THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

© 2012 Cisco Systems, Inc. All rights reserved.
CONTENTS

Preface xlvii

Audience xlvii

Conventions xlvii

Related Documentation xlviii

Obtaining Documentation and Submitting a Service Request xlix

CHAPTER 1

Overview 1

Introduction 1

Single-Controller Deployments 2

Multiple-Controller Deployments 3

Operating System Software 3

Operating System Security 4

Layer 2 and Layer 3 Operation 4

Operational Requirements 5

Configuration Requirements 5

Cisco Wireless Controllers 5

Client Location 5

Cisco WLC Platforms 6

Cisco Wireless Solution WLANs 6

File Transfers 6

Power over Ethernet 6

Cisco Wireless Controller Memory 7

Cisco Wireless Controller Failover Protection 7

CHAPTER 2

Using the Web-Browser and CLI Interfaces 9

Configuring the Controller Using the Configuration Wizard 9

Connecting the Console Port of the Controller 10
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring the Controller (GUI)</td>
<td>10</td>
</tr>
<tr>
<td>Configuring the Controller—Using the CLI Configuration Wizard</td>
<td>21</td>
</tr>
<tr>
<td>Using the Controller GUI</td>
<td>23</td>
</tr>
<tr>
<td>Guidelines and Limitations</td>
<td>24</td>
</tr>
<tr>
<td>Logging On to the GUI</td>
<td>24</td>
</tr>
<tr>
<td>Logging out of the GUI</td>
<td>25</td>
</tr>
<tr>
<td>Enabling Web and Secure Web Modes</td>
<td>25</td>
</tr>
<tr>
<td>Enabling Web and Secure Web Modes (GUI)</td>
<td>25</td>
</tr>
<tr>
<td>Enabling Web and Secure Web Modes (CLI)</td>
<td>26</td>
</tr>
<tr>
<td>Loading an Externally Generated SSL Certificate</td>
<td>27</td>
</tr>
<tr>
<td>Information About Externally Generated SSL Certificates</td>
<td>27</td>
</tr>
<tr>
<td>Loading an SSL Certificate (GUI)</td>
<td>28</td>
</tr>
<tr>
<td>Loading an SSL Certificate (CLI)</td>
<td>29</td>
</tr>
<tr>
<td>Using the Controller CLI</td>
<td>30</td>
</tr>
<tr>
<td>Logging on to the Controller CLI</td>
<td>30</td>
</tr>
<tr>
<td>Guidelines and Limitations</td>
<td>30</td>
</tr>
<tr>
<td>Using a Local Serial Connection</td>
<td>31</td>
</tr>
<tr>
<td>Using a Remote Ethernet Connection</td>
<td>31</td>
</tr>
<tr>
<td>Logging Out of the CLI</td>
<td>32</td>
</tr>
<tr>
<td>Navigating the CLI</td>
<td>32</td>
</tr>
<tr>
<td>Using the AutoInstall Feature for Controllers Without a Configuration</td>
<td>33</td>
</tr>
<tr>
<td>Information About the AutoInstall Feature</td>
<td>33</td>
</tr>
<tr>
<td>Guidelines and Limitations</td>
<td>34</td>
</tr>
<tr>
<td>Obtaining an IP Address Through DHCP and Downloading a Configuration File from a TFTP Server</td>
<td>34</td>
</tr>
<tr>
<td>Selecting a Configuration File</td>
<td>35</td>
</tr>
<tr>
<td>Example: AutoInstall Operation</td>
<td>36</td>
</tr>
<tr>
<td>Managing the Controller System Date and Time</td>
<td>37</td>
</tr>
<tr>
<td>Information About Controller System Date and Time</td>
<td>37</td>
</tr>
<tr>
<td>Restrictions on Configuring the Cisco WLC Date and Time</td>
<td>37</td>
</tr>
<tr>
<td>Configuring an NTP/SNTP Server to Obtain the Date and Time</td>
<td>37</td>
</tr>
<tr>
<td>Configuring NTP/SNTP Authentication (GUI)</td>
<td>38</td>
</tr>
<tr>
<td>Configuring NTP/SNTP Authentication (CLI)</td>
<td>38</td>
</tr>
<tr>
<td>Configuring the Date and Time (GUI)</td>
<td>39</td>
</tr>
<tr>
<td>Configuring the Date and Time (CLI)</td>
<td>40</td>
</tr>
</tbody>
</table>
Contents

Configuring Interface Groups 82
  Information About Interface Groups 82
Creating Interface Groups (GUI) 82
Creating Interface Groups (CLI) 83
  Adding Interfaces to Interface Groups (GUI) 83
  Adding Interfaces to Interface Groups (CLI) 83
  Viewing VLANs in Interface Groups (CLI) 83
  Adding an Interface Group to a WLAN (GUI) 84
  Adding an Interface Group to a WLAN (CLI) 84
Configuring Multicast Optimization 84
  Information About Multicast Optimization 84
  Configuring a Multicast VLAN (GUI) 85
  Configuring a Multicast VLAN (CLI) 85

Chapter 4

Configuring Controller Settings 87
  Installing and Configuring Licenses 88
    Information About Installing and Configuring Licenses 88
    Restrictions for Using Licenses 89
    Obtaining an Upgrade or Capacity Adder License 89
      Information About Obtaining an Upgrade or Capacity Adder License 89
      Obtaining and Registering a PAK Certificate 90
    Installing a License 91
      Installing a License (GUI) 91
      Installing a License (CLI) 92
  Viewing Licenses 92
    Viewing Licenses (GUI) 92
    Viewing Licenses (CLI) 93
  Troubleshooting Licensing Issues 95
  Activating an AP-Count Evaluation License 96
    Information About Activating an AP-Count Evaluation License 96
    Activating an AP-Count Evaluation License (GUI) 96
    Activating an AP-Count Evaluation License (CLI) 97
  Configuring Right to Use Licensing 98
    Information About Right to Use Licensing 98
    Configuring Right to Use Licensing (GUI) 100
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Right to Use Licensing (CLI)</td>
<td>100</td>
</tr>
<tr>
<td>Rehosting Licenses</td>
<td>100</td>
</tr>
<tr>
<td>Information About Rehosting Licenses</td>
<td>100</td>
</tr>
<tr>
<td>Rehosting a License</td>
<td>101</td>
</tr>
<tr>
<td>Rehosting a License (GUI)</td>
<td>101</td>
</tr>
<tr>
<td>Rehosting a License (CLI)</td>
<td>102</td>
</tr>
<tr>
<td>Transferring Licenses to a Replacement Controller after an RMA</td>
<td>104</td>
</tr>
<tr>
<td>Information About Transferring Licenses to a Replacement Controller after an RMA</td>
<td>104</td>
</tr>
<tr>
<td>Transferring a License to a Replacement Controller after an RMA</td>
<td>104</td>
</tr>
<tr>
<td>Configuring the License Agent</td>
<td>105</td>
</tr>
<tr>
<td>Information About Configuring the License Agent</td>
<td>105</td>
</tr>
<tr>
<td>Configuring the License Agent (GUI)</td>
<td>105</td>
</tr>
<tr>
<td>Configuring the License Agent (CLI)</td>
<td>106</td>
</tr>
<tr>
<td>Configuring 802.11 Bands</td>
<td>107</td>
</tr>
<tr>
<td>Information About Configuring 802.11 Bands</td>
<td>107</td>
</tr>
<tr>
<td>Configuring the 802.11 Bands (GUI)</td>
<td>107</td>
</tr>
<tr>
<td>Configuring the 802.11 Bands (CLI)</td>
<td>108</td>
</tr>
<tr>
<td>Configuring 802.11n Parameters</td>
<td>110</td>
</tr>
<tr>
<td>Information About Configuring the 802.11n Parameters</td>
<td>110</td>
</tr>
<tr>
<td>Configuring the 802.11n Parameters (GUI)</td>
<td>111</td>
</tr>
<tr>
<td>Configuring the 802.11n Parameters (CLI)</td>
<td>112</td>
</tr>
<tr>
<td>Additional References</td>
<td>113</td>
</tr>
<tr>
<td>Configuring 802.11h Parameters</td>
<td>114</td>
</tr>
<tr>
<td>Information About Configuring 802.11h Parameters</td>
<td>114</td>
</tr>
<tr>
<td>Configuring the 802.11h Parameters (GUI)</td>
<td>114</td>
</tr>
<tr>
<td>Configuring the 802.11h Parameters (CLI)</td>
<td>114</td>
</tr>
<tr>
<td>Configuring DHCP Proxy</td>
<td>115</td>
</tr>
<tr>
<td>Information About Configuring DHCP Proxy</td>
<td>115</td>
</tr>
<tr>
<td>Restrictions on Using DHCP Proxy</td>
<td>115</td>
</tr>
<tr>
<td>Configuring DHCP Proxy</td>
<td>116</td>
</tr>
<tr>
<td>Configuring DHCP Proxy (GUI)</td>
<td>116</td>
</tr>
<tr>
<td>Configuring DHCP Proxy (CLI)</td>
<td>117</td>
</tr>
<tr>
<td>Configuring DHCP Proxy (CLI)</td>
<td>117</td>
</tr>
</tbody>
</table>
Configuring a DHCP Timeout (GUI)  117
Configuring a DHCP Timeout (CLI)  118
Configuring Administrator Usernames and Passwords  118
   Information About Configuring Administrator Usernames and Passwords  118
   Configuring Usernames and Passwords  118
      Configuring Usernames and Passwords (GUI)  118
      Configuring Usernames and Passwords (CLI)  118
   Restoring Passwords  119

Configuring SNMP  119
   Configuring SNMP (CLI)  119
   SNMP Community Strings  121
      Changing the SNMP Community String Default Values (GUI)  122
      Changing the SNMP Community String Default Values (CLI)  122
   Changing the Default Values for SNMP v3 Users  123
      Information About Changing the Default Values for SNMP v3 Users  123
      Changing the SNMP v3 User Default Values (GUI)  124
      Changing the SNMP v3 User Default Values (CLI)  124

Configuring Aggressive Load Balancing  125
   Information About Configuring Aggressive Load Balancing  125
   Configuring Aggressive Load Balancing  126
      Configuring Aggressive Load Balancing (GUI)  126
      Configuring Aggressive Load Balancing (CLI)  127

Configuring Band Selection  127
   Information About Configuring Band Selection  127
   Restrictions on Band Selection  128
   Configuring Band Selection  129
      Configuring Band Selection (GUI)  129
      Configuring Band Selection (CLI)  129

Configuring Fast SSID Changing  130
   Information About Configuring Fast SSID Changing  130
   Configuring Fast SSID  131
      Configuring Fast SSID Changing (GUI)  131
      Configuring Fast SSID Changing (CLI)  131

Enabling 802.3X Flow Control  131
Configuring 802.3 Bridging  131
Information About Configuring 802.3 Bridging 131
Restrictions on 802.3 Bridging 132
Configuring 802.3 Bridging 132
  Configuring 802.3 Bridging (GUI) 132
  Configuring 802.3 Bridging (CLI) 132
Configuring Multicast Mode 133
Information About Multicast Mode 133
Restrictions for Configuring Multicast Mode 134
Configuring Multicast Mode 136
  Enabling Multicast Mode (GUI) 136
  Enabling Multicast Mode (CLI) 137
  Viewing Multicast Groups (GUI) 138
  Viewing Multicast Groups (CLI) 138
  Viewing an Access Point's Multicast Client Table (CLI) 139
Configuring Client Roaming 139
Information About Client Roaming 139
  Inter-Controller Roaming 139
  Intra-Controller Roaming 140
  Inter-Subnet Roaming 140
  Voice-over-IP Telephone Roaming 140
  CCX Layer 2 Client Roaming 140
Restrictions on Client Roaming 141
Configuring CCX Client Roaming Parameters 142
  Configuring CCX Client Roaming Parameters (GUI) 142
  Configuring CCX Client Roaming Parameters (CLI) 143
  Obtaining CCX Client Roaming Information (CLI) 143
  Debugging CCX Client Roaming Issues (CLI) 143
Configuring IP-MAC Address Binding 144
Information About Configuring IP-MAC Address Binding 144
Configuring IP-MAC Address Binding 144
  Configuring IP-MAC Address Binding (CLI) 144
Configuring Quality of Service 145
Information About Quality of Service 145
Configuring Quality of Service Profiles 145
  Configuring QoS Profiles (GUI) 146
Configuring QoS Profiles (CLI) 147
Configuring Quality of Service Roles 149
  Information About Quality of Service Roles 149
Configuring QoS Roles 149
  Configuring QoS (GUI) 149
  Configuring QoS Roles (CLI) 150
Configuring Voice and Video Parameters 151
  Information About Configuring Voice and Video Parameters 151
    Call Admission Control 152
      Bandwidth-Based CAC 152
      Load-Based CAC 152
    Expedited Bandwidth Requests 153
    U-APSD 154
    Traffic Stream Metrics 154
    Configuring Voice Parameters (GUI) 155
    Configuring Voice Parameters (CLI) 156
  Configuring Video Parameters 158
    Configuring Video Parameters (GUI) 158
    Configuring Video Parameters (CLI) 159
  Viewing Voice and Video Settings 160
    Viewing Voice and Video Settings (GUI) 160
    Viewing Voice and Video Settings (CLI) 160
Configuring SIP Based CAC 164
  Restrictions for SIP-Based CAC 164
  Configuring SIP-Based CAC (GUI) 164
  Configuring SIP-Based CAC (CLI) 165
Configuring Media Parameters 165
  Configuring Media Parameters (GUI) 165
Configuring Voice Prioritization Using Preferred Call Numbers 166
  Information About Configuring Voice Prioritization Using Preferred Call Numbers 166
  Prerequisites for Configuring Voice Prioritization Using Preferred Call Numbers 166
  Configuring a Preferred Call Number 167
    Configuring a Preferred Call Number (GUI) 167
    Configuring a Preferred Call Number (CLI) 167
Configuring EDCA Parameters 168
Contents

Information About EDCA Parameters 168
Configuring EDCA Parameters 168
  Configuring EDCA Parameters (GUI) 168
  Configuring EDCA Parameters (CLI) 169
Configuring the Cisco Discovery Protocol 170
  Information About Configuring the Cisco Discovery Protocol 170
  Restrictions for Configuring the Cisco Discovery Protocol 170
  Configuring the Cisco Discovery Protocol 172
    Configuring the Cisco Discovery Protocol (GUI) 172
    Configuring the Cisco Discovery Protocol (CLI) 173
  Viewing Cisco Discovery Protocol Information 174
    Viewing Cisco Discovery Protocol Information (GUI) 174
    Viewing Cisco Discovery Protocol Information (CLI) 176
    Getting CDP Debug Information 176
Configuring Authentication for the Controller and NTP Server 177
  Information About Configuring Authentication for the Controller and NTP/SNTP Server 177
  Configuring Authentication for the Controller and NTP Server 177
    Configuring the NTP/SNTP Server for Authentication (GUI) 177
    Configuring the NTP/SNTP Server for Authentication (CLI) 177
Configuring RFID Tag Tracking 178
  Information About Configuring RFID Tag Tracking 178
  Configuring RFID Tag Tracking 179
    Configuring RFID Tag Tracking (CLI) 179
    Viewing RFID Tag Tracking Information (CLI) 180
    Debugging RFID Tag Tracking Issues (CLI) 180
Configuring and Viewing Location Settings 181
  Information About Configuring and Viewing Location Settings 181
    Synchronizing the Controller and Mobility Services Engine 181
  Configuring Location Settings 181
    Configuring Location Settings (CLI) 181
    Viewing Location Settings (CLI) 183
    Modifying the NMSP Notification Interval for Clients, RFID Tags, and Rogues (CLI) 184
    Viewing NMSP Settings (CLI) 185
Debugging NMSP Issues 185
Resetting the Controller to Default Settings 186
Information About Resetting the Controller to Default Settings 186
Resetting the Controller to Default Settings (GUI) 186
Resetting the Controller to Default Settings (CLI) 187

CHAPTER 5
Configuring VideoStream 189
Prerequisites for VideoStream 189
Restrictions for Configuring VideoStream 189
Information about VideoStream 189
Configuring VideoStream 190
Configuring VideoStream (GUI) 190
Configuring VideoStream (CLI) 193
Viewing and Debugging Media Streams 194

CHAPTER 6
Configuring Security Solutions 197
Cisco Unified Wireless Network Solution Security 198
Security Overview 198
Layer 1 Solutions 198
Layer 2 Solutions 198
Restrictions for Layer 2 Solutions 198
Layer 3 Solutions 199
Integrated Security Solutions 199
Configuring RADIUS 199
Information About RADIUS 199
Configuring RADIUS on the ACS 201
Configuring RADIUS (GUI) 202
Configuring RADIUS (CLI) 206
RADIUS Authentication Attributes Sent by the Controller 210
RADIUS Accounting Attributes 212
Configuring TACACS+ 214
Information About TACACS+ 214
TACACS+ VSA 216
Configuring TACACS+ on the ACS 216
Contents

Device Registration 244
Central Web Authentication 244
Local Web Authentication 245
Restrictions for RADIUS NAC Support 245
Configuring RADIUS NAC Support (GUI) 246
Configuring RADIUS NAC Support (CLI) 246

Using Management Over Wireless 247
Information About Management over Wireless 247
Enabling Management over Wireless (GUI) 247
Enabling Management over Wireless (CLI) 247

Using Dynamic Interfaces for Management 248
Information About Using Dynamic Interfaces for Management 248
Configuring Management using Dynamic Interfaces (CLI) 248

Configuring DHCP Option 82 248
Information About DHCP Option 82 248
Restrictions on DHCP Option 82 249
Configuring DHCP Option 82 (GUI) 249
Configuring DHCP Option 82 (CLI) 250

Additional References 250

Configuring and Applying Access Control Lists 250
Information About Access Control Lists 250
Restrictions for Access Control Lists 251
Configuring and Applying Access Control Lists (GUI) 252

Configuring Access Control Lists 252
Applying an Access Control List to an Interface 254
Applying an Access Control List to the Controller CPU 254
Applying an Access Control List to a WLAN 255
Applying a Preauthentication Access Control List to a WLAN 255

Configuring and Applying Access Control Lists (CLI) 256
Configuring Access Control Lists 256
Applying Access Control Lists 256

Configuring Management Frame Protection 257
Information About Management Frame Protection 257
Restrictions for Management Frame Protection 259
Configuring Management Frame Protection (GUI) 259
Contents

Viewing the Management Frame Protection Settings (GUI) 260
Configuring Management Frame Protection (CLI) 260
Viewing the Management Frame Protection Settings (CLI) 260
Debugging Management Frame Protection Issues (CLI) 261
Configuring Client Exclusion Policies 261
Configuring Client Exclusion Policies (GUI) 261
Configuring Client Exclusion Policies (CLI) 262
Configuring Identity Networking 263
Information About Identity Networking 263
    RADIUS Attributes Used in Identity Networking 264
Configuring AAA Override 267
Information About AAA Override 267
Restrictions for AAA Override 267
Updating the RADIUS Server Dictionary File for Proper QoS Values 268
Configuring AAA Override (GUI) 269
Configuring AAA Override (CLI) 269
Managing Rogue Devices 269
Information About Rogue Devices 269
Configuring Rogue Detection (GUI) 274
Configuring Rogue Detection (CLI) 275
Classifying Rogue Access Points 278
Information About Classifying Rogue Access Points 278
Restrictions for Classifying Rogue Access Points 280
Configuring Rogue Classification Rules (GUI) 281
Viewing and Classifying Rogue Devices (GUI) 283
Configuring Rogue Classification Rules (CLI) 286
Viewing and Classifying Rogue Devices (CLI) 288
Configuring Cisco TrustSec SXP 290
Information About Cisco TrustSec SXP 290
Restrictions for Cisco TrustSec SXP 291
Configuring Cisco TrustSec SXP (GUI) 291
Creating a New SXP Connection (GUI) 292
Configuring Cisco TrustSec SXP (CLI) 292
Configuring Cisco Intrusion Detection System 293
Information About Cisco Intrusion Detection System 293
CHAPTER 7  WLANs  319

Information About WLANs  320
Guidelines and Limitations  320
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating WLANs</td>
<td>320</td>
</tr>
<tr>
<td>Creating and Removing WLANs (GUI)</td>
<td>320</td>
</tr>
<tr>
<td>Enabling and Disabling WLANs (GUI)</td>
<td>321</td>
</tr>
<tr>
<td>Creating and Deleting WLANs (CLI)</td>
<td>322</td>
</tr>
<tr>
<td>Enabling and Disabling WLANs (CLI)</td>
<td>322</td>
</tr>
<tr>
<td>Viewing WLANs (CLI)</td>
<td>323</td>
</tr>
<tr>
<td>Searching WLANs (GUI)</td>
<td>323</td>
</tr>
<tr>
<td>Setting the Client Count per WLAN</td>
<td>324</td>
</tr>
<tr>
<td>Information About Setting the Client Count per WLAN</td>
<td>324</td>
</tr>
<tr>
<td>Guidelines and Limitations</td>
<td>324</td>
</tr>
<tr>
<td>Configuring the Client Count per WLAN (GUI)</td>
<td>325</td>
</tr>
<tr>
<td>Configuring the Maximum Number of Clients per WLAN (CLI)</td>
<td>325</td>
</tr>
<tr>
<td>Configuring the Maximum Number of Clients for each AP Radio per WLAN</td>
<td>325</td>
</tr>
<tr>
<td>Configuring the Maximum Number of Clients for each AP Radio per WLAN</td>
<td>326</td>
</tr>
<tr>
<td>Configuring DHCP</td>
<td>326</td>
</tr>
<tr>
<td>Information About the Dynamic Host Configuration Protocol</td>
<td>326</td>
</tr>
<tr>
<td>Internal DHCP Servers</td>
<td>326</td>
</tr>
<tr>
<td>External DHCP Servers</td>
<td>327</td>
</tr>
<tr>
<td>DHCP Assignments</td>
<td>327</td>
</tr>
<tr>
<td>Restrictions for Internal DHCP Servers</td>
<td>328</td>
</tr>
<tr>
<td>Configuring DHCP (GUI)</td>
<td>328</td>
</tr>
<tr>
<td>Configuring DHCP (CLI)</td>
<td>329</td>
</tr>
<tr>
<td>Debugging DHCP (CLI)</td>
<td>329</td>
</tr>
<tr>
<td>Configuring DHCP Scopes</td>
<td>330</td>
</tr>
<tr>
<td>Information About DHCP Scopes</td>
<td>330</td>
</tr>
<tr>
<td>Guidelines and Limitations</td>
<td>330</td>
</tr>
<tr>
<td>Configuring DHCP Scopes (GUI)</td>
<td>330</td>
</tr>
<tr>
<td>Configuring DHCP Scopes (CLI)</td>
<td>331</td>
</tr>
<tr>
<td>Configuring MAC Filtering for WLANs</td>
<td>332</td>
</tr>
<tr>
<td>Information About MAC Filtering of WLANs</td>
<td>332</td>
</tr>
<tr>
<td>Enabling MAC Filtering</td>
<td>333</td>
</tr>
<tr>
<td>Configuring Local MAC Filters</td>
<td>333</td>
</tr>
<tr>
<td>Information About Local MAC Filters</td>
<td>333</td>
</tr>
<tr>
<td>Configuring Local MAC Filters (CLI)</td>
<td>333</td>
</tr>
<tr>
<td>Prerequisites for Configuring Local MAC Filters</td>
<td>334</td>
</tr>
</tbody>
</table>
Information About Configuring a Timeout for Disabled Clients 334
  Configuring Timeout for Disabled Clients (CLI) 334
Assigning WLANs to Interfaces 334
Configuring the DTIM Period 335
  Information About DTIM Period 335
  Guidelines and Limitations 335
  Configuring the DTIM Period (GUI) 336
  Configuring the DTIM Period (CLI) 336
Configuring Peer-to-Peer Blocking 337
  Information About Peer-to-Peer Blocking 337
  Restrictions for Peer-to-Peer Blocking 337
  Configuring Peer-to-Peer Blocking (GUI) 337
  Configuring Peer-to-Peer Blocking (CLI) 338
Configuring Layer 2 Security 339
  Configuring Static WEP Keys (CLI) 339
  Configuring Dynamic 802.1X Keys and Authorization (CLI) 339
Configuring 802.11r BSS Fast Transition 340
  Information About 802.11r Fast Transition 340
  Restrictions for 802.11r Fast Transition 342
  Configuring 802.11r Fast Transition (GUI) 343
  Configuring 802.11r Fast Transition (CLI) 344
  Troubleshooting 802.11r BSS Fast Transition 345
Configuring MAC Authentication Failover to 802.1X Authentication 345
  Configuring MAC Authentication Failover to 802.1x Authentication (GUI) 345
  Configuring MAC Authentication Failover to 802.1X Authentication (CLI) 345
Configuring a WLAN for Both Static and Dynamic WEP 346
  Information About WLAN for Both Static and Dynamic WEP 346
    WPA1 and WPA2 346
  Restrictions for Configuring Static and Dynamic WEP 347
  Configuring WPA1 +WPA2 347
    Configuring WPA1+WPA2 (GUI) 347
    Configuring WPA1+WPA2 (CLI) 348
Configuring Sticky PMKID Caching 349
  Information About Sticky Key Caching 349
  Restrictions for Sticky Key Caching 350
Configuring Sticky Key Caching (CLI) 350
Configuring CKIP 351
Information About CKIP 351
Configuring CKIP (GUI) 352
Configuring CKIP (CLI) 352
Configuring a Session Timeout 353
Information About Session Timeouts 353
Configuring Session Timeouts 353
Configuring a Session Timeout (GUI) 353
Configuring a Session Timeout (CLI) 354
Configuring Layer 3 Security Using VPN Passthrough 355
Information About VPN Passthrough 355
Restrictions for Layer 3 Security Using VPN Passthrough 355
Configuring VPN Passthrough 355
Configuring VPN Passthrough (GUI) 355
Configuring VPN Passthrough (CLI) 355
Configuring Layer 3 Security Using Web Authentication 356
Information About Web Authentication 356
Prerequisites for Configuring Web Authentication on a WLAN 356
Additional Information 356
Configuring Web Authentication 357
Configuring Web Authentication (GUI) 357
Configuring Web Authentication (CLI) 357
Configuring Captive Bypassing 358
Information About Captive Bypassing 358
Configuring Captive Bypassing (CLI) 358
Configuring a Fallback Policy with MAC Filtering and Web Authentication 359
Information About Fallback Policy with MAC Filtering and Web Authentication 359
Configuring a Fallback Policy with MAC Filtering and Web Authentication (GUI) 359
Configuring a Fallback Policy with MAC Filtering and Web Authentication (CLI) 360
Assigning a QoS Profile to a WLAN 360
Information About QoS Profiles 360
Assigning a QoS Profile to a WLAN (GUI) 362
Assigning a QoS Profile to a WLAN (CLI) 363
Configuring QoS Enhanced BSS 364
Information About QoS Enhanced BSS 364
Restrictions for QoS Enhanced BSS 364
Additional Information 365
Configuring QBSS (GUI) 365
Configuring QBSS (CLI) 365
Configuring Media Session Snooping and Reporting 366
Information About Media Session Snooping and Reporting 366
Restrictions for Media Session Snooping and Reporting 366
Configuring Media Session Snooping (GUI) 367
Configuring Media Session Snooping (CLI) 367
Configuring Key Telephone System-Based CAC 371
Information About Key Telephone System-Based CAC 371
Restrictions for Key Telephone System-Based CAC 371
Configuring KTS-based CAC (GUI) 371
Configuring KTS-based CAC (CLI) 372
Related Commands 373
Configuring Reanchoring of Roaming Voice Clients 373
Information About Reanchoring of Roaming Voice Clients 373
Restrictions for Configuring Reanchoring of Roaming Voice Clients 373
Configuring Reanchoring of Roaming Voice Clients (GUI) 374
Configuring Reanchoring of Roaming Voice Clients (CLI) 374
Configuring Seamless IPv6 Mobility 375
Information About IPv6 Mobility 375
Prerequisites for Configuring IPv6 Mobility 375
Configuring RA Guard for IPv6 Clients 375
Information About RA Guard 375
Configuring RA Guard (GUI) 376
Configuring RA Guard (CLI) 376
Configuring RA Throttling for IPv6 Clients 376
Information about RA Throttling 376
Configuring RA Throttling (GUI) 376
Configuring the RA Throttle Policy (CLI) 377
Configuring IPv6 Neighbor Discovery Caching 377
Information About IPv6 Neighbor Discovery 377
Configuring Neighbor Binding (GUI) 378
Configuring Neighbor Binding (CLI) 378

Configuring Cisco Client Extensions 378
  Information About Cisco Client Extensions 378
  Prerequisites for Configuring Cisco Client Extensions 378

Configuring CCX Aironet IEs (GUI) 379
  Configuring CCX Aironet IEs (CLI) 379

Viewing a Client’s CCX Version (GUI) 379
  Viewing a Client’s CCX Version (CLI) 380

Configuring Remote LANs 380
  Information About Remote LANs 380
  Restrictions for Configuring Remote LANs 380

Configuring Remote LANs 380
  Configuring a Remote LAN (GUI) 380
  Configuring a Remote LAN (CLI) 381

Configuring AP Groups 382
  Information About Access Point Groups 382
  AP Groups Supported on Controller Platforms 382

Configuring Access Point Groups 382
  Creating Access Point Groups (GUI) 383
  Creating Access Point Groups (CLI) 384

Viewing Access Point Groups (CLI) 385

Configuring RF Profiles 385
  Information About RF Profiles 385
  Prerequisites for Configuring RF Profiles 387

Configuring an RF Profile (GUI) 388
  Configuring an RF Profile (CLI) 389

Applying an RF Profile to AP Groups (GUI) 390
  Applying RF Profiles to AP Groups (CLI) 391

Configuring Web Redirect with 802.1X Authentication 391
  Information About Web Redirect with 802.1X Authentication 391

  Conditional Web Redirect 391
  Splash Page Web Redirect 391

Configuring the RADIUS Server (GUI) 392
  Configuring Web Redirect 393
  Configuring Web Redirect (GUI) 393
Configuring Web Redirect (CLI) 393
Disabling Accounting Servers per WLAN (GUI) 394
Disabling Coverage Hole Detection per WLAN 394
Disabling Coverage Hole Detection on a WLAN (GUI) 395
Disabling Coverage Hole Detection on a WLAN (CLI) 395

Configuring NAC Out-of-Band Integration 396
Information About NAC Out-of-Band Integration 396
Guidelines and Limitations 397
Configuring NAC Out-of-Band Integration 397
Configuring NAC Out-of-Band Integration (GUI) 397
Configuring NAC Out-of-Band Integration (CLI) 398

Configuring Passive Clients 399
Information About Passive Clients 399
Restrictions for Passive Clients 399
Configuring Passive Clients (GUI) 400
  Enabling the Multicast-Multicast Mode (GUI) 400
  Enabling the Global Multicast Mode on Controllers (GUI) 401
  Enabling the Passive Client Feature on the Controller (GUI) 401
Configuring Passive Clients (CLI) 402

Configuring Client Profiling 402
Information About Client Profiling 402
Restrictions for Configuring Client Profiling 403
Configuring Client Profiling 404
  Configuring Client Profiling (GUI) 404
  Configuring Client Profiling (CLI) 404

Configuring Per-WLAN RADIUS Source Support 405
Information About Per-WLAN RADIUS Source Support 405
Restrictions for Per-WLAN RADIUS Source Support 405
Configuring Per-WLAN RADIUS Source Support (CLI) 405
Monitoring the Status of Per-WLAN RADIUS Source Support (CLI) 406

Configuring Remote LANs 406
Information About Remote LANs 406
Restrictions for Configuring Remote LANs 406
Configuring Remote LANs 407
  Configuring a Remote LAN (GUI) 407
Configuring a Remote LAN (CLI) 407

**CHAPTER 8**  
Controlling Lightweight Access Points 409

- Access Point Communication Protocols 410
  - Information About Access Point Communication Protocols 410
  - Restrictions for Access Point Communication Protocols 411
- Configuring Data Encryption 411
  - Guidelines for Data Encryption 411
  - Upgrading or Downgrading DTLS Images for Cisco 5500 Series Controllers 412
    - Guidelines When Upgrading to or from a DTLS Image 413
  - Configuring Data Encryption (GUI) 413
  - Configuring Data Encryption (CLI) 413
- Viewing CAPWAP Maximum Transmission Unit Information 414
- Debugging CAPWAP 414
- Controller Discovery Process 415
  - Restrictions for Controller Discovery Process 416
- Verifying that Access Points Join the Controller 416
  - Verifying that Access Points Join the Controller (GUI) 416
  - Verifying that Access Points Join the Controller (CLI) 416
- Searching for Access Points 417
  - Information About Searching for Access Points 417
- Searching the AP Filter (GUI) 417
- Monitoring the Interface Details 420
- Searching for Access Point Radios 422
  - Information About Searching for Access Point Radios 422
- Searching for Access Point Radios (GUI) 422
- Configuring Global Credentials for Access Points 423
  - Information About Configuring Global Credentials for Access Points 423
  - Restrictions for Global Credentials for Access Points 424
  - Configuring Global Credentials for Access Points (GUI) 424
  - Configuring Global Credentials for Access Points (CLI) 425
- Configuring Authentication for Access Points 426
  - Information About Configuring Authentication for Access Points 426
  - Restrictions for Authenticating Access Points 426
  - Prerequisites for Configuring Authentication for Access Points 426
Configuring Authentication for Access Points 427
  Configuring Authentication for Access Points (GUI) 427
  Configuring Authentication for Access Points (CLI) 428
Configuring the Switch for Authentication 429
Configuring Embedded Access Points 429
  Information About Embedded Access Points 429
Converting Autonomous Access Points to Lightweight Mode 431
  Information About Converting Autonomous Access Points to Lightweight Mode 431
Restrictions for Converting Autonomous Access Points to Lightweight Mode 431
Reverting from Lightweight Mode to Autonomous Mode 432
  Reverting to a Previous Release (CLI) 432
  Reverting to a Previous Release Using the MODE Button and a TFTP Server 432
Authorizing Access Points 432
  Authorizing Access Points Using SSCs 433
  Authorizing Access Points for Virtual Controllers Using SSC 433
    Configuring SSC (GUI) 433
    Configuring SSC (CLI) 433
  Authorizing Access Points Using MICs 434
  Authorizing Access Points Using LSCs 434
    Configuring Locally Significant Certificates (GUI) 435
    Configuring Locally Significant Certificates (CLI) 435
  Authorizing Access Points (GUI) 437
  Authorizing Access Points (CLI) 438
Configuring VLAN Tagging for CAPWAP Frames from Access Points 438
  Information About VLAN Tagging for CAPWAP Frames from Access Points 438
  Configuring VLAN Tagging for CAPWAP Frames from Access Points (GUI) 438
  Configuring VLAN Tagging for CAPWAP Frames from Access Points (CLI) 439
Using DHCP Option 43 and DHCP Option 60 439
Troubleshooting the Access Point Join Process 441
  Configuring the Syslog Server for Access Points (CLI) 442
  Viewing Access Point Join Information 443
    Viewing Access Point Join Information (GUI) 443
    Viewing Access Point Join Information (CLI) 444
Sending Debug Commands to Access Points Converted to Lightweight Mode 445
Understanding How Converted Access Points Send Crash Information to the Controller 445
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding How Converted Access Points Send Radio Core Dumps to the Controller</td>
<td>445</td>
</tr>
<tr>
<td>Retrieving Radio Core Dumps (CLI)</td>
<td>446</td>
</tr>
<tr>
<td>Uploading Radio Core Dumps (GUI)</td>
<td>446</td>
</tr>
<tr>
<td>Uploading Radio Core Dumps (CLI)</td>
<td>446</td>
</tr>
<tr>
<td>Uploading Memory Core Dumps from Converted Access Points</td>
<td>447</td>
</tr>
<tr>
<td>Uploading Access Point Core Dumps (GUI)</td>
<td>448</td>
</tr>
<tr>
<td>Uploading Access Point Core Dumps (CLI)</td>
<td>448</td>
</tr>
<tr>
<td>Viewing the AP Crash Log Information</td>
<td>448</td>
</tr>
<tr>
<td>Viewing the AP Crash Log Information (GUI)</td>
<td>449</td>
</tr>
<tr>
<td>Viewing the AP Crash Log Information (CLI)</td>
<td>449</td>
</tr>
<tr>
<td>Displaying MAC Addresses for Converted Access Points</td>
<td>449</td>
</tr>
<tr>
<td>Disabling the Reset Button on Access Points Converted to Lightweight Mode</td>
<td>449</td>
</tr>
<tr>
<td>Configuring a Static IP Address on a Lightweight Access Point</td>
<td>450</td>
</tr>
<tr>
<td>Configuring a Static IP Address (GUI)</td>
<td>450</td>
</tr>
<tr>
<td>Configuring a Static IP Address (CLI)</td>
<td>451</td>
</tr>
<tr>
<td>Supporting Oversized Access Point Images</td>
<td>452</td>
</tr>
<tr>
<td>Recovering the Access Point—Using the TFTP Recovery Procedure</td>
<td>452</td>
</tr>
<tr>
<td>Configuring Packet Capture</td>
<td>452</td>
</tr>
<tr>
<td>Information About Packet Capture</td>
<td>452</td>
</tr>
<tr>
<td>Restrictions for Packet Capture</td>
<td>453</td>
</tr>
<tr>
<td>Configuring Packet Capture (CLI)</td>
<td>454</td>
</tr>
<tr>
<td>Configuring OfficeExtend Access Points</td>
<td>454</td>
</tr>
<tr>
<td>Information About OfficeExtend Access Points</td>
<td>454</td>
</tr>
<tr>
<td>OEAP 600 Series Access Points</td>
<td>455</td>
</tr>
<tr>
<td>OEAP in Local Mode</td>
<td>455</td>
</tr>
<tr>
<td>Supported WLAN Settings for 600 Series OfficeExtend Access Point</td>
<td>456</td>
</tr>
<tr>
<td>WLAN Security Settings for the 600 Series OfficeExtend Access Point</td>
<td>456</td>
</tr>
<tr>
<td>Authentication Settings</td>
<td>460</td>
</tr>
<tr>
<td>Supported User Count on 600 Series OfficeExtend Access Point</td>
<td>461</td>
</tr>
<tr>
<td>Remote LAN Settings</td>
<td>461</td>
</tr>
<tr>
<td>Channel Management and Settings</td>
<td>462</td>
</tr>
<tr>
<td>Additional Caveats</td>
<td>463</td>
</tr>
<tr>
<td>Implementing Security</td>
<td>463</td>
</tr>
<tr>
<td>Licensing for an OfficeExtend Access Point</td>
<td>464</td>
</tr>
</tbody>
</table>
Configuring OfficeExtend Access Points 464
  Configuring OfficeExtend Access Points (GUI) 464
  Configuring OfficeExtend Access Points (CLI) 466
Configuring a Personal SSID on an OfficeExtend Access Point Other than 600 Series OEAP 468
Viewing OfficeExtend Access Point Statistics 469
Using Cisco Workgroup Bridges 469
  Information About Cisco Workgroup Bridges 469
  Restrictions for Cisco Workgroup Bridges 471
  WGB Configuration Example 473
  Viewing the Status of Workgroup Bridges (GUI) 473
  Viewing the Status of Workgroup Bridges (CLI) 474
  Debugging WGB Issues (CLI) 474
Using Non-Cisco Workgroup Bridges 475
  Information About Non-Cisco Workgroup Bridges 475
  Restrictions for Non-Cisco Workgroup Bridges 476
Configuring Backup Controllers 476
  Information About Configuring Backup Controllers 476
  Restrictions for Configuring Backup Controllers 477
  Configuring Backup Controllers (GUI) 477
  Configuring Backup Controllers (CLI) 478
Configuring High Availability 481
  Information About High Availability 481
  Restrictions on High Availability 484
  Configuring High Availability (GUI) 486
  Configuring High Availability (CLI) 487
Configuring Failover Priority for Access Points 489
  Information About Configuring Failover Priority for Access Points 489
  Configuring Failover Priority for Access Points (GUI) 489
  Configuring Failover Priority for Access Points (CLI) 490
  Viewing Failover Priority Settings (CLI) 490
Configuring Access Point Retransmission Interval and Retry Count 491
  Information About Configuring the AP Retransmission Interval and Retry Count 491
  Restrictions for Access Point Retransmission Interval and Retry Count 491
  Configuring the AP Retransmission Interval and Retry Count (GUI) 491
Configuring the Access Point Retransmission Interval and Retry Count (CLI) 492

Configuring Country Codes 493
  Information About Configuring Country Codes 493
  Restrictions for Configuring Country Codes 494
  Configuring Country Codes (GUI) 494
  Configuring Country Codes (CLI) 495

Migrating Access Points from the -J Regulatory Domain to the -U Regulatory Domain 496
  Information About Migrating Access Points from the -J Regulatory Domain to the -U Regulatory Domain 496
  Restrictions for Migrating Access Points from the -J Regulatory Domain to the -U Regulatory Domain 498
  Migrating Access Points to the -U Regulatory Domain (CLI) 498

Using the W56 Band in Japan 499

Dynamic Frequency Selection 500

Optimizing RFID Tracking on Access Points 501
  Information About Optimizing RFID Tracking on Access Points 501
  Optimizing RFID Tracking on Access Points (GUI) 502
  Optimizing RFID Tracking on Access Points (CLI) 502

Configuring Probe Request Forwarding 503
  Information About Configuring Probe Request Forwarding 503
  Configuring Probe Request Forwarding (CLI) 503

Retrieving the Unique Device Identifier on Controllers and Access Points 504
  Information About Retrieving the Unique Device Identifier on Controllers and Access Points 504
  Retrieving the Unique Device Identifier on Controllers and Access Points (GUI) 504
  Retrieving the Unique Device Identifier on Controllers and Access Points (CLI) 505

Performing a Link Test 505
  Information About Performing a Link Test 505
  Performing a Link Test (GUI) 506
  Performing a Link Test (CLI) 506

Configuring Link Latency 507
  Information About Configuring Link Latency 507
  Restrictions for Link Latency 508
  Configuring Link Latency (GUI) 508
  Configuring Link Latency (CLI) 509
Configuring the TCP MSS 510
   Information About Configuring the TCP MSS 510
   Configuring TCP MSS (GUI) 510
   Configuring TCP MSS (CLI) 510
Configuring Power Over Ethernet 511
   Information About Configuring Power over Ethernet 511
   Configuring Power over Ethernet (GUI) 513
   Configuring Power over Ethernet (CLI) 514
Configuring Flashing LEDs 516
   Information About Configuring Flashing LEDs 516
   Configuring Flashing LEDs (CLI) 516
Viewing Clients 517
   Viewing Clients (GUI) 517
   Viewing Clients (CLI) 518
Configuring LED States for Access Points 518
   Configuring the LED State for Access Points in a Network Globally (GUI) 519
   Configuring the LED State for Access Point in a Network Globally (CLI) 519
   Configuring LED State on a Specific Access Point (GUI) 519
   Configuring LED State on a Specific Access Point (CLI) 519

CHAPTER 9

Controlling Mesh Access Points 521
   Information About Cisco Aironet Mesh Access Points 521
   Guidelines and Limitations 522
   Additional References 522
   Access Point Roles 523
   Network Access 523
   Network Segmentation 523
   Cisco Indoor Mesh Access Points 524
   Cisco Outdoor Mesh Access Points 524
   Mesh Deployment Modes 525
      Wireless Mesh Network 525
      Wireless Backhaul 526
         Universal Access 526
      Point-to-Multipoint Wireless Bridging 526
      Point-to-Point Wireless Bridging 527
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Mesh Range (CLI)</td>
<td>528</td>
</tr>
<tr>
<td>Assumptions for the AP1522 Range Calculator</td>
<td>529</td>
</tr>
<tr>
<td>Assumptions for the AP1552 Range Calculator</td>
<td>529</td>
</tr>
<tr>
<td>Architecture Overview</td>
<td>530</td>
</tr>
<tr>
<td>Control And Provisioning of Wireless Access Points (CAPWAP)</td>
<td>530</td>
</tr>
<tr>
<td>Cisco Adaptive Wireless Path Protocol Wireless Mesh Routing</td>
<td>530</td>
</tr>
<tr>
<td>Mesh Neighbors, Parents, and Children</td>
<td>530</td>
</tr>
<tr>
<td>Design Considerations</td>
<td>531</td>
</tr>
<tr>
<td>Wireless Mesh Constraints</td>
<td>531</td>
</tr>
<tr>
<td>Wireless Backhaul Data Rate</td>
<td>531</td>
</tr>
<tr>
<td>ClientLink Technology</td>
<td>535</td>
</tr>
<tr>
<td>Configuring ClientLink (CLI)</td>
<td>536</td>
</tr>
<tr>
<td>Commands Related to ClientLink</td>
<td>537</td>
</tr>
<tr>
<td>Controller Planning</td>
<td>538</td>
</tr>
<tr>
<td>Adding Mesh Access Points to the Mesh Network</td>
<td>539</td>
</tr>
<tr>
<td>Adding MAC Addresses of Mesh Access Points to the MAC Filter</td>
<td>539</td>
</tr>
<tr>
<td>Adding the MAC Address of the Mesh Access Point to the Controller Filter List (GUI)</td>
<td>540</td>
</tr>
<tr>
<td>Adding the MAC Address of the Mesh Access Point to the Controller Filter List (CLI)</td>
<td>541</td>
</tr>
<tr>
<td>Defining Mesh Access Point Role</td>
<td>541</td>
</tr>
<tr>
<td>Information About MAP and RAP Association With the Controller</td>
<td>541</td>
</tr>
<tr>
<td>Configuring the AP Role (GUI)</td>
<td>542</td>
</tr>
<tr>
<td>Configuring the AP Role (CLI)</td>
<td>542</td>
</tr>
<tr>
<td>Configuring Multiple Controllers Using DHCP 43 and DHCP 60</td>
<td>543</td>
</tr>
<tr>
<td>Configuring Backup Controllers</td>
<td>544</td>
</tr>
<tr>
<td>Information About Configuring Backup Controllers</td>
<td>544</td>
</tr>
<tr>
<td>Guidelines and Limitations</td>
<td>544</td>
</tr>
<tr>
<td>Configuring Backup Controllers (GUI)</td>
<td>545</td>
</tr>
<tr>
<td>Configuring Backup Controllers (CLI)</td>
<td>546</td>
</tr>
<tr>
<td>Configuring External Authentication and Authorization Using a RADIUS Server</td>
<td>549</td>
</tr>
<tr>
<td>Configuring RADIUS Servers</td>
<td>549</td>
</tr>
<tr>
<td>Adding a Username to a RADIUS Server</td>
<td>550</td>
</tr>
<tr>
<td>Enabling External Authentication of Mesh Access Points</td>
<td>551</td>
</tr>
<tr>
<td>Enabling External Authentication of Mesh Access Points (GUI)</td>
<td>551</td>
</tr>
</tbody>
</table>
Enabling External Authentication of Mesh Access Points (CLI) 551

Viewing Security Statistics 552

Configuring Global Mesh Parameters 552

Information About Configuring Global Mesh Parameters 552

Configuring Global Mesh Parameters (GUI) 552

Configuring Global Mesh Parameters (CLI) 555

Viewing Global Mesh Parameter Settings (CLI) 556

Configuring Local Mesh Parameters 557

Configuring Wireless Backhaul Data Rate 557

Configuring Ethernet Bridging 559

Enabling Ethernet Bridging (GUI) 560

Configuring Bridge Group Names 560

Configuring Bridge Group Names (CLI) 561

Verifying Bridge Group Names (GUI) 561

Verifying Bridge Group Names (CLI) 561

Configuring Public Safety Band Settings 561

Enabling the 4.9-GHz Band 563

Configuring Interoperability with Cisco 3200 563

Configuration Guidelines for Public Safety 4.9-GHz Band 564

Enabling AP1522 to Associate with Cisco 3200 (GUI) 565

Enabling 1522 and 1524PS Association with Cisco 3200 (CLI) 565

Configuring Power and Channel Settings 566

Configuring Power and Channel Settings (GUI) 566

Configuring the Channels on the Serial Backhaul (CLI) 567

Configuring Antenna Gain 568

Configuring Antenna Gain (GUI) 568

Configuring Antenna Gain (CLI) 568

Backhaul Channel Deselection on Serial Backhaul Access Point 569

Configuring Backhaul Channel Deselection (GUI) 569

Configuring Backhaul Channel Deselection (CLI) 570

Backhaul Channel Deselection Guidelines 573

Configuring Dynamic Channel Assignment (GUI) 574

Configuring Advanced Features 577

Using the 2.4-GHz Radio for Backhaul 577

Changing the Backhaul from 5 GHz to 2.4 GHz 578
Changing the Backhaul from 2.4 GHz to 5 GHz  578
Verifying the Current Backhaul in Use  578
Universal Client Access  579
  Configuring Universal Client Access (GUI)  579
  Configuring Universal Client Access (CLI)  579
Universal Client Access on Serial Backhaul Access Points  580
  Configuring Extended Universal Access (GUI)  580
  Configuring Extended Universal Access (CLI)  582
  Configuring Extended Universal Access from the Cisco Prime Infrastructure  583
Configuring Ethernet VLAN Tagging  583
  Ethernet Port Notes  584
  Ethernet VLAN Tagging Guidelines  584
  VLAN Registration  587
  Enabling Ethernet VLAN Tagging (GUI)  588
  Configuring Ethernet VLAN Tagging (CLI)  590
  Viewing Ethernet VLAN Tagging Configuration Details (CLI)  590
Workgroup Bridge Interoperability with Mesh Infrastructure  592
  Configuring Workgroup Bridges  592
  Supported Workgroup Bridge Modes and Capacities  593
  Viewing Status of WGB Client  595
  Guidelines and Limitations  595
  Example—Configuration of a Workgroup Bridge  596
  WGB Association Check  597
  Link Test Result  599
  WGB Wired/Wireless Client  600
Client Roaming  601
  WGB Roaming Guidelines  601
  Configuration Example  602
  Troubleshooting Tips  603
Configuring Voice Parameters in Indoor Mesh Networks  603
  CAC  604
  QoS and DSCP Marking  604
  Encapsulations  605
  Queuing on the Mesh Access Point  606
  Bridging Backhaul Packets  609
Bridging Packets from and to a LAN 609
Guidelines For Using Voice on the Mesh Network 610
Voice Call Support in a Mesh Network 611
Viewing the Voice Details for Mesh Networks (CLI) 612
Enabling Mesh Multicast Containment for Video 615
Enabling Multicast on a Mesh Network (CLI) 616
IGMP Snooping 616
Locally Significant Certificates for Mesh APs 617
  Guidelines and Limitations 617
  Differences Between LSCs for Mesh APs and Normal APs 618
  Certificate Verification Process in LSC AP 618
  Configuring an LSC (CLI) 618
  LSC-Related Commands 620
  Controller CLI show Commands 621
  Controller GUI Security Settings 621
Deployment Guidelines 623
Slot Bias Options 623
  Information About Slot Bias Options 623
  Disabling Slot Bias 624
  Guidelines and Limitations 624
  Commands Related to Slot Bias 624
Preferred Parent Selection 625
  Guidelines and Limitations 625
  Configuring a Preferred Parent 626
Co-Channel Interference 627
Viewing Mesh Statistics for a Mesh Access Point 627
  Viewing Mesh Statistics for a Mesh Access Point (GUI) 628
  Viewing Mesh Statistics for an Mesh Access Point (CLI) 632
Viewing Neighbor Statistics for a Mesh Access Point 633
  Viewing Neighbor Statistics for a Mesh Access Point (GUI) 634
  Viewing the Neighbor Statistics for a Mesh Access Point (CLI) 636
Converting Indoor Access Points to Mesh Access Points 637
Changing MAP and RAP Roles for Indoor Mesh Access Points 638
  Changing MAP and RAP Roles for Indoor Mesh Access Points (GUI) 638
  Changing MAP and RAP Roles for Indoor Mesh Access Points (CLI) 639
Converting Indoor Mesh Access Points to Nonmesh Lightweight Access Points (1130AG, 1240AG) 639

Configuring Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers 640
  Guidelines and Limitations 640
  Enabling Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers (GUI) 642
  Enabling Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers (CLI) 643

CHAPTER 10  Managing Controller Software and Configurations 645
  Upgrading the Controller Software 645
    Restrictions for Upgrading Controller Software 646
    Upgrading Controller Software (GUI) 649
    Upgrading Controller Software (CLI) 650
  Predownloading an Image to an Access Point 652
    Access Point Predownload Process 653
    Restrictions for Predownloading an Image to an Access Point 654
    Predownloading an Image to Access Points—Global Configuration (GUI) 654
    Predownloading an Image to Access Points (CLI) 656
  Transferring Files to and from a Controller 658
    Downloading a Login Banner File 658
      Downloading a Login Banner File (GUI) 659
      Downloading a Login Banner File (CLI) 660
      Clearing the Login Banner (GUI) 661
    Downloading Device Certificates 661
      Downloading Device Certificates (GUI) 662
      Downloading Device Certificates (CLI) 663
    Downloading CA Certificates 664
      Download CA Certificates (GUI) 664
      Downloading CA Certificates (CLI) 665
  Uploading PACs 666
    Uploading PACs (GUI) 666
    Uploading PACs (CLI) 667
  Uploading and Downloading Configuration Files 668
### CHAPTER 11  Managing User Accounts 677

- Information About Creating Guest Accounts 677
- Restrictions on Managing User Accounts 678
- Creating a Lobby Ambassador Account 678
  - Creating a Lobby Ambassador Account (GUI) 678
  - Creating a Lobby Ambassador Account (CLI) 679
  - Creating Guest User Accounts as a Lobby Ambassador (GUI) 679
- Viewing Guest User Accounts 680
  - Viewing the Guest Accounts (GUI) 680
  - Viewing the Guest Accounts (CLI) 680
- Obtaining a Web Authentication Certificate 680
  - Information About Web Authentication Certificates 680
  - Obtaining Web Authentication Certificates 681
    - Obtaining a Web Authentication Certificate (GUI) 681
    - Obtaining a Web Authentication Certificate (CLI) 682
- Web Authentication Process 683
  - Guidelines and Limitations 684
- Choosing the Default Web Authentication Login Page 686
  - Information About Default Web Authentication Login Page 686
  - Guidelines and Limitations 687
- Choosing the Default Web Authentication Login Page (GUI) 687
- Choosing the Default Web Authentication Login Page (CLI) 687
- Example: Creating a Customized Web Authentication Login Page 689
Example: Modified Default Web Authentication Login Page Example 692
Generating a Certificate Signing Request 692
    Downloading Third-Party Certificate (GUI) 694
    Downloading Third-Party Certificate (CLI) 695
Using a Customized Web Authentication Login Page from an External Web Server 696
    Information About Customized Web Authentication Login Page 696
    Guidelines and Limitations 696
Choosing a Customized Web Authentication Login Page from an External Web Server 696
    Choosing a Customized Web Authentication Login Page from an External Web Server (GUI) 696
    Choosing a Customized Web Authentication Login Page from an External Web Server (CLI) 697
    Additional References 697
Downloading a Customized Web Authentication Login Page 697
    Prerequisites for Downloading a Customized Web Authentication Login Page 698
    Additional References 698
    Downloading a Customized Web Authentication Login Page (GUI) 698
    Downloading a Customized Web Authentication Login Page (CLI) 699
    Additional References 700
    Example: Customized Web Authentication Login Page 700
    Verifying the Web Authentication Login Page Settings (CLI) 700
Assigning Login, Login Failure, and Logout Pages per WLAN 701
    Information About Assigning Login, Login Failure, and Logout Pages per WLAN 701
    Assigning Login, Login Failure, and Logout Pages per WLAN (GUI) 701
    Assigning Login, Login Failure, and Logout Pages per WLAN (CLI) 702
Configuring Wired Guest Access 703
    Information About Wired Guest Access 703
    Prerequisites for Configuring Wired Guest Access 704
    Restrictions for Configuring Wired Guest Access 704
Configuring Wired Guest Access 705
    Configuring Wired Guest Access (GUI) 705
    Configuring Wired Guest Access (CLI) 707
    Supporting IPv6 Client Guest Access 709

C H A P T E R 12  Radio Resource Management 711
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information About Radio Resource Management</td>
<td>711</td>
</tr>
<tr>
<td>Radio Resource Monitoring</td>
<td>712</td>
</tr>
<tr>
<td>Transmit Power Control</td>
<td>712</td>
</tr>
<tr>
<td>Overriding the TPC Algorithm with Minimum and Maximum Transmit Power Settings</td>
<td>713</td>
</tr>
<tr>
<td>Dynamic Channel Assignment</td>
<td>713</td>
</tr>
<tr>
<td>Coverage Hole Detection and Correction</td>
<td>715</td>
</tr>
<tr>
<td>Benefits of RRM</td>
<td>715</td>
</tr>
<tr>
<td>Restrictions for Configuring RRM</td>
<td>715</td>
</tr>
<tr>
<td>Configuring RRM</td>
<td>716</td>
</tr>
<tr>
<td>Configuring the RF Group Mode (GUI)</td>
<td>716</td>
</tr>
<tr>
<td>Configuring the RF Group Mode (CLI)</td>
<td>717</td>
</tr>
<tr>
<td>Configuring Transmit Power Control (GUI)</td>
<td>718</td>
</tr>
<tr>
<td>Configuring Off-Channel Scanning Defer</td>
<td>719</td>
</tr>
<tr>
<td>Information About Off-Channel Scanning Defer</td>
<td>719</td>
</tr>
<tr>
<td>Configuring Off-Channel Scanning Defer for WLANs</td>
<td>720</td>
</tr>
<tr>
<td>Configuring Off-Channel Scanning Defer for a WLAN (GUI)</td>
<td>720</td>
</tr>
<tr>
<td>Configuring Off Channel Scanning Defer for a WLAN (CLI)</td>
<td>720</td>
</tr>
<tr>
<td>Configuring Dynamic Channel Assignment (GUI)</td>
<td>720</td>
</tr>
<tr>
<td>Configuring Coverage Hole Detection (GUI)</td>
<td>723</td>
</tr>
<tr>
<td>Configuring RRM Profile Thresholds, Monitoring Channels, and Monitor Intervals (GUI)</td>
<td>725</td>
</tr>
<tr>
<td>Configuring RRM (CLI)</td>
<td>726</td>
</tr>
<tr>
<td>Viewing RRM Settings (CLI)</td>
<td>730</td>
</tr>
<tr>
<td>Debug RRM Issues (CLI)</td>
<td>730</td>
</tr>
<tr>
<td>Configuring RRM Neighbor Discovery Packets</td>
<td>731</td>
</tr>
<tr>
<td>Information About RRM NDP and RF Grouping</td>
<td>731</td>
</tr>
<tr>
<td>Configuring RRM NDP (CLI)</td>
<td>731</td>
</tr>
<tr>
<td>Configuring RF Groups</td>
<td>732</td>
</tr>
<tr>
<td>Information About RF Groups</td>
<td>732</td>
</tr>
<tr>
<td>RF Group Leader</td>
<td>732</td>
</tr>
<tr>
<td>RF Group Name</td>
<td>734</td>
</tr>
<tr>
<td>Controllers and APs in RF Groups</td>
<td>734</td>
</tr>
<tr>
<td>Configuring RF Groups</td>
<td>734</td>
</tr>
<tr>
<td>Configuring an RF Group Name (GUI)</td>
<td>735</td>
</tr>
</tbody>
</table>
Configuring an RF Group Name (CLI) 735
Viewing the RF Group Status 735
Viewing the RF Group Status (GUI) 736
Viewing the RF Group Status (CLI) 736

Overriding RRM 737
Information About Overriding RRM 737
Prerequisites for Overriding RRM 737
Restrictions for Overriding RRM 737
Statically Assigning Channel and Transmit Power Settings to Access Point Radios 737
Statically Assigning Channel and Transmit Power Settings (GUI) 737
Statically Assigning Channel and Transmit Power Settings (CLI) 739
Disabling Dynamic Channel and Power Assignment Globally for a Controller 742
Disabling Dynamic Channel and Power Assignment (GUI) 742
Disabling Dynamic Channel and Power Assignment (CLI) 742

Configuring Rogue Access Point Detection in RF Groups 743
Information About Rogue Access Point Detection in RF Groups 743
Configuring Rogue Access Point Detection in RF Groups 743
Enabling Rogue Access Point Detection in RF Groups (GUI) 743
Configuring Rogue Access Point Detection in RF Groups (CLI) 744

Configuring CCX Radio Management Features 744
Information About CCX Radio Management Features 744
Radio Measurement Requests 745
Location Calibration 745
Configuring CCX Radio Management 746
Configuring CCX Radio Management (GUI) 746
Configuring CCX Radio Management (CLI) 746
Viewing CCX Radio Management Information (CLI) 747
Debugging CCX Radio Management Issues (CLI) 748

CHAPTER 13
Configuring Cisco CleanAir 749
Information About CleanAir 749
Role of the Cisco Wireless LAN Controller in a Cisco CleanAir System 750
Interference Types that Cisco CleanAir Can Detect 750
Persistent Devices 751
Persistent Devices Detection 751
Contents

Persistent Devices Propagation 752
Guidelines and Limitations 752
Configuring Cisco CleanAir 753
  Configuring Cisco CleanAir on the Controller 753
    Configuring Cisco CleanAir on the Cisco Wireless LAN Controller (GUI) 753
    Configuring Cisco CleanAir on the Cisco Wireless LAN Controller (CLI) 755
  Configuring Cisco CleanAir on an Access Point 759
    Configuring Cisco CleanAir on an Access Point (GUI) 759
    Configuring Cisco CleanAir on an Access Point (CLI) 760
Monitoring the Interference Devices 760
  Prerequisites for Monitoring the Interference Devices 761
  Monitoring the Interference Device (GUI) 761
  Monitoring the Interference Device (CLI) 762
    Detecting Interferers by an Access Point 762
    Detecting Interferers by Device Type 763
    Detecting Persistent Sources of Interference 763
  Monitoring Persistent Devices (GUI) 763
  Monitoring Persistent Devices (CLI) 764
Monitoring the Air Quality of Radio Bands 764
  Monitoring the Air Quality of Radio Bands (GUI) 764
  Monitoring the Air Quality of Radio Bands (CLI) 765
    Viewing a Summary of the Air Quality 765
    Viewing Air Quality for all Access Points on a Radio Band 765
    Viewing Air Quality for an Access Point on a Radio Band 765
  Monitoring the Worst Air Quality of Radio Bands (GUI) 765
  Monitoring the Worst Air Quality of Radio Bands (CLI) 766
    Viewing a Summary of the Air Quality (CLI) 766
    Viewing the Worst Air Quality Information for all Access Points on a Radio Band (CLI) 766
    Viewing the Air Quality for an Access Point on a Radio Band (CLI) 766
    Viewing the Air Quality for an Access Point by Device Type (CLI) 766
    Detecting Persistent Sources of Interference (CLI) 767
Information About Spectrum Expert Connection 767
  Configuring Spectrum Expert (GUI) 768
Related Documents 769
CHAPTER 14

FlexConnect 771

Information About FlexConnect 771

  FlexConnect Authentication Process 773

Restrictions on FlexConnect 777

Configuring FlexConnect 778

  Configuring the Switch at a Remote Site 778
    Configuring the Switch with Multicast enabled directly 779
  Configuring the Controller for FlexConnect 780
    Configuring the Controller for FlexConnect for a Centrally Switched WLAN Used for
    Guest Access 781
    Configuring the Controller for FlexConnect (GUI) 781
    Configuring the Controller for FlexConnect (CLI) 783

  Configuring an Access Point for FlexConnect 785
    Configuring an Access Point for FlexConnect (GUI) 785
    Configuring an Access Point for FlexConnect (CLI) 787
    Configuring an Access Point for Local Authentication on a WLAN (GUI) 789
    Configuring an Access Point for Local Authentication on a WLAN (CLI) 789

Connecting Client Devices to WLANs 790

Configuring FlexConnect ACLs 790

  Information About Access Control Lists 790

Restrictions for FlexConnect ACLs 791

Configuring FlexConnect ACLs 791

  Configuring FlexConnect ACLs (GUI) 791
  Configuring FlexConnect ACLs (CLI) 793
  Viewing and Debugging FlexConnect ACLs (CLI) 794

Configuring FlexConnect Groups 795

  Information About FlexConnect Groups 795

    FlexConnect Groups and Backup RADIUS Servers 795
    FlexConnect Groups and CCKM 795
    FlexConnect Groups and Opportunistic Key Caching 796
    FlexConnect Groups and Local Authentication 796

  Configuring FlexConnect Groups (GUI) 797
  Configuring FlexConnect Groups (CLI) 799
CHAPTER 15

Mobility Groups 807

Information About Mobility 807
Information About Mobility Groups 811
Messaging Among Mobility Groups 813
Using Mobility Groups with NAT Devices 814
Mobility Groups 814
Prerequisites for Configuring Mobility Groups 814
Configuring Mobility Groups (GUI) 816
Configuring Mobility Groups (CLI) 818
Viewing Mobility Group Statistics 819
Viewing Mobility Group Statistics (GUI) 819
Viewing Mobility Group Statistics (CLI) 821
Configuring Auto-Anchor Mobility 821
Information About Auto-Anchor Mobility 821
Restrictions on Auto-Anchor Mobility 822
Configuring Auto-Anchor Mobility (GUI) 823
Configuring Auto-Anchor Mobility (CLI) 823
Validating WLAN Mobility Security Values 825
Information About WLAN Mobility Security Values 825
Using Symmetric Mobility Tunneling 827
Information About Symmetric Mobility Tunneling 827
Guidelines and Limitations 827

Verifying Symmetric Mobility Tunneling 828
Verifying Symmetric Mobility Tunneling (GUI) 828
Verifying if Symmetric Mobility Tunneling is Enabled (CLI) 828

Running Mobility Ping Tests 828
Information About Mobility Ping Tests 828
Guidelines and Limitations 828
Running Mobility Ping Tests (CLI) 829

Configuring Dynamic Anchoring for Clients with Static IP Addresses 829
Information About Dynamic Anchoring for Clients with Static IP 829
How Dynamic Anchoring of Static IP Clients Works 830
Restrictions on Dynamic Anchoring for Clients With Static IP Addresses 830
Configuring Dynamic Anchoring of Static IP Clients (GUI) 831
Configuring Dynamic Anchoring of Static IP Clients (CLI) 831

Configuring Foreign Mappings 832
Information About Foreign Mappings 832
Configuring Foreign Controller MAC Mapping (GUI) 832
Configuring Foreign Controller MAC Mapping (CLI) 832

Configuring Proxy Mobile IPv6 832
Information About Proxy Mobile IPv6 832
Restrictions on Proxy Mobile IPv6 834
Configuring Proxy Mobile IPv6 (GUI) 835
Configuring Proxy Mobile IPv6 (CLI) 836

**CHAPTER 16**

Configuring Mobile Concierge 839
Information About Mobile Concierge 839
Configuring Mobile Concierge (802.11u) 839
Configuring Mobile Concierge (802.11u) (GUI) 839
Configuring Mobile Concierge (802.11u) (CLI) 840

Configuring 802.11u Mobility Services Advertisement Protocol 841
Information About 802.11u MSAP 841
Configuring 802.11u MSAP (GUI) 842
Configuring MSAP (CLI) 842
Configuring 802.11u HotSpot 842
Information About 802.11u HotSpot 842
Configuring 802.11u HotSpot (GUI) 843
Configuring HotSpot 2.0 (CLI) 843
Configuring Access Points for HotSpot2 (GUI) 845
Configuring Access Points for HotSpot2 (CLI) 845
Downloading the Icon File (CLI) 849

APPENDIX A

Troubleshooting 851
Interpreting LEDs 851
Information About Interpreting LEDs 851
Interpreting Controller LEDs 852
Interpreting Lightweight Access Point LEDs 852
System Messages 852
Information About System Messages 852
Viewing System Resources 855
Information About Viewing System Resources 855
Guidelines and Limitations - not used 856
Viewing System Resources (GUI) 856
Viewing System Resources (CLI) 856
Using the CLI to Troubleshoot Problems 857
Configuring System and Message Logging 858
Information About System and Message Logging 858
Configuring System and Message Logging (GUI) 858
Viewing Message Logs (GUI) 860
Configuring System and Message Logging (CLI) 861
Viewing System and Message Logs (CLI) 864
Viewing Access Point Event Logs 865
Information About Access Point Event Logs 865
Viewing Access Point Event Logs (CLI) 865
Uploading Logs and Crash Files 866
Prerequisites to Upload Logs and Crash Files 866
Uploading Logs and Crash Files (GUI) 866
Uploading Logs and Crash Files (CLI) 867
Uploading Core Dumps from the Controller 868
Information About Uploading Core Dumps from the Controller 868
Configuring the Controller to Automatically Upload Core Dumps to an FTP Server (GUI) 868
Configuring the Controller to Automatically Upload Core Dumps to an FTP Server (CLI) 869
Uploading Core Dumps from Controller to a Server (CLI) 870
Uploading Packet Capture Files 871
Information About Uploading Packet Capture Files 871
Restrictions for Uploading Packet Capture Files 872
Uploading Packet Capture Files (GUI) 873
Uploading Packet Capture Files (CLI) 873
Monitoring Memory Leaks 874
Monitoring Memory Leaks (CLI) 874
Troubleshooting CCXv5 Client Devices 875
Information About Troubleshooting CCXv5 Client Devices 875
Restrictions for CCXv5 Client Devices 875
Configuring Diagnostic Channel 876
Configuring the Diagnostic Channel (GUI) 876
Configuring the Diagnostic Channel (CLI) 877
Configuring Client Reporting 881
Configuring Client Reporting (GUI) 881
Configuring Client Reporting (CLI) 881
Configuring Roaming and Real-Time Diagnostics 882
Configuring Roaming and Real-Time Diagnostics (CLI) 882
Using the Debug Facility 885
Information About Using the Debug Facility 885
Configuring the Debug Facility (CLI) 887
Configuring Wireless Sniffing 890
Information About Wireless Sniffing 890
Restrictions for Wireless Sniffing 891
Configuring Sniffing on an Access Point (GUI) 891
Configuring Sniffing on an Access Point (CLI) 892
Troubleshooting Access Points Using Telnet or SSH 892
Guidelines and Limitations 893
Troubleshooting Access Points Using Telnet or SSH (GUI) 893
Troubleshooting Access Points Using Telnet or SSH (CLI) 893
Debugging the Access Point Monitor Service 894
Information About Debugging the Access Point Monitor Service 894
Debugging Access Point Monitor Service Issues (CLI) 894
Troubleshooting OfficeExtend Access Points 895
  Information About Troubleshooting OfficeExtend Access Points 895
  Interpreting OfficeExtend LEDs 895
  Positioning OfficeExtend Access Points for Optimal RF Coverage 895
Troubleshooting Common Problems 895
Preface

This preface describes the audience, organization, and conventions of this document. It also provides information on how to obtain other documentation. This chapter includes the following sections:

- Audience, page xlvi
- Conventions, page xlvii
- Related Documentation, page xlviii
- Obtaining Documentation and Submitting a Service Request, page xlix

Audience

This publication is for experienced network administrators who configure and maintain Cisco wireless controllers and Cisco lightweight access points.

Conventions

This document uses the following conventions:

Table 1: Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong> font</td>
<td>Commands and keywords and user-entered text appear in <strong>bold</strong> font.</td>
</tr>
<tr>
<td><em>italic</em> font</td>
<td>Document titles, new or emphasized terms, and arguments for which you supply values are in <em>italic</em> font.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Elements in square brackets are optional.</td>
</tr>
<tr>
<td>{x</td>
<td>y</td>
</tr>
<tr>
<td>[x</td>
<td>y</td>
</tr>
</tbody>
</table>
**Convention** | **Indication**
--- | ---
string | A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.
courier font | Terminal sessions and information the system displays appear in courier font.
<> | Nonprinting characters such as passwords are in angle brackets.
[] | Default responses to system prompts are in square brackets.
!, # | An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.

**Note**
Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.

**Tip**
Means the following information will help you solve a problem.

**Caution**
Means reader be careful. In this situation, you might perform an action that could result in equipment damage or loss of data.

---

**Related Documentation**

These documents provide complete information about Cisco Wireless:

- Cisco Wireless Controller configuration guides:
  

- Cisco Wireless Controller command references:
  

- Cisco Wireless Controller System Message Guide:
  

- Release Notes for Cisco Wireless Controllers and Lightweight Access Points:
  

- Cisco Wireless Mesh Access Points, Design and Deployment Guide:
  

- Cisco Prime Infrastructure documentation:
  

- Cisco Mobility Services Engine documentation:
  
Click this link to access user documentation pertaining to Cisco Wireless solution:


**Obtaining Documentation and Submitting a Service Request**

For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and gathering additional information, see [What's New in Cisco Product Documentation](http://www.cisco.com.cisco.web/psa/default.html?mode=prod).

To receive new and revised Cisco technical content directly to your desktop, you can subscribe to the [What's New in Cisco Product Documentation RSS feed](http://www.cisco.com.cisco.web/psa/default.html?mode=prod). RSS feeds are a free service.
Overview

This chapter describes the controller components and features. It contains these sections:

- Introduction, page 1
- Operating System Software, page 3
- Operating System Security, page 4
- Layer 2 and Layer 3 Operation, page 4
- Cisco Wireless Controllers, page 5
- Cisco Wireless Solution WLANs, page 6
- File Transfers, page 6
- Power over Ethernet, page 6
- Cisco Wireless Controller Memory, page 7
- Cisco Wireless Controller Failover Protection, page 7

Introduction

Cisco Wireless is designed to provide 802.11 wireless networking solutions for enterprises and service providers. Cisco Wireless simplifies deploying and managing large-scale wireless LANs and enables a unique best-in-class security infrastructure. The operating system manages all data client, communications, and system administration functions, performs radio resource management (RRM) functions, manages system-wide mobility policies using the operating system security solution, and coordinates all security functions using the operating system security framework.

Cisco Wireless solution consists of Cisco wireless controllers (Cisco WLCs) and their associated lightweight access points controlled by the operating system, all concurrently managed by any or all of the operating system user interfaces:

- An HTTP and/or HTTPS full-featured Web User Interface hosted by Cisco WLCs can be used to configure and monitor individual Cisco WLCs.
- A full-featured command-line interface (CLI) can be used to configure and monitor individual Cisco Cisco WLCs.
• The Cisco Prime Infrastructure, which you use to configure and monitor one or more Cisco WLCs and associated access points. The Prime Infrastructure has tools to facilitate large-system monitoring and control. For more information about Cisco Prime Infrastructure, see http://www.cisco.com/c/en/us/support/cloud-systems-management/prime-infrastructure/tsd-products-support-series-home.html.

• An industry-standard SNMP V1, V2c, and V3 interface can be used with any SNMP-compliant third-party network management system.

The Cisco Wireless solution supports client data services, client monitoring and control, and all rogue access point detection, monitoring, and containment functions. It uses lightweight access points, Cisco WLCs, and the optional Cisco Prime Infrastructure to provide wireless services to enterprises and service providers.


Single-Controller Deployments

A standalone controller can support lightweight access points across multiple floors and buildings simultaneously and support the following features:

• Autodetecting and autoconfiguring lightweight access points as they are added to the network.

• Full control of lightweight access points.

• Lightweight access points connect to controllers through the network. The network equipment may or may not provide Power over Ethernet (PoE) to the access points.

Some controllers use redundant Gigabit Ethernet connections to bypass single network failures.

Note

Some controllers can connect through multiple physical ports to multiple subnets in the network. This feature can be helpful when you want to confine multiple VLANs to separate subnets.

This figure shows a typical single-controller deployment.

Figure 1: Single-Controller Deployment
Multiple-Controller Deployments

Each controller can support lightweight access points across multiple floors and buildings simultaneously. However, full functionality of the Cisco wireless LAN solution occurs when it includes multiple controllers. A multiple-controller system has the following additional features:

- Autodetecting and autoconfiguring RF parameters as the controllers are added to the network.
- Same-subnet (Layer 2) roaming and inter-subnet (Layer 3) roaming.
- Automatic access point failover to any redundant controller with a reduced access point load.

The following figure shows a typical multiple-controller deployment. The figure also shows an optional dedicated management network and the three physical connection types between the network and the controllers.

**Figure 2: Typical Multiple-Controller Deployment**

---

Operating System Software

The operating system software controls controllers and lightweight access points. It includes full operating system security and radio resource management (RRM) features.
## Operating System Security

Operating system security bundles Layer 1, Layer 2, and Layer 3 security components into a simple, Cisco WLAN solution-wide policy manager that creates independent security policies for each of up to 16 wireless LANs.

The 802.11 Static WEP weaknesses can be overcome using the following robust industry-standard security solutions:

- 802.1X dynamic keys with extensible authentication protocol (EAP).
- Wi-Fi protected access (WPA) dynamic keys. The Cisco WLAN solution WPA implementation includes:
  - Temporal key integrity protocol (TKIP) and message integrity code checksum dynamic keys
  - WEP keys, with or without a preshared key passphrase
- RSN with or without a preshared key
- Optional MAC filtering

The WEP problem can be further solved using the following industry-standard Layer 3 security solutions:

- Passthrough VPNs
- Local and RADIUS MAC address filtering
- Local and RADIUS user/password authentication
- Manual and automated disabling to block access to network services. In manual disabling, you block access using client MAC addresses. In automated disabling, which is always active, the operating system software automatically blocks access to network services for a user-defined period of time when a client fails to authenticate for a fixed number of consecutive attempts. This feature can be used to deter brute-force login attacks.

These and other security features use industry-standard authorization and authentication methods to ensure the highest possible security for your business-critical wireless LAN traffic.

## Layer 2 and Layer 3 Operation

Lightweight Access Point Protocol (LWAPP) communications between the controller and lightweight access points can be conducted at Layer 2 or Layer 3. Control and Provisioning of Wireless Access Points protocol (CAPWAP) communications between the controller and lightweight access points are conducted at Layer 3. Layer 2 mode does not support CAPWAP.

### Note

The IPv4 network layer protocol is supported for transport through a CAPWAP or LWAPP controller system. IPv6 (for clients only) and AppleTalk are also supported but only on Cisco 5500 Series Controllers and the Cisco WiSM2. Other Layer 3 protocols (such as IPX, DECnet Phase IV, OSI CLNP, and so on) and Layer 2 (bridged) protocols (such as LAT and NetBeui) are not supported.
Operational Requirements

The requirement for Layer 3 LWAPP communications is that the controller and lightweight access points can be connected through Layer 2 devices on the same subnet or connected through Layer 3 devices across subnets. Another requirement is that the IP addresses of access points should be either statically assigned or dynamically assigned through an external DHCP server.

The requirement for Layer 3 CAPWAP communications is that the controller and lightweight access points can be connected through Layer 2 devices on the same subnet or connected through Layer 3 devices across subnets.

Configuration Requirements

When you are operating the Cisco wireless LAN solution in Layer 2 mode, you must configure a management interface to control your Layer 2 communications.

When you are operating the Cisco wireless LAN solution in Layer 3 mode, you must configure an AP-manager interface to control lightweight access points and a management interface as configured for Layer 2 mode.

Cisco Wireless Controllers

When you are adding lightweight access points to a multiple-Cisco WLC deployment network, it is convenient to have all lightweight access points associate with one master Cisco WLC on the same subnet. That way, the you do not have to log into multiple Cisco WLCs to find out which controller newly-added lightweight access points associated with.

One Cisco WLC in each subnet can be assigned as the master Cisco WLC while adding lightweight access points. As long as a master Cisco WLC is active on the same subnet, all new access points without a primary, secondary, and tertiary controller assigned automatically attempt to associate with the master Cisco WLC.

You can monitor the master Cisco WLC using the Cisco Prime Infrastructure Web User Interface and watch as access points associate with the master Cisco WLC. You can then verify the access point configuration and assign a primary, secondary, and tertiary Cisco WLC to the access point, and reboot the access point so it reassociates with its primary, secondary, or tertiary Cisco WLC.

Note

Lightweight access points without a primary, secondary, and tertiary Cisco WLC assigned always search for a master Cisco WLC first upon reboot. After adding lightweight access points through the master Cisco WLC, you should assign primary, secondary, and tertiary Cisco WLCs to each access point. We recommend that you disable the master setting on all Cisco WLCs after initial configuration.

Client Location

When you use Cisco Prime Infrastructure in your Cisco wireless LAN solution, controllers periodically determine the client, rogue access point, rogue access point client, radio frequency ID (RFID) tag location and store the locations in the Cisco Prime Infrastructure database.
Cisco WLC Platforms

Cisco WLCs are enterprise-class high-performance wireless switching platforms that support 802.11a/n and 802.11b/g/n protocols. They operate under control of the operating system, which includes the radio resource management (RRM), creating a Cisco Wireless solution that can automatically adjust to real-time changes in the 802.11 RF environment. Cisco WLCs are built around high-performance network and security hardware, resulting in highly reliable 802.11 enterprise networks with unparalleled security.

The following Cisco WLCs are supported:

• Cisco 2504 Wireless Controller
• Cisco 5508 Wireless Controller
• Cisco Flex 7510 Wireless Controller
• Cisco 8510 Wireless Controller
• Cisco Virtual Wireless Controller
• Catalyst Wireless Services Module (WiSM2)

Cisco Wireless Solution WLANs

The Cisco Wireless solution can control up to 512 WLANs for lightweight access points. Each WLAN has a separate WLAN ID (1 through 512), a separate profile name, and a WLAN SSID and can be assigned with unique security policies. The lightweight access points broadcast all active Cisco Wireless solution WLAN SSIDs and enforce the policies defined for each WLAN.

Note
We recommend that you assign one set of VLANs for WLANs and a different set of VLANs for management interfaces to ensure that controllers operate with optimum performance and ease of management.

If management over wireless is enabled across the Cisco Wireless solution, you can manage the system across the enabled WLAN using CLI and Telnet, HTTP/HTTPS, and SNMP.

File Transfers

You can upload and download operating system code, configuration, and certificate files to and from the controller using the GUI, CLI, or Cisco Prime Infrastructure.

Power over Ethernet

Lightweight access points can receive power through their Ethernet cables from 802.3af-compatible Power over Ethernet (PoE) devices, which can reduce the cost of discrete power supplies, additional wiring, conduits, outlets, and installation time. PoE frees you from having to mount lightweight access points or other powered equipment near AC outlets, which provides greater flexibility in positioning the access points for maximum coverage.
When you are using PoE, you run a single CAT-5 cable from each lightweight access point to PoE-equipped network elements, such as a PoE power hub or a Cisco WLAN solution single-line PoE injector. When the PoE equipment determines that the lightweight access point is PoE-enabled, it sends 48 VDC over the unused pairs in the Ethernet cable to power the access point.

The PoE cable length is limited by the 100BASE-T or 10BASE-T specification to 100 m or 200 m, respectively.

**Cisco Wireless Controller Memory**

The controller contains two kinds of memory: volatile RAM, which holds the current, active controller configuration, and NVRAM (nonvolatile RAM), which holds the reboot configuration. When you are configuring the operating system in the controller, you are modifying volatile RAM; you must save the configuration from the volatile RAM to the NVRAM to ensure that the controller reboots in the current configuration.

Knowing which memory you are modifying is important when you are doing the following tasks:

- Using the configuration wizard
- Clearing the controller configuration
- Saving configurations
- Resetting the controller
- Logging out of the CLI

**Cisco Wireless Controller Failover Protection**

During installation, we recommend that you connect all lightweight access points to a dedicated controller, and configure each lightweight access point for final operation. This step configures each lightweight access point for a primary, secondary, and tertiary controller and allows it to store the configured mobility group information.

During the failover recovery, the following tasks are performed:

- The configured access point attempts to contact the primary, secondary, and tertiary controllers, and then attempts to contact the IP addresses of the other controllers in the mobility group.
- DNS is resolved with the controller IP address.
- DHCP servers get the controller IP addresses (vendor-specific option 43 in DHCP offer).

In multiple-controller deployments, if one controller fails, the access points perform the following tasks:

- If the lightweight access point has a primary, secondary, and tertiary controller assigned, it attempts to associate with that controller.
- If the access point has no primary, secondary, or tertiary controllers assigned or if its primary, secondary, or tertiary controllers are unavailable, it attempts to associate with a master controller.
- If the access point finds no master controller, it attempts to contact stored mobility group members by the IP address.
• If the mobility group members are available, and if the lightweight access point has no primary, secondary, and tertiary controllers assigned and there is no master controller active, it attempts to associate with the least-loaded controller to respond to its discovery messages.

When controllers are deployed, if one controller fails, active access point client sessions are momentarily dropped while the dropped access point associates with another controller, allowing the client device to immediately reassociate and reauthenticate.

CHAPTER 2

Using the Web-Browser and CLI Interfaces

This chapter describes how to initially configure and log into the controller. It contains these sections:

- Configuring the Controller Using the Configuration Wizard, page 9
- Connecting the Console Port of the Controller, page 10
- Configuring the Controller (GUI), page 10
- Configuring the Controller—Using the CLI Configuration Wizard, page 21
- Using the Controller GUI, page 23
- Loading an Externally Generated SSL Certificate, page 27
- Information About Externally Generated SSL Certificates, page 27
- Loading an SSL Certificate (GUI), page 28
- Loading an SSL Certificate (CLI), page 29
- Using the Controller CLI, page 30
- Using the AutoInstall Feature for Controllers Without a Configuration, page 33
- Information About the AutoInstall Feature, page 33
- Guidelines and Limitations, page 34
- Managing the Controller System Date and Time, page 37
- Telnet and Secure Shell Sessions, page 42
- Managing the Controller Wirelessly, page 46

Configuring the Controller Using the Configuration Wizard

The configuration wizard enables you to configure basic settings on the controller. You can run the wizard after you receive the controller from the factory or after the controller has been reset to factory defaults. The configuration wizard is available in both GUI and CLI formats.
Connecting the Console Port of the Controller

Before you can configure the controller for basic operations, you need to connect it to a PC that uses a VT-100 terminal emulation program (such as HyperTerminal, ProComm, Minicom, or Tip).

Note
On Cisco 5500 Series Controllers, you can use either the RJ-45 console port or the USB console port. If you use the USB console port, plug the 5-pin mini Type B connector into the controller’s USB console port and the other end of the cable into the PC’s USB Type A port. The first time that you connect a Windows PC to the USB console port, you are prompted to install the USB console driver. Follow the installation prompts to install the driver. The USB console driver maps to a COM port on your PC; you then need to map the terminal emulator application to the COM port.

Step 1
Connect one end of a null-modem serial cable to the controller's console port and the other end to your PC's serial port.

Step 2
Start the PC’s VT-100 terminal emulation program.

Step 3
Configure the terminal emulation program for these parameters:
- 9600 baud
- 8 data bits
- 1 stop bit
- No parity
- No hardware flow control

Step 4
Plug the AC power cord into the controller and a grounded 100 to 240 VAC, 50/60-Hz electrical outlet. Turn on the power supply. The bootup script displays operating system software initialization (code download and power-on self test verification) and basic configuration. If the controller passes the power-on self test, the bootup script runs the configuration wizard, which prompts you for basic configuration input.

Configuring the Controller (GUI)

Step 1
Connect your PC to the service port and configure it to use the same subnet as the controller.

Note
In case of Cisco WLC 2500, connect your PC to the port 2 on the controller and configure to use the same subnet.

Step 2
Start Internet Explorer 6.0 SP1 (or later) or Firefox 2.0.0.11 (or later) on your PC and browse to http://192.168.1.1. The configuration wizard appears. You can use both HTTP and HTTPS when using the service port interface. HTTPS is enabled by default and HTTP can also be enabled. The default IP address to connect to the service port interface is 192.168.1.1.

Note
For the initial GUI Configuration Wizard only, you cannot access the controller using IPv6 address.
Step 3  In the System Name text box, enter the name that you want to assign to this controller. You can enter up to 31 ASCII characters.

Step 4  In the User Name text box, enter the administrative username to be assigned to this controller. You can enter up to 24 ASCII characters. The default username is admin.

Step 5  In the Password and Confirm Password text boxes, enter the administrative password to be assigned to this controller. You can enter up to 24 ASCII characters. The default password is admin.

Starting in release 7.0.116.0, the following password policy has been implemented:

- The password must contain characters from at least three of the following classes:
  - Lowercase letters
  - Uppercase letters
  - Digits
  - Special characters

- No character in the password must be repeated more than three times consecutively.

- The new password must not be the same as the associated username and not be the username reversed.

- The password must not be cisco, ocsc, or any variant obtained by changing the capitalization of letters of the word Cisco. In addition, you cannot substitute 1, I, or 1 for i, 0 for o, or $ for s.
Step 6 Click Next. The SNMP Summary screen appears.

Figure 4: Configuration Wizard — SNMP Summary Screen

Step 7 If you want to enable Simple Network Management Protocol (SNMP) v1 mode for this controller, choose Enable from the SNMP v1 Mode drop-down list. Otherwise, leave this parameter set to Disable.

Note SNMP manages nodes (servers, workstations, routers, switches, and so on) on an IP network. Currently, there are three versions of SNMP: SNMPv1, SNMPv2c, and SNMPv3.

Step 8 If you want to enable SNMPv2c mode for this controller, leave this parameter set to Enable. Otherwise, choose Disable from the SNVP v2c Mode drop-down list.

Step 9 If you want to enable SNMPv3 mode for this controller, leave this parameter set to Enable. Otherwise, choose Disable from the SNVP v3 Mode drop-down list.

Step 10 Click Next.

Step 11 When the following message appears, click OK:

Default values are present for v1/v2c community strings.
Please make sure to create new v1/v2c community strings once the system comes up.
Please make sure to create new v3 users once the system comes up.
The Service Interface Configuration screen appears.
Step 12 If you want the controller’s service-port interface to obtain an IP address from a DHCP server, select the **DHCP Protocol Enabled** check box. If you do not want to use the service port or if you want to assign a static IP address to the service port, leave the check box unselected.

**Note** The service-port interface controls communications through the service port. Its IP address must be on a different subnet from the management interface. This configuration enables you to manage the controller directly or through a dedicated management network to ensure service access during network downtime.

Step 13 Perform one of the following:

- If you enabled DHCP, clear out any entries in the IP Address and Netmask text boxes, leaving them blank.
- If you disabled DHCP, enter the static IP address and netmask for the service port in the IP Address and Netmask text boxes.

Step 14 Click Next.
The LAG Configuration screen appears.

*Figure 6: Configuration Wizard — LAG Configuration Screen*

**Step 15**
To enable link aggregation (LAG), choose *Enabled* from the Link Aggregation (LAG) Mode drop-down list. To disable LAG, leave this text box set to *Disabled*.

**Step 16**
Click *Next*
The Management Interface Configuration screen appears.

**Note**
The management interface is the default interface for in-band management of the controller and connectivity to enterprise services such as AAA servers.
Step 17 In the VLAN Identifier text box, enter the VLAN identifier of the management interface (either a valid VLAN identifier or 0 for an untagged VLAN). The VLAN identifier should be set to match the switch interface configuration.

Step 18 In the IP Address text box, enter the IP address of the management interface.

Step 19 In the Netmask text box, enter the IP address of the management interface netmask.

Step 20 In the Gateway text box, enter the IP address of the default gateway.

Step 21 In the Port Number text box, enter the number of the port assigned to the management interface. Each interface is mapped to at least one primary port.

Step 22 In the Backup Port text box, enter the number of the backup port assigned to the management interface. If the primary port for the management interface fails, the interface automatically moves to the backup port.

Step 23 In the Primary DHCP Server text box, enter the IP address of the default DHCP server that will supply IP addresses to clients, the controller's management interface, and optionally, the service port interface.

Step 24 In the Secondary DHCP Server text box, enter the IP address of an optional secondary DHCP server that will supply IP addresses to clients, the controller's management interface, and optionally, the service port interface.

Step 25 Click Next. The AP-Manager Interface Configuration screen appears.

Step 26 In the IP Address text box, enter the IP address of the AP-manager interface.

Step 27 Click Next. The Miscellaneous Configuration screen appears.

**Figure 7: Configuration Wizard — Miscellaneous Configuration Screen**

Step 28 In the RF Mobility Domain Name text box, enter the name of the mobility group/RF group to which you want the controller to belong.

**Note** Although the name that you enter here is assigned to both the mobility group and the RF group, these groups are not identical. Both groups define clusters of controllers, but they have different purposes. All of the controllers in an RF group are usually also in the same mobility group and vice versa. However, a mobility group facilitates scalable, system-wide mobility and controller redundancy while an RF group facilitates scalable, system-wide dynamic RF management.
**Step 29**
The Configured Country Code(s) text box shows the code for the country in which the controller will be used. If you want to change the country of operation, select the check box for the desired country.

*Note* You can choose more than one country code if you want to manage access points in multiple countries from a single controller. After the configuration wizard runs, you must assign each access point joined to the controller to a specific country.

**Step 30**
Click **Next**.

**Step 31**
When the following message appears, click **OK**:

> Warning! To maintain regulatory compliance functionality, the country code setting may only be modified by a network administrator or qualified IT professional. Ensure that proper country codes are selected before proceeding.

The Virtual Interface Configuration screen appears.

*Figure 8: Configuration Wizard — Virtual Interface Configuration Screen*

**Step 32**
In the IP Address text box, enter the IP address of the controller’s virtual interface. You should enter a fictitious, unassigned IP address.

*Note* The virtual interface is used to support mobility management, DHCP relay, and embedded Layer 3 security such as guest web authentication and VPN termination. All controllers within a mobility group must be configured with the same virtual interface IP address.

**Step 33**
In the DNS Host Name text box, enter the name of the Domain Name System (DNS) gateway used to verify the source of certificates when Layer 3 web authorization is enabled.

*Note* To ensure connectivity and web authentication, the DNS server should always point to the virtual interface. If a DNS hostname is configured for the virtual interface, then the same DNS hostname must be configured on the DNS servers used by the client.
Step 34  Click Next. The WLAN Configuration screen appears.

*Figure 9: Configuration Wizard — WLAN Configuration Screen*

Step 35  In the Profile Name text box, enter up to 32 alphanumeric characters for the profile name to be assigned to this WLAN.

Step 36  In the WLAN SSID text box, enter up to 32 alphanumeric characters for the network name, or service set identifier (SSID). The SSID enables basic functionality of the controller and allows access points that have joined the controller to enable their radios.

Step 37  Click Next.

Step 38  When the following message appears, click OK:

*Default Security applied to WLAN is: [WPA2(AES)][Auth(802.1x)]. You can change this after the wizard is complete and the system is rebooted.*
The RADIUS Server Configuration screen is displayed.

Figure 10: Configuration Wizard-RADIUS Server Configuration Screen

Step 39  In the Server IP Address text box, enter the IP address of the RADIUS server.

Step 40  From the Shared Secret Format drop-down list, choose ASCII or Hex to specify the format of the shared secret.

Note  Due to security reasons, the RADIUS shared secret key reverts to ASCII mode even if you have selected HEX as the shared secret format from the Shared Secret Format drop-down list.
Step 41  In the Shared Secret and Confirm Shared Secret text boxes, enter the secret key used by the RADIUS server.

Step 42  In the Port Number text box, enter the communication port of the RADIUS server. The default value is 1812.

Step 43  To enable the RADIUS server, choose Enabled from the Server Status drop-down list. To disable the RADIUS server, leave this text box set to Disabled.

Step 44  Click Apply. The 802.11 Configuration screen appears.

**Figure 11: Configuration Wizard — 802.11 Configuration Screen**

Step 45  To enable the 802.11a, 802.11b, and 802.11g lightweight access point networks, leave the 802.11a Network Status, 802.11b Network Status, and 802.11g Network Status check boxes selected. To disable support for any of these networks, unselect the check boxes.

Step 46  To enable the controller’s radio resource management (RRM) auto-RF feature, leave the Auto RF check box selected. To disable support for the auto-RF feature, unselect this check box.

**Note**  The auto-RF feature enables the controller to automatically form an RF group with other controllers. The group dynamically elects a leader to optimize RRM parameter settings, such as channel and transmit power assignment, for the group.
Step 47  Click Next. The Set Time screen appears.

*Figure 12: Configuration Wizard — Set Time Screen*

Step 48  To manually configure the system time on your controller, enter the current date in Month/DD/YYYY format and the current time in HH:MM:SS format.

Step 49  To manually set the time zone so that Daylight Saving Time (DST) is not set automatically, enter the local hour difference from Greenwich Mean Time (GMT) in the Delta Hours text box and the local minute difference from GMT in the Delta Mins text box.

*Note*  When manually setting the time zone, enter the time difference of the local current time zone with respect to GMT (+/-). For example, Pacific time in the United States is 8 hours behind GMT. Therefore, it is entered as –8.
Step 50
Click Next. The Configuration Wizard Completed screen appears.

Figure 13: Configuration Wizard — Configuration Wizard Completed Screen

Step 51
Click Save and Reboot to save your configuration and reboot the controller.

Step 52
When the following message appears, click OK:

Configuration will be saved and the controller will be rebooted. Click ok to confirm.

The controller saves your configuration, reboots, and prompts you to log on.

Configuring the Controller—Using the CLI Configuration Wizard

Before You Begin

- The available options appear in brackets after each configuration parameter. The default value appears in all uppercase letters.
- If you enter an incorrect response, the controller provides you with an appropriate error message, such as “Invalid Response,” and returns you to the wizard prompt.
- Press the hyphen key if you ever need to return to the previous command line.

Step 1
When prompted to terminate the AutoInstall process, enter yes. If you do not enter yes, the AutoInstall process begins after 30 seconds.
The AutoInstall feature downloads a configuration file from a TFTP server and then loads the configuration onto the controller automatically.

**Step 2** Enter the system name, which is the name that you want to assign to the controller. You can enter up to 31 ASCII characters.

**Step 3** Enter the administrative username and password to be assigned to this controller. You can enter up to 24 ASCII characters for each.
Starting in release 7.0.116.0, the following password policy has been implemented:

- The password must contain characters from at least three of the following classes:
  - Lowercase letters
  - Uppercase letters
  - Digits
  - Special characters
- No character in the password must be repeated more than three times consecutively.
- The new password must not be the same as the associated username and not be the username reversed.
- The password must not be cisco, ocisc, or any variant obtained by changing the capitalization of letters of the word Cisco. In addition, you cannot substitute 1, i, or ! for i, 0 for o, or $ for s.

**Step 4** If you want the controller’s service-port interface to obtain an IP address from a DHCP server, enter **DHCP**. If you do not want to use the service port or if you want to assign a static IP address to the service port, enter none.

**Note** The service-port interface controls communications through the service port. Its IP address must be on a different subnet from the management interface. This configuration enables you to manage the controller directly or through a dedicated management network to ensure service access during network downtime.

**Step 5** If you entered none in Step 4, enter the IP address and netmask for the service-port interface on the next two lines.

**Step 6** Enable or disable link aggregation (LAG) by choosing yes or no.

**Step 7** Enter the IP address of the management interface.

**Note** The management interface is the default interface for in-band management of the controller and connectivity to enterprise services such as AAA servers.

**Step 8** Enter the IP address of the management interface netmask.

**Step 9** Enter the IP address of the default router.

**Step 10** Enter the VLAN identifier of the management interface (either a valid VLAN identifier or 0 for an untagged VLAN). The VLAN identifier should be set to match the switch interface configuration.

**Step 11** Enter the IP address of the default DHCP server that will supply IP addresses to clients, the management interface of the controller, and optionally, the service port interface. Enter the IP address of the AP-manager interface.

**Note** This prompt does not appear for Cisco 5500 Series Controllers because you are not required to configure an AP-manager interface. The management interface acts like an AP-manager interface by default.

**Step 12** Enter the IP address of the controller’s virtual interface. You should enter a fictitious unassigned IP address.

**Note** The virtual interface is used to support mobility management, DHCP relay, and embedded Layer 3 security such as guest web authentication and VPN termination. All controllers within a mobility group must be configured with the same virtual interface IP address.

**Step 13** If desired, enter the name of the mobility group/RF group to which you want the controller to belong.
Although the name that you enter here is assigned to both the mobility group and the RF group, these groups are not identical. Both groups define clusters of controllers, but they have different purposes. All of the controllers in an RF group are usually also in the same mobility group and vice versa. However, a mobility group facilitates scalable, system-wide mobility and controller redundancy while an RF group facilitates scalable, system-wide dynamic RF management.

**Step 14** Enter the network name or service set identifier (SSID). The SSID enables basic functionality of the controller and allows access points that have joined the controller to enable their radios.

**Step 15** Enter YES to allow clients to assign their own IP address or no to require clients to request an IP address from a DHCP server.

**Step 16** To configure a RADIUS server now, enter YES and then enter the IP address, communication port, and secret key of the RADIUS server. Otherwise, enter no. If you enter no, the following message appears: "Warning! The default WLAN security policy requires a RADIUS server. Please see the documentation for more details.

**Step 17** Enter the code for the country in which the controller will be used.

**Note** Enter help to view the list of available country codes.

**Note** You can enter more than one country code if you want to manage access points in multiple countries from a single controller. To do so, separate the country codes with a comma (for example, US,CA,MX). After the configuration wizard runs, you need to assign each access point joined to the controller to a specific country.

**Step 18** Enable or disable the 802.11b, 802.11a, and 802.11g lightweight access point networks by entering YES or no.

**Step 19** Enable or disable the controller’s radio resource management (RRM) auto-RF feature by entering YES or no.

**Note** The auto-RF feature enables the controller to automatically form an RF group with other controllers. The group dynamically elects a leader to optimize RRM parameter settings, such as channel and transmit power assignment, for the group.

**Step 20** If you want the controller to receive its time setting from an external Network Time Protocol (NTP) server when it powers up, enter YES to configure an NTP server. Otherwise, enter no.

**Note** The controller network module installed in a Cisco Integrated Services Router does not have a battery and cannot save a time setting. Therefore, it must receive a time setting from an external NTP server when it powers up.

**Step 21** If you entered no in Step 20 and want to manually configure the system time on your controller now, enter YES. If you do not want to configure the system time now, enter no.

**Step 22** If you entered YES in Step 21, enter the current date in the MM/DD/YY format and the current time in the HH:MM:SS format.

**Step 23** When prompted to verify that the configuration is correct, enter yes or NO. The controller saves your configuration when you enter yes, reboots, and prompts you to log on.

---

**Using the Controller GUI**

A browser-based GUI is built into each controller.

It allows up to five users to simultaneously browse into the controller HTTP or HTTPS (HTTP + SSL) management pages to configure parameters and monitor the operational status for the controller and its associated access points.

For detailed descriptions of the Controller GUI, see the Online Help. To access the online help, click Help on the Controller GUI.
We recommend that you enable the HTTPS interface and disable the HTTP interface to ensure more robust security.

Guidelines and Limitations

Follow these guidelines when using the controller GUI:

• The GUI must be used on a PC running Windows 7, Windows XP SP1 (or later releases), or Windows 2000 SP4 (or later releases).

• The controller Web UI is compatible with the following web browsers
  • Microsoft Internet Explorer 10 and later versions
  • Mozilla Firefox 32 and later versions

• To view the Main Dashboard that is introduced in Release 8.1.102.0, you must enable JavaScript on the web browser.

• You can use either the service port interface or the management interface to access the GUI. We recommend that you use the service-port interface.

• You can use both HTTP and HTTPS when using the service port interface. HTTPS is enabled by default and HTTP can also be enabled. The default IP address to connect to the service port interface is 192.168.1.1.

• Click Help at the top of any page in the GUI to display online help. You might need to disable your browser’s pop-up blocker to view the online help.

Logging On to the GUI

Do not configure TACACS authentication when the controller is set to use local authentication.

Step 1  Enter the controller IP address in your browser’s address bar. For a secure connection, enter https://ip-address. For a less secure connection, enter http://ip-address.

Step 2  When prompted, enter a valid username and password, and click OK. The Summary page is displayed.

Note  The administrative username and password that you created in the configuration wizard are case sensitive. The default username is admin, and the default password is admin.
Logging out of the GUI

Step 1  Click Logout in the top right corner of the page.
Step 2  Click Close to complete the log out process and prevent unauthorized users from accessing the controller GUI.
Step 3  When prompted to confirm your decision, click Yes.

Enabling Web and Secure Web Modes

This section provides instructions to enable the distribution system port as a web port (using HTTP) or as a secure web port (using HTTPS). You can protect communication with the GUI by enabling HTTPS. HTTPS protects HTTP browser sessions by using the Secure Sockets Layer (SSL) protocol. When you enable HTTPS, the controller generates its own local web administration SSL certificate and automatically applies it to the GUI. You also have the option of downloading an externally generated certificate.

You can configure web and secure web mode using the controller GUI or CLI.

Enabling Web and Secure Web Modes (GUI)

Step 1  Choose Management > HTTP-HTTPS. The HTTP-HTTPS Configuration page is displayed.
Step 2  To enable web mode, which allows users to access the controller GUI using "http://ip-address," choose Enabled from the HTTP Access drop-down list. Otherwise, choose Disabled. The default value is Disabled. Web mode is not a secure connection.
Step 3  To enable secure web mode, which allows users to access the controller GUI using "https://ip-address," choose Enabled from the HTTPS Access drop-down list. Otherwise, choose Disabled. The default value is Enabled. Secure web mode is a secure connection.
Step 4  In the Web Session Timeout text box, enter the amount of time, in minutes, before the web session times out due to inactivity. You can enter a value between 10 and 160 minutes (inclusive). The default value is 30 minutes.
Step 5  Click Apply.
Step 6  If you enabled secure web mode in Step 3, the controller generates a local web administration SSL certificate and automatically applies it to the GUI. The details of the current certificate appear in the middle of the HTTP-HTTPS Configuration page.
Note  If desired, you can delete the current certificate by clicking Delete Certificate and have the controller generate a new certificate by clicking Regenerate Certificate.
Step 7  Click Save Configuration.
Enabling Web and Secure Web Modes (CLI)

| Step 1 | Enable or disable web mode by entering this command:  
| config network webmode {enable | disable} | This command allows users to access the controller GUI using "http://ip-address." The default value is disabled. Web mode is not a secure connection. |

| Step 2 | Enable or disable secure web mode by entering this command:  
| config network secureweb {enable | disable} | This command allows users to access the controller GUI using "https://ip-address." The default value is enabled. Secure web mode is a secure connection. |

| Step 3 | Enable or disable secure web mode with increased security by entering this command:  
| config network secureweb cipher-option high {enable | disable} | This command allows users to access the controller GUI using "https://ip-address" but only from browsers that support 128-bit (or larger) ciphers. The default value is disabled. |

| Step 4 | Enable or disable SSLv2 for web administration by entering this command:  
| config network secureweb cipher-option sslv2 {enable | disable} | If you disable SSLv2, users cannot connect using a browser configured with SSLv2 only. They must use a browser that is configured to use a more secure protocol such as SSLv3 or later. The default value is disabled. |

| Step 5 | Enable or disable preference for RC4-SHA (Rivest Cipher 4-Secure Hash Algorithm) cipher suites (over CBC cipher suites) for web authentication and web administration by entering this command:  
| config network secureweb cipher-option rc4-preference {enable | disable} |

| Step 6 | Verify that the controller has generated a certificate by entering this command:  
| show certificate summary | Information similar to the following appears:  

```
Web Administration Certificate................ Locally Generated
Web Authentication Certificate................. Locally Generated
Certificate compatibility mode..................... off
```

| Step 7 | (Optional) Generate a new certificate by entering this command:  
| config certificate generate webadmin | After a few seconds, the controller verifies that the certificate has been generated. |

| Step 8 | Save the SSL certificate, key, and secure web password to nonvolatile RAM (NVRAM) so that your changes are retained across reboots by entering this command:  
| save config |

| Step 9 | Reboot the controller by entering this command:  
| reset system |
Loading an Externally Generated SSL Certificate

This section describes how to load an externally generated SSL certificate.

Information About Externally Generated SSL Certificates

You can use a TFTP server to download an externally generated SSL certificate to the controller. Follow these guidelines for using TFTP:

• If you load the certificate through the service port, the TFTP server must be on the same subnet as the controller because the service port is not routable, or you must create static routes on the controller. Also, if you load the certificate through the distribution system network port, the TFTP server can be on any subnet.

• A third-party TFTP server cannot run on the same PC as the Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP server and the third-party TFTP server require the same communication port.

:::Note
Chained certificates are supported for web authentication only and not for the management certificate.

:::Note
Every HTTPS certificate contains an embedded RSA key. The length of the key can vary from 512 bits, which is relatively insecure, to thousands of bits, which is very secure. When you obtain a new certificate from a Certificate Authority, make sure that the RSA key embedded in the certificate is at least 768 bits long.
Loading an SSL Certificate (GUI)

**Step 1**  
On the HTTP Configuration page, select the **Download SSL Certificate** check box.

*Figure 14: HTTP Configuration Page*

**Step 2**  
In the **Server IP Address** text box, enter the IP address of the TFTP server.

**Step 3**  
In the **Maximum Retries** text box, enter the maximum number of times that the TFTP server attempts to download the certificate.

**Step 4**  
In the **Timeout** text box, enter the amount of time (in seconds) that the TFTP server attempts to download the certificate.

**Step 5**  
In the **Certificate File Path** text box, enter the directory path of the certificate.

**Step 6**  
In the **Certificate File Name** text box, enter the name of the certificate (webadmincert_name.pem).

**Step 7**  
(Optional) In the **Certificate Password** text box, enter a password to encrypt the certificate.

**Step 8**  
Click **Apply**.

**Step 9**  
Click **Save Configuration**.

**Step 10**  
Choose **Commands > Reboot > Reboot > Save and Reboot** to reboot the controller for your changes to take effect.
Loading an SSL Certificate (CLI)

Step 1  Use a password to encrypt the HTTPS certificate in a .PEM-encoded file. The PEM-encoded file is called a web administration certificate file (webadmincert_name.pem).

Step 2  Move the webadmincert_name.pem file to the default directory on your TFTP server.

Step 3  To view the current download settings, enter this command and answer n to the prompt:

```
transfer download start
```

Information similar to the following appears:

```
Mode........................................... TFTP
Data Type...................................... Admin Cert
TFTP Server IP............................... xxx.xxx.xxx.xxx
TFTP Path...................................... <directory path>
TFTP Filename................................. webadmincert_name.pem
Are you sure you want to start? (y/n) n
Transfer Canceled
```

Step 4  Use these commands to change the download settings:

```
transfer download mode tftp
transfer download datatype webauthcert
transfer download serverip TFTP_server_IP_address
transfer download path absolute_TFTP_server_path_to_the_update_file
transfer download filename webadmincert_name.pem
```

Step 5  To set the password for the .PEM file so that the operating system can decrypt the web administration SSL key and certificate, enter this command:

```
transfer download certpassword private_key_password
```

Step 6  To confirm the current download settings and start the certificate and key download, enter this command and answer y to the prompt:

```
transfer download start
```

Information similar to the following appears:

```
Mode........................................... TFTP
Data Type...................................... Site Cert
TFTP Server IP............................... xxx.xxx.xxx.xxx
TFTP Path...................................... directory path
TFTP Filename................................. webadmincert_name.pem
Are you sure you want to start? (y/n) y
TFTP Webadmin cert transfer starting.
Certificate installed.
Please restart the switch (reset system) to use the new certificate.
```

Step 7  To save the SSL certificate, key, and secure web password to NVRAM so that your changes are retained across reboots, enter this command:
Using the Controller CLI

A Cisco UWN solution command-line interface (CLI) is built into each controller. The CLI enables you to use a VT-100 terminal emulation program to locally or remotely configure, monitor, and control individual controllers and its associated lightweight access points. The CLI is a simple text-based, tree-structured interface that allows up to five users with Telnet-capable terminal emulation programs to access the controller.

Note
See the Cisco Wireless LAN Controller Command Reference for information on specific commands.

Note
If you want to input any strings from the XML configuration into CLI commands, you must enclose the strings in quotation marks.

Logging on to the Controller CLI

You can access the controller CLI using one of the following two methods:

• A direct serial connection to the controller console port
• A remote console session over Ethernet through the preconfigured service port or the distribution system ports

Before you log on to the CLI, configure your connectivity and environment variables based on the type of connection you use.

Guidelines and Limitations

On Cisco 5500 Series Controllers, you can use either the RJ-45 console port or the USB console port. If you use the USB console port, plug the 5-pin mini Type B connector into the controller’s USB console port and the other end of the cable into the PC’s USB Type A port. The first time that you connect a Windows PC to the USB console port, you are prompted to install the USB console driver. Follow the installation prompts to install the driver. The USB console driver maps to a COM port on your PC; you then need to map the terminal emulator application to the COM port.

See the Telnet and Secure Shell Sessions section for information on enabling Telnet sessions.
Using a Local Serial Connection

**Before You Begin**

You need these items to connect to the serial port:

- A PC that is running a VT-100 terminal emulation program (such as HyperTerminal, ProComm, Minicom, or Tip)
- A null-modem serial cable

To log on to the controller CLI through the serial port, follow these steps:

---

**Step 1**
Connect one end of a null-modem serial cable to the controller’s console port and the other end to your PC’s serial port.

**Step 2**
Start the PC’s VT-100 terminal emulation program. Configure the terminal emulation program for these parameters:

- 9600 baud
- 8 data bits
- 1 stop bit
- No parity
- No hardware flow control

**Note** Minimum serial timeout on Controller is 15 seconds instead of 1 minute.

**Note** The controller serial port is set for a 9600 baud rate and a short timeout. If you would like to change either of these values, enter config serial baudrate baudrate and config serial timeout timeout to make your changes. If you enter config serial timeout 0, serial sessions never time out.

**Step 3**
When prompted, enter a valid username and password to log into the controller. The administrative username and password that you created in the configuration wizard are case sensitive.

**Note** The default username is admin, and the default password is admin.

The CLI displays the root level system prompt:

```
#(system prompt)>
```

**Note** The system prompt can be any alphanumeric string up to 31 characters. You can change it by entering the `config prompt` command.

---

Using a Remote Ethernet Connection

**Before You Begin**

You need these items to connect to a controller remotely:

- A PC with access to the controller over the Ethernet network
The IP address of the controller

A VT-100 terminal emulation program or a DOS shell for the Telnet session

Note: By default, controllers block Telnet sessions. You must use a local connection to the serial port to enable Telnet sessions.

---

**Step 1**
Verify that your VT-100 terminal emulation program or DOS shell interface is configured with these parameters:

- Ethernet address
- Port 23

**Step 2**
Use the controller IP address to Telnet to the CLI.

**Step 3**
When prompted, enter a valid username and password to log into the controller. The administrative username and password that you created in the configuration wizard are case sensitive.

Note: The default username is admin, and the default password is admin.

The CLI displays the root level system prompt.

Note: The system prompt can be any alphanumeric string up to 31 characters. You can change it by entering the `config prompt` command.

---

**Logging Out of the CLI**

When you finish using the CLI, navigate to the root level and enter logout. The system prompts you to save any changes you made to the volatile RAM.

Note: The CLI automatically logs you out without saving any changes after 5 minutes of inactivity. You can set the automatic logout from 0 (never log out) to 160 minutes using the `config serial timeout` command.

---

**Navigating the CLI**

The CLI is organized into five levels:

- Root Level
- Level 2
- Level 3
- Level 4
- Level 5
When you log into the CLI, you are at the root level. From the root level, you can enter any full command without first navigating to the correct command level.

The following table lists commands you use to navigate the CLI and to perform common tasks.

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>help</td>
<td>At the root level, view system wide navigation commands</td>
</tr>
<tr>
<td>?</td>
<td>View commands available at the current level</td>
</tr>
<tr>
<td>command ?</td>
<td>View parameters for a specific command</td>
</tr>
<tr>
<td>exit</td>
<td>Move down one level</td>
</tr>
<tr>
<td>Ctrl-Z</td>
<td>Return from any level to the root level</td>
</tr>
<tr>
<td>save config</td>
<td>At the root level, save configuration changes from active working RAM to nonvolatile RAM (NVRAM) so they are retained after reboot</td>
</tr>
<tr>
<td>reset system</td>
<td>At the root level, reset the controller without logging out</td>
</tr>
</tbody>
</table>

**Using the AutoInstall Feature for Controllers Without a Configuration**

This section describes how to use the AutoInstall feature for controllers without a configuration.

**Information About the AutoInstall Feature**

When you boot up a controller that does not have a configuration, the AutoInstall feature can download a configuration file from a TFTP server and then load the configuration onto the controller automatically.

If you create a configuration file on a controller that is already on the network (or through a Prime Infrastructure filter), place that configuration file on a TFTP server, and configure a DHCP server so that a new controller can get an IP address and TFTP server information, the AutoInstall feature can obtain the configuration file for the new controller automatically.

When the controller boots, the AutoInstall process starts. The controller does not take any action until AutoInstall is notified that the configuration wizard has started. If the wizard has not started, the controller has a valid configuration.
If AutoInstall is notified that the configuration wizard has started (which means that the controller does not have a configuration), AutoInstall waits for an additional 30 seconds. This time period gives you an opportunity to respond to the first prompt from the configuration wizard:

Would you like to terminate autoinstall? [yes]:

When the 30-second abort timeout expires, AutoInstall starts the DHCP client. You can abort the AutoInstall task even after this 30-second timeout if you enter Yes at the prompt. However, AutoInstall cannot be aborted if the TFTP task has locked the flash and is in the process of downloading and installing a valid configuration file.

Note

The AutoInstall process and manual configuration using both the GUI and CLI of Cisco WLC can occur in parallel. As part of the AutoInstall cleanup process, the service port IP address is set to 192.168.1.1 and the service port protocol configuration is modified. Because the AutoInstall process takes precedence over the manual configuration, whatever manual configuration is performed is overwritten by the AutoInstall process.

Guidelines and Limitations

AutoInstall uses the following interfaces:

- Cisco 5500 Series Controllers
  - eth0—Service port (untagged)
  - dtl0—Gigabit port 1 through the NPU (untagged)

Obtaining an IP Address Through DHCP and Downloading a Configuration File from a TFTP Server

AutoInstall attempts to obtain an IP address from the DHCP server until the DHCP process is successful or until you abort the AutoInstall process. The first interface to successfully obtain an IP address from the DHCP server registers with the AutoInstall task. The registration of this interface causes AutoInstall to begin the process of obtaining TFTP server information and downloading the configuration file.

Following the acquisition of the DHCP IP address for an interface, AutoInstall begins a short sequence of events to determine the host name of the controller and the IP address of the TFTP server. Each phase of this sequence gives preference to explicitly configured information over default or implied information and to explicit host names over explicit IP addresses.

The process is as follows:

- If at least one Domain Name System (DNS) server IP address is learned through DHCP, AutoInstall creates a /etc/resolv.conf file. This file includes the domain name and the list of DNS servers that have been received. The Domain Name Server option provides the list of DNS servers, and the Domain Name option provides the domain name.

- If the domain servers are not on the same subnet as the controller, static route entries are installed for each domain server. These static routes point to the gateway that is learned through the DHCP Router option.
• The host name of the controller is determined in this order by one of the following:
  ◦ If the DHCP Host Name option was received, this information (truncated at the first period [.]) is used as the host name for the controller.
  ◦ A reverse DNS lookup is performed on the controller IP address. If DNS returns a hostname, this name (truncated at the first period [.]) is used as the hostname for the controller.

• The IP address of the TFTP server is determined in this order by one of the following:
  ◦ If AutoInstall received the DHCP TFTP Server Name option, AutoInstall performs a DNS lookup on this server name. If the DNS lookup is successful, the returned IP address is used as the IP address of the TFTP server.
  ◦ If the DHCP Server Host Name (sname) text box is valid, AutoInstall performs a DNS lookup on this name. If the DNS lookup is successful, the IP address that is returned is used as the IP address of the TFTP server.
  ◦ If AutoInstall received the DHCP TFTP Server Address option, this address is used as the IP address of the TFTP server.
  ◦ AutoInstall performs a DNS lookup on the default TFTP server name (cisco-wlc-tftp). If the DNS lookup is successful, the IP address that is received is used as the IP address of the TFTP server.
  ◦ If the DHCP server IP address (siaddr) text box is nonzero, this address is used as the IP address of the TFTP server.
  ◦ The limited broadcast address (255.255.255.255) is used as the IP address of the TFTP server.
  ◦ If the TFTP server is not on the same subnet as the controller, a static route (/32) is installed for the IP address of the TFTP server. This static route points to the gateway that is learned through the DHCP Router option.

Selecting a Configuration File

After the hostname and TFTP server have been determined, AutoInstall attempts to download a configuration file. AutoInstall performs three full download iterations on each interface that obtains a DHCP IP address. If the interface cannot download a configuration file successfully after three attempts, the interface does not attempt further.

The first configuration file that is downloaded and installed successfully triggers a reboot of the controller. After the reboot, the controller runs the newly downloaded configuration.

AutoInstall searches for configuration files in the order in which the names are listed:

• The filename that is provided by the DHCP Boot File Name option
• The filename that is provided by the DHCP File text box
• host name-config
• host name.cfg
• base MAC address-config (for example, 0011.2233.4455-config)
• serial number-config
AutoInstall runs through this list until it finds a configuration file. It stops running if it does not find a configuration file after it cycles through this list three times on each registered interface.

Note

The downloaded configuration file can be a complete configuration, or it can be a minimal configuration that provides enough information for the controller to be managed by the Cisco Prime Infrastructure. Full configuration can then be deployed directly from the Prime Infrastructure.

Note

AutoInstall does not expect the switch connected to the controller to be configured for either channels. AutoInstall works with a service port in LAG configuration.

Note

Cisco Prime Infrastructure provides AutoInstall capabilities for controllers. A Cisco Prime Infrastructure administrator can create a filter that includes the host name, the MAC address, or the serial number of the controller and associate a group of templates (a configuration group) to this filter rule. The Prime Infrastructure pushes the initial configuration to the controller when the controller boots up initially. After the controller is discovered, the Prime Infrastructure pushes the templates that are defined in the configuration group. For more information about the AutoInstall feature and Cisco Prime Infrastructure, see the Cisco Prime Infrastructure documentation.

Example: AutoInstall Operation

The following is an example of an AutoInstall process from start to finish:

Welcome to the Cisco Wizard Configuration Tool
Use the '-' character to backup
Would you like to terminate autoinstall? [yes]:
AUTO-INSTALL: starting now...
AUTO-INSTALL: interface 'service-port' - setting DHCP TFTP Filename 'abcd-confg'
AUTO-INSTALL: interface 'service-port' - setting DHCP TFTP Server IP 1.100.108.2
AUTO-INSTALL: interface 'service-port' - setting DHCP saddr 1.100.108.2
AUTO-INSTALL: interface 'service-port' - setting DHCP Domain Server[0] 1.100.108.2
AUTO-INSTALL: interface 'service-port' - setting DHCP Domain Name 'engtest.com'
AUTO-INSTALL: interface 'service-port' - setting DHCP yaddr 172.19.29.253
AUTO-INSTALL: interface 'service-port' - setting DHCP Netmask 255.255.255.0
AUTO-INSTALL: interface 'service-port' registered
AUTO-INSTALL: interaction 1 -- interface 'service-port'
AUTO-INSTALL: DNS reverse lookup 172.19.29.253 'wlc-1'
AUTO-INSTALL: hostname 'wlc-1'
AUTO-INSTALL: TFTP server 1.100.108.2 (from DHCP Option 150)
AUTO-INSTALL: attempting download of 'abcd-confg'
AUTO-INSTALL: TFTP status 'TFTP Config transfer starting.' (2)
AUTO-INSTALL: interface 'management' - setting DHCP file 'bootfile1'
AUTO-INSTALL: interface 'management' - setting DHCP TFTP Filename 'bootfile2-confg'
AUTO-INSTALL: interface 'management' - setting DHCP saddr 1.100.108.2
AUTO-INSTALL: interface 'management' - setting DHCP Domain Server[0] 1.100.108.2
AUTO-INSTALL: interface 'management' - setting DHCP Domain Server[1] 1.100.108.3
AUTO-INSTALL: interface 'management' - setting DHCP Domain Server[2] 1.100.108.4
AUTO-INSTALL: interface 'management' - setting DHCP Domain Name 'engtest.com'
Managing the Controller System Date and Time

This section describes how to manage the date and time of a controller system.

Information About Controller System Date and Time

You can configure the controller system date and time at the time of configuring the controller using the configuration wizard. If you did not configure the system date and time through the configuration wizard or if you want to change your configuration, you can follow the instructions in this section to configure the controller to obtain the date and time from a Network Time Protocol (NTP) server or to configure the date and time manually. Greenwich Mean Time (GMT) is used as the standard for setting the time zone on the controller.

You can also configure an authentication mechanism between various NTP servers.

Restrictions on Configuring the Cisco WLC Date and Time

- If you are configuring wIPS, you must set the controller time zone to UTC.
- Cisco Aironet lightweight access points might not connect to the controller if the date and time are not set properly. Set the current date and time on the controller before allowing the access points to connect to it.
- You can configure an authentication channel between the controller and the NTP server.

Configuring an NTP/SNTP Server to Obtain the Date and Time

Each NTP/SNTP server IP address is added to the controller database. Each controller searches for an NTP/SNTP server and obtains the current time upon reboot and at each user-defined polling interval (daily to weekly).

Use these commands to configure an NTP/SNTP server to obtain the date and time:

- To specify the NTP/SNTP server for the controller, enter this command:
  ```
  config time ntp server index ip_address
  ```
- To specify the polling interval (in seconds), enter this command:
  ```
  config time ntp interval
  ```
Configuring NTP/SNTP Authentication (GUI)

Step 1 Choose Controller > NTP > Servers to open the NTP Servers page.
Step 2 Click New to add an NTP server.
Step 3 Choose a server priority from the Server Index (Priority) drop-down list.
Step 4 Enter the NTP server IPv4/IPv6 address in the Server IP Address (IPv4/IPv6) text box.
Step 5 Enable NTP server authentication by checking the NTP Server Authentication check box.
Step 6 Click Apply.
Step 7 Choose Controller > NTP > Keys.
Step 8 Click New to create a key.
Step 9 Enter the key index in the Key Index text box.
Step 10 Choose the key format from the Key Format drop-down list.
Step 11 Enter the key in the Key text box.
Step 12 Click Apply.

Configuring NTP/SNTP Authentication (CLI)

Note: By default, MD5 is used.

- `config time ntp auth enable server-index key-index`
- `config time ntp auth disable server-index`
- `config time ntp key-auth add key-index md5 key-format key`
- Delete an authentication key by entering this command:
  
- `config time ntp key-auth delete key-index`
- View the list of NTP/SNTP key Indices by entering this command:
  
- `show ntp-keys`
Configuring the Date and Time (GUI)

**Step 1**  Choose **Commands > Set Time** to open the Set Time page.

*Figure 15: Set Time Page*

![Set Time Page](image)

The current date and time appear at the top of the page.

**Step 2**  In the Timezone area, choose your local time zone from the Location drop-down list.

*Note*  When you choose a time zone that uses Daylight Saving Time (DST), the controller automatically sets its system clock to reflect the time change when DST occurs. In the United States, DST starts on the second Sunday in March and ends on the first Sunday in November.

*Note*  You cannot set the time zone delta on the controller GUI. However, if you do so on the controller CLI, the change is reflected in the Delta Hours and Mins text boxes on the controller GUI.

**Step 3**  Click **Set Timezone** to apply your changes.

**Step 4**  In the Date area, choose the current local month and day from the Month and Day drop-down lists, and enter the year in the Year text box.

**Step 5**  In the Time area, choose the current local hour from the Hour drop-down list, and enter the minutes and seconds in the Minutes and Seconds text boxes.

*Note*  If you change the time zone location after setting the date and time, the values in the Time area are updated to reflect the time in the new time zone location. For example, if the controller is currently configured for noon Eastern time and you change the time zone to Pacific time, the time automatically changes to 9:00 a.m.

**Step 6**  Click **Set Date and Time** to apply your changes.

**Step 7**  Click **Save Configuration** to save your changes.
Configuring the Date and Time (CLI)

**Step 1** Configure the current local date and time in GMT on the controller by entering this command:

```
config time manual mm/dd/yy hh:mm:ss
```

**Note** When setting the time, the current local time is entered in terms of GMT and as a value between 00:00 and 24:00. For example, if it is 8:00 a.m. Pacific time in the United States, you would enter 16:00 because the Pacific time zone is 8 hours behind GMT.

**Step 2** Perform one of the following to set the time zone for the controller:

- Set the time zone location in order to have Daylight Saving Time (DST) set automatically when it occurs by entering this command:

```
config time timezone location location_index
```

where `location_index` is a number representing one of the following time zone locations:

1. (GMT-12:00) International Date Line West
2. (GMT-11:00) Samoa
3. (GMT-10:00) Hawaii
4. (GMT-9:00) Alaska
5. (GMT-8:00) Pacific Time (US and Canada)
6. (GMT-7:00) Mountain Time (US and Canada)
7. (GMT-6:00) Central Time (US and Canada)
8. (GMT-5:00) Eastern Time (US and Canada)
9. (GMT-4:00) Atlantic Time (Canada)
10. (GMT-3:00) Buenos Aires (Argentina)
11. (GMT-2:00) Mid-Atlantic
12. (GMT-1:00) Azores
13. (GMT) London, Lisbon, Dublin, Edinburgh (default value)
14. (GMT +1:00) Amsterdam, Berlin, Rome, Vienna
15. (GMT +2:00) Jerusalem
16. (GMT +3:00) Baghdad
17. (GMT +4:00) Muscat, Abu Dhabi
18. (GMT +4:30) Kabul
19. (GMT +5:00) Karachi, Islamabad, Tashkent
20. (GMT +5:30) Colombo, Kolkata, Mumbai, New Delhi
21. (GMT +5:45) Katmandu
22 (GMT +6:00) Almaty, Novosibirsk
23 (GMT +6:30) Rangoon
24 (GMT +7:00) Saigon, Hanoi, Bangkok, Jakarta
25 (GMT +8:00) Hong Kong, Beijing, Chongqing
26 (GMT +9:00) Tokyo, Osaka, Sapporo
27 (GMT +9:30) Darwin
28 (GMT+10:00) Sydney, Melbourne, Canberra
29 (GMT+11:00) Magadan, Solomon Is., New Caledonia
30 (GMT+12:00) Kamchatka, Marshall Is., Fiji
31 (GMT+12:00) Auckland (New Zealand)

Note: If you enter this command, the controller automatically sets its system clock to reflect DST when it occurs. In the United States, DST starts on the second Sunday in March and ends on the first Sunday in November.

- Manually set the time zone so that DST is not set automatically by entering this command:

  `config time timezone delta_hours delta_mins`

  where `delta_hours` is the local hour difference from GMT, and `delta_mins` is the local minute difference from GMT. When manually setting the time zone, enter the time difference of the local current time zone with respect to GMT (+/−). For example, Pacific time in the United States is 8 hours behind GMT. Therefore, it is entered as −8.

Note: You can manually set the time zone and prevent DST from being set only on the controller CLI.

**Step 3**  Save your changes by entering this command:

  `save config`

**Step 4**  Verify that the controller shows the current local time with respect to the local time zone by entering this command:

  `show time`

Information similar to the following appears:

```
Time................................. Thu Apr  7 13:56:37 2011
Timezone delta......................... 0:0
Timezone location..................... (GMT +5:30) Colombo, New Delhi, Chennai, Kolkata

NTP Servers
  NTP Polling Interval.............. 3600
  NTP Key Index Index NTP Server NTP Msg Auth Status
  --------------- ------------------------- ------------------------
  1 1 209.165.200.225 AUTH SUCCESS

Note: If you configured the time zone location, the Timezone Delta value is set to "0:0." If you manually configured the time zone using the time zone delta, the Timezone Location is blank.
Telnet and Secure Shell Sessions

Information About Telnet and SSH

Telnet is a network protocol used to provide access to the controller’s CLI. Secure Shell (SSH) is a more secure version of Telnet that uses data encryption and a secure channel for data transfer. You can use the controller GUI or CLI to configure Telnet and SSH sessions.

Restrictions for Telnet and SSH

• Only the FIPS approved algorithm aes128-cbc is supported when using SSH to control WLANs.
• The controller does not support raw Telnet mode.

Configuring Telnet and SSH Sessions (GUI)

Step 1 Choose Management > Telnet-SSH to open the Telnet-SSH Configuration page.

Figure 16: Telnet-SSH Configuration Page
Step 2  In the **Telnet Login Timeout** text box, enter the number of minutes that a Telnet session is allowed to remain inactive before being terminated. The valid range is 0 to 160 minutes (inclusive), and the default value is 5 minutes. A value of 0 indicates no timeout.

Step 3  From the **Maximum Number of Sessions** drop-down list, choose the number of simultaneous Telnet or SSH sessions allowed. The valid range is 0 to 5 sessions (inclusive), and the default value is 5 sessions. A value of zero indicates that Telnet/SSH sessions are disallowed.

Step 4  From the **Allow New Telnet Sessions** drop-down list, choose **Yes** or **No** to allow or disallow new Telnet sessions on the controller. The default value is No.

Step 5  From the \ drop-down list, choose **Yes** or **No** to allow or disallow new SSH sessions on the controller. The default value is Yes.

Step 6  Click **Apply**.

Step 7  Click **Save Configuration**.

Step 8  To see a summary of the Telnet configuration settings, choose **Management > Summary**. The Summary page appears.

Figure 17: Summary Page

![Summary Page](image)

This page shows whether additional Telnet and SSH sessions are permitted.

---

**Configuring Telnet and SSH Sessions (CLI)**

Step 1  Allow or disallow new Telnet sessions on the controller by entering this command:

```
config network telnet {enable | disable}
```

The default value is disabled.

Step 2  Allow or disallow new SSH sessions on the controller by entering this command:
config network ssh {enable | disable}

The default value is enabled.

**Note** Use the `config network ssh cipher-option high {enable | disable}` command to enable sha2 which is supported in WLC.

**Step 3** Specify the number of minutes that a Telnet session is allowed to remain inactive before being terminated by entering this command:

```
config sessions timeout timeout
```

where `timeout` is a value between 0 and 160 minutes (inclusive). The default value is 5 minutes. A value of 0 indicates no timeout.

**Step 4** Specify the number of simultaneous Telnet or SSH sessions allowed by entering this command:

```
config sessions maxsessions session_num
```

where `session_num` is a value between 0 and 5 (inclusive). The default value is 5 sessions. A value of zero indicates that Telnet/SSH sessions are disallowed.

**Step 5** Save your changes by entering this command:

```
save config
```

**Step 6** See the Telnet and SSH configuration settings by entering this command:

```
show network summary
```

Information similar to the following appears:

```
RF-Network Name............................. TestNetwork1
Web Mode.................................... Enable
Secure Web Mode............................ Enable
Secure Web Mode Cipher-Option High........ Disable
Secure Web Mode Cipher-Option SSLv2........ Disable
Secure Shell (ssh).......................... Enable
Telnet................................... Disable
...
```

**Step 7** See the Telnet session configuration settings by entering this command:

```
show sessions
```

Information similar to the following appears:

```
CLI Login Timeout (minutes)............ 5
Maximum Number of CLI Sessions....... 5
```

**Step 8** See all active Telnet sessions by entering this command:

```
show login-session
```

Information similar to the following appears:

```
<table>
<thead>
<tr>
<th>ID</th>
<th>User Name</th>
<th>Connection From</th>
<th>Idle Time</th>
<th>Session Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>admin</td>
<td>EIA-232</td>
<td>00:00:00</td>
<td>00:19:04</td>
</tr>
</tbody>
</table>
```
Troubleshooting Access Points Using Telnet or SSH

The controller supports the use of the Telnet and Secure Shell (SSH) protocols to troubleshoot lightweight access points. Using these protocols makes debugging easier, especially when the access point is unable to connect to the controller.

- To avoid potential conflicts and security threats to the network, the following commands are unavailable while a Telnet or SSH session is enabled: `config terminal, telnet, ssh, rsh, ping, traceroute, clear, clock, crypto, delete, fsck, lwapp, mkdir, radius, release, reload, rename, renew, rmdir, save, set, test, upgrade`

- Commands available during a Telnet or SSH session include `debug, disable, enable, help, led, login, logout, more, no debug, show, systat, undebug and where`.

  **Note** For instructions on configuring Telnet or SSH SSH sessions on the controller, see the Telnet and Secure Shell Sessions section.

## Troubleshooting Access Points Using Telnet or SSH (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Wireless &gt; Access Points &gt; All APs to open the All APs page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the name of the access point for which you want to enable Telnet or SSH.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose the Advanced tab to open the All APs &gt; Details for Advanced page.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the Telnet check box to enable Telnet connectivity on this access point. The default value is unchecked.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Select the SSH check box to enable SSH connectivity on this access point. The default value is unchecked.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click Apply.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Click Save Configuration.</td>
</tr>
</tbody>
</table>

## Troubleshooting Access Points Using Telnet or SSH (CLI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Enable Telnet or SSH connectivity on an access point by entering this command: `config ap {telnet</td>
</tr>
<tr>
<td>Note</td>
<td>Disable Telnet or SSH connectivity on an access point by entering this command: `config ap {telnet</td>
</tr>
<tr>
<td>Step 2</td>
<td>Save your changes by entering this command: <code>save config</code></td>
</tr>
<tr>
<td>Step 3</td>
<td>See whether Telnet or SSH is enabled on an access point by entering this command:</td>
</tr>
</tbody>
</table>
Managing the Controller Wirelessly

You can monitor and configure controllers using a wireless client. This feature is supported for all management tasks except uploads from and downloads to the controller.

Before you can open the GUI or the CLI from a wireless client device, you must configure the controller to allow the connection.

Enabling Wireless Connections (GUI)

**Step 1** Log onto the GUI.

**Step 2** Choose Management > Mgmt Via Wireless page.

**Step 3** Enable the Controller Management to be accessible from wireless clients.

**Step 4** Click Apply.
Enabling Wireless Connections (CLI)

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Log onto the CLI.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Enter the <code>config network mgmt-via-wireless enable</code> command.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Use a wireless client to associate to a lightweight access point connected to the controller.</td>
</tr>
<tr>
<td>Step 4</td>
<td>On the wireless client, open a Telnet session to the controller, or browse to the controller GUI.</td>
</tr>
</tbody>
</table>
Ports and Interfaces

- Overview of Ports and Interfaces, page 50
- Information About Distribution System Ports, page 50
- Information About Interfaces, page 52
- Configuring the Management Interface, page 53
- Configuring the AP-Manager Interface, page 58
- Configuring Virtual Interfaces, page 61
- Configuring Service-Port Interfaces, page 62
- Configuring Dynamic Interfaces, page 64
- Information About Dynamic AP Management, page 68
- Information About WLANs, page 69
- Configuring Ports (GUI), page 70
- Configuring Port Mirroring, page 71
- Using the Cisco 5500 Series Controller USB Console Port, page 72
- Choosing Between Link Aggregation and Multiple AP-Manager Interfaces, page 73
- Configuring Link Aggregation, page 74
- Configuring Multiple AP-Manager Interfaces, page 77
- Configuration Example: Configuring AP-Manager on a Cisco 5500 Series Controller, page 79
- Configuring VLAN Select, page 81
- Configuring Interface Groups, page 82
- Configuring Multicast Optimization, page 84
Overview of Ports and Interfaces

Three concepts are key to understanding how controllers connect to a wireless network: ports, interfaces, and WLANs.

Information About Ports

A port is a physical entity that is used for connections on the controller platform. Controllers have two types of ports: distribution system ports and a service port.

**Figure 18: Ports on the Cisco 5500 Series Wireless LAN Controllers**

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Redundant port (RJ-45)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Service port (RJ-45)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Console port (RJ-45)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>USB ports 0 and 1 (Type A)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Console port (Mini USB Type B)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>SFP distribution system ports 1–8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Management port LEDs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>SFP distribution port Link and Activity LEDs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Power supply (PS1 and PS2), System (SYS), and Alarm (ALM) LEDs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Expansion module slot</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: You can use only one console port (either RJ-45 or mini USB). When you connect to one console port, the other is disabled.

Information About Distribution System Ports

A distribution system port connects the controller to a neighbor switch and serves as the data path between these two devices.
Restrictions for Configuring Distribution System Ports

- Cisco 5508 Controllers have eight Gigabit Ethernet distribution system ports, through which the Controller can manage multiple access points. The 5508-12, 5508-25, 5508-50, 5508-100, and 5508-250 models allow a total of 12, 25, 50, 100, or 250 access points to join the controller. Cisco 5508 controllers have no restrictions on the number of access points per port. However, we recommend using link aggregation (LAG) or configuring dynamic AP-manager interfaces on each Gigabit Ethernet port to automatically balance the load. If more than 100 access points are connected to the Cisco 5500 Series Controller, make sure that more than one Gigabit Ethernet interface is connected to the upstream switch.

Note

The Gigabit Ethernet ports on the Cisco 5508 Controllers accept these SX/LC/T small form-factor plug-in (SFP) modules:

- 1000BASE-SX SFP modules, which provide a 1000-Mbps wired connection to a network through an 850nM (SX) fiber-optic link using an LC physical connector
- 1000BASE-LX SFP modules, which provide a 1000-Mbps wired connection to a network through a 1300nM (LX/LH) fiber-optic link using an LC physical connector
- 1000BASE-T SFP modules, which provide a 1000-Mbps wired connection to a network through a copper link using an RJ-45 physical connector

- GLC-SX-MM, a 1000BASE-SX connector should be in auto-negotiation mode to function as desired because all SFP modules using LC physical connectors must ideally be in auto-negotiation mode on Cisco 5508 Series Controllers to function properly. However, when Cisco ASR is connected using the fiber port, GLC-SX-MM does not come up between Cisco ASR and Cisco 5508 as Cisco ASR requires the connector to be in fixed mode to function properly.

- Each distribution system port is, by default, an 802.1Q VLAN trunk port. The VLAN trunking characteristics of the port are not configurable.

Note

Some controllers support link aggregation (LAG), which bundles all of the controller's distribution system ports into a single 802.3ad port channel. Cisco 5500 Series Controllers support LAG, and LAG is enabled automatically on the controllers within the Cisco WiSM2.

- Cisco WLC configuration in access mode is not supported. We recommend that you configure Cisco WLC in trunk mode when you configure Cisco WLC ports on a switch.

- In Cisco Flex 7500 and 8500 Series Controllers:
  - If a port is unresponsive after a soaking period of 5 seconds, all the interfaces for which the port is the primary and the active port, fail over to the backup port, if a backup is configured and is operational. Similarly, if the unresponsive port is the backup port, then all the interfaces fail over to the primary port if it is operational.
• After the unresponsive port is restored, there is a soaking period of 60 seconds after which if the port is still operational, then all the interfaces fall back to this port, which was the primary port. If the port was the backup port, then no change is done.

• You must ensure that you configure the port before you connect a switch or distribution system in the Cisco Wireless LAN Controller 2500 series.

• If an IPv6 packet is destined to controller management IPv6 address and the client VLAN is different from the controller management VLAN, then the IPv6 packet is switched out of the WLC box. If the same IPv6 packet comes as a network packet to the WLC, management access is not denied.

Information About Service Port

Cisco 5500 Series Controllers also have a 10/100/1000 copper Ethernet service port. The service port is controlled by the service-port interface and is reserved for out-of-band management of the controller and system recovery and maintenance in the event of a network failure. It is also the only port that is active when the controller is in boot mode. The service port is not capable of carrying 802.1Q tags, so it must be connected to an access port on the neighbor switch. Use of the service port is optional.

The service port of the Cisco Wireless Controller 7510 and 8510 models is a one Gigabit Ethernet port. To verify the speed of service port, you must connect the service port to a Gigabit Ethernet port on the switch.

Note
The service port is not auto-sensing. You must use the correct straight-through or crossover Ethernet cable to communicate with the service port.

Caution
Do not configure wired clients in the same VLAN or subnet of the service port of the controller on the network. If you configure wired clients on the same subnet or VLAN as the service port, it is not possible to access the management interface of the controller.

Information About Interfaces

An interface is a logical entity on the controller. An interface has multiple parameters associated with it, including an IP address, default gateway (for the IP subnet), primary physical port, secondary physical port, VLAN identifier, and DHCP server.

These five types of interfaces are available on the controller. Four of these are static and are configured at setup time:

• Management interface (static and configured at setup time; mandatory)

• AP-manager interface (static and configured at setup time; mandatory)

Note
You are not required to configure an AP-manager interface on Cisco 5500 Series Controllers.
• Virtual interface (static and configured at setup time; mandatory)
• Service-port interface (static and configured at setup time; optional)
• Dynamic interface (user-defined)

Typically, you define the management, AP-manager, virtual, and service-port interface parameters using the Startup Wizard. However, you can display and configure interface parameters through either the GUI or CLI after the controller is running.

When LAG is disabled, each interface is mapped to at least one primary port, and some interfaces (management and dynamic) can be mapped to an optional secondary (or backup) port. If the primary port for an interface fails, the interface automatically moves to the backup port. In addition, multiple interfaces can be mapped to a single controller port.

In Cisco Wireless LAN Controller 5508 Series, the controller marks packets greater than 1500 bytes as long. However, the packets are not dropped. The workaround to this is to configure the MTU on a switch to less than 1500 bytes.

Interfaces that are quarantined are not displayed on the Controller > Interfaces page. For example, if there are 6 interfaces and one of them is quarantined, the quarantined interface is not displayed and the details of the other 5 interfaces are displayed on the GUI. You can get the total number of interfaces that is inclusive of quarantined interfaces through the count displayed on the top-right corner of the GUI.

Restrictions for Configuring Interfaces

• Each physical port on the wireless controller can have only one AP-manager configured with it. For the Cisco 5500 Series Controllers, the management interface with AP-management enabled cannot fail over to the backup port, which is primary for the AP-manager on the management or dynamic VLAN interface.

• Cisco 5500 Series Controllers do not support fragmented pings on any interface.

• When the port comes up in VMware ESXi with configuration for NIC teaming, the vWLC may lose connectivity. However, the virtual wireless LAN controller (vWLC) resumes connectivity after a while.

Configuring the Management Interface

Information About the Management Interface

The management interface is the default interface for in-band management of the controller and connectivity to enterprise services such as AAA servers. It is also used for communications between the controller and access points. The management interface has the only consistently "pingable" in-band interface IP address on the controller. You can access the GUI of the controller by entering the management interface IP address of the controller in the address field of your browser.
For CAPWAP, the controller requires one management interface to control all inter-controller communications and one AP-manager interface to control all controller-to-access point communications, regardless of the number of ports.

If the service port is in use, the management interface must be on a different supernet from the service-port interface.

**Note**

To prevent or block a wired or wireless client from accessing the management network on a controller (from the wireless client dynamic interface or VLAN), the network administrator must ensure that only authorized clients gain access to the management network through proper CPU ACLs, or use a firewall between the client dynamic interface and the management network.

**Caution**

Do not map a guest WLAN to the management interface. If the EoIP tunnel breaks, the client could obtain an IP and be placed on the management subnet.

**Caution**

Do not configure wired clients in the same VLAN or subnet of the service port of the controller on the network. If you configure wired clients on the same subnet or VLAN as the service port, it is not possible to access the management interface of the controller.

**Authentication Type for Management Interfaces**

For any type of management access to the controller, be it SSH, Telnet, or HTTP, we recommend that you use any one authentication type, which can be TACACS+, RADIUS, or Local, and not a mix of these authentication types. Ensure that you take care of the following:

- Authentication type (TACACS+, RADIUS, or Local), must be the same for all management access and for all AAA authentication and authorization parameters.
- The method list must be explicitly specified in the HTTP authentication.

**Example**

Follow these steps to configure Telnet:

1. Configure TACACS+ server by entering these commands:
   - tacacs server server-name
   - address ipv4 ip-address
   - key key-name

2. Configure the server group name by entering these commands:
   - aaa group server tacacs+ group-name
   - server name name

3. Configure authentication and authorization by entering these commands:
   - aaa authentication login method-list group server-group
   - aaa authorization exec method-list group server-group
These and all the other authentication and authorization parameters must be using the same database, be it RADIUS, TACACS+, or Local. For example, if command authorization has to be enabled, it also needs to be pointing to the same database.

4. Configure HTTP to use the above method lists:

1. `ip http authentication aaa login-auth method-list`
   You must explicitly specify the method list, even if the method list is "default".

2. `ip http authentication aaa exec-auth method-list`

Note

- Do not configure any method-lists on the "line vty" configuration parameters. If the above steps and the line vty have different configurations, then line vty configurations take precedence.
- The database should be the same across all management configuration types such as SSH/Telnet and webui.
- You must explicitly define the method list for HTTP authentication.

Workaround

As a workaround, enter the following commands:

1. `aaa authentication login default group server-group local`
2. `aaa authorization exec default group server-group local`

Configuring the Management Interface (GUI)

Step 1
Choose Controller > Interfaces to open the Interfaces page.

Step 2
Click the management link.

The Interfaces > Edit page appears.

Step 3
Set the management interface parameters:

- Quarantine and quarantine VLAN ID, if applicable

Note

- Select the Quarantine check box if you want to configure this VLAN as unhealthy or you want to configure network access control (NAC) out-of-band integration. Doing so causes the data traffic of any client that is assigned to this VLAN to pass through the controller.
- NAT address (only Cisco 2500 Series Controllers and Cisco 5500 Series Controllers are configured for dynamic AP management.)
Select the **Enable NAT Address** check box and enter the external NAT IP address if you want to be able to deploy your Cisco 2500 Series Controllers or Cisco 5500 Series Controller behind a router or other gateway device that is using one-to-one mapping network address translation (NAT). NAT allows a device, such as a router, to act as an agent between the Internet (public) and a local network (private). In this case, it maps the controller’s intranet IP addresses to a corresponding external address. The controller’s dynamic AP-manager interface must be configured with the external NAT IP address so that the controller can send the correct IP address in the Discovery Response.

**Note**

If a Cisco 2500 Series Controllers or Cisco 5500 Series Controller is configured with an external NAT IP address under the management interface, the APs in local mode cannot associate with the controller. The workaround is to either ensure that the management interface has a globally valid IP address or ensure that external NAT IP address is valid internally for the local APs.

**Note**

The NAT parameters are supported for use only with one-to-one-mapping NAT, where each private client has a direct and fixed mapping to a global address. The NAT parameters do not support one-to-many NAT, which uses source port mapping to enable a group of clients to be represented by a single IP address.

- **VLAN**
  - **identifier**
  - **Note** Enter 0 for an untagged VLAN or a nonzero value for a tagged VLAN. We recommend using tagged VLANs for the management interface.
  - **Configuring Management Interface using IPv4**— Fixed IP address, IP netmask, and default gateway.
    - **Configuring Management Interface using IPv6**— Fixed IPv6 address, prefix-length (interface subnet mask for IPv6) and the link local address of the IPv6 gateway router.
  - **Note**
    - Once the Primary IPv6 Address, Prefix Length, and Primary IPv6 Gateway are configured on the management interface, they cannot be changed back to default values (::/128).
    - A configuration backup must be carried out before configuring IPv6 in case the user wants to revert back to IPv4 only management interface.
    - When more than 1300 IPv6 APs are in use, on a single Catalyst 6000 Switch, then assign APs on multiple VLANs.
    - In 8500 controller running a ha-pair, IPv6 primary gateway(link local) configured though 3600 AP joined with the IPv6 address tears down the capwap. Using the command test capwap though the AP joined with ipv6 address, it is seen that when the Link local address is not reachable capwap should not be formed.
    - If APs are joined on V6 tunnel and if IPv6 gateway is misconfigured then v6 tunnel will not be teared down. The APs will still be on v6 tunnel and will not fall back to v4 tunnel.
  - **Dynamic AP management** (for Cisco 2500 Series Controllers or Cisco 5500 Series Controller only)
    - **Note** For Cisco 5500 Series Controllers, the management interface acts like an AP-manager interface by default. If desired, you can disable the management interface as an AP-manager interface and create another dynamic interface as an AP manager.
    - **Physical port assignment** (for all controllers except the Cisco 2500 Series Controllers or Cisco 5500 Series Controller)
    - **Primary and secondary DHCP servers**
    - **Access control list (ACL) setting**, if required

**Step 4**

Click **Save Configuration**.

**Step 5**

If you made any changes to the management or virtual interface, reboot the controller so that your changes take effect.
Configuring the Management Interface (CLI)

Step 1
Enter the `show interface detailed management` command to view the current management interface settings.

**Note**  The management interface uses the controller’s factory-set distribution system MAC address.

Step 2
Enter the `config wlan disable wlan-number` command to disable each WLAN that uses the management interface for distribution system communication.

Step 3
Enter these commands to define the management interface:

a) **Using IPv4 Address**
   - `config interface address management ip-addr ip-netmask gateway`
   - `config interface quarantine vlan management vlan_id`
   **Note**  Use the `config interface quarantine vlan management vlan_id` command to configure a quarantine VLAN on the management interface.
   - `config interface vlan management {vlan-id | 0}`
   **Note**  Enter 0 for an untagged VLAN or a nonzero value for a tagged VLAN. We recommend using tagged VLANs for the management interface.
   - `config interface ap-manager management {enable | disable}` (for Cisco 5500 Series Controllers only)
   **Note**  Use the `config interface ap-manager management {enable | disable}` command to enable or disable dynamic AP management for the management interface. For Cisco 5500 Series Controllers, the management interface acts like an AP-manager interface by default. If desired, you can disable the management interface as an AP-manager interface and create another dynamic interface as an AP manager.
   - `config interface port management physical-ds-port-number` (for all controllers except the 5500 series)
   - `config interface dhcp management ip-address-of-primary-dhcp-server [ip-address-of-secondary-dhcp-server]`
   - `config interface acl management access-control-list-name`

b) **Using IPv6 Address**
   - `config ipv6 interface address management primary ip-address prefix-length IPv6_Gateway_Address`
   **Note**  Once the Primary IPv6 Address, Prefix Length, and Primary IPv6 Gateway are configured on the management interface, they cannot be changed back to default values (::/128). A configuration backup must be carried out before configuring IPv6 in case the user wants to revert back to IPv4 only management interface.
   - `config interface quarantine vlan management vlan_id`
   **Note**  Use the `config interface quarantine vlan management vlan_id` command to configure a quarantine VLAN on the management interface.
   - `config interface vlan management {vlan-id | 0}`
Configuring the AP-Manager Interface

Information About AP-Manager Interface

A controller configured with IPv4 has one or more AP-manager interfaces, which are used for all Layer 3 communications between the controller and lightweight access points after the access points have joined the controller.
A controller configured with IPv6 has only one AP-manager and is applicable on management interface. You cannot remove the AP-manager configured on management interface.

The AP-manager IP address is used as the tunnel source for CAPWAP packets from the controller to the access point and as the destination for CAPWAP packets from the access point to the controller.

The controller does not support transmitting the jumbo frames. To avoid having the controller transmit CAPWAP packets to the AP that will necessitate fragmentation and reassembly, reduce MTU/MSS on the client side.

The AP-manager interface communicates through any distribution system port by listening across the Layer 3 network for access point CAPWAP or LWAPP join messages to associate and communicate with as many lightweight access points as possible.

A controller configured with IPv6 does not support Dynamic AP-Manager. By default, the management interface acts like an AP-manager interface. Link Aggregation (LAG) is used for IPv6 AP load balancing.

**Guidelines and Limitations**

- An AP-manager interface is not required to be configured. The management interface acts like an AP-manager interface by default, and the access points can join on this interface.
- The MAC address of the management interface and the AP-manager interface is the same as the base LAG MAC address.
- If only one distribution system port can be used, you should use distribution system port 1.
- If link aggregation (LAG) is enabled, there can be only one AP-manager interface. But when LAG is disabled, one or more AP-manager interfaces can be created, generally one per physical port.
- Port redundancy for the AP-manager interface is not supported. You cannot map the AP-manager interface to a backup port.

## Configuring the AP-Manager Interface (GUI)

**Step 1** Choose Controller > Interfaces to open the Interfaces page.

**Step 2** Click AP-Manager Interface. The Interface > Edit page appears.

**Step 3** Set the AP-Manager Interface parameters:

- **Physical port assignment**
- **VLAN identifier**
Enter 0 for an untagged VLAN or a nonzero value for a tagged VLAN. We recommend using tagged VLANs for the AP-manager interface.

Note The gig/wired subinterface is numbered with VLAN number and dot11 subinterface is numbered with the WLAN ID. The first configured WLAN becomes dot11 0.1 & dot11 1.1 and second WLAN ID subinterface becomes dot11 0.2 & dot11 1.2 onwards. This dot11 sub interface number cannot be mapped with a VLAN ID because multiple WLAN can be assigned with a same VLAN number. We cannot have duplicate subinterface created in the system. The native subinterface configuration in wired interface is the AP native VLAN configuration, if VLAN support is enabled in FlexConnect mode or else the native interface is always gig prime interface in AP(Local / Flex with no VLAN support).

- Fixed IP address, IP netmask, and default gateway
- Primary and secondary DHCP servers
- Access control list (ACL) name, if required

**Step 4** Click **Save Configuration** to save your changes.

**Step 5** If you made any changes to the management or virtual interface, reboot the controller so that your changes take effect.

**Configuring the AP Manager Interface (CLI)**

**Before You Begin**

For Cisco 5500 Series Controllers, you are not required to configure an AP-manager interface. The management interface acts like an AP-manager interface by default.

**Note** A controller configured with IPv6 address does not support Dynamic AP-Manager. The management interface acts like an AP-manager interface by default.

**Step 1** Enter the **show interface summary** command to view the current interfaces.

**Note** If the system is operating in Layer 2 mode, the AP-manager interface is not listed.

**Step 2** Enter the **show interface detailed ap-manager** command to view the current AP-manager interface settings.

**Step 3** Enter the **config wlan disable wlan-number** command to disable each WLAN that uses the AP-manager interface for distribution system communication.

**Step 4** Enter these commands to define the AP-manager interface:

- **config interface address ap-manager ip-addr ip-netmask gateway**
- **config interface vlan ap-manager {vlan-id | 0}**

**Note** Enter 0 for an untagged VLAN or a nonzero value for a tagged VLAN. We recommend using tagged VLANs for the AP-manager interface.
• config interface port ap-manager physical-ds-port-number
• config interface dhcp ap-manager ip-address-of-primary-dhcp-server [ip-address-of-secondary-dhcp-server]
• config interface acl ap-manager access-control-list-name

Step 5
Enter the save config command to save your changes.

Step 6
Enter the show interface detailed ap-manager command to verify that your changes have been saved.

Configuring Virtual Interfaces

Information About the Virtual Interface

The virtual interface is used to support mobility management, Dynamic Host Configuration Protocol (DHCP) relay, and embedded Layer 3 security such as guest web authentication and VPN termination. It also maintains the DNS gateway host name used by Layer 3 security and mobility managers to verify the source of certificates when Layer 3 web authorization is enabled.

Specifically, the virtual interface plays these two primary roles:

• Acts as the DHCP server placeholder for wireless clients that obtain their IP address from a DHCP server.
• Serves as the redirect address for the web authentication login page.

The virtual interface IP address is used only in communications between the controller and wireless clients. It never appears as the source or destination address of a packet that goes out a distribution system port and onto the switched network. For the system to operate correctly, the virtual interface IP address must be set (it cannot be 0.0.0.0), and no other device on the network can have the same address as the virtual interface. Therefore, the virtual interface must be configured with an unassigned and unused gateway IP address. The virtual interface IP address is not pingable and should not exist in any routing table in your network. In addition, the virtual interface cannot be mapped to a physical port.

Note
All controllers within a mobility group must be configured with the same virtual interface IP address. Otherwise, inter-controller roaming may appear to work, but the handoff does not complete, and the client loses connectivity for a period of time.

Configuring Virtual Interfaces (GUI)

Step 1
Choose Controller > Interfaces to open the Interfaces page.

Step 2
Click Virtual.
The Interfaces > Edit page appears.

**Step 3** Enter the following parameters:
- Any fictitious, unassigned, and unused gateway IP address
- DNS gateway hostname

**Note** To ensure connectivity and web authentication, the DNS server should always point to the virtual interface. If a DNS hostname is configured for the virtual interface, then the same DNS host name must be configured on the DNS server(s) used by the client.

**Step 4** Click Save Configuration.

**Step 5** If you made any changes to the management or virtual interface, reboot the controller so that your changes take effect.

---

**Configuring Virtual Interfaces (CLI)**

**Step 1** Enter the `show interface detailed virtual` command to view the current virtual interface settings.

**Step 2** Enter the `config wlan disable wlan-number` command to disable each WLAN that uses the virtual interface for distribution system communication.

**Step 3** Enter these commands to define the virtual interface:

- `config interface address virtual ip-address`
  
  **Note** For `ip-address`, enter any fictitious, unassigned, and unused gateway IP address.

- `config interface hostname virtual dns-host-name`

**Step 4** Enter the `reset system` command. At the confirmation prompt, enter Y to save your configuration changes to NVRAM. The controller reboots.

**Step 5** Enter the `show interface detailed virtual` command to verify that your changes have been saved.

---

**Configuring Service-Port Interfaces**

**Information About Service-Port Interfaces**

The service-port interface controls communications through and is statically mapped by the system to the service port.

The service port can obtain an IPv4 address using DHCP, or it can be assigned a static IPv4 address, but a default gateway cannot be assigned to the service-port interface. Static IPv4 routes can be defined through the controller for remote network access to the service port.
If the service port is in use, the management interface must be on a different supernet from the service-port interface.

Similarly, the service port can be statically assigned an IPv6 address or select an IPv6 address using Stateless Address Auto-Configuration (SLAAC). The default gateway cannot be assigned to the service-port interface. Static IPv6 routes can be defined through the controller for remote network access to the service port.

---

**Note**

This is the only SLAAC interface on the controller, all other interfaces must be statically assigned (just like for IPv4).

---

**Note**

User does not require IPv6 static routes to reach service port from the same network, but IPv6 routes requires to access service port from different network. The IPv6 static routes should be as same as IPv4.

---

### Restrictions for Configuring Service-Port Interfaces

- Only Cisco 7500 Series Controllers and Cisco 5500 Series Controllers have a physical service-port interface that is reachable from the external network.
- You must not use the service-port for continuous SNMP polling and management functions except when the management interface of the controller is unreachable.

### Configuring Service-Port Interfaces Using IPv4 (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose Controller &gt; Interfaces to open the Interfaces page.</td>
</tr>
<tr>
<td>2</td>
<td>Click the service-port link to open the Interfaces &gt; Edit page.</td>
</tr>
</tbody>
</table>
| 3    | Enter the Service-Port Interface parameters:  
  **Note** The service-port interface uses the controller's factory-set service-port MAC address.  
  - DHCP protocol (enabled)  
  - DHCP protocol (disabled) and IP address and IP netmask |
| 4    | Click Save Configuration to save your changes. |
| 5    | If you made any changes to the management or virtual interface, reboot the controller so that your changes take effect. |
Configuring Service-Port Interfaces Using IPv4 (CLI)

Step 1  
To view the current service-port interface settings, enter this command:  
```
show interface detailed service-port
```

Note  
The service-port interface uses the controller’s factory-set service-port MAC address.

Step 2  
Enter these commands to define the service-port interface:

- To configure the DHCP server, enter this command:
  ```
  config interface dhcp service-port enable
  ```

- To disable the DHCP server, enter this command:
  ```
  config interface dhcp service-port disable
  ```

- To configure the IPv4 address, enter this command:
  ```
  config interface address service-port ip-addr ip-netmask
  ```

Step 3  
The service port is used for out-of-band management of the controller. If the management workstation is in a remote subnet, you may need to add a IPv4 route on the controller in order to manage the controller from that remote workstation. To do so, enter this command:

```
config route add network-ip-addr ip-netmask gateway
```

Step 4  
To remove the IPv4 route on the controller, enter this command:
```
config route delete ip_address
```

Step 5  
Enter the `save config` command to save your changes.

Step 6  
Enter the `show interface detailed service-port` command to verify that your changes have been saved.

Configuring Dynamic Interfaces

Information About Dynamic Interface

Dynamic interfaces, also known as VLAN interfaces, are created by users and designed to be analogous to VLANs for wireless LAN clients. A controller can support up to 512 dynamic interfaces (VLANs). Each dynamic interface is individually configured and allows separate communication streams to exist on any or all of a controller’s distribution system ports. Each dynamic interface controls VLANs and other communications between controllers and all other network devices, and each acts as a DHCP relay for wireless clients associated to WLANs mapped to the interface. You can assign dynamic interfaces to distribution system ports, WLANs, the Layer 2 management interface, and the Layer 3 AP-manager interface, and you can map the dynamic interface to a backup port.

You can configure zero, one, or multiple dynamic interfaces on a distribution system port. However, all dynamic interfaces must be on a different VLAN or IP subnet from all other interfaces configured on the port.
If the port is untagged, all dynamic interfaces must be on a different IP subnet from any other interface configured on the port.

This table lists the maximum number of VLANs supported on the various controller platforms.

### Table 3: Maximum number of VLANs supported on Cisco Wireless Controllers

<table>
<thead>
<tr>
<th>Wireless Controllers</th>
<th>Maximum VLANs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Virtual Wireless Controller</td>
<td>512</td>
</tr>
<tr>
<td>Cisco Wireless Controller Module for ISR G2</td>
<td>16</td>
</tr>
<tr>
<td>Cisco 2500 Series Wireless Controllers</td>
<td>16</td>
</tr>
<tr>
<td>Cisco 5500 Series Wireless Controller</td>
<td>512</td>
</tr>
<tr>
<td>Cisco Catalyst 6500 Series Wireless Services Module2 (WiSM2)</td>
<td>512</td>
</tr>
<tr>
<td>Cisco Flex 7500 Series Cloud Controller</td>
<td>4,096</td>
</tr>
<tr>
<td>Cisco 8500 Series Controller</td>
<td>4,096</td>
</tr>
</tbody>
</table>

**Note**

You must not configure a dynamic interface in the same network as that of Local Mobility Anchor (LMA). If you do so, the GRE tunnel between the controller and LMA does not come up.

### Guidelines and Limitations

- If you are using DHCP proxy and/or a RADIUS source interface, ensure that the dynamic interface has a valid routable address. Duplicate or overlapping addresses across controller interfaces are not supported.
- We recommend using tagged VLANs for dynamic interfaces.
- You must not configure a dynamic interface in the same sub-network as a server that is reachable by the controller CPU, like a RADIUS server, as it might cause asymmetric routing issues.
- For SNMP requests that come from a subnet that is configured as a dynamic interface, the controller responds but the response does not reach the device that initiated the conversation.
Configuring Dynamic Interfaces (GUI)

**Step 1**  Choose **Controller > Interfaces** to open the Interfaces page.

**Step 2**  Perform one of the following:

- To create a new dynamic interface, click **New**. The **Interfaces > New** page appears. Go to **Step 3**.
- To modify the settings of an existing dynamic interface, click the name of the interface. The **Interfaces > Edit** page for that interface appears. Go to **Step 5**.
- To delete an existing dynamic interface, hover your cursor over the blue drop-down arrow for the desired interface and choose **Remove**.

**Step 3**  Enter an interface name and a VLAN identifier, as shown in the figure above.

**Step 4**  Click **Apply** to commit your changes. The **Interfaces > Edit** page appears.

**Step 5**  Configure the following parameters:

- Guest LAN, if applicable
- Quarantine and quarantine VLAN ID, if applicable

**Note**  Select the **Quarantine** check box if you want to configure this VLAN as unhealthy or you want to configure network access control (NAC) out-of-band integration. Doing so causes the data traffic of any client that is assigned to this VLAN to pass through the controller.

- Physical port assignment (for all controllers except the 5500 series)
- NAT address (only for Cisco 5500 Series Controllers configured for dynamic AP management)

**Note**  Select the **Enable NAT Address** check box and enter the external NAT IP address if you want to be able to deploy your Cisco 5500 Series Controller behind a router or other gateway device that is using one-to-one mapping network address translation (NAT). NAT allows a device, such as a router, to act as an agent between the Internet (public) and a local network (private). In this case, it maps the controller's intranet IP addresses to a corresponding external address. The controller's dynamic AP-manager interface must be configured with the external NAT IP address so that the controller can send the correct IP address in the Discovery Response.

**Note**  The NAT parameters are supported for use only with one-to-one-mapping NAT, where each private client has a direct and fixed mapping to a global address. The NAT parameters do not support one-to-many NAT, which uses source port mapping to enable a group of clients to be represented by a single IP address.

- Dynamic AP management

**Note**  When you enable this feature, this dynamic interface is configured as an AP-manager interface (only one AP-manager interface is allowed per physical port). A dynamic interface that is marked as an AP-manager interface cannot be used as a WLAN interface.

**Note**  Set the APs in a VLAN that is different than the dynamic interface configured on the controller. If the APs are in the same VLAN as the dynamic interface, the APs are not registered on the controller and the "LWAPP discovery rejected" and "Layer 3 discovery request not received on management VLAN" errors are logged on the controller.

- VLAN identifier
- Fixed IP address, IP netmask, and default gateway
- Primary and secondary DHCP servers
- Access control list (ACL) name, if required

**Note** To ensure proper operation, you must set the Port Number and Primary DHCP Server parameters.

**Step 6** Click **Save Configuration** to save your changes.

**Step 7** Repeat this procedure for each dynamic interface that you want to create or edit.

---

## Configuring Dynamic Interfaces (CLI)

**Step 1** Enter the `show interfaces summary` command to view the current dynamic interfaces.

**Step 2** View the details of a specific dynamic interface by entering this command:

```
show interface detailed operator_defined_interface_name.
```

**Note** Interface names that contain spaces must be enclosed in double quotes. For example: `config interface create "vlan 25"`

**Step 3** Enter the `config wlan disable wlan_id` command to disable each WLAN that uses the dynamic interface for distribution system communication.

**Step 4** Enter these commands to configure dynamic interfaces:

- `config interface create operator_defined_interface_name {vlan_id | x}`
- `config interface address interface ip_addr ip_netmask [gateway]`
- `config interface vlan operator_defined_interface_name {vlan_id | o}`
- `config interface port operator_defined_interface_name physical_ds_port_number`
- `config interface ap-manager operator_defined_interface_name {enable | disable}`

**Note** Use the `config interface ap-manager operator_defined_interface_name {enable | disable}` command to enable or disable dynamic AP management. When you enable this feature, this dynamic interface is configured as an AP-manager interface (only one AP-manager interface is allowed per physical port). A dynamic interface that is marked as an AP-manager interface cannot be used as a WLAN interface.

- `config interface dhcp operator_defined_interface_name ip_address_of_primary_dhcp_server [ip_address_of_secondary_dhcp_server]`
- `config interface quarantine vlan interface_name vlan_id`

**Note** Use the `config interface quarantine vlan interface_name vlan_id` command to configure a quarantine VLAN on any interface.

- `config interface acl operator_defined_interface_name access_control_list_name`

**Step 5** Enter these commands if you want to be able to deploy your Cisco 5500 Series Controller behind a router or other gateway device that is using one-to-one mapping network address translation (NAT):

- `config interface nat-address dynamic-interface operator_defined_interface_name {enable | disable}`
Information About Dynamic AP Management

A dynamic interface is created as a WLAN interface by default. However, any dynamic interface can be configured as an AP-manager interface, with one AP-manager interface allowed per physical port. A dynamic interface with the Dynamic AP Management option enabled is used as the tunnel source for packets from the controller to the access point and as the destination for CAPWAP packets from the access point to the controller. The dynamic interfaces for AP management must have a unique IP address and are usually configured on the same subnet as the management interface.

Note

If link aggregation (LAG) is enabled, there can be only one AP-manager interface.

We recommend having a separate dynamic AP-manager interface per controller port.
Information About WLANs

A WLAN associates a service set identifier (SSID) to an interface or an interface group. It is configured with security, quality of service (QoS), radio policies, and other wireless network parameters. Up to 512 WLANs can be configured per controller.

Figure 19: Relationship between Ports, Interfaces, and WLANs

Each controller port connection is an 802.1Q trunk and should be configured as such on the neighbor switch. On Cisco switches, the native VLAN of an 802.1Q trunk is an untagged VLAN. If you configure an interface to use the native VLAN on a neighboring Cisco switch, make sure you configure the interface on the controller to be untagged.

Note
A zero value for the VLAN identifier (on the Controller > Interfaces page) means that the interface is untagged.
The default (untagged) native VLAN on Cisco switches is VLAN 1. When controller interfaces are configured as tagged (meaning that the VLAN identifier is set to a nonzero value), the VLAN must be allowed on the 802.1Q trunk configuration on the neighbor switch and not be the native untagged VLAN.

We recommend that tagged VLANs be used on the controller. You should also allow only relevant VLANs on the neighbor switch’s 802.1Q trunk connections to controller ports. All other VLANs should be disallowed or pruned in the switch port trunk configuration. This practice is extremely important for optimal performance of the controller.

Note  We recommend that you assign one set of VLANs for WLANs and a different set of VLANs for management interfaces to ensure that controllers properly route VLAN traffic.

## Configuring Ports (GUI)

The controller’s ports are configured with factory-default settings designed to make the controllers’ ports operational without additional configuration. However, you can view the status of the controller’s ports and edit their configuration parameters at any time.

### Step 1

Choose **Controller > Ports** to open the Ports page.

This page shows the current configuration for each of the controller’s ports.

If you want to change the settings of any port, click the number for that specific port. The **Port > Configure** page appears.

**Note**  If the management and AP-manager interfaces are mapped to the same port and are members of the same VLAN, you must disable the WLAN before making a port-mapping change to either interface. If the management and AP-manager interfaces are assigned to different VLANs, you do not need to disable the WLAN.

**Note**  The number of parameters available on the **Port > Configure** page depends on your controller type.

The following show the current status of the port:

- **Port Number**—Number of the current port.
- **Admin Status**—Current state of the port. Values: Enable or Disable
- **Physical Mode**—Configuration of the port physical interface. The mode varies by the controller type.
- **Physical Status**—The data rate being used by the port. The available data rates vary based on controller type.
  - 2500 series - 1 Gbps full duplex
  - WiSM2 - 10 Gbps full duplex
  - 7500 series - 10 Gbps full duplex
- **Link Status**—Link status of the port. Values: Link Up or Link Down
- **Link Trap**—Whether the port is set to send a trap when the link status changes. Values: Enable or Disable
- **Power over Ethernet (PoE)**—If the connecting device is equipped to receive power through the Ethernet cable and if so, provides ~48 VDC. Values: Enable or Disable
Some older Cisco access points do not draw PoE even if it is enabled on the controller port. In such cases, contact the Cisco Technical Assistance Center (TAC).

The following is a list of the port’s configurable parameters.

1 **Admin Status**—Enables or disables the flow of traffic through the port. Options: Enable or Disable, with default option of Enable.
   
   **Note** When a primary port link goes down, messages may get logged internally only and not be posted to a syslog server. It may take up to 40 seconds to restore logging to the syslog server.

2 **Physical Mode**—Determines whether the port’s data rate is set automatically or specified by the user. The supported data rates vary based on the controller type. Default: Auto.

3 **Link Trap**—Causes the port to send a trap when the port’s link status changes. Options: Enable or Disable, with default option of Enable.

---

### Configuring Port Mirroring

#### Information About Port Mirroring

Mirror mode enables you to duplicate to another port all of the traffic originating from or terminating at a single client device or access point. It is useful in diagnosing specific network problems. Mirror mode should be enabled only on an unused port as any connections to this port become unresponsive.

#### Guidelines and Limitations

- Port mirroring is not supported when link aggregation (LAG) is enabled on the controller.
- We recommend that you do not mirror traffic from one controller port to another as this setup could cause network problems.
Enabling Port Mirroring (GUI)

**Step 1** Choose **Controller > Ports** to open the Ports page.

**Step 2** Click the number of the unused port for which you want to enable mirror mode. The Port > Configure page appears.

**Step 3** Set the Mirror Mode parameter to **Enable**.

**Step 4** Click **Apply** to commit your changes.

**Step 5** Perform one of the following:

a) If you want to choose a specific client device that will mirror its traffic to the port you selected on the controller, choose **Wireless > Clients** to open the Clients page.

b) Click the MAC address of the client for which you want to enable mirror mode. The Clients > Detail page appears.

c) Under Client Details, set the Mirror Mode parameter to **Enable**.

OR

a) If you want to choose an access point that will mirror its traffic to the port you selected on the controller, choose **Wireless > Access Points > All APs** to open the All APs page.

b) Click the name of the access point for which you want to enable mirror mode. The All APs > Details page appears.

c) Choose the **Advanced** tab.

d) Set the Mirror Mode parameter to **Enable**.

**Step 6** Click **Save Configuration** to save your changes.

Using the Cisco 5500 Series Controller USB Console Port

USB Console OS Compatibility

**Before You Begin**

These operating systems are compatible with the USB console:

- Microsoft Windows 2000, Windows XP, Windows Vista, Windows 7 (Cisco Windows USB console driver required)

- Apple Mac OS X 10.5.2 (no driver required)

- Linux (no driver required)

**Step 1** Download the USB_Console.inf driver file as follows:

a) Click this URL to go to the Software Center: [http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=278875243](http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=278875243)

b) Click **Wireless LAN Controllers**.

c) Click **Standalone Controllers**.
d) Click Cisco 5500 Series Wireless LAN Controllers.
e) Click Cisco 5508 Wireless LAN Controller.
f) Choose the USB driver file.
g) Save the file to your hard drive.

**Step 2**
Connect the Type A connector to a USB port on your PC.

**Step 3**
Connect the mini Type B connector to the USB console port on the controller.

**Step 4**
When prompted for a driver, browse to the USB_Console.inf file on your PC. Follow the prompts to install the USB driver.

**Note**
Some systems might also require an additional system file. You can download the Usbser.sys file from Microsoft's Website.

---

### Changing the Cisco USB Systems Management Console COM Port to an Unused Port

**Before You Begin**

The USB driver is mapped to COM port 6. Some terminal emulation programs do not recognize a port higher than COM 4. If necessary, you must change the Cisco USB systems management console COM port to an unused port of COM 4 or lower.

**Step 1**
From your Windows desktop, right-click **My Computer** and choose **Manage**.

**Step 2**
From the list on the left side, choose **Device Manager**.

**Step 3**
From the device list on the right side, double-click **Ports (COM & LPT)**.

**Step 4**
Right-click **Cisco USB System Management Console 0108** and choose **Properties**.

**Step 5**
Click the **Port Settings** tab and click the **Advanced** button.

**Step 6**
From the COM Port Number drop-down list, choose an unused COM port of 4 or lower.

**Step 7**
Click **OK** to save and then close the Advanced Settings dialog box.

**Step 8**
Click **OK** to save and then close the Communications Port Properties dialog box.

---

### Choosing Between Link Aggregation and Multiple AP-Manager Interfaces

Cisco 5500 Series Controllers have no restrictions on the number of access points per port, but we recommend using LAG or multiple AP-manager interfaces on each Gigabit Ethernet port to automatically balance the load.

The following factors should help you decide which method to use if your controller is set for Layer 3 operation:
With LAG, all of the controller ports need to connect to the same neighbor switch. If the neighbor switch goes down, the controller loses connectivity.

With multiple AP-manager interfaces, you can connect your ports to different neighbor devices. If one of the neighbor switches goes down, the controller still has connectivity. However, using multiple AP-manager interfaces presents certain challenges when port redundancy is a concern.

Configuring Link Aggregation

Information About Link Aggregation

Link aggregation (LAG) is a partial implementation of the 802.3ad port aggregation standard. It bundles all of the controller’s distribution system ports into a single 802.3ad port channel, thereby reducing the number of IP addresses needed to configure the ports on your controller. When LAG is enabled, the system dynamically manages port redundancy and load balances access points transparently to the user.

LAG simplifies controller configuration because you no longer need to configure primary and secondary ports for each interface. If any of the controller ports fail, traffic is automatically migrated to one of the other ports. As long as at least one controller port is functioning, the system continues to operate, access points remain connected to the network, and wireless clients continue to send and receive data.

Cisco WLC does not send CDP advertisements on a LAG interface.

Note

LAG is supported across switches.

Restrictions for Link Aggregation

- You can bundle all eight ports on a Cisco 5508 Controller into a single link.
- Terminating on two different modules within a single Catalyst 6500 series switch provides redundancy and ensures that connectivity between the switch and the controller is maintained when one module fails. The controller’s port 1 is connected to Gigabit interface 3/1, and the controller’s port 2 is connected to Gigabit interface 2/1 on the Catalyst 6500 series switch. Both switch ports are assigned to the same channel group.
- LAG requires the EtherChannel to be configured for 'mode on' on both the controller and the Catalyst switch.
- Once the EtherChannel is configured as on at both ends of the link, the Catalyst switch should not be configured for either Link Aggregation Control Protocol (LACP) or Cisco proprietary Port Aggregation Protocol (PAgP) but be set unconditionally to LAG. Because no channel negotiation is done between the controller and the switch, the controller does not answer to negotiation frames and the LAG is not formed if a dynamic form of LAG is set on the switch. Additionally, LACP and PAgP are not supported on the controller.
• If the recommended load-balancing method cannot be configured on the Catalyst switch, then configure the LAG connection as a single member link or disable LAG on the controller.

Figure 20: Link Aggregation with the Catalyst 6500 Series Neighbor Switch

- You cannot configure the controller’s ports into separate LAG groups. Only one LAG group is supported per controller. Therefore, you can connect a controller in LAG mode to only one neighbor device.
- When you enable LAG or make any changes to the LAG configuration, you must immediately reboot the controller.
- When you enable LAG, you can configure only one AP-manager interface because only one logical port is needed. LAG removes the requirement for supporting multiple AP-manager interfaces.
- When you enable LAG, all dynamic AP-manager interfaces and untagged interfaces are deleted, and all WLANs are disabled and mapped to the management interface. Also, the management, static AP-manager, and VLAN-tagged dynamic interfaces are moved to the LAG port.
- Multiple untagged interfaces to the same port are not allowed.
- When you enable LAG, you cannot create interfaces with a primary port other than 29.
- When you enable LAG, all ports participate in LAG by default. You must configure LAG for all of the connected ports in the neighbor switch.
- When you enable LAG, if any single link goes down, traffic migrates to the other links.
- When you enable LAG, only one functional physical port is needed for the controller to pass client traffic.
- When you enable LAG, access points remain connected to the controller until you reboot the controller, which is needed to activate the LAG mode change, and data service for users continues uninterrupted.
- When you enable LAG, you eliminate the need to configure primary and secondary ports for each interface.
- When you enable LAG, the controller sends packets out on the same port on which it received them. If a CAPWAP packet from an access point enters the controller on physical port 1, the controller removes
the CAPWAP wrapper, processes the packet, and forwards it to the network on physical port 1. This may not be the case if you disable LAG.

- When you disable LAG, the management, static AP-manager, and dynamic interfaces are moved to port 1.
- When you disable LAG, you must configure primary and secondary ports for all interfaces.
- When you disable LAG, you must assign an AP-manager interface to each port on the controller. Otherwise, access points are unable to join.
- Cisco 5500 Series Controllers support a single static link aggregation bundle.
- LAG is typically configured using the Startup Wizard, but you can enable or disable it at any time through either the GUI or CLI.
- When you enable LAG on Cisco 2500 Series Controller to which the direct-connect access point is associated, the direct connect access point is disconnected since LAG enabling is still in the transition state. You must reboot the controller immediately after enabling LAG.
- In 8500 when more than 1000 APs joining WLC flapping occurs, to avoid this do not add more than 1000 Aps on a single catalyst switch for Capwap IPv6.

### Configuring Link Aggregation (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose <strong>Controller &gt; General</strong> to open the General page.</td>
</tr>
<tr>
<td>2</td>
<td>Set the LAG Mode on Next Reboot parameter to Enabled.</td>
</tr>
<tr>
<td>3</td>
<td>Save the configuration.</td>
</tr>
<tr>
<td>4</td>
<td>Reboot Cisco WLC.</td>
</tr>
<tr>
<td>5</td>
<td>Assign the WLAN to the appropriate VLAN.</td>
</tr>
</tbody>
</table>

### Configuring Link Aggregation (CLI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Enter the <code>config lag enable</code> command to enable LAG. <strong>Note</strong> Enter the <code>config lag disable</code> command if you want to disable LAG.</td>
</tr>
<tr>
<td>2</td>
<td>Enter the <code>save config</code> command to save your settings.</td>
</tr>
<tr>
<td>3</td>
<td>Reboot Cisco WLC.</td>
</tr>
</tbody>
</table>
Verifying Link Aggregation Settings (CLI)

To verify your LAG settings, enter this command:

```
show lag summary
```

Information similar to the following appears:

```
LAG Enabled
```

Configuring Neighbor Devices to Support Link Aggregation

The controller’s neighbor devices must also be properly configured to support LAG.

- Each neighbor port to which the controller is connected should be configured as follows:

```
interface GigabitEthernet <interface id>
switchport
channel-group <id> mode on
no shutdown
```

- The port channel on the neighbor switch should be configured as follows:

```
interface port-channel <id>
switchport
switchport trunk encapsulation dot1q
switchport trunk native vlan <native vlan id>
switchport trunk allowed vlan <allowed vlans>
switchport mode trunk
no shutdown
```

Configuring Multiple AP-Manager Interfaces

Information About Multiple AP-Manager Interfaces

When you create two or more AP-manager interfaces, each one is mapped to a different port. The ports should be configured in sequential order so that AP-manager interface 2 is on port 2, AP-manager interface 3 is on port 3, and AP-manager interface 4 is on port 4.

Before an access point joins a controller, it sends out a discovery request. From the discovery response that it receives, the access point can tell the number of AP-manager interfaces on the controller and the number of access points on each AP-manager interface. The access point generally joins the AP-manager with the least number of access points. In this way, the access point load is dynamically distributed across the multiple AP-manager interfaces.

![Note](image)

Access points may not be distributed completely evenly across all of the AP-manager interfaces, but a certain level of load balancing occurs.
Guidelines and Limitations

- Only Cisco 5500 Series Controllers support the use of multiple AP-manager interfaces.
- AP-manager interfaces do not need to be on the same VLAN or IP subnet, and they may or may not be on the same VLAN or IP subnet as the management interface. However, we recommend that you configure all AP-manager interfaces on the same VLAN or IP subnet.
- You must assign an AP-manager interface to each port on the controller.
- Before implementing multiple AP-manager interfaces, you should consider how they would impact your controller’s port redundancy.

If the port of one of the AP-manager interfaces fails, the controller clears the state of the access points, and the access points must reboot to reestablish communication with the controller using the normal controller join process. The controller no longer includes the failed AP-manager interface in the CAPWAP or LWAPP discovery responses. The access points then rejoin the controller and are load balanced among the available AP-manager interfaces.

Creating Multiple AP-Manager Interfaces (GUI)

Step 1
Choose Controller > Interfaces to open the Interfaces page.

Step 2
Click New.
The Interfaces > New page appears.

Step 3
Enter an AP-manager interface name and a VLAN identifier.

Step 4
Click Apply to commit your changes. The Interfaces > Edit page appears.

Step 5
Enter the appropriate interface parameters.
Note Every interface supports primary and backup port with the following exceptions

- Dynamic interface is converted to AP manager which does not support backup of port configuration.
- If AP manager is enabled on management interface and when management interface moves to backup port because of primary port failure, the AP manager will be disabled.

Step 6
To make this interface an AP-manager interface, select the Enable Dynamic AP Management check box.
Note Only one AP-manager interface is allowed per physical port. A dynamic interface that is marked as an AP-manager interface cannot be used as a WLAN interface.

Step 7
Click Save Configuration to save your settings.

Step 8
Repeat this procedure for each additional AP-manager interface that you want to create.
Creating Multiple AP-Manager Interfaces (CLI)

Step 1
Enter these commands to create a new interface:

- `config interface create operator_defined_interface_name {vlan_id | x}`
- `config interface address operator_defined_interface_name ip_addr ip_netmask [gateway]`
- `config interface vlan operator_defined_interface_name {vlan_id | o}`
- `config interface port operator_defined_interface_name physical_ds_port_number`
- `config interface dhcp operator_defined_interface_name ip_address_of_primary_dhcp_server [ip_address_of_secondary_dhcp_server]`
- `config interface quarantine vlan interface_name vlan_id`
  
  **Note** Use this command to configure a quarantine VLAN on any interface.

- `config interface acl operator_defined_interface_name access_control_list_name`

Step 2
To make this interface an AP-manager interface, enter this command:

```text
{config interface ap-manager operator_defined_interface_name enable | disable}
```

**Note** Only one AP-manager interface is allowed per physical port. A dynamic interface that is marked as an AP-manager interface cannot be used as a WLAN interface.

Step 3
Enter `save config` command to save your changes.

Step 4
Repeat this procedure for each additional AP-manager interface that you want to create.

Configuration Example: Configuring AP-Manager on a Cisco 5500 Series Controller

For a Cisco 5500 Series Controller, we recommend that you have eight dynamic AP-manager interfaces and associate them to the eight Gigabit ports of the controller when LAG is not used. If you are using the management interface, which acts like an AP-manager interface by default, you must create only seven more dynamic AP-manager interfaces and associate them to the remaining seven Gigabit ports.

**Note** For IPv6 only—A controller configured with IPv6 address does not support Dynamic AP-Manager. By default, the management interface acts like an AP-manager interface. Use LAG for IPv6 AP load balancing.
This figure shows a dynamic interface that is enabled as a dynamic AP-manager interface and associated to port number 2.

*Figure 21: Dynamic Interface Example with Dynamic AP Management*
This figure shows a Cisco 5500 Series Controller with LAG disabled, the management interface used as one dynamic AP-manager interface, and seven additional dynamic AP-manager interfaces, each mapped to a different Gigabit port.

Figure 22: Cisco 5500 Series Controller Interface Configuration Example

### Configuring VLAN Select

#### Information About VLAN Select

Whenever a wireless client connects to a wireless network (WLAN), the client is placed in a VLAN that is associated with the WLAN. In a large venue such as an auditorium, a stadium, or a conference where there may be numerous wireless clients, having only a single WLAN to accommodate many clients might be a challenge.

The VLAN select feature enables you to use a single WLAN that can support multiple VLANs. Clients can get assigned to one of the configured VLANs. This feature enables you to map a WLAN to a single or multiple interface VLANs using interface groups. Wireless clients that associate to the WLAN get an IP address from a pool of subnets identified by the interfaces. The IP address is derived by an algorithm based on the MAC address of the wireless client. This feature also extends the current AP group architecture where AP groups can override an interface or interface group to which the WLAN is mapped to, with multiple interfaces using the interface groups. This feature also provides the solution to auto anchor restrictions where a wireless guest user on a foreign location can get an IP address from multiple subnets based on their foreign locations or foreign controllers from the same anchor controller.

When a client roams from one controller to another, the foreign controller sends the VLAN information as part of the mobility announce message. Based on the VLAN information received, the anchor decides whether the tunnel should be created between the anchor controller and the foreign controller. If the same VLAN is available on the foreign controller, the client context is completely deleted from the anchor and the foreign controller becomes the new anchor controller for the client.

If an interface (int-1) in a subnet is untagged in one controller (Vlan ID 0) and the interface (int-2) in the same subnet is tagged to another controller (Vlan ID 1), then with the VLAN select, client joining the first controller over this interface may not undergo an L2 roam while it moves to the second controller. Hence, for L2 roaming to happen between two controllers with VLAN select, all the interfaces in the same subnet should be either tagged or untagged.

As part of the VLAN select feature, the mobility announce message carries an additional vendor payload that contains the list of VLAN interfaces in an interface group mapped to a foreign controller’s WLAN. This VLAN list enables the anchor to differentiate from a local to local or local to foreign handoff.
Restrictions for Configuring VLAN Select

- The VLAN select feature enables you to use a single WLAN that can support multiple VLANs.

Configuring Interface Groups

Information About Interface Groups

Interface groups are logical groups of interfaces. Interface groups facilitate user configuration where the same interface group can be configured on multiple WLANs or while overriding a WLAN interface per AP group. An interface group can exclusively contain either quarantine or nonquarantine interfaces. An interface can be part of multiple interface groups.

A WLAN can be associated with an interface or interface group. The interface group name and the interface name cannot be the same.

This feature also enables you to associate a client to specific subnets based on the foreign controller that they are connected to. The anchor controller WLAN can be configured to maintain a mapping between foreign controller MAC and a specific interface or interface group (Foreign maps) as needed. If this mapping is not configured, clients on that foreign controller gets VLANs associated in a round robin fashion from interface group configured on WLAN.

You can also configure AAA override for interface groups. This feature extends the current access point group and AAA override architecture where access point groups and AAA override can be configured to override the interface group WLAN that the interface is mapped to. This is done with multiple interfaces using interface groups.

This feature enables network administrators to configure guest anchor restrictions where a wireless guest user at a foreign location can obtain an IP address from multiple subnets on the foreign location and controllers from within the same anchor controller.

Controller marks VLAN as dirty when the clients are unable to receive IP address using DHCP. The VLAN interface is marked as dirty based on two methods:

Aggressive Method—When only one failure is counted per association per client and controller marks VLAN as dirty interface when a failure occurs three times for a client or for three different clients.

Non-Aggressive Method—When only one failure is counted per association per client and controller marks VLAN as a dirty interface only when three or more clients fail.

Creating Interface Groups (GUI)

Step 1 Choose Controller > Interface Groups.
The Interface Groups page appears with the list of interface groups already created.

Note To remove an interface group, hover your mouse pointer over the blue drop-down icon and choose Remove.

Step 2 Click Add Group.
The Add New Interface Group page appears.

**Step 3** Enter the details of the interface group:

- **Interface Group Name**—Specify the name of the interface group.
- **Description**—Add a brief description of the interface group.

**Step 4** Click Add.

---

**Creating Interface Groups (CLI)**

- **config interface group {create | delete} interface_group_name**—Creates or deletes an interface group
- **config interface group description interface_group_name description**—Adds a description to the interface group

**Adding Interfaces to Interface Groups (GUI)**

**Step 1** Choose **Controller > Interface Groups**. The Interface Groups page appears with a list of all interface groups.

**Step 2** Click the name of the interface group to which you want to add interfaces. The Interface Groups > Edit page appears.

**Step 3** Choose the interface name that you want to add to this interface group from the Interface Name drop-down list.

**Step 4** Click **Add Interface** to add the interface to the Interface group.

**Step 5** Repeat Steps 2 and 3 if you want to add multiple interfaces to this interface group.

**Note** To remove an interface from the interface group, hover your mouse pointer over the blue drop-down arrow and choose **Remove**.

---

**Adding Interfaces to Interface Groups (CLI)**

To add interfaces to interface groups, use the **config interface group interface add interface_group interface_name** command.

**Viewing VLANs in Interface Groups (CLI)**

To view a list of VLANs in the interface groups, use the **show interface group detailed interface-group-name** command.
Adding an Interface Group to a WLAN (GUI)

**Step 1**
Choose the WLAN tab.
The WLANs page appears listing the available WLANs.

**Step 2**
Click the WLAN ID of the WLAN to which you want to add the interface group.

**Step 3**
In the General tab, choose the interface group from the Interface/Interface Group (G) drop-down list.

**Step 4**
Click Apply.

*Note* Suppose that the interface group that you add to a WLAN has RADIUS Server Overwrite interface enabled. In this case, when a client requests for authentication, the controller selects the first IP address from the interface group as the RADIUS server.

Adding an Interface Group to a WLAN (CLI)

To add an interface group to a WLAN, enter the `config wlan interface wlan_id interface_group_name` command.

Configuring Multicast Optimization

Information About Multicast Optimization

Prior to the 7.0.116.0 release, multicast was based on the grouping of the multicast address and the VLAN as one entity, MGID. With VLAN select and VLAN pooling, there is a possibility that you might increase duplicate packets. With the VLAN select feature, every client listens to the multicast stream on a different VLAN. As a result, the controller creates different MGIDs for each multicast address and VLAN. Therefore, the upstream router sends one copy for each VLAN, which results, in the worst case, in as many copies as there are VLANs in the pool. Since the WLAN is still the same for all clients, multiple copies of the multicast packet are sent over the air. To suppress the duplication of a multicast stream on the wireless medium and between the controller and access points, you can use the multicast optimization feature.

Multicast optimization enables you to create a multicast VLAN which you can use for multicast traffic. You can configure one of the VLANs of the WLAN as a multicast VLAN where multicast groups are registered. Clients are allowed to listen to a multicast stream on the multicast VLAN. The MGID is generated using multicast VLAN and multicast IP addresses. If multiple clients on the VLAN pool of the same WLAN are listening to a single multicast IP address, a single MGID is generated. The controller makes sure that all multicast streams from the clients on this VLAN pool always go out on the multicast VLAN to ensure that the upstream router has one entry for all the VLANs of the VLAN pool. Only one multicast stream hits the VLAN pool even if the clients are on different VLANs. Therefore, the multicast packets that are sent out over the air is just one stream.
Configuring a Multicast VLAN (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose WLANs &gt; WLAN ID. The WLAN &gt; Edit page appears.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the General tab, select the Multicast VLAN feature check box to enable multicast VLAN for the WLAN. The Multicast Interface drop-down list appears.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose the VLAN from the Multicast Interface drop-down list.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click Apply.</td>
</tr>
</tbody>
</table>

Configuring a Multicast VLAN (CLI)

Use the `config wlan multicast interface wlan_id enable interface_name` command to configure the multicast VLAN feature.
Configuring Controller Settings

This chapter describes how to configure settings on the controller.

- Installing and Configuring Licenses, page 88
- Rehosting Licenses, page 100
- Configuring the License Agent, page 105
- Configuring 802.11 Bands, page 107
- Configuring 802.11n Parameters, page 110
- Configuring 802.11h Parameters, page 114
- Configuring DHCP Proxy, page 115
- Configuring Administrator Usernames and Passwords, page 118
- Configuring SNMP, page 119
- Changing the Default Values for SNMP v3 Users, page 123
- Configuring Aggressive Load Balancing, page 125
- Configuring Band Selection, page 127
- Configuring Fast SSID Changing, page 130
- Enabling 802.3X Flow Control, page 131
- Configuring 802.3 Bridging, page 131
- Configuring Multicast Mode, page 133
- Configuring Client Roaming, page 139
- Configuring IP-MAC Address Binding, page 144
- Configuring Quality of Service, page 145
- Configuring Quality of Service Roles, page 149
- Configuring Voice and Video Parameters, page 151
- Configuring SIP Based CAC, page 164
Installing and Configuring Licenses

Information About Installing and Configuring Licenses

You can order Cisco 5500 Series Controllers with support for 12, 25, 50, 100, 250 or 500 access points as the controller’s base capacity. You can add additional access point capacity through capacity adder licenses available at 25, 50, 100 and 250 access point capacities. You can add the capacity adder licenses to any base license in any combination to arrive at the maximum capacity of 500 access points. The base and adder licenses are supported through both rehosting and RMAs.

The base license supports the standard base software set, and the premium software set is included as part of the base feature set, which includes this functionality:

- Datagram Transport Layer Security (DTLS) data encryption for added security across remote WAN and LAN links.
- The availability of data DTLS is as follows:
  - Cisco 5500 Series Controller—The Cisco 5500 Series Controller is available with two licensing options: One with data DTLS capabilities and another image without data DTLS.
  - 2500, WiSM2—These platforms by default do not contain DTLS. To turn on data DTLS, you must install a license. These platforms will have a single image with data DTLS turned off. To use data DTLS, you must have a license.

- Support for OfficeExtend access points, which are used for secure mobile teleworking.

All features included in a Wireless LAN Controller WPLUS license are now included in the base license. There are no changes to Cisco Prime Infrastructure BASE and PLUS licensing. These WPlus license features are included in the base license:

- OfficeExtend AP
- Enterprise Mesh
- CAPWAP Data Encryption

For information about upgrade and capacity adder licenses, see the product data sheet of your controller model.
Restrictions for Using Licenses

The following are the restrictions you must keep in mind when using licenses for the controllers:

- The licensing change can affect features on your wireless LAN when you upgrade or downgrade software releases, so you should be aware of these guidelines:
  - If you have a WPlus license and you upgrade from 6.0.x.x to 7.x.x.x, your license file contains both Basic and WPlus license features. There is no disruption in feature availability and operation.
  - If you have a WPlus license and you downgrade from 7.x.x.x to 6.0.196.0 or 6.0.188.0 or 6.0.182.0, your license file contains only base license, and you will lose all WPlus features.
  - If you have a base license and you downgrade from 6.0.196.0 to 6.0.188.0 or 6.0.182.0, when you downgrading, you lose all WPlus features.

- In the controller software 7.0.116.0 and later releases, the AP association trap is ciscoLwappApAssociated. In prior releases, the trap was bsnAPAssociated.

- The ap-count licenses and their corresponding image-based licenses are installed together. The controller keeps track of the licensed access point count and does not allow more than the number of access points to associate to it.

- The Cisco 5500 Series Controller is shipped with both permanent and evaluation base and base-ap-count licenses. If desired, you can activate the evaluation licenses, which are designed for temporary use and set to expire after 60 days.

- No licensing steps are required after you receive your Cisco 5500 Series Controller because the licenses you ordered are installed at the factory. In addition, licenses and product authorization keys (PAKs) are preregistered to serial numbers. However, as your wireless network evolves, you might want to add support for additional access points or upgrade from the standard software set to the base software set. To do so, you must obtain and install an upgrade license.

Obtaining an Upgrade or Capacity Adder License

This section describes how to get an upgrade or capacity adder license.

Information About Obtaining an Upgrade or Capacity Adder License

A certificate with a product authorization key (PAK) is required before you can obtain an upgrade license.

You can use the capacity adder licenses to increase the number of access points supported by the controller up to a maximum of 500 access points. The capacity adder licenses are available in access point capacities of 10, 25, 50, 100 and 250 access points. You can add these licenses to any of the base capacity licenses of 12, 25, 50, 100 and 250 access points.

For example, if your controller was initially ordered with support for 100 access points (base license AIR-CT5508-100-K9), you could increase the capacity to 500 access points by purchasing a 250 access point, 100 access point, and a 50 access point additive capacity license (LIC-CT5508-250A, LIC-CT5508-100A, and LIC-CT5508-50A).

Obtaining an Upgrade or Capacity Adder License

Note
If you skip any tiers when upgrading (for example, if you do not install the -25U and -50U licenses along with the -100U), the license registration for the upgraded capacity fails.

For a single controller, you can order different upgrade licenses in one transaction (for example, -25U, -50U, -100U, and -250U), for which you receive one PAK with one license. Then you have only one license (instead of four) to install on your controller.

If you have multiple controllers and want to upgrade all of them, you can order multiple quantities of each upgrade license in one transaction (for example, you can order 10 each of the -25U, -50U, -100U, and -250 upgrade licenses), for which you receive one PAK with one license. You can continue to register the PAK for multiple controllers until it is exhausted.

For more information about the base license SKUs and capacity adder licenses, see the respective controller’s data sheet.

Obtaining and Registering a PAK Certificate

Step 1
Order the PAK certificate for an upgrade license through your Cisco channel partner or your Cisco sales representative, or order it online at this URL:
http://www.cisco.com/go/ordering

Step 2
If you are ordering online, begin by choosing the primary upgrade SKU L-LIC-CT5508-UPG or LIC CT5508-UPG. Then, choose any number of the following options to upgrade one or more controllers under one PAK. After you receive the certificate, use one of the following methods to register the PAK:

• Cisco License Manager (CLM)—This method automates the process of obtaining licenses and deploying them on Cisco devices. For deployments with more than five controllers, we recommend using CLM to register PAKs and install licenses. You can also use CLM to rehost or RMA a license.

  Note You cannot use CLM to change the licensed feature set or activate an ap-count evaluation license. To perform these operations, you must follow the instructions in the Activating an AP-Count Evaluation License section. Because you can use CLM to perform all other license operations, you can disregard the remaining licensing information in this chapter except these two sections and the Configuring the License Agent section if you want your controller to use HTTP to communicate with CLM.

  Note You can download the CLM software and access user documentation at this URL: http://www.cisco.com/go/clm

• Licensing portal—This alternative method enables you to manually obtain and install licenses on your controller. If you want to use the licensing portal to register the PAK, follow the instructions in Step 3.

Step 3
Use the licensing portal to register the PAK as follows:

a) Go to http://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet

b) On the main Product License Registration page, enter the PAK mailed with the certificate in the Product Authorization Key (PAK) text box and click Submit.

  c) On the Validate Features page, enter the number of licenses that you want to register in the Qty text box and click Update.

  d) To determine the controller’s product ID and serial number, choose Controller > Inventory on the controller GUI or enter the show license udi command on the controller CLI.
Information similar to the following appears on the controller CLI:

<table>
<thead>
<tr>
<th>Device#</th>
<th>PID</th>
<th>SN</th>
<th>UDI</th>
</tr>
</thead>
<tbody>
<tr>
<td>*0</td>
<td>AIR-CT5508-K9</td>
<td>CW1308L030</td>
<td>AIR-CT5508-K9:FCW1308L030</td>
</tr>
</tbody>
</table>

e) On the Designate Licensee page, enter the product ID and serial number of the controller on which you plan to install the license, read and accept the conditions of the end-user license agreement (EULA), complete the rest of the text boxes on this page, and click **Submit**.

f) On the Finish and Submit page, verify that all information is correct and click **Submit**.

g) When a message appears indicating that the registration is complete, click **Download License**. The license is e-mailed within 1 hour to the address that you specified.

h) When the e-mail arrives, follow the instructions provided.

i) Copy the license file to your TFTP server.

---

## Installing a License

### Installing a License (GUI)

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose Management &gt; Software Activation &gt; Commands to open the License Commands page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>From the Action drop-down list, choose <strong>Install License</strong>. The Install License from a File section appears.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the File Name to Install text box, enter the path to the license (*.lic) on the TFTP server.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click <strong>Install License</strong>. A message appears to show whether the license was installed successfully. If the installation fails, the message provides the reason for the failure, such as the license is an existing license, the path was not found, the license does not belong to this device, you do not have correct permissions for the license, and so on.</td>
</tr>
<tr>
<td>Step 5</td>
<td>If the end-user license agreement (EULA) acceptance dialog box appears, read the agreement and click <strong>Accept</strong> to accept the terms of the agreement.</td>
</tr>
</tbody>
</table>

**Note** Typically, you are prompted to accept the EULA for evaluation, extension, and rehost licenses. The EULA is also required for permanent licenses, but it is accepted during license generation.

<table>
<thead>
<tr>
<th>Step 6</th>
<th>Save a backup copy of all installed licenses as follows:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>From the Action drop-down list, choose <strong>Save License</strong>.</td>
</tr>
<tr>
<td>b)</td>
<td>In the File Name to Save text box, enter the path on the TFTP server where you want the licenses to be saved.</td>
</tr>
</tbody>
</table>

**Note** You cannot save evaluation licenses.

c) Click **Save Licenses**.

| Step 7 | Reboot the controller. |

**Note** We recommend that you reset the system to ensure that the newly installed license file is saved in the WLC.
Installing a License (CLI)

**Step 1**  
Install a license on the controller by entering this command:  
\[ \text{license install url} \]  
where \( url \) is tftp://server_ip/path/filename.

**Note**  
To remove a license from the controller, enter the \texttt{license clear license_name} command. For example, you might want to delete an expired evaluation license or any unused license. You cannot delete unexpired evaluation licenses, the permanent base image license, or licenses that are in use by the controller.

**Step 2**  
If you are prompted to accept the end-user license agreement (EULA), read and accept the terms of the agreement.

**Note**  
Typically, you are prompted to accept the EULA for evaluation, extension, and rehost licenses. The EULA is also required for permanent licenses, but it is accepted during license generation.

**Step 3**  
Add comments to a license or delete comments from a license by entering this command:  
\[ \text{license comment \{add | delete\} license_name comment_string} \]

**Step 4**  
Save a backup copy of all installed licenses by entering this command:  
\[ \text{license save url} \]  
where \( url \) is tftp://server_ip/path/filename.

**Step 5**  
Reboot the controller by entering this command:  
\[ \text{reset system} \]  

**Note**  
We recommend that you reset the system to ensure that the newly installed license file is saved in the WLC.

Viewing Licenses

Viewing Licenses (GUI)

**Step 1**  
Choose **Management > Software Activation > Licenses** to open the Licenses page.  
This page lists all of the licenses installed on the controller. For each license, it shows the license type, expiration, count (the maximum number of access points allowed for this license), priority (low, medium, or high), and status (in use, not in use, inactive, or EULA not accepted).

**Note**  
Controller platforms do not support the status of “grace period” or “extension” as a license type. The license status will always show "evaluation" even if a grace period or an extension evaluation license is installed.

**Note**  
If you ever want to remove a license from the controller, hover your cursor over the blue drop-down arrow for the license and click **Remove**. For example, you might want to delete an expired evaluation license or any unused license. You cannot delete unexpired evaluation licenses, the permanent base image license, or licenses that are in use by the controller.

**Step 2**  
Click the link for the desired license to view more details for a particular license. The License Detail page appears.
This page shows the following additional information for the license:

- The license type (permanent, evaluation, or extension)
- The license version
- The status of the license (in use, not in use, inactive, or EULA not accepted)
- The length of time before the license expires

**Note**  Permanent licenses never expire.

- Whether the license is a built-in license
- The maximum number of access points allowed for this license
- The number of access points currently using this license

**Step 3**  If you want to enter a comment for this license, type it in the Comment text box and click **Apply**.

**Step 4**  Click **Save Configuration** to save your changes.

---

### Viewing Licenses (CLI)

**Before You Begin**

- See the license level, license type, and number of access points licensed on the controller by entering this command:

  ```
  show sysinfo
  ```

  Information similar to the following appears:

```
Manufacturer's Name.............................. Cisco Systems Inc.
Product Name.................................... Cisco Controller
Product Version.................................. 7.0
RTOS Version.................................... 7.0
Bootloader Version.............................. 5.2
Emergency Image Version........................ N/A
Build Type.......................... DATA + WPS
System Name..................................... Cisco 69
System Location.......................... na
System Contact.......................... abc@cisco.com
System ObjectID............................. 1.3.6.1.4.1.14179.1.1.4.3
IP Address.................................... 10.10.10.10
System Up Time............................ 3 days 1 hrs 12 mins 42 secs
System Timezone Location.....................
CurrentBoot License Level......................base
CurrentBoot License Type.......................Permanent
NextBoot License Level.........................base
NextBoot License Type........................Permanent
Operating Environment........................Commercial (0 to 40 C)
Internal Temp Alarm Limits.................... 0 to 65 C
Internal Temperature..........................+40 C
State of 802.11b Network.....................Enabled
State of 802.11a Network.....................Enabled
Number of WLANs...............................4
Number of Active Clients......................0
Burned-in MAC Address.........................00:1A:6D:DD:1E:40
Crypto Accelerator 1............................Absent
```
Crypto Accelerator 2............................. Absent
Power Supply 1................................... Absent
Power Supply 2................................... Present, OK
Maximum number of APs supported.................. 12

Note The Operating Environment and Internal Temp Alarm Limits data are not displayed for Cisco Flex 7500 Series Controllers.

• See a brief summary of all active licenses installed on the controller by entering this command:

  show license summary

  Information similar to the following appears:

  Index 1 Feature: wplus
  Period left: 0 minute 0 second
  Index 2 Feature: wplus-ap-count
  Period left: 0 minute 0 second
  Index 3 Feature: base
  Period left: Life time
  License Type: Permanent
  License State: Active, In Use
  License Count: Non-Counted
  License Priority: Medium
  Index 4 Feature: base-ap-count
  Period left: 6 weeks, 4 days
  License Type: Evaluation
  License State: Active, In Use
  License Count: 250/250/0
  License Priority: High

• See all of the licenses installed on the controller by entering this command:

  show license all

  Information similar to the following appears:

  License Store: Primary License Storage
  StoreIndex: 1 Feature: base Version: 1.0
  License Type: Permanent
  License State: Active, Not in Use
  License Count: Non-Counted
  License Priority: Medium

  StoreIndex: 3 Feature: base-ap-count Version: 1.0
  License Type: Evaluation
  License State: Active, In Use
  Evaluation total period: 8 weeks 4 days
  Evaluation period left: 8 weeks 3 days
  License Count: 250/0/0
  License Priority: High

• See the details for a particular license by entering this command:

  show license detail license_name

  Information similar to the following appears:

  Index: 1 Feature: base-ap-count Version: 1.0
  License Type: Permanent
  License State: Active, Not in Use
  License Count: 12/0/0
  License Priority: Medium
Store Index: 0
Store Name: Primary License Storage

Index: 2  Feature: base-ap-count  Version: 1.0
License Type: Evaluation
License State: Inactive
   Evaluation total period: 8 weeks 4 days
   Evaluation period left: 8 weeks 4 days
License Count: 250/0/0
License Priority: Low

Store Index: 3
Store Name: Evaluation License Storage

• See all expiring, evaluation, permanent, or in-use licenses by entering this command:

```
show license {expiring | evaluation | permanent | in-use}
```

Information similar to the following appears for the `show license in-use` command:

```
StoreIndex: 2  Feature: base-ap-count  Version: 1.0
License Type: Permanent
License State: Active, In Use
License Count: 12/12/0
License Priority: Medium
```

```
StoreIndex: 3  Feature: base  Version: 1.0
License Type: Permanent
License State: Active, In Use
License Count: Non-Counted License Priority: Medium
```

Note  Controller platforms do not support the status of "grace period" or "extension" as a license type. The license status will always show "evaluation" even if a grace period or an extension evaluation license is installed.

• See the maximum number of access points allowed for this license on the controller, the number of access points currently joined to the controller, and the number of access points that can still join the controller by entering this command:

```
show license capacity
```

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Licensed Feature</th>
<th>Max Count</th>
<th>Current Count</th>
<th>Remaining Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Count</td>
<td>250</td>
<td>4</td>
<td>246</td>
</tr>
</tbody>
</table>

• See statistics for all licenses on the controller by entering this command:

```
show license statistics
```

• See a summary of license-enabled features by entering this command:

```
show license feature
```

## Troubleshooting Licensing Issues

• Configure debugging of license agent by entering this command:

```
debug license agent {errors | all} {enable | disable}
```

• Configure debugging of licensing core events and core errors by entering this command:
debug license core {all | errors | events} {enable | disable}

- Configure debugging of licensing errors by entering this command:
  debug license errors {enable | disable}

- Configure debugging of licensing events by entering this command:
  debug license events {enable | disable}

Activating an AP-Count Evaluation License

Information About Activating an AP-Count Evaluation License

If you are considering upgrading to a license with a higher access point count, you can try an evaluation license before upgrading to a permanent version of the license. For example, if you are using a permanent license with a 50-access-point count and want to try an evaluation license with a 100-access-point count, you can try out the evaluation license for 60 days.

AP-count evaluation licenses are set to low priority by default so that the controller uses the ap-count permanent license. If you want to try an evaluation license with an increased access point count, you must change its priority to high. If you no longer want to have this higher capacity, you can lower the priority of the ap-count evaluation license, which forces the controller to use the permanent license.

Note

To prevent disruptions in operation, the controller does not switch licenses when an evaluation license expires. You must reboot the controller in order to return to a permanent license. Following a reboot, the controller defaults to the same feature set level as the expired evaluation license. If no permanent license at the same feature set level is installed, the controller uses a permanent license at another level or an unexpired evaluation license.

Activating an AP-Count Evaluation License (GUI)

Step 1
Choose Management > Software Activation > Licenses to open the Licenses page. The Status column shows which licenses are currently in use, and the Priority column shows the current priority of each license.

Step 2
Activate an ap-count evaluation license as follows:

a) Click the link for the ap-count evaluation license that you want to activate. The License Detail page appears.

b) Choose High from the Priority drop-down list and click Set Priority.

   Note: You can set the priority only for ap-count evaluation licenses. AP-count permanent licenses always have a medium priority, which cannot be configured.

c) Click OK when prompted to confirm your decision about changing the priority of the license.

d) When the EULA appears, read the terms of the agreement and then click Accept.

e) When prompted to reboot the controller, click OK.

f) Reboot the controller in order for the priority change to take effect.
Step 3

If you decide to stop using the ap-count evaluation license and want to revert to using an ap-count permanent license, follow these steps:

a) On the Licenses page, click the link for the ap-count evaluation license that is in use.

b) Choose Low from the Priority drop-down list and click Set Priority.

   Note: You can set the priority only for ap-count evaluation licenses. AP-count permanent licenses always have a medium priority, which cannot be configured.

c) Click OK when prompted to confirm your decision about changing the priority of the license.

d) When the EULA appears, read the terms of the agreement and then click Accept.

e) When prompted to reboot the controller, click OK.

f) Reboot the controller in order for the priority change to take effect.

g) Click Licenses to open the Licenses page and verify that the ap-count evaluation license now has a low priority and is not in use. Instead, the ap-count permanent license should be in use.

Activating an AP-Count Evaluation License (CLI)

Step 1

See the current status of all the licenses on your controller by entering this command:

```
show license all
```

Information similar to the following appears:

```
License Store: Primary License Storage
StoreIndex: 0 Feature: base-ap-count Version: 1.0
   License Type: Permanent
   License State: Active, In Use
   License Count: 12/0/0
   License Priority: Medium

StoreIndex: 1 Feature: base Version: 1.0
   License Type: Permanent
   License State: Active, In Use
   License Count: Non-Counted
   License Priority: Medium

StoreIndex: 2 Feature: base-ap-count Version: 1.0
   License Type: Evaluation
   License State: Inactive
   Evaluation total period: 8 weeks 4 days
   Evaluation period left: 8 weeks 4 days
   License Count: Non-Counted
   License Priority: Low

StoreIndex: 3 Feature: base-ap-count Version: 1.0
   License Type: Evaluation
   License State: Inactive
   Evaluation total period: 8 weeks 4 days
   Evaluation period left: 8 weeks 4 days
```
License Count: 250/0/0  
License Priority: Low

The License State text box shows the licenses that are in use, and the License Priority text box shows the current priority of each license.

**Note**  In the 7.2.110.0 release, the command output displays the full in-use count for active base-ap-count license even though there are no APs connected.

**Step 2**  Activate an ap-count evaluation license as follows:

a) Raise the priority of the base-ap-count evaluation license by entering this command:

   `license modify priority license_name high`

   **Note**  You can set the priority only for ap-count evaluation licenses. AP-count permanent licenses always have a medium priority, which cannot be configured.

b) Reboot the controller in order for the priority change to take effect by entering this command:

   `reset system`

c) Verify that the ap-count evaluation license now has a high priority and is in use by entering this command:

   `show license all`

   You can use the evaluation license until it expires.

**Step 3**  If you decide to stop using the ap-count evaluation license and want to revert to using an ap-count permanent license, follow these steps:

a) Lower the priority of the ap-count evaluation license by entering this command:

   `license modify priority license_name low`

b) Reboot the controller in order for the priority change to take effect by entering this command:

   `reset system`

c) Verify that the ap-count evaluation license now has a low priority and is not in use by entering this command:

   `show license all`

   Instead, the ap-count permanent license should be in use.

---

**Configuring Right to Use Licensing**

**Information About Right to Use Licensing**

Right to Use (RTU) licensing is a model in which licenses are not tied to a unique device identifier (UDI), product ID, or serial number. Use RTU licensing to enable a desired AP license count on the controller after you accept the End User License Agreement (EULA). This allows you to add AP counts on a controller interacting with external tools.

RTU licensing is supported only on the following Cisco Wireless Controller platforms:

- Cisco 5520 Wireless Controller
- Cisco Flex 7510 Wireless Controller
In the RTU licensing model, the following types of licenses are available:

- Permanent or base licenses—These licenses are programmed into the controller hardware at the time of manufacturing. These licenses are base count licenses that cannot be deleted or transferred.

- Adder licenses—These licenses are wireless access point count licenses that you can activate by accepting the RTU EULA. The EULA states that you are obliged to purchase the specified access point count licenses at the time of activation. You must activate these licenses for the purchased access points count and accept the EULA.

You can remove an adder license from one controller and transfer the license to another controller in the same product family. For example, an adder license such as LIC-CT7500-100A can be transferred (partially or fully) from one Cisco Flex 7500 Series Controller to another Cisco Flex 7500 Series Controller.

Note Licenses embedded in the controller at the time of shipment is not transferrable.

- Evaluation licenses—These licenses are demo or trial mode licenses that are valid for 90 days. Fifteen days prior to the expiry of the 90-day period, you are notified about the requirement to buy the permanent license. These evaluation licenses are installed with the license image. You can activate the evaluation licenses anytime with a command. A EULA is prompted after you run the activation command on the controller CLI. The EULA states that you are obligated to pay for the specified license count within 90 days of usage. The countdown starts after you accept the EULA.

Whenever you add or delete an access point adder license on the controller, you are prompted with an RTU EULA. You can either accept or decline the RTU EULA for each add or delete operation.

For high-availability (HA) controllers when you enable HA, the controllers synchronize with the enabled license count of the primary controller and support high availability for up to the license count enabled on the primary controller.

You can view the RTU licenses through the controller GUI or CLI. You can also view these licenses across multiple wireless controllers through Cisco Prime Infrastructure.

With Release 8.1, the license management for Cisco Virtual Wireless Controller is changed from license-file based management to Right-to-Use-based management. The previous licenses are still valid, and when you upgrade to Release 8.1 from an earlier release, you are required to only accept an end-user license agreement again to the quantity installed before.
**Configuring Right to Use Licensing (GUI)**

**Step 1** Choose **Management > Software Activation > Licenses** to open the Licenses page.

**Step 2** In the Adder License area, choose to add or delete the number of APs that an AP license can support, enter a value, and click **Set Count**.

**Step 3** Click **Save Configuration**.

---

**Configuring Right to Use Licensing (CLI)**

- Add or delete the number of APs that an AP license can support by entering this command:

  ```
  license {add | delete} ap-count count
  ```

- Add or delete a license for a feature by entering this command:

  ```
  license {add | delete} feature license_name
  ```

- Activate or deactivate an evaluation AP count license by entering this command:

  ```
  license {activate | deactivate} ap-count eval
  ```

**Note** When you activate the license, you are prompted to accept or reject the End User License Agreement (EULA) for the given license. If you activate a license that supports fewer number of APs than the current number of APs connected to the controller, the activation command fails.

- Activate or deactivate a feature license by entering this command:

  ```
  license {activate | deactivate} feature license_name
  ```

- See the licensing information by entering this command:

  ```
  show license all
  ```

---

**Rehosting Licenses**

This section describes how to rehost licenses.

---

**Information About Rehosting Licenses**

Revoking a license from one controller and installing it on another is called **rehosting**. You might want to rehost a license in order to change the purpose of a controller. For example, if you want to move your OfficeExtend or indoor mesh access points to a different controller, you could transfer the adder license from one controller to another controller of the same model (intramodel transfer). This can be done in the case of
RMA or a network rearchitecture that requires you to transfer licenses from one appliance to another. It is not possible to rehost base licenses in normal scenarios of network rearchitecture. The only exception where the transfer of base licenses is allowed is for RMA when you get a replacement hardware when your existing appliance has a failure.

Evaluation licenses cannot be rehosted.

In order to rehost a license, you must generate credential information from the controller and use it to obtain a permission ticket to revoke the license from the Cisco licensing site. Next, you must obtain a rehost ticket and use it to obtain a license installation file for the controller on which you want to install the license.

---

**Note**

A revoked license cannot be reinstalled on the same controller.

---

**Note**

Starting in the release 7.3, the Right-to-Use licensing is supported on the Cisco Flex 7500 Series Controllers, thereby the rehosting behavior changes on these controllers. If you require to rehost licenses, you need to plan rehosting the installed adder licenses prior to an upgrade.

---

**Rehosting a License**

**Rehosting a License (GUI)**

**Step 1**
Choose **Management > Software Activation > Commands** to open the License Commands page.

**Step 2**
From the Action drop-down list, choose **Rehost**. The Revoke a License from the Device and Generate Rehost Ticket area appears.

**Step 3**
In the File Name to Save Credentials text box, enter the path on the TFTP server where you want the device credentials to be saved and click **Save Credentials**.

**Step 4**
To obtain a permission ticket to revoke the license, follow these steps:

1. a) Click **Cisco Licensing** ([https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet](https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet)).
2. b) On the Product License Registration page, click **Look Up a License** under Manage Licenses.
3. c) Enter the product ID and serial number for your controller.
   
   **Note** To find the controller’s product ID and serial number, choose **Controller > Inventory** on the controller GUI.

4. d) Open the device credential information file that you saved in Step 3 and copy and paste the contents of the file into the Device Credentials text box.

5. e) Enter the security code in the blank box and click **Continue**.

6. f) Choose the licenses that you want to revoke from this controller and click **Start License Transfer**.

7. g) On the Rehost Quantities page, enter the number of licenses that you want to revoke in the To Rehost text box and click **Continue**.

8. h) On the Designate Licensee page, enter the product ID and serial number of the controller for which you plan to revoke the license, read and accept the conditions of the End User License Agreement (EULA), complete the rest of the text boxes on this page, and click **Continue**.

9. i) On the Review and Submit page, verify that all information is correct and click **Submit**.
j) When a message appears indicating that the registration is complete, click Download Permission Ticket. The rehost permission ticket is e-mailed within 1 hour to the address that you specified.

k) After the e-mail arrives, copy the rehost permission ticket to your TFTP server.

**Step 5**
Use the rehost permission ticket to revoke the license from this controller and generate a rehost ticket as follows:

a) In the Enter Saved Permission Ticket File Name text box, enter the TFTP path and filename (*.lic) for the rehost permission ticket that you generated in **Step 4**.

b) In the Rehost Ticket File Name text box, enter the TFTP path and filename (*.lic) for the ticket that will be used to rehost this license on another controller.

c) Click Generate Rehost Ticket.

d) When the End User License Agreement (EULA) acceptance dialog box appears, read the agreement and click Accept to accept the terms of the agreement.

**Step 6**
Use the rehost ticket generated in **Step 5** to obtain a license installation file, which can then be installed on another controller as follows:

a) Click Cisco Licensing.

b) On the Product License Registration page, click Upload Rehost Ticket under Manage Licenses.

c) On the Upload Ticket page, enter the rehost ticket that you generated in **Step 5** in the Enter Rehost Ticket text box and click Continue.

d) On the Validate Features page, verify that the license information for your controller is correct, enter the rehost quantity, and click Continue.

e) On the Designate License page, enter the product ID and serial number of the controller on which you plan to use the license, read and accept the conditions of the End User License Agreement (EULA), complete the rest of the text boxes on this page, and click Continue.

f) On the Review and Submit page, verify that all information is correct and click Submit.

g) When a message appears indicating that the registration is complete, click Download License. The rehost license key is e-mailed within 1 hour to the address that you specified.

h) After the e-mail arrives, copy the rehost license key to your TFTP server.

i) Follow the instructions in the Installing a License section to install this on another controller.

**Step 7**
After revoking the license on original controller, correspondent evaluation licence appear with High pririty. Lower the priority of the evaluation license so that the permanent license is in "In Use" status.

---

**Rehosting a License (CLI)**

**Step 1**
Save device credential information to a file by entering this command:

```
license save credential url
```

where *url* is \ftp://server_ip/path/filename.

**Step 2**
Obtain a permission ticket to revoke the license as follows:

a) Go to https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet. The Product License Registration page appears.

b) Under Manage Licenses, click Look Up a License.

c) Enter the product ID and serial number for your controller.
To find the controller's product ID and serial number, enter the `show license udi` command on the controller CLI.

d) Open the device credential information file that you saved in Step 1 and copy and paste the contents of the file into the Device Credentials text box.
e) Enter the security code in the blank box and click Continue.
f) Choose the licenses that you want to revoke from this controller and click Start License Transfer.
g) On the Rehost Quantities page, enter the number of licenses that you want to revoke in the To Rehost text box and click Continue.
h) On the Designate Licensee page, enter the product ID and serial number of the controller for which you plan to revoke the license, read and accept the conditions of the End-User License Agreement (EULA), complete the rest of the text boxes on this page, and click Continue.
i) On the Review and Submit page, verify that all information is correct and click Submit.
j) When a message appears indicating that the registration is complete, click Download Permission Ticket. The rehost permission ticket is e-mailed within 1 hour to the address that you specified.
k) After the e-mail arrives, copy the rehost permission ticket to your TFTP server.

**Step 3**

Use the rehost permission ticket to revoke the license from this controller and generate a rehost ticket as follows:

a) Revoke the license from the controller by entering this command:

```
license revoke permission_ticket_url
```

where `permission_ticket_url` is `tftp://server_ip/path/filename`.

b) Generate the rehost ticket by entering this command:

```
license revoke rehost rehost_ticket_url
```

where `rehost_ticket_url` is `tftp://server_ip/path/filename`.

c) If prompted, read and accept the terms of the End-User License Agreement (EULA).

**Step 4**

Use the rehost ticket generated in Step 3 to obtain a license installation file, which can then be installed on another controller as follows:

a) Go to [https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet](https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet).
b) On the Product License Registration page, click Upload Rehost Ticket under Manage Licenses.
c) On the Upload Ticket page, enter the rehost ticket that you generated in Step 3 in the Enter Rehost Ticket text box and click Continue.

d) On the Validate Features page, verify that the license information for your controller is correct, enter the rehost quantity, and click Continue.

e) On the Designate Licensee page, enter the product ID and serial number of the controller on which you plan to use the license, read and accept the conditions of the End-User License Agreement (EULA), complete the rest of the text boxes on this page, and click Continue.

f) On the Review and Submit page, verify that all information is correct and click Submit.

g) When a message appears indicating that the registration is complete, click Download License. The rehost license key is e-mailed within 1 hour to the address that you specified.

h) After the e-mail arrives, copy the rehost license key to your TFTP server.
i) Follow the instructions in the Installing a License (GUI), on page 91 section to install this license on another controller.

**Step 5**

After revoking the license on original controller, correspondent evaluation licence appear with High pririty. Lower the priority of the evaluation license so that the parmanent license is in "In Use" status.
Transferring Licenses to a Replacement Controller after an RMA

Information About Transferring Licenses to a Replacement Controller after an RMA

If you return a Cisco 5500 Series Controller to Cisco as part of the Return Material Authorization (RMA) process, you must transfer that controller’s licenses within 60 days to a replacement controller that you receive from Cisco.

Replacement controllers come preinstalled with the following licenses: permanent base and evaluation base, base-ap-count. No other permanent licenses are installed. The SKU for replacement controllers is AIR-CT5508-CA-K9.

Because licenses are registered to the serial number of a controller, you can use the licensing portal on Cisco.com to request that the license from your returned controller be revoked and authorized for use on the replacement controller. After your request is approved, you can install the old license on the replacement controller. Any additional ap-count licenses if installed in the returned controller has to be rehosted on the replacement controller. Before you begin, you need the product ID and serial number of both the returned controller and the replacement controller. This information is included in your purchase records.

Note

The evaluation licenses on the replacement controller are designed for temporary use and expire after 60 days. To prevent disruptions in operation, the controller does not switch licenses when an evaluation license expires. You must reboot the controller in order to return to a permanent license. If the evaluation licenses expire before you transfer the permanent licenses from your defective controller to your replacement controller, the replacement controller remains up and running using the permanent base license, but access points are no longer able to join the controller.

Transferring a License to a Replacement Controller after an RMA

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Browse to <a href="https://tools.cisco.com/SWIFT/LicensingUI/Quickstart">https://tools.cisco.com/SWIFT/LicensingUI/Quickstart</a>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Log on to the site.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Manage tab, click Devices.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Choose Actions &gt; Rehost/Transfer.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Follow the on-screen instructions to generate the license file. The license is provided online or in an e-mail.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Copy the license file to the TFTP server.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Install the license by choosing Management &gt; Software Activation &gt; Commands &gt; Action &gt; Install License.</td>
</tr>
</tbody>
</table>
Configuring the License Agent

Information About Configuring the License Agent

If your network contains various Cisco-licensed devices, you might want to consider using the Cisco License Manager (CLM) to manage all of the licenses using a single application. CLM is a secure client/server application that manages Cisco software licenses network wide.

The license agent is an interface module that runs on the controller and mediates between CLM and the controller’s licensing infrastructure. CLM can communicate with the controller using various channels, such as HTTP, Telnet, and so on. If you want to use HTTP as the communication method, you must enable the license agent on the controller.

The license agent receives requests from CLM and translates them into license commands. It also sends notifications to CLM. It uses XML messages over HTTP or HTTPS to receive the requests and send the notifications. For example, CLM sends a license install command, and the agent notifies CLM after the license expires.

Note
You can download the CLM software and access user documentation at http://www.cisco.com/go/clm.

Configuring the License Agent (GUI)

Step 1  Choose Management > Software Activation > License Agent to open the License Agent Configuration page.

Step 2  Select the Enable Default Authentication check box to enable the license agent, or leave it unselected to disable this feature. The default value is unselected.

Step 3  In the Maximum Number of Sessions text box, enter the maximum number of sessions for the license agent. The valid range is 1 to 25 sessions (inclusive).

Step 4  Configure the license agent to listen for requests from the CLM as follows:

a)  Select the Enable Listener check box to enable the license agent to receive license requests from the CLM, or unselect this check box to disable this feature. The default value is unselected.

b)  In the Listener Message Processing URL text box, enter the URL where the license agent receives license requests (for example, http://209.165.201.30/licenseAgent/custom). The Protocol parameter indicates whether the URL requires HTTP or HTTPS.

   Note  You can specify the protocol to use on the HTTP Configuration page.

c)  Select the Enable Authentication for Listener check box to enable authentication for the license agent when it is receiving license requests, or unselect this check box to disable this feature. The default value is unselected.

d)  In the Max HTTP Message Size text box, enter the maximum size for license requests. The valid range is 0 to 9999 bytes, and the default value is 0.

Step 5  Configure the license agent to send license notifications to the CLM as follows:
a) Select the **Enable Notification** check box to enable the license agent to send license notifications to the CLM, or unselect this check box to disable this feature. The default value is unselected.

b) In the URL to Send the Notifications text box, enter the URL where the license agent sends the notifications (for example, http://www.cisco.com/license/notify).

c) In the User Name text box, enter the username required in order to view the notification messages at this URL.

d) In the Password and Confirm Password text boxes, enter the password required in order to view the notification messages at this URL.

**Step 6**
Click **Apply** to commit your changes.

**Step 7**
Click **Save Configuration** to save your changes.

---

## Configuring the License Agent (CLI)

**Step 1**
Enable the license agent by entering one of these commands:

- `config license agent default authenticate`—Enables the license agent default listener with authentication.
- `config license agent default authenticate none`—Enables the license agent default listener without authentication.

**Note**
To disable the license agent default listener, enter the `config license agent default disable` command. The default value is disabled.

**Step 2**
Specify the maximum number of sessions for the license agent by entering this command:

```
config license agent max-sessions sessions
```

The valid range for the `sessions` parameter is 1 to 25 (inclusive), and the default value is 9.

**Step 3**
Enable the license agent to receive license requests from the CLM and to specify the URL where the license agent receives the requests by entering this command:

```
config license agent listener http {plaintext | encrypt} url authenticate [none] [max-message size] [acl acl]
```

The valid range for the `size` parameter is 0 to 65535 bytes, and the default value is 0.

**Note**
To prevent the license agent from receiving license requests from the CLM, enter the `config license agent listener http disable` command. The default value is disabled.

**Step 4**
Configure the license agent to send license notifications to the CLM and to specify the URL where the license agent sends the notifications by entering this command:

```
config license agent notify url username password
```

**Note**
To prevent the license agent from sending license notifications to the CLM, enter the `config license agent notify disable` command. The default value is disabled.

**Step 5**
Enter the `save config` command to save your changes.

**Step 6**
See statistics for the license agent’s counters or sessions by entering this command:

```
show license agent {counters | sessions}
```
Information similar to the following appears for the **show license agent counters** command:

License Agent Counters  
Request Messages Received: 10: Messages with Errors: 1  
Request Operations Received: 9: Operations with Errors: 0  
Notification Messages Sent: 12: Transmission Errors: 0: Soap Errors: 0

Information similar to the following appears for the **show license agent sessions** command:

License Agent Sessions: 1 open, maximum is 9

**Note**  
To clear the license agent's counter or session statistics, enter the **clear license agent {counters | sessions}** command.

---

## Configuring 802.11 Bands

### Information About Configuring 802.11 Bands

You can configure the 802.11b/g/n (2.4-GHz) and 802.11a/n (5-GHz) bands for the controller to comply with the regulatory requirements in your country. By default, both 802.11b/g/n and 802.11a/n are enabled.

When a controller is configured to allow only 802.11g traffic, 802.11b client devices are able to successfully connect to an access point but cannot pass traffic. When you configure the controller for 802.11g traffic only, you must mark 11g rates as mandatory.

### Configuring the 802.11 Bands (GUI)

**Step 1**  
Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the Global Parameters page.

**Step 2**  
Select the **802.11a** (or **802.11b/g**) **Network Status** check box to enable the 802.11a or 802.11b/g band. To disable the band, unselect the check box. The default value is enabled. You can enable both the 802.11a and 802.11b/g bands.

**Step 3**  
If you enabled the 802.11b/g band in **Step 2**, select the **802.11g Support** check box if you want to enable 802.11g network support. The default value is enabled. If you disable this feature, the 802.11b band is enabled without 802.11g support.

**Step 4**  
Specify the period at which the SSID is broadcast by the access point by entering a value between 20 and 1000 milliseconds (inclusive) in the Beacon Period text box. The default value is 100 milliseconds.

**Note**  
The beacon period in controllers is listed in terms of milliseconds. The beacon period can also be measured in time units, where one time unit equals 1024 microseconds or 102.4 milliseconds. If a beacon interval is listed as 100 milliseconds in a controller, it is only a rounded off value for 102.4 milliseconds. Due to hardware limitation in certain radios, even though the beacon interval is, say 100 time units, it is adjusted to 102 time units, which roughly equals 104.448 milliseconds. When the beacon period is to be represented in terms of time units, the value is adjusted to the nearest multiple of 17.
Step 5 Specify the size at which packets are fragmented by entering a value between 256 and 2346 bytes (inclusive) in the Fragmentation Threshold text box. Enter a low number for areas where communication is poor or where there is a great deal of radio interference.

Step 6 Make access points advertise their channel and transmit power level in beacons and probe responses for CCX clients. Select the DTPC Support check box. Otherwise, unselect this check box. The default value is enabled. Client devices using dynamic transmit power control (DTPC) receive the channel and power level information from the access points and adjust their settings automatically. For example, a client device used primarily in Japan could rely on DTPC to adjust its channel and power settings automatically when it travels to Italy and joins a network there.

Note On access points that run Cisco IOS software, this feature is called world mode.

Note DTPC and 801.11h power constraint cannot be enabled simultaneously.

Step 7 Specify the maximum allowed clients by entering a value between 1 to 200 in the Maximum Allowed Client text box. The default value is 200.

Step 8 Use the Data Rates options to specify the rates at which data can be transmitted between the access point and the client. These data rates are available:

- 802.11a—6, 9, 12, 18, 24, 36, 48, and 54 Mbps
- 802.11b/g—1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, or 54 Mbps

For each data rate, choose one of these options:

- Mandatory—Clients must support this data rate in order to associate to an access point on the controller.
- Supported—Any associated clients that support this data rate may communicate with the access point using that rate. However, the clients are not required to be able to use this rate in order to associate.
- Disabled—The clients specify the data rates used for communication.

Step 9 Click Apply.

Step 10 Click Save Configuration.

Configuring the 802.11 Bands (CLI)

Step 1 Disable the 802.11a band by entering this command:

```
config 802.11a disable network
```

Note The 802.11a band must be disabled before you can configure the 802.11a network parameters in this section.

Step 2 Disable the 802.11b/g band by entering this command:

```
config 802.11b disable network
```

Note The 802.11b band must be disabled before you can configure the 802.11b network parameters in this section.

Step 3 Specify the rate at which the SSID is broadcast by the access point by entering this command:
**config** \{802.11a | 802.11b\} **beaconperiod** *time_unit*

where *time_unit* is the beacon interval in time units (TUs). One TU is 1024 microseconds. You can configure the access point to send a beacon every 20 to 1000 milliseconds.

**Step 4**

Specify the size at which packets are fragmented by entering this command:

```
config \{802.11a | 802.11b\} fragmentation **threshold**
```

where *threshold* is a value between 256 and 2346 bytes (inclusive). Specify a low number for areas where communication is poor or where there is a great deal of radio interference.

**Step 5**

Make access points advertise their channel and transmit power level in beacons and probe responses by entering this command:

```
config \{802.11a | 802.11b\} dtpc \{enable | disable\}
```

The default value is enabled. Client devices using dynamic transmit power control (DTPC) receive the channel and power level information from the access points and adjust their settings automatically. For example, a client device used primarily in Japan could rely on DTPC to adjust its channel and power settings automatically when it travels to Italy and joins a network there.

**Note**  On access points that run Cisco IOS software, this feature is called *world mode*.

**Step 6**

Specify the maximum allowed clients that can be configured by entering this command:

```
config \{802.11a | 802.11b\} max-clients *max_allow_clients*
```

The valid range is between 1 to 200.

**Step 7**

Specify the rates at which data can be transmitted between the controller and the client by entering this command:

```
config \{802.11a | 802.11b\} rate \{disabled | mandatory | supported\} *rate*
```

where

- **disabled**—Clients specify the data rates used for communication.
- **mandatory**—Clients support this data rate in order to associate to an access point on the controller.
- **supported**—Any associated clients that support this data rate may communicate with the access point using that rate. However, the clients are not required to be able to use this rate in order to associate.

- **rate**—The rate at which data is transmitted:
  - 6, 9, 12, 18, 24, 36, 48, and 54 Mbps (802.11a)
  - 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, or 54 Mbps (802.11b/g)

**Step 8**

Enable the 802.11a band by entering this command:

```
config 802.11a enable network
```

The default value is enabled.

**Step 9**

Enable the 802.11b band by entering this command:

```
config 802.11b enable network
```

The default value is enabled.

**Step 10**

Enable or disable 802.11g network support by entering this command:

```
config 802.11b 11gSupport \{enable | disable\}
```
The default value is enabled. You can use this command only if the 802.11b band is enabled. If you disable this feature, the 802.11b band is enabled without 802.11g support.

**Step 11**

Enter the `save config` command to save your changes.

**Step 12**

View the configuration settings for the 802.11a or 802.11b/g band by entering this command:

```
show {802.11a | 802.11b}
```

Information similar to the following appears:

```
802.11a Network............................... Enabled
11nSupport...................................... Enabled
  802.11a Low Band........................... Enabled
  802.11a Mid Band........................... Enabled
  802.11a High Band.......................... Enabled
802.11a Operational Rates
  802.11a 6M Rate.............................. Mandatory
  802.11a 9M Rate.............................. Supported
  802.11a 12M Rate............................ Mandatory
  802.11a 18M Rate............................. Supported
  802.11a 24M Rate............................. Mandatory
  802.11a 36M Rate............................. Supported
  802.11a 48M Rate............................. Supported
  802.11a 54M Rate............................. Supported
...
Beacon Interval................................. 100
...
Default Channel............................... 36
Default Tx Power Level........................ 1
DTPC Status.................................... Enabled
Fragmentation Threshold....................... 2346
Maximum Number of Clients per AP............. 200
```

## Configuring 802.11n Parameters

### Information About Configuring the 802.11n Parameters

This section provides instructions for managing 802.11n devices such as the Cisco Aironet 1140 and 3600 Series Access Points on your network. The 802.11n devices support the 2.4- and 5-GHz bands and offer high-throughput data rates.

The 802.11n high-throughput rates are available on all 802.11n access points for WLANs using WMM with no Layer 2 encryption or with WPA2/AES encryption enabled.
Note

Some Cisco 802.11n APs may intermittently emit incorrect beacon frames, which can trigger false wIPS alarms. We recommend that you ignore these alarms. The issue is observed in the following Cisco 802.11n APs: 1140, 1250, 2600, 3500, and 3600.

Configuring the 802.11n Parameters (GUI)

Step 1
Choose Wireless > 802.11a/n or 802.11b/g/n > High Throughput to open the (5 GHz or 2.4 GHz) High Throughput page.

Step 2
Select the 11n Mode check box to enable 802.11n support on the network. The default value is enabled.

Step 3
Select the check boxes of the desired rates to specify the modulation and coding scheme (MCS) rates at which data can be transmitted between the access point and the client. These data rates, which are calculated for a 20-MHz channel width using a short guard interval, are available:

- 0 (7 Mbps)
- 1 (14 Mbps)
- 2 (21 Mbps)
- 3 (29 Mbps)
- 4 (43 Mbps)
- 5 (58 Mbps)
- 6 (65 Mbps)
- 7 (72 Mbps)
- 8 (14 Mbps)
- 9 (29 Mbps)
- 10 (43 Mbps)
- 11 (58 Mbps)
- 12 (87 Mbps)
- 13 (116 Mbps)
- 14 (130 Mbps)
- 15 (144 Mbps)

Any associated clients that support the selected rates may communicate with the access point using those rates. However, the clients are not required to be able to use this rate in order to associate. The MCS settings determine the number of spatial streams, the modulation, the coding rate, and the data rate values that are used.

Step 4
Click Apply.

Step 5
Use the 802.11n data rates that you configured by enabling WMM on the WLAN as follows:

a) Choose WLANs to open the WLANs page.
b) Click the ID number of the WLAN for which you want to configure WMM mode.
c) When the WLANs > Edit page appears, choose the QoS tab to open the WLANs > Edit (Qos) page.
d) From the WMM Policy drop-down list, choose Required or Allowed to require or allow client devices to use WMM. Devices that do not support WMM cannot join the WLAN. If you choose Allowed, devices that cannot support WMM can join the WLAN but will not benefit from the 802.11n rates.
e) Click Apply.

**Step 6**  
Click Save Configuration.

**Note**  
To determine if an access point supports 802.11n, look at the 11n Supported text box on either the 802.11a/n (or 802.11b/g/n) Cisco APs > Configure page or the 802.11a/n (or 802.11b/g/n) AP Interfaces > Details page.

---

## Configuring the 802.11n Parameters (CLI)

- Enable 802.11n support on the network by entering this command:
  ```
  config {802.11a | 802.11b} 11nsupport {enable | disable}
  ```

- Specify the modulation and coding scheme (MCS) rates at which data can be transmitted between the access point and the client by entering this command:
  ```
  config {802.11a | 802.11b} 11nsupport mcs tx {0-15} {enable | disable}
  ```

- Use the 802.11n data rates that you configured by enabling WMM on the WLAN as follows:
  ```
  config wlan wmm {allow | disable | require} wlan_id
  ```

  The `require` parameter requires client devices to use WMM. Devices that do not support WMM cannot join the WLAN. If set to `allow`, devices that cannot support WMM can join the WLAN but do not benefit from 802.11n rates.

- Specify the aggregation method used for 802.11n packets as follows:
  a) Disable the network by entering this command:
  ```
  config {802.11a | 802.11b} disable network
  ```

  b) Specify the aggregation method entering this command:
  ```
  config {802.11a | 802.11b} 11nsupport {a-mpdu | a-msdu} tx priority {0-7 | all} {enable | disable}
  ```

  Aggregation is the process of grouping packet data frames together rather than transmitting them separately. Two aggregation methods are available: Aggregated MAC Protocol Data Unit (A-MPDU) and Aggregated MAC Service Data Unit (A-MSDU). A-MSDU is performed in hardware and therefore is the default method.

  You can specify the aggregation method for various types of traffic from the access point to the clients. This table defines the priority levels (0-7) assigned per traffic type.

**Table 4: Traffic Type Priority Levels**

<table>
<thead>
<tr>
<th>User Priority</th>
<th>Traffic Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Best effort</td>
</tr>
<tr>
<td>User Priority</td>
<td>Traffic Type</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>Background</td>
</tr>
<tr>
<td>2</td>
<td>Spare</td>
</tr>
<tr>
<td>3</td>
<td>Excellent effort</td>
</tr>
<tr>
<td>4</td>
<td>Controlled load</td>
</tr>
<tr>
<td>5</td>
<td>Video, less than 100-ms latency and jitter</td>
</tr>
<tr>
<td>6</td>
<td>Voice, less than 10-ms latency and jitter</td>
</tr>
<tr>
<td>7</td>
<td>Network control</td>
</tr>
</tbody>
</table>

You can configure each priority level independently, or you can use the `all` parameter to configure all of the priority levels at once. When you use the `enable` command, the traffic associated with that priority level uses A-MPDU transmission. When you use the `disable` command, the traffic associated with that priority level uses A-MSDU transmission. Configure the priority levels to match the aggregation method used by the clients. By default, A-MPDU is enabled for priority level 0, 4 and 5 and the rest are disabled. By default, A-MSDU is enabled for all priorities except 6 and 7.

c) Reenable the network by entering this command:

```
config {802.11a | 802.11b} enable network
```

- Configure the 802.11n-5 GHz A-MPDU transmit aggregation scheduler by entering this command:

```
config 802.11 {a | b} 11support a-mpdu tx scheduler {enable | disable | timeout rt timeout-value}
```

The timeout value is in milliseconds. The valid range is between 1 millisecond to 1000 milliseconds.

- Configure the guard interval for the network by entering this command:

```
config 802.11 {a | b} 11support guard_interval {any | long}
```

- Configure the Reduced Interframe Space (RIFS) for the network by entering this command:

```
config 802.11 {a | b} 11support rifs rx {enable | disable}
```

- Save your changes by entering this command:

```
save config
```

- View the configuration settings for the 802.11 networks by entering this command:

```
show {802.11a | 802.11b}
```

### Additional References

For information about configuring radio resource management (RRM) parameters or statically assigning radio parameters for 802.11n access points, see [Radio Resource Management](#), on page 711
Configuring 802.11h Parameters

Information About Configuring 802.11h Parameters

802.11h informs client devices about channel changes and can limit the transmit power of those client devices.

Configuring the 802.11h Parameters (GUI)

Step 1 Disable the 802.11 band as follows:
   a) Choose Wireless > 802.11a/n > Network to open the 802.11a Global Parameters page.
   b) Unselect the 802.11a Network Status check box.
   c) Click Apply.

Step 2 Choose Wireless > 802.11a/n > DFS (802.11h) to open the 802.11h Global Parameters page.

Step 3 In the Power Constraint area, enter the local power constraint. The valid range is between 0 dBm and 30 dBm.

Step 4 In the Channel Switch Announcement area, select the Channel Announcement check box if you want the access point to announce when it is switching to a new channel and the new channel number, or unselect this check box to disable the channel announcement. The default value is disabled.

Step 5 If you enabled the channel announcement, the Channel Quiet Mode check box appears. Select this check box if you want the access point to stop transmitting on the current channel, or unselect this check box to disable quiet mode. The default value is disabled.

Step 6 Click Apply.

Step 7 Reenable the 802.11a band as follows:
   a) Choose Wireless > 802.11a/n > Network to open the 802.11a Global Parameters page.
   b) Select the 802.11a Network Status check box.
   c) Click Apply.

Step 8 Click Save Configuration.

Configuring the 802.11h Parameters (CLI)

Step 1 Disable the 802.11a network by entering this command:
   config 802.11a disable network

Step 2 Enable or disable an access point to announce when it is switching to a new channel, and the new channel number by entering this command:
   config 802.11h channelswitch {enable | disable} switch_mode
Enter either 0 or 1 for the `switch_mode` parameter to specify whether transmissions are restricted until the actual channel switch (0), or are not restricted (1). By default, this feature is in disabled state.

**Step 3** Configure a new channel using the 802.11h channel announcement by entering this command:

```
config 802.11h setchannel channel
```

**Step 4** Configure the 802.11h power constraint value by entering this command:

```
config 802.11h powerconstraint value
```

Use increments of 3 dB for the value so that the AP goes down one power level at a time.

**Step 5** Reenable the 802.11a network by entering this command:

```
config 802.11a enable network
```

**Step 6** View the status of the 802.11h parameters by entering this command:

```
show 802.11h
```

Information similar to the following appears:

```
Power Constraint................................. 0
Channel Switch................................... Disabled
Channel Switch Mode.............................. 0
```

---

## Configuring DHCP Proxy

### Information About Configuring DHCP Proxy

When DHCP proxy is enabled on the controller, the controller unicasts DHCP requests from the client to the configured servers. At least one DHCP server must be configured on either the interface associated with the WLAN or the WLAN itself.

When DHCP proxy is disabled on the controller, those DHCP packets transmitted to and from the clients are bridged by the controller without any modification to the IP portion of the packet. Packets received from the client are removed from the CAPWAP tunnel and transmitted on the upstream VLAN. DHCP packets directed to the client are received on the upstream VLAN, converted to 802.11, and transmitted through a CAPWAP tunnel toward the client. As a result, the internal DHCP server cannot be used when DHCP proxy is disabled. The ability to disable DHCP proxy allows organizations to use DHCP servers that do not support Cisco’s native proxy mode of operation. It should be disabled only when required by the existing infrastructure.

**Note**

DHCP proxy is enabled by default.

## Restrictions on Using DHCP Proxy

- DHCP proxy must be enabled in order for DHCP option 82 to operate correctly.
• All controllers that will communicate must have the same DHCP proxy setting.
• DHCP v6 Proxy is not supported.

Configuring DHCP Proxy

Configuring DHCP Proxy (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose \texttt{Controller} &gt; \texttt{Advanced} &gt; \texttt{DHCP} to open the DHCP Parameters page.</td>
</tr>
<tr>
<td>2</td>
<td>Select the \texttt{Enable DHCP Proxy} check box to enable DHCP proxy on a global basis. Otherwise, unselect the check box. The default value is selected.</td>
</tr>
<tr>
<td>3</td>
<td>Click \texttt{Apply} to commit your changes.</td>
</tr>
<tr>
<td>4</td>
<td>Click \texttt{Save Configuration} to save your changes.</td>
</tr>
</tbody>
</table>

Configuring DHCP Proxy (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose \texttt{Controller} &gt; \texttt{Interfaces}.</td>
</tr>
<tr>
<td>2</td>
<td>Select the interface you want to configure the DHCP proxy. You can configure the DHCP proxy on the management, virtual, ap manager, or dynamic interfaces in the controller. The \texttt{Interfaces} &gt; \texttt{Edit} page is displayed with DHCP information on the primary and secondary DHCP servers configured in the controller. If the primary and secondary servers are not listed, you must enter values for the IP address of the DHCP servers in the text boxes displayed in this window.</td>
</tr>
<tr>
<td>3</td>
<td>Select from the following option of the proxy mode drop-down to enable DHCP proxy on the selected management interface: Global—Uses the global DHCP proxy mode on the controller. Enabled—Enables the DHCP proxy mode on the interface. When you enable DHCP proxy on the controller, the controller unicasts the DHCP requests from the client to the configured servers. You must configure at least one DHCP server on either the interface associated with the WLAN or on the WLAN. Disabled—Disables the DHCP proxy mode on the interface. When you disable the DHCP proxy on the controller, the DHCP packets transmitted to and from the clients are bridged by the controller without any modification to the IP portion of the packet. Packets received from the client are removed from the CAPWAP tunnel and transmitted on the upstream VLAN. DHCP packets directed to the client are received on the upstream VLAN, converted to 802.11, and transmitted through a CAPWAP tunnel toward the client. As a result, the internal DHCP server cannot be used when DHCP proxy is disabled.</td>
</tr>
<tr>
<td>4</td>
<td>Check the Enable DHCP option 82 checkbox to ensure additional security when DHCP is used to allocate network addresses, check the Enable DHCP option 82 checkbox.</td>
</tr>
<tr>
<td>5</td>
<td>Click \texttt{Apply} to save the configuration.</td>
</tr>
</tbody>
</table>
Configuring DHCP Proxy (CLI)

**Step 1**
Enable or disable DHCP proxy by entering this command:
`config dhcp proxy {enable | disable}`

**Step 2**
View the DHCP proxy configuration by entering this command:
`show dhcp proxy`
Information similar to the following appears:

```
DHCP Proxy Behavior: enabled
```

Configuring DHCP Proxy (CLI)

**Step 1**
Configure the DHCP primary and secondary servers on the interface. To do this, enter the following commands:
- `config interface dhcp management primary primary-server`
- `config interface dhcp dynamic-interface interface-name primary primary-s`

**Step 2**
Configure DHCP proxy on the management or dynamic interface of the controller. To do this, enter the following command:
- `config interface dhcp management proxy-mode enable global disable`
- `config interface dhcp dynamic-interface interface-name proxy-mode enable global disable`. **Note**
To ensure additional security when DHCP is configured, use the `config interface dhcp interface type option-82 enable` command.

**Step 3**
Enter the `save config` command.

**Step 4**
To view the proxy settings of the controller interface enter the `show dhcp proxy` command.

Configuring a DHCP Timeout (GUI)

**Step 1**
Choose Controller > Advanced > DHCP to open the DHCP Parameters page.

**Step 2**
Select the DHCP Timeout (5 - 120 seconds) check box to enable a DHCP timeout on a global basis. Otherwise, unselect the check box. The valid range is 5 through 120 seconds.

**Step 3**
Click Apply to commit your changes.

**Step 4**
Click Save Configuration to save your changes.
Configuring a DHCP Timeout (CLI)

Configure a DHCP timeout by entering this command:

```
config dhcp timeout seconds
```

Configuring Administrator Usernames and Passwords

Information About Configuring Administrator Usernames and Passwords

You can configure administrator usernames and passwords to prevent unauthorized users from reconfiguring the controller and viewing configuration information. This section provides instructions for initial configuration and for password recovery.

Configuring Usernames and Passwords

Configuring Usernames and Passwords (GUI)

Step 1  Choose Management > Local Management Users.
Step 2  Click New.
Step 3  Enter the username and password, and confirm the password.
        Usernames and passwords are case-sensitive and can contain up to 24 ASCII characters. Usernames and passwords cannot contain spaces.
Step 4  Choose the User Access Mode as one of the following:
        • ReadOnly
        • ReadWrite
        • LobbyAdmin
Step 5  Click Apply.

Configuring Usernames and Passwords (CLI)

Step 1  Configure a username and password by entering one of these commands:
• **config mgmtuser add username password read-write**—Creates a username-password pair with read-write privileges.

• **config mgmtuser add username password read-only**—Creates a username-password pair with read-only privileges.

Usernames and passwords are case-sensitive and can contain up to 24 ASCII characters. Usernames and passwords cannot contain spaces.

**Note** If you ever need to change the password for an existing username, enter the **config mgmtuser password username new_password** command.

---

**Step 2** List the configured users by entering this command:

```bash
show mgmtuser
```

---

**Restoring Passwords**

**Before You Begin**

Ensure that you are accessing the controller CLI through the console port.

---

**Step 1** After the controller boots up, enter **Restore-Password** at the User prompt.

**Note** For security reasons, the text that you enter does not appear on the controller console.

**Step 2** At the Enter User Name prompt, enter a new username.

**Step 3** At the Enter Password prompt, enter a new password.

**Step 4** At the Re-enter Password prompt, reenter the new password. The controller validates and stores your entries in the database.

**Step 5** When the User prompt reappears, enter your new username.

**Step 6** When the Password prompt appears, enter your new password. The controller logs you in with your new username and password.

---

**Configuring SNMP**

**Configuring SNMP (CLI)**

**Note** To view the controller trap log, choose **Monitor** and click **View All** under “Most Recent Traps” on the controller GUI.

- Create an SNMP community name by entering this command:
We refer you to Section 15.2 on the Cisco Wireless LAN Controller Configuration Guide, Release 7.3

**config snmp community create name**

- Delete an SNMP community name by entering this command:
  `config snmp community delete name`

- Configure an SNMP community name with read-only privileges by entering this command:
  `config snmp community accessmode ro name`

- Configure an SNMP community name with read-write privileges by entering this command:
  `config snmp community accessmode rw name`

- For IPv4 configuration—Configure an IPv4 address and subnet mask for an SNMP community by entering this command:
  `config snmp community ipaddr ip-address ip-mask name`

---

**Note**

This command behaves like an SNMP access list. It specifies the IP address from which the device accepts SNMP packets with the associated community. An AND operation is performed between the requesting entity’s IP address and the subnet mask before being compared to the IP address. If the subnet mask is set to 0.0.0.0, an IP address of 0.0.0.0 matches to all IP addresses. The default value is 0.0.0.0.

---

**Note**

The controller can use only one IP address range to manage an SNMP community.

- For IPv6 configuration—Configure an IPv6 address and prefix-length for an SNMP community by entering this command:
  `config snmp community ipaddr ipv6-address ip-mask name`

- Enable or disable a community name by entering this command:
  `config snmp community mode {enable | disable}`

- Enable or disable a community name by entering this command:
  `config snmp community ipsec {enable | disable}`

- Configure the IKE authentication methods by entering this command:
  `config snmp community ipsec ike auth-mode {certificate | pre-shared-key ascii/hex secret}`

  Authentication mode can be configured per trap receiver. By default, the authentication mode is set to certificate.

- Configure a destination for a trap by entering this command:
  `config snmp trapreceiver create name ip-address`

- Delete a trap by entering this command:
  `config snmp trapreceiver delete name`

- Change the destination for a trap by entering this command:
  `config snmp trapreceiver ipaddr old-ip-address name new-ip-address`

- Configure the trap receiver IPSec session entering this command:
  `config snmp trapreceiver ipsec {enable | disable} community-name`

  Trap receiver IPSec must be in the disabled state to change the authentication mode.

- Configure the IKE authentication methods by entering this command:
  `config snmp trapreceiver ipsec ike auth-mode {certificate | pre-shared-key ascii/hex secret community-name}`
Authentication mode can be configured per trap receiver. By default, the authentication mode is set to certificate.

- Enable or disable the traps by entering this command:
  ```bash
cfg snmp trapreceiver mode {enable | disable}
  ```
- Configure the name of the SNMP contact by entering this command:
  ```bash
cfg snmp syscontact syscontact-name
  ```
  Enter up to 31 alphanumeric characters for the contact name.
- Configure the SNMP system location by entering this command:
  ```bash
cfg snmp syslocation syslocation-name
  ```
  Enter up to 31 alphanumeric characters for the location.
- Verify that the SNMP traps and communities are correctly configured by entering these commands:
  ```bash
  show snmpcommunity
  show snmptrap
  ```
  - See the enabled and disabled trap flags by entering this command:
    ```bash
    show trapflags
    ```
    If necessary, use the `config trapflags` command to enable or disable trap flags.
- Configure the SNMP engine ID by entering this command:
  ```bash
  config snmp engineID engine-id-string
  ```
  - View the engine ID by entering this command:
    ```bash
    show snmpengineID
    ```
  - Configure the SNMP version by entering this command:
    ```bash
    config snmp version {v1 | v2c | v3} {enable | disable}
    ```

**SNMP Community Strings**

The controller has commonly known default values of "public" and "private" for the read-only and read-write SNMP community strings. Using these standard values presents a security risk. If you use the default community names, and since these are known, the community names could be used to communicate to the controller using SNMP. Therefore, we strongly advise that you change these values.
### Changing the SNMP Community String Default Values (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Choose <a href="#">Management</a> and then <a href="#">Communities</a> under SNMP. The SNMP v1 / v2c Community page appears.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>If &quot;public&quot; or &quot;private&quot; appears in the Community Name column, hover your cursor over the blue drop-down arrow for the desired community and choose <a href="#">Remove</a> to delete this community.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Click <a href="#">New</a> to create a new community. The SNMP v1 / v2c Community &gt; New page appears.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>In the Community Name text box, enter a unique name containing up to 16 alphanumeric characters. Do not enter &quot;public&quot; or &quot;private.&quot;</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>In the next two text boxes, enter the IPv4/IPv6 address and IP Mask/Prefix Length from which this device accepts SNMP packets with the associated community and the IP mask.</td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>Choose <a href="#">Read Only</a> or <a href="#">Read/Write</a> from the Access Mode drop-down list to specify the access level for this community.</td>
</tr>
<tr>
<td><strong>Step 7</strong></td>
<td>Choose <a href="#">Enable</a> or <a href="#">Disable</a> from the Status drop-down list to specify the status of this community.</td>
</tr>
<tr>
<td><strong>Step 8</strong></td>
<td>Click <a href="#">Apply</a> to commit your changes.</td>
</tr>
<tr>
<td><strong>Step 9</strong></td>
<td>Click <a href="#">Save Configuration</a> to save your settings.</td>
</tr>
<tr>
<td><strong>Step 10</strong></td>
<td>Repeat this procedure if a &quot;public&quot; or &quot;private&quot; community still appears on the SNMP v1 / v2c Community page.</td>
</tr>
</tbody>
</table>

### Changing the SNMP Community String Default Values (CLI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>See the current list of SNMP communities for this controller by entering this command: <code>show snmp community</code></td>
</tr>
</tbody>
</table>
| **Step 2** | If "public" or "private" appears in the SNMP Community Name column, enter this command to delete this community: `config snmp community delete name`  
The `name` parameter is the community name (in this case, "public" or "private"). |
| **Step 3** | Create a new community by entering this command: `config snmp community create name`  
Enter up to 16 alphanumeric characters for the `name` parameter. Do not enter "public" or "private." |
| **Step 4** | For IPv4 specific configuration, enter the IPv4 address from which this device accepts SNMP packets with the associated community by entering this command: `config snmp community ipaddr ip_address ip_mask name` |
| **Step 5** | For IPv6 specific configuration, enter the IPv6 address from which this device accepts SNMP packets with the associated community by entering this command: `config snmp community ipaddr ip_address prefix_length name` |
| **Step 6** | Specify the access level for this community by entering this command, where `ro` is read-only mode and `rw` is read/write mode: `config snmp community accessmode {ro | rw} name` |
| **Step 7** | Enable or disable this SNMP community by entering this command: |
Step 8
Enable or disable SNMP IPSec sessions for all SNMP communities by entering this command:
```
config snmp community ipsec {enable | disable} name
```
By default SNMP IPSec session is disabled. SNMP IPSec session must be disabled state to change the authentication mode.

Step 9
Configure the IKE authentication methods by entering this command:
```
config snmp community ipsec ike auth-mode {certificate | pre-shared-key ascii/hex secret}
```
- If authentication mode is configured as pre-shared-key, then enter a secret value. The secret value can either be an ASCII or a hexadecimal value. If auth-mode configured is certificate, then WLC will use the ipsecCaCert and ipsecDevCerts for SNMP over IPSEC.
- If authentication mode is configured as certificate, then controller uses the IPSEC CA and IPSEC device certificates for SNMP sessions. You need to download these certificates to the controller using the `transfer download datatype {ipseccacert | ipsecdevcert}` command.

Step 10
Save your changes by entering this command:
```
save config
```

Step 11
Repeat this procedure if you still need to change the default values for a “public” or “private” community string.

---

**Changing the Default Values for SNMP v3 Users**

**Information About Changing the Default Values for SNMP v3 Users**

The controller uses a default value of "default" for the username, authentication password, and privacy password for SNMP v3 users. Using these standard values presents a security risk. Therefore, Cisco strongly advises that you change these values.

**Note**

SNMP v3 is time sensitive. Ensure that you configure the correct time and time zone on your controller.
Changing the SNMP v3 User Default Values (GUI)

Step 1: Choose Management > SNMP > SNMP V3 Users to open the SNMP V3 Users page.

Step 2: If "default" appears in the User Name column, hover your cursor over the blue drop-down arrow for the desired user and choose Remove to delete this SNMP v3 user.

Step 3: Click New to add a new SNMP v3 user. The SNMP V3 Users > New page appears.

Step 4: In the User Profile Name text box, enter a unique name. Do not enter "default."

Step 5: Choose Read Only or Read Write from the Access Mode drop-down list to specify the access level for this user. The default value is Read Only.

Step 6: From the Authentication Protocol drop-down list, choose the desired authentication method: None, HMAC-MD5 (Hashed Message Authentication Coding-Message Digest 5), or HMAC-SHA (Hashed Message Authentication Coding-Secure Hashing Algorithm). The default value is HMAC-SHA.

Step 7: In the Auth Password and Confirm Auth Password text boxes, enter the shared secret key to be used for authentication. You must enter at least 12 characters that include both letters and numbers.

Step 8: From the Privacy Protocol drop-down list, choose the desired encryption method: None, CBC-DES (Cipher Block Chaining-Digital Encryption Standard), or CFB-AES-128 (Cipher Feedback Mode-Advanced Encryption Standard-128). The default value is CFB-AES-128.

Note: In order to configure CBC-DES or CFB-AES-128 encryption, you must have selected either HMAC-MD5 or HMAC-SHA as the authentication protocol in Step 6.

Step 9: In the Priv Password and Confirm Priv Password text boxes, enter the shared secret key to be used for encryption. You must enter at least 12 characters that include both letters and numbers.

Step 10: Click Apply.

Step 11: Click Save Configuration.

Step 12: Reboot the controller so that the SNMP v3 user that you added takes effect.

Changing the SNMP v3 User Default Values (CLI)

Step 1: See the current list of SNMP v3 users for this controller by entering this command:

```
show snmpv3user
```

Step 2: If "default" appears in the SNMP v3 User Name column, enter this command to delete this user:

```
config snmp v3user delete username
```

The username parameter is the SNMP v3 username (in this case, "default").

Step 3: Create a new SNMP v3 user by entering this command:

```
config snmp v3user create username {ro | rw} {none | hmacmd5 | hmacsha} {none | des | aesfb128} auth_key encrypt_key
```

where
• *username* is the SNMP v3 username.
• *ro* is read-only mode and *rw* is read-write mode.
• *none, hmacmd5*, and *hmacsha* are the authentication protocol options.
• *none, des*, and *aescfb128* are the privacy protocol options.
• *auth_key* is the authentication shared secret key.
• *encrypt_key* is the encryption shared secret key.

Do not enter “default” for the *username, auth_key, and encrypt_key* parameters.

**Step 4** Enter the `save config` command.
**Step 5** Reboot the controller so that the SNMP v3 user that you added takes effect by entering `reset system` command.

---

**Configuring Aggressive Load Balancing**

**Information About Configuring Aggressive Load Balancing**

Enabling aggressive load balancing on the controller allows lightweight access points to load balance wireless clients across access points. You can enable aggressive load balancing using the controller.

---

**Note**

Clients are load balanced between access points on the same controller. Load balancing does not occur between access points on different controllers.

When a wireless client attempts to associate to a lightweight access point, association response packets are sent to the client with an 802.11 response packet including status code 17. The code 17 indicates that the AP is busy. The AP responds with an association response bearing 'success' if the AP threshold is not met, and with code 17 (AP busy) if the AP utilization threshold is reached or exceeded and another less busy AP heard the client request.

For example, if the number of clients on AP1 is more than the number of clients on AP2 plus the load-balancing window, then AP1 is considered to be busier than AP2. When a client attempts to associate to AP1, it receives an 802.11 response packet with status code 17, indicating that the access point is busy, and the client attempts to associate to a different access point.

You can configure the controller to deny client associations up to 10 times (if a client attempted to associate 11 times, it would be allowed to associate on the 11th try). You can also enable or disable load balancing on a particular WLAN, which is useful if you want to disable load balancing for a select group of clients (such as time-sensitive voice clients).
Voice Client does not authenticate when delay is configured more than 300 ms. To avoid this configure a Central-Auth, Local Switching WLAN with CCKM, configure a Paqent Router between AP and WLC with a delay of 600 ms (300 ms UP and 300 ms DOWN and try associating the voice client

Passive scanning clients will be able to associate to an AP irrespective of whether load balancing is enabled or not.

Note
Cisco 600 Series OfficeExtend Access Points do not support client load balancing.

With the 7.4 release, FlexConnect access points do support client load balancing.

You can configure the controller to analyze the WAN interface utilization of neighboring APs and then load balance the clients across the lightly loaded APs. You can configure this by defining a load balancing threshold. By defining the threshold, you can measure the WAN interface utilization percentage. For example, a threshold value of 50 triggers the load balancing upon detecting utilization of 50% or more on an AP-WAN interface.

Note
For a FlexConnect AP the association is locally handled. The load-balancing decisions are taken at the Cisco WLC. A FlexConnect AP initially responds to the client before knowing the result of calculations at the Cisco WLC. Load-balancing doesn't take effect when the FlexConnect AP is in standalone mode.

FlexConnect AP does not send (re)association response with status 17 for Load-Balancing as Local mode APs do; instead, it first sends (re)association with status 0 (success) and then deauth with reason 5.

Configuring Aggressive Load Balancing

Configuring Aggressive Load Balancing (GUI)

Step 1
Choose Wireless > Advanced > Load Balancing to open the Load Balancing page.

Step 2
In the Client Window Size text box, enter a value between 1 and 20.
The window size becomes part of the algorithm that determines whether an access point is too heavily loaded to accept more client associations:

\[ \text{load-balancing window} + \text{client associations on AP with the lightest load} = \text{load-balancing threshold} \]

In the group of access points accessible to a client device, each access point has a different number of client associations. The access point with the lowest number of clients has the lightest load. The client window size plus the number of clients on the access point with the lightest load forms the threshold. Access points with more client associations than this threshold is considered busy, and clients can associate only to access points with client counts lower than the threshold.

Step 3
In the Maximum Denial Count text box, enter a value between 0 and 10.
The denial count sets the maximum number of association denials during load balancing.
Step 4 Click **Apply**.

Step 5 Click **Save Configuration**.

Step 6 To enable or disable aggressive load balancing on specific WLANs, do the following:
   a) Choose **WLANs > WLAN ID**. The WLANs > Edit page appears.
   b) In the **Advanced** tab, select or unselect the **Client Load Balancing** check box.
   c) Click **Apply**.
   d) Click **Save Configuration**.

---

**Configuring Aggressive Load Balancing (CLI)**

**Step 1**
Set the client window for aggressive load balancing by entering this command:

```
config load-balancing window client_count
```

You can enter a value between 0 and 20 for the `client_count` parameter.

**Step 2**
Set the denial count for load balancing by entering this command:

```
config load-balancing denial denial_count
```

You can enter a value between 1 and 10 for the `denial_count` parameter.

**Step 3**
Save your changes by entering this command:

```
save config
```

**Step 4**
Enable or disable aggressive load balancing on specific WLANs by entering this command:

```
config wlan load-balance allow {enable | disable} wlan_ID
```

You can enter a value between 1 and 512 for `wlan_ID` parameter.

**Step 5**
Verify your settings by entering this command:

```
show load-balancing
```

**Step 6**
Save your changes by entering this command:

```
save config
```

---

**Configuring Band Selection**

**Information About Configuring Band Selection**

Band selection enables client radios that are capable of dual-band (2.4- and 5-GHz) operation to move to a less congested 5-GHz access point. The 2.4-GHz band is often congested. Clients on this band typically experience interference from Bluetooth devices, microwave ovens, and cordless phones as well as co-channel interference from other access points because of the 802.11b/g limit of three nonoverlapping channels. To
prevent these sources of interference and improve overall network performance, you can configure band selection on the controller.

Band selection is enabled globally by default.

Band selection works by regulating probe responses to clients. It makes 5-GHz channels more attractive to clients by delaying probe responses to clients on 2.4-GHz channels.

---

**Note**

The client RSSI value (seen as $\text{sh cont d0 | beg RSSI}$) is the average of the client packets received, and the midRSSI feature is the instantaneous RSSI value of the probe packets. As a result, the client RSSI is seen as weaker than the configured midRSSI value (7 dB delta). The 802.11b probes from the client are suppressed to push the client to associate with the 802.11a band.

---

### Restrictions on Band Selection

- Band-selection enabled WLANs do not support time-sensitive applications like voice and video because of roaming delays.

- Band selection can be used only with Cisco Aironet 1040, 1140, 1250, 1260, 1550, 2600, 3500, 3600, series access points.

  **Note**  
  OEAP 600 Series access points do not support band select.

- Band selection operates only on access points that are connected to a controller. A FlexConnect access point without a controller connection does not perform band selection after a reboot.

- The band-selection algorithm directs dual-band clients only from the 2.4-GHz radio to the 5-GHz radio of the same access point, and it only runs on an access point when both the 2.4-GHz and 5-GHz radios are up and running.

- You can enable both band selection and aggressive load balancing on the controller. They run independently and do not impact one another.

- It is not possible to enable or disable band selection and client load balancing globally through the controller GUI or CLI. You can, however, enable or disable band selection and client load balancing for a particular WLAN. Band selection and client load balancing are enabled globally by default.
Configuring Band Selection

Configuring Band Selection (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Wireless &gt; Advanced &gt; Band Select to open the Band Select page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the Probe Cycle Count text box, enter a value between 1 and 10. The cycle count sets the number of suppression cycles for a new client. The default cycle count is 2.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Scan Cycle Period Threshold (milliseconds) text box, enter a value between 1 and 1000 milliseconds for the scan cycle period threshold. This setting determines the time threshold during which new probe requests from a client come from a new scanning cycle. The default cycle threshold is 200 milliseconds.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the Age Out Suppression (seconds) text box, enter a value between 10 and 200 seconds. Age-out suppression sets the expiration time for pruning previously known 802.11b/g/n clients. The default value is 20 seconds. After this time elapses, clients become new and are subject to probe response suppression.</td>
</tr>
<tr>
<td>Step 5</td>
<td>In the Age Out Dual Band (seconds) text box, enter a value between 10 and 300 seconds. The age-out period sets the expiration time for pruning previously known dual-band clients. The default value is 60 seconds. After this time elapses, clients become new and are subject to probe response suppression.</td>
</tr>
</tbody>
</table>
| Step 6 | In the Acceptable Client RSSI (dBm) text box, enter a value between –20 and –90 dBm. This parameter sets the minimum RSSI for a client to respond to a probe. The default value is –80 dBm.  
  **Note**  
  To disable band select based on RSSI add Mid RSSI. BandSelect is active only to mid_rssi when mid_rssi and min_rssi probes are not suppressed. New threshold mid_rssi is introduced in bandSelect this is between the AP and min_rssi (-80). |
| Step 7 | Click Apply. |
| Step 8 | Click Save Configuration. |
| Step 9 | To enable or disable band selection on specific WLANs, choose WLANs > WLAN ID. The WLANs > Edit page appears. |
| Step 10 | Click the Advanced tab. |
| Step 11 | In the Load Balancing and Band Select text area, if you want to enable band selection, select the Client Band Select check box. If you want to disable band selection, leave the check box unselected. The default value is disabled. |
| Step 12 | Click Save Configuration. |

Configuring Band Selection (CLI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Set the probe cycle count for band select by entering this command:  
  ```bash
  config band-select cycle-count cycle_count
  ```  
  You can enter a value between 1 and 10 for the cycle_count parameter. |
| Step 2 | Set the time threshold for a new scanning cycle period by entering this command:  
  ```bash
  config band-select cycle-threshold milliseconds
  ``` |
You can enter a value for threshold between 1 and 1000 for the \textit{milliseconds} parameter.

**Step 3**
Set the suppression expire to the band select by entering this command:
\texttt{config band-select expire suppression seconds}
You can enter a value for suppression between 10 to 200 for the \textit{seconds} parameter.

**Step 4**
Set the dual band expire by entering this command:
\texttt{config band-select expire dual-band seconds}
You can enter a value for dual band between 10 and 300 for the \textit{seconds} parameter.

**Step 5**
Set the client RSSI threshold by entering this command:
\texttt{config band-select client-rssi client_rssi}
You can enter a value for minimum dBm of a client RSSI to respond to a probe between 20 and 90 for the \textit{client_rssi} parameter.

**Step 6**
Enter the \texttt{save config} command to save your changes.

**Step 7**
Enable or disable band selection on specific WLANs by entering this command:
\texttt{config wlan band-select allow \{enable | disable\} wlan_ID}
You can enter a value between 1 and 512 for \textit{wlan_ID} parameter.

**Step 8**
Verify your settings by entering this command:
\texttt{show band-select}
Information similar to the following appears:

\begin{verbatim}
Band Select Probe Response....................... Enabled
Cycle Count................................... 3 cycles
Cycle Threshold............................... 300 milliseconds
Age Out Suppression........................... 20 seconds
Age Out Dual Band............................. 20 seconds
Client RSSI................................... -30 dBm
\end{verbatim}

**Step 9**
Enter the \texttt{save config} command to save your changes.

---

**Configuring Fast SSID Changing**

**Information About Configuring Fast SSID Changing**

When fast SSID changing is enabled, the controller allows clients to move faster between SSIDs. When fast SSID is enabled, the client entry is not cleared and the delay is not enforced.

When fast SSID changing is disabled, the controller enforces a delay before clients are allowed to move to a new SSID. When fast SSID is disabled and the client sends a new association for a different SSID, the client entry in the controller connection table is cleared before the client is added to the new SSID.
Configuring Fast SSID

Configuring Fast SSID Changing (GUI)

Step 1  Choose Controller to open the General page.
Step 2  From the Fast SSID Change drop-down list, choose Enabled to enable this feature or Disabled to disable it. The default value is disabled.
Step 3  Click Apply to commit your changes.
Step 4  Click Save Configuration to save your changes.

Configuring Fast SSID Changing (CLI)

Step 1  Enable or disable fast SSID changing by entering this command:
        config network fast-ssid-change {enable | disable}
Step 2  Save your changes by entering this command:
        save config

Enabling 802.3X Flow Control

802.3X Flow Control is disabled by default. To enable it, enter the config switchconfig flowcontrol enable command.

Configuring 802.3 Bridging

Information About Configuring 802.3 Bridging

The controller supports 802.3 frames and the applications that use them, such as those typically used for cash registers and cash register servers. However, to make these applications work with the controller, the 802.3 frames must be bridged on the controller.

You can also configure 802.3 bridging using the Cisco Prime Network Control System. See the Cisco Prime Network Control System Configuration Guide for instructions.
Restrictions on 802.3 Bridging

- Support for raw 802.3 frames allows the controller to bridge non-IP frames for applications not running over IP.

  The raw 802.3 frame contains destination MAC address, source MAC address, total packet length, and payload.

- By default, Cisco 5500 Series Controllers bridge all non-IPv4 packets (such as AppleTalk, IPv6, and so on). You can also use ACLs to block the bridging of these protocols.

Configuring 802.3 Bridging

Configuring 802.3 Bridging (GUI)

**Step 1** Choose Controller > General to open the General page.

**Step 2** From the 802.3 Bridging drop-down list, choose Enabled to enable 802.3 bridging on your controller or Disabled to disable this feature. The default value is Disabled.

**Step 3** Click Apply to commit your changes.

**Step 4** Click Save Configuration to save your changes.

Configuring 802.3 Bridging (CLI)

**Step 1** See the current status of 802.3 bridging for all WLANs by entering this command:

   `show network`

**Step 2** Enable or disable 802.3 bridging globally on all WLANs by entering this command:

   `config network 802.3-bridging {enable | disable}`

   The default value is disabled.

**Step 3** Save your changes by entering this command:

   `save config`
Configuring Multicast Mode

Information About Multicast Mode

If your network supports packet multicasting, you can configure the multicast method that the controller uses. The controller performs multicasting in two modes:

• Unicast mode—In this mode, the controller unicasts every multicast packet to every access point associated to the controller. This mode is inefficient but might be required on networks that do not support multicasting.

• Multicast mode—In this mode, the controller sends multicast packets to a CAPWAP multicast group. This method reduces overhead on the controller processor and shifts the work of packet replication to your network, which is much more efficient than the unicast method.

When you enable multicast mode and the controller receives a multicast packet from the wired LAN, the controller encapsulates the packet using CAPWAP and forwards the packet to the CAPWAP multicast group address. The controller always uses the management interface for sending multicast packets. Access points in the multicast group receive the packet and forward it to all the BSSIDs mapped to the interface on which clients receive multicast traffic. From the access point perspective, the multicast appears to be a broadcast to all SSIDs.

Note

Until Release 7.5, the port number used for CAPWAP multicast was 12224. From Release 7.6 onwards, the port number used for CAPWAP is changed to 5247.

The controller supports Multicast Listener Discovery (MLD) v1 snooping for IPv6 multicast. This feature keeps track of and delivers IPv6 multicast flows to the clients that request them. To support IPv6 multicast, you must enable Global Multicast Mode.

Note

When you disable the Global Multicast Mode, the controller still forwards the IPv6 ICMP multicast messages, such as router announcements and DHCPv6 solicits, as these are required for IPv6 to work. As a result, enabling the Global Multicast Mode on the controller does not impact the ICMPv6 and the DHCPv6 messages. These messages will always be forwarded irrespective of whether or not the Global Multicast Mode is enabled.

In controller software 4.2 or later releases, Internet Group Management Protocol (IGMP) snooping is introduced to better direct multicast packets. When this feature is enabled, the controller gathers IGMP reports from the clients, processes them, creates unique multicast group IDs (MGIDs) from the IGMP reports after selecting the Layer 3 multicast address and the VLAN number, and sends the IGMP reports to the infrastructure switch. The controller sends these reports with the source address as the interface address on which it received the reports from the clients. The controller then updates the access point MGID table on the access point with the client MAC address. When the controller receives multicast traffic for a particular multicast group, it forwards it to all the access points, but only those access points that have active clients listening or subscribed to that multicast group send multicast traffic on that particular WLAN. IP packets are forwarded with an MGID that is unique for an ingress VLAN and the destination multicast group. Layer 2 multicast packets are forwarded with an MGID that is unique for the ingress interface.

When IGMP snooping is disabled, the following is true:
• The controller always uses Layer 2 MGID when it sends multicast data to the access point. Every interface created is assigned one Layer 2 MGID. For example, the management interface has an MGID of 0, and the first dynamic interface created is assigned an MGID of 8, which increments as each dynamic interface is created.

• The IGMP packets from clients are forwarded to the router. As a result, the router IGMP table is updated with the IP address of the clients as the last reporter.

When IGMP snooping is enabled, the following is true:

• The controller always uses Layer 3 MGID for all Layer 3 multicast traffic sent to the access point. For all Layer 2 multicast traffic, it continues to use Layer 2 MGID.

• IGMP report packets from wireless clients are consumed or absorbed by the controller, which generates a query for the clients. After the router sends the IGMP query, the controller sends the IGMP reports with its interface IP address as the listener IP address for the multicast group. As a result, the router IGMP table is updated with the controller IP address as the multicast listener.

• When the client that is listening to the multicast groups roams from one controller to another, the first controller transmits all the multicast group information for the listening client to the second controller. As a result, the second controller can immediately create the multicast group information for the client. The second controller sends the IGMP reports to the network for all multicast groups to which the client was listening. This process aids in the seamless transfer of multicast data to the client.

• If the listening client roams to a controller in a different subnet, the multicast packets are tunneled to the anchor controller of the client to avoid the reverse path filtering (RPF) check. The anchor then forwards the multicast packets to the infrastructure switch.

---

**Restrictions for Configuring Multicast Mode**

• The Cisco Unified Wireless Network solution uses some IP address ranges for specific purposes, and you should keep these ranges in mind when configuring a multicast group:

  - 224.0.0.0 through 224.0.0.255—Reserved link local addresses
  - 224.0.1.0 through 238.255.255.255—Globally scoped addresses
  - 239.0.0.0 through 239.255.x.y/16—Limited scope addresses

---

**Note**
The MGIDs are controller specific. The same multicast group packets coming from the same VLAN in two different controllers may be mapped to two different MGIDs.

**Note**
If Layer 2 multicast is enabled, a single MGID is assigned to all the multicast addresses coming from an interface.

**Note**
The number of multicast addresses supported per VLAN for a Cisco WLC is 100.
When you enable multicast mode on the controller, you also must configure a CAPWAP multicast group address. Access points subscribe to the CAPWAP multicast group using IGMP.

Cisco 1100, 1130, 1200, 1230, and 1240 access points use IGMP versions 1, 2, and 3.

Access points in monitor mode, sniffer mode, or rogue detector mode do not join the CAPWAP multicast group address.

The CAPWAP multicast group configured on the controllers should be different for different controllers.

Lightweight Access Points transmit multicast packets at the highest configured mandatory data rate.

Because multicast frames are not retransmitted at the MAC layer, clients at the edge of the cell might fail to receive them successfully. If reliable reception is a goal, multicast frames should be transmitted at a low data rate. If support for high data rate multicast frames is required, it might be useful to shrink the cell size and disable all lower data rates.

Depending on your requirements, you can take the following actions:

- If you need to transmit multicast data with the greatest reliability and if there is no need for great multicast bandwidth, then configure a single basic rate, that is low enough to reach the edges of the wireless cells.

- If you need to transmit multicast data at a certain data rate in order to achieve a certain throughput, you can configure that rate as the highest basic rate. You can also set a lower basic rate for coverage of non-multicast clients.

Multicast mode does not operate across intersubnet mobility events such as guest tunneling. It does, however, operate with interface overrides using RADIUS (but only when IGMP snooping is enabled) and with site-specific VLANs (access point group VLANs).

For LWAPP, the controller drops multicast packets sent to UDP control port 12223. For CAPWAP, the controller drops multicast packets sent to UDP control and data ports 5246 and 5247, respectively. Therefore, you may want to consider not using these port numbers with the multicast applications on your network.

We recommend that any multicast applications on your network not use the multicast address configured as the CAPWAP multicast group address on the controller.

For multicast to work on Cisco 2500 Series WLC, you have to configure the multicast IP address.

Multicast mode is not supported on Cisco Flex 7500 Series WLCs.

In a multicast group, when multicast audio is initiated, the recipients do not hear the first two seconds of the multicast audio. As a workaround, we recommend that you set the Cisco APs to FlexConnect + Local Switching mode for small-scale deployments.

To reduce join latency, we recommend disabling IPv6 on the Cisco WLC.

For 8.0 Release, there is a limitation - the FlexConnect APs do not join the multicast group when the Multicast mode is Multicast-Multicast and CAPWAP has IPv4 and IPv6. For Cisco 5500 and 8500 Series WLC, you can disable the Multicast-Multicast mode and enable the Multicast-Unicast mode. For Cisco 7500 Series WLC, there is no Multicast-Multicast configuration. For FlexConnect APs in Multicast-Multicast mode joined with central switching clients, there is reduction of 0-13% in data throughput.

While using Local and Flexconnect AP mode the WLC platform's multicast support differs for different platforms.
The parameters that affect Multicast forwarding are:

- WLC Platform.
- Global AP multicast mode configuration at WLC.
- Mode of the AP - Local, Flexconnect central switching.
- For Local switching, it does not send/receive the packet to/from WLC, so it does not matter which Multicast mode is configured on WLC.

Multicast support on different WLC platform are:

- WLC 5500/WiSM2/8500 supports both Multicast and Unicast mode.
- WLC 2500 supports Multicast to Multicast only.
- WLC 7500 & vWLC supports Multicast to Unicast only. It supports only Flex AP's.

**Note**  
Flexconnect mode AP cannot join Multicast group address configured at WLC, so it cannot receive Multicast packets that are sent by WLC(Multicast packets sent by flex central switching is received by local mode AP's). If Multicast needs to be forwarded for flexconnect central switching you must configure AP mode Multicast to Unicast. This configuration is global since it is applicable to local mode AP.

### Configuring Multicast Mode

**Enabling Multicast Mode (GUI)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Choose <strong>Controller</strong> &gt; <strong>Multicast</strong> to open the Multicast page.</td>
</tr>
</tbody>
</table>
| **Step 2** | Select the **Enable Global Multicast Mode** check box to configure sending multicast packets. The default value is disabled.  

**Note** FlexConnect supports unicast mode only.  

**Step 3** | If you want to enable IGMP snooping, select the **Enable IGMP Snooping** check box. If you want to disable IGMP snooping, leave the check box unselected. The default value is disabled. |
| **Step 4** | To set the IGMP timeout, enter a value between 30 and 7200 seconds in the IGMP Timeout text box. The controller sends three queries in one timeout value at an interval of \( \text{timeout} / 3 \) to see if any clients exist for a particular multicast group. If the controller does not receive a response through an IGMP report from the client, the controller times out the client entry from the MGID table. When no clients are left for a particular multicast group, the controller waits for the IGMP timeout value to expire and then deletes the MGID entry from the controller. The controller always generates a general IGMP query (that is, to destination address 224.0.0.1) and sends it on all WLANs with an MGID value of 1. |
| **Step 5** | Enter the IGMP Query Interval (seconds). |
| **Step 6** | Select the **Enable MLD Snooping** check box to support IPv6 forwarding decisions.  

**Note** To enable MLD Snooping, you must enable Global Multicast Mode of the controller. |
**Enabling Multicast Mode (CLI)**

**Step 1** Enable or disable multicasting on the controller by entering this command:
```
config network multicast global {enable | disable}
```
The default value is disabled.

**Note** The `config network broadcast {enable | disable}` command allows you to enable or disable broadcasting without enabling or disabling multicasting as well. This command uses the multicast mode currently on the controller to operate.

**Step 2** Perform either of the following:

a) Configure the controller to use the unicast method to send multicast packets by entering this command:
```
config network multicast mode unicast
```

b) Configure the controller to use the multicast method to send multicast packets to a CAPWAP multicast group by entering this command:
```
config network multicast mode multicast multicast_group_ip_address
```

**Step 3** Enable or disable IGMP snooping by entering this command:
```
config network multicast igmp snooping {enable | disable}
```
The default value is disabled.

**Step 4** Set the IGMP timeout value by entering this command:
```
config network multicast igmp timeout timeout
```
You can enter a `timeout` value between 30 and 7200 seconds. The controller sends three queries in one timeout value at an interval of `timeout/3` to see if any clients exist for a particular multicast group. If the controller does not receive a response through an IGMP report from the client, the controller times out the client entry from the MGID table. When no clients are left for a particular multicast group, the controller waits for the IGMP timeout value to expire and then deletes the MGID entry from the controller. The controller always generates a general IGMP query (that is, to destination address 224.0.0.1) and sends it on all WLANs with an MGID value of 1.

**Step 5** Enable or disable Layer 2 Multicast by entering this command:
```
config network multicast l2mcast {enable {all | interface-name} | disable}
```

**Step 6** Enable or disable MLD snooping by entering this command:
```
config network multicast mldsnooping {enable | disable}
```
The default value is disabled.

**Note** To enable MLD snooping, you must enable global multicast mode of the controller.

**Step 7** Set the MLD timeout value by entering this command:
config network multicast mld timeout \textit{timeout}

Enter the MLD Query Interval (seconds). The valid range is between 15 and 2400 seconds.

\textbf{Step 8} Save your changes by entering this command:

\texttt{save config}

---

**Viewing Multicast Groups (GUI)**

\textbf{Step 1} Choose Monitor > Multicast. The Multicast Groups page appears. This page shows all the multicast groups and their corresponding MGIDs.

\textbf{Step 2} Click the link for a specific MGID (such as MGID 550) to see a list of all the clients joined to the multicast group in that particular MGID.

---

**Viewing Multicast Groups (CLI)**

\textbf{Before You Begin}

- See all the multicast groups and their corresponding MGIDs by entering this command:

  \texttt{show network multicast mgid summary}

  Information similar to the following appears:

  \begin{verbatim}
  Layer2 MGID Mapping:
  ----------------------
  InterfaceName vlanId MGID
  management 0 0
  test 0 9
  wired 20 8
  
  Layer3 MGID Mapping:
  ----------------------
  Number of Layer3 MGIDs...................... 1
  
  Group address Vlan MGID
  ---------------------- ---- ----
  239.255.255.250 0 550
  \end{verbatim}

- See all the clients joined to the multicast group in a specific MGID by entering this command:

  \texttt{show network multicast mgid detail mgid\_value}

  where the \textit{mgid\_value} parameter is a number between 550 and 4095.

  Information similar to the following appears:

  \begin{verbatim}
  Mgid........................................ 550
  Multicast Group Address.................... 239.255.255.250
  \end{verbatim}
Viewing an Access Point’s Multicast Client Table (CLI)

To help troubleshoot roaming events, you can view an access point’s multicast client table from the controller by performing a remote debug of the access point.

Step 1
Initiate a remote debug of the access point by entering this command:
```
devap enable Cisco_AP
```

Step 2
See all of the MGIDs on the access point and the number of clients per WLAN by entering this command:
```
devap command "show capwap mcast mgid all" Cisco_AP
```

Step 3
See all of the clients per MGID on the access point and the number of clients per WLAN by entering this command:
```
devap command "show capwap mcast mgid id mgid_value" Cisco_AP
```

Configuring Client Roaming

Information About Client Roaming

The Cisco UWN solution supports seamless client roaming across lightweight access points managed by the same controller, between controllers in the same mobility group on the same subnet, and across controllers in the same mobility group on different subnets. Also, in controller software release 4.1 or later releases, client roaming with multicast packets is supported.

You can adjust the default RF settings (RSSI, hysteresis, scan threshold, and transition time) to fine-tune the operation of client roaming using the controller GUI or CLI.

Inter-Controller Roaming

Multiple-controller deployments support client roaming across access points managed by controllers in the same mobility group and on the same subnet. This roaming is also transparent to the client because the session is sustained and a tunnel between controllers allows the client to continue using the same DHCP- or client-assigned IP address as long as the session remains active. The tunnel is torn down, and the client must reauthenticate when the client sends a DHCP Discover with a 0.0.0.0 client IP address or a 169.254.*.* client auto-IP address or when the operator-set session timeout is exceeded.
Intra-Controller Roaming

Each controller supports same-controller client roaming across access points managed by the same controller. This roaming is transparent to the client as the session is sustained, and the client continues using the same DHCP-assigned or client-assigned IP address. The controller provides DHCP functionality with a relay function. Same-controller roaming is supported in single-controller deployments and in multiple-controller deployments.

Inter-Subnet Roaming

Multiple-controller deployments support client roaming across access points managed by controllers in the same mobility group on different subnets. This roaming is transparent to the client because the session is sustained and a tunnel between the controllers allows the client to continue using the same DHCP-assigned or client-assigned IP address as long as the session remains active. The tunnel is torn down, and the client must reauthenticate when the client sends a DHCP Discover with a 0.0.0.0 client IP address or a 169.254.*.* client auto-IP address or when the operator-set user timeout is exceeded.

Voice-over-IP Telephone Roaming

802.11 voice-over-IP (VoIP) telephones actively seek out associations with the strongest RF signal to ensure the best quality of service (QoS) and the maximum throughput. The minimum VoIP telephone requirement of 20-millisecond or shorter latency time for the roaming handover is easily met by the Cisco Wireless solution, which has an average handover latency of 5 or fewer milliseconds when open authentication is used. This short latency period is controlled by controllers rather than allowing independent access points to negotiate roaming handovers.

The Cisco Wireless solution supports 802.11 VoIP telephone roaming across lightweight access points managed by controllers on different subnets, as long as the controllers are in the same mobility group. This roaming is transparent to the VoIP telephone because the session is sustained and a tunnel between controllers allows the VoIP telephone to continue using the same DHCP-assigned IP address as long as the session remains active. The tunnel is torn down, and the VoIP client must reauthenticate when the VoIP telephone sends a DHCP Discover with a 0.0.0.0 VoIP telephone IP address or a 169.254.*.* VoIP telephone auto-IP address or when the operator-set user timeout is exceeded.

CCX Layer 2 Client Roaming

The controller supports five CCX Layer 2 client roaming enhancements:

- Access point assisted roaming—This feature helps clients save scanning time. When a CCXv2 client associates to an access point, it sends an information packet to the new access point listing the characteristics of its previous access point. Roaming time decreases when the client recognizes and uses an access point list built by compiling all previous access points to which each client was associated and sent (unicast) to the client immediately after association. The access point list contains the channels, BSSIDs of neighbor access points that support the client’s current SSID(s), and time elapsed since disassociation.

- Enhanced neighbor list—This feature focuses on improving a CCXv4 client’s roam experience and network edge performance, especially when servicing voice applications. The access point provides its associated client information about its neighbors using a neighbor-list update unicast message.
• Enhanced neighbor list request (E2E)—The End-2-End specification is a Cisco and Intel joint program that defines new protocols and interfaces to improve the overall voice and roaming experience. It applies only to Intel clients in a CCX environment. Specifically, it enables Intel clients to request a neighbor list at will. When this occurs, the access point forwards the request to the controller. The controller receives the request and replies with the current CCX roaming sublist of neighbors for the access point to which the client is associated.

Note To see whether a particular client supports E2E, choose Wireless > Clients on the controller GUI, click the Detail link for the desired client, and look at the E2E Version text box in the Client Properties area.

• Roam reason report—This feature enables CCXv4 clients to report the reason why they roamed to a new access point. It also allows network administrators to build and monitor a roam history.

• Directed roam request—This feature enables the controller to send directed roam requests to the client in situations when the controller can better service the client on an access point different from the one to which it is associated. In this case, the controller sends the client a list of the best access points that it can join. The client can either honor or ignore the directed roam request. Non-CCX clients and clients running CCXv3 or below must not take any action. No configuration is required for this feature.

Restrictions on Client Roaming

• Controller software release 4.2 or later releases support CCX versions 1 through 5. CCX support is enabled automatically for every WLAN on the controller and cannot be disabled. The controller stores the CCX version of the client in its client database and uses it to generate and respond to CCX frames appropriately. Clients must support CCXv4 or v5 (or CCXv2 for access point assisted roaming) in order to utilize these roaming enhancements.

The roaming enhancements mentioned above are enabled automatically, with the appropriate CCX support.

• FlexConnect access points in standalone mode do not support CCX Layer 2 roaming.

• Client roaming between 600 Series Access points is not supported.

• Seamless L2 and L3 roaming is not supported between a Cisco and a third-party wireless infrastructure, which also includes a Cisco IOS access point.
Configuring CCX Client Roaming Parameters

Configuring CCX Client Roaming Parameters (GUI)

Step 1 Choose Wireless > 802.11a/n or 802.11b/g/n > Client Roaming. The 802.11a (802.11b) > Client Roaming page appears.

Step 2 If you want to fine-tune the RF parameters that affect client roaming, choose Custom from the Mode drop-down list and go to Step 3. If you want to leave the RF parameters at their default values, choose Default and go to Step 8.

Step 3 In the Minimum RSSI text box, enter a value for the minimum received signal strength indicator (RSSI) required for the client to associate to an access point. If the client’s average received signal power dips below this threshold, reliable communication is usually impossible. Therefore, clients must already have found and roamed to another access point with a stronger signal before the minimum RSSI value is reached.

The range is −90 to −50 dBm.

The default is −85 dBm.

Step 4 In the Hysteresis text box, enter a value to indicate how much greater the signal strength of a neighboring access point must be in order for the client to roam to it. This parameter is intended to reduce the amount of roaming between access points if the client is physically located on or near the border between two access points.

The range is 3 to 20 dB.

The default is 3 dB.

Step 5 In the Scan Threshold text box, enter the minimum RSSI that is allowed before the client should roam to a better access point. When the RSSI drops below the specified value, the client must be able to roam to a better access point within the specified transition time. This parameter also provides a power-save method to minimize the time that the client spends in active or passive scanning. For example, the client can scan slowly when the RSSI is above the threshold and scan more rapidly when the RSSI is below the threshold.

The range is −90 to −50 dBm.

The default is −72 dBm.

Step 6 In the Transition Time text box, enter the maximum time allowed for the client to detect a suitable neighboring access point to roam to and to complete the roam, whenever the RSSI from the client’s associated access point is below the scan threshold.

The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming performance. Together with the highest expected client speed and roaming hysteresis, these parameters make it possible to design a wireless LAN network that supports roaming simply by ensuring a certain minimum overlap distance between access points.

The range is 1 to 5 seconds.

The default is 5 seconds.

Step 7 Click Apply.

Step 8 Click Save Configuration.

Step 9 Repeat this procedure if you want to configure client roaming for another radio band.
**Configuring CCX Client Roaming Parameters (CLI)**

Configure CCX Layer 2 client roaming parameters by entering this command:

```
config {802.11a | 802.11b} l2roam rf-params {default | custom min_rssi roam_hyst scan_thresh trans_time}
```

**Obtaining CCX Client Roaming Information (CLI)**

**Step 1**
View the current RF parameters configured for client roaming for the 802.11a or 802.11b/g network by entering this command:

```
show {802.11a | 802.11b} l2roam rf-param
```

**Step 2**
View the CCX Layer 2 client roaming statistics for a particular access point by entering this command:

```
show {802.11a | 802.11b} l2roam statistics ap_mac
```

This command provides the following information:
- The number of roam reason reports received
- The number of neighbor list requests received
- The number of neighbor list reports sent
- The number of broadcast neighbor updates sent

**Step 3**
View the roaming history for a particular client by entering this command:

```
show client roam-history client_mac
```

This command provides the following information:
- The time when the report was received
- The MAC address of the access point to which the client is currently associated
- The MAC address of the access point to which the client was previously associated
- The channel of the access point to which the client was previously associated
- The SSID of the access point to which the client was previously associated
- The time when the client disassociated from the previous access point
- The reason for the client roam

**Debugging CCX Client Roaming Issues (CLI)**

If you experience any problems with CCX Layer 2 client roaming, enter this command:

```
debug l2roam [detail | error | packet | all] {enable | disable}
```
Configuring IP-MAC Address Binding

Information About Configuring IP-MAC Address Binding

In the controller software Release 5.2 or later releases, the controller enforces strict IP address-to-MAC address binding in client packets. The controller checks the IP address and MAC address in a packet, compares them to the addresses that are registered with the controller, and forwards the packet only if they both match. In previous releases, the controller checks only the MAC address of the client and ignores the IP address.

You must disable IP-MAC address binding to use an access point in sniffer mode if the access point is associated with a 5500 series controller, a 2500 series controller, or a controller network module. To disable IP-MAC address binding, enter the `config network ip-mac-binding disable`.

WLAN must be enabled to use an access point in sniffer mode if the access point is associated with a 5500 series controller, a 2500 series controller, or a controller network module. If WLAN is disabled, the access point cannot send packets.

Note

If the IP address or MAC address of the packet has been spoofed, the check does not pass, and the controller discards the packet. Spoofed packets can pass through the controller only if both the IP and MAC addresses are spoofed together and changed to that of another valid client on the same controller.

Configuring IP-MAC Address Binding

Configuring IP-MAC Address Binding (CLI)

Step 1

Enable or disable IP-MAC address binding by entering this command:

```
config network ip-mac-binding {enable | disable}
```

The default value is enabled.

Note

You might want to disable this binding check if you have a routed network behind a workgroup bridge (WGB).

Note

You must disable this binding check in order to use an access point in sniffer mode if the access point is joined to a Cisco 5500 Series Controller.

Step 2

Save your changes by entering this command:

```
save config
```

Step 3

View the status of IP-MAC address binding by entering this command:

```
show network summary
```

Information similar to the following appears:

```
RF-Network Name............................. ctrl4404
Web Mode.................................... Disable
Secure Web Mode............................ Enable
```
Secure Web Mode Cipher-Option High............ Disable
Secure Web Mode Cipher-Option SSLv2......... Disable

IP/MAC Addr Binding Check .................... Enabled

Configuring Quality of Service

Information About Quality of Service

Quality of service (QoS) refers to the capability of a network to provide better service to selected network traffic over various technologies. The primary goal of QoS is to provide priority including dedicated bandwidth, controlled jitter and latency (required by some real-time and interactive traffic), and improved loss characteristics.

The controller supports four QoS levels:

• Platinum/Voice—Ensures a high quality of service for voice over wireless.
• Gold/Video—Supports high-quality video applications.
• Silver/Best Effort—Supports normal bandwidth for clients. This is the default setting.
• Bronze/Background—Provides the lowest bandwidth for guest services.

Note
VoIP clients should be set to Platinum.

You can configure the bandwidth of each QoS level using QoS profiles and then apply the profiles to WLANs. The profile settings are pushed to the clients associated to that WLAN. In addition, you can create QoS roles to specify different bandwidth levels for regular and guest users. Follow the instructions in this section to configure QoS profiles and QoS roles. You can also define the maximum and default QoS levels for unicast and multicast traffic when you assign a QoS profile to a WLAN.

The wireless rate limits can be defined on both upstream and downstream traffic. Rate limits can be defined per SSID and/or specified as a maximum rate limit for all clients. These rate limits can be individually configured.

Configuring Quality of Service Profiles

You can configure the Platinum, Gold, Silver, and Bronze QoS profiles.
Configuring QoS Profiles (GUI)

Step 1 Disable the 802.11a and 802.11b/g networks so that you can configure the QoS profiles. To disable the radio networks, choose Wireless > 802.11a/n or 802.11b/g/n > Network, unselect the 802.11a (or 802.11b/g) Network Status check box, and click Apply.

Step 2 Choose Wireless > QoS > Profiles to open the QoS Profiles page.

Step 3 Click the name of the profile that you want to configure to open the Edit QoS Profile page.

Step 4 Change the description of the profile by modifying the contents of the Description text box.

Step 5 Define the data rates on a per-user basis as follows:

a) Define the average data rate for TCP traffic per user by entering the rate in Kbps in the Average Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

b) Define the peak data rate for TCP traffic per user by entering the rate in Kbps in the Burst Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

Note The burst data rate should be greater than or equal to the average data rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

Ensure that you configure the average data rate before you configure the burst data rate.

c) Define the average real-time rate for UDP traffic per user by entering the rate in Kbps in the Average Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

Note Average Data Rate is used to measure TCP traffic while Average real-time rate is used for UDP traffic. They are measured in kbps for all the entries. The values for Average Data Rate and Average real-time rate can be different because they are applied to different upper layer protocols such as TCP and UDP. These different values for the rates do not impact the bandwidth.

d) Define the peak real-time rate for UDP traffic per user by entering the rate in Kbps in the Burst Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

Note The burst real-time rate should be greater than or equal to the average real-time rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

Step 6 Define the data rates on a per-SSID basis as follows:

a) Define the average data rate TCP traffic per SSID by entering the rate in Kbps in the Average Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

b) Define the peak data rate for TCP traffic per SSID by entering the rate in Kbps in the Burst Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

Note The burst data rate should be greater than or equal to the average data rate. Otherwise, the QoS policy may block traffic in the WLANs.

c) Define the average real-time rate for UDP traffic per SSID by entering the rate in Kbps in the Average Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

d) Define the peak real-time rate for UDP traffic per SSID by entering the rate in Kbps in the Burst Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

Note The burst real-time rate should be greater than or equal to the average real-time rate. Otherwise, the QoS policy may block traffic in the WLANs.

Step 7 Define the maximum and default QoS levels for unicast and multicast traffic when you assign a QoS profile to a WLAN.

a) From the Maximum Priority drop-down list, choose the maximum QoS priority for any data frames transmitted by the AP to any station in the WLAN.
For example, a QoS profile named ‘gold’ targeted for video applications has the maximum priority set to video by default.

b) From the Unicast Default Priority drop-down list, choose the QoS priority for unicast data frames transmitted by the AP to non-WMM stations in the WLAN

c) From the Multicast Default Priority drop-down list, choose the QoS priority for multicast data frames transmitted by the AP to stations in the WLAN,

Note The default unicast priority cannot be used for non-WMM clients in a mixed WLAN.

Step 8 Choose 802.1p from the Protocol Type drop-down list and enter the maximum priority value in the 802.1p Tag text box to define the maximum value (0–7) for the priority tag associated with packets that fall within the profile.

The tagged packets include CAPWAP data packets (between access points and the controller) and packets sent toward the core network.

Note If a QoS profile has 802.1p tagging configured and if this QoS profile is assigned to a WLAN that uses an untagged interface on the controller, the client traffic will be blocked.

Step 9 Click Apply.

Step 10 Click Save Configuration.

Step 11 Reenable the 802.11 networks.

To enable the radio networks, choose Wireless > 802.11a/n or 802.11b/g/n > Network, select the 802.11a (or 802.11b/g) Network Status check box, and click Apply.

Step 12 Choose WLANs and select a WLAN ID to apply the new QoS profile to it.

Step 13 In the WLAN > Edit page, go to the QoS tab and select the QoS Profile type from the Quality of Service drop-down list. The QoS profile will add the rate limit values configured on the controller on per WLAN, per radio and per AP basis. For example, if upstream rate limit of 5Mbps is configured for a QoS profile of type silver, then every WLAN that has silver profile will limit traffic to 5Mbps (5Mbps for each wlan) on each radio and on each AP where the WLAN is applicable.

Step 14 Click Apply.

Step 15 Click Save Configuration.

---

**Configuring QoS Profiles (CLI)**

**Step 1** Disable the 802.11a and 802.11b/g networks so that you can configure the QoS profiles by entering these commands:

```
config 802.11 {a | b} disable network
```

**Step 2** Change the profile description by entering this command:

```
config qos description {bronze | silver | gold | platinum} description
```

**Step 3** Define the average data rate for TCP traffic per user or per SSID by entering this command:

```
config qos average-data-rate {bronze | silver | gold | platinum} {per-ssid | per-client} {downstream | upstream} rate
```

Note For the rate parameter, you can enter a value between 0 and 512,000 Kbps (inclusive). A value of 0 imposes no bandwidth restriction on the QoS profile.
Step 4 Define the peak data rate for TCP traffic per user or per SSID by entering this command:
`config qos burst-data-rate {bronze | silver | gold | platinum} {per-ssid | per-client} {downstream | upstream} rate`

Step 5 Define the average real-time data rate for UDP traffic per user or per SSID by entering this command:
`config qos average-realtime-rate {bronze | silver | gold | platinum} {per-ssid | per-client} {downstream | upstream} rate`

Step 6 Define the peak real-time data rate for UDP traffic per user or per SSID by entering this command:
`config qos burst-realtime-rate {bronze | silver | gold | platinum} {per-ssid | per-client} {downstream | upstream} rate`

Step 7 Define the maximum and default QoS levels for unicast and multicast traffic when you assign a QoS profile to a WLAN by entering this command:
`config qos priority {bronze | gold | platinum | silver} {maximum priority} {default unicast priority} {default multicast priority}`

You choose from the following options for the maximum priority, default unicast priority, and default multicast priority parameters:
- `besteffort`
- `background`
- `video`
- `voice`

Step 8 Define the maximum value (0–7) for the priority tag associated with packets that fall within the profile, by entering these commands:
`config qos protocol-type {bronze | silver | gold | platinum} dot1p`
`config qos dot1p-tag {bronze | silver | gold | platinum} tag`

The tagged packets include CAPWAP data packets (between access points and the controller) and packets sent toward the core network.

**Note** The 802.1p tagging has impact only on wired packets. Wireless packets are impacted only by the maximum priority level set for a QoS profile.

**Note** If a QoS profile has 802.1p tagging configured and if this QoS profile is assigned to a WLAN that uses an untagged interface on the controller, the client traffic will be blocked.

Step 9 Reenable the 802.11a and 802.11b/g networks so that you can configure the QoS profiles by entering these commands:
`config 802.11 {a | b} enable network`

Step 10 Apply the new QoS profile to a WLAN, by entering these commands:
`config wlan qos <WLAN ID> {bronze | silver | gold | platinum}`
Configuring Quality of Service Roles

Information About Quality of Service Roles

After you configure a QoS profile and apply it to a WLAN, it limits the bandwidth level of clients associated to that WLAN. Multiple WLANs can be mapped to the same QoS profile, which can result in bandwidth contention between regular users (such as employees) and guest users. In order to prevent guest users from using the same level of bandwidth as regular users, you can create QoS roles with different (and presumably lower) bandwidth contracts and assign them to guest users.

You can configure up to ten QoS roles for guest users.

Note
If you choose to create an entry on the RADIUS server for a guest user and enable RADIUS authentication for the WLAN on which web authentication is performed rather than adding a guest user to the local user database from the controller, you need to assign the QoS role on the RADIUS server itself. To do so, a "guest-role" Airespace attribute needs to be added on the RADIUS server with a datatype of "string" and a return value of "$11." This attribute is sent to the controller when authentication occurs. If a role with the name returned from the RADIUS server is found configured on the controller, the bandwidth associated to that role is enforced for the guest user after authentication completes successfully.

Configuring QoS Roles

Configuring QoS (GUI)

Step 1
Choose Wireless > QoS > Roles to open the QoS Roles for the Guest Users page. This page shows any existing QoS roles for guest users.

Note
If you want to delete a QoS role, hover your cursor over the blue drop-down arrow for that role and choose Remove.

Step 2
Click New to create a new QoS role. The QoS Role Name > New page appears.

Step 3
In the Role Name text box, enter a name for the new QoS role. The name should uniquely identify the role of the QoS user (such as Contractor, Vendor, and so on).

Step 4
Click Apply.

Step 5
Click the name of the QoS role to edit the bandwidth of a QoS role. The Edit QoS Role Data Rates page appears.

Note
The values that you configure for the per-user bandwidth contracts affect only the amount of bandwidth going downstream (from the access point to the wireless client). They do not affect the bandwidth for upstream traffic (from the client to the access point).

Note
The Access Points that support per-user bandwidth contracts for upstream (from the client to the access point) are - AP1140, AP1040, AP3500, AP3600, AP1250, and AP1260.
Step 6  Define the average data rate for TCP traffic on a per-user basis by entering the rate in Kbps in the Average Data Rate textbox. You can enter a value between 0 and 60,000 Kbps (inclusive). A value of 0 imposes no bandwidth restriction on the QoS role.

Step 7  Define the peak data rate for TCP traffic on a per-user basis by entering the rate in Kbps in the Burst Data Rate text box. You can enter a value between 0 and 60,000 Kbps (inclusive). A value of 0 imposes no bandwidth restriction on the QoS role.

**Note**  The burst data rate should be greater than or equal to the average data rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

Ensure that you configure the average data rate before you configure the burst data rate.

Step 8  Define the average real-time rate for UDP traffic on a per-user basis by entering the rate in Kbps in the Average Real-Time Rate text box. You can enter a value between 0 and 60,000 Kbps (inclusive). A value of 0 imposes no bandwidth restriction on the QoS role.

Step 9  Define the peak real-time rate for UDP traffic on a per-user basis by entering the rate in Kbps in the Burst Real-Time Rate text box. You can enter a value between 0 and 60,000 Kbps (inclusive). A value of 0 imposes no bandwidth restriction on the QoS role.

**Note**  The burst real-time rate should be greater than or equal to the average real-time rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

Step 10  Click Apply.

Step 11  Click Save Configuration.

Step 12  Apply a QoS role to a guest user by following the instructions in the Configuring Local Network Users for the Controller (GUI) section.

---

### Configuring QoS Roles (CLI)

**Step 1**  Create a QoS role for a guest user by entering this command:

```bash
config netuser guest-role create role_name
```

**Note**  If you want to delete a QoS role, enter the `config netuser guest-role delete role_name` command.

**Step 2**  Configure the bandwidth contracts for a QoS role by entering these commands:

- ```bash
  config netuser guest-role qos data-rate average-data-rate role_name rate
  ```
  Configures the average data rate for TCP traffic on a per-user basis.

- ```bash
  config netuser guest-role qos data-rate burst-data-rate role_name rate
  ```
  Configures the peak data rate for TCP traffic on a per-user basis.

  **Note**  The burst data rate should be greater than or equal to the average data rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

- ```bash
  config netuser guest-role qos data-rate average-realtime-rate role_name rate
  ```
  Configures the average real-time rate for UDP traffic on a per-user basis.

- ```bash
  config netuser guest-role qos data-rate burst-realtime-rate role_name rate
  ```
  Configures the peak real-time rate for UDP traffic on a per-user basis.
The burst real-time rate should be greater than or equal to the average real-time rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

Note For the role_name parameter in each of these commands, enter a name for the new QoS role. The name should uniquely identify the role of the QoS user (such as Contractor, Vendor, and so on). For the rate parameter, you can enter a value between 0 and 60,000 Kbps (inclusive). A value of 0 imposes no bandwidth restriction on the QoS role.

Step 3 Apply a QoS role to a guest user by entering this command:
\[ \text{config netuser guest-role apply username role_name} \]
For example, the role of Contractor could be applied to guest user jsmith.

Note If you do not assign a QoS role to a guest user, the Role text box in the User Details shows the role as “default.” The bandwidth contracts for this user are defined in the QoS profile for the WLAN.

Note If you want to unassign a QoS role from a guest user, enter the \[ \text{config netuser guest-role apply username default} \] command. This user now uses the bandwidth contracts defined in the QoS profile for the WLAN.

Step 4 Save your changes by entering this command:
\[ \text{save config} \]

Step 5 See a list of the current QoS roles and their bandwidth parameters by entering this command:
\[ \text{show netuser guest-roles} \]
Information similar to the following appears:

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Average Data Rate</th>
<th>Burst Data Rate</th>
<th>Average Realtime Rate</th>
<th>Burst Realtime Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contractor</td>
<td>10</td>
<td>10</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Vendor</td>
<td>unconfigured</td>
<td>unconfigured</td>
<td>unconfigured</td>
<td>unconfigured</td>
</tr>
</tbody>
</table>

Configuring Voice and Video Parameters

Information About Configuring Voice and Video Parameters

Three parameters on the controller affect voice and/or video quality:

- Call admission control
- Expedited bandwidth requests
- Unscheduled automatic power save delivery

Each of these parameters is supported in Cisco Compatible Extensions (CCX) v4 and v5.
Traffic stream metrics (TSM) can be used to monitor and report issues with voice quality.

**Call Admission Control**

Call admission control (CAC) enables an access point to maintain controlled quality of service (QoS) when the wireless LAN is experiencing congestion. The Wi-Fi Multimedia (WMM) protocol deployed in CCXv3 ensures sufficient QoS as long as the wireless LAN is not congested. However, in order to maintain QoS under differing network loads, CAC in CCXv4 is required. Two types of CAC are available: bandwidth-based CAC and load-based CAC.

**Note**

CAC is not supported in Flexconnect local auth, resulting in voice traffic not getting properly tagged.

**Bandwidth-Based CAC**

Bandwidth-based, or static, CAC enables the client to specify how much bandwidth or shared medium time is required to accept a new call and in turn enables the access point to determine whether it is capable of accommodating this particular call. The access point rejects the call if necessary in order to maintain the maximum allowed number of calls with acceptable quality.

The QoS setting for a WLAN determines the level of bandwidth-based CAC support. To use bandwidth-based CAC with voice applications, the WLAN must be configured for Platinum QoS. To use bandwidth-based CAC with video applications, the WLAN must be configured for Gold QoS. Also, make sure that WMM is enabled for the WLAN. See the Information About Configuring 802.3 Bridging, on page 131 section for QoS and WMM configuration instructions.

**Note**

You must enable admission control (ACM) for CCXv4 clients that have WMM enabled. Otherwise, bandwidth-based CAC does not operate properly.

**Load-Based CAC**

Load-based CAC incorporates a measurement scheme that takes into account the bandwidth consumed by all traffic types (including that from clients), co-channel access point loads, and collocated channel interference, for voice applications. Load-based CAC also covers the additional bandwidth consumption resulting from PHY and channel impairment.

In load-based CAC, the access point continuously measures and updates the utilization of the RF channel (that is, the percentage of bandwidth that has been exhausted), channel interference, and the additional calls that the access point can admit. The access point admits a new call only if the channel has enough unused bandwidth to support that call. By doing so, load-based CAC prevents oversubscription of the channel and maintains QoS under all conditions of WLAN loading and interference.
Load-based CAC is supported only on lightweight access points. If you disable load-based CAC, the access points start using bandwidth-based CAC.

**Expedited Bandwidth Requests**

The expedited bandwidth request feature enables CCXv5 clients to indicate the urgency of a WMM traffic specifications (TSPEC) request (for example, an e911 call) to the WLAN. When the controller receives this request, it attempts to facilitate the urgency of the call in any way possible without potentially altering the quality of other TSPEC calls that are in progress.

You can apply expedited bandwidth requests to both bandwidth-based and load-based CAC. Expedited bandwidth requests are disabled by default. When this feature is disabled, the controller ignores all expedited requests and processes TSPEC requests as normal TSPEC requests.

This table lists examples of TSPEC request handling for normal TSPEC requests and expedited bandwidth requests.

**Table 5: TSPEC Request Handling Examples**

<table>
<thead>
<tr>
<th>CAC Mode</th>
<th>Reserved bandwidth for voice calls</th>
<th>Usage</th>
<th>Normal TSPEC Request</th>
<th>TSPEC with Expedited Bandwidth Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth-based CAC</td>
<td>75% (default setting)</td>
<td>Less than 75%</td>
<td>Admitted</td>
<td>Admitted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Between 75% and 90% (reserved bandwidth for voice calls exhausted)</td>
<td>Rejected</td>
<td>Admitted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>More than 90%</td>
<td>Rejected</td>
<td>Rejected</td>
</tr>
<tr>
<td>Load-based CAC</td>
<td>Less than 75%</td>
<td>Admitted</td>
<td>Admitted</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Between 75% and 85% (reserved bandwidth for voice calls exhausted)</td>
<td>Rejected</td>
<td>Admitted</td>
<td></td>
</tr>
<tr>
<td></td>
<td>More than 85%</td>
<td>Rejected</td>
<td>Rejected</td>
<td></td>
</tr>
</tbody>
</table>

1 For bandwidth-based CAC, the voice call bandwidth usage is per access point and does not take into account co-channel access points. For load-based CAC, the voice call bandwidth usage is measured for the entire channel.

2 Bandwidth-based CAC (consumed voice and video bandwidth) or load-based CAC (channel utilization [Pb]).

**Note** Admission control for TSPEC g711-40ms codec type is supported.
When video ACM is enabled, the controller rejects a video TSPEC if the non-MSDU size in the TSPEC is greater than 149 or the mean data rate is greater than 1 Kbps.

**U-APSD**

 Unscheduled automatic power saved delivery (U-APSD) is a QoS facility defined in IEEE 802.11e that extends the battery life of mobile clients. In addition to extending battery life, this feature reduces the latency of traffic flow delivered over the wireless media. Because U-APSD does not require the client to poll each individual packet buffered at the access point, it allows delivery of multiple downlink packets by sending a single uplink trigger packet. U-APSD is enabled automatically when WMM is enabled.

**Traffic Stream Metrics**

 In a voice-over-wireless LAN (VoWLAN) deployment, traffic stream metrics (TSM) can be used to monitor voice-related metrics on the client-access point air interface. It reports both packet latency and packet loss. You can isolate poor voice quality issues by studying these reports.

 The metrics consist of a collection of uplink (client side) and downlink (access point side) statistics between an access point and a client device that supports CCX v4 or later releases. If the client is not CCX v4 or CCXv5 compliant, only downlink statistics are captured. The client and access point measure these metrics. The access point also collects the measurements every 5 seconds, prepares 90-second reports, and then sends the reports to the controller. The controller organizes the uplink measurements on a client basis and the downlink measurements on an access point basis and maintains an hour’s worth of historical data. To store this data, the controller requires 32 MB of additional memory for uplink metrics and 4.8 MB for downlink metrics. TSM can be configured through either the GUI or the CLI on a per radio-band basis (for example, all 802.11a radios). The controller saves the configuration in flash memory so that it persists across reboots. After an access point receives the configuration from the controller, it enables TSM on the specified radio band.

**Note**

Access points support TSM entries in both local and FlexConnect modes.

This table shows the upper limit for TSM entries in different controller series.

<table>
<thead>
<tr>
<th>TSM Entries</th>
<th>5500</th>
<th>7500</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAX AP TSM entries</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>MAX Client TSM entries</td>
<td>250</td>
<td>250</td>
</tr>
<tr>
<td>MAX TSM entries</td>
<td>100*250=25000</td>
<td>100*250=25000</td>
</tr>
</tbody>
</table>
Once the upper limit is reached, additional TSM entries cannot be stored and sent to Cisco Prime Infrastructure. If client TSM entries are full and AP TSM entries are available, then only the AP entries are stored, and vice versa. This leads to partial output. TSM cleanup occurs every one hour. Entries are removed only for those APs and clients that are not in the system.

### Configuring Voice Parameters (GUI)

**Step 1**  
Ensure that the WLAN is configured for WMM and the Platinum QoS level.

**Step 2**  
Disable all WLANs with WMM enabled and click **Apply**.

**Step 3**  
Choose **Wireless** and then **Network** under 802.11a/n or 802.11b/g/n, unselect the 802.11a (or 802.11b/g) Network Status check box, and click **Apply** to disable the radio network.

**Step 4**  
Choose **Wireless > 802.11a/n or 802.11b/g/n > Media**. The 802.11a (or 802.11b) > Media page appears. The Voice tab is displayed by default.

**Step 5**  
Select the **Admission Control (ACM)** check box to enable bandwidth-based CAC for this radio band. The default value is disabled.

**Step 6**  
Select the **Admission Control (ACM)** you want to use by choosing from the following choices:

- **Load-based**—To enable channel-based CAC. This is the default option.
- **Static**—To enable radio-based CAC.

**Step 7**  
In the **Max RF Bandwidth** text box, enter the percentage of the maximum bandwidth allocated to clients for voice applications on this radio band. Once the client reaches the value specified, the access point rejects new calls on this radio band.

The range is 5% to 85%. The sum of maximum bandwidth percentage of voice and video should not exceed 85%.

The default is 75%.

**Step 8**  
In the **Reserved Roaming Bandwidth** text box, enter the percentage of maximum allocated bandwidth that is reserved for roaming voice clients. The controller reserves this bandwidth from the maximum allocated bandwidth for roaming voice clients.

The range is 0% to 25%.

The default is 6%.

**Step 9**  
To enable expedited bandwidth requests, select the **Expedited Bandwidth** check box. By default, this text box is disabled.

**Step 10**  
To enable SIP CAC support, select the **SIP CAC Support** check box. By default, SIP CAC support is disabled.

**Step 11**  
From the **SIP Codec** drop-down list, choose one of the following options to set the codec name. The default value is G.711. The options are as follows:

- User Defined
- G.711
- G.729

**Step 12**  
In the **SIP Bandwidth (kbps)** text box, enter the bandwidth in kilobits per second.
The possible range is 8 to 64.
The default value is 64.

**Note** The SIP Bandwidth (kbps) text box is highlighted only when you select the SIP codec as User-Defined. If you choose the SIP codec as G.711, the SIP Bandwidth (kbps) text box is set to 64. If you choose the SIP codec as G.729, the SIP Bandwidth (kbps) text box is set to 8.

**Step 13**
In the SIP Voice Sample Interval (msecs) text box, enter the value for the sample interval.

**Step 14**
In the Maximum Calls text box, enter the maximum number of calls that can be made to this radio. The maximum call limit includes both direct and roaming-in calls. If the maximum call limit is reached, the new or roaming-in calls result in failure.
The possible range is 0 to 25.
The default value is 0, which indicates that there is no check for maximum call limit.

**Note** If SIP CAC is supported and the CAC method is static, the Maximum Possible Voice Calls and Maximum Possible Roaming Reserved Calls fields appear.

**Step 15**
Select the Metrics Collection check box to collect traffic stream metrics. By default, this box is unselected. That is, the traffic stream metrics is not collected by default.

**Step 16**
Click Apply.

**Step 17**
Reenable all WMM WLANs and click Apply.

**Step 18**
Choose Network under 802.11a/n or 802.11b/g/n, select the 802.11a (or 802.11b/g) Network Status check box, and click Apply to reenable the radio network.

**Step 19**
Click Save Configuration.

**Step 20**
Repeat this procedure if you want to configure voice parameters for another radio band.

---

**Configuring Voice Parameters (CLI)**

**Before You Begin**
Ensure that you have configured SIP-based CAC.

**Step 1**
See all of the WLANs configured on the controller by entering this command:
```
show wlan summary
```

**Step 2**
Make sure that the WLAN that you are planning to modify is configured for WMM and the QoS level is set to Platinum by entering this command:
```
show wlan wlan_id
```

**Step 3**
Disable all WLANs with WMM enabled prior to changing the voice parameters by entering the command:
```
config wlan disable wlan_id
```

**Step 4**
Disable the radio network by entering this command:
```
config 802.11a | 802.11b disable network
```

**Step 5**
Save your settings by entering this command:
```
save config
```
Step 6  Enable or disable bandwidth-based voice CAC for the 802.11a or 802.11b/g network by entering this command:
```
config {802.11a | 802.11b} cac voice acm {enable | disable}
```

Step 7  Set the percentage of maximum bandwidth allocated to clients for voice applications on the 802.11a or 802.11b/g network by entering this command:
```
config {802.11a | 802.11b} cac voice max-bandwidth bandwidth
```

The bandwidth range is 5 to 85%, and the default value is 75%. Once the client reaches the value specified, the access point rejects new calls on this network.

Step 8  Set the percentage of maximum allocated bandwidth reserved for roaming voice clients by entering this command:
```
config {802.11a | 802.11b} cac voice roam-bandwidth bandwidth
```

The bandwidth range is 0 to 25%, and the default value is 6%. The controller reserves this much bandwidth from the maximum allocated bandwidth for roaming voice clients.

Step 9  Configure the codec name and sample interval as parameters and to calculate the required bandwidth per call by entering this command:
```
config {802.11a | 802.11b} cac voice sip codec {g711 | g729} sample-interval number_msecs
```

Step 10 Configure the bandwidth that is required per call by entering this command:
```
config {802.11a | 802.11b} cac voice sip bandwidth bandwidth_kbps sample-interval number_msecs
```

Step 11 Reenable all WLANs with WMM enabled by entering this command:
```
config wlan enable wlan_id
```

Step 12 Reenable the radio network by entering this command:
```
config {802.11a | 802.11b} enable network
```

Step 13 View the TSM voice metrics by entering this command:
```
show {802.11a | 802.11b} cu-metrics AP_Name
```

The command also displays the channel utilization metrics.

Step 14 Enter the `save config` command to save your settings.
## Configuring Video Parameters

### Configuring Video Parameters (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Ensure that the WLAN is configured for WMM and the Gold QoS level.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Disable all WLANs with WMM enabled and click Apply.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose Wireless and then Network under 802.11a/n or 802.11b/g/n, unselect the 802.11a (or 802.11b/g) Network Status check box, and click Apply to disable the radio network.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Choose Wireless &gt; 802.11a/n or 802.11b/g/n &gt; Media. The 802.11a (or 802.11b) &gt; Media page appears.</td>
</tr>
<tr>
<td>Step 5</td>
<td>In the Video tab, select the Admission Control (ACM) check box to enable video CAC for this radio band. The default value is disabled.</td>
</tr>
<tr>
<td>Step 6</td>
<td>From the CAC Method drop-down list, choose between Static and Load Based methods. The static CAC method is based on the radio and the load-based CAC method is based on the channel. <strong>Note</strong> For TSpec and SIP based CAC for video calls, only Static method is supported.</td>
</tr>
<tr>
<td>Step 7</td>
<td>In the Max RF Bandwidth text box, enter the percentage of the maximum bandwidth allocated to clients for video applications on this radio band. When the client reaches the value specified, the access point rejects new requests on this radio band. The range is 5% to 85%. The sum of maximum bandwidth percentage of voice and video should not exceed 85%. The default is 0%.</td>
</tr>
<tr>
<td>Step 8</td>
<td>In the Reserved Roaming Bandwidth text box, enter the percentage of the maximum RF bandwidth that is reserved for roaming clients for video.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Configure the SIP CAC Support by selecting or unselecting the SIP CAC Support check box. SIP CAC is supported only if SIP Snooping is enabled. <strong>Note</strong> You cannot enable SIP CAC if you have selected the Load Based CAC method.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Click Apply.</td>
</tr>
<tr>
<td>Step 11</td>
<td>Reenable all WMM WLANs and click Apply.</td>
</tr>
<tr>
<td>Step 12</td>
<td>Choose Network under 802.11a/n or 802.11b/g/n, select the 802.11a (or 802.11b/g) Network Status check box, and click Apply to reenable the radio network.</td>
</tr>
<tr>
<td>Step 13</td>
<td>Click Save Configuration.</td>
</tr>
<tr>
<td>Step 14</td>
<td>Repeat this procedure if you want to configure video parameters for another radio band.</td>
</tr>
</tbody>
</table>
Configuring Video Parameters (CLI)

**Before You Begin**
Ensure that you have configured SIP-based CAC.

---

**Step 1**
See all of the WLANs configured on the controller by entering this command:
```
show wlan summary
```

**Step 2**
Make sure that the WLAN that you are planning to modify is configured for WMM and the QoS level is set to Gold by entering this command:
```
show wlan wlan_id
```

**Step 3**
Disable all WLANs with WMM enabled prior to changing the video parameters by entering this command:
```
config wlan disable wlan_id
```

**Step 4**
Disable the radio network by entering this command:
```
config {802.11a | 802.11b} disable network
```

**Step 5**
Save your settings by entering this command:
```
save config
```

**Step 6**
Enable or disable video CAC for the 802.11a or 802.11b/g network by entering this command:
```
config {802.11a | 802.11b} cac video acm {enable | disable}
```

**Step 7**
To configure the CAC method as either static or load-based, enter this command:
```
config {802.11a | 802.11b} cac video cac-method {static | load-based}
```

**Step 8**
Set the percentage of maximum bandwidth allocated to clients for video applications on the 802.11a or 802.11b/g network by entering this command:
```
config {802.11a | 802.11b} cac video max-bandwidth bandwidth
```

The `bandwidth` range is 5 to 85%, and the default value is 5%. However, the maximum RF bandwidth cannot exceed 85% for voice and video. Once the client reaches the value specified, the access point rejects new calls on this network.

**Note**
If this parameter is set to zero (0), the controller assumes that you do not want to do any bandwidth allocation and, therefore, allows all bandwidth requests.

**Step 9**
To configure the percentage of the maximum RF bandwidth that is reserved for roaming clients for video, enter this command:
```
config {802.11a | 802.11b} cac video roam-bandwidth bandwidth
```

**Step 10**
To configure the CAC parameters for SIP-based video calls, enter this command:
```
config {802.11a | 802.11b} cac video sip {enable | disable}
```

**Step 11**
Process or ignore the TSPEC inactivity timeout received from an access point by entering this command:
```
config {802.11a | 802.11b} cac video tspec-inactivity-timeout {enable | ignore}
```

**Step 12**
Reenable all WLANs with WMM enabled by entering this command:
```
config wlan enable wlan_id
```

**Step 13**
Reenable the radio network by entering this command:
```
config {802.11a | 802.11b} enable network
```
Step 14  Enter the save config command to save your settings.

Viewing Voice and Video Settings

Viewing Voice and Video Settings (GUI)

Step 1  Choose Monitor > Clients to open the Clients page.
Step 2  Click the MAC address of the desired client to open the Clients > Detail page.
        This page shows the U-APSD status (if enabled) for this client under Quality of Service Properties.
Step 3  Click Back to return to the Clients page.
Step 4  See the TSM statistics for a particular client and the access point to which this client is associated as follows:
        a) Hover your cursor over the blue drop-down arrow for the desired client and choose 802.11aTSM or 802.11b/g TSM. The Clients > AP page appears.
        b) Click the Detail link for the desired access point to open the Clients > AP > Traffic Stream Metrics page. This page shows the TSM statistics for this client and the access point to which it is associated. The statistics are shown in 90-second intervals. The timestamp text box shows the specific interval when the statistics were collected.
Step 5  See the TSM statistics for a particular access point and a particular client associated to this access point, as follows:
        a) Choose Wireless > Access Points > Radios > 802.11a/n or 802.11b/g/n. The 802.11a/n Radios or 802.11b/g/n Radios page appears.
        b) Hover your cursor over the blue drop-down arrow for the desired access point and choose 802.11aTSM or 802.11b/g TSM. The AP > Clients page appears.
        c) Click the Detail link for the desired client to open the AP > Clients > Traffic Stream Metrics page. This page shows the TSM statistics for this access point and a client associated to it. The statistics are shown in 90-second intervals. The timestamp text box shows the specific interval when the statistics were collected.

Viewing Voice and Video Settings (CLI)

Step 1  See the CAC configuration for the 802.11 network by entering this command:
        show ap stats {802.11a | 802.11b}
Step 2  See the CAC statistics for a particular access point by entering this command:
        show ap stats {802.11a | 802.11b} ap_name
        Information similar to the following appears:

        Call Admission Control (CAC) Stats
Voice Bandwidth in use (% of config bw) ........ 0
Total channel MT free .......................... 0
Total voice MT free ............................ 0
Na Direct ...................................... 0
Na Roam ...................................... 0
Video Bandwidth in use (% of config bw) ........ 0
Total num of voice calls in progress ........... 0
Num of roaming voice calls in progress ........ 0
Total Num of voice calls since AP joined....... 0
Total Num of roaming calls since AP joined.... 0
Total Num of exp bw requests received .......... 5
Total Num of exp bw requests admitted .......... 2

Num of voice calls rejected since AP joined.... 0
Num of roam calls rejected since AP joined.... 0
Num of calls rejected due to insufficient bw.... 0
Num of calls rejected due to invalid params.... 0
Num of calls rejected due to PHY rate.......... 0
Num of calls rejected due to QoS policy...... 0

In the example above, "MT" is medium time, "Na" is the number of additional calls, and "exp bw" is expedited bandwidth.

Note  Suppose an AP has to be rebooted when a voice client associated with the AP is on an active call. After the AP is rebooted, the client continues to maintain the call, and during the time the AP is down, the database is not refreshed by the controller. Therefore, we recommend that all active calls are ended before the AP is taken down.

Step 3  See the U-APSD status for a particular client by entering this command:

```
show client detail client_mac
```

Step 4  See the TSM statistics for a particular client and the access point to which this client is associated by entering this command:

```
show client tsm {802.11a | 802.11b} client_mac {ap_mac | all}
```

The optional all command shows all access points to which this client has associated. Information similar to the following appears:

```
Client Interface Mac: 00:01:02:03:04:05
Measurement Duration: 90 seconds
Timestamp 1st Jan 2006, 06:35:80
UpLink Stats
------------------------
Average Delay (5sec intervals)....................35
Delay less than 10 ms............................20
Delay bet 10 - 20 ms.............................20
Delay bet 20 - 40 ms.............................20
Delay greater than 40 ms........................20
Total packet Count................................80
Total packet lost count (5sec)...................10
Maximum Lost Packet count (5sec)............... 5
Average Lost Packet count (5sec)................2
DownLink Stats
------------------------
```
Average Delay (5sec intervals)............................35
Delay less than 10 ms.....................................20
Delay bet 10 - 20 ms......................................20
Delay bet 20 - 40 ms......................................20
Delay greater than 40 ms..................................20
Total packet Count.........................................80
Total packet lost count (5sec).............................10
Maximum Lost Packet count (5sec)............................5
Average Lost Packet count (5secs)..........................2

Note   The statistics are shown in 90-second intervals. The timestamp text box shows the specific interval when the statistics were collected.

Note   Clear the TSM statistics for a particular access point or all the access points to which this client is associated by entering this clear client tsm {802.11a | 802.11b} client_mac {ap_mac | all} command.

Step 5  See the TSM statistics for a particular access point and a particular client associated to this access point by entering this command:

show ap stats {802.11a | 802.11b} ap_name tsm {client_mac | all}    

The optional all command shows all clients associated to this access point. Information similar to the following appears:

AP Interface Mac: 00:0b:85:01:02:03
Client Interface Mac: 00:01:02:03:04:05
Measurement Duration: 90 seconds

Uplink Stats

Average Delay (5sec intervals)............................35
Delay less than 10 ms.....................................20
Delay bet 10 - 20 ms......................................20
Delay bet 20 - 40 ms......................................20
Delay greater than 40 ms..................................20
Total packet Count.........................................80
Total packet lost count (5sec).............................10
Maximum Lost Packet count (5sec)............................5
Average Lost Packet count (5secs)..........................2

Step 6  Enable or disable debugging for call admission control (CAC) messages, events, or packets by entering this command:

deprec cac {all | event | packet} {enable | disable}
where all configures debugging for all CAC messages, event configures debugging for all CAC events, and packet configures debugging for all CAC packets.

Step 7 Use the following command to perform voice diagnostics and to view the debug messages between a maximum of two 802.11 clients:

```
debug voice-diag {enable | disable} mac-id mac-id2 [verbose]
```

The verbose mode is an optional argument. When the verbose option is used, all debug messages are displayed in the console. You can use this command to monitor a maximum of two 802.11 clients. If one of the clients is a non-WiFi client, only the 802.11 client is monitored for debug messages.

**Note** It is implicitly assumed that the clients being monitored are on call.

**Note** The debug command automatically stops after 60 minutes.

Step 8 Use the following commands to view various voice-related parameters:

- **show client voice-diag status**
  Displays information about whether voice diagnostics is enabled or disabled. If enabled, will also displays information about the clients in the watch list and the time remaining for the diagnostics of the voice call.

If voice diagnostics is disabled when the following commands are entered, a message indicating that voice diagnostics is disabled appears.

- **show client voice-diag tspec**
  Displays the TSPEC information sent from the clients that are enabled for voice diagnostics.

- **show client voice-diag qos-map**
  Displays information about the QoS/DSCP mapping and packet statistics in each of the four queues: VO, VI, BE, BK. The different DSCP values are also displayed.

- **show client voice-diag avrg_rssi**
  Display the client's RSSI values in the last 5 seconds when voice diagnostics is enabled.

- **show client voice-diag roam-history**
  Displays information about the last three roaming calls. The output contains the timestamp, access point associated with roaming, roaming reason, and if there is a roaming failure, the reason for the roaming-failure.

- **show client calls {active | rejected} {802.11a | 802.11bg | all}**
  This command lists the details of active TSPEC and SIP calls on the controller.

Step 9 Use the following commands to troubleshoot video debug messages and statistics:

- **debug ap show stats {802.11b | 802.11a} ap-name multicast**—Displays the access point’s supported multicast rates.

- **debug ap show stats {802.11b | 802.11a} ap-name load**—Displays the access point’s QBSS and other statistics.

- **debug ap show stats {802.11b | 802.11a} ap-name tx-queue**—Displays the access point’s transmit queue traffic statistics.

- **debug ap show stats {802.11b | 802.11a} ap-name client {all | video | client-mac}**—Displays the access point’s client metrics.
• debug ap show stats {802.11b | 802.11a} ap-name packet—Displays the access point’s packet statistics.
• debug ap show stats {802.11b | 802.11a} ap-name video metrics—Displays the access point’s video metrics.
• debug ap show stats video ap-name multicast mgid number —Displays an access point’s Layer 2 MGID database number.
• debug ap show stats video ap-name admission—Displays an access point’s admission control statistics.
• debug ap show stats video ap-name bandwidth—Displays an access point’s video bandwidth.

Configuring SIP Based CAC

Restrictions for SIP-Based CAC

• SIPs are available only on the Cisco 5500 Series Controllers, Cisco 8500 Series Controllers, and on the 1240, 1130, and 11n access points.
• SIP CAC should only be used for phones that support status code 17 and do not support TSPEC-based admission control.
• SIP CAC will be supported only if SIP snooping is enabled.

Configuring SIP-Based CAC (GUI)

Before You Begin

• Ensure that you have set the voice to the platinum QoS level.
• Ensure that you have enabled call snooping for the WLAN.
• Ensure that you have enabled the Admission Control (ACM) for this radio.

Step 1  Choose Wireless > Advanced > SIP Snooping to open the SIP Snooping page.
Step 2  Specify the call-snooping ports by entering the starting port and the ending port.
Step 3  Click Apply and then click Save Configuration.
Configuring SIP-Based CAC (CLI)

Step 1  Set the voice to the platinum QoS level by entering this command:
config wlan qos wlan-id Platinum
Step 2  Enable the call-snooping feature for a particular WLAN by entering this command:
config wlan call-snoop enable wlan-id
Step 3  Enable the ACM to this radio by entering this command:
config {802.11a | 802.11b} cac {voice | video} acm enable
Step 4  To configure the call snooping ports, enter this command:
config advanced sip-snooping-ports starting-port ending-port
Step 5  To troubleshoot SIP-based CAC events, enter this command:
debg sip event {enable | disable}

Configuring Media Parameters

Configuring Media Parameters (GUI)

Step 1  Ensure that the WLAN is configured for WMM and the Gold QoS level.
Step 2  Disable all WLANs with WMM enabled and click Apply.
Step 3  Choose Wireless and then Network under 802.11a/n or 802.11b/g/n, unselect the 802.11a (or 802.11b/g) Network Status check box, and click Apply to disable the radio network.
Step 4  Choose Wireless > 802.11a/n or 802.11b/g/n > Media. The 802.11a (or 802.11b) > Media > Parameters page appears.
Step 5  Choose the Media tab to open the Media page.
Step 6  Select the Unicast Video Redirect check box to enable Unicast Video Redirect. The default value is disabled.
Step 7  In the Maximum Media Bandwidth (0-85%) text box, enter the percentage of the maximum bandwidth to be allocated for media applications on this radio band. Once the client reaches the specified value, the access point rejects new calls on this radio band.
The default value is 85%; valid values are from 0 to 85%.
Step 8 In the Client Phy Rate text box, enter the value for the rate in kilobits per second at which the client operates.

Step 9 In the Maximum Retry Percent (0-100%) text box, enter the percentage of the maximum retry. The default value is 80.

Step 10 Select the Multicast Direct Enable check box to enable the Multicast Direct Enable text box. The default value is enabled.

Step 11 From the Max Streams per Radio drop-down list, choose the maximum number of allowed multicast direct streams per radio. Choose a value between 1 to 20 or No Limit. The default value is set to No Limit.

Step 12 From the Max Streams per Client drop-down list, choose the maximum number of allowed clients per radio. Choose a value between 1 to 20 or No Limit. The default value is set to No Limit.

Step 13 If you want to enable the best radio queue for this radio, select the Best Effort QoS Admission check box. The default value is disabled.

Configuring Voice Prioritization Using Preferred Call Numbers

Information About Configuring Voice Prioritization Using Preferred Call Numbers

You can configure a controller to support calls from clients that do not support TSPEC-based calls. This feature is known as voice prioritization. These calls are given priority over other clients utilizing the voice pool. Voice prioritization is available only for SIP-based calls and not for TSPEC-based calls. If the bandwidth is available, it takes the normal flow and allocates the bandwidth to those calls.

You can configure up to six preferred call numbers. When a call comes to one of the configured preferred numbers, the controller does not check on the maximum call limit. It invokes the CAC to allocate bandwidth for the preferred call. The bandwidth allocation is 85 percent of the entire bandwidth pool, not just from the maximum configured voice pool. The bandwidth allocation is the same even for roaming calls.

Prerequisites for Configuring Voice Prioritization Using Preferred Call Numbers

You must configure the following before configuring voice prioritization:

- Set WLAN QoS to platinum.
- Enable ACM for the radio.
- Enable SIP call snooping on the WLAN.
Configuring a Preferred Call Number

Configuring a Preferred Call Number (GUI)

Step 1 Set the WLAN QoS profile to Platinum.
Step 2 Enable ACM for the WLAN radio.
Step 3 Enable SIP call snooping for the WLAN.
Step 4 Choose Wireless > Advanced > Preferred Call to open the Preferred Call page. All calls configured on the controller appear.
   Note To remove a preferred call, hover your cursor over the blue drop-down arrow and choose Remove.
Step 5 Click Add Number to add a new preferred call.
Step 6 In the Call Index text box, enter the index that you want to assign to the call. Valid values are from 1 through 6.
Step 7 In the Call Number text box, enter the number.
Step 8 Click Apply to add the new number.

Configuring a Preferred Call Number (CLI)

Step 1 Set the voice to the platinum QoS level by entering this command:
   config wlan qos wlan-id Platinum
Step 2 Enable the ACM to this radio by entering this command:
   config {802.11a | 802.11b} cac {voice | video} acm enable
Step 3 Enable the call-snooping feature for a particular WLAN by entering this command:
   config wlan call-snoop enable wlan-id
Step 4 Add a new preferred call by entering this command:
   config advanced sip-preferred-call-no call_index {call_number | none}
Step 5 Remove a preferred call by entering this command:
   config advanced sip-preferred-call-no call_index none
Step 6 View the preferred call statistics by entering the following command:
   show ap stats {802.11{a | b} | wlan} ap_name
Step 7 Enter the following command to list the preferred call numbers:
   show advanced sip-preferred-call-no
Configuring EDCA Parameters

Information About EDCA Parameters

Enhanced distributed channel access (EDCA) parameters are designed to provide preferential wireless channel access for voice, video, and other quality-of-service (QoS) traffic.

Configuring EDCA Parameters (GUI)

Step 1
Choose Wireless and then Network under 802.11a/n or 802.11b/g/n, unselect the 802.11a (or 802.11b/g) Network Status check box, and click Apply to disable the radio network.

Step 2
Choose EDCA Parameters under 802.11a/n or 802.11b/g/n. The 802.11a (or 802.11b/g) > EDCA Parameters page appears.

Step 3
Choose one of the following options from the EDCA Profile drop-down list:

- **WMM**—Enables the Wi-Fi Multimedia (WMM) default parameters. This is the default value. Choose this option when voice or video services are not deployed on your network.

- **Spectralink Voice Priority**—Enables SpectraLink voice priority parameters. Choose this option if SpectraLink phones are deployed on your network to improve the quality of calls.

- **Voice Optimized**—Enables EDCA voice-optimized profile parameters. Choose this option when voice services other than SpectraLink are deployed on your network.

- **Voice & Video Optimized**—Enables EDCA voice- and video-optimized profile parameters. Choose this option when both voice and video services are deployed on your network.

- **Custom Voice**—Enables custom voice EDCA parameters for 802.11a. The EDCA parameters under this option also match the 6.0 WMM EDCA parameters when this profile is applied.

  **Note** If you deploy video services, admission control (ACM) must be disabled.

Step 4
If you want to enable MAC optimization for voice, select the Enable Low Latency MAC check box. Otherwise, leave this check box unselected, which is the default value. This feature enhances voice performance by controlling packet retransmits and appropriately aging out voice packets on lightweight access points, which improves the number of voice calls serviced per access point.

  **Note** We do not recommend you to enable low latency MAC. You should enable low latency MAC only if the WLAN allows WMM clients. If WMM is enabled, then low latency MAC can be used with any of the EDCA profiles.
Configuring EDCA Parameters (CLI)

Step 1  Disable the radio network by entering this command:
        `config {802.11a | 802.11b} disable network`

Step 2  Save your settings by entering this command:
        `save config`

Step 3  Enable a specific EDCA profile by entering this command:
        `config advanced {802.11a | 802.11b} edca-parameters {wmm-default |svp-voice| optimized-voice| optimized-voice-video| custom-voice}
               • wmm-default—Enables the Wi-Fi Multimedia (WMM) default parameters. This is the default value. Choose this option when voice or video services are not deployed on your network.
               • svp-voice—Enables SpectraLink voice priority parameters. Choose this option if SpectraLink phones are deployed on your network to improve the quality of calls.
               • optimized-voice—Enables EDCA voice-optimized profile parameters. Choose this option when voice services other than SpectraLink are deployed on your network.
               • optimized-video-voice—Enables EDCA voice- and video-optimized profile parameters. Choose this option when both voice and video services are deployed on your network.
               • custom-voice—Enables custom voice EDCA parameters for 802.11a. The EDCA parameters under this option also match the 6.0 WMM EDCA parameters when this profile is applied.
               
Note  If you deploy video services, admission control (ACM) must be disabled.

Step 4  View the current status of MAC optimization for voice by entering this command:
        `show {802.11a | 802.11b}`

        Information similar to the following appears:

        Voice-mac-optimization..................Disabled

Step 5  Enable or disable MAC optimization for voice by entering this command:
        `config advanced {802.11a | 802.11b} voice-mac-optimization {enable | disable}

        This feature enhances voice performance by controlling packet retransmits and appropriately aging out voice packets on lightweight access points, which improves the number of voice calls serviced per access point. The default value is disabled.
Configuring the Cisco Discovery Protocol

Information About Configuring the Cisco Discovery Protocol

The Cisco Discovery Protocol (CDP) is a device discovery protocol that runs on all Cisco-manufactured equipment. A device enabled with CDP sends out periodic interface updates to a multicast address in order to make itself known to neighboring devices.

The default value for the frequency of periodic transmissions is 60 seconds, and the default advertised time-to-live value is 180 seconds. The second and latest version of the protocol, CDPv2, introduces new time-length-values (TLVs) and provides a reporting mechanism that allows for more rapid error tracking, which reduces downtime.

Cisco recommends that you disable Cisco Discovery Protocol on the controller and access point when connected to non-Cisco switches as CDP is unsupported on non-Cisco switches and network elements.

Restrictions for Configuring the Cisco Discovery Protocol

• CDPv1 and CDPv2 are supported on the following devices:
  • Cisco 2504 Wireless Controller
  • Cisco 5508 Wireless Controller
  • Cisco 5520 Wireless Controller
  • Cisco 8510 Wireless Controller
  • Cisco 8540 Wireless Controller
  • CAPWAP-enabled access points
  • An access point connected directly to a Cisco 2504 Wireless Controller

  Note To use the Intelligent Power Management feature, ensure that CDPv2 is enabled on the Cisco 2504 Wireless Controller. CDP v2 is enabled by default.

• The Cisco 600 Series OEAP access points do not support CDP.
• The support of CDPv1 and CDPv2 enables network management applications to discover Cisco devices.

• The following TLVs are supported by both the controller and the access point:
  ◦ Device-ID TLV: 0x0001—The hostname of the controller, the access point, or the CDP neighbor.
  ◦ Address TLV: 0x0002—The IP address of the controller, the access point, or the CDP neighbor.
  ◦ Port-ID TLV: 0x0003—The name of the interface on which CDP packets are sent out.
  ◦ Capabilities TLV: 0x0004—The capabilities of the device. The controller sends out this TLV with a value of Host: 0x10, and the access point sends out this TLV with a value of Transparent Bridge: 0x02.
  ◦ Version TLV: 0x0005—The software version of the controller, the access point, or the CDP neighbor.
  ◦ Platform TLV: 0x0006—The hardware platform of the controller, the access point, or the CDP neighbor.
  ◦ Power Available TLV: 0x001a—The amount of power available to be transmitted by power sourcing equipment to permit a device to negotiate and select an appropriate power setting.
  ◦ Full/Half Duplex TLV: 0x000b—The full- or half-duplex mode of the Ethernet link on which CDP packets are sent out.

• These TLVs are supported only by the access point:
  ◦ Power Consumption TLV: 0x0010—The maximum amount of power consumed by the access point.
  ◦ Power Request TLV: 0x0019—The amount of power to be transmitted by a powerable device in order to negotiate a suitable power level with the supplier of the network power.

• Changing the CDP configuration on the controller does not change the CDP configuration on the access points that are connected to the controller. You must enable and disable CDP separately for each access point.

• You can enable or disable the CDP state on all or specific interfaces and radios. This configuration can be applied to all access points or a specific access point.

• The following is the behavior assumed for various interfaces and access points:
  ◦ CDP is disabled on radio interfaces on indoor (nonindoor mesh) access points.
  ◦ Nonmesh access points have CDPs disabled on radio interfaces when they join the controller. The persistent CDP configuration is used for the APs that had CDP support in its previous image.
  ◦ CDP is enabled on radio interfaces on indoor-mesh and mesh access points.
  ◦ Mesh access points will have CDP enabled on their radio interfaces when they join the controller. The persistent CDP configuration is used for the access points that had CDP support in a previous image. The CDP configuration for radio interfaces is applicable only for mesh APs.
Configuring the Cisco Discovery Protocol

Configuring the Cisco Discovery Protocol (GUI)

Step 1  Choose **Controller** > **CDP** > **Global Configuration** to open the CDP > Global Configuration page.

Step 2  Select the **CDP Protocol Status** check box to enable CDP on the controller or unselect it to disable this feature. The default value is selected.

  **Note**  Enabling or disabling this feature is applicable to all controller ports.

Step 3  From the CDP Advertisement Version drop-down list, choose **v1** or **v2** to specify the highest CDP version supported on the controller. The default value is **v1**.

Step 4  In the Refresh-time Interval textbox, enter the interval at which CDP messages are to be generated. The range is 5 to 254 seconds, and the default value is 60 seconds.

Step 5  In the Holdtime text box, enter the amount of time to be advertised as the time-to-live value in generated CDP packets. The range is 10 to 255 seconds, and the default value is 180 seconds.

Step 6  Click **Apply** to commit your changes.

Step 7  Click **Save Configuration** to save your changes.

Step 8  Perform one of the following:

  - To enable or disable CDP on a specific access point, follow these steps:
    Choose **Wireless** > **Access Points** > **All APs** to open the All APs page.
    Click the link for the desired access point.
    Choose the **Advanced** tab to open the All APs > Details for (Advanced) page.
    Select the **Cisco Discovery Protocol** check box to enable CDP on this access point or unselect it to disable this feature. The default value is enabled.
    **Note**  If CDP is disabled in Step 2, a message indicating that the Controller CDP is disabled appears.

  - Enable CDP for a specific Ethernet interface, radio, or slot as follows:
    Choose **Wireless** > **Access Points** > **All APs** to open the All APs page.
    Click the link for the desired access point.
    Choose the **Interfaces** tab and select the corresponding check boxes for the radios or slots from the CDP Configuration section.
    **Note**  Configuration for radios is only applicable for mesh access points.
    Click **Apply** to commit your changes.

  - To enable or disable CDP on all access points currently associated to the controller, follow these steps:
    Choose **Wireless** > **Access Points** > **Global Configuration** to open the Global Configuration page.
    Select the **CDP State** check box to enable CDP on all access points associated to the controller or unselect it to disable CDP on all access points. The default value is selected. You can enable CDP on a specific Ethernet interface,
radio, or slot by selecting the corresponding check box. This configuration will be applied to all access points associated with the controller.

Click **Apply** to commit your changes.

**Step 9**

Click **Save Configuration** to save your changes.

---

**Configuring the Cisco Discovery Protocol (CLI)**

**Step 1**

Enable or disable CDP on the controller by entering this command:

```
config cdp {enable | disable}
```

CDP is enabled by default.

**Step 2**

Specify the interval at which CDP messages are to be generated by entering this command:

```
config cdp timer seconds
```

The range is 5 to 254 seconds, and the default value is 60 seconds.

**Step 3**

Specify the amount of time to be advertised as the time-to-live value in generated CDP packets by entering this command:

```
config cdp holdtime seconds
```

The range is 10 to 255 seconds, and the default value is 180 seconds.

**Step 4**

Specify the highest CDP version supported on the controller by entering this command:

```
config cdp advertise {v1 | v2}
```

The default value is v1.

**Step 5**

Enable or disable CDP on all access points that are joined to the controller by entering the `config ap cdp {enable | disable} all` command.

The `config ap cdp disable all` command disables CDP on all access points that are joined to the controller and all access points that join in the future. CDP remains disabled on both current and future access points even after the controller or access point reboots. To enable CDP, enter the `config ap cdp enable all` command.

**Note**

After you enable CDP on all access points joined to the controller, you may disable and then reenable CDP on individual access points using the command in Step 6. After you disable CDP on all access points joined to the controller, you may not enable and then disable CDP on individual access points.

**Step 6**

Enable or disable CDP on a specific access point by entering this command:

```
config ap cdp {enable | disable} Cisco_AP
```

**Step 7**

Configure CDP on a specific or all access points for a specific interface by entering this command:

```
config ap cdp {ethernet | radio} interface_number slot_id {enable | disable} {all | Cisco_AP}
```

**Note**

When you use the `config ap cdp` command to configure CDP on radio interfaces, a warning message appears indicating that the configuration is applicable only for mesh access points.

**Step 8**

Save your changes by entering this command:

```
save config
```
Viewing Cisco Discovery Protocol Information

Viewing Cisco Discovery Protocol Information (GUI)

**Step 1** Choose **Monitor > CDP > Interface Neighbors** to open the CDP > Interface Neighbors page appears. This page shows the following information:

- The controller port on which the CDP packets were received
- The name of each CDP neighbor
- The IP address of each CDP neighbor
- The port used by each CDP neighbor for transmitting CDP packets
- The time left (in seconds) before each CDP neighbor entry expires
- The functional capability of each CDP neighbor, defined as follows: R - Router, T - Trans Bridge, B - Source Route Bridge, S - Switch, H - Host, I - IGMP, r - Repeater, or M - Remotely Managed Device
- The hardware platform of each CDP neighbor device

**Step 2** Click the name of the desired interface neighbor to see more detailed information about each interface's CDP neighbor. The CDP > Interface Neighbors > Detail page appears. This page shows the following information:

- The controller port on which the CDP packets were received
- The name of the CDP neighbor
- The IP address of the CDP neighbor
- The port used by the CDP neighbor for transmitting CDP packets
- The CDP version being advertised (v1 or v2)
- The time left (in seconds) before the CDP neighbor entry expires
- The functional capability of the CDP neighbor, defined as follows: Router, Trans Bridge, Source Route Bridge, Switch, Host, IGMP, Repeater, or Remotely Managed Device
- The hardware platform of the CDP neighbor device
- The software running on the CDP neighbor

**Step 3** Choose **AP Neighbors** to see a list of CDP neighbors for all access points connected to the controller. The CDP AP Neighbors page appears.

**Step 4** Click the **CDP Neighbors** link for the desired access point to see a list of CDP neighbors for a specific access point. The CDP > AP Neighbors page appears. This page shows the following information:

- The name of each access point
- The IP address of each access point
Step 5  Click the name of the desired access point to see detailed information about an access point's CDP neighbors. The CDP > AP Neighbors > Detail page appears. This page shows the following information:

- The name of the access point
- The MAC address of the access point’s radio
- The IP address of the access point
- The interface on which the CDP packets were received
- The name of the CDP neighbor
- The IP address of the CDP neighbor
- The port used by the CDP neighbor
- The CDP version being advertised (v1 or v2)
- The time left (in seconds) before the CDP neighbor entry expires
- The functional capability of the CDP neighbor, defined as follows: R - Router, T - Trans Bridge, ?B - Source Route Bridge, S - Switch, H - Host, I - IGMP, r - Repeater, or M - Remotely Managed Device
- The hardware platform of the CDP neighbor device
- The software running on the CDP neighbor

Step 6  Choose Traffic Metrics to see CDP traffic information. The CDP > Traffic Metrics page appears. This page shows the following information:

- The number of CDP packets received by the controller
- The number of CDP packets sent from the controller
- The number of packets that experienced a checksum error
- The number of packets dropped due to insufficient memory
- The number of invalid packets
### Viewing Cisco Discovery Protocol Information (CLI)

| Step 1 | See the status of CDP and to view CDP protocol information by entering this command: |
|        | `show cdp` |
| Step 2 | See a list of all CDP neighbors on all interfaces by entering this command: |
|        | `show cdp neighbors [detail]` |
| Note   | This command shows only the CDP neighbors of the controller. It does not show the CDP neighbors of the controller's associated access points. Additional commands are provided below to show the list of CDP neighbors per access point. |
| Step 3 | See all CDP entries in the database by entering this command: |
|        | `show cdp entry all` |
| Step 4 | See CDP traffic information on a given port (for example, packets sent and received, CRC errors, and so on) by entering this command: |
|        | `show cdp traffic` |
| Step 5 | See the CDP status for a specific access point by entering this command: |
|        | `show ap cdp ap-name Cisco_AP` |
| Step 6 | See the CDP status for all access points that are connected to the controller by entering this command: |
|        | `show ap cdp all` |
| Step 7 | See a list of all CDP neighbors for a specific access point by entering these commands: |
|        | • `show ap cdp neighbors ap-name Cisco_AP` |
|        | • `show ap cdp neighbors detail Cisco_AP` |
| Note   | The access point sends CDP neighbor information to the controller only when the information changes. |
| Step 8 | See a list of all CDP neighbors for all access points connected to the controller by entering these commands: |
|        | • `show ap cdp neighbors all` |
|        | • `show ap cdp neighbors detail all` |
| Note   | The access point sends CDP neighbor information to the controller only when the information changes. |

### Getting CDP Debug Information

- Get debug information related to CDP packets by entering by entering this command:
  ```
  debug cdp packets
  ```
- Get debug information related to CDP events by entering this command:
debug cdp events

Configuring Authentication for the Controller and NTP Server

Information About Configuring Authentication for the Controller and NTP/SNTP Server

Cisco WLCs must synchronize time with an NTP/SNTP server by authentication. By default, an MD5 checksum is used.

Configuring Authentication for the Controller and NTP Server

Configuring the NTP/SNTP Server for Authentication (GUI)

Step 1 Choose Controller > NTP > Server to open the NTP Server page.
Step 2 Click New to add a new NTP/SNTP Server.
Step 3 In the Server Index (Priority) text box, enter the NTP/SNTP server index. The controller tries Index 1 first, then Index 2 through 3, in a descending order. Set this to 1 if your network is using only one NTP/SNTP server.
Step 4 Enter the server IP address.
Step 5 Enable or disable the NTP/SNTP Authentication.
Step 6 If you enable the NTP/SNTP Authentication, enter the Key Index.
Step 7 Click Apply.

Configuring the NTP/SNTP Server for Authentication (CLI)

- `config time ntp auth enable server-index key-index`—Enables NTP/SNTP authentication on a given NTP/SNTP server.
- `config time ntp key-auth add key-index md5 key-format key`—Adds an authentication key. By default MD5 is used. The key format can be "ascii" or "hex".
- `config time ntp key-auth delete key-index`—Deletes authentication keys.
- `config time ntp auth disable server-index`—Disables NTP/SNTP authentication.
- `show ntp-keys`—Displays the NTP/SNTP authentication related parameter.
Configuring RFID Tag Tracking

Information About Configuring RFID Tag Tracking

The controller enables you to configure radio-frequency identification (RFID) tag tracking. RFID tags are small wireless devices that are affixed to assets for real-time location tracking. They operate by advertising their location using special 802.11 packets, which are processed by access points, the controller, and the mobility services engine.

To know more about the tags supported by controller, see http://www.cisco.com/c/en/us/products/wireless/compatible-extensions.html. The mobility services engine receives telemetry and chokepoint information from tags that are compliant with this CCX specification.

Table 6: Cisco Compatible Extensions for RFID Tags Summary

<table>
<thead>
<tr>
<th>Partners</th>
<th>AeroScout</th>
<th>WhereNet</th>
<th>Pango (InnerWireless)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
<td>T2</td>
<td>T3</td>
<td>V3</td>
</tr>
<tr>
<td>Telemetry</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>Pressure</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Humidity</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Status</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Fuel</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Quantity</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Distance</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Motion Detection</td>
<td>X</td>
<td>X</td>
<td>—</td>
</tr>
<tr>
<td>Number of Panic Buttons</td>
<td>1</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Tampering</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Battery Information</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Multiple-Frequency Tags(^3)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

\(^3\) For chokepoint systems, note that the tag can work only with chokepoints coming from the same vendor.
The Network Mobility Services Protocol (NMSP) runs on the mobility services engine. For NMSP to function, the TCP port (16113) over which the controller and the mobility services engine communicate must be open (not blocked) on any firewall that exists between these two devices.

The Cisco-approved tags support these capabilities:

- **Information notifications**—Enables you to view vendor-specific and emergency information.
- **Information polling**—Enables you to monitor battery status and telemetry data. Many telemetry data types provide support for sensory networks and a large range of applications for RFID tags.
- **Measurement notifications**—Enables you to deploy chokepoints at strategic points within your buildings or campuses. Whenever an RFID tag moves to within a defined proximity of a chokepoint, the tag begins transmitting packets that advertise its location in relation to the chokepoint.

You can configure and view RFID tag tracking information through the controller CLI.

## Configuring RFID Tag Tracking

### Configuring RFID Tag Tracking (CLI)

#### Step 1
Enable or disable RFID tag tracking by entering this command:

```
config rfid status {enable | disable}
```

The default value is enabled.

#### Step 2
Specify a static timeout value (between 60 and 7200 seconds) by entering this command:

```
config rfid timeout seconds
```

The static timeout value is the amount of time that the controller maintains tags before expiring them. For example, if a tag is configured to beacon every 30 seconds, we recommend that you set the timeout value to 90 seconds (approximately three times the beacon value). The default value is 1200 seconds.

#### Step 3
Enable or disable RFID tag mobility for specific tags by entering these commands:

- **config rfid mobility vendor_name enable**—Enables client mobility for a specific vendor’s tags. When you enter this command, tags are unable to obtain a DHCP address for client mode when attempting to select and/or download a configuration.

- **config rfid mobility vendor_name disable**—Disables client mobility for a specific vendor’s tags. When you enter this command, tags can obtain a DHCP address. If a tag roams from one subnet to another, it obtains a new address rather than retaining the anchor state.

  **Note** These commands can be used only for Pango tags. Therefore, the only valid entry for vendor_name is “pango” in all lowercase letters.
Viewing RFID Tag Tracking Information (CLI)

**Step 1**
See the current configuration for RFID tag tracking by entering this command:

```
show rfid config
```

**Step 2**
See detailed information for a specific RFID tag by entering this command:

```
show rfid detail mac_address
```

where `mac_address` is the tag’s MAC address.

**Step 3**
See a list of all RFID tags currently connected to the controller by entering this command:

```
show rfid summary
```

**Step 4**
See a list of RFID tags that are associated to the controller as clients by entering this command:

```
show rfid client
```

Debugging RFID Tag Tracking Issues (CLI)

If you experience any problems with RFID tag tracking, use these debug commands.

- Configure MAC address debugging by entering this command:

```
debug mac addr mac_address
```

**Note**
We recommend that you perform the debugging on a per-tag basis. If you enable debugging for all of the tags, the console or Telnet screen is inundated with messages.

- Enable or disable debugging for the 802.11 RFID tag module by entering this command:

```
debug dot11 rfid {enable | disable}
```

- Enable or disable RFID debug options by entering this command:

```
debug rfid {all | detail | error | nmsp | receive} {enable | disable}
```

where

- `all` configures debugging of all RFID messages.
- `detail` configures debugging of RFID detailed messages.
- `error` configures debugging of RFID error messages.
- `nmsp` configures debugging of RFID NMSP messages.
- `receive` configures debugging of incoming RFID tag messages.
Configuring and Viewing Location Settings

Information About Configuring and Viewing Location Settings

This section provides instructions to configure and view location settings from the controller CLI.

Synchronizing the Controller and Mobility Services Engine

If mobility services engine is installed on your network, the time zone must be set on the controller to ensure proper synchronization between the two systems. Also, the times must be synchronized on the two devices. We recommend that you set the time even for networks that do not have mobility services engine. See the Configuring 802.11 Bands section for instructions on setting the time and date on the controller.

Note

The time zone can be different for the controller and the location appliance, but the time zone delta must be configured accordingly, based on GMT.

Configuring Location Settings

Configuring Location Settings (CLI)

The controller determines the location of client devices by gathering received signal strength indication (RSSI) measurements from access points all around the client of interest. The controller can obtain location reports from up to 16 access points for clients, RFID tags, and rogue access points.

Improve location accuracy by configuring the path loss measurement (S60) request for normal clients or calibrating clients by entering this command:

```plaintext
config location plm ?
```

where ? is one of the following:

- **client {enable | disable} burst_interval**—Enables or disables the path loss measurement request for normal, non-calibrating clients. The valid range for the `burst_interval` parameter is 1 to 3600 seconds, and the default value is 60 seconds.

- **calibrating {enable | disable} {uniband | multiband}**—Enables or disables the path loss measurement request for calibrating clients on the associated 802.11a or 802.11b/g radio or on the associated 802.11a/b/g radio.

If a client does not send probes often or sends them only on a few channels, its location cannot be updated or cannot be updated accurately. The `config location plm` command forces clients to send more packets on all channels. When a CCXv4 (or higher) client associates, the controller sends it a path loss measurement request, which instructs the client to transmit on the bands and channels that the access points are on (typically, channels 1, 6, and 11 for 2.4-GHz-only access points) at a configurable interval (such as 60 seconds) indefinitely.

These four additional location CLI commands are available; however, they are set to optimal default values, so we do not recommend that you use or modify them:
• Configure the RSSI timeout value for various devices by entering this command:

```
config location expiry ?
```

where ? is one of the following:

- **client timeout**—Configures the RSSI timeout value for clients. The valid range for the `timeout` parameter is 5 to 3600 seconds, and the default value is 5 seconds.
- **calibrating-client timeout**—Configures the RSSI timeout value for calibrating clients. The valid range for the `timeout` parameter is 0 to 3600 seconds, and the default value is 5 seconds.
- **tags timeout**—Configures the RSSI timeout value for RFID tags. The valid range for the `timeout` parameter is 5 to 300 seconds, and the default value is 5 seconds.
- **rogue-aps timeout**—Configures the RSSI timeout value for rogue access points. The valid range for the `timeout` parameter is 5 to 3600 seconds, and the default value is 5 seconds.

Ensuring that recent, strong RSSIs are retained by the CPU is critical to location accuracy. The `config location expiry` command enables you to specify the length of time after which old RSSI averages expire.

**Note**

We recommend that you do not use or modify the `config location expiry` command.

• Configure the RSSI half life for various devices by entering this command:

```
config location rssi-half-life ?
```

where ? is one of the following:

- **client half_life**—Configures the RSSI half life for clients. The valid range for the `half_life` parameter is 0, 1, 2, 5, 10, 20, 30, 60, 90, 120, 180, or 300 seconds, and the default value is 0 seconds.
- **calibrating-client half_life**—Configures the RSSI half life for calibrating clients. The valid range for the `half_life` parameter is 0, 1, 2, 5, 10, 20, 30, 60, 90, 120, 180, or 300 seconds, and the default value is 0 seconds.
- **tags half_life**—Configures the RSSI half life for RFID tags. The valid range for the `half_life` parameter is 0, 1, 2, 5, 10, 20, 30, 60, 90, 120, 180, or 300 seconds, and the default value is 0 seconds.
- **rogue-aps half_life**—Configures the RSSI half life for rogue access points. The valid range for the `half_life` parameter is 0, 1, 2, 5, 10, 20, 30, 60, 90, 120, 180, or 300 seconds, and the default value is 0 seconds.

Some client devices transmit at reduced power immediately after changing channels, and RF is variable, so RSSI values might vary considerably from packet to packet. The `config location rssi-half-life` command increases accuracy by averaging nonuniformly arriving data using a configurable forget period (or half life).

**Note**

We recommend that you do not use or modify the `config location rssi-half-life` command.
• Configure the NMSP notification threshold for RSSI measurements by entering this command:

```plaintext
config location notify-threshold ?
```

where ? is one of the following:

- **client threshold**—Configures the NMSP notification threshold (in dB) for clients and rogue clients. The valid range for the `threshold` parameter is 0 to 10 dB, and the default value is 0 dB.

- **tags threshold**—Configures the NMSP notification threshold (in dB) for RFID tags. The valid range for the `threshold` parameter is 0 to 10 dB, and the default value is 0 dB.

- **rogue-aps threshold**—Configures the NMSP notification threshold (in dB) for rogue access points. The valid range for the `threshold` parameter is 0 to 10 dB, and the default value is 0 dB.

**Note**

We recommend that you do not use or modify the `config location notify-threshold` command.

• Configure the algorithm used to average RSSI and signal-to-noise ratio (SNR) values by entering this command:

```plaintext
config location algorithm ?
```

where ? is one of the following:

- **simple**—Specifies a faster algorithm that requires low CPU overhead but provides less accuracy.

- **rssi-average**—Specifies a more accurate algorithm but requires more CPU overhead.

**Note**

We recommend that you do not use or modify the `config location algorithm` command.

### Viewing Location Settings (CLI)

To view location information, use these CLI commands:

- View the current location configuration values by entering this command:
  ```plaintext
  show location summary
  ```

- See the RSSI table for a particular client by entering this command:
  ```plaintext
  show location detail client_mac_addr
  ```

- See the location-based RFID statistics by entering this command:
  ```plaintext
  show location statistics rfid
  ```

- Clear the location-based RFID statistics by entering this command:
  ```plaintext
  clear location statistics rfid
  ```

- Clear a specific RFID tag or all of the RFID tags in the entire database by entering this command:
  ```plaintext
  clear location rfid {mac_address | all}
  ```
• See whether location presence (S69) is supported on a client by entering this command:

```
show client detail client_mac
```

When location presence is supported by a client and enabled on a location appliance, the location appliance can provide the client with its location upon request. Location presence is enabled automatically on CCXv5 clients.

### Modifying the NMSP Notification Interval for Clients, RFID Tags, and Rogues (CLI)

The Network Mobility Services Protocol (NMSP) manages communication between the mobility services engine and the controller for incoming and outgoing traffic. If your application requires more frequent location updates, you can modify the NMSP notification interval (to a value between 1 and 180 seconds) for clients, active RFID tags, and rogue access points and clients.

**Note**

The TCP port (16113) that the controller and mobility services engine communicate over must be open (not blocked) on any firewall that exists between the controller and the mobility services engine for NMSP to function.

---

### Step 1

Set the NMSP notification interval value for clients, RFID tags, and rogue clients and access points by entering these commands, where `interval` is a value between 1 and 180 seconds:

- `conf nmsp notification interval rssi clients interval`
- `conf nmsp notification interval rssi rfid interval`
- `conf nmsp notification interval rssi rogues interval`

### Step 2

See the NMSP notification intervals by entering this command:

```
show nmsp notification interval
```

Information similar to the following appears:

<table>
<thead>
<tr>
<th>NMSP Notification Interval Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSSI Interval:</td>
</tr>
<tr>
<td>Client................................. 2 sec</td>
</tr>
<tr>
<td>RFID........................................ 2 sec</td>
</tr>
<tr>
<td>Rogue AP..................................... 2 sec</td>
</tr>
<tr>
<td>Rogue Client................................ 2 sec</td>
</tr>
<tr>
<td>Spectrum Interval:</td>
</tr>
<tr>
<td>Interferer device.................... 2 sec</td>
</tr>
</tbody>
</table>
Viewing NMSP Settings (CLI)

To view NMSP information, use these CLI commands:

- See the status of active NMSP connections by entering this command:
  ```
  show nmsp status
  ```

- See the NMSP capabilities by entering this command:
  ```
  show nmsp capability
  ```

- See the NMSP counters by entering this command:
  ```
  show nmsp statistics \{summary \| connection\}
  ```
  where
  - **summary** shows the common NMSP counters.
  - **connection** shows the connection-specific NMSP counters.

- See the mobility services that are active on the controller by entering this command:
  ```
  show nmsp subscription \{summary \| detail \| detail ip_addr\}
  ```
  where
  - **summary** shows all of the mobility services to which the controller is subscribed.
  - **detail** shows details for all of the mobility services to which the controller is subscribed.
  - **detail ip_addr** shows details only for the mobility services subscribed to by a specific IP address.

- Clear all NMSP statistics by entering this command:
  ```
  clear nmsp statistics
  ```

Debugging NMSP Issues

Use these commands if you experience any problems with NMSP:

- Configure NMSP debug options by entering this command:
  ```
  debug nmsp ?
  ```
  where ? is one of the following:
  - **all** \{enable | disable\}—Enables or disables debugging for all NMSP messages.
  - **connection** \{enable | disable\}—Enables or disables debugging for NMSP connection events.
  - **detail** \{enable | disable\}—Enables or disables debugging for NMSP detailed events.
  - **error** \{enable | disable\}—Enables or disables debugging for NMSP error messages.
  - **event** \{enable | disable\}—Enables or disables debugging for NMSP events.
  - **message** \{tx | rx\} \{enable | disable\}—Enables or disables debugging for NMSP transmit or receive messages.
*packet {enable | disable}—Enables or disables debugging for NMSP packet events.

- Enable or disable debugging for NMSP interface events by entering this command:
  `debug dot11 nmsp {enable | disable}`

- Enable or disable debugging for IAPP NMSP events by entering this command:
  `debug iapp nmsp {enable | disable}`

- Enable or disable debugging for RFID NMSP messages by entering this command:
  `debug rfid nmsp {enable | disable}`

- Enable or disable debugging for access point monitor NMSP events by entering this command:
  `debug service ap-monitor nmsp {enable | disable}`

- Enable or disable debugging for wIPS NMSP events by entering this command:
  `debug wips nmsp {enable | disable}`

## Resetting the Controller to Default Settings

### Information About Resetting the Controller to Default Settings

You can return the controller to its original configuration by resetting the controller to factory-default settings.

### Resetting the Controller to Default Settings

#### Resetting the Controller to Default Settings (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Start your Internet browser.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Enter the controller IP address in the browser address line and press <strong>Enter</strong>. An Enter Network Password dialog box appears.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter your username in the User Name text box. The default username is <strong>admin</strong>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Enter the wireless device password in the Password text box and press <strong>Enter</strong>. The default password is <strong>admin</strong>.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Choose <strong>Commands &gt; Reset to Factory Default</strong>.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click <strong>Reset</strong>.</td>
</tr>
<tr>
<td>Step 7</td>
<td>When prompted, confirm the reset.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Reboot the controller without saving the configuration.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Use the configuration wizard to enter configuration settings. See the <strong>Configuring the Controller—Using the CLI Configuration Wizard</strong> section for more information.</td>
</tr>
</tbody>
</table>
Resetting the Controller to Default Settings (CLI)

**Step 1** Enter the `reset system` command. At the prompt that asks whether you need to save changes to the configuration, enter `N`. The unit reboots.

**Step 2** When you are prompted for a username, enter the `recover-config` command to restore the factory-default configuration. The controller reboots and displays this message:

```
Welcome to the Cisco WLAN Solution Wizard Configuration Tool
```

**Step 3** Use the configuration wizard to enter configuration settings. See the Configuring the Controller—Using the CLI Configuration Wizard section for more information.
Configuring VideoStream

This chapter contains the following sections:

• Prerequisites for VideoStream, page 189
• Restrictions for Configuring VideoStream, page 189
• Information about VideoStream, page 189
• Configuring VideoStream, page 190

Prerequisites for VideoStream

Make sure that the multicast feature is enabled. We recommend configuring IP multicast on the controller with multicast-multicast mode.

Check for the IP address on the client machine. The machine should have an IP address from the respective VLAN.

Verify that the access points have joined the controllers.

Make sure that the clients are able to associate to the configured WLAN at 802.11n speed.

Restrictions for Configuring VideoStream

VideoStream is supported in the 7.0.98.0 and later controller software releases.

The Cisco OEAP-600 does not support VideoStream. All other access points support VideoStream.

Information about VideoStream

The IEEE 802.11 wireless multicast delivery mechanism does not provide a reliable way to acknowledge lost or corrupted packets. As a result, if any multicast packet is lost in the air, it is not sent again which may cause an IP multicast stream unviewable.
The VideoStream feature makes the IP multicast stream delivery reliable over the air, by converting the multicast frame to a unicast frame over the air. Each VideoStream client acknowledges receiving a video IP multicast stream.

Configuring VideoStream

Configuring VideoStream (GUI)

Step 1 Configure the multicast feature by following these steps:

a) Choose Wireless > MediaStream > General.

b) Select or unselect the Multicast Direct feature check box. The default value is disabled.

Note Enabling the multicast direct feature does not automatically reset the existing client state. The wireless clients must rejoin the multicast stream after enabling the multicast direct feature on the controller.

c) In the Session Message Config area, select Session announcement State check box to enable the session announcement mechanism. If the session announcement state is enabled, clients are informed each time a controller is not able to serve the multicast direct data to the client.

d) In the Session announcement URL text box, enter the URL where the client can find more information when an error occurs during the multicast media stream transmission.

e) In the Session announcement e-mail text box, enter the e-mail address of the person who can be contacted.

f) In the Session announcement Phone text box, enter the phone number of the person who can be contacted.

g) In the Session announcement Note text box, enter a reason as to why a particular client cannot be served with a multicast media.

h) Click Apply.

Step 2 Add a media stream by following these steps:

a) Choose Wireless > Media Stream > Streams to open the Media Stream page.

b) Click Add New to configure a new media stream. The Media Stream > New page appears.

Note The Stream Name, Multicast Destination Start IP Address (IPv4 or IPv6), and Multicast Destination End IP Address (IPv4 or IPv6) text boxes are mandatory. You must enter information in these text boxes.

c) In the Stream Name text box, enter the media stream name. The stream name can be up to 64 characters.

d) In the Multicast Destination Start IP Address (IPv4 or IPv6) text box, enter the start (IPv4 or IPv6) address of the multicast media stream.

e) In the Multicast Destination End IP Address (IPv4 or IPv6) text box, enter the end (IPv4 or IPv6) address of the multicast media stream.

Note Ensure that the Multicast Destination Start and End IP addresses are of the same type, that is both addresses should be of either IPv4 or IPv6 type.

f) In the Maximum Expected Bandwidth text box, enter the maximum expected bandwidth that you want to assign to the media stream. The values can range between 1 to 35000 kbps.

Note We recommend that you use a template to add a media stream to the controller.

g) From the Select from Predefined Templates drop-down list under Resource Reservation Control (RRC) Parameters, choose one of the following options to specify the details about the resource reservation control:

• Very Coarse (below 300 kbps)
• Coarse (below 500 kbps)
• Ordinary (below 750 kbps)
• Low (below 1 Mbps)
• Medium (below 3 Mbps)
• High (below 5 Mbps)

Note When you select a predefined template from the drop-down list, the following text boxes under the Resource Reservation Control (RRC) Parameters list their default values that are assigned with the template.

• Average Packet Size (100-1500 bytes)—Specifies the average packet size. The value can be in the range of 100 to 1500 bytes. The default value is 1200.

• RRC Periodic update—Enables the RRC (Resource Reservation Control Check) Periodic update. By default, this option is enabled. RRC periodically updates the admission decision on the admitted stream according to the correct channel load. As a result, it may deny certain low priority admitted stream requests.

• RRC Priority (1-8)—Specifies the priority bit set in the media stream. The priority can be any number between 1 and 8. The larger the value means the higher the priority is. For example, a priority of 1 is the lowest value and a value of 8 is the highest value. The default priority is 4. The low priority stream may be denied in the RRC periodic update.

• Traffic Profile Violation—Specifies the action to perform in case of a violation after a re-RRC. Choose an action from the drop-down list. The possible values are as follows:
  - Drop—Specifies that a stream is dropped on periodic reevaluation.
  - Fallback—Specifies that a stream is demoted to Best Effort class on periodic reevaluation.

  The default value is *drop*.

h) Click **Apply**.

**Step 3**
Enable the media stream for multicast-direct by following these steps:

a) Choose **WLANs > WLAN ID** to open the WLANs > Edit page.

b) Click the **QoS** tab and select Gold (Video) from the Quality of Service (QoS) drop-down list.

c) Click **Apply**.

**Step 4**
Set the EDCA parameters to voice and video optimized (optional) by following these steps:

a) Choose **Wireless > 802.11a/n or 802.11b/g/n > EDCA Parameters**.

b) From the **EDCA Profile** drop-down list, choose the Voice and Video Optimized option.

c) Click **Apply**.

**Step 5**
Enable the admission control on a band for video (optional) by following these steps:

Note Keep the voice bandwidth allocation to a minimum for better performance.

a) Choose **Wireless > 802.11a/n or 802.11b/g/n > Media** to open the 802.11a/n (5 GHZ) or 802.11b/g/n > Media page.

b) Click the **Video** tab.

c) Select the **Admission Control (ACM)** check box to enable bandwidth-based CAC for this radio band. The default value is disabled.

d) Click **Apply**.

**Step 6**
Configure the video bandwidth by following these steps:

Note The template bandwidth that is configured for a media stream should be more than the bandwidth for the source media stream.
Note: The voice configuration is optional. Keep the voice bandwidth allocation to a minimum for better performance.

a) Disable all WMM WLANs.
b) Choose Wireless > 802.11a/n or 802.11b/g/n > Media to open the 802.11a/n (5 GHz) or 802.11b/g/n > Media page.
c) Click the Video tab.
d) Select the Admission Control (ACM) check box to enable the video CAC for this radio band. The default value is disabled.
e) In the Max RF Bandwidth field, enter the percentage of the maximum bandwidth allocated to clients for video applications on this radio band. Once the client reaches the value specified, the access point rejects new requests on this radio band.
f) The range is 5 to 85%.
g) The default value is 9%.
h) Click Apply.
i) Reenable all WMM WLANs and click Apply.

Step 7 Configure the media bandwidth by following these steps:

a) Choose Wireless > 802.11a/n or 802.11b/g/n > Media to open the 802.11a (or 802.11b) > Media > Parameters page.
b) Click the Media tab to open the Media page.
c) Select the Unicast Video Redirect check box to enable Unicast Video Redirect. The default value is disabled.
d) In the Maximum Media Bandwidth (0-85%) text box, enter the percentage of the maximum bandwidth to be allocated for media applications on this radio band. Once the client reaches a specified value, the access point rejects new calls on this radio band.
e) The default value is 85%; valid values are from 0% to 85%.
f) In the Client Minimum Phy Rate text box, enter the minimum transmission data rate to the client. If the transmission data rate is below the phy rate, either the video will not start or the client may be classified as a bad client. The bad client video can be demoted for better effort QoS or subject to denial.
g) In the Maximum Retry Percent (0-100%) text box, enter the percentage of maximum retries that are allowed. The default value is 80. If it exceeds 80, either the video will not start or the client might be classified as a bad client. The bad video client can be demoted for better effort QoS or subject to denial.
h) Select the Multicast Direct Enable check box to enable the Multicast Direct Enable field. The default value is enabled.
i) From the Max Streams per Radio drop-down list, choose the maximum number of streams allowed per radio from the range 0 to 20. The default value is set to No-limit. If you choose No-limit, there is no limit set for the number of client subscriptions.
j) From the Max Streams per Client drop-down list, choose the maximum number of streams allowed per client from the range 0 to 20. The default value is set to No-limit. If you choose No-limit, there is no limit set for the number of client subscriptions.
k) Select the Best Effort QoS Admission check box to enable best-effort QoS admission.
l) Click Apply.

Step 8 Enable a WLAN by following these steps:

a) Choose WLANS > WLAN ID. The WLANS > Edit page appears.
b) Select the Status check box.
c) Click Apply.

Step 9 Enable the 802.11 a/n or 802.11 b/g/n network by following these steps:

a) Choose Wireless > 802.11a/n or 802.11b/g/n > Network.
b) Select the 802.11a or 802.11b/g Network Status check box to enable the network status.
c) Click Apply.

Step 10 Verify that the clients are associated with the multicast groups and group IDs by following these steps:
   a) Choose Monitor > Clients. The Clients page appears.
   b) Check if the 802.11a/n or 802.11b/g/n network clients have the associated access points.
   c) Choose Monitor > Multicast. The Multicast Groups page appears.
   d) Select the MGID check box for the VideoStream to the clients.
   e) Click MGID. The Multicast Group Detail page appears. Check the Multicast Status details.

---

## Configuring VideoStream (CLI)

### Step 1
Configure the multicast-direct feature on WLANs media stream by entering this command:
```
config wlan media-stream multicast-direct {wlan_id | all} {enable | disable}
```

### Step 2
Enable or disable the multicast feature by entering this command:
```
config media-stream multicast-direct {enable | disable}
```

### Step 3
Configure various message configuration parameters by entering this command:
```
config media-stream message {state [enable | disable] | url url | email email | phone phone_number | note note}
```

### Step 4
Save your changes by entering this command:
```
save config
```

### Step 5
Configure various global media-stream configurations by entering this command:
```
config media-stream add multicast-direct stream-name media_stream_name start_IP end_IP [template {very-coarse | coarse | ordinary | low-resolution | med-resolution | high-resolution} | detail {Max_bandwidth bandwidth | packet size packet_size | Re-evaluation re-evaluation {periodic | initial} | video video priority {drop | fallback}}]
```

- The Resource Reservation Control (RRC) parameters are assigned with the predefined values based on the values assigned to the template.
- The following templates are used to assign RRC parameters to the media stream:
  - Very Coarse (below 3000 kbps)
  - Coarse (below 500 kbps)
  - Ordinary (below 750 kbps)
  - Low Resolution (below 1 mbps)
  - Medium Resolution (below 3 mbps)
  - High Resolution (below 5 mbps)

### Step 6
Delete a media stream by entering this command:
```
config media-stream delete media_stream_name
```
Step 7  Enable a specific enhanced distributed channel access (EDC) profile by entering this command:
config advanced { 801.11a | 802.11b } edca-parameters optimized-video-voice

Step 8  Enable the admission control on the desired bandwidth by entering the following commands:

- Enable bandwidth-based voice CAC for 802.11a or 802.11b/g network by entering this command:
  config { 802.11a | 802.11b } cac voice acm enable

- Set the percentage of the maximum bandwidth allocated to clients for voice applications on the 802.11a or 802.11b/g network by entering this command:
  config { 802.11a | 802.11b } cac voice max-bandwidth bandwidth

- Configure the percentage of the maximum allocated bandwidth reserved for roaming voice clients on the 802.11a or 802.11b/g network by entering this command:
  config { 802.11a | 802.11b } cac voice roam-bandwidth bandwidth

Note  For TSpec and SIP based CAC for video calls, only Static method is supported.

Step 9  Set the maximum number of streams per radio and/or per client by entering these commands:

- Set the maximum limit to the number multicast streams per radio by entering this command:
  config { 802.11a | 802.11b } media-stream multicast-direct radio-maximum [value | no-limit]

- Set the maximum number of multicast streams per client by entering this command:
  config { 802.11a | 802.11b } media-stream multicast-direct client-maximum [value | no-limit]

Step 10 Save your changes by entering this command:
        save config

Viewing and Debugging Media Streams

- See the configured media streams by entering this command:
  show wlan wlan_id

- See the details of the media stream name by entering this command:
  show 802.11{a | b | h} media-stream media-stream_name

- See the clients for a media stream by entering this command:
  show 802.11a media-stream client media-stream-name

- See a summary of the media stream and client information by entering this command:
  show media-stream group summary

- See details about a particular media stream group by entering this command:
  show media-stream group detail media_stream_name

- See details of the 802.11a or 802.11b media resource reservation configuration by entering this command:
show {802.11a | 802.11b} media-stream rrc

- Enable debugging of the media stream history by entering this command:
  
  debug media-stream history {enable | disable}
CHAPTER 6

Configuring Security Solutions

This chapter describes security solutions for wireless LANs. It contains these sections:

- Cisco Unified Wireless Network Solution Security, page 198
- Configuring RADIUS, page 199
- Configuring TACACS+, page 214
- Configuring Maximum Local Database Entries, page 222
- Configuring Local Network Users on the Controller, page 223
- Configuring Password Policies, page 225
- Configuring LDAP, page 227
- Configuring Local EAP, page 231
- Configuring the System for SpectraLink NetLink Telephones, page 242
- Configuring RADIUS NAC Support, page 244
- Using Management Over Wireless, page 247
- Using Dynamic Interfaces for Management, page 248
- Configuring DHCP Option 82, page 248
- Configuring and Applying Access Control Lists, page 250
- Configuring Management Frame Protection, page 257
- Configuring Client Exclusion Policies, page 261
- Configuring Identity Networking, page 263
- Configuring AAA Override, page 267
- Managing Rogue Devices, page 269
- Classifying Rogue Access Points, page 278
- Configuring Cisco TrustSec SXP, page 290
- Configuring Cisco Intrusion Detection System, page 293
Cisco Unified Wireless Network Solution Security

Security Overview

The Cisco Unified Wireless Network (UWN) security solution bundles potentially complicated Layer 1, Layer 2, and Layer 3 802.11 Access Point security components into a simple policy manager that customizes system-wide security policies on a per-WLAN basis. The Cisco UWN security solution provides simple, unified, and systematic security management tools.

One of the biggest hurdles to WLAN deployment in the enterprise is WEP encryption, which is a weak standalone encryption method. A newer problem is the availability of low-cost access points, which can be connected to the enterprise network and used to mount man-in-the-middle and denial-of-service attacks.

Layer 1 Solutions

The Cisco UWN security solution ensures that all clients gain access within a user-set number of attempts. If a client fails to gain access within that limit, it is automatically excluded (blocked from access) until the user-set timer expires. The operating system can also disable SSID broadcasts on a per-WLAN basis.

Layer 2 Solutions

If a higher level of security and encryption is required, you can also implement industry-standard security solutions such as Extensible Authentication Protocol (EAP), Wi-Fi Protected Access (WPA), and WPA2. The Cisco UWN solution WPA implementation includes AES (Advanced Encryption Standard), TKIP and Michael (temporal key integrity protocol and message integrity code checksum) dynamic keys, or WEP (Wired Equivalent Privacy) static keys. Disabling is also used to automatically block Layer 2 access after a user-set number of failed authentication attempts.

Regardless of the wireless security solution selected, all Layer 2 wired communications between controllers and lightweight access points are secured by passing data through CAPWAP tunnels.

Restrictions for Layer 2 Solutions

Cisco Aironet client adapter version 4.2 does not authenticate if WPA/WPA2 is used with CCKM as auth key management and a 2 second latency between the controller and AP.
Layer 3 Solutions

The WEP problem can be further solved using industry-standard Layer 3 security solutions such as passthrough VPNs (virtual private networks).

The Cisco UWN solution supports local and RADIUS MAC (media access control) filtering. This filtering is best suited to smaller client groups with a known list of 802.11 access card MAC addresses.

The Cisco UWN solution supports local and RADIUS user/password authentication. This authentication is best suited to small to medium client groups.

Integrated Security Solutions

The integrated security solutions are as follows:

- Cisco Unified Wireless Network (UWN) solution operating system security is built around a 802.1X AAA (authorization, authentication and accounting) engine, which allows users to rapidly configure and enforce a variety of security policies across the Cisco UWN solution.
- The controllers and lightweight access points are equipped with system-wide authentication and authorization protocols across all ports and interfaces, maximizing system security.
- Operating system security policies are assigned to individual WLANs, and lightweight access points simultaneously broadcast all (up to 16) configured WLANs, which can eliminate the need for additional access points, which can increase interference and degrade system throughput.
- Operating system security uses the RRM function to continually monitor the air space for interference and security breaches and to notify the user when they are detected.
- Operating system security works with industry-standard authorization, authentication, and accounting (AAA) servers.

Configuring RADIUS

Information About RADIUS

Remote Authentication Dial-In User Service (RADIUS) is a client/server protocol that provides centralized security for users attempting to gain management access to a network. It serves as a backend database similar to local and TACACS+ and provides authentication and accounting services:

- **Authentication**—The process of verifying users when they attempt to log into the controller.
  
  Users must enter a valid username and password in order for the controller to authenticate users to the RADIUS server. If multiple databases are configured, you can specify the sequence in which the backend database must be tried.

- **Accounting**—The process of recording user actions and changes.

  Whenever a user successfully executes an action, the RADIUS accounting server logs the changed attributes, the user ID of the person who made the change, the remote host where the user is logged in, the date and time when the command was executed, the authorization level of the user, and a description
of the action performed and the values provided. If the RADIUS accounting server becomes unreachable, users are able to continue their sessions uninterrupted.

RADIUS uses User Datagram Protocol (UDP) for its transport. It maintains a database and listens on UDP port 1812 for incoming authentication requests and UDP port 1813 for incoming accounting requests. The controller, which requires access control, acts as the client and requests AAA services from the server. The traffic between the controller and the server is encrypted by an algorithm defined in the protocol and a shared secret key configured on both devices.

You can configure multiple RADIUS accounting and authentication servers. For example, you may want to have one central RADIUS authentication server but several RADIUS accounting servers in different regions. If you configure multiple servers of the same type and the first one fails or becomes unreachable, the controller automatically tries the second one, then the third one if necessary, and so on.

When a management user is authenticated using a RADIUS server, only the PAP protocol is used. For web authentication users, PAP, MSCHAPv2 and MD5 security mechanisms are supported.

**RADIUS Server Support**

- You can configure up to 17 RADIUS authentication and accounting servers each.
- If multiple RADIUS servers are configured for redundancy, the user database must be identical in all the servers for the backup to work properly.
- One Time Passwords (OTPs) are supported on the controller using RADIUS. In this configuration, the controller acts as a transparent passthrough device. The controller forwards all client requests to the RADIUS server without inspecting the client behavior. When using OTP, the client must establish a single connection to the controller to function properly. The controller currently does not have any intelligence or checks to correct a client that is trying to establish multiple connections.
- To create a read-only controller user on the RADIUS server, you must set the service type to NAS prompt instead of Callback NAS prompt. If you set the service type to Callback NAS Prompt, the user authentication fails while setting it to NAS prompt gives the user read-only access to the controller. Also, the Callback Administrative service type gives the user the lobby ambassador privileges to the controller.
- If RADIUS servers are mapped per WLAN, then controller do not use RADIUS server from the global list on that WLAN.

**Radius ACS Support**

- You must configure RADIUS on both your CiscoSecure Access Control Server (ACS) and your controller.
- RADIUS is supported on CiscoSecure ACS version 3.2 and later releases. See the CiscoSecure ACS documentation for the version that you are running.

**Primary and Fallback RADIUS Servers**

The primary RADIUS server (the server with the lowest server index) is assumed to be the most preferable server for the controller. If the primary server becomes unresponsive, the controller switches to the next active backup server (the server with the next lowest server index). The controller continues to use this backup server, unless you configure the controller to fall back to the primary RADIUS server when it recovers and becomes responsive or to a more preferable server from the available backup servers.
Configuring RADIUS on the ACS

Step 1  Choose **Network Configuration** on the ACS main page.

Step 2  Choose **Add Entry** under AAA Clients to add your controller to the server. The Add AAA Client page appears.

*Figure 23: Add AAA Client Page on CiscoSecure ACS*

Step 3  In the **AAA Client Hostname** text box, enter the name of your controller.

Step 4  In the **AAA Client IP Address** text box, enter the IP address of your controller.

Step 5  In the **Shared Secret** text box, enter the shared secret key to be used for authentication between the server and the controller.

**Note**  The shared secret key must be the same on both the server and the controller.
Step 6  From the Authenticate Using drop-down list, choose RADIUS (Cisco Airespace).
Step 7  Click Submit + Apply to save your changes.
Step 8  Choose Interface Configuration on the ACS main page.
Step 9  Choose RADIUS (Cisco Aironet). The RADIUS (Cisco Aironet) page appears.
Step 10 Under User Group, select the Cisco-Aironet-Session-Timeout check box.
Step 11 Click Submit to save your changes.
Step 12 On the ACS main page, from the left navigation pane, choose System Configuration.
Step 13 Choose Logging.
Step 14 When the Logging Configuration page appears, enable all of the events that you want to be logged and save your changes.
Step 15 On the ACS main page, from the left navigation pane, choose Group Setup.
Step 16 Choose a previously created group from the Group drop-down list.
   Note This step assumes that you have already assigned users to groups on the ACS according to the roles to which they will be assigned.
Step 17 Click Edit Settings. The Group Setup page appears.
Step 18 Under Cisco Aironet Attributes, select the Cisco-Aironet-Session-Timeout check box and enter a session timeout value in the edit box.
Step 19 Specify read-only or read-write access to controllers through RADIUS authentication, by setting the Service-Type attribute (006) to Callback NAS Prompt for read-only access or to Administrative for read-write privileges. If you do not set this attribute, the authentication process completes successfully (without an authorization error on the controller), but you might be prompted to authenticate again.
   Note If you set the Service-Type attribute on the ACS, make sure to select the Management check box on the RADIUS Authentication Servers page of the controller GUI.
Step 20 Click Submit to save your changes.

Configuring RADIUS (GUI)

Step 1  Choose Security > AAA > RADIUS.
Step 2  Perform one of the following:
   • If you want to configure a RADIUS server for authentication, choose Authentication.
   • If you want to configure a RADIUS server for accounting, choose Accounting.

Note The pages used to configure authentication and accounting contain mostly the same text boxes. Therefore, these instructions walk through the configuration only once, using the Authentication pages as examples. You would follow the same steps to configure multiple services and/or multiple servers.
The RADIUS Authentication (or Accounting) Servers page appears. This page lists any RADIUS servers that have already been configured.
   • If you want to delete an existing server, hover your cursor over the blue drop-down arrow for that server and choose Remove.
If you want to make sure that the controller can reach a particular server, hover your cursor over the blue drop-down arrow for that server and choose **Ping**.

**Step 3**  
From the **Call Station ID Type** drop-down list, choose the option that is sent to the RADIUS server in the Access-Request message. The following options are available:

- IP Address
- System MAC Address
- AP MAC Address
- AP MAC Address:SSID
- AP Name:SSID
- AP Name
- AP Group
- Flex Group
- AP Location
- VLAN ID

**Note**  
The AP Name:SSID, AP Name, AP Group, Flex Group, AP Location, and VLAN ID options are added in the 7.4 release.

**Step 4**  
Enable RADIUS-to-controller key transport using AES key wrap protection by checking the **Use AES Key Wrap** check box. The default value is unchecked. This feature is required for FIPS customers.

**Step 5**  
From the **MAC Delimiter** drop-down list, choose the option that is sent to the RADIUS server in the Access-Request message. The following options are available:

- Colon
- Hyphen
- Single-hyphen
- None

**Step 6**  
Click **Apply**. Perform one of the following:

- To edit an existing RADIUS server, click the server index number for that server. The **RADIUS Authentication (or Accounting) Servers > Edit** page appears.
- To add a RADIUS server, click **New**. The **RADIUS Authentication (or Accounting) Servers > New** page appears.

**Step 7**  
If you are adding a new server, choose a number from the **Server Index (Priority)** drop-down list to specify the priority order of this server in relation to any other configured RADIUS servers providing the same service.

**Step 8**  
If you are adding a new server, enter the IP address of the RADIUS server in the **Server IP Address** text box.  

**Note**  
Auto IPv6 is not supported on RADIUS server. The RADIUS server must not be configured with Auto IPv6 address. Use fixed IPv6 address instead.
Step 9  From the Shared Secret Format drop-down list, choose ASCII or Hex to specify the format of the shared secret key to be used between the controller and the RADIUS server. The default value is ASCII.

Step 10 In the Shared Secret and Confirm Shared Secret text boxes, enter the shared secret key to be used for authentication between the controller and the server.

Note  The shared secret key must be the same on both the server and the controller.

Step 11 If you are configuring a new RADIUS authentication server and want to enable AES key wrap, which makes the shared secret between the controller and the RADIUS server more secure, follow these steps:

Note  AES key wrap is designed for Federal Information Processing Standards (FIPS) customers and requires a key-wrap compliant RADIUS authentication server.

a)  Check the Key Wrap check box.

b)  From the Key Wrap Format drop-down list, choose ASCII or HEX to specify the format of the AES key wrap keys: Key Encryption Key (KEK) and Message Authentication Code Key (MACK).

c)  In the Key Encryption Key (KEK) text box, enter the 16-byte KEK.

d)  In the Message Authentication Code Key (MACK) text box, enter the 20-byte KEK.

Step 12 If you are adding a new server, enter the RADIUS server’s UDP port number for the interface protocols in the Port Number text box. The valid range is 1 to 65535, and the default value is 1812 for authentication and 1813 for accounting.

Step 13 From the Server Status text box, choose Enabled to enable this RADIUS server or choose Disabled to disable it. The default value is enabled.

Step 14 If you are configuring a new RADIUS authentication server, choose Enabled from the Support for RFC 3576 drop-down list to enable RFC 3576, which is an extension to the RADIUS protocol that allows dynamic changes to a user session, or choose Disabled to disable this feature. The default value is Enabled. RFC 3576 includes support for disconnecting users and changing authorizations applicable to a user session and supports disconnect and change-of-authorization (CoA) messages. Disconnect messages cause a user session to be terminated immediately where CoA messages modify session authorization attributes such as data filters.

Step 15 In the Server Timeout text box, enter the number of seconds between retransmissions. The valid range is 2 to 30 seconds, and the default value is 2 seconds. Check the Key Wrap check box.

Note  We recommend that you increase the timeout value if you experience repeated reauthentication attempts or the controller falls back to the backup server when the primary server is active and reachable.

Step 16 Check the Network User check box to enable network user authentication (or accounting), or uncheck it to disable this feature. The default value is unchecked. If you enable this feature, this entry is considered the RADIUS authentication (or accounting) server for network users. If you did not configure a RADIUS server entry on the WLAN, you must enable this option for network users.

Step 17 If you are configuring a RADIUS authentication server, check the Management check box to enable management authentication, or uncheck the check box to disable this feature. The default value is checked. If you enable this feature, this entry is considered the RADIUS authentication server for management users, and authentication requests go to the RADIUS server.

Step 18 Enter the Management Retransmit Timeout value, which denotes the network login retransmission timeout for the server.

Step 19 Check the IPSec check box to enable the IP security mechanism, or uncheck the check box to disable this feature. The default value is unchecked.

Note  IPSec is not supported for IPv6. Use this only if you have used IPv4 for Server IP Address.

Step 20 If you enabled IPsec in Step 17, follow these steps to configure additional IPsec parameters:
a) From the IPSec drop-down list, choose one of the following options as the authentication protocol to be used for IP security: HMAC MD5 or HMAC SHA1. The default value is HMAC SHA1. A message authentication code (MAC) is used between two parties that share a secret key to validate information transmitted between them. HMAC (Hash MAC) is based on cryptographic hash functions. It can be used in combination with any iterated cryptographic hash function. HMAC MD5 and HMAC SHA1 are two constructs of the HMAC using the MD5 hash function and the SHA1 hash function. HMAC also uses a secret key for calculation and verification of the message authentication values.

b) From the IPSec Encryption drop-down list, choose one of the following options to specify the IP security encryption mechanism:

- **DES**—Data Encryption Standard that is a method of data encryption using a private (secret) key. DES applies a 56-bit key to each 64-bit block of data.
- **3DES**—Data Encryption Standard that applies three keys in succession. This is the default value.
- **AES CBC**—Advanced Encryption Standard that uses keys with a length of 128, 192, or 256 bits to encrypt data blocks with a length of 128, 192, or 256 bits. AES 128 CBC uses a 128-bit data path in Cipher Block Chaining (CBC) mode.
- **256-AES**—Advanced Encryption Standard that uses keys with a length of 256 bits.

c) From the IKE Phase 1 drop-down list, choose one of the following options to specify the Internet Key Exchange (IKE) protocol: Aggressive or Main. The default value is Aggressive. IKE Phase 1 is used to negotiate how IKE should be protected. Aggressive mode passes more information in fewer packets with the benefit of slightly faster connection establishment at the cost of transmitting the identities of the security gateways in the clear.

d) In the Lifetime text box, enter a value (in seconds) to specify the timeout interval for the session. The valid range is 1800 to 57600 seconds, and the default value is 1800 seconds.

e) From the IKE Diffie Hellman Group drop-down list, choose one of the following options to specify the IKE Diffie Hellman group: Group 1 (768 bits), Group 2 (1024 bits), or Group 5 (1536 bits). The default value is Group 1 (768 bits). Diffie-Hellman techniques are used by two devices to generate a symmetric key through which they can publicly exchange values and generate the same symmetric key. Although all three groups provide security from conventional attacks, Group 5 is considered more secure because of its larger key size. However, computations involving Group 1 and Group 2 based keys might occur slightly faster because of their smaller prime number size.

**Note** If the shared secret for IPSec is not configured, the default radius shared secret is used. If the authentication method is PSK, WLANCC should be enabled to use the IPSec shared secret, default value is used otherwise. You can view the status for the WLANCC and UCAPL prerequisite modes in Controller > Inventory.

**Step 21** Click **Apply**.

**Step 22** Click **Save Configuration**.

**Step 23** Repeat the previous steps if you want to configure any additional services on the same server or any additional RADIUS servers.

**Step 24** Specify the RADIUS server fallback behavior, as follows:

a) Choose Security > AAA > RADIUS > Fallback to open the RADIUS > Fallback Parameters to open the fallback parameters page.

b) From the **Fallback Mode** drop-down list, choose one of the following options:

- **Off**—Disables RADIUS server fallback. This is the default value.
• **Passive**—Causes the controller to revert to a server with a lower priority from the available backup servers without using extraneous probe messages. The controller ignores all inactive servers for a time period and retries later when a RADIUS message needs to be sent.

• **Active**—Causes the controller to revert to a server with a lower priority from the available backup servers by using RADIUS probe messages to proactively determine whether a server that has been marked inactive is back online. The controller ignores all inactive servers for all active RADIUS requests. Once the primary server receives a response from the recovered ACS server, the active fallback RADIUS server no longer sends probe messages to the server requesting the active probe authentication.

c) If you enabled Active fallback mode in Step b, enter the name to be sent in the inactive server probes in the **Username** text box. You can enter up to 16 alphanumeric characters. The default value is "cisco-probe."

d) If you enabled Active fallback mode in Step b, enter the probe interval value (in seconds) in the Interval in **Sec** text box. The interval serves as inactive time in passive mode and probe interval in active mode. The valid range is 180 to 3600 seconds, and the default value is 300 seconds.

**Step 25** Specify the order of authentication when multiple databases are configured by choosing **Security > Priority Order > Management User**. The Priority Order > Management User page appears.

**Step 26** In the Order Used for Authentication text box, specify which servers have priority when the controller attempts to authenticate management users. Use the > and < buttons to move servers between the Not Used and Order Used for Authentication text boxes. After the desired servers appear in the Order Used for **Authentication** text box, use the Up and Down buttons to move the priority server to the top of the list.

By default, the local database is always queried first. If the username is not found, the controller switches to the RADIUS server if configured for RADIUS or to the TACACS+ server if configured for TACACS+. The default setting is local and then RADIUS.

**Step 27** Click **Apply**.

**Step 28** Click **Save Configuration**.

### Configuring RADIUS (CLI)

- Specify whether the IP address, system MAC address, AP MAC address, AP Ethernet MAC address of the originator will be sent to the RADIUS server in the Access-Request message by entering this command:

  ```text
  config radius callStationIdType {ipaddr | macaddr | ap-macaddr-only | ap-macaddr-ssid | || ap-group-name | ap-location | ap-name | ap-name-ssid | flex-group-name | vlan-id}
  ```

**Note**

The default is System MAC Address.

**Caution**

Do not use Call Station ID Type for IPv6-only clients.

- Specify the delimiter to be used in the MAC addresses that are sent to the RADIUS authentication or accounting server in Access-Request messages by entering this command:

  ```text
  config radius {auth | acct} mac-delimiter {colon | hyphen | single-hyphen | none}
  ```
where

- **colon** sets the delimiter to a colon (the format is xx:xx:xx:xx:xx:xx).
- **hyphen** sets the delimiter to a hyphen (the format is xx-xx-xx-xx-xx-xx). This is the default value.
- **single-hyphen** sets the delimiter to a single hyphen (the format is xxxxxx-xxxxxx).
- **none** disables delimiters (the format is xxxxxxxxxxx).

- Configure a RADIUS authentication server by entering these commands:
  
  • `config radius auth add index server_ip_address port_number {ascii | hex} shared_secret`—Adds a RADIUS authentication server.
  
  • `config radius auth keywrap {enable | disable}`—Enables AES key wrap, which makes the shared secret between the controller and the RADIUS server more secure. AES key wrap is designed for Federal Information Processing Standards (FIPS) customers and requires a key-wrap compliant RADIUS authentication server.
  
  • `config radius auth keywrap add {ascii | hex} kek mack index`—Configures the AES key wrap attributes

  where

  - **kek** specifies the 16-byte Key Encryption Key (KEK).
  - **mack** specifies the 20-byte Message Authentication Code Key (MACK).
  - **index** specifies the index of the RADIUS authentication server on which to configure the AES key wrap.

  • `config radius auth rfc3576 {enable | disable} index`—Enables or disables RFC 3576, which is an extension to the RADIUS protocol that allows dynamic changes to a user session. RFC 3576 includes support for disconnecting users and changing authorizations applicable to a user session and supports disconnect and change-of-authorization (CoA) messages. Disconnect messages cause a user session to be terminated immediately where CoA messages modify session authorization attributes such as data filters.
  
  • `config radius auth retransmit-timeout index timeout`—Configures the retransmission timeout value for a RADIUS authentication server.
  
  • `config radius auth mgmt-retransmit-timeout index timeout`—Configures the default management login retransmission timeout for a RADIUS authentication server.
  
  • `config radius auth network index {enable | disable}`—Enables or disables network user authentication. If you enable this feature, this entry is considered the RADIUS authentication server for network users. If you did not configure a RADIUS server entry on the WLAN, you must enable this option for network users.
  
  • `config radius auth management index {enable | disable}`—Enables or disables management authentication. If you enable this feature, this entry is considered the RADIUS authentication server for management users, and authentication requests go to the RADIUS server.
  
  • `config radius auth ipsec {enable | disable} index`—Enables or disables the IP security mechanism.
  
  • `config radius auth ipsec authentication {hmac-md5 | hmac-sha1} index`—Configures the authentication protocol to be used for IP security.
• config radius auth ipsec encryption {3des | aes | des | none} index—Configures the IP security encryption mechanism.

• config radius auth ipsec ike dh-group {group-1 | group-2 | group-5} index—Configures the IKE Diffie-Hellman group.

• config radius auth ipsec ike lifetime interval index—Configures the timeout interval for the session.

• config radius auth ipsec ike phase1 {aggressive | main} index—Configures the Internet Key Exchange (IKE) protocol.

• config radius auth ipsec ike auth-method {PSK | certificate} index—Configures the IKE authentication methods. By default PSK is used for IPSEC sessions.

• config radius auth ipsec ike auth-mode pre-shared-key index hex/asciisecret—Configures the IPSEC pre-shared key.

• config radius auth {enable | disable} index—Enables or disables a RADIUS authentication server.

• config radius auth delete index—Deletes a previously added RADIUS authentication server.

• Configure a RADIUS accounting server by entering these commands:

  • config radius acct add index server_ip_address port# {asci | hex} shared_secret—Adds a RADIUS accounting server.

  • config radius acct server-timeout index timeout—Configures the retransmission timeout value for a RADIUS accounting server.

  • config radius acct network index {enable | disable}—Enables or disables network user accounting. If you enable this feature, this entry is considered the RADIUS accounting server for network users. If you did not configure a RADIUS server entry on the WLAN, you must enable this option for network users.

  • config radius acct ipsec {enable | disable} index—Enables or disables the IP security mechanism.

  • config radius acct ipsec authentication {hmac-md5 | hmac-sha1} index—Configures the authentication protocol to be used for IP security.

  • config radius acct ipsec encryption {3des | aes | des | none} index—Configures the IP security encryption mechanism.

  • config radius acct ipsec ike dh-group {group-1 | group-2 | group-5} index—Configures the IKE Diffie Hellman group.

  • config radius acct ipsec ike lifetime interval index—Configures the timeout interval for the session.

  • config radius acct ipsec ike phase1 {aggressive | main} index—Configures the Internet Key Exchange (IKE) protocol.

  • config radius acct {enable | disable} index—Enables or disables a RADIUS accounting server.

  • config radius acct delete index—Deletes a previously added RADIUS accounting server.

  • config radius auth callStationIdType {ap-macaddr-only | ap-macaddr-ssid}—Sets the Called Station ID type to be AP's radio MAC address or AP's radio MAC address with SSID in the <AP radio MAC address>::<SSID> format.
- `config radius auth callStationIdType {ipaddr | macaddr}`—Sets the Called Station ID type to use the IP address (only Layer 3) or system's MAC address.

- Configure the RADIUS server fallback behavior by entering this command:
  `config radius fallback-test mode {off | passive | active}`
  where
  - `off` disables RADIUS server fallback.
  - `passive` causes the controller to revert to a server with a lower priority from the available backup servers without using extraneous probe messages. The controller simply ignores all inactive servers for a time period and retries later when a RADIUS message needs to be sent.
  - `active` causes the controller to revert to a server with a lower priority from the available backup servers by using RADIUS probe messages to proactively determine whether a server that has been marked inactive is back online. The controller simply ignores all inactive servers for all active RADIUS requests. Once the primary server receives a response from the recovered ACS server, the active fallback RADIUS server no longer sends probe messages to the server requesting the active probe authentication.

- If you enabled Active mode in Step 5, enter these commands to configure additional fallback parameters:
  - `config radius fallback-test username username`—Specifies the name to be sent in the inactive server probes. You can enter up to 16 alphanumeric characters for the `username` parameter.
  - `config radius fallback-test interval interval`—Specifies the probe interval value (in seconds).

- Save your changes by entering this command:
  `save config`

- Configure the order of authentication when multiple databases are configured by entering this command:
  `config aaa auth mgmt AAA_server_type AAA_server_type`
  where `AAA_server_type` is local, radius, or tacacs.
  To see the current management authentication server order, enter the `show aaa auth` command.

- See RADIUS statistics by entering these commands:
  - `show radius summary`—Shows a summary of RADIUS servers and statistics with AP Ethernet MAC configurations.
  - `show radius auth statistics`—Shows the RADIUS authentication server statistics.
  - `show radius acct statistics`—Shows the RADIUS accounting server statistics.
  - `show radius rfc3576 statistics`—Shows a summary of the RADIUS RFC-3576 server.

- See active security associations by entering these commands:
  - `show ike {brief | detailed} ip_or_mac_addr`—Shows a brief or detailed summary of active IKE security associations.
  - `show ipsec {brief | detailed} ip_or_mac_addr`—Shows a brief or detailed summary of active IPSec security associations.

- Clear the statistics for one or more RADIUS servers by entering this command:
RADIUS Authentication Attributes Sent by the Controller

The following tables identify the RADIUS authentication attributes sent between the controller and the RADIUS server in access-request and access-accept packets.

**Table 7: Authentication Attributes Sent in Access-Request Packets**

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User-Name</td>
</tr>
<tr>
<td>2</td>
<td>Password</td>
</tr>
<tr>
<td>3</td>
<td>CHAP-Password</td>
</tr>
<tr>
<td>4</td>
<td>NAS-IP-Address</td>
</tr>
<tr>
<td>5</td>
<td>NAS-Port</td>
</tr>
<tr>
<td>6</td>
<td>Service-Type</td>
</tr>
<tr>
<td>12</td>
<td>Framed-MTU</td>
</tr>
<tr>
<td>30</td>
<td>Called-Station-ID (MAC address)</td>
</tr>
<tr>
<td>31</td>
<td>Calling-Station-ID (MAC address)</td>
</tr>
<tr>
<td>32</td>
<td>NAS-Identifier</td>
</tr>
<tr>
<td>33</td>
<td>Proxy-State</td>
</tr>
<tr>
<td>60</td>
<td>CHAP-Challenge</td>
</tr>
<tr>
<td>61</td>
<td>NAS-Port-Type</td>
</tr>
<tr>
<td>79</td>
<td>EAP-Message</td>
</tr>
</tbody>
</table>

4 To specify read-only or read-write access to controllers through RADIUS authentication, you must set the Service-Type attribute (6) on the RADIUS server to Callback NAS Prompt for read-only access or to Administrative for read-write privileges.

**Table 8: Authentication Attributes Honored in Access-Accept Packets (Cisco)**

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cisco-LEAP-Session-Key</td>
</tr>
<tr>
<td>2</td>
<td>Cisco-Keywrap-Msg-Auth-Code</td>
</tr>
<tr>
<td>3</td>
<td>Cisco-Keywrap-NonCE</td>
</tr>
<tr>
<td>4</td>
<td>Cisco-Keywrap-Key</td>
</tr>
</tbody>
</table>
These Cisco-specific attributes are not supported: Auth-Algo-Type and SSID.

### Table 9: Authentication Attributes Honored in Access-Accept Packets (Standard)

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Service-Type. To specify read-only or read-write access to controllers through RADIUS authentication, you must set the Service-Type attribute (6) on the RADIUS server to Callback NAS Prompt for read-only access or to Administrative for read-write privileges.</td>
</tr>
<tr>
<td>8</td>
<td>Framed-IP-Address</td>
</tr>
<tr>
<td>25</td>
<td>Class</td>
</tr>
<tr>
<td>26</td>
<td>Vendor-Specific</td>
</tr>
<tr>
<td>27</td>
<td>Timeout</td>
</tr>
<tr>
<td>29</td>
<td>Termination-Action</td>
</tr>
<tr>
<td>40</td>
<td>Acct-Status-Type</td>
</tr>
<tr>
<td>64</td>
<td>Tunnel-Type</td>
</tr>
<tr>
<td>79</td>
<td>EAP-Message</td>
</tr>
<tr>
<td>81</td>
<td>Tunnel-Group-ID</td>
</tr>
</tbody>
</table>

Message authentication is not supported.

### Table 10: Authentication Attributes Honored in Access-Accept Packets (Microsoft)

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>MS-CHAP-Challenge</td>
</tr>
<tr>
<td>16</td>
<td>MS-MPPE-Send-Key</td>
</tr>
<tr>
<td>17</td>
<td>MS-MPPE-Receive-Key</td>
</tr>
<tr>
<td>25</td>
<td>MS-MSCHAP2-Response</td>
</tr>
</tbody>
</table>
### RADIUS Accounting Attributes

This table identifies the RADIUS accounting attributes for accounting requests sent from a controller to the RADIUS server.

#### Table 12: Accounting Attributes for Accounting Requests

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User-Name</td>
</tr>
<tr>
<td>4</td>
<td>NAS-IP-Address</td>
</tr>
<tr>
<td>5</td>
<td>NAS-Port</td>
</tr>
<tr>
<td>8</td>
<td>Framed-IP-Address</td>
</tr>
<tr>
<td>25</td>
<td>Class</td>
</tr>
</tbody>
</table>

### RADIUS Accounting Attributes

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VAP-ID</td>
</tr>
<tr>
<td>3</td>
<td>DSCP</td>
</tr>
<tr>
<td>4</td>
<td>8021P-Type</td>
</tr>
<tr>
<td>5</td>
<td>VLAN-Interface-Name</td>
</tr>
<tr>
<td>6</td>
<td>ACL-Name</td>
</tr>
<tr>
<td>7</td>
<td>Data-Bandwidth-Average-Contract</td>
</tr>
<tr>
<td>8</td>
<td>Real-Time-Bandwidth-Average-Contract</td>
</tr>
<tr>
<td>9</td>
<td>Data-Bandwidth-Burst-Contract</td>
</tr>
<tr>
<td>10</td>
<td>Real-Time-Bandwidth-Burst-Contract</td>
</tr>
<tr>
<td>11</td>
<td>Guest-Role-Name</td>
</tr>
<tr>
<td>13</td>
<td>Data-Bandwidth-Average-Contract-US</td>
</tr>
<tr>
<td>14</td>
<td>Real-Time-Bandwidth-Average-Contract-US</td>
</tr>
<tr>
<td>15</td>
<td>Data-Bandwidth-Burst-Contract-US</td>
</tr>
<tr>
<td>16</td>
<td>Real-Time-Bandwidth-Burst-Contract-US</td>
</tr>
</tbody>
</table>

### Table 11: Authentication Attributes Honored in Access-Accept Packets ( Airespace)

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>26</td>
<td>MS-MSCHAP2-Success</td>
</tr>
</tbody>
</table>

### RADIUS Accounting Attributes

This table identifies the RADIUS accounting attributes for accounting requests sent from a controller to the RADIUS server.

#### Table 12: Accounting Attributes for Accounting Requests

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User-Name</td>
</tr>
<tr>
<td>4</td>
<td>NAS-IP-Address</td>
</tr>
<tr>
<td>5</td>
<td>NAS-Port</td>
</tr>
<tr>
<td>8</td>
<td>Framed-IP-Address</td>
</tr>
<tr>
<td>25</td>
<td>Class</td>
</tr>
<tr>
<td>Attribute ID</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>30</td>
<td>Called-Station-ID (MAC address)</td>
</tr>
<tr>
<td>31</td>
<td>Calling-Station-ID (MAC address)</td>
</tr>
<tr>
<td>32</td>
<td>NAS-Identifier</td>
</tr>
<tr>
<td>40</td>
<td>Accounting-Status-Type</td>
</tr>
<tr>
<td>41</td>
<td>Accounting-Delay-Time (Stop and interim messages only)</td>
</tr>
<tr>
<td>42</td>
<td>Accounting-Input-Octets (Stop and interim messages only)</td>
</tr>
<tr>
<td>43</td>
<td>Accounting-Output-Octets (Stop and interim messages only)</td>
</tr>
<tr>
<td>44</td>
<td>Accounting-Session-ID</td>
</tr>
<tr>
<td>45</td>
<td>Accounting-Authentic</td>
</tr>
<tr>
<td>46</td>
<td>Accounting-Session-Time (Stop and interim messages only)</td>
</tr>
<tr>
<td>47</td>
<td>Accounting-Input-Packets (Stop and interim messages only)</td>
</tr>
<tr>
<td>48</td>
<td>Accounting-Output-Packets (Stop and interim messages only)</td>
</tr>
<tr>
<td>49</td>
<td>Accounting-Terminate-Cause (Stop messages only)</td>
</tr>
<tr>
<td>52</td>
<td>Accounting-Input-Gigawords</td>
</tr>
<tr>
<td>53</td>
<td>Accounting-Output-Gigawords</td>
</tr>
<tr>
<td>55</td>
<td>Event-Timestamp</td>
</tr>
<tr>
<td>64</td>
<td>Tunnel-Type</td>
</tr>
<tr>
<td>65</td>
<td>Tunnel-Medium-Type</td>
</tr>
<tr>
<td>81</td>
<td>Tunnel-Group-ID</td>
</tr>
</tbody>
</table>

This table lists the different values for the Accounting-Status-Type attribute (40).

**Table 13: Accounting-Status-Type Attribute Values**

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start</td>
</tr>
<tr>
<td>2</td>
<td>Stop</td>
</tr>
<tr>
<td>3</td>
<td>Interim-Update</td>
</tr>
</tbody>
</table>

**Note**  
RADIUS Accounting Interim updates are sent upon each client authentication, even if the RADIUS Server Accounting - Interim Update feature is not enabled on the client's WLAN.

| 7            | Accounting-On               |
Configuring TACACS+

Information About TACACS+

Terminal Access Controller Access Control System Plus (TACACS+) is a client/server protocol that provides centralized security for users attempting to gain management access to a controller. It serves as a backend database similar to local and RADIUS. However, local and RADIUS provide only authentication support and limited authorization support while TACACS+ provides three services:

• **Authentication**—The process of verifying users when they attempt to log into the controller.

  Users must enter a valid username and password in order for the controller to authenticate users to the TACACS+ server. The authentication and authorization services are tied to one another. For example, if authentication is performed using the local or RADIUS database, then authorization would use the permissions associated with the user in the local or RADIUS database (which are read-only, read-write, and lobby-admin) and not use TACACS+. Similarly, when authentication is performed using TACACS+, authorization is tied to TACACS+.

  When multiple databases are configured, you can use the controller GUI or CLI to specify the sequence in which the backend databases should be tried.

• **Authorization**—The process of determining the actions that users are allowed to take on the controller based on their level of access.

  For TACACS+, authorization is based on privilege (or role) rather than specific actions. The available roles correspond to the seven menu options on the controller GUI: MONITOR, WLAN, CONTROLLER, WIRELESS, SECURITY, MANAGEMENT, and COMMANDS. An additional role, LOBBY, is available for users who require only lobby ambassador privileges. The roles to which users are assigned are configured on the TACACS+ server. Users can be authorized for one or more roles. The minimum authorization is MONITOR only, and the maximum is ALL, which authorizes the user to execute the functionality associated with all seven menu options. For example, a user who is assigned the role of SECURITY can make changes to any items appearing on the Security menu (or designated as security commands in the case of the CLI). If users are not authorized for a particular role (such as WLAN), they can still access that menu option in read-only mode (or the associated CLI show commands). If the TACACS+ authorization server becomes unreachable or unable to authorize, users are unable to log into the controller.
If users attempt to make changes on a controller GUI page that are not permitted for their assigned role, a message appears indicating that they do not have sufficient privilege. If users enter a controller CLI command that is not permitted for their assigned role, a message may appear indicating that the command was successfully executed although it was not. In this case, the following additional message appears to inform users that they lack sufficient privileges to successfully execute the command: "Insufficient Privilege! Cannot execute command!"

• **Accounting**—The process of recording user actions and changes. Whenever a user successfully executes an action, the TACACS+ accounting server logs the changed attributes, the user ID of the person who made the change, the remote host where the user is logged in, the date and time when the command was executed, the authorization level of the user, and a description of the action performed and the values provided. If the TACACS+ accounting server becomes unreachable, users are able to continue their sessions uninterrupted.

TACACS+ uses Transmission Control Protocol (TCP) for its transport, unlike RADIUS which uses User Datagram Protocol (UDP). It maintains a database and listens on TCP port 49 for incoming requests. The controller, which requires access control, acts as the client and requests AAA services from the server. The traffic between the controller and the server is encrypted by an algorithm defined in the protocol and a shared secret key configured on both devices.

You can configure up to three TACACS+ authentication, authorization, and accounting servers each. For example, you may want to have one central TACACS+ authentication server but several TACACS+ authorization servers in different regions. If you configure multiple servers of the same type and the first one fails or becomes unreachable, the controller automatically tries the second one and then the third one if necessary.

If multiple TACACS+ servers are configured for redundancy, the user database must be identical in all the servers for the backup to work properly.

The following are some guidelines about TACACS+:

• You must configure TACACS+ on both your CiscoSecure Access Control Server (ACS) and your controller. You can configure the controller through either the GUI or the CLI.

• TACACS+ is supported on CiscoSecure ACS version 3.2 and later releases. See the CiscoSecure ACS documentation for the version that you are running.

• One Time Passwords (OTPs) are supported on the controller using TACACS. In this configuration, the controller acts as a transparent passthrough device. The controller forwards all client requests to the TACACS server without inspecting the client behavior. When using OTP, the client must establish a single connection to the controller to function properly. The controller currently does not have any intelligence or checks to correct a client that is trying to establish multiple connections.

• We recommend that you increase the retransmit timeout value for TACACS+ authentication, authorization, and accounting servers if you experience repeated reauthentication attempts or the controller falls back to the backup server when the primary server is active and reachable. The default retransmit timeout value is 2 seconds and you can increase the retransmit timeout value to a maximum of 30 seconds.
The Internet Engineering Task Force (IETF) draft standard specifies a method for communicating vendor-specific attributes (VSAs) between the network access server and the TACACS+ server. The IETF uses attribute 26. VSAs allow vendors to support their own extended attributes that are not suitable for general use.

The Cisco TACACS+ implementation supports one vendor-specific option using the format recommended in the IETF specification. The Cisco vendor ID is 9, and the supported option is vendor type 1, which is named cisco-av-pair. The value is a string with the following format:

```
protocol : attribute separator value *
```

The protocol is a Cisco attribute for a particular type of authorization, the separator is = (equal sign) for mandatory attributes, and * (asterisk) indicates optional attributes.

### Configuring TACACS+ on the ACS

**Step 1** Choose **Network Configuration** on the ACS main page.

**Step 2** Choose **Add Entry** under AAA Clients to add your controller to the server. The Add AAA Client page appears.

*Figure 24: Add AAA Client Page on CiscoSecure ACS*
Step 3 In the **AAA Client Hostname** text box, enter the name of your controller.

Step 4 In the **AAA Client IP Address** text box, enter the IP address of your controller.

Step 5 In the **Shared Secret** text box, enter the shared secret key to be used for authentication between the server and the controller.

**Note** The shared secret key must be the same on both the server and the controller.

Step 6 From the Authenticate Using drop-down list, choose **TACACS+ (Cisco IOS)**.

Step 7 Click **Submit + Apply** to save your changes.

Step 8 On the ACS main page, in the left navigation pane, choose **Interface Configuration**.

Step 9 Choose **TACACS+ (Cisco IOS)**. The TACACS+ (Cisco) page appears.

Step 10 Under **TACACS+ Services**, select the **Shell (exec)** check box.

Step 11 Under **New Services**, select the first check box and enter **ciscowlc** in the Service text box and **common** in the Protocol text box.

Step 12 Under **Advanced Configuration Options**, select the **Advanced TACACS+ Features** check box.

Step 13 Click **Submit** to save your changes.

Step 14 On the ACS main page, in the left navigation pane, choose **System Configuration**.

Step 15 Choose **Logging**.

Step 16 When the Logging Configuration page appears, enable all of the events that you want to be logged and save your changes.

Step 17 On the ACS main page, in the left navigation pane, choose **Group Setup**.

Step 18 From the Group drop-down list, choose a previously created group.

**Note** This step assumes that you have already assigned users to groups on the ACS according to the roles to which they will be assigned.

Step 19 Click **Edit Settings**. The Group Setup page appears.

Step 20 Under **TACACS+ Settings**, select the **ciscowlc common** check box.

Step 21 Select the **Custom Attributes** check box.

Step 22 In the text box below Custom Attributes, specify the roles that you want to assign to this group. The available roles are MONITOR, WLAN, CONTROLLER, WIRELESS, SECURITY, MANAGEMENT, COMMANDS, ALL, and LOBBY. The first seven correspond to the menu options on the controller GUI and allow access to those particular controller features. If a user is not entitled for a particular task, the user is still allowed to access that task in read-only mode. You can enter one or multiple roles, depending on the group’s needs. Use ALL to specify all seven roles or LOBBY to specify the lobby ambassador role. Enter the roles using this format:

role1=ROLE
role2=ROLE
role3=ROLE

For example, to specify the WLAN, CONTROLLER, and SECURITY roles for a particular user group, you would enter the following text:

```
role1=WLAN
role2=CONTROLLER
role3=SECURITY
```

To give a user group access to all seven roles, you would enter the following text:

```
role1=ALL
```

**Note** Make sure to enter the roles using the format shown above. The roles must be in all uppercase letters, and there can be no spaces within the text.
You should not combine the MONITOR role or the LOBBY role with any other roles. If you specify one of these two roles in the Custom Attributes text box, users will have MONITOR or LOBBY privileges only, even if additional roles are specified.

**Step 23** Click *Submit* to save your changes.

---

**Configuring TACACS+ (GUI)**

**Step 1** Choose Security > AAA > TACACS+.

**Step 2** Perform one of the following:

- If you want to configure a TACACS+ server for authentication, choose **Authentication**.
- If you want to configure a TACACS+ server for authorization, choose **Authorization**.
- If you want to configure a TACACS+ server for accounting, choose **Accounting**.

**Note** The pages used to configure authentication, authorization, and accounting all contain the same text boxes. Therefore, these instructions walk through the configuration only once, using the Authentication pages as examples. You would follow the same steps to configure multiple services and/or multiple servers.

**Note** For basic management authentication via TACACS+ to succeed, it is required to configure authentication and authorization servers on the WLC. Accounting configuration is optional.

The TACACS+ (Authentication, Authorization, or Accounting) Servers page appears. This page lists any TACACS+ servers that have already been configured.

- If you want to delete an existing server, hover your cursor over the blue drop-down arrow for that server and choose **Remove**.
- If you want to make sure that the controller can reach a particular server, hover your cursor over the blue drop-down arrow for that server and choose **Ping**.

**Step 3** Perform one of the following:

- To edit an existing TACACS+ server, click the server index number for that server. The **TACACS+ (Authentication, Authorization, or Accounting) Servers > Edit** page appears.
- To add a TACACS+ server, click **New**. The **TACACS+ (Authentication, Authorization, or Accounting) Servers > New** page appears.

**Step 4** If you are adding a new server, choose a number from the Server Index (Priority) drop-down list to specify the priority order of this server in relation to any other configured TACACS+ servers providing the same service. You can configure
Configuring TACACS+ (CLI)

- Configure a TACACS+ authentication server by entering these commands:
  - `config tacacs auth add index server_ip_address port# {ascii | hex} shared_secret`—Adds a TACACS+ authentication server.
  - `config tacacs auth delete index`—Deletes a previously added TACACS+ authentication server.
  - `config tacacs auth (enable | disable) index`—Enables or disables a TACACS+ authentication server.
• **config tacacs auth server-timeout index timeout**—Configures the retransmission timeout value for a TACACS+ authentication server.

• Configure a TACACS+ authorization server by entering these commands:
  - * config tacacs athr add index server_ip_address port# {ascii | hex} shared_secret—Adds a TACACS+ authorization server.
  - * config tacacs athr delete index—Deletes a previously added TACACS+ authorization server.
  - * config tacacs athr (enable | disable) index—Enables or disables a TACACS+ authorization server.
  - * config tacacs athr server-timeout index timeout—Configures the retransmission timeout value for a TACACS+ authorization server.

• Configure a TACACS+ accounting server by entering these commands:
  - * config tacacs acct add index server_ip_address port# {ascii | hex} shared_secret—Adds a TACACS+ accounting server.
  - * config tacacs acct delete index—Deletes a previously added TACACS+ accounting server.
  - * config tacacs acct (enable | disable) index—Enables or disables a TACACS+ accounting server.
  - * config tacacs acct server-timeout index timeout—Configures the retransmission timeout value for a TACACS+ accounting server.

• See TACACS+ statistics by entering these commands:
  - * show tacacs summary—Shows a summary of TACACS+ servers and statistics.
  - * show tacacs auth stats—Shows the TACACS+ authentication server statistics.
  - * show tacacs athr stats—Shows the TACACS+ authorization server statistics.
  - * show tacacs acct stats—Shows the TACACS+ accounting server statistics.

• Clear the statistics for one or more TACACS+ servers by entering this command:
  `clear stats tacacs [auth | athr | acct] {index | all}`

• Configure the order of authentication when multiple databases are configured by entering this command.
The default setting is local and then radius.
  `config aaa auth mgmt [radius | tacacs]`

  See the current management authentication server order by entering the `show aaa auth` command.

• Make sure the controller can reach the TACACS+ server by entering this command:
  `ping server_ip_address`

• Enable or disable TACACS+ debugging by entering this command:
  `debug aaa tacacs {enable | disable}`

• Save your changes by entering this command:
  `save config`
Viewing the TACACS+ Administration Server Logs

**Step 1**
On the ACS main page, in the left navigation pane, choose **Reports and Activity**.

**Step 2**
Under Reports, choose **TACACS+ Administration**.
Click the .csv file corresponding to the date of the logs you want to view. The TACACS+ Administration .csv page appears.

*Figure 25: TACACS+ Administration .csv Page on CiscoSecure ACS*

This page displays the following information:

- Date and time the action was taken
- Name and assigned role of the user who took the action
- Group to which the user belongs
- Specific action that the user took
- Privilege level of the user who executed the action
- IP address of the controller
- IP address of the laptop or workstation from which the action was executed

Sometimes a single action (or command) is logged multiple times, once for each parameter in the command. For example, if you enter the **snmp community ipaddr ip_address subnet_mask community_name** command, the IP address may be
logged on one line while the subnet mask and community name are logged as "E." On another line, the subnet mask maybe logged while the IP address and community name are logged as "E." See the first and third lines in the example in this figure.

Figure 26: TACACS+ Administration .csv Page on CiscoSecure ACS

Configuring Maximum Local Database Entries

Information About Configuring Maximum Local Database Entries

You can configure the controller to specify the maximum number of local database entries used for storing user authentication information. The database entries include local management users (including lobby ambassadors), local network users (including guest users), MAC filter entries, exclusion list entries, and access point authorization list entries. Together they cannot exceed the configured maximum value.
Configuring Maximum Local Database Entries (GUI)

Step 1  Choose Security > AAA > General to open the General page.
Step 2  In the Maximum Local Database Entries text box, enter a value for the maximum number of entries that can be added to the local database the next time the controller reboots. The currently configured value appears in parentheses to the right of the text box. The valid range is 512 to 2048, and the default setting is 2048. The Number of Entries, Already Used text box shows the number of entries currently in the database.
Step 3  Click Apply to commit your changes.
Step 4  Click Save Configuration to save your settings.

Configuring Maximum Local Database Entries (CLI)

Step 1  Specify the maximum number of entries that can be added to the local database the next time the controller reboots by entering this command:

```
config database size max_entries
```

Step 2  Save your changes by entering this command:

```
save config
```

Step 3  View the maximum number of database entries and the current database contents by entering this command:

```
show database summary
```

Configuring Local Network Users on the Controller

Information About Local Network Users on Controller

You can add local network users to the local user database on the controller. The local user database stores the credentials (username and password) of all the local network users. These credentials are then used to authenticate the users. For example, local EAP may use the local user database as its backend database to retrieve user credentials.
The controller passes client information to the RADIUS authentication server first. If the client information does not match a RADIUS database entry, the RADIUS authentication server replies with an authentication failure message. If the RADIUS authentication server does not reply, then the local user database is queried. Clients located in this database are granted access to network services if the RADIUS authentication fails or does not exist.

### Configuring Local Network Users for the Controller (GUI)

**Step 1**  
Choose Security > AAA > Local Net Users to open the Local Net Users page.  
**Note**  
If you want to delete an existing user, hover your cursor over the blue drop-down arrow for that user and choose Remove.

**Step 2**  
Perform one of the following:  
- To edit an existing local network user, click the username for that user. The Local Net Users > Edit page appears.
- To add a local network user, click New. The Local Net Users > New page appears.

**Step 3**  
If you are adding a new user, enter a username for the local user in the User Name text box. You can enter up to 49 alphanumeric characters.  
**Note**  
Local network usernames must be unique because they are all stored in the same database.

**Step 4**  
In the Password and Confirm Password text boxes, enter a password for the local user. You can enter up to 49 alphanumeric characters.

**Step 5**  
If you are adding a new user, select the Guest User check box if you want to limit the amount of time that the user has access to the local network. The default setting is unselected.

**Step 6**  
If you are adding a new user and you selected the Guest User check box, enter the amount of time (in seconds) that the guest user account is to remain active in the Lifetime text box. The valid range is 60 to 2,592,000 seconds (30 days) inclusive, and the default setting is 86,400 seconds.

**Step 7**  
If you are adding a new user, you selected the Guest User check box, and you want to assign a QoS role to this guest user, select the Guest User Role check box. The default setting is unselected.  
**Note**  
If you do not assign a QoS role to a guest user, the bandwidth contracts for this user are defined in the QoS profile for the WLAN.

**Step 8**  
If you are adding a new user and you selected the Guest User Role check box, choose the QoS role that you want to assign to this guest user from the Role drop-down list.

**Step 9**  
From the WLAN Profile drop-down list, choose the name of the WLAN that is to be accessed by the local user. If you choose Any WLAN, which is the default setting, the user can access any of the configured WLANs.

**Step 10**  
In the Description text box, enter a descriptive title for the local user (such as “User 1”).

**Step 11**  
Click Apply to commit your changes.

**Step 12**  
Click Save Configuration to save your changes.
Configuring Local Network Users for the Controller (CLI)

• Configure a local network user by entering these commands:

  - `config netuser add username password wlan wlan_id userType permanent description description`—Adds a permanent user to the local user database on the controller.

  - `config netuser add username password {wlan | guestlan} {wlan_id | guest_lan_id} userType guest_lifetime seconds description description`—Adds a guest user on a WLAN or wired guest LAN to the local user database on the controller.

Note

Instead of adding a permanent user or a guest user to the local user database from the controller, you can choose to create an entry on the RADIUS server for the user and enable RADIUS authentication for the WLAN on which web authentication is performed.

- `config netuser delete username`  
  - `username`—Deletes a user from the local user database on the controller.

Note

Local network usernames must be unique because they are all stored in the same database.

• See information related to the local network users configured on the controller by entering these commands:

  - `show netuser detail username`—Shows the configuration of a particular user in the local user database.

  - `show netuser summary`—Lists all the users in the local user database.

• Save your changes by entering this command:
  `save config`

Additional References

To know more about configuring local network users, see Configuring Local EAP, on page 231.

Configuring Password Policies

Information About Password Policies

The password policies allows you to enforce strong password checks on newly created passwords for additional management users of controller and access point. The following are the requirements enforced on the new password:
• When the controller is upgraded from old version, all the old passwords are maintained as it is, even though the passwords are weak. After the system upgrade, if strong password checks are enabled, the same is enforced from that time and the strength of previously added passwords will not be checked or altered.

• Depending on the settings done in the Password Policy page, the local management and access point user configuration is affected.

### Configuring Password Policies (GUI)

**Step 1** Choose Security > AAA > Password Policies to open the Password Policies page.

**Step 2** Select the Password must contain characters from at least 3 different classes check box if you want your password to contain characters from at least three of the following classes: lower case letters, upper case letters, digits, and special characters.

**Step 3** Select the No character can be repeated more than 3 times consecutively check box if you do not want character in the new password to repeat more than three times consecutively.

**Step 4** Select the Password cannot be the default words like cisco, admin check box if you do not want the password to contain words such as Cisco, ocisic, admin, nimda, or any variant obtained by changing the capitalization of letters or by substituting 1, |, or! or substituting 0 for o or substituting $ for s.

**Step 5** Select the Password cannot contain username or reverse of username check box if you do not want the password to contain a username or the reverse letters of a username.

**Step 6** Click Apply to commit your changes.

**Step 7** Click Save Configuration to save your changes.

### Configuring Password Policies (CLI)

• Enable or disable strong password check for AP and WLC by entering this command:

```
config switchconfig strong-pwd \{case-check | consecutive-check | default-check | username-check \| all-checks\} \{enable | disable\}
```

where

* **case-check**—Checks the occurrence of same character thrice consecutively
* **consecutive-check**—Checks the default values or its variants are being used.
* **default-check**—Checks either username or its reverse is being used.
* **all-checks**—Enables/disables all the strong password checks.

• See the configured options for strong password check by entering this command:

```
show switchconfig
```
Information similar to the following appears:

- **802.3x Flow Control Mode**: Disabled
- **FIPS prerequisite features**: Disabled
- **secret obfuscation**: Enabled
- **Strong Password Check Features**:
  - case-check: Enabled
  - consecutive-check: Enabled
  - default-check: Enabled
  - username-check: Enabled

## Configuring LDAP

This section explains how to configure a Lightweight Directory Access Protocol (LDAP) server as a backend database, similar to a RADIUS or local user database.

### Information About LDAP

An LDAP backend database allows the controller to query an LDAP server for the credentials (username and password) of a particular user. These credentials are then used to authenticate the user. For example, local EAP may use an LDAP server as its backend database to retrieve user credentials.

#### Note

From Release 8.0, IPv6 can also be used to configure the LDAP server on the controller.

### Fallback LDAP Servers

The LDAP servers are configured on a WLAN for authentication. You require at least two LDAP servers to configure them for fallback behavior. A maximum of three LDAP servers can be configured for the fallback behavior per WLAN. The servers are listed in the priority order for authentication. If the first LDAP server becomes unresponsive, then the controller switches to the next LDAP server. If the second LDAP server becomes unresponsive, then the controller switches again to the third LDAP server.

The LDAP backend database supports these local EAP methods: EAP-TLS, EAP-FAST/GTC, and PEAPv1/GTC. LEAP, EAP-FAST/MSCHAPv2, EAP-FAST/EAP-GTC and PEAPv0/MSCHAPv2 are also supported, but only if the LDAP server is set up to return a clear-text password.

Configuring LDAP (GUI)

Step 1
Choose Security > AAA > LDAP to open the LDAP Servers page.

- If you want to delete an existing LDAP server, hover your cursor over the blue drop-down arrow for that server and choose Remove.
- If you want to make sure that the controller can reach a particular server, hover your cursor over the blue drop-down arrow for that server and choose Ping.

Step 2
Perform one of the following:

- To edit an existing LDAP server, click the index number for that server. The LDAP Servers > Edit page appears.
- To add an LDAP server, click New. The LDAP Servers > New page appears. If you are adding a new server, choose a number from the Server Index (Priority) drop-down list to specify the priority order of this server in relation to any other configured LDAP servers. You can configure up to 17 servers. If the controller cannot reach the first server, it tries the second one in the list and so on.

Step 3
If you are adding a new server, enter the IP address of the LDAP server in the Server IP Address text box.

Note From Release 8.0, IPv6 can also be used to configure the LDAP server on the controller.

Step 4
If you are adding a new server, enter the LDAP server's TCP port number in the Port Number text box. The valid range is 1 to 65535, and the default value is 389.

Note Only LDAP port 389 is supported on Cisco WLC. No other ports are supported for LDAP.

Step 5
From the Server Mode drop-down list, choose None.

Step 6
Select the Enable Server Status check box to enable this LDAP server or unselect it to disable it. The default value is disabled.

Step 7
From the Simple Bind drop-down list, choose Anonymous or Authenticated to specify the local authentication bind method for the LDAP server. The Anonymous method allows anonymous access to the LDAP server. The Authenticated method requires that a username and password be entered to secure access. The default value is Anonymous.

Step 8
If you chose Authenticated in the previous step, follow these steps:

a) In the Bind Username text box, enter a username to be used for local authentication to the LDAP server. The username can contain up to 80 characters.

Note If the username starts with “cn=” (in lowercase letters), the controller assumes that the username includes the entire LDAP database path and does not append the user base DN. This designation allows the authenticated bind user to be outside the user base DN.

b) In the Bind Username text box, enter a username to be used for local authentication to the LDAP server. The username can contain up to 80 characters.

Step 9
In the User Base DN text box, enter the distinguished name (DN) of the subtree in the LDAP server that contains a list of all the users. For example, ou=organizational unit, .ou=next organizational unit, and o=corporation.com. If the tree containing users is the base DN, type.

o=corporation.com

or
dc=corporation,dc=com

Step 10 In the User Attribute text box, enter the name of the attribute in the user record that contains the username. You can obtain this attribute from your directory server.

Step 11 In the User Object Type text box, enter the value of the LDAP objectType attribute that identifies the record as a user. Often, user records have several values for the objectType attribute, some of which are unique to the user and some of which are shared with other object types.

Step 12 In the Server Timeout text box, enter the number of seconds between retransmissions. The valid range is 2 to 30 seconds, and the default value is 2 seconds.

Step 13 Click Apply to commit your changes.

Step 14 Click Save Configuration to save your changes.

Step 15 Specify LDAP as the priority backend database server for local EAP authentication as follows:
   a) Choose Security > Local EAP > Authentication Priority to open the Priority Order > Local-Auth page.
   b) Highlight LOCAL and click < to move it to the left User Credentials box.
   c) Highlight LDAP and click > to move it to the right User Credentials box. The database that appears at the top of the right User Credentials box is used when retrieving user credentials.

   Note If both LDAP and LOCAL appear in the right User Credentials box with LDAP on the top and LOCAL on the bottom, local EAP attempts to authenticate clients using the LDAP backend database and fails over to the local user database if the LDAP servers are not reachable. If the user is not found, the authentication attempt is rejected. If LOCAL is on the top, local EAP attempts to authenticate using only the local user database. It does not fail over to the LDAP backend database.

   d) Click Apply to commit your changes.
   e) Click Save Configuration to save your changes.

Step 16 (Optional) Assign specific LDAP servers to a WLAN as follows:
   a) Choose WLANs to open the WLANs page.
   b) Click the ID number of the desired WLAN.
   c) When the WLANs > Edit page appears, choose the Security > AAA Servers tabs to open the WLANs > Edit (Security > AAA Servers) page.
   d) From the LDAP Servers drop-down lists, choose the LDAP server(s) that you want to use with this WLAN. You can choose up to three LDAP servers, which are tried in priority order.

   Note These LDAP servers apply only to WLANs with web authentication enabled. They are not used by local EAP.

   e) Click Apply to commit your changes.
   f) Click Save Configuration to save your changes.

Step 17 Specify the LDAP server fallback behavior, as follows:
   a) Choose WLAN > AAA Server to open the Fallback Parameters page.
   b) From the LDAP Servers drop-down list, choose the LDAP server in the order of priority when the controller attempts to authenticate management users. The order of authentication is from server.
   c) Choose Security > AAA > LDAP to view the list of global LDAP servers configured for the controller.
Configuring LDAP (CLI)

• Configure an LDAP server by entering these commands:
  
  * `config ldap add index server_ip_address port# user_base user_attr user_type` — Adds an LDAP server.
  
  * `config ldap delete index` — Deletes a previously added LDAP server.
  
  * `config ldap {enable | disable} index` — Enables or disables an LDAP server.
  
  * `config ldap simple-bind {anonymous index | authenticated index username username password password}` — Specifies the local authentication bind method for the LDAP server. The anonymous method allows anonymous access to the LDAP server whereas the authenticated method requires that a username and password be entered to secure access. The default value is anonymous. The username can contain up to 80 characters.

  If the username starts with "cn=" (in lowercase letters), the controller assumes that the username includes the entire LDAP database path and does not append the user base DN. This designation allows the authenticated bind user to be outside the user base DN.

  * `config ldap retransmit-timeout index timeout` — Configures the number of seconds between retransmissions for an LDAP server.

• Specify LDAP as the priority backend database server by entering this command:
  
  `config local-auth user-credentials ldap`

  If you enter the `config local-auth user-credentials ldap local command`, local EAP attempts to authenticate clients using the LDAP backend database and fails over to the local user database if the LDAP servers are not reachable. If the user is not found, the authentication attempt is rejected. If you enter the `config local-auth user-credentials local ldap command`, local EAP attempts to authenticate using only the local user database. It does not fail over to the LDAP backend database.

• (Optional) Assign specific LDAP servers to a WLAN by entering these commands:

  * `config wlan ldap add wlan_id server_index` — Links a configured LDAP server to a WLAN. The LDAP servers specified in this command apply only to WLANs with web authentication enabled. They are not used by local EAP.

  * `config wlan ldap delete wlan_id {all | index}` — Deletes a specific or all configured LDAP server(s) from a WLAN.

• View information pertaining to configured LDAP servers by entering these commands:

  * `show ldap summary` — Shows a summary of the configured LDAP servers.

      Idx Server Address Port Enabled
      --- --------------- ---- -------
      1 2.3.1.4 389 No
      2 10.10.20.22 389 Yes

  * `show ldap index` — Shows detailed LDAP server information. Information like the following appears:

      Server Index.............................. 2
      Address................................. 10.10.20.22
      Port................................. 389
Enabled.......................................... Yes
User DN.......................................... ou=active,ou=employees,ou=people,
o=cisco.com
User Attribute................................... uid
User Type........................................ Person
Retransmit Timeout............................... 2 seconds
Bind Method ..................................... Authenticated
Bind Username.................................. user1

*show ldap statistics—Shows LDAP server statistics.

Server Index................................. 1
Server statistics:
  Initialized OK............................... 0
  Initialization failed........................ 0
  Initialization retries........................ 0
  Closed OK.................................... 0
Request statistics:
  Received...................................... 0
  Sent.......................................... 0
  OK............................................ 0
  Success....................................... 0
  Authentication failed....................... 0
  Server not found............................ 0
  No received attributes...................... 0
  No passed username........................... 0
  Not connected to server.................... 0
  Internal error................................ 0
  Retries...................................... 0

Server Index................................. 2
...

*show wlan wlan_id—Shows the LDAP servers that are applied to a WLAN.

- Make sure the controller can reach the LDAP server by entering this command:
  ping server_ip_address
- Save your changes by entering this command:
  save config
- Enable or disable debugging for LDAP by entering this command:
  debug aaa ldap {enable | disable}

Additional References

For more information about configuring LEAP, see the Configuring Local EAP, on page 231 section

Configuring Local EAP

Information About Local EAP

Local EAP is an authentication method that allows users and wireless clients to be authenticated locally. It is designed for use in remote offices that want to maintain connectivity to wireless clients when the backend system becomes disrupted or the external authentication server goes down. When you enable local EAP, the controller serves as the authentication server and the local user database, which removes dependence on an
external authentication server. Local EAP retrieves user credentials from the local user database or the LDAP backend database to authenticate users. Local EAP supports LEAP, EAP-FAST, EAP-TLS, P EAPv0/MSCHAPv2, and PEAPv1/GTC authentication between the controller and wireless clients.

The LDAP backend database supports these local EAP methods: EAP-TLS, EAP-FAST/GTC, and PEAPv1/GTC. LEAP, EAP-FAST/MSCHAPv2, and PEAPv0/MSCHAPv2 are also supported but only if the LDAP server is set up to return a clear-text password.


If any RADIUS servers are configured on the controller, the controller tries to authenticate the wireless clients using the RADIUS servers first. Local EAP is attempted only if no RADIUS servers are found, either because the RADIUS servers timed out or no RADIUS servers were configured. If four RADIUS servers are configured, the controller attempts to authenticate the client with the first RADIUS server, then the second RADIUS server, and then local EAP. If the client attempts to then reauthenticate manually, the controller tries the third RADIUS server, then the fourth RADIUS server, and then local EAP. If you never want the controller to try to authenticate clients using an external RADIUS server, enter these CLI commands in this order:

- `config wlan disable wlan_id`
- `config wlan radius_server auth disable wlan_id`
Restrictions on Local EAP

- Local EAP profiles are not supported on Cisco 600 Series OfficeExtend access points.
Configuring Local EAP (GUI)

Before You Begin

Note

EAP-TLS, P EAPv0/MSCHAPv2, and PEAPv1/GTC use certificates for authentication, and EAP-FAST uses either certificates or PACs. The controller is shipped with Cisco-installed device and Certificate Authority (CA) certificates. However, if you want to use your own vendor-specific certificates, they must be imported on the controller.

Step 1
If you are configuring local EAP to use one of the EAP types listed in the note above, make sure that the appropriate certificates and PACs (if you will use manual PAC provisioning) have been imported on the controller.

Step 2
If you want the controller to retrieve user credentials from the local user database, make sure that you have properly configured the local network users on the controller.

Step 3
If you want the controller to retrieve user credentials from an LDAP backend database, make sure that you have properly configured an LDAP server on the controller.

Step 4
Specify the order in which user credentials are retrieved from the backend database servers as follows:

a) Choose Security > Local EAP > Authentication Priority to open the Priority Order > Local-Auth page.

b) Determine the priority order in which user credentials are to be retrieved from the local and/or LDAP databases. For example, you may want the LDAP database to be given priority over the local user database, or you may not want the LDAP database to be considered at all.

c) When you have decided on a priority order, highlight the desired database. Then use the left and right arrows and the Up and Down buttons to move the desired database to the top of the right User Credentials box.

Note If both LDAP and LOCAL appear in the right User Credentials box with LDAP on the top and LOCAL on the bottom, local EAP attempts to authenticate clients using the LDAP backend database and fails over to the local user database if the LDAP servers are not reachable. If the user is not found, the authentication attempt is rejected. If LOCAL is on the top, local EAP attempts to authenticate using only the local user database. It does not fail over to the LDAP backend database.

d) Click Apply to commit your changes.

Step 5
Specify values for the local EAP timers as follows:

a) Choose Security > Local EAP > General to open the General page.

b) In the Local Auth Active Timeout text box, enter the amount of time (in seconds) in which the controller attempts to authenticate wireless clients using local EAP after any pair of configured RADIUS servers fails. The valid range is 1 to 3600 seconds, and the default setting is 100 seconds.

Step 6
Specify values for the Advanced EAP parameters as follows:

a) Choose Security > Advanced EAP.

b) In the Identity Request Timeout text box, enter the amount of time (in seconds) in which the controller attempts to send an EAP identity request to wireless clients using local EAP. The valid range is 1 to 120 seconds, and the default setting is 30 seconds.

c) In the Identity Request Max Retries text box, enter the maximum number of times that the controller attempts to retransmit the EAP identity request to wireless clients using local EAP. The valid range is 1 to 20 retries, and the default setting is 20 retries.
d) In the **Dynamic WEP Key Index** text box, enter the key index used for dynamic wired equivalent privacy (WEP). The default value is 0, which corresponds to a key index of 1; the valid values are 0 to 3 (key index of 1 to 4).

e) In the **Request Timeout** text box, enter the amount of time (in seconds) in which the controller attempts to send an EAP request to wireless clients using local EAP. The valid range is 1 to 120 seconds, and the default setting is 30 seconds.

f) In the **Request Max Retries** text box, enter the maximum number of times that the controller attempts to retransmit the EAP request to wireless clients using local EAP. The valid range is 1 to 120 retries, and the default setting is 20 retries.

g) From the **Max-Login Ignore Identity Response** drop-down list, choose **Enable** to limit the number of devices that can be connected to the controller with the same username. You can log in up to eight times from different devices (PDA, laptop, IP phone, and so on) on the same controller. The default value is enabled.

h) In the **EAPOL-Key Timeout** text box, enter the amount of time (in seconds) in which the controller attempts to send an EAP key over the LAN to wireless clients using local EAP. The valid range is 1 to 5 seconds, and the default setting is 1 second.

   **Note**  
   If the controller and access point are separated by a WAN link, the default timeout of 1 second may not be sufficient.

i) In the **EAPOL-Key Max Retries** text box, enter the maximum number of times that the controller attempts to send an EAP key over the LAN to wireless clients using local EAP. The valid range is 0 to 4 retries, and the default setting is 2 retries.

j) Click **Apply** to commit your changes.

### Step 7

Create a local EAP profile, which specifies the EAP authentication types that are supported on the wireless clients as follows:

a) Choose **Security > Local EAP > Profiles** to open the Local EAP Profiles page.

   This page lists any local EAP profiles that have already been configured and specifies their EAP types. You can create up to 16 local EAP profiles.

   **Note**  
   If you want to delete an existing profile, hover your cursor over the blue drop-down arrow for that profile and choose **Remove**.

b) Click **New** to open the **Local EAP Profiles > New** page.

c) In the **Profile Name** text box, enter a name for your new profile and then click **Apply**.

   **Note**  
   You can enter up to 63 alphanumeric characters for the profile name. Make sure not to include spaces.

d) When the Local EAP Profiles page reappears, click the name of your new profile. The **Local EAP Profiles > Edit** page appears.

e) Select the **LEAP, EAP-FAST, EAP-TLS**, and/or **PEAP** check boxes to specify the EAP type that can be used for local authentication.

   **Note**  
   You can specify more than one EAP type per profile. However, if you choose multiple EAP types that use certificates (such as EAP-FAST with certificates, EAP-TLS, PEAPv0/MSCHAPv2, and PEAPv1/GTC), all of the EAP types must use the same certificate (from either Cisco or another vendor).

   **Note**  
   If you select the **PEAP** check box, both PEAPv0/MSCHAPv2 or PEAPv1/GTC are enabled on the controller.

f) If you chose EAP-FAST and want the device certificate on the controller to be used for authentication, select the **Local Certificate Required** check box. If you want to use EAP-FAST with PACs instead of certificates, leave this check box unselected, which is the default setting.

   **Note**  
   This option applies only to EAP-FAST because device certificates are not used with LEAP and are mandatory for EAP-TLS and PEAP.
g) If you chose EAP-FAST and want the wireless clients to send their device certificates to the controller in order to authenticate, select the **Client Certificate Required** check box. If you want to use EAP-FAST with PACs instead of certificates, leave this check box unselected, which is the default setting.

**Note** This option applies only to EAP-FAST because client certificates are not used with LEAP or PEAP and are mandatory for EAP-TLS.

h) If you chose EAP-FAST with certificates, EAP-TLS, or PEAP, choose which certificates will be sent to the client, the ones from **Cisco** or the ones from another **Vendor**, from the Certificate Issuer drop-down list. The default setting is Cisco.

i) If you chose EAP-FAST with certificates or EAP-TLS and want the incoming certificate from the client to be validated against the CA certificates on the controller, select the **Check against CA certificates** check box. The default setting is enabled.

j) If you chose EAP-FAST with certificates or EAP-TLS and want the common name (CN) in the incoming certificate to be validated against the CA certificates’ CN on the controller, select the **Verify Certificate CN Identity** check box. The default setting is disabled.

k) If you chose EAP-FAST with certificates or EAP-TLS and want the controller to verify that the incoming device certificate is still valid and has not expired, select the **Check Certificate Date Validity** check box. The default setting is enabled.

**Note** Certificate date validity is checked against the current UTC (GMT) time that is configured on the controller. Timezone offset will be ignored.

l) Click **Apply** to commit your changes.

**Step 8** If you created an EAP-FAST profile, follow these steps to configure the EAP-FAST parameters:

a) Choose **Security > Local EAP > EAP-FAST Parameters** to open the EAP-FAST Method Parameters page.

b) In the Server Key and Confirm Server Key text boxes, enter the key (in hexadecimal characters) used to encrypt and decrypt PACs.

c) In the Time to Live for the PAC text box, enter the number of days for the PAC to remain viable. The valid range is 1 to 1000 days, and the default setting is 10 days.

d) In the Authority ID text box, enter the authority identifier of the local EAP-FAST server in hexadecimal characters. You can enter up to 32 hexadecimal characters, but you must enter an even number of characters.

e) In the Authority ID Information text box, enter the authority identifier of the local EAP-FAST server in text format.

f) If you want to enable anonymous provisioning, select the **Anonymous Provision** check box. This feature allows PACs to be sent automatically to clients that do not have one during PAC provisioning. If you disable this feature, PACs must be manually provisioned. The default setting is enabled.

**Note** If the local and/or client certificates are required and you want to force all EAP-FAST clients to use certificates, unselect the **Anonymous Provision** check box.

g) Click **Apply** to commit your changes.

**Step 9** Enable local EAP on a WLAN as follows:

a) Choose **WLANs** to open the WLANs page.

b) Click the ID number of the desired WLAN.

c) When the **WLANs > Edit** page appears, choose the **Security > AAA Servers** tabs to open the **WLANs > Edit (Security > AAA Servers)** page.

d) Unselect the **Enabled** check boxes for Radius Authentication Servers and Accounting Server to disable RADIUS accounting and authentication for this WLAN.

e) Select the **Local EAP Authentication** check box to enable local EAP for this WLAN.

f) From the EAP Profile Name drop-down list, choose the EAP profile that you want to use for this WLAN.
g) If desired, choose the LDAP server that you want to use with local EAP on this WLAN from the LDAP Servers drop-down lists.

h) Click **Apply** to commit your changes.

**Step 10**

Click **Save Configuration** to save your changes.

---

**Configuring Local EAP (CLI)**

**Before You Begin**

**Note**

EAP-TLS, P EAPv0/MSCHAPv2, and PEAPv1/GTC use certificates for authentication, and EAP-FAST uses either certificates or PACs. The controller is shipped with Cisco-installed device and Certificate Authority (CA) certificates. However, if you want to use your own vendor-specific certificates, they must be imported on the controller.

---

**Step 1**

If you are configuring local EAP to use one of the EAP types listed in the note above, make sure that the appropriate certificates and PACs (if you will use manual PAC provisioning) have been imported on the controller.

**Step 2**

If you want the controller to retrieve user credentials from the local user database, make sure that you have properly configured the local network users on the controller.

**Step 3**

If you want the controller to retrieve user credentials from an LDAP backend database, make sure that you have properly configured an LDAP server on the controller.

**Step 4**

Specify the order in which user credentials are retrieved from the local and/or LDAP databases by entering this command: `config local-auth user-credentials {local | ldap}

**Note**

If you enter the `config local-auth user-credentials ldap local` command, local EAP attempts to authenticate clients using the LDAP backend database and fails over to the local user database if the LDAP servers are not reachable. If the user is not found, the authentication attempt is rejected. If you enter the `config local-auth user-credentials local ldap` command, local EAP attempts to authenticate using only the local user database. It does not fail over to the LDAP backend database.

**Step 5**

Specify values for the local EAP timers by entering these commands:

- `config local-auth active-timeout timeout`—Specifies the amount of time (in seconds) in which the controller attempts to authenticate wireless clients using local EAP after any pair of configured RADIUS servers fails. The valid range is 1 to 3600 seconds, and the default setting is 100 seconds.

- `config advanced eap identity-request-timeout timeout`—Specifies the amount of time (in seconds) in which the controller attempts to send an EAP identity request to wireless clients using local EAP. The valid range is 1 to 120 seconds, and the default setting is 30 seconds.

- `config advanced eap identity-request-retries retries`—Specifies the maximum number of times that the controller attempts to retransmit the EAP identity request to wireless clients using local EAP. The valid range is 1 to 20 retries, and the default setting is 20 retries.
• **config advanced eap key-index index**—Specifies the key index used for dynamic wired equivalent privacy (WEP). The default value is 0, which corresponds to a key index of 1; the valid values are 0 to 3 (key index of 1 to 4).

• **config advanced eap request-timeout timeout**—Specifies the amount of time (in seconds) in which the controller attempts to send an EAP request to wireless clients using local EAP. The valid range is 1 to 120 seconds, and the default setting is 30 seconds.

• **config advanced eap request-retries retries**—Specifies the maximum number of times that the controller attempts to retransmit the EAP request to wireless clients using local EAP. The valid range is 1 to 120 retries, and the default setting is 20 retries.

• **config advanced eap eapol-key-timeout timeout**—Specifies the amount of time (in seconds) in which the controller attempts to send an EAP key over the LAN to wireless clients using local EAP. The valid range is 1 to 5 seconds, and the default setting is 1 second.

  **Note** If the controller and access point are separated by a WAN link, the default timeout of 1 second may not be sufficient.

• **config advanced eap eapol-key-retries retries**—Specifies the maximum number of times that the controller attempts to send an EAP key over the LAN to wireless clients using local EAP. The valid range is 0 to 4 retries, and the default setting is 2 retries.

• **config advanced eap max-login-ignore-identity-response {enable | disable}**—When enabled, this command ignores the limit set for the number of devices that can be connected to the controller with the same username through 802.1x authentication. When disabled, this command limits the number of devices that can be connected to the controller with the same username. This is not applicable for web authentication users. You can log in up to eight times from different devices (PDA, laptop, IP phone, and so on) on the same controller. The default value is enabled. Use the command **config netuser maxUserLogin** to set the limit of maximum number of devices per same username.

**Step 6**
Create a local EAP profile by entering this command:

```
config local-auth eap-profile add profile_name
```

**Note** Do not include spaces within the profile name.

**Note** To delete a local EAP profile, enter the `config local-auth eap-profile delete profile_name` command.

**Step 7**
Add an EAP method to a local EAP profile by entering this command:

```
config local-auth eap-profile method add method profile_name
```

The supported methods are leap, fast, tls, and peap.

**Note** If you choose peap, both P EAPv0/MSCHAPv2 or PEAPv1/GTC are enabled on the controller.

**Note** You can specify more than one EAP type per profile. However, if you create a profile with multiple EAP types that use certificates (such as EAP-FAST with certificates, EAP-TLS, PEAPv0/MSCHAPv2, and PEAPv1/GTC), all of the EAP types must use the same certificate (from either Cisco or another vendor).

**Note** To delete an EAP method from a local EAP profile, enter the `config local-auth eap-profile method delete method profile_name` command.

**Step 8**
Configure EAP-FAST parameters if you created an EAP-FAST profile by entering this command:

```
config local-auth method fast ?
```

where ? is one of the following:
• **anon-prov** \{**enable** | **disable**\}—Configures the controller to allow anonymous provisioning, which allows PACs to be sent automatically to clients that do not have one during PAC provisioning.

• **authority-id** *auth_id*—Specifies the authority identifier of the local EAP-FAST server.

• **pac-ttl** *days*—Specifies the number of days for the PAC to remain viable.

• **server-key** *key*—Specifies the server key used to encrypt and decrypt PACs.

### Step 9
Configure certificate parameters per profile by entering these commands:

- **config local-auth eap-profile method fast local-cert** \{**enable** | **disable**\} *profile_name*—Specifies whether the device certificate on the controller is required for authentication.
  
  **Note** This command applies only to EAP-FAST because device certificates are not used with LEAP and are mandatory for EAP-TLS and PEAP.

- **config local-auth eap-profile method fast client-cert** \{**enable** | **disable**\} *profile_name*—Specifies whether wireless clients are required to send their device certificates to the controller in order to authenticate.
  
  **Note** This command applies only to EAP-FAST because client certificates are not used with LEAP or PEAP and are mandatory for EAP-TLS.

- **config local-auth eap-profile cert-issuer** \{**cisco** | **vendor**\} *profile_name*—If you specified EAP-FAST with certificates, EAP-TLS, or PEAP, specifies whether the certificates that will be sent to the client are from Cisco or another vendor.

- **config local-auth eap-profile cert-verify ca-issuer** \{**enable** | **disable**\} *profile_name*—If you chose EAP-FAST with certificates or EAP-TLS, specifies whether the incoming certificate from the client is to be validated against the CA certificates on the controller.

- **config local-auth eap-profile cert-verify cn-verify** \{**enable** | **disable**\} *profile_name*—If you chose EAP-FAST with certificates or EAP-TLS, specifies whether the common name (CN) in the incoming certificate is to be validated against the CA certificates on the controller.

- **config local-auth eap-profile cert-verify date-valid** \{**enable** | **disable**\} *profile_name*—If you chose EAP-FAST with certificates or EAP-TLS, specifies whether the controller is to verify that the incoming device certificate is still valid and has not expired.

### Step 10
Enable local EAP and attach an EAP profile to a WLAN by entering this command:

```
config wlan local-auth enable profile_name wlan_id
```

**Note** To disable local EAP for a WLAN, enter the `config wlan local-auth disable wlan_id` command.

### Step 11
Save your changes by entering this command:

```
save config
```

### Step 12
View information pertaining to local EAP by entering these commands:

- **show local-auth config**—Shows the local EAP configuration on the controller.

```plaintext
User credentials database search order:
    Primary ......................................... Local DB

Timer:
    Active timeout .............................. 300

Configured EAP profiles:
    Name ........................................... fast-cert
```
Certificate issuer ......................... vendor
Peer verification options:
  Check against CA certificates ........ Enabled
  Verify certificate CN identity ........ Disabled
  Check certificate date validity ........ Enabled
EAP-FAST configuration:
  Local certificate required .......... Yes
  Client certificate required .......... Yes
  Enabled methods ....................... fast
  Configured on WLANs ................. 1

Name ..................................... tis
Certificate issuer ......................... vendor
Peer verification options:
  Check against CA certificates ........ Enabled
  Verify certificate CN identity ........ Disabled
  Check certificate date validity ........ Enabled
EAP-FAST configuration:
  Local certificate required .......... No
  Client certificate required .......... No
  Enabled methods ....................... tis
  Configured on WLANs ................. 2

EAP Method configuration:
EAP-FAST:
  Server key ............................... <hidden>
  TTL for the PAC ......................... 10
  Anonymous provision allowed .......... Yes
  Accept client on auth prov .......... No
  Authority ID ............................ 436973636f000000000000000000000000
  Authority Information .................. Cisco A-ID

• show local-auth statistics—Shows the local EAP statistics.

• show local-auth certificates—Shows the certificates available for local EAP.

• show local-auth user-credentials—Shows the priority order that the controller uses when retrieving user credentials from the local and/or LDAP databases.

• show advanced eap—Shows the timer values for local EAP.

  EAP-Identity-Request Timeout (seconds)........ 1
  EAP-Identity-Request Max Retries............... 20
  EAP Key-Index for Dynamic WEP.................. 0
  EAP Max-Login Ignore Identity Response........ enable
  EAP-Request Timeout (seconds).................. 20
  EAP-Request Max Retries....................... 20
  EAPOL-Key Timeout (seconds).................... 1
  EAPOL-Key Max Retries......................... 2

• show ap stats wlan Cisco_AP—Shows the EAP timeout and failure counters for a specific access point for each WLAN.

• show client detail client_mac—Shows the EAP timeout and failure counters for a specific associated client. These statistics are useful in troubleshooting client association issues.

...
Step 13 (Optional) Troubleshoot local EAP sessions by entering these commands:

- `debug aaa local-auth eap method {all | errors | events | packets | sm} {enable | disable}` — Enables or disables debugging of local EAP methods.

- `debug aaa local-auth eap framework {all | errors | events | packets | sm} {enable | disable}` — Enables or disables debugging of the local EAP framework.

**Note** In these two debug commands, *sm* is the state machine.

- `clear stats local-auth` — Clears the local EAP counters.

- `clear stats ap wlan Cisco_AP` — Clears the EAP timeout and failure counters for a specific access point for each WLAN.

```plaintext
WLAN 1
  EAP Id Request Msg Timeouts.................. 0
  EAP Id Request Msg Timeouts Failures........ 0
  EAP Request Msg Timeouts.................... 2
  EAP Request Msg Timeouts Failures........... 1
  EAP Key Msg Timeouts........................ 0
  EAP Key Msg Timeouts Failures............... 0

WLAN 2
  EAP Id Request Msg Timeouts.................. 1
  EAP Id Request Msg Timeouts Failures........ 0
  EAP Request Msg Timeouts.................... 0
  EAP Request Msg Timeouts Failures........... 0
  EAP Key Msg Timeouts......................... 3
  EAP Key Msg Timeouts Failures............... 1
```

### Additional References

See the [Managing Controller Software and Configurations](#), on page 645 section for instructions on importing certificates and PACs.

See the [Configuring Local Network Users on the Controller](#), on page 223 section for instructions on configuring local network users on the controller.

See the [Configuring LDAP](#), on page 227 section for instruction on configuring LDAP.
Configuring the System for SpectraLink NetLink Telephones

Information About SpectraLink NetLink Telephones

For the best integration with the Cisco UWN solution, SpectraLink NetLink Telephones require an extra operating system configuration step: **enable long preambles.** The radio preamble (sometimes called a header) is a section of data at the head of a packet that contains information that wireless devices need when sending and receiving packets. Short preambles improve throughput performance, so they are enabled by default. However, some wireless devices, such as SpectraLink NetLink phones, require long preambles.

Configuring SpectraLink NetLink Phones

Enabling Long Preambles (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose <strong>Wireless &gt; 802.11b/g/n &gt; Network</strong> to open the 802.11b/g Global Parameters page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>If the <strong>Short Preamble</strong> check box is selected, continue with this procedure. However, if the Short Preamble check box is unselected (which means that long preambles are enabled), the controller is already optimized for SpectraLink NetLink phones and you do not need to continue this procedure.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Unselect the <strong>Short Preamble</strong> check box to enable long preambles.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click <strong>Apply</strong> to update the controller configuration. <strong>Note</strong> If you do not already have an active CLI session to the controller, we recommend that you start a CLI session to reboot the controller and watch the reboot process. A CLI session is also useful because the GUI loses its connection when the controller reboots.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Choose <strong>Commands &gt; Reboot &gt; Reboot &gt; Save and Reboot to reboot the controller</strong>. Click OK in response to this prompt: <strong>Configuration will be saved and the controller will be rebooted. Click ok to confirm. The controller reboots.</strong></td>
</tr>
<tr>
<td>Step 6</td>
<td>Log back onto the controller GUI to verify that the controller is properly configured.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Choose <strong>Wireless &gt; 802.11b/g/n &gt; Network</strong> to open the 802.11b/g Global Parameters page. If the <strong>Short Preamble</strong> check box is unselected, the controller is optimized for SpectraLink NetLink phones.</td>
</tr>
</tbody>
</table>
### Enabling Long Preambles (CLI)

**Step 1** Log on to the controller CLI.

**Step 2** Enter the show 802.11b command and select the Short preamble mandatory parameter. If the parameter indicates that short preambles are enabled, continue with this procedure. This example shows that short preambles are enabled:

```
Short Preamble mandatory....................... Enabled
```

However, if the parameter shows that short preambles are disabled (which means that long preambles are enabled), the controller is already optimized for SpectraLink NetLink phones and you do not need to continue this procedure.

**Step 3** Disable the 802.11b/g network by entering this command:

```
config 802.11b disable network
```

You cannot enable long preambles on the 802.11a network.

**Step 4** Enable long preambles by entering this command:

```
config 802.11b preamble long
```

**Step 5** Reenable the 802.11b/g network by entering this command:

```
config 802.11b enable network
```

**Step 6** Enter the reset system command to reboot the controller. Enter y when the prompt to save the system changes is displayed. The controller reboots.

**Step 7** Verify that the controller is properly configured by logging back into the CLI and entering the show 802.11b command to view these parameters:

```
802.11b Network................................. Enabled
Short Preamble mandatory....................... Disabled
```

These parameters show that the 802.11b/g network is enabled and that short preambles are disabled.

### Configuring Enhanced Distributed Channel Access (CLI)

To configure 802.11 enhanced distributed channel access (EDCA) parameters to support SpectraLink phones, use the following CLI commands:

```
config advanced edca-parameter {custom-voice | optimized-video-voice | optimized-voice | svp-voice | wmm-default}
```

where

- **custom-voice** enables custom voice EDCA parameters
- **optimized-video-voice** enables combined video-voice-optimized parameters
- **optimized-voice** enables non-SpectraLink voice-optimized parameters
- **svp-voice** enables SpectraLink voice priority (SVP) parameters
- **wmm-default** enables wireless multimedia (WMM) default parameters
To propagate this command to all access points connected to the controller, make sure to disable and then reenable the 802.11b/g network after entering this command.

Configuring RADIUS NAC Support

Information About RADIUS NAC Support

The Cisco Identity Services Engine (ISE) is a next-generation, context-based access control solution that provides the functions of Cisco Secure Access Control System (ACS) and Cisco Network Admission Control (NAC) in one integrated platform.

ISE has been introduced in the 7.0.116.0 release of the Cisco Unified Wireless Network. ISE can be used to provide advanced security for your deployed network. It is an authentication server that you can configure on your controller. When a client associates to the controller on a RADIUS NAC–enabled WLAN, the controller forwards the request to the ISE server.

The ISE server validates the user in the database and on successful authentication, the URL and pre-AUTH ACL are sent to the client. The client then moves to the Posture Required state and is redirected to the URL returned by the ISE server.

The client moves to the Central Web Authentication state, if the URL returned by the ISE server has the keyword 'cwa'.

The NAC agent in the client triggers the posture validation process. On successful posture validation by the ISE server, the client is moved to the run state.

Flex local switching with Radius NAC support is added in Release 7.2.110.0. It is not supported in 7.0 Releases and 7.2 Releases. Downgrading 7.2.110.0 and later releases to either 7.2 or 7.0 releases will require you to reconfigure the WLAN for Radius NAC feature to work.

Device Registration

Device registration enables you to authenticate and provision new devices on the WLAN with RADIUS NAC enabled. When the device is registered on the WLAN, it can use the network based on the configured ACL.

Central Web Authentication

In the case of Central Web Authentication (CWA), the web-authentication occurs on the ISE server. The web portal in the ISE server provides a login page to the client. Once the credentials are verified on the ISE server, the client is provisioned. The client remains in the POSTURE_REQD state until a CoA is reached. The credentials and ACLs are received from the ISE server.
Local Web Authentication

Local web authentication is not supported for RADIUS NAC.

This table describes the possible combinations in a typical ISE deployment with Device Registration, CWA and LWA enabled:

Table 14: ISE Network Authentication Flow

<table>
<thead>
<tr>
<th>WLAN Configuration</th>
<th>CWA</th>
<th>LWA</th>
<th>Device Registration</th>
</tr>
</thead>
<tbody>
<tr>
<td>RADIUS NAC Enabled</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>L2 None</td>
<td>No</td>
<td>PSK, Static WEP, CKIP</td>
<td>No</td>
</tr>
<tr>
<td>L3 None</td>
<td>N/A</td>
<td>Internal/External</td>
<td>N/A</td>
</tr>
<tr>
<td>MAC Filtering Enabled</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Restrictions for RADIUS NAC Support

- A RADIUS NAC-enabled WLAN supports Open Authentication and MAC filtering.
- Radius NAC functionality does not work if the configured accounting server is different from authentication (ISE) server. You should configure the same server as the authentication and accounting server in case ISE functionalities are used. If ISE is used only for ACS functionality, the accounting server can be flexible.
- When clients move from one WLAN to another, the controller retains the client’s audit session ID if it returns to the WLAN before the idle timeout occurs. As a result, when clients join the controller before the idle timeout session expires, they are immediately moved to RUN state. The clients are validated if they reassociate with the controller after the session timeout.
- Suppose you have two WLANs, where WLAN 1 is configured on a controller (WLC1) and WLAN2 is configured on another controller (WLC2) and both are RADIUS NAC enabled. The client first connects to WLC1 and moves to the RUN state after posture validation. Assume that the client now moved to WLC2. If the client connects back to WLC1 before the PMK expires for this client in WLC1, the posture validation is skipped for the client. The client directly moves to RUN state by passing posture validation as the controller retains the old audit session ID for the client that is already known to ISE.
- When deploying RADIUS NAC in your wireless network, do not configure a primary and secondary ISE server. Instead, we recommend that you configure HA between the two ISE servers. Having a primary and secondary ISE setup will require a posture validation to happen before the clients move to RUN state. If HA is configured, the client is automatically moved to RUN state in the fallback ISE server.
- The controller software configured with RADIUS NAC does not support a change of authorization (CoA) on the service port.
- Do not swap AAA server indexes in a live network because clients might get disconnected and have to reconnect to the RADIUS server, which might result in log messages to be appended to the ISE server logs.
• You must enable AAA override on the WLAN to use RADIUS NAC.
• WPA and WPA2 or dot1X must be enabled on the WLAN.
• During slow roaming, the client goes through posture validation.
• Guest tunneling mobility is supported for ISE NAC–enabled WLANs.
• VLAN select is not supported
• Workgroup bridges are not supported.
• The AP Group over NAC is not supported over RADIUS NAC.
• With RADIUS NAC enabled, the RADIUS server overwrite interface is not supported.
• Any DHCP communication between client and server. We parse the DHCP profiling only once. This is sent to the ISE server only once.
• If the AAA url-redirect-acl and url-redirect attributes are expected from the AAA server, the AAA override feature must be enabled on the controller.

Configuring RADIUS NAC Support (GUI)

Step 1 Choose the WLANs tab.
Step 2 Click the WLAN ID of the WLAN for which you want to enable ISE. The WLANs > Edit page appears.
Step 3 Click the Advanced tab.
Step 4 From the NAC State drop-down list, choose Radius NAC:
   • SNMP NAC—Uses SNMP NAC for the WLAN.
   • Radius NAC—Uses Radius NAC for the WLAN.
   Note AAA override is automatically enabled when you use RADIUS NAC on a WLAN.
Step 5 Click Apply.

Configuring RADIUS NAC Support (CLI)

Enter the following command:

```
config wlan nac radius { enable | disable} wlan_id
```
Using Management Over Wireless

Information About Management over Wireless

The management over wireless feature allows you to monitor and configure local controllers using a wireless client. This feature is supported for all management tasks except uploads to and downloads from (transfers to and from) the controller.

Restrictions on Management over Wireless

- Management over Wireless can be disabled only if clients are on central switching.

Enabling Management over Wireless (GUI)

Step 1
Choose Management > Mgmt Via Wireless to open the Management Via Wireless page.

Step 2
Select the Enable Controller Management to be accessible from Wireless Clients check box to enable management over wireless for the WLAN or unselect it to disable this feature. The default value is unselected.

Step 3
Click Apply to commit your changes.

Step 4
Click Save Configuration to save your changes.

Enabling Management over Wireless (CLI)

Step 1
Verify whether the management over wireless interface is enabled or disabled by entering this command:

```
show network summary
```

- If disabled: Enable management over wireless by entering this command:

```
config network mgmt-via-wireless enable
```

- Otherwise, use a wireless client to associate with an access point connected to the controller that you want to manage.

Step 2
Log into the CLI to verify that you can manage the WLAN using a wireless client by entering this command:

```
telnet controller-ip-address command
```
Using Dynamic Interfaces for Management

Information About Using Dynamic Interfaces for Management

You can access the controller with one of its dynamic interface IP addresses. Both the wired and wireless clients can access the dynamic interface of the controller using the CLI and GUI. To access the GUI of the controller enter the dynamic interface IP address of the controller in the address field of either Internet Explorer or Mozilla Firefox browser. For wired clients, you must enable management of dynamic interface and must ensure that the wired client is in the VLAN that is mapped to the dynamic interface.

A device, when the management using dynamic interfaces is disabled, can open an SSH connection, if the protocol is enabled. However, you are not prompted to log on. Additionally, the management address remains accessible from a dynamic interface VLAN, unless a CPU ACL is in place. When management using dynamic interface is enabled along with CPU ACL, the CPU ACL has more priority.

The following are some examples of management access and management access using dynamic interfaces, here the management VLAN IP address of the Cisco WLC is 209.165. 201.1 and dynamic VLAN IP address of the Cisco WLC is 209.165. 202.129:

- Source wired client from Cisco WLC's dynamic interface VLAN accesses the management interface VLAN and tries for management access.
- Source wired client from Cisco WLC's management interface VLAN accesses the dynamic interface VLAN and tries for management access.
- Source wired client from Cisco WLC's dynamic interface VLAN accesses the dynamic interface VLAN tries and tries for management access.
- Source wired client from Layer 3 VLAN interface accesses the dynamic interface or the management interface and tries for management access.

Here, management is not the management interface but the configuration access. If the Cisco WLC configuration is accessed from any other IP address on the Cisco WLC other than the management IP, it is management using dynamic interface.

Configuring Management using Dynamic Interfaces (CLI)

Enable or disable management using dynamic interfaces by entering this command:

```
config network mgmt-via-dynamic-interface {enable | disable}
```

Configuring DHCP Option 82

Information About DHCP Option 82

DHCP option 82 provides additional security when DHCP is used to allocate network addresses. It enables the controller to act as a DHCP relay agent to prevent DHCP client requests from untrusted sources. You can
configure the controller to add option 82 information to DHCP requests from clients before forwarding the requests to the DHCP server.

**Figure 28: DHCP Option 82**

The access point forwards all DHCP requests from a client to the controller. The controller adds the DHCP option 82 payload and forwards the request to the DHCP server. The payload can contain the MAC address or the MAC address and SSID of the access point, depending on how you configure this option.

---

**Restrictions on DHCP Option 82**

- DHCP option 82 is not supported for use with auto-anchor mobility.

**Configuring DHCP Option 82 (GUI)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Controller &gt; Advanced &gt; DHCP to open the DHCP Parameters page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select the Enable DHCP Proxy check box to enable DHCP proxy.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose a DHCP Option 82 format from the drop-down list. You can choose either binary or ascii to specify the format of the DHCP option 82 payload.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Choose a DHCP Option 82 Remote ID field format from the drop-down list to specify the format of the DHCP option 82 payload. For more information about the options available, see the Controller Online Help.</td>
</tr>
</tbody>
</table>

---

Note: Any DHCP packets that already include a relay agent option are dropped at the controller.

For DHCP option 82 to operate correctly, DHCP proxy must be enabled.
Step 5  Enter the DHCP timeout value in the DHCP Timeout field. The timeout value is globally applicable. You can specify the DHCP timeout value in range from 5 to 120 seconds.

Step 6  Click Apply.

Step 7  Click Save Configuration.

What to Do Next

On the controller CLI, you can enable DHCP option 82 on the dynamic interface to which the WLAN is associated by entering this command:

```
config interface dhcp dynamic-interface interface-name option-82 enable
```

Configuring DHCP Option 82 (CLI)

- Configure the format of the DHCP option 82 payload by entering one of these commands:
  * `config dhcp opt-82 remote-id ap_mac`—Adds the radio MAC address of the access point to the DHCP option 82 payload.
  * `config dhcp opt-82 remote-id ap_mac:ssid`—Adds the radio MAC address and SSID of the access point to the DHCP option 82 payload.
  * `config dhcp opt-82 remote-id ap-ethmac`—Adds the Ethernet MAC address of the access point to the DHCP option 82 payload.

- Enable DHCP Option 82 on the dynamic interface to which the WLAN is associated by entering this command:
  `config interface dhcp dynamic-interface interface-name option-82 enable`

- See the status of DHCP option 82 on the dynamic interface by entering the `show interface detailed dynamic-interface-name` command.

Additional References

In order for DHCP option 82 to operate correctly, DHCP proxy must be enabled.

Configuring and Applying Access Control Lists

Information About Access Control Lists

An Access Control List (ACL) is a set of rules used to limit access to a particular interface (for example, if you want to restrict a wireless client from pinging the management interface of the controller). After ACLs are configured on the controller, they can be applied to the management interface, the AP-manager interface, any of the dynamic interfaces, or a WLAN to control data traffic to and from wireless clients or to the controller central processing unit (CPU) to control all traffic destined for the CPU.
You may also want to create a preauthentication ACL for web authentication. Such an ACL could be used to allow certain types of traffic before authentication is complete.

Both IPv4 and IPv6 ACLs are supported. IPv6 ACLs support the same options as IPv4 ACLs including source, destination, source and destination ports.

---

You can enable only IPv4 traffic in your network by blocking IPv6 traffic. That is, you can configure an IPv6 ACL to deny all IPv6 traffic and apply it on specific or all WLANs.

---

**Restrictions for Access Control Lists**

- You can define up to 64 ACLs, each with up to 64 rules (or filters) for both IPv4 and IPv6. Each rule has parameters that affect its action. When a packet matches all of the parameters for a rule, the action set for that rule is applied to the packet.

- When you apply CPU ACLs on a Cisco 5508 WLC or a Cisco WiSM2, you must permit traffic towards the virtual interface IP address for web authentication.

- All ACLs have an implicit “deny all rule” as the last rule. If a packet does not match any of the rules, it is dropped by the controller.

- If you are using an external web server with a Cisco 5508 WLC or a WLC network module, you must configure a preauthentication ACL on the WLAN for the external web server.

- If you apply an ACL to an interface or a WLAN, wireless throughput is degraded when downloading from a 1-GBps file server. To improve throughput, remove the ACL from the interface or WLAN, move the ACL to a neighboring wired device with a policy rate-limiting restriction, or connect the file server using 100 Mbps rather than 1 Gbps.

- Multicast traffic received from wired networks that is destined to wireless clients is not processed by WLC ACLs. Multicast traffic initiated from wireless clients, destined to wired networks or other wireless clients on the same controller, is processed by WLC ACLs.

- ACLs are configured on the controller directly or configured through Cisco Prime Infrastructure templates. The ACL name must be unique.

- You can configure ACL per client (AAA overridden ACL) or on either an interface or a WLAN. The AAA overridden ACL has the highest priority. However, each interface, WLAN, or per client ACL configuration that you apply can override one another.

- If peer-to-peer blocking is enabled, traffic is blocked between peers even if the ACL allows traffic between them.

- Authentication traffic has to go through the Cisco WLC for this feature to be supported, even if DNS-based ACL is local to the AP.

- When you create an ACL, it is recommended to perform the two actions (create an ACL or ACL rule and apply the ACL or ACL rule) continuously either from CLI or GUI.

- In Cisco Wireless Releases prior to 8.0.100.0, the behavior of the Redirect-URL-ACL (as returned via RADIUS attributes) may have been incorrect. The ACL was applied in only the Ingress direction (traffic destined for the LAN or distribution system) of the radio interface. These ACLs should also be applied in the Egress direction (traffic destined for the wireless client). Therefore, after upgrading to a Cisco
Wireless Release 8.0 or a later release, you may need to adjust the ACL to accommodate the correction of this behavior.

ACL ID 0 is not supported in Cisco WLC. Foreign WLC does not send url-redirect-acl to anchor WLC if the received ACL attribute from RADIUS/ISE is mapped to ACL ID 0. It causes web redirect failure on wireless client later.

### Configuring and Applying Access Control Lists (GUI)

#### Configuring Access Control Lists

**Step 1** Choose **Security > Access Control Lists** to open the Access Control Lists page.

**Step 2** If you want to see if packets are hitting any of the ACLs configured on your controller, select the **Enable Counters** check box and click **Apply**. Otherwise, leave the check box unselected, which is the default value. This feature is useful when troubleshooting your system.

**Note** If you want to clear the counters for an ACL, hover your cursor over the blue drop-down arrow for that ACL and choose **Clear Counters**.

**Step 3** Add a new ACL by clicking **New**. The Access Control Lists > New page appears.

**Step 4** In the Access Control List Name text box, enter a name for the new ACL. You can enter up to 32 alphanumeric characters.

**Step 5** Choose the ACL type. There are two types of ACL supported, IPv4 and IPv6.

**Step 6** Click **Apply**. When the Access Control Lists page reappears, click the name of the new ACL.

**Step 7** When the Access Control Lists > Edit page appears, click **Add New Rule**. The Access Control Lists > Rules > New page appears.

**Step 8** Configure a rule for this ACL as follows:

a) The controller supports up to 64 rules for each ACL. These rules are listed in order from 1 to 64. In the Sequence text box, enter a value (between 1 and 64) to determine the order of this rule in relation to any other rules defined for this ACL.

**Note** If rules 1 through 4 are already defined and you add rule 29, it is added as rule 5. If you add or change a sequence number for a rule, the sequence numbers for other rules adjust to maintain a continuous sequence. For instance, if you change a rule’s sequence number from 7 to 5, the rules with sequence numbers 5 and 6 are automatically reassigned as 6 and 7, respectively.

b) From the Source drop-down list, choose one of these options to specify the source of the packets to which this ACL applies:

   - **Any**—Any source (this is the default value).
   - **IP Address**—A specific source. If you choose this option, enter the IP address and netmask of the source in the text boxes. If you are configuring IPv6 ACL, enter the IPv6 address and prefix length of the destination in the text boxes.

c) From the Destination drop-down list, choose one of these options to specify the destination of the packets to which this ACL applies:
• **Any**—Any destination (this is the default value).

• **IP Address**—A specific destination. If you choose this option, enter the IP address and netmask of the destination in the text boxes. If you are configuring IPv6 ACL, enter the IPv6 address and prefix length of the destination in the text boxes.

d) From the Protocol drop-down list, choose the protocol ID of the IP packets to be used for this ACL. These are the protocol options:

- **Any**—Any protocol (this is the default value)
- **TCP**—Transmission Control Protocol
- **UDP**—User Datagram Protocol
- **ICMP/ICMPv6**—Internet Control Message Protocol
  - **Note** ICMPv6 is only available for IPv6 ACL.
- **ESP**—IP Encapsulating Security Payload
- **AH**—Authentication Header
- **GRE**—Generic Routing Encapsulation
- **IP in IP**—Internet Protocol (IP) in IP (permits or denies IP-in-IP packets)
- **Eth Over IP**—Ethernet-over-Internet Protocol
- **OSPF**—Open Shortest Path First
- **Other**—Any other Internet Assigned Numbers Authority (IANA) protocol
  - **Note** If you choose Other, enter the number of the desired protocol in the Protocol text box. You can find the list of available protocols in the IANA website.

The controller can permit or deny only IP packets in an ACL. Other types of packets (such as ARP packets) cannot be specified.

e) If you chose TCP or UDP in the previous step, two additional parameters appear: Source Port and Destination Port. These parameters enable you to choose a specific source port and destination port or port ranges. The port options are used by applications that send and receive data to and from the networking stack. Some ports are designated for certain applications such as Telnet, SSH, HTTP, and so on.
  - **Note** Source and Destination ports based on the ACL type.

f) From the DSCP drop-down list, choose one of these options to specify the differentiated services code point (DSCP) value of this ACL. DSCP is an IP header text box that can be used to define the quality of service across the Internet.

- **Any**—Any DSCP (this is the default value)
- **Specific**—A specific DSCP from 0 to 63, which you enter in the DSCP edit box

g) From the Direction drop-down list, choose one of these options to specify the direction of the traffic to which this ACL applies:

- **Any**—Any direction (this is the default value)
- **Inbound**—From the client
• **Outbound**—To the client

  **Note** If you are planning to apply this ACL to the controller CPU, the packet direction does not have any significance, it is always ’Any’.

h) From the **Action** drop-down list, choose **Deny** to cause this ACL to block packets or **Permit** to cause this ACL to allow packets. The default value is Deny.

i) Click **Apply** to commit your changes. The **Access Control Lists > Edit** page reappears, showing the rules for this ACL.

The **Deny Counters** fields show the number of times that packets have matched the explicit deny ACL rule. The **Number of Hits** field shows the number of times that packets have matched an ACL rule. You must enable ACL counters on the Access Control Lists page to enable these fields.

  **Note** If you want to edit a rule, click the sequence number of the desired rule to open the **Access Control Lists > Rules > Edit** page. If you want to delete a rule, hover your cursor over the blue drop-down arrow for the desired rule and choose **Remove**.

j) Repeat this procedure to add any additional rules for this ACL.

**Step 9** Click **Save Configuration** to save your changes.

**Step 10** Repeat this procedure to add any additional ACLs.

---

### Applying an Access Control List to an Interface

**Step 1** Choose **Controller > Interfaces**.

**Step 2** Click the name of the desired interface. The **Interfaces > Edit** page for that interface appears.

**Step 3** Choose the desired ACL from the **ACL Name** drop-down list and click **Apply**. The default is None.

  **Note** Only IPv4 ACL are supported as interface ACL.

**Step 4** Click **Save Configuration** to save your changes.

---

### Applying an Access Control List to the Controller CPU

**Step 1** Choose **Security > Access Control Lists > CPU Access Control Lists** to open the CPU Access Control Lists page.

**Step 2** Select the **Enable CPU ACL** check box to enable a designated ACL to control the IPv4 traffic to the controller CPU or unselect the check box to disable the CPU ACL feature and remove any ACL that had been applied to the CPU. The default value is unselected.

**Step 3** From the **ACL Name** drop-down list, choose the ACL that will control the IPv4 traffic to the controller CPU. None is the default value when the CPU ACL feature is disabled. If you choose None while the Enable CPU ACL check box is selected, an error message appears indicating that you must choose an ACL.
Configuring Security Solutions

- **Note** This parameter is available only if you have selected the CPU ACL Enable check box.

- **Note** When CPU ACL is enabled, it is applicable to both wireless and wired traffic.

**Step 4** Select the Enable CPU IPv6 ACL check box to enable a designated ACL to control the IPv6 traffic to the controller CPU or unselect the check box to disable the CPU ACL feature and remove any ACL that had been applied to the CPU. The default value is unselected.

**Step 5** From the IPv6 ACL Name drop-down list, choose the ACL that will control the IPv6 traffic to the controller CPU. None is the default value when the CPU ACL feature is disabled. If you choose None while the Enable CPU IPv6 ACL check box is selected, an error message appears indicating that you must choose an ACL.

**Step 6** Click Apply to commit your changes.

**Step 7** Click Save Configuration to save your changes.

### Applying an Access Control List to a WLAN

**Step 1** Choose WLANs to open the WLANs page.

**Step 2** Click the ID number of the desired WLAN to open the WLANs > Edit page.

**Step 3** Choose the Advanced tab to open the WLANs > Edit (Advanced) page.

**Step 4** From the Override Interface ACL drop-down list, choose the IPv4 or IPv6 ACL that you want to apply to this WLAN. The ACL that you choose overrides any ACL that is configured for the interface. None is the default value.

- **Note** To support centralized access control through AAA server such as ISE or ACS, IPv6 ACL must be configured on the controller and the WLAN must be configured with AAA override enabled feature.

**Step 5** Click Apply.

**Step 6** Click Save Configuration.

### Applying a Preauthentication Access Control List to a WLAN

**Step 1** Choose WLANs to open the WLANs page.

**Step 2** Click the ID number of the desired WLAN to open the WLANs > Edit page.

**Step 3** Choose the Security and Layer 3 tabs to open the WLANs > Edit (Security > Layer 3) page.

**Step 4** Select the Web Policy check box.

**Step 5** From the Preauthentication ACL drop-down list, choose the desired ACL and click Apply. None is the default value.

**Step 6** Click Save Configuration to save your changes.
Configuring and Applying Access Control Lists (CLI)

Configuring Access Control Lists

Step 1  See all of the ACLs that are configured on the controller by entering this command:
show [ipv6] acl summary

Step 2  See detailed information for a particular ACL by entering this command:
show [ipv6] acl detailed acl_name
The Counter text box increments each time a packet matches an ACL rule, and the DenyCounter text box increments each time a packet does not match any of the rules.

Note  If a traffic/request is allowed from the controller by a permit rule, then the response to the traffic/request in the opposite direction also is allowed and cannot be blocked by a deny rule in the ACL.

Step 3  Enable or disable ACL counters for your controller by entering this command:
config acl counter {start | stop}

Note  If you want to clear the current counters for an ACL, enter the clear acl counters acl_name command.

Step 4  Add a new ACL by entering this command:
config [ipv6] acl create acl_name.
You can enter up to 32 alphanumeric characters for the acl_name parameter.

Note  When you try to create an interface name with space, the controller CLI does not create an interface. For example, if you want to create an interface name int 3, the CLI will not create this since there is a space between int and 3. If you want to use int 3 as the interface name, you need to enclose within single quotes like ‘int 3’.

Step 5  Add a rule for an ACL by entering this command:
config [ipv6] acl rule add acl_name rule_index

Step 6  Configure an ACL rule by entering config [ipv6] acl rule command:

Step 7  Save your settings by entering this command:
save config

Note  To delete an ACL, enter the config [ipv6] acl delete acl_name command. To delete an ACL rule, enter the config [ipv6] acl rule delete acl_name rule_index command.

Applying Access Control Lists

Step 1  Perform the following to apply an IPv4 ACL:

- To apply an ACL to the IPv4 data path, enter this command:
  config acl apply acl_name
To apply an ACL to the controller CPU to restrict the IPv4 type of traffic (wired, wireless, or both) reaching the CPU, enter this command:

```
config acl cpu acl_name {wired | wireless | both}
```

**Note** To see the ACL that is applied to the controller CPU, enter the `show acl cpu` command. To remove the ACL that is applied to the controller CPU, enter the `config acl cpu none` command.

**Note** For 2504 and 4400 series WLC, the CPU ACL cannot be used to control the CAPWAP traffic. Use the access-list on the network to control CAPWAP traffic.

**Step 2** Perform the following to apply an IPv6 ACL:

- To apply an ACL to an IPv6 data path, enter this command:
  
  ```
  config ipv6 acl apply name
  ```

- To apply an ACL to the controller CPU to restrict the IPv6 type of traffic (wired, wireless, or both) reaching the CPU, enter this command:
  
  ```
  config ipv6 acl cpu {name|none}
  ```

**Step 3** To apply an ACL to a WLAN, enter this command:

```
config wlan acl wlan_id acl_name
```

**Note** To see the ACL that is applied to a WLAN, enter the `show wlan wlan_id` command. To remove the ACL that is applied to a WLAN, enter the `config wlan acl wlan_id none` command.

**Step 4** To apply a pre-authentication ACL to a WLAN, enter this command:

```
config wlan security web-auth acl wlan_id acl_name
```

**Step 5** Save your changes by entering this command:

```
save config
```

---

**Configuring Management Frame Protection**

**Information About Management Frame Protection**

Management frame protection (MFP) provides security for the otherwise unprotected and unencrypted 802.11 management messages passed between access points and clients. MFP provides both infrastructure and client support.

- Infrastructure MFP—Protects management frames by detecting adversaries that are invoking denial-of-service attacks, flooding the network with associations and probes, interjecting as rogue access points, and affecting network performance by attacking the QoS and radio measurement frames. Infrastructure MFP is a global setting that provides a quick and effective means to detect and report phishing incidents.

  Specifically, infrastructure MFP protects 802.11 session management functions by adding message integrity check information elements (MIC IEs) to the management frames emitted by access points.
(and not those emitted by clients), which are then validated by other access points in the network. Infrastructure MFP is passive. It can detect and report intrusions but has no means to stop them.

- **Client MFP**—Shields authenticated clients from spoofed frames, preventing many of the common attacks against wireless LANs from becoming effective. Most attacks, such as deauthentication attacks, revert to simply degrading performance by contending with valid clients.

Specifically, client MFP encrypts management frames sent between access points and CCXv5 clients so that both the access points and clients can take preventative action by dropping spoofed class 3 management frames (that is, management frames passed between an access point and a client that is authenticated and associated). Client MFP leverages the security mechanisms defined by IEEE 802.11i to protect the following types of class 3 unicast management frames: disassociation, deauthentication, and QoS (WMM) action. Client MFP protects a client-access point session from the most common type of denial-of-service attack. It protects class 3 management frames by using the same encryption method used for the session’s data frames. If a frame received by the access point or client fails decryption, it is dropped, and the event is reported to the controller.

To use client MFP, clients must support CCXv5 MFP and must negotiate WPA2 using either TKIP or AES-CCMP. EAP or PSK may be used to obtain the PMK. CCKM and controller mobility management are used to distribute session keys between access points for Layer 2 and Layer 3 fast roaming.

---

**Note**

To prevent attacks using broadcast frames, access points supporting CCXv5 will not emit any broadcast class 3 management frames (such as disassociation, deauthentication, or action). CCXv5 clients and access points must discard broadcast class 3 management frames.

Client MFP supplements infrastructure MFP rather than replaces it because infrastructure MFP continues to detect and report invalid unicast frames sent to clients that are not client-MFP capable as well as invalid class 1 and 2 management frames. Infrastructure MFP is applied only to management frames that are not protected by client MFP.

Infrastructure MFP consists of three main components:

- **Management frame protection**—The access point protects the management frames it transmits by adding a MIC IE to each frame. Any attempt to copy, alter, or replay the frame invalidates the MIC, causing any receiving access point configured to detect MFP frames to report the discrepancy. MFP is supported for use with Cisco Aironet lightweight access points.

- **Management frame validation**—In infrastructure MFP, the access point validates every management frame that it receives from other access points in the network. It ensures that the MIC IE is present (when the originator is configured to transmit MFP frames) and matches the content of the management frame. If it receives any frame that does not contain a valid MIC IE from a BSSID belonging to an access point that is configured to transmit MFP frames, it reports the discrepancy to the network management system. In order for the timestamps to operate properly, all controllers must be Network Time Protocol (NTP) synchronized.

- **Event reporting**—The access point notifies the controller when it detects an anomaly, and the controller aggregates the received anomaly events and can report the results through SNMP traps to the network management system.

---

**Note**

Client MFP uses the same event reporting mechanisms as infrastructure MFP.
Infrastructure MFP is disabled by default and can be enabled globally. When you upgrade from a previous software release, infrastructure MFP is disabled globally if access point authentication is enabled because the two features are mutually exclusive. Once infrastructure MFP is enabled globally, signature generation (adding MICs to outbound frames) can be disabled for selected WLANs, and validation can be disabled for selected access points.

Client MFP is enabled by default on WLANs that are configured for WPA2. It can be disabled, or it can be made mandatory (in which case, only clients that negotiate MFP are allowed to associate) on selected WLANs.

Restrictions for Management Frame Protection

- Lightweight access points support infrastructure MFP in local and monitor modes and in FlexConnect mode when the access point is connected to a controller. They support client MFP in local, FlexConnect, and bridge modes.
- OEAP 600 Series Access points do not support MFP.
- Client MFP is supported for use only with CCXv5 clients using WPA2 with TKIP or AES-CCMP.
- Non-CCXv5 clients may associate to a WLAN if client MFP is disabled or optional.
- Error reports generated on a FlexConnect access point in standalone mode cannot be forwarded to the controller and are dropped.

Configuring Management Frame Protection (GUI)

| Step 1 | Choose Security > Wireless Protection Policies > AP Authentication/MFP to open the AP Authentication Policy page. |
| Step 2 | Enable infrastructure MFP globally for the controller by choosing Management Frame Protection from the Protection Type drop-down list. |
| Step 3 | Click Apply to commit your changes.  
Note: If more than one controller is included in the mobility group, you must configure an NTP/SNTP server on all controllers in the mobility group that are configured for infrastructure MFP. |
| Step 4 | Configure client MFP for a particular WLAN after infrastructure MFP has been enabled globally for the controller as follows:  
a) Choose WLANs. 
b) Click the profile name of the desired WLAN. The WLANs > Edit page appears. 
c) Choose Advanced. The WLANs > Edit (Advanced) page appears. 
d) Choose Disabled, Optional, or Required from the MFP Client Protection drop-down list. The default value is Optional. If you choose Required, clients are allowed to associate only if MFP is negotiated (that is, if WPA2 is configured on the controller and the client supports CCXv5 MFP and is also configured for WPA2).  
Note: For Cisco OEAP 600, MFP is not supported. It should either be Disabled or Optional. 
e) Click Apply to commit your changes. |
| Step 5 | Click Save Configuration to save your settings. |
Viewing the Management Frame Protection Settings (GUI)

To see the controller’s current global MFP settings, choose Security > Wireless Protection Policies > Management Frame Protection. The Management Frame Protection Settings page appears.

On this page, you can see the following MFP settings:

- The **Management Frame Protection** field shows if infrastructure MFP is enabled globally for the controller.
- The **Controller Time Source Valid** field indicates whether the controller time is set locally (by manually entering the time) or through an external source (such as the NTP/SNTP server). If the time is set by an external source, the value of this field is “True.” If the time is set locally, the value is “False.” The time source is used for validating the timestamp on management frames between access points of different controllers within a mobility group.
- The **Client Protection** field shows if client MFP is enabled for individual WLANs and whether it is optional or required.

Configuring Management Frame Protection (CLI)

- Enable or disable infrastructure MFP globally for the controller by entering this command:
  ```bash
  config wps mfp infrastructure {enable | disable}
  ```
- Enable or disable client MFP on a specific WLAN by entering this command:
  ```bash
  config wlan mfp client {enable | disable} wlan_id [required ]
  ```
  If you enable client MFP and use the optional **required** parameter, clients are allowed to associate only if MFP is negotiated.

Viewing the Management Frame Protection Settings (CLI)

- See the controller’s current MFP settings by entering this command:
  ```bash
  show wps mfp summary
  ```
- See the current MFP configuration for a particular WLAN by entering this command:
  ```bash
  show wlan wlan_id
  ```
- See whether client MFP is enabled for a specific client by entering this command:
  ```bash
  show client detail client_mac
  ```
- See MFP statistics for the controller by entering this command:
  ```bash
  show wps mfp statistics
  ```

**Note**

This report contains no data unless an active attack is in progress. This table is cleared every 5 minutes when the data is forwarded to any network management stations.
Debugging Management Frame Protection Issues (CLI)

- Use this command if you experience any problems with MFP:
  
  ```
  debug wps mfp ? {enable | disable}
  ```

  where ? is one of the following:

  - **client**—Configures debugging for client MFP messages.
  - **capwap**—Configures debugging for MFP messages between the controller and access points.
  - **detail**—Configures detailed debugging for MFP messages.
  - **report**—Configures debugging for MFP reporting.
  - **mm**—Configures debugging for MFP mobility (inter-controller) messages.

Configuring Client Exclusion Policies

Configuring Client Exclusion Policies (GUI)

Step 1

Step 2
Select any of these check boxes if you want the controller to exclude clients for the condition specified. The default value for each exclusion policy is enabled.

- **Excessive 802.11 Association Failures**—Clients are excluded on the sixth 802.11 association attempt, after five consecutive failures.
- **Excessive 802.11 Authentication Failures**—Clients are excluded on the sixth 802.11 authentication attempt, after five consecutive failures.
- **Excessive 802.1X Authentication Failures**—Clients are excluded on the fourth 802.1X authentication attempt, after three consecutive failures.
- **IP Theft or IP Reuse**—Clients are excluded if the IP address is already assigned to another device.
- **Excessive Web Authentication Failures**—Clients are excluded on the fourth web authentication attempt, after three consecutive failures.

Step 3
Click **Apply**.

Step 4
Click **Save Configuration**.
Configuring Client Exclusion Policies (CLI)

**Step 1**  
Enable or disable the controller to exclude clients on the sixth 802.11 association attempt, after five consecutive failures by entering this command:  
```
config wps client-exclusion 802.11-assoc {enable | disable}
```

**Step 2**  
Enable or disable the controller to exclude clients on the sixth 802.11 authentication attempt, after five consecutive failures by entering this command:  
```
config wps client-exclusion 802.11-auth {enable | disable}
```

**Step 3**  
Enable or disable the controller to exclude clients on the fourth 802.1X authentication attempt, after three consecutive failures by entering this command:  
```
config wps client-exclusion 802.1x-auth {enable | disable}
```

**Step 4**  
Configure the controller to exclude clients that reaches the maximum failure 802.1X authentication attempt with the RADIUS server by entering this command:  
```
config wps client-exclusion 802.1x-auth max-1x-aaa-fail-attempts
```
You can configure the maximum failure 802.1X authentication attempt from 1 to 3 and the default value is 3.

**Step 5**  
Enable or disable the controller to exclude clients if the IP address is already assigned to another device by entering this command:  
```
config wps client-exclusion ip-theft {enable | disable}
```

**Step 6**  
Enable or disable the controller to exclude clients on the fourth web authentication attempt, after three consecutive failures by entering this command:  
```
config wps client-exclusion web-auth {enable | disable}
```

**Step 7**  
Enable or disable the controller to exclude clients for all of the above reasons by entering this command:  
```
config wps client-exclusion all {enable | disable}
```

**Step 8**  
Use the following command to add or delete client exclusion entries.  
```
config exclusionlist {add MAC [description] | delete MAC [description]}
```

**Step 9**  
Save your changes by entering this command:  
```
save config
```

**Step 10**  
See a list of clients that have been dynamically excluded, by entering this command:  
```
show exclusionlist
```
Information similar to the following appears:

```
Dynamically Disabled Clients
-------------------------------------------
MAC Address    Exclusion Reason   Time Remaining (in secs)
-------------------------------------------
00:40:96:b4:82:55  802.1X Failure      51
```

**Step 11**  
See the client exclusion policy configuration settings by entering this command:  
```
show wps summary
```
Information similar to the following appears:

```
Auto-Immune
```
Configuring Identity Networking

Information About Identity Networking

In most wireless LAN systems, each WLAN has a static policy that applies to all clients associated with an SSID. Although powerful, this method has limitations because it requires clients to associate with different SSIDs to inherit different QoS and security policies.

However, the Cisco Wireless LAN solution supports identity networking, which allows the network to advertise a single SSID but allows specific users to inherit different QoS or security policies based on their user profiles. The specific policies that you can control using identity networking are as follows:

• ACL—When the ACL attribute is present in the RADIUS Access Accept, the system applies the ACL name to the client station after it authenticates, which overrides any ACLs that are assigned to the interface.

• VLAN—When a VLAN Interface-name or VLAN tag is present in a RADIUS Access Accept, the system places the client on a specific interface.

Note
The VLAN feature only supports MAC filtering, 802.1X, and WPA. The VLAN feature does not support web authentication or IPsec.

• Tunnel Attributes.

Note
When any of the other RADIUS attributes (QoS-Level, ACL-Name, Interface-Name, or VLAN-Tag), which are described later in this section, are returned, the Tunnel Attributes must also be returned.
The operating system’s local MAC filter database has been extended to include the interface name, allowing local MAC filters to specify to which interface the client should be assigned. A separate RADIUS server can also be used, but the RADIUS server must be defined using the Security menus.

RADIUS Attributes Used in Identity Networking

QoS-Level

This section explains the RADIUS attributes used in identity networking. This attribute indicates the QoS level to be applied to the mobile client’s traffic within the switching fabric, as well as over the air. This example shows a summary of the QoS-Level Attribute format. The text boxes are transmitted from left to right.

```
0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+
| Type | Length | Vendor-Id |
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+

Vendor-Id (cont.) | Vendor type | Vendor length |
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+

| QoS Level |
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+
```

- Type – 26 for Vendor-Specific
- Length – 10
- Vendor-Id – 14179
- Vendor type – 2
- Vendor length – 4
- Value – Three octets:
  - 3 – Bronze (Background)
  - 0 – Silver (Best Effort)
  - 1 – Gold (Video)
  - 2 – Platinum (Voice)

ACL-Name

This attribute indicates the ACL name to be applied to the client. A summary of the ACL-Name Attribute format is shown below. The text boxes are transmitted from left to right.

```
0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+
| Type | Length | Vendor-Id |
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+

Vendor-Id (cont.) | Vendor type | Vendor length |
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+

| ACL Name... |
+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+-+
```

- Type – 26 for Vendor-Specific
• Length – >7
• Vendor-Id – 14179
• Vendor type – 6
• Vendor length – >0
• Value – A string that includes the name of the ACL to use for the client

Interface Name

This attribute indicates the VLAN Interface a client is to be associated to. A summary of the Interface-Name Attribute format is shown below. The text boxes are transmitted from left to right.

```plaintext
+-----------------+-----------------+-----------------+
| Type | Length | Vendor-Id |
+-----------------+-----------------+-----------------+
| Vendor-Id (cont.) | Vendor type | Vendor length |
+-----------------+-----------------+-----------------+
| Interface Name... |
```

• Type – 26 for Vendor-Specific
• Length – >7
• Vendor-Id – 14179
• Vendor type – 5
• Vendor length – >0
• Value – A string that includes the name of the interface the client is to be assigned to.

**Note**

This Attribute only works when MAC filtering is enabled or if 802.1X or WPA is used as the security policy.

VLAN Tag

This attribute indicates the group ID for a particular tunneled session and is also known as the Tunnel-Private-Group-ID attribute.

This attribute might be included in the Access-Request packet if the tunnel initiator can predetermine the group resulting from a particular connection and should be included in the Access-Accept packet if this tunnel session is to be treated as belonging to a particular private group. Private groups may be used to associate a tunneled session with a particular group of users. For example, it may be used to facilitate routing of unregistered IP addresses through a particular interface. It should be included in Accounting-Request packets which contain Acct-Status-Type attributes with values of either Start or Stop and which pertain to a tunneled session.

A summary of the Tunnel-Private-Group-ID Attribute format is shown below. The text boxes are transmitted from left to right.

```plaintext
+-----------------+-----------------+-----------------+
| Type | Length | Vendor-Id |
+-----------------+-----------------+-----------------+
| Vendor-Id (cont.) | Vendor type | Vendor length |
+-----------------+-----------------+-----------------+
| Interface Name...
```
• Type – 81 for Tunnel-Private-Group-ID.

• Length – >= 3

• Tag – The Tag text box is one octet in length and is intended to provide a means of grouping attributes in the same packet which refer to the same tunnel. If the value of the Tag text box is greater than 0x00 and less than or equal to 0x1F, it should be interpreted as indicating which tunnel (of several alternatives) this attribute pertains. If the Tag text box is greater than 0x1F, it should be interpreted as the first byte of the following String text box.

• String – This text box must be present. The group is represented by the String text box. There is no restriction on the format of group IDs.

---

**Note** When any of the other RADIUS attributes (QoS-Level, ACL-Name, Interface-Name, or VLAN-Tag) are returned, the Tunnel Attributes must also be returned.

---

**Tunnel Attributes**

RFC 2868 defines RADIUS tunnel attributes used for authentication and authorization, and RFC2867 defines tunnel attributes used for accounting. Where the IEEE 802.1X authenticator supports tunneling, a compulsory tunnel may be set up for the Supplicant as a result of the authentication.

In particular, it may be desirable to allow a port to be placed into a particular VLAN, defined in IEEE 8021Q, based on the result of the authentication. This configuration can be used, for example, to allow a wireless host to remain on the same VLAN as it moves within a campus network.

The RADIUS server typically indicates the desired VLAN by including tunnel attributes within the Access-Accept. However, the IEEE 802.1X authenticator may also provide a hint as to the VLAN to be assigned to the Supplicant by including Tunnel attributes within the AccessRequest.

For use in VLAN assignment, the following tunnel attributes are used:

• Tunnel-Type=VLAN (13)

• Tunnel-Medium-Type=802

• Tunnel-Private-Group-ID=VLANID

The VLAN ID is 12 bits, with a value between 1 and 4094, inclusive. Because the Tunnel-Private-Group-ID is of type String as defined in RFC 2868, for use with IEEE 802.1X, the VLANID integer value is encoded as a string.

When Tunnel attributes are sent, it is necessary to fill in the Tag text box. As noted in RFC 2868, section 3.1:

• The Tag text box is one octet in length and is intended to provide a means of grouping attributes in the same packet that refer to the same tunnel. Valid values for this text box are 0x01 through 0x1F, inclusive. If the Tag text box is unused, it must be zero (0x00).

• For use with Tunnel-Client-Endpoint, Tunnel-Server-Endpoint, Tunnel-Private-Group-ID, Tunnel-Assignment-ID, Tunnel-Client-Auth-ID or Tunnel-Server-Auth-ID attributes (but not Tunnel-Type, Tunnel-Medium-Type, Tunnel-Password, or Tunnel-Preference), a tag text box of greater than 0x1F is interpreted as the first octet of the following text box.
• Unless alternative tunnel types are provided, (e.g. for IEEE 802.1X authenticators that may support tunneling but not VLANs), it is only necessary for tunnel attributes to specify a single tunnel. As a result, where it is only desired to specify the VLANID, the tag text box should be set to zero (0x00) in all tunnel attributes. Where alternative tunnel types are to be provided, tag values between 0x01 and 0x1F should be chosen.

Configuring AAA Override

Information About AAA Override

The AAA Override option of a WLAN enables you to configure the WLAN for identity networking. It enables you to apply VLAN tagging, Quality of Service (QoS), and Access Control Lists (ACLs) to individual clients based on the returned RADIUS attributes from the AAA server.

AAA Override for IPv6 ACLs

In order to support centralized access control through a centralized AAA server such as the Cisco Identity Services Engine (ISE) or ACS, the IPv6 ACL can be provisioned on a per-client basis using AAA Override attributes. In order to use this feature, the IPv6 ACL must be configured on the controller and the WLAN must be configured with the AAA Override feature enabled. The actual named AAA attribute for an IPv6 ACL is `Airespace-IPv6-ACL-Name`, which is similar to the `Airespace-ACL-Name` attribute that is used for provisioning an IPv4-based ACL. The AAA attribute returned contents should be a string equal to the name of the IPv6 ACL as configured on the controller.

Note

From Release 7.5, the upstream AAA override rate limiting value is same as the downstream AAA override rate limiting value.

Restrictions for AAA Override

• If a client moves to a new interface due to the AAA override and then you apply an ACL to that interface, the ACL does not take effect until the client reauthenticates. To work around this issue, apply the ACL and then enable the WLAN so that all clients connect to the ACL that is already configured on the interface, or disable and then reenable the WLAN after you apply the interface so that the clients can reauthenticate.

• When the interface group is mapped to a WLAN and clients connect to the WLAN, the client does not get the IP address in a round robin fashion. The AAA override with interface group is supported.

• Most of the configuration for allowing AAA override is done at the RADIUS server, where you should configure the Access Control Server (ACS) with the override properties you would like it to return to the controller (for example, Interface-Name, QoS-Level, and VLAN-Tag).

• On the controller, enable the Allow AAA Override configuration parameter using the GUI or CLI. Enabling this parameter allows the controller to accept the attributes returned by the RADIUS server. The controller then applies these attributes to its clients.
If you are using a Steel-Belted RADIUS (SBR), FreeRadius, or similar RADIUS server, clients may not obtain the correct QoS values after the AAA override feature is enabled. For these servers, which allow you to edit the dictionary file, you need to update the file to reflect the proper QoS values: Silver is 0, Gold is 1, Platinum is 2, and Bronze is 3. To update the RADIUS server dictionary file, follow these steps:

This issue does not apply to the Cisco Secure Access Control Server (ACS).

To update the RADIUS server dictionary file, follow these steps:

1. Stop the SBR service (or other RADIUS service).
2. Save the following text to the `Radius_Install_Directory\Service` folder as `ciscowlan.dct`:

   ```
   # CiscoWLAN.dct - Cisco Wireless Lan Controllers
   # (See README.DCT for more details on the format of this file)
   # Dictionary - Cisco WLAN Controllers
   # Start with the standard Radius specification attributes
   @radius.dct
   
   # Standard attributes supported by Airespace
   
   # Define additional vendor specific attributes (VSAs)
   
   MACRO Airespace-VSA(t,s) 26 [vid=14179 type1=%t% len1=+2 data=%s%]

   ATTRIBUTE WLAN-Id Airespace-VSA(1, integer) cr
   ATTRIBUTE Aire-QoS-Level Airespace-VSA(2, integer) r
   VALUE Aire-QoS-Level Bronze 3
   VALUE Aire-QoS-Level Silver 0
   VALUE Aire-QoS-Level Gold 1
   VALUE Aire-QoS-Level Platinum 2
   ATTRIBUTE DSCP Airespace-VSA(3, integer) r
   ATTRIBUTE 802.1P-Tag Airespace-VSA(4, integer) r
   ATTRIBUTE Interface-Name Airespace-VSA(5, string) r
   ATTRIBUTE ACL-Name Airespace-VSA(6, string) r
   
   # This should be last.
   # CiscoWLAN.dct - Cisco WLC dictionary
   
   # This should be last.
   # CiscoWLAN.dct - Cisco WLC dictionary
   
3. Open the `dictionary.dcm` file (in the same directory) and add the line "@ciscowlan.dct."
4. Save and close the `dictionary.dcm` file.
5. Open the `vendor.ini` file (in the same directory) and add the following text:

   ```
   vendor-product = Cisco WLAN Controller
dictionary = ciscowlan
ignore-ports = no
port-number-usage = per-port-type
```
Configuring AAA Override (GUI)

Step 1  Choose WLANs to open the WLANs page.

Step 2  Click the ID number of the WLAN that you want to configure. The WLANs > Edit page appears.

Step 3  Choose the Advanced tab.

Step 4  Select the Allow AAA Override check box to enable AAA override or unselect it to disable this feature. The default value is disabled.

Step 5  Click Apply.

Step 6  Click Save Configuration.

Configuring AAA Override (CLI)

- Configure override of user policy through AAA on a WLAN by entering this command:

  \[\text{config wlan aaa-override} \{\text{enable} | \text{disable}\} \text{ wlan-id}\]

  For \text{wlan-id}, enter a value between 1 and 16.

- Configure debugging of 802.1X AAA interactions by entering this command:

  \[\text{debug dot1x aaa} \{\text{enable} | \text{disable}\}\]

Managing Rogue Devices

Information About Rogue Devices

Rogue access points can disrupt wireless LAN operations by hijacking legitimate clients and using plain-text or other denial-of-service or man-in-the-middle attacks. That is, a hacker can use a rogue access point to capture sensitive information, such as usernames and passwords. The hacker can then transmit a series of Clear to Send (CTS) frames. This action mimics an access point, informing a particular client to transmit, and instructing all the other clients to wait, which results in legitimate clients being unable to access network resources. Wireless LAN service providers have a strong interest in banning rogue access points from the air space.
Because rogue access points are inexpensive and readily available, employees sometimes plug unauthorized rogue access points into existing LANs and build ad hoc wireless networks without their IT department's knowledge or consent. These rogue access points can be a serious breach of network security because they can be plugged into a network port behind the corporate firewall. Because employees generally do not enable any security settings on the rogue access point, it is easy for unauthorized users to use the access point to intercept network traffic and hijack client sessions. Even more alarming, wireless users frequently publish unsecured access point locations, increasing the odds of having enterprise security breached.

The following are some guidelines to manage rogue devices:

• The containment frames are sent immediately after the authorization and associations are detected. The enhanced containment algorithm provides more effective containment of ad hoc clients.

• In a dense RF environment, where maximum rogue access points are suspected, the chances of detecting rogue access points by a local mode access point and FlexConnect mode access point in channel 157 or channel 161 are less when compared to other channels. To mitigate this problem, we recommend that you use dedicated monitor mode access points.

• The local and FlexConnect mode access points are designed to serve associated clients. These access points spend relatively less time performing off-channel scanning: about 50 milliseconds on each channel. If you want to perform high rogue detection, a monitor mode access point must be used. Alternatively, you can reduce the scan intervals from 180 seconds to a lesser value, for example, 120 or 60 seconds, ensuring that the radio goes off-channel more frequently, which improves the chances of rogue detection. However, the access point will still spend about 50 milliseconds on each channel.

• Rogue detection is disabled by default for OfficeExtend access points because these access points, which are deployed in a home environment, are likely to detect a large number of rogue devices.

• Client card implementations might mitigate the effectiveness of ad hoc containment.

• It is possible to classify and report rogue access points through the use of rogue states and user-defined classification rules that enable rogues to automatically move between states.

• Each controller limits the number of rogue containment to three per radio (or six per radio for access points in the monitor mode).

• Rogue Location Discovery Protocol (RLDP) detects rogue access points that are configured for open authentication.

• RLDP detects rogue access points that use a broadcast Basic Service Set Identifier (BSSID), that is, the access point broadcasts its Service Set Identifier in beacons.

• RLDP detects only those rogue access points that are on the same network. If an access list in the network prevents the sending of RLDP traffic from the rogue access point to the controller, RLDP does not work.

• RLDP does not work on 5-GHz dynamic frequency selection (DFS) channels. However, RLDP works when the managed access point is in the monitor mode on a DFS channel.

• If RLDP is enabled on mesh APs, and the APs perform RLDP tasks, the mesh APs are dissociated from the controller. The workaround is to disable RLDP on mesh APs.

• If RLDP is enabled on nonmonitor APs, client connectivity outages occur when RLDP is in process.

• If the rogue is manually contained, the rogue entry is retained even after the rogue expires.

• If the rogue is contained by any other means, such as auto, rule, and AwIPS preventions, the rogue entry is deleted when it expires.
- The controller will request to AAA server for rogue client validation only once. As a result, if rogue client validation fails on the first attempt then the rogue client will not be detected as a threat any more. To avoid this, add the valid client entries in the authentication server before enabling **Validate Rogue Clients Against AAA**.

- In the 7.4 and earlier releases, if a rogue that was already classified by a rule was not reclassified. In the 7.5 release, this behavior is enhanced to allow reclassification of rogues based on the priority of the rogue rule. The priority is determined by using the rogue report that is received by the controller.

- The rogue detector AP fails to co-relate and contain the wired rogue AP on a 5Mhz channel because the MAC address of the rogue AP for WLAN, LAN, 11a radio and 11bg radio are configured with a difference of +/-1 of the rogue BSSID. In the 8.0 release, this behavior is enhanced by increasing the range of MAC address, that the rogue detector AP co-relates the wired ARP MAC and rogue BSSID, by +/-3.

- The rogue access points with open authentication can be detected on wire. The NAT wired or rogue wired detection is not supported in by WLC (both RLDP and rogue detector AP). The non-adjacent MAC address is supported by rogue detector mode of AP and not by RLDP.

**Note**
A rogue AP or client or adhoc containment configuration is not saved after the reload. You have to configure all the rogues again after the reload.

**Note**
No separate command exists for controlling rogue client traps. However, you can enable or disable rogue client traps using the `config trapflags rogueap {enable | disable}` command, which is also used for rouge APs. In GUI configuration also, you should use the rogue AP flag under Management->SNMP->TrapControl->Security->Rogue AP to control rogue clients.

**Rogue Location Discovery Protocol**
Rogue Location Discovery Protocol (RLDP) is an active approach, which is used when rogue AP has no authentication (Open Authentication) configured. This mode, which is disabled by default, instructs an active AP to move to the rogue channel and connect to the rogue as a client. During this time, the active AP sends de-authentication messages to all connected clients and then shuts down the radio interface. Then, it associates to the rogue AP as a client. The AP then tries to obtain an IP address from the rogue AP and forwards a User Datagram Protocol (UDP) packet (port 6352) that contains the local AP and rogue connection information to the controller through the rogue AP. If the controller receives this packet, the alarm is set to notify the network administrator that a rogue AP was discovered on the wired network with the RLDP feature.

RLDP has 100% accuracy in rogue AP detection. It detects Open APs and NAT APs.

**Note**
Use the `debug dot11 rldp enable` command in order to check if the Lightweight AP associates and receives a DHCP address from the rogue AP. This command also displays the UDP packet sent by the Lightweight AP to the controller.

A sample of a UDP (destination port 6352) packet sent by the Lightweight AP is shown here:

```
0020 0a 01 01 0d 0a 01 .......(.*.... 0030 01 1e 00 07 85 92 78 01 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
```
The first 5 bytes of the data contain the DHCP address given to the local mode AP by the rogue AP. The next 5 bytes are the IP address of the controller, followed by 6 bytes that represent the rogue AP MAC address. Then, there are 18 bytes of zeroes.

Steps of how RLDP works are listed here:

1. Identify the closest Unified AP to the rogue using signal strength values.
2. The AP then connects to the rogue as a WLAN client, attempting three associations before timing out.
3. If association is successful, the AP then uses DHCP to obtain an IP address.
4. If an IP address was obtained, the AP (acting as a WLAN client) sends a UDP packet to each of the controller's IP addresses.
5. If the controller receives even one of the RLDP packets from the client, that rogue is marked as on-wire with a severity of critical.

---

**Note**

The RLDP packets are unable to reach the controller if filtering rules are placed between the controller's network and the network where the rogue device is located.

Caveats of RLDP:

- RLDP only works with open rogue APs broadcasting their SSID with authentication and encryption disabled.
- RLDP requires that the Managed AP acting as a client is able to obtain an IP address via DHCP on the rogue network.
- Manual RLDP can be used to attempt an RLDP trace on a rogue multiple number of times.
- During RLDP process, the AP is unable to serve clients. This negatively impacts performance and connectivity for local mode APs. To avoid this case, RLDP can be selectively enabled for Monitor Mode AP only.
- RLDP does not attempt to connect to a rogue AP operating in a 5GHz DFS channel.

---

**Note**

RLDP is not supported for use with Cisco autonomous rogue access points. These access points drop the DHCP Discover request sent by the RLDP client. Also, RLDP is not supported if the rogue access point channel requires dynamic frequency selection (DFS). If the automatic RLDP attempt does not detect the rogue (due to a noisy RF environment, for example), the controller does not retry. However, you can initiate RLDP manually on a rogue device.

---

**Detecting Rogue Devices**

The controller continuously monitors all the nearby access points and automatically discovers and collects information on rogue access points and clients. When the controller discovers a rogue access point, it uses the Rogue Location Discovery Protocol (RLDP) and the rogue detector mode access point is connected to determine if the rogue is attached to your network.

Controller initiates RLDP on rogue devices that have open authenticated and configured. If RLDP uses Flexconnect or local mode access points, then clients are disconnected for that moment. After the RLDP cycle,
the clients are reconnected to the access points. As and when rogue access points are seen (auto-configuration), the RLDP process is initiated.

You can configure the controller to use RLDP on all the access points or only on the access points configured for the monitor (listen-only) mode. The latter option facilitates automated rogue access point detection in a crowded radio frequency (RF) space, allowing monitoring without creating unnecessary interference and without affecting the regular data access point functionality. If you configure the controller to use RLDP on all the access points, the controller always chooses the monitor access point for RLDP operation if a monitor access point and a local (data) access point are both nearby. If RLDP determines that the rogue is on your network, you can choose to contain the detected rogue either manually or automatically.

RLDP detects on wire presence of the rogue access points that are configured with open authentication only once, which is the default retry configuration. Retries can be configured using the `config rogue ap rldp retries` command.

You can initiate or trigger RLDP from controller in three ways:

1. Enter the RLDP initiation command manually from the controller CLI. The equivalent GUI option for initiating RLDP is not supported.
   ```
   config rogue ap rldp initiate mac-address
   ```
2. Schedule RLDP from the controller CLI. The equivalent GUI option for scheduling RLDP is not supported.
   ```
   config rogue ap rldp schedule
   ```
3. Auto RLDP. You can configure auto RLDP on controller either from controller CLI or GUI but keep in mind the following guidelines:
   - The auto RLDP option can be configured only when the rogue detection security level is set to custom.
   - Either auto RLDP or schedule of RLDP can be enabled at a time.

A rogue access point is moved to a contained state either automatically or manually. The controller selects the best available access point for containment and pushes the information to the access point. The access point stores the list of containments per radio. For auto containment, you can configure the controller to use only the monitor mode access point. The containment operation occurs in the following two ways:

- The container access point goes through the list of containments periodically and sends unicast containment frames. For rogue access point containment, the frames are sent only if a rogue client is associated.
- Whenever a contained rogue activity is detected, containment frames are transmitted.

Individual rogue containment involves sending a sequence of unicast disassociation and deauthentication frames.

**Cisco Prime Infrastructure Interaction and Rogue Detection**

Cisco Prime Infrastructure supports rule-based classification and uses the classification rules configured on the controller. The controller sends traps to Cisco Prime Infrastructure after the following events:

- If an unknown access point moves to the Friendly state for the first time, the controller sends a trap to Cisco Prime Infrastructure only if the rogue state is Alert. It does not send a trap if the rogue state is Internal or External.
- If a rogue entry is removed after the timeout expires, the controller sends a trap to Cisco Prime Infrastructure for rogue access points categorized as Malicious (Alert, Threat) or Unclassified (Alert).
The controller does not remove rogue entries with the following rogue states: Contained, Contained Pending, Internal, and External.

**Configuring Rogue Detection (GUI)**

**Step 1** Make sure that rogue detection is enabled on the corresponding access points. Rogue detection is enabled by default for all access points joined to the controller (except for OfficeExtend access points). However, you can enable or disable rogue detection for individual access points by selecting or unselecting the Rogue Detection check box on the All APs > Details for (Advanced) page.

**Step 2** Choose Security > Wireless Protection Policies > Rogue Policies > General. The Rogue Policies page is displayed.

**Step 3** Choose one of the following options from the Rogue Location Discovery Protocol drop-down list:

- **Disable**—Disables RLDP on all the access points. This is the default value.
- **All APs**—Enables RLDP on all the access points.
- **Monitor Mode APs**—Enables RLDP only on the access points in the monitor mode.

**Step 4** In the Expiration Timeout for Rogue AP and Rogue Client Entries text box, enter the number of seconds after which the rogue access point and client entries expire and are removed from the list. The valid range is 240 to 3600 seconds, and the default value is 1200 seconds.

**Note** If a rogue access point or client entry times out, it is removed from the controller only if its rogue state is Alert or Threat for any classification type.

**Step 5** To use the AAA server or local database to validate if rogue clients are valid clients, select the Validate Rogue Clients Against AAA check box. By default, the check box is unselected.

**Step 6** If necessary, select the Detect and Report Ad-Hoc Networks check box to enable ad hoc rogue detection and reporting. By default, the check box is selected.

**Step 7** In the Rogue Detection Report Interval text box, enter the time interval, in seconds, at which APs should send the rogue detection report to the controller. The valid range is 10 seconds to 300 seconds, and the default value is 10 seconds.

**Step 8** In the Rogue Detection Minimum RSSI text box, enter the minimum Received Signal Strength Indicator (RSSI) value that a rogue entry should have for APs to detect the rogue and for a rogue entry to be created in the controller. The valid range is $-128 \text{ dBm}$ to $-0 \text{ dBm}$, and the default value is $0 \text{ dBm}$.

**Note** This feature is applicable to all the AP modes. There can be many rogues with very weak RSSI values that do not provide any valuable information in rogue analysis. Therefore, you can use this option to filter rogues by specifying the minimum RSSI value at which APs should detect rogues.

**Step 9** In the Rogue Detection Transient Interval text box, enter the time interval at which a rogue should be scanned for by the AP after the first time the rogue is scanned. After the rogue is scanned for consistently, updates are sent periodically to the controller. Thus, the APs filter the transient rogues, which are active for a very short period and are then silent. The valid range is between 120 seconds to 1800 seconds, and the default value is 0.

The rogue detection transient interval is applicable to the monitor mode APs only.

This feature has the following advantages:

- Rogue reports from APs to the controller are shorter.
- Transient rogue entries are avoided in the controller.
• Unnecessary memory allocation for transient rogues are avoided.

Step 10

If you want the controller to automatically contain certain rogue devices, enable the following parameters. By default, these parameters are in disabled state.

Caution

When you select any of the Auto Contain parameters and click **Apply**, the following message is displayed:

"Using this feature may have legal consequences. Do you want to continue?"

The 2.4-GHz and 5-GHz frequencies in the Industrial, Scientific, and Medical (ISM) band are open to the public and can be used without a license. As such, containing devices on another party’s network could have legal consequences.

• **Auto Containment Level**—Set the auto containment level. By default, the auto containment level is set to 1.

• **Auto Containment only for Monitor mode APs**—Configure the monitor mode access points for auto-containment.

• **Rogue on Wire**—Configure the auto containment of rogues that are detected on the wired network.

• **Using Our SSID**—Configure the auto containment of rogues that are advertising your network’s SSID. If you leave this parameter unselected, the controller only generates an alarm when such a rogue is detected.

• **Valid Client on Rogue AP**—Configure the auto containment of a rogue access point to which trusted clients are associated. If you leave this parameter unselected, the controller only generates an alarm when such a rogue is detected.

• **AdHoc Rogue AP**—Configure the auto containment of ad hoc networks detected by the controller. If you leave this parameter unselected, the controller only generates an alarm when such a network is detected.

Step 11

Click **Apply**.

Step 12

Click **Save Configuration**.

---

### Configuring Rogue Detection (CLI)

**Step 1**

Ensure that rogue detection is enabled on the desired access points. Rogue detection is enabled by default for all the access points that are associated with the controller. You can enable or disable rogue detection for individual access points by entering this command:

```
config rogue detection {enable | disable} cisco-ap command.
```

**Note**

To see the current Rogue detection configuration for a specific access point, enter the **show ap config general Cisco_AP** command.

**Note**

Rogue detection is disabled by default for OfficeExtend access points because these access points, which are deployed in a home environment, are likely to detect a large number of rogue devices.

**Step 2**

Enable, disable, or initiate RLDP by entering these commands:

- **config rogue ap rldp enable alarm-only**—Enables RLDP on all the access points.

- **config rogue ap rldp enable alarm-only monitor_ap_only**—Enables RLDP only on the access points in the monitor mode.
• config rogue ap rldp initiate rogue_mac_address—Initiates RLDP on a specific rogue access point.

• config rogue ap rldp disable—Disables RLDP on all the access points.

• config rogue ap rldp retries—Specifies the number of times RLDP to be tried per rogue access point. The range is from 1 to 5 and default is 1.

Step 3 Specify the number of seconds after which the rogue access point and client entries expire and are removed from the list by entering this command:

```plaintext
config rogue ap timeout seconds
```

The valid range for the `seconds` parameter is 240 to 3600 seconds (inclusive). The default value is 1200 seconds.

**Note** If a rogue access point or client entry times out, it is removed from the controller only if its rogue state is Alert or Threat for a classification type.

Step 4 Enable or disable ad hoc rogue detection and reporting by entering this command:

```plaintext
config rogue adhoc {enable | disable}
```

Step 5 Enable or disable the AAA server or local database to validate if rogue clients are valid clients by entering this command:

```plaintext
config rogue client aaa {enable | disable}
```

Step 6 Specify the time interval, in seconds, at which APs should send the rogue detection report to the controller by entering this command:

```plaintext
config rogue detection monitor-ap report-interval time in sec
```

The valid range for the `time in sec` parameter is 10 seconds to 300 seconds. The default value is 10 seconds.

**Note** This feature is applicable only to the monitor mode APs.

Step 7 Specify the minimum RSSI value that rogues should have for APs to detect them and for the rogue entries to be created in the controller by entering this command:

```plaintext
config rogue detection min-rssi rssi in dBm
```

The valid range for the `rssi in dBm` parameter is −128 dBm to 0 dBm. The default value is 0 dBm.

**Note** This feature is applicable to all the AP modes. There can be many rogues with very weak RSSI values that do not provide any valuable information in rogue analysis. Therefore, you can use this option to filter rogues by specifying the minimum RSSI value at which APs should detect rogues.

Step 8 Specify the time interval at which rogues have to be consistently scanned for by APs after the first time the rogues are scanned for by entering this command:

```plaintext
config rogue detection monitor-ap transient-rogue-interval time in sec
```

The valid range for the `time in sec` parameter is 120 seconds to 1800 seconds. The default value is 0.

**Note** This feature is applicable only to the monitor mode APs.

Using the transient interval values, you can control the time interval at which APs should scan for rogues. APs can also filter rogues based on their transient interval values.

This feature has the following advantages:

• Rogue reports from APs to the controller are shorter.

• Transient rogue entries are avoided in the controller.

• Unnecessary memory allocation for transient rogues are avoided.

Step 9 If you want the controller to automatically contain certain rogue devices, enter these commands.
Caution When you enter any of these commands, the following message is displayed: Using this feature may have legal consequences. Do you want to continue? The 2.4-GHz and 5-GHz frequencies in the Industrial, Scientific, and Medical (ISM) band are open to the public and can be used without a license. As such, containing devices on another party’s network could have legal consequences.

- **config rogue ap rldp enable auto-contain**—Automatically contains the rogues that are detected on the wired network.

- **config rogue ap ssid auto-contain**—Automatically contains the rogues that are advertising your network’s SSID.
  
  **Note** If you want the controller to only generate an alarm when such a rogue is detected, enter the **config rogue ap ssid alarm** command.

- **config rogue ap valid-client auto-contain**—Automatically contains a rogue access point to which trusted clients are associated.
  
  **Note** If you want the controller to only generate an alarm when such a rogue is detected, enter the **config rogue ap valid-client alarm** command.

- **config rogue adhoc auto-contain**—Automatically contains ad hoc networks detected by the controller.
  
  **Note** If you want the controller to only generate an alarm when such a network is detected, enter the **config rogue adhoc alert** command.

- **config rogue auto-contain level level monitor_mode_ap_only**—Sets the auto containment level for the monitor mode access points. The default value is 1.

### Step 10
Configure ad hoc rogue classification by entering these commands:

- **config rogue adhoc classify friendly state {internal | external} mac-addr**
- **config rogue adhoc classify malicious state {alert | contain} mac-addr**
- **config rogue adhoc classify unclassified state {alert | contain} mac-addr**

The following is a brief description of the parameters:

- **internal**—Trusts a foreign ad hoc rogue.
- **external**—Acknowledges the presence of an ad hoc rogue.
- **alert**—Generates a trap when an ad hoc rogue is detected.
- **contain**—Starts containing a rogue ad hoc.

### Step 11
Configure RLDP scheduling by entering this command:

```plaintext
config rogue ap rldp schedule { add | delete | disable | enable }
```

- **add**—Enables you to schedule RLDP on a particular day of the week. You must enter the day of the week (for example, mon, tue, wed, and so on) on which you want to schedule RLDP and the start time and end time in HH:MM:SS format. For example: **config rogue ap rldp schedule add mon 22:00:00 23:00:00**.

- **delete**—Enables you to delete the RLDP schedule. You must enter the number of days.

- **disable**—Configure to disable RLDP scheduling.

- **enable**—Configure to enable RLDP scheduling.
When you configure RLDP scheduling, it is assumed that the scheduling will occur in the future, that is, after the configuration is saved.

**Step 12**

Save your changes by entering this command:
```
save config
```

**Note**

Rogue client detection on non monitor AP on serving channel was not done until 8.1 Release. From Release 8.1 onwards, serving channel rogue client detection will happen only if WIPS submode is turned on non monitor AP's.

---

### Classifying Rogue Access Points

#### Information About Classifying Rogue Access Points

The controller software enables you to create rules that can organize and display rogue access points as Friendly, Malicious, or Unclassified.

By default, none of the classification rules are enabled. Therefore, all unknown access points are categorized as Unclassified. When you create a rule, configure conditions for it, and enable the rule, the unclassified access points are reclassified. Whenever you change a rule, it is applied to all access points (friendly, malicious, and unclassified) in the Alert state only.

**Note**

Rule-based rogue classification does not apply to ad hoc rogues and rogue clients.

**Note**

You can configure up to 64 rogue classification rules per controller.

When the controller receives a rogue report from one of its managed access points, it responds as follows:

1. The controller verifies that the unknown access point is in the friendly MAC address list. If it is, the controller classifies the access point as Friendly.

2. If the unknown access point is not in the friendly MAC address list, the controller starts applying rogue classification rules.

3. If the rogue is already classified as Malicious, Alert or Friendly, Internal or External, the controller does not reclassify it automatically. If the rogue is classified differently, the controller reclassifies it automatically only if the rogue is in the Alert state.

4. The controller applies the first rule based on priority. If the rogue access point matches the criteria specified by the rule, the controller classifies the rogue according to the classification type configured for the rule.

5. If the rogue access point does not match any of the configured rules, the controller classifies the rogue as Unclassified.

6. The controller repeats the previous steps for all rogue access points.
If RLDP determines that the rogue access point is on the network, the controller marks the rogue state as Threat and classifies it as Malicious automatically, even if no rules are configured. You can then manually contain the rogue (unless you have configured RLDP to automatically contain the rogue), which would change the rogue state to Contained. If the rogue access point is not on the network, the controller marks the rogue state as Alert, and you can manually contain the rogue.

If desired, you can manually move the access point to a different classification type and rogue state.

Table 15: Classification Mapping

<table>
<thead>
<tr>
<th>Rule-Based Classification Type</th>
<th>Rogue States</th>
</tr>
</thead>
</table>
| Friendly                      | • Internal—If the unknown access point is inside the network and poses no threat to WLAN security, you would manually configure it as Friendly, Internal. An example is the access points in your lab network.  
|                               | • External—If the unknown access point is outside the network and poses no threat to WLAN security, you would manually configure it as Friendly, External. An example is an access point that belongs to a neighboring coffee shop.  
|                               | • Alert—The unknown access point is moved to Alert if it is not in the neighbor list or in the user-configured friendly MAC list. |
| Malicious                     | • Alert—The unknown access point is moved to Alert if it is not in the neighbor list or in the user-configured friendly MAC list.  
|                               | • Threat—The unknown access point is found to be on the network and poses a threat to WLAN security.  
|                               | • Contained—The unknown access point is contained.  
|                               | • Contained Pending—The unknown access point is marked Contained, but the action is delayed due to unavailable resources. |
| Unclassified                  | • Pending—On first detection, the unknown access point is put in the Pending state for 3 minutes. During this time, the managed access points determine if the unknown access point is a neighbor access point.  
|                               | • Alert—The unknown access point is moved to Alert if it is not in the neighbor list or in the user-configured friendly MAC list.  
|                               | • Contained—The unknown access point is contained.  
|                               | • Contained Pending—The unknown access point is marked Contained, but the action is delayed due to unavailable resources. |

The classification and state of the rogue access points are configured as follows:

• From Known to Friendly, Internal
• From Acknowledged to Friendly, External
• From Contained to Malicious, Contained

As mentioned previously, the controller can automatically change the classification type and rogue state of an unknown access point based on user-defined rules, or you can manually move the unknown access point to a different classification type and rogue state.

Table 16: Allowable Classification Type and Rogue State Transitions

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Friendly (Internal, External, Alert)</td>
<td>Malicious (Alert)</td>
</tr>
<tr>
<td>Friendly (Internal, External, Alert)</td>
<td>Unclassified (Alert)</td>
</tr>
<tr>
<td>Friendly (Alert)</td>
<td>Friendly (Internal, External)</td>
</tr>
<tr>
<td>Malicious (Alert, Threat)</td>
<td>Friendly (Internal, External)</td>
</tr>
<tr>
<td>Malicious (Contained, Contained Pending)</td>
<td>Malicious (Alert)</td>
</tr>
<tr>
<td>Unclassified (Alert, Threat)</td>
<td>Friendly (Internal, External)</td>
</tr>
<tr>
<td>Unclassified (Contained, Contained Pending)</td>
<td>Unclassified (Alert)</td>
</tr>
<tr>
<td>Unclassified (Alert)</td>
<td>Malicious (Alert)</td>
</tr>
</tbody>
</table>

If the rogue state is Contained, you have to uncontain the rogue access point before you can change the classification type. If you want to move a rogue access point from Malicious to Unclassified, you must delete the access point and allow the controller to reclassify it.

Restrictions for Classifying Rogue Access Points

There are some rogue rules. They are:

• Classifying Custom type rogues is tied to rogue rules. Therefore, it is not possible to manually classify a rogue as Custom. Custom class change can occur only using rogue rules.

• There are traps that are sent for containment by rule and for every 30 minutes for rogue classification change. For custom classification, the first trap does not contain the severity score because the trap has existed before the custom classification. The severity score is obtained from the subsequent trap that is generated after 30 minutes if the rogue is classified.

• Rogue rules are applied on every incoming new rogue report in the controller in the order of their priority.

• Once a rogue satisfies a higher priority rule and classified, it does not move down the priority list for the same report.

• Previously classified rogue gets re-classified on every new rogue report with the following restrictions:
  • Rogues which are classified as friendly by rule and whose state is set to ALERT, go through re-classification on receiving the new rogue report.
• If a rogue is classified as friendly by the administrator manually, then the state is INTERNAL and it does not get re-classified on successive rogue reports.

• If rogue is classified as malicious, irrespective of the state it does not get re-classified on subsequent rogue reports.

• Transition of the rogue's state from friendly to malicious is possible by multiple rogue rules if some attribute is missing in new rogue report.

• Transition of the rogue's state from malicious to any other classification is not possible by any rogue rule.

**Configuring Rogue Classification Rules (GUI)**

**Step 1** Choose **Security > Wireless Protection Policies > Rogue Policies > Rogue Rules** to open the Rogue Rules page. Any rules that have already been created are listed in priority order. The name, type, and status of each rule is provided.

**Note** To delete a rule, hover your cursor over the blue drop-down arrow for that rule and click **Remove**.

**Step 2** Create a new rule as follows:

a) Click **Add Rule**. An Add Rule section appears at the top of the page.

b) In the **Rule Name** text box, enter a name for the new rule. Ensure that the name does not contain any spaces.

c) From the **Rule Type** drop-down list, choose from the following options to classify rogue access points matching this rule as friendly or malicious:

   • Friendly
   • Malicious

d) Click **Add** to add this rule to the list of existing rules, or click **Cancel** to discard this new rule.

**Step 3** Edit a rule as follows:

a) Click the name of the rule that you want to edit. The **Rogue Rule > Edit** page appears.

b) From the Type drop-down list, choose from the following options to classify rogue access points matching this rule:

   • Friendly
   • Malicious

c) From the Match Operation text box, choose one of the following:

   **Match All**—If this rule is enabled, a detected rogue access point must meet all of the conditions specified by the rule in order for the rule to be matched and the rogue to adopt the classification type of the rule.

   **Match Any**—If this rule is enabled, a detected rogue access point must meet any of the conditions specified by the rule in order for the rule to be matched and the rogue to adopt the classification type of the rule. This is the default value.

d) To enable this rule, select the **Enable Rule** check box. The default value is unselected.

e) From the Add Condition drop-down list, choose one or more of the following conditions that the rogue access point must meet and click **Add Condition**.
• **SSID**—Requires that the rogue access point have a specific user-configured SSID. If you choose this option, enter the SSID in the **User Configured SSID** text box, and click **Add SSID**.

  **Note**  
  To delete an SSID, highlight the SSID and click **Remove**.

• **RSSI**—Requires that the rogue access point have a minimum received signal strength indication (RSSI) value. For example, if the rogue access point has an RSSI that is greater than the configured value, then the access point could be classified as malicious. If you choose this option, enter the minimum RSSI value in the **Minimum RSSI** text box. The valid range is $-95$ to $-50$ dBm (inclusive), and the default value is $0$ dBm.

• **Duration**—Requires that the rogue access point be detected for a minimum period of time. If you choose this option, enter a value for the minimum detection period in the **Time Duration** text box. The valid range is $0$ to $3600$ seconds (inclusive), and the default value is $0$ seconds.

• **Client Count**—Requires that a minimum number of clients be associated to the rogue access point. For example, if the number of clients associated to the rogue access point is greater than or equal to the configured value, then the access point could be classified as malicious. If you choose this option, enter the minimum number of clients to be associated to the rogue access point in the **Minimum Number of Rogue Clients** text box. The valid range is $1$ to $10$ (inclusive), and the default value is $0$.

• **No Encryption**—Requires that the rogue access point’s advertised WLAN does not have encryption enabled. If a rogue access point has encryption disabled, it is likely that more clients will try to associate to it. No further configuration is required for this option.

  **Note**  
  Cisco Prime Infrastructure refers to this option as "Open Authentication."

• **Managed SSID**—Requires that the rogue access point’s managed SSID (the SSID configured for the WLAN) be known to the controller. No further configuration is required for this option.

  **Note**  
  The SSID and Managed SSID conditions cannot be used with the Match All operation because these two SSID lists are mutually exclusive. If you define a rule with Match All and have these two conditions configured, the rogue access points are never classified as friendly or malicious because one of the conditions can never be met.

  You can add up to six conditions per rule. When you add a condition, it appears under the Conditions section.

  **Note**  
  To delete a condition from this rule, hover your cursor over the blue drop-down arrow for that condition and click **Remove**.

f) Click **Apply**.

**Step 4**  
Click **Save Configuration**.

**Step 5**  
If you want to change the order in which rogue classification rules are applied, follow these steps:

1. Click **Back** to return to the Rogue Rules page.

2. Click **Change Priority** to access the Rogue Rules > Priority page.

   The rogue rules are listed in priority order in the Change Rules Priority text box.

3. Highlight the rule for which you want to change the priority, and click **Up** to raise its priority in the list or **Down** to lower its priority in the list.

4. Continue to move the rules up or down until the rules are in the desired order.

5. Click **Apply**.
Step 6  Classify any rogue access points as friendly and add them to the friendly MAC address list as follows:

- In the MAC Address text box, enter the MAC address of the friendly rogue access point.
- Click Apply.
- Click Save Configuration. This access point is added to the controller’s list of friendly access points and should now appear on the Friendly Rogue APs page.

Viewing and Classifying Rogue Devices (GUI)

Before You Begin

⚠️ Caution  When you choose to contain a rogue device, the following warning appears: “There may be legal issues following this containment. Are you sure you want to continue?” The 2.4- and 5-GHz frequencies in the Industrial, Scientific, and Medical (ISM) band are open to the public and can be used without a license. As such, containing devices on another party’s network could have legal consequences.

Step 1  Choose Monitor > Rogues.
Step 2  Choose the following options to view the different types of rogue access points detected by the controller:

- Friendly APs
- Malicious APs
- Unclassified APs

The respective rogue APs pages provide the following information: the MAC address and SSID of the rogue access point, channel number, the number of radios that detected the rogue access point, the number of clients connected to the rogue access point, and the current status of the rogue access point.

Note  To remove acknowledged rogues from the database, change the rogue state to Alert. If the rogue is no longer present, the rogue data is deleted from the database in 20 minutes.

Note  To delete a rogue access point from one of these pages, hover your cursor over the blue drop-down arrow and click Remove. To delete multiple rogue access points, select the check box corresponding to the row you want to delete and click Remove.

Note  You can move the Malicious or Unclassified rogue APs that are being contained or were contained back to Alert state by clicking the Move to Alert button on the respective pages.

Step 3  Get more details about a rogue access point by clicking the MAC address of the access point. The Rogue AP Detail page appears.
This page provides the following information: the MAC address of the rogue device, the type of rogue device (such as an access point), whether the rogue device is on the wired network, the dates and times when the rogue device was first and last reported, and the current status of the device.

The Class Type text box shows the current classification for this rogue access point:

- **Friendly**—An unknown access point that matches the user-defined friendly rules or an existing known and acknowledged rogue access point. Friendly access points cannot be contained.

- **Malicious**—An unknown access point that matches the user-defined malicious rules or is moved manually by the user from the Friendly or Unclassified classification type.

  **Note** Once an access point is classified as Malicious, you cannot apply rules to it in the future, and it cannot be moved to another classification type. If you want to move a malicious access point to the Unclassified classification type, you must delete the access point and allow the controller to reclassify it.

- **Unclassified**—An unknown access point that does not match the user-defined friendly or malicious rules. An unclassified access point can be contained. It can also be moved to the Friendly or Malicious classification type automatically in accordance with user-defined rules or manually by the user.

**Step 4** If you want to change the classification of this device, choose a different classification from the Class Type drop-down list.

  **Note** A rogue access point cannot be moved to another class if its current state is Contain.

**Step 5** From the Update Status drop-down list, choose one of the following options to specify how the controller should respond to this rogue access point:

- **Internal**—The controller trusts this rogue access point. This option is available if the Class Type is set to Friendly.

- **External**—The controller acknowledges the presence of this rogue access point. This option is available if the Class Type is set to Friendly.

- **Contain**—The controller contains the offending device so that its signals no longer interfere with authorized clients. This option is available if the Class Type is set to Malicious or Unclassified.

- **Alert**—The controller forwards an immediate alert to the system administrator for further action. This option is available if the Class Type is set to Malicious or Unclassified.

The bottom of the page provides information on both the access points that detected this rogue access point and any clients that are associated to it. To see more details for any of the clients, click **Edit** to open the Rogue Client Detail page.

**Step 6** Click **Apply**.

**Step 7** Click **Save Configuration**.

**Step 8** View any rogue clients that are connected to the controller by choosing **Rogue Clients**. The Rogue Clients page appears. This page shows the following information: the MAC address of the rogue client, the MAC address of the access point to which the rogue client is associated, the SSID of the rogue client, the number of radios that detected the rogue client, the date and time when the rogue client was last reported, and the current status of the rogue client.

**Step 9** Obtain more details about a rogue client by clicking the MAC address of the client. The Rogue Client Detail page appears.
This page provides the following information: the MAC address of the rogue client, the MAC address of the rogue access point to which this client is associated, the SSID and IP address of the rogue client, the dates and times when the rogue client was first and last reported, and the current status of the rogue client.

**Step 10**  
From the Update Status drop-down list, choose one of the following options to specify how the controller should respond to this rogue client:

- **Contain**—The controller contains the offending device so that its signals no longer interfere with authorized clients.
- **Alert**—The controller forwards an immediate alert to the system administrator for further action.

The bottom of the page provides information on the access points that detected this rogue client.

**Step 11**  
Click **Apply**.

**Step 12**  
If desired, you can test the controller’s connection to this client by clicking **Ping**.

**Step 13**  
Click **Save Configuration**.

**Step 14**  
See any ad-hoc rogues detected by the controller by choosing **Adhoc Rogues**. The Adhoc Rogues page appears. This page shows the following information: the MAC address, BSSID, and SSID of the ad-hoc rogue, the number of radios that detected the ad-hoc rogue, and the current status of the ad-hoc rogue.

**Step 15**  
Obtain more details about an ad-hoc rogue by clicking the MAC address of the rogue. The Adhoc Rogue Detail page appears. This page provides the following information: the MAC address and BSSID of the ad-hoc rogue, the dates and times when the rogue was first and last reported, and the current status of the rogue.

**Step 16**  
From the Update Status drop-down list, choose one of the following options to specify how the controller should respond to this ad-hoc rogue:

- **Contain**—The controller contains the offending device so that its signals no longer interfere with authorized clients.
- **Alert**—The controller forwards an immediate alert to the system administrator for further action.
- **Internal**—The controller trusts this rogue access point.
- **External**—The controller acknowledges the presence of this rogue access point.

**Step 17**  
From the Maximum number of APs to contain the rogue drop-down list, choose one of the following options to specify the maximum number of access points used to contain this ad-hoc rogue: 1, 2, 3, or 4. The bottom of the page provides information on the access points that detected this ad-hoc rogue:

- **1**—Specifies targeted rogue access point is contained by one access point. This is the lowest containment level.
- **2**—Specifies targeted rogue access point is contained by two access points.
- **3**—Specifies targeted rogue access point is contained by three access points.
- **4**—Specifies targeted rogue access point is contained by four access points. This is the highest containment level.

**Step 18**  
Click **Apply**.

**Step 19**  
Click **Save Configuration**.

**Step 20**  
View any access points that have been configured to be ignored by choosing **Rogue AP Ignore-List**. The Rogue AP Ignore-List page appears. This page shows the MAC addresses of any access points that are configured to be ignored. The rogue-ignore list contains a list of any autonomous access points that have been manually added to Cisco Prime Infrastructure maps by the users.
The controller regards these autonomous access points as rogues even though the Prime Infrastructure is managing them. The rogue-ignore list allows the controller to ignore these access points. The list is updated as follows:

- When the controller receives a rogue report, it checks to see if the unknown access point is in the rogue-ignore access point list.
- If the unknown access point is in the rogue-ignore list, the controller ignores this access point and continues to process other rogue access points.
- If the unknown access point is not in the rogue-ignore list, the controller sends a trap to the Prime Infrastructure. If the Prime Infrastructure finds this access point in its autonomous access point list, the Prime Infrastructure sends a command to the controller to add this access point to the rogue-ignore list. This access point is then ignored in future rogue reports.
- If a user removes an autonomous access point from the Prime Infrastructure, the Prime Infrastructure sends a command to the controller to remove this access point from the rogue-ignore list.

---

### Configuring Rogue Classification Rules (CLI)

**Step 1**

Create a rule by entering this command:

```
config rogue rule add ap priority priority classify {friendly | malicious} rule-name
```

If you later want to change the priority of this rule and shift others in the list accordingly, enter the `config rogue rule priority priority rule-name` command.

If you later want to change the classification of this rule, enter the `config rogue rule classify {friendly | malicious} rule-name` command.

If you ever want to delete all of the rogue classification rules or a specific rule, enter the `{config rogue rule delete {all | rule-name}command.

**Step 2**

Disable all rules or a specific rule by entering this command:

```
config rogue rule disable {all | rule_name}
```

**Note** A rule must be disabled before you can modify its attributes.

**Step 3**

Add conditions to a rule that the rogue access point must meet by entering this command:

```
config rogue rule condition ap set condition_type condition_value rule_name
```

The following condition types are available:

- `ssid`—Requires that the rogue access point have a specific SSID. You should add SSIDs that are not managed by the controller. If you choose this option, enter the SSID for the `condition_value` parameter. The SSID is added to the user-configured SSID list.

  **Note** If you ever want to delete all of the SSIDs or a specific SSID from the user-configured SSID list, enter the `config rogue rule condition ap delete ssid {all | ssid} rule_name` command.

  **Note** The sub-string should be specified in full or part of SSID (without any asterisks). This sub-string is matched in the same sequence to its occurrence in the rogue AP SSID. Once the condition is met, the rogue AP is classified (depending on OR or AND match condition).
• **rssi**—Requires that the rogue access point have a minimum RSSI value. For example, if the rogue access point has an RSSI that is greater than the configured value, then the access point could be classified as malicious. If you choose this option, enter the minimum RSSI value for the condition_value parameter.

In Release 8.0 and later releases, for friendly rogue rules, you are required to set a maximum RSSI value. The RSSI value of the rogue AP must be less than the RSSI value set, for the rogue AP to be classified as a friendly rogue. For malicious and custom rogue rules, there is no change in functionality.

For example, for a friendly rogue rule, the RSSI value is set at –80 dBm. All the rogue APs that are detected and have RSSI value that is less than –80 dBm are classified as friendly rogues. For malicious and custom rogue rules, the RSSI value is set at –80 dBm. All the rogue APs that are detected and have RSSI value that is more than –80 dBm are classified as malicious or custom rogue APs.

• **duration**—Requires that the rogue access point be detected for a minimum period of time. If you choose this option, enter a value for the minimum detection period for the condition_value parameter. The valid range is 0 to 3600 seconds (inclusive), and the default value is 0 seconds.

• **client-count**—Requires that a minimum number of clients be associated to the rogue access point. For example, if the number of clients associated to the rogue access point is greater than or equal to the configured value, then the access point could be classified as malicious. If you choose this option, enter the minimum number of clients to be associated to the rogue access point for the condition_value parameter. The valid range is 1 to 10 (inclusive), and the default value is 0.

• **managed-ssid**—Requires that the rogue access point’s SSID be known to the controller. A condition_value parameter is not required for this option.

**Note** You can add up to six conditions per rule. If you ever want to delete all of the conditions or a specific condition from a rule, enter the `config rogue rule condition ap delete all condition_type condition_value rule_name` command.

**Step 4** Specify whether a detected rogue access point must meet all or any of the conditions specified by the rule in order for the rule to be matched and the rogue access point to adopt the classification type of the rule by entering this command:

`config rogue rule match {all | any} rule_name`

**Step 5** Enable all rules or a specific rule by entering this command:

`config rogue rule enable {all | rule_name}`

**Note** For your changes to become effective, you must enable the rule.

**Step 6** Add a new friendly access point entry to the friendly MAC address list or delete an existing friendly access point entry from the list by entering this command:

`config rogue ap friendly {add | delete} ap_mac_address`

**Step 7** Save your changes by entering this command:

`save config`

**Step 8** View the rogue classification rules that are configured on the controller by entering this command:

`show rogue rule summary`

**Step 9** View detailed information for a specific rogue classification rule by entering this command:

`show rogue rule detailed rule_name`
Viewing and Classifying Rogue Devices (CLI)

- View a list of all rogue access points detected by the controller by entering this command:
  \`\`show rogue ap summary\`\`

- See a list of the friendly rogue access points detected by the controller by entering this command:
  \`\`show rogue ap friendly summary\`\`

- See a list of the malicious rogue access points detected by the controller by entering this command:
  \`\`show rogue ap malicious summary\`\`

- See a list of the unclassified rogue access points detected by the controller by entering this command:
  \`\`show rogue ap unclassified summary\`\`

- See detailed information for a specific rogue access point by entering this command:
  \`\`show rogue ap detailed ap_mac_address\`\`

- See the rogue report (which shows the number of rogue devices detected on different channel widths) for a specific 802.11a/n radio by entering this command:
  \`\`show ap auto-rf 802.11a Cisco_AP\`\`

- See a list of all rogue clients that are associated to a rogue access point by entering this command:
  \`\`show rogue ap clients ap_mac_address\`\`

- See a list of all rogue clients detected by the controller by entering this command:
  \`\`show rogue client summary\`\`

- See detailed information for a specific rogue client by entering this command:
  \`\`show rogue client detailed Rogue_AP client_mac_address\`\`

- See a list of all ad-hoc rogues detected by the controller by entering this command:
  \`\`show rogue adhoc summary\`\`

- See detailed information for a specific ad-hoc rogue by entering this command:
  \`\`show rogue adhoc detailed rogue_mac_address\`\`

- See a summary of ad hoc rogues based on their classification by entering this command:
  \`\`show rogue adhoc \{friendly | malicious | unclassified\} summary\`\`

- See a list of rogue access points that are configured to be ignore by entering this command:
  \`\`show rogue ignore-list\`\`

---

**Note**

See the **Viewing and Classifying Rogue Devices (GUI)** section for more information on the rogue-ignore access point list.

- Classify a rogue access point as friendly by entering this command:
  \`\`config rogue ap classify friendly state \{internal | external\} ap_mac_address\`\`

  where

  - **internal** means that the controller trusts this rogue access point.
  - **external** means that the controller acknowledges the presence of this rogue access point.
A rogue access point cannot be moved to the Friendly class if its current state is Contain.

- Mark a rogue access point as malicious by entering this command:
  ```
  config rogue ap classify malicious state {alert | contain} ap_mac_address
  ```
  where
  - `alert` means that the controller forwards an immediate alert to the system administrator for further action.
  - `contain` means that the controller contains the offending device so that its signals no longer interfere with authorized clients.

A rogue access point cannot be moved to the Malicious class if its current state is Contain.

- Mark a rogue access point as unclassified by entering this command:
  ```
  config rogue ap classify unclassified state {alert | contain} ap_mac_address
  ```

A rogue access point cannot be moved to the Unclassified class if its current state is Contain.

- Choose the maximum number of access points used to contain the ad-hoc rogue by entering this command:
  ```
  config rogue ap classify unclassified state contain rogue_ap_mac_address 1, 2, 3, or 4
  ```
  - 1—Specifies targeted rogue access point will be contained by one access point. This is the lowest containment level.
  - 2—Specifies targeted rogue access point will be contained by two access points.
  - 3—Specifies targeted rogue access point will be contained by three access points.
  - 4—Specifies targeted rogue access point will be contained by four access points. This is the highest containment level.

- Specify how the controller should respond to a rogue client by entering one of these commands:
  - `config rogue client alert client_mac_address`—The controller forwards an immediate alert to the system administrator for further action.
  - `config rogue client contain client_mac_address`—The controller contains the offending device so that its signals no longer interfere with authorized clients.

- Specify how the controller should respond to an ad-hoc rogue by entering one these commands:
  - `config rogue adhoc alert rogue_mac_address`—The controller forwards an immediate alert to the system administrator for further action.
  - `config rogue adhoc contain rogue_mac_address`—The controller contains the offending device so that its signals no longer interfere with authorized clients.
config rogue adhoc external rogue_mac_address—The controller acknowledges the presence of this ad-hoc rogue.

• Save your changes by entering this command:
  
save config

Configuring Cisco TrustSec SXP

Information About Cisco TrustSec SXP

Cisco TrustSec enables organizations to secure their networks and services through identity-based access control to anyone, anywhere, anytime. The solution also offers data integrity and confidentiality services, policy-based governance, and centralized monitoring, troubleshooting, and reporting services. TrustSec can be combined with personalized, professional service offerings to simplify solution deployment and management, and is a foundational security component to Cisco Borderless Networks.

The Cisco TrustSec security architecture builds secure networks by establishing domains of trusted network devices. Each device in the domain is authenticated by its peers. Communication on the links between devices in the domain is secured with a combination of encryption, message integrity check, and data-path replay protection mechanisms. Cisco TrustSec uses the device and user credentials acquired during authentication for classifying the packets by security groups (SGs) as they enter the network. This packet classification is maintained by tagging packets on ingress to the Cisco TrustSec network so that they can be correctly identified to apply security and other policy criteria along the data path. The tag, called the security group tag (SGT), allows the network to enforce the access control policy by enabling the endpoint device to act upon the SGT to filter traffic.

One of the components of Cisco TrustSec architecture is the security group-based access control. In the security group-based access control component, access policies in the Cisco TrustSec domain are topology-independent, based on the roles (as indicated by security group number) of source and destination devices rather than on network addresses. Individual packets are tagged with the security group number of the source.

Cisco devices use the SGT Exchange Protocol (SXP) to propagate SGTs across network devices that do not have hardware support for Cisco TrustSec. SXP is the software solution to avoid CTS hardware upgrade on all switches. WLC will be supporting SXP as part of TrustSec Architecture. The SXP sends SGT information to the CTS-enabled switches so that appropriate role-based access control lists (RBACLs) can be activated depending on the role information represented by the SGT. By default, the controller always works in the Speaker mode. To implement the SXP on a network, only the egress distribution switch needs to be CTS-enabled, and all the other switches can be non-CTS-capable switches.

The SXP runs between any access layer and distribution switch or between two distribution switches. The SXP uses TCP as the transport layer. CTS authentication is performed for any host (client) joining the network on the access layer switch similar to an access switch with CTS-enabled hardware. The access layer switch is not CTS hardware enabled. Therefore, data traffic is not encrypted or cryptographically authenticated when it passes through the access layer switch. The SXP is used to pass the IP address of the authenticated device, that is a wireless client, and the corresponding SGT up to the distribution switch. If the distribution switch is CTS hardware enabled, the switch inserts the SGT into the packet on behalf of the access layer switch. If the distribution switch is not CTS hardware enabled, the SXP on the distribution switch passes the IP-SGT mapping to all the distribution switches that have CTS hardware. On the egress side, the enforcement of the RBACL occurs at the egress L3 interface on the distribution switch.

The following are some guidelines for Cisco TrustSec SXP:
• SXP is supported on the following security policies only:
  ◦ WPA2-dot1x
  ◦ WPA-dot1x
  ◦ 802.1x (Dynamic WEP)
  ◦ MAC Filtering using RADIUS servers
  ◦ Web authentication using RADIUS servers for user authentication

• SXP is supported for both IPv4 and IPv6 clients.
• Controller always operates in the Speaker mode.

For more information about Cisco TrustSec, see

Restrictions for Cisco TrustSec SXP

• SXP is not supported on FlexConnect access points.
• SXP is supported only in centrally switched networks that have central authentication.
• By default, SXP is supported for APs that work in local mode only.
• The configuration of the default password should be consistent for both controller and the switch.
• Fault tolerance is not supported because fault tolerance requires local switching on APs.
• Static IP-SGT mapping for local authentication of users is not supported.
• IP-SGT mapping requires authentication with external ACS servers.
• In auto-anchor/guest-anchor mobility the SGT information passed by the RADIUS server to foreign
  WLC can be communicated to the anchor WLC through the EoIP/CAPWAP mobility tunnel. The anchor
  WLC can then build the SGT-IP mapping and communicate it to another peer via SXP.

Configuring Cisco TrustSec SXP (GUI)

Step 1  Choose Security > TrustSec SXP to open the SXP Configuration page. This page lists the following SXP configuration
details:

• Total SXP Connections—Number of SXP connections that are configured.
• SXP State—Status of SXP connections as either disabled or enabled.
• SXP Mode—SXP mode of the controller. The controller is always set to Speaker mode for SXP connections.
• Default Password—Password for MD5 authentication of SXP messages. We recommend that the password contain
  a minimum of 6 characters.
• **Default Source IP**—IP address of the management interface. SXP uses the default source IP address for all new TCP connections.

• **Retry Period**—SXP retry timer. The default value is 120 seconds (2 minutes). The valid range is 0 to 64000 seconds. The SXP retry period determines how often the controller retries for an SXP connection. When an SXP connection is not successfully set up, the controller makes a new attempt to set up the connection after the SXP retry period timer expires. Setting the SXP retry period to 0 seconds disables the timer and retries are not attempted.

This page also displays the following information about SXP connections:

• **Peer IP Address**—The IP address of the peer, that is the IP address of the next hop switch to which the controller is connected. There is no effect on the existing TCP connections when you configure a new peer connection.

• **Source IP Address**—The IP address of the source, that is the management IP address of the controller.

• **Connection Status**—Status of the SXP connection.

### Step 2
From the SXP State drop-down list, choose **Enabled** to enable Cisco TrustSec SXP.

### Step 3
Enter the default password that should be used to make an SXP connection. We recommend that the password contain a minimum of 6 characters.

### Step 4
In the **Retry Period** box, enter the time in seconds that determines how often the Cisco TrustSec software retries for an SXP connection.

### Step 5
Click **Apply**.

---

**Creating a New SXP Connection (GUI)**

### Step 1
Choose **SECURITY > TrustSec SXP** and click **New** to open the SXP Connection > New page.

### Step 2
In the **Peer IP Address** text box, enter the IP address of the next hop switch to which the controller is connected.

### Step 3
Click **Apply**.

---

**Configuring Cisco TrustSec SXP (CLI)**

• Enable or disable the SXP on the controller by entering this command:
  
  ```
  config cts xsp {enable | disable}
  ```

• Configure the default password for MD5 Authentication of SXP messages by entering this command:
  
  ```
  config cts xsp default password password
  ```

• Configure the IP address of the next hop switch with which the controller is connected by entering this command:
  
  ```
  config cts xsp connection peer ip-address
  ```

• Configure the interval between connection attempts by entering this command:
config cts sxp retry period time-in-seconds

- Remove an SXP connection by entering this command:
  config cts sxp connection delete ip-address

- See a summary of SXP configuration by entering this command:
  show cts sxp summary

Information similar to the following appears:

SXP State........................................ Enable
SXP Mode......................................... Speaker
Default Password................................. ****
Default Source IP................................ 209.165.200.224
Connection retry open period ................. 120

- See the list of SXP connections that are configured by entering this command:
  show cts sxp connections

Information similar to the following appears:

Total num of SXP Connections............... 1
SXP State........................................ Enable
Peer IP          Source IP      Connection Status
--------------- --------------- -----------------
 209.165.200.229 209.165.200.224  On

Configuring Cisco Intrusion Detection System

Information About Cisco Intrusion Detection System

The Cisco Intrusion Detection System/Intrusion Prevention System (CIDS/CIPS) instructs controllers to block certain clients from accessing the wireless network when attacks involving these clients are detected at Layer 3 through Layer 7. This system offers significant network protection by helping to detect, classify, and stop threats including worms, spyware/adware, network viruses, and application abuse. Two methods are available to detect potential attacks:

- IDS sensors
- IDS signatures

You can configure IDS sensors to detect various types of IP-level attacks in your network. When the sensors identify an attack, they can alert the controller to shun the offending client. When you add a new IDS sensor, you register the controller with that IDS sensor so that the controller can query the sensor to get the list of shunned clients.

Shunned Clients

When an IDS sensor detects a suspicious client, it alerts the controller to shun this client. The shun entry is distributed to all controllers within the same mobility group. If the client to be shunned is currently joined to
a controller in this mobility group, the anchor controller adds this client to the dynamic exclusion list, and the foreign controller removes the client. The next time that the client tries to connect to a controller, the anchor controller rejects the handoff and informs the foreign controller that the client is being excluded.

Additional Information

The Cisco wireless intrusion prevention system (wIPS) is also supported on the controller through Cisco Prime Infrastructure. See the Configuring wIPS section for more information.

Configuring IDS Sensors (GUI)

Step 1  Choose Security > Advanced > CIDS > Sensors to open the CIDS Sensors List page.

Note  If you want to delete an existing sensor, hover your cursor over the blue drop-down arrow for that sensor and choose Remove.

Step 2  Click New to add a new IDS sensor to the list. The CIDS Sensor Add page is displayed.

Step 3  From the Index drop-down list, choose a number (between 1 and 5) to determine the sequence in which the controller consults the IDS sensors. For example, if you choose 1, the controller consults this IDS sensor first. Cisco WLC supports up to five IDS sensors.

Step 4  In the Server Address text box, enter the IP address of your IDS server.

Step 5  In the Port text box, enter the number of the HTTPS port through which the controller has to communicate with the IDS sensor.

We recommend that you set this parameter to 443 because the sensor uses this value to communicate by default. The default value is 443 and the range is 1 to 65535.

Step 6  In the Username text box, enter the name that the controller uses to authenticate to the IDS sensor.

Note  This username must be configured on the IDS sensor and have at least a read-only privilege.

Step 7  In the Password and Confirm Password text boxes, enter the password that the controller uses to authenticate to the IDS sensor.

Step 8  In the Query Interval text box, enter the time (in seconds) for how often the controller should query the IDS server for IDS events.

The default is 60 seconds and the range is 10 to 3600 seconds.

Step 9  Check the State check box to register the controller with this IDS sensor or uncheck this check box to disable registration. The default value is disabled.

Step 10  Enter a 40-hexadecimal-character security key in the Fingerprint text box. This key is used to verify the validity of the sensor and is used to prevent security attacks.

Note  Make sure you include colons that appear between every two bytes within the key. For example, enter AA:BB:CC:DD.

Step 11  Click Apply. Your new IDS sensor appears in the list of sensors on the CIDS Sensors List page.

Step 12  Click Save Configuration.
**Viewing Shunned Clients (GUI)**

**Step 1** Choose **Security > Advanced > CIDS > Shunned Clients** to open the CIDS Shun List page. This page shows the IP address and MAC address of each shunned client, the length of time that the client’s data packets should be blocked by the controller as requested by the IDS sensor, and the IP address of the IDS sensor that discovered the client.

**Step 2** Click **Re-sync** to purge and reset the list as desired.

**Note** The controller does not take any action on shun entries when the corresponding timers have expired. The shun entry timers are maintained only for the display purpose. The shun entries are cleaned up whenever the controller polls the IPS server. If the CIDS IPS server is not reachable, the shun entries are not removed even if they are timed out on the controller. The shun entries are cleaned up only when the CIDS IPS server is operational again and the controller polls the CIDS IPS server.

---

**Configuring IDS Sensors (CLI)**

**Step 1** Add an IDS sensor by entering this command:

```plaintext
config wps cids-sensor add index ids_ip_address username password
```

The index parameter determines the sequence in which the controller consults the IDS sensors. The controller supports up to five IDS sensors. Enter a number (between 1 and 5) to determine the priority of this sensor. For example, if you enter 1, the controller consults this IDS sensor first.

**Note** The username must be configured on the IDS sensor and have at least a read-only privilege.

**Step 2** (Optional) Specify the number of the HTTPS port through which the controller is to communicate with the IDS sensor by entering this command:

```plaintext
config wps cids-sensor port index port
```

For the port-number parameter, you can enter a value between 1 and 65535. The default value is 443. This step is optional because we recommend that you use the default value of 443. The sensor uses this value to communicate by default.

**Step 3** Specify how often the controller should query the IDS server for IDS events by entering this command:

```plaintext
config wps cids-sensor interval index interval
```

For the interval parameter, you can enter a value between 10 and 3600 seconds. The default value is 60 seconds.

**Step 4** Enter a 40-hexadecimal-character security key used to verify the validity of the sensor by entering this command:

```plaintext
config wps cids-sensor fingerprint index sha1 fingerprint
```

You can get the value of the fingerprint by entering `show tls fingerprint` on the sensor’s console.

**Note** Make sure to include the colons that appear between every two bytes within the key (for example, AA:BB:CC:DD).

**Step 5** Enable or disable this controller’s registration with an IDS sensor by entering this command:

```plaintext
config wps cids-sensor {enable | disable} index
```

**Step 6** Enable or disable protection from DoS attacks by entering this command:

The default value is disabled.
A potential attacker can use specially crafted packets to mislead the IDS into treating a legitimate client as an attacker. It causes the controller to wrongly disconnect this legitimate client and launches a DoS attack. The auto-immune feature, when enabled, is designed to protect against such attacks. However, conversations using Cisco 792x phones might be interrupted intermittently when the auto-immune feature is enabled. If you experience frequent disruptions when using 792x phones, you might want to disable this feature.

**Step 7**
Save your settings by entering this command:
```
save config
```

**Step 8**
See the IDS sensor configuration by entering one of these commands:
- `show wps cids-sensor summary`
- `show wps cids-sensor detail index`

**Step 9**
The second command provides more information than the first.

**Step 10**
See the auto-immune configuration setting by entering this command:
```
show wps summary
```
Information similar to the following appears:

```
Auto-Immune
  Auto-Immune................................. Disabled

Client Exclusion Policy
  Excessive 802.11-association failures........... Enabled
  Excessive 802.11-authentication failures......... Enabled
  Excessive 802.1x-authentication................ Enabled
  IP-theft..................................... Enabled
  Excessive Web authentication failure.......... Enabled
Signature Policy
  Signature Processing.......................... Enabled
```

**Step 11**
Obtain debug information regarding IDS sensor configuration by entering this command:
```
debug wps cids enable
```
**Note** If you ever want to delete or change the configuration of a sensor, you must first disable it by entering the `config wps cids-sensor disable index` command. To delete the sensor, enter the `config wps cids-sensor delete index` command.

---

**Viewing Shunned Clients (CLI)**

**Step 1**
View the list of clients to be shunned by entering this command:
```
show wps shun-list
```

**Step 2**
Force the controller to synchronize with other controllers in the mobility group for the shun list by entering this command:
```
config wps shun-list re-sync
```
The controller does not take any action on shun entries when the corresponding timers have expired. The shun entry timers are maintained only for the display purpose. The shun entries are cleaned up whenever the controller polls the IPS server. If the CIDS IPS server is not reachable, the shun entries are not removed even if they are timed out on the controller. The shun entries are cleaned up only when the CIDS IPS server is operational again and the controller polls the CIDS IPS server.

### Configuring IDS Signatures

#### Information About IDS Signatures

You can configure IDS signatures, or bit-pattern matching rules used to identify various types of attacks in incoming 802.11 packets, on the controller. When the signatures are enabled, the access points joined to the controller perform signature analysis on the received 802.11 data or management frames and report any discrepancies to the controller. If an attack is detected, appropriate mitigation is initiated.

Cisco supports 17 standard signatures. These signatures are divided into six main groups. The first four groups contain management signatures, and the last two groups contain data signatures.

- **Broadcast deauthentication frame signatures**—During a broadcast deauthentication frame attack, a hacker sends an 802.11 deauthentication frame to the broadcast MAC destination address of another client. This attack causes the destination client to disassociate from the access point and lose its connection. If this action is repeated, the client experiences a denial of service. When the broadcast deauthentication frame signature (precedence 1) is used to detect such an attack, the access point listens for clients transmitting broadcast deauthentication frames that match the characteristics of the signature. If the access point detects such an attack, it alerts the controller. Depending on how your system is configured, the offending device is contained so that its signals no longer interfere with authorized clients, or the controller forwards an immediate alert to the system administrator for further action, or both.

- **NULL probe response signatures**—During a NULL probe response attack, a hacker sends a NULL probe response to a wireless client adapter. As a result, the client adapter locks up. When a NULL probe response signature is used to detect such an attack, the access point identifies the wireless client and alerts the controller. The NULL probe response signatures are as follows:
  
  - NULL probe resp 1 (precedence 2)
  - NULL probe resp 2 (precedence 3)

#### Note

Controller does not log historical NULL Probe IDS events within the Signature Events Summary output.

- **Management frame flood signatures**—During a management frame flood attack, a hacker floods an access point with 802.11 management frames. The result is a denial of service to all clients associated or attempting to associate to the access point. This attack can be implemented with different types of management frames: association requests, authentication requests, reassociation requests, probe requests, disassociation requests, deauthentication requests, and reserved management subtypes.
When a management frame flood signature is used to detect such an attack, the access point identifies management frames matching the entire characteristic of the signature. If the frequency of these frames is greater than the value of the frequency set in the signature, an access point that hears these frames triggers an alarm. The controller generates a trap and forwards it to Cisco Prime Infrastructure.

The management frame flood signatures are as follows:

- Assoc flood (precedence 4)
- Auth flood (precedence 5)
- Reassoc flood (precedence 6)
- Broadcast probe flood (precedence 7)
- Disassoc flood (precedence 8)
- Deauth flood (precedence 9)
- Reserved mgmt 7 (precedence 10)
- Reserved mgmt F (precedence 11)

The reserved management frame signatures 7 and F are reserved for future use.

- **Wellenreiter signature**—Wellenreiter is a wireless LAN scanning and discovery utility that can reveal access point and client information. When the Wellenreiter signature (precedence 17) is used to detect such an attack, the access point identifies the offending device and alerts the controller.

- **EAPOL flood signature**—During an EAPOL flood attack, a hacker floods the air with EAPOL frames that contain 802.1X authentication requests. As a result, the 802.1X authentication server cannot respond to all of the requests and fails to send successful authentication responses to valid clients. The result is a denial of service to all affected clients. When the EAPOL flood signature (precedence 12) is used to detect such an attack, the access point waits until the maximum number of allowed EAPOL packets is exceeded. It then alerts the controller and proceeds with the appropriate mitigation.

- **NetStumbler signatures**—NetStumbler is a wireless LAN scanning utility that reports access point broadcast information (such as operating channel, RSSI information, adapter manufacturer name, SSID, WEP status, and the latitude and longitude of the device running NetStumbler when a GPS is attached). If NetStumbler succeeds in authenticating and associating to an access point, it sends a data frame with the following strings, depending on the NetStumbler version:

<table>
<thead>
<tr>
<th>Version</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2.0</td>
<td>&quot;Flurble gronk bloopit, bnip Frundletrune&quot;</td>
</tr>
<tr>
<td>3.2.3</td>
<td>“All your 802.11b are belong to us”</td>
</tr>
<tr>
<td>3.3.0</td>
<td>Sends white spaces</td>
</tr>
</tbody>
</table>

When a NetStumbler signature is used to detect such an attack, the access point identifies the offending device and alerts the controller. The NetStumbler signatures are as follows:

- NetStumbler 3.2.0 (precedence 13)
- NetStumbler 3.2.3 (precedence 14)
A standard signature file exists on the controller by default. You can upload this signature file from the controller, or you can create a custom signature file and download it to the controller or modify the standard signature file to create a custom signature.

## Configuring IDS Signatures (GUI)

### Uploading or Downloading IDS Signatures

**Step 1** If desired, create your own custom signature file.

**Step 2** Make sure that you have a Trivial File Transfer Protocol (TFTP) server available. Follow these guidelines when setting up a TFTP server:

- If you are downloading through the service port, the TFTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.
- If you are downloading through the distribution system network port, the TFTP server can be on the same or a different subnet because the distribution system port is routable.
- A third-party TFTP server cannot run on the same computer as the Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP server and the third-party TFTP server require the same communication port.

**Step 3** If you are downloading a custom signature file (*.sig), copy it to the default directory on your TFTP server.

**Step 4** Choose Commands to open the Download File to Controller page.

**Step 5** Perform one of the following:

- If you want to download a custom signature file to the controller, choose Signature File from the File Type drop-down list on the Download File to Controller page.
- If you want to upload a standard signature file from the controller, choose Upload File and then Signature File from the File Type drop-down list on the Upload File from Controller page.

**Step 6** From the Transfer Mode drop-down list, choose TFTP, FTP, or SFTP. The SFTP option was added in Release 7.4.

**Step 7** In the IP Address text box, enter the IP address of the TFTP, FTP, or SFTP server.

**Step 8** If you are downloading the signature file using a TFTP server, enter the maximum number of times that the controller should attempt to download the signature file in the Maximum retries text box. The range is 1 to 254 and the default value is 10.

**Step 9** If you are downloading the signature file using a TFTP server, enter the amount of time in seconds before the controller times out while attempting to download the signature file in the Timeout text box. The range is 1 to 254 seconds and the default is 6 seconds.

**Step 10** In the File Path text box, enter the path of the signature file to be downloaded or uploaded. The default value is “/.”

**Step 11** In the File Name text box, enter the name of the signature file to be downloaded or uploaded.
When uploading signatures, the controller uses the filename that you specify as a base name and then adds 
"_std.sig" and "_custom.sig" to it in order to upload both standard and custom signature files to the TFTP server. 
For example, if you upload a signature file called "ids1," the controller automatically generates and uploads both 
ids1_std.sig and ids1_custom.sig to the TFTP server. If desired, you can then modify ids1_custom.sig on the 
TFTP server (making sure to set "Revision = custom") and download it by itself.

**Step 12**

If you are using an FTP or SFTP server, follow these steps:

1. In the Server Login Username text box, enter the username to log into the FTP or SFTP server.
2. In the Server Login Password text box, enter the password to log into the FTP or SFTP server.
3. In the Server Port Number text box, enter the port number on the FTP or SFTP server through which the download 
   occurs. The default value is 21.

**Step 13**

Choose Download to download the signature file to the controller or Upload to upload the signature file from the 
controller.

---

**Enabling or Disabling IDS Signatures**

**Step 1**

Choose Security > Wireless Protection Policies > Standard Signatures or Custom Signatures to open the Standard 
Signatures page or the Custom Signatures page. 
The Standard Signatures page shows the list of Cisco-supplied signatures that are currently on the controller. The Custom 
Signatures page shows the list of customer-supplied signatures that are currently on the controller. This page shows the 
following information for each signature:

- The order, or precedence, in which the controller performs the signature checks.
- The name of the signature, which specifies the type of attack that the signature is trying to detect.
- The frame type on which the signature is looking for a security attack. The possible frame types are data and 
  management.
- The action that the controller is directed to take when the signature detects an attack. The possible actions are None 
  and Report.
- The state of the signature, which indicates whether the signature is enabled to detect security attacks.
- A description of the type of attack that the signature is trying to detect.

**Step 2**

Perform one of the following:

- If you want to allow all signatures (both standard and custom) whose individual states are set to Enabled to remain 
  enabled, select the Enable Check for All Standard and Custom Signatures check box at the top of either the 
  Standard Signatures page or the Custom Signatures page. The default value is enabled (or selected). When the 
  signatures are enabled, the access points joined to the controller perform signature analysis on the received 802.11 
  data or management frames and report any discrepancies to the controller.
• If you want to disable all signatures (both standard and custom) on the controller, unselect the **Enable Check for All Standard and Custom Signatures** check box. If you unselected this check box, all signatures are disabled, even the ones whose individual states are set to Enabled.

**Step 3**
Click **Apply** to commit your changes.

**Step 4**
Click the precedence number of the desired signature to enable or disable an individual signature. The **Standard Signature (or Custom Signature) > Detail** page appears.
This page shows much of the same information as the Standard Signatures and Custom Signatures pages but provides these additional details:

• The tracking method used by the access points to perform signature analysis and report the results to the controller. The possible values are as follows:
  ◦ **Per Signature**—Signature analysis and pattern matching are tracked and reported on a per-signature and per-channel basis.
  ◦ **Per MAC**—Signature analysis and pattern matching are tracked and reported separately for individual client MAC addresses on a per-channel basis.
  ◦ **Per Signature and MAC**—Signature analysis and pattern matching are tracked and reported on a per-signature and per-channel basis as well as on a per-MAC-address and per-channel basis.

• The pattern that is being used to detect a security attack

**Step 5**
In the Measurement Interval text box, enter the number of seconds that must elapse before the signature frequency threshold is reached within the configured interval. The range is 1 to 3600 seconds, and the default value varies per signature.

**Step 6**
In the Signature Frequency text box, enter the number of matching packets per interval that must be identified at the individual access point level before an attack is detected. The range is 1 to 32,000 packets per interval, and the default value varies per signature.

**Step 7**
In the Signature MAC Frequency text box, enter the number of matching packets per interval that must be identified per client per access point before an attack is detected. The range is 1 to 32,000 packets per interval, and the default value varies per signature.

**Step 8**
In the Quiet Time text box, enter the length of time (in seconds) after which no attacks have been detected at the individual access point level and the alarm can stop. The range is 60 to 32,000 seconds, and the default value varies per signature.

**Step 9**
Select the **State** check box to enable this signature to detect security attacks or unselect it to disable this signature. The default value is enabled (or selected).

**Step 10**
Click **Apply** to commit your changes. The Standard Signatures or Custom Signatures page reflects the signature's updated state.

**Step 11**
Click **Save Configuration** to save your changes.
Viewing IDS Signature Events (GUI)

**Step 1** Choose Security > Wireless Protection Policies > Signature Events Summary to open the Signature Events Summary page.

**Step 2** Click the Signature Type for the signature to see more information on the attacks detected by a particular signature. The Signature Events Detail page appears. This page shows the following information:

- The MAC addresses of the clients identified as attackers
- The method used by the access point to track the attacks
- The number of matching packets per second that were identified before an attack was detected.
- The number of access points on the channel on which the attack was detected
- The day and time when the access point detected the attack

**Step 3** Click the Detail link for that attack to see more information for a particular attack. The Signature Events Track Detail page appears.

- The MAC address of the access point that detected the attack
- The name of the access point that detected the attack
- The type of radio (802.11a or 802.11b/g) used by the access point to detect the attack
- The radio channel on which the attack was detected
- The day and time when the access point reported the attack

Configuring IDS Signatures (CLI)

**Step 1** If desired, create your own custom signature file.

**Step 2** Make sure that you have a TFTP server available.

**Step 3** Copy the custom signature file (*.sig) to the default directory on your TFTP server.

**Step 4** Specify the download or upload mode by entering the `transfer {download | upload} mode tftp` command.

**Step 5** Specify the type of file to be downloaded or uploaded by entering the `transfer {download | upload} datatype signature` command.

**Step 6** Specify the IP address of the TFTP server by entering the `transfer {download | upload} serverip tftp-server-ip-address` command.

**Note** Some TFTP servers require only a forward slash (/) as the TFTP server IP address, and the TFTP server automatically determines the path to the correct directory.
Step 7 Specify the download or upload path by entering the `transfer {download | upload} path absolute-tftp-server-path-to-file` command.

Step 8 Specify the file to be downloaded or uploaded by entering the `transfer {download | upload} filename filename.sig` command.

**Note** When uploading signatures, the controller uses the filename you specify as a base name and then adds "_std.sig" and "_custom.sig" to it in order to upload both standard and custom signature files to the TFTP server. For example, if you upload a signature file called “ids1,” the controller automatically generates and uploads both ids1_std.sig and ids1_custom sig to the TFTP server. If desired, you can then modify ids1_custom.sig on the TFTP server (making sure to set "Revision = custom") and download it by itself.

Step 9 Enter the `transfer {download | upload} start` command and answer y to the prompt to confirm the current settings and start the download or upload.

Step 10 Specify the number of seconds that must elapse before the signature frequency threshold is reached within the configured interval by entering this command:

```
config wps signature interval signature_id interval
```

where signature_id is a number used to uniquely identify a signature. The range is 1 to 3600 seconds, and the default value varies per signature.

Step 11 Specify the number of matching packets per interval that must be identified at the individual access point level before an attack is detected by entering this command:

```
config wps signature frequency signature_id frequency
```

The range is 1 to 32,000 packets per interval, and the default value varies per signature.

Step 12 Specify the number of matching packets per interval that must be identified per client per access point before an attack is detected by entering this command:

```
config wps signature mac-frequency signature_id mac_frequency
```

The range is 1 to 32,000 packets per interval, and the default value varies per signature.

Step 13 Specify the length of time (in seconds) after which no attacks have been detected at the individual access point level and the alarm can stop by entering this command:

```
config wps signature quiet-time signature_id quiet_time
```

The range is 60 to 32,000 seconds, and the default value varies per signature.

Step 14 Perform one of the following:

- To enable or disable an individual IDS signature, enter this command:
  ```
  config wps signature {standard | custom} state signature_id {enable | disable}
  ```

- To enable or disable IDS signature processing, which enables or disables the processing of all IDS signatures, enter this command:
  ```
  config wps signature {enable | disable}
  ```

  **Note** If IDS signature processing is disabled, all signatures are disabled, regardless of the state configured for individual signatures.

Step 15 Save your changes by entering this command:
```
save config
```

Step 16 If desired, you can reset a specific signature or all signatures to default values. To do so, enter this command:
```
config wps signature reset {signature_id | all}
```

**Note** You can reset signatures to default values only through the controller CLI.
**Viewing IDS Signature Events (CLI)**

- See whether IDS signature processing is enabled or disabled on the controller by entering this command:

  `show wps summary`

  **Note**
  If IDS signature processing is disabled, all signatures are disabled, regardless of the state configured for individual signatures.

- See individual summaries of all of the standard and custom signatures installed on the controller by entering this command:

  `show wps signature summary`

- See the number of attacks detected by the enabled signatures by entering this command:

  `show wps signature events summary`

- See more information on the attacks detected by a particular standard or custom signature by entering this command:

  `show wps signature events {standard | custom} precedence# summary`

- See information on attacks that are tracked by access points on a per-signature and per-channel basis by entering this command:

  `show wps signature events {standard | custom} precedence# detailed per-signature source_mac`

- See information on attacks that are tracked by access points on an individual-client basis (by MAC address) by entering this command:

  `show wps signature events {standard | custom} precedence# detailed per-mac source_mac`

**Configuring wIPS**

**Information About wIPS**

The Cisco Adaptive Wireless Intrusion Prevention System (wIPS) uses an advanced approach to wireless threat detection and performance management. It combines network traffic analysis, network device and topology information, signature-based techniques, and anomaly detection to deliver highly accurate and complete wireless threat prevention. With a fully infrastructure-integrated solution, you can continually monitor wireless traffic on both the wired and wireless networks and use that network intelligence to analyze attacks from many sources to accurately pinpoint and proactively prevent attacks, rather than wait until damage or exposure has occurred.

Cisco Adaptive wIPS is a part of the Cisco 3300 Series Mobility Services Engine (MSE), which centralizes the processing of intelligence collected by the continuous monitoring of Cisco Aironet APs. With Cisco Adaptive wIPS functionalities and Cisco Prime Infrastructure integration into the Cisco MSE, the wIPS can configure and monitor wIPS policies and alarms and report threats.
If your wIPS deployment consists of a Cisco WLC, access point, and Cisco MSE, you must set all the three entities to the UTC time zone.

Cisco Adaptive wIPS is not configured on the Cisco WLC. Instead, the Cisco Prime Infrastructure forwards the profile configuration to the wIPS service, which forwards the profile to the Cisco WLC. The profile is stored in flash memory on the Cisco WLC and sent to APs when they join the Cisco WLC. When an access point disassociates and joins another Cisco WLC, it receives the wIPS profile from the new Cisco WLC.

Local-mode or FlexConnect mode APs with a subset of wIPS capabilities are referred to as Enhanced Local Mode access point or ELM AP. You can configure an access point to work in the wIPS mode if the AP is in any of the following modes:

- Monitor
- Local
- FlexConnect

The regular local mode or FlexConnect mode AP is extended with a subset of wIPS capabilities. This feature enables you to deploy your APs to provide protection without needing a separate overlay network.

wIPS ELM has the limited capability of detecting off-channel alarms. AN AP periodically goes off-channel, and monitors the nonserving channels for a short duration, and triggers alarms if any attack is detected on the channel. But off-channel alarm detection is best effort, and it takes a longer time to detect attacks and trigger alarms, which might cause the ELM AP to intermittently detect an alarm and clear it because it is not visible. APs in any of the above modes can periodically send alarms based on the policy profile to the wIPS service through the Cisco WLC. The wIPS service stores and processes the alarms and generates SNMP traps. Cisco Prime Infrastructure configures its IP address as a trap destination to receive SNMP traps from the Cisco MSE.

This table lists all the SNMP trap controls and their respective traps. When a trap control is enabled, all the traps of that trap control are also enabled.

The Cisco WLC uses only SNMPv2 for SNMP trap transmission.
### Table 17: SNMP Trap Controls and Their Respective Traps

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Trap Control</th>
<th>Trap</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Link (Port) Up/Down</td>
<td>linkUp, linkDown</td>
</tr>
<tr>
<td></td>
<td>Spanning Tree</td>
<td>newRoot, topologyChange,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>stpInstanceNewRootTrap,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>stpInstanceTopologyChangeTrap</td>
</tr>
<tr>
<td></td>
<td>Config Save</td>
<td>bsnDot11EssCreated,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>bsnDot11EssDeleted,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>bsnConfigSaved,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ciscoLwappScheduledResetNotif,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ciscoLwappClearResetNotif,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ciscoLwappResetFailedNotif,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ciscoLwapp SysInvalidXmlConfig</td>
</tr>
<tr>
<td>AP</td>
<td>AP Register</td>
<td>bsnAPDisassociated,</td>
</tr>
<tr>
<td></td>
<td>AP Interface Up/Down</td>
<td>bsnAPfUp, bsnAPfDown</td>
</tr>
<tr>
<td>Client Traps</td>
<td>802.11 Association</td>
<td>bsnDot11StationAssociate</td>
</tr>
<tr>
<td></td>
<td>802.11 Disassociation</td>
<td>bsnDot11StationDisassociate</td>
</tr>
<tr>
<td></td>
<td>802.11 Deauthentication</td>
<td>bsnDot11StationDeauthenticate</td>
</tr>
<tr>
<td></td>
<td>802.11 Failed Authentication</td>
<td>bsnDot11StationAuthenticateFail</td>
</tr>
<tr>
<td></td>
<td>802.11 Failed Association</td>
<td>bsnDot11StationAssociateFail</td>
</tr>
<tr>
<td></td>
<td>Exclusion</td>
<td>bsnDot11StationBlacklisted</td>
</tr>
<tr>
<td></td>
<td>NAC Alert</td>
<td>cldcClientWlanProfileName,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cldcClientIPAddress,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cldcClientIPAddress,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cldcClientQuarantineVLAN,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cldcClientAccessVLAN</td>
</tr>
<tr>
<td>Tab Name</td>
<td>Trap Control</td>
<td>Trap</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Security Traps</td>
<td>User Authentication</td>
<td>bsnTooManyUnsuccessLoginAttempts, cLWAGuestUserLoggedIn, cLWAGuestUserLoggedOut</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RADIUS Servers Not Responding</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WEP Decrypt Error</td>
</tr>
<tr>
<td>SNMP Authentication</td>
<td></td>
<td>agentSnmpAuthenticationTrapFlag</td>
</tr>
<tr>
<td>Multiple Users</td>
<td></td>
<td>multipleUsersTrap</td>
</tr>
<tr>
<td>Auto RF Profile</td>
<td>Load Profile</td>
<td>bsnAPLoadProfileFailed</td>
</tr>
<tr>
<td>Traps</td>
<td></td>
<td>bsnAPNoiseProfileFailed</td>
</tr>
<tr>
<td></td>
<td>Interference Profile</td>
<td>bsnAPInterferenceProfileFailed</td>
</tr>
<tr>
<td></td>
<td>Coverage Profile</td>
<td>bsnAPCoverageProfileFailed</td>
</tr>
<tr>
<td>Auto RF Update</td>
<td>Channel Update</td>
<td>bsnAPCurrentChannelChanged</td>
</tr>
<tr>
<td>Traps</td>
<td>Tx Power Update</td>
<td>bsnAPCurrentTxPowerChanged</td>
</tr>
<tr>
<td>Tab Name</td>
<td>Trap Control</td>
<td>Trap</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Mesh Traps</td>
<td>Child Excluded Parent</td>
<td>ciscoLwappMeshChildExcludedParent</td>
</tr>
<tr>
<td>Parent Change</td>
<td>ciscoLwappMeshParentChange</td>
<td></td>
</tr>
<tr>
<td>Authfailure Mesh</td>
<td>ciscoLwappMeshAuthorizationFailure</td>
<td></td>
</tr>
<tr>
<td>Child Moved</td>
<td>ciscoLwappMeshChildMoved</td>
<td></td>
</tr>
<tr>
<td>Excessive Parent Change</td>
<td>ciscoLwappMeshExcessiveParentChange</td>
<td></td>
</tr>
<tr>
<td>Excessive Children</td>
<td>ciscoLwappMeshExcessiveChildren</td>
<td></td>
</tr>
<tr>
<td>Poor SNR</td>
<td>ciscoLwappMeshAbateSNR, ciscoLwappMeshOnsetSNR</td>
<td></td>
</tr>
<tr>
<td>Console Login</td>
<td>ciscoLwappMeshConsoleLogin</td>
<td></td>
</tr>
<tr>
<td>Excessive Association</td>
<td>ciscoLwappMeshExcessiveAssociation</td>
<td></td>
</tr>
<tr>
<td>Default Bridge Group Name</td>
<td>ciscoLwappMeshDefaultBridgeGroupName</td>
<td></td>
</tr>
</tbody>
</table>

The following are the trap descriptions for the traps mentioned in the *SNMP Trap Controls and Their Respective Traps* table:

- **General Traps**
  - SNMP Authentication—The SNMPv2 entity has received a protocol message that is not properly authenticated.

  **Note**
  When a user who is configured in SNMP V3 mode tries to access the Cisco WLC with an incorrect password, the authentication fails and a failure message is displayed. However, no trap logs are generated for the authentication failure.

  - Link (Port) Up/Down—Link changes status from up or down.
  - Link (Port) Up/Down—Link changes status from up or down.
  - Multiple Users—Two users log in with the same ID.
  - Rogue AP—Whenever a rogue access point is detected, this trap is sent with its MAC address; when a rogue access point that was detected earlier no longer exists, this trap is sent.
  - Config Save—Notification that is sent when the Cisco WLC configuration is modified.

- **Cisco AP Traps**
  - AP Register—Notification sent when an access point associates or disassociates with the Cisco WLC.
• AP Interface Up/Down—Notification sent when an access point interface (802.11X) status goes up or down.

• Client-Related Traps
  • 802.11 Association—Associate notification that is sent when a client sends an association frame.
  • 802.11 Disassociation—Disassociate notification that is sent when a client sends a disassociation frame.
  • 802.11 Deauthentication—Deauthenticate notification that is sent when a client sends a deauthentication frame.
  • 802.11 Failed Authentication—Authenticate failure notification that is sent when a client sends an authentication frame with a status code other than successful.
  • 802.11 Failed Association—Associate failure notification that is sent when the client sends an association frame with a status code other than successful.
  • Exclusion—Associate failure notification that is sent when a client is exclusion listed (blacklisted).
  • Authentication—Authentication notification that is sent when a client is successfully authenticated.
  • Max Clients Limit Reached—Notification that is sent when the maximum number of clients, defined in the Threshold field, are associated with the Cisco WLC.
  • NAC Alert—Alert that is sent when a client joins an SNMP NAC-enabled WLAN.

This notification is generated when a client on NAC-enabled SSIDs completes Layer2 authentication to inform the NAC appliance about the client's presence. cldcClientWlanProfileName represents the profile name of the WLAN that the 802.11 wireless client is connected to, cldcClientIPAddress represents the unique IP address of the client. cldcApMacAddress represents the MAC address of the AP to which the client is associated. cldcClientQuarantineVLAN represents the quarantine VLAN for the client. cldcClientAccessVLAN represents the access VLAN for the client.

• Association with Stats—Associate notification that is sent with data statistics when a client is associated with the Cisco WLC, or roams. Data statistics include transmitted and received bytes and packets.

• Disassociation with Stats—Disassociate notification that is sent with data statistics when a client disassociates from the Cisco WLC. Data statistics include transmitted and received bytes and packets, SSID, and session ID.

• Security Traps
  • User Auth Failure—This trap informs that a client RADIUS Authentication failure has occurred.
  • RADIUS Server No Response—This trap is to indicate that no RADIUS servers are responding to authentication requests sent by the RADIUS client.
  • WEP Decrypt Error—Notification sent when the Cisco WLC detects a WEP decrypting error.
  • Rouge AP—Whenever a rogue access point is detected, this trap is sent with its MAC address; when a rogue access point that was detected earlier no longer exists, this trap is sent.
  • SNMP Authentication—The SNMPv2 entity has received a protocol message that is not properly authenticated.
When a user who is configured in SNMP V3 mode tries to access the Cisco WLC with an incorrect password, authentication fails and a failure message is displayed. However, no trap logs are generated for the authentication failure.

* Multiple Users—Two users log in with the same ID.

**SNMP Authentication**

* Load Profile—Notification sent when the Load Profile state changes between PASS and FAIL.
* Noise Profile—Notification sent when the Noise Profile state changes between PASS and FAIL.
* Interference Profile—Notification sent when the Interference Profile state changes between PASS and FAIL.
* Coverage Profile—Notification sent when the Coverage Profile state changes between PASS and FAIL.

**Auto RF Profile Traps**

* Load Profile—Notification sent when the Load Profile state changes between PASS and FAIL.
* Noise Profile—Notification sent when the Noise Profile state changes between PASS and FAIL.
* Interference Profile—Notification sent when the Interference Profile state changes between PASS and FAIL.
* Coverage Profile—Notification sent when the Coverage Profile state changes between PASS and FAIL.

**Auto RF Update Traps**

* Channel Update—Notification sent when the access point dynamic channel algorithm is updated.
* Tx Power Update—Notification sent when the access point dynamic transmit power algorithm is updated.

**Mesh Traps**

* Child Excluded Parent—Notification that is sent when a defined number of failed association to the Cisco WLC occurs through a parent mesh node.

Notification sent when a child mesh node exceeds the threshold limit of the number of discovery response timeouts. The child mesh node does not try to associate an excluded parent mesh node for the interval defined. The child mesh node remembers the excluded parent MAC address when it joins the network, and informs the Cisco WLC.

* Parent Change—Notification is sent by the agent when a child mesh node changes its parent. The child mesh node remembers previous parent and informs the Cisco WLC about the change of parent when it rejoins the network.

* Child Moved—Notification sent when a parent mesh node loses connection with its child mesh node.
• Excessive Parent Change—Notification sent when the child mesh node changes its parent frequently. Each mesh node keeps a count of the number of parent changes in a fixed time. If it exceeds the defined threshold, the child mesh node informs the Cisco WLC.

• Excessive Children—Notification sent when the child count exceeds for a RAP and a MAP.

• Poor SNR—Notification sent when the child mesh node detects a lower SNR on a backhaul link. For the other trap, a notification is sent to clear a notification when the child mesh node detects an SNR on a backhaul link that is higher than the object defined by 'clMeshSNRThresholdAbate'.

• Console Login—Notification is sent by the agent when a login on a MAP console is either successful or fail after three attempts.

• Default Bridge Group Name—Notification sent when the MAP mesh node joins its parent using the default bridge group name.

---

**Note**
The remaining traps do not have trap controls. These traps are not generated too frequently and do not require any trap control. Any other trap that is generated by the Cisco WLC cannot be turned off.

**Note**
In all of the above cases, the Cisco WLC functions solely as a forwarding device.

---

**Restrictions for wIPS**

- wIPS ELM is not supported on 702i, 702W, 1130 and 1240 access points.

- WIPS and Rogue Detection must be disabled on the AP in IPv6 mode to prevent it from leaking traffic outside CAPWAP towards 32.x.x.x destination.

---

**Configuring wIPS on an Access Point (GUI)**

**Step 1**
Choose Wireless > Access Points > All APs > access point name.

**Step 2**
Set the AP Mode parameter. To configure an access point for wIPS, you must choose one of the following modes from the AP Mode drop-down list:

- Local
- FlexConnect
• Monitor

Step 3  Choose wIPS from the AP Sub Mode drop-down list.
Step 4  Click Apply.
Step 5  Click Save Configuration.

Configuring wIPS on an Access Point (CLI)

Step 1  Configure an access point for the monitor mode by entering this command:
        `config ap mode {monitor | local | flexconnect} Cisco_AP`
        Note: To configure an access point for wIPS, the access point must be in monitor, local, or flexconnect modes.

Step 2  Enter Y when you see the message that the access point will be rebooted if you want to continue.
Step 3  Save your changes by entering this command:
        `save config`

Step 4  Disable the access point radio by entering this command:
        `config {802.11a | 802.11b} disable Cisco_AP`
Step 5  Configure the wIPS submode on the access point by entering this command:
        `config ap mode ap_mode submode wips Cisco_AP`
        Note: To disable wIPS on the access point, enter the `config ap mode ap_mode submode none Cisco_AP` command.

Step 6  Enable wIPS-optimized channel scanning for the access point by entering this command:
        `config ap monitor-mode wips-optimized Cisco_AP`
        The access point scans each channel for 250 milliseconds. It derives the list of channels to be scanned from the monitor configuration. You can choose one of these options:

        • All—All channels are supported by the access point's radio
        • Country—Only the channels supported by the access point's country of operation
        • DCA—Only the channel set used by the dynamic channel assignment (DCA) algorithm, which, by default, includes all of the nonoverlapping channels allowed in the access point’s country of operation

The 802.11a or 802.11b Monitor Channels information in the output of the `show advanced {802.11a | 802.11b} monitor` command shows the monitor configuration channel set:

Default 802.11b AP monitoring
802.11b Monitor Mode.......................... enable
802.11b Monitor Channels...................... Country channels
802.11b AP Coverage Interval.................. 180 seconds
802.11b AP Load Interval....................... 60 seconds
802.11b AP Noise Interval..................... 180 seconds
802.11b AP Signal Strength Interval.......... 60 seconds
Step 7  Reenable the access point radio by entering this command:
\[ \text{config} \{ \text{802.11a} | \text{802.11b} \} \text{ enable } \text{Cisco_AP} \]

Step 8  Save your changes by entering this command:
\[ \text{save config} \]

---

### Viewing wIPS Information (CLI)

You can also view the access point submode from the controller GUI. To do so, choose **Wireless > Access Points > All APs > access point name > the Advanced tab**. The **AP Sub Mode** field shows **wIPS** if the access point is in the monitor mode and the wIPS submode is configured on the access point, or **None** if the access point is not in the monitor mode or the access point is in the monitor mode, but the wIPS submode is not configured.

- See the wIPS submode in the access point by entering this command:
  \[ \text{show ap config general } \text{Cisco_AP} \]
- See the wIPS-optimized channel-scanning configuration in the access point by entering this command:
  \[ \text{show ap monitor-mode summary} \]
- See the wIPS configuration forwarded by Cisco Prime Infrastructure to the controller by entering this command:
  \[ \text{show wps wips summary} \]
- See the current state of the wIPS operation in the controller by entering this command:
  \[ \text{show wps wips statistics} \]
- Clear the wIPS statistics in the controller by entering this command:
  \[ \text{clear stats wps wips} \]

---

### Configuring Wi-Fi Direct Client Policy

#### Information About the Wi-Fi Direct Client Policy

Devices that are Wi-Fi Direct capable can connect directly to each other quickly and conveniently to do tasks such as printing, synchronization, and sharing of data. Wi-Fi Direct devices may associate with multiple peer-to-peer (P2P) devices and with infrastructure wireless LANs (WLANs) concurrently. You can use the controller to configure the Wi-Fi Direct Client Policy, on a per WLAN basis, where you can allow or disallow association of Wi-Fi devices with infrastructure WLANs, or disable Wi-Fi Direct Client Policy altogether for WLANs.
Restrictions for the Wi-Fi Direct Client Policy

- Wi-Fi Direct Client Policy is applicable to WLANs that have APs in local mode only.
- If WLAN applied client policy is invalid, the client is excluded with the exclusion reason being 'Client QoS Policy failure'.

Configuring the Wi-Fi Direct Client Policy (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the WLAN ID of the WLAN for which you want to configure the Wi-Fi Direct Client Policy. The WLANs > Edit page appears.
Step 3  Click the Advanced tab.
Step 4  From the Wi-Fi Direct Clients Policy drop-down list, choose one of the following options:
  - Disabled—Ignores the Wi-Fi Direct status of clients thereby allowing Wi-Fi Direct clients to associate
  - Allow—Allows Wi-Fi Direct clients to associate with the WLAN
  - Not-Allow—Disallows the Wi-Fi Direct clients from associating with the WLAN
Step 5  Click Apply.

Configuring the Wi-Fi Direct Client Policy (CLI)

Step 1  Configure the Wi-Fi Direct Client Policy on WLANs by entering this command:
```plaintext
config wlan wifidirect {allow | disable | not-allow} wlan-id
```
The syntax of the command is as follows:
  - allow—Allows Wi-Fi Direct clients to associate with the WLAN
  - disable—Disables the Wi-Fi Direct Client Policy for the WLAN and deauthenticates all Wi-Fi Direct clients
  - not-allow—Disallows the Wi-Fi Direct clients from associating with the WLAN
  - wlan-id—WLAN identifier
Step 2  Save your configuration by entering this command:
```plaintext
save config
```
Monitoring and Troubleshooting the Wi-Fi Direct Client Policy (CLI)

- Monitor and troubleshoot the Wi-Fi Direct Client Policy by entering these commands:
  - `show wlan wifidirect wlan-id`—Displays status of the Wi-Fi Direct Client Policy on the WLAN.
  - `show client wifiDirect-stats`—Displays the total number of clients associated and the number of clients rejected if the Wi-Fi Direct Client Policy is enabled.

Configuring Web Auth Proxy

Information About the Web Authentication Proxy

This feature enables clients that have manual web proxy enabled in the browser to facilitate authentication with the controller. If the user's browser is configured with manual proxy settings with a configured port number as 8080 or 3128 and if the client requests any URL, the controller responds with a web page prompting the user to change the Internet proxy settings to automatically detect the proxy settings so that the browser's manual proxy settings information does not get lost. After enabling this settings, the user can get access to the network through the web authentication policy. This functionality is given for port 8080 and 3128 because these are the most commonly used ports for the web proxy server.

Note: The web authentication proxy redirect ports are not blocked through CPU ACL. If a CPU ACL is configured to block the port 8080, 3128, and one random port as part of web authentication proxy configuration, those ports are not blocked because the webauth rules take higher precedence than the CPU ACL rules unless the client is in the webauth_req state.

A web browser has the following three types of Internet settings that you can configure:

- Auto detect
- System Proxy
- Manual

In a manual proxy server configuration, the browser uses the IP address of a proxy server and a port. If this configuration is enabled on the browser, the wireless client communicates with the IP address of the destination proxy server on the configured port. In a web authentication scenario, the controller does not listen to such proxy ports and the client is not able to establish a TCP connection with the controller. The user is unable to get any login page to authentication and get access to the network.

When a wireless client enters a web-authenticated WLAN, the client tries to access a URL. If a manual proxy configuration is configured on the client's browser, all the web traffic going out from the client will be destined to the proxy IP and port configured on the browser.

- A TCP connection is established between the client and the proxy server IP address that the controller proxies for.
The client processes the DHCP response and obtains a JavaScript file from the controller. The script disables all proxy configurations on the client for that session.

Note
For external clients, the controller sends the login page as is (with or without JavaScript).

Any requests that bypass the proxy configuration. The controller can then perform web-redirection, login, and authentication.

When the client goes out of the network, and then back into its own network, a DHCP refresh occurs and the client continues to use the old proxy configuration configured on the browser.

If the external DHCP server is used with webauth proxy, then DHCP option 252 must be configured on the DHCP server for that scope. The value of option 252 will have the format http://<virtual ip>/proxy.js. No extra configuration is needed for internal DHCP servers.

Note
When you configure FIPS mode with secure web authentication, we recommend that you use Mozilla Firefox as your browser.

Configuring the Web Authentication Proxy (GUI)

Step 1 Choose Controller > General
Step 2 From the WebAuth Proxy Redirection Mode drop-down list, choose Enabled or Disabled.
Step 3 In the WebAuth Proxy Redirection Port text box, enter the port number of the web auth proxy. This text box consists of the port numbers on which the controller listens to for web authentication proxy redirection. By default, the three ports 80, 8080, and 3128 are assumed. If you configured the web authentication redirection port to any port other than these values, you must specify that value.
Step 4 Click Apply.

Configuring the Web Authentication Proxy (CLI)

- Enable web authentication proxy redirection by entering this command:
  `config network web-auth proxy-redirect {enable | disable}`

- Configure the secure web (HTTPS) authentication for clients by entering this command:
  `config network web-auth secureweb {enable | disable}`
  The default secure web (HTTPS) authentication for clients is enabled.

Note
If you configure to disallow secure web (HTTPS) authentication for clients using the `config network web-auth secureweb disable` command, then you must reboot the Cisco WLC to implement the change.
Set the web authentication port number by entering this command:

```
config network web-auth port port-number
```

This parameter specifies the port numbers on which the controller listens to for web authentication proxy redirection. By default, the three ports 80, 8080, and 3128 are assumed. If you configured the web authentication redirection port to any port other than these values, you must specify that value.

Configure secure redirection (HTTPS) for web authentication clients by entering this command:

```
config network web-auth https-redirect {enable | disable}
```

See the current status of the web authentication proxy configuration by entering one of the following commands:

- `show network summary`
- `show running-config`

### Detecting Active Exploits

The controller supports three active exploit alarms that serve as notifications of potential threats. They are enabled by default and therefore require no configuration on the controller.

- **ASLEAP detection**—The controller raises a trap event if an attacker launches a LEAP crack tool. The trap message is visible in the controller’s trap log.

- **Fake access point detection**—The controller tweaks the fake access point detection logic to avoid false access point alarms in high-density access point environments.

- **Honeypot access point detection**—The controller raises a trap event if a rogue access point is using managed SSIDs (WLANs configured on the controller). The trap message is visible in the controller’s trap log.
CHAPTER 7

WLANs

- Information About WLANs, page 320
- Guidelines and Limitations, page 320
- Creating WLANs, page 320
- Searching WLANs (GUI), page 323
- Setting the Client Count per WLAN, page 324
- Configuring DHCP, page 326
- Configuring DHCP Scopes, page 330
- Configuring MAC Filtering for WLANs, page 332
- Configuring Local MAC Filters, page 333
- Information About Configuring a Timeout for Disabled Clients, page 334
- Assigning WLANs to Interfaces, page 334
- Configuring the DTIM Period, page 335
- Configuring Peer-to-Peer Blocking, page 337
- Configuring Layer 2 Security, page 339
- Configuring a WLAN for Both Static and Dynamic WEP, page 346
- Configuring Sticky PMKID Caching, page 349
- Configuring CKIP, page 351
- Configuring a Session Timeout, page 353
- Configuring Layer 3 Security Using VPN Passthrough, page 355
- Configuring Layer 3 Security Using Web Authentication, page 356
- Configuring Captive Bypassing, page 358
- Configuring a Fallback Policy with MAC Filtering and Web Authentication, page 359
- Assigning a QoS Profile to a WLAN, page 360
- Configuring QoS Enhanced BSS, page 364
Information About WLANs

This feature enables you to control up to WLANs for lightweight access points. Each WLAN has a separate WLAN ID, a separate profile name, and a WLAN SSID. All controllers publish up to 16 WLANs to each connected access point, but you can create up to the maximum number of WLANs supported and then selectively publish these WLANs (using access point groups) to different access points to better manage your wireless network.

You can configure WLANs with different SSIDs or with the same SSID. An SSID identifies the specific wireless network that you want the controller to access.

Guidelines and Limitations

Creating WLANs

Creating and Removing WLANs (GUI)

Step 1

Choose WLANs to open the WLANs page.

This page lists all of the WLANs currently configured on the controller. For each WLAN, you can see its WLAN ID, profile name, type, SSID, status, and security policies.
The total number of WLANs appears in the upper right-hand corner of the page. If the list of WLANs spans multiple pages, you can access these pages by clicking the page number links.

**Note** If you want to delete a WLAN, hover your cursor over the blue drop-down arrow for that WLAN and choose **Remove**, or select the check box to the left of the WLAN, choose **Remove Selected** from the drop-down list, and click **Go**. A message appears asking you to confirm your decision. If you proceed, the WLAN is removed from any access point group to which it is assigned and from the access point’s radio.

**Step 2** Create a new WLAN by choosing **Create New** from the drop-down list and clicking **Go**. The **WLANs > New** page appears.

**Note** When you upgrade to controller software release 5.2 or later releases, the controller creates the default-group access point group and automatically populates it with the first 16 WLANs (WLANs with IDs 1 through 16, or fewer if 16 WLANs are not configured). This default group cannot be modified (you cannot add WLANs to it nor delete WLANs from it). It is dynamically updated whenever the first 16 WLANs are added or deleted. If an access point does not belong to an access point group, it is assigned to the default group and uses the WLANs in that group. If an access point joins the controller with an undefined access point group name, the access point keeps its group name but uses the WLANs in the default-group access point group.

**Step 3** From the **Type** drop-down list, choose **WLAN** to create a WLAN.

**Note** If you want to create a guest LAN for wired guest users, choose **Guest LAN**.

**Step 4** In the **Profile Name** text box, enter up to 32 characters for the profile name to be assigned to this WLAN. The profile name must be unique.

**Step 5** In the **WLAN SSID** text box, enter up to 32 characters for the SSID to be assigned to this WLAN.

**Step 6** From the **WLAN ID** drop-down list, choose the ID number for this WLAN.

**Note** If the Cisco OEAP 600 is in the default group, the WLAN/Remote LAN IDs need to be set as lower than ID 8.

**Step 7** Click **Apply** to commit your changes. The **WLANs > Edit** page appears.

**Note** You can also open the **WLANs > Edit** page from the **WLANs** page by clicking the ID number of the WLAN that you want to edit.

**Step 8** Use the parameters on the General, Security, QoS, and Advanced tabs to configure this WLAN. See the sections in the rest of this chapter for instructions on configuring specific features for WLANs.

**Step 9** On the General tab, select the **Status** check box to enable this WLAN. Be sure to leave it unselected until you have finished making configuration changes to the WLAN.

**Step 10** Click **Apply** to commit your changes.

**Step 11** Click **Save Configuration** to save your changes.

---

**Enabling and Disabling WLANs (GUI)**

**Step 1** Choose **WLANs** to open the WLANs page. This page lists all of the WLANs currently configured on the controller.
Step 2 Enable or disable WLANs from the WLANs page by selecting the check boxes to the left of the WLANs that you want to enable or disable, choosing Enable Selected or Disable Selected from the drop-down list, and clicking Go.

Step 3 Click Apply.

Creating and Deleting WLANs (CLI)

- Create a new WLAN by entering this command:

  ```plaintext
  config wlan create wlan_id {profile_name | foreign_ap} ssid
  ```

  Note If you do not specify an ssid, the profile_name parameter is used for both the profile name and the SSID.

  Note When WLAN 1 is created in the configuration wizard, it is created in enabled mode. Disable it until you have finished configuring it. When you create a new WLAN using the config wlan create command, it is created in disabled mode. Leave it disabled until you have finished configuring it.

- Delete a WLAN by entering this command:

  ```plaintext
  config wlan delete {wlan_id | foreign_ap}
  ```

  Note An error message appears if you try to delete a WLAN that is assigned to an access point group. If you proceed, the WLAN is removed from the access point group and from the access point’s radio.

- View the WLANs configured on the controller by entering this command:

  ```plaintext
  show wlan summary
  ```

Enabling and Disabling WLANs (CLI)

- Enable a WLAN (for example, after you have finished making configuration changes to the WLAN) by entering this command:

  ```plaintext
  config wlan enable {wlan_id | foreign_ap | all}
  ```

  Note If the command fails, an error message appears (for example, “Request failed for wlan 10 - Static WEP key size does not match 802.1X WEP key size”).
• Disable a WLAN (for example, before making any modifications to a WLAN) by entering this command:
  
  ```
  config wlan disable {wlan_id | foreign_ap | all}
  ```

  where

  - `wlan_id` is a WLAN ID between 1 and 512.
  - `foreign_ap` is a third-party access point.
  - `all` is all WLANs.

  **Note**
  
  If the management and AP-manager interfaces are mapped to the same port and are members of the same VLAN, you must disable the WLAN before making a port-mapping change to either interface. If the management and AP-manager interfaces are assigned to different VLANs, you do not need to disable the WLAN.

  **Note**
  
  If the WLAN is disabled, the VLAN acls corresponding to the WLAN-VLAN mapping at the AP is pushed to the AP and has precedence over the group mappings. Before WLAN is disabled there should be 16 sub interface created for vlan-acl mapping and 3 ap specific WLAN-VLAN mapping and 3 more sub interface should be created for group specific WLAN-VLAN mapping, as of now out of 16 vlan-acl mapping only 14 are pushed. After disabling all the WLAN only vlan-acl sub interface should be pushed and other sub interface should be deleted from the AP.

**Viewing WLANs (CLI)**

• View the list of existing WLANs and to see whether they are enabled or disabled by entering this command:

  ```
  show wlan summary
  ```

**Searching WLANs (GUI)**

**Step 1**

On the WLANs page, click **Change Filter**. The Search WLANs dialog box appears.

**Step 2**

Perform one of the following:

- To search for WLANs based on profile name, select the **Profile Name** check box and enter the desired profile name in the edit box.

- To search for WLANs based on SSID, select the **SSID** check box and enter the desired SSID in the edit box.

- To search for WLANs based on their status, select the **Status** check box and choose **Enabled** or **Disabled** from the drop-down list.
Step 3
Click Find. Only the WLANs that match your search criteria appear on the WLANs page, and the Current Filter field at the top of the page specifies the search criteria used to generate the list (for example, None, Profile Name: user1, SSID: test1, Status: disabled).

Note: To clear any configured search criteria and display the entire list of WLANs, click Clear Filter.

Setting the Client Count per WLAN

Information About Setting the Client Count per WLAN

You can set a limit to the number of clients that can connect to a WLAN, which is useful in scenarios where you have a limited number of clients that can connect to a controller. For example, consider a scenario where the controller can serve up to 256 clients on a WLAN and these clients can be shared between enterprise users (employees) and guest users. You can set a limit on the number of guest clients that can access a given WLAN. The number of clients that you can configure for each WLAN depends on the platform that you are using.

Guidelines and Limitations

• The maximum number of clients for each WLAN feature is not supported when you use FlexConnect local authentication.

• The maximum number of clients for each WLAN feature is supported only for access points that are in connected mode.

• When a WLAN has reached the limit on the maximum number of clients connected to it or an AP radio and a new client tries to join the WLAN, the client cannot connect to the WLAN until an existing client gets disconnected.

• Roaming clients are considered as new clients. The new client can connect to a WLAN, which has reached the maximum limit on the number of connected clients, only when an existing client gets disconnected.

For more information about the number of clients that are supported, see the product data sheet of your controller.
Configuring the Client Count per WLAN (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the WLAN for which you want to limit the number of clients. The WLANs > Edit page appears.
Step 3  Click the Advanced tab.
Step 4  In the Maximum Allowed Clients text box, enter the maximum number of clients that are to be allowed.
Step 5  Click Apply.
Step 6  Click Save Configuration.

Configuring the Maximum Number of Clients per WLAN (CLI)

Step 1  Determine the WLAN ID for which you want to configure the maximum clients by entering this command: show wlan summary
        Get the WLAN ID from the list.
Step 2  Configure the maximum number of clients for each WLAN by entering this command: config wlan max-associated-clients max-clients wlan-id

Configuring the Maximum Number of Clients for each AP Radio per WLAN (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the WLAN for which you want to limit the number of clients. The WLANs > Edit page appears.
Step 3  In the Advanced tab, enter the maximum allowed clients for each access point radio in the Maximum Allowed Clients Per AP Radio text box. You can configure up to 200 clients.
Step 4  Click Apply.
Configuring the Maximum Number of Clients for each AP Radio per WLAN (CLI)

Step 1  Determine the WLAN ID for which you want to configure the maximum clients for each radio by entering this command:
show wlan summary
Obtain the WLAN ID from the list.

Step 2  Configure the maximum number of clients for each WLAN by entering this command:
config wlan max-radio-clients client_count
You can configure up to 200 clients.

Step 3  See the configured maximum associated clients by entering the show 802.11a command.

Configuring DHCP

Information About the Dynamic Host Configuration Protocol

You can configure WLANs to use the same or different Dynamic Host Configuration Protocol (DHCP) servers or no DHCP server. Two types of DHCP servers are available: internal and external.

Internal DHCP Servers

The controllers contain an internal DHCP server. This server is typically used in branch offices that do not already have a DHCP server. The wireless network generally contains a maximum of 10 access points or fewer, with the access points on the same IP subnet as the controller. The internal server provides DHCP addresses to wireless clients, direct-connect access points, and DHCP requests that are relayed from access points. Only lightweight access points are supported. When you want to use the internal DHCP server, you must set the management interface IP address of the controller as the DHCP server IP address.

DHCP option 43 is not supported on the internal server. Therefore, the access point must use an alternative method to locate the management interface IP address of the controller, such as local subnet broadcast, Domain Name System (DNS), or priming.

An internal DHCP server pool only serves the wireless clients of that controller, not clients of other controllers. Also, an internal DHCP server can serve only wireless clients, not wired clients.

When clients use the internal DHCP server of the controller, IP addresses are not preserved across reboots. As a result, multiple clients can be assigned with the same IP address. To resolve any IP address conflicts, clients must release their existing IP address and request a new one. Wired guest clients are always on a Layer 2 network connected to a local or foreign controller.
DHCPv6 is not supported in the internal DHCP servers.

External DHCP Servers

The operating system is designed to appear as a DHCP Relay to the network and as a DHCP server to clients with industry-standard external DHCP servers that support DHCP Relay, which means that each controller appears as a DHCP Relay agent to the DHCP server and as a DHCP server at the virtual IP address to wireless clients.

Because the controller captures the client IP address that is obtained from a DHCP server, it maintains the same IP address for that client during intra controller, inter controller, and inter-subnet client roaming.

Note External DHCP servers can support DHCPv6.

DHCP Assignments

You can configure DHCP on a per-interface or per-WLAN basis. We recommend that you use the primary DHCP server address that is assigned to a particular interface.

You can assign DHCP servers for individual interfaces. You can configure the management interface, AP-manager interface, and dynamic interface for a primary and secondary DHCP server, and you can configure the service-port interface to enable or disable DHCP servers. You can also define a DHCP server on a WLAN. In this case, the server overrides the DHCP server address on the interface assigned to the WLAN.

Security Considerations

For enhanced security, we recommend that you require all clients to obtain their IP addresses from a DHCP server. To enforce this requirement, you can configure all WLANs with a DHCP Addr. Assignment Required setting, which disallows client static IP addresses. If DHCP Addr. Assignment Required is selected, clients must obtain an IP address via DHCP. Any client with a static IP address is not allowed on the network. The controller monitors DHCP traffic because it acts as a DHCP proxy for the clients.

Note WLANs that support management over wireless must allow management (device-servicing) clients to obtain an IP address from a DHCP server.

If slightly less security is tolerable, you can create WLANs with DHCP Addr. Assignment Required disabled. Clients then have the option of using a static IP address or obtaining an IP address from a designated DHCP server.

Note DHCP Addr. Assignment Required is not supported for wired guest LANs.

You can create separate WLANs with DHCP Addr. Assignment Required configured as disabled. This is applicable only if DHCP proxy is enabled for the controller. You must not define the primary/secondary
configuration DHCP server you should disable the DHCP proxy. These WLANs drop all DHCP requests and force clients to use a static IP address. These WLANs do not support management over wireless connections.

**Restrictions for Internal DHCP Servers**

- The controller internal DHCP server does not support Cisco Aironet 600 Series OfficeExtend Access Point.
- Internal DHCP servers are not supported in Cisco Flex 7500 Series Controllers. As a workaround, you can use External DHCP servers.

**Configuring DHCP (GUI)**

To configure a primary DHCP server for a management, AP-manager, or dynamic interface, see the Configuring Ports and Interfaces chapter.

When you want to use the internal DHCP server, you must set the management interface IP address of the controller as the DHCP server IP address.

**Step 1**
Choose WLANs to open the WLANs page.

**Step 2**
Click the ID number of the WLAN for which you want to assign an interface. The WLANs > Edit (General) page appears.

**Step 3**
On the General tab, unselect the Status check box and click Apply to disable the WLAN.

**Step 4**
Reclick the ID number of the WLAN.

**Step 5**
On the General tab, choose the interface for which you configured a primary DHCP server to be used with this WLAN from the Interface drop-down list.

**Step 6**
Choose the Advanced tab to open the WLANs > Edit (Advanced) page.

**Step 7**
If you want to define a DHCP server on the WLAN that will override the DHCP server address on the interface assigned to the WLAN, select the DHCP Server Override check box and enter the IP address of the desired DHCP server in the DHCP Server IP Addr text box. The default value for the check box is disabled.

**Note**
The preferred method for configuring DHCP is to use the primary DHCP address assigned to a particular interface instead of the DHCP server override.

**Note**
DHCP Server override is applicable only for the default group.

**Note**
If a WLAN has the DHCP server override option enabled and the controller has DHCP proxy enabled, any interface mapped to the WLAN must have a DHCP server IP address or the WLAN must be configured with a DHCP server IP address.

**Step 8**
If you want to require all clients to obtain their IP addresses from a DHCP server, select the DHCP Addr. Assignment Required check box. When this feature is enabled, any client with a static IP address is not allowed on the network. The default value is disabled.

**Note**
DHCP Addr. Assignment Required is not supported for wired guest LANs.

**Note**
PMIPv6 supports only DHCP based clients and Static IP address is not supported.
Step 9  Click Apply.
Step 10 On the General tab, select the Status check box and click Apply to reenable the WLAN.
Step 11 Click Save Configuration.

Configuring DHCP (CLI)

Step 1 Disable the WLAN by entering this command:
   `config wlan disable wlan-id`

Step 2 Specify the interface for which you configured a primary DHCP server to be used with this WLAN by entering this command:
   `config wlan interface wlan-id interface_name`

Step 3 If you want to define a DHCP server on the WLAN that will override the DHCP server address on the interface assigned to the WLAN, enter this command:
   `config wlan dhcp_server wlan-id dhcp_server_ip_address`
   **Note** The preferred method for configuring DHCP is to use the primary DHCP address assigned to a particular interface instead of the DHCP server override. If you enable the override, you can use the `show wlan` command to verify that the DHCP server has been assigned to the WLAN.
   **Note** If a WLAN has the DHCP server override option enabled and the controller has DHCP proxy enabled, any interface mapped to the WLAN must have a DHCP server IP address or the WLAN must be configured with a DHCP server IP address.
   **Note** PMIPv6 supports only DHCP based clients and Static IP address is not supported.

Step 4 Reenable the WLAN by entering this command:
   `config wlan enable wlan-id`

Debugging DHCP (CLI)

Use these commands to debug DHCP:

- `debug dhcp packet {enable | disable}` — Enables or disables debugging of DHCP packets.
- `debug dhcp message {enable | disable}` — Enables or disables debugging of DHCP error messages.
- `debug dhcp service-port {enable | disable}` — Enables or disables debugging of DHCP packets on the service port.
Configuring DHCP Scopes

Information About DHCP Scopes

Controllers have built-in DHCP relay agents. However, when you desire network segments that do not have a separate DHCP server, the controllers can have built-in DHCP scopes that assign IP addresses and subnet masks to wireless clients. Typically, one controller can have one or more DHCP scopes that each provide a range of IP addresses.

DHCP scopes are needed for internal DHCP to work. Once DHCP is defined on the controller, you can then point the primary DHCP server IP address on the management, AP-manager, and dynamic interfaces to the controller’s management interface.

Guidelines and Limitations

You can configure up to 16 DHCP scopes.

Configuring DHCP Scopes (GUI)

Step 1
Choose Controller > Internal DHCP Server > DHCP Scope to open the DHCP Scopes page. This page lists any DHCP scopes that have already been configured.

Note If you ever want to delete an existing DHCP scope, hover your cursor over the blue drop-down arrow for that scope and choose Remove.

Step 2
Click New to add a new DHCP scope. The DHCP Scope > New page appears.

Step 3
In the Scope Name text box, enter a name for the new DHCP scope.

Step 4
Click Apply. When the DHCP Scopes page reappears, click the name of the new scope. The DHCP Scope > Edit page appears.

Step 5
In the Pool Start Address text box, enter the starting IP address in the range assigned to the clients.

Note This pool must be unique for each DHCP scope and must not include the static IP addresses of routers or other servers.

Step 6
In the Pool End Address text box, enter the ending IP address in the range assigned to the clients.

Note This pool must be unique for each DHCP scope and must not include the static IP addresses of routers or other servers.
Step 7  In the Network text box, enter the network served by this DHCP scope. This IP address is used by the management interface with Netmask applied, as configured on the Interfaces page.

Step 8  In the Netmask text box, enter the subnet mask assigned to all wireless clients.

Step 9  In the Lease Time text box, enter the amount of time (from 0 to 65536 seconds) that an IP address is granted to a client.

Step 10 In the Default Routers text box, enter the IP address of the optional router connecting the controllers. Each router must include a DHCP forwarding agent, which allows a single controller to serve the clients of multiple controllers.

Step 11 In the DNS Domain Name text box, enter the optional domain name system (DNS) domain name of this DHCP scope for use with one or more DNS servers.

Step 12 In the DNS Servers text box, enter the IP address of the optional DNS server. Each DNS server must be able to update a client’s DNS entry to match the IP address assigned by this DHCP scope.

Step 13 In the Netbios Name Servers text box, enter the IP address of the optional Microsoft Network Basic Input Output System (NetBIOS) name server, such as the Internet Naming Service (WINS) server.

Step 14 From the Status drop-down list, choose Enabled to enable this DHCP scope or choose Disabled to disable it.

Step 15  Save the configuration.

Step 16  Choose DHCP Allocated Leases to see the remaining lease time for wireless clients. The DHCP Allocated Lease page appears, showing the MAC address, IP address, and remaining lease time for the wireless clients.

---

**Configuring DHCP Scopes (CLI)**

**Step 1** Create a new DHCP scope by entering this command:
```
config dhcp create-scope scope
```

**Note** If you ever want to delete a DHCP scope, enter this command: `config dhcp delete-scope scope`.

**Step 2** Specify the starting and ending IP address in the range assigned to the clients by entering this command:
```
config dhcp address-pool scope start end
```

**Note** This pool must be unique for each DHCP scope and must not include the static IP addresses of routers or other servers.

**Step 3** Specify the network served by this DHCP scope (the IP address used by the management interface with the Netmask applied) and the subnet mask assigned to all wireless clients by entering this command:
```
config dhcp network scope network netmask
```

**Step 4** Specify the amount of time (from 0 to 65536 seconds) that an IP address is granted to a client by entering this command:
```
config dhcp lease scope lease_duration
```

**Step 5** Specify the IP address of the optional router connecting the controllers by entering this command:
```
config dhcp default-router scope router_1 [router_2] [router_3]
```

Each router must include a DHCP forwarding agent, which allows a single controller to serve the clients of multiple controllers.

**Step 6** Specify the optional domain name system (DNS) domain name of this DHCP scope for use with one or more DNS servers by entering this command:
config dhcp domain scope domain

Step 7 Specify the IP address of the optional DNS server(s) by entering this command:
config dhcp dns-servers scope dns1 [dns2] [dns3]

Each DNS server must be able to update a client’s DNS entry to match the IP address assigned by this DHCP scope.

Step 8 Specify the IP address of the optional Microsoft Network Basic Input Output System (NetBIOS) name server, such as the Internet Naming Service (WINS) server by entering this command:
config dhcp netbios-name-server scope wins1 [wins2] [wins3]

Step 9 Enable or disable this DHCP scope by entering this command:
config dhcp {enable | disable} scope

Step 10 Save your changes by entering this command:
save config

Step 11 See the list of configured DHCP scopes by entering this command:
show dhcp summary

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Scope Name</th>
<th>Enabled</th>
<th>Address Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope 1</td>
<td>No</td>
<td>0.0.0.0 -&gt; 0.0.0.0</td>
</tr>
<tr>
<td>Scope 2</td>
<td>No</td>
<td>0.0.0.0 -&gt; 0.0.0.0</td>
</tr>
</tbody>
</table>

Step 12 Display the DHCP information for a particular scope by entering this command:
show dhcp scope

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Enabled.................................</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lease Time............................</td>
<td>0</td>
</tr>
<tr>
<td>Pool Start................................</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Pool End.................................</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Network...............................</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Netmask..................................</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Default Routers........................</td>
<td>0.0.0.0 0.0.0.0 0.0.0.0</td>
</tr>
<tr>
<td>DNS Domain................................</td>
<td></td>
</tr>
<tr>
<td>DNS.....................................</td>
<td>0.0.0.0 0.0.0.0 0.0.0.0</td>
</tr>
<tr>
<td>Netbios Name Servers...................</td>
<td>0.0.0.0 0.0.0.0 0.0.0.0</td>
</tr>
</tbody>
</table>

Configuring MAC Filtering for WLANs

Information About MAC Filtering of WLANs

When you use MAC filtering for client or administrator authorization, you need to enable it at the WLAN level first. If you plan to use local MAC address filtering for any WLAN, use the commands in this section to configure MAC filtering for a WLAN.
Enabling MAC Filtering

Use these commands to enable MAC filtering on a WLAN:

- Enable MAC filtering by entering the `config wlan mac-filtering enable wlan_id` command.
- Verify that you have MAC filtering enabled for the WLAN by entering the `show wlan` command.

When you enable MAC filtering, only the MAC addresses that you add to the WLAN are allowed to join the WLAN. MAC addresses that have not been added are not allowed to join the WLAN.

When a client tries to associate to a WLAN for the first time, the client gets authenticated with its MAC address from AAA server. If the authentication is successful, the client gets an IP address from DHCP server, and then the client is connected to the WLAN.

When the client roams or sends association request to the same AP or different AP and is still connected to WLAN, the client is not authenticated again to AAA server.

If the client is not connected to WLAN, then the client has to get authenticated from the AAA server.

Configuring Local MAC Filters

Information About Local MAC Filters

Controllers have built-in MAC filtering capability, similar to that provided by a RADIUS authorization server.

Configuring Local MAC Filters (CLI)

- Create a MAC filter entry on the controller by entering the `config macfilter add mac_addr wlan_id [interface_name] [description] [IP_addr]` command.

  The following parameters are optional:

  - `mac_addr`—MAC address of the client.
  - `wlan_id`—WLAN id on which the client is associating.
  - `interface_name`—The name of the interface. This interface name is used to override the interface configured to the WLAN.
  - `description`—A brief description of the interface in double quotes (for example, "Interface1").
  - `IP_addr`—The IP address which is used for a passive client with the MAC address specified by the mac addr value above.

- Assign an IP address to an existing MAC filter entry, if one was not assigned in the `config macfilter add` command by entering the `config macfilter ip-address mac_addr IP_addr` command.

- Verify that MAC addresses are assigned to the WLAN by entering the `show macfilter` command.
If MAC filtering is configured, the controller tries to authenticate the wireless clients using the RADIUS servers first. Local MAC filtering is attempted only if no RADIUS servers are found, either because the RADIUS servers timed out or no RADIUS servers were configured.

**Prerequisites for Configuring Local MAC Filters**

You must have AAA enabled on the WLAN to override the interface name.

**Information About Configuring a Timeout for Disabled Clients**

You can configure a timeout for disabled clients. Clients who fail to authenticate three times when attempting to associate are automatically disabled from further association attempts. After the timeout period expires, the client is allowed to retry authentication until it associates or fails authentication and is excluded again. Use these commands to configure a timeout for disabled clients.

**Configuring Timeout for Disabled Clients (CLI)**

- Configure the timeout for disabled clients by entering the `config wlan exclusionlist wlan_id timeout` command. The valid timeout range is 1 to 2147483647 seconds. A value of 0 permanently disables the client.
- Verify the current timeout by entering the `show wlan` command.

**Assigning WLANs to Interfaces**

Use these commands to assign a WLAN to an interface:

- Assign a WLAN to an interface by entering this command:

  `config wlan interface {wlan_id | foreignAp} interface_id`

  - Use the `interface_id` option to assign the WLAN to a specific interface.
  - Use the `foreignAp` option to use a third-party access point.

- Verify the interface assignment status by entering the `show wlan summary` command.

For the client with an IPv6 address, controllers support only one untagged interface for a controller. However, in an ideal scenario of IPv4 address, the controller supports one untagged interface per port.
Configuring the DTIM Period

Information About DTIM Period

In the 802.11 networks, lightweight access points broadcast a beacon at regular intervals, which coincides with the Delivery Traffic Indication Map (DTIM). After the access point broadcasts the beacon, it transmits any buffered broadcast and multicast frames based on the value set for the DTIM period. This feature allows power-saving clients to wake up at the appropriate time if they are expecting broadcast or multicast data.

Typically, the DTIM value is set to 1 (to transmit broadcast and multicast frames after every beacon) or 2 (to transmit after every other beacon). For instance, if the beacon period of the 802.11 network is 100 ms and the DTIM value is set to 1, the access point transmits buffered broadcast and multicast frames 10 times per second. If the beacon period is 100 ms and the DTIM value is set to 2, the access point transmits buffered broadcast and multicast frames 5 times per second. Either of these settings are suitable for applications, including Voice Over IP (VoIP), that expect frequent broadcast and multicast frames.

However, the DTIM value can be set as high as 255 (to transmit broadcast and multicast frames after every 255th beacon) if all 802.11 clients have power save enabled. Because the clients have to listen only when the DTIM period is reached, they can be set to listen for broadcasts and multicasts less frequently which results in a longer battery life. For example, if the beacon period is 100 ms and you set the DTIM value to 100, the access point transmits buffered broadcast and multicast frames once every 10 seconds. This rate allows the power-saving clients to sleep longer before they have to wake up and listen for broadcasts and multicasts, which results in a longer battery life.

Note

A beacon period, which is specified in milliseconds on the controller, is converted internally by the software to 802.11 Time Units (TUs), where 1 TU = 1.024 milliseconds. On Cisco’s 802.11n access points, this value is rounded to the nearest multiple of 17 TUs. For example, a configured beacon period of 100 ms results in an actual beacon period of 104 ms.

Many applications cannot tolerate a long time between broadcast and multicast messages, which results in poor protocol and application performance. We recommend that you set a low DTIM value for 802.11 networks that support such clients.

You can configure the DTIM period for the 802.11 radio networks on specific WLANs. For example, you might want to set different DTIM values for voice and data WLANs.

Guidelines and Limitations

When you upgrade the controller software to release 5.0 or later releases, the DTIM period that was configured for a radio network is copied to all of the existing WLANs on the controller.
Configuring the DTIM Period (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the WLAN for which you want to configure the DTIM period.
Step 3  Unselect the Status check box to disable the WLAN.
Step 4  Click Apply.
Step 5  Choose the Advanced tab to open the WLANs > Edit (Advanced) page.
Step 6  Under DTIM Period, enter a value between 1 and 255 (inclusive) in the 802.11a/n and 802.11b/g/n text boxes. The default value is 1 (transmit broadcast and multicast frames after every beacon).
Step 7  Click Apply.
Step 8  Choose the General tab to open the WLANs > Edit (General) page.
Step 9  Select the Status check box to reenable the WLAN.
Step 10 Click Save Configuration.

Configuring the DTIM Period (CLI)

Step 1  Disable the WLAN by entering this command:
config wlan disable wlan_id
Step 2  Configure the DTIM period for a 802.11 radio network on a specific WLAN by entering this command:
config wlan dtim {802.11a | 802.11b} dtim wlan_id
where dtim is a value between 1 and 255 (inclusive). The default value is 1 (transmit broadcast and multicast frames after every beacon).
Step 3  Reenable the WLAN by entering this command:
config wlan enable wlan_id
Step 4  Save your changes by entering this command:
save config
Step 5  Verify the DTIM period by entering this command:
show wlan wlan_id
Configuring Peer-to-Peer Blocking

Information About Peer-to-Peer Blocking

Peer-to-peer blocking is applied to individual WLANs, and each client inherits the peer-to-peer blocking setting of the WLAN to which it is associated. Peer-to-Peer enables you to have more control over how traffic is directed. For example, you can choose to have traffic bridged locally within the controller, dropped by the controller, or forwarded to the upstream VLAN.

Peer-to-peer blocking is supported for clients that are associated with the local switching WLAN.

Per WLAN, peer-to-peer configuration is pushed by the controller to FlexConnect AP. In controller software releases prior to 4.2, peer-to-peer blocking is applied globally to all clients on all WLANs and causes traffic between two clients on the same VLAN to be transferred to the upstream VLAN rather than being bridged by the controller. This behavior usually results in traffic being dropped at the upstream switch because switches do not forward packets out the same port on which they are received.

Restrictions for Peer-to-Peer Blocking

- In controller software releases prior to 4.2, the controller forwards Address Resolution Protocol (ARP) requests upstream (just like all other traffic). In controller software release 4.2 or later releases, ARP requests are directed according to the behavior set for peer-to-peer blocking.
- Peer-to-peer blocking does not apply to multicast traffic.
- If you upgrade to controller software release 4.2 or later releases from a previous release that supports global peer-to-peer blocking, each WLAN is configured with the peer-to-peer blocking action of forwarding traffic to the upstream VLAN.
- In FlexConnect, solution peer-to-peer blocking configuration cannot be applied only to a particular FlexConnect AP or a subset of APs. It is applied to all FlexConnect APs that broadcast the SSID.
- Unified solution for central switching clients supports peer-to-peer upstream-forward. However, this is not supported in the FlexConnect solution. This is treated as peer-to-peer drop and client packets are dropped.
- Unified solution for central switching clients supports peer-to-peer blocking for clients associated with different APs. However, this solution targets only clients connected to the same AP. FlexConnect ACLs can be used as a workaround for this limitation.

Configuring Peer-to-Peer Blocking (GUI)

Step 1 Choose WLANs to open the WLANs page.
Step 2 Click the ID number of the WLAN for which you want to configure peer-to-peer blocking.
Step 3 Choose the Advanced tab to open the WLANs > Edit (Advanced) page.
Step 4 Choose one of the following options from the P2P Blocking drop-down list:
**Configuring Peer-to-Peer Blocking (CLI)**

**Step 1** Configure a WLAN for peer-to-peer blocking by entering this command:
```
config wlan peer-blocking {disable | drop | forward-upstream} wlan_id
```

**Step 2** Save your changes by entering this command:
```
save config
```

**Step 3** See the status of peer-to-peer blocking for a WLAN by entering this command:
```
show wlan wlan_id
```

Information similar to the following appears:

```
WLAN Identifier.......................... 1
Profile Name............................... test
Network Name (SSID)....................... test
Status..................................... Enabled
...                                      ...
...                                      ...
Peer-to-Peer Blocking Action............ Disabled
Radio Policy.............................. All
Local EAP Authentication................ Disabled
```
Configuring Layer 2 Security

Configuring Static WEP Keys (CLI)

Controllers can control static WEP keys across access points. Use these commands to configure static WEP for WLANs:

- Disable the 802.1X encryption by entering this command:
  ```
  config wlan security 802.1X disable wlan_id
  ```

- Configure 40/64-bit or 104/128-bit WEP keys by entering this command:
  ```
  config wlan security static-wep-key encryption wlan_id {40 | 104} {hex | ascii} key key_index
  ```
  - Use the 40 or 104 option to specify 40/64-bit or 104/128-bit encryption. The default setting is 104/128.
  - Use the hex or ascii option to specify the character format for the WEP key.
  - Enter 10 hexadecimal digits (any combination of 0-9, a-f, or A-F) or five printable ASCII characters for 40-bit/64-bit WEP keys or enter 26 hexadecimal or 13 ASCII characters for 104-bit/128-bit keys.
  - Enter a key index (sometimes called a key slot). The default value is 0, which corresponds to a key index of 1; the valid values are 0 to 3 (key index of 1 to 4).

Configuring Dynamic 802.1X Keys and Authorization (CLI)

Controllers can control 802.1X dynamic WEP keys using Extensible Authentication Protocol (EAP) across access points and support 802.1X dynamic key settings for WLANs.

Note

To use LEAP with lightweight access points and wireless clients, make sure to choose **Cisco-Aironet** as the RADIUS server type when configuring the CiscoSecure Access Control Server (ACS).

- Check the security settings of each WLAN by entering this command:
  ```
  show wlan wlan_id
  ```
  The default security setting for new WLANs is 802.1X with dynamic keys enabled. To maintain robust Layer 2 security, leave 802.1X configured on your WLANs.

- Disable or enable the 802.1X authentication by entering this command:
  ```
  config wlan security 802.1X {enable | disable} wlan_id
  ```
  After you enable 802.1X authentication, the controller sends EAP authentication packets between the wireless client and the authentication server. This command allows all EAP-type packets to be sent to and from the controller.

- Change the 802.1X encryption level for a WLAN by entering this command:
config wlan security 802.1X encryption wlan_id [0 | 40 | 104]

◦ Use the 0 option to specify no 802.1X encryption.
◦ Use the 40 option to specify 40/64-bit encryption.
◦ Use the 104 option to specify 104/128-bit encryption. (This is the default encryption setting.)

Configuring 802.11r BSS Fast Transition

Information About 802.11r Fast Transition

802.11r, which is the IEEE standard for fast roaming, introduces a new concept of roaming where the initial handshake with the new AP is done even before the client roams to the target AP, which is called Fast Transition (FT). The initial handshake allows the client and APs to do the Pairwise Transient Key (PTK) calculation in advance. These PTK keys are applied to the client and AP after the client does the reassociation request or response exchange with new target AP.

802.11r provides two methods of roaming:

• Over-the-Air
• Over-the-DS (Distribution System)

The FT key hierarchy is designed to allow clients to make fast BSS transitions between APs without requiring reauthentication at every AP. WLAN configuration contains a new Authenticated Key Management (AKM) type called FT (Fast Transition).

How a Client Roams

For a client to move from its current AP to a target AP using the FT protocols, the message exchanges are performed using one of the following two methods:

• Over-the-Air—The client communicates directly with the target AP using IEEE 802.11 authentication with the FT authentication algorithm.

• Over-the-DS—The client communicates with the target AP through the current AP. The communication between the client and the target AP is carried in FT action frames between the client and the current AP and is then sent through the controller.
This figure shows the sequence of message exchanges that occur when Over the Air client roaming is configured.

**Figure 29: Message Exchanges when Over the Air client roaming is configured**

MOBILITY DOMAIN - M1

Controller - 1 → Mobility update for C1 → Controller - 2

AP1 → 802.11 auth request → AP2

Associated

Client C1

→ Roaming direction →

--- Actual communication path
This figure shows the sequence of message exchanges that occur when Over the DS client roaming is configured.

*Figure 30: Message Exchanges when Over the DS client roaming is configured*

![Diagram showing message exchanges](image)

**Restrictions for 802.11r Fast Transition**

- This feature is not supported on Mesh access points.
- In 8.1 and earlier releases, this feature is not supported on access points in FlexConnect mode. In Release 8.2, this restriction is removed.
- This feature is not supported on Linux-based APs such as Cisco 600 Series OfficeExtend Access Points.
- 802.11r client association is not supported on access points in standalone mode.
- 802.11r fast roaming is not supported on access points in standalone mode.
- 802.11r fast roaming between local authentication and central authentication WLAN is not supported.
- 802.11r fast roaming is not supported if the client uses Over-the-DS preauthentication in standalone mode.
- For APs in FlexConnect mode, 802.11r fast roaming works only if the APs are in the same FlexConnect group.
- EAP LEAP method is not supported. WAN link latency prevents association time to a maximum of 2 seconds.
• The service from standalone AP to client is only supported until the session timer expires.

• TSpec is not supported for 802.11r fast roaming. Therefore, RIC IE handling is not supported.

• If WAN link latency exists, fast roaming is also delayed. Voice or data maximum latency should be verified. The controller handles 802.11r Fast Transition authentication request during roaming for both Over-the-Air and Over-the-DS methods.

• This feature is supported only on open and WPA2 configured WLANs.

• Legacy clients cannot associate with a WLAN that has 802.11r enabled if the driver of the supplicant that is responsible for parsing the Robust Security Network Information Exchange (RSN IE) is old and not aware of the additional AKM suites in the IE. Due to this limitation, clients cannot send association requests to WLANs. These clients, however, can still associate with non-802.11r WLANs. Clients that are 802.11r capable can associate as 802.11i clients on WLANs that have both 802.11i and 802.11r Authentication Key Management Suites enabled.

The workaround is to enable or upgrade the driver of the legacy clients to work with the new 802.11r AKMs, after which the legacy clients can successfully associate with 802.11r enabled WLANs.

Another workaround is to have two SSIDs with the same name but with different security settings (FT and non-FT).

• Fast Transition resource request protocol is not supported because clients do not support this protocol. Also, the resource request protocol is an optional protocol.

• To avoid any Denial of Service (DoS) attack, each controller allows a maximum of three Fast Transition handshakes with different APs.

• For APs in FlexConnect mode, 802.11r fast roaming works only if the APs are in the same FlexConnect group.

### Configuring 802.11r Fast Transition (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose WLANs to open the WLANs page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the WLAN ID to open the WLANs &gt; Edit page.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose the Security &gt; Layer 2 tab.</td>
</tr>
<tr>
<td>Step 4</td>
<td>From the Layer 2 Security drop-down list, choose WPA+WPA2. The Authentication Key Management parameters for Fast Transition appear.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Select or unselect the Fast Transition check box to enable or disable Fast Transition on the WLAN.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Select or unselect the Over the DS check box to enable or disable Fast Transition over a distributed system. This option is available only if you enable Fast Transition.</td>
</tr>
<tr>
<td>Step 7</td>
<td>In the Reassociation Timeout box, enter the number of seconds after which the reassociation attempt of a client to an AP should time out. The valid range is 1 to 100 seconds. This option is available only if you enable Fast Transition.</td>
</tr>
</tbody>
</table>
Step 8: Under Authentication Key Management, choose between **FT 802.1X** or **FT PSK**. Select or unselect the corresponding check boxes to enable or disable the keys. If you select the **FT PSK** check box, then, from the PSK Format drop-down list, choose **ASCII** or **Hex** and enter the key value.

Step 9: From the WPA gtk-randomize State drop-down list, choose **Enable** or **Disable** to configure the WPA group temporal key (GTK) randomize state.

Step 10: Click **Apply** to save your settings.

---

**Configuring 802.11r Fast Transition (CLI)**

Step 1: To enable or disable 802.11r fast transition parameters, use the `config wlan security ft {enable | disable} wlan-id` command.

By default, the fast transition is disabled.

Step 2: To enable or disable 802.11r fast transition parameters over a distributed system, use the `config wlan security ft over-the-ds {enable | disable} wlan-id` command.

By default, the fast transition over a distributed system is disabled.

Step 3: To enable or disable the authentication key management for fast transition using preshared keys (PSK), use the `config wlan security wpa akm ft-psk {enable | disable} wlan-id` command.

By default, the authentication key management using PSK is disabled.

Step 4: To enable or disable the authentication key management for fast transition using 802.1X, use the `config wlan security wpa akm ft-802.1X {enable | disable} wlan-id` command.

By default, the authentication key management using 802.1X is disabled.

Step 5: To enable or disable 802.11r fast transition reassociation timeout, use the `config wlan security ft reassociation-timeout timeout-in-seconds wlan-id` command.

The valid range is 1 to 100 seconds. The default value of reassociation timeout is 20 seconds.

Step 6: To enable or disable the authentication key management for fast transition over a distributed system, use the `config wlan security wpa akm ft over-the-ds {enable | disable} wlan-id` command.

By default, the authentication key management for fast transition over a distributed system is enabled.

Step 7: To view the fast transition configuration on a client, use the `show client detailed client-mac` command.

Step 8: To view the fast transition configuration on a WLAN, use the `show wlan wlan-id` command.

Step 9: To enable or disable debugging of fast transition events, use the `debug ft events {enable | disable}` command.

Step 10: To enable or disable debugging of key generation for fast transition, use the `debug ft keys {enable | disable}` command.
**Troubleshooting 802.11r BSS Fast Transition**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-802.11r legacy clients are no longer connecting.</td>
<td>Check if the WLAN has FT enabled. If so, non-FT WLAN will need to be created.</td>
</tr>
<tr>
<td>When configuring WLAN, the FT setup options are not shown.</td>
<td>Check if WPA2 is being used (802.1x / PSK). FT is supported only on WPA2 and OPEN SSIDs.</td>
</tr>
<tr>
<td>802.11r clients appear to reauthenticate when they do a Layer 2 roam to a new controller.</td>
<td>Check if the reassociation timeout has been lowered from the default of 20 by navigating to WLANs &gt; WLAN Name &gt; Security &gt; Layer 2 on the controller GUI.</td>
</tr>
</tbody>
</table>

**Configuring MAC Authentication Failover to 802.1X Authentication**

You can configure the controller to start 802.1X authentication when MAC authentication with static WEP for the client fails. If the RADIUS server rejects an access request from a client instead of deauthenticating the client, the controller can force the client to undergo an 802.1X authentication. If the client fails the 802.1X authentication too, then the client is deauthenticated.

If MAC authentication is successful and the client requests for an 802.1X authentication, the client has to pass the 802.1X authentication to be allowed to send data traffic. If the client does not choose an 802.1X authentication, the client is declared to be authenticated if the client passes the MAC authentication.

**Configuring MAC Authentication Failover to 802.1x Authentication (GUI)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose WLANs &gt; WLAN ID to open the WLANs &gt; Edit page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the Security tab, click the Layer 2 tab.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select the MAC Filtering check box.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the Mac Auth or Dot1x check box.</td>
</tr>
</tbody>
</table>

**Configuring MAC Authentication Failover to 802.1X Authentication (CLI)**

To configure MAC authentication failover to 802.1X authentication, enter this command:
```
cfg wlan security 802.1X on-macfilter-failure {enable | disable} wlan-id
```
Configuring a WLAN for Both Static and Dynamic WEP

Information About WLAN for Both Static and Dynamic WEP

You can configure up to four WLANs to support static WEP keys, and you can also configure dynamic WEP on any of these static-WEP WLANs. Follow these guidelines when configuring a WLAN for both static and dynamic WEP:

• The static WEP key and the dynamic WEP key must be the same length.

• When you configure both static and dynamic WEP as the Layer 2 security policy, no other security policies can be specified. That is, you cannot configure web authentication. However, when you configure either static or dynamic WEP as the Layer 2 security policy, you can configure web authentication.

WPA1 and WPA2

Wi-Fi Protected Access (WPA or WPA1) and WPA2 are standards-based security solutions from the Wi-Fi Alliance that provide data protection and access control for wireless LAN systems. WPA1 is compatible with the IEEE 802.11i standard but was implemented prior to the standard's ratification; WPA2 is the Wi-Fi Alliance's implementation of the ratified IEEE 802.11i standard.

By default, WPA1 uses Temporal Key Integrity Protocol (TKIP) and message integrity check (MIC) for data protection while WPA2 uses the stronger Advanced Encryption Standard encryption algorithm using Counter Mode with Cipher Block Chaining Message Authentication Code Protocol (AES-CCMP). Both WPA1 and WPA2 use 802.1X for authenticated key management by default. However, these options are also available:

• 802.1X—The standard for wireless LAN security, as defined by IEEE, is called 802.1X for 802.11, or simply 802.1X. An access point that supports 802.1X acts as the interface between a wireless client and an authentication server, such as a RADIUS server, to which the access point communicates over the wired network. If 802.1X is selected, only 802.1X clients are supported.

• PSK—When you choose PSK (also known as WPA preshared key or WPA passphrase), you need to configure a preshared key (or a passphrase). This key is used as the pairwise master key (PMK) between the clients and the authentication server.

• CCKM—Cisco Centralized Key Management (CCKM) uses a fast rekeying technique that enables clients to roam from one access point to another without going through the controller, typically in under 150 milliseconds (ms). CCKM reduces the time required by the client to mutually authenticate with the new access point and derive a new session key during reassociation. CCKM fast secure roaming ensures that there is no perceptible delay in time-sensitive applications such as wireless Voice over IP (VoIP), enterprise resource planning (ERP), or Citrix-based solutions. CCKM is a CCXv4-compliant feature. If CCKM is selected, only CCKM clients are supported.

When CCKM is enabled, the behavior of access points differs from the controller's for fast roaming in the following ways:

• If an association request sent by a client has CCKM enabled in a Robust Secure Network Information Element (RSN IE) but CCKM IE is not encoded and only PMKID is encoded in RSN IE, then the controller does not do a full authentication. Instead, the controller validates the PMKID and does a four-way handshake.
If an association request sent by a client has CCKM enabled in RSN IE but CCKM IE is not encoded and only PMKID is encoded in RSN IE, then AP does a full authentication. The access point does not use PMKID sent with the association request when CCKM is enabled in RSN IE.

- 802.1X+CCKM—During normal operation, 802.1X-enabled clients mutually authenticate with a new access point by performing a complete 802.1X authentication, including communication with the main RADIUS server. However, when you configure your WLAN for 802.1X and CCKM fast secure roaming, CCKM-enabled clients securely roam from one access point to another without the need to reauthenticate to the RADIUS server. 802.1X+CCKM is considered optional CCKM because both CCKM and non-CCKM clients are supported when this option is selected.

On a single WLAN, you can allow WPA1, WPA2, and 802.1X/PSK/CCKM/802.1X+CCKM clients to join. All of the access points on such a WLAN advertise WPA1, WPA2, and 802.1X/PSK/CCKM/ 802.1X+CCKM information elements in their beacons and probe responses. When you enable WPA1 and/or WPA2, you can also enable one or two ciphers, or cryptographic algorithms, designed to protect data traffic. Specifically, you can enable AES and/or TKIP data encryption for WPA1 and/or WPA2. TKIP is the default value for WPA1, and AES is the default value for WPA2.

**Restrictions for Configuring Static and Dynamic WEP**

- The OEAP 600 series does not support fast roaming for clients. Dual mode voice clients will experience reduced call quality when they roam between the two spectrums on OEAP602 access point. We recommend that you configure voice devices to only connect on one band, either 2.4 GHz or 5.0 GHz.

- The controller software supports CCX versions 1 through 5. CCX support is enabled automatically for every WLAN on the controller and cannot be disabled. The controller stores the CCX version of the client in its client database and uses it to limit client functionality. Clients must support CCXv4 or v5 in order to use CCKM. For more information about CCX, see the Configuring Cisco Client Extensions section.

- In a unified architecture where multiple VLAN clients are supported for a WGB, you also need to configure encryption cipher suite and WEP keys globally, when the WEP encryption is enabled on the WGB. Otherwise, multicast traffic for wired VLAN clients fail.

**Configuring WPA1 +WPA2**

**Configuring WPA1+WPA2 (GUI)**

1. Choose WLANs to open the WLANs page.
2. Click the ID number of the desired WLAN to open the WLANs > Edit page.
3. Choose the Security and Layer 2 tabs to open the WLANs > Edit (Security > Layer 2) page.
4. Choose WPA+WPA2 from the Layer 2 Security drop-down list.
5. Under WPA+WPA2 Parameters, select the WPA Policy check box to enable WPA1, select the WPA2 Policy check box to enable WPA2, or select both check boxes to enable both WPA1 and WPA2.
The default value is disabled for both WPA1 and WPA2. If you leave both WPA1 and WPA2 disabled, the access points advertise in their beacons and probe responses information elements only for the authentication key management method that you choose in Step 7.

**Step 6**  
Select the AES check box to enable AES data encryption or the TKIP check box to enable TKIP data encryption for WPA1, WPA2, or both. The default values are TKIP for WPA1 and AES for WPA2.

**Step 7**  
Choose one of the following key management methods from the Auth Key Mgmtd drop-down list: **802.1X, CCKM, PSK, or 802.1X+CCKM**.

**Note**  
Cisco OEAP 600 does not support CCKM. You must choose either 802.1X or PSK.

**Note**  
For Cisco OEAP 600, the TKIP and AES security encryption settings must be identical for WPA and WPA2.

**Step 8**  
If you chose PSK in Step 7, choose ASCII or HEX from the PSK Format drop-down list and then enter a preshared key in the blank text box. WPA preshared keys must contain 8 to 63 ASCII text characters or 64 hexadecimal characters.

**Note**  
The PSK parameter is a set-only parameter. The value set for the PSK key is not visible to the user for security reasons. For example, if you selected HEX as the key format when setting the PSK key, and later when you view the parameters of this WLAN, the value shown is the default value. The default is ASCII.

**Step 9**  
Click **Apply** to commit your changes.

**Step 10**  
Click **Save Configuration** to save your changes.

---

### Configuring WPA1+WPA2 (CLI)

**Step 1**  
Disable the WLAN by entering this command:  
```plaintext
config wlan disable wlan_id
```

**Step 2**  
Enable or disable WPA for the WLAN by entering this command:  
```plaintext
config wlan security wpa {enable | disable} wlan_id
```

**Step 3**  
Enable or disable WPA1 for the WLAN by entering this command:  
```plaintext
config wlan security wpa wpa1 {enable | disable} wlan_id
```

**Step 4**  
Enable or disable WPA2 for the WLAN by entering this command:  
```plaintext
config wlan security wpa wpa2 {enable | disable} wlan_id
```

**Step 5**  
Enable or disable AES or TKIP data encryption for WPA1 or WPA2 by entering one of these commands:

- ```plaintext
  * config wlan security wpa wpa1 ciphers {aes | tkip} {enable | disable} wlan_id
  * config wlan security wpa wpa2 ciphers {aes | tkip} {enable | disable} wlan_id
  ```

The default values are TKIP for WPA1 and AES for WPA2.

**Note**  
You can enable or disable TKIP encryption only using the CLI. Configuring TKIP encryption is not supported in GUI.

When you have VLAN configuration on WGB, you need to configure the encryption cipher mode and keys for a particular VLAN, for example, **encryption vlan 80 mode ciphers tkip**. Then, you need configure the encryption cipher mode globally on the multicast interface by entering the following command: **encryption mode ciphers tkip**.

**Step 6**  
Enable or disable 802.1X, PSK, or CCKM authenticated key management by entering this command:
config wlan security wpa akm 802.1X | psk | cckm  enable | disable  wlan_id
The default value is 802.1X.

Step 7 If you enabled PSK in Step 6, enter this command to specify a preshared key:
config wlan security wpa akm psk set-key {ascii | hex} psk-key wlan_id
WPA preshared keys must contain 8 to 63 ASCII text characters or 64 hexadecimal characters.

Step 8 Enable or disable authentication key management suite for fast transition by entering this command:
config wlan security wpa akm ft 802.1X | psk  enable | disable  wlan_id
Note You can now choose between the PSK and the fast transition PSK as the AKM suite.

Step 9 Enable or disable randomization of group temporal keys (GTK) between AP and clients by entering this command:
config wlan security wpa gtk-random enable | disable  wlan_id

Step 10 If you enabled WPA2 with 802.1X authenticated key management or WPA1 or WPA2 with CCKM authenticated key management, the PMK cache lifetime timer is used to trigger reauthentication with the client when necessary. The timer is based on the timeout value received from the AAA server or the WLAN session timeout setting. To see the amount of time remaining before the timer expires, enter this command:
show pmk-cache all
If you enabled WPA2 with 802.1X authenticated key management, the controller supports both opportunistic PMKID caching and sticky (or non-opportunistic) PMKID caching. In sticky PMKID caching (SKC), the client stores multiple PMKIDs, a different PMKID for every AP it associates with. Opportunistic PMKID caching (OKC) stores only one PMKID per client. By default, the controller supports OKC.

Step 11 Enable the WLAN by entering this command:
config wlan enable wlan_id

Step 12 Save your settings by entering this command:
save config

---

**Configuring Sticky PMKID Caching**

**Information About Sticky Key Caching**

The controller supports sticky key caching (SKC). With sticky key caching, the client receives and stores a different PMKID for every AP it associates with. The APs also maintain a database of the PMKID issued to the client.

In SKC, the client stores each Pairwise Master Key ID (PMKID) against a Pairwise Master Key Security Association (PMKSA). When a client finds an AP for which it has the PMKSA, it sends the PMKID in the association request to the AP. If the PMKSA is alive in the AP, the AP provides support for fast roaming. In SKC, full authentication is done on each new AP to which the client associates and the client must keep the PMKSA associated with all APs. For SKC, PMKSA is a per AP cache that the client stores and PMKSA is precalculated based on the BSSID of the new AP.
Restrictions for Sticky Key Caching

• The controller supports SKC for up to eight APs per client. If a client roams to more than 8 APs per session, the old APs are removed to store the newly cached entries when the client roams. We recommend that you do not use SKC for large scale deployments.

• SKC works only on WPA2-enabled WLANs.

• SKC does not work across controllers in a mobility group.

• SKC works only on local mode APs.

Configuring Sticky Key Caching (CLI)

Step 1
Disable the WLAN by entering this command:
```plaintext
cfg wlandisable wlan_id
```

Step 2
Enable sticky key caching by entering this command:
```plaintext
cfg wlansecurity wpa wpa2 cache sticky enable wlan_id
```
By default, SKC is disabled and opportunistic key caching (OKC) is enabled.

**Note** SKC works only on WPA2 enabled WLANs.

You can check if SKC is enabled by entering this command:
```plaintext
show wlan wlan_id
```
Information similar to the following appears:

```
WLAN Identifier.......................... 2
Profile Name.............................. new
Network Name (SSID)....................... new
Status...................................... Disabled
MAC Filtering.............................. Disabled
Security
  802.11 Authentication:................... Open System
  Static WEP Keys:......................... Disabled
  802.1X..................................... Disabled
  Wi-Fi Protected Access (WPA/WPA2)....... Enabled
    WPA (SSN IE)............................ Disabled
    WPA2 (RSN IE)........................... Enabled
    TKIP Cipher............................ Disabled
    AES Cipher............................ Enabled
Auth Key Management
  802.1x.................................... Disabled
  EAP...................................... Enabled
  CCX...................................... Disabled
  FT(802.11r).............................. Disabled
  FT-PSK(802.11r)......................... Disabled
SKCCacheSupport.......................... Enabled
```
Configuring CKIP

Information About CKIP

Cisco Key Integrity Protocol (CKIP) is a Cisco-proprietary security protocol for encrypting 802.11 media. CKIP improves 802.11 security in infrastructure mode using key permutation, a message integrity check (MIC), and a message sequence number. Software release 4.0 or later releases support CKIP with a static key. For this feature to operate correctly, you must enable Aironet information elements (IEs) for the WLAN.

A lightweight access point advertises support for CKIP in beacon and probe response packets by adding an Aironet IE and setting one or both of the CKIP negotiation bits (key permutation and multi-modular hash message integrity check [MMH MIC]). Key permutation is a data encryption technique that uses the basic encryption key and the current initialization vector (IV) to create a new key. MMH MIC prevents bit-flip attacks on encrypted packets by using a hash function to compute message integrity code.

The CKIP settings specified in a WLAN are mandatory for any client attempting to associate. If the WLAN is configured for both CKIP key permutation and MMH MIC, the client must support both. If the WLAN is configured for only one of these features, the client must support only the CKIP feature.

CKIP requires that 5-byte and 13-byte encryption keys be expanded to 16-byte keys. The algorithm to perform key expansion occurs at the access point. The key is appended to itself repeatedly until the length reaches 16 bytes. All lightweight access points support CKIP.

Note

CKIP is supported for use only with static WEP. It is not supported for use with dynamic WEP. Therefore, a wireless client that is configured to use CKIP with dynamic WEP is unable to associate to a WLAN that is configured for CKIP. We recommend that you use either dynamic WEP without CKIP (which is less secure) or WPA/WPA2 with TKIP or AES (which are more secure).
Configuring CKIP (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the desired WLAN to open the WLANs > Edit page.
Step 3  Choose the Advanced tab.
Step 4  Select the Aironet IE check box to enable Aironet IEs for this WLAN and click Apply.
Step 5  Choose the General tab.
Step 6  Unselect the Status check box, if selected, to disable this WLAN and click Apply.
Step 7  Choose the Security and Layer 2 tabs to open the WLANs > Edit (Security > Layer 2) page.
Step 8  Choose CKIP from the Layer 2 Security drop-down list.
Step 9  Under CKIP Parameters, choose the length of the CKIP encryption key from the Key Size drop-down list. The range is Not Set, 40 bits, or 104 bits and the default is Not Set.
Step 10 Choose the number to be assigned to this key from the Key Index drop-down list. You can configure up to four keys.
Step 11 From the Key Format drop-down list, choose ASCII or HEX and then enter an encryption key in the Encryption Key text box. 40-bit keys must contain 5 ASCII text characters or 10 hexadecimal characters. 104-bit keys must contain 13 ASCII text characters or 26 hexadecimal characters.
Step 12 Select the MMH Mode check box to enable MMH MIC data protection for this WLAN. The default value is disabled (or unselected).
Step 13 Select the Key Permutation check box to enable this form of CKIP data protection. The default value is disabled (or unselected).
Step 14 Click Apply to commit your changes.
Step 15 Choose the General tab.
Step 16 Select the Status check box to enable this WLAN.
Step 17 Click Apply to commit your changes.
Step 18 Click Save Configuration to save your changes.

Configuring CKIP (CLI)

Step 1  Disable the WLAN by entering this command:
  config wlan disable wlan_id
Step 2  Enable Aironet IEs for this WLAN by entering this command:
  config wlan ccx aironet-ie enable wlan_id
Step 3  Enable or disable CKIP for the WLAN by entering this command:
  config wlan security ckip {enable | disable} wlan_id
Step 4  Specify a CKIP encryption key for the WLAN by entering this command:
  config wlan security ckip akm psk set-key wlan_id {40 | 104} {hex | ascii} key key_index
Step 5  Enable or disable CKIP MMH MIC for the WLAN by entering this command:
`config wlan security ckip mmh-mic {enable | disable} wlan_id`

Step 6  Enable or disable CKIP key permutation for the WLAN by entering this command:
`config wlan security ckip kp {enable | disable} wlan_id`

Step 7  Enable the WLAN by entering this command:
`config wlan enable wlan_id`

Step 8  Save your settings by entering this command:
`save config`

### Configuring a Session Timeout

#### Information About Session Timeouts

You can configure a WLAN with a session timeout. The session timeout is the maximum time for a client session to remain active before requiring reauthorization.

#### Configuring Session Timeouts

**Configuring a Session Timeout (GUI)**

Configurable session timeout range is:

- 300-86400 for 802.1x.
- 0-65535 for all other security types.

**Note**

If you configure session timeout as 0, it means disabling session-timeout, in case of open system, and 86400 seconds for all other system types.
When a 802.1x WLAN session timeout value is modified, the associated clients pmk-cache does not change to reflect the new session timeout value.

**Step 1** Choose WLANs to open the WLANs page.
**Step 2** Click the ID number of the WLAN for which you want to assign a session timeout.
**Step 3** When the WLANs > Edit page appears, choose the Advanced tab. The WLANs > Edit (Advanced) page appears.
**Step 4** Select the Enable Session Timeout check box to configure a session timeout for this WLAN. Not selecting the check box is equal to setting it to 0, which is the maximum value for a session timeout for each session type.
**Step 5** Click Apply to commit your changes.
**Step 6** Click Save Configuration to save your changes.

**Configuring a Session Timeout (CLI)**

**Step 1** Configure a session timeout for wireless clients on a WLAN by entering this command:
```
config wlan session-timeout wlan_id timeout
```
The default value is 1800 seconds for the following Layer 2 security types: 802.1X, Static WEP+802.1X, WPA+WPA2 with 802.1X, CCKM, or 802.1X+CCKM authentication key management and 0 seconds for all other Layer 2 security types (Open WLAN/CKIP/Static WEP). A value of 0 is equivalent to no timeout.

**Step 2** Save your changes by entering this command:
```
save config
```

**Step 3** See the current session timeout value for a WLAN by entering this command:
```
show wlan wlan_id
```
Information similar to the following appears:

```
WLAN Identifier......................... 9
Profile Name.............................. test12
Network Name (SSID)...................... test12
...
Number of Active Clients............... 0
Exclusionlist Timeout.................... 60 seconds
Session Timeout........................ 1800 seconds
...
```
Configuring Layer 3 Security Using VPN Passthrough

Information About VPN Passthrough

The controller supports VPN passthrough or the "passing through" of packets that originate from VPN clients. An example of VPN passthrough is your laptop trying to connect to the VPN server at your corporate office.

Restrictions for Layer 3 Security Using VPN Passthrough

- Layer 2 Tunnel Protocol (L2TP) and IPsec are not supported on controllers.
- Layer 3 security settings are not supported when you disable the client IP address on a WLAN.
- The VPN Passthrough option is not available on Cisco 5500 Series Controllers. However, you can replicate this functionality on the controller by creating an open WLAN using an ACL.

Configuring VPN Passthrough

Configuring VPN Passthrough (GUI)

Step 1. Choose WLANs to open the WLANs page.
Step 2. Click the ID number of the WLAN for which you want to configure VPN passthrough. The WLANs > Edit page appears.
Step 3. Choose the Security and Layer 3 tabs to open the WLANs > Edit (Security > Layer 3) page.
Step 4. From the Layer 3 Security drop-down list, choose VPN Pass-Through.
Step 5. In the VPN Gateway Address text box, enter the IP address of the gateway router that is terminating the VPN tunnels initiated by the client and passed through the controller.
Step 6. Click Apply to commit your changes.
Step 7. Click Save Configuration to save your settings.

Configuring VPN Passthrough (CLI)

Use these commands to configure VPN passthrough:

- `config wlan security passthru {enable | disable} wlan_id gateway`
  For `gateway`, enter the IP address of the router that is terminating the VPN tunnel.
- Verify that the passthrough is enabled by entering this command:
  `show wlan`
Configuring Layer 3 Security Using Web Authentication

Information About Web Authentication

WLANs can use web authentication only if VPN passthrough is not enabled on the controller. Web authentication is simple to set up and use and can be used with SSL to improve the overall security of the WLAN.

Prerequisites for Configuring Web Authentication on a WLAN

- To initiate HTTP/HTTPS web authentication redirection, use HTTP URL or HTTPS URL.
- If the CPU ACLs are configured to block HTTP / HTTPS traffic, after the successful web login authentication, there could be a failure in the redirection page.
- Before enabling web authentication, make sure that all proxy servers are configured for ports other than port 53.
- When you enable web authentication for a WLAN, a message appears indicating that the controller forwards DNS traffic to and from wireless clients prior to authentication. We recommend that you have a firewall or intrusion detection system (IDS) behind your guest VLAN to regulate DNS traffic and to prevent and detect any DNS tunneling attacks.
- If the web authentication is enabled on the WLAN and you also have the CPU ACL rules, the client-based web authentication rules take higher precedence as long as the client is unauthenticated (in the webAuth_Reqd state). Once the client goes to the RUN state, the CPU ACL rules get applied. Therefore, if the CPU ACL rules are enabled in the controller, an allow rule for the virtual interface IP is required (in any direction) with the following conditions:
  - When the CPU ACL does not have an allow ACL rule for both directions.
  - When an allow ALL rule exists, but also a DENY rule for port 443 or 80 of higher precedence.
- The allow rule for the virtual IP should be for TCP protocol and port 80 (if secureweb is disabled) or port 443 (if secureweb is enabled). This process is required to allow client's access to the virtual interface IP address, post successful authentication when the CPU ACL rules are in place.

Additional Information

For more information on using web authentication, see Managing User Accounts.
### Configuring Web Authentication

#### Configuring Web Authentication (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Choose <strong>WLANs</strong> to open the WLANs page.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Click the ID number of the WLAN for which you want to configure web authentication. The <strong>WLANs &gt; Edit</strong> page appears.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Choose the <strong>Security</strong> and <strong>Layer 3</strong> tabs to open the <strong>WLANs &gt; Edit (Security &gt; Layer 3)</strong> page.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Select the <strong>Web Policy</strong> check box.</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Make sure that the <strong>Authentication</strong> option is selected.</td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>Click <strong>Apply</strong> to commit your changes.</td>
</tr>
<tr>
<td><strong>Step 7</strong></td>
<td>Click <strong>Save Configuration</strong> to save your settings.</td>
</tr>
</tbody>
</table>

#### Configuring Web Authentication (CLI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Step 1** | Enable or disable web authentication on a particular WLAN by entering this command:  
```plaintext
config wlan security web-auth {enable | disable} wlan_id
```
| **Step 2** | Release the guest user IP address when the web authentication policy timer expires and prevent the guest user from acquiring an IP address for 3 minutes by entering this command:  
```plaintext
config wlan webauth-exclude wlan_id {enable | disable}
```
The default value is disabled. This command is applicable when you configure the internal DHCP scope on the controller. By default, when the web authentication timer expires for a guest user, the user can immediately reassociate to the same IP address before another guest user can acquire it. If there are many guest users or limited IP addresses in the DHCP pool, some guest users might not be able to acquire an IP address.

When you enable this feature on the guest WLAN, the guest user’s IP address is released when the web authentication policy timer expires and the guest user is excluded from acquiring an IP address for 3 minutes. The IP address is available for another guest user to use. After 3 minutes, the excluded guest user can reassociate and acquire an IP address, if available. |
| **Step 3** | See the status of web authentication by entering this command:  
```plaintext
show wlan wlan_id
```
Configuring Captive Bypassing

Information About Captive Bypassing

WISPr is a draft protocol that enables users to roam between different wireless service providers. Some devices (for example, Apple iOS devices) have a mechanism using which they can determine if the device is connected to Internet, based on an HTTP WISPr request made to a designated URL. This mechanism is used for the device to automatically open a web browser when a direct connection to the internet is not possible. This enables the user to provide his credentials to access the internet. The actual authentication is done in the background every time the device connects to a new SSID.

This HTTP request triggers a web authentication interception in the controller as any other page requests are performed by a wireless client. This interception leads to a web authentication process, which will be completed normally. If the web authentication is being used with any of the controller splash page features (URL provided by a configured RADIUS server), the splash page may never be displayed because the WISPr requests are made at very short intervals, and as soon as one of the queries is able to reach the designated server, any web redirection or splash page display process that is performed in the background is aborted, and the device processes the page request, thus breaking the splash page functionality.

For example, Apple introduced an iOS feature to facilitate network access when captive portals are present. This feature detects the presence of a captive portal by sending a web request on connecting to a wireless network. This request is directed to http://www.apple.com/library/test/success.html for Apple iOS version 6 and older, and to several possible target URLs for Apple iOS version 7 and later. If a response is received, then the Internet access is assumed to be available and no further interaction is required. If no response is received, then the Internet access is assumed to be blocked by the captive portal and Apple’s Captive Network Assistant (CNA) auto-launches the pseudo-browser to request portal login in a controlled window. The CNA may break when redirecting to an ISE captive portal. The controller prevents this pseudo-browser from popping up.

You can now configure the controller to bypass WISPr detection process, so the web authentication interception is only done when a user requests a web page leading to splash page load in user context, without the WISPr detection being performed in the background.

Configuring Captive Bypassing (CLI)

Use these commands to configure captive bypassing:

- `config network web-auth captive-bypass {enable | disable}`—Enables or disables the controller to support bypass of captive portals at the network level.

- `show network summary`—Displays the status for the WISPr protocol detection feature.
Configuring a Fallback Policy with MAC Filtering and Web Authentication

Information About Fallback Policy with MAC Filtering and Web Authentication

You can configure a fallback policy mechanism that combines Layer 2 and Layer 3 security. In a scenario where you have both MAC filtering and web authentication implemented, when a client tries to connect to a WLAN using the MAC filter (RADIUS server), if the client fails the authentication, you can configure the authentication to fall back to web authentication. When a client passes the MAC filter authentication, the web authentication is skipped and the client is connected to the WLAN. With this feature, you can avoid disassociations based on only a MAC filter authentication failure.

Restrictions
Mobility is not supported for SSIDs with security type configured for Webauth on MAC filter failure.

Configuring a Fallback Policy with MAC Filtering and Web Authentication (GUI)

Note Before configuring a fallback policy, you must have MAC filtering enabled.

Step 1 Choose WLANs to open the WLANs page.
Step 2 Click the ID number of the WLAN for which you want to configure the fallback policy for web authentication. The WLANs > Edit page appears.
Step 3 Choose the Security and Layer 3 tabs to open the WLANs > Edit (Security > Layer 3) page.
Step 4 From the Layer 3 Security drop-down list, choose None.
Step 5 Select the Web Policy check box.

Note The controller forwards DNS traffic to and from wireless clients prior to authentication.

The following options are displayed:

• Authentication
• Passthrough
• Conditional Web Redirect
• Splash Page Web Redirect
• On MAC Filter Failure
Configuring a Fallback Policy with MAC Filtering and Web Authentication (CLI)

Before configuring a fallback policy, you must have MAC filtering enabled. To know more about how to enable MAC filtering, see the Information About MAC Filtering of WLANs, on page 332.

Assigning a QoS Profile to a WLAN

Information About QoS Profiles

Cisco UWN solution WLANs support four levels of QoS: Platinum/Voice, Gold/Video, Silver/Best Effort (default), and Bronze/Background. You can configure the voice traffic WLAN to use Platinum QoS, assign the low-bandwidth WLAN to use Bronze QoS, and assign all other traffic between the remaining QoS levels.
The WLAN QoS level defines a specific 802.11e user priority (UP) for over-the-air traffic. This UP is used to derive the over-the-wire priorities for non-WMM traffic, and it also acts as the ceiling when managing WMM traffic with various levels of priorities.

The wireless rate limits can be defined on both upstream and downstream traffic. Rate limits can be defined per SSID and/or specified as a maximum rate limit for all clients. These rate limits can be individually configured.

The access point uses this QoS-profile-specific UP in accordance with the values in the following table to derive the IP DSCP value that is visible on the wired LAN.

Table 18: Access Point QoS Translation Values

<table>
<thead>
<tr>
<th>AVVID Traffic Type</th>
<th>AVVID IP DSCP</th>
<th>QoS Profile</th>
<th>AVVID 802.1p</th>
<th>IEEE 802.11e UP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network control</td>
<td>56 (CS7)</td>
<td>Platinum</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>Inter-network control</td>
<td>48 (CS6)</td>
<td>Platinum</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>(CAPWAP control, 802.11 management)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voice</td>
<td>46 (EF)</td>
<td>Platinum</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>Interactive video</td>
<td>34 (AF41)</td>
<td>Gold</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>Mission critical</td>
<td>26 (AF31)</td>
<td>Gold</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Transactional</td>
<td>18 (AF21)</td>
<td>Silver</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>Bulk data</td>
<td>10 (AF11)</td>
<td>Bronze</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Best effort</td>
<td>0 (BE)</td>
<td>Silver</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Scavenger</td>
<td>2</td>
<td>Bronze</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Note: The IEEE 802.11e UP value for DSCP values that are not mentioned in the table is calculated by considering 3 MSB bits of DSCP.

For example, the IEEE 802.11e UP value for DSCP 32 (100 000 in binary), would be the decimal equivalent of the MSB (100) which is 4. The 802.11e UP value of DSCP 32 is 4.
Assigning a QoS Profile to a WLAN (GUI)

Before You Begin

If you have not already done so, configure one or more QoS profiles using the instructions in the Configuring QoS Profiles (GUI) section.

---

**Step 1** Choose WLANs to open the WLANs page.

**Step 2** Click the ID number of the WLAN to which you want to assign a QoS profile.

**Step 3** When the WLANs > Edit page appears, choose the QoS tab.

**Step 4** From the Quality of Service (QoS) drop-down list, choose one of the following:

- **Platinum (voice)**
- **Gold (video)**
- **Silver (best effort)**
- **Bronze (background)**

**Note** Silver (best effort) is the default value.

**Step 5** To define the data rates on a per-user basis, do the following:

a) Define the average data rate for TCP traffic per user by entering the rate in Kbps in the Average Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

b) Define the peak data rate for TCP traffic per user by entering the rate in Kbps in the Burst Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

**Note** The burst data rate should be greater than or equal to the average data rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

Ensure that you configure the average data rate before you configure the burst data rate.

c) Define the average real-time rate for UDP traffic per user by entering the rate in Kbps in the Average Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

**Note** Average Data Rate is used to measure TCP traffic while Average Real-time rate is used for UDP traffic. They are measured in kbps for all the entries. The values for Average Data Rate and Average Real-time rate can be different because they are applied to different upper layer protocols such as TCP and UDP. These different values for the rates do not impact the bandwidth.

d) Define the peak real-time rate for UDP traffic per user by entering the rate in Kbps in the Burst Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

**Note** The burst real-time rate should be greater than or equal to the average real-time rate. Otherwise, the QoS policy may block traffic to and from the wireless client.

**Step 6** To define the data rates on a per-SSID basis, do the following:

a) Define the average data rate TCP traffic per SSID by entering the rate in Kbps in the Average Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

b) Define the peak data rate for TCP traffic per SSID by entering the rate in Kbps in the Burst Data Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

**Note** The burst data rate should be greater than or equal to the average data rate. Otherwise, the QoS policy may block traffic in the WLANs.
c) Define the average real-time rate for UDP traffic per SSID by entering the rate in Kbps in the Average Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

d) Define the peak real-time rate for UDP traffic per SSID by entering the rate in Kbps in the Burst Real-Time Rate text boxes. A value of 0 indicates that the value specified in the selected QoS profile will take effect.

**Note** The burst real-time rate should be greater than or equal to the average real-time rate. Otherwise, the QoS policy may block traffic in the WLANs.

**Step 7** Click **Apply**.

**Step 8** Click **Save Configuration**.

---

**Assigning a QoS Profile to a WLAN (CLI)**

If you have not already done so, configure one or more QoS profiles using the instructions in the Configuring QoS Profiles (CLI) section.

**Step 1** Assign a QoS profile to a WLAN by entering this command:

```bash
config wlan qos wlan_id {bronze | silver | gold | platinum}
```

Silver is the default value.

**Step 2** To override QoS profile rate limit parameters, enter this command:

```bash
config wlan override-rate-limit wlan-id {average-data-rate | average-realtime-rate | burst-data-rate | burst-realtime-rate} {per-ssid | per-client} {downstream | upstream} rate
```

**Step 3** Enter the `save config` command.

**Step 4** Verify that you have properly assigned the QoS profile to the WLAN by entering this command:

```bash
show wlan wlan_id
```

Information similar to the following appears:

```
WLAN Identifier................................. 1
Profile Name...................................... test
Network Name (SSID)............................. test
Status........................................... Enabled
MAC Filtering.................................... Disabled
Broadcast SSID................................... Enabled
AAA Policy Override............................ Disabled
Number of Active Clients...................... 0
Exclusionlist.................................... Disabled
Session Timeout............................... 0
Interface........................................ management
WLAN ACL........................................ unconfigured
DHCP Server.................................... 1.100.163.24
DHCP Address Assignment Required......... Disabled
Quality of Service............................ Silver (best effort)
WMM............................................ Disabled
...
Configuring QoS Enhanced BSS

Information About QoS Enhanced BSS

The QoS Enhanced Basis Service Set (QBSS) information element (IE) enables the access points to communicate their channel usage to wireless devices. Because access points with high channel usage might not be able to handle real-time traffic effectively, the 7921 or 7920 phone uses the QBSS value to determine if they should associate to another access point. You can enable QBSS in these two modes:

- Wi-Fi Multimedia (WMM) mode, which supports devices that meet the 802.11E QBSS standard (such as Cisco 7921 IP Phones)
- 7920 support mode, which supports Cisco 7920 IP Phones on your 802.11b/g network

The 7920 support mode has two options:

- Support for 7920 phones that require call admission control (CAC) to be configured on and advertised by the client device (these are typically older 7920 phones)
- Support for 7920 phones that require CAC to be configured on and advertised by the access point (these are typically newer 7920 phones)

When access point-controlled CAC is enabled, the access point sends out a Cisco proprietary CAC Information Element (IE) and does not send out the standard QBSS IE.

Restrictions for QoS Enhanced BSS

- The OEAP 600 Series access points do not support CAC.
- QBSS is disabled by default.
- 7920 phones are non-WMM phones with limited CAC functionality. The phones look at the channel utilization of the access point to which they are associated and compare that to a threshold that is beaconed by the access point. If the channel utilization is less than the threshold, the 7920 places a call. In contrast, 7921 phones are full-fledged WMM phones that use traffic specifications (TSPECs) to gain access to the voice queue before placing a phone call. The 7921 phones work well with load-based CAC, which uses the percentage of the channel set aside for voice and tries to limit the calls accordingly.

Because 7921 phones support WMM and 7920 phones do not, capacity and voice quality problems can arise if you do not properly configure both phones when they are used in a mixed environment. To enable both 7921 and 7920 phones to co-exist on the same network, make sure that load-based CAC and 7920 AP CAC are both enabled on the controller and the WMM Policy is set to Allowed. These settings become particularly important if you have many more 7920 users than 7921 users.

- We recommend that aggressive load balancing always be turned off either through the controller GUI or CLI in any wireless network that is supporting voice, regardless of vendor. When aggressive load balancing is turned on, voice clients can hear an audible artifact when roaming, if the handset is refused at its first reassociation attempt.
**Additional Information**

See Configuring Controller Settings for more information on configuration instruction for load-based CAC.

**Configuring QBSS (GUI)**

**Step 1** Choose WLANs to open the WLANs page.

**Step 2** Click the ID number of the WLAN for which you want to configure WMM mode.

**Step 3** When the WLANs > Edit page appears, choose the QoS tab to open the WLANs > Edit (Qos) page.

**Step 4** From the WMM Policy drop-down list, choose one of the following options, depending on whether you want to enable WMM mode for 7921 phones and other devices that meet the WMM standard:

- **Disabled**—Disables WMM on the WLAN. This is the default value.
- **Allowed**—Allows client devices to use WMM on the WLAN.
- **Required**—Requires client devices to use WMM. Devices that do not support WMM cannot join the WLAN.

**Step 5** Select the 7920 AP CAC check box if you want to enable 7920 support mode for phones that require access point-controlled CAC. The default value is unselected.

**Step 6** Select the 7920 Client CAC check box if you want to enable 7920 support mode for phones that require client-controlled CAC. The default value is unselected.

**Note** You cannot enable both WMM mode and client-controlled CAC mode on the same WLAN.

**Step 7** Click Apply to commit your changes.

**Step 8** Click Save Configuration to save your changes.

**Configuring QBSS (CLI)**

**Step 1** Determine the ID number of the WLAN to which you want to add QBSS support by entering this command:

```bash
show wlan summary
```

**Step 2** Disable the WLAN by entering this command:

```bash
config wlan disable wlan_id
```

**Step 3** Configure WMM mode for 7921 phones and other devices that meet the WMM standard by entering this command:

```bash
config wlan wmm {disabled | allowed | required} wlan_id
```

where

- **disabled** disables WMM mode on the WLAN.
- **allowed** allows client devices to use WMM on the WLAN.
• **required** requires client devices to use WMM. Devices that do not support WMM cannot join the WLAN.

**Step 4**
Enable or disable 7920 support mode for phones that require client-controlled CAC by entering this command:

```bash
config wlan 7920-support client-cac-limit {enable | disable} wlan_id
```

**Note** You cannot enable both WMM mode and client-controlled CAC mode on the same WLAN.

**Step 5**
Enable or disable 7920 support mode for phones that require access point-controlled CAC by entering this command:

```bash
config wlan 7920-support ap-cac-limit {enable | disable} wlan_id
```

**Step 6**
Reenable the WLAN by entering this command:

```bash
config wlan enable wlan_id
```

**Step 7**
Save your changes by entering this command:

```bash
save config
```

**Step 8**
Verify that the WLAN is enabled and the Dot11-Phone Mode (7920) text box is configured for compact mode by entering this command:

```bash
show wlan wlan_id
```

---

### Configuring Media Session Snooping and Reporting

#### Information About Media Session Snooping and Reporting

This feature enables access points to detect the establishment, termination, and failure of Session Initiation Protocol (SIP) voice calls and then report them to the controller and Cisco Prime Infrastructure. You can enable or disable Voice over IP (VoIP) snooping and reporting for each WLAN.

When you enable VoIP Media Session Aware (MSA) snooping, the access point radios that advertise this WLAN look for SIP voice packets that comply with SIP RFC 3261. They do not look for non-RFC 3261-compliant SIP voice packets or Skinny Call Control Protocol (SCCP) voice packets. Any SIP packets destined to or originating from port number 5060 (the standard SIP signaling port) are considered for further inspection. The access points track when Wi-Fi Multimedia (WMM) and non-WMM clients are establishing a call, are already on an active call, or are in the process of ending a call. Upstream packet classification for both client types occurs at the access point. Downstream packet classification occurs at the controller for WMM clients and at the access point for non-WMM clients. The access points notify the controller and Cisco Prime Infrastructure of any major call events, such as call establishment, termination, and failure.

The controller provides detailed information for VoIP MSA calls. For failed calls, the controller generates a trap log with a timestamp and the reason for failure (in the GUI) and an error code (in the CLI) to aid in troubleshooting. For successful calls, the controller shows the number and duration of calls for usage tracking purposes. Cisco Prime Infrastructure displays failed VoIP call information in the Events page.

#### Restrictions for Media Session Snooping and Reporting

Controller software release 6.0 or later releases support Voice over IP (VoIP) Media Session Aware (MSA) snooping and reporting.
Configuring Media Session Snooping (GUI)

Step 1  Choose WLANs to open the WLANs page.

Step 2  Click the ID number of the WLAN for which you want to configure media session snooping.

Step 3  On the WLANs > Edit page, click the Advanced tab.

Step 4  Under Voice, select the Media Session Snooping check box to enable media session snooping or unselect it to disable this feature. The default value is unselected.

Step 5  Click Apply.

Step 6  Click Save Configuration.

Step 7  See the VoIP statistics for your access point radios as follows:

a) Choose Monitor > Access Points > Radios > 802.11a/n or 802.11b/g/n to open the 802.11a/n (or 802.11b/g/n) Radios page.

b) Scroll to the right and click the Detail link for the access point for which you want to view VoIP statistics. The Radio > Statistics page appears.

   The VoIP Stats section shows the cumulative number and length of voice calls for this access point radio. Entries are added automatically when voice calls are successfully placed and deleted when the access point disassociates from the controller.

Step 8  Choose Management > SNMP > Trap Logs to see the traps generated for failed calls. The Trap Logs page appears. For example, log 0 in the figure shows that a call failed. The log provides the date and time of the call, a description of the failure, and the reason why the failure occurred.

Configuring Media Session Snooping (CLI)

Step 1  Enable or disable VoIP snooping for a particular WLAN by entering this command:

```
config wlan call-snoop {enable | disable} wlan_id
```

Step 2  Save your changes by entering this command:

```
save config
```

Step 3  See the status of media session snooping on a particular WLAN by entering this command:

```
show wlan wlan_id
```

   Information similar to the following appears:

```
   WLAN Identifier.................................. 1
   Profile Name........................................ wpa2-psk
   Network Name (SSID)............................... wpa2-psk
   Status............................................ Enabled
   ...
   FlexConnect Local Switching..................... Disabled
```
See the call information for an MSA client when media session snooping is enabled and the call is active by entering this command:
```
show call-control client callInfo client_MAC_address
```
Information similar to the following appears:

```
Uplink IP/port................................. 192.11.1.71 / 23870
Downlink IP/port.............................. 192.12.1.47 / 2070
UP.............................................. 6
Calling Party................................ sip:1054
Called Party.................................. sip:1000
Call ID........................................ 58635b00-850161b7-14853-1501a8
Number of calls for given client is......... 1
```

See the metrics for successful calls or the traps generated for failed calls by entering this command:
```
show call-control ap {802.11a | 802.11b} Cisco_AP {metrics | traps}
```
Information similar to the following appears when you enter `show call-control ap {802.11a | 802.11b} Cisco_AP metrics`:

```
Total Call Duration in Seconds............... 120
Number of Calls................................ 10
```

To aid in troubleshooting, the output of this command shows an error code for any failed calls. This table explains the possible error codes for failed calls.

### Table 19: Error Codes for Failed VoIP Calls

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Integer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>unknown</td>
<td>Unknown error.</td>
</tr>
<tr>
<td>400</td>
<td>badRequest</td>
<td>The request could not be understood because of malformed syntax.</td>
</tr>
<tr>
<td>401</td>
<td>unauthorized</td>
<td>The request requires user authentication.</td>
</tr>
<tr>
<td>402</td>
<td>paymentRequired</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>403</td>
<td>forbidden</td>
<td>The server understood the request but refuses to fulfill it.</td>
</tr>
<tr>
<td>Error Code</td>
<td>Integer</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>404</td>
<td>notFound</td>
<td>The server has information that the user does not exist at the domain specified in the Request-URI.</td>
</tr>
<tr>
<td>405</td>
<td>methodNotAllowed</td>
<td>The method specified in the Request-Line is understood but not allowed for the address identified by the Request-URI.</td>
</tr>
<tr>
<td>406</td>
<td>notAcceptable</td>
<td>The resource identified by the request is only capable of generating response entities with content characteristics that are not acceptable according to the Accept header text box sent in the request.</td>
</tr>
<tr>
<td>407</td>
<td>proxyAuthenticationRequired</td>
<td>The client must first authenticate with the proxy.</td>
</tr>
<tr>
<td>408</td>
<td>requestTimeout</td>
<td>The server could not produce a response within a suitable amount of time, if it could not determine the location of the user in time.</td>
</tr>
<tr>
<td>409</td>
<td>conflict</td>
<td>The request could not be completed due to a conflict with the current state of the resource.</td>
</tr>
<tr>
<td>410</td>
<td>gone</td>
<td>The requested resource is no longer available at the server, and no forwarding address is known.</td>
</tr>
<tr>
<td>411</td>
<td>lengthRequired</td>
<td>The server is refusing to process a request because the request entity-body is larger than the server is willing or able to process.</td>
</tr>
<tr>
<td>413</td>
<td>requestEntityTooLarge</td>
<td>The server is refusing to process a request because the request entity-body is larger than the server is willing or able to process.</td>
</tr>
<tr>
<td>414</td>
<td>requestURITooLarge</td>
<td>The server is refusing to service the request because the Request-URI is longer than the server is willing to interpret.</td>
</tr>
<tr>
<td>415</td>
<td>unsupportedMediaType</td>
<td>The server is refusing to service the request because the message body of the request is in a format not supported by the server for the requested method.</td>
</tr>
<tr>
<td>420</td>
<td>badExtension</td>
<td>The server did not understand the protocol extension specified in a Proxy-Require or Require header text box.</td>
</tr>
<tr>
<td>480</td>
<td>temporarilyNotAvailable</td>
<td>The callee's end system was contacted successfully, but the callee is currently unavailable.</td>
</tr>
<tr>
<td>481</td>
<td>callLegDoesNotExist</td>
<td>The UAS received a request that does not match any existing dialog or transaction.</td>
</tr>
<tr>
<td>482</td>
<td>loopDetected</td>
<td>The server has detected a loop.</td>
</tr>
<tr>
<td>483</td>
<td>tooManyHops</td>
<td>The server received a request that contains a Max-Forwards header text box with the value zero.</td>
</tr>
<tr>
<td>Error Code</td>
<td>Integer</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>484</td>
<td>addressIncomplete</td>
<td>The server received a request with a Request-URI that was incomplete.</td>
</tr>
<tr>
<td>485</td>
<td>ambiguous</td>
<td>The Request-URI was ambiguous.</td>
</tr>
<tr>
<td>486</td>
<td>busy</td>
<td>The callee's end system was contacted successfully, but the callee is currently not willing or able to take additional calls at this end system.</td>
</tr>
<tr>
<td>500</td>
<td>internalServerError</td>
<td>The server encountered an unexpected condition that prevented it from fulfilling the request.</td>
</tr>
<tr>
<td>501</td>
<td>notImplemented</td>
<td>The server does not support the functionality required to fulfill the request.</td>
</tr>
<tr>
<td>502</td>
<td>badGateway</td>
<td>The server, while acting as a gateway or proxy, received an invalid response from the downstream server it accessed in attempting to fulfill the request.</td>
</tr>
<tr>
<td>503</td>
<td>serviceUnavailable</td>
<td>The server is temporarily unable to process the request because of a temporary overloading or maintenance of the server.</td>
</tr>
<tr>
<td>504</td>
<td>serverTimeout</td>
<td>The server did not receive a timely response from an external server it accessed in attempting to process the request.</td>
</tr>
<tr>
<td>505</td>
<td>versionNotSupported</td>
<td>The server does not support or refuses to support the SIP protocol version that was used in the request.</td>
</tr>
<tr>
<td>600</td>
<td>busyEverywhere</td>
<td>The callee's end system was contacted successfully, but the callee is busy or does not want to take the call at this time.</td>
</tr>
<tr>
<td>603</td>
<td>decline</td>
<td>The callee's machine was contacted successfully, but the user does not want to or cannot participate.</td>
</tr>
<tr>
<td>604</td>
<td>doesNotExistAnywhere</td>
<td>The server has information that the user indicated in the Request-URI does not exist anywhere.</td>
</tr>
<tr>
<td>606</td>
<td>notAcceptable</td>
<td>The user's agent was contacted successfully, but some aspects of the session description (such as the requested media, bandwidth, or addressing style) were not acceptable.</td>
</tr>
</tbody>
</table>

**Note** If you experience any problems with media session snooping, enter the `debug call-control {all | event} {enable | disable}` command to debug all media session snooping messages or events.
Configuring Key Telephone System-Based CAC

Information About Key Telephone System-Based CAC

Key Telephone System-based CAC is a protocol that is used in NEC MH240 wireless IP telephones. You can configure the controller to support CAC on KTS-based SIP clients, to process bandwidth request message from such clients, to allocate the required bandwidth on the AP radio, and to handle other messages that are part of the protocol.

When a call is initiated, the KTS-based CAC client sends a Bandwidth Request message to which the controller responds with a Bandwidth Confirm message indicating whether the bandwidth is allocated or not. The call is allowed only if the bandwidth is available. If the client roams from one AP to another, the client sends another Bandwidth Request message to the controller.

Bandwidth allocation depends on the median time calculated using the data rate from the Bandwidth Request message and the packetization interval. For KTS-based CAC clients, the G.711 codec with 20 milliseconds as the packetization interval is used to compute the medium time.

The controller releases the bandwidth after it receives the bandwidth release message from the client. When the client roams to another AP, the controller releases the bandwidth on the previous AP and allocates bandwidth on the new AP, in both intracontroller and intercontroller roaming scenarios. The controller releases the bandwidth if the client is dissociated or if there is inactivity for 120 seconds. The controller does not inform the client when the bandwidth is released for the client due to inactivity or dissociation of the client.

Restrictions for Key Telephone System-Based CAC

- The controller ignores the SSID Capability Check Request message from the clients.
- Preferred call is not supported for KTS CAC clients.
- Reason code 17 is not supported in intercontroller roaming scenarios.
- To make the KTS-based CAC feature functional, ensure that you do the following:
  - Enable WMM on the WLAN
  - Enable ACM at the radio level
  - Enable processing of TSPEC inactivity timeout at the radio level

Configuring KTS-based CAC (GUI)

Before You Begin

To enable KTS-based CAC for a WLAN, ensure that you do the following:

- Set the QoS profile for the WLAN to Platinum.
- Set the WLAN in disabled state.
• Set the FlexConnect Local Switching in disabled state for the WLAN (On the WLANs > Edit page, click the Advanced tab and uncheck the FlexConnect Local Switching check box).

---

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the WLAN for which you want to configure the KTS-based CAC policy.
Step 3  On the WLANs > Edit page, click the Advanced tab.
Step 4  Under Voice, check or uncheck the KTS based CAC Policy check box to enable or disable KTS-based CAC for the WLAN.
Step 5  Save the configuration.

---

Configuring KTS-based CAC (CLI)

**Before You Begin**
To enable KTS-based CAC for a WLAN, ensure that you do the following:

- Configure the QoS profile for the WLAN to Platinum by entering the following command:

  ```
  config wlan qos wlan-id platinum
  ```

- Disable the WLAN by entering the following command:

  ```
  config wlan disable wlan-id
  ```

- Disable FlexConnect Local Switching for the WLAN by entering the following command:

  ```
  config wlan flexconnect local-switching wlan-id disable
  ```

---

Step 1  To enable KTS-based CAC for a WLAN, enter the following command:

  ```
  config wlan kts-cac enable wlan-id
  ```

Step 2  To enable the functioning of the KTS-based CAC feature, ensure you do the following:

  a) Enable WMM on the WLAN by entering the following command:

     ```
     config wlan wmm allow wlan-id
     ```

  b) Enable ACM at the radio level by entering the following command:

     ```
     config 802.11a cac voice acm enable
     ```

  c) Enable the processing of the TSPEC inactivity timeout at the radio level by entering the following command:

     ```
     config 802.11a cac voice tspec-inactivity-timeout enable
     ```
Related Commands

• To see whether the client supports KTS-based CAC, enter the following command:

   `show client detail client-mac-address`

   Information similar to the following appears:

   ```
   Client MAC Address: 00:60:b9:0d:ef:26
   AP MAC Address: 58:bc:27:93:79:90
   QoS Level: Platinum
   802.1P Priority Tag: disabled
   KTS CAC Capability: Yes
   WMM Support: Enabled
   Power Save: ON
   ```

• To troubleshoot issues with KTS-based CAC, enter the following command:

   `debug cac kts enable`

• To troubleshoot other issues related to CAC, enter the following commands:

   `debug cac event enable`
   `debug call-control all enable`

Configuring Reanchoring of Roaming Voice Clients

Information About Reanchoring of Roaming Voice Clients

You can allow voice clients to get anchored on the best suited and nearest available controller, which is useful when intercontroller roaming occurs. By using this feature, you can avoid the use of tunnels to carry traffic between the foreign controller and the anchor controller and remove unnecessary traffic from the network.

The ongoing call during roaming is not affected and can continue without any problem. The traffic passes through proper tunnels that are established between the foreign controller and the anchor controller. Disassociation occurs only after the call ends, and then the client then gets reassociated to a new controller.

Note

You can reanchor roaming of voice clients for each WLAN.

Restrictions for Configuring Reanchoring of Roaming Voice Clients

• The ongoing data session might be affected due to disassociation and then reassociation.

• This feature is supported for TSPEC-based calls and non-TSPEC SIP-based calls only when you enable the admission control.

• This feature is not recommended for use on Cisco 792x phones.
Configuring Reanchoring of Roaming Voice Clients (GUI)

**Step 1**  Choose WLANs to open the WLANs page.
**Step 2**  Click the ID number of the WLAN for which you want to configure reanchoring of roaming voice clients.
**Step 3**  When the WLANs > Edit page appears, choose the Advanced tab to open the WLANs > Edit (Advanced) page.
**Step 4**  In the Voice area select the Re-anchor Roamed Clients check box.
**Step 5**  Click Apply to commit your changes.
**Step 6**  Click Save Configuration to save your changes.

Configuring Reanchoring of Roaming Voice Clients (CLI)

**Step 1**  Enable or disable reanchoring of roaming voice clients for a particular WLAN by entering this command:
```
config wlan roamed-voice-client re-anchor {enable | disable} wlan id
```
**Step 2**  Save your changes by entering this command:
```
save config
```
**Step 3**  See the status of reanchoring roaming voice client on a particular WLAN by entering this command:
```
show wlan wlan_id
```
Information similar to the following appears:

- WLAN Identifier......................... 1
- Profile Name.............................. wpa2-psk
- Network Name (SSID)...................... wpa2-psk
- Status..................................... Enabled
- Call Snooping............................. Enabled
- Roamed Call Re-Anchor Policy............ Enabled
- Band Select.............................. Disabled
- Load Balancing......................... Disabled
**Step 4**  Save your changes by entering this command:
```
save config
```
Configuring Seamless IPv6 Mobility

Information About IPv6 Mobility

Internet Protocol version 6 (IPv6) is the next-generation network layer Internet protocol intended to replace version 4 (IPv4) in the TCP/IP suite of protocols. This new version increases the Internet global address space to accommodate users and applications that require unique global IP addresses. IPv6 incorporates 128-bit source and destination addresses, which provide significantly more addresses than the 32-bit IPv4 addresses.

To support IPv6 clients across controllers, ICMPv6 messages must be dealt with specially to ensure the IPv6 client remains on the same Layer 3 network. The controllers keep track of IPv6 clients by intercepting the ICMPv6 messages to provide seamless mobility and protect the network from network attacks. The ICMPv6 packets are converted from multicast to unicast and delivered individually per client. This process allows more control. Specific clients can receive specific Neighbor Discovery and Router Advertisement packets, which ensures correct IPv6 addressing and avoids unnecessary multicast traffic.

The configuration for IPv6 mobility is the same as IPv4 mobility and requires no separate software on the client side to achieve seamless roaming. The controllers must be part of the same mobility group. Both IPv4 and IPv6 client mobility are enabled by default.

Prerequisites for Configuring IPv6 Mobility

- Up to eight client addresses can be tracked per client.
- To allow stateful DHCPv6 IP addressing to operate properly, you must have a switch or router that supports the DHCP for IPv6 feature that is configured to act like a DHCPv6 server, or you need a dedicated server such as a Windows 2008 server with a built-in DHCPv6 server.

To support the seamless IPv6 Mobility, you might need to configure the following:

- Configuring RA Guard for IPv6 Clients
- Configuring RA Throttling for IPv6 Clients
- Configuring IPv6 Neighbor Discovery Caching

Configuring RA Gaurd for IPv6 Clients

Information About RA Guard

IPv6 clients configure IPv6 addresses and populate their router tables based on IPv6 Router Advertisement (RA) packets. The RA Guard feature is similar to the RA guard feature of wired networks. RA Guard increases the security of the IPv6 network by dropping the unwanted or rogue RA packets that come from wireless clients. If this feature is not configured, malicious IPv6 clients could announce themselves as the router for the network, which would take higher precedence over legitimate IPv6 routers.

RA Guard occurs at the controller. You can configure the controller to drop RA messages at the access point or at the controller. By default, RA Guard is configured at the access point and also enabled in the controller.
All IPv6 RA messages are dropped, which protects other wireless clients and upstream wired network from malicious IPv6 clients.

**Note** RA guard is also supported in flexconnect local switching mode.

### Configuring RA Guard (GUI)

**Step 1** Choose **Controller > IPv6 > RA Guard** to open the IPv6 RA Guard page. By default the IPv6 RA Guard on AP is enabled.

**Step 2** From the drop-down list, choose **Disable** to disable RA Guard. The controller also displays the clients that have been identified as sending RA packets.

**Step 3** Click **Apply** to commit your changes.

**Step 4** Click **Save Configuration** to save your changes.

### Configuring RA Guard (CLI)

Use this command to configure RA Guard:

```
config ipv6 ra-guard ap {enable | disable}
```

### Configuring RA Throttling for IPv6 Clients

#### Information about RA Throttling

RA throttling allows the controller to enforce limits to RA packets headed toward the wireless network. By enabling RA throttling, routers that send many RA packets can be trimmed to a minimum frequency that will still maintain an IPv6 client connectivity. If a client sends an RS packet, then an RA is sent back to the client. This is allowed through the controller and unicast to the client. This process ensures that the new clients or roaming clients are not affected by the RA throttling.

### Configuring RA Throttling (GUI)

**Step 1** Choose **Controller > IPv6 > RA Throttle Policy** page. By default the IPv6 RA Throttle Policy is disabled. Unselect the check box to disable RA throttle policy.

**Step 2** Configure the following parameters:

- **Throttle period**—The period of time for throttling. RA throttling takes place only after the Max Through limit is reached for the VLAN or the Allow At-Most value is reached for a particular router. The range is from 10 seconds to 86400 seconds. The default is 600 seconds.
• **Max Through**—The maximum number of RA packets on a VLAN that can be sent before throttling takes place. The No Limit option allows an unlimited number of RA packets through with no throttling. The range is from 0 to 256 RA packets. The default is 10 RA packets.

• **Interval Option**—This option allows the controller to act differently based on the RFC 3775 value set in IPv6 RA packets.
  - **Passthrough**—Allows any RA messages with the RFC 3775 interval option to go through without throttling.
  - **Ignore**—Causes the RA throttle to treat packets with the interval option as a regular RA and subject to throttling if in effect.
  - **Throttle**—Causes the RA packets with the interval option to always be subject to rate limiting.

• **Allow At-least**—The minimum number of RA packets per router that can be sent as multicast before throttling takes place. The range is from 0 to 32 RA packets.

• **Allow At-most**—The maximum number of RA packets per router that can be sent as multicast before throttling takes place. The No Limit option allows an unlimited number of RA packets through the router. The range is from 0 to 256 RA packets.

**Note** When RA throttling occurs, only the first IPv6 capable router is allowed through. For networks that have multiple IPv6 prefixes being served by different routers, you should disable RA throttling.

**Step 3** Click **Apply** to commit your changes.

**Step 4** Click **Save Configuration** to save your changes.

---

**Configuring the RA Throttle Policy (CLI)**

Use this command to configure the RA throttle policy:

```
config ipv6 neighbor-binding ra-throttle {allow-at-least allow-at-least-value | enable | disable | interval-option {ignore | passthrough | throttle} | max-through {max-through-value | no-limit}}
```

**Configuring IPv6 Neighbor Discovery Caching**

**Information About IPv6 Neighbor Discovery**

IPv6 Neighbor Discovery is a set of messages and processes that determine relationships between neighboring nodes. Neighbor Discovery replaces ARP, ICMP Router Discovery, and ICMP Redirect used in IPv4.

At any given time, only eight IPv6 addresses are supported per client. When the ninth IPv6 address is encountered, the controller removes the oldest stale entry and accommodates the latest one.

IPv6 Neighbor Discovery inspection analyzes neighbor discovery messages in order to build a trusted binding table database, and IPv6 neighbor discovery packets that do not comply are dropped. The neighbor binding table in the controller track each IPv6 address and its associated MAC address. Clients are expired from the table according to Neighbor Binding timers.
Configuring Neighbor Binding (GUI)

Step 1
Choose Controller > IPv6 > Neighbor Binding page.

Step 2
Configure the following:

- **Down – Lifetime**—Specifies how long IPv6 cache entries are kept if the interface goes down. The range is from 0 to 86400 seconds.
- **Reachable – Lifetime**—Specifies how long IPv6 addresses are active. The range is from 0 to 86400 seconds.
- **Stale – Lifetime**—Specifies how long to keep IPv6 addresses in the cache. The range is from 0 to 86400 seconds.

Step 3
Enable or disable the Unknown Address Multicast NS Forwarding.

Step 4
Click Apply.

Step 5
Click Save Configuration.

Configuring Neighbor Binding (CLI)

- Configure the neighbor binding parameters by entering this command:
  ```
  config ipv6 neighbor-binding timers {down-lifetime | reachable-lifetime | stale-lifetime} {enable | disable}
  ```
- Configure the Unknown Address Multicast NS Forwarding by entering this command:
  ```
  config ipv6 ns-mcast-fwd {enable | disable}
  ```
- See the status of neighbor binding data that are configured on the controller by entering this command:
  ```
  show ipv6 neighbor-binding summary
  ```

Configuring Cisco Client Extensions

Information About Cisco Client Extensions

The Cisco Client Extensions (CCX) software is licensed to manufacturers and vendors of third-party client devices. The CCX code resident on these clients enables them to communicate wirelessly with Cisco access points and to support Cisco features that other client devices do not, including those features that are related to increased security, enhanced performance, fast roaming, and power management.

Prerequisites for Configuring Cisco Client Extensions

- The software supports CCX versions 1 through 5, which enables controllers and their access points to communicate wirelessly with third-party client devices that support CCX. CCX support is enabled
automatically for every WLAN on the controller and cannot be disabled. However, you can configure
Aironet information elements (IEs).

• If Aironet IE support is enabled, the access point sends an Aironet IE 0x85 (which contains the access
point name, load, number of associated clients, and so on) in the beacon and probe responses of this
WLAN, and the controller sends Aironet IEs 0x85 and 0x95 (which contains the management IP address
of the controller and the IP address of the access point) in the reassociation response if it receives Aironet
IE 0x85 in the reassociation request.

Configuring CCX Aironet IEs (GUI)

Step 1 Choose WLANs to open the WLANs page.
Step 2 Click the ID number of the desired WLAN to open the WLANs > Edit page.
Step 3 Choose the Advanced tab to open the WLANs > Edit (Advanced tab) page.
Step 4 Select the Aironet IE check box if you want to enable support for Aironet IEs for this WLAN. Otherwise, unselect this
check box. The default value is enabled (or selected).
Step 5 Click Apply to commit your changes.
Step 6 Click Save Configuration to save your changes.

Viewing a Client’s CCX Version (GUI)

A client device sends its CCX version in association request packets to the access point. The controller then
stores the client’s CCX version in its database and uses it to limit the features for this client. For example, if
a client supports CCX version 2, the controller does not allow the client to use CCX version 4 features.

Step 1 Choose Monitor > Clients to open the Clients page.
Step 2 Click the MAC address of the desired client device to open the Clients > Detail page.
The CCX Version text box shows the CCX version supported by this client device. Not Supported appears if the client
does not support CCX.
Step 3 Click Back to return to the previous screen.
Step 4 Repeat this procedure to view the CCX version supported by any other client devices.

Configuring CCX Aironet IEs (CLI)

Use this command to configure CCX Aironet IEs:

```
config wlan ccx aironet-ie {enable | disable} wlan_id
```
The default value is enabled.

**Viewing a Client’s CCX Version (CLI)**

See the CCX version supported by a particular client device using the controller CLI by entering this command:

```
show client detail client_mac
```

**Configuring Remote LANs**

**Information About Remote LANs**

This section describes how to configure remote LANs.

**Restrictions for Configuring Remote LANs**

- Only four clients can connect to an OEAP 600 series access point through a remote LAN port. This number does not affect the fifteen WLAN limit imposed for the controller WLANs. The remote LAN client limit supports connecting a switch or hub to the remote LAN port for multiple devices or connecting directly to a Cisco IP phone that is connected to that port. Only the first four devices can connect until one of the devices is idle for more than one minute.
- It is not possible to configure 802.1X on remote LANs through the controller GUI; configuration only through CLI is supported.

**Configuring Remote LANs**

**Configuring a Remote LAN (GUI)**

**Step 1**

Choose **WLANs** to open the WLANs page.

This page lists all of the WLANs and remote LANs currently configured on the controller. For each WLAN, you can see its WLAN/remote LAN ID, profile name, type, SSID, status, and security policies.

The total number of WLANs/Remote LANs appears in the upper right-hand corner of the page. If the list of WLANs/Remote LANs spans multiple pages, you can access these pages by clicking the page number links.

**Note**

If you want to delete a Remote LAN, hover your cursor over the blue drop-down arrow for that WLAN and choose **Remove**, or select the check box to the left of the row, choose **Remove Selected** from the drop-down list, and click **Go**. A message appears asking you to confirm your decision. If you proceed, the remote LAN is removed from any access point group to which it is assigned and from the access point’s radio.
Step 2: Create a new Remote-LAN by choosing Create New from the drop-down list and clicking Go. The WLANs > New page appears.

Step 3: From the Type drop-down list, choose Remote LAN to create a remote LAN.

Step 4: In the Profile Name text box, enter up to 32 alphanumeric characters for the profile name to be assigned to this Remote WLAN. The profile name must be unique.

Step 5: From the WLAN ID drop-down list, choose the ID number for this WLAN.

Step 6: Click Apply to commit your changes. The WLANs > Edit page appears.

Note: You can also open the WLANs > Edit page from the WLANs page by clicking the ID number of the WLAN that you want to edit.

Step 7: Use the parameters on the General, Security, and Advanced tabs to configure this remote LAN. See the sections in the rest of this chapter for instructions on configuring specific features.

Step 8: On the General tab, select the Status check box to enable this remote LAN. Be sure to leave it unselected until you have finished making configuration changes to the remote LAN.

Note: You can also enable or disable remote LANs from the WLANs page by selecting the check boxes to the left of the IDs that you want to enable or disable, choosing Enable Selected or Disable Selected from the drop-down list, and clicking Go.

Step 9: Click Apply to commit your changes.

Step 10: Click Save Configuration to save your changes.

---

**Configuring a Remote LAN (CLI)**

- See the current configuration of the remote LAN by entering this command:
  
  `show remote-lan remote-lan-id`

- Enable or disable remote LAN by entering this command:
  
  `config remote-lan {enable | disable} remote-lan-id`

- Enable or disable 802.1X authentication for remote LAN by entering this command:
  
  `config remote-lan security 802.1X {enable | disable} remote-lan-id`

  **Note:** The encryption on a remote LAN is always "none."

- Enable or disable local EAP with the controller as an authentication server, by entering this command:
  
  `config remote-lan local-auth enable profile-name remote-lan-id`

- If you are using an external AAA authentication server, use the following command:
  
  `config remote-lan radius_server auth {add | delete} remote-lan-id server id`

  `config remote-lan radius_server auth {enable | disable} remote-lan-id`
Configuring AP Groups

Information About Access Point Groups

After you create up to 512 WLANs on the controller, you can selectively publish them (using access point groups) to different access points to better manage your wireless network. In a typical deployment, all users on a WLAN are mapped to a single interface on the controller. Therefore, all users that are associated with that WLAN are on the same subnet or VLAN. However, you can choose to distribute the load among several interfaces or to a group of users based on specific criteria such as individual departments (such as Marketing) by creating access point groups. Additionally, these access point groups can be configured in separate VLANs to simplify network administration.

AP Groups Supported on Controller Platforms

This table lists the AP groups supported on various controller platforms:

<table>
<thead>
<tr>
<th>Controller Platform</th>
<th>AP Groups Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco 2500 Series Wireless Controller</td>
<td>50</td>
</tr>
<tr>
<td>Cisco 5500 Series Wireless Controller</td>
<td>500</td>
</tr>
<tr>
<td>Cisco Virtual Wireless Controller</td>
<td>200</td>
</tr>
<tr>
<td>Cisco 7500 Series Wireless Controller</td>
<td>6000</td>
</tr>
<tr>
<td>Cisco 8500 Series Wireless Controller</td>
<td>6000</td>
</tr>
<tr>
<td>Cisco Wireless Services Module 2</td>
<td>1000</td>
</tr>
</tbody>
</table>

Configuring Access Point Groups

Step 1 Configure the appropriate dynamic interfaces and map them to the desired VLANs. For example, to implement the network described in the Information About Access Point Groups section, create dynamic interfaces for VLANs 61, 62, and 63 on the controller. See the Configuring Dynamic Interfaces section for information about how to configure dynamic interfaces.

Step 2 Create the access point groups. See the Creating Access Point Groups section.

Step 3 Create a RF profile. See the Creating an RF Profile section.

Step 4 Assign access points to the appropriate access point groups. See the Creating Access Point Groups section.

Step 5 Apply the RF profile on the AP groups. See the Applying RF Profile to AP Groups section.
Creating Access Point Groups (GUI)

Step 1
Choose WLANs > Advanced > AP Groups to open the AP Groups page. This page lists all the access point groups currently created on the controller. By default, all access points belong to the default access point group "default-group," unless you assign them to other access point groups.

Note The controller creates a default access point group and automatically populates it with the first 16 WLANs (WLANs with IDs 1 through 16, or fewer if 16 WLANs are not configured). This default group cannot be modified (you cannot add WLANs to it nor delete WLANs from it). It is dynamically updated whenever the first 16 WLANs are added or deleted. If an access point does not belong to an access point group, it is assigned to the default group and uses the WLANs in that group. If an access point joins the controller with an undefined access point group name, the access point keeps its group name but uses the WLANs in the default-group access point group.

Step 2
Click Add Group to create a new access point group. The Add New AP Group section appears at the top of the page.

Step 3
In the AP Group Name text box, enter the group’s name.

Step 4
In the Description text box, enter the group’s description.

Step 5
In the NAS-ID text box, enter the network access server identifier for the AP group.

Step 6
Click Add. The newly created access point group appears in the list of access point groups on the AP Groups page.

Note If you ever want to delete this group, hover your cursor over the blue drop-down arrow for the group and choose Remove. An error message appears if you try to delete an access point group that is used by at least one access point. Before deleting an access point group in controller software release 6.0 or later releases, move all access points in the group to another group. The access points are not moved to the default-group access point group as in previous releases.

Step 7
Click the name of the group to edit this new group. The AP Groups > Edit (General) page appears.

Step 8
Change the description of this access point group by entering the new text in the AP Group Description text box and click Apply.

Step 9
Choose the WLANs tab to open the AP Groups > Edit (WLANs) page. This page lists the WLANs that are currently assigned to this access point group.

Step 10
Click Add New to assign a WLAN to this access point group. The Add New section appears at the top of the page.

Step 11
From the WLAN SSID drop-down list, choose the SSID of the WLAN.

Step 12
From the Interface Name drop-down list, choose the interface to which you want to map the access point group. Choose the quarantine VLAN if you plan to enable network admission control (NAC) out-of-band support.

Note The interface name in the default-group access point group matches the WLAN interface.

Step 13
Select the SNMP NAC State check box to enable NAC out-of-band support for this access point group. To disable NAC out-of-band support, leave the check box unselected, which is the default value.

Step 14
Click Add to add this WLAN to the access point group. This WLAN appears in the list of WLANs that are assigned to this access point group.

Note If you ever want to remove this WLAN from the access point group, hover your cursor over the blue drop-down arrow for the WLAN and choose Remove.
Step 15 Repeat Step 10 through Step 14 to add any additional WLANs to this access point group.

Step 16 Choose the APs tab to assign access points to this access point group. The AP Groups > Edit (APs) page lists the access points that are currently assigned to this group as well as any access points that are available to be added to the group. If an access point is not currently assigned to a group, its group name appears as "default-group".

Step 17 Select the check box to the left of the access point name and click Add APs to add an access point to this access point group. The access point, after it is reloaded, appears in the list of access points currently in this access point group. The AP has to be reloaded if the AP has to be moved from one group to another.

Note To select all of the available access points at once, select the AP Name check box. All of the access points are then selected.

Note If you ever want to remove an access point from the group, select the check box to the left of the access point name and click Remove APs. To select all of the access points at once, select the AP Name check box. All of the access points are then removed from this group.

Note If you ever want to change the access point group to which an access point belongs, choose Wireless > Access Points > All APs > ap_name > Advanced tab, choose the name of another access point group from the AP Group Name drop-down list, and click Apply.

Step 18 Click Save Configuration.

Creating Access Point Groups (CLI)

Step 1 Create an access point group by entering this command:
config wlan apgroup add group_name

Note To delete an access point group, enter the config wlan apgroup delete group_name command. An error message appears if you try to delete an access point group that is used by at least one access point. Before deleting an access point group in controller software release 6.0 or later releases, move all access points in the group to another group. The access points are not moved to the default-group access point group as in previous releases. To see the access points in a group, enter the show wlan apgroups command. To move the access points to another group, enter the config ap group-name group_name Cisco_AP command.

Step 2 Add a description to an access point group by entering this command:
config wlan apgroup description group_name description

Step 3 Assign a WLAN to an access point group by entering this command:
config wlan apgroup interface-mapping add group_name wlan_id interface_name

Note To remove a WLAN from an access point group, enter the config wlan apgroup interface-mapping delete group_name wlan_id command.

Step 4 Enable or disable NAC out-of-band support for this access point group by entering this command:
config wlan apgroup nac {enable | disable}group_name wlan_id

Step 5 Configure a WLAN radio policy on the access point group by entering this command:
config wlan apgroup wlan-radio-policy apgroup_name wlan_id {802.11a-only | 802.11bg | 802.11g-only | all}

Step 6 Assign an access point to an access point group by entering this command:
config ap group-name group_name Cisco_AP
To remove an access point from an access point group, reenter this command and assign the access point to another group.

**Note**

**Step 7** Save your changes by entering this command:

```
save config
```

---

**Viewing Access Point Groups (CLI)**

To view information about or to troubleshoot access point groups, use these commands:

- See a list of all access point groups on the controller by entering this command:
  ```
  show wlan apgroups
  ```

- See the BSSIDs for each WLAN assigned to an access point group by entering this command:
  ```
  show ap wlan {802.11a | 802.11b} Cisco_AP
  ```

- See the number of WLANs enabled for an access point group by entering this command:
  ```
  show ap config {802.11a | 802.11b} Cisco_AP
  ```

- Enable or disable debugging of access point groups by entering this command:
  ```
  debug group {enable | disable}
  ```

---

**Configuring RF Profiles**

**Information About RF Profiles**

RF Profiles allows you to tune groups of APs that share a common coverage zone together and selectively change how RRM will operates the APs within that coverage zone.

For example, a university might deploy a high density of APs in an area where a high number of users will congregate or meet. This situation requires that you manipulate both data rates and power to address the cell density while managing the co-channel interference. In adjacent areas, normal coverage is provided and such manipulation would result in a loss of coverage.

Using RF profiles and AP groups allows you to optimize the RF settings for AP groups that operate in different environments or coverage zones. RF profiles are created for the 802.11 radios. RF profiles are applied to all APs that belong to an AP group, where all APs in that group will have the same profile settings.

The RF profile gives you the control over the data rates and power (TPC) values.

---

**Note**

The application of an RF profile does not change the AP’s status in RRM. It is still in global configuration mode controlled by RRM.

To address high-density complex RF topologies, the following configurations are available:
- **High Density Configurations**—The following configurations are available to fine tune RF environments in a dense wireless network:
  - Client limit per WLAN or radio—Maximum number of clients that can communicate with the AP in a high-density environment.
  - Client trap threshold—Threshold value of the number of clients that associate with an access point, after which an SNMP trap is sent to the controller and Cisco Prime Infrastructure.

- **Stadium Vision Configurations**—You can configure the following parameter:
  - Multicast data rates—Configurable data rate for multicast traffic based on the RF condition of an AP.

- **Out-of-Box AP Configurations**—To create an Out-of-Box AP group that consists of newly installed access points that belong to the default AP group. When you enable this feature:
  - Newly installed access points (assigned to the 'default-group' AP group by default) are automatically assigned to the Out-of-Box AP group upon associating with the controller, and their radios are administratively disabled. This eliminates any RF instability caused by the new access points.
  - When Out-of-Box is enabled, default-group APs currently associated with the controller remain in the default group until they reassociate with the controller.
  - All default-group APs that subsequently associate with the controller (existing APs on the same controller that have dropped and reassociated, or APs from another controller) are placed in the Out-of-Box AP group.

  __Note__
  When removing APs from the Out-of-Box AP group for production use, we recommend that you assign the APs to a custom AP group to prevent inadvertently having them revert to the Out-of-Box AP group.

- Special RF profiles are created per 802.11 band. These RF profiles have default settings for all the existing RF parameters and additional new configurations.

  __Note__
  When you disable this feature after you enable it, only subscription of new APs to the Out of Box AP group stops. All APs that are subscribed to the Out of Box AP Group remain in this AP group. The network administrators can move such APs to the default group or a custom AP group upon network convergence.

- **Band Select Configurations**—Band Select addresses client distribution between the 2.4-GHz and 5-GHz bands by first understanding the client capabilities to verify whether a client can associate on both 2.4-GHz and 5-GHz spectrum. Enabling band select on a WLAN forces the AP to do probe suppression on the 2.4-GHz band that ultimately moves dual band clients to 5-GHz spectrum. You can configure the following band select parameters per AP Group:
  - Probe response—Probe responses to clients that you can enable or disable.
  - Probe Cycle Count—Probe cycle count for the RF profile. The cycle count sets the number of suppression cycles for a new client.
• Cycle Threshold—Time threshold for a new scanning RF Profile band select cycle period. This setting determines the time threshold during which new probe requests from a client come in a new scanning cycle.

• Suppression Expire—Expiration time for pruning previously known 802.11b/g clients. After this time elapses, clients become new and are subject to probe response suppression.

• Dual Band Expire—Expiration time for pruning previously known dual-band clients. After this time elapses, clients become new and are subject to probe response suppression.

• Client RSSI—Minimum RSSI for a client to respond to a probe.

• Load Balancing Configurations—Load balancing maintains fair distribution of clients across APs. You can configure the following parameters:
  • Window—Load balancing sets client association limits by enforcing a client window size. For example, if the window size is defined as 3, assuming fair client distribution across the floor area, then an AP should have no more than 3 clients associated with it than the group average.
  • Denial—The denial count sets the maximum number of association denials during load balancing.

• Coverage Hole Mitigation Configurations—You can configure the following parameters:
  • Data RSSI—Minimum receive signal strength indication (RSSI) value for data packets received by the access point. The value that you enter is used to identify coverage holes (or areas of poor coverage) within your network.
  • Voice RSSI—Minimum receive signal strength indication (RSSI) value for voice packets received by the access point.
  • Coverage Exception—Minimum number of clients on an access point with an RSSI value at or below the data or voice RSSI threshold to trigger a coverage hole exception.
  • Coverage Level—Percentage of clients on an access point that are experiencing a low signal level but cannot roam to another access point. If an access point has more number of such clients than the configured coverage level it triggers a coverage hole event.

**Prerequisites for Configuring RF Profiles**

Once you create an AP group and apply RF profiles or modify an existing AP group, the new settings are in effect and the following rules become effective:

• The same RF profile must be applied and present on every controller of the AP group or the action will fail for that controller.

• You can assign the same RF profile to more than one AP group.
Configuring an RF Profile (GUI)

**Step 1** Choose **Wireless > RF Profiles** to open the RF profiles page.

**Step 2** To configure the out-of-box status for all RF profiles, select or unselect the **Enable Out Of Box** check box.

**Step 3** Click **New**.

**Step 4** Enter the RF Profile Name and choose the radio band.

**Step 5** Click **Apply** to configure the customizations of power and data rate parameters.

**Step 6** In the **General** tab, enter the description for the RF profile in the Description text box.

**Step 7** In the **802.11** tab, configure the data rates to be applied to the APs of this profile.

**Step 8** In the **RRM** tab, do the following:

a) In the TPC area, configure the Maximum and Minimum Power Level Assignment, that is the maximum and minimum power that the APs in this RF profile are allowed to use.

b) In the TPC area, configure a custom TPC power threshold for either Version 1 or Version 2 of TPC.

   **Note** Only one version of TPC can be operable for RRM on a given controller Version 1 and Version 2 are not interoperable within the same RF profile. If you select a threshold value for TPCv2 and it is not in the chosen TPC algorithm for the RF profile, this value will be ignored.

c) In the Coverage Hole Detection area, configure the voice and data RSSI.

d) In the Coverage Exception text box, enter the number for clients.

e) In the Coverage Level text box, enter the percentage.

**Step 9** In the **High Density** tab, do the following:

a) In the High Density Parameters area, enter the maximum number of clients to be allowed per AP radio and the client trap threshold value.

b) In the Multicast Parameters area, choose the data rates from the Multicast Data Rates drop-down list.

**Step 10** In the **Client Distribution** tab, do the following:

a) In the Load Balancing area, enter the client window size and the denial count.

   The window size becomes part of the algorithm that determines whether an access point is too heavily loaded to accept more client associations:

   \[
   \text{load-balancing window} + \text{client associations on AP with the lightest load} = \text{load-balancing threshold}
   \]

   In the group of access points accessible to a client device, each access point has a different number of client associations. The access point with the lowest number of clients has the lightest load. The client window size plus the number of clients on the access point with the lightest load forms the threshold. Access points with more client associations than this threshold is considered busy, and clients can associate only to access points with client counts lower than the threshold.

   The denial count sets the maximum number of association denials during load balancing.

b) In the Band Select area, select or unselect the **Probe Response** check box.

   **Note** The Band Select configurations are available only for the 802.11b/g RF profiles.

c) In the Cycle Count text box, enter a value that sets the number of suppression cycles for a new client. The default count is 2.

d) In the Cycle Threshold text box, enter a time period in milliseconds that determines the time threshold during which new probe requests from a client from a new scanning cycle. The default cycle threshold is 200 milliseconds.
e) In the Suppression Expire textbox, enter a time period after which the 802.11 b/g clients become new and are subject to probe response suppression.

f) In the Dual Band Expire textbox, enter a time period after which the dual band clients become new and are subject to probe response suppression.

g) In the Client RSSI textbox, enter the minimum RSSI for a client to respond to a probe.

Step 11 Click Apply to commit your changes.

Step 12 Click Save Configuration to save your changes.

---

### Configuring an RF Profile (CLI)

**Step 1**
To configure the out-of-box status for all RF profiles, enter this command:
```bash
config rf-profile out-of-box {enable | disable}
```

**Step 2**
To create or delete an RF profile, enter this command:
```bash
config rf-profile {create {802.11a | 802.11b} | delete} profile-name
```

**Step 3**
To specify a description for the RF profile, enter this command:
```bash
config rf-profile description text profile-name
```

**Step 4**
To configure the data rates to be applied to the APs of this profile, enter this command:
```bash
config rf-profile data-rates {802.11a | 802.11b} {disabled | mandatory | supported} rate profile-name
```

**Step 5**
To configure the maximum and minimum power level assignment, that is the maximum and minimum power that the APs in this RF profile are allowed to use, enter this command:
```bash
config rf-profile {tx-power-max | tx-power-min} power-value profile-name
```

**Step 6**
To configure a custom TPC power threshold for either Version1 or Version 2 of TPC, enter this command:
```bash
config rf-profile {tx-power-control-thresh-v1 | tx-power-control-thresh-v2} power-threshold profile-name
```

**Step 7**
To configure the coverage hole detection parameters:

a) To configure the coverage data, enter this command:
```bash
config rf-profile coverage data value-in-dBm profile-name
```

b) To configure the minimum client coverage exception level, enter this command:
```bash
config rf-profile coverage exception clients profile-name
```

c) To configure the coverage exception level percentage, enter this command:
```bash
config rf-profile coverage level percentage-value profile-name
```

d) To configure the coverage of voice, enter this command:
```bash
config rf-profile coverage voice value-in-dBm profile-name
```

**Step 8**
To configure the maximum number of clients to be allowed per AP radio, enter this command:
```bash
config rf-profile max-clients num-of-clients profile-name
```

**Step 9**
To configure the client trap threshold value, enter this command:
```bash
config rf-profile client-trap-threshold threshold-value profile-name
```
Step 10  To configure multicast, enter this command:
```
config rf-profile multicast data-rate rate profile-name
```

Step 11  To configure load balancing, enter this command:
```
config rf-profile load-balancing {window num-of-clients | denial value} profile-name
```

Step 12  To configure band select:

 a) To configure the band select cycle count, enter this command:
```
config rf-profile band-select cycle-count max-num-of-cycles profile-name
```

 b) To configure the cycle threshold, enter this command:
```
config rf-profile band-select cycle-threshold time-in-milliseconds profile-name
```

 c) To configure the expiry of the band select, enter this command:
```
config rf-profile band-select expire {dual-band | suppression} time-in-seconds profile-name
```

 d) To configure the probe response, enter this command:
```
config rf-profile band-select probe-response {enable | disable} profile-name
```

 e) To configure the minimum RSSI for a client to respond to a probe, enter this command:
```
config rf-profile band-select client-rssi value-in-dBm profile-name
```

---

**Applying an RF Profile to AP Groups (GUI)**

**Step 1**  Choose **WLANs > Advanced > AP Groups** to open the AP Groups page.

**Step 2**  Click the AP Group Name to open the AP Group > Edit page.

**Step 3**  Click the **RF Profile** tab to configure the RF profile details. You can choose an RF profile for each band (802.11a/802.11b) or you can choose just one or none to apply to this group.

**Note**  Until you choose the APs and add them to the new group, no configurations are applied. You can save the new configuration as is, but no profiles are applied. Once you choose the APs to move the AP group, the process of moving the APs into the new group reboots the APs and the configurations for the RF profiles are applied to the APs in that AP group.

**Step 4**  Click the **APs** tab and choose the APs to add to the AP group.

**Step 5**  Click **Add APs** to add the selected APs to the AP group. A warning message displays that the AP group will reboot the APs will rejoin the controller.

**Note**  APs cannot belong to two AP groups at once.

**Step 6**  Click **Apply**. The APs are added to the AP Group.
Applying RF Profiles to AP Groups (CLI)

What to Do Next

Use this command to apply RF profiles to AP groups:

- `config wlan apgroup profile-mapping {add | delete} ap-group-name rf-profile-name`

Configuring Web Redirect with 802.1X Authentication

Information About Web Redirect with 802.1X Authentication

You can configure a WLAN to redirect a user to a particular web page after 802.1X authentication has completed successfully. You can configure the web redirect to give the user partial or full access to the network.

Conditional Web Redirect

If you enable conditional web redirect, the user can be conditionally redirected to a particular web page after 802.1X authentication has completed successfully. You can specify the redirect page and the conditions under which the redirect occurs on your RADIUS server. Conditions might include the user’s password reaching expiration or the user needing to pay his or her bill for continued usage.

If the RADIUS server returns the Cisco AV-pair "url-redirect," then the user is redirected to the specified URL upon opening a browser. If the server also returns the Cisco AV-pair "url-redirect-acl," the specified access control list (ACL) is installed as a preauthentication ACL for this client. The client is not considered fully authorized at this point and can only pass traffic allowed by the preauthentication ACL.

After the client completes a particular operation at the specified URL (for example, changing a password or paying a bill), the client must reauthenticate. When the RADIUS server does not return a "url-redirect," the client is considered fully authorized and allowed to pass traffic.

Note

The conditional web redirect feature is available only for WLANs that are configured for 802.1X or WPA+WPA2 Layer 2 security.

After you configure the RADIUS server, you can then configure the conditional web redirect on the controller using either the controller GUI or CLI.

Splash Page Web Redirect

If you enable splash page web redirect, the user is redirected to a particular web page after 802.1X authentication has completed successfully. After the redirect, the user has full access to the network. You can specify the redirect page on your RADIUS server and the corresponding ACL to allow access to this server in "url-redirect-acl". If the RADIUS server returns the Cisco AV-pair "url-redirect," then the user is redirected to the specified URL upon opening a browser. The client is considered fully authorized at this point and is allowed to pass traffic, even if the RADIUS server does not return a "url-redirect."
The splash page web redirect feature is available only for WLANs that are configured for 802.1X or WPA+WPA2 Layer 2 security with 802.1x key management. Preshared key management is not supported with any Layer 2 security method.

Suppose there are backend applications running on the wireless clients and they use HTTP or HTTPS port for their communication. If the applications start communicating before the actual web page is opened, the redirect functionality does not work with web passthrough.

After you configure the RADIUS server, you can then configure the splash page web redirect on the controller using either the controller GUI or CLI.

### Configuring the RADIUS Server (GUI)

**Step 1**  
From the CiscoSecure ACS main menu, choose **Group Setup**.

**Step 2**  
Click **Edit Settings**.

**Step 3**  
From the Jump To drop-down list, choose **RADIUS (Cisco IOS/PIX 6.0)**.

**Step 4**  
Select the **[009][001] cisco-av-pair** check box.

**Step 5**  
Enter the following Cisco AV-pairs in the **[009][001] cisco-av-pair** edit box to specify the URL to which the user is redirected and, if configuring conditional web redirect, the conditions under which the redirect takes place, respectively:

- `url-redirect=http://url`
- `url-redirect-acl=acl_name`

**Note**  
These instructions are specific to the CiscoSecure ACS; however, they should be similar to those for other RADIUS servers.
Configuring Web Redirect

Configuring Web Redirect (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the desired WLAN. The WLANs > Edit page appears.
Step 3  Choose the Security and Layer 2 tabs to open the WLANs > Edit (Security > Layer 2) page.
Step 4  From the Layer 2 Security drop-down list, choose 802.1X or WPA+WPA2.
Step 5  Set any additional parameters for 802.1X or WPA+WPA2.
Step 6  Choose the Layer 3 tab to open the WLANs > Edit (Security > Layer 3) page.
Step 7  From the Layer 3 Security drop-down list, choose None.
Step 8  Check the Web Policy check box.
Step 9  Choose one of the following options to enable conditional or splash page web redirect: Conditional Web Redirect or Splash Page Web Redirect. The default value is disabled for both parameters.
Step 10 If the user is to be redirected to a site external to the controller, choose the ACL that was configured on your RADIUS server from the Preauthentication ACL drop-down list.
Step 11 Click Apply to commit your changes.
Step 12 Click Save Configuration to save your changes.

Configuring Web Redirect (CLI)

Step 1  Enable or disable conditional web redirect by entering this command:
        config wlan security cond-web-redir {enable | disable} wlan_id
Step 2  Enable or disable splash page web redirect by entering this command:
        config wlan security splash-page-web-redir {enable | disable} wlan_id
Step 3  Save your settings by entering this command:
        save config
Step 4  See the status of the web redirect features for a particular WLAN by entering this command:
        show wlan wlan_id
        Information similar to the following appears:

        WLAN Identifier................................. 1
        Profile Name..................................... test
        Network Name (SSID).............................. test
        ...
        Web Based Authentication...................... Disabled
Disabling Accounting Servers per WLAN (GUI)

Note
Disabling accounting servers disables all accounting operations and prevents the controller from falling back to the default RADIUS server for the WLAN.

Step 1
Choose WLANs to open the WLANs page.
Step 2
Click the ID number of the WLAN to be modified. The WLANs > Edit page appears.
Step 3
Choose the Security and AAA Servers tabs to open the WLANs > Edit (Security > AAA Servers) page.
Step 4
Unselect the Enabled check box for the Accounting Servers.
Step 5
Click Apply to commit your changes.
Step 6
Click Save Configuration to save your changes.

Disabling Coverage Hole Detection per WLAN

Note
Coverage hole detection is enabled globally on the controller.

Note
You can disable coverage hole detection on a per-WLAN basis. When you disable coverage hole detection on a WLAN, a coverage hole alert is still sent to the controller, but no other processing is done to mitigate the coverage hole. This feature is useful for guest WLANs where guests are connected to your network for short periods of time and are likely to be highly mobile.
Disabling Coverage Hole Detection on a WLAN (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the profile name of the WLAN to be modified. The WLANs > Edit page appears.
Step 3  Choose the Advanced tab to display the WLANs > Edit (Advanced) page.
Step 4  Unselect the Coverage Hole Detection Enabled check box.
   Note  OEAP600 Series Access Points do not support coverage hole detection.
Step 5  Click Apply.
Step 6  Click Save Configuration.

Disabling Coverage Hole Detection on a WLAN (CLI)

Step 1  Disable coverage hole detection on a by entering this command:
   config wlan chd wlan-id disable
   Note  OEAP 600 Series Access Points do not support Coverage Hole detection.
Step 2  Save your settings by entering this command:
   save config
Step 3  See the coverage hole detection status for a particular WLAN by entering this command:
   show wlan wlan-id
   Information similar to the following appears:

   WLAN Identifier................................. 2
   Profile Name..................................... wlan2
   Network Name (SSID)............................ 2
   . . .
   CHD per WLAN................................. Disabled
Configuring NAC Out-of-Band Integration

Information About NAC Out-of-Band Integration

The Cisco NAC Appliance, also known as Cisco Clean Access (CCA), is a network admission control (NAC) product that enables network administrators to authenticate, authorize, evaluate, and remediate wired, wireless, and remote users and their machines prior to allowing users onto the network. NAC identifies whether machines are compliant with security policies and repairs vulnerabilities before permitting access to the network.

The NAC appliance is available in two modes: in-band and out-of-band. Customers can deploy both modes if desired, each geared toward certain types of access (in-band for supporting wireless users and out-of-band for supporting wired users, for example).

To implement the NAC out-of-band feature on the controller, you must enable NAC support on the WLAN or guest LAN and then map this WLAN or guest LAN to an interface that is configured with a quarantine VLAN (untrusted VLAN) and an access VLAN (trusted VLAN). When a client associates and completes Layer 2 authentication, the client obtains an IP address from the access VLAN subnet, but the client state is Quarantine. While deploying the NAC out-of-band feature, be sure that the quarantine VLAN is allowed only between the Layer 2 switch on which the controller is connected and the NAC appliance and that the NAC appliance is configured with a unique quarantine-to-access VLAN mapping. Client traffic passes into the quarantine VLAN, which is trunked to the NAC appliance. After posture validation is completed, the client is prompted to take remedial action. After cleaning is completed, the NAC appliance updates the controller to change the client state from Quarantine to Access.

The link between the controller and the switch is configured as a trunk, enabling the quarantine VLAN (110) and the access VLAN (10). On the Layer 2 switch, the quarantine traffic is trunked to the NAC appliance while the access VLAN traffic goes directly to the Layer 3 switch. Traffic that reaches the quarantine VLAN on the NAC appliance is mapped to the access VLAN based on a static mapping configuration.

Figure 31: Example of NAC Out-of-Band Integration
Guidelines and Limitations

Configuring NAC Out-of-Band Integration

Configuring NAC Out-of-Band Integration (GUI)

Step 1
Configure the quarantine VLAN for a dynamic interface as follows:

a) Choose **Controller > Interfaces** to open the Interfaces page.
b) Click **New** to create a new dynamic interface.
c) In the Interface Name text box, enter a name for this interface, such as "quarantine."
d) In the VLAN ID text box, enter a nonzero value for the access VLAN ID, such as "10."
e) Click **Apply** to commit your changes. The **Interfaces > Edit** page appears.
f) Select the **Quarantine** check box and enter a nonzero value for the quarantine VLAN ID, such as "110."

**Note**
We recommend that you configure unique quarantine VLANs throughout your network. If multiple controllers are configured in the same mobility group and access interfaces on all controllers are in the same subnet, it is mandatory to have the same quarantine VLAN if there is only one NAC appliance in the network. If multiple controllers are configured in the same mobility group and access interfaces on all controllers are in different subnets, it is mandatory to have different quarantine VLANs if there is only one NAC appliance in the network.

g) Configure any remaining text boxes for this interface, such as the IP address, netmask, and default gateway.
h) Click **Apply** to save your changes.

Step 2
Configure NAC out-of-band support on a WLAN or guest LAN as follows:

a) Choose **WLANs** to open the WLANs page.
b) Click the ID number of the desired WLAN or guest LAN. The **WLANs > Edit** page appears.
c) Choose the **Advanced** tab to open the **WLANs > Edit (Advanced)** page.
d) Configure NAC out-of-band support for this WLAN or guest LAN by selecting the **NAC State** check box. To disable NAC out-of-band support, leave the check box unselected, which is the default value.
e) Click **Apply** to commit your changes.

Step 3
Configure NAC out-of-band support for a specific access point group as follows:

a) Choose **WLANs > Advanced > AP Groups** to open the AP Groups page.
b) Click the name of the desired access point group.
c) Choose the **WLANs** tab to open the **AP Groups > Edit (WLANs)** page.
d) Click **Add New** to assign a WLAN to this access point group. The Add New section appears at the top of the page.
e) From the WLAN SSID drop-down list, choose the SSID of the WLAN.
f) From the Interface Name drop-down list, choose the interface to which you want to map the access point group.

Choose the quarantine VLAN if you plan to enable NAC out-of-band support.

g) To enable NAC out-of-band support for this access point group, select the **NAC State** check box. To disable NAC out-of-band support, leave the check box unselected, which is the default value.
h) Click **Add** to add this WLAN to the access point group. This WLAN appears in the list of WLANs assigned to this access point group.
If you ever want to remove this WLAN from the access point group, hover your cursor over the blue drop-down arrow for the WLAN and choose Remove.

Step 4 Click Save Configuration to save your changes.

Step 5 See the current state of the client (Quarantine or Access) as follows:

a) Choose Monitor > Clients to open the Clients page.

b) Click the MAC address of the desired client to open the Clients > Detail page. The NAC state appears under the Security Information section.

Note The client state appears as “Invalid” if the client is probing, has not yet associated to a WLAN, or cannot complete Layer 2 authentication.

Configuring NAC Out-of-Band Integration (CLI)

Step 1 Configure the quarantine VLAN for a dynamic interface by entering this command:

```
config interface quarantine vlan interface_name vlan_id
```

Note You must configure a unique quarantine VLAN for each interface on the controller.

To disable the quarantine VLAN on an interface, enter 0 for the VLAN ID.

Step 2 Enable or disable NAC out-of-band support for a WLAN or guest LAN by entering this command:

```
config {wlan | guest-lan} nac {enable | disable} {wlan_id | guest_lan_id}
```

Step 3 Enable or disable NAC out-of-band support for a specific access point group by entering this command:

```
config wlan apgroup nac {enable | disable} group_name wlan_id
```

Step 4 Save your changes by entering this command:

```
save config
```

Step 5 See the configuration of a WLAN or guest LAN, including the NAC state by entering this command:

```
show {wlan wlan_id | guest-lan guest_lan_id}
```

Information similar to the following appears:

```
WLAN Identifier................................. 1
Profile Name..................................... wlan
Network Name (SSID)............................ wlan
Status........................................... Disabled
MAC Filtering.................................... Disabled
Broadcast SSID.................................. Enabled
AAA Policy Override............................ Disabled
Network Admission Control

    NAC-State.................................... Enabled
    Quarantine VLAN............................ 110
```

Step 6 See the current state of the client (either Quarantine or Access) by entering this command:
show client detailed client_mac
Information similar to the following appears:

Client's NAC state.................................. QUARANTINE

Note The client state appears as "Invalid" if the client is probing, has not yet associated to a WLAN, or cannot complete Layer 2 authentication.

Configuring Passive Clients

Information About Passive Clients

Passive clients are wireless devices, such as scales and printers that are configured with a static IP address. These clients do not transmit any IP information such as IP address, subnet mask, and gateway information when they associate with an access point. As a result, when passive clients are used, the controller never knows the IP address unless they use the DHCP.

Wireless LAN controllers currently act as a proxy for ARP requests. Upon receiving an ARP request, the controller responds with an ARP response instead of passing the request directly to the client. This scenario has two advantages:

• The upstream device that sends out the ARP request to the client will not know where the client is located.

• Power for battery-operated devices such as mobile phones and printers is preserved because they do not have to respond to every ARP requests.

Since the wireless controller does not have any IP related information about passive clients, it cannot respond to any ARP requests. The current behavior does not allow the transfer of ARP requests to passive clients. Any application that tries to access a passive client will fail.

The passive client feature enables the ARP requests and responses to be exchanged between wired and wireless clients. This feature when enabled, allows the controller to pass ARP requests from wired to wireless clients until the desired wireless client gets to the RUN state.

Note For FlexConnect APs with locally switched WLANs, passive client feature enables the broadcast of ARP requests and the APs respond on behalf of the client.

Restrictions for Passive Clients

• The interface associated to the WLAN must have a VLAN tagging.

• GARP forwarding must to be enabled using the show advanced hotspot command.
Client ARP forwarding will not work if any one of the two scenarios, mentioned above, is not configured.

- The passive client feature is not supported with the AP groups and FlexConnect centrally switched WLANs.

# Configuring Passive Clients (GUI)

## Before You Begin

To configure passive clients, you must enable multicast-multicast or multicast-unicast mode.

### Step 1
Choose Controller > General to open the General page.

### Step 2
Choose one of the following options from the AP Multicast Mode drop-down list:

- **Unicast**—Configures the controller to use the unicast method to send multicast packets. This is the default value.
- **Multicast**—Configures the controller to use the multicast method to send multicast packets to a CAPWAP multicast group.

### Step 3
From the AP Multicast Mode drop-down list, choose Multicast. The Multicast Group Address text box is displayed.

### Step 4
In the Multicast Group Address text box, enter the IP address of the multicast group.

### Step 5
Click Apply.

### Step 6
Enable global multicast mode as follows:

a) Choose Controller > Multicast.

b) Select the Enable Global Multicast Mode check box.

# Enabling the Multicast-Multicast Mode (GUI)

## Before You Begin

To configure passive clients, you must enable multicast-multicast or multicast-unicast mode.

### Step 1
Choose Controller > General to open the General page.

### Step 2
Choose one of the following options from the AP Multicast Mode drop-down list:

- **Unicast**—Configures the controller to use the unicast method to send multicast packets. This is the default value.
- **Multicast**—Configures the controller to use the multicast method to send multicast packets to a CAPWAP multicast group.
Step 3  From the AP Multicast Mode drop-down list, choose Multicast. The Multicast Group Address text box is displayed.  
  
  Note  It is not possible to configure the AP multicast mode for Cisco Flex 7500 Series controllers because only unicast is supported.

Step 4  In the Multicast Group Address text box, enter the IP address of the multicast group.

Step 5  Click Apply.

Step 6  Enable global multicast mode as follows:  
  a) Choose Controller > Multicast.  
  b) Select the Enable Global Multicast Mode check box.

---

### Enabling the Global Multicast Mode on Controllers (GUI)

Step 1  Choose Controller > Multicast to open the Multicast page.  
  
  Note  The Enable IGMP Snooping text box is highlighted only when you enable the Enable Global Multicast mode.  
  The IGMP Timeout (seconds) text box is highlighted only when you enable the Enable IGMP Snooping text box.

Step 2  Select the Enable Global Multicast Mode check box to enable the multicast mode. This step configures the controller to use the multicast method to send multicast packets to a CAPWAP multicast group.  
  
  Note  It is not possible to configure Global Multicast Mode for Cisco Flex 7500 Series Controllers.

Step 3  Select the Enable IGMP Snooping check box to enable the IGMP snooping. The default value is disabled.

Step 4  In the IGMP Timeout text box to set the IGMP timeout, enter a value between 30 and 7200 seconds.

Step 5  Click Apply to commit your changes.

---

### Enabling the Passive Client Feature on the Controller (GUI)

Step 1  Choose WLANs > WLANs > WLAN ID to open the WLANs > Edit page. By default, the General tab is displayed.

Step 2  Choose the Advanced tab.

Step 3  Select the Passive Client check box to enable the passive client feature.

Step 4  Click Apply to commit your changes.
Configuring Passive Clients (CLI)

**Step 1** Enable multicasting on the controller by entering this command:

```
config network multicast global enable
```

The default value is disabled.

**Step 2** Configure the controller to use multicast to send multicast to an access point by entering this command:

```
config network multicast mode multicast multicast_group_IP_address
```

**Step 3** Configure passive client on a wireless LAN by entering this command:

```
config wlan passive-client {enable | disable} wlan_id
```

**Step 4** Configure a WLAN by entering this command:

```
config wlan
```

**Step 5** Save your changes by entering this command:

```
save config
```

**Step 6** Display the passive client information on a particular WLAN by entering this command:

```
show wlan 2
```

**Step 7** Verify if the passive client is associated correctly with the AP and if the passive client has moved into the DHCP required state at the controller by entering this command:

```
debug client mac_address
```

**Step 8** Display the detailed information for a client by entering this command:

```
show client detail mac_address
```

**Step 9** Check if the client moves into the run state, when a wired client tries to contact the client by entering this command:

```
debug client mac_address
```

**Step 10** Configure and check if the ARP request is forwarded from the wired side to the wireless side by entering this command:

```
debug arp all enable
```

**Note** Cisco WLC detects duplicate IP addresses based on the ARP table, and not based on the VLAN information. If two clients in different VLANs are using the same IP address, Cisco WLC reports IP conflict and sends GARP. This is not limited to two wired clients, but also for a wired client and a wireless client.

---

Configuring Client Profiling

**Information About Client Profiling**

When a client tries to associate with a WLAN, it is possible to determine the client type from the information received in the process. The controller acts as the collector of the information and sends the ISE with the required data in an optimal form. Local Client profiling (DHCP and HTTP) is enabled at WLAN level. Clients on the WLANS will be profiled as soon as profiling is enabled.
Wireless LAN Controller has been enhanced with some of these following capabilities:

- WLC does profiling of devices based on protocols like HTTP, DHCP, etc. to identify the end devices on the network.
- You can configure device-based policies and enforce per user or per device end points, and policies applicable per device.
- WLC displays statistics based on per user or per device end points, and policies applicable per device.

Profiling can be based on:

- Role, defining the user type or the user group to which the user belongs.
- Device type, such as Windows machine, Smart Phone, iPad, iPhone, Android, etc.
- Username/ password pair.
- Location, based on the AP group to which the endpoint is connected
- Time of the day, based on what time of the day the endpoint is allowed on the network.
- EAP type, to check what EAP method the client uses to get connected.

Policing is decided based on a profile which are:

- VLAN
- QoS Level
- ACL
- Session timeout value

**Restrictions for Configuring Client Profiling**

- Profiling is not supported for clients in the following scenarios:
  - Clients associating with FlexConnect mode APs in Standalone mode.
  - Clients associating with FlexConnect mode APs when local authentication is done with local switching is enabled.
  - Wired clients behind the WGB will not be profiled and policy action will not be done.

- With profiling enabled for local switching FlexConnect mode APs, only VLAN override is supported as an AAA override attribute.
- While the controller parses the DHCP profiling information every time the client sends a request, the profiling information is sent to ISE only once.
- Custom profiles cannot be created for this release.
- This release contains 88 pre-existing policies where CLI is check only except if you create a policy.
- When local profiling is enabled radius profiling is not allowed on a particular WLAN.
- Only the first policy rule that matches is applied.
• Only 16 policies per WLAN can be configured and globally 16 policies can be allowed.
• Policy action is done only after L2/L3 authentication is complete or when the device sends http traffic and gets the device profiled. Profiling and policing actions will happen more than once per client.
• If AAA override is enabled and if you get any AAA attributes from the AAA server other than role type, configured policy does not apply since the AAA override attributes have a higher precedence.

Configuring Client Profiling

Configuring Client Profiling (GUI)

Step 1 Choose WLANs to open the WLANs page.
Step 2 Click the WLAN ID. The WLANs > Edit page appears.
Step 3 Click the Advanced tab.
Step 4 In the Client Profiling area, do the following:
   a) To profile clients based on HTTP, select the HTTP Profiling check box.
Step 5 Click Apply.
Step 6 Click Save Configuration.

Configuring Client Profiling (CLI)

• Enable or disable client profiling in RADIUS mode for a WLAN based on HTTP, DHCP, or both by entering this command:

  config wlan profiling radius {dhcp | http | all} {enable | disable} wlan-id

  Note  Use the all parameter to configure client profiling based on both DHCP and HTTP.

• To see the status of client profiling on a WLAN, enter the following command:

  show wlan wlan-id

• To enable or disable debugging of client profiling, enter the following command:

  debug profiling {enable | disable}
Configuring Per-WLAN RADIUS Source Support

Information About Per-WLAN RADIUS Source Support

The controller sources RADIUS traffic from the IP address of its management interface unless the configured RADIUS server exists on a VLAN accessible via one of the controller Dynamic interfaces. If a RADIUS server is reachable via a controller Dynamic interface, RADIUS requests to this specific RADIUS server will be sourced from the controller via the corresponding Dynamic interface.

By default, RADIUS packets sourced from the controller will set the NAS-IP-Address attribute to that of the management interface's IP Address, regardless of the packet's source IP Address (Management or Dynamic, depending on topology).

When you enable per-WLAN RADIUS source support (Radius Server Overwrite interface) the NAS-IP-Address attribute is overwritten by the controller to reflect the sourced interface. Also, RADIUS attributes are modified accordingly to match the identity. This feature virtualizes the controller on the per-WLAN RADIUS traffic, where each WLAN can have a separate layer 3 identity. This feature is useful in deployments that integrate with ACS Network Access Restrictions and Network Access Profiles.

To filter WLANs, use the callStationID that is set by RFC 3580 to be in the APMAC:SSID format. You can also extend the filtering on the authentication server to be on a per-WLAN source interface by using the NAS-IP-Address attribute.

You can combine per-WLAN RADIUS source support with the normal RADIUS traffic source and some WLANs that use the management interface and others using the per-WLAN dynamic interface as the address source.

Restrictions for Per-WLAN RADIUS Source Support

- callStationID is always in the APMAC:SSID format to comply with 802.1X over RADIUS RFC. This is also a legacy behavior. Web-auth can use different formats available in the `config radius callStationIDType` command.

Configuring Per-WLAN RADIUS Source Support (CLI)

Step 1
Enter the `config wlan disable wlan-id` command to disable the WLAN.

Step 2
Enter the following command to enable or disable the per-WLAN RADIUS source support:
```
config wlan radius_server overwrite-interface {enable | disable} wlan-id
```

Note: When enabled, the controller uses the interface specified on the WLAN configuration as identity and source for all RADIUS related traffic on that WLAN. When disabled, the controller uses the management interface as the identity in the NAS-IP-Address attribute. If the RADIUS server is on a directly connected dynamic interface, the RADIUS traffic will be sourced from that interface. Otherwise, the management IP address is used. In all cases, the NAS-IP-Address attribute remains the management interface, unless the feature is enabled.

Step 3
Enable either an AP group's interface or a WLAN's interface for RADIUS packet routing by entering these commands:
• AP group's interface—`config wlan radius_server overwrite-interface apgroup wlan-id`
• WLAN's interface—`config wlan radius_server overwrite-interface wlan wlan-id`

**Note**  
Valid WLAN ID range is between 1 and 16.

**Step 4**  
Enter the `config wlan enable wlan-id` command to enable the WLAN.

**Note**  
You can filter requests on the RADIUS server side using CiscoSecure ACS. You can filter (accept or reject) a request depending on the NAS-IP-Address attribute through a Network Access Restrictions rule. The filtering to be used is the CLI/DNIS filtering.

---

### Monitoring the Status of Per-WLAN RADIUS Source Support (CLI)

To see if the feature is enabled or disabled, enter the following command:

```
show wlan wlan-id
```

**Example**
The following example shows that the per-WLAN RADIUS source support is enabled on WLAN 1.

```
show wlan 1
```

Information similar to the following is displayed:

```
WLAN Identifier.......................... 4  
Profile Name................................. example  
Network Name (SSID)......................... example  
Status......................................... Enabled  
MAC Filtering.................................. Disabled  
Broadcast SSID............................... Enabled  
AAA Policy Override.......................... Disabled  
Network Admission Control
  Radius Servers
    Authentication............................ Global Servers  
    Accounting................................ Global Servers  
    Overwrite Sending Interface.............. Enabled  
    Local EAP Authentication.................. Disabled
```

### Configuring Remote LANs

#### Information About Remote LANs

This section describes how to configure remote LANs.

#### Restrictions for Configuring Remote LANs

- Only four clients can connect to an OEAP 600 series access point through a remote LAN port. This number does not affect the fifteen WLAN limit imposed for the controller WLANs. The remote LAN client limit supports connecting a switch or hub to the remote LAN port for multiple devices or connecting
directly to a Cisco IP phone that is connected to that port. Only the first four devices can connect until one of the devices is idle for more than one minute.

- It is not possible to configure 802.1X on remote LANs through the controller GUI; configuration only through CLI is supported.

Configuring Remote LANs

Configuring a Remote LAN (GUI)

**Step 1** Choose **WLANs** to open the WLANs page. This page lists all of the WLANs and remote LANs currently configured on the controller. For each WLAN, you can see its WLAN/remote LAN ID, profile name, type, SSID, status, and security policies.

The total number of WLANs/Remote LANs appears in the upper right-hand corner of the page. If the list of WLANs/Remote LANs spans multiple pages, you can access these pages by clicking the page number links.

**Note** If you want to delete a Remote LAN, hover your cursor over the blue drop-down arrow for that WLAN and choose **Remove**, or select the check box to the left of the row, choose **Remove Selected** from the drop-down list, and click **Go**. A message appears asking you to confirm your decision. If you proceed, the remote LAN is removed from any access point group to which it is assigned and from the access point’s radio.

**Step 2** Create a new Remote-LAN by choosing **Create New** from the drop-down list and clicking **Go**. The WLANs > New page appears.

**Step 3** From the Type drop-down list, choose **Remote LAN** to create a remote LAN.

**Step 4** In the Profile Name text box, enter up to 32 alphanumeric characters for the profile name to be assigned to this Remote WLAN. The profile name must be unique.

**Step 5** From the WLAN ID drop-down list, choose the ID number for this WLAN.

**Step 6** Click **Apply** to commit your changes. The **WLANs > Edit** page appears.

**Note** You can also open the WLANs > Edit page from the WLANs page by clicking the ID number of the WLAN that you want to edit.

**Step 7** Use the parameters on the General, Security, and Advanced tabs to configure this remote LAN. See the sections in the rest of this chapter for instructions on configuring specific features.

**Step 8** On the General tab, select the **Status** check box to enable this remote LAN. Be sure to leave it unselected until you have finished making configuration changes to the remote LAN.

**Note** You can also enable or disable remote LANs from the WLANs page by selecting the check boxes to the left of the IDs that you want to enable or disable, choosing **Enable Selected** or **Disable Selected** from the drop-down list, and clicking **Go**.

**Step 9** Click **Apply** to commit your changes.

**Step 10** Click **Save Configuration** to save your changes.

Configuring a Remote LAN (CLI)

- See the current configuration of the remote LAN by entering this command:
show remote-lan remote-lan-id

- Enable or disable remote LAN by entering this command:
  config remote-lan {enable | disable} remote-lan-id

- Enable or disable 802.1X authentication for remote LAN by entering this command:
  config remote-lan security 802.1X {enable | disable} remote-lan-id

  Note  The encryption on a remote LAN is always "none."

- Enable or disable local EAP with the controller as an authentication server, by entering this command:
  config remote-lan local-auth enable profile-name remote-lan-id

- If you are using an external AAA authentication server, use the following command:
  config remote-lan radius_server auth {add | delete} remote-lan-id server id
  config remote-lan radius_server auth {enable | disable} remote-lan-id
CHAPTER 8

Controlling Lightweight Access Points

This chapter contains these sections:

- Access Point Communication Protocols, page 410
- Searching for Access Points, page 417
- Searching for Access Point Radios, page 422
- Configuring Global Credentials for Access Points, page 423
- Configuring Authentication for Access Points, page 426
- Configuring Embedded Access Points, page 429
- Converting Autonomous Access Points to Lightweight Mode, page 431
- Configuring Packet Capture, page 452
- Configuring OfficeExtend Access Points, page 454
- Using Cisco Workgroup Bridges, page 469
- Using Non-Cisco Workgroup Bridges, page 475
- Configuring Backup Controllers, page 476
- Configuring High Availability, page 481
- Configuring Failover Priority for Access Points, page 489
- Configuring Access Point Retransmission Interval and Retry Count, page 491
- Configuring Country Codes, page 493
- Migrating Access Points from the -J Regulatory Domain to the -U Regulatory Domain, page 496
- Using the W56 Band in Japan, page 499
- Dynamic Frequency Selection, page 500
- Optimizing RFID Tracking on Access Points, page 501
- Configuring Probe Request Forwarding, page 503
- Retrieving the Unique Device Identifier on Controllers and Access Points, page 504
Access Point Communication Protocols

Information About Access Point Communication Protocols

Cisco lightweight access points use the IETF standard Control and Provisioning of Wireless Access Points Protocol (CAPWAP) to communicate with the controller and other lightweight access points on the network. CAPWAP, which is based on LWAPP, is a standard, interoperable protocol that enables a controller to manage a collection of wireless access points. CAPWAP is implemented in controller for these reasons:

- To provide an upgrade path from Cisco products that use LWAPP to next-generation Cisco products that use CAPWAP
- To manage RFID readers and similar devices
- To enable controllers to interoperate with third-party access points in the future

LWAPP-enabled access points can discover and join a CAPWAP controller, and conversion to a CAPWAP controller is seamless. For example, the controller discovery process and the firmware downloading process when using CAPWAP are the same as when using LWAPP. The one exception is for Layer 2 deployments, which are not supported by CAPWAP.

You can deploy CAPWAP controllers and LWAPP controllers on the same network. The CAPWAP-enabled software allows access points to join either a controller running CAPWAP or LWAPP. The only exceptions are that the Cisco Aironet 1040, 1140, 1260, 3500, and 3600 Series Access Points, which support only CAPWAP and join only controllers that run CAPWAP. For example, an 1130 series access point can join a controller running either CAPWAP or LWAPP where an 1140 series access point can join only a controller that runs CAPWAP.

The following are some guidelines that you must follow for access point communication protocols:

- If your firewall is currently configured to allow traffic only from access points using LWAPP, you must change the rules of the firewall to allow traffic from access points using CAPWAP.
- Ensure that the CAPWAP UDP ports 5246 and 5247 (similar to the LWAPP UDP ports 12222 and 12223) are enabled and are not blocked by an intermediate device that could prevent an access point from joining the controller.
- If access control lists (ACLs) are in the control path between the controller and its access points, you need to open new protocol ports to prevent access points from being stranded.
Restrictions for Access Point Communication Protocols

- On virtual controller platforms, per-client downstream rate limiting is not supported in FlexConnect central switching.

- Rate-limiting is applicable to all traffic destined to the CPU from either direction (wireless or wired). We recommend that you always run the controller with the default `config advanced rate enable` command in effect to rate limit traffic to the controller and protect against denial-of-service (DoS) attacks. You can use the `config advanced rate disable` command to stop rate-limiting of Internet Control Message Protocol (ICMP) echo responses for testing purposes. However, we recommend that you reapply the `config advanced rate enable` command after testing is complete.

- Ensure that the controllers are configured with the correct date and time. If the date and time configured on the controller precedes the creation and installation date of certificates on the access points, the access point fails to join the controller.

Configuring Data Encryption

Cisco 5500 Series Controllers enable you to encrypt CAPWAP control packets (and optionally, CAPWAP data packets) that are sent between the access point and the controller using Datagram Transport Layer Security (DTLS). DTLS is a standards-track Internet Engineering Task Force (IETF) protocol based on TLS. CAPWAP control packets are management packets exchanged between a controller and an access point while CAPWAP data packets encapsulate forwarded wireless frames. CAPWAP control and data packets are sent over separate UDP ports: 5246 (control) and 5247 (data). If an access point does not support DTLS data encryption, DTLS is enabled only for the control plane, and a DTLS session for the data plane is not established.

With Release 8.2, DTLSv1.2 for CAPWAP is not supported. The following are supported for web authentication and WebAdmin based on the configuration:

- TLSv1.2
- TLSv1.0
- SSLv3
- SSLv2

Cisco WLC supports only static configuration of gateway. Therefore, the ICMP redirect to change IP address of the gateway is not considered.

Guidelines for Data Encryption

- Cisco 1130 and 1240 series access points support DTLS data encryption with software-based encryption.
- Cisco 1040, 1140, 1250, 1260, 1530, 1550, 1600, 1700, 2600, 2700, 3500, 3600, and 3700 series access points support DTLS data encryption with hardware-based encryption.
• Cisco Aironet 1552 and 1522 outdoor access points support data DTLS.

• DTLS data encryption is not supported on Cisco Aironet 700 Series Access Points.

• DTLS data encryption is enabled automatically for OfficeExtend access points but disabled by default for all other access points. Most access points are deployed in a secure network within a company building, so data encryption is not necessary. In contrast, the traffic between an OfficeExtend access point and the controller travels through an unsecure public network, so data encryption is more important for these access points. When data encryption is enabled, traffic is encrypted at the access point before it is sent to the controller and at the controller before it is sent to the client.

• Encryption limits throughput at both the controller and the access point, and maximum throughput is desired for most enterprise networks.

• In a Cisco unified local wireless network environment, do not enable DTLS on the Cisco 1130 and 1240 access points, as it may result in severe throughput degradation and may render the APs unusable. See the OfficeExtend Access Points section for more information on OfficeExtend access points.

• You can use the controller to enable or disable DTLS data encryption for a specific access point or for all access points.

• The availability of data DTLS is as follows:

  * The Cisco 5500 Series Controller will be available with two licenses options: One that allows data DTLS without any license requirements and another image that requires a license to use data DTLS. See the Upgrading or Downgrading DTLS Images for Cisco 5500 Series Controllers section. The images for the DTLS and licensed DTLS images are as follows:

    Licensed DTLS—AS_5500_LDPE_x_x_x_x.aes
    Non licensed DTLS—AS_5500_x_x_x_x.aes

  * Cisco 2500, Cisco WiSM2—By default, these platforms do not contain DTLS. To turn on data DTLS, you must install a license. These platforms have a single image with data DTLS turned off. To use data DTLS you must have a license.

• If your controller does not have a data DTLS license and if the access point associated with the controller has DTLS enabled, the data path will be unencrypted.

• Non-Russian customers using Cisco 5508 Series Controller do not need data DTLS license. However all customers using Cisco 2500 Series Controllers, Cisco 8500 Series Controllers, WISM2, and need a data DTLS license to turn on the Data DTLS feature.

**Upgrading or Downgrading DTLS Images for Cisco 5500 Series Controllers**

---

**Step 1**

The upgrade operation fails on the first attempt with a warning indicating that the upgrade to a licensed DTLS image is irreversible.

**Note**

Do not reboot the controller after Step 1.

**Step 2**

On a subsequent attempt, the license is applied and the image is successfully updated.
Guidelines When Upgrading to or from a DTLS Image

- You cannot install a regular image (nonlicensed data DTLS) once a licensed data DTLS image is installed.
- You can upgrade from one licensed DTLS image to another licensed DTLS image.
- You can upgrade from a regular image (DTLS) to a licensed DTLS image in a two step process.
- You can use the `show sysinfo` command to verify the LDPE image, before and after the image upgrade.

Configuring Data Encryption (GUI)

Ensure that the base license is installed on the Cisco 5500 Series Controller. Once the license is installed, you can enable data encryption for the access points.

Step 1
Choose Wireless > Access Points > All APs to open the All APs page.

Step 2
Click the name of the access point for which you want to enable data encryption.

Step 3
Choose the Advanced tab to open the All APs > Details for (Advanced) page.

Step 4
Select the Data Encryption check box to enable data encryption for this access point or unselect it to disable this feature. The default value is unselected.

**Note** Changing the data encryption mode requires the access points to rejoin the controller.

Step 5
Click Apply.

Step 6
Click Save Configuration.

Configuring Data Encryption (CLI)

**Note** In images without a DTLS license, the `config` or `show` commands are not available.

To enable DTLS data encryption for access points on the controller using the controller CLI, follow these steps:

Step 1
Enable or disable data encryption for all access points or a specific access point by entering this command:

```
config ap link-encryption {enable | disable} {all | Cisco_AP}
```

The default value is disabled.

**Note** Changing the data encryption mode requires the access points to rejoin the controller.

Step 2
When prompted to confirm that you want to disconnect the access point(s) and attached client(s), enter Y.

Step 3
Enter the `save config` command to save your configuration.

Step 4
See the encryption state of all access points or a specific access point by entering this command:
show ap link-encryption {all | Cisco_AP}

This command also shows authentication errors, which tracks the number of integrity check failures, and replay errors, which tracks the number of times that the access point receives the same packet.

**Step 5**

See a summary of all active DTLS connections by entering this command:

```
show dtls connections
```

**Note** If you experience any problems with DTLS data encryption, enter the `debug dtls {all | event | trace | packet} {enable | disable}` command to debug all DTLS messages, events, traces, or packets.

---

**Viewing CAPWAP Maximum Transmission Unit Information**

See the maximum transmission unit (MTU) for the CAPWAP path on the controller by entering this command:

```
show ap config general Cisco_AP
```

The MTU specifies the maximum size of any packet (in bytes) in a transmission.

Information similar to the following appears:

```
Cisco AP Identifier.............................. 9
Cisco AP Name.................................... Maria-1250
Country code..................................... US - United States
Regulatory Domain allowed by Country............. 802.11bg:-A 802.11a:-A
AP Country code................................ US - United States
AP Regulatory Domain............................. 802.11bg:-A 802.11a:-A
Switch Port Number .............................. 1
MAC Address...................................... 00:1f:ca:bd:bc:7c
IP Address Configuration......................... DHCP
IP Address....................................... 1.100.163.193
IP NetMask....................................... 255.255.255.0
CAPWAP Path MTU.................................. 1485
```

**Debugging CAPWAP**

Use these commands to obtain CAPWAP debug information:

- `• debug capwap events {enable | disable}` — Enables or disables debugging of CAPWAP events.
- `• debug capwap errors {enable | disable}` — Enables or disables debugging of CAPWAP errors.
- `• debug capwap detail {enable | disable}` — Enables or disables debugging of CAPWAP details.
- `• debug capwap info {enable | disable}` — Enables or disables debugging of CAPWAP information.
- `• debug capwap packet {enable | disable}` — Enables or disables debugging of CAPWAP packets.
- `• debug capwap payload {enable | disable}` — Enables or disables debugging of CAPWAP payloads.
- `• debug capwap hexdump {enable | disable}` — Enables or disables debugging of the CAPWAP hexadecimal dump.
- `• debug capwap dtls-keepalive {enable | disable}` — Enables or disables debugging of CAPWAP DTLS data keepalive packets.
Controller Discovery Process

In a CAPWAP environment, a lightweight access point discovers a controller by using CAPWAP discovery mechanisms and then sends the controller a CAPWAP join request. The controller sends the access point a CAPWAP join response allowing the access point to join the controller. When the access point joins the controller, the controller manages its configuration, firmware, control transactions, and data transactions.

The following are some guidelines for the controller discovery process:

- Upgrade and downgrade paths from LWAPP to CAPWAP or from CAPWAP to LWAPP are supported. An access point with an LWAPP image starts the discovery process in LWAPP. If it finds an LWAPP controller, it starts the LWAPP discovery process to join the controller. If it does not find a LWAPP controller, it starts the discovery in CAPWAP. If the number of times that the discovery process starts with one discovery type (CAPWAP or LWAPP) exceeds the maximum discovery count and the access point does not receive a discovery response, the discovery type changes to the other type. For example, if the access point does not discover the controller in LWAPP, it starts the discovery process in CAPWAP.

- If an access point is in the UP state and its IP address changes, the access point tears down the existing CAPWAP tunnel and rejoinsthe controller.

- To configure the IP addresses that the controller sends in its CAPWAP discovery responses, use the `config network ap-discovery nat-ip-only {enable | disable}` command.

- Access points must be discovered by a controller before they can become an active part of the network. The lightweight access points support the following controller discovery processes:

  - Layer 3 CAPWAP or LWAPP discovery—This feature can be enabled on different subnets from the access point and uses either IPv4 or IPv6 addresses and UDP packets rather than the MAC addresses used by Layer 2 discovery.

  - CAPWAP Multicast Discovery—Broadcast does not exist in IPv6 address. Access point sends CAPWAP discovery message to all the controllers multicast address (FF01::18C). The controller receives the IPv6 discovery request from the AP only if it is in the same L2 segment and sends back the IPv6 discovery response.

  - Locally stored controller IPv4 or IPv6 address discovery—If the access point was previously associated to a controller, the IPv4 or IPv6 addresses of the primary, secondary, and tertiary controllers are stored in the access point’s nonvolatile memory. This process of storing controller IPv4 or IPv6 addresses on an access point for later deployment is called priming the access point.

  - DHCP server discovery using option 43—This feature uses DHCP option 43 to provide controller IPv4 addresses to the access points. Cisco switches support a DHCP server option that is typically used for this capability. For more information about DHCP option 43, see the Using DHCP Option 43 and DHCP Option 60 section.

  - DHCP server discovery using option 52—This feature uses DHCP option 52 to allow the AP to discover the IPv6 address of the controller to which it connects. As part of the DHCPv6 messages, the DHCP server provides the controllers management with an IPv6 address.

  - DNS discovery—The access point can discover controllers through your domain name server (DNS). You must configure your DNS to return controller IPv4 and IPv6 addresses in response to CISCO-LWAPP-CONTROLLER.localdomain or CISCO-CAPWAP-CONTROLLER.localdomain, where localdomain is the access point domain name.

When an access point receives an IPv4/IPv6 address and DNSv4/DNSv6 information from a DHCPv4/DHCPv6 server, it contacts the DNS to resolve
CISCO-LWAPP-CONTROLLER.localdomain or CISCO-CAPWAP-CONTROLLER.localdomain. When the DNS sends a list of controller IP addresses, which may include either IPv4 addresses or IPv6 addresses or both the addresses, the access point sends discovery requests to the controllers.

Restrictions for Controller Discovery Process

• During the discovery process, the 1040, 1140, 1260, 3500, and 3600 series access points will only query for Cisco CAPWAP Controllers. It will not query for LWAPP controllers. If you want these access points to query for both LWAPP and CAPWAP controllers then you need to update the DNS.

• Ensure that the controller is set to the current time. If the controller is set to a time that has already occurred, the access point might not join the controller because its certificate may not be valid for that time.

• To avoid downtime restart CAPWAP on AP while configuring Global HA, so that AP goes back and joins the backup primary controller. This starts a discovery with the primary controller in the background. If the discovery with primary is successful, it goes back and joins the primary again.

Verifying that Access Points Join the Controller

When replacing a controller, ensure that access points join the new controller.

Verifying that Access Points Join the Controller (GUI)

Step 1 Configure the new controller as a master controller as follows:
   a) Choose Controller > Advanced > Master Controller Mode to open the Master Controller Configuration page.
   b) Select the Master Controller Mode check box.
   c) Click Apply to commit your changes.
   d) Click Save Configuration to save your changes.

Step 2 (Optional) Flush the ARP and MAC address tables within the network infrastructure.

Step 3 Restart the access points.

Step 4 Once all the access points have joined the new controller, configure the controller not to be a master controller by unselecting the Master Controller Mode check box on the Master Controller Configuration page.

Verifying that Access Points Join the Controller (CLI)

Step 1 Configure the new controller as a master controller by entering this command:
**Searching for Access Points**

**Information About Searching for Access Points**

You can search for specific access points in the list of access points on the All APs page. To do so, you create a filter to display only access points that meet certain criteria (such as MAC address, status, access point mode, and certificate type). This feature is especially useful if your list of access points spans multiple pages, preventing you from viewing them all at once.

**Searching the AP Filter (GUI)**

**Step 1** Choose Monitor > Access Point Summary > All APs > Details to open the All APs page. This page lists all of the access points joined to the controller. For each access point, you can see its name, MAC address, uptime, status, operating mode, certificates, OfficeExtend access point status, and access point submode.

The total number of access points appears in the upper right-hand corner of the page. If the list of access points spans multiple pages, you can access these pages by clicking the page number links. Each page shows up to 20 access points.

**Step 2** Click Change Filter to open the Search AP dialog box.

**Step 3** Select one or more of the following check boxes to specify the criteria used when displaying access points:

- **MAC Address**—The MAC address of an access point.
  - **Note** When you enable the MAC Address filter, the other filters are disabled automatically. When you enable any of the other filters, the MAC Address filter is disabled automatically.

- **AP Name**—Enter the name of an access point.

- **AP Model**—Enter the model name of an access point.

- **Operating Status**—Select one or more of the following check boxes to specify the operating status of the access points:
  - **UP**—The access point is up and running.
  - **Note** When the APs are in downloading state, during which time the APs are nonfunctional due to no configuration on the APs, the WLC GUI shows these AP radios in UP state on the Monitor page.

---

*config network master-base enable*

**Step 2** (Optional) Flush the ARP and MAC address tables within the network infrastructure.

**Step 3** Restart the access points.

**Step 4** Configure the controller not to be a master controller after all the access points have joined the new controller by entering this command:

*config network master-base disable*
* **DOWN**—The access point is not operational.
* **REG**—The access point is registered to the controller.
* **DEREG**—The access point is not registered to the controller.
* **DOWNLOAD**—The controller is downloading its software image to the access point.

**• Port Number**—Enter the controller port number to which the access point is connected.

**• Admin Status**—Choose **Enabled** or **Disabled** to specify whether the access points are enabled or disabled on the controller.

**• AP Mode**—Select one or more of the following options to specify the operating mode of the access points:

  * **Local**—The default option.
  * **Note** The 600 OEAP series access point uses only local mode.

  When an access point in local mode connects to a Cisco Flex 7500 Series Controller, it does not serve clients. The access point details are available in the controller. To enable an access point to serve clients or perform monitoring-related tasks when connected to the Cisco Flex 7500 Series Controller, the access point mode must be in FlexConnect or monitor mode. Use the following command to automatically convert access points to a FlexConnect mode or monitor mode on joining the controller:

  ```
  config ap autoconvert {flexconnect | monitor | disable}
  ```

  All access points that connect to the controller will either be converted to FlexConnect mode or monitor mode depending on the configuration provided.

  * **FlexConnect**—This mode is used for 1040, 1130, 1140, 1240, 1250, 1260, 1600, 2600, 3500, 3600, and 800 access points.

  * **REAP**—This mode is the remote edge lightweight access point.

  * **Monitor**—This mode is the monitor-only mode.

  * **Rogue Detector**—This mode monitors the rogue APs on wire. It does not transmit or receive frames over the air or contain rogue APs.

    * **Note** Information about rogues that are detected is not shared between controllers. Therefore, we recommend that every controller has its own connected rogue detector AP when rogue detector APs are used.

  * **Sniffer**—The access point starts sniffing the air on a given channel. It captures and forwards all the packets from the clients on that channel to a remote machine that runs Airopeek or Wireshark (packet analyzers for IEEE 802.11 wireless LANs). It includes information on the time stamp, signal strength, packet size, and so on.

    * **Note** The Bridge option is displayed only if the AP is bridge capable.

    * **Note** If the AP mode is set to "Bridge" and the AP is not REAP capable, an error appears.

    * **Note** In the access point sniffer, the server to which the data is to be sent should be on the same VLAN as the wireless controller management VLAN otherwise an error will be displayed.

  * **Bridge**—This mode sets the AP mode to “Bridge” if you are connecting a Root AP.
SE-Connect—This mode allows you to connect to spectrum expert and it allows the access point to perform spectrum intelligence.

Note Spectrum intelligence is supported on 2600 and 3600 series access points. 1260 series access points does not support the spectrum intelligence.

Note When an access point is configured in SE-Connect mode, the access point reboots and rejoinsthe controller. Access points that are configured in this mode do not serve the client.

Flex+Bridge—The standalone mode support is applicable when the AP is in this mode.

• Certificate Type—Select one or more of the following check boxes to specify the types of certificates installed on the access points:
  - MIC—Manufactured-installed certificate
  - SSC—Self-signed certificate
  - LSC—Local significant certificate

  Note See the Authorizing Access Points section for more information about these certificate types.

• Primary S/W Version—Select this check box to enter the primary software version number

• Backup S/W Version—Select this check box to enter the secondary software version number.

Step 4 Click Apply.

Only the access points that match your search criteria appear on the All APs page, and the Current Filter parameter at the top of the page specifies the filter used to generate the list (for example, MAC Address:00:1d:e5:54:0e:e6, AP Name:pmsk-ap, Operational Status: UP, Status: Enabled, and so on).

Note If you want to remove the filters and display the entire access point list, click Clear Filter.
Monitoring the Interface Details

**Step 1**  
Choose **Monitor > Summary > All APs**. The All APs > Details page appears.

**Step 2**  
Click the **Interfaces** tab.

![Figure 32: Interfaces Tab](image)

**Step 3**  
Click on the available Interface name. The Interface Details page appears.

**Step 4**  
The Interface Details page displays the following parameter details.

**Table 20: Interfaces Parameters Details**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Name</td>
<td>Name of the access point.</td>
</tr>
<tr>
<td>Link Speed</td>
<td>Speed of the interference in Mbps.</td>
</tr>
<tr>
<td>RX Bytes</td>
<td>Total number of bytes in the error-free packets received on the interface.</td>
</tr>
<tr>
<td>RX Unicast Packets</td>
<td>Total number of unicast packets received on the interface.</td>
</tr>
<tr>
<td>RX Non-Unicast Packets</td>
<td>Total number of nonunicast or multicast packets received on the interface.</td>
</tr>
<tr>
<td>Input CRC</td>
<td>Total number of CRC error in packets while receiving on the interface.</td>
</tr>
<tr>
<td>Input Errors</td>
<td>Sum of all errors in the packets while receiving on the interface.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Input Overrun</td>
<td>Number of times the receiver hardware was incapable of handling received data to a hardware buffer because the input rate exceeded the receiver’s capability to handle that data.</td>
</tr>
<tr>
<td>Input Resource</td>
<td>Total number of resource errors in packets received on the interface.</td>
</tr>
<tr>
<td>Runts</td>
<td>Number of packets that are discarded because they are similar to the medium’s minimum packet size.</td>
</tr>
<tr>
<td>Throttle</td>
<td>Total number of times the interface advised a sending NIC that it was overwhelmed by packets being sent and to slow the pace of delivery.</td>
</tr>
<tr>
<td>Output Collision</td>
<td>Total number of packet retransmitted due to an Ethernet collision.</td>
</tr>
<tr>
<td>Output Resource</td>
<td>Resource errors in packets transmitted on the interface.</td>
</tr>
<tr>
<td>Output Errors</td>
<td>Errors that prevented the final transmission of packets out of the interface.</td>
</tr>
<tr>
<td>Operational Status</td>
<td>Operational state of the physical ethernet interface on the AP.</td>
</tr>
<tr>
<td>Duplex</td>
<td>Interface’s duplex mode.</td>
</tr>
<tr>
<td>TX Bytes</td>
<td>Number of bytes in the error-free packets transmitted on the interface.</td>
</tr>
<tr>
<td>TX Unicast Packets</td>
<td>Total number of unicast packets transmitted on the interface.</td>
</tr>
<tr>
<td>TX Non-Unicast Packets</td>
<td>Total number of nonunicast or multicast packets transmitted on the interface.</td>
</tr>
<tr>
<td>Input Aborts</td>
<td>Total number of packets aborted while receiving on the interface.</td>
</tr>
<tr>
<td>Input Frames</td>
<td>Total number of packets received incorrectly that has a CRC error and a noninteger number of octets on the interface.</td>
</tr>
<tr>
<td>Input Drops</td>
<td>Total number of packets dropped while receiving on the interface because the queue was full.</td>
</tr>
<tr>
<td>Unknown Protocol</td>
<td>Total number of packets discarded on the interface due to an unknown protocol.</td>
</tr>
<tr>
<td>Giants</td>
<td>Number of packets that are discarded because they exceeded the medium’s maximum packet size.</td>
</tr>
<tr>
<td>Interface Resets</td>
<td>Number of times that an interface has been completely reset.</td>
</tr>
<tr>
<td>Output No Buffer</td>
<td>Total number of packets discarded because there was no buffer space.</td>
</tr>
<tr>
<td>Output Underrun</td>
<td>Number of times the transmitter has been running faster than the router can handle.</td>
</tr>
</tbody>
</table>
### Searching for Access Point Radios

**Information About Searching for Access Point Radios**

You can search for specific access point radios in the list of radios on the 802.11a/n Radios page or the 802.11b/g/n Radios page. You can access these pages from the Monitor tab on the menu bar when viewing access point radios or from the Wireless tab on the menu bar when configuring access point radios. To search for specific access point radios, you create a filter to display only radios that meet certain criteria (such as radio MAC address, access point name, or CleanAir status). This feature is especially useful if your list of access point radios spans multiple pages, which prevents you from viewing them all at once.

### Searching for Access Point Radios (GUI)

**Step 1**
Perform either of the following:

- Choose **Monitor > Access Points Summary > 802.11a/n (or 802.11b/g/n) > Radios > Details** to open the 802.11a/n (or 802.11b/g/n) Radios page.

- Choose **Wireless > Access Points > Radios > 802.11a/n (or 802.11b/g/n)** to open the 802.11a/n (or 802.11b/g/n) Radios page.

These pages show all of the 802.11a/n or 802.11b/g/n access point radios that are joined to the controller and their current settings.

The total number of access point radios appears in the upper right-hand corner of the page. If the list of radios spans multiple pages, you can access these pages by clicking the page number links. Each page shows up to 25 access point radios.

**Note** In a Cisco Unified Wireless Network environment, the 802.11a/n and 802.11b/g/n radios should not be differentiated based on their Base Radio MAC addresses, as they may have the same addresses. Instead, the radios should be differentiated based on their physical addresses.

**Step 2**
Click **Change Filter** to open the **Search AP** dialog box.

**Step 3**
Select one of the following check boxes to specify the criteria used when displaying access point radios:

- **MAC Address**—Base radio MAC address of an access point radio.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Total Drops</td>
<td>Total number of packets dropped while transmitting from the interface because the queue was full.</td>
</tr>
</tbody>
</table>
• **AP Name**—Access point name.

  **Note**  When you enable the MAC address filter, the other filters are disabled automatically. When you enable any of the other filters, the MAC address filter is disabled automatically.

• **Clean Air Status**—Select one or more of the following checkboxes to specify the operating status of the access points:

  ◦ **UP**—The spectrum sensor for the access point radio is currently operational.

  ◦ **DOWN**—The spectrum sensor for the access point radio is currently not operational because an error has occurred. The most likely reason for the error is that the access point radio is disabled.

  ◦ **ERROR**—The spectrum sensor for the access point radio has crashed, making Clean Air monitoring nonoperational for this radio. We recommend rebooting the access point or disabling Clean Air functionality on the radio.

  ◦ **N/A**—The access point radio is not capable of supporting Clean Air functionality. Currently, only Cisco Aironet 3500 series access point radios can be configured for Cisco Clean Air.

---

**Step 4**  Click **Find** to commit your changes. Only the access point radios that match your search criteria appear on the 802.11a/n Radios page or the 802.11b/g/n Radios page, and the Current Filter parameter at the top of the page specifies the filter used to generate the list (for example, MAC Address:00:1e:f7:75:0a:a0 or AP Name:pmsk-ap).

  **Note**  If you want to remove the filter and display the entire access point radio list, click **Clear Filter**.

---

### Configuring Global Credentials for Access Points

#### Information About Configuring Global Credentials for Access Points

Cisco IOS access points are shipped from the factory with *Cisco* as the default enable password. This password allows users to log onto the nonprivileged mode and enter **show** and **debug** commands, which poses a security threat. The default enable password must be changed to prevent unauthorized access and to enable users to enter configuration commands from the access point’s console port.

The following are some guidelines to configure global credentials for access points:

• You can set a global username, password, and enable password that all access points that are currently joined to the controller and any that join in the future inherit as they join the controller. If desired, you can override the global credentials and assign a unique username, password, and enable password for a specific access point.

• After an access point joins the controller, the access point enables console port security, and you are prompted for your username and password whenever you log into the access point’s console port. When you log on, you are in nonprivileged mode, and you must enter the enable password in order to use the privileged mode.
The global credentials that you configure on the controller are retained across controller and access point reboots. They are overwritten only if the access point joins a new controller that is configured with a global username and password. If the new controller is not configured with global credentials, the access point retains the global username and password configured for the first controller.

You must keep track of the credentials used by the access points. Otherwise, you might not be able to log onto the console port of the access point. If you need to return the access points to the default Cisco/Cisco username and password, you must clear the controller’s configuration and the access point’s configuration to return them to factory-default settings. To clear the controller’s configuration, choose Commands > Reset to Factory Default > Reset on the controller GUI, or enter the clear config command on the controller CLI. To clear the access point’s configuration, choose Wireless > Access Points > All APs, click the AP name and click Clear All Config on the controller GUI, or enter the clear ap config Cisco_AP command on the controller CLI. To clear the access point’s configuration except its static IP address, choose Wireless > Access Points > All APs, click the AP name and click Clear Config Except Static IP, or enter the clear ap config ap-name keep-ip-config command on the controller CLI. After the access point rejoins a controller, it adopts the default Cisco/Cisco username and password.

Note Suppose you configure an indoor Cisco AP to go into the mesh mode. If you want to reset the Cisco AP to the local mode, use the test mesh mode local command.

To reset the AP hardware, choose Wireless > Access Points > All APs, click the AP name and click Reset AP Now.

Restrictions for Global Credentials for Access Points

- The controller software features are supported on all access points that have been converted to lightweight mode except the 1100 series. VxWorks access points are not supported.
- Telnet is not supported on Cisco Aironet 1830 and 1850 Series Access Points.

Configuring Global Credentials for Access Points (GUI)

Step 1 Choose Wireless > Access Points > Global Configuration to open the Global Configuration page.

Step 2 In the Username text box, enter the username that is to be inherited by all access points that join the controller.

Step 3 In the Password text box, enter the password that is to be inherited by all access points that join the controller. You can set a global username, password, and enable password that all access points inherit as they join the controller including access points that are currently joined to the controller and any that join in the future. You can override the global credentials and assign a unique username, password, and enable password for a specific access point. The following are requirements enforced on the password:

- The password should contain characters from at least three of the following classes: lowercase letters, uppercase letters, digits, and special characters.
- No character in the password can be repeated more than three times consecutively.
- The password should not contain the management username or the reverse of the username.
- The password should not contain words like Cisco, oscic, admin, nimda or any variant obtained by changing the capitalization of letters by substituting 1, |, or ! or substituting 0 for o or substituting $ for s.

Step 4 In the Enable Password text box, enter the enable password that is to be inherited by all access points that join the controller.

Step 5 Click Apply to send the global username, password, and enable password to all access points that are currently joined to the controller or that join the controller in the future.

Step 6 Click Save Configuration to save your changes.

Step 7 (Optional) Override the global credentials for a specific access point and assign a unique username, password, and enable password to this access point as follows:

a) Choose Access Points > All APs to open the All APs page.
b) Click the name of the access point for which you want to override the global credentials.
c) Choose the Credentials tab. The All APs > Details for (Credentials) page appears.
d) Select the Over-ride Global Credentials check box to prevent this access point from inheriting the global username, password, and enable password from the controller. The default value is unselected.
e) In the Username, Password, and Enable Password text boxes, enter the unique username, password, and enable password that you want to assign to this access point.

Note The information that you enter is retained across controller and access point reboots and if the access point joins a new controller.
f) Click Apply to commit your changes.
g) Click Save Configuration to save your changes.

Note If you want to force this access point to use the controller’s global credentials, unselect the Over-ride Global Credentials check box.

---

Configuring Global Credentials for Access Points (CLI)

Step 1 Configure the global username, password, and enable password for all access points currently joined to the controller as well as any access points that join the controller in the future by entering this command:

```
config ap mgmtuser add username user password password enablesecret enable_password all
```

Step 2 (Optional) Override the global credentials for a specific access point and assign a unique username, password, and enable password to this access point by entering this command:

```
config ap mgmtuser add username user password password enablesecret enable_password Cisco_AP
```

The credentials that you enter in this command are retained across controller and access point reboots and if the access point joins a new controller.

Note If you want to force this access point to use the controller’s global credentials, enter the config ap mgmtuser delete Cisco_AP command. The following message appears after you execute this command: "AP reverted to global username configuration."

Step 3 Enter the save config command to save your changes.

Step 4 Verify that global credentials are configured for all access points that join the controller by entering this command:
show ap summary

**Note** If global credentials are not configured, the Global AP User Name text box shows "Not Configured."

To view summary of specific access point you can specify the access point name. You can also use wildcard searches when filtering for access points.

**Step 5**

See the global credentials configuration for a specific access point by entering this command:

type: `show ap config general Cisco_AP`

**Note** The name of the access point is case sensitive.

**Note** If this access point is configured for global credentials, the AP User Mode text boxes shows "Automatic." If the global credentials have been overwritten for this access point, the AP User Mode text box shows "Customized."

---

### Configuring Authentication for Access Points

#### Information About Configuring Authentication for Access Points

You can configure 802.1X authentication between a lightweight access point and a Cisco switch. The access point acts as an 802.1X supplicant and is authenticated by the switch using EAP-FAST with anonymous PAC provisioning.

You can configure global authentication settings that all access points that are currently associated with the controller and any that associate in the future. You can also override the global authentication settings and assign unique authentication settings for a specific access point.

#### Restrictions for Authenticating Access Points

- The OEAP 600 Series access points do not support LEAP.
- The Bridge Protocol Data Unit (BPDU) guard should always be disabled on the switch port connected to the AP. Enabling of BPDU guard is allowed only when the switch puts the port in port fast mode.

#### Prerequisites for Configuring Authentication for Access Points

**Step 1**

If the access point is new, do the following:

a) Boot the access point with the installed recovery image.

b) If you choose not to follow this suggested flow and instead enable 802.1X authentication on the switch port connected to the access point prior to the access point joining the controller, enter this command:

```
lwapp ap dot1x username username password password
```
If you choose to follow this suggested flow and enable 802.1X authentication on the switch port after the access point has joined the controller and received the configured 802.1X credentials, you do not need to enter this command.

Note
This command is available only for access points that are running the 5.1, 5.2, 6.0, or 7.0 recovery image.

Connect the access point to the switch port.

Step 2
Install the 5.1, 5.2, 6.0, or 7.0 image on the controller and reboot the controller.

Step 3
Allow all access points to join the controller.

Step 4
Configure authentication on the controller. See the Configuring Authentication for Access Points (GUI) section or the Configuring Authentication for Access Points (CLI) section for information about configuring authentication on the controller.

Step 5
Configure the switch to allow authentication. See the Configuring the Switch for Authentication section for information about configuring the switch for authentication.

Configuring Authentication for Access Points

Configuring Authentication for Access Points (GUI)

Step 1
Choose Wireless > Access Points > Global Configuration to open the Global Configuration page.

Step 2
Under 802.1x Supplicant Credentials, select the 802.1x Authentication check box.

Step 3
In the Username text box, enter the username that is to be inherited by all access points that join the controller.

Step 4
In the Password and Confirm Password text boxes, enter the password that is to be inherited by all access points that join the controller.

Note
You must enter a strong password in these text boxes. Strong passwords have the following characteristics:

- They are at least eight characters long
- They contain a combination of uppercase and lowercase letters, numbers, and symbols
- They are not a word in any language

Step 5
Click Apply to send the global authentication username and password to all access points that are currently joined to the controller and to any that join the controller in the future.

Step 6
Click Save Configuration to save your changes.

Step 7
If desired, you can choose to override the global authentication settings and assign a unique username and password to a specific access point as follows:

a) Choose Access Points > All APs to open the All APs page.

b) Click the name of the access point for which you want to override the authentication settings.

c) Click the Credentials tab to open the All APs > Details for (Credentials) page.

d) Under 802.1x_supplicant Credentials, select the Over-ride Global Credentials check box to prevent this access point from inheriting the global authentication username and password from the controller. The default value is unselected.
e) In the Username, Password, and Confirm Password text boxes, enter the unique username and password that you want to assign to this access point.

   Note   The information that you enter is retained across controller and access point reboots and whenever the access point joins a new controller.

f) Click Apply to commit your changes.

g) Click Save Configuration to save your changes.

   Note   If you want to force this access point to use the controller’s global authentication settings, unselect the Over-ride Global Credentials check box.

---

### Configuring Authentication for Access Points (CLI)

#### Step 1
Configure the global authentication username and password for all access points currently joined to the controller as well as any access points that join the controller in the future by entering this command:

```plaintext
config ap 802.1Xuser add username ap-username password ap-password all
```

   Note   You must enter a strong password for the `ap-password` parameter. Strong passwords have the following characteristics:

   - They are at least eight characters long.
   - They contain a combination of uppercase and lowercase letters, numbers, and symbols.
   - They are not a word in any language.

#### Step 2
(Optional) Override the global authentication settings and assign a unique username and password to a specific access point. To do so, enter this command:

```plaintext
config ap 802.1Xuser add username ap-username password ap-password Cisco_AP
```

   Note   You must enter a strong password for the `ap-password` parameter. See the note in Step 1 for the characteristics of strong passwords.

The authentication settings that you enter in this command are retained across controller and access point reboots and whenever the access point joins a new controller.

   Note   If you want to force this access point to use the controller’s global authentication settings, enter the `config ap 802.1Xuser delete Cisco_AP` command. The following message appears after you execute this command: “AP reverted to global username configuration.”

#### Step 3
Enter the `save config` command to save your changes.

#### Step 4
(Optional) Disable 802.1X authentication for all access points or for a specific access point by entering this command:

```plaintext
config ap 802.1Xuser disable {all | Cisco_AP}
```

   Note   You can disable 802.1X authentication for a specific access point only if global 802.1X authentication is not enabled. If global 802.1X authentication is enabled, you can disable 802.1X for all access points only.

#### Step 5
See the authentication settings for all access points that join the controller by entering this command:

```plaintext
show ap summary
```
Information similar to the following appears:

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of APs</td>
<td>1</td>
</tr>
<tr>
<td>Global AP User Name</td>
<td>globalap</td>
</tr>
<tr>
<td>Global AP Dot1x User Name</td>
<td>globalDot1x</td>
</tr>
</tbody>
</table>

**Step 6**

See the authentication settings for a specific access point by entering this command:

```
show ap config general Cisco_AP
```

**Note**

- The name of the access point is case sensitive.
- If this access point is configured for global authentication, the AP Dot1x User Mode text boxes shows “Automatic.”
- If the global authentication settings have been overwritten for this access point, the AP Dot1x User Mode text box shows “Customized.”

---

**Configuring the Switch for Authentication**

To enable 802.1X authentication on a switch port, on the switch CLI, enter these commands:

- Switch# `configure terminal`
- Switch(config)# `dot1x system-auth-control`
- Switch(config)# `aaa new-model`
- Switch(config)# `aaa authentication dot1x default group radius`
- Switch(config)# `radius-server host ip_addr auth-port port acct-port port key key`
- Switch(config)# `interface fastethernet2/1`
- Switch(config-if)# `switchport mode access`
- Switch(config-if)# `dot1x pae authenticator`
- Switch(config-if)# `dot1x port-control auto`
- Switch(config-if)# `end`

---

**Configuring Embedded Access Points**

**Information About Embedded Access Points**

Controller software release 7.0.116.0 or later releases support the embedded access points: AP801 and AP802, which are the integrated access points on the Cisco 880 Series Integrated Services Routers (ISRs). This access points use a Cisco IOS software image that is separate from the router Cisco IOS software image. The access points can operate as autonomous access points configured and managed locally, or they can operate as
centrally managed access points that utilize the CAPWAP or LWAPP protocol. The AP801 and AP802 access points are preloaded with both an autonomous Cisco IOS release and a recovery image for the unified mode. The following are some guidelines for embedded access points:

- Before you use an AP801 or AP802 Series Lightweight Access Point with controller software release 7.0.116.0 or later releases, you must upgrade the software in the Next Generation Cisco 880 Series Integrated Services Routers (ISRs) to Cisco IOS 151-4.M or later.

  **Note** In Release 7.4, all AP modes except bridging (required for mesh) are supported for both AP801 and AP802. In Release 7.5 and later, all AP modes are supported on AP802; however, bridging is not supported on AP801.

- When you want to use the AP801 or AP802 with a controller, you must enable the recovery image for the unified mode on the access point by entering the `service-module wlan-ap 0 bootimage unified` command on the router in privileged EXEC mode.

- If the `service-module wlan-ap 0 bootimage unified` command does not work, make sure that the software license is still eligible.

- After enabling the recovery image, enter the `service-module wlan-ap 0 reload` command on the router to shut down and reboot the access point. After the access point reboots, it discovers the controller, downloads the full CAPWAP or LWAPP software release from the controller, and acts as a lightweight access point.

  **Note** To use the CLI commands mentioned above, the router must be running Cisco IOS Release 12.4(20)T or later releases.

- To support CAPWAP or LWAPP, the router must be activated with at least the Cisco Advanced IP Services IOS license-grade image. A license is required to upgrade to this Cisco IOS image on the router. For licensing information, see [http://www.cisco.com/c/en/us/td/docs/routers/access/sw_activation/SA_on_ISR.html](http://www.cisco.com/c/en/us/td/docs/routers/access/sw_activation/SA_on_ISR.html).

- After the AP801 or AP802 boots up with the recovery image for the unified mode, it requires an IP address to communicate with the controller and to download its unified image and configuration from the controller. The router can provide DHCP server functionality, the DHCP pool to reach the controller, and setup option 43 for the controller IP address in the DHCP pool configuration. Use the following configuration to perform this task:

  ```
ip dhcp pool pool_name
  network ip_address subnet_mask
dns-server ip_address
default-router ip_address
  option 43 hex controller_ip_address_in_hex
  ```

  Example:

  ```
ip dhcp pool embedded-ap-pool
  network 60.0.0.0 255.255.255.0
dns-server 171.70.168.183
default-router 60.0.0.1
  option 43 hex f104.0a0a.0a0f /* single WLC IP address(10.10.10.15) in hex format
The AP801 and AP802 802.11n radio supports lower power levels than the 802.11n radio in the Cisco Aironet 1250 series access points. The AP801 and AP802 access points store the radio power levels and pass them to the controller when the access point joins the controller. The controller uses the supplied values to limit the user’s configuration.

- The AP801 and AP802 access points can be used in FlexConnect mode.


Converting Autonomous Access Points to Lightweight Mode

Information About Converting Autonomous Access Points to Lightweight Mode

You can convert any autonomous mode Cisco Aironet access point, to lightweight mode. When you upgrade one of these access points to lightweight mode, the access point communicates with a controller and receives a configuration and software image from the controller.

See the Upgrading Autonomous Cisco Aironet Access Points to Lightweight Mode document for instructions to upgrade an autonomous access point to lightweight mode:


The following are some guidelines for converting autonomous APs to lightweight mode APs:

- All Cisco lightweight access points support 16 BSSIDs per radio and a total of 16 wireless LANs per access point. When a converted access point associates with a controller, wireless LANs with IDs 1 through 16 are pushed to the access point if the AP is part of the default AP group on the controller. You can use other AP group configurations to push other wireless LANs to the new AP.
  
  When an 802.11ac module (the RM3000AC) is added to a 3600 AP, you can have only 8 wireless LANs on the 802.11a/n/ac radio.

- Access points converted to lightweight mode must get an IP address and discover the controller using DHCP, DNS, or IP subnet broadcast.

Restrictions for Converting Autonomous Access Points to Lightweight Mode

- Access points converted to lightweight mode do not support Wireless Domain Services (WDS). Converted access points communicate only with Cisco wireless LAN controllers and cannot communicate with WDS devices. However, the controller provides functionality that is equivalent to WDS when the access point associates to it.

- After you convert an access point to lightweight mode, the console port provides read-only access to the unit.
Reverting from Lightweight Mode to Autonomous Mode

After you convert an autonomous access point to lightweight mode, you can convert the access point from a lightweight unit back to an autonomous unit by loading a Cisco IOS release that supports autonomous mode. If the access point is associated to a controller, you can use the controller to load the Cisco IOS release. If the access point is not associated to a controller, you can load the Cisco IOS release using TFTP. In either method, the access point must be able to access a TFTP server that contains the Cisco IOS release to be loaded.

Reverting to a Previous Release (CLI)

Step 1
Log on to the CLI on the controller to which the access point is associated.

Step 2
Revert from lightweight mode, by entering this command:
```
config ap tftp-downgrade tftp-server-ip-address filename access-point-name
```

Step 3
Wait until the access point reboots and reconfigure the access point using the CLI or GUI.

Reverting to a Previous Release Using the MODE Button and a TFTP Server

Step 1
Configure the PC on which your TFTP server software runs with a static IP address in the range of 10.0.0.2 to 10.0.0.30.

Step 2
Make sure that the PC contains the access point image file (such as `ap3g2-k9w7-tar.152-4.JB4.tar` for a 2700 or 3700 series access point) in the TFTP server folder and that the TFTP server is activated.

Step 3
Rename the access point image file in the TFTP server folder to `ap3g2-k9w7-tar.default` for a 2700 or a 3700 series access point.

Step 4
Connect the PC to the access point using a Category 5 (CAT5) Ethernet cable.

Step 5
Disconnect power from the access point.

Step 6
Press and hold the MODE button while you reconnect power to the access point.

Note
The MODE button on the access point must be enabled. Follow the steps in the Disabling the Reset Button on Access Points Converted to Lightweight Mode to select the status of the access point MODE button.

Step 7
Hold the MODE button until the status LED turns red (approximately 20 to 30 seconds), and release the MODE button.

Step 8
Wait until the access point reboots as indicated by all LEDs turning green followed by the Status LED blinking green.

Step 9
After the access point reboots, reconfigure the access point using the GUI or the CLI.

Authorizing Access Points

In controller software releases prior to 5.2, the controller may either use self-signed certificates (SSCs) to authenticate access points or send the authorization information to a RADIUS server (if access points have
manufactured-installed certificates (MICs)). In controller software release 5.2 or later releases, you can configure the controller to use a local significant certificate (LSC).

Access points manufactured after July 18, 2005 contain a manufactured-installed certificate (MIC). The controller can use this certificate to authenticate the access points. Alternatively, you can use an authentication list on the controller or an external RADIUS server.

**Authorizing Access Points Using SSCs**

The Control and Provisioning of Wireless Access Points protocol (CAPWAP) secures the control communication between the access point and controller by a secure key distribution requiring X.509 certificates on both the access point and controller. CAPWAP relies on provisioning of the X.509 certificates. Cisco Aironet access points shipped before July 18, 2005 do not have a MIC, so these access points create an SSC when upgraded to operate in lightweight mode. Controllers are programmed to accept local SSCs for authentication of specific access points and do not forward those authentication requests to a RADIUS server. This behavior is acceptable and secure.

**Authorizing Access Points for Virtual Controllers Using SSC**

Virtual controllers use SSC certificates instead of Manufacturing Installed Certificates (MIC) used by physical controllers. You can configure the controller to allow an AP to validate the SSC of the virtual controller. When an AP validates the SSC, the AP checks if the hash key of the virtual controller matches the hash key stored in its flash. If a match is found, the AP associates with the controller. If a match is not found, the validation fails and the AP disconnects from the controller and restarts the discovery process. By default, hash validation is enabled. An AP must have the virtual controller hash key in its flash before associating with the virtual controller. If you disable hash validation of the SSC, the AP bypasses the hash validation and directly moves to the Run state. APs can associate with a physical controller, download the hash keys and then associate with a virtual controller. If the AP is associated with a physical controller and hash validation is disabled, the AP associates with any virtual controller without hash validation. The hash key of the virtual controller can be configured for a mobility group member. This hash key gets pushed to the APs, so that the APs can validate the hash key of the controller.

**Configuring SSC (GUI)**

1. Choose **Security > Certificate > SSC** to open the Self Significant Certificates (SSC) page. The SSC device certification details are displayed.
2. Select the **Enable SSC Hash Validation** check box to enable the validation of the hash key.
3. Click **Apply** to commit your changes.

**Configuring SSC (CLI)**

1. To configure hash validation of SSC, enter this command:
config certificate ssc hash validation {enable | disable}

**Step 2**

To see the hash key details, enter this command:

`show certificate ssc`

## Authorizing Access Points Using MICs

You can configure controllers to use RADIUS servers to authorize access points using MICs. The controller uses an access point's MAC address as both the username and password when sending the information to a RADIUS server. For example, if the MAC address of the access point is 000b85229a70, both the username and password used by the controller to authorize the access point are 000b85229a70.

**Note**

The lack of a strong password by the use of the access point's MAC address should not be an issue because the controller uses MIC to authenticate the access point prior to authorizing the access point through the RADIUS server. Using MIC provides strong authentication.

**Note**

If you use the MAC address as the username and password for access point authentication on a RADIUS AAA server, do not use the same AAA server for client authentication.

## Authorizing Access Points Using LSCs

You can use an LSC if you want your own public key infrastructure (PKI) to provide better security, to have control of your certificate authority (CA), and to define policies, restrictions, and usages on the generated certificates.

The LSC CA certificate is installed on access points and controllers. You need to provision the device certificate on the access point. The access point gets a signed X.509 certificate by sending a certRequest to the controller. The controller acts as a CA proxy and receives the certRequest signed by the CA for the access point.

**Note**

When the CA server is in manual mode and if there is an AP entry in the LSC SCEP table that is pending enrollment, the controller waits for the CA server to send a pending response. If there is no response from the CA server, the controller retries a total of three times to get a response, after which the fallback mode comes into effect where the AP provisioning times out and the AP reboots and comes up with MIC.

**Note**

LSC on controller does not take password challenge. Therefore, for LSC to work, you must disable password challenge on the CA server.
Configuring Locally Significant Certificates (GUI)

Step 1 Choose Security > Certificate > LSC to open the Local Significant Certificates (LSC) - General page.

Step 2 Select the Enable LSC on Controller check box to enable the LSC on the system.

Step 3 In the CA Server URL text box, enter the URL to the CA server. You can enter either a domain name or an IP address.

Step 4 In the Params text boxes, enter the parameters for the device certificate. The key size is a value from 384 to 2048 (in bits), and the default value is 2048.

Step 5 Click Apply to commit your changes.

Step 6 To add the CA certificate into the controller’s CA certificate database, hover your cursor over the blue drop-down arrow for the certificate type and choose Add.

Step 7 Choose the AP Provisioning tab to open the Local Significant Certificates (LSC) - AP Provisioning page.

Step 8 Select the Enable check box and click Update to provision the LSC on the access point.

Step 9 When a message appears indicating that the access points will be rebooted, click OK.

Step 10 In the Number of Attempts to LSC text box, enter the number of times that the access point attempts to join the controller using an LSC before the access point reverts to the default certificate (MIC or SSC). The range is 0 to 255 (inclusive), and the default value is 3.

Note If you set the number of retries to a nonzero value and the access point fails to join the controller using an LSC after the configured number of retries, the access point reverts to the default certificate. If you set the number of retries to 0 and the access point fails to join the controller using an LSC, the access point does not attempt to join the controller using the default certificate.

Note If you are configuring LSC for the first time, we recommend that you configure a nonzero value.

Step 11 Enter the access point MAC address in the AP Ethernet MAC Addresses text box and click Add to add access points to the provision list.

Note To remove an access point from the provision list, hover your cursor over the blue drop-down arrow for the access point and choose Remove.

Note If you configure an access point provision list, only the access points in the provision list are provisioned when you enable AP provisioning. If you do not configure an access point provision list, all access points with a MIC or SSC certificate that join the controller are LSC provisioned.

Step 12 Click Apply to commit your changes.

Step 13 Click Save Configuration to save your changes.

Configuring Locally Significant Certificates (CLI)

Step 1 Enable LSC on the system by entering this command:
```
config certificate lsc {enable | disable}
```

Step 2 Configure the URL to the CA server by entering this command:
```
config certificate lsc ca-server http://url:port/path
```
where *url* can be either a domain name or IP address.

**Note** You can configure only one CA server. To configure a different CA server, delete the configured CA server using the `config certificate lsc ca-server delete` command, and then configure a different CA server.

**Step 3** Add the LSC CA certificate into the controller’s CA certificate database by entering this command:

```
cfgpipe:configure>config certificate lsc ca-cert {add | delete}
```

**Step 4** Configure the parameters for the device certificate by entering this command:

```
cfgpipe:configure>config certificate lsc subject-params country state city orgn dept e-mail
```

**Note** The common name (CN) is generated automatically on the access point using the current MIC/SSC format `C_xxxx-MacAddr`, where `xxxx` is the product number.

**Step 5** Configure a key size by entering this command:

```
cfgpipe:configure>config certificate lsc other-params keysize
```

The `keysize` is a value from 384 to 2048 (in bits), and the default value is 2048.

**Step 6** Add access points to the provision list by entering this command:

```
cfgpipe:configure>config certificate lsc ap-provision auth-list add AP_mac_addr
```

**Note** To remove access points from the provision list, enter the `config certificate lsc ap-provision auth-list delete AP_mac_addr` command.

**Note** If you configure an access point provision list, only the access points in the provision list are provisioned when you enable AP provisioning (in **Step 8**). If you do not configure an access point provision list, all access points with a MIC or SSC certificate that join the controller are LSC provisioned.

**Step 7** Configure the number of times that the access point attempts to join the controller using an LSC before the access point reverts to the default certificate (MIC or SSC) by entering this command:

```
cfgpipe:configure>config certificate lsc ap-provision revert-cert retries
```

where `retries` is a value from 0 to 255, and the default value is 3.

**Note** If you set the number of retries to a nonzero value and the access point fails to join the controller using an LSC after the configured number of retries, the access point reverts to the default certificate. If you set the number of retries to 0 and the access point fails to join the controller using an LSC, the access point does not attempt to join the controller using the default certificate.

**Note** If you are configuring LSC for the first time, Cisco recommends that you configure a nonzero value.

**Step 8** Provision the LSC on the access point by entering this command:

```
cfgpipe:configure>config certificate lsc ap-provision {enable | disable}
```

**Step 9** See the LSC summary by entering this command:

```
show certificate lsc summary
```

Information similar to the following appears:

```
LSC Enabled.......................................... Yes
LSC CA-Server........................................ http://10.0.0.1:8080/caserver

LSC AP-Provisioning.................................... Yes
Provision-List......................................... Not Configured
LSC Revert Count in AP reboots.................... 3

LSC Params:
  Country.......................................... 4
```
Step 10

See details about the access points that are provisioned using LSC by entering this command:

```
show certificate lsc ap-provision
```

Information similar to the following appears:

```
LSC AP-Provisioning........................... Yes
Provision-List................................. Present

Idx  Mac Address
---  ------------
1  00:18:74:c7:c0:90
```

**Authorizing Access Points (GUI)**

**Step 1**
Choose Security > AAA > AP Policies to open the AP Policies page.

**Step 2**
If you want the access point to accept self-signed certificates (SSCs), manufactured-installed certificates (MICs), or local significant certificates (LSCs), select the appropriate check box.

**Step 3**
If you want the access points to be authorized using an AAA RADIUS server, select the **Authorize MIC APs against auth-list** or **AAA** check box.

**Step 4**
If you want the access points to be authorized using an LSC, select the **Authorize LSC APs against auth-list** check box.

Enter the Ethernet MAC address for all APs except when in bridge mode (where you need to enter the radio Mac address).

**Step 5**
Click **Apply** to commit your changes.

**Step 6**
Follow these steps to add an access point to the controller’s authorization list:

a) Click **Add** to access the Add AP to Authorization List area.

b) In the MAC Address text box, enter the MAC address of the access point.

c) From the Certificate Type drop-down list, choose **MIC**, **SSC**, or **LSC**.

d) Click **Add**. The access point appears in the access point authorization list.

**Note**
To remove an access point from the authorization list, hover your cursor over the blue drop-down arrow for the access point and choose **Remove**.

**Note**
To search for a specific access point in the authorization list, enter the MAC address of the access point in the Search by MAC text box and click **Search**.
Authorizing Access Points (CLI)

- Configure an access point authorization policy by entering this command:
  ```plaintext
  config auth-list ap-policy {authorize-ap {enable | disable} | authorize-lsc-ap {enable | disable}}
  ```

- Configure an access point to accept manufactured-installed certificates (MICs), self-signed certificates (SSCs), or local significant certificates (LSCs) by entering this command:
  ```plaintext
  config auth-list ap-policy {mic | ssc | lsc {enable | disable}}
  ```

- Configure the user name to be used in access point authorization requests.
  ```plaintext
  config auth-list ap-policy {authorize-ap username {ap_name | ap_mac | both}}
  ```

- Add an access point to the authorization list by entering this command:
  ```plaintext
  config auth-list add {mic | ssc | lsc} ap_mac [ap_key]
  ```
  where `ap_key` is an optional key hash value equal to 20 bytes or 40 digits.

  **Note**
  To delete an access point from the authorization list, enter this command: `config auth-list delete ap_mac`.

  - See the access point authorization list by entering this command:
    ```plaintext
    show auth-list
    ```

Configuring VLAN Tagging for CAPWAP Frames from Access Points

**Information About VLAN Tagging for CAPWAP Frames from Access Points**

You can configure VLAN tagging on the Ethernet interface either directly on the AP console or through the controller. The configuration is saved in the flash memory and all CAPWAP frames use the VLAN tag as configured, along with all the locally switched traffic, which is not mapped to a VLAN.

This feature is not supported on mesh access points that are in bridge mode.

**Configuring VLAN Tagging for CAPWAP Frames from Access Points (GUI)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose <strong>Wireless</strong> &gt; <strong>Access Points</strong> &gt; <strong>All APs</strong> to open the All APs page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the AP name from the list of AP names to open the Details page for the AP.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click the <strong>Advanced</strong> tab.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the VLAN Tagging area, select the <strong>VLAN Tagging</strong> check box.</td>
</tr>
<tr>
<td>Step 5</td>
<td>In the <strong>Trunk VLAN ID</strong> text box, enter an ID. If the access point is unable to route traffic through the specified trunk VLAN after about 10 minutes, the access point performs a recovery procedure by rebooting and sending CAPWAP frames in untagged mode to try and reassociate with...</td>
</tr>
</tbody>
</table>
the controller. The controller sends a trap to a trap server such as the Cisco Prime Infrastructure, which indicates the failure of the trunk VLAN.

If the access point is unable to route traffic through the specified trunk VLAN, it untags the packets and reassociates with the controller. The controller sends a trap to a trap server such as the Cisco Prime Infrastructure, which indicates the failure of the trunk VLAN.

If the trunk VLAN ID is 0, the access point untags the CAPWAP frames.

The VLAN Tag status is displayed showing whether the AP tags or untags the CAPWAP frames.

**Step 6** Click *Apply*.

**Step 7** You are prompted with a warning message saying that the configuration will result in a reboot of the access point. Click *OK* to continue.

**Step 8** Click *Save Configuration*.

---

**What to Do Next**

After the configuration, the switch or other equipment connected to the Ethernet interface of the AP must also be configured to support tagged Ethernet frames.

### Configuring VLAN Tagging for CAPWAP Frames from Access Points (CLI)

**Step 1** Configure VLAN tagging for CAPWAP frames from access points by entering this command:

```
config ap ethernet tag {disable | id vlan-id | ap-name | all}
```

**Step 2** You can see VLAN tagging information for an AP or all APs by entering this command:

```
show ap ethernet tag {summary | ap-name}
```

---

**Using DHCP Option 43 and DHCP Option 60**

Cisco Aironet access points use the type-length-value (TLV) format for DHCP option 43. DHCP servers must be programmed to return the option based on the access point’s DHCP Vendor Class Identifier (VCI) string (DHCP option 60).

This table lists the VCI strings for Cisco access points capable of operating in lightweight mode.

**Table 21: VCI Strings For Lightweight Access Points**

<table>
<thead>
<tr>
<th>Access Point</th>
<th>VCI String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Aironet 1040 Series</td>
<td>Cisco AP c1040</td>
</tr>
<tr>
<td>Cisco Aironet 1130 Series</td>
<td>Cisco AP c1130</td>
</tr>
</tbody>
</table>
The format of the TLV block is as follows:

- **Type**: 0xf1 (decimal 241)
- **Length**: Number of controller IP addresses * 4
- **Value**: List of the IP addresses of controller management interfaces

See the product documentation for your DHCP server for instructions on configuring DHCP option 43. The *Upgrading Autonomous Cisco Aironet Access Points to Lightweight Mode* document contains example steps for configuring option 43 on a DHCP server.

If the access point is ordered with the Service Provider Option - AIR-OPT60-DHCP selected, the VCI string for that access point will be different than those listed above. The VCI string will have the “ServiceProvider”. For example, a 1260 with this option will return this VCI string: "Cisco AP c1260-ServiceProvider".

---

**Note**

The controller IP address that you obtain from the DHCP server should be a unicast IP address. Do not configure the controller IP address as a multicast address when configuring DHCP Option 43.

<table>
<thead>
<tr>
<th>Access Point</th>
<th>VCI String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Aironet 1140 Series</td>
<td>Cisco AP c1140</td>
</tr>
<tr>
<td>Cisco Aironet 1240 Series</td>
<td>Cisco AP c1240</td>
</tr>
<tr>
<td>Cisco Aironet 1250 Series</td>
<td>Cisco AP c1250</td>
</tr>
<tr>
<td>Cisco Aironet 1260 Series</td>
<td>Cisco AP c1260</td>
</tr>
<tr>
<td>Cisco Aironet 1520 Series</td>
<td>Cisco AP c1520</td>
</tr>
<tr>
<td>Cisco Aironet 1550 Series</td>
<td>Cisco AP c1550</td>
</tr>
<tr>
<td>Cisco Aironet 1700 Series</td>
<td>Cisco AP c1700</td>
</tr>
<tr>
<td>Cisco Aironet 2700 Series</td>
<td>Cisco AP c2700</td>
</tr>
<tr>
<td>Cisco Aironet 3600 Series</td>
<td>Cisco AP c3600</td>
</tr>
<tr>
<td>Cisco Aironet 3700 Series</td>
<td>Cisco AP c3700</td>
</tr>
<tr>
<td>Cisco Aironet 3500 Series</td>
<td>Cisco AP c3500</td>
</tr>
<tr>
<td>Cisco Aironet 700 Series</td>
<td>Cisco AP c700</td>
</tr>
<tr>
<td>Cisco AP801 Embedded Access Point</td>
<td>Cisco AP801</td>
</tr>
<tr>
<td>Cisco AP802 Embedded Access Point</td>
<td>Cisco AP802</td>
</tr>
</tbody>
</table>
Troubleshooting the Access Point Join Process

Access points can fail to join a controller for many reasons such as a RADIUS authorization is pending, self-signed certificates are not enabled on the controller, the access point and controller’s regulatory domains do not match, and so on.

Controller software release 5.2 or later releases enable you to configure the access points to send all CAPWAP-related errors to a syslog server. You do not need to enable any debug commands on the controller because all of the CAPWAP error messages can be viewed from the syslog server itself.

The state of the access point is not maintained on the controller until it receives a CAPWAP join request from the access point, so it can be difficult to determine why the CAPWAP discovery request from a certain access point was rejected. In order to troubleshoot such joining issues without enabling CAPWAP debug commands on the controller, the controller collects information for all access points that send a discovery message to this controller and maintains information for any access points that have successfully joined this controller.

The controller collects all join-related information for each access point that sends a CAPWAP discovery request to this controller. Collection begins with the first discovery message received from the access point and ends with the last configuration payload sent from the controller to the access point.

You can view join-related information for the following numbers of access points:

When the controller is maintaining join-related information for the maximum number of access points, it does not collect information for any more access points.

If any of these conditions are met and the access point has not yet joined a controller, you can also configure a DHCP server to return a syslog server IP address to the access point using option 7 on the server. The access point then starts sending all syslog messages to this IP address.

You can also configure the syslog server IP address through the access point CLI, provided the access point is currently not connected to the controller by entering the `capwap ap log-server syslog_server_IP_address` command.

When the access point joins a controller for the first time, the controller pushes the global syslog server IP address (the default is 255.255.255.255) to the access point. After that, the access point sends all syslog messages to this IP address, until it is overridden by one of the following scenarios:

- The access point is still connected to the same controller, and the global syslog server IP address configuration on the controller has been changed using the `config ap syslog host global syslog_server_IP_address` command. In this case, the controller pushes the new global syslog server IP address to the access point.

- The access point is still connected to the same controller, and a specific syslog server IP address has been configured for the access point on the controller using the `config ap syslog host specific Cisco_AP syslog_server_IP_address` command. In this case, the controller pushes the new specific syslog server IP address to the access point.

- The access point gets disconnected from the controller, and the syslog server IP address has been configured from the access point CLI using the `lwapp ap log-server syslog_server_IP_address` command. This command works only if the access point is not connected to any controller.

- The access point gets disconnected from the controller and joins another controller. In this case, the new controller pushes its global syslog server IP address to the access point.
Whenever a new syslog server IP address overrides the existing syslog server IP address, the old address is erased from persistent storage, and the new address is stored in its place. The access point also starts sending all syslog messages to the new IP address, provided the access point can reach the syslog server IP address.

You can configure the syslog server for access points using the controller GUI and view the access point join information using the controller GUI or CLI.

**Note** When an AP in a Release 8.0 image tries to join Cisco WLC, Release 8.3 (having Release 8.2 as the primary image and Release 8.2.1 as the secondary image on Flash), the AP goes into a perpetual loop. (Note that the release numbers are used only as an example to illustrate the scenario of three different images and does not apply to the releases mentioned.) This loop occurs due to version mismatch. After the download, when the AP compares its image with the Cisco WLC image, there will be a version mismatch. The AP will start the entire process again, resulting in a loop.

### Configuring the Syslog Server for Access Points (CLI)

**Step 1** Perform one of the following:

- To configure a global syslog server for all access points that join this controller, enter this command:
  ```
  config ap syslog host global syslog_server_IP_address
  ```

  **Note** By default, the global syslog server IPv4/IPv6 address for all access points is 255.255.255.255. Make sure that the access points can reach the subnet on which the syslog server resides before configuring the syslog server on the controller. If the access points cannot reach this subnet, the access points are unable to send out syslog messages.

  **Note** Only one Syslog Server is used for both IPv4 and IPv6.

- To configure a syslog server for a specific access point, enter this command:
  ```
  config ap syslog host specific Cisco_AP syslog_server_IP_address
  ```

  **Note** By default, the syslog server IPv4/IPv6 address for each access point is 0.0.0.0, which indicates that the access point is not yet set. When the default value is used, the global access point syslog server IP address is pushed to the access point.

**Step 2** Enter the `save config` command to save your changes.

**Step 3** See the global syslog server settings for all access points that join the controller by entering this command:

  ```
  show ap config global
  ```

  Information similar to the following appears:

  ```
  AP global system logging host....................... 255.255.255.255
  ```

**Step 4** See the syslog server settings for a specific access point by entering this command:

  ```
  show ap config general Cisco_AP
  ```
**Viewing Access Point Join Information**

Join statistics for an access point that sends a CAPWAP discovery request to the controller at least once are maintained on the controller even if the access point is rebooted or disconnected. These statistics are removed only when the controller is rebooted or when you choose to clear the statistics.

**Viewing Access Point Join Information (GUI)**

**Step 1**
Choose Monitor > Statistics > AP Join to open the AP Join Stats page. This page lists all of the access points that are joined to the controller or that have tried to join. It shows the radio MAC address, access point name, current join status, Ethernet MAC address, IP address, and last join time for each access point.

The total number of access points appears in the upper right-hand corner of the page. If the list of access points spans multiple pages, you can view these pages by clicking the page number links. Each page shows the join statistics for up to 25 access points.

*Note* If you want to remove an access point from the list, hover your cursor over the blue drop-down arrow for that access point and click **Remove**.

*Note* If you want to clear the statistics for all access points and start over, click **Clear Stats on All APs**.

**Step 2**
If you want to search for specific access points in the list of access points on the AP Join Stats page, follow these steps to create a filter to display only access points that meet certain criteria (such as MAC address or access point name).

*Note* This feature is especially useful if your list of access points spans multiple pages, preventing you from viewing them all at once.

a) Click **Change Filter** to open the Search AP dialog box.

b) Select one of the following check boxes to specify the criteria used when displaying access points:

- **MAC Address**—Enter the base radio MAC address of an access point.

  * **AP Name**—Enter the name of an access point.

  * **Note** When you enable one of these filters, the other filter is disabled automatically.

  c) Click **Find** to commit your changes. Only the access points that match your search criteria appear on the AP Join Stats page, and the Current Filter parameter at the top of the page specifies the filter used to generate the list (for example, MAC Address:00:1e:f7:75:0a:a0 or AP Name:pmsk-ap).

  * **Note** If you want to remove the filter and display the entire access point list, click **Clear Filter**.

**Step 3**
To see detailed join statistics for a specific access point, click the radio MAC address of the access point. The AP Join Stats Detail page appears. This page provides information from the controller’s perspective on each phase of the join process and shows any errors that have occurred.
Viewing Access Point Join Information (CLI)

Use these CLI commands to see access point join information:

- See the MAC addresses of all the access points that are joined to the controller or that have tried to join by entering this command:
  
  ```
  show ap join stats summary all
  ```

- See the last join error detail for a specific access point by entering this command:
  
  ```
  show ap join stats summary ap_mac
  ```

  where `ap_mac` is the MAC address of the 802.11 radio interface.

  **Note**  
  To obtain the MAC address of the 802.11 radio interface, enter the `show interfaces Dot11Radio 0` command on the access point.

  Information similar to the following appears:

  Is the AP currently connected to controller.................. Yes
  Time at which the AP joined this controller last time...... Aug 21 12:50:36.061
  Type of error that occurred last............................ AP got or has been disconnected
  Reason for error that occurred last........................ The AP has been reset by the controller
  Time at which the last join error occurred................. Aug 21 12:50:34.374

- See all join-related statistics collected for a specific access point by entering this command:
  
  ```
  show ap join stats detailed ap_mac
  ```

  Information similar to the following appears:

  Discovery phase statistics
  - Discovery requests received.............................. 2
  - Successful discovery responses sent..................... 2
  - Unsuccessful discovery request processing............... 0
  - Reason for last unsuccessful discovery attempt......... Not applicable
  - Time at last successful discovery attempt................ Aug 21 12:50:23.335
  - Time at last unsuccessful discovery attempt............. Not applicable

  Join phase statistics
  - Join requests received.................................. 1
  - Successful join responses sent.......................... 1
  - Unsuccessful join request processing.................... 1
  - Reason for last unsuccessful join attempt.............. RADIUS authorization is pending for the AP
  - Time at last successful join attempt..................... Aug 21 12:50:34.481
  - Time at last unsuccessful join attempt.................. Aug 21 12:50:34.374

  Configuration phase statistics
  - Configuration requests received.......................... 1
  - Successful configuration responses sent.................. 1
  - Unsuccessful configuration request processing.......... 0
  - Reason for last unsuccessful configuration attempt..... Not applicable
  - Time at last successful configuration attempt........... Aug 21 12:50:34.374
  - Time at last unsuccessful configuration attempt........ Not applicable

  Last AP message decryption failure details
  - Reason for last message decryption failure.............. Not applicable
Last AP disconnect details
- Reason for last AP connection failure.................... The AP has been reset by the controller

Last join error summary
- Type of error that occurred last......................... AP got or has been disconnected
- Reason for error that occurred last........................... The AP has been reset by the controller
- Time at which the last join error occurred............... Aug 21 12:50:34.374

• Clear the join statistics for all access points or for a specific access point by entering this command:
  clear ap join stats {all | ap_mac}

---

Sending Debug Commands to Access Points Converted to Lightweight Mode

You can enable the controller to send debug commands to an access point converted to lightweight mode by entering this command:

debug ap {enable | disable | command cmd} Cisco_AP

When this feature is enabled, the controller sends debug commands to the converted access point as character strings. You can send any debug command supported by Cisco Aironet access points that run Cisco IOS software in lightweight mode.

---

Understanding How Converted Access Points Send Crash Information to the Controller

When a converted access point unexpectedly reboots, the access point stores a crash file on its local flash memory at the time of the crash. After the unit reboots, it sends the reason for the reboot to the controller. If the unit rebooted because of a crash, the controller pulls up the crash file using existing CAPWAP messages and stores it in the controller flash memory. The crash info copy is removed from the access point flash memory when the controller pulls it from the access point.

---

Understanding How Converted Access Points Send Radio Core Dumps to the Controller

When a radio module in a converted access point generates a core dump, the access point stores the core dump file of the radio on its local flash memory at the time of the radio crash. It sends a notification message to the controller indicating which radio generated a core dump file. The controller sends a trap that alerts you so that you can retrieve the radio core file from the access point.

The retrieved core file is stored in the controller flash and can be uploaded through TFTP or FTP to an external server for analysis. The core file is removed from the access point flash memory when the controller pulls it from the access point.
Retrieving Radio Core Dumps (CLI)

Step 1  Transfer the radio core dump file from the access point to the controller by entering this command:
`config ap crash-file get-radio-core-dump slot Cisco_AP`
For the `slot` parameter, enter the slot ID of the radio that crashed.

Step 2  Verify that the file was downloaded to the controller by entering this command:
`show ap crash-file`

Uploading Radio Core Dumps (GUI)

Step 1  Choose `Commands > Upload File` to open the Upload File from Controller page.

Step 2  From the File Type drop-down list, choose `Radio Core Dump`.

Step 3  From the Transfer Mode drop-down list, choose from the following options:

- TFTP
- FTP

Step 4  In the IP Address text box, enter the IP address of the server.

Step 5  In the File Path text box, enter the directory path of the file.

Step 6  In the File Name text box, enter the name of the radio core dump file.

Note  The `filename` that you enter should match the filename generated on the controller. You can determine the `filename` on the controller by entering the `show ap crash-file` command.

Step 7  If you chose FTP as the Transfer Mode, follow these steps:
   a) In the Server Login Username text box, enter the FTP server login name.
   b) In the Server Login Password text box, enter the FTP server login password.
   c) In the Server Port Number text box, enter the port number of the FTP server. The default value for the server port is 21.

Step 8  Click `Upload` to upload the radio core dump file from the controller. A message appears indicating the status of the upload.

Uploading Radio Core Dumps (CLI)

Step 1  Transfer the file from the controller to a server by entering these commands:
• transfer upload mode {tftp | ftp}
• transfer upload datatype radio-core-dump
• transfer upload serverip server_ip_address
• transfer upload path server_path_to_file
• transfer upload filename filename

  Note  The filename that you enter should match the filename generated on the controller. You can determine the filename on the controller by entering the show ap crash-file command.

  Note  Ensure that the filename and server_path_to_file do not contain these special characters: \, :, *, ?, "", <, >, and \. You can use only / (forward slash) as the path separator. If you use the disallowed special characters in the filename, then the special characters are replaced with _ (underscores); and if you use the disallowed special characters in the server_path_to_file, then the path is set to the root path.

Step 2  If you are using an FTP server, also enter these commands:
  • transfer upload username username
  • transfer upload password password
  • transfer upload port port

  Note  The default value for the port parameter is 21.

Step 3  View the updated settings by entering this command:
transfer upload start

Step 4  When prompted to confirm the current settings and start the software upload, answer y.

---

**Uploading Memory Core Dumps from Converted Access Points**

By default, access points converted to lightweight mode do not send memory core dumps to the controller. This section provides instructions to upload access point core dumps using the controller GUI or CLI.
Uploading Access Point Core Dumps (GUI)

Step 1  Choose Wireless > Access Points > All APs > access point name > and choose the Advanced tab to open the All APs > Details for (Advanced) page.

Step 2  Select the AP Core Dump check box to upload a core dump of the access point.

Step 3  In the TFTP Server IP text box, enter the IP address of the TFTP server.

Step 4  In the File Name text box, enter a name of the access point core dump file (such as dump.log).

Step 5  Select the File Compression check box to compress the access point core dump file. When you enable this option, the file is saved with a .gz extension (such as dump.log.gz). This file can be opened with WinZip.

Step 6  Click Apply to commit your changes.

Step 7  Click Save Configuration to save your changes.

Uploading Access Point Core Dumps (CLI)

Step 1  Upload a core dump of the access point by entering this command on the controller:

```
config ap core-dump enable tftp_server_ip_address filename {compress | uncompress} {ap_name | all}
```

where

- `tftp_server_ip_address` is the IP address of the TFTP server to which the access point sends core dump files.

  Note  The access point must be able to reach the TFTP server.

- `filename` is the name that the access points uses to label the core file.

- `compress` configures the access point to send compressed core files whereas `uncompress` configures the access point to send uncompressed core files.

  Note  When you choose `compress`, the file is saved with a .gz extension (for example, dump.log.gz). This file can be opened with WinZip.

- `ap_name` is the name of a specific access point for which core dumps are uploaded and `all` is all access points converted to lightweight mode.

Step 2  Enter the `save config` command to save your changes.

Viewing the AP Crash Log Information

Whenever the controller reboots or upgrades, the AP crash log information gets deleted from the controller. We recommend that you make a backup of AP crash log information before rebooting or upgrading the controller.
Viewing the AP Crash Log information (GUI)

- Choose Management > Tech Support > AP Crash Log to open the AP Crash Logs page.

Viewing the AP Crash Log information (CLI)

---

Step 1  Verify that the crash file was downloaded to the controller by entering this command:

```
show ap crash-file
```

Information similar to the following appears:

```
Local Core Files:
1rad_AP1130.rdump0 (156)
The number in parentheses indicates the size of the file. The size should be greater than zero if a
core dump file is available.
```

Step 2  See the contents of the AP crash log file by entering this command:

```
show ap crash-file Cisoc_AP
```

---

Displaying MAC Addresses for Converted Access Points

There are some differences in the way that controllers display the MAC addresses of converted access points on information pages in the controller GUI:

- On the AP Summary page, the controller lists the Ethernet MAC addresses of converted access points.
- On the AP Detail page, the controller lists the BSS MAC addresses and Ethernet MAC addresses of converted access points.
- On the Radio Summary page, the controller lists converted access points by radio MAC address.

Disabling the Reset Button on Access Points Converted to Lightweight Mode

You can disable the reset button on access points converted to lightweight mode. The reset button is labeled MODE on the outside of the access point.

Use this command to disable or enable the reset button on one or all converted access points associated to a controller:

```
config ap rst-button {enable | disable} {ap-name}
```

The reset button on converted access points is enabled by default.
Configuring a Static IP Address on a Lightweight Access Point

If you want to specify an IP address for an access point rather than having one assigned automatically by a DHCP server, you can use the controller GUI or CLI to configure a static IP address for the access point. Static IP addresses are generally used only for deployments with a limited number of APs.

An access point cannot discover the controller using domain name system (DNS) resolution if a static IP address is configured for the access point, unless you specify a DNS server and the domain to which the access point belongs.

Note: If you configure an access point to use a static IP address that is not on the same subnet on which the access point’s previous DHCP address was, the access point falls back to a DHCP address after the access point reboots. If the access point falls back to a DHCP address, enter the `show ap config general` Cisco_AP CLI command to show that the access point is using a fallback IP address. However, the GUI shows both the static IP address and the DHCP address, but it does not identify the DHCP address as a fallback address.

Configuring a Static IP Address (GUI)

**Step 1** Choose Wireless > Access Points > All APs to open the All APs page.

**Step 2** Click the name of the access point for which you want to configure a static IP address. The All APs > Details for (General) page appears.

**Step 3** Under IP Config, select the Static IP (IPv4/IPv6) check box if you want to assign a static IP address to this access point. The default value is unselected.

*Note:* The static IP configured on the AP will take precedence over the preferred mode configured on the AP. For example: If AP has static IPv6 address and prefer-mode is set to IPv4, then the AP will join over IPv6.

**Step 4** Enter the static IPv4/IPv6 address of the access point, subnet mask/prefix length assigned to the access point IPv4/IPv6 address, and the IPv4/IPv6 gateway of the access point in the corresponding textboxes.

**Step 5** Click Apply to commit your changes. The access point reboots and rejoins the controller, and the static IPv4/IPv6 address that you specified in Step 4 is sent to the access point.

**Step 6** After the static IPv4/IPv6 address has been sent to the access point, you can configure the DNS server IP address and domain name as follows:

a) In the DNS IP Address text box, enter the IPv4/IPv6 address of the DNS server.

b) In the Domain Name text box, enter the name of the domain to which the access point belongs.

c) Click Apply to commit your changes.

d) Click Save Configuration to save your changes.
Configuring a Static IP Address (CLI)

Step 1
Configure a static IP address on the access point by entering this command:
For IPv4—`config ap static-ip enable Cisco_AP ip_address mask gateway`
For IPv6—`config ap static-ip enable Cisco_AP ip_address prefix_length gateway`

**Note** To disable static IP for the access point, enter the `config ap static-ip disable Cisco_AP` command.

**Note** The static IP configured on the AP will take precedence over the preferred mode configured on the AP. For example: If AP has static IPv6 address and prefer-mode is set to IPv4, then the AP will join over IPv6.

Step 2
Enter the `save config` command to save your changes.
The access point reboots and rejoins the controller, and the static IP address that you specified in Step 1 is pushed to the access point.

Step 3
After the static IPv4/IPv6 address has been sent to the access point, you can configure the DNSv4/DNSv6 server IP address and domain name as follows:

a) To specify a DNSv4/DNSv6 server so that a specific access point or all access points can discover the controller using DNS resolution, enter this command:
`config ap static-ip add nameserver {Cisco_AP | all} ip_address`

**Note** To delete a DNSv4/DNSv6 server for a specific access point or all access points, enter the `config ap static-ip delete nameserver {Cisco_AP | all}` command.

b) To specify the domain to which a specific access point or all access points belong, enter this command:
`config ap static-ip add domain {Cisco_AP | all} domain_name`

**Note** To delete a domain for a specific access point or all access points, enter this command: `config ap static-ip delete domain {Cisco_AP | all}`

c) Enter the `save config` command to save your changes.

Step 4
See the IPv4/IPv6 address configuration for the access point by entering this command:

- For IPv4:
  `show ap config general Cisco_AP`
  Information similar to the following appears:
  
  ```
  show ap config general <Cisco_AP>
  Cisco AP Identifier.............................. 4
  Cisco AP Name.................................... AP6
  ... IP Address Configuration.................... Static IP assigned
  IP Address........................................ 10.10.10.118
  IP NetMask....................................... 255.255.255.0
  Gateway IP Addr.................................. 10.10.10.1
  Domain........................................... Domain1
  Name Server...................................... 10.10.10.205
  ...```

- For IPv6:
  `show ap config general Cisco_AP`
  Information similar to the following appears:
  
  ```
  show ap config general <Cisco_AP>
  ...```
Supporting Oversized Access Point Images

Controller software release 5.0 or later releases allow you to upgrade to an oversized access point image by automatically deleting the recovery image to create sufficient space.

The recovery image provides a backup image that can be used if an access point power-cycles during an image upgrade. The best way to avoid the need for access point recovery is to prevent an access point from power-cycling during a system upgrade. If a power-cycle occurs during an upgrade to an oversized access point image, you can recover the access point using the TFTP recovery procedure.

Recovering the Access Point—Using the TFTP Recovery Procedure

Step 1
Download the required recovery image from Cisco.com (for example, ap3g2-rcvk9w8-tar.152-4.JB6.tar for 2700 or 3700 APs) and install it in the root directory of your TFTP server.

Step 2
Connect the TFTP server to the same subnet as the target access point and power-cycle the access point. The access point boots from the TFTP image and then joins the controller to download the oversized access point image and complete the upgrade procedure.

Step 3
After the access point has been recovered, you may remove the TFTP server.

Configuring Packet Capture

Information About Packet Capture

To resolve issues such as voice and security on wireless networks, you might need to dump packets from the AP for analysis while the AP continues to operate normally. The packets can be dumped on to an FTP server. This process of dumping packets for analysis is called Packet Capture. Use the controller to start or stop packet
This packet capture can be enabled for only one client.

This feature is not supported in intercontroller roaming scenarios. If you know the AP or the controller to which the client is going to roam, you can configure the packet capture for the client in the new controller or AP using the CLI.

Not all packets in the air are captured, but only those that reach the radio driver.

By default, a packet capture process is stopped after 10 minutes. You can, however, configure the packet capture to stop at any time between 1 to 60 minutes.
Configuring Packet Capture (CLI)

Step 1 Configure FTP parameters for packet capture by entering this command:
\[ \text{config ap packet-dump ftp serverip ip-address path path username user_ID password password} \]

Step 2 Start or stop packet capture by entering this command:
\[ \text{config ap packet-dump \{start client-mac-address ap-name | stop\}} \]

Step 3 Configure the buffer size for packet capture by entering this command:
\[ \text{config ap packet-dump buffer-size size-in-kb} \]

Step 4 Configure the time for packet capture by entering this command:
\[ \text{config ap packet-dump capture-time time-in-minutes} \]

Step 5 Configure the types of packets to be captured by entering this command:
\[ \text{config ap packet-dump classifier \{arp | broadcast | control | data | dot1x | iapp | ip | management | multicast | \{tcp port port-number\} | \{udp port port-number\}\} \{enable | disable\}} \]

Step 6 Configure the packet length after truncation by entering this command:
\[ \text{config ap packet-dump truncate length-in-bytes} \]

Step 7 Know the status of packet capture by entering this command:
\[ \text{show ap packet-dump status} \]

Step 8 Configure debugging of packet capture by entering this command:
\[ \text{debug ap packet-dump \{enable | disable\}} \]

Configuring OfficeExtend Access Points

Information About OfficeExtend Access Points

A Cisco 600 Series OfficeExtend access point (Cisco OEAP) provides secure communications from a controller to an access point at a remote location, seamlessly extending the corporate WLAN over the Internet to an employee’s residence. The user’s experience at the home office is exactly the same as it would be at the corporate office. Datagram Transport Layer Security (DTLS) encryption between the access point and the controller ensures that all communications have the highest level of security.

Note
DTLS is permanently enabled on the Cisco OEAP. You cannot disable DTLS on this access point.

The following figure shows a typical OfficeExtend access point setup.
Cisco OEAPs are designed to work behind a router or other gateway device that is using network address translation (NAT). NAT allows a device, such as a router, to act as an agent between the Internet (public) and a personal network (private), enabling an entire group of computers to be represented by a single IP address. There is no limit to the number of Cisco OEAPs that you can deploy behind a NAT device. Roaming is not supported for the Cisco 600 OEAP model.

All the supported indoor AP models with integrated antenna can be configured as OEAP except the AP-700I and AP-700W series access points.

**OEAP 600 Series Access Points**

This section details the requirements for configuring a Cisco wireless LAN controller for use with the Cisco 600 Series OfficeExtend Access Point. The 600 Series OfficeExtend Access Point supports split mode operation, and it requires configuration through the WLAN controller in local mode. This section describes the configurations necessary for proper connection and supported feature sets.

IPv6 is not supported on Cisco 600 Series OfficeExtend Access Points.

The CAPWAP UDP 5246 and 5247 ports must be open on the firewall between the WLAN controller and the 600 Series OfficeExtend Access Point.

Multicast is not supported on Cisco 600 Series OfficeExtend Access Points.

**OEAP in Local Mode**

The 600 Series OfficeExtend Access Point connects to the controller in local mode. You cannot alter these settings.
Monitor mode, flexconnect mode, sniffer mode, rogue detector, bridge, and SE-Connect are not supported on the 600 Series OfficeExtend Access Point and are not configurable.

**Figure 34: OEAP Mode**

<table>
<thead>
<tr>
<th>General</th>
<th>Interfaces</th>
<th>High Availability</th>
<th>Inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Name</td>
<td>Evora-OEAP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>default location</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AP MAC Address</td>
<td>98:fc:11:8b:66:e0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Admin Status</td>
<td>Enable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AP Mode</td>
<td>Local</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AP Sub Mode</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operational Status</td>
<td>REG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port Number</td>
<td>13</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Supported WLAN Settings for 600 Series OfficeExtend Access Point**

The 600 Series OfficeExtend Access Point supports a maximum of three WLANs and one remote LAN. If your network deployment has more than three WLANs, you must place the 600 Series OfficeExtend Access Point in an AP group. If the 600 Series OfficeExtend Access Points are added to an AP group, the same limit of three WLANs and one remote LAN still applies for the configuration of the AP group.

If the 600 Series OfficeExtend Access Point is in the default group, which means that it is not in a defined AP group, the WLAN/remote LAN IDs must be set lower than ID 8.

If additional WLANs or remote LANs are created with the intent of changing the WLANs or remote LAN being used by the 600 Series OfficeExtend Access Point, you must disable the current WLANs or remote LAN that you are removing before enabling the new WLANs or remote LAN on the 600 Series OfficeExtend Access Point. If there are more than one remote LANs enabled for an AP group, disable all remote LANs and then enable only one of them.

If more than three WLANs are enabled for an AP group, disable all WLANs and then enable only three of them.

**WLAN Security Settings for the 600 Series OfficeExtend Access Point**

When configuring the security settings in the WLAN (see the following figure), note that there are specific elements that are not supported on the 600 Series OfficeExtend Access Point. CCX is not supported on the 600 Series OfficeExtend Access Point, and elements related to CCX are not supported.

For Layer 2 Security, the following options are supported for the 600 Series OfficeExtend Access Point:
• None
• WPA+WPA2
• Static WEP
• 802.1X (only for remote LANs)

**Figure 35: WLAN Layer 2 Security Settings**

In the Security tab (see the following figure), do not select CCKM in WPA+WPA2 settings. Select only 802.1X or PSK.

**Figure 36: WLAN Security Settings - Auth Key Management**
Security encryption settings must be identical for WPA and WPA2 for TKIP and AES. The following are examples of incompatibe settings for TKIP and AES.

*Figure 37: Incompatible WPA and WPA2 Security Encryption Settings for OEAP 600 Series*

*Figure 38: Incompatible WPA and WPA2 Security Encryption Settings for OEAP 600 Series*
The following are examples of compatible settings:

*Figure 39: Compatible Security Settings for OEAP Series*

![Figure 39](image1)

*Figure 40: Compatible Security Settings for OEAP Series*

![Figure 40](image2)

QoS settings are supported (see the following figure), but CAC is not supported and should not be enabled.

---

**Note**

Do not enable Coverage Hole Detection.
Aironet IE should not be enabled. This option is not supported.

Figure 41: QoS Settings for OEAP 600

![QoS Settings for OEAP 600]

MFP is also not supported and should be disabled or set to optional.

Figure 42: MFP Settings for OEAP Series Access Points

![MFP Settings for OEAP Series Access Points]

Client Load Balancing and Client Band Select are not supported.

Authentication Settings

For authentication on the 600 Series OfficeExtend Access Point, LEAP is not supported. This configuration must be addressed on the clients and RADIUS servers to migrate them to EAP-Fast, EAP-TTLS, EAP-TLS, or PEAP.

If Local EAP is being utilized on the controller, the settings would also have to be modified not to use LEAP.
**Supported User Count on 600 Series OfficeExtend Access Point**

Only 15 users are allowed to connect on the WLANs provided on the Cisco 600 Series OEAP at any one time, a sixteenth user cannot authenticate until one of the first clients is deauthenticated or timeout on the controller occurs. This number is cumulative across the controller WLANs on the 600 Series OfficeExtend Access Point.

For example, if two controller WLANs are configured and there are 15 users on one of the WLANs, no other users can join the other WLAN on the 600 Series OfficeExtend Access Point at that time.

This limit does not apply to the local private WLANs that the end user configures on the 600 Series OfficeExtend Access Point for personal use. Clients connected on these private WLANs or on the wired ports do not affect these limits.

---

**Note**

This limit does not apply to other AP models that operate in the OfficeExtend mode.

---

**Remote LAN Settings**

Only four clients can connect through a remote LAN port on the 600 Series OfficeExtend Access Point. This number does not affect the fifteen user limit imposed for the Controller WLANs. The remote LAN client limit supports connecting a switch or hub to the remote LAN port for multiple devices or connecting directly to a Cisco IP phone that is connected to that port. Only the first four devices can connect until one of the devices is idle for more than one minute.

Remote LAN is configured in the same way that a WLAN or Guest LAN is configured on the controller:

*Figure 43: Remote LAN Settings for OEAP 600 Series AP*
Security settings can be left open, set for MAC filtering, or set for Web Authentication. The default is to use MAC filtering. Additionally, you can specify 802.1X Layer 2 security settings.

**Figure 44: Layer 2 Security Settings for OEAP 600 Series APs in Remote LANs**

**Figure 45: Layer 3 Security Settings for OEAP 600 Series APs in Remote LANs**

**Channel Management and Settings**

The radios for the 600 Series OfficeExtend Access Point are controlled through the Local GUI on the access point and not through the Wireless LAN Controller. The Tx power and channel settings can be set manually through the controller interface. RRM is not supported on the 600 Series OfficeExtend Access Point.

The 600 series scans and chooses channels for 2.4-GHz and 5-GHz during startup as long as the default settings on the local GUI are left as default in both spectrums.

**Figure 46: Channel Selection for OEAP 600 Series APs**
The channel bandwidth for 5.0 GHz is also configured on the 600 Series OfficeExtend Access Point Local GUI, for 20-MHz or 40-MHz wide channels. Setting the channel width to 40 MHz for 2.4 GHz is not supported and fixed at 20 MHz.

**Figure 47: Channel Width for OEAP 600 APs**

---

**Additional Caveats**

- The Cisco 600 Series OfficeExtend Access Points (OEAPs) are designed for single AP deployments, therefore client roaming between Cisco 600 Series OEAPs is not supported. Disabling the 802.11a/n or 802.11b/g/n on the controller may not disable these spectrums on the Cisco 600 Series OEAP because local SSID may be still working.

- Your firewall must be configured to allow traffic from access points using CAPWAP. Make sure that UDP ports 5246 and 5247 are enabled and are not blocked by an intermediate device that could prevent an access point from joining the controller.

- Cisco Aironet APs other than 600 Series OEAPs that are converted to OEAP mode and mapped to locally switched WLAN forward the DHCP request to the local subnet on the AP connected switch. To avoid this condition, you must disable local switching and local authentication.

- For Cisco 600 Series OEAP to associate with Cisco Virtual Wireless LAN Controller, follow these steps:
  1. Configure the OEAP to associate with a physical controller that is using 7.5 or a later release and download the corresponding AP image.
  2. Configure the OEAP so that the OEAP does not associate with the physical controller again; for example, you can implement an ACL in the network to block CAPWAP between the OEAP and the physical controller.
  3. Configure the OEAP to associate with the Cisco Virtual Wireless LAN Controller.

---

**Implementing Security**

**Note**

Configuring LSC is not a requirement but is an option. The OfficeExtend 600 access points do not support LSC.
1 Use local significant certificates (LSCs) to authorize your OfficeExtend access points, by following the instructions in Authorizing Access Points Using LSCs.

2 Implement AAA server validation using the access point’s MAC address, name, or both as the username in authorization requests, by entering this command:

```
config auth-list ap-policy authorize-ap username \{ap_mac | Cisco_AP | both\}
```

Using the access point name for validation can ensure that only the OfficeExtend access points of valid employees can associate with the controller. To implement this security policy, ensure that you name each OfficeExtend access point with an employee ID or employee number. When an employee is terminated, run a script to remove this user from the AAA server database, which prevents that employee’s OfficeExtend access point from joining the network.

3 Save your changes by entering this command:
```
save config
```

Note:
CCX is not supported on the 600 OEAP. Elements related to CCX are not supported. Also, only 802.1X or PSK is supported. TKIP and AES security encryption settings must be identical for WPA and WPA2.

Licensing for an OfficeExtend Access Point

To use OfficeExtend access points, a base license must be installed and in use on the controller. After the license is installed, you can enable the OfficeExtend mode on the supported Cisco Aironet AP models that support OfficeExtend mode.

Configuring OfficeExtend Access Points

After Cisco Aironet access point has associated with the controller, you can configure it as an OfficeExtend access point.

Configuring OfficeExtend Access Points (GUI)

Step 1 Choose Wireless to open the All APs page.

Step 2 Click the name of the desired access point to open the All APs > Details page.

Step 3 Enable FlexConnect on the access point as follows:

a) In the General tab, choose FlexConnect from the AP Mode drop-down list to enable FlexConnect for this access point.

Step 4 Configure one or more controllers for the access point as follows:

a) Click the High Availability tab.
b) Enter the name and IP address of the primary controller for this access point in the Primary Controller Name and Management IP Address text boxes.

Note You must enter both the name and IP address of the controller. Otherwise, the access point cannot join this controller.
c) If desired, enter the name and IP address of a secondary or tertiary controller (or both) in the corresponding **Controller Name** and **Management IP Address** text boxes.

d) Click **Apply**. The access point reboots and then rejoins the controller.

**Note** The names and IP addresses must be unique for the primary, secondary, and tertiary controllers.

**Step 5** Enable OfficeExtend access point settings as follows:

a) Click the **FlexConnect** tab.

b) Select the **Enable OfficeExtend AP** check box to enable the OfficeExtend mode for this access point. The default value is selected.

   Unselecting this check box disables OfficeExtend mode for this access point. It does not undo all of the configuration settings on the access point. If you want to clear the access point’s configuration and return it to the factory-default settings, enter `clear ap config Cisco_AP` on the controller CLI. If you want to clear only the access point’s personal SSID, click **Reset Personal SSID**.

   **Note** The OfficeExtend AP support is enabled for all the supported Cisco Aironet integrated antenna access points.

   **Note** Rogue detection is disabled automatically when you enable the OfficeExtend mode for an access point. However, you can enable or disable rogue detection for a specific access point by selecting the **Rogue Detection** check box on the **All APs > Details for (Advanced)** page. Rogue detection is disabled by default for OfficeExtend access points because these access points, which are deployed in a home environment, are likely to detect a large number of rogue devices.

   **Note** DTLS data encryption is enabled automatically when you enable the OfficeExtend mode for an access point. However, you can enable or disable DTLS data encryption for a specific access point by selecting the **Data Encryption** check box on the **All APs > Details for (Advanced)** page.

   **Note** Telnet and SSH access are disabled automatically when you enable the OfficeExtend mode for an access point.

   **Note** Link latency is enabled automatically when you enable the OfficeExtend mode for an access point. However, you can enable or disable link latency for a specific access point by selecting the **Enable Link Latency** check box on the **All APs > Details for (Advanced)** page.

c) Select the **Enable Least Latency Controller Join** check box if you want the access point to choose the controller with the least latency when joining. Otherwise, leave this check box unselected, which is the default value. When you enable this feature, the access point calculates the time between the discovery request and discovery response and joins the Cisco 5500 Series Controller that responds first.

d) Click **Apply**.

   The **OfficeExtend AP** textbox on the **All APs** page shows which access points are configured as OfficeExtend access points.

**Step 6** Configure a specific username and password for the OfficeExtend access point so that the user at home can log into the GUI of the OfficeExtend access point:

a) Click the **Credentials** tab.

b) Select the **Over-ride Global Credentials** check box to prevent this access point from inheriting the global username, password, and enable password from the controller. The default value is unselected.

c) In the **Username**, **Password**, and **Enable Password** text boxes, enter the unique username, password, and enable password that you want to assign to this access point.

   **Note** The information that you enter is retained across controller and access point reboots and if the access point joins a new controller.

d) Click **Apply**.
If you want to force this access point to use the controller’s global credentials, unselect the Over-ride Global Credentials check box.

**Step 7** Configure access to local GUI, LAN ports, and local SSID of the OfficeExtend access points:

a) Choose **Wireless > Access Points > Global Configuration** to open the Global Configuration page.

b) Under OEAP Config Parameters, select or unselect the **Disable Local Access** check box to enable or disable local access of the OfficeExtend access points.

*Note* By default, the **Disable Local Access** check box is unselected and therefore the Ethernet ports and personal SSIDs are enabled. This configuration does not affect remote LAN. The port is enabled only when you configure a remote LAN.

**Step 8** Click **Save Configuration**.

**Step 9** If your controller supports only OfficeExtend access points, see the Configuring RRM section for instructions on setting the recommended values for the DCA interval, channel scan duration, and neighbor packet frequency.

---

**Configuring OfficeExtend Access Points (CLI)**

- Enable FlexConnect on the access point by entering this command:
  ```bash
  config ap mode flexconnect Cisco_AP
  ```

- Configure one or more controllers for the access point by entering one or all of these commands:
  ```bash
  config ap primary-base controller_name Cisco_AP controller_ip_address
  config ap secondary-base controller_name Cisco_AP controller_ip_address
  config ap tertiary-base controller_name Cisco_AP controller_ip_address
  ```

*Note* You must enter both the name and IP address of the controller. Otherwise, the access point cannot join this controller.

*Note* The names and IP addresses must be unique for the primary, secondary, and tertiary controllers.

- Enable the OfficeExtend mode for this access point by entering this command:
  ```bash
  config flexconnect office-ext {enable | disable} Cisco_AP
  ```

  The default value is enabled. The **disable** parameter disables OfficeExtend mode for this access point. It does not undo all of the configuration settings on the access point. If you want to clear the access point’s configuration and return it to the factory-default settings, enter this command:
  ```bash
  clear ap config cisco-ap
  ```

  If you want to clear only the access point’s personal SSID, enter this command:
  ```bash
  config flexconnect office-ext clear-personalssid-config Cisco_AP
  ```
Rogue detection is disabled automatically when you enable the OfficeExtend mode for an access point. However, you can enable or disable rogue detection for a specific access point or for all access points using the `config rogue detection {enable | disable} {Cisco_AP | all}` command. Rogue detection is disabled by default for OfficeExtend access points because these access points, which are deployed in a home environment, are likely to detect a large number of rogue devices.

Note: DTLS data encryption is enabled automatically when you enable the OfficeExtend mode for an access point. However, you can enable or disable DTLS data encryption for a specific access point or for all access points using the `config ap link-encryption {enable | disable} {Cisco_AP | all}` command.

Note: Telnet and SSH access are disabled automatically when you enable the OfficeExtend mode for an access point. However, you can enable or disable Telnet or SSH access for a specific access point using the `config ap {telnet | ssh} {enable | disable} Cisco_AP` command.

Note: Link latency is enabled automatically when you enable the OfficeExtend mode for an access point. However, you can enable or disable link latency for a specific access point or for all access points currently associated to the controller using the `config ap link-latency {enable | disable} {Cisco_AP | all}` command.

- Enable the access point to choose the controller with the least latency when joining by entering this command:
  `config flexconnect join min-latency {enable | disable} Cisco_AP`
  The default value is disabled. When you enable this feature, the access point calculates the time between the discovery request and discovery response and joins the Cisco 5500 Series Controller that responds first.

- Configure a specific username and password that users at home can enter to log into the GUI of the OfficeExtend access point by entering this command:
  `config ap mgmtuser add username user password password enablesecret enable_password Cisco_AP`
  The credentials that you enter in this command are retained across controller and access point reboots and if the access point joins a new controller.

Note: If you want to force this access point to use the controller's global credentials, enter the `config ap mgmtuser delete Cisco_AP` command. The following message appears after you execute this command: “AP reverted to global username configuration.”

- To configure access to the local network for the Cisco 600 Series OfficeExtend access points, enter the following command:
  `config network ocap-600 local-network {enable | disable}`
When disabled, the local SSIDs, local ports are inoperative; and the console is not accessible. When reset, the default restores local access. This configuration does not affect the remote LAN configuration if configured on the access points.

- Configure the Dual R-LAN Ports feature, which allows the Ethernet port 3 of Cisco 600 Series OfficeExtend access points to operate as a remote LAN by entering this command:

```plaintext
config network oeap-600 dual-rlan-ports {enable | disable}
```

This configuration is global to the controller and is stored by the AP and the NVRAM variable. When this variable is set, the behavior of the remote LAN is changed. This feature supports different remote LANs per remote LAN port.

The remote LAN mapping is different depending on whether the default group or AP Groups is used:

- Default Group—If you are using the default group, a single remote LAN with an even numbered remote LAN ID is mapped to port 4. For example, a remote LAN with remote LAN ID 2 is mapped to port 4 (on the Cisco 600 OEAP). The remote LAN with an odd numbered remote LAN ID is mapped to port 3 (on the Cisco 600 OEAP). For example, a remote LAN with remote LAN ID 1 is mapped to port 3 (on the Cisco 600 OEAP).

- AP Groups—If you are using an AP group, the mapping to the OEAP-600 ports is determined by the order of the AP groups. To use an AP group, you must first delete all remote LANs and WLANs from the AP group leaving it empty. Then, add the two remote LANs to the AP group adding the port 3 AP remote LAN first, and the port 4 remote group second, followed by any WLANs.

- Save your changes by entering this command:

```plaintext
save config
```

**Note** If your controller supports only OfficeExtend access points, see the Configuring Radio Resource Management section for instructions on setting the recommended value for the DCA interval.

## Configuring a Personal SSID on an OfficeExtend Access Point Other than 600 Series OEAP

**Step 1** Find the IP address of your OfficeExtend access point by doing one of the following:

- Log on to your home router and look for the IP address of your OfficeExtend access point.
- Ask your company’s IT professional for the IP address of your OfficeExtend access point.
- Use an application such as Network Magic to detect devices on your network and their IP addresses.

**Step 2** With the OfficeExtend access point connected to your home router, enter the IP address of the OfficeExtend access point in the Address text box of your Internet browser and click **Go**.

**Note** Make sure that you are not connected to your company’s network using a virtual private network (VPN) connection.
Step 3  When prompted, enter the username and password to log into the access point.

Step 4  On the OfficeExtend Access Point Welcome page, click Enter. The OfficeExtend Access Point Home page appears.

Step 5  Choose Configuration to open the Configuration page.

Step 6  In the SSID text box, enter the personal SSID that you want to assign to this access point. This SSID is locally switched.

Note  A controller with an OfficeExtend access point publishes only up to 15 WLANs to each connected access point because it reserves one WLAN for the personal SSID.

Step 7  From the Security drop-down list, choose Open, WPA2/PSK (AES), or 104 bit WEP to set the security type to be used by this access point.

Note  If you choose WPA2/PSK (AES), make sure that the client is configured for WPA2/PSK and AES encryption.

Step 8  If you chose WPA2/PSK (AES) in Step 8, enter an 8- to 38-character WPA2 passphrase in the Secret text box. If you chose 104 bit WEP, enter a 13-character ASCII key in the Key text box.

Step 9  Click Apply.

Note  If you want to use the OfficeExtend access point for another application, you can clear this configuration and return the access point to the factory-default settings by clicking Clear Config. You can also clear the access point's configuration from the controller CLI by entering the clear ap config Cisco_AP command.

These steps can be used for configuring a personal SSID on OfficeExtend access points only. See the Aironet 600 Series OfficeExtend Access Point Configuration Guide for information on configuring a personal SSID on OEAP 600 APs.

### Viewing OfficeExtend Access Point Statistics

Use these commands to view information about the OfficeExtend access points on your network:

- See a list of all OfficeExtend access points by entering this command:
  
  `show flexconnect office-extend summary`

- See the link delay for OfficeExtend access points by entering this command:
  
  `show flexconnect office-extend latency`

- See the encryption state of all access points or a specific access point by entering this command:
  
  `show ap link-encryption {all | Cisco_AP}`

  This command also shows authentication errors, which track the number of integrity check failures, and replay errors, which track the number of times that the access point receives the same packet. See the data plane status for all access points or a specific access point by entering this command:

  `show ap data-plane {all | Cisco_AP}`

### Using Cisco Workgroup Bridges

#### Information About Cisco Workgroup Bridges

A workgroup bridge (WGB) is a mode that can be configured on an autonomous IOS access point to provide wireless connectivity to a lightweight access point on behalf of clients that are connected by Ethernet to the
WGB access point. A WGB connects a wired network over a single wireless segment by learning the MAC addresses of its wired clients on the Ethernet interface and reporting them to the lightweight access point using Internet Access Point Protocol (IAPP) messaging. The WGB provides wireless access connectivity to wired clients by establishing a single wireless connection to the lightweight access point. The lightweight access point treats the WGB as a wireless client.

A Cisco IOS AP as a WGB using the Cisco IOS 15.2 or later releases support Protected Extensible Authentication Protocol (PEAP) with the controller.

**Figure 48: WGB Example**

![Diagram of WGB Example](image)

**Note**

If the lightweight access point fails, the WGB attempts to associate to another access point.

The following are some guidelines for Cisco Workgroup Bridges:

- The WGB can be any autonomous access point that supports the workgroup bridge mode and is running Cisco IOS Release 12.4(3g)JA or later releases (on 32-MB access points) or Cisco IOS Release 12.3(8)JEB or later releases (on 16-MB access points). These access points include the AP1120, AP1121, AP1130, AP1231, AP1240, and AP1310. Cisco IOS releases prior to 12.4(3g)JA and 12.3(8)JEB are not supported.

**Note**

If your access point has two radios, you can configure only one for workgroup bridge mode. This radio is used to connect to the lightweight access point. We recommend that you disable the second radio.

Enable the workgroup bridge mode on the WGB as follows:

- On the WGB access point GUI, choose **Workgroup Bridge** for the role in radio network on the Settings > Network Interfaces page.

- On the WGB access point CLI, enter the **station-role workgroup-bridge command**.
Note
See the sample WGB access point configuration in the WGB Configuration Example section.

• The following features are supported for use with a WGB:
  ◦ Guest N+1 redundancy
  ◦ Local EAP
  ◦ Open, WEP 40, WEP 128, CKIP, WPA+TKIP, WPA2+AES, LEAP, EAP-FAST, and EAP-TLS authentication modes

• Wired clients connected to the WGB are not authenticated for security. Instead, the WGB is authenticated against the access point to which it associates. Therefore, we recommend that you physically secure the wired side of the WGB.

• Wired clients connected to a WGB inherit the WGB’s QoS and AAA override attributes.

• To enable the WGB to communicate with the lightweight access point, create a WLAN and make sure that Aironet IE is enabled.

• If you have to apply ACL to WGB during runtime, do not modify the ACL configuration for interface in the controller during runtime. If you need to modify any ACLs, then you must disable all WLANs that are in the controller or disable both the 802.11a and 80.11b networks. Also, ensure that there are no clients associated and mapped to that interface and then you can modify the ACL settings.

Restrictions for Cisco Workgroup Bridges

• The WGB can associate only with lightweight access points.

• Only WGBs in client mode (which is the default value) are supported. Those WGBs in infrastructure mode are not supported. Perform one of the following to enable client mode on the WGB:
  ◦ On the WGB access point GUI, choose Disabled for the Reliable Multicast to WGB parameter.
  ◦ On the WGB access point CLI, enter the no infrastructure client command.

Note
VLANs are not supported for use with WGBs.

Note
See the sample WGB access point configuration in the WGB Configuration Example section.

• The following features are not supported for use with a WGB:
  ◦ Idle timeout
  ◦ Web authentication
If a WGB associates to a web-authentication WLAN, the WGB is added to the exclusion list, and all of the WGB wired clients are deleted.

**Note**

- The WGB supports a maximum of 20 wired clients. If you have more than 20 wired clients, use a bridge or another device.

- The DirectStream feature from the controller does not work for clients behind workgroup bridges and the stream is denied.

- With Layer 3 roaming, if you plug a wired client into the WGB network after the WGB has roamed to another controller (for example, to a foreign controller), the wired client’s IP address displays only on the anchor controller, not on the foreign controller.

- If a wired client does not send traffic for an extended period of time, the WGB removes the client from its bridge table, even if traffic is continuously being sent to the wired client. As a result, the traffic flow to the wired client fails. To avoid the traffic loss, prevent the wired client from being removed from the bridge table by configuring the aging-out timer on the WGB to a large value using the following Cisco IOS commands on the WGB:

  ```
  configure terminal
  bridge bridge-group-number aging-time seconds
  exit
  end
  ```

  where `bridge-group-number` is a value between 1 and 255, and `seconds` is a value between 10 and 1,000,000 seconds. We recommend configuring the `seconds` parameter to a value greater than the wired client’s idle period.

- When you delete a WGB record from the controller, all of the WGB wired clients’ records are also deleted.

- These features are not supported for wired clients connected to a WGB:
  - MAC filtering
  - Link tests
  - Idle timeout

- The broadcast forwarding toward wired WGB clients works only on the native VLAN. If additional VLANs are configured, only the native VLAN forwards broadcast traffic.

- Wired clients behind a WGB cannot connect to a DMZ/Anchor controller. To enable wired clients behind a WGB to connect to an anchor controller in a DMZ, you must enable VLANs in the WGB using the `config wgb vlan enable` command.

- The `dot11 arp-cache` global configuration command that you can enter on the access point that is in WGB mode is not supported.

- WGB clients do not show enc-cipher and AKM because they are wired clients. WGB APs, however, show correct values of enc-cipher and AKM.
WGB Configuration Example

The following is an example of the configuration of a WGB access point using static WEP with a 40-bit WEP key:

```
ap# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.
ap(config)# dot11 ssid WGB_with_static_WEP
ap(config-ssid)# authentication open
ap(config-ssid)# guest-mode
ap(config-ssid)# exit
ap(config)# interface dot11Radio 0
ap(config)# station-role workgroup-bridge
ap(config-if)# encry mode wep 40
ap(config-if)# encry key 1 size 40 0 1234567890
ap(config-if)# ssid WGB_with_static_WEP
ap(config-if)# end
```

Verify that the WGB is associated to an access point by entering this command on the WGB:

```
show dot11 association
```

Information similar to the following appears:

```
ap# show dot11 associations
802.11 Client Stations on Dot11Radio0:
SSID (FCVTESTING):
MAC Address   IP address   Device Name   Parent   State
000b.8581.6aee 10.11.12.1   WGB-client map1   -   Assoc
```

Viewing the Status of Workgroup Bridges (GUI)

Step 1 Choose Monitor > Clients to open the Clients page. The WGB text box on the right side of the page indicates whether any of the clients on your network are workgroup bridges.

Step 2 Click the MAC address of the desired client. The Clients > Detail page appears. The Client Type text box under Client Properties shows "WGB" if this client is a workgroup bridge, and the Number of Wired Client(s) text box shows the number of wired clients that are connected to this WGB.

Step 3 See the details of any wired clients that are connected to a particular WGB as follows:
   a) Click Back on the Clients > Detail page to return to the Clients page.
   b) Hover your cursor over the blue drop-down arrow for the desired WGB and choose Show Wired Clients. The WGB Wired Clients page appears.
      Note If you want to disable or remove a particular client, hover your cursor over the blue drop-down arrow for the desired client and choose Remove or Disable, respectively.
   c) Click the MAC address of the desired client to see more details for this particular client. The Clients > Detail page appears.
The Client Type text box under Client Properties shows “WGB Client,” and the rest of the text boxes on this page provide additional information for this client.

**Viewing the Status of Workgroup Bridges (CLI)**

**Step 1**
See any WGBs on your network by entering this command:

```
show wgb summary
```

**Step 2**
See the details of any wired clients that are connected to a particular WGB by entering this command:

```
show wgb detail wgb_mac_address
```

**Debugging WGB Issues (CLI)**

**Before You Begin**
- Enable debugging for IAPP messages, errors, and packets by entering these commands:
  - `debug iapp all enable`—Enables debugging for IAPP messages.
  - `debug iapp error enable`—Enables debugging for IAPP error events.
  - `debug iapp packet enable`—Enables debugging for IAPP packets.

- Debug an roaming issue by entering this command:

```
debug mobility handoff enable
```

- Debug an IP assignment issue when DHCP is used by entering these commands:
  - `debug dhcp message enable`
  - `debug dhcp packet enable`

- Debug an IP assignment issue when static IP is used by entering these commands:
  - `debug dot11 mobile enable`
  - `debug dot11 state enable`
Using Non-Cisco Workgroup Bridges

Information About Non-Cisco Workgroup Bridges

When a Cisco workgroup bridge (WGB) is used, the WGB informs the access points of all the clients that it is associated with. The controller is aware of the clients associated with the access point. When non-Cisco WGBs are used, the controller has no information about the IP address of the clients on the wired segment behind the WGB. Without this information, the controller drops the following types of messages:

- ARP REQ from the distribution system for the WGB client
- ARP RPLY from the WGB client
- DHCP REQ from the WGB client
- DHCP RPLY for the WGB client

The following are some guidelines for non-Cisco workgroup bridges:

- The controller can accommodate non-Cisco WGBs so that the controller can forward ARP, DHCP, and data traffic to and from the wired clients behind workgroup bridges by enabling the passive client feature. To configure your controller to work with non-Cisco WGBs, you must enable the passive client feature so that all traffic from the wired clients is routed through the WGB to the access point. All traffic from the wired clients is routed through the workgroup bridge to the access point.

  Note  For FlexConnect APs in local switching, non-Cisco workgroup-bridge clients in bridged mode are supported using the \texttt{config flexconnect group group-name dhcp overridden-interface enable} command.

- When a WGB wired client leaves a multicast group, the downstream multicast traffic to other WGB wired clients is interrupted briefly.

- If you have clients that use PC virtualization software such as VMware, you must enable this feature.

  Note  We have tested multiple third-party devices for compatibility but cannot ensure that all non-Cisco devices work. Support for any interaction or configuration details on the third-party device should be discussed with the device manufacturer.

- You must enable the passive client functionality for all non-Cisco workgroup bridges.

- You might need to use the following commands to configure DHCP on clients:
  - Disable DHCP proxy by using the \texttt{config dhcp proxy disable} command.
  - Enable DHCP boot broadcast by using the \texttt{config dhcp proxy disable bootp-broadcast enable} command.
Restrictions for Non-Cisco Workgroup Bridges

- Only Layer 2 roaming is supported for WGB devices.
- Layer 3 security (web authentication) is not support for WGB clients.
- Visibility of wired hosts behind a WGB on a controller is not supported because the non-Cisco WGB device performs MAC hiding. Cisco WGB supports IAPP.
- ARP poisoning detection does not work on a WLAN when the flag is enabled.
- VLAN select is not supported for WGB clients.
- Some third-party WGBs need to operate in non-DHCP relay mode. If problems occur with the DHCP assignment on devices behind the non-Cisco WGB, use the `config dhcp proxy disable` and `config dhcp proxy disable bootp-broadcast disable` commands.

The default state is DHCP proxy enabled. The best combination depends on the third-party characteristics and configuration.

Configuring Backup Controllers

Information About Configuring Backup Controllers

A single controller at a centralized location can act as a backup for access points when they lose connectivity with the primary controller in the local region. Centralized and regional controllers do not need to be in the same mobility group. You can specify a primary, secondary, and tertiary controller for specific access points in your network. Using the controller GUI or CLI, you can specify the IP addresses of the backup controllers, which allows the access points to fail over to controllers outside of the mobility group.

The following are some guidelines for configuring backup controllers:

- You can configure primary and secondary backup controllers (which are used if primary, secondary, or tertiary controllers are not specified or are not responsive) for all access points connected to the controller as well as various timers, including heartbeat timers and discovery request timers. To reduce the controller failure detection time, you can configure the fast heartbeat interval (between the controller and the access point) with a smaller timeout value. When the fast heartbeat timer expires (at every heartbeat interval), the access point determines if any data packets have been received from the controller within the last interval. If no packets have been received, the access point sends a fast echo request to the controller.

- The access point maintains a list of backup controllers and periodically sends primary discovery requests to each entry on the list. When the access point receives a new discovery response from a controller, the backup controller list is updated. Any controller that fails to respond to two consecutive primary discovery requests is removed from the list. If the access point’s local controller fails, it chooses an available controller from the backup controller list in this order: primary, secondary, tertiary, primary backup, and secondary backup. The access point waits for a discovery response from the first available controller in the backup list and joins the controller if it receives a response within the time configured for the primary discovery request timer. If the time limit is reached, the access point assumes that the controller cannot be joined and waits for a discovery response from the next available controller in the list.
• When an access point's primary controller comes back online, the access point disassociates from the backup controller and reconnects to its primary controller. The access point falls back only to its primary controller and not to any available secondary controller for which it is configured. For example, if an access point is configured with primary, secondary, and tertiary controllers, it fails over to the tertiary controller when the primary and secondary controllers become unresponsive. If the secondary controller comes back online while the primary controller is down, the access point does not fall back to the secondary controller and stays connected to the tertiary controller. The access point waits until the primary controller comes back online to fall back from the tertiary controller to the primary controller. If the tertiary controller fails and the primary controller is still down, the access point then falls back to the available secondary controller.

Restrictions for Configuring Backup Controllers

• You can configure the fast heartbeat timer only for access points in local and FlexConnect modes.

Configuring Backup Controllers (GUI)

Step 1 Choose Wireless > Access Points > Global Configuration to open the Global Configuration page.

Step 2 From the Local Mode AP Fast Heartbeat Timer State drop-down list, choose Enable to enable the fast heartbeat timer for access points in local mode or choose Disable to disable this timer. The default value is Disable.

Step 3 If you chose Enable in Step 2, enter the Local Mode AP Fast Heartbeat Timeout text box to configure the fast heartbeat timer for access points in local mode. Specifying a small heartbeat interval reduces the amount of time it takes to detect a controller failure.

The range for the AP Fast Heartbeat Timeout value for Cisco Flex 7500 Controllers is 10–15 (inclusive) and is 1–10 (inclusive) for other controllers. The default value for the heartbeat timeout for Cisco Flex 7500 Controllers is 10. The default value for other controllers is 1 second.

Step 4 From the FlexConnect Mode AP Fast Heartbeat Timer State drop-down list, choose Enable to enable the fast heartbeat timer for FlexConnect access points or choose Disable to disable this timer. The default value is Disable.

Step 5 If you enable FlexConnect fast heartbeat, enter the FlexConnect Mode AP Fast Heartbeat Timeout value in the FlexConnect Mode AP Fast Heartbeat Timeout text box. Specifying a small heartbeat interval reduces the amount of time it takes to detect a controller failure.

The range for the FlexConnect Mode AP Fast Heartbeat Timeout value for Cisco Flex 7500 Controllers is 10–15 (inclusive) and is 1–10 for other controllers. The default value for the heartbeat timeout for Cisco Flex 7500 Controllers is 10. The default value for other controllers is 1 second.

Step 6 In the AP Primary Discovery Timeout text box, a value between 30 and 3600 seconds (inclusive) to configure the access point primary discovery request timer. The default value is 120 seconds.

Step 7 If you want to specify a primary backup controller for all access points, enter the IPv4/IPv6 address of the primary backup controller in the Back-up Primary Controller IP Address (IPv4/IPv6) text box and the name of the controller in the Back-up Primary Controller Name text box.

Note The default value for the IP address is 0.0.0.0, which disables the primary backup controller.
Step 8 If you want to specify a secondary backup controller for all access points, enter the IPv4/IPv6 address of the secondary backup controller in the Back-up Secondary Controller IP Address (IPv4/IPv6) text box and the name of the controller in the Back-up Secondary Controller Name text box.

Note The default value for the IP address is 0.0.0.0, which disables the secondary backup controller.

Step 9 Click Apply to commit your changes.

Step 10 Configure primary, secondary, and tertiary backup controllers for a specific access point as follows:

a) Choose Access Points > All APs to open the All APs page.
b) Click the name of the access point for which you want to configure primary, secondary, and tertiary backup controllers.
c) Choose the High Availability tab to open the All APs > Details for (High Availability) page.
d) If desired, enter the name and IP address of the primary controller for this access point in the Primary Controller text boxes.

Note Entering an IP address for the backup controller is optional in this step and the next two steps. If the backup controller is outside the mobility group to which the access point is connected (the primary controller), then you need to provide the IP address of the primary, secondary, or tertiary controller, respectively. The controller name and IP address must belong to the same primary, secondary, or tertiary controller. Otherwise, the access point cannot join the backup controller.

e) If desired, enter the name and IP address of the secondary controller for this access point in the Secondary Controller text boxes.
f) If desired, enter the name and IP address of the tertiary controller for this access point in the Tertiary Controller text boxes.
g) Click Apply to commit your changes.

Step 11 Click Save Configuration to save your changes.

---

Configuring Backup Controllers (CLI)

Step 1 Configure a primary controller for a specific access point by entering this command:

```
config ap primary-base controller_name Cisco_AP [controller_ip_address]
```

Note The controller_ip_address parameter in this command and the next two commands is optional. If the backup controller is outside the mobility group to which the access point is connected (the primary controller), then you need to provide the IP address of the primary, secondary, or tertiary controller, respectively. In each command, the controller_name and controller_ip_address must belong to the same primary, secondary, or tertiary controller. Otherwise, the access point cannot join the backup controller.

Step 2 Configure a secondary controller for a specific access point by entering this command:

```
config ap secondary-base controller_name Cisco_AP [controller_ip_address]
```

Step 3 Configure a tertiary controller for a specific access point by entering this command:

```
config ap tertiary-base controller_name Cisco_AP [controller_ip_address]
```

Step 4 Configure a primary backup controller for all access points by entering this command:

```
config advanced backup-controller primary system name ip_addr
```

Note This command is valid for both IPv4 and IPv6.
Step 5 Configure a secondary backup controller for all access points by entering this command:
`config advanced backup-controller secondary system name ip_addr`

**Note** To delete a primary or secondary backup controller entry, enter `0.0.0.0` for the controller IPv4/IPv6 address.

**Note** This command is valid for both IPv4 and IPv6.

Step 6 Enable or disable the fast heartbeat timer for local or FlexConnect access points by entering this command:
`config advanced timers ap-fast-heartbeat {local | flexconnect | all} {enable | disable} interval`

where `all` is both local and FlexConnect access points, and `interval` is a value between 1 and 10 seconds (inclusive).

Specifying a small heartbeat interval reduces the amount of time that it takes to detect a controller failure. The default value is disabled. Configure the access point heartbeat timer by entering this command:

`config advanced timers ap-heartbeat-timeout interval`

where `interval` is a value between 1 and 30 seconds (inclusive). This value should be at least three times larger than the fast heartbeat timer. The default value is 30 seconds.

**Caution** Do not enable the fast heartbeat timer with the high latency link. If you have to enable the fast heartbeat timer, the timer value must be greater than the latency.

Step 7 Configure the access point primary discovery request timer by entering this command:
`config advanced timers ap-primary-discovery-timeout interval`

where `interval` is a value between 30 and 3600 seconds. The default value is 120 seconds.

Step 8 Configure the access point discovery timer by entering this command:
`config advanced timers ap-discovery-timeout interval`

where `interval` is a value between 1 and 10 seconds (inclusive). The default value is 10 seconds.

Step 9 Configure the 802.11 authentication response timer by entering this command:
`config advanced timers auth-timeout interval`

where `interval` is a value between 5 and 600 seconds (inclusive). The default value is 10 seconds.

Step 10 Save your changes by entering this command:
`save config`

Step 11 See an access point’s configuration by entering these commands:

- `show ap config general Cisco_AP`
- `show advanced backup-controller`
- `show advanced timers`

Information similar to the following appears for the `show ap config general Cisco_AP` command for Primary Cisco Switch IP Address using IPv4:

```
Cisco AP Identifier.............................. 1
Cisco AP Name.................................... AP5
Country code..................................... US - United States
Regulatory Domain allowed by Country............. 802.11bg:-AB 802.11a:-AB
AP Country code.................................. US - United States
AP Regulatory Domain............................. 802.11bg:-A 802.11a:-N
Switch Port Number .............................. 1
MAC Address...................................... 00:13:80:60:48:3e
```
IP Address Configuration.........................  DHCP
IP Address....................................... 1.100.163.133
...
Primary Cisco Switch Name........................ 1-5508
Primary Cisco Switch IP Address.................. 2.2.2.2
Secondary Cisco Switch Name..................... 1-4404
Secondary Cisco Switch IP Address................ 2.2.2.2
Tertiary Cisco Switch Name........................ 2-4404
Tertiary Cisco Switch IP Address................. 1.1.1.4
...

Information similar to the following appears for the show ap config general Cisco_AP command for Primary Cisco Switch IP Address using IPv6:

Cisco AP Identifier.............................. 1
Cisco AP Name.................................... AP6
Country code..................................... US - United States
Regulatory Domain allowed by Country............ 802.11bg:-A 802.11a:-A
AP Country code.................................. US - United States
AP Regulatory Domain............................. 802.11bg:-A 802.11a:-A
Switch Port Number ................................ 13
MAC Address...................................... 44:2b:03:9a:9d:30
IPv6 Address Configuration....................... DHCPv6
IPv6 Prefix Length............................... 128
Gateway IPv6 Addr................................ fe80::6abd:abff:fe8c:764a
NAT External IP Address.......................... None
CAPWAP Path MTU.................................. 1473
Telnet State...................................... Globally Disabled
Ssh State......................................... Globally Disabled
Cisco AP Location............................... _5500
Cisco AP Floor Label............................ 0
Cisco AP Group Name............................ IPv6-Same_VLAN
Primary Cisco Switch Name....................... Maulik_WLC_5500-HA
Primary Cisco Switch IP Address................. 2001:9:5:95::11

Information similar to the following appears for the show advanced backup-controller command when configured using IPv4:

AP primary Backup Controller .................. controller1 10.10.10.10
AP secondary Backup Controller ................. 0.0.0.0

Information similar to the following appears for the show advanced backup-controller command when configured using IPv6:

AP primary Backup Controller .................. WLC_5500-2 fd09:9:5:94::11
AP secondary Backup Controller ................. vWLC 9.5.92.11

Information similar to the following appears for the show advanced timers command:

Authentication Response Timeout (seconds)...... 10
Configuring High Availability

This section describes how to configure high availability.

Information About High Availability

High availability (HA) in controllers allows you to reduce the downtime of the wireless networks that occurs due to the failover of controllers.

A 1:1 (Active:Standby-Hot) stateful switchover of access points (AP SSO) is supported. In an HA architecture, one controller is configured as the primary controller and another controller as the secondary controller.

After you enable HA, the primary and secondary controllers are rebooted. During the boot process, the role of the primary controller is negotiated as active and the role of the secondary controller as standby-hot. After a switchover, the secondary controller becomes the active controller and the primary controller becomes the standby-hot controller. After subsequent switchovers, the roles are interchanged between the primary and the secondary controllers. The reason for switchovers are either because of manual trigger, or a controller, or network failure.

During an AP SSO, all the AP sessions statefully switch over and all the clients are deauthenticated and reassocaited with the new active controller except for the locally switched clients in the FlexConnect mode.

The standby-hot controller continuously monitors the health of the active controller through a direct wired connection over a dedicated redundancy port. Both the controllers share the same configurations, including the IP address of the management interface.

Before you enable HA, ensure that both the controllers are physically connected through the redundant port using an Ethernet cable. Also, ensure that the uplink is connected to an infrastructure switch and that the gateway is reachable from both the controllers.

In HA architecture, the redundancy port and redundant management interfaces have been introduced.

ACL and NAT IP configurations are synchronized to the HA standby controller when these parameters are configured before HA pair-up. If the NAT IP is set on the management interface, the access point sets the AP manager IP address as the NAT IP address. This issue is seen only when the NAT IP address and ACL are set on the management interface before you enable high availability.

The following are some guidelines for high availability:

- We recommend that you do not pair two controllers of different hardware models. If they are paired, the higher controller model becomes the active controller and the other controller goes into maintenance mode.
• We recommend that you do not pair two controllers on different controller software releases. If they are paired, the controller with the lower redundancy management address becomes the active controller and the other controller goes into maintenance mode.

• All download file types, such as image, configuration, web-authentication bundle, and signature files—are downloaded on the active controller first and then pushed to the standby-hot controller.

• Certificates should be downloaded separately on each controller before they are paired.

• You can upload file types such as configuration files, event logs, crash files, and so on, from the standby-hot controller using the GUI or CLI of the active controller. You can also specify a suffix to the filename to identify the uploaded file.

• To perform a peer upload, use the service port. In a management network, you can also use the redundancy management interface (RMI) that is mapped to the redundancy port or RMI VLAN, or both, where the RMI is the same as the management VLAN. Note that the RMI and the redundancy port should be in two separate Layer2 VLANs, which is a mandatory configuration.

• If the controllers cannot reach each other through the redundant port and the RMI, the primary controller becomes active and the standby-hot controller goes into the maintenance mode.

---

**Note**

To achieve HA between two Cisco Wireless Services Module 2 (WiSM2) platforms, the controllers should be deployed on a single chassis, or on multiple chassis using a virtual switching system (VSS) and extending a redundancy VLAN between the multiple chassis.

---

**Note**

A redundancy VLAN should be a nonroutable VLAN in which a Layer 3 interface should not be created for the VLAN, and the interface should be allowed on the trunk port to extend an HA setup between multiple chassis. Redundancy VLAN should be created like any other data VLAN on Cisco IOS-based switching software. A redundancy VLAN is connected to the redundant port on Cisco WiSM2 through the backplane. It is not necessary to configure the IP address for the redundancy VLAN because the IP address is automatically generated. Also, ensure that the redundancy VLAN is not the same as the management VLAN.

---

**Note**

When the RMIs for two controllers that are a pair, and that are mapped to same VLAN and connected to same Layer3 switch stop working, the standby controller is restarted.

---

**Note**

The "mobilityHaMac is out of range" xml message is seen during the active/standby second switch over in HA setup. This occurs if mobility HA mac field is more than 128.

---

• When HA is enabled, the standby controller always uses RMI and all the other interfaces, dynamic and management, are invalid. A ping must only accept RMI as source and not other interfaces.

• When HA is enabled, ensure that you do not use the backed-up image. If this image is used, the HA feature might not work as expected.
- The service port and route information that is configured is lost after you enable SSO. You must configure the service port and route information again after you enable SSO. You can configure the service port and route information for the standby-hot controller using the `peer-service-port` and `peer-route` commands.

- For Cisco WiSM2, service port reconfigurations are required after you enable redundancy. Otherwise, Cisco WiSM2 might not be able to communicate with the supervisor. We recommend that you enable DHCP on the service port before you enable redundancy.

- We recommend that you do not use the `reset` command on the standby-hot controller directly. If you use this, unsaved configurations will be lost.

- We recommend that you enable link aggregation configuration on the controllers before you enable the port channel in the infrastructure switches.

- All the configurations that require reboot of the active controller results in the reboot of the standby-hot controller.

- The Ignore AP list is not synchronized from the active controller to the standby-hot controller. The list is relearned through SNMP messages from Cisco Prime Infrastructure after the standby-hot controller becomes active.

- In Release 7.3.x, AP SSO is supported, but client SSO is not supported, which means that after an HA setup that uses Release 7.3.x encounters a switchover, all the clients associated with the controller are deauthenticated and forced to reassociate.

- You must manually configure the mobility MAC address on the then active controller post switchover, when a peer controller has a controller software release that is prior to Release 7.2.

**Redundancy Management Interface**

The active and standby-hot controllers use the RMI to check the health of the peer controller and the default gateway of the management interface through network infrastructure.

The RMI is also used to send notifications from the active controller to the standby-hot controller if a failure or manual reset occurs. The standby-hot controller uses the RMI to communicate to the syslog, NTP/SNTP server, FTP, and TFTP server.

It is mandatory to configure the IP addresses of the Redundancy Management Interface and the Management Interface in the same subnet on both the primary and secondary controllers.

**Redundancy Port**

The redundancy port is used for configuration, operational data synchronization, and role negotiation between the primary and secondary controllers.

The redundancy port checks for peer reachability by sending UDP keepalive messages every 100 milliseconds (default frequency) from the standby-hot controller to the active controller. If a failure of the active controller occurs, the redundancy port is used to notify the standby-hot controller.

If an NTP/SNTP server is not configured, the redundancy port performs a time synchronization from the active controller to the standby-hot controller.

In Cisco WiSM2, the redundancy VLAN must be configured on the Cisco Catalyst 6000 Supervisor Engine because there is no physical redundancy port available on Cisco WiSM2.

The redundancy port and the redundancy VLAN in Cisco WiSM2 are assigned an automatically generated IP address in which the last two octets are obtained from the last two octets of the RMI. The first two octets
Restrictions on High Availability

• We recommend that you do not disable LAG physical ports when HA SSO is enabled.

• HA is not supported on the Cisco 2500 Series and Cisco Virtual Wireless LAN Controllers.

• When you configure the controller for AP SSO, the Cisco 600 Series OfficeExtend Access Points are not supported.

• In an HA environment using FlexConnect locally switched clients, the client information might not show the username. To get details about the client, you must use the MAC address of the client. This restriction does not apply to FlexConnect centrally switched clients or central (local) mode clients.

• It is not possible to access the Cisco WiSM2 GUI through the service interface when you have enabled HA. The workaround is to create a service port interface again after HA is established.

• In an HA environment, an upgrade from an LDPE image to a non-LDPE image is not supported.

• It is not possible to pair two primary controllers or two secondary controllers.

• Standby controllers are unavailable on the APs connected switch port

• An HA-SKU controller with an evaluation license cannot become a standby controller. However, an HA-SKU controller with zero license can become a standby controller.

• Service VLAN configuration is lost when moving from HA mode to non-HA mode and vice versa. You should configure the service IP address manually again.

• The following scenario is not supported: The primary controller has the management address and the redundancy management address in the same VLAN, and the secondary controller has the management address in the same VLAN as the primary one, and the redundancy management address in a different VLAN.

• The following is a list of some software upgrade scenarios:
  
  • A software upgrade on the active controller ensures the upgrade of the standby-hot controller.

  • An in-service upgrade is not supported. Therefore, you should plan your network downtime before you upgrade the controllers in an HA environment.

  • Rebooting the active controller after a software upgrade also reboots the standby-hot controller.

  • If both active and standby-hot controllers have different software releases in the backup, and if you enter the `config boot backup` command in the active controller, both the controllers reboot with their respective backup images breaking the HA pair due to a software mismatch.

  • A schedule reset applies to both the controllers in an HA environment. The peer controller reboots a minute before the scheduled time expires on the active controller.

  • You can reboot the standby-hot controller from the active controller by entering the `reset peer-system` command if the scheduled reset is not planned. If you reset only the standby-hot controller with this command, any unsaved configurations on the standby-hot controller is lost. Therefore, ensure that you save the configurations on the active controller before you reset the standby-hot controller.
A preimage download is reinitiated if an SSO is triggered at the time of the image transfer.

- Only **debug** and **show** commands are allowed on the standby-hot controller.

- It is not possible to access the standby-hot controller through the controller GUI, Cisco Prime Infrastructure, or Telnet. You can access the standby-hot controller only on its console.

- When a failover occurs, the standby controller must be in a standby-hot state and the redundant port in a terminal state in SSO for successful switchover to occur.

- To enable or disable LAG, you must disable HA.

  **Note**  
  If LAG is disabled and both primary and backup ports are connected to the management interface and if the primary port becomes nonoperational, a switchover might occur because the default gateway is not reachable and backup port failover might exceed 12 seconds.

- Pairwise Master Key (PMK) cache synchronization is not supported on FlexConnect local-authenticated clients.

- You cannot change the NAT address configuration of the management interface when the controllers are in redundancy mode. To enable NAT address configuration on the management interface, you must remove the redundancy configuration first, make the required changes on the primary controller, and then reenable the redundancy configuration on the same controller.

- After you enable SSO, you must access both the standby and active controller using:
  - The console connection
  - SSH facility on the service port
  - SSH facility on the redundant management interface

  **Note**  
  While SSO is enabled, you cannot access both the standby and active controller either using the web UI/the telnet facility or using Cisco Prime Infrastructure/Prime NCS on the service port.

- Synchronization of bulk configurations is supported only for the configurations that are stored in XMLs. Scheduled reboot is a configuration that is not stored in XMLs or Flash. Therefore, the scheduled reboot configuration is not included in the synchronization of bulk configurations.

- When a switchover occurs, the controller does not synchronize the information on DHCP dirty bit from the active to standby controller even when DHCP dirty bit is set on the active controller. After a switchover, the controller populates the DHCP dirty bit based on the client DHCP retries.

- If you are using Cisco WiSM2, we recommend that you use the following release versions of Cisco IOS on Cisco Catalyst 6500 Series Supervisor Engine 2T:
  - 15.1(02)SY
  - 15.1(01)ICB40.1
  - 15.1(01)ICB29.36
Configuring High Availability (GUI)

Before You Begin
Ensure that the management interfaces of both controllers are in the same subnet. You can verify this on the GUI of both the controllers by choosing **Controllers > Interfaces** and viewing the IP addresses of the management interface.

---

**Step 1**
On the GUI of both the controllers, choose **Controller > Redundancy > Global Configuration**. The **Global Configuration** page is displayed.

**Step 2**
Enter the addresses of the controllers in the **Redundant Management IP** and the **Peer Redundant Management IP** text boxes.

*Note* Ensure that the Redundant Management Interface IP address of one controller is the same as the Redundant Management Interface IP address of the peer controller.

**Step 3**
From the **Redundant Unit** drop-down list, choose one of the controllers as primary and the other as secondary.

**Step 4**
On the GUI of both the controllers, set the **SSO** to Enabled state.

*Note* After you enable an SSO, the service port peer IP address and the service port netmask appear on the configuration page. Note that the service port peer IP address and the netmask can be pushed to the peer only if the HA peer is available and operational. When you enable high availability, you do not have to configure the service port peer IP address and the service port netmask parameters. You must configure the parameters only when the HA peer is available and operational. After you enable SSO, both the controllers are rebooted. During the reboot process, the controllers negotiate the redundancy role through the redundant port based on the configuration. The primary controller becomes the active controller and the secondary controller becomes the standby controller.

**Step 5**
(Optional) When the HA pair becomes available and operational, you can configure the peer service port IP address and the netmask when the service port is configured as static. If you enable DHCP on the service port, you do not have to configure these parameters on the **Global Configuration** page:

- **Service Port Peer IP**—IP address of the service port of the peer controller.
- **Service Port Peer Netmask**—Netmask of the service port of the peer controller.
- **Mobility MAC Address**—A common MAC address for the active and standby controllers that is used in the mobility protocol. If an HA pair has to be added as a mobility member for a mobility group, the mobility MAC address (instead of the system MAC address of the active or standby controller) should be used. Normally, the mobility MAC address is chosen as the MAC address of the active controller and you do not have to manually configure this.
- **Keep Alive Timer**—The timer that controls how often the standby controller sends keepalive messages to the active controller. The valid range is between 100 to 1000 milliseconds.
- **Peer Search Timer**—The timer that controls how often the active controller sends peer search messages to the standby controller. The valid range is between 60 to 300 seconds.
After you enable the high availability and pair the controllers, there is only one unified GUI to manage the HA pair through the management port. GUI access through the service port is not feasible for both the active and standby controllers. The standby controller can be managed only through the console or the service port.

Only Telnet and SSH sessions are allowed through the service port of the active and standby controllers.

**Step 6** Click Apply.

**Step 7** Click Save Configuration.

**Step 8** View the redundancy status of the HA pair by choosing Monitor > Redundancy > Summary. The *Redundancy Summary* page is displayed.

**Step 9** Follow these steps to configure the peer network route:

a) Choose Controller > Redundancy > Peer Network Route. The *Network Routes Peer* page is displayed.

b) To create a new peer network route, click New.

c) Enter the IP address, IP netmask, and the Gateway IP address of the route.

d) Click Apply.

---

**Configuring High Availability (CLI)**

**Before You Begin**

Ensure that the management interfaces of both controllers are in the same subnet.

To configure high availability in controllers, you must:

- Configure a local-redundancy IP address and a peer-redundancy management IP address by entering this command:

  ```
  config interface address redundancy-management ip-addr1 peer-redundancy-management ip-addr2
  ```

- Configure the role of a controller by entering this command:

  ```
  config redundancy unit {primary | secondary}
  ```

- Configure the redundancy mode by entering this command:

  ```
  config redundancy mode {sso | none}
  ```

  **Note** Both controllers reboot and then negotiate the roles of active and standby-hot controllers.

- Configure the route configurations of the standby controller by entering this command:

  ```
  config redundancy peer-route {add network-ip-addr ip-mask | delete network-ip-addr}
  ```

  **Note** This command can be run only if the HA peer controller is available and operational.
• Configure a mobility MAC address by entering this command:
  `config redundancy mobility mac mac-addr`

**Note**
This command can be run only when SSO is disabled.

• Configure the IP address and netmask of the peer service port of the standby controller by entering this command:
  `config redundancy interface address peer-service-port ip-address netmask`

This command can be run only if the HA peer controller is available and operational.

• Initiate a manual switchover by entering this command:
  `redundancy force-switchover`

**Note**
Execute this command only when you require a manual switchover.

• Configure a redundancy timer by entering this command:
  `config redundancy timer {keep-alive-timer time-in-milliseconds | peer-search-timer time-in-seconds}`

• View the status of redundancy by entering this command:
  `show redundancy summary`

• View information about the Redundancy Management Interface by entering this command:
  `show interface detailed redundancy-management`

• View information about the redundancy port by entering this command:
  `show interface detailed redundancy-port`

• Reboot a peer controller by entering this command:
  `reset peer-system`

• Start the upload of file types, such as configuration, event logs, crash files, and so on from the standby-hot controller by entering this command on the active controller:
  `transfer upload peer-start`

• Debug the redundancy modules by entering these commands:

  **Note**
  Ensure that SSO is enabled to use these debug commands. Enter `config redundancy mode SSO` command to enable SSO.

  `debug redundancy {infra | facilitator | transport | keepalive | gw-reachability | config-sync | ap-sync | client-sync | mobility}`

  • **infra**—Configures debug of Redundancy Infra Module
  • **facilitator**—Configures debug of Redundancy Facilitator Module
  • **transport**—Configures debug of Redundancy Transport Module
  • **keepalive**—Configures debug of Redundancy Keepalive Module
  • **gw-reachability**—Configures debug of Redundancy Gw-reachability Module
• **config-sync**—Configures debug of Redundancy Config-Sync Module
• **ap-sync**—Configures debug of Redundancy AP-Sync Module
• **client-sync**—Configures debug of Redundancy Client-Sync Module
• **mobility**—Configures debug of Redundancy Mobility Module

### Configuring Failover Priority for Access Points

#### Information About Configuring Failover Priority for Access Points

Each controller has a defined number of communication ports for access points. When multiple controllers with unused access point ports are deployed on the same network and one controller fails, the dropped access points automatically poll for unused controller ports and associate with them.

The following are some guidelines for configuring failover priority for access points:

- You can configure your wireless network so that the backup controller recognizes a join request from a higher-priority access point and if necessary disassociates a lower-priority access point as a means to provide an available port.

- Failover priority is not in effect during the regular operation of your wireless network. It takes effect only if there are more association requests after a controller failure than there are available backup controller ports.

- To configure this feature, you must enable failover priority on your network and assign priorities to the individual access points.

- By default, all access points are set to priority level 1, which is the lowest priority level. Therefore, you need to assign a priority level only to those access points that warrant a higher priority.

#### Configuring Failover Priority for Access Points (GUI)

**Step 1** Choose **Wireless > Access Points > Global Configuration** to open the Global Configuration page.

**Step 2** From the Global AP Failover Priority drop-down list, choose **Enable** to enable access point failover priority or choose **Disable** to disable this feature and turn off any access point priority assignments. The default value is **Disable**.

**Step 3** Click **Apply** to commit your changes.

**Step 4** Click **Save Configuration** to save your changes.

**Step 5** Choose **Wireless > Access Points > All APs** to open the All APs page.

**Step 6** Click the name of the access point for which you want to configure failover priority.

**Step 7** Choose the **High Availability** tab. The All APs > Details for (High Availability) page appears.

**Step 8** From the AP Failover Priority drop-down list, choose one of the following options to specify the priority of the access point:
Configuring Failover Priority for Access Points (CLI)

Step 1
Enable or disable access point failover priority by entering this command:
```
cfg network ap-priority {enable | disable}
```

Step 2
Specify the priority of an access point by entering this command:
```
cfg ap priority {1 | 2 | 3 | 4} Cisco_AP
```
where 1 is the lowest priority level and 4 is the highest priority level. The default value is 1.

Step 3
Enter the `save config` command to save your changes.

Viewing Failover Priority Settings (CLI)

- Confirm whether access point failover priority is enabled on your network by entering this command:
  
  `show network summary`

  Information similar to the following appears:

  ```
  RF-Network Name......................... mrf
  Web Mode.................................. Enable
  Secure Web Mode........................... Enable
  Secure Web Mode Cipher-Option High..... Disable
  Secure Shell (ssh).......................... Enable
  Telnet.................................... Enable
  Ethernet Multicast Mode................... Disable
  Ethernet Broadcast Mode................... Disable
  IGMP snooping............................ Disabled
  IGMP timeout............................. 60 seconds
  User Idle Timeout......................... 300 seconds
  ARP Idle Timeout.......................... 300 seconds
  Cisco AP Default Master.................. Disable
  AP Join Priority......................... Disabled
  ...
  ```

- See the failover priority for each access point by entering this command:
show ap summary

Information similar to the following appears:

Number of APs.................................... 2
Global AP User Name.............................. user
Global AP Dot1x User Name....................... Not Configured

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slots</th>
<th>AP Model</th>
<th>Ethernet MAC</th>
<th>Location</th>
<th>Port</th>
<th>Country</th>
<th>Priority</th>
</tr>
</thead>
</table>

To see the summary of a specific access point, you can specify the access point name. You can also use wildcard searches when filtering for access points.

Configuring Access Point Retransmission Interval and Retry Count

Information About Configuring the AP Retransmission Interval and Retry Count

The controller and the APs exchange packets using the CAPWAP reliable transport protocol. For each request, a response is defined. This response is used to acknowledge the receipt of the request message. Response messages are not explicitly acknowledged; therefore, if a response message is not received, the original request message is retransmitted after the retransmit interval. If the request is not acknowledged after a maximum number of retransmissions, the session is closed and the APs reassociate with another controller.

Restrictions for Access Point Retransmission Interval and Retry Count

- You can configure the retransmission intervals and retry count both at a global as well as a specific access point level. A global configuration applies these configuration parameters to all the access points. That is, the retransmission interval and the retry count are uniform for all access points. Alternatively, when you configure the retransmission level and retry count at a specific access point level, the values are applied to that particular access point. The access point specific configuration has a higher precedence than the global configuration.
- Retransmission intervals and the retry count do not apply for mesh access points.

Configuring the AP Retransmission Interval and Retry Count (GUI)

You can configure the retransmission interval and retry count for all APs globally or a specific AP.

Step 1

To configure the controller to set the retransmission interval and retry count globally using the controller GUI, follow these steps:

a) Choose **Wireless > Access Points > Global Configuration**.

b) Choose one of the following options under the AP Transmit Config Parameters section:
• **AP Retransmit Count**—Enter the number of times you want the access point to retransmit the request to the controller. This parameter can take values between 3 and 8.

• **AP Retransmit Interval**—Enter the time duration between the retransmission of requests. This parameter can take values between 2 and 5.

c) Click **Apply**.

### Step 2

To configure the controller to set the retransmission interval and retry count for a specific access point, follow these steps:

a) Choose **Wireless > Access Points > All APs**.

b) Click on the AP Name link for the access point on which you want to set the values. The **All APs > Details** page appears.

c) Click the **Advanced Tab** to open the advanced parameters page.

d) Choose one of the following parameters under the AP Transmit Config Parameters section:

   • **AP Retransmit Count**—Enter the number of times that you want the access point to retransmit the request to the controller. This parameter can take values between 3 and 8.

   • **AP Retransmit Interval**—Enter the time duration between the retransmission of requests. This parameter can take values between 2 and 5.

e) Click **Apply**.

### Configuring the Access Point Retransmission Interval and Retry Count (CLI)

You can configure the retransmission interval and retry count for all access points globally or a specific access point.

- Configure the retransmission interval and retry count for all access points globally by entering the this command:

  ```
  config ap retransmit {interval | count} seconds all
  ```

  The valid range for the **interval** parameter is between 3 and 8. The valid range for the **count** parameter is between 2 and 5.

- Configure the retransmission interval and retry count for a specific access point, by entering this command:

  ```
  config ap retransmit {interval | count} seconds Cisco_AP
  ```

  The valid range for the **interval** parameter is between 3 and 8. The valid range for the **count** parameter is between 2 and 5.

- See the status of the configured retransmit parameters on all or specific APs by entering this command:

  ```
  show ap retransmit all
  ```
Because retransmit and retry values cannot be set for access points in mesh mode, these values are displayed as N/A (not applicable).

- See the status of the configured retransmit parameters on a specific access point by entering this command:
  ```
  show ap retransmit Cisco_AP
  ```

## Configuring Country Codes

### Information About Configuring Country Codes

Controllers and access points are designed for use in many countries with varying regulatory requirements. The radios within the access points are assigned to a specific regulatory domain at the factory (such as -E for Europe), but the country code enables you to specify a particular country of operation (such as FR for France or ES for Spain). Configuring a country code ensures that each radio’s broadcast frequency bands, interfaces, channels, and transmit power levels are compliant with country-specific regulations.

The following are some guidelines for configuring country codes:

- Generally, you configure one country code per controller, the one matching the physical location of the controller and its access points. However, you can configure more than one country code per Cisco WLC. Prior to Release 8.2, you could configure up to 20 country codes per Cisco WLC; from Release 8.2 onwards, you can configure up to 110 country codes per Cisco WLC. This multiple-country support enables you to manage access points in various countries from a single Cisco WLC.

- Although the controller supports different access points in different regulatory domains (countries), it requires all radios in a single access point to be configured for the same regulatory domain. For example, you should not configure a Cisco 1231 access point’s 802.11b/g radio for the US (-A) regulatory domain and its 802.11a radio for the Great Britain (-E) regulatory domain. Otherwise, the controller allows only one of the access point’s radios to turn on, depending on which regulatory domain you selected for the access point on the controller. Therefore, make sure that the same country code is configured for both of the access point’s radios.


- When the multiple-country feature is being used, all controllers that are going to join the same RF group must be configured with the same set of countries, configured in the same order.

- When multiple countries are configured and the RRM auto-RF feature is enabled, the RRM assigns the channels that are derived by performing a union of the allowed channels per the AP country code. The APs are assigned channels by the RRM based on their PID country code. APs are only allowed to use legal frequencies that match their PID country code. Ensure that your APs’ country code is legal in the country that it is deployed.

- The country list configured on the RF group leader determines what channels the members would operate on. This list is independent of what countries have been configured on the RF group members.
Information About Japanese Country Codes

Country codes define the channels that can be used legally in each country. These country codes are available for Japan:

- **JP**—Allows only -J radios to join the controller
- **J2**—Allows only -P radios to join the controller
- **J3**—Uses the -U frequencies but allows -U, -P and -Q (other than 1550/1600/2600/3600) radios to join the WLC
- **J4**—Allows 2.4G JPQU and 5G PQU to join the controller.

\[\text{Note}\] The 1550, 1600, 2600, and 3600 APs require J4.

See the *Channels and Maximum Power Settings for Cisco Aironet Lightweight Access Points* document for the list of channels and power levels supported by access points in the Japanese regulatory domains.

Restrictions for Configuring Country Codes

- The access point can only operate on the channels for the countries that they are designed for.

\[\text{Note}\] If an access point was already set to a higher legal power level or is configured manually, the power level is limited only by the particular country to which that access point is assigned.

Configuring Country Codes (GUI)

**Step 1**  
Disable the 802.11 networks as follows:
- a) Choose Wireless > 802.11a/n > Network.
- b) Unselect the 802.11a Network Status check box.
- c) Click Apply.
- d) Choose Wireless > 802.11a/n > Network.
- e) Unselect the 802.11b/g Network Status check box.
- f) Click Apply.

**Step 2**  
Choose Wireless > Country to open the Country page.

**Step 3**  
Select the check box for each country where your access points are installed. If you selected more than one check box, a message appears indicating that RRM channels and power levels are limited to common channels and power levels.

**Step 4**  
Click OK to continue or Cancel to cancel the operation.

**Step 5**  
Click Apply.
If you selected multiple country codes in Step 3, each access point is assigned to a country.

**Step 6**

See the default country chosen for each access point and choose a different country if necessary as follows:

*Note* If you remove a country code from the configuration, any access points currently assigned to the deleted country reboot and when they rejoin the controller, they get re-assigned to one of the remaining countries if possible.

a) Perform one of the following:

- Leave the 802.11 networks disabled.
- Reenable the 802.11 networks and then disable only the access points for which you are configuring a country code. To disable an access point, choose **Wireless > Access Points > All APs**, click the link of the desired access point, choose **Disable** from the Status drop-down list, and click **Apply**.

b) Choose **Wireless > Access Points > All APs** to open the All APs page.

c) Click the link for the desired access point.

d) Choose the **Advanced** tab to open the All APs > Details for (Advanced) page.

The default country for this access point appears in the Country Code drop-down list.

e) If the access point is installed in a country other than the one shown, choose the correct country from the drop-down list. The box contains only those country codes that are compatible with the regulatory domain of at least one of the access point’s radios.

f) Click **Apply**.

g) Repeat these steps to assign all access points joined to the controller to a specific country.

h) Reenable any access points that you disabled in **Step a**.

**Step 7**

Reenable the 802.11 networks if you did not enable them in **Step 6**.

**Step 8**

Click **Save Configuration**.

---

**Configuring Country Codes (CLI)**

**Step 1**

See a list of all available country codes by entering this command:

```
show country supported
```

**Step 2**

Disable the 802.11 networks by entering these commands:

```
config 802.11a disable network
config 802.11b disable network
```

**Step 3**

Configure the country codes for the countries where your access points are installed by entering this command:

```
config country code1[,code2,code3]...
```

If you are entering more than one country code, separate each by a comma (for example, **config country US,CA,MX**).

**Step 4**

Enter **Y** when prompted to confirm your decision.

**Step 5**

Verify your country code configuration by entering this command:

```
show country
```

**Step 6**

See the list of available channels for the country codes configured on your controller by entering this command:

```
show country channels
```
Step 7
Save your changes by entering this command:
```bash
save config
```

Step 8
See the countries to which your access points have been assigned by entering this command:
```bash
show ap summary
```
To see a summary of specific access point you can specify the access point name. You can also use wildcard searches when filtering for access points.

Step 9
If you entered multiple country codes in Step 3, follow these steps to assign each access point to a specific country:

a) Perform one of the following:
   - Leave the 802.11 networks disabled.
   - Reenable the 802.11 networks and then disable only the access points for which you are configuring a country code. To Reenable the networks, enter this command:
     ```bash
     config 802.11 {a | b} enable network
     ```
     To disable an access point, enter this command:
     ```bash
     config ap disable ap_name
     ```

b) To assign an access point to a specific country, enter this command:
```bash
config ap country code {ap_name | all}
```
Make sure that the country code you choose is compatible with the regulatory domain of at least one of the access point's radios.

Note: If you enabled the networks and disabled some access points and then run the `config ap country code all` command, the specified country code is configured on only the disabled access points. All other access points are ignored.

   c) To reenable any access points that you disabled in Step a, enter this command:
```bash
config ap enable ap_name
```

Step 10
If you did not reenable the 802.11 networks in Step 9, enter these commands to reenable them now:
```bash
config 802.11 {a | b} enable network
```

Step 11
Save your changes by entering this command:
```bash
save config
```

---

**Migrating Access Points from the -J Regulatory Domain to the -U Regulatory Domain**

**Information About Migrating Access Points from the -J Regulatory Domain to the -U Regulatory Domain**

The Japanese government has changed its 5-GHz radio spectrum regulations. These regulations allow a text box upgrade of 802.11a 5-GHz radios. Japan allows three frequency sets:
Cisco has organized these frequency sets into the following regulatory domains:

- **-J regulatory domain = J52**
- **-P regulatory domain = W52 + W53**
- **-U regulatory domain = W52**

Regulatory domains are used by Cisco to organize the legal frequencies of the world into logical groups. For example, most of the European countries are included in the -E regulatory domain. Cisco access points are configured for a specific regulatory domain at the factory and, with the exception of this migration process, never change. The regulatory domain is assigned per radio, so an access point’s 802.11a and 802.11b/g radios may be assigned to different domains.

**Note**

Controllers and access points may not operate properly if they are not designed for use in your country of operation. For example, an access point with part number AIR-AP1030-A-K9 (which is included in the Americas regulatory domain) cannot be used in Australia. Always be sure to purchase controllers and access points that match your country’s regulatory domain.

The Japanese regulations allow the regulatory domain that is programmed into an access point’s radio to be migrated from the -J domain to the -U domain. New access points for the Japanese market contain radios that are configured for the -P regulatory domain. -J radios are no longer being sold. In order to make sure that your existing -J radios work together with the new -P radios in one network, you need to migrate your -J radios to the -U domain.

Country codes define the channels that can be used legally in each country. These country codes are available for Japan:

- **JP**—Allows only -J radios to join the controller
- **J2**—Allows only -P radios to join the controller
- **J3**—Uses the -U frequencies but allows both -U and -P radios to join the controller
- **J4**—Allows 2.4G PQU and 5G JPQU to join the controller.

**Note**

After migration, you need to use the J3 country code. If your controller is running software release 4.1 or later releases, you can use the multiple-country feature to choose both J2 and J3. You can manually configure your -P radios to use the channels not supported by J3.

If you are using controller software 7.0.98.0 or earlier releases, you must enable J2 and J4 for the Q radios.

See the *Channels and Maximum Power Settings for Cisco Aironet Lightweight Access Points* document for the list of channels and power levels supported by access points in the Japanese regulatory domains.
Restrictions for Migrating Access Points from the -J Regulatory Domain to the -U Regulatory Domain

- You can migrate only Cisco Aironet 1130, 1200, and 1240 lightweight access points that support the -J regulatory domain and Airespace AS1200 access points. Other access points cannot be migrated.
- You must have had one or more Japan country codes (JP, J2, or J3) configured on your controller at the time you last booted your controller.
- You must have at least one access point with a -J regulatory domain associated with your controller.
- You cannot migrate your access points from the -U regulatory domain back to the -J domain. The Japanese government has made reverse migration illegal.

Note: You cannot undo an access point migration. Once an access point has been migrated, you cannot return to software release 4.0. Migrated access points will have nonfunctioning 802.11a radios under software release 4.0.

- The migration process cannot be performed using the controller GUI.

Migrating Access Points to the -U Regulatory Domain (CLI)

Step 1 Determine which access points in your network are eligible for migration by entering this command:
show ap migrate
Information similar to the following appears:

These 1 APs are eligible for migration:

No APs have already been migrated.

Step 2Disable the 802.11a and 802.11b/g networks by entering these commands:
config 802.11a disable network
config 802.11b disable network

Step 3Change the country code of the access points to be migrated to J3 by entering this command:
config country J3

Step 4Wait for any access points that may have rebooted to rejoin the controller.

Step 5Migrate the access points from the -J regulatory domain to the -U regulatory domain by entering this command:
config ap migrate j52w52 {all | ap_name}
Informations similar to the following appears:

Migrate APs with 802.11A Radios in the “J” Regulatory Domain to the “U” Regulatory Domain. The “J” domain allows J52 frequencies, the “U” domain allows W52 frequencies.
WARNING: This migration is permanent and is not reversible, as required by law.
WARNING: Once migrated the 802.11A radios will not operate with previous OS versions.
WARNING: All attached “J” radios will be migrated.
WARNING: All migrated APs will reboot.
WARNING: All migrated APs must be promptly reported to the manufacturer.
Send the AP list and your company name to: abc@cisco.com

This AP is eligible for migration:
00:14:1c:ed:27:fe AIR-AP1242AG-J-K9 ap1240

Begin to migrate Access Points from “J” (J52) to “U” (W52). Are you sure? (y/n)

Step 6 Enter Y when prompted to confirm your decision to migrate.

Step 7 Wait for all access points to reboot and rejoin the controller. This process may take up to 15 minutes, depending on access point. The AP1130, AP1200, and AP1240 reboot twice; all other access points reboot once.

Step 8 Verify migration for all access points by entering this command:
show ap migrate

Information similar to the following appears:

No APs are eligible for migration.

These 1 APs have already been migrated:

Step 9 Reenable the 802.11a and 802.11b/g networks by entering these commands:
config 802.11a enable network
config 802.11b enable network

Step 10 Send an e-mail with your company name and the list of access points that have been migrated to this e-mail address: migrateapj52w52@cisco.com. We recommend that you cut and paste the output from the show ap migrate command in Step 8 into the e-mail.

---

Using the W56 Band in Japan

The Japanese government is formally permitting wireless LAN use of the frequencies in the W56 band for 802.11a radios. The W56 band includes the following channels, frequencies, and power levels (in dBm):

<table>
<thead>
<tr>
<th>Channel</th>
<th>Frequency (MHz)</th>
<th>Maximum Power for AIR-LAP1132AG-Q-K9</th>
<th>Maximum Power for AIR-LAP1242AG-Q-K9</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>5500</td>
<td>17</td>
<td>15</td>
</tr>
</tbody>
</table>

---

OL-27510-01


499
### Dynamic Frequency Selection

The Cisco UWN solution complies with regulations that require radio devices to use dynamic frequency selection (DFS) to detect radar signals and avoid interfering with them.

When a lightweight access point with a 5-GHz radio operates on one of the 15 channels listed in the table below, the controller to which the access point is associated automatically uses DFS to set the operating frequency.

When you manually select a channel for DFS-enabled 5-GHz radios, the controller checks for radar activity on the channel for 60 seconds. If there is no radar activity, the access point operates on the channel that you selected. If there is radar activity on the channel that you selected, the controller automatically selects a different channel, and after 30 minutes, the access point retries the channel.

---

<table>
<thead>
<tr>
<th>Channel</th>
<th>Frequency (MHz)</th>
<th>Maximum Power for AIR-LAP1132AG-Q-K9</th>
<th>Maximum Power for AIR-LAP1242AG-Q-K9</th>
</tr>
</thead>
<tbody>
<tr>
<td>104</td>
<td>5520</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>108</td>
<td>5540</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>112</td>
<td>5560</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>116</td>
<td>5580</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>120</td>
<td>5600</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>124</td>
<td>5620</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>128</td>
<td>5640</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>132</td>
<td>5660</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>136</td>
<td>5680</td>
<td>17</td>
<td>15</td>
</tr>
<tr>
<td>140</td>
<td>5700</td>
<td>17</td>
<td>15</td>
</tr>
</tbody>
</table>

All of the channels in the W56 band require dynamic frequency selection (DFS). In Japan, the W56 band is subject to Japan’s DFS regulations. Currently, only the new 1130 and 1240 series access point SKUs (with the -Q product code) support this requirement: AIR-LAP1132AG-Q-K9 and AIR-LAP1242AG-Q-K9.

To set up a network consisting of only -P and -Q access points, configure the country code to J2. To set up a network consisting of -P, -Q, and -U access points, configure the country code to J3.

---

**Note**

After radar has been detected on a DFS-enabled channel, it cannot be used for 30 minutes.
The Rogue Location Detection Protocol (RLDP) and rogue containment are not supported on the channels listed in the table below.

### Note

The maximum legal transmit power is greater for some 5-GHz channels than for others. When the controller randomly selects a 5-GHz channel on which power is restricted, it automatically reduces transmit power to comply with power limits for that channel.

#### Table 22: DFS-Enabled 5-GHz Channels

<table>
<thead>
<tr>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>52 (5260 MHz)</td>
</tr>
<tr>
<td>56 (5280 MHz)</td>
</tr>
<tr>
<td>60 (5300 MHz)</td>
</tr>
<tr>
<td>64 (5320 MHz)</td>
</tr>
<tr>
<td>100 (5500 MHz)</td>
</tr>
</tbody>
</table>

Using DFS, the controller monitors operating frequencies for radar signals. If it detects radar signals on a channel, the controller takes these steps:

- It changes the access point channel to a channel that has not shown radar activity within the last 30 minutes. (The radar event is cleared after 30 minutes.) The controller selects the channel at random.
- If the channel selected is one of the channels in the table above, it scans the new channel for radar signals for 60 seconds. If there are no radar signals on the new channel, the controller accepts client associations.
- It records the channel that showed radar activity as a radar channel and prevents activity on that channel for 30 minutes.
- It generates a trap to alert the network manager.

---

### Optimizing RFID Tracking on Access Points

#### Information About Optimizing RFID Tracking on Access Points

To optimize the monitoring and location calculation of RFID tags, you can enable tracking optimization on up to four channels within the 2.4-GHz band of an 802.11b/g access point radio. This feature allows you to scan only the channels on which tags are usually programmed to operate (such as channels 1, 6, and 11).

You can use the controller GUI or CLI to configure the access point for monitor mode and to then enable tracking optimization on the access point radio.
Optimizing RFID Tracking on Access Points (GUI)

Step 1  Choose Wireless > Access Points > All APs to open the All APs page.
Step 2  Click the name of the access point for which you want to configure monitor mode. The All APs > Details for page appears.
Step 3  From the AP Mode drop-down list, choose Monitor.
Step 4  Click Apply.
Step 5  Click OK when warned that the access point will be rebooted.
Step 6  Click Save Configuration to save your changes.
Step 7  Choose Wireless > Access Points > Radios > 802.11b/g/n to open the 802.11b/g/n Radios page.
Step 8  Hover your cursor over the blue drop-down arrow for the desired access point and choose Configure. The 802.11b/g/n Cisco APs > Configure page appears.
Step 9  Disable the access point radio by choosing Disable from the Admin Status drop-down list and click Apply.
Step 10  Enable tracking optimization on the radio by choosing Enable from the Enable Tracking Optimization drop-down list.
Step 11  From the four Channel drop-down lists, choose the channels on which you want to monitor RFID tags.  
Note  You must configure at least one channel on which the tags will be monitored.
Step 12  Click Apply.
Step 13  Click Save Configuration.
Step 14  To reenable the access point radio, choose Enable from the Admin Status drop-down list and click Apply.
Step 15  Click Save Configuration.

Optimizing RFID Tracking on Access Points (CLI)

Step 1  Configure an access point for monitor mode by entering this command:
    config ap mode monitor Cisco_AP
Step 2  When warned that the access point will be rebooted and asked if you want to continue, enter Y.
Step 3  Save your changes by entering this command:
    save config
Step 4  Disable the access point radio by entering this command:
    config 802.11b disable Cisco_AP
Step 5  Configure the access point to scan only the DCA channels supported by its country of operation by entering this command:
    config ap monitor-mode tracking-opt Cisco_AP
    Note  To specify the exact channels to be scanned, enter the config ap monitor-mode tracking-opt Cisco_AP command in Step 6.
To disable tracking optimization for this access point, enter the `config ap monitor-mode no-optimization Cisco_AP` command.

**Step 6**

After you have entered the command in **Step 5**, you can enter this command to choose up to four specific 802.11b channels to be scanned by the access point:

```
config ap monitor-mode 802.11b fast-channel Cisco_AP channel1 channel2 channel3 channel4
```

**Note** In the United States, you can assign any value between 1 and 11 (inclusive) to the `channel` variable. Other countries support additional channels. You must assign at least one channel.

**Step 7**

Reenable the access point radio by entering this command:

```
config 802.11b enable Cisco_AP
```

**Step 8**

Save your changes by entering this command:

```
save config
```

**Step 9**

See a summary of all access points in monitor mode by entering this command:

```
show ap monitor-mode summary
```

---

### Configuring Probe Request Forwarding

#### Information About Configuring Probe Request Forwarding

Probe requests are 802.11 management frames sent by clients to request information about the capabilities of SSIDs. By default, access points forward acknowledged probe requests to the controller for processing. Acknowledged probe requests are probe requests for SSIDs that are supported by the access point. If desired, you can configure access points to forward both acknowledged and unacknowledged probe requests to the controller. The controller can use the information from unacknowledged probe requests to improve the location accuracy.

#### Configuring Probe Request Forwarding (CLI)

**Step 1**

Enable or disable the filtering of probe requests forwarded from an access point to the controller by entering this command:

```
config advanced probe filter {enable | disable}
```

If you enable probe filtering, the default filter setting, the access point forwards only acknowledged probe requests to the controller. If you disable probe filtering, the access point forwards both acknowledged and unacknowledged probe requests to the controller.

**Step 2**

Limit the number of probe requests sent to the controller per client per access point radio in a given interval by entering this command:

```
config advanced probe limit num_probes interval
```

**Note** `num_probes` is the number of probe requests (from 1 to 100) forwarded to the controller per client per access point radio in a given interval.
interval is the probe limit interval (from 100 to 10000 milliseconds).

The default value for num_probes is 2 probe requests, and the default value for interval is 500 milliseconds.

Step 3
Enter the save config command to save your changes.

Step 4
See the probe request forwarding configuration by entering this command:
show advanced probe

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Probe request filtering</td>
<td>Enabled</td>
</tr>
<tr>
<td>Probes fwd to controller per client per radio.....</td>
<td>2</td>
</tr>
<tr>
<td>Probe request rate-limiting interval........</td>
<td>500 msec</td>
</tr>
</tbody>
</table>

Retrieving the Unique Device Identifier on Controllers and Access Points

Information About Retrieving the Unique Device Identifier on Controllers and Access Points

The Unique Device Identifier (UDI) standard uniquely identifies products across all Cisco hardware product families, enabling customers to identify and track Cisco products throughout their business and network operations and to automate their asset management systems. The standard is consistent across all electronic, physical, and standard business communications. The UDI consists of five data elements:

- The orderable product identifier (PID)
- The version of the product identifier (VID)
- The serial number (SN)
- The entity name
- The product description

The UDI is burned into the EEPROM of controllers and lightweight access points at the factory. It can be retrieved through either the GUI or the CLI.

Retrieving the Unique Device Identifier on Controllers and Access Points (GUI)

Step 1
Choose Controller > Inventory to open the Inventory page. This page shows the five data elements of the controller UDI.
Retrieving the Unique Device Identifier on Controllers and Access Points (CLI)

Use these commands to retrieve the UDI on controllers and access points using the controller CLI:

- `show inventory`—Shows the UDI string of the controller. Information similar to the following appears:

  ...  
  NAME: "Chassis" , DESCR: "Cisco 5500 Series Wireless LAN Controller"  
  PID: AIR-CT5508-K9, VID: V01, SN: XXXXXXXXXXX

- `show inventory ap ap_id`—Shows the UDI string of the access point specified.

Performing a Link Test

Information About Performing a Link Test

A link test is used to determine the quality of the radio link between two devices. Two types of link-test packets are transmitted during a link test: request and response. Any radio receiving a link-test request packet fills in the appropriate text boxes and echoes the packet back to the sender with the response type set.

The radio link quality in the client-to-access point direction can differ from that in the access point-to-client direction due to the asymmetrical distribution of the transmit power and receive sensitivity on both sides. Two types of link tests can be performed: a ping test and a CCX link test.

With the ping link test, the controller can test link quality only in the client-to-access point direction. The RF parameters of the ping reply packets received by the access point are polled by the controller to determine the client-to-access point link quality.

With the CCX link test, the controller can also test the link quality in the access point-to-client direction. The controller issues link-test requests to the client, and the client records the RF parameters (received signal strength indicator [RSSI], signal-to-noise ratio [SNR], and so on) of the received request packet in the response packet. Both the link-test requestor and responder roles are implemented on the access point and controller. Not only can the access point or controller initiate a link test to a CCX v4 or v5 client, but a CCX v4 or v5 client can initiate a link test to the access point or controller.

The controller shows these link-quality metrics for CCX link tests in both directions (out—access point to client; in—client to access point):

- Signal strength in the form of RSSI (minimum, maximum, and average)
- Signal quality in the form of SNR (minimum, maximum, and average)
- Total number of packets that are retried
Performing a Link Test (GUI)

Step 1  Choose Monitor > Clients to open the Clients page.

Step 2  Hover your cursor over the blue drop-down arrow for the desired client and choose Link Test. A link test page appears.

Note  You can also access this page by clicking the MAC address of the desired client and then clicking the Link Test button on the top of the Clients > Detail page. This page shows the results of the CCX link test.

Note  If the client and/or controller does not support CCX v4 or later releases, the controller performs a ping link test on the client instead, and a much more limited link test page appears.

Note  The Link Test results of CCX clients when it fails will default to ping test results if the client is reachable.

Step 3  Click OK to exit the link test page.

Performing a Link Test (CLI)

Use these commands to run a link test using the controller CLI:

• Run a link test by entering this command:

  linktest ap_mac

  When CCX v4 or later releases is enabled on both the controller and the client being tested, information similar to the following appears:

  CCX Link Test to 00:0d:88:c5:8a:d1.
  Link Test Packets Sent...................................... 20
Link Test Packets Received................................. 10
Link Test Packets Lost (Total/AP to Client/Client to AP).... 10/5/5
Link Test Packets round trip time (min/max/average)......... 5ms/20ms/15ms
RSSI at AP (min/max/average)................................ -60dBm/-50dBm/-55dBm
RSSI at Client (min/max/average).............................. -50dBm/-40dBm/-45dBm
SNR at AP (min/max/average).................................. 40dB/30dB/35dB
SNR at Client (min/max/average).............................. 40dB/30dB/35dB
Transmit Retries at AP (Total/Maximum)...................... 5/3
Transmit Retries at Client (Total/Maximum).................. 4/2
Packet Count: 0 0 0 0 0 0 0 0 0 2 0 8 0
Packet Count: 0 0 0 0 0 0 0 0 0 2 0 8 0

When CCX v4 or later releases is not enabled on either the controller or the client being tested, fewer
details appear:

Ping Link Test to 00:0d:88:c5:8a:d1.
   Link Test Packets Sent.................. 20
   Link Test Packets Received.............. 20
   Local Signal Strength.................... -49dBm
   Local Signal to Noise Ratio............... 39dB

• Adjust the link-test parameters that are applicable to both the CCX link test and the ping test by entering
  these commands from configuration mode:

  linktest frame-size size_of_link-test_frames
  linktest num-of-frame number_of_link-test_request_frames_per_test

Configuring Link Latency

Information About Configuring Link Latency

You can configure link latency on the controller to measure the link between an access point and the controller.
This feature can be used with all access points joined to the controller but is especially useful for FlexConnect
and OfficeExtend access points, for which the link could be a slow or unreliable WAN connection.

The following are some guidelines for link latency:

• Link latency monitors the round-trip time of the CAPWAP heartbeat packets (echo request and response)
  from the access point to the controller and back. This time can vary due to the network link speed and
  controller processing loads. The access point timestamps the outgoing echo requests to the controller
  and the echo responses received from the controller. The access point sends this delta time to the controller
  as the system round-trip time. The access point sends heartbeat packets to the controller at a default
  interval of 30 seconds.

  Note  Link latency calculates the CAPWAP response time between the access point and the
         controller. It does not measure network latency or ping responses.
Restrictions for Link Latency

- Link latency is supported for use only with FlexConnect access points in connected mode. FlexConnect access points in standalone mode are not supported.

Configuring Link Latency (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose <strong>Wireless &gt; Access Points &gt; All APs</strong> to open the All APs page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the name of the access point for which you want to configure link latency.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Choose the <strong>Advanced</strong> tab to open the All APs &gt; Details for (Advanced) page.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the <strong>Enable Link Latency</strong> check box to enable link latency for this access point or unselect it to prevent the access point from sending the round-trip time to the controller after every echo response is received. The default value is unselected.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click <strong>Apply</strong> to commit your changes.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click <strong>Save Configuration</strong> to save your changes.</td>
</tr>
<tr>
<td>Step 7</td>
<td>When the All APs page reappears, click the name of the access point again.</td>
</tr>
<tr>
<td>Step 8</td>
<td>When the All APs &gt; Details for page reappears, choose the <strong>Advanced</strong> tab again. The link latency and data latency results appear below the Enable Link Latency check box:</td>
</tr>
</tbody>
</table>
  - **Current**—The current round-trip time (in milliseconds) of CAPWAP heartbeat packets or data packets from the access point to the controller and back. |
  - **Minimum**—Since link latency has been enabled or reset, the minimum round-trip time (in milliseconds) of CAPWAP heartbeat packets or data packets from the access point to the controller and back. |
  - **Maximum**—Since link latency has been enabled or reset, the maximum round-trip time (in milliseconds) of CAPWAP heartbeat packets or data packets from the access point to the controller and back. |
| Step 9 | To clear the current, minimum, and maximum link latency and data latency statistics on the controller for this access point, click **Reset Link Latency**. |
| Step 10 | After the page refreshes and the All APs > Details for page reappears, choose the **Advanced** tab. The updated statistics appear in the Minimum and Maximum text boxes. |
Configuring Link Latency (CLI)

**Step 1**
Enable or disable link latency for a specific access point or for all access points currently associated to the controller by entering this command:

```
config ap link-latency {enable | disable} {Cisco_AP | all}
```

The default value is disabled.

**Note**  The `config ap link-latency {enable | disable} all` command enables or disables link latency only for access points that are currently joined to the controller. It does not apply to access points that join in the future.

**Step 2**
See the link latency results for a specific access point by entering this command:

```
show ap config general Cisco_AP
```

Information similar to the following appears:

```
Cisco AP Identifier.............................. 1
Cisco AP Name.................................... AP1
... AP Link Latency............................... Enabled
    Current Delay................................. 1 ms
    Maximum Delay................................. 1 ms
    Minimum Delay................................. 1 ms
    Last updated (based on AP Up Time)......... 0 days, 05 h 03 m 25 s
```

The output of this command contains the following link latency results:

- **Current Delay**—The current round-trip time (in milliseconds) of CAPWAP heartbeat packets from the access point to the controller and back.

- **Maximum Delay**—Since link latency has been enabled or reset, the maximum round-trip time (in milliseconds) of CAPWAP heartbeat packets from the access point to the controller and back.

- **Minimum Delay**—Since link latency has been enabled or reset, the minimum round-trip time (in milliseconds) of CAPWAP heartbeat packets from the access point to the controller and back.

**Step 3**
Clear the current, minimum, and maximum link latency statistics on the controller for a specific access point by entering this command:

```
config ap link-latency reset Cisco_AP
```

**Step 4**
See the results of the reset by entering this command:

```
show ap config general Cisco_AP
```
Configuring the TCP MSS

Information About Configuring the TCP MSS

If the client’s maximum segment size (MSS) in a Transmission Control Protocol (TCP) three-way handshake is greater than the maximum transmission unit can handle, the client might experience reduced throughput and the fragmentation of packets. To avoid this problem in controller software release 6.0 or later releases, you can specify the MSS for all access points that are joined to the controller or for a specific access point.

When you enable this feature, the access point selects the MSS for TCP packets to and from wireless clients in its data path. If the MSS of these packets is greater than the value that you configured or greater than the default value for the CAPWAP tunnel, the access point changes the MSS to the new configured value.

TCP MSS is supported only on APs that are in local mode or FlexConnect with centrally switched WLANs.

Configuring TCP MSS (GUI)

**Step 1** Choose WIRELESS > Access Points > Global Configuration to open the Global Configuration page.

**Step 2** Under TCP MSS, select the Global TCP Adjust MSS check box and set the MSS for all access points that are associated with the controller.

**Note** The valid range are:

- For IPv4 TCP - between 536 and 1363 bytes.
- For IPv6 TCP - between 1220 and 1331.

Any TCP MSS value that is below 1220 and above 1331 will not be effective for CAPWAP v6 AP.

Configuring TCP MSS (CLI)

**Step 1** Enable or disable the TCP MSS on a particular access point or on all access points by entering this command:

```
config ap tcp-mss-adjust {enable|disable} {Cisco_AP | all} size
```

where the size parameter is a value between 536 and 1363 bytes for IPv4 and between 1220 and 1331 for IPv6. The default value varies for different clients.
The valid ranges are:

- For IPv4 - Use a value between 536 and 1363 bytes.
- For IPv6 - Use a value between 1220 and 1331 bytes.

Any TCP MSS value that is below 1220 and above 1331 will not be effective for CAPWAP v6 AP.

**Step 2**

Save your changes by entering this command:
```
save config
```

**Step 3**

See the current TCP MSS setting for a particular access point or all access points by entering this command:
```
show ap tcp-mss-adjust {Cisco_AP | all}
```

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>TCP State</th>
<th>MSS Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP-1140</td>
<td>enabled</td>
<td>536</td>
</tr>
<tr>
<td>AP-1240</td>
<td>disabled</td>
<td>-</td>
</tr>
<tr>
<td>AP-1130</td>
<td>disabled</td>
<td>-</td>
</tr>
</tbody>
</table>

### Configuring Power Over Ethernet

**Information About Configuring Power over Ethernet**

When an access point that has been converted to lightweight mode (such as an AP1131 or AP1242) or a 1250 series access point is powered by a power injector that is connected to a Cisco pre-Intelligent Power Management (pre-IPM) switch, you need to configure Power over Ethernet (PoE), also known as *inline power*.

The dual-radio 1250 series access points can operate in four different modes when powered using PoE:

- **20.0 W (Full Power)**—This mode is equivalent to using a power injector or an AC/DC adapter.
- **16.8 W**—Both transmitters are used but at reduced power. Legacy data rates are not affected, but the M0 to M15 data rates are reduced in the 2.4-GHz band. Throughput should be minimally impacted because all data rates are still enabled. The range is affected because of the lower transmit power. All receivers remain enabled.
- **15.4 W**—Only a single transmitter is enabled. Legacy data rates and M0 to M7 rates are minimally affected. M8 to M15 rates are disabled because they require both transmitters. Throughput is better than that received with legacy access points but less than the 20 and 16.8 W power modes.
- **11.0 W (Low Power)**—The access point runs, but both radios are disabled.

The following are some guidelines for Power over Ethernet:

- When a dual-radio 1250 series access point is powered using 15.4-W PoE, it cannot operate at full functionality, which requires 20 W. The access point can operate with dual radios on 15.4-W PoE, but
performance is reduced in terms of throughput and range. If full functionality is required on 15.4 W, you can remove one of the radios from the 1250 series access point chassis or disable it in controller software release 6.0 or later releases so that the other radio can operate in full 802.11n mode. After the access point radio is administratively disabled, the access point must be rebooted for the change to take effect. The access point must also be rebooted after you reenable the radio to put it into reduced throughput mode.

These modes provide the flexibility of running the 1250 series access points with the available wired infrastructure to obtain the desired level of performance. With enhanced PoE switches (such as the Cisco Catalyst 3750-E Series Switches), the 1250 series access points can provide maximum features and functionality with a minimum total cost of ownership. Alternatively, if you decide to power the access point with the existing PoE (802.3af) switches, the access point chooses the appropriate mode of operation based on whether it has one radio or two.

Table 23: Maximum Transmit Power Settings for 1250 Series Access Points Using PoE

<table>
<thead>
<tr>
<th>Radio Band</th>
<th>Data Rates</th>
<th>Number of Transmitters</th>
<th>Cyclic Shift Diversity (CSD)</th>
<th>Maximum Transmit Power (dBm) 5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>802.3af Mode (15.4 W)</td>
</tr>
<tr>
<td>2.4 GHz</td>
<td>802.11b</td>
<td>1</td>
<td>—</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>802.11g</td>
<td>1</td>
<td>—</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>802.11n MCS 0-7</td>
<td>1 2</td>
<td>Disabled Enabled (default)</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>802.11n MCS 8-15</td>
<td>2</td>
<td>—</td>
<td>Disabled</td>
</tr>
<tr>
<td>5 GHz</td>
<td>802.11a</td>
<td>1</td>
<td>—</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>802.11n MCS 0-7</td>
<td>1 2</td>
<td>Disabled Enabled (default)</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>802.11n MCS 8-15</td>
<td>2</td>
<td>—</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

Note: For more information about Cisco PoE switches, see http://www.cisco.com/c/en/us/products switches/epoe.html
Maximum transmit power varies by channel and according to individual country regulations. See the product documentation for specific details.

- When powered with a non-Cisco standard PoE switch, the 1250 series access point operates under 15.4 Watts. Even if the non-Cisco switch or midspan device is capable of providing higher power, the access point does not operate in enhanced PoE mode.

## Configuring Power over Ethernet (GUI)

### Step 1
Choose **Wireless > Access Points > All APs** and then the name of the desired access point.

### Step 2
Choose the **Advanced** tab to open the All APs > Details for (Advanced) page.

The PoE Status text box shows the power level at which the access point is operating: High (20 W), Medium (16.8 W), or Medium (15.4 W). This text box is not configurable. The controller auto-detects the access point’s power source and displays the power level here.

**Note** — This text box applies only to 1250 series access points that are powered using PoE. There are two other ways to determine if the access point is operating at a lower power level. First, the "Due to low PoE, radio is transmitting at degraded power" message appears under the Tx Power Level Assignment section on the 802.11a/n (or 802.11b/g/n) Cisco APs > Configure page. Second, the "PoE Status: degraded operation" message appears in the controller’s trap log on the Trap Logs page.

### Step 3
Perform one of the following:

- Select the **Pre-standard 802.3af switches** check box if the access point is being powered by a high-power 802.3af Cisco switch. This switch provides more than the traditional 6 Watts of power but do not support the intelligent power management (IPM) feature.

- Unselect the **Pre-standard 802.3af switches** check box if power is being provided by a power injector. This is the default value.

### Step 4
Select the **Power Injector State** check box if the attached switch does not support IPM and a power injector is being used. If the attached switch supports IPM, you do not need to select this check box.

### Step 5
If you selected the Power Injector State check box in the previous step, the Power Injector Selection and Injector Switch MAC Address parameters appear. The Power Injector Selection parameter enables you to protect your switch port from an accidental overload if the power injector is inadvertently bypassed. Choose one of these options from the drop-down list to specify the desired level of protection:

- **Installed** — This option examines and remembers the MAC address of the currently connected switch port and assumes that a power injector is connected. Choose this option if your network contains older Cisco 6-Watt switches and you want to avoid possible overloads by forcing a double-check of any relocated access points.

  If you want to configure the switch MAC address, enter the MAC address in the Injector Switch MAC Address text box. If you want the access point to find the switch MAC address, leave the Injector Switch MAC Address text box blank.

  **Note** — Each time an access point is relocated, the MAC address of the new switch port fails to match the remembered MAC address, and the access point remains in low-power mode. You must then physically verify the existence of a power injector and reselect this option to cause the new MAC address to be remembered.
• **Override**—This option allows the access point to operate in high-power mode without first verifying a matching MAC address. You can use this option if your network does not contain any older Cisco 6-W switches that could be overloaded if connected directly to a 12-W access point. The advantage of this option is that if you relocate the access point, it continues to operate in high-power mode without any further configuration. The disadvantage of this option is that if the access point is connected directly to a 6-W switch, an overload occurs.

**Step 6** Click **Apply**.

**Step 7** If you have a dual-radio 1250 series access point and want to disable one of its radios in order to enable the other radio to receive full power, follow these steps:

a) Choose **Wireless > Access Points > Radios > 802.11a/n** or **802.11b/g/n** to open the 802.11a/n (or 802.11b/g/n) Radios page.

b) Hover your cursor over the blue drop-down arrow for the radio that you want to disable and choose **Configure**.

c) On the 802.11a/n (or 802.11b/g/n) Cisco APs > Configure page, choose **Disable** from the **Admin Status** drop-down list.

d) Click **Apply**.

e) Manually reset the access point in order for the change to take effect.

**Step 8** Click **Save Configuration**.

---

### Configuring Power over Ethernet (CLI)

Use these commands to configure and See PoE settings using the controller CLI:

• If your network contains any older Cisco 6-W switches that could be accidentally overloaded if connected directly to a 12-W access point, enter this command:

```
config ap power injector enable {Cisco_AP | all} installed
```

The access point remembers that a power injector is connected to this particular switch port. If you relocate the access point, you must reissue this command after the presence of a new power injector is verified.

| Note | Ensure CDP is enabled before entering this command. Otherwise, this command will fail. See the Configuring the Cisco Discovery Protocol section for information about enabling CDP. |

• Remove the safety checks and allow the access point to be connected to any switch port by entering this command:

```
config ap power injector enable {Cisco_AP | all} override
```

You can use this command if your network does not contain any older Cisco 6-W switches that could be overloaded if connected directly to a 12-W access point. The access point assumes that a power injector is always connected. If you relocate the access point, it continues to assume that a power injector is present.

• If you know the MAC address of the connected switch port and do not want to automatically detect it using the installed option, enter this command:
config ap power injector enable {Cisco_AP | all} switch_port_mac_address

- If you have a dual-radio 1250 series access point and want to disable one of its radios in order to enable the other radio to receive full power, enter this command:

config {802.11a | 802.11b} disable Cisco_AP

Note: You must manually reset the access point in order for the change to take effect.

- See the PoE settings for a specific access point by entering this command:

show ap config general Cisco_AP

Information similar to the following appears:

Cisco AP Identifier.............................. 1
Cisco AP Name.................................... AP1

PoE Pre-Standard Switch......................... Enabled
PoE Power Injector MAC Addr...................... Disabled
Power Type/Mode.................................. PoE/Low Power (degraded mode)

The Power Type/Mode text box shows "degraded mode" if the access point is not operating at full power.

- See the controller’s trap log by entering this command:

show traplog

If the access point is not operating at full power, the trap contains "PoE Status: degraded operation."

- You can power an access point by a Cisco prestandard 15-W switch with Power over Ethernet (PoE) by entering this command:

config ap power pre-standard {enable | disable} {all | Cisco_AP}

A Cisco prestandard 15-W switch does not support intelligent power management (IPM) but does have sufficient power for a standard access point. The following Cisco prestandard 15-W switches are available:

- WS-C3550, WS-C3560, WS-C3750
- C1880
- 2600, 2610, 2611, 2621, 2650, 2651
- 2610XM, 2611XM, 2621XM, 2650XM, 2651XM, 2691
- 2811, 2821, 2851
- 3631-telco, 3620, 3640, 3660
- 3725, 3745
- 3825, 3845

The enable version of this command is required for full functionality when the access point is powered by a Cisco prestandard 15-W switch. It is safe to use if the access point is powered by either an IPM switch or a power injector or if the access point is not using one of the 15-W switches listed above.
You might need this command if your radio operational status is "Down" when you expect it to be "Up." Enter the `show msglog` command to look for this error message, which indicates a PoE problem:

Apr 13 09:08:24.986 spam_lrad.c:2262 LWAPP-3-MSGTAG041: AP 00:14:f1:af:f3:40 is unable to verify sufficient in-line power. Radio slot 0 disabled.

### Configuring Flashing LEDs

#### Information About Configuring Flashing LEDs

Controller software enables you to flash the LEDs on an access point in order to locate it. All Cisco IOS lightweight access points support this feature.

#### Configuring Flashing LEDs (CLI)

Use these commands to configure LED flashing from the privileged EXEC mode of the controller:

1. Configure the LED flash for an AP by entering this command:

   ```
   config ap led-state flash {seconds | indefinite | disable} {Cisco_AP}
   ```

   The valid LED flash duration for the AP is 1 to 3600 seconds. You can also configure the LED to flash indefinitely or to stop flashing the LED.

2. Disable LED flash for an AP after enabling it by entering this command:

   ```
   config ap led-state flash disable Cisco_AP
   ```

   The command disables LED flashing immediately. For example, if you run the previous command (with the `seconds` parameter set to 60 seconds) and then disable LED flashing after only 20 seconds, the access point’s LEDs stop flashing immediately.

3. Save your changes by entering this command:

   ```
   save config
   ```

4. Check the status of LED flash for the AP by entering this command:

   ```
   show ap led-flash Cisco_AP
   ```

   Information similar to the following appears:

   ```
   (Cisco Controller)> show ap led-flash AP1040_46:b9
   Led Flash.......................... Enabled for 450 secs, 425 secs left
   ```

#### Note

The output of these commands is sent only to the controller console, regardless of whether the commands were entered on the console or in a TELNET/SSH CLI session.
Viewing Clients

You can use the controller GUI or CLI to view information about the clients that are associated to the controller’s access points.

Viewing Clients (GUI)

Step 1
Choose Monitor > Clients to open the Clients page.
This page lists all of the clients that are associated to the controller’s access points. It provides the following information for each client:

• The MAC address of the client
• The name of the access point to which the client is associated
• The name of the WLAN used by the client
• The type of client (802.11a, 802.11b, 802.11g, or 802.11n)

Note If the 802.11n client associates to an 802.11a radio that has 802.11n enabled, then the client type shows as 802.11a/n. If the 802.11n client associates to an 802.11b/g radio with 802.11n enabled, then the client type shows as 802.11b/n.

• The status of the client connection
• The authorization status of the client
• The port number of the access point to which the client is associated
• An indication of whether the client is a WGB

Note If you want to remove or disable a client, hover your cursor over the blue drop-down arrow for that client and choose Remove or Disable, respectively. If you want to test the connection between the client and the access point, hover your cursor over the blue drop-down arrow for that client and choose Link Test.

Step 2
Create a filter to display only clients that meet certain criteria (such as the MAC address, status, or radio type) as follows:

a) Click Change Filter to open the Search Clients dialog box.
b) Select one or more of the following check boxes to specify the criteria used when displaying clients:

• MAC Address—Enter a client MAC address.
  Note When you enable the MAC address filter, the other filters are disabled automatically. When you enable any of the other filters, the MAC address filter is disabled automatically.

• AP Name—Enter the name of an access point.

• WLAN Profile—Choose one of the available WLAN profiles from the drop-down list.

• Status—Select the Associated, Authenticated, Excluded, and/or Idle check boxes.

• Radio Type—Choose 802.11a, 802.11b, 802.11g, 802.11an, 802.11bn or Mobile.

• WGB—Enter the WGB clients associated to the controller’s access points.
c) Click **Apply**. The Current Filter parameter at the top of the Clients page shows the filters that are currently applied.  
   **Note** If you want to remove the filters and display the entire client list, click **Clear Filter**.

**Step 3** Click the MAC address of the client to view detailed information for a specific client. The Clients > Detail page appears. This page shows the following information:

- The general properties of the client
- The security settings of the client
- The QoS properties of the client
- Client statistics
- The properties of the access point to which the client is associated

---

### Viewing Clients (CLI)

Use these commands to view client information:

- See the clients associated to a specific access point by entering this command:
  ```
  show client ap {802.11a | 802.11b} Cisco_AP
  ```
- See a summary of the clients associated to the controller’s access points by entering this command:
  ```
  show client summary
  ```
- See detailed information for a specific client by entering this command:
  ```
  show client detail client_mac
  ```
- See detailed information of the first eight clients that are in RUN state, associated to the controller’s access points by entering this command:
  ```
  show client username username
  ```

### Configuring LED States for Access Points

In a wireless LAN network where there are a large number of access points, it is difficult to locate a specific access point associated with the controller. You can configure the controller to set the LED state of an access point so that it blinks and the access point can be located. This configuration can be done in the wireless network on a global as well as per-AP level.
Configuring the LED State for Access Points in a Network Globally (GUI)

**Step 1**  Choose Wireless > Access Points > Global Configuration to open the Global Configuration page.

**Step 2**  Select the LED state check box.

**Step 3**  Choose Enable from the drop-down list adjacent to this check box.

**Step 4**  Click Apply.

Configuring the LED State for Access Point in a Network Globally (CLI)

- Set the LED state for all access points associated with a controller by entering this command:
  ```
  config ap led-state {enable | disable} all
  ```

Configuring LED State on a Specific Access Point (GUI)

**Step 1**  Choose Wireless > Access Points > All APs and then the name of the desired access point.

**Step 2**  Choose the Advanced tab to open the All APs > Details for (Advanced) page.

**Step 3**  Select the LED state check box.

**Step 4**  Choose Enable from the drop-down list adjacent to this text box.

**Step 5**  Click Apply.

Configuring LED State on a Specific Access Point (CLI)

**Step 1**  Determine the ID of the access point for which you want to configure the LED state by entering this command:
  ```
  show ap summary
  ```

**Step 2**  Configure the LED state by entering the following command:
  ```
  config ap led-state {enable | disable} Cisco_AP
  ```
Controlling Lightweight Access Points

Configuring LED State on a Specific Access Point (CLI)
CHAPTER 9

Controlling Mesh Access Points

This chapter contains these sections:

- Information About Cisco Aironet Mesh Access Points, page 521
- Guidelines and Limitations, page 522
- Additional References, page 522
- Access Point Roles, page 523
- Network Access, page 523
- Network Segmentation, page 523
- Cisco Indoor Mesh Access Points, page 524
- Cisco Outdoor Mesh Access Points, page 524
- Mesh Deployment Modes, page 525
- Architecture Overview, page 530
- Design Considerations, page 531
- Adding Mesh Access Points to the Mesh Network, page 539
- Configuring Advanced Features, page 577
- Converting Indoor Access Points to Mesh Access Points, page 637
- Converting Indoor Mesh Access Points to Nonmesh Lightweight Access Points (1130AG, 1240AG), page 639
- Configuring Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers, page 640

Information About Cisco Aironet Mesh Access Points

Mesh networking employs Cisco Aironet 1500 Series outdoor mesh access points and indoor mesh access points (Cisco Aironet 1040, 1130, 1140, 1240, 1250, 1260, series access points) along with the Cisco Wireless LAN Controller, and Cisco Prime Network Control System (NCS) to provide scalable, central management, and mobility between indoor and outdoor deployments. Control and Provisioning of Wireless Access Points (CAPWAP) protocol manages the connection of mesh access points to the network.
End-to-end security within the mesh network is supported by employing Advanced Encryption Standard (AES) encryption between the wireless mesh access points and Wi-Fi Protected Access 2 (WPA2) clients. This document also outlines radio frequency (RF) components to consider when designing an outdoor network.

Controller software release 7.0.116.0 and later releases support these Cisco Aironet mesh access points:

- Cisco Aironet 1520 series outdoor mesh access points consist of the 1522 dual-radio mesh access point and the 1524PS/Serial Backhaul multi-radio mesh access point.

**Note** AP1130 and AP1240 must be converted to operate as indoor mesh access points. See the Converting Indoor Access Points to Mesh Access Points.

- Cisco Aironet 1550 series outdoor mesh access points consist of these models:
  - 1552E
  - 1552C
  - 1552I
  - 1552H
  - 1552EU
  - 1552CU

In the 7.0.98.0 release, indoor mesh is available on Cisco Aironet 1130 and 1240 series access points. In the 7.0.116.0 release, indoor mesh is also available on 11n access points (Cisco Aironet 1040, 1140, 1250, 1260, 3500 and 3600 series access points). Indoor mesh is not supported with 802.11b/g only access points because 5 GHz is required for mesh backhaul access.

**Guidelines and Limitations**

- All features discussed in this chapter apply to indoor (1040, 1140, 1250, 1260, 3500, 3600) and outdoor mesh access points (1500 series) unless noted otherwise. Mesh access point or MAP is hereafter used to refer to both indoor and outdoor mesh access points.
- Cisco Aironet 1505 and 1510 access points are not supported in this release.

**Additional References**

<table>
<thead>
<tr>
<th>Related Topic</th>
<th>Document Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converting indoor access points to operate as mesh access points</td>
<td>Converting Indoor Access Points to Mesh Access Points</td>
</tr>
</tbody>
</table>


Access Point Roles

Access points within a mesh network operate as either a Root Access Point (RAP) or a Mesh Access Point (MAP).

RAPs have wired connections to their controller, and MAPs have wireless connections to their controller. MAPs communicate among themselves and back to the RAP using wireless connections over the 802.11a radio backhaul. MAPs use the Cisco Adaptive Wireless Path Protocol (AWPP) to determine the best path through the other mesh access points to the controller.

All the possible paths between the MAPs and RAPs form the wireless mesh network.

Network Access

Wireless mesh networks can simultaneously carry two different traffic types: wireless LAN client traffic and MAP Ethernet port traffic.

Wireless LAN client traffic terminates on the controller, and the Ethernet traffic terminates on the Ethernet ports of the mesh access points.

Access to the wireless LAN mesh for mesh access points is managed by the following:

- MAC authentication—Mesh access points are added to a database to ensure that they are allowed access to a given controller and the mesh network. See the Converting Indoor Access Points to Mesh Access Points section.
- External RADIUS authentication—Mesh access points can be externally authorized to use a RADIUS server such as Cisco ACS 4.1 and later releases that support the client authentication type of EAP-FAST with certificates. See the Configuring RADIUS Servers section.

Network Segmentation

Membership to the wireless LAN mesh network for mesh access points is controlled by the bridge group names (BGNs). Mesh access points can be placed in similar bridge groups to manage membership or provide network segmentation. See the Configuring Antenna Gain section.
Cisco Indoor Mesh Access Points

With the 7.3 release, indoor mesh is available on 2600 series access points.

With the 7.2 release, indoor mesh is available on 3600 series access points.

With the 7.0.116.0 release, indoor mesh is also available on 802.11n access points (Cisco Aironet 1040, 1140, 1250, 1260, 3500, and 3600 series access points).

With the 7.0 release, indoor mesh is available on Cisco Aironet 1130 and 1240 series access points.

Enterprise 11n mesh is an enhancement added to the CUWN feature to work with the 802.11n access points. Enterprise 11n mesh features are compatible with non-802.11n mesh but adds higher backhaul and client access speeds. The 802.11n indoor access points are two-radio Wi-Fi infrastructure devices for select indoor deployments. One radio can be used for local (client) access for the access point and the other radio can be configured for wireless backhaul. The backhaul is supported only on the 5-GHz radio. Enterprise 11n mesh supports P2P, P2MP, and mesh types of architectures.

You have a choice of ordering indoor access points directly into the bridge mode, so that these access points can be used directly as mesh access points. If you have these access points in a local mode (nonmesh), then you have to connect these access points to the controller and change the AP mode to the bridge mode (mesh). This scenario can become cumbersome particularly if the volume of the access points being deployed is large and if the access points are already deployed in the local mode for a traditional nonmesh wireless coverage.

The Cisco indoor mesh access points are equipped with the following two simultaneously operating radios:

- 2.4-GHz radio used for client access
- 5-GHz radio used for data backhaul

The 5-GHz radio supports the 5.15 GHz, 5.25 GHz, 5.47 GHz, and 5.8 GHz bands.

Cisco Outdoor Mesh Access Points

Cisco outdoor mesh access points comprise of the Cisco Aironet 1500 series access points. The 1500 series includes 1552 11n outdoor mesh access points, 1522 dual-radio mesh access points, and 1524 multi-radio mesh access points. There are two models of the 1524, which are the following:

- The public safety model, 1524PS
- The serial backhaul model, 1524SB

Note

In the 6.0 release, the AP1524SB access point was launched in A, C and N domains. In the 7.0 release, the AP1524SB access point is launched also in -E, -M, -K, -S, and -T domains.

Cisco 1500 series mesh access points are the core components of the wireless mesh deployment. AP1500s are configured by both the controller (GUI and CLI) and Cisco WCS. Communication between outdoor mesh access points (MAPs and RAPs) is over the 802.11a/n radio backhaul. Client traffic is generally transmitted over the 802.11b/g/n radio (802.11a/n can also be configured to accept client traffic), and public safety traffic (AP1524PS only) is transmitted over the 4.9-GHz radio.
The mesh access point can also operate as a relay node for other access points not directly connected to a wired network. Intelligent wireless routing is provided by the Adaptive Wireless Path Protocol (AWPP). This Cisco protocol enables each mesh access point to identify its neighbors and intelligently choose the optimal path to the wired network by calculating the cost of each path in terms of the signal strength and the number of hops required to get to a controller.

AP1500s are manufactured in two different configurations: cable and noncable.

- The cable configuration can be mounted to a cable strand and supports power-over-cable (POC).
- The noncable configuration supports multiple antennas. It can be mounted to a pole or building wall and supports several power options.

Uplinks support includes Gigabit Ethernet (1000BASE-T) and a small form-factor (SFP) slot that can be plugged for a fiber or cable modem interface. Both single mode and multimode SFPs up to 1000BASE-BX are supported. The cable modem can be DOCSIS 2.0 or DOCSIS/EuroDOCSIS 3.0 depending upon the type of mesh access point.

AP1500s are available in a hazardous location hardware enclosure. When configured, the AP1500 complies with safety standards for Class I, Division 2, Zone 2 hazardous locations.

Cisco 3500 series outdoor access points support clean air in a mesh backhaul at 5 GHz frequency and provides only the IDR and AQI reports. These access points work similar to other access points.

Note: See the Cisco Aironet 1520 Series Lightweight Outdoor Access Point Ordering Guide for power, mounting, antenna, and regulatory support by model:

Mesh Deployment Modes

Mesh access points support multiple deployment modes, including the following:

- Wireless mesh
- Wireless backhaul
- Point-to-Multipoint Wireless Bridging
- Point-to-Point Wireless Bridging

Wireless Mesh Network

In a Cisco wireless outdoor mesh network, multiple mesh access points comprise a network that provides secure, scalable outdoor wireless LAN.

The three RAPs are connected to the wired network at each location and are located on the building roof. All the downstream access points operate as MAPs and communicate using wireless links (not shown).

Both MAPs and RAPs can provide WLAN client access; however, the location of RAPs are often not suitable for providing client access.
Some of the buildings have onsite controllers to terminate CAPWAP sessions from the mesh access points but it is not a mandatory requirement because CAPWAP sessions can be back hauled to a controller over a wide-area network (WAN).

Note

- CAPWAP over CAPWAP is not supported.
- CAPWAP over MAP Ethernet port is currently not a supported design. It is not possible to connect a local, FlexConnect mode AP or a RAP behind MAP Ethernet port.

## Wireless Backhaul

In a Cisco wireless backhaul network, traffic can be bridged between MAPs and RAPs. Outdoor Mesh AP and indoor AP converted to MAP mode are supported if CAPWAP over CAPWAP using ethernet bridging is supported. Both, local and flexconnect modes are support in MAP using ethernet bridging. This traffic can be from wired devices that are being bridged by the wireless mesh or CAPWAP traffic from the mesh access points. This traffic is always AES encrypted when it crosses a wireless mesh link such as a wireless backhaul. AES encryption is established as part of the mesh access point neighbor relationship with other mesh access points. The encryption keys used between mesh access points are derived during the EAP authentication process.

Only 5 GHz backhaul is possible on all mesh access points except 1522 in which either 2.4 or 5 GHz radio can be configured as a backhaul radio (see Configuring Advanced Features).

## Universal Access

You can configure the backhaul on mesh access points to accept client traffic over its 802.11a radio. This feature is identified as Backhaul Client Access in the controller GUI (Monitor > Wireless). When this feature is disabled, backhaul traffic is transmitted only over the 802.11a or 802.11a/n radio and client association is allowed only over the 802.11b/g or 802.11b/g/n radio. For more information about the configuration, see the Configuring Advanced Features section.

## Point-to-Multipoint Wireless Bridging

In the point-to-multipoint bridging scenario, a RAP acting as a root bridge connects multiple MAPs as nonroot bridges with their associated wired LANs. By default, this feature is disabled for all MAPs. If Ethernet bridging is used, you must enable it on the controller for the respective MAP and for the RAP.

This figure shows a simple deployment with one RAP and two MAPs, but this configuration is fundamentally a wireless mesh with no WLAN clients. Client access can still be provided with Ethernet bridging enabled,
although if bridging between buildings, MAP coverage from a high rooftop might not be suitable for client access.

Figure 49: Point-to-Multipoint Bridging Example

Point-to-Point Wireless Bridging

In a point-to-point bridging scenario, a 1500 Series Mesh AP can be used to extend a remote network by using the backhaul radio to bridge two segments of a switched network. This is fundamentally a wireless mesh network with one MAP and no WLAN clients. Just as in point-to-multipoint networks, client access can still be provided with Ethernet bridging enabled, although if bridging between buildings, MAP coverage from a high rooftop might not be suitable for client access.

If you intend to use an Ethernet bridged application, we recommend that you enable the bridging feature on the RAP and on all MAPs in that segment. You must verify that any attached switches to the Ethernet ports of your MAPs are not using VLAN Trunking Protocol (VTP). VTP can reconfigure the trunked VLANs across your mesh and possibly cause a loss in connection for your RAP to its primary WLC. An incorrect configuration can take down your mesh deployment.

Figure 50: Point-to-Point Wireless Bridging Example

For security reasons the Ethernet port on the MAPs is disabled by default. It can be enabled only by configuring Ethernet Bridging on the Root and the respective MAPs.

Ethernet bridging has to be enabled for the following two scenarios:
When you want to use the mesh nodes as bridges.

When you want to connect Ethernet devices such as a video camera on the MAP using its Ethernet port.

Ensure that you enable Ethernet bridging for every parent mesh AP taking the path from the mesh AP in question to the controller. For example, if you enable Ethernet bridging on MAP2 in Hop 2, then you must also enable Ethernet bridging on MAP1 (parent MAP), and on the RAP connecting to the controller.

Range Parameters have to be configured for longer links under the **Wireless > Mesh** tab. Optimum distance (in feet) should exist between the root access point (RAP) and the farthest mesh access point (MAP). Range from the RAP bridge to the MAP bridge has to be mentioned in feet.

The following global parameter applies to all mesh access points when they join the controller and all existing mesh access points in the network:

- **Range**: 150 to 132,000 feet
- **Default**: 12,000 feet

### Configuring Mesh Range (CLI)

- To configure the distance between the nodes doing the bridging, enter this command:

  ```
  config mesh range range-in-feet
  ```

- To get the mesh range, enter this command:

  ```
  show mesh config
  ```

Information similar to the following is displayed:

```
Mesh Range....................................... 12000
Mesh Statistics update period.................... 3 minutes
Backhaul with client access status............. disabled
Background Scanning State....................... enabled
Backhaul Amsdu State............................ disabled

Mesh Security
Security Mode.................................... EAP
External-Auth.................................... disabled
Use MAC Filter in External AAA server......... disabled
Force External Authentication.................. disabled

Mesh Alarm Criteria
Max Hop Count................................... 4
Recommended Max Children for MAP............ 10
Recommended Max Children for RAP............ 20
Low Link SNR.................................... 12
High Link SNR.................................. 60
Max Association Number........................ 10
Association Interval........................... 60 minutes
Parent Change Numbers......................... 3
Parent Change Interval......................... 60 minutes

Mesh Multicast Mode............................ In-Out
Mesh Full Sector DFS........................... enabled
Mesh Ethernet Bridging VLAN Transparent Mode..... enabled
```

**Note**  
APs reboot after you specify the range.

To estimate the range, you can use range calculators that are available at:
Assumptions for the AP1522 Range Calculator

• The AP1522 Range Calculator has been edited to stay within limitations for Tx power and EIRP under the listed regulatory domains. There may be cases where it exceeds the limitations. You must verify that the installation is within the laws of the location in which it is being installed.

• When you use the AP1522 Range Calculator, available power levels change based upon the regulatory domain, the antenna (or antenna gain) selected, the modulation mode, which is based on the data rate selected (OFDM requires a lower power level in some domains). You must verify all parameters after making any parameter changes.

• Rx sensitivity in 2.4 GHz is the composite sensitivity of all three Rx paths. That is, MRC is included in 2.4 GHz. There is only one Rx for 5 GHz.

• You can choose only the channels that the access point is certified for.

• You can select only valid power levels.

Assumptions for the AP1552 Range Calculator

• The AP1552 Range Calculator has been edited to stay within limitations for Tx power and EIRP under the listed regulatory domains. There may be cases where it exceeds the limitations. You must verify that the installation is within the laws of the location in which it is being installed.

• All three antenna ports must be used for external antenna models of 1552 for effective performance. Otherwise, range is significantly compromised. 1552 radios have two Tx paths and three Rx paths.

• The Tx power is the total composite power of both Tx paths.

• Rx sensitivity is the composite sensitivity of all three Rx paths. That is, MRC is included.

• The AP1552 Range Calculator assumes that ClientLink (Beamforming) is switched on.

• When you use the AP1552 Range Calculator, available power levels change based upon the regulatory domain, the antenna (or antenna gain) selected, and the data rate selected. You must verify all parameters after making any parameter changes.

• You can select a different antenna than the two that are available by default. If you enter a high gain antenna and choose a power that goes over the EIRP limit, then you get a warning and the range equals 0.

• You can choose only the channels that the access point is certified for.

• You can only select only valid power levels.
Architecture Overview

Control And Provisioning of Wireless Access Points (CAPWAP)

CAPWAP is the provisioning and control protocol used by the controller to manage access points (mesh and nonmesh) in the network. This protocol replaces LWAPP in controller software 5.2 or later releases.

Cisco Adaptive Wireless Path Protocol Wireless Mesh Routing

The Cisco Adaptive Wireless Path Protocol (AWPP) is designed specifically for wireless mesh networking. The path decisions of AWPP are based on the link quality and the number of hops.

Ease of deployment, fast convergence, and minimal resource consumption are also key components of AWPP.

The goal of AWPP is to find the best path back to a RAP for each MAP that is part of the RAP’s bridge group. To do this, the MAP actively solicits for neighbor MAPs. During the solicitation, the MAP learns all of the available neighbors back to a RAP, determines which neighbor offers the best path, and then synchronizes with that neighbor.

Mesh Neighbors, Parents, and Children

Relationships among access points with the mesh network are labeled as parent, child, or neighbor as follows:

- A parent access point offers the best route back to the RAP based on its ease values. A parent can be either the RAP itself or another MAP. Ease is calculated using the SNR and link hop value of each neighbor. Given multiple choices, an access point with a higher ease value is selected.

- A child access point selects the parent access point as its best route back to the RAP.
Design Considerations

Each outdoor wireless mesh deployment is unique, and each environment has its own challenges with available locations, obstructions, and available network infrastructure. Design requirements driven by expected users, traffic, and availability needs are also major design criteria. This section describes important design considerations and provides an example of a wireless mesh design.

Wireless Mesh Constraints

The following are a few system characteristics to consider when you design and build a wireless mesh network. Some of these characteristics apply to the backhaul network design and others to the CAPWAP controller design:

Wireless Backhaul Data Rate

Backhaul is used to create only the wireless connection between the access points. The backhaul interface by default is 802.11a or 802.11a/n depending upon the access point. The rate selection is important for effective use of the available RF spectrum. The rate can also affect the throughput of client devices, and throughput is an important metric used by industry publications to evaluate vendor devices.

Dynamic Rate Adaptation (DRA) introduces a process to estimate optimal transmission rate for packet transmissions. It is important to select rates correctly. If the rate is too high, packet transmissions fail resulting in communication failure. If the rate is too low, the available channel bandwidth is not used, resulting in inferior products, and the potential for catastrophic network congestion and collapse.

- A neighbor access point is within the radio frequency (RF) range of another access point but is not selected as its parent or a child because its ease values are lower than that of the parent.
Data rates also affect the RF coverage and network performance. Lower data rates, for example 6 Mbps, can extend farther from the access point than can higher data rates, for example 300 Mbps. As a result, the data rate affects cell coverage and consequently the number of access points required. Different data rates are achieved by sending a more redundant signal on the wireless link, allowing data to be easily recovered from noise. The number of symbols sent out for a packet at the 1-Mbps data rate is higher than the number of symbols used for the same packet at 11 Mbps. Therefore, sending data at the lower bit rates takes more time than sending the equivalent data at a higher bit rate, resulting in reduced throughput.

A lower bit rate might allow a greater distance between MAPs, but there are likely to be gaps in the WLAN client coverage, and the capacity of the backhaul network is reduced. An increased bit rate for the backhaul network either requires more MAPs or results in a reduced SNR between MAPs, limiting mesh reliability and interconnection. For more information about configuring wireless backhaul data rate.

![Image](image100x547to116x564)

**Note**

The data rate can be set on the backhaul on a per AP basis. It is not a global command.

**Table 24: Backhaul Data Rates and Minimum LinkSNR Requirements**

<table>
<thead>
<tr>
<th>802.11a Data Rate (Mbps)</th>
<th>Minimum Required LinkSNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>54</td>
<td>31</td>
</tr>
<tr>
<td>48</td>
<td>29</td>
</tr>
<tr>
<td>36</td>
<td>26</td>
</tr>
<tr>
<td>24</td>
<td>22</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
</tr>
<tr>
<td>12</td>
<td>16</td>
</tr>
<tr>
<td>9</td>
<td>15</td>
</tr>
<tr>
<td>6</td>
<td>14</td>
</tr>
</tbody>
</table>

• The required minimum LinkSNR value is driven by the data rate and the following formula: \( \text{Minimum SNR} + \text{fade margin} \).

  • Minimum SNR refers to an ideal state of noninterference, nonnoise, and a system packet error rate (PER) of no more than 10 percent.

  • Typical fade margin is approximately 9 to 10 dB.
Table 25: Minimum Required LinkSNR Calculations by Data Rate

<table>
<thead>
<tr>
<th>802.11n Date Rate (Mbps)</th>
<th>Minimum SNR (dB)</th>
<th>Fade Margin = Minimum SNR (dB) + 802.11n Date Rate (Mbps)</th>
<th>Minimum Required LinkSNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>5</td>
<td>9</td>
<td>14</td>
</tr>
<tr>
<td>9</td>
<td>6</td>
<td>9</td>
<td>15</td>
</tr>
<tr>
<td>12</td>
<td>7</td>
<td>9</td>
<td>16</td>
</tr>
<tr>
<td>18</td>
<td>9</td>
<td>9</td>
<td>18</td>
</tr>
<tr>
<td>24</td>
<td>13</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>36</td>
<td>17</td>
<td>9</td>
<td>26</td>
</tr>
</tbody>
</table>

- If you take into account the effect of MRC for calculating Minimum Required Link SNR.
  \[
  \text{LinkSNR} = \text{Minimum SNR} - \text{MRC Gain from 3 RXs (dB)} + \text{Fade Margin (9 dB)}
  \]

This table shows the required Link SNR for 802.11a/g (2.4 GHz and 5 GHz) for AP1552 and 1522 with 3 Rx antennas (MRC gain).

Table 26: Required Link SNR Calculations for 802.11a/g

<table>
<thead>
<tr>
<th>802.11a/g MCS (Mbps)</th>
<th>Modulation</th>
<th>Minimum SNR (dB)</th>
<th>MRC Gain from 3 RXs (dB)</th>
<th>Fade Margin (dB)</th>
<th>Required Link SNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>BPSK 1/2</td>
<td>5</td>
<td>4.7</td>
<td>9</td>
<td>9.3</td>
</tr>
<tr>
<td>9</td>
<td>BPSK 3/4</td>
<td>6</td>
<td>4.7</td>
<td>9</td>
<td>10.3</td>
</tr>
<tr>
<td>12</td>
<td>QPSK 1/2</td>
<td>7</td>
<td>4.7</td>
<td>9</td>
<td>11.3</td>
</tr>
<tr>
<td>18</td>
<td>QPSK 3/4</td>
<td>9</td>
<td>4.7</td>
<td>9</td>
<td>13.3</td>
</tr>
<tr>
<td>24</td>
<td>16QAM 1/2</td>
<td>13</td>
<td>4.7</td>
<td>9</td>
<td>17.3</td>
</tr>
<tr>
<td>36</td>
<td>16QAM 3/4</td>
<td>17</td>
<td>4.7</td>
<td>9</td>
<td>21.3</td>
</tr>
<tr>
<td>48</td>
<td>64QAM 2/3</td>
<td>20</td>
<td>4.7</td>
<td>9</td>
<td>24.3</td>
</tr>
<tr>
<td>54</td>
<td>64QAM 3/4</td>
<td>22</td>
<td>4.7</td>
<td>9</td>
<td>26.3</td>
</tr>
</tbody>
</table>

This table shows Link SNR requirements with AP1552 for 2.4 and 5 GHz.
Table 27: Requirements for Link SNR with AP1552 for 2.4 and 5 GHz

<table>
<thead>
<tr>
<th>No. of Spatial Streams</th>
<th>11n MCS</th>
<th>Modulation</th>
<th>Minimum SNR (dB)</th>
<th>MRC Gain from 3 RXs (dB)</th>
<th>Fade Margin (dB)</th>
<th>Link SNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MCS 0</td>
<td>BPSK 1/2</td>
<td>5</td>
<td>4.7</td>
<td>9</td>
<td>9.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 1</td>
<td>QPSK 1/2</td>
<td>7</td>
<td>4.7</td>
<td>9</td>
<td>11.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 2</td>
<td>QPSK 3/4</td>
<td>9</td>
<td>4.7</td>
<td>9</td>
<td>13.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 3</td>
<td>16QAM 1/2</td>
<td>13</td>
<td>4.7</td>
<td>9</td>
<td>17.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 4</td>
<td>16QAM 3/4</td>
<td>17</td>
<td>4.7</td>
<td>9</td>
<td>21.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 5</td>
<td>64QAM 2/3</td>
<td>20</td>
<td>4.7</td>
<td>9</td>
<td>24.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 6</td>
<td>64QAM 3/4</td>
<td>22</td>
<td>4.7</td>
<td>9</td>
<td>26.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 7</td>
<td>64QAM 5/6</td>
<td>23</td>
<td>4.7</td>
<td>9</td>
<td>27.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 8</td>
<td>BPSK 1/2</td>
<td>5</td>
<td>1.7</td>
<td>9</td>
<td>12.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 9</td>
<td>QPSK 1/2</td>
<td>7</td>
<td>1.7</td>
<td>9</td>
<td>14.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 10</td>
<td>QPSK 3/4</td>
<td>9</td>
<td>1.7</td>
<td>9</td>
<td>16.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 11</td>
<td>16QAM 1/2</td>
<td>13</td>
<td>1.7</td>
<td>9</td>
<td>20.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 12</td>
<td>16QAM 3/4</td>
<td>17</td>
<td>1.7</td>
<td>9</td>
<td>24.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 13</td>
<td>64QAM 2/3</td>
<td>20</td>
<td>1.7</td>
<td>9</td>
<td>27.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 14</td>
<td>64QAM 3/4</td>
<td>22</td>
<td>1.7</td>
<td>9</td>
<td>29.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 15</td>
<td>64QAM 5/6</td>
<td>23</td>
<td>1.7</td>
<td>9</td>
<td>30.3</td>
</tr>
</tbody>
</table>

With two spatial streams, the MRC gain is halved, that is the MRC gain is reduced by 3 dB. This is because the system has $10 \log (3/2 \text{SS})$ instead of $10 \log (3/1 \text{SS})$. If there were to have been 3 SS with 3 RX, then the MRC gain would have been zero.

- Number of backhaul hops is limited to eight but we recommend three to four hops.

The number of hops is recommended to be limited to three or four primarily to maintain sufficient backhaul throughput, because each mesh access point uses the same radio for transmission and reception of backhaul traffic, which means that throughput is approximately halved over every hop. For example,
the maximum throughput for 24 Mbps is approximately 14 Mbps for the first hop, 9 Mbps for the second hop, and 4 Mbps for the third hop.

• Number of MAPs per RAP.

There is no current software limitation on how many MAPs per RAP you can configure. However, it is suggested that you limit the number to 20 MAPs per RAP.

• Number of controllers

  The number of controllers per mobility group is limited to 72.

• Number of mesh access points supported per controller.

ClientLink Technology

Many networks still support a mix of 802.11a/g and 802.11n clients. Because 802.11a/g clients (legacy clients) operate at lower data rates, the older clients can reduce the capacity of the entire network. Cisco’s ClientLink technology can help solve problems related to adoption of 802.11n in mixed-client networks by ensuring that 802.11a/g clients operate at the best possible rates, especially when they are near cell boundaries.

Advanced signal processing has been added to the Wi-Fi chipset. Multiple transmit antennas are used to focus transmissions in the direction of the 802.11a/g client, increasing the downlink signal-to-noise ratio and the data rate over range, thereby reducing coverage holes and enhancing the overall system performance. This technology learns the optimum way to combine the signal received from a client and then uses this information to send packets in an optimum way back to the client. This technique is also referred to as MIMO (multiple-input multiple-output) beamforming, transmit beamforming, or cophasing, and it is the only enterprise-class and service provider-class solution in the market that does not require expensive antenna arrays.

The 802.11n systems take advantage of multipath by sending multiple radio signals simultaneously. Each of these signals, called a spatial stream, is sent from its own antenna using its own transmitter. Because there is some space between these antennas, each signal follows a slightly different path to the receiver, a situation called spatial diversity. The receiver has multiple antennas as well, each with its own radio that independently decodes the arriving signals, and each signal is combined with signals from the other receiver radios. This results in multiple data streams receiving at the same time. This enables a higher throughput than previous 802.11a/g systems, but requires an 802.11n capable client to decipher the signal. Therefore, both AP and client need to support this capability. Due to the complexity of issues, in the first generation of mainstream 802.11n chipsets, neither the AP nor client chipsets implemented 802.11n transmit beamforming. Therefore, the 802.11n standard transmit beamforming will be available eventually, but not until the next generation of chipsets take hold in the market. We intend to lead in this area going forward.

For the current generation of 802.11n APs, while the second transmit path was being well utilized for 802.11n clients (to implement spatial diversity), it was not being fully used for 802.11a/g clients. For 802.11 a/g clients, some of the capabilities of the extra transmit path was lying idle. In addition, for many networks, the performance of the installed 802.11 a/g client base would be a limiting factor on the network.

ClientLink uses advanced signal processing techniques and multiple transmit paths to optimize the signal received by 802.11a/g clients in the downlink direction without requiring feedback. Because no special feedback is required, Cisco ClientLink works with all existing 802.11a/g clients.

Cisco ClientLink technology effectively enables the access point to optimize the SNR exactly at the position where the client is placed. ClientLink provides a gain of almost 4 dB in the downlink direction. Improved SNR yields many benefits, such as a reduced number of retries and higher data rates. For example, a client at the edge of the cell that might previously have been capable of receiving packets at 12 Mbps could now receive...
them at 36 Mbps. Typical measurements of downlink performance with ClientLink show as much as 65 percent greater throughput for 802.11a/g clients. By allowing the Wi-Fi system to operate at higher data rates and with fewer retries, ClientLink increases the overall capacity of the system, which means an efficient use of spectrum resources.

ClientLink in the 1552 access points is based on ClientLink capability available in AP3500s. Therefore, the access point has the ability to beamform well to nearby clients and to update beamforming information on 802.11ACKs. Therefore, even if there is no dedicated uplink traffic, the ClientLink works well, which is beneficial to both TCP and UDP traffic streams. There are no RSSI watermarks, which the client has to cross to take advantage of this Beamforming with Cisco 802.11n access points.

ClientLink can beamform to 15 clients at a time. Therefore, the host must select the best 15 if the number of legacy clients exceeds 15 per radio. AP1552 has two radios, which means that up to 30 clients can be beamformed in time domain.

Although ClientLink is applied to legacy OFDM portions of packets, which refers to 11a/g rates (not 11b) for both indoor and outdoor 802.11n access points, there is one difference between ClientLink for indoor 11n and ClientLink for outdoor 11n. For indoor 11n access points, SW limits the affected rates to 24, 36, 48, and 54 Mbps. To avoid clients sticking to a far away AP in an indoor environment. SW also does not allow ClientLink to work for those rates for 11n clients because the throughput gain is so minimal. However, there is a demonstrable gain for pure legacy clients. For outdoor 11n access points, three more additional legacy data rates lower than 24 Mbps have been added. ClientLink for outdoors is applicable to legacy data rates of 9, 12, 18, 24, 36, 48, and 54 Mbps.

### Configuring ClientLink (CLI)

From the 7.2 release onwards, it is not possible to configure ClientLink (beamforming) using the controller GUI.

<table>
<thead>
<tr>
<th>Step</th>
<th>Command</th>
</tr>
</thead>
</table>
| **Step 1** | Disable the 802.11a or 802.11b/g network by entering this command:  
`config {802.11a | 802.11b} disable network` |
| **Step 2** | Globally enable or disable beamforming on your 802.11a or 802.11g network by entering this command:  
`config {802.11a | 802.11b} beamforming global {enable | disable}`  
The default value is disabled. **Note** After you enable beamforming on the network, it is automatically enabled for all the radios applicable to that network type. |
| **Step 3** | Override the global configuration and enable or disable beamforming for a specific access point by entering this command:  
`config {802.11a | 802.11b} beamforming ap Cisco_AP {enable | disable}`  
The default value is disabled if beamforming is disabled on the network and enabled if beamforming is enabled on the network. |
| **Step 4** | Reenable the network by entering this command:  
`config {802.11a | 802.11b} enable network` |
| **Step 5** | Save your changes by entering this command:  
`save config` |
| **Step 6** | See the beamforming status for your network by entering this command:  
`show {802.11a | 802.11b}` |
Information similar to the following appears:

802.11a Network.................................. Enabled
11nSupport....................................... Enabled
802.11a Low Band........................... Enabled
802.11a Mid Band........................... Enabled
802.11a High Band.......................... Enabled

Pico-Cell-V2 Status.............................. Disabled
TI Threshold..................................... -50
Legacy Tx Beamforming setting................. Enabled

Step 7
See the beamforming status for a specific access point by entering this command:
```
show ap config {802.11a | 802.11b} Cisco_AP
```

Information similar to the following appears:

Cisco AP Identifier.................................. 14
Cisco AP Name.................................... 1250-1
Country code..................................... US - United States
Regulatory Domain allowed by Country ........... 802.11bg:-A 802.11a:-A

Phy OFDM parameters
Configuration ............................. AUTOMATIC
Current Channel ........................... 149
Extension Channel ......................... NONE
Channel Width.............................. 20 Mhz
Allowed Channel List....................... 36,40,44,48,52,56,60,64,100,
......................................... 104,108,112,116,132,136,140,
......................................... 149,153,157,161,165
TI Threshold .............................. -50
Legacy Tx Beamforming Configuration ....... CUSTOMIZED
Legacy Tx Beamforming ..................... ENABLED

Commands Related to ClientLink

- The following commands are to be entered in the AP console:
  - To check the status of Beamforming on the AP, enter the `show controller d0/d1` command.
  - To find a client in the AP rbf table, enter the `show interface dot110` command.
  - To check the Beamforming rate assigned on the AP, enter the `debug d0 trace print rates` command.

- The following commands on the AP console are used for troubleshooting:
  - To show that ClientLink is enabled on a radio, enter the `show controllers | inc Beam` command.
    The output is displayed as follows:

    Legacy Beamforming: Configured Yes, Active Yes, RSSI Threshold -50 dBm
    Legacy Beamforming: Configured Yes, Active Yes, RSSI Threshold -60 dBm
To show that ClientLink is Beamforming to a particular client, enter the `show interface dot11radio 1 lbf rbf` command.

The output is displayed as follows:

<table>
<thead>
<tr>
<th>RBF Table:</th>
<th>Index</th>
<th>Client MAC</th>
<th>Reserved</th>
<th>Valid</th>
<th>Tx BF</th>
<th>Aging</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0040.96BA.45A0</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**Controller Planning**

The following items affect the number of controllers required in a mesh network:

- **Mesh access points (RAPs and MAPs) in the network.**

  The wired network that connects the RAP and controllers can affect the total number of access points supported in the network. If this network allows the controllers to be equally available to all access points without any impact on WLAN performance, the access points can be evenly distributed across all controllers for maximum efficiency. If this is not the case, and controllers are grouped into various clusters or PoPs, the overall number of access points and coverage are reduced.

- **Number of mesh access points (RAPs and MAPs) supported per controller.**

  For clarity, nonmesh access points are referred to as local access points in this document.

**Table 28: Mesh Access Point Support by Controller Model**

<table>
<thead>
<tr>
<th>Controller Model</th>
<th>Local AP Support (nonmesh)</th>
<th>Maximum Possible Mesh AP Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>5508</td>
<td>500</td>
<td>500</td>
</tr>
<tr>
<td>2504</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>WiSM2</td>
<td>500</td>
<td>500</td>
</tr>
</tbody>
</table>

6 Local AP support is the total number of nonmesh APs supported on the controller model.
7 For 5508, 2112, and 2125 controllers, the number of MAPs is equal to (local AP support - number of RAPs).
8 For 2504.

**Note**

The Wireless LAN Controller modules NM and NME now support mesh 1520 series access points from Wireless LAN Controller (WLC) software release 5.2 and later releases.
Mesh is fully supported on Cisco 5508 Controllers. The Base License (LIC-CT508-Base) is sufficient for indoor and outdoor APs (AP152X). The WPlus License (LIC-WPLUS-SW) is merged with the base license. The WPlus License is not required for indoor mesh APs. Mesh APs (MAPs/RAPs) are counted as full APs on Cisco 5508 Controllers. With other controller platforms, MAPs are counted as half APs. Data Plane Transport Layer Security (DTLS) is not supported on mesh access points.

**Adding Mesh Access Points to the Mesh Network**

This section assumes that the controller is already active in the network and is operating in Layer 3 mode. Controller ports that the mesh access points connect to should be untagged.

Ensure that you do the following:

**Step 1** Add the radio or ethernet MAC address of the mesh access point to the controller’s MAC filter. See the Adding MAC Addresses of Mesh Access Points to the MAC Filter, on page 539.

**Step 2** Define the role (RAP or MAP) for the mesh access point. See the Defining Mesh Access Point Role, on page 541.

**Step 3** Configure a primary, secondary, and tertiary controller for each mesh access point. See the Configuring Multiple Controllers Using DHCP 43 and DHCP 60, on page 543.

**Step 4** Configure a backup controller. See the Configuring Backup Controllers, on page 544.

**Step 5** Configure external authentication of MAC addresses using an external RADIUS server. See the Configuring External Authentication and Authorization Using a RADIUS Server, on page 549.

**Step 6** Configure global mesh parameters. See the Configuring Global Mesh Parameters, on page 552.

**Step 7** Configure universal client access. Configuring universal client access is part of the Configuring Advanced Features section. See the Universal Client Access, on page 579.

**Step 8** Configure local mesh parameters. See the Configuring Local Mesh Parameters, on page 557.

**Step 9** Configure mobility groups (if desired) and assign controllers. See Chapter 12, Configuring Mobility Groups.

**Adding MAC Addresses of Mesh Access Points to the MAC Filter**

You must enter the radio or ethernet MAC address for all mesh access points that you want to use in the mesh network into the appropriate controller. A controller only responds to discovery requests from outdoor radios that appear in its authorization list. MAC filtering is enabled by default on the controller, so only the MAC addresses need to be configured. If the access point has an SSC and has been added to the AP Authorization List, then the MAC address of the AP does not need to be added to the MAC Filtering List.

You can add the mesh access point using either the GUI or the CLI.

**Note** You can also download the list of mesh access point MAC addresses and push them to the controller using the Cisco Prime Infrastructure. For more information, see the Cisco Prime Infrastructure documentation.
Adding the MAC Address of the Mesh Access Point to the Controller Filter List (GUI)

Step 1  Choose Security > AAA > MAC Filtering. The MAC Filtering page appears.

![Figure 52: MAC Filtering Page](image)

Step 2  Click New. The MAC Filters > New page appears.

Step 3  Enter the MAC address of the mesh access point.

Note  For 1500 series outdoor mesh access points, specify the BVI MAC address of the mesh access point into the controller as a MAC filter. For indoor mesh access points, enter the Ethernet MAC. If the required MAC address does not appear on the exterior of the mesh access point, enter the following command at the access point console to display the BVI and Ethernet MAC addresses: `sh int | i Hardware`.

Step 4  From the Profile Name drop-down list, select Any WLAN.

Step 5  In the Description field, specify a description of the mesh access point. The text that you enter identifies the mesh access point on the controller.

Note  You might want to include an abbreviation of its name and the last few digits of the MAC address, such as `ap1522:62:39:10`. You can also note details on its location such as `roof top`, `pole top`, or its cross streets.

Step 6  From the Interface Name drop-down list, choose the controller interface to which the mesh access point is to connect.

Step 7  Click Apply to commit your changes. The mesh access point now appears in the list of MAC filters on the MAC Filtering page.

Step 8  Click Save Configuration to save your changes.

Step 9  Repeat this procedure to add the MAC addresses of additional mesh access points to the list.
Adding the MAC Address of the Mesh Access Point to the Controller Filter List (CLI)

**Step 1**
To add the MAC address of the mesh access point to the controller filter list, enter this command:
```
cfg macfilter add ap_mac wlan_id interface [description]
```
A value of zero (0) for the `wlan_id` parameter specifies any WLAN, and a value of zero (0) for the `interface` parameter specifies none. You can enter up to 32 characters for the optional `description` parameter.

**Step 2**
To save your changes, enter this command:
```
save config
```

Defining Mesh Access Point Role

By default, AP1500s are shipped with a radio role set to MAP. You must reconfigure a mesh access point to act as a RAP.

Information About MAP and RAP Association With the Controller

- A MAP always sets the Ethernet port as the *primary backhaul* if it is UP, and secondarily the 802.11a/n radio. This gives the network administrator time to reconfigure the mesh access point as a RAP, initially. For faster convergence on the network, we recommend that you do not connect any Ethernet device to the MAP until it has joined the mesh network.

- A MAP that fails to connect to a controller on a UP Ethernet port, sets the 802.11a/n radio as the primary backhaul. If a MAP fails to find a neighbor or fails to connect to a controller through a neighbor, the Ethernet port is set as the primary backhaul again.

- A MAP connected to a controller over an Ethernet port does not build a mesh topology (unlike a RAP).

- A RAP always sets the Ethernet port as the primary backhaul.

- If the Ethernet port is DOWN on a RAP, or a RAP fails to connect to a controller on a UP Ethernet port, the 802.11a/n radio is set as the primary backhaul for 15 minutes. Failing to find a neighbor or failing to connect to a controller via any neighbor on the 802.11a/n radio causes the primary backhaul to go into the *scan* state. The primary backhaul begins its scan with the Ethernet port.
Configuring the AP Role (GUI)

Step 1  Click **Wireless** to open the All APs page.
Step 2  Click the name of an access point. The All APs > Details (General) page appears.
Step 3  Click the **Mesh** tab.

*Figure 53: All APs > Details for (Mesh) Page*

![Image of All APs > Details for (Mesh) Page]

Step 4  Choose **RootAP** or **MeshAP** from the AP Role drop-down list.
Step 5  Click **Apply** to commit your changes and to cause the access point to reboot.

Configuring the AP Role (CLI)

To configure the role of a mesh access point using the CLI, enter the following command:

```
config ap role {rootAP | meshAP} Cisco_AP
```
Configuring Multiple Controllers Using DHCP 43 and DHCP 60

To configure DHCP Option 43 and 60 for mesh access points in the embedded Cisco IOS DHCP server, follow these steps:

**Step 1**
Enter configuration mode at the Cisco IOS CLI.

**Step 2**
Create the DHCP pool, including the necessary parameters such as the default router and name server. The commands used to create a DHCP pool are as follows:

```
  ip dhcp pool pool name
  network IP Network Netmask
  default-router Default router
  dns-server DNS Server
```

where

- `pool name` is the name of the DHCP pool, such as AP1520
- `IP Network` is the network IP address where the controller resides, such as 10.0.15.1
- `Netmask` is the subnet mask, such as 255.255.255.0
- `Default router` is the IP address of the default router, such as 10.0.0.1
- `DNS Server` is the IP address of the DNS server, such as 10.0.10.2

**Step 3**
Add the option 60 line using the following syntax:

```
  option 60 ascii VCI string
```

For the VCI string, use one of the values below. The quotation marks must be included.

- For Cisco 1550 series access points, enter `Cisco AP c1550`
- For Cisco 1520 series access points, enter `Cisco AP c1520`
- For Cisco 1240 series access points, enter `Cisco AP c1240`
- For Cisco 1130 series access points, enter `Cisco AP c1130`

**Step 4**
Add the option 43 line using the following syntax:

```
  option 43 hex hex string
```

The hex string is assembled by concatenating the TLV values shown below:

- `Type + Length + Value`
- `Type` is always f1(hex); `Length` is the number of controller management IP addresses times 4 in hex; `Value` is the IP address of the controller listed sequentially in hex.

For example, suppose that there are two controllers with management interface IP addresses 10.126.126.2 and 10.127.127.2. The type is f1(hex). The length is \(2 \times 4 = 8 = 08\) (hex). The IP addresses translate to 0a7e7e02 and 0a7f7f02. Assembling the string then yields f1080a7e7e020a7f7f02.
The resulting Cisco IOS command added to the DHCP scope is listed below:

```
option 43 hex f1080a7e7e020a7f7f02
```

## Configuring Backup Controllers

### Information About Configuring Backup Controllers

A single controller at a centralized location can act as a backup for mesh access points when they lose connectivity with the primary controller in the local region. Centralized and regional controllers need not be in the same mobility group. Using the controller GUI or CLI, you can specify the IP addresses of the backup controllers, which allows the mesh access points to fail over to controllers outside of the mobility group.

You can also configure primary and secondary backup controllers (which are used if primary, secondary, or tertiary controllers are not specified or are not responsive) for all access points connected to the controller as well as various timers, including the heartbeat timer and discovery request timers.

### Guidelines and Limitations

- The fast heartbeat timer is not supported on mesh access points. The fast heartbeat timer is only configured on access points in local and flexconnect modes.

- The mesh access point maintains a list of backup controllers and periodically sends primary discovery requests to each entry on the list. When the mesh access point receives a new discovery response from a controller, the backup controller list is updated. Any controller that fails to respond to two consecutive primary discovery requests is removed from the list. If the mesh access point’s local controller fails, it chooses an available controller from the backup controller list in this order: primary, secondary, tertiary, primary backup, and secondary backup. The mesh access point waits for a discovery response from the first available controller in the backup list and joins the controller if it receives a response within the time configured for the primary discovery request timer. If the time limit is reached, the mesh access point assumes that the controller cannot be joined and waits for a discovery response from the next available controller in the list.

- When a mesh access point’s primary controller comes back online, the mesh access point disassociates from the backup controller and reconnects to its primary controller. The mesh access point falls back to its primary controller and not to any secondary controller for which it is configured. For example, if a mesh access point is configured with primary, secondary, and tertiary controllers, it fails over to the tertiary controller when the primary and secondary controllers become unresponsive and waits for the primary controller to come back online so that it can fall back to the primary controller. The mesh access point does not fall back from the tertiary controller to the secondary controller if the secondary controller comes back online; it stays connected to the tertiary controller until the primary controller comes back up.

- If you inadvertently configure a controller that is running software release 6.0 with a failover controller that is running a different software release (such as 4.2, 5.0, 5.1, or 5.2), the mesh access point might...
take a long time to join the failover controller because the mesh access point starts the discovery process in LWAPP and then changes to CAPWAP discovery.

**Configuring Backup Controllers (GUI)**

Follow these steps to configure primary, secondary, and tertiary controllers for a specific mesh access point and to configure primary and secondary backup controllers for all mesh access points:

**Step 1**  
Choose *Wireless > Access Points > Global Configuration* to open the Global Configuration page.

**Figure 54: Global Configuration Page**

![Global Configuration Page](image)

**Note**  
The fast heartbeat timer is not supported on mesh access points.

**Step 2**  
In the AP Primary Discovery Timeout field, enter a value between 30 and 3600 seconds (inclusive) to configure the access point primary discovery request timer. The default value is 120 seconds.

**Step 3**  
If you want to specify a primary backup controller for all access points, specify the IP address of the primary backup controller in the Back-up Primary Controller IP Address field and the name of the controller in the Back-up Primary Controller Name field.

**Note**  
The default value for the IP address is 0.0.0.0, which disables the primary backup controller.

**Step 4**  
If you want to specify a secondary backup controller for all access points, specify the IP address of the secondary backup controller in the Back-up Secondary Controller IP Address field and the name of the controller in the Back-up Secondary Controller Name field.
The default value for the IP address is 0.0.0.0, which disables the secondary backup controller.

**Step 5**
Click **Apply** to commit your changes.

**Step 6**
If you want to configure primary, secondary, and tertiary backup controllers for a specific point, follow these steps:

a) Choose **Access Points > All APs** to open the All APs page.
b) Click the name of the access point for which you want to configure primary, secondary, and tertiary backup controllers.
c) Click the **High Availability** tab.

d) If desired, specify the name and IP address of the primary backup controller for this access point in the Primary Controller fields.  
   **Note** Specifying an IP address for the backup controller is optional in this step and the next two steps. If the backup controller is outside the mobility group to which the mesh access point is connected (the primary controller), then you need to provide the IP address of the primary, secondary, or tertiary controller, respectively. The controller name and IP address must belong to the same primary, secondary, or tertiary controller. Otherwise, the mesh access point cannot join the backup controller.

e) If desired, specify the name and IP address of the secondary backup controller for this mesh access point in the Secondary Controller fields.
f) If desired, specify the name and IP address of the tertiary backup controller for this mesh access point in the Tertiary Controller fields.
g) No change is required to the AP Failover Priority value. The default value for mesh access points is **critical** and it cannot be modified.

h) Click **Apply** to commit your changes.

**Step 7**
Click **Save Configuration** to save your changes.

---

**Configuring Backup Controllers (CLI)**

**Step 1**
To configure a primary controller for a specific mesh access point, enter this command:

```
config ap primary-base controller_name Cisco_AP [controller_ip_address]
```
The `controller_ip_address` parameter in this command and the next two commands is optional. If the backup controller is outside the mobility group to which the mesh access point is connected (the primary controller), then you need to provide the IP address of the primary, secondary, or tertiary controller, respectively. In each command, the `controller_name` and `controller_ip_address` must belong to the same primary, secondary, or tertiary controller. Otherwise, the mesh access point cannot join the backup controller.

**Note** To delete a primary or secondary backup controller entry, enter `0.0.0.0` for the controller IP address.

**Step 2**
To configure a secondary controller for a specific mesh access point, enter this command:

```
config ap secondary-base controller_name Cisco_AP [controller_ip_address]
```

**Step 3**
To configure a tertiary controller for a specific mesh access point, enter this command:

```
config ap tertiary-base controller_name Cisco_AP [controller_ip_address]
```

**Step 4**
To configure a primary backup controller for all mesh access points, enter this command:

```
config advanced backup-controller primary backup_controller_name backup_controller_ip_address
```

**Step 5**
To configure a secondary backup controller for all mesh access points, enter this command:

```
config advanced backup-controller secondary backup_controller_name backup_controller_ip_address
```

**Note** To delete a primary or secondary backup controller entry, enter `0.0.0.0` for the controller IP address.

**Step 6**
To configure the mesh access point primary discovery request timer, enter this command:

```
config advanced timers ap-primary-discovery-timeout interval
```
where `interval` is a value between 30 and 3600 seconds. The default value is 120 seconds.

**Step 7**
To configure the mesh access point discovery timer, enter this command:

```
config advanced timers ap-discovery-timeout interval
```
where `interval` is a value between 1 and 10 seconds (inclusive). The default value is 10 seconds.

**Step 8**
To configure the 802.11 authentication response timer, enter this command:

```
config advanced timers auth-timeout interval
```
where `interval` is a value between 10 and 600 seconds (inclusive). The default value is 10 seconds.

**Step 9**
To save your changes, enter this command:

```
save config
```

**Step 10**
To view a mesh access point’s configuration, enter these commands:

- `show ap config general Cisco_AP`
- `show advanced backup-controller`
- `show advanced timers`
- `show mesh config`

Information similar to the following appears for the `show ap config general Cisco_AP` command:

- **Cisco AP Identifier**.......................... 1
- **Cisco AP Name**................................. AP5
- **Country code**................................. US - United States
- **Regulatory Domain allowed by Country**........ 802.11bg:-AB 802.11a:-AB
- **AP Country code**............................... US - United States
- **AP Regulatory Domain**........................... 802.11bg:-A 802.11a:-N
- **Switch Port Number**........................... 1
- **MAC Address**................................. 00:13:80:60:48:3e
IP Address Configuration............... DHCP
IP Address...................................... 1.100.163.133

Primary Cisco Switch Name................. 1-4404
Primary Cisco Switch IP Address............. 2.2.2.2
Secondary Cisco Switch Name............... 1-4404
Secondary Cisco Switch IP Address .......... 2.2.2.2
Tertiary Cisco Switch Name.................. 2-4404
Tertiary Cisco Switch IP Address .......... 1.1.1.4

Information similar to the following appears for the `show advanced backup-controller` command:

AP primary Backup Controller ............. controller1 10.10.10.10
AP secondary Backup Controller .......... 0.0.0.0

Information similar to the following appears for the `show advanced timers` command:

Authentication Response Timeout (seconds)...... 10
Rogue Entry Timeout (seconds)................ 1300
AP Heart Beat Timeout (seconds)............. 30
AP Discovery Timeout (seconds).............. 10
AP Primary Discovery Timeout (seconds)........ 120

Information similar to the following appears for the `show mesh config` command:

Mesh Range........................................ 12000
Backhaul with client access status........... disabled
Background Scanning State.................... enabled
Mesh Security
Security Mode.................................... EAP
External-Auth.................................... disabled
Use MAC Filter in External AAA server......... disabled
Force External Authentication................. disabled
Mesh Alarm Criteria
Max Hop Count..................................... 4
Recommended Max Children for MAP........... 10
Recommended Max Children for RAP........... 20
Low Link SNR..................................... 12
High Link SNR................................... 60
Max Association Number....................... 10
Association Interval......................... 60 minutes
Parent Change Numbers....................... 3
Parent Change Interval....................... 60 minutes
Mesh Multicast Mode.......................... In-Out
Mesh Full Sector DFS......................... enabled
Mesh Ethernet Bridging VLAN Transparent Mode..... enabled
Configuring External Authentication and Authorization Using a RADIUS Server

External authorization and authentication of mesh access points using a RADIUS server such as Cisco ACS (4.1 and later) is supported in release 5.2 and later releases. The RADIUS server must support the client authentication type of EAP-FAST with certificates.

Before you employ external authentication within the mesh network, ensure that you make these changes:

- The RADIUS server to be used as an AAA server must be configured on the controller.
- The controller must also be configured on the RADIUS server.
- Add the mesh access point configured for external authorization and authentication to the user list of the RADIUS server.
  - For additional details, see the Adding a Username to a RADIUS Server.

- Configure EAP-FAST on the RADIUS server and install the certificates. EAP-FAST authentication is required if mesh access points are connected to the controller using an 802.11a interface; the external RADIUS servers need to trust Cisco Root CA 2048. For information about installing and trusting the CA certificates, see the Configuring RADIUS Servers.

Note
If mesh access points connect to a controller using a Fast Ethernet or Gigabit Ethernet interface, only MAC authorization is required.

Note
This feature also supports local EAP and PSK authentication on the controller.

Configuring RADIUS Servers

Step 1
Download the CA certificates for Cisco Root CA 2048 from the following locations:

Step 2
Install the certificates as follows:

a) From the CiscoSecure ACS main menu, click System Configuration > ACS Certificate Setup > ACS Certification Authority Setup.
b) In the CA certificate file box, type the CA certificate location (path and name). For example: C:/Certs/crca2048.cer.
c) Click Submit.

Step 3
Configure the external RADIUS servers to trust the CA certificate as follows:

b) Select the check box next to the Cisco Root CA 2048 (Cisco Systems) certificate name.
c) Click **Submit**.

d) To restart ACS, choose **System Configuration** > **Service Control**, and then click **Restart**.

For additional configuration details on Cisco ACS servers, see the following:


---

**Adding a Username to a RADIUS Server**

Add MAC addresses of mesh access point that are authorized and authenticated by external RADIUS servers to the user list of that server **prior** to enabling RADIUS authentication for a mesh access point.

For remote authorization and authentication, EAP-FAST uses the manufacturer’s certificate (CERT) to authenticate the child mesh access point. Additionally, this manufacturer certificate-based identity serves as the username for the mesh access point in user validation.

For Cisco IOS-based mesh access points, in addition to adding the MAC address to the user list, you need to enter the `platform_name_string-MAC_address` string to the user list (for example, `c1240-001122334455`). The controller first sends the MAC address as the username; if this first attempt fails, then the controller sends the `platform_name_string-MAC_address` string as the username.

---

**Note**

The Authentication MAC address is different for outdoor versus indoor APs. Outdoor APs use the AP's BVI MAC address, whereas indoor APs use the AP's Gigabit Ethernet MAC address.

---

**RADIUS Server Username Entry**

For each mesh access point, two entries must be added to the RADIUS server, the `platform_name_string-MAC_address` string, then a hyphen delimited MAC Address. For example:

- `platform_name_string-MAC_address`
  - User: c1520-aabbcddddeeff
  - Password: cisco
- Hyphen Delimited MAC Address
  - User: aa-bb-cc-dd-ee-ff
  - Password: aa-bb-cc-dd-ee-ff

---

**Note**

The platform AP1552 uses a platform name of c1520.
Enabling External Authentication of Mesh Access Points

This section describes how to enable external authentication of mesh access points.

Enabling External Authentication of Mesh Access Points (GUI)

**Step 1**
Choose Wireless > Mesh. The Mesh page appears.

*Figure 56: Mesh Page*

<table>
<thead>
<tr>
<th>Wireless</th>
<th>Mesh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Points</td>
<td>General</td>
</tr>
<tr>
<td>All APs</td>
<td>Range (Root AP to MeshAP)</td>
</tr>
<tr>
<td>Radio</td>
<td>192.168</td>
</tr>
<tr>
<td>802.11a/n</td>
<td>Enabled</td>
</tr>
<tr>
<td>802.11b/g/n</td>
<td>Enabled</td>
</tr>
<tr>
<td>Global Configuration</td>
<td>Enabled</td>
</tr>
<tr>
<td>Mesh</td>
<td>Enabled</td>
</tr>
<tr>
<td>HRSEAP Groups</td>
<td>Enabled</td>
</tr>
<tr>
<td>802.11a/n</td>
<td>Enabled</td>
</tr>
<tr>
<td>802.11b/g/n</td>
<td>Enabled</td>
</tr>
<tr>
<td>Media Stream</td>
<td>Enabled</td>
</tr>
<tr>
<td>Country</td>
<td>Timer</td>
</tr>
<tr>
<td>Time</td>
<td>QoS</td>
</tr>
</tbody>
</table>

**Step 2**
In the security section, select the EAP option from the Security Mode drop-down list.

**Step 3**

**Step 4**
Click Apply.

**Step 5**
Click Save Configuration.

Enabling External Authentication of Mesh Access Points (CLI)

1. `config mesh security eap`
2. `config macfilter mac-delimiter colon`
3. `config mesh security rad-mac-filter enable`
4. `config mesh radius-server index enable`
5. `config mesh security force-ext-auth enable` (Optional)
Viewing Security Statistics

To view security statistics for mesh access points using the CLI, enter the following command:

```
show mesh security-stats Cisco_AP
```

Use this command to display packet error statistics and a count of failures, timeouts, and association and authentication successes as well as reassociations and reauthentications for the specified access point and its child.

Configuring Global Mesh Parameters

Information About Configuring Global Mesh Parameters

This section provides instructions to configure the mesh access point to establish a connection with the controller including:

- Setting the maximum range between RAP and MAP (not applicable to indoor MAPs).
- Enabling a backhaul to carry client traffic.
- Defining if VLAN tags are forwarded or not.
- Defining the authentication mode (EAP or PSK) and method (local or external) for mesh access points including security settings (local and external authentication).

You can configure the necessary mesh parameters using either the GUI or the CLI. All parameters are applied globally.

Configuring Global Mesh Parameters (GUI)

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose Wireless &gt; Mesh.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Modify the mesh parameters as appropriate.</td>
</tr>
</tbody>
</table>

This table describes each parameter.

<table>
<thead>
<tr>
<th>Table 29: Global Mesh Parameters</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Range (RootAP to MeshAP) | The optimum distance (in feet) that should exist between the root access point (RAP) and the mesh access point (MAP). This global parameter applies to all mesh access points when they join the controller and all existing mesh access points in the network.  
  **Range:** 150 to 132,000 feet  
  **Default:** 12,000 feet  
  **Note:** After this feature is enabled, all mesh access points reboot. |
When you enable this feature, IDS reports are generated for all traffic on the client access only and not on the backhaul.

When you disable this feature, no IDS reports are generated, which preserves bandwidth on the backhaul.

You have to use the following command to enable or disable it on the mesh APs:

```
config mesh ids-state {enable | disable}
```

**Note** 2.4-GHz IDS is activated with the global IDS settings on the controller.

**Backhaul Client Access**

**Note** This parameter applies to mesh access points with two or more radios (1552, 1524SB, 1522, 1240, 1130, and 11n indoor mesh APs) excluding the 1524PS.

When Universal Client Access is enabled, it allows wireless client association over the backhaul radio. Generally, backhaul radio is a 5-GHz radio for most of the mesh access points except for 1522 where backhaul can be 2.4 GHz. This means that a backhaul radio can carry both backhaul traffic and client traffic.

When Universal Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client association is only over the second radio(s).

**Default:** Disabled

**Note** After this feature is enabled, all mesh access points reboot.

**VLAN Transparent**

This feature determines how a mesh access point handles VLAN tags for Ethernet bridged traffic.

If VLAN Transparent is enabled, then VLAN tags are not handled and packets are bridged as untagged packets.

**Note** No configuration of Ethernet ports is required when VLAN transparent is enabled. The Ethernet port passes both tagged and untagged frames without interpreting the frames.

If VLAN Transparent is disabled, then all packets are handled according to the VLAN configuration on the port (trunk, access, or normal mode).

**Note** If the Ethernet port is set to Trunk mode, then Ethernet VLAN tagging must be configured. See the Enabling Ethernet Bridging section.

**Note** For an overview of normal, access, and trunk Ethernet port use, see the Ethernet Port Notes section.

**Note** To use VLAN tagging, you must uncheck the VLAN Transparent check box.

**Default:** Enabled.
### Parameter | Description
--- | ---
Security Mode | Defines the security mode for mesh access points: Pre-Shared Key (PSK) or Extensible Authentication Protocol (EAP).

**Note**
- EAP must be selected if external MAC filter authorization using a RADIUS server is configured.
- Local EAP or PSK authentication is performed within the controller if the External MAC Filter Authorization parameter is disabled (check box unchecked).

**Options:** PSK or EAP

**Default:** EAP

External MAC Filter Authorization | MAC filtering uses the local MAC filter on the controller by default.

When external MAC filter authorization is enabled, if the MAC address is not found in the local MAC filter, then the MAC address in the external RADIUS server is used.

This protects your network against rogue mesh access points by preventing mesh access points that are not defined on the external server from joining.

Before employing external authentication within the mesh network, the following configuration is required:

- The RADIUS server to be used as an AAA server must be configured on the controller.
- The controller must also be configured on the RADIUS server.
- The mesh access point configured for external authorization and authentication must be added to the user list of the RADIUS server.
  - For remote authorization and authentication, EAP-FAST uses the manufacturer’s certificate (CERT) to authenticate the child mesh access point. Additionally, this manufacturer certificate-based identity serves as the username for the mesh access point in user validation.
  - For IOS-based mesh access points (1130, 1240, 1522, 1524), the platform name of the mesh access point is located in front of its Ethernet address within the certificate; therefore, their username for external RADIUS servers is `platform_name_string–Ethernet MAC address` such as `c1520-001122334455`.

- The certificates must be installed and EAP-FAST must be configured on the RADIUS server.

**Note**
- When this capability is not enabled, by default, the controller authorizes and authenticates mesh access points using the MAC address filter.

**Default:** Disabled.
### Configuring Global Mesh Parameters (CLI)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force External Authorization</td>
<td>When enabled along with <em>EAP</em> and <em>External MAC Filter Authorization</em> parameters, external authorization and authentication of mesh access points is done by default by an external RADIUS server (such as Cisco 4.1 and later). The RADIUS server overrides local authentication of the MAC address by the controller which is the default. <strong>Default:</strong> Disabled.</td>
</tr>
</tbody>
</table>

**Step 3** Click **Apply** to commit your changes.

**Step 4** Click **Save Configuration** to save your changes.

---

**Note** See the Configuring Global Mesh Parameters (GUI) for descriptions, valid ranges, and default values of the parameters used in the CLI commands.

**Step 1** To specify the maximum range (in feet) of all mesh access points in the network, enter this command: `config mesh range feet`  
To see the current range, enter the `show mesh range` command.

**Step 2** To enable or disable IDS reports for all traffic on the backhaul, enter this command:  
`config mesh ids-state {enable | disable} `

**Step 3** To specify the rate (in Mbps) at which data is shared between access points on the backhaul interface, enter this command:  
`config ap bhrate {rate | auto} Cisco_AP`

**Step 4** To enable or disable client association on the primary backhaul (802.11a) of a mesh access point, enter these commands:  
`config mesh client-access {enable | disable}`  
`config ap wlan {enable | disable} 802.11a Cisco_AP`  
`config ap wlan {add | delete} 802.11a wlan_id Cisco_AP`

**Step 5** To enable or disable VLAN transparent, enter this command:  
`config mesh ethernet-bridging VLAN-transparent {enable | disable}`

**Step 6** To define a security mode for the mesh access point, enter one of the following commands:  
a) To provide local authentication of the mesh access point by the controller, enter this command:  
`config mesh security {eap | psk}`

b) To store the MAC address filter in an external RADIUS server for authentication instead of the controller (local), enter these commands:
c) To provide external authentication on a RADIUS server and define a local MAC filter on the controller, enter these commands:

```
cfg-macfilter mac-delimiter colon
cfg-mesh security rad-mac-filter enable
cfg-mesh radius-server index enable
```

Step 7 To save your changes, enter this command:
```
save config
```

Viewing Global Mesh Parameter Settings (CLI)

- **show mesh client-access**—When Universal Client Access is enabled, it allows wireless client association over the backhaul radio. Generally, backhaul radio is a 5-GHz radio for most of the mesh access points except for 1522 where backhaul can be 2.4 GHz. This means that a backhaul radio can carry both backhaul traffic and client traffic.

When Universal Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client association is only over the second radio(s).

Example:
```
show mesh client-access
```
```
Backhaul with client access status: enabled
```

- **show mesh ids-state**—Shows the status of the IDS reports on the backhaul as either enabled or disabled.

Example:
```
show mesh ids-state
```
```
Outdoor Mesh IDS(Rogue/Signature Detect): .... Disabled
```

- **show mesh config**—Displays global configuration settings.

Example:
show mesh config

Mesh Range....................................... 12000
Mesh Statistics update period................. 3 minutes
Backhaul with client access status............. disabled
Background Scanning State...................... enabled
Backhaul Amsdu State.......................... disabled

Mesh Security
Security Mode........................................ EAP
External-Auth........................................ disabled
Use MAC Filter in External AAA server......... disabled
Force External Authentication.................. disabled

Mesh Alarm Criteria
Max Hop Count....................................... 4
Recommended Max Children for RAP............. 10
Recommended Max Children for RAP............. 20
Low Link SNR......................................... 12
High Link SNR........................................ 60
Max Association Number.......................... 10
Association Interval............................... 60 minutes
Parent Change Numbers......................... 3
Parent Change Interval......................... 60 minutes

Mesh Multicast Mode................................. In-Out
Mesh Full Sector DFS............................... enabled
Mesh Ethernet Bridging VLAN Transparent Mode.... enabled

Configuring Local Mesh Parameters

After configuring global mesh parameters, you must configure the following local mesh parameters for these specific features if in use in your network:

- Backhaul Data Rate. See the Configuring Wireless Backhaul Data Rate, on page 557.
- Ethernet Bridging. See the Configuring Ethernet Bridging, on page 559.
- Bridge Group Name. See the Configuring Ethernet Bridging, on page 559.
- Workgroup Bridge. See the Configuring Workgroup Bridges, on page 592.
- Public Safety Band Settings. See the Configuring Public Safety Band Settings, on page 561.
- Cisco 3200 Series Association and Interoperability. See the Enabling Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers (GUI), on page 642.
- Power and Channel Setting. See the Configuring Power and Channel Settings, on page 566.
- Antenna Gain Settings. See the Configuring Antenna Gain, on page 568.
- Backhaul channel deselection on serial backhaul access point. See the Backhaul Channel Deselection on Serial Backhaul Access Point, on page 569.
- Dynamic Channel Assignment. See the Configuring Dynamic Channel Assignment (GUI), on page 720.

Configuring Wireless Backhaul Data Rate

Backhaul is used to create only the wireless connection between the access points. The backhaul interface by default is 802.11a or 802.11a/n depending upon the access point. The rate selection is important for effective
use of the available RF spectrum. The rate can also affect the throughput of client devices, and throughput is an important metric used by industry publications to evaluate vendor devices.

Dynamic Rate Adaptation (DRA) introduces a process to estimate optimal transmission rate for packet transmissions. It is important to select rates correctly. If the rate is too high, packet transmissions fail resulting in communication failure. If the rate is too low, the available channel bandwidth is not used, resulting in inferior products, and the potential for catastrophic network congestion and collapse.

Data rates also affect the RF coverage and network performance. Lower data rates, for example 6 Mbps, can extend farther from the access point than can higher data rates, for example 300 Mbps. As a result, the data rate affects cell coverage and consequently the number of access points required. Different data rates are achieved by sending a more redundant signal on the wireless link, allowing data to be easily recovered from noise. The number of symbols sent out for a packet at the 1-Mbps data rate is higher than the number of symbols used for the same packet at 11 Mbps. Therefore, sending data at the lower bit rates takes more time than sending the equivalent data at a higher bit rate, resulting in reduced throughput.

In the controller release 5.2, the default data rate for the mesh 5-GHz backhaul is 24 Mbps. It remains the same with 6.0 and 7.0 controller releases.

With the 6.0 controller release, mesh backhaul can be configured for 'Auto' data rate. Once configured, the access point picks the highest rate where the next higher rate cannot be used because of conditions not being suitable for that rate and not because of conditions that affect all rates. That is, once configured, each link is free to settle down to the best possible rate for its link quality.

We recommend that you configure the mesh backhaul to Auto.

For example, if mesh backhaul chose 48 Mbps, then this decision is taken after ensuring that we cannot use 54 Mbps as there is not enough SNR for 54 and not because some just turned the microwave oven on which affects all rates.

A lower bit rate might allow a greater distance between MAPs, but there are likely to be gaps in the WLAN client coverage, and the capacity of the backhaul network is reduced. An increased bit rate for the backhaul network either requires more MAPs or results in a reduced SNR between MAPs, limiting mesh reliability and interconnection.

---

**Note**

The data rate can be set on the backhaul on a per-AP basis. It is not a global command.

Use these commands to obtain information about backhaul:

- `config ap bhrate`—Configures the Cisco Bridge backhaul Tx rate.

  ```
  config ap bhrate backhaul-rate ap-name
  ```

**Note**

Preconfigured data rates for each AP (RAP=18 Mbps, MAP1=36 Mbps) are preserved after the upgrade to 6.0 or later software releases. Before you upgrade to the 6.0 release, if you have the backhaul data rate configured to any data rate, then the configuration is preserved.

The following example shows how to configure a backhaul rate of 36000 Kbps on a RAP:

(Cisco Controller) > `config ap bhrate 36000 HPRAPI`

- `show ap bhrate`—Displays the Cisco Bridge backhaul rate.

  (Cisco Controller) > `show ap bhrate ap-name`
• show mesh neigh summary—Displays the link rate summary including the current rate being used in backhaul

(Cisco Controller) > show mesh neigh summary HPRAP1

<table>
<thead>
<tr>
<th>AP Name/Radio</th>
<th>Channel</th>
<th>Rate</th>
<th>Link-Snr</th>
<th>Flags</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>--------</td>
<td>------</td>
<td>----------</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>00:0B:85:5C:B9:20</td>
<td>0</td>
<td>auto</td>
<td>4</td>
<td>0x10e8fcb8</td>
<td>BEACON</td>
</tr>
<tr>
<td>00:0B:85:5F:FF:60</td>
<td>0</td>
<td>auto</td>
<td>4</td>
<td>0x10e8fcb8</td>
<td>BEACON DEFAULT</td>
</tr>
<tr>
<td>00:0B:85:62:1E:00</td>
<td>165</td>
<td>auto</td>
<td>4</td>
<td>0x10e8fcb8</td>
<td>BEACON</td>
</tr>
<tr>
<td>00:0B:85:70:8C:A0</td>
<td>0</td>
<td>auto</td>
<td>4</td>
<td>0x10e8fcb8</td>
<td>BEACON</td>
</tr>
<tr>
<td>HPRAP1</td>
<td>165</td>
<td>54</td>
<td>40</td>
<td>0x36</td>
<td>CHILD BEACON</td>
</tr>
<tr>
<td>HJMAP2</td>
<td>0</td>
<td>auto</td>
<td>4</td>
<td>0x10e8fcb8</td>
<td>BEACON</td>
</tr>
</tbody>
</table>

Backhaul capacity and throughput depends upon the type of the AP, that is, if it is 802.11a/n or only 802.11a, number of backhaul radios it has, and so on.

In AP1524 SB, Slot 2 in the 5-GHz radio in the RAP is used to extend the backhaul in the downlink direction, whereas Slot 2 in the 5-GHz radio in the MAP is used for backhaul in the uplink. We recommend using a directional antenna with the Slot 2 radio. MAPs extend Slot 1 radio in the downlink direction with Omni or directional antenna also providing client access. Client access can be provided on the Slot 2 radio from the 7.0 release onwards.

AP1524 SB provides you with better throughput, and throughput rarely degrades after the first hop. The performance of AP1524SB is better than AP1522 and AP1524PS because these APs have only a single radio for the backhaul uplink and downlink.

Table 30: AP1552 Backhaul capacity

<table>
<thead>
<tr>
<th>HOPS</th>
<th>RAP</th>
<th>One</th>
<th>Two</th>
<th>Three</th>
<th>Four</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Throughput (20 MHz BH)</td>
<td>112</td>
<td>83</td>
<td>41</td>
<td>25</td>
<td>15</td>
</tr>
<tr>
<td>Maximum Throughput (40 MHz BH)</td>
<td>206</td>
<td>111</td>
<td>94</td>
<td>49</td>
<td>35</td>
</tr>
</tbody>
</table>

Configuring Ethernet Bridging

For security reasons, the Ethernet port on all MAPs is disabled by default. It can be enabled only by configuring Ethernet bridging on the root and its respective MAP.
Exceptions are allowed for a few protocols even though Ethernet bridging is disabled. For example, the following protocols are allowed:

- Spanning Tree Protocol (STP)
- Address Resolution Protocol (ARP)
- Control And Provisioning of Wireless Access Points (CAPWAP)
- Bootstrap Protocol (BOOTP) packets

Enable the spanning tree protocol on all connected switch ports to avoid Layer 2 looping.

Ethernet bridging has to be enabled for two scenarios:

1. When you want to use the mesh nodes as bridges.

Note

You do not need to configure VLAN tagging to use Ethernet bridging for point-to-point and point-to-multipoint bridging deployments.

2. When you want to connect any Ethernet device such as a video camera on the MAP using its Ethernet port. This is the first step to enable VLAN tagging.

Enabling Ethernet Bridging (GUI)

Step 1 Choose Wireless > All APs.

Step 2 Click the AP name link of the mesh access point on which you want to enable Ethernet bridging.

Step 3 On the details page, click the Mesh tab.

Step 4 Select either RootAP or MeshAP from the AP Role drop-down list, if not already selected.

Step 5 Select the Ethernet Bridging check box to enable Ethernet bridging or deselect it to disable this feature.

Step 6 Click Apply to commit your changes. An Ethernet Bridging section appears at the bottom of the page listing each of the Ethernet ports of the mesh access point.

Step 7 Ensure that you enable Ethernet bridging for every parent mesh AP taking the path from the mesh AP in question to the controller. For example, if you enable Ethernet bridging on MAP2 in Hop 2, then you must also enable Ethernet bridging on MAP1 (parent MAP), and on the RAP connecting to the controller.

Configuring Bridge Group Names

Bridge group names (BGNs) control the association of mesh access points. BGNs can logically group radios to avoid two networks on the same channel from communicating with each other. The setting is also useful if you have more than one RAP in your network in the same sector (area). BGN is a string of 10 characters maximum.
A BGN of *NULL VALUE* is assigned by default by manufacturing. Although not visible to you, it allows a mesh access point to join the network prior to your assignment of your network-specific BGN.

If you have two RAPs in your network in the same sector (for more capacity), we recommend that you configure the two RAPs with the same BGN, but on different channels.

**Configuring Bridge Group Names (CLI)**

- Using the CLI, enter the following command:

  ```
  config ap bridgegroupname set bridge-group-name
  ```

  Information similar to the following is displayed:

  ```
  Setting bridgegroupname on an AP permanently restricts the APs to which it may connect, use with caution.
  Are you sure you want to continue? (y/n) n
  AP bridgegroupname not changed!
  ```

  The mesh access point reboots after a BGN configuration.

  **Caution**

  Exercise caution when you configure a BGN on a live network. Always start a BGN assignment from the farthest-most node (last node, bottom of mesh tree) and move up toward the RAP to ensure that no mesh access points are dropped due to mixed BGNs (old and new BGNs) within the same network.

**Verifying Bridge Group Names (GUI)**

**Step 1**

Click **Wireless > Access Points > AP Name**. The details page for the selected mesh access point appears.

**Step 2**

Click the **Mesh** tab. Details for the mesh access point including the BGN appears.

**Verifying Bridge Group Names (CLI)**

- To verify the BGN, enter the following command:

  ```
  (Cisco controller) > show ap config general AP_Name
  ```

  Information similar to the following is displayed.

**Configuring Public Safety Band Settings**

A public safety band (4.9 GHz) is supported on the AP1522 and AP1524PS.

- For the AP1524PS, the 4.9-GHz radio is independent of the 5-GHz radio and is not used for backhaul. The 5.8 GHz is used only for backhaul, and there is no client access possible on it. On the AP1524PS, the 4.9-GHz band is enabled by default.
In Japan, 4.9 GHz is enabled by default as 4.9 GHz is unlicensed.

- For AP1522s, you can enable the 4.9-GHz public safety band on the backhaul. This step can only be done at the global level and cannot be done on a per mesh access point basis.
  - For client access on the 4.9-GHz band on the AP1522, you have to enable the feature universal client access.

- For public safety-only deployments, the AP1522 and the AP1524PS must each be connected to its own separate RAP-based tree. For such deployments, the 1522 must use the 4.9-GHz backhaul and the 1524PS must be in its own RAP tree and use the 5.8-GHz backhaul.

- In some parts of the world including the USA, you can only have public safety traffic on the 4.9-GHz backhaul. Check the destination countries compliance before installing.

The 4.9-GHz subband radio on the AP1524PS supports public safety channels within the 5-MHz (channels 1 to 10), 10-MHz (channels 11 to 19), and 20-MHz (channels 20 to 26) bandwidths.

- The following data rates are supported within the 5 MHz bandwidth: 1.5, 2.25, 3, 4.5, 6, 9, 12, and 13.5 Mbps. The default rate is 6 Mbps.

- The following data rates are supported within the 10-MHz bandwidth: 3, 4.5, 6, 9, 12, 18, 24, and 27 Mbps. The default rate is 12 Mbps.

---

**Note**

- Those AP1522s with serial numbers prior to FTX1150XXXX do not support 5 and 10 MHz channels on the 4.9-GHz radio; however, a 20-MHz channel is supported.

- Those AP1522s with serial numbers after FTX1150XXXX support 5, 10, and 20 MHz channels.
Enabling the 4.9-GHz Band

When you attempt to enable the 4.9-GHz band, you get a warning that the band is a licensed band in most parts of the world.

Figure 57: Public Safety Warning During Configuration

```
(Cisco Controller) > config mesh public-safety
enable   Enable/Disable 4.9GHz Public Safety Bands for Mesh AP.
disable  Enable/Disable 4.9GHz Public Safety Bands for Mesh AP.
(Cisco Controller) > config mesh public-safety enable
all       For All Cisco AP
(Cisco Controller) > config mesh public-safety enable all

4.9GHz is a licensed frequency band in -A domain for public-safety usage
Are you sure you want to continue? (y/N)y

Global Public Safety Status: Already configured. Configuring Local States ...

(Cisco Controller) > config mesh public-safety enable wlan1

Public Safety can't be configured on individual Cisco APs.
```

- To verify that a public safety band is on the mesh access point using the CLI, enter the following command:

  `show mesh public-safety`

  The following is displayed:

  `Global Public Safety status: enabled`

- To verify that a public safety band is on the mesh access point using the GUI:

  Wireless > Access Points > 802.11a radio > Configure (from the Antenna drop-down list)

Configuring Interoperability with Cisco 3200

Cisco AP1522 and AP1524PS can interoperate with the Cisco 3200 on the public safety channel (4.9-GHz) as well as the 2.4-GHz access and 5.8-GHz backhaul.

The Cisco 3200 creates an *in-vehicle network* in which devices such as PCs, surveillance cameras, digital video recorders, printers, PDAs, and scanners can share wireless networks such as cellular or WLAN based services back to the main infrastructure. This feature allows data collected from in-vehicle deployments such as a police cars to be integrated into the overall wireless infrastructure.

This section provides configuration guidelines and step-by-step instructions for configuring interoperability between the Cisco 3200 and the AP1522 and the AP1524PS.

For specific interoperability details between series 1130, 1240, and 1520 (1522, 1524PS) mesh access points and Cisco 3200.
Table 31: Mesh Access Points and Cisco 3200 Interoperability

<table>
<thead>
<tr>
<th>Mesh Access Point Model</th>
<th>Cisco 3200 Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>1552, 1522&lt;sup&gt;9&lt;/sup&gt;</td>
<td>c3201, c3202&lt;sup&gt;10&lt;/sup&gt;</td>
</tr>
<tr>
<td>1524PS</td>
<td>c3201, c3202</td>
</tr>
<tr>
<td>1524SB, 1130, 1240, Indoor 802.11n mesh access points</td>
<td>c3201, c3205</td>
</tr>
</tbody>
</table>

<sup>9</sup> Universal access must be enabled on the AP1522 if connecting to a Cisco 3200 on the 802.11a radio or 4.9-GHz band.

<sup>10</sup> Model c3201 is a Cisco 3200 with an 802.11b/g radio (2.4-GHz).

<sup>11</sup> Model c3202 is a Cisco 3200 with a 4.9-GHz subband radio.

<sup>12</sup> Model c3205 is a Cisco 3200 with a 802.11a radio (5.8-GHz subband).

To enable AP1522 to associate with Cisco 3200, follow these steps:

Configuration Guidelines for Public Safety 4.9-GHz Band

For the AP1522 or AP1524PS and Cisco 3200 to interoperate on the public safety network, the following configuration guidelines must be met:

- Client access must be enabled on the backhaul (mesh global parameter). This feature is not supported on the AP1524PS.

- Public safety must be enabled globally on all mesh access points (MAPs) in the mesh network.

- The channel number assignment on the AP1522 or AP1524PS must match those on the Cisco 3200 radio interfaces:
  - Channels 20 (4950 GHz) through 26 (4980 GHz) and subband channels 1 through 19 (5 and 10 MHz) are used for Cisco 3200 interoperability. This configuration change is made on the controller. No changes are made to the mesh access point configuration.
  - Channel assignments are only made to the RAP. Updates to the MAP are propagated by the RAP.

The default channel width for Cisco 3200s is 5 MHz. You must either change the channel width to 10 or 20 MHz to enable WGBs to associate with the AP1522 and AP1524PS or change the channel on the AP1522 or AP1524PS to a channel in the 5-MHz band (channels 1 to 10) or 10-MHz band (channels 11 to 19).

- Radio (802.11a) must be disabled when configuring channels and then reenabled when using the CLI. When using the GUI, enabling and disabling of the 802.11a radio for channel configuration is not required.

- Cisco 3200s can scan channels within but not across the 5, 10 or 20-MHz bands.
Enabling AP1522 to Associate with Cisco 3200 (GUI)

**Step 1**
To enable the backhaul for client access, choose **Wireless > Mesh** to access the Mesh page.

**Step 2**
Select the Backhaul Client Access **Enabled** check box to allow wireless client association over the 802.11a radio. Click **Apply**.

*Note*  You are prompted with a message to allow reboot of all the mesh access points to enable Backhaul Client Access on a network. Click **OK**.

**Step 3**
To assign the channel to use for the backhaul (channels 20 through 26), click **Wireless > Access Points > Radio** and select 802.11a/n from the Radio subheading. A summary page for all 802.11a radios displays.

**Step 4**
At the Antenna drop-down list for the appropriate RAP, select **Configure**. The Configure page appears.

**Step 5**
At the RF Channel Assignment section, select the **WLC Controlled** option for the Assignment Method option and select any channel between 1 and 26.

**Step 6**
Click **Apply** to commit your changes.

**Step 7**
Click **Save Configuration** to save your changes.

Enabling 1522 and 1524PS Association with Cisco 3200 (CLI)

**Step 1**
To enable client access mode on the AP1522, enter this command:

```
config mesh client-access enable
```

**Step 2**
To enable the public safety on a global basis, enter this command:

```
config mesh public-safety enable all
```

**Step 3**
To enable the public safety channels, enter these commands:

1. On the AP1522, enter these commands:

   ```
   config 802.11a disable Cisco_MAP
   config 802.11a channel ap Cisco_MAP channel number
   config 802.11a enable Cisco_MAP
   ```

2. On the AP1524PS, enter these commands:

   ```
   config 802.11–a49 disable Cisco_MAP
   config 802.11–a49 channel ap Cisco_MAP channel number
   config 802.11–a49 enable Cisco_MAP
   ```

*Note*  Enter the **config 802.11–a58 enable Cisco_MAP** command to enable a 5.8-GHz radio.

*Note*  For both the AP1522 and AP1524PS, **channel number** is equal to any value 1 to 26.

**Step 4**
To save your changes, enter this command:
save config

**Step 5**
To verify your configuration, enter these commands:

- `show mesh public-safety`
- `show mesh client-access`
- `show ap config 802.11a summary` (1522 only)
- `show ap config 802.11-a49 summary` (1524PS only)

**Note** Enter the `show config 802.11-a58 summary` command to display configuration details for a 5.8-GHz radio.

---

**Configuring Power and Channel Settings**

The backhaul channel (802.11a/n) can be configured on a RAP. MAPs tune to the RAP channel. The local access can be configured independently for MAP.

**Configuring Power and Channel Settings (GUI)**

**Step 1** Choose **Wireless > Access Points > 802.11a/n**.
Radio slots are displayed for each radio. For an AP1524SB, the 802.11a/n radio displays for slots 1 and 2 that operate in the 5-GHz band. For an AP1524PS, the 802.11a/n radio displays for slots 1 and 2, operating in the 5-GHz and 4.9-GHz bands respectively.

**Step 2** Select **Configure** from the Antenna drop-down list for the 802.11a/n radio. The Configure page is displayed.

**Note** For the 1524SB, select the Antenna drop-down list for a RAP with a radio role of downlink.

**Step 3** Assign a channel (assignment methods of AP Controlled and WLC Controlled) for the radio.

**Note** When you assign a channel to the AP1524SB, choose the **WLC Controlled** assignment method, and select one of the supported channels for the 5-GHz band.

**Step 4** Assign Tx power levels (AP Controlled and WLC Controlled) for the radio.
There are five selectable power levels for the 802.11a backhaul for AP1500s.

**Note** The default Tx power level on the backhaul is the highest power level (Level 1).

**Note** Radio Resource Management (RRM) is OFF (disabled) by default. RRM cannot be turned ON (enabled) for the backhaul.

**Step 5** Click **Apply** when power and channel assignment are complete.

**Step 6** From the 802.11a/n Radios page, verify that channel assignments were made correctly.
Configuring the Channels on the Serial Backhaul (CLI)

**Step 1**  
To configure the backhaul channel on the radio in slot 2 of the RAP, enter this command:  
```
config slot 2 channel ap Cisco_RAPSB channel
```

The available channels for the 5.8-GHz band are 149, 153, 157, 161, and 165.

**Step 2**  
To configure the transmit power level on the radio in slot 2 of the RAP, enter this command:  
```
config slot 2 txPower ap Cisco_RAPSB power
```

Valid values are 1 through 5; the default value is 1.

**Step 3**  
To display the configurations on the mesh access points, enter these commands:

- `show mesh path MAP`

  Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name/Radio</th>
<th>Channel</th>
<th>Rate</th>
<th>Link-Snr</th>
<th>Flags</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP1SB</td>
<td>161</td>
<td>auto</td>
<td>60</td>
<td>0x10ea9d54</td>
<td>UPDATED NEIGH PARENT BEACON</td>
</tr>
<tr>
<td>RAPSB</td>
<td>153</td>
<td>auto</td>
<td>51</td>
<td>0x10ea9d54</td>
<td>UPDATED NEIGH PARENT BEACON</td>
</tr>
</tbody>
</table>

  RAPSB is a Root AP.

- `show mesh backhaul RAPSB`

  Information similar to the following appears:

  Current Backhaul Slot(s).......................... 1, 2,

  Basic Attributes for Slot 1
  - Radio Type.................................. RADIO_TYPE_80211a
  - Radio Role................................. ACCESS
  - Administrative State ..................... ADMIN_ENABLED
  - Operation State ............................ UP
  - Current Tx Power Level .................... 1
  - Current Channel ............................ 165
  - Antenna Type............................... EXTERNAL_ANTENNA
  - External Antenna Gain (in .5 dBm units) 0

  Basic Attributes for Slot 2
  - Radio Type.................................. RADIO_TYPE_80211a
  - Radio Role................................. RADIO_DOWNLINK
  - Administrative State ..................... ADMIN_ENABLED
  - Operation State ............................ UP
  - Current Tx Power Level .................... 3
  - Current Channel ............................ 153
Antenna Type........................................ EXTERNAL_ANTENNA
External Antenna Gain (in .5 dBm units)....... 0

- show ap channel MAP1SB

Information similar to the following appears:

802.11b/g Current Channel ................. 11
Slot Id ................................... 0
Allowed Channel List....................... 1,2,3,4,5,6,7,8,9,10,11
802.11a(5.8Ghz) Current Channel ........... 161
Slot Id ................................... 1
Allowed Channel List....................... 149,153,157,161,165
802.11a(5.8Ghz) Current Channel ........... 153
Slot Id ................................... 2
Allowed Channel List....................... 149,153,157,161,165

Configuring Antenna Gain

You must configure the antenna gain for the mesh access point to match that of the antenna installed using the controller GUI or controller CLI.

Configuring Antenna Gain (GUI)

Step 1 Choose Wireless > Access Points > Radio > 802.11a/n to open the 802.11a/n Radios page.
Step 2 For the mesh access point antenna you want to configure, hover the mouse over the blue arrow (far right) to display antenna options. Choose Configure.
   Note Only external antennas have configurable gain settings.
Step 3 In the Antenna Parameters area, enter the antenna gain.
   The gain is entered in 0.5 dBm units. For example, 2.5 dBm = 5.
   Note The entered gain value must match that value specified by the vendor for that antenna.
Step 4 Click Apply and Save Configuration to save the changes.

Configuring Antenna Gain (CLI)

Enter this command to configure the antenna gain for the 802.11a backhaul radio using the controller CLI:

```
config 802.11a antenna extAntGain antenna_gain AP_name
```
where gain is entered in 0.5-dBm units (for example, 2.5 dBm = 5).
Backhaul Channel Deselection on Serial Backhaul Access Point

This feature is applicable to mesh APs with two 5-GHz radios, such as 1524SB (serial backhaul).

The backhaul channel deselection feature helps you to restrict the set of channels available to be assigned for the serial backhaul MAPs and RAPs. Because 1524SB MAP channels are automatically assigned, this feature helps in regulating the set of channels that get assigned to mesh access points. For example, if you do not want channel 165 to get assigned to any of the 1524SB mesh access points, you need to remove channel 165 from the DCA list and enable this feature.

When you remove certain channels from the DCA list and enable the `mesh backhaul dca-channel` command, those channels will not be assigned to any serial backhaul access points in any scenario. Even if a radar is detected on all channels within the DCA list channels, the radio will be shut down rather than moved to channels outside it. A trap message is sent to the WCS, and the message is displayed showing that the radio has been shut down because of DFS. You will not be able to assign channels to the serial backhaul RAP outside of the DCA list with the `config mesh backhaul dca-channels enable` command enabled. However, this is not case for the APs with one 5-GHz radio such as 1552, 1522, and 1524PS APs. For these APs, you can assign any channel outside of the DCA list for a RAP, and the controller/AP can also select a channel outside of the DCA list if no radar-free channel is available from the list.

This feature is best suited in an interoperability scenario with indoor mesh access points or workgroup bridges that support a channel set that is different from outdoor access points. For example, channel 165 is supported by outdoor access points but not by indoor access points in the -A domain. By enabling the backhaul channel deselection feature, you can restrict the channel assignment to only those channels that are common to both indoor and outdoor access points.

---

**Note**

Channel deselection is applicable to 7.0 and later releases.

In some scenarios, there may be two linear tracks or roads for mobility side by side. Because channel selection of MAPs happens automatically, there can be a hop at a channel, which is not available on the autonomous side, or the channel has to be skipped when the same or adjacent channel is selected in a neighborhood access point that belongs to a different linear chain.

---

**Configuring Backhaul Channel Deselection (GUI)**

**Step 1**
Choose **Controller > Wireless > 802.11a/n > DCA**.
The Dynamic Channel Assignment Algorithm page appears.

**Step 2**
Select one or more channels to include in the DCA list.
The channels included in the DCA list will not be assigned to the access points associated to this controller during automatic channel assignment.

**Step 3**
Choose **Wireless > Mesh**.
The Mesh page appears.
Step 4 Select the **Mesh DCA Channels** check box to enable the backhaul channel deselection using the DCA list. This option is applicable for serial backhaul access points.

Step 5 After you enable the backhaul deselection option, choose **Wireless > Access Points > Radios > 802.11a/n** to configure the channel for the RAP downlink radio.

Step 6 From the list of access points, click on the **Antenna** drop-down list for a RAP and choose **Configure**. The Configure page appears.

Step 7 In the RF Backhaul Channel assignment section, choose **Custom**.

Step 8 Select a channel for the RAP downlink radio from the drop-down list, which appears when you choose **Custom**.

Step 9 Click **Apply** to apply and save the backhaul channel deselection configuration changes.

---

**Configuring Backhaul Channel Deselection (CLI)**

---

**Step 1** To review the channel list already configured in the DCA list, enter the following command:

```
show advanced 802.11a channel
```

Information similar to the following appears:

```
Automatic Channel Assignment
 Channel Assignment Mode......................... AUTO
 Channel Update Interval........................... 600 seconds
 Anchor time (Hour of the day).................... 0
 Channel Update Contribution..................... SNI..
 CleanAir Event-driven RRM option.............. Enabled
 CleanAir Event-driven RRM sensitivity.......... Medium
 Channel Assignment Leader...................... 09:2b:16:28:00:03
 Last Run........................................ 286 seconds ago
 DCA Sensitivity Level........................... MEDIUM (15 dB)
 DCA 802.11n Channel Width..................... 20 MHz
 DCA Minimum Energy Limit....................... -95 dBm
 Channel Energy Levels
 Minimum................................. unknown
 Average....................................... unknown
 Maximum..................................... unknown
 Channel Dwell Times
 Minimum.................................... 0 days, 17 h 02 m 05 s
 Average....................................... 0 days, 17 h 46 m 07 s
 Maximum..................................... 0 days, 18 h 28 m 58 s
 802.11a 5 GHz Auto-RF Channel List

--More-- or (q)uit
 Allowed Channel List.......................... 36,40,44,48,52,56,60,64,116, 140
 Unused Channel List......................... 100,104,108,112,120,124,128, 132,136
 DCA Outdoor AP option......................... Disabled
```
Step 2

To add a channel to the DCA list, enter the `config advanced 802.11a channel add channel number` command, where `channel number` is the channel number that you want to add to the DCA list.

You can also delete a channel from the DCA list by entering the `config advanced 802.11a channel delete channel number` command, where `channel number` is the channel number that you want to delete from the DCA list.

Before you add or delete a channel to or from the DCA list, ensure that the 802.11a network is disabled.

- To disable the 802.11a network, enter the following command:
  `config 802.11a disable network`

- To enable the 802.11a network, enter the following command:
  `config 802.11a enable network`

You cannot directly delete a channel from the DCA list if it is assigned to any 1524 RAP. To delete a channel assigned to a RAP, you must first change the channel assigned to the RAP and then enter the `config advanced 802.11a channel delete channel number` command from the controller.

The following is a sample output of the `add channel` and `delete channel` commands:

```
(Controller) > config 802.11a disable network
Disabling the 802.11a network may strand mesh APs. Are you sure you want to continue? (y/n)y

(Controller) > config advanced 802.11a channel add 132

(Controller) > config advanced 802.11a channel delete 116

802.11a 5 GHz Auto-RF:
Allowed Channel List......................... 36,40,44,48,52,56,60,64,116,132,140
DCA channels for cSerial Backhaul Mesh APs is enabled.
DCA list should have at least 3 non public safety channels supported by Serial Backhaul Mesh APs.
Otherwise, the Serial Backhaul Mesh APs can get stranded.
Are you sure you want to continue? (y/N)y

Failed to delete channel.
Reason: Channel 116 is configured for one of the Serial Backhaul RAPs.
Disable mesh backhaul dca-channels or configure a different channel for Serial Backhaul RAPs.

(Controller) > config advanced 802.11a channel delete 132

802.11a 5 GHz Auto-RF:
Allowed Channel List......................... 36,40,44,48,52,56,60,64,116,132,140
DCA channels for Serial Backhaul Mesh APs is enabled.
DCA list should have at least 3 non public safety channels supported by Serial Backhaul Mesh APs.
Otherwise, the Serial Backhaul Mesh APs can get stranded.
Are you sure you want to continue? (y/N)y

(Controller) > config 802.11a enable network
```
Step 3
After a suitable DCA list has been created, enter the `config mesh backhaul dca-channels enable` command to enable the backhaul channel deselection feature for mesh access points.
You can enter the `config mesh backhaul dca-channels disable` command if you want to disable the backhaul channel deselection feature for mesh access points.

It is not required that you disable 802.11a network to enable or disable this feature.

The following is a sample output:

```
(Controller) > config mesh backhaul dca-channels enable
802.11a 5 GHz Auto-RF:
    Allowed Channel List......................... 36,40,44,48,52,56,60,64,116, 140
Enabling DCA channels for c1524 mesh APs will limit the channel set to the DCA channel list.
DCA list should have at least 3 non public safety channels supported by Serial Backhaul Mesh APs.
Otherwise, the Serial Backhaul Mesh APs can get stranded.
Are you sure you want to continue? (y/N) y
```

Step 4
To check the current status of the backhaul channel deselection feature, enter the `show mesh config` command.

The following is a sample output:

```
(Controller) > show mesh config
Mesh Range....................................... 12000
Mesh Statistics update period.................... 3 minutes
Backhaul with client access status.............. enabled
Background Scanning State........................ enabled
Backhaul Amsdu State............................. disabled

Mesh Security
    Security Mode................................. PSK
    External-Auth................................ enabled
    Radius Server 1................................ 209.165.200.240
Use MAC Filter in External AAA server......... disabled
Force External Authentication................... disabled

Mesh Alarm Criteria
    Max Hop Count................................ 4
    Recommended Max Children for MAP............ 10
    Recommended Max Children for RAP............ 20
    Low Link SNR................................. 12
    High Link SNR............................... 60
    Max Association Number....................... 10
    Association Interval......................... 60 minutes
    Parent Change Numbers....................... 3

--More-- or (q)uit
    Parent Change Interval....................... 60 minutes

Mesh Multicast Mode............................ In-Out
Mesh Full Sector DFS............................ enabled
```
Mesh Ethernet Bridging VLAN Transparent Mode..... enabled

Mesh DCA channels for Serial Backhaul APs.............. disabled

**Step 5** Enter the `config slot slot number channel ap ap-name channel number` command to assign a particular channel to the 1524 RAP downlink radio.

- `slot number` refers to the slot of the downlink radio to which the channel is assigned.
- `ap-name` refers to the name of the access point on which the channel is configured.
- `channel number` refers to the channel that is assigned to a slot on the access point.

Slot 2 of the 1524 RAP acts as a downlink radio. If backhaul channel deselection is enabled, you can assign only those channels that are available in the DCA list the access point.

The following is a sample output:

```plaintext
(Controller) > config slot 2 channel ap Controller-RAP2-1524 136
Mesh backhaul dca-channels is enabled. Choose a channel from the DCA list.
(Controller) > config slot 2 channel ap Controller-RAP2-1524 140
```

---

**Backhaul Channel Deselection Guidelines**

Follow these guidelines when configuring backhaul channel deselection:

- Channels for serial backhaul RAP 11a access radio and both 11a radios of serial backhaul MAPs are assigned automatically. You cannot configure these channels.

- Look out for trap logs on the controller. In case of radar detection and subsequent channel change, messages similar to below appear:

  ```plaintext
  Channel changed for Base Radio MAC: 00:1e:bd:19:7b:00 on 802.11a radio. Old channel: 132. New Channel: 116. Why: Radar. Energy before/after change: 0/0. Noise before/after change: 0/0. Interference before/after change: 0/0.
  Radar signals have been detected on channel 132 by 802.11a radio with MAC: 00:1e:bd:19:7b:00 and slot 2
  ```

- For every serial backhaul AP, channels on downlink and uplink radios should always be noninterfering (for example, if the uplink is channel 104, the 100, 104, and 108 channels cannot be assigned for a downlink radio on that AP). An alternate adjacent channel is also selected for an 11a access radio on RAP.

- If radar signals are detected on all channels except the uplink radio channel, the downlink radio will be shut down and the uplink radio will act as both an uplink and a downlink (that is, the behavior is similar to 1522 APs in this case).

- Radar detection is cleared after 30 minutes. Any radio that is shut down because of radar detection should be back up and operational after this duration.
There is a 60-second silent period immediately after moving to a DFS-enabled channel (irrespective of whether the channel change is because of radar detection or user configured in case of a RAP) during which the AP scans for radar signals without transmitting anything. A small period (60 seconds) of downtime may occur because of radar detection, if the new channel is also DFS-enabled. If radar detection occurs again on the new channel during the silent period, the parent changes its channel without informing the child AP because it is not allowed to transmit during the silent period. In this case, the child AP dissociates and goes back to scan mode, rediscover the parent on the new channel and then joins back, which causes a slightly longer (approximately 3 minutes) downtime.

For a RAP, the channel for the downlink radio is always selected from within the DCA list, irrespective of whether the backhaul channel deselection feature is enabled or not. The behavior is different for a MAP because the MAP can pick any channel that is allowed for that domain, unless the backhaul channel deselection feature is enabled. We recommend that you have quite a few channels added to the 802.11a DCA channel list to prevent any radios getting shut down because of a lack of channels even if the backhaul channel deselection feature is not in use.

Because the DCA list that was used for the RRM feature is also used for mesh APs through the backhaul channel deselection feature, keep in mind that any addition or deletion of channels from the DCA list will affect the channel list input to the RRM feature for nonmesh access points as well. RRM is off for mesh.

For -M domain APs, a slightly longer time interval (25 to 50 percent more time than usual) may be required for the mesh network to come up because there is a longer list of DFS-enabled channels in the -M domain, which each AP scans before joining the parent.

### Configuring Dynamic Channel Assignment (GUI)

Using the controller GUI, follow these steps to specify the channels that the dynamic channel assignment (DCA) algorithm considers when selecting the channels to be used for RRM scanning. This functionality is helpful when you know that the clients do not support certain channels because they are legacy devices or they have certain regulatory restrictions.

> **Note** The steps outlined in this section are only relevant to mesh networks.

#### Step 1

To disable the 802.11a/n or 802.11b/g/n network, follow these steps:

- a) Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the 802.11a (or 802.11b/g) Global Parameters page.
- b) Deselect the 802.11a (or 802.11b/g) Network Status check box.
- c) Click Apply to commit your changes.

#### Step 2

Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > DCA to open the 802.11a (or 802.11b/g) > RRM > Dynamic Channel Assignment (DCA) page.

#### Step 3

Choose one of the following options from the Channel Assignment Method drop-down list to specify the controller’s DCA mode:

- **Automatic**—Causes the controller to periodically evaluate and, if necessary, update the channel assignment for all joined mesh access points. This is the default value.
• **Freeze**—Causes the controller to evaluate and update the channel assignment for all joined mesh access points, if necessary, but only when you click **Invoke Channel Update Once**.

  **Note**  The controller does not evaluate and update the channel assignment immediately after you click **Invoke Channel Update Once**. It waits for the next interval to elapse.

• **OFF**—Turns off DCA and sets all mesh access point radios to the first channel of the band, which is the default value. If you choose this option, you must manually assign channels on all radios.

**Step 4** From the Interval drop-down list, choose one of the following options to specify how often the DCA algorithm is allowed to run: 10 minutes, 1 hour, 2 hours, 3 hours, 4 hours, 6 hours, 8 hours, 12 hours, or 24 hours. The default value is 10 minutes.

**Step 5** From the AnchorTime drop-down list, choose a number to specify the time of day when the DCA algorithm is to start. The options are numbers between 0 and 23 (inclusive) representing the hour of the day from 12:00 a.m. to 11:00 p.m.

**Step 6** Select the **Avoid Foreign AP Interference** check box to cause the controller’s RRM algorithms to consider 802.11 traffic from foreign access points (those access points not included in your wireless network) when assigning channels to lightweight access points, or deselect it to disable this feature. For example, RRM may adjust the channel assignment to have access points avoid channels close to foreign access points. The default value is checked.

**Step 7** Select the **Avoid Cisco AP Load** check box to cause the controller’s RRM algorithms to consider 802.11 traffic from Cisco lightweight access points in your wireless network when assigning channels, or deselect it to disable this feature. For example, RRM can assign better reuse patterns to access points that carry a heavier traffic load. The default value is deselected.

**Step 8** Select the **Avoid Non-802.11a (802.11b) Noise** check box to cause the controller’s RRM algorithms to consider noise (non-802.11 traffic) in the channel when assigning channels to lightweight access points, or deselect it to disable this feature. For example, RRM may have access points avoid channels with significant interference from nonaccess point sources, such as microwave ovens. The default value is checked.

**Step 9** From the DCA Channel Sensitivity drop-down list, choose one of the following options to specify how sensitive the DCA algorithm is to environmental changes such as signal, load, noise, and interference when determining whether to change channels:

- **Low**—The DCA algorithm is not particularly sensitive to environmental changes.
- **Medium**—The DCA algorithm is moderately sensitive to environmental changes.
- **High**—The DCA algorithm is highly sensitive to environmental changes.

The default value is **Medium**. The DCA sensitivity thresholds vary by radio band.

**Table 32: DCA Sensitivity Thresholds**

<table>
<thead>
<tr>
<th>Option</th>
<th>2.4-GHz DCA Sensitivity Threshold</th>
<th>5-GHz DCA Sensitivity Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>5 dB</td>
<td>5 dB</td>
</tr>
<tr>
<td>Medium</td>
<td>10 dB</td>
<td>15 dB</td>
</tr>
<tr>
<td>Low</td>
<td>20 dB</td>
<td>20 dB</td>
</tr>
</tbody>
</table>
Step 10  For 802.11a/n networks only, choose one of the following Channel Width options to specify the channel bandwidth supported for all 802.11n radios in the 5-GHz band:

- **20 MHz**—The 20-MHz channel bandwidth (default)

Note  To override the globally configured DCA channel width setting, you can statically configure an access point's radio for 20-MHz mode on the 802.11a/n Cisco APs > Configure page. If you ever change the static RF channel assignment method to WLC Controlled on the access point radio, the global DCA configuration overrides the channel width configuration that the access point was previously using.

This page also shows the following nonconfigurable channel parameter settings:

- **Channel Assignment Leader**—The MAC address of the RF group leader, which is responsible for channel assignment.

- **Last Auto Channel Assignment**—The last time RRM evaluated the current channel assignments.

Step 11  In the DCA Channel List section, the DCA Channels field shows the channels that are currently selected. To choose a channel, select its check box in the Select column. To exclude a channel, deselect its check box.

Range: ?802.11a—36, 40, 44, 48, 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136, 140, 149, 153, 157, 161, 165, 190, 196?802.11b/g—1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11


Note  These extended UNII-2 channels in the 802.11a band do not appear in the channel list: 100, 104, 108, 112, 116, 132, 136, and 140. If you have Cisco Aironet 1500 series mesh access points in the -E regulatory domain, you must include these channels in the DCA channel list before you start operation. If you are upgrading from a previous release, verify that these channels are included in the DCA channel list. To include these channels in the channel list, select the Extended UNII-2 Channels check box.

Step 12  If you are using AP1500s in your network, you must set the 4.9-GHz channels in the 802.11a band on which they are to operate. The 4.9-GHz band is for public safety client access traffic only. To choose a 4.9-GHz channel, select its check box in the Select column. To exclude a channel, deselected its check box.

Range: ?802.11a—1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26

Default: ?802.11a—20, 26

Step 13  Click **Apply** to commit your changes.

Step 14  To reenable the 802.11a or 802.11b/g network, follow these steps:

1  Click **Wireless** > **802.11a/n or 802.11b/g/n > Network** to open the 802.11a (or 802.11b/g) Global Parameters page.

2  Select the **802.11a** (or **802.11b/g**) **Network Status** check box.

3  Click **Apply** to commit your changes.

Step 15  Click **Save Configuration** to save your changes.

To see why the DCA algorithm changed channels, click **Monitor** and then **View All** under Most Recent Traps. The trap provides the MAC address of the radio that changed channels, the previous channel and the new channel, the reason why the change occurred, the energy before and after the change, the noise before and after the change, and the interference before and after the change.
Configuring Advanced Features

This section includes the following topics:

- Using the 2.4-GHz Radio for Backhaul
- Universal Client Access
- Universal Client Access on Serial Backhaul Access Points
- Configuring Ethernet VLAN Tagging
- Workgroup Bridge Interoperability with Mesh Infrastructure
- Client Roaming
- Configuring Voice Parameters in Indoor Mesh Networks
- Enabling Mesh Multicast Containment for Video
- IGMP Snooping
- Locally Significant Certificates for Mesh APs

Using the 2.4-GHz Radio for Backhaul

Until the 7.0 release, mesh used the 5-GHz radio for backhaul, and the 2.4-GHz radio was used only for client access. The reasons for using only the 5-GHz radio for backhaul are as follows:

- More channels are available
- More EIRP is available
- Less interference occurs
- Most of the client access occurs over the 2.4-GHz band

However, under certain conditions, such as dense foliage areas, you might have needed to use the 2.4-GHz band for a backhaul because it has better penetration.

With the 7.0.116.0 release, you can configure an entire mesh network to use a single backhaul that can be either 5 GHz or 2.4 GHz.

Caution

This feature is available only for AP1522 (two radios). This feature should be used only after exploring the 5-GHz backhaul option.

Caution

We recommend that you use 5 GHz as the first option and use 2.4 GHz only if the 5-GHz option does not work.
Changing the Backhaul from 5 GHz to 2.4 GHz

When you specify only the RAP name as an argument to the command, the whole mesh sector changes to 2.4 GHz or 5 GHz backhaul. The warning messages indicate the change in backhaul, whether it is from 2.4 GHz to 5 GHz or vice versa.

**Note**  
The 2.4-GHz backhaul cannot be configured using the controller user interface, but only through the CLI.

1. To change the backhaul, enter the following command:

   ```text
   (Cisco Controller) > config mesh backhaul slot 0 enable RAP
   ``
   The following message appears;
   
   Warning! Changing backhaul slot will bring down the mesh for renegotiation!!!
   After backhaul is changed, 5 GHz client access channels need to be changed manually
   Are you sure you want to continue? (y/N)

2. Press y.

**Note**  
When you change the 5-GHz backhaul to local client access, the 5-GHz client access frequencies on all the APs are the same, because the backhaulfrequency is ported on these 5-GHz radios for client access. You need to configure these channels for a better frequency planning.

Changing the Backhaul from 2.4 GHz to 5 GHz

**Step 1**  
To change the backhaul, enter the following command:

   ```text
   (Cisco Controller) > config mesh backhaul slot 1 enable RAP
   ``
   The following message appears:
   
   Warning! Changing backhaul slot will bring down the mesh for renegotiation!!!
   Are you sure you want to continue? (y/N)

**Step 2**  
Press y.

**Note**  
You cannot configure the 2.4-GHz backhaul using the controller GUI, but you can configure the 2.4-GHz backhaul using the CLI.

Verifying the Current Backhaul in Use

To verify the current backhaul in use, enter the following command:

   ```text
   (Cisco Controller) > show mesh backhaul AP_name
   ```
For a 5-GHz backhaul, dynamic frequency selection (DFS) occurs only on 5 GHz and not on 2.4 GHz. The mechanism, which differs for RAP and MAP, is called a coordinated change mechanism. When 5 GHz is converted to client access from the backhaul or 2.4 GHz is being used as backhaul, DFS works similar to how it works for a local mode AP. DFS is detected on a 5-GHz client access, and the request is sent to the controller for a new channel. Mesh adjacency is not affected for the 2.4-GHz backhaul.

Universal Client Access

When Universal Client Access is enabled, it allows wireless client association over the backhaul radio. Generally, backhaul radio is a 5-GHz radio for most of the mesh access points except for 1522 where backhaul can be 2.4 GHz. This means that a backhaul radio can carry both backhaul traffic and client traffic.

When Universal Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client association is only over the second radio(s).

Universal Client Access is disabled by default. After this feature is enabled, all mesh access points reboot.

This feature is applicable to mesh access points with two or more radios (1552, 1524SB, 1522, Indoor APs in mesh mode) excluding the 1524PS.

Configuring Universal Client Access (GUI)

**Step 1** Choose Wireless > Mesh to open the Mesh page.

**Step 2** Select the Backhaul Client Access check box.
You will be prompted that all mesh APs will be rebooted.

**Step 3** Click OK to continue.

Configuring Universal Client Access (CLI)

Use the following command to enable Universal Client Access:

```
(Cisco Controller)> config mesh client-access enable
```

The following message is displayed:

```
All Mesh APs will be rebooted
Are you sure you want to start? (y/N)
```
Universal Client Access on Serial Backhaul Access Points

With universal client access, you can have client access on the backhaul 802.11a radios in addition to the backhaul functionality. This feature is applicable to mesh access points with two or more radios (1552, 1524SB, 1522, Indoor APs in mesh mode) excluding the 1524PS.

The dual 5-GHz Universal Client Access feature is intended for the serial backhaul access point platform, which has three radio slots. The radio in slot 0 operates in the 2.4-GHz band and is used for client access. The radios in slot 1 and slot 2 operate in the 5-GHz band and are primarily used for backhaul. However, with the Universal Client Access feature, clients were allowed to associate over the slot 1 radio. But slot 2 radio was used only for backhaul. With the 7.0 release, client access over the slot 2 radio is allowed with this Dual 5-GHz Universal Access feature.

By default, client access is disabled over both the backhaul radios. Follow the guidelines to enable or disable client access on the radio slots that constitute 5-GHz radios, irrespective of the radios being used as downlinks or uplinks:

- You can enable client access on slot 1 even if client access on slot 2 is disabled.
- You can enable client access on slot 2 only when client access on slot 1 is enabled.
- If you disable client access on slot 1, client access on slot 2 is automatically disabled on the CLI.
- To disable only the extended client access (on the slot 2 radio), use the GUI.
- All the mesh access points reboot whenever client access is enabled or disabled.

The two 802.11a backhaul radios use the same MAC address. There may be instances where a WLAN maps to the same BSSID on more than one slot. Client access on the slot 2 radio is referred to as Extended Universal Access (EUA) in this document.

Configuring Extended Universal Access (GUI)

| Step 1 | Choose Wireless > Mesh.  
The Controller GUI when Backhaul Client Access is disabled page appears. |
|--------|---------------------------------------------------------------|
| Step 2 | Select the Backhaul Client Access check box to display the Extended Backhaul Client Access check box.  
Step 3 | Select the Extended Backhaul Client Access check box and click Apply.  
You will be prompted that all mesh APs will be rebooted.  
Step 4 | Click OK continue.                                                 |
What to Do Next

After EUA is enabled, 802.11a radios are displayed as shown in this figure.

Figure 58: 802.11a Radios after EUA is Enabled

Slot 2 in the 5-GHz radio in the RAPSB (serial backhaul) that is used to extend the backhaul in the DOWNLINK direction is displayed as DOWNLINK ACCESS, where slot 1 in the 5-GHz radio in the RAPSB that is used for client access is displayed as ACCESS. Slot 2 in the 5-GHz radio in the MAPSB that is used for the UPLINK is displayed as UPLINK ACCESS, and slot 1 in the MAPSB is used for the DOWNLINK ACCESS with an omnidirectional antenna that also provides the client access.
Create WLAN on the WLC with the appropriate SSID mapped to the correct interface (VLAN). After you create a WLAN, it is applied to all the radios by default. If you want to enable client access only on 802.11a radios, then choose only the appropriate radio policy from the list shown in this figure.

*Figure 59: Radio Policy Selection*

**Configuring Extended Universal Access (CLI)**

- Go to the Controller prompt and enter the `config mesh client-access enable extended` command.

  The following message is displayed:

  Enabling client access on both backhaul slots
  Same BSSIDs will be used on both slots
  All Mesh Serial Backhaul APs will be rebooted
  Are you sure you want to start? (y/N)

- Enter the `show mesh client-access` command to know the status of the backhaul with client access and the backhaul with client access extended.

  The status is displayed as follows:

  Backhaul with client access status: enabled
  Backhaul with client access extended status(3 radio AP): enabled

- There is no explicit command to disable client access only on slot 2 (EUA). You have to disable client access on both the backhaul slots by entering the following command:

  `config mesh client-access disable`

  The following message is displayed:

  All Mesh APs will be rebooted
  Are you sure you want to start? (y/N)

- You can disable EUA from the GUI without disturbing client access on the slot 1 radio, but all 1524SB access points will be rebooted.

  It is possible to enable client access only on slot 1 and not on slot 2 by entering the following command:

  `config mesh client-access enable`
The following message is displayed:

All Mesh APs will be rebooted
Are you sure you want to start? (y/N)

Configuring Extended Universal Access from the Cisco Prime Infrastructure

Step 1  Choose Controllers > Controller IP Address > Mesh > Mesh Settings. The Mesh page when Backhaul Client Access is disabled appears.

Step 2  Select the Client Access on Backhaul Link check box to display the Extended Backhaul Client Access check box.

Step 3  Select the Extended Backhaul Client Access check box and click Apply. A message appears indicating the possible results of enabling the Extended Backhaul Client Access.

Step 4  Click OK to continue.

Configuring Ethernet VLAN Tagging

Ethernet VLAN tagging allows specific application traffic to be segmented within a wireless mesh network and then forwarded (bridged) to a wired LAN (access mode) or bridged to another wireless mesh network (trunk mode).

A typical public safety access application that uses Ethernet VLAN tagging is the placement of video surveillance cameras at various outdoor locations within a city. Each of these video cameras has a wired connection to a MAP. The video of all these cameras is then streamed across the wireless backhaul to a central command station on a wired network.

Figure 60: Ethernet VLAN Tagging
Ethernet Port Notes

Ethernet VLAN tagging allows Ethernet ports to be configured as normal, access, or trunk in both indoor and outdoor implementations:

When VLAN Transparent is disabled, the default Ethernet port mode is normal. VLAN Transparent must be disabled for VLAN tagging to operate and to allow configuration of Ethernet ports. To disable VLAN Transparent, which is a global parameter, see the Configuring Global Mesh Parameters section.

- Normal mode—In this mode, the Ethernet port does not accept or send any tagged packets. Tagged frames from clients are dropped.
  
  Use the normal mode in applications when only a single VLAN is in use or there is no need to segment traffic in the network across multiple VLANs.

- Access Mode—In this mode, only untagged packets are accepted. All incoming packets are tagged with user-configured VLANs called access-VLANs.
  
  Use the access mode for applications in which information is collected from devices connected to the MAP, such as cameras or PCs, and then forwarded to the RAP. The RAP then applies tags and forwards traffic to a switch on the wired network.

- Trunk mode—This mode requires the user to configure a native VLAN and an allowed VLAN list (no defaults). In this mode, both tagged and untagged packets are accepted. Untagged packets are accepted and are tagged with the user-specified native VLAN. Tagged packets are accepted if they are tagged with a VLAN in the allowed VLAN list.
  
  Use the trunk mode for bridging applications such as forwarding traffic between two MAPs that reside on separate buildings within a campus.

Ethernet VLAN tagging operates on Ethernet ports that are not used as backhauls.

In the controller releases prior to 7.2, the Root Access Point (RAP) native VLAN is forwarded out of Mesh Access Point (MAP) Ethernet ports with Mesh Ethernet Bridging and VLAN Transparent enabled. In the 7.2 and later controller releases, the Root Access Point (RAP) native VLAN is not forwarded out of Mesh Access Point (MAP) Ethernet ports with Mesh Ethernet Bridging and VLAN Transparent enabled. This change in behavior increases reliability and minimizes the possibility of forwarding loops on Mesh Backhauls.

Ethernet VLAN Tagging Guidelines

Follow these guidelines for Ethernet tagging:

- For security reasons, the Ethernet port on a mesh access point (RAP and MAP) is disabled by default. It is enabled by configuring Ethernet bridging on the mesh access point port.

- Ethernet bridging must be enabled on all the mesh access points in the mesh network to allow Ethernet VLAN tagging to operate.
• VLAN mode must be set as non-VLAN transparent (global mesh parameter). See the Configuring Global Mesh Parameters (CLI), on page 555. VLAN transparent is enabled by default. To set as non-VLAN transparent, you must deselect the VLAN transparent option in the global mesh parameters page.

Figure 61: Wireless > Mesh Page

• VLAN tagging can only be configured on Ethernet interfaces as follows:
  ◦ On AP1500s, three of the four ports can be used as secondary Ethernet interfaces: port 0-PoE in, port 1-PoE out, and port 3- fiber. Port 2-cable cannot be configured as a secondary Ethernet interface.
  ◦ In Ethernet VLAN tagging, port 0-PoE in on the RAP is used to connect to the trunk port of the switch of the wired network. Port 1-PoE out on the MAP is used to connect to external devices such as video cameras.

• Backhaul interfaces (802.11a radios) act as primary Ethernet interfaces. Backhauls function as trunks in the network and carry all VLAN traffic between the wireless and wired network. No configuration of primary Ethernet interfaces is required.

• For indoor mesh networks, the VLAN tagging feature functions as it does for outdoor mesh networks. Any access port that is not acting as a backhaul is secondary and can be used for VLAN tagging.

• VLAN tagging cannot be implemented on RAPs because the RAPs do not have a secondary Ethernet port, and the primary port is used as a backhaul. However, VLAN tagging can be enabled on MAPs with a single Ethernet port because the Ethernet port on a MAP does not function as a backhaul and is therefore a secondary port.
• No configuration changes are applied to any Ethernet interface acting as a backhaul. A warning displays if you attempt to modify the backhaul’s configuration. The configuration is only applied after the interface is no longer acting as a backhaul.

Figure 62: Warning Message Displays for Backhaul Configuration Attempts

• No configuration is required to support VLAN tagging on any 802.11a backhaul Ethernet interface within the mesh network as follows:
  * This includes the RAP uplink Ethernet port. The required configuration occurs automatically using a registration mechanism.
  * Any configuration changes to an 802.11a Ethernet link acting as a backhaul are ignored and a warning results. When the Ethernet link no longer functions as a backhaul, the modified configuration is applied.

• VLAN configuration is not allowed on port-02-cable modem port of AP1500s (wherever applicable). VLANs can be configured on ports 0 (PoE-in), 1 (PoE-out), and 3 (fiber).

• Up to 16 VLANs are supported on each sector. The cumulative number of VLANs supported by a RAP’s children (MAP) cannot exceed 16.

• The switch port connected to the RAP must be a trunk:
  * The trunk port on the switch and the RAP trunk port must match.
  * The RAP must always connect to the native VLAN ID 1 on a switch. The RAP’s primary Ethernet interface is by default the native VLAN of 1.
  * The switch port in the wired network that is attached to the RAP (port 0–PoE in) must be configured to accept tagged packets on its trunk port. The RAP forwards all tagged packets received from the mesh network to the wired network.
  * No VLANs, other than those destined for the mesh sector, should be configured on the switch trunk port.
• A configured VLAN on a MAP Ethernet port cannot function as a Management VLAN.
• Configuration is effective only when a mesh access point is in the CAPWAP RUN state and VLAN-Transparent mode is disabled.
• Whenever there roaming or a CAPWAP restart, an attempt is made to apply configuration again.

VLAN Registration

To support a VLAN on a mesh access point, all the uplink mesh access points must also support the same VLAN to allow segregation of traffic that belongs to different VLANs. The activity by which mesh access point communicates its requirements for a VLAN and gets response from a parent is known as VLAN registration.

Note VLAN registration occurs automatically. No user intervention is required.

VLAN registration is summarized below:

1. Whenever an Ethernet port on a mesh access point is configured with a VLAN, the port requests its parent to support that VLAN.
2. If the parent is able to support the request, it creates a bridge group for the VLAN and propagates the request to its parent. This propagation continues until the RAP is reached.
3. When the request reaches the RAP, it checks whether it is able to support the VLAN request. If yes, the RAP creates a bridge group and a subinterface on its uplink Ethernet interface to support the VLAN request.
4. If the mesh access point is not able to support the VLAN request by its child, at any point, the mesh access point replies with a negative response. This response is propagated to downstream mesh access points until the mesh access point that requested the VLAN is reached.
5. Upon receiving negative response from its parent, the requesting mesh access point defers the configuration of the VLAN. However, the configuration is stored for future attempts. Given the dynamic nature of mesh, another parent and its uplink mesh access points might be able to support it in the case of roaming or a CAPWAP reconnect.
Enabling Ethernet VLAN Tagging (GUI)

You must enable Ethernet bridging before you can configure VLAN tagging. See the Configuring Ethernet Bridging section.

Step 1
After enabling Ethernet bridging, choose Wireless > All APs.

Step 2
Click the AP name link of the mesh access point on which you want to enable VLAN tagging.

Step 3
On the details page, select the Mesh tab.

Figure 63: All APs > Details for (Mesh) Page

Step 4
Select the Ethernet Bridging check box to enable the feature and click Apply.
An Ethernet Bridging section appears at the bottom of the page listing each of the four Ethernet ports of the mesh access point.

- If configuring a MAP access port, click, for example, gigabitEthernet1 (port 1-PoE out).
  1. Select access from the mode drop-down list.
  2. Enter a VLAN ID. The VLAN ID can be any value between 1 and 4095.
  3. Click Apply.

Note: VLAN ID 1 is not reserved as the default VLAN.
Note: A maximum of 16 VLANs are supported across all of a RAP’s subordinate MAP.

Figure 64: VLAN Access Mode

• If configuring a RAP or MAP trunk port, click gigabitEthernet0 (port 0-PoE in).

1. Select trunk from the mode drop-down list.

2. Specify a native VLAN ID for incoming traffic. The native VLAN ID can be any value between 1 and 4095. Do not assign any value assigned to a user-VLAN (access).

3. Click Apply.

   A trunk VLAN ID field and a summary of configured VLANs appears at the bottom of the screen. The trunk VLAN ID field is for outgoing packets.

4. Specify a trunk VLAN ID for outgoing packets:

   If forwarding untagged packets, do not change the default trunk VLAN ID value of zero. (MAP-to-MAP bridging, campus environment)

   If forwarding tagged packets, enter a VLAN ID (1 to 4095) that is not already assigned. (RAP to switch on wired network).

5. Click Add to add the trunk VLAN ID to the allowed VLAN list. The newly added VLAN displays under the Configured VLANs section on the page.
To remove a VLAN from the list, select the Remove option from the arrow drop-down list to the right of the desired VLAN.

Figure 65: All APs > AP > VLAN Mappings Page

Step 5  Click Apply.
Step 6  Click Save Configuration.

Configuring Ethernet VLAN Tagging (CLI)

- To configure a MAP access port, enter this command:
  ```
  config ap ethernet 1 mode access enable AP1500-MAP 50
  ```
  where AP1500-MAP is the variable AP_name and 50 is the variable access_vlan ID

- To configure a RAP or MAP trunk port, enter this command:
  ```
  config ap ethernet 0 mode trunk enable AP1500-MAP 60
  ```
  where AP1500-MAP is the variable AP_name and 60 is the variable native_vlan ID

- To add a VLAN to the VLAN allowed list of the native VLAN, enter this command:
  ```
  config ap ethernet 0 mode trunk add AP1500-MAP 3 65
  ```
  where AP1500-MAP 3 is the variable AP_name and 65 is the variable VLAN ID

Viewing Ethernet VLAN Tagging Configuration Details (CLI)

To view VLAN configuration details for Ethernet interfaces on a specific mesh access point (AP Name) or all mesh access points (summary), enter one of the following commands:
To see if VLAN transparent mode is enabled or disabled, enter the following command:

```
<Cisco Controller> show ap config ethernet
```

```
summary For all APs
<AP Name> For specific AP

<Cisco Controller> show ap config ethernet AP-23

Vlan Tagging Information For AP AP-23
Ethernet 0
  Mode: TRUNK
  Native Vlan 80
  Allowed Vlans: 81 83
Ethernet 1
  Mode: ACCESS
  Access Vlan 88
Ethernet 2
  Mode: NORMAL
Ethernet 3
  Mode: TRUNK
  Native Vlan 83
  Allowed Vlans: 81 87 89
```

```
<Cisco Controller> show mesh config

Mesh Range................................. 12000
Backhaul with client access status......... disabled
Background Scanning State.................. enabled

Mesh Security:
  Security Mode............................ EAP
  External-Auth............................ disabled
  Use MAC Filter in External AAA server... disabled
  Force External Authentication............ disabled

Mesh Alarm Criteria
  Max Hop Count............................ 4
  Recommended Max Children for RAP........ 10
  Recommended Max Children for RAP........ 20
  Low Link SNR................................ 12
  High Link SNR...................... 60
  Max Association Number................. 10
  Association Interval................... 60 minutes
  Parent Change Numbers................. 3
  Parent Change Interval................ 60 minutes

--More-- or <quit>

Mesh Multicast Mode........................ In-Out
Mesh Full Sector DFS....................... enabled

Mesh Ethernet Bridging VLAN Transparent Mode..... disabled
```
Workgroup Bridge Interoperability with Mesh Infrastructure

A workgroup bridge (WGB) is a small standalone unit that can provide a wireless infrastructure connection for Ethernet-enabled devices. Devices that do not have a wireless client adapter to connect to the wireless network can be connected to the WGB through the Ethernet port. The WGB is associated with the root AP through the wireless interface, which means that wired clients get access to the wireless network.

A WGB is used to connect wired networks over a single wireless segment by informing the mesh access point of all the clients that the WGB has on its wired segment via IAPP messages. The data packets for WGB clients contain an additional MAC address in the 802.11 header (4 MAC headers, versus the normal 3 MAC data headers). The additional MAC in the header is the address of the WGB itself. This additional MAC address is used to route the packet to and from the clients.

WGB association is supported on all radios of every mesh access point.

In the current architecture, while an autonomous AP functions as a workgroup bridge, only one radio interface is used for controller connectivity, Ethernet interface for wired client connectivity, and other radio interface for wireless client connectivity. dot11radio 1 (5 GHz) can be used to connect to a controller (using the mesh infrastructure) and Ethernet interface for wired clients. dot11radio 0 (2.4 GHz) can be used for wireless client connectivity. Depending on the requirement, dot11radio 1 or dot11radio 0 can be used for client association or controller connectivity.

With the 7.0 release, a wireless client on the second radio of the WGB is not dissociated by the WGB upon losing its uplink to a wireless infrastructure or in a roaming scenario.

With two radios, one radio can be used for client access and the other radio can be used for accessing the access points. Having two independent radios performing two independent functions provides you better control and lowers the latency. Also, wireless clients on the second radio for the WGB do not get disassociated by the WGB when an uplink is lost or in a roaming scenario. One radio has to be configured as a Root AP (radio role) and the second radio has to be configured as a WGB (radio role).

Note

If one radio is configured as a WGB, then the second radio cannot be a WGB or a repeater.

The following features are not supported for use with a WGB:

- FlexConnect
- Idle timeout
- Web authentication—If a WGB associates to a web-authentication WLAN, the WGB is added to the exclusion list, and all of the WGB-wired clients are deleted (web-authentication WLAN is another name for a guest WLAN).
- For wired clients behind the WGB, MAC filtering, link tests, and idle timeout

Configuring Workgroup Bridges

A workgroup bridge (WGB) is used to connect wired networks over a single wireless segment by informing the mesh access point of all the clients that the WGB has on its wired segment via IAPP messages. In addition to the IAPP control messages, the data packets for WGB clients contain an extra MAC address in the 802.11 header (4 MAC headers, versus the normal 3 MAC data headers). The extra MAC in the header is the address of the workgroup bridge itself. This extra MAC address is used to route the packet to and from the clients.
WGB association is supported on both the 2.4-GHz (802.11b/g) and 5-GHz (802.11a) radios on the AP1522, and the 2.4-GHz (802.11b) and 4.9-GHz (public safety) radios on the AP1524PS; Supported platforms are autonomous WGBs AP1130, AP1140, AP1240, AP1310, and the Cisco 3200 Mobile Router (hereafter referred to as Cisco 3200) which are configured as WGBs can associate with a mesh access point. See the “Cisco Workgroup Bridges” section in Chapter 7 of the Cisco Wireless LAN Controller Configuration Guide, Release 7.0.116.0 for configuration steps at http://www.cisco.com/c/en/us/support/wireless/4400-series-wireless-lan-controllers/products-installation-and-configuration-guides-list.html

Supported Workgroup Bridge Modes and Capacities

The supported WGB modes and capacities are as follows:

- The autonomous access points configured as WGBs must be running Cisco IOS release 12.4.25d-JA or later.

\[\text{Note}\]

If your mesh access point has two radios, you can only configure workgroup bridge mode on one of the radios. We recommend that you disable the second radio. Workgroup bridge mode is not supported on access points with three radios such as the AP1524SB.

- Client mode WGB (BSS) is supported; however, infrastructure WGB is not supported. The client mode WGB is not able to trunk VLAN as in an infrastructure WGB.

- Multicast traffic is not reliably transmitted to WGB because no ACKs are returned by the client. Multicast traffic is unicast to infrastructure WGB, and ACKs are received back.

- If one radio is configured as a WGB in a Cisco IOS access point, then the second radio cannot be a WGB or a repeater.

- Mesh access points can support up to 200 clients including wireless clients, WGB, and wired clients behind the associated WGB.

- A WGB cannot associate with mesh access points if the WLAN is configured with WPA1 (TKIP) +WPA2 (AES), and the corresponding WGB interface is configured with only one of these encryptions (either WPA1 or WPA2):
This figure displays WPA security settings for WGB (controller GUI).

Figure 66: WPA Security Settings for a WGB

This figure displays WPA-2 security settings for WGB (controller GUI).

Figure 67: WPA-2 Security Settings for a WGB
Viewing Status of WGB Client

Step 1  Choose Monitor > Clients.
Step 2  On the client summary page, click on the MAC address of the client or search for the client using its MAC address.
Step 3  In the page that appears, note that the client type is identified as a WGB (far right).

Figure 68: Clients are Identified as a WGB

Step 4  Click on the MAC address of the client to view configuration details.

Guidelines and Limitations

- We recommend using a 5-GHz radio for the uplink to Mesh AP infrastructure so you can take advantage of a strong client access on two 5-GHz radios available on mesh access points. A 5-GHz band allows more Effective Isotropic Radiated Power (EIRP) and is less polluted. In a two-radio WGB, configure 5-GHz radio (radio 1) mode as WGB. This radio will be used to access the mesh infrastructure. Configure the second radio 2.4-GHz (radio 0) mode as Root for client access.

- On the Autonomous access points, only one SSID can be assigned to the native VLAN. You cannot have multiple VLANs in one SSID on the autonomous side. SSID to VLAN mapping should be unique because this is the way to segregate traffic on different VLANs. In a unified architecture, multiple VLANs can be assigned to one VLAN (SSID).

- Only one WLAN (SSID) for wireless association of the WGB to the access point infrastructure is supported. This SSID should be configured as an infrastructure SSID and should be mapped to the native VLAN.

- A dynamic interface should be created in the controller for each VLAN configured in the WGB.

- A second radio (2.4-GHz) on the access point should be configured for client access. You have to use the same SSID on both radios and map to the native VLAN. If you create a separate SSID, then it is not possible to map it to a native VLAN, due to the unique VLAN/SSID mapping requirements. If you try to map the SSID to another VLAN, then you do not have multiple VLAN support for wireless clients.

- All Layer 2 security types are supported for the WLANs (SSIDs) for wireless client association in WGB.
• This feature does not depend on the AP platform. On the controller side, both mesh and nonmesh APs are supported.

• There is a limitation of 20 clients in the WGB. The 20-client limitation includes both wired and wireless clients. If the WGB is talking to autonomous access points, then the client limit is very high.

• The controller treats the wireless and wired clients behind a WGB in the same manner. Features such as MAC filtering and link test are not supported for wireless WGB clients from the controller.

• If required, you can run link tests for a WGB wireless client from an autonomous AP.

• Multiple VLANs for wireless clients associated to a WGB are not supported.

• Up to 16 multiple VLANs are supported for wired clients behind a WGB from the 7.0 release and later releases.

• Roaming is supported for wireless and wired clients behind a WGB. The wireless clients on the other radio will not be dissociated by the WGB when an uplink is lost or in a roaming scenario.

We recommend that you configure radio 0 (2.4 GHz) as a Root (one of the mode of operations for Autonomous AP) and radio 1 (5 GHz) as a WGB.

Example—Configuration of a Workgroup Bridge

When you configure from the CLI, the following are mandatory:

• dot11 SSID (security for a WLAN can be decided based on the requirement).

• Map the subinterfaces in both the radios to a single bridge group.

Note
A native VLAN is always mapped to bridge group 1 by default. For other VLANs, the bridge group number matches the VLAN number; for example, for VLAN 46, the bridge group is 46.

• Map the SSID to the radio interfaces and define the role of the radio interfaces.

In the following example, one SSID (WGBTEST) is used in both radios, and the SSID is the infrastructure SSID mapped to NATIVE VLAN 51. All radio interfaces are mapped to bridge group -1.

```
WGB1#config
WGB1(config)#interface Dot11Radio1.51
WGB1(config-subif)#encapsulation dot1q 51 native
WGB1(config-subif)#bridge-group 1
WGB1(config-subif)#exit
WGB1(config)#interface Dot11Radio0.51
WGB1(config-subif)#encapsulation dot1q 51 native
WGB1(config-subif)#bridge-group 1
WGB1(config-subif)#exit
WGB1(config)#dot11 ssid WGBTEST
WGB1(config-ssid)#VLAN 51
WGB1(config-ssid)#authentication open
WGB1(config-ssid)#infrastructure-ssid
WGB1(config-ssid)#exit
WGB1(config)#interface Dot11Radio1
```
You can also use the GUI of an autonomous AP for configuration. From the GUI, subinterfaces are automatically created after the VLAN is defined.

Figure 69: SSID Configuration Page

WGB Association Check

Both the WGB association to the controller and the wireless client association to WGB can be verified by entering the `show dot11 associations client` command in autonomous AP.

WGB#show dot11 associations client

802.11 Client Stations on Dot11Radio1:

<table>
<thead>
<tr>
<th>SSID [WGBTEST] :</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Address</td>
</tr>
<tr>
<td>0024.130f.920e</td>
</tr>
</tbody>
</table>
From the controller, choose **Monitor > Clients**. The WGB and the wireless/wired client behind the WGB are updated and the wireless/wired client are shown as the WGB client, as shown in the figures below.

**Figure 70: Updated WGB Clients**

**Figure 71: Updated WGB Clients**

**Figure 72: Updated WGB Clients**
Link Test Result

This figure shows the link test results.

Figure 73: Link Test Results

A link test can also be run from the controller CLI using the following command:

(Cisco Controller) > linktest client mac address

Link tests from the controller are only limited to the WGB, and they cannot be run beyond the WGB from the controller to a wired or wireless client connected to the WGB. You can run link tests for the wireless client connected to the WGB from the WGB itself using the following command:

ap# dot11 dot11Radio 0 linktest target client mac
Start linktest to 0040.96b8.d462, 100 512 byte packets
ap#

<table>
<thead>
<tr>
<th>Packet rate</th>
<th>1M</th>
<th>2M</th>
<th>3M</th>
<th>6M</th>
<th>9M</th>
<th>11M</th>
<th>12M</th>
<th>16M</th>
<th>24M</th>
<th>36M</th>
<th>48M</th>
<th>54M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sent count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Receive count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Packet rate (mac)</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>Sent count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Receive count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

POOR (4% lost) | Time (msec) | Strength (dBm) | SNR Quality | Retries
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In</td>
<td>Out</td>
<td>In</td>
<td>Out</td>
</tr>
<tr>
<td>Sent: 100</td>
<td></td>
<td></td>
<td>48</td>
<td>3</td>
</tr>
<tr>
<td>Lost to Tgt: 4</td>
<td></td>
<td></td>
<td>61</td>
<td>10</td>
</tr>
<tr>
<td>Lost to Src: 4</td>
<td></td>
<td></td>
<td>15</td>
<td>3</td>
</tr>
</tbody>
</table>

Rates (Src/Tgt) 24Mb 0/5 36Mb 25/0 48Mb 73/0 54Mb 2/91
Linktest Done in 24.464 msec
WGB Wired/Wireless Client

You can also use the following commands to know the summary of WGBs and clients associated with a Cisco lightweight access point:

(Cisco Controller) > **show wgb summary**

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>IP Address</th>
<th>AP Name</th>
<th>Status</th>
<th>WLAN</th>
<th>Auth</th>
<th>Protocol</th>
<th>Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:1d:70:97:bd:e8</td>
<td>209.165.200.225</td>
<td>c1240</td>
<td>Assoc</td>
<td>2</td>
<td>Yes</td>
<td>802.11a</td>
<td>2</td>
</tr>
<tr>
<td>00:1e:be:27:5f:e2</td>
<td>209.165.200.226</td>
<td>c1240</td>
<td>Assoc</td>
<td>2</td>
<td>Yes</td>
<td>802.11a</td>
<td>5</td>
</tr>
</tbody>
</table>

(Cisco Controller) > **show client summary**

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>AP Name</th>
<th>Status</th>
<th>WLAN/Guest-Lan</th>
<th>Auth</th>
<th>Protocol</th>
<th>Port</th>
<th>Wired</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:24:ca:a9:b4</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>N/A</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:3a</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:f4</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:f8</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:62:0a</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:62:42</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:71:d2</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
</tbody>
</table>

(Cisco Controller) > **show wgb detail** 00:1e:be:27:5f:e2
Number of wired client(s): 5

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>IP Address</th>
<th>AP Name</th>
<th>Mobility</th>
<th>WLAN</th>
<th>Auth</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:16:c7:5d:b4:8f</td>
<td>Unknown</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>No</td>
</tr>
<tr>
<td>00:21:91:f8:e9:ae</td>
<td>209.165.200.232</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:21:55:04:07:b5</td>
<td>209.165.200.234</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:1e:58:31:c7:4a</td>
<td>209.165.200.236</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:23:04:9a:0b:12</td>
<td>Unknown</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>No</td>
</tr>
</tbody>
</table>

Client Roaming

High-speed roaming of Cisco Compatible Extension (CX), version 4 (v4) clients is supported at speeds up to 70 miles per hour in outdoor mesh deployments of AP1522s and AP1524s. An example application might be maintaining communication with a terminal in an emergency vehicle as it moves within a mesh public network.

Three Cisco CX v4 Layer 2 client roaming enhancements are supported:

- **Access point assisted roaming**—Helps clients save scanning time. When a Cisco CX v4 client associates to an access point, it sends an information packet to the new access point listing the characteristics of its previous access point. Roaming time decreases when the client recognizes and uses an access point list built by compiling all previous access points to which each client was associated and sent (unicast) to the client immediately after association. The access point list contains the channels, BSSIDs of neighbor access points that support the client’s current SSID(s), and time elapsed since disassociation.

- **Enhanced neighbor list**—Focuses on improving a Cisco CX v4 client’s roam experience and network edge performance, especially when servicing voice applications. The access point provides its associated client information about its neighbors using a neighbor-list update unicast message.

- **Roam reason report**—Enables Cisco CX v4 clients to report the reason why they roamed to a new access point. It also allows network administrators to build and monitor a roam history.

**Note**


WGB Roaming Guidelines

Follow these guidelines for WGB roaming:

- **Configuring a WGB for roaming**—If a WGB is mobile, you can configure it to scan for a better radio connection to a parent access point or bridge. Use the `ap(config-if)#mobile station period 3 threshold 50` command to configure the workgroup bridge as a mobile station.
When you enable this setting, the WGB scans for a new parent association when it encounters a poor Received Signal Strength Indicator (RSSI), excessive radio interference, or a high frame-loss percentage. Using these criteria, a WGB configured as a mobile station searches for a new parent association and roams to a new parent before it loses its current association. When the mobile station setting is disabled (the default setting), a WGB does not search for a new association until it loses its current association.

- **Configuring a WGB for Limited Channel Scanning**—In mobile environments such as railroads, a WGB instead of scanning all the channels is restricted to scan only a set of limited channels to reduce the hand-off delay when the WGB roams from one access point to another. By limiting the number of channels, the WGB scans only those required channels; the mobile WGB achieves and maintains a continuous wireless LAN connection with fast and smooth roaming. This limited channel set is configured using the `ap(config-if)#mobile station scan set of channels`. This command invokes scanning to all or specified channels. There is no limitation on the maximum number of channels that can be configured. The maximum number of channels that can be configured is restricted only by the number of channels that a radio can support. When executed, the WGB scans only this limited channel set. This limited channel feature also affects the known channel list that the WGB receives from the access point to which it is currently associated. Channels are added to the known channel list only if they are also part of the limited channel set.

### Configuration Example

The following example shows how to configure a roaming configuration:

```
ap(config)#interface dot11radio 1
ap(config-if)#ssid outside
ap(config-if)#packet retries 16
ap(config-if)#station role workgroup-bridge
ap(config-if)#mobile station
ap(config-if)#mobile station period 3 threshold 50
ap(config-if)#mobile station scan 5745 5765
```

Use the `no mobile station scan` command to restore scanning to all the channels.

This table identifies mesh access points and their respective frequency bands that support WGB.

#### Table 33: WGB Interoperability Chart

<table>
<thead>
<tr>
<th>RAP/MAP</th>
<th>WGB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backhaul</td>
<td>MAR3200</td>
</tr>
<tr>
<td></td>
<td>802.11n Indoor APs</td>
</tr>
<tr>
<td></td>
<td>1130/1240</td>
</tr>
<tr>
<td></td>
<td>1310</td>
</tr>
<tr>
<td></td>
<td>4.9 GHz (5, 10, 20 MHz)</td>
</tr>
<tr>
<td></td>
<td>5 GHz</td>
</tr>
<tr>
<td></td>
<td>2.4 GHz</td>
</tr>
<tr>
<td></td>
<td>5 GHz</td>
</tr>
<tr>
<td></td>
<td>2.4 GHz</td>
</tr>
<tr>
<td></td>
<td>5 GHz</td>
</tr>
<tr>
<td></td>
<td>2.4 GHz</td>
</tr>
<tr>
<td>1552/1552</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>1524SB/1524SB</td>
<td>No</td>
</tr>
<tr>
<td>1524PS/1524PS</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Troubleshooting Tips

If a wireless client is not associated with a WGB, use the following steps to troubleshoot the problem:

1. Verify the client configuration and ensure that the client configuration is correct.
2. Check the `show bridge` command output in autonomous AP, and confirm that the AP is reading the client MAC address from the right interface.
3. Confirm that the subinterfaces corresponding to specific VLANs in different interfaces are mapped to the same bridge group.
4. If required, clear the bridge entry using the `clear bridge` command (remember that this command will remove all wired and wireless clients associated in a WGB and make them associate again).
5. Check the `show dot11 association` command output and confirm that the WGB is associated with the controller.
6. Ensure that the WGB has not exceeded its 20-client limitation.

In a normal scenario, if the `show bridge` and `show dot11 association` command outputs are as expected, wireless client association should be successful.

### Configuring Voice Parameters in Indoor Mesh Networks

You can configure call admission control (CAC) and QoS on the controller to manage voice and video quality on the mesh network.

The indoor mesh access points are 802.11e capable, and QoS is supported on the local 2.4-GHz access radio and the 5-GHz backhaul radio. CAC is supported on the backhaul and the CCXv4 clients (which provides CAC between the mesh access point and the client).

**Note**

Voice is supported only on indoor mesh networks. Voice is supported on a best-effort basis in the outdoors in a mesh network.
CAC

CAC enables a mesh access point to maintain controlled quality of service (QoS) when the wireless LAN is experiencing congestion. The Wi-Fi Multimedia (WMM) protocol deployed in CCXv3 ensures sufficient QoS as long as the wireless LAN is not congested. However, to maintain QoS under differing network loads, CAC in CCXv4 or later is required.

Note

Two types of CAC are available for access points: bandwidth-based CAC and load-based CAC. All calls on a mesh network are bandwidth-based, so mesh access points use only bandwidth-based CAC.

Bandwidth-based, or static CAC enables the client to specify how much bandwidth or shared medium time is required to accept a new call. Each access point determines whether it is capable of accommodating a particular call by looking at the bandwidth available and compares it against the bandwidth required for the call. If there is not enough bandwidth available to maintain the maximum allowed number of calls with acceptable quality, the mesh access point rejects the call.

QoS and DSCP Marking

Cisco supports 802.11e on the local access and on the backhaul. Mesh access points prioritize user traffic based on classification, and therefore all user traffic is treated on a best-effort basis.

Resources available to users of the mesh vary, according to the location within the mesh, and a configuration that provides a bandwidth limitation in one point of the network can result in an oversubscription in other parts of the network.

Similarly, limiting clients on their percentage of RF is not suitable for mesh clients. The limiting resource is not the client WLAN, but the resources available on the mesh backhaul.

Similar to wired Ethernet networks, 802.11 WLANs employ Carrier Sense Multiple Access (CSMA), but instead of using collision detection (CD), WLANs use collision avoidance (CA), which means that instead of each station trying to transmit as soon as the medium is free, WLAN devices will use a collision avoidance mechanism to prevent multiple stations from transmitting at the same time.

The collision avoidance mechanism uses two values called CWmin and CWmax. CW stands for contention window. The CW determines what additional amount of time an endpoint should wait, after the interframe space (IFS), to attend to transmit a packet. Enhanced distributed coordination function (EDCF) is a model that allows end devices that have delay-sensitive multimedia traffic to modify their CWmin and CWmax values to allow for statically greater (and more frequent) access to the medium.

Cisco access points support EDCF-like QoS. This provides up to eight queues for QoS.

These queues can be allocated in several different ways, as follows:

- Based on TOS / DiffServ settings of packets
- Based on Layer 2 or Layer 3 access lists
- Based on VLAN
- Based on dynamic registration of devices (IP phones)
AP1500s, with Cisco controllers, provide a minimal integrated services capability at the controller, in which client streams have maximum bandwidth limits, and a more robust differentiated services (diffServ) capability based on the IP DSCP values and QoS WLAN overrides.

When the queue capacity has been reached, additional frames are dropped (tail drop).

**Encapsulations**

Several encapsulations are used by the mesh system. These encapsulations include CAPWAP control and data between the controller and RAP, over the mesh backhaul, and between the mesh access point and its client(s). The encapsulation of bridging traffic (noncontroller traffic from a LAN) over the backhaul is the same as the encapsulation of CAPWAP data.

There are two encapsulations between the controller and the RAP. The first is for CAPWAP control, and the second is for CAPWAP data. In the control instance, CAPWAP is used as a container for control information and directives. In the instance of CAPWAP data, the entire packet, including the Ethernet and IP headers, is sent in the CAPWAP container.

*Figure 74: Encapsulations*

For the backhaul, there is only one type of encapsulation, encapsulating MESH traffic. However, two types of traffic are encapsulated: bridging traffic and CAPWAP control and data traffic. Both types of traffic are encapsulated in a proprietary mesh header.

In the case of bridging traffic, the entire packet Ethernet frame is encapsulated in the mesh header.
All backhaul frames are treated identically, regardless of whether they are MAP to MAP, RAP to MAP, or MAP to RAP.

**Figure 75: Encapsulating Mesh Traffic**

The mesh access point uses a high speed CPU to process ingress frames, Ethernet, and wireless on a first-come, first-serve basis. These frames are queued for transmission to the appropriate output device, either Ethernet or wireless. Egress frames can be destined for either the 802.11 client network, the 802.11 backhaul network, or Ethernet.

AP1500s support four FIFOs for wireless client transmissions. These FIFOs correspond to the 802.11e platinum, gold, silver, and bronze queues, and obey the 802.11e transmission rules for those queues. The FIFOs have a user configurable queue depth.

The backhaul (frames destined for another outdoor mesh access point) uses four FIFOs, although user traffic is limited to gold, silver, and bronze. The platinum queue is used exclusively for CAPWAP control traffic and voice, and has been reworked from the standard 802.11e parameters for CWmin, CWmax, and so on, to provide more robust transmission but higher latencies.

The 802.11e parameters for CWmin, CWmax, and so on, for the gold queue have been reworked to provide lower latency at the expense of slightly higher error rate and aggressiveness. The purpose of these changes is to provide a channel that is more conducive to video applications.

Frames that are destined for Ethernet are queued as FIFO, up to the maximum available transmit buffer pool (256 frames). There is support for a Layer 3 IP Differentiated Services Code Point (DSCP), so marking of the packets is there as well.

In the controller to RAP path for the data traffic, the outer DSCP value is set to the DSCP value of the incoming IP frame. If the interface is in tagged mode, the controller sets the 802.1Q VLAN ID and derives the 802.1p
UP (outer) from 802.1p UP incoming and the WLAN default priority ceiling. Frames with VLAN ID 0 are not tagged.

*Figure 76: Controller to RAP Path*

For CAPWAP control traffic the IP DSCP value is set to 46, and the 802.1p user priority is set to 7. Prior to transmission of a wireless frame over the backhaul, regardless of node pairing (RAP/MAP) or direction, the DSCP value in the outer header is used to determine a backhaul priority. The following sections describe the mapping between the four backhaul queues the mesh access point uses and the DSCP values shown in Backhaul Path QoS.

*Table 34: Backhaul Path QoS*

<table>
<thead>
<tr>
<th>DSCP Value</th>
<th>Backhaul Queue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2, 4, 6, 8 to 23</td>
<td>Bronze</td>
</tr>
<tr>
<td>26, 32 to 63</td>
<td>Gold</td>
</tr>
<tr>
<td>46 to 56</td>
<td>Platinum</td>
</tr>
<tr>
<td>All others including 0</td>
<td>Silver</td>
</tr>
</tbody>
</table>

*Note*

The platinum backhaul queue is reserved for CAPWAP control traffic, IP control traffic, and voice packets. DHCP, DNS, and ARP requests are also transmitted at the platinum QoS level. The mesh software inspects each frame to determine whether it is a CAPWAP control or IP control frame in order to protect the platinum queue from use by non-CAPWAP applications.

For a MAP to the client path, there are two different procedures, depending on whether the client is a WMM client or a normal client. If the client is a WMM client, the DSCP value in the outer frame is examined, and the 802.11e priority queue is used.

*Table 35: MAP to Client Path QoS*

<table>
<thead>
<tr>
<th>DSCP Value</th>
<th>Backhaul Queue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2, 4, 6, 8 to 23</td>
<td>Bronze</td>
</tr>
</tbody>
</table>
If the client is not a WMM client, the WLAN override (as configured at the controller) determines the 802.11e queue (bronze, gold, platinum, or silver), on which the packet is transmitted.

For a client of a mesh access point, there are modifications made to incoming client frames in preparation for transmission on the mesh backhaul or Ethernet. For WMM clients, a MAP illustrates the way in which the outer DSCP value is set from an incoming WMM client frame.

**Table 36: DSCP to Backhaul Queue Mapping**

<table>
<thead>
<tr>
<th>DSCP Value</th>
<th>Backhaul Queue</th>
</tr>
</thead>
<tbody>
<tr>
<td>26, 32 to 45, 47</td>
<td>Gold</td>
</tr>
<tr>
<td>46, 48 to 63</td>
<td>Platinum</td>
</tr>
<tr>
<td>All others including 0</td>
<td>Silver</td>
</tr>
</tbody>
</table>

The minimum value of the incoming 802.11e user priority and the WLAN override priority is translated using the information listed in the table below to determine the DSCP value of the IP frame. For example, if the incoming frame has as its value a priority indicating the gold priority, but the WLAN is configured for the silver priority, the minimum priority of silver is used to determine the DSCP value.

If there is no incoming WMM priority, the default WLAN priority is used to generate the DSCP value in the outer header. If the frame is an originated CAPWAP control frame, the DSCP value of 46 is placed in the outer header.

With the 5.2 code enhancements, DSCP information is preserved in an AWPP header.
All wired client traffic is restricted to a maximum 802.1p value of 5, except DHCP/DNS and ARP packets, which go through the platinum queue.

The non-WMM wireless client traffic gets the default QoS priority of its WLAN. The WMM wireless client traffic may have a maximum 802.11e value of 6, but it must be below the QoS profile configured for its WLAN. If admission control is configured, WMM clients must use TSPEC signaling and get admitted by CAC.

The CAPWAPP data traffic carries wireless client traffic and has the same priority and treatment as wireless client traffic.

Now that the DSCP value is determined, the rules described earlier for the backhaul path from the RAP to the MAP are used to further determine the backhaul queue on which the frame is transmitted. Frames transmitted from the RAP to the controller are not tagged. The outer DSCP values are left intact, as they were first constructed.

**Bridging Backhaul Packets**

Bridging services are treated a little differently from regular controller-based services. There is no outer DSCP value in bridging packets because they are not CAPWAP encapsulated. Therefore, the DSCP value in the IP header as it was received by the mesh access point is used to index into the table as described in the path from the mesh access point to the mesh access point (backhaul).

**Bridging Packets from and to a LAN**

Packets received from a station on a LAN are not modified in any way. There is no override value for the LAN priority. Therefore, the LAN must be properly secured in bridging mode. The only protection offered to the mesh backhaul is that non-CAPWAP control frames that map to the platinum queue are demoted to the gold queue.

Packets are transmitted to the LAN precisely as they are received on the Ethernet ingress at entry to the mesh. The only way to integrate QoS between Ethernet ports on AP1500 and 802.11a is by tagging Ethernet packets with DSCP. AP1500s take the Ethernet packet with DSCP and places it in the appropriate 802.11e queue.

AP1500s do not tag DSCP itself:

- On the ingress port, the AP1500 sees a DSCP tag, encapsulates the Ethernet frame, and applies the corresponding 802.11e priority.
- On the egress port, the AP1500 decapsulates the Ethernet frame, and places it on the wire with an untouched DSCP field.

Ethernet devices, such as video cameras, should have the capability to mark the bits with DSCP value to take advantage of QoS.

---

**Note**

QoS only is relevant when there is congestion on the network.
Guidelines For Using Voice on the Mesh Network

- Voice is supported only on indoor mesh networks in release 5.2, 6.0, 7.0, and 7.0.116.0. For outdoors, voice is supported on a best-effort basis on a mesh infrastructure.

- When voice is operating on a mesh network, calls must not traverse more than two hops. Each sector must be configured to require no more than two hops for voice.

- RF considerations for voice networks are as follows:
  - Coverage hole of 2 to 10 percent
  - Cell coverage overlap of 15 to 20 percent
  - Voice needs RSSI and SNR values that are at least 15 dB higher than data requirements
  - RSSI of -67 dBm for all data rates should be the goal for 11b/g/n and 11a/n
  - SNR should be 25 dB for the data rate used by client to connect to the AP
  - Packet error rate (PER) should be configured for a value of one percent or less
  - Channel with the lowest utilization (CU) must be used

- On the 802.11a/n (or 802.11b/g/n) > Global parameters page, do the following:
  - Enable dynamic target power control (DTPC).
  - Disable all data rates less than 11 Mbps.

- On the 802.11a/n or 802.11b/g/n > Voice parameters page, you should do the following:
  - Load-based CAC must be disabled.
  - Enable admission control (ACM) for CCXv4 or v5 clients that have WMM enabled. Otherwise, bandwidth-based CAC does not operate properly.
  - Set the maximum RF bandwidth to 50 percent.
  - Set the reserved roaming bandwidth to 6 percent.
  - Enable traffic stream metrics.

- On the 802.11a/n or 802.11b/g/n > EDCA parameters page, you should do the following:
  - Set the EDCA profile for the interface as voice optimized.
  - Disable low latency MAC.

- On the QoS > Profile page, you should do the following:
  - Create a voice profile and select 802.1Q as the wired QoS protocol type.

- On the WLANs > Edit > QoS page, you should do the following:
  - Select a QoS of platinum for voice and gold for video on the backhaul.
  - Select allowed as the WMM policy.
- On the WLANs > Edit > QoS page, you should do the following:
  - Select CCKM for authorization (auth) key management (mgmt) if you want to support fast roaming.
    For more information, see the Client Roaming section.

- On the x > y page, you should do the following:
  - Disable voice active detection (VAD).

Voice Call Support in a Mesh Network

The table below shows the actual calls in a clean, ideal environment.

**Table 37: Calls Possible with 1520 Series in 802.11a and 802.11b/g Radios**

<table>
<thead>
<tr>
<th>No. of Calls</th>
<th>802.11a Radio</th>
<th>802.11b/g Radio</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAP</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>MAP1</td>
<td>7</td>
<td>10</td>
</tr>
<tr>
<td>MAP2</td>
<td>4</td>
<td>8</td>
</tr>
</tbody>
</table>

The table below shows the actual calls in a clean, ideal environment.

**Table 38: Calls Possible with 1550 Series in 802.11a/n 802.11b/g/n Radios**

<table>
<thead>
<tr>
<th>No. of Calls</th>
<th>802.11a/n Radio 20 MHz</th>
<th>802.11a/n Radio 40 MHz</th>
<th>802.11b/g/n Backhaul Radio 20 MHz</th>
<th>802.11b/g/n Backhaul Radio 40 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAP</td>
<td>20</td>
<td>35</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>MAP1 (First Hop)</td>
<td>10</td>
<td>20</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>MAP2 (Second Hop)</td>
<td>8</td>
<td>15</td>
<td>10</td>
<td>15</td>
</tr>
</tbody>
</table>

While making a call, observe the MOS score of the call on the 7921 phone (see the table below). A MOS score between 3.5 and 4 is acceptable.

**Table 39: MOS Ratings**

<table>
<thead>
<tr>
<th>MOS rating</th>
<th>User satisfaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 4.3</td>
<td>Very satisfied</td>
</tr>
<tr>
<td>4.0</td>
<td>Satisfied</td>
</tr>
</tbody>
</table>
### MOS rating vs. User satisfaction

<table>
<thead>
<tr>
<th>MOS rating</th>
<th>User satisfaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.6</td>
<td>Some users dissatisfied</td>
</tr>
<tr>
<td>3.1</td>
<td>Many users dissatisfied</td>
</tr>
<tr>
<td>&lt; 2.58</td>
<td>-</td>
</tr>
</tbody>
</table>

### Viewing the Voice Details for Mesh Networks (CLI)

Use the commands in this section to view details on voice and video calls on the mesh network:

#### Note

See the figure below when using the CLI commands and viewing their output.

#### Figure 78: Mesh Network Example

- To view the total number of voice calls and the bandwidth used for voice calls on each RAP, enter this command:

  `show mesh cac summary`
Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>BW Used/Max</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
<td>0</td>
</tr>
</tbody>
</table>

• To view the mesh tree topology for the network and the bandwidth utilization (used/maximum available) of voice calls and video links for each mesh access point and radio, enter this command:

   `show mesh cac bwused {voice | video} AP_name`

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>BW Used/Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>1016/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>3048/23437</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>3048/23437</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0</td>
<td>11b/g</td>
<td>2032/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>3048/23437</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
</tr>
</tbody>
</table>

**Note**

The bars (|) to the left of the AP Name field indicate the number of hops that the MAP is from its RAP.

**Note**

When the radio type is the same, the backhaul bandwidth utilization (bw used/max) at each hop is identical. For example, mesh access points `map1`, `map2`, `map3`, and `rap1` are all on the same radio backhaul (802.11a) and are using the same bandwidth (3048). All of the calls are in the same interference domain. A call placed anywhere in that domain affects the others.

• To view the mesh tree topology for the network and display the number of voice calls that are in progress by mesh access point radio, enter this command:

   `show mesh cac access AP_name`

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0</td>
<td>11b/g</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
</tbody>
</table>
Each call received by a mesh access point radio causes the appropriate calls summary column to increment by one. For example, if a call is received on the 802.11b/g radio on map2, then a value of one is added to the existing value in that radio’s calls column. In this case, the new call is the only active call on the 802.11b/g radio of map2. If one call is active when a new call is received, the resulting value is two.

To view the mesh tree topology for the network and display the voice calls that are in progress, enter this command:

```
show mesh cac callpath AP_name
```

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
</tbody>
</table>

To view the mesh tree topology of the network, the voice calls that are rejected at the mesh access point radio due to insufficient bandwidth, and the corresponding mesh access point radio where the rejection occurred, enter this command:

```
show mesh cac rejected AP_name
```

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0 1 0</td>
<td>11b/g 1a</td>
<td>0 0</td>
</tr>
</tbody>
</table>

If a call is rejected at the map2 802.11b/g radio, its calls column increments by one.

To view the number of bronze, silver, gold, platinum, and management queues active on the specified access point, enter this command. The peak and average length of each queue are shown as well as the overflow count.
show mesh queue-stats AP_name

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Queue Type</th>
<th>Overflows</th>
<th>Peak length</th>
<th>Average length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silver</td>
<td>0</td>
<td>1</td>
<td>0.000</td>
</tr>
<tr>
<td>Gold</td>
<td>0</td>
<td>4</td>
<td>0.004</td>
</tr>
<tr>
<td>Platinum</td>
<td>0</td>
<td>4</td>
<td>0.001</td>
</tr>
<tr>
<td>Bronze</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
<tr>
<td>Management</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
</tbody>
</table>

Overflows—The total number of packets dropped due to queue overflow.

Peak Length—The peak number of packets waiting in the queue during the defined statistics time interval.

Average Length—The average number of packets waiting in the queue during the defined statistics time interval.

---

**Enabling Mesh Multicast Containment for Video**

You can use the controller CLI to configure three mesh multicast modes to manage video camera broadcasts on all mesh access points. When enabled, these modes reduce unnecessary multicast transmissions within the mesh network and conserve backhaul bandwidth.

Mesh multicast modes determine how bridging-enabled access points MAP and RAP send multicasts among Ethernet LANs within a mesh network. Mesh multicast modes manage non-CAPWAP multicast traffic only. CAPWAP multicast traffic is governed by a different mechanism.

The three mesh multicast modes are as follows:

- **Regular mode**—Data is multicast across the entire mesh network and all its segments by bridging-enabled RAP and MAP.

- **In-only mode**—Multicast packets received from the Ethernet by a MAP are forwarded to the RAP’s Ethernet network. No additional forwarding occurs, which ensures that non-CAPWAP multicasts received by the RAP are not sent back to the MAP Ethernet networks within the mesh network (their point of origin), and MAP to MAP multicasts do not occur because they are filtered out.

> **Note** When an HSRP configuration is in operation on a mesh network, we recommend the In-Out multicast mode be configured.

- **In-out mode**—The RAP and MAP both multicast but in a different manner:
  - In-out mode is the default mode.
  - If multicast packets are received at a MAP over Ethernet, they are sent to the RAP; however, they are not sent to other MAP over Ethernet, and the MAP to MAP packets are filtered out of the multicast.
  - If multicast packets are received at a RAP over Ethernet, they are sent to all the MAPs and their respective Ethernet networks. When the in-out mode is in operation, it is important to properly partition your network to ensure that a multicast sent by one RAP is not received by another RAP on the same Ethernet segment and then sent back into the network.
If 802.11b clients need to receive CAPWAP multicasts, then multicast must be enabled globally on the controller as well as on the mesh network (using the **confignetwork multicast global enable** CLI command). If multicast does not need to extend to 802.11b clients beyond the mesh network, the global multicast parameter should be disabled (using the **confignetwork multicast global disable** command).

---

### Enabling Multicast on a Mesh Network (CLI)

To enable multicast mode on the mesh network to receive multicasts from beyond the mesh networks, enter these commands:

```
confignetworkmulticastglobalenable
configmeshmulticast {regular | in | in-out}
```

To enable multicast mode only the mesh network (multicasts do not need to extend to 802.11b clients beyond the mesh network), enter these commands:

```
confignetworkmulticastglobaldisable
configmeshmulticast {regular | in | in-out}
```

---

**Note**

Multicast for mesh networks cannot be enabled using the controller GUI.

---

### IGMP Snooping

IGMP snooping delivers improved RF usage through selective multicast forwarding and optimizes packet forwarding in voice and video applications.

A mesh access point transmits multicast packets only if a client is associated with the mesh access point that is subscribed to the multicast group. So, when IGMP snooping is enabled, only that multicast traffic relevant to given hosts is forwarded.

To enable IGMP snooping on the controller, enter the following command:

```
configurenetworkmulticastigmpsnoopingenable
```

A client sends an IGMP *join* that travels through the mesh access point to the controller. The controller intercepts the *join* and creates a table entry for the client in the multicast group. The controller then proxies the IGMP *join* through the upstream switch or router.

You can query the status of the IGMP groups on a router by entering the following command:

```
router# showipgmpgroups
```

<table>
<thead>
<tr>
<th>Group Address</th>
<th>Interface</th>
<th>Uptime</th>
<th>Expires</th>
<th>Last Reporter</th>
</tr>
</thead>
<tbody>
<tr>
<td>233.0.0.1</td>
<td>Vlan119</td>
<td>3w1d</td>
<td>00:01:52</td>
<td>10.1.1.130</td>
</tr>
</tbody>
</table>

For Layer 3 roaming, an IGMP query is sent to the client's WLAN. The controller modifies the client's response before forwarding and changes the source IP address to the controller's dynamic interface IP address.
The network hears the controller’s request for the multicast group and forwards the multicast to the new controller.

For more information about video, see the following:

- Video Surveillance over Mesh Deployment Guide:
- Cisco Unified Wireless Network Solution: VideoStream Deployment Guide:

### Locally Significant Certificates for Mesh APs

Until the 7.0 release, mesh APs supported only the Manufactured Installed Certificate (MIC) to authenticate and get authenticated by controllers to join the controller. You might have had to have your own public key infrastructure (PKI) to control CAs, to define policies, to define validity periods, to define restrictions and usages on the certificates that are generated, and get these certificates installed on the APs and controllers. After these customer-generated or locally significant certificates (LSCs) are present on the APs and controllers, the devices start using these LSCs, to join, authenticate, and derive a session key. Cisco supported normal APs from the 5.2 release and later releases and extended the support for mesh APs as well from the 7.0 release.

With the 7.0.116.0 release, the following functionality has been added:

- Graceful fallback to MIC if APs are unable to join the controller with LSC certificates—Local APs try to join a controller with an LSC for the number of times that are configured on the controller (the default value is 3). After these trials, the AP deletes the LSC and tries to join a controller with an MIC.

Mesh APs try to join a controller with an LSC until its lonely timer expires and the AP reboots. The lonely timer is set for 40 minutes. After the reboot, the AP tries to join a controller with an MIC. If the AP is again not able to join a controller with an MIC in 40 minutes, the AP reboots and then tries to join a controller with an LSC.

Note: An LSC in mesh APs is not deleted. An LSC is deleted in mesh APs only when the LSC is disabled on the controller, which causes the APs to reboot.

- Over the air provisioning of MAPs.

### Guidelines and Limitations

- This feature does not remove any preexisting certificates from an AP. It is possible for an AP to have both LSC and MIC certificates.

- After an AP is provisioned with an LSC, it does not read in its MIC certificate on boot-up. A change from an LSC to an MIC will require the AP to reboot. APs do it for a fallback if they cannot be joined with an LSC.

- Provisioning an LSC on an AP does not require an AP to turn off its radios, which is vital for mesh APs, which may get provisioned over-the-air.

- Because mesh APs need a dot1x authentication, a CA and ID certificate is required on the server (in the controller or third-party server depending on the configuration).
• LSC provisioning will be supported only over Ethernet. You have to connect the mesh AP to the controller through Ethernet and get the LSC certificate provisioned. After the LSC becomes the default, an AP can be connected over-the-air to the controller using the LSC certificate.

Differences Between LSCs for Mesh APs and Normal APs

CAPWAP APs use LSC for DTLS setup during a JOIN irrespective of the AP mode. Mesh APs also use the certificate for mesh security, which involves a dot1x authentication with the controller (or an external AAA server), through the parent AP. After the mesh APs are provisioned with an LSC, they need to use the LSC for this purpose because MIC will not be read in.

Mesh APs use a statically configured dot1x profile to authenticate.

This profile is hardcoded to use "cisco" as the certificate issuer. This profile needs to be made configurable so that vendor certificates can be used for mesh authentication (enter the `config local-auth eap-profile cert-issuer vendor "prfMaP1500LIEAuth93"` command).

You must enter the `config mesh lsc enable/disable` command to enable or disable an LSC for mesh APs. This command will cause all the mesh APs to reboot.

Note

An LSC on mesh is open for very specific Oil and Gas customers with the 7.0 release. Initially, it is a hidden feature. The `config mesh lsc enable/disable` is a hidden command. Also, the `config local-auth eap-profile cert-issuer vendor "prfMaP1500LIEAuth93"` command is a normal command, but the "prfMaP1500LIEAuth93" profile is a hidden profile, and is not stored on the controller and is lost after the controller reboot.

Certificate Verification Process in LSC AP

LSC-provisioned APs have both LSC and MIC certificates, but the LSC certificate will be the default one. The verification process consists of the following two steps:

Step 1  The controller sends the AP the MIC device certificate, which the AP verifies with the MIC CA.
Step 2  The AP sends the LSC device certificate to the controller, which the controller verifies with the LSC CA.

Configuring an LSC (CLI)

Step 1  Enable LSC and provision the LSC CA certificate in the controller.
Step 2  Enter this command:
`config local-auth eap-profile cert-issuer vendor prfMaP1500LIEAuth93`
Step 3  Turn on the feature by entering the following command:
`config mesh lsc {enable | disable}`
Step 4: Install the CA and ID cert on the controller (or any other authentication server) from the same certificate server.

Step 5: Connect the mesh AP through Ethernet and provision for an LSC certificate.

Step 6: Allow the mesh AP get a certificate and join the controller using the LSC certificate.

**Figure 79: Local Significant Certificate**

![Local Significant Certificate](image)

**Figure 80: AP Policy Configuration**

![AP Policy Configuration](image)
LSC-Related Commands

The following commands are related to LSCs:

• **config certificate lsc** {enable | disable}
  * **enable**—To enable an LSC on the system.
  * **disable**—To disable an LSC on the system. Use this keyword to remove the LSC device certificate and send a message to an AP, to do the same and disable an LSC, so that subsequent joins could be made using the MIC/SSC. The removal of the LSC CA cert on the WLC should be done explicitly by using the CLI to accommodate any AP that has not transitioned back to the MIC/SSC.

• **config certificate lsc ca-server** URL-Path
  This command configures the URL to the CA server for getting the certificates. The URL contains either the domain name or the IP address, port number (typically=80), and the CGI-PATH. The following format is an example:
  
  `http://ipaddr:port/cgi-path`

  Only one CA server is allowed to be configured. The CA server has to be configured to provision an LSC.

• **config certificate lsc ca-server delete**
  This command deletes the CA server configured on the WLC.

• **config certificate lsc ca-cert** {add | delete}
  This command adds or deletes the LSC CA certificate into/from the WLC's CA certificate database as follows:
  * **add**—Queries the configured CA server for a CA certificate using the SSCEP getca operation, and gets into the WLC and installs it permanently into the WLC database. If installed, this CA certificate is used to validate the incoming LSC device certificate from the AP.
  * **delete**—Deletes the LSC CA certificate from the WLC database.

• **config certificate lsc subject-params** Country State City Orgn Dept Email
  This command configures the parameters for the device certificate that will be created and installed on the controller and the AP.

  All of these strings have 64 bytes, except for the Country that has a maximum of 3 bytes. The Common Name will be autogenerated using its Ethernet MAC address. This should be given prior to the creation of the controller device certificate request.

  The above parameters are sent as an LWAPP payload to the AP, so that the AP can use these parameters to generate the certReq. The CN is autogenerated on the AP using the current MIC/SSC "Cxxxx-MacAddr" format, where xxxx is the product number.

• **config certificate lsc other-params** keysizes validity
  The keysizes and validity configurations have defaults. Therefore, it is not mandatory to configure them.

  The keysizes can be from 360 to 2048 (the default is 2048 bits).

  The validity period can be configured from 1 to 20 years (the default is 10 years).

• **config certificate lsc ap-provision** {enable | disable}
This command enables or disables the provisioning of the LSCs on the APs if the APs just joined using the SSC/MIC. If enabled, all APs that join and do not have the LSC will get provisioned. If disabled, no more automatic provisioning will be done. This command does not affect the APs, which already have LSCs in them.

- **config certificate lsc ra-cert {add | delete}**
  This command is recommended when the CA server is a Cisco IOS CA server. The WLC can use the RA to encrypt the certificate requests and make communication more secure. RA certificates are not currently supported by other external CA servers, such as MSFT.
  - **add**—Queries the configured CA server for an RA certificate using the SCEP operation and installs it into the WLC Database. This keyword is used to get the certReq signed by the CA.
  - **delete**—Deletes the LSC RA certificate from the WLC database.

- **config auth-list ap-policy lsc {enable | disable}**
  After getting the LSC, an AP tries to join the WLC. Before the AP tries to join the WLC, this command must be executed on the WLC console. Execution of this command is mandatory. By default, the **config auth-list ap-policy lsc** command is in the disabled state, and in the disabled state, the APs are not allowed to join the WLC using the LSC.

- **config auth-list ap-policy mic {enable | disable}**
  After getting the MIC, an AP tries to join the WLC. Before the AP tries to join the WLC, this command must be executed on the WLC console. Execution of this command is mandatory. By default, the **config auth-list ap-policy mic** command is in the enabled state. If an AP cannot join because of the enabled state, this log message in the WLC side is displayed: LSC/MIC AP is not allowed to join by config.

### Controller CLI show Commands

The following are the WLC **show** commands:

- **show certificate lsc summary**
  This command displays the LSC certificates installed on the WLC. It would be the CA certificate, device certificate, and optionally, an RA certificate if the RA certificate has also been installed. It also indicates if an LSC is enabled or not.

- **show certificate lsc ap-provision**
  This command displays the status of the provisioning of the AP, whether it is enabled or disabled, and whether a provision list is present or not.

- **show certificate lsc ap-provision details**
  This command displays the list of MAC addresses present in the AP provisioning lists.

### Controller GUI Security Settings

Although the settings are not directly related to the feature, it may help you in achieving the desired behavior with respect to APs provisioned with an LSC.
The figure below shows three possible cases for mesh AP MAC authorization and EAP.

*Figure 81: Possible Cases for Mesh AP MAC Authorization and EAP*

- **Case 1** — Local MAC Authorization and Local EAP Authentication
  Add the MAC address of RAP/MAP to the controller MAC filter list.
  Example:

  ```
  (Cisco Controller) > config macfilter mac-delimiter colon
  (Cisco Controller) > config macfilter add 00:0b:85:60:92:30 management
  ```

- **Case 2** — External MAC Authorization and Local EAP authentication
  Enter the following command on the WLC:

  ```
  (Cisco Controller) > config mesh security rad-mac-filter enable
  ```

  or

  Check only the external MAC filter authorization on the GUI page and follow these guidelines:
  - Do not add the MAC address of the RAP/MAP to the controller MAC filter list.
  - Configure the external radius server details on the WLC.
  - Enter the `config macfilter mac-delimiter colon` command configuration on the WLC.
  - Add the MAC address of the RAP/MAP in the external radius server in the following format:
    

- **Case 3** — External EAP authentication
Configure the external radius server details on the WLC and apply the following configuration on the controller:

(Cisco Controller) > config mesh radius-server index enable
(Cisco Controller) > config mesh security force-ext-auth enable

Add the userID and password on the AAA server in the ('<platform name string>'<Ethernet mac address hex string>') format for EAP Authentication.

If it is a Cisco IOS AP, it should be in the following format:
username: c1240-112233445566 and password: c1240-112233445566 for 1240 platform APs
username: c1520-112233445566 and password: c1520-112233445566 for 1520 platform APs

For 1510 VxWorks-based AP, it should be in the following format:
username: 112233445566 and password: 112233445566

Deployment Guidelines

• When using local authorization, the controller should be installed with the vendor's CA and device certificate.
• When using an external AAA server, the controller should be installed with the vendor’s CA and device certificate.
• Mesh security should be configured to use ‘vendor’ as the cert-issuer.
• MAPs cannot move from an LSC to an MIC when they fall back to a backup controller.
• The config mesh lsc {enable | disable} command is required to enable or disable an LSC for mesh APs. This command causes all the mesh APs to reboot. Currently, disabling this command may also reboot nonmesh APs.

Slot Bias Options

Information About Slot Bias Options

When a 1524SB AP is switched on, either slot 1 or slot 2 can be used for an uplink depending on the strength of the signal. AWPP treats both slots equally. For a MAP, slot 2 is the preferred (biased) uplink slot, that is, the slot that is used to connect to the parent AP. Slot 1 is the preferred downlink slot. When both radio slots are available for use and if slot 1 is used for an uplink backhaul, a 15-minute timer is started. At the end of 15 minutes, the AP scans for a channel in slot 2 so that slot 2 might be used for an uplink backhaul again. This process is called slot bias.

We recommend that you use a directional antenna on slot 2 for a proper linear functionality. We also recommend that you ensure that slot 2 is selected for a strong uplink. However, there may be some scenarios where directional antennas are used on both the backhaul radios for mobility. When the AP is powered on, the parent can be selected in either direction. If slot 1 is selected, the AP should not go to the scanning mode after 15 minutes, that is, you should disable the slot bias.
Disabling Slot Bias

You can use the `config mesh slot-bias disable` to disable slot bias so that the APs can be stable on slot 1.

To disable slot bias, enter the following command:

```
(Cisco Controller) > config mesh slot-bias disable
```

Note: The slot bias is enabled by default.

Guidelines and Limitations

- The `config mesh slot-bias disable` command is a global command and is applicable to all 1524SB APs associated with the same controller.
- Slot bias is applicable only when both slot 1 and slot 2 are usable. If a slot radio does not have a channel that is available because of dynamic frequency selection (DFS), the other slot takes up both the uplink and downlink roles.
- If slot 2 is not available because of hardware issues, slot bias functions normally. Take corrective action by disabling the slot bias or fixing the antenna.
- A 15-minute timer is initiated (slot bias) only when slot 1 and slot 2 are usable (have channels to operate).
- The 15-minute timer is not initiated if slot 2 cannot find any channels because of DFS, which results in slot 1 taking over the uplink and the downlink.
- Slot 2 takes over slot 1 if slot 1 does not have any channels to operate because of DFS.
- If slot 2 has a hardware failure, then slot bias is initiated, and slot 1 is selected for uplinking.
- Disabling slot bias enables you to take preventive action for a smooth operation.

Commands Related to Slot Bias

The following commands related to slot bias:

- To see which slot is being used for an uplink or a downlink, enter the following command:

```
(Cisco Controller) > show mesh config
```

```
Mesh Range......................... 12000
Mesh Statistics update period........ 3 minutes
Backhaul with client access status...... enabled
Backhaul with extended client access status...... disabled
Background Scanning State................ enabled
Backhaul Amsdu State................ enabled
Mesh Security
  Security Mode.............................. EAP
  External-Auth............................ disabled
  Use MAC Filter in External AAA server... disabled
  Force External Authentication............ disabled
Mesh Alarm Criteria
  Max Hop Count.......................... 4
  Recommended Max Children for MAP....... 10
  Recommended Max Children for RAP....... 20
```
To verify that slot 1 is being used for an uplink, do the following:

Enable debugging on the AP by entering the following command in the controller:

```plaintext
(Cisco Controller) > debug ap enable AP_name
```

Enter the following commands in the controller:

```plaintext
(Cisco Controller) > debug ap command show mesh config AP_name
(Cisco Controller) > debug ap command show mesh adjacency parent AP_name
```

**Preferred Parent Selection**

You can configure a preferred parent for a MAP. This feature gives more control to you and enables you to enforce a linear topology in a mesh environment. You can skip AWPP and force a parent to go to a preferred parent.

**Guidelines and Limitations**

The child AP selects the preferred parent based on the following criteria:

- The preferred parent is the best parent.
- The preferred parent has a link SNR of at least 20 dB (other parents, however good, are ignored).
- The preferred parent has a link SNR in the range of 12 dB and 20 dB, but no other parent is significantly better (that is, the SNR is more than 20 percent better). For an SNR lower than 12 dB, the configuration is ignored.
- The preferred parent is not blacklisted.
- The preferred parent is not in silent mode because of dynamic frequency selection (DFS).
- The preferred parent is in the same bridge group name (BGN). If the configured preferred parent is not in the same BGN and no other parent is available, the child joins the parent AP using the default BGN.

**Note**

Slot bias and preferred parent selection features are independent of each other. However, with the preferred parent configured, the connection is made to the parent using slot 1 or slot 2, whichever the AP sees first. If slot 1 is selected for the uplink in a MAP, then slot bias occurs. We recommend that you disable slot bias if you already know that slot 1 is going to be selected.
Configuring a Preferred Parent

To configure a preferred parent, enter the following command:

(Cisco Controller) > config mesh parent preferred AP_name MAC

where:

• *AP_name* is the name of the child AP that you have to specify.

• *MAC* is the MAC address of the preferred parent that you have to specify.

**Note** When you configure a preferred parent, ensure that you specify the MAC address of the actual mesh neighbor for the desired parent. This MAC address is the base radio MAC address that has the letter f as the final character. For example, if the base radio MAC address is 00:24:13:0f:92:00, then you must specify 00:24:13:0f:92:0f as the preferred parent. This is the actual MAC address that is used for mesh neighbor relationships.

The following example shows how to configure the preferred parent for the MAP1SB access point, where 00:24:13:0f:92:00 is the preferred parent’s MAC address:

(Cisco Controller) > config mesh parent preferred MAP1SB 00:24:13:0f:92:0f

The following commands are related to preferred parent selection:

• To clear a configured parent, enter the following command:

(Cisco Controller) > config mesh parent preferred AP_name none

• To get information about the AP that is configured as the preferred parent of a child AP, enter the following command:

(Cisco Controller) > show ap config general AP_name

The following example shows how to get the configuration information for the MAP1SB access point, where 00:24:13:0f:92:00 is the MAC address of the preferred parent:

(Cisco Controller) > show ap config general MAP1SB

Cisco AP Identifier........................................ 9
Cisco AP Name.............................................. MAP1SB
Country code............................................. US - United States
Regulatory Domain allowed by Country............ 802.11bg:-A 802.11a:-A
AP Country code....................................... US - United States
AP Regulatory Domain................................. 802.11bg:-A 802.11a:-A
Switch Port Number .................................... 1
MAC Address.............................................. 12:12:12:12:12:12
IP Address Configuration............................. DHCP
IP Address.................................................. 209.165.200.225
IP NetMask.................................................. 255.255.255.224
CAPWAP Path MTU........................................ 1485
Domain......................................................
Name Server................................................
Telnet State.............................................. Disabled
Ssh State.................................................. Disabled
Cisco AP Location...................................... default location
Cisco AP Group Name................................. default-group
Primary Cisco Switch Name.......................... 4404
### Co-Channel Interference

In addition to hidden node interference, co-channel interference can also impact performance. Co-channel interference occurs when adjacent radios on the same channel interfere with the performance of the local mesh network. This interference takes the form of collisions or excessive deferrals by CSMA. In both cases, performance of the mesh network is degraded. With appropriate channel management, co-channel interference on the wireless mesh network can be minimized.

### Viewing Mesh Statistics for a Mesh Access Point

This section describes how to use the controller GUI or CLI to view mesh statistics for specific mesh access points.

**Note**

You can modify the Statistics Timer interval setting on the All APs > Details page of the controller GUI.
Viewing Mesh Statistics for a Mesh Access Point (GUI)

**Step 1**
Choose **Wireless > Access Points > All APs** to open the All APs page.

*Figure 82: All APs Page*
Step 2: To view statistics for a specific mesh access point, hover the mouse over the blue drop-down arrow for the desired mesh access point and choose Statistics. The All APs > AP Name > Statistics page for the selected mesh access point appears.

**Figure 83: All APs > Access Point Name > Statistics Page**

This page shows the role of the mesh access point in the mesh network, the name of the bridge group to which the mesh access point belongs, the backhaul interface on which the access point operates, and the number of the physical switch port. It also displays a variety of mesh statistics for this mesh access point. The table below describes each of the statistics.
### Table 40: Mesh Access Point Statistics

<table>
<thead>
<tr>
<th>Statistics</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mesh Node Stats</strong></td>
<td>Malformed Neighbor Packets</td>
<td>The number of malformed packets received from the neighbor. Examples of malformed packets include malicious floods of traffic such as malformed or short DNS packets and malformed DNS replies.</td>
</tr>
<tr>
<td></td>
<td>Poor Neighbor SNR Reporting</td>
<td>The number of times the signal-to-noise ratio falls below 12 dB on the backhaul link.</td>
</tr>
<tr>
<td></td>
<td>Excluded Packets</td>
<td>The number of packets received from excluded neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Insufficient Memory Reporting</td>
<td>The number of insufficient memory conditions.</td>
</tr>
<tr>
<td></td>
<td>Rx Neighbor Requests</td>
<td>The number of broadcast and unicast requests received from the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Rx Neighbor Responses</td>
<td>The number of responses received from the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Tx Neighbor Requests</td>
<td>The number of unicast and broadcast requests sent to the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Tx Neighbor Responses</td>
<td>The number of responses sent to the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Parent Changes Count</td>
<td>The number of times a mesh access point (child) moves to another parent.</td>
</tr>
<tr>
<td></td>
<td>Neighbor Timeouts Count</td>
<td>The number of neighbor timeouts.</td>
</tr>
<tr>
<td><strong>Queue Stats</strong></td>
<td>Gold Queue</td>
<td>The average and peak number of packets waiting in the gold (video) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Silver Queue</td>
<td>The average and peak number of packets waiting in the silver (best effort) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Platinum Queue</td>
<td>The average and peak number of packets waiting in the platinum (voice) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Bronze Queue</td>
<td>The average and peak number of packets waiting in the bronze (background) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Management Queue</td>
<td>The average and peak number of packets waiting in the management queue during the defined statistics time interval.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Mesh Node Security Stats</strong></td>
<td>Transmitted Packets</td>
<td>The number of packets transmitted during security negotiations by the selected mesh access point.</td>
</tr>
<tr>
<td></td>
<td>Received Packets</td>
<td>The number of packets received during security negotiations by the selected mesh access point.</td>
</tr>
<tr>
<td></td>
<td>Association Request Failures</td>
<td>The number of association request failures that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Association Request Timeouts</td>
<td>The number of association request timeouts that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Association Requests Successful</td>
<td>The number of successful association requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Authentication Request Failures</td>
<td>The number of failed authentication requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Authentication Request Timeouts</td>
<td>The number of authentication request timeouts that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Authentication Requests Successful</td>
<td>The number of successful authentication requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Reassociation Request Failures</td>
<td>The number of failed reassociation requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Reassociation Request Timeouts</td>
<td>The number of reassociation request timeouts between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Reassociation Requests Successful</td>
<td>The number of successful reassociation requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Reauthentication Request Failures</td>
<td>The number of failed reauthentication requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Reauthentication Request Timeouts</td>
<td>The number of reauthentication request timeouts that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Reauthentication Requests Successful</td>
<td>The number of successful reauthentication requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td></td>
<td>Unknown Association Requests</td>
<td>The number of unknown association requests received by the parent mesh access point from its child. The unknown association requests often occur when a child is an unknown neighbor mesh access point.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>invalid association requests</td>
<td>The number of invalid association requests received by the parent mesh access point from the selected child mesh access point. This state may occur when the selected child is a valid neighbor but is not in a state that allows association.</td>
<td></td>
</tr>
<tr>
<td>Mesh Node Security Stats (continued)</td>
<td>Unknown Reauthentication Requests</td>
<td>The number of unknown reauthentication requests received by the parent mesh access point node from its child. This state may occur when a child mesh access point is an unknown neighbor.</td>
</tr>
<tr>
<td>invalid reauthentication requests</td>
<td>The number of invalid reauthentication requests received by the parent mesh access point from a child. This state may occur when a child is a valid neighbor but is not in a proper state for reauthentication.</td>
<td></td>
</tr>
<tr>
<td>unknown reassociation requests</td>
<td>The number of unknown reassociation requests received by the parent mesh access point from a child. This state may occur when a child mesh access point is an unknown neighbor.</td>
<td></td>
</tr>
<tr>
<td>invalid reassociation requests</td>
<td>The number of invalid reassociation requests received by the parent mesh access point from a child. This state may occur when a child is a valid neighbor but is not in a proper state for reassociation.</td>
<td></td>
</tr>
</tbody>
</table>

**Viewing Mesh Statistics for an Mesh Access Point (CLI)**

Use these commands to view mesh statistics for a specific mesh access point using the controller CLI:

- To view packet error statistics, a count of failures, timeouts, and successes with respect to associations and authentications, and reassociations and reauthentications for a specific mesh access point, enter this command:

  ```
  show mesh security-stats AP_name
  ```

  Information similar to the following appears:

  ```
  AP MAC : 00:0B:85:5F:FA:F0
  Packet/Error Statistics:
  14 Packets 14, Rx Packets 19, Rx Error Packets 0
  Parent-Side Statistics:
  Unknown Association Requests 0
  Invalid Association Requests 0
  Unknown Re-Authentication Requests 0
  Invalid Re-Authentication Requests 0
  Unknown Re-Association Requests 0
  Invalid Re-Association Requests 0
  Unknown Re-Association Requests 0
  Invalid Re-Association Requests 0
  ```
Child-Side Statistics:

Association Failures 0
Association Timeouts 0
Association Successes 0
Authentication Failures 0
Authentication Timeouts 0
Authentication Successes 0
Re-Association Failures 0
Re-Association Timeouts 0
Re-Association Successes 0
Re-Authentication Failures 0
Re-Authentication Timeouts 0
Re-Authentication Successes 0

• To view the number of packets in the queue by type, enter this command:

   show mesh queue-stats AP_name

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Queue Type</th>
<th>Overflows</th>
<th>Peak length</th>
<th>Average length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silver</td>
<td>0</td>
<td>1</td>
<td>0.000</td>
</tr>
<tr>
<td>Gold</td>
<td>0</td>
<td>4</td>
<td>0.004</td>
</tr>
<tr>
<td>Platinum</td>
<td>0</td>
<td>4</td>
<td>0.001</td>
</tr>
<tr>
<td>Bronze</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
<tr>
<td>Management</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
</tbody>
</table>

Overflows—The total number of packets dropped due to queue overflow.
Peak Length—The peak number of packets waiting in the queue during the defined statistics time interval.
Average Length—The average number of packets waiting in the queue during the defined statistics time interval.

Viewing Neighbor Statistics for a Mesh Access Point

This section describes how to use the controller GUI or CLI to view neighbor statistics for a selected mesh access point. It also describes how to run a link test between the selected mesh access point and its parent.
Viewing Neighbor Statistics for a Mesh Access Point (GUI)

Step 1  
Choose Wireless > Access Points > All APs to open the All APs page.

*Figure 84: All APs Page*

Step 2  
To view neighbor statistics for a specific mesh access point, hover the mouse over the blue drop-down arrow for the desired mesh access point and choose Neighbor Information. The All APs > Access Point Name > Neighbor Info page for the selected mesh access point appears.

*Figure 85: All APs > Access Point Name > Neighbor Info Page*

This page lists the parent, children, and neighbors of the mesh access point. It provides each mesh access point’s name and radio MAC address.

Step 3  
To perform a link test between the mesh access point and its parent or children, follow these steps:
a) Hover the mouse over the blue drop-down arrow of the parent or desired child and choose **LinkTest**. A pop-up window appears.

*Figure 86: Link Test Page*

b) Click **Submit** to start the link test. The link test results appear on the Mesh > LinkTest Results page.

*Figure 87: Mesh > LinkTest Results Page*
Step 4 To view the details for any of the mesh access points on this page, follow these steps:

a) Hover the mouse over the blue drop-down arrow for the desired mesh access point and choose Details. The All APs > Access Point Name > Link Details > Neighbor Name page appears.

Figure 88: All APs > Access Point Name > Link Details > Neighbor Name page

b) Click Back to return to the All APs > Access Point Name > Neighbor Info page.

Step 5 To view statistics for any of the mesh access points on this page, follow these steps:

a) Hover the mouse over the blue drop-down arrow for the desired mesh access point and choose Stats. The All APs > Access Point Name > Mesh Neighbor Stats page appears.

Figure 89: All APs > Access Point Name > Mesh Neighbor Stats Page

b) Click Back to return to the All APs > Access Point Name > Neighbor Info page.

Viewing the Neighbor Statistics for a Mesh Access Point (CLI)

Use these commands to view neighbor statistics for a specific mesh access point using the controller CLI.

- To view the mesh neighbors for a specific mesh access point, enter this command:

  show mesh neigh {detail | summary} AP_Name

  Information similar to the following appears when you request a summary display:

  AP Name/Radio Mac  Channel Snr-Up Snr-Down Link-Snr Flags State
To view the channel and signal-to-noise ratio (SNR) details for a link between a mesh access point and its neighbor, enter this command:

`show mesh path AP_Name`

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name/Radio Mac</th>
<th>Channel</th>
<th>Snr-Up</th>
<th>Snr-Down</th>
<th>Link-Snr</th>
<th>Flags</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>mesh-45-rap1 165 15 18 16 0x86b</td>
<td>UPDATED NEIGH PARENT BEACON</td>
<td>mesh-45-rap1 is a Root AP.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00:17:94:FE:C3:5F 149 7 0 0 0x860</td>
<td>BEACON</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To view the percentage of packet errors for packets transmitted by the neighbor mesh access point, enter this command:

`show mesh per-stats AP_Name`

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Neighbor MAC Address</th>
<th>Total Packets transmitted:</th>
<th>Total Packets transmitted successfully:</th>
<th>Total Packets retried for transmission:</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:0B:85:5F:FA:F0</td>
<td>104833</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:0B:85:80:ED:D0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:17:94:FE:C3:5F</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Packet error rate percentage = \(1 - \frac{\text{number of successfully transmitted packets}}{\text{number of total packets transmitted}}\).

---

**Converting Indoor Access Points to Mesh Access Points**

**Step 1**
Convert the autonomous access point (k9w7 image) to a lightweight access point.

For information about this process, see this URL:

**Step 2**
Convert the lightweight access point to either a mesh access point (MAP) or root access point (RAP) as follows:

**Note** Indoor mesh access points (1130 and 1240) can function as either a RAP or a MAP. By default, all are configured as MAPs.

To convert the access point to a mesh access point using the controller CLI, perform one of the following:

To convert from a lightweight access point to a MAP, enter this command:

`config ap mode bridge Cisco_AP`
The mesh access point reloads.
To convert from a lightweight access point to a RAP, enter these CLI commands:

\begin{verbatim}
config ap mode bridge Cisco_AP
config ap role rootAP Cisco_AP
\end{verbatim}

The mesh access point reloads and is configured to operate as a RAP.

- To convert the access point to a mesh access point using the GUI, follow these steps:
  1. Choose Wireless and click on the AP Name link for the 1130 or 1240 indoor access point you want to convert.
  2. At the General Properties panel, choose Bridge from the AP Mode drop-down list.
     - The access point reboots.
  3. At the Mesh panel, choose either RootAP or MeshAP from the AP Role drop-down list.
  4. Click Apply to commit your changes.
  5. Click Save Configuration to save your changes.

---

**Changing MAP and RAP Roles for Indoor Mesh Access Points**

Cisco 1130 and 1240 series indoor mesh access points can function as either RAPs or MAPs.

**Changing MAP and RAP Roles for Indoor Mesh Access Points (GUI)**

**Step 1** Choose Wireless > Access Points > All APs to open the All APs page.

**Step 2** Click the name of the 1130 or 1240 series access point that you want to change.

**Step 3** Click the Mesh tab.

**Step 4** From the AP Role drop-down list, choose MeshAP or RootAP to specify this access point as a MAP or RAP, respectively.

**Step 5** Click Apply to commit your changes. The access point reboots.

**Step 6** Click Save Configuration to save your changes.

**Note** We recommend that you use a Fast Ethernet connection between the MAP and controller when changing from a MAP to RAP.

**Note** After a RAP-to-MAP conversion, the MAP's connection to the controller is a wireless backhaul rather than a Fast Ethernet connection. You must ensure that the Fast Ethernet connection of the RAP being converted is disconnected before the MAP starts up so that the MAP can join over the air.

**Note** We recommend that your power source for MAPs is either a power supply or power injector. We do not recommend that you use PoE as a power source for MAPs.
### Changing MAP and RAP Roles for Indoor Mesh Access Points (CLI)

**Step 1**
Change the role of an indoor access point from MAP to RAP or from RAP to MAP by entering this command:
```
config ap role {rootAP | meshAP} Cisco_AP
```
The access point reboots after you change the role.

**Step 2**
Save your changes by entering this command:
```
save config
```

### Converting Indoor Mesh Access Points to Nonmesh Lightweight Access Points (1130AG, 1240AG)

The access point reboots after you enter the conversion commands in the controller CLI or perform the steps on the controller or the Cisco WCS.

**Note**
We recommend that you use a Fast Ethernet connection to the controller for the conversion from a mesh (bridge) to nonmesh (local) access point. If the backhaul is a radio, after the conversion, you must enable Ethernet and then reload the access image.

**Note**
When a root access point is converted back to a lightweight access point, all of its subordinate mesh access points lose connectivity to the controller. A mesh access point is unable to service its clients until the mesh access point is able to connect to a different root access point in the vicinity. Likewise, clients might connect to a different mesh access point in the vicinity to maintain connectivity to the network.

- To convert an indoor mesh access point (MAP or RAP) to a nonmesh lightweight access point using the controller CLI, enter this command.
  ```
  config ap mode local Cisco_AP
  ```
  The access point reloads.

- To convert an indoor mesh access point (MAP or RAP) to a nonmesh lightweight access point using the GUI, follow these steps:
  1. Choose **Wireless** and click on the AP Name link for the 1130 or 1240 indoor access point you want to convert.
  2. At the General Properties panel, choose **Local** from the AP Mode drop-down list.
  3. Click **Apply to apply changes**.
  4. Click **Save Configuration** to save your changes.
To convert an indoor mesh access point (MAP or RAP) to a nonmesh lightweight access point using Cisco WCS, follow these steps:

1. Choose Configure > Access Points and click on the AP Name link for the 1130 or 1240 indoor access point you want to convert.
2. At the General Properties panel, choose Local as the AP Mode (left side).
3. Click Save.

Configuring Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers

Outdoor access points (1522, 1524PS) can interoperate with the Cisco 3200 Series Mobile Access Router (MAR) on the public safety channel (4.9 GHz) as well as the 2.4-GHz access and 5-GHz backhaul.

The Cisco 3200 creates an in-vehicle network in which devices such as PCs, surveillance cameras, digital video recorders, printers, PDAs, and scanners can share wireless networks such as cellular or WLAN-based services back to the main infrastructure. Data that is collected from in-vehicle deployments, such as a police car can be integrated into the overall wireless infrastructure. For specific interoperability details between series 1130, 1240, and 1520 mesh access points and series 3200 mobile access routers, see the table below.

Table 41: Mesh Access Points and MAR 3200 Interoperability

<table>
<thead>
<tr>
<th>Mesh Access Point Model</th>
<th>MAR Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>1522</td>
<td>c3201, c3202, c3205</td>
</tr>
<tr>
<td>1524PS</td>
<td>c3201, c3202</td>
</tr>
<tr>
<td>1130, 1240 configured as indoor mesh access points with universal access</td>
<td>c3201, c3205</td>
</tr>
</tbody>
</table>

15 Universal access must be enabled on the 1522 if connecting to a MAR on the 802.11a radio or 4.9-GHz band.
16 Model c3201 is a MAR with a 802.11b/g radio (2.4 GHz).
17 Model c3202 is a MAR with a 4-9-GHz sub-band radio.
18 Model c3205 is a MAR with a 802.11a radio (5.8-GHz sub-band).

Guidelines and Limitations

• Client access must be enabled on the backhaul (Mesh global parameter).
• Public Safety must be enabled globally on all mesh access points (MAPs) in the mesh network.
• Channel number assignments on the 1522 or 1524PS must match those on the Cisco 3200 radio interfaces:
  • Channels 20 (4950 GHz) through 26 (4980 GHz) and sub-band channels 1 through 19 (5 and 10 MHz) are used for MAR interoperability. This configuration change is made on the controller. No changes are made to the access point configuration.
Channel assignments are made only to the RAP. Updates to the MAP are propagated by the RAP.

The default channel width for MAR 3200s is 5 MHz. You must do one of the following:

- Change the channel width to 10 or 20 MHz to enable WGBs to associate with series 1520 mesh access points.

- Change the channel on the 1522 or 1524PS to a channel in the 5-MHz (channels 1 to 10) or 10-MHz band (channels 11 through 19) as follows:
  - When using the controller CLI, you must disable the 802.11a radio prior to configuring its channels. You reenable the radio after the channels are configured.
  - When using the GUI, enabling and disabling the 802.11a radio for channel configuration is not required.
  - Cisco MAR 3200s can scan channels within but not across the 5-, 10-, or 20-MHz bands.
Enabling Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers (GUI)

Step 1  Enable the backhaul for client access by choosing Wireless > Mesh to open the Mesh page.

Step 2  Select the Backhaul Client Access check box to allow wireless client association over the 802.11a radio.

Step 3  Click Apply to commit your changes.

Step 4  When prompted to allow a reboot of all the mesh access points on the network, click OK.

Step 5  Choose Wireless > Access Points > Radios > 802.11a/n to open the 802.11a/n Radios page.

Step 6  Hover your cursor over the blue drop-down arrow for the appropriate RAP and choose Configure. The 802.11a/n (4.9 GHz) > Configure page appears.

Figure 90: 802.11 a/n (4.9GHz) > Configure Page

Step 7  Under the RF Channel Assignment section, choose the WLC Controlled option for Assignment Method and select a channel between 1 and 26.

Step 8  Click Apply to commit your changes.

Step 9  Click Save Configuration to save your changes.
Enabling Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers (CLI)

Step 1
Enable client access mode on the 1522 and 1524PS mesh access points by entering this command:
```
config mesh client-access enable
```

Step 2
Enable public safety on a global basis by entering this command:
```
config mesh public-safety enable all
```

Step 3
Enable the public safety channels by entering these commands:
- For the 1522 access point, enter these commands:
  ```
  config 802.11a disable Cisco_MAP
  config 802.11a channel ap Cisco_MAP channel_number
  config 802.11a enable Cisco_MAP
  ```
- For the 1524PS, enter these commands:
  ```
  config 802.11–a49 disable Cisco_MAP
  config 802.11–a49 channel ap Cisco_MAP channel_number
  config 802.11–a49 enable Cisco_MAP
  ```

Note: Enter the `config 802.11–a58 enable Cisco_MAP` command to enable a 5-GHz radio.

Note: For both the 1522 and 1524PS mesh access points, valid values for the channel number is 1 through 26.

Step 4
Save your changes by entering this command:
```
save config
```

Step 5
Verify your configuration by entering these commands:
```
show mesh public-safety
show mesh client-access
show ap config 802.11a summary (for 1522 access points only)
show ap config 802.11–a49 summary (for 1524PS access points only)
```

Note: Enter the `show config 802.11–a58 summary` command to view configuration details for a 5-GHz radio.
Enabling Mesh Access Points to Operate with Cisco 3200 Series Mobile Access Routers (CLI)
Managing Controller Software and Configurations

This chapter describes how to manage configurations and software versions on the controllers.

- Upgrading the Controller Software, page 645
- Transferring Files to and from a Controller, page 658
- Saving Configurations, page 673
- Editing Configuration Files, page 673
- Clearing the Controller Configuration, page 674
- Erasing the Controller Configuration, page 674
- Resetting the Controller, page 675

Upgrading the Controller Software

When you upgrade the controller software, the software on the access points associated with the controller is also automatically upgraded. When an access point is loading software, each of its LEDs blinks in succession. Up to 10 access points can be concurrently upgraded from the controller.

---

**Caution**

Do not power down the controller or any access point during this process; otherwise, you might corrupt the software image. Upgrading a controller with a large number of access points can take as long as 30 minutes, depending on the size of your network. However, with the increased number of concurrent access point upgrades supported in the controller software release, the upgrade time should be significantly reduced. The access points must remain powered, and the controller must not be reset during this time.
Restrictions for Upgrading Controller Software

- If you require a downgrade from one release to another, you might lose the configuration from your current release. The workaround is to reload the previous controller configuration files saved on the backup server or to reconfigure the controller.

- It is not possible to directly upgrade to this release from a release that is older than 6.0.182.0.

- You can upgrade or downgrade the controller software only between certain releases. In some instances, you must first install an intermediate release prior to upgrading to the latest software release.

- When you upgrade the controller to an intermediate software release, you must wait until all of the access points that are associated with the controller are upgraded to the intermediate release before you install the latest controller software. In large networks, it can take some time to download the software on each access point.

- When you upgrade to the latest software release, the software on the access points associated with the controller is also automatically upgraded. When an access point is loading software, each of its LEDs blinks in succession.

- We recommend that you access the controller GUI using Microsoft Internet Explorer 6.0 SP1 (or a later release) or Mozilla Firefox 2.0.0.11 (or a later release).

- Cisco controllers support standard SNMP Management Information Base (MIB) files. MIBs can be downloaded from the Software Center on Cisco.com.

- The controller software is factory installed on your controller and automatically downloaded to the access points after a release upgrade and whenever an access point joins a controller. We recommend that you install the latest software version available for maximum operational benefit.

- We recommend that you install Wireless LAN Controller Field Upgrade Software for Release 1.7.0.0-FUS, which is a special AES package that contains several system-related component upgrades. These include the bootloader, field recovery image, and FPGA/MCU firmware. Installing the FUS image requires special attention because it installs some critical firmware. The FUS image is independent of the runtime image. For more information, see http://www.cisco.com/c/en/us/td/docs/wireless/controller/release/notes/fus_rn_1_7_0_0.html.

- Ensure that you have a TFTP or FTP server available for the software upgrade. Follow these guidelines when setting up a TFTP or FTP server:
  - Ensure that your TFTP server supports files that are larger than the size of the controller software release. Some TFTP servers that support files of this size are tftpd32 and the TFTP server within the Cisco Prime Infrastructure. If you attempt to download the controller software and your TFTP server does not support files of this size, the following error message appears: "TFTP failure while storing in flash."
  - If you are upgrading through the distribution system network port, the TFTP or FTP server can be on the same or a different subnet because the distribution system port is routable.

- When you plug a controller into an AC power source, the bootup script and power-on self-test run to initialize the system. During this time, you can press Esc to display the bootloader Boot Options Menu. The menu options for the 5500 and Flex 7500 series controllers are different than for other controller platforms.
Bootloader menu for 5500 Series Controllers:
Boot Options
Please choose an option from below:
1. Run primary image
2. Run backup image
3. Change active boot image
4. Clear Configuration
5. Format FLASH Drive
6. Manually update images
Please enter your choice:

Bootloader menu for other controller platforms:
Boot Options
Please choose an option from below:
1. Run primary image
2. Run backup image
3. Manually update images
4. Change active boot image
5. Clear Configuration
Please enter your choice:

Enter 1 to run the current software, enter 2 to run the previous software, enter 4 (on a 5500 series controller), or enter 5 (on another controller platform) to run the current software and set the controller configuration to factory defaults. Do not choose the other options unless directed to do so.

---

Note
See the Installation Guide or the Quick Start Guide for your controller for more details on running the bootup script and power-on self-test.

---

• Control which address(es) are sent in CAPWAP discovery responses when NAT is enabled on the Management Interface using the following command:

```
config network ap-discovery nat-ip-only {enable | disable}
```

where

- **enable**—Enables use of NAT IP only in Discovery response. This is the default. Use this command if all APs are outside of the NAT gateway.

- **disable**—Enables use of both NAT IP and non-NAT IP in discovery response. Use this command if APs are on the inside and outside of the NAT gateway; for example, Local Mode and OfficeExtend APs on the same controller.

---

Note
To avoid stranding APs, you must disable AP link-latency (if enabled) before you use the disable option for the `config network ap-discovery nat-ip-only` command. To disable AP link-latency, use the `config ap link-latency disable all` command.

---

• You can configure 802.1p tagging by using the `config qos dot1p-tag {bronze | silver | gold | platinum}` tag. For the 7.2.103.0 and later releases, if you tag 802.1p packets, the tagging has impact only on wired packets. Wireless packets are impacted only by the maximum priority level set for QoS.

• You can reduce the network downtime using the following options:

  • You can predownload the AP image.

  • For FlexConnect access points, use the FlexConnect Efficient AP upgrade feature to reduce traffic between the controller and the AP (main site and the branch).
• Do not power down the controller or any access point during the upgrade process; otherwise, you might corrupt the software image. Upgrading a controller with a large number of access points can take as long as 30 minutes, depending on the size of your network. However, with the increased number of concurrent access point upgrades supported, the upgrade time should be significantly reduced. The access points must remain powered, and the controller must not be reset during this time.

• If you want to downgrade to a previous release, do either of the following:
  • Delete all WLANs that are mapped to interface groups and create new ones.
  • Ensure that all WLANs are mapped to interfaces rather than interface groups.

• After you perform these functions on the controller, you must reboot the controller for the changes to take effect:
  • Enable or disable link aggregation (LAG)
  • Enable a feature that is dependent on certificates (such as HTTPS and web authentication)
  • Add new or modify existing SNMP v3 users
  • Modify an existing SNMP v3 engine ID
  • Add a new license or modify an existing license
  • Increase the priority for a license

• The controller bootloader stores a copy of the active primary image and the backup image. If the primary image becomes corrupted, you can use the bootloader to boot with the backup image.

With the backup image stored before rebooting, be sure to choose **Option 2: Run Backup Image** from the boot menu to boot from the backup image. Then, upgrade with a known working image and reboot the controller.

• The recovery image provides a backup image that can be used if an access point power-cycles during an image upgrade. The best way to avoid the need for access point recovery is to prevent an access point from power-cycling during a system upgrade. If a power-cycle occurs during an upgrade to an oversized access point image, you can recover the access point using the TFTP recovery procedure.

To recover the access point using the TFTP recovery procedure, follow these steps:

1. Download the required recovery image from Cisco.com (c1100-rcvk9w8-mx, c1200-rcvk9w8-mx, or c1310-rcvk9w8-mx) and install it in the root directory of your TFTP server.

2. Connect the TFTP server to the same subnet as the target access point and power-cycle the access point. The access point boots from the TFTP image and then joins the controller to download the oversized access point image and complete the upgrade procedure.

3. After the access point has been recovered, you can remove the TFTP server.

• You can upgrade to a new release of the controller software or downgrade to an older release even if Federal Information Processing Standard (FIPS) is enabled.

• If you upgrade from a release that is prior to Release 7.5 directly to Release 7.6.X or a later release, the predownload process on Cisco AP2600 and AP3600 fails. After the Cisco WLC is upgraded to Release 7.6.X or a later release, the new image is loaded on Cisco AP2600 and AP3600. After the upgrade to a Release 7.6.X image, the predownload functionality works as expected. The predownload failure is only a one-time failure.
Upgrading Controller Software (GUI)

Step 1
Upload your controller configuration files to a server to back them up.

Note: We highly recommend that you back up your configuration files of the controller prior to upgrading the controller software. Otherwise, you must manually reconfigure the controller.

Step 2
Get the controller software image by following these steps:

b) Choose Wireless > Wireless LAN Controller.
   The following options are available: Integrated Controllers and Controller Modules and Standalone Controllers.
c) Depending on your controller platform, click one of the above options.
d) Click the controller model number or name. The Download Software page is displayed.
e) Click a controller software release. The software releases are labeled as follows to help you determine which release to download:
   - Early Deployment (ED)—These software releases provide new features, new hardware platform support, and bug fixes.
   - Maintenance Deployment (MD)—These software releases provide bug fixes and ongoing software maintenance.
   - Deferred (DF)—These software releases have been deferred. We recommend that you migrate to an upgraded release.
f) Choose a software release number.
g) Click the filename (filename.aes).
h) Click Download.
i) Read Cisco’s End User Software License Agreement and then click Agree.
j) Save the file to your hard drive.
k) Repeat steps a through k to download the remaining file.

Step 3
Copy the controller software image (filename.aes) to the default directory on your TFTP or FTP server.

Step 4
(Optional) Disable the 802.11 networks.

Note: For busy networks, controllers on high utilization, or small controller platforms, we recommend that you disable the 802.11 networks as a precautionary measure.

Step 5
Disable any WLANs on the controller.

Step 6
Choose Commands > Download File to open the Download File to Controller page.

Step 7
From the File Type drop-down list, choose Code.

Step 8
From the Transfer Mode drop-down list, choose from the following options:

- TFTP
- FTP
- HTTP (available in 8.1 and later releases)

Step 9
In the IP Address text box, enter the IP address of the server.
If you are using a TFTP server, the default values of 10 retries and 6 seconds for the Maximum Retries and Timeout text boxes should work correctly without any adjustment. However, you can change these values.

Step 10
If you are using a TFTP server, the default values of 10 retries for the Maximum Retries text field, and 6 seconds for the Timeout text field should work correctly without any adjustment. However, you can change these values if desired.
do so, enter the maximum number of times that the TFTP server attempts to download the software in the **Maximum Retries** text box and the amount of time (in seconds) that the TFTP server attempts to download the software in the **Timeout** text box.

**Step 11**  
In the **File Path** text box, enter the directory path of the software.

**Step 12**  
In the **File Name** text box, enter the name of the controller software file (*filename*.aes).

**Step 13**  
If you are using an FTP server, follow these steps:

a) In the **Server Login Username** text box, enter the username to log into the FTP server.

b) In the **Server Login Password** text box, enter the password to log into the FTP server.

c) In the **Server Port Number** text box, enter the port number on the FTP server through which the download occurs. The default value is 21.

**Step 14**  
Click **Download** to download the software to the controller. A message appears indicating the status of the download.

**Step 15**  
After the download is complete, click **Reboot**.

**Step 16**  
If prompted to save your changes, click **Save and Reboot**.

**Step 17**  
Click **OK** to confirm.

**Step 18**  
After the controller reboots, repeat step 6 to step 17 to install the remaining file.

**Step 19**  
Reenable the WLANs.

**Step 20**  
For Cisco WiSM2, reenable the controller port channel on the Catalyst switch.

**Step 21**  
If you have disabled the 802.11 networks in Step 4, reenable them.

**Step 22**  
To verify the controller software version, choose **Monitor** on the controller GUI and see **Software Version** in the Controller Summary area.

---

**Upgrading Controller Software (CLI)**

**Step 1**  
Upload your controller configuration files to a server to back them up.  
**Note** We highly recommend that you back up your controller's configuration files prior to upgrading the controller software. Otherwise, you must manually reconfigure the controller.

**Step 2**  
Get the controller software image by following these steps:


b) Choose **Wireless** > **Wireless LAN Controller**.  
The following options are available: Integrated Controllers and Controller Modules and Standalone Controllers.

c) Depending on your controller platform, click one of the above options.

d) Click the controller model number or name. The Download Software page is displayed.

e) Click a controller software release. The software releases are labeled as follows to help you determine which release to download:

**Early Deployment (ED)**—These software releases provide new features, new hardware platform support, and bug fixes.

**Maintenance Deployment (MD)**—These software releases provide bug fixes and ongoing software maintenance.

**Deferred (DF)**—These software releases have been deferred. We recommend that you migrate to an upgraded release.
f) Choose a software release number.
g) Click the filename (filename.aes).
h) Click **Download**.
i) Read Cisco’s End User Software License Agreement and then click **Agree**.
j) Save the file to your hard drive.
k) Repeat steps a through k to download the remaining file.

**Step 3**
Copy the controller software image (filename.aes) to the default directory on your TFTP or FTP server.

**Step 4**
(Optional) Disable the 802.11 networks.

**Note**
For busy networks, controllers on high utilization, or small controller platforms, we recommend that you disable the 802.11 networks as a precautionary measure.

**Step 5**
Disable any WLANs on the controller (using the `config wlan disable wlan_id` command).

**Step 6**
Log onto the controller CLI.

**Step 7**
Enter the `ping server-ip-address` command to verify that the controller can contact the TFTP or FTP server.

**Step 8**
View current download settings by entering the `transfer download start` command. Answer `n` to the prompt to view the current download settings.

**Step 9**
Change the download settings, if necessary by entering these commands:

- `transfer download mode {tftp | ftp}`
- `transfer download datatype code`
- `transfer download serverip server-ip-address`
- `transfer download filename filename`
- `transfer download path server-path-to-file`

**Note**
Pathnames on a TFTP or FTP server are relative to the server’s default or root directory. For example, in the case of the Solaris TFTP server, the path is "/".

If you are using a TFTP server, also enter these commands:

- `transfer download tftpMaxRetries retries`
- `transfer download tftpPktTimeout timeout`

**Note**
The default values of 10 retries and a 6-second timeout should work correctly without any adjustment. However, you can change these values. To do so, enter the maximum number of times that the TFTP server attempts to download the software for the `retries` parameter and the amount of time (in seconds) that the TFTP server attempts to download the software for the `timeout` parameter.

If you are using an FTP server, also enter these commands:

- `transfer download username username`
- `transfer download password password`
- `transfer download port port`

**Note**
The default value for the port parameter is 21.
Step 10  View the current updated settings by entering the transfer download start command. Answer y to the prompt to confirm the current download settings and start the software download.

Step 11  Save the code update to nonvolatile NVRAM and reboot the controller by entering this command: 
**reset system**

The controller completes the bootup process.

Step 12  After the controller reboots, repeat Steps 6 through 11 to install the remaining file.

Step 13  Reenable the WLANs by entering this command:
**config wlan enable wlan_id**

Step 14  For Cisco WiSMs, re-enable the controller port channel on the Catalyst switch.

Step 15  If you have disabled the 802.11 networks in Step 4, re-enable them.

Step 16  To verify the controller software that is installed, enter the **show sysinfo** command and see Product Version.

Step 17  To verify the Cisco Unified Wireless Network Controller Boot Software file that is installed on the controller, enter the **show sysinfo** command on the controller CLI and see Recovery Image Version or Emergency Image Version.

**Note**  If a Cisco Unified Wireless Network Controller Boot Software ER.aes file is not installed, Recovery Image Version or Emergency Image Version show 'N/A.'

---

**Predownloading an Image to an Access Point**

To minimize network outages, you can download an upgrade image to the access point from the Cisco WLC without resetting the access point or losing network connectivity. Previously, you would download an upgrade image to the controller and reset it, which causes the access point to go into discovery mode. After the access point discovers the Cisco WLC with the new image, the access point downloads the new image, resets, goes into discovery mode, and rejoins the Cisco WLC.

You can now download the upgrade image to the Cisco WLC and then download the image to the access point while the network is still operational. You can also schedule a reboot of the Cisco WLC and access points, either after a specified amount of time or at a specific date and time. When both devices are up, the access point discovers and rejoins the Cisco WLC.

**Flash Memory Requirements on Access Points**

This table lists the Cisco AP models and the minimum amount of free flash memory required for the predownload process to work:

<table>
<thead>
<tr>
<th>Cisco AP</th>
<th>Minimum Free Flash Memory Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>3502(I/E)</td>
<td>14 MB</td>
</tr>
<tr>
<td>2602(I/E)</td>
<td>14 MB</td>
</tr>
<tr>
<td>1602(I/E)</td>
<td>12 MB</td>
</tr>
<tr>
<td>1262</td>
<td>14 MB</td>
</tr>
<tr>
<td>1142</td>
<td>12 MB</td>
</tr>
</tbody>
</table>
Note

- The required flash memory can vary based on the radio type and the number of antennas used.
- This predownload feature is not supported on 1242 and 1131 Cisco AP models.
- Cisco AP1142 has 32 MB of total flash memory and can support the predownload feature.

Access Point Predownload Process

The access point predownload feature works as follows:

- The controller image is downloaded.
  - The primary image becomes the backup image of the controller and the downloaded image becomes the new primary image. Change the current boot image as the backup image by using the `config boot backup` command to ensure that if a system failure occurs, the controller boots with the last working image of the controller.
  - To switch over to the new downloaded image, start predownload of the upgraded image using the `config ap image predownload primary all` command.
  - The upgrade image is downloaded as the backup image on the access points. You can verify this by using the `show ap image all` command.
  - Change the boot image to primary image manually using the `config boot primary` command and reboot the controller for the upgrade image to be activated.
  - You issue a scheduled reboot with the `swap` keyword. The `swap` keyword has the following importance: The swapping occurs to the primary and backup images on the access point and the currently active image on controller with the backup image.
  - When the controller reboots, the access points are disassociated and eventually come up with an upgraded image. Once the controller responds to the discovery request sent by an access point with its discovery response packet, the access point sends a join request.
- The actual upgrade of the images occur. The following sequence of actions occur:
  - During boot time, the access point sends a join request.
  - The controller responds with the join response with the image version that the controller is running.
  - The access point compares its running image with the running image on the controller. If the versions match, the access point joins the controller.
  - If the versions do not match, the access point compares the version of the backup image and if they match, the access point swaps the primary and backup images and reloads and subsequently joins the controller.
  - If the primary image of the access point is the same as the controller image, the access point reloads and joins the controller.
  - If none of the above conditions are true, the access point sends an image data request to the controller, downloads the latest image, reloads, and joins the controller.
Restrictions for Predownloading an Image to an Access Point

- The maximum number of concurrent predownloads is limited to half the number of concurrent normal image downloads. This limitation allows new access points to join the controller during image downloading.

If you reach the predownload limit, then the access points that cannot get an image sleep for a time between 180 to 600 seconds and then reattempt the predownload.

- Before you predownload, you should change the active controller boot image to the backup image to ensure that if the controller reboots for some reason, it comes back up with the earlier running image, not the partially downloaded upgrade image.

- This predownload feature is not supported on 1242 and 1131 Cisco AP models.

- When the system time is changed by using the `config time` command, the time set for a scheduled reset is not valid and the scheduled system reset is canceled. You are given an option either to cancel the scheduled reset before configuring the time or retain the scheduled reset and not configure the time.

- All the primary, secondary, and tertiary controllers should run the same images as the primary and backup images. That is, the primary image of all three controllers should be X and the secondary image of all three controllers should be Y or the feature is not effective.

- At the time of the reset, if any AP is downloading the controller image, the scheduled reset is canceled. The following message appears with the reason why the scheduled reset was canceled:

  %OSAPI-3-RESETSYSTEM_FAILED: osapi_task.c:4458 System will not reset as software is being upgraded.

- Predownloading a 7.2 or later version of image on a Cisco Aironet 1240 access point is not supported when upgrading from a previous controller release. If predownloading is attempted to the Cisco Aironet 1240 access point, the AP gets disconnected.

- There are two images for the 1550 Mesh AP - 1550 with 64 MB memory and 1550 with 128 MB memory. During the controller upgrade to 7.6 and higher versions, the AP images are downloaded and there are two reboots.

- If you upgrade from a release that is prior to Release 7.5 directly to Release 7.6.X or a later release, the predownload process on Cisco AP2600 and AP3600 fails. After the Cisco WLC is upgraded to Release 7.6.X or a later release, the new image is loaded on Cisco AP2600 and AP3600. After the upgrade to a Release 7.6.X image, the predownload functionality works as expected. The predownload failure is only a one-time failure.

Predownloading an Image to Access Points—Global Configuration (GUI)

**Step 1**
Upload your controller configuration files to a server to back them up.

**Note** We highly recommend that you back up your controller's configuration files prior to upgrading the controller software. Otherwise, you must manually reconfigure the controller.

**Step 2**
Follow these steps to obtain the controller software:

b) Choose Wireless from the center selection window.
c) Click **Wireless LAN Controllers**.
The following options are available: Integrated Controllers and Controller Modules and Standalone Controllers.

d) Depending on your controller platform, click one of the above options.
e) Click the controller model number or name. The Download Software page is displayed.
f) Click a controller software release. The software releases are labeled as follows to help you determine which release to download:
- **Early Deployment (ED)**—These software releases provide new features, new hardware platform support, and bug fixes.
- **Maintenance Deployment (MD)**—These software releases provide bug fixes and ongoing software maintenance.
- **Deferred (DF)**—These software releases have been deferred. We recommend that you migrate to an upgraded release.

g) Choose a software release number.
h) Click the filename *(filename.aes)*.
i) Click **Download**.
j) Read Cisco’s End User Software License Agreement and then click **Agree**.
k) Save the file to your hard drive.
l) Repeat steps a through k to download the remaining file.

**Step 3** Copy the controller software file *(filename.aes)* to the default directory on your TFTP or FTP server.

**Step 4** (Optional) Disable the controller 802.11X networks.

**Note** For busy networks, controllers on high utilization, or small controller platforms, we recommend that you disable the 802.11X networks as a precautionary measure.

**Step 5** Choose **Commands > Download File** to open the Download File to Controller page.

**Step 6** From the **File Type** drop-down list, choose **Code**.

**Step 7** From the **Transfer Mode** drop-down list, choose from the following options:
- **TFTP**
- **FTP**

**Step 8** In the **IP Address** text box, enter the IP address of the server.
If you are using a TFTP server, the default values of 10 retries and 6 seconds for the Maximum Retries and Timeout text boxes should work correctly without any adjustment. However, you can change these values.

**Step 9** Enter the maximum number of times that the TFTP server attempts to download the software in the **Maximum Retries** text box and the amount of time (in seconds) that the TFTP server attempts to download the software in the **Timeout** text box.

**Step 10** In the **File Path** text box, enter the directory path of the software.

**Step 11** In the **File Name** text box, enter the name of the controller software file *(filename.aes)*.

**Step 12** If you are using an FTP server, follow these steps:

a) In the **Server Login Username** text box, enter the username to log into the FTP server.
b) In the **Server Login Password** text box, enter the password to log into the FTP server.
c) In the **Server Port Number** text box, enter the port number on the FTP server through which the download occurs. The default value is 21.

**Step 13**  
Click **Download** to download the software to the controller. A message appears indicating the status of the download.

**Step 14**  
To configure the predownloading of access point images globally, choose **Wireless > Access Points > Global Configuration** to open the Global Configuration page.

**Step 15**  
In the AP Image Pre-download section, perform one of the following:

- To instruct all the access points to predownload a primary image from the controller, click **Download Primary** under the AP Image Pre-download.
- To instruct all the access points to swap their primary and backup images, click **Interchange Image**.
- To download an image from the controller and store it as a backup image, click **Download Backup**.
- To abort the predownload operation, click **Abort Predownload**.

**Step 16**  
Click **OK**.

**Step 17**  
Click **Apply**.

---

**Predownloading an Image to Access Points (CLI)**

Using the CLI, you can predownload an image to a specific access point or to all access points.

**Step 1**  
Follow these steps to obtain the controller software:

- **b)** Select **Wireless** from the center selection window.
- **c)** Click **Wireless LAN Controllers**.  
  The following options are available: Integrated Controllers and Controller Modules and Standalone Controllers.
- **d)** Depending on your controller platform, click one of the above options.
- **e)** Click the controller model number or name. The **Download Software** page is displayed.
- **f)** Click a controller software release. The software releases are labeled as follows to help you determine which release to download:
  - **Early Deployment (ED)**—These software releases provide new features, new hardware platform support, and bug fixes.
  - **Maintenance Deployment (MD)**—These software releases provide bug fixes and ongoing software maintenance.
  - **Deferred (DF)**—These software releases have been deferred. We recommend that you migrate to an upgraded release.
- **g)** Choose a software release number.
- **h)** Click the filename (*filename.aes*).
- **i)** Click **Download**.
- **j)** Read Cisco’s End User Software License Agreement and then click **Agree**.
- **k)** Save the file to your hard drive.
l) Repeat steps a through n to download the remaining file.

Step 2
Copy the controller software file (filename.aes) to the default directory on your TFTP or FTP server.

Step 3
(Optional) Disable the 802.11 networks.

Note For busy networks, controllers on high utilization, or small controller platforms, we recommend that you disable the 802.11a/n or 802.11b/g/n networks as a precautionary measure.

Step 4
For Cisco WiSM2, shut down the controller port channel on the Catalyst switch to allow the controller to reboot before the access points start downloading the software.

Step 5
Disable any WLANs on the controller using the config wlan disable wlan_id command.

Step 6
Specify access points that will receive the predownload image.
Use one of these commands to specify access points for predownload:

- Specify access points for predownload by entering this command:
  
  config ap image predownload {primary | backup} {ap_name | all}

  The primary image is the new image; the backup image is the existing image. Access points always boot with the primary image.

- Swap an access point's primary and backup images by entering this command:
  
  config ap image swap {ap_name | all}

- Display detailed information on access points specified for predownload by entering this command:
  
  show ap image {all | ap-name}

The output lists access points that are specified for predownloading and provides for each access point, primary and secondary image versions, the version of the predownload image, the predownload retry time (if necessary), and the number of predownload attempts. The output also includes the predownload status for each device. The status of the access points is as follows:

- None—The access point is not scheduled for predownload.
- Predownloading—The access point is predownloading the image.
- Not supported—The access point (1120, 1230, and 1310) does not support predownloading.
- Initiated—The access point is waiting to get the predownload image because the concurrent download limit has been reached.
- Failed—The access point has failed 64 predownload attempts.
- Complete—The access point has completed predownloading.

Step 7
Set a reboot time for the controller and the access points.
Use one of these commands to schedule a reboot of the controller and access points:

- Specify the amount of time delay before the devices reboot by entering this command:
  
  reset system in HH:MM:SS image {swap | no-swap} reset-aps [save-config]

  Note The swap operand in the reset command will result in the swapping of the primary and backup images on both the controller and the access point.

  The controller sends a reset message to all joined access points, and then the controller resets.

- Specify a date and time for the devices to reboot by entering this command:
The controller sends a reset message to all joined access points, and then the controller resets.

**Note** The `swap` operand in the `reset` command will result in the swapping of the primary and backup images on both the controller and the access point.

- Set up an SNMP trap message that announces the upcoming reset by entering this command:

  ```
  reset system notify-time minutes
  ```

  The controller sends the announcement trap the configured number of minutes before the reset.

- Cancel the scheduled reboot by entering this command:

  ```
  reset system cancel
  ```

  **Note** If you configure reset times and then use the `config time` command to change the system time on the controller, the controller notifies you that any scheduled reset times will be canceled and must be reconfigured after you set the system time.

Use the `show reset` command to display scheduled resets.

Information similar to the following appears:

```
System reset is scheduled for Apr 08 01:01:01 2010.
Current local time and date is Apr 07 02:57:44 2010.
A trap will be generated 10 minutes before each scheduled system reset.
Use 'reset system cancel' to cancel the reset.
Configuration will be saved before the system reset.
```
Here is an example of a login banner:

Welcome to the Cisco Wireless Controller!
Unauthorized access prohibited.
Contact sysadmin@corp.com for access.

Follow the instructions in this section to download a login banner to the controller through the GUI or CLI. However, before you begin, make sure that you have a TFTP or FTP server available for the file download. Follow these guidelines when setting up a TFTP or FTP server:

- If you are downloading through the service port, the TFTP or FTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.

- If you are downloading through the distribution system network port, the TFTP or FTP server can be on the same or a different subnet because the distribution system port is routable.

- A third-party TFTP or FTP server cannot run on the same computer as Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP or FTP server and the third-party TFTP or FTP server require the same communication port.

Note: Clearing the controller configuration does not remove the login banner. See the Clearing the Login Banner (GUI) section for information about clearing the login banner using the controller GUI or CLI.

Note: The controller can have only one login banner file. If you download another login banner file to the controller, the first login banner file is overwritten.

**Downloading a Login Banner File (GUI)**

**Step 1**  
Copy the login banner file to the default directory on your server.

**Step 2**  
Choose **Commands > Download File** to open the Download File to Controller page.

**Step 3**  
From the File Type drop-down list, choose **Login Banner**.

**Step 4**  
From the Transfer Mode drop-down list, choose from the following options:

- **TFTP**
- **FTP**

**Step 5**  
In the IP Address text box, enter the IP address of the server type you chose in Step 4. If you are using a TFTP server, the default values of 10 retries and 6 seconds for the Maximum Retries and Timeout text boxes should work correctly without any adjustment. However, you can change these values.
Step 6 Enter the maximum number of times that the TFTP server attempts to download the certificate in the Maximum Retries text box and the amount of time (in seconds) that the TFTP server attempts to download the certificate in the Timeout text box.

Step 7 In the File Path text box, enter the directory path of the login banner file.

Step 8 In the File Name text box, enter the name of the login banner text (*.txt) file.

Step 9 If you are using an FTP server, follow these steps:
   a) In the Server Login Username text box, enter the username to log into the FTP server.
   b) In the Server Login Password text box, enter the password to log into the FTP server.
   c) In the Server Port Number text box, enter the port number on the FTP server through which the download occurs. The default value is 21.

Step 10 Click Download to download the login banner file to the controller. A message appears indicating the status of the download.

---

**Downloading a Login Banner File (CLI)**

Step 1 Log into the controller CLI.

Step 2 Specify the transfer mode used to download the config file by entering this command:
```
transfer download mode {tftp | ftp}
```

Step 3 Download the controller login banner by entering this command:
```
transfer download datatype login-banner
```

Step 4 Specify the IP address of the TFTP or FTP server by entering this command:
```
transfer download serverip server-ip-address
```

Step 5 Specify the name of the config file to be downloaded by entering this command:
```
transfer download path server-path-to-file
```

Step 6 Specify the directory path of the config file by entering this command:
```
transfer download filename filename.txt
```

Step 7 If you are using a TFTP server, enter these commands:
   • `transfer download tftpMaxRetries retries`
   • `transfer download tftpPktTimeout timeout`

   **Note** The default values of 10 retries and a 6-second timeout should work correctly without any adjustment. However, you can change these values. To do so, enter the maximum number of times that the TFTP server attempts to download the software for the `retries` parameter and the amount of time (in seconds) that the TFTP server attempts to download the software for the `timeout` parameter.

Step 8 If you are using an FTP server, enter these commands:
   • `transfer download username username`
   • `transfer download password password`
Step 9 View the download settings by entering the `transfer download start` command. Enter y when prompted to confirm the current settings and start the download process.

---

### Clearing the Login Banner (GUI)

**Step 1** Choose **Commands > Login Banner** to open the Login Banner page.

**Step 2** Click **Clear**.

**Step 3** When prompted, click **OK** to clear the banner.

To clear the login banner from the controller using the controller CLI, enter the `clear login-banner` command.

---

### Downloading Device Certificates

Each wireless device (controller, access point, and client) has its own device certificate. For example, the controller is shipped with a Cisco-installed device certificate. This certificate is used by EAP-FAST (when not using PACs), EAP-TLS, PEAP-GTC, and PEAP-MSCHAPv2 to authenticate wireless clients during local EAP authentication. However, if you want to use your own vendor-specific device certificate, it must be downloaded to the controller.

**Note** For more information about configuring local EAP, see the Configuring Local EAP section.

Follow the instructions in this section to download a vendor-specific device certificate to the controller through the GUI or CLI. However, before you begin, make sure you have a TFTP or FTP server available for the certificate download. Follow these guidelines when setting up a TFTP or FTP server:

- If you are downloading through the service port, the TFTP or FTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.

- If you are downloading through the distribution system network port, the TFTP or FTP server can be on the same or a different subnet because the distribution system port is routable.

- A third-party TFTP or FTP server cannot run on the same computer as Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP or FTP server and the third-party TFTP or FTP server require the same communication port.
All certificates downloaded to the controller must be in PEM format.

**Downloading Device Certificates (GUI)**

**Step 1** Copy the device certificate to the default directory on your server.

**Step 2** Choose **Commands > Download File** to open the Download File to Controller page.

**Step 3** From the File Type drop-down list, choose **Vendor Device Certificate**.

**Step 4** In the Certificate Password text box, enter the password that was used to protect the certificate.

**Step 5** From the Transfer Mode drop-down list, choose from the following options:

- TFTP
- FTP

**Step 6** In the IP Address text box, enter the IP address of the server.
If you are using a TFTP server, the default values of 10 retries and 6 seconds for the Maximum Retries and Timeout text boxes should work correctly without any adjustment. However, you can change these values.

**Step 7** Enter the maximum number of times that the TFTP server attempts to download the certificate in the Maximum Retries text box and the amount of time (in seconds) that the TFTP server attempts to download the certificate in the Timeout text box.

**Step 8** In the File Path text box, enter the directory path of the certificate.

**Step 9** In the File Name text box, enter the name of the certificate.

**Step 10** If you are using an FTP server, follow these steps:

a) In the Server Login Username text box, enter the username to log into the FTP server.

b) In the Server Login Password text box, enter the password to log into the FTP server.

c) In the Server Port Number text box, enter the port number on the FTP server through which the download occurs. The default value is 21.

**Step 11** Click **Download** to download the device certificate to the controller. A message appears indicating the status of the download.

**Step 12** After the download is complete, choose **Commands > Reboot > Reboot**.

**Step 13** If prompted to save your changes, click **Save and Reboot**.

**Step 14** Click **OK** to confirm your decision to reboot the controller.
**Downloading Device Certificates (CLI)**

**Step 1**
Log onto the controller CLI.

**Step 2**
Specify the transfer mode used to download the config file by entering this command:
```
transfer download mode \{tftp | ftp\}
```

**Step 3**
Specify the type of the file to be downloaded by entering this command:
```
transfer download datatype eapdevcert
```

**Step 4**
Specify the certificate’s private key by entering this command:
```
transfer download certpassword password
```

**Step 5**
Specify the IP address of the TFTP or FTP server by entering this command:
```
transfer download serverip server-ip-address
```

**Step 6**
Specify the name of the config file to be downloaded by entering this command:
```
transfer download path server-path-to-file
```

**Step 7**
Specify the directory path of the config file by entering this command:
```
transfer download filename filename.pem
```

**Step 8**
If you are using a TFTP server, enter these commands:
```
• transfer download tftpMaxRetries retries
• transfer download tftpPktTimeout timeout
```

**Note**
The default values of 10 retries and a 6-second timeout should work correctly without any adjustment. However, you can change these values. To do so, enter the maximum number of times that the TFTP server attempts to download the software for the `retries` parameter and the amount of time (in seconds) that the TFTP server attempts to download the software for the `timeout` parameter.

**Step 9**
If you are using an FTP server, enter these commands:
```
• transfer download username username
• transfer download password password
• transfer download port port
```

**Note**
The default value for the port parameter is 21.

**Step 10**
View the updated settings by entering the `transfer download start` command. Answer `y` when prompted to confirm the current settings and start the download process.

**Step 11**
Reboot the controller by entering this command:
```
reset system
```
Downloading CA Certificates

Controllers and access points have a Certificate Authority (CA) certificate that is used to sign and validate device certificates. The controller is shipped with a Cisco-installed CA certificate. This certificate may be used by EAP-FAST (when not using PACs), EAP-TLS, PEAP-GTC, and PEAP-MSCHAPv2 to authenticate wireless clients during local EAP authentication. However, if you want to use your own vendor-specific CA certificate, it must be downloaded to the controller.

For more information about configuring local EAP, see the Configuring Local EAP section.

Follow the instructions in this section to download CA certificates to the controller through the GUI or CLI. However, before you begin, make sure that you have a TFTP or FTP server available for the certificate download. Follow these guidelines when setting up a TFTP or FTP server:

- If you are downloading through the service port, the TFTP or FTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.
- If you are downloading through the distribution system network port, the TFTP or FTP server can be on the same or a different subnet because the distribution system port is routable.
- A third-party TFTP or FTP server cannot run on the same computer as Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP or FTP server and the third-party TFTP or FTP server require the same communication port.

All certificates downloaded to the controller must be in PEM format.

Download CA Certificates (GUI)

Step 1: Copy the CA certificate to the default directory on your server.
Step 2: Choose **Commands > Download File** to open the Download File to Controller page.
Step 3: From the File Type drop-down list, choose **Vendor CA Certificate**.
Step 4: From the Transfer Mode drop-down list, choose from the following options:
   - TFTP
   - FTP

Step 5: In the IP Address text box, enter the IP address of the server. If you are using a TFTP server, the default values of 10 retries and 6 seconds for the Maximum Retries and Timeout text boxes should work correctly without any adjustment. However, you can change these values.
Step 6 Enter the maximum number of times that the TFTP server attempts to download the certificate in the Maximum Retries text box and the amount of time (in seconds) that the TFTP server attempts to download the certificate in the Timeout text box.

Step 7 In the File Path text box, enter the directory path of the certificate.

Step 8 In the File Name text box, enter the name of the certificate.

Step 9 If you are using an FTP server, follow these steps:
   a) In the Server Login Username text box, enter the username to log on to the FTP server.
   b) In the Server Login Password text box, enter the password to log on to the FTP server.
   c) In the Server Port Number text box, enter the port number on the FTP server through which the download occurs. The default value is 21.

Step 10 Click Download to download the CA certificate to the controller. A message appears indicating the status of the download.

Step 11 After the download is complete, choose Commands > Reboot > Reboot.

Step 12 If prompted to save your changes, click Save and Reboot.

Step 13 Click OK to confirm your decision to reboot the controller.

### Downloading CA Certificates (CLI)

**Step 1** Log on to the controller CLI.

**Step 2** Specify the transfer mode used to download the config file by entering this command:
```plaintext
transfer download mode {tftp | ftp}
```

**Step 3** Specify the type of the file to be downloaded by entering this command:
```plaintext
transfer download datatype eapdevcert
```

**Step 4** Specify the IP address of the TFTP or FTP server by entering this command:
```plaintext
transfer download serverip server-ip-address
```

**Step 5** Specify the directory path of the config file by entering this command:
```plaintext
transfer download path server-path-to-file
```

**Step 6** Specify the name of the config file to be downloaded by entering this command:
```plaintext
transfer download filename filename
```

**Step 7** If you are using a TFTP server, enter these commands:
```bash
• transfer download tftpMaxRetries retries
• transfer download tftpPktTimeout timeout
```

**Note** The default values of 10 retries and a 6-second timeout should work correctly without any adjustment. However, you can change these values. To do so, enter the maximum number of times that the TFTP server attempts to download the software for the `retries` parameter and the amount of time (in seconds) that the TFTP server attempts to download the software for the `timeout` parameter.

**Step 8** If you are using an FTP server, enter these commands:
Uploading PACs

Protected access credentials (PACs) are credentials that are either automatically or manually provisioned and used to perform mutual authentication with a local EAP authentication server during EAP-FAST authentication. When manual PAC provisioning is enabled, the PAC file is manually generated on the controller.

Follow the instructions in this section to generate and load PACs from the controller through the GUI or CLI. However, before you begin, make sure you have a TFTP or FTP server available for the PAC upload. Follow these guidelines when setting up a TFTP or FTP server:

• If you are uploading through the service port, the TFTP or FTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.

• If you are uploading through the distribution system network port, the TFTP or FTP server can be on the same or a different subnet because the distribution system port is routable.

• A third-party TFTP or FTP server cannot run on the same computer as Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP or FTP server and the third-party TFTP or FTP server require the same communication port.

Uploading PACs (GUI)

Step 1 Choose Commands > Upload File to open the Upload File from Controller page.

Step 2 From the File Type drop-down list, choose PAC (Protected Access Credential).

Step 3 In the User textbox, enter the name of the user who will use the PAC.

Step 4 In the Validity text box, enter the number of days for the PAC to remain valid. The default setting is zero (0).

Step 5 In the Password and Confirm Password text boxes, enter a password to protect the PAC.

Step 6 From the Transfer Mode drop-down list, choose from the following options:

• TFTP
FTP

Step 7  In the IP Address (IPv4/IPv6) text box, enter the IPv4/IPv6 address of the server.
Step 8  In the File Path text box, enter the directory path of the PAC.
Step 9  In the File Name text box, enter the name of the PAC file. PAC files have a .pac extension.
Step 10 If you are using an FTP server, follow these steps:
   a) In the Server Login Username text box, enter the username to log into the FTP server.
   b) In the Server Login Password text box, enter the password to log into the FTP server.
   c) In the Server Port Number text box, enter the port number on the FTP server through which the upload occurs. The default value is 21.

Step 11  Click Upload to upload the PAC from the controller. A message appears indicating the status of the upload.
Step 12  Follow the instructions for your wireless client to load the PAC on your client devices. Make sure to use the password that you entered above.

Uploading PACs (CLI)

Step 1  Log on to the controller CLI.
Step 2  Specify the transfer mode used to upload the config file by entering this command:
        transfer upload mode {tftp | ftp}
Step 3  Upload a Protected Access Credential (PAC) by entering this command:
        transfer upload datatype pac
Step 4  Specify the identification of the user by entering this command:
        transfer upload pac username validity password
Step 5  Specify the IP address of the TFTP or FTP server by entering this command:
        transfer upload serverip server-ip-address
        Note  The server supports both, IPv4 and IPv6.
Step 6  Specify the directory path of the config file by entering this command:
        transfer upload path server-path-to-file
Step 7  Specify the name of the config file to be uploaded by entering this command:
        transfer upload filename manual.pac.
Step 8  If you are using an FTP server, enter these commands:
        • transfer upload username username
        • transfer upload password password
        • transfer upload port port
        Note  The default value for the port parameter is 21.
Step 9  View the updated settings by entering the `transfer upload start` command. Answer y when prompted to confirm the current settings and start the upload process.

Step 10  Follow the instructions for your wireless client to load the PAC on your client devices. Make sure to use the password that you entered above.

---

### Uploading and Downloading Configuration Files

We recommend that you upload your controller’s configuration file to a server to back it up. If you lose your configuration, you can then download the saved configuration to the controller.

**Note**  Do not download a configuration file to your controller that was uploaded from a different controller platform. For example, a Cisco 5500 Series Controller does not support the configuration file from a Cisco 2500 Series Controller.

Follow these guidelines when working with configuration files:

- Any CLI with an invalid value is filtered out and set to default by the XML validation engine. Validation occurs during bootup. A configuration may be rejected if the validation fails. A configuration may fail if you have an invalid CLI. For example, if you have a CLI where you try to configure a WLAN without adding appropriate commands to add the WLAN.

- A configuration may be rejected if the dependencies are not addressed. For example, if you try to configure dependent parameters without using the `add` command. The XML validation may succeed but the configuration download infrastructure will immediately reject the configuration with no validation errors.

- An invalid configuration can be verified by using the `show invalid-config` command. The `show invalid-config` command reports the configuration that is rejected by the controller either as part of download process or by XML validation infrastructure.

**Note**  You can also read and modify the configuration file.

- The FTP or the TFTP servers for transfer of configuration, image, and so on, must be reachable over a wired connection. The transfer cannot be performed over one of the wireless clients of the Cisco WLC. If you try to use a wireless client of the Cisco WLC, you are prompted with a system message saying that the server is not reachable. However, if you use a wireless client that is associated with another Cisco WLC, the FTP or the TFTP servers are reachable.

---

### Uploading Configuration Files

You can upload configuration files using either the GUI or the CLI.
Uploading the Configuration Files (GUI)

**Step 1** Choose Commands > Upload File to open the Upload File from Controller page.

**Step 2** From the File Type drop-down list, choose Configuration.

**Step 3** Encrypt the configuration file by selecting the Configuration File Encryption check box and entering the encryption key in the Encryption Key text box.

**Step 4** From the Transfer Mode drop-down list, choose from the following options:

- TFTP
- FTP

**Step 5** In the IP Address text box, enter the IP address of the server.

**Step 6** In the File Path text box, enter the directory path of the configuration file.

**Step 7** In the File Name text box, enter the name of the configuration file.

**Step 8** If you are using an FTP server, follow these steps:

a) In the Server Login Username text box, enter the username to log into the FTP server.
b) In the Server Login Password text box, enter the password to log into the FTP server.
c) In the Server Port Number text box, enter the port number on the FTP server through which the upload occurs. The default value is 21.

**Step 9** Click Upload to upload the configuration file to the server. A message appears indicating the status of the upload. If the upload fails, repeat this procedure and try again.

Uploading the Configuration Files (CLI)

**Step 1** Specify the transfer mode used to upload the configuration file by entering this command:

```
transfer upload mode {tftp | ftp}
```

**Step 2** Specify the type of file to be uploaded by entering this command:

```
transfer upload datatype config
```

**Step 3** Encrypt the configuration file by entering these commands:

```
• transfer encrypt enable
• transfer encrypt set-key key, where key is the encryption key used to encrypt the file.
```

**Step 4** Specify the IP address of the server by entering this command:

```
transfer upload serverip server-ip-address
```

**Step 5** Specify the directory path of the configuration file by entering this command:

```
transfer upload path server-path-to-file
```

**Step 6** Specify the name of the configuration file to be uploaded by entering this command:
Step 7 If you are using an FTP server, enter these commands to specify the username and password used to log into the FTP server and the port number through which the upload occurs:

- `transfer upload username username`
- `transfer upload password password`
- `transfer upload port port`

Note The default value for the port parameter is 21.

Step 8 Initiate the upload process by entering this command:

```
transfer upload start
```

Step 9 When prompted to confirm the current settings, answer `y`.

Information similar to the following appears:

```
Mode............................................. TFTP
TFTP Server IP................................... 10.10.10.4
TFTP Path........................................ Config/
TFTP Filename.................................... AS_4402_4_2_55_8_Config.xml
Data Type........................................ Config File
Encryption....................................... Disabled

****************************************************
*** WARNING: Config File Encryption Disabled ***
****************************************************

Are you sure you want to start? (y/N) Y

File transfer operation completed successfully.

If the upload fails, repeat this procedure and try again.

---

**Downloading Configuration Files**

You can download configuration files using either the GUI or the CLI.

**Downloading the Configuration Files (GUI)**

**Step 1** Choose **Commands > Download File** to open the Download File to Controller page.

**Step 2** From the File Type drop-down list, choose **Configuration**.

**Step 3** If the configuration file is encrypted, select the **Configuration File Encryption** check box and enter the encryption key used to decrypt the file in the Encryption Key text box.

Note The key that you enter here should match the one entered during the upload process.
Step 4  From the Transfer Mode drop-down list, choose from the following options:

- TFTP
- FTP

Step 5  In the IP Address text box, enter the IP address of the server.
If you are using a TFTP server, the default values of 10 retries and 6 seconds for the Maximum Retries and Timeout text boxes should work correctly without any adjustment. However, you can change these values.

Step 6  Enter the maximum number of times that the TFTP server attempts to download the configuration file in the Maximum Retries text box and the amount of time (in seconds) that the TFTP server attempts to download the configuration file in the Timeout text box.

Step 7  In the File Path text box, enter the directory path of the configuration file.

Step 8  In the File Name text box, enter the name of the configuration file.

Step 9  If you are using an FTP server, follow these steps:

a) In the Server Login Username text box, enter the username to log into the FTP server.
b) In the Server Login Password text box, enter the password to log into the FTP server.
c) In the Server Port Number text box, enter the port number on the FTP server through which the download occurs. The default value is 21.

Step 10 Click Download to download the file to the controller. A message appears indicating the status of the download, and the controller reboots automatically. If the download fails, repeat this procedure and try again.

---

**Downloading the Configuration Files (CLI)**

*Note* The controller does not support incremental configuration downloads. The configuration file contains all mandatory commands (all interface address commands, mgmtuser with read-write permission commands, and interface port or LAG enable or disable commands) required to successfully complete the download. For example, if you download only the `config time ntp server index server_address` command as part of the configuration file, the download fails. Only the commands present in the configuration file are applied to the controller, and any configuration in the controller prior to the download is removed.

---

Step 1  Specify the transfer mode used to download the configuration file by entering this command:

```
transfer download mode \{tftp \| ftp\}
```

Step 2  Specify the type of file to be downloaded by entering this command:

```
transfer download datatype config
```

Step 3  If the configuration file is encrypted, enter these commands:

```
  • transfer encrypt enable
  • transfer encrypt set-key key, where key is the encryption key used to decrypt the file.
```

*Note* The key that you enter here should match the one entered during the upload process.
Step 4 Specify the IP address of the TFTP or FTP server by entering this command:

```
transfer download serverip server-ip-address
```

Step 5 Specify the directory path of the configuration file by entering this command:

```
transfer download path server-path-to-file
```

Step 6 Specify the name of the configuration file to be downloaded by entering this command:

```
transfer download filename filename
```

Step 7 If you are using a TFTP server, enter these commands:

- `transfer download tftpMaxRetries retries`
- `transfer download tftpPktTimeout timeout`

**Note** The default values of 10 retries and a 6-second timeout should work correctly without any adjustment. However, you can change these values. To do so, enter the maximum number of times that the TFTP server attempts to download the software for the `retries` parameter and the amount of time (in seconds) that the TFTP server attempts to download the software for the `timeout` parameter.

Step 8 If you are using an FTP server, enter these commands to specify the username and password used to log into the FTP server and the port number through which the download occurs:

- `transfer upload username username`
- `transfer upload password password`
- `transfer upload port port`

**Note** The default value for the port parameter is 21.

Step 9 View the updated settings by entering this command:

```
transfer download start
```

Step 10 When prompted to confirm the current settings and start the download process, answer y. Information similar to the following appears:

```
Mode............................................. TFTP
TFTP Server IP................................... 10.10.10.4
TFTP Path........................................ Config/
TFTP Filename.................................... AS_4402_4_2_55_8_Config.xml
Data Type........................................ Config File
Encryption....................................... Disabled

**************************************************
*** WARNING: Config File Encryption Disabled ***
**************************************************

Are you sure you want to start? (y/N) y

File transfer operation completed successfully.

If the download fails, repeat this procedure and try again.
Saving Configurations

Controllers contain two kinds of memory: volatile RAM and NVRAM. At any time, you can save the configuration changes from active volatile RAM to nonvolatile RAM (NVRAM) using one of these commands:

- **save config**—Saves the configuration from volatile RAM to NVRAM without resetting the controller.
- **reset system**—Prompts you to confirm that you want to save configuration changes before the controller reboots.
- **logout**—Prompts you to confirm that you want to save configuration changes before you log out.

Editing Configuration Files

When you save the controller’s configuration, the controller stores it in XML format in flash memory. Controller software release 5.2 or later releases enable you to easily read and modify the configuration file by converting it to CLI format. When you upload the configuration file to a TFTP/FTP server, the controller initiates the conversion from XML to CLI. You can then read or edit the configuration file in a CLI format on the server. When you are finished, you download the file back to the controller, where it is reconverted to an XML format and saved.

### Step 1
Upload the configuration file to a TFTP/FTP server by performing one of the following:

- Upload the file using the controller GUI.
- Upload the file using the controller CLI.

### Step 2
Read or edit the configuration file on the server. You can modify or delete existing CLI commands and add new CLI commands to the file.

**Note** To edit the configuration file, you can use either Notepad or WordPad on Windows or the VI editor on Linux.

### Step 3
Save your changes to the configuration file on the server.

### Step 4
Download the configuration file to the controller by performing one of the following:

- Download the file using the controller GUI.
- Download the file using the controller CLI.

The controller converts the configuration file to an XML format, saves it to flash memory, and then reboots using the new configuration. CLI commands with known keywords and proper syntax are converted to XML while improper CLI commands are ignored and saved to flash memory. Any CLI commands that have invalid values are replaced with default values. To see any ignored commands or invalid configuration values, enter this command:

```
show invalid-config
```

**Note** You cannot execute this command after the `clear config` or `save config` command.

### Step 5
If the downloaded configuration contains a large number of invalid CLI commands, you might want to upload the invalid configuration to the TFTP or FTP server for analysis. To do so, perform one of the following:
• Upload the invalid configuration using the controller GUI. Follow the instructions in the Uploading Configuration Files (GUI) section but choose **Invalid Config** from the File Type drop-down list in **Step 2** and skip **Step 3**.

• Upload the invalid configuration using the controller CLI. Follow the instructions in the Uploading Configuration Files (CLI) section but enter the transfer **upload datatype invalid-config command** in **Step 2** and skip **Step 3**.

**Step 6**
The controller does not support the uploading and downloading of port configuration CLI commands. If you want to configure the controller ports, enter these commands:

- **config port linktrap** `{port | all} {enable | disable}`—Enables or disables the up and down link traps for a specific controller port or for all ports.

- **config port adminmode** `{port | all} {enable | disable}`—Enables or disables the administrative mode for a specific controller port or for all ports.

**Step 7**
Save your changes by entering this command:

```
save config
```

---

**Clearing the Controller Configuration**

**Step 1**
Clear the configuration by entering this command:

```
clear config
```
Enter y at the confirmation prompt to confirm the action.

**Step 2**
Reboot the system by entering this command:

```
reset system
```
Enter n to reboot without saving configuration changes. When the controller reboots, the configuration wizard starts automatically.

**Step 3**
Follow the instructions in the Configuring the Controller-Using the Configuration Wizard section to complete the initial configuration.

---

**Erasing the Controller Configuration**

**Step 1**
Reset the configuration by entering this command:

```
reset system
```
At the confirmation prompt, enter y to save configuration changes to NVRAM. The controller reboots.

**Step 2**
When you are prompted for a username, restore the factory-default settings by entering this command:
recover-config
The controller reboots and the configuration wizard starts automatically.

**Step 3**
Follow the instructions in the Configuring the Controller-Using the Configuration Wizard section to complete the initial configuration.

---

**Resetting the Controller**

You can reset the controller and view the reboot process on the CLI console using one of the following two methods:

- Turn the controller off and then turn it back on.
- On the CLI, enter `reset system`. At the confirmation prompt, enter `y` to save configuration changes to NVRAM. The controller reboots.

When the controller reboots, the CLI console displays the following reboot information:

- Initializing the system.
- Verifying the hardware configuration.
- Loading microcode into memory.
- Verifying the operating system software load.
- Initializing with its stored configurations.
- Displaying the login prompt.
Resetting the Controller
Managing User Accounts

This chapter contains these sections:

- Information About Creating Guest Accounts, page 677
- Restrictions on Managing User Accounts, page 678
- Creating a Lobby Ambassador Account, page 678
- Viewing Guest User Accounts, page 680
- Obtaining a Web Authentication Certificate, page 680
- Web Authentication Process, page 683
- Choosing the Default Web Authentication Login Page, page 686
- Generating a Certificate Signing Request, page 692
- Using a Customized Web Authentication Login Page from an External Web Server, page 696
- Choosing a Customized Web Authentication Login Page from an External Web Server, page 696
- Downloading a Customized Web Authentication Login Page, page 697
- Assigning Login, Login Failure, and Logout Pages per WLAN, page 701
- Configuring Wired Guest Access, page 703
- Configuring Wired Guest Access, page 705
- Supporting IPv6 Client Guest Access, page 709

Information About Creating Guest Accounts

The controller can provide guest user access on WLANs. The first step in creating guest user accounts is to create a lobby administrator user, also known as a lobby ambassador account. Once this account has been created, a lobby ambassador can create and manage guest user accounts on the controller. The lobby ambassador has limited configuration privileges and access only to the web pages used to manage the guest accounts.

The lobby ambassador can specify the amount of time that the guest user accounts remain active. After the specified time elapses, the guest user accounts expire automatically.
Restrictions on Managing User Accounts

• The local user database is limited to a maximum of 2048 entries, which is also the default value. This database is shared by local management users (including lobby ambassadors), local network users (including guest users), MAC filter entries, exclusion list entries, and access point authorization list entries. Together they cannot exceed the configured maximum value.

• For net user accounts or guest user accounts, the following special characters are allowed along with alphanumeric characters: ~, @, #, $, %, ^, &, (,), !, _, -, ,, ,, [, ], =, +, *, ;, {, }, ,, /, and \.

Creating a Lobby Ambassador Account

Creating a Lobby Ambassador Account (GUI)

Step 1 Choose Management > Local Management Users to open the Local Management Users page. This page lists the names and access privileges of the local management users.

Note If you want to delete any of the user accounts from the controller, hover your cursor over the blue drop-down arrow and choose Remove. However, deleting the default administrative user prohibits both GUI and CLI access to the controller. Therefore, you must create a user with administrative privileges (ReadWrite) before you remove the default user.

Step 2 Click New to create a lobby ambassador account. The Local Management Users > New page appears.

Step 3 In the User Name text box, enter a username for the lobby ambassador account.

Note Management usernames must be unique because they are stored in a single database.

Step 4 In the Password and Confirm Password text boxes, enter a password for the lobby ambassador account.

Note Passwords are case sensitive. The settings for the management User Details parameters depends on the settings that you make in the Password Policy page. The following requirements are enforced on the password

• The password should contain characters from at least three of the following classes: lowercase letters, uppercase letters, digits, and special characters.

• No character in the password can be repeated more than three times consecutively.

• The password should not contain a management username or the reverse letters of a username.

• The password should not contain words like Cisco, oscic, admin, nimda, or any variant obtained by changing the capitalization of letters by substituting 1, |, or ! or substituting 0 for o or substituting $ for s.

Step 5 Choose LobbyAdmin from the User Access Mode drop-down list. This option enables the lobby ambassador to create guest user accounts.

Note The ReadOnly option creates an account with read-only privileges, and the ReadWrite option creates an administrative account with both read and write privileges.

Step 6 Click Apply to commit your changes. The new lobby ambassador account appears in the list of local management users.

Step 7 Click Save Configuration to save your changes.
Creating a Lobby Ambassador Account (CLI)

To create a lobby ambassador account use the following command:

```
config mgmtuser add lobbyadmin_username lobbyadmin_pwd lobby-admin
```

Note: Replacing `lobby-admin` with `read-only` creates an account with read-only privileges. Replacing `lobby-admin` with `read-write` creates an administrative account with both read and write privileges.

Creating Guest User Accounts as a Lobby Ambassador (GUI)

**Step 1**
Log into the controller as the lobby ambassador, using the username and password. The Lobby Ambassador Guest Management > Guest Users List page appears.

**Step 2**
Click New to create a guest user account. The Lobby Ambassador Guest Management > Guest Users List > New page appears.

**Step 3**
In the User Name text box, enter a name for the guest user. You can enter up to 24 characters.

**Step 4**
Perform one of the following:

- If you want to generate an automatic password for this guest user, select the Generate Password check box. The generated password is entered automatically in the Password and Confirm Password text boxes.

- If you want to create a password for this guest user, leave the Generate Password check box unselected and enter a password in both the Password and Confirm Password text boxes.

  Note: Passwords can contain up to 24 characters and are case sensitive.

**Step 5**
From the Lifetime drop-down lists, choose the amount of time (in days, hours, minutes, and seconds) that this guest user account is to remain active. A value of zero (0) for all four text boxes creates a permanent account.

Default: 1 day

Range: 5 minutes to 30 days

Note: The smaller of this value or the session timeout for the guest WLAN, which is the WLAN on which the guest account is created, takes precedence. For example, if a WLAN session timeout is due to expire in 30 minutes but the guest account lifetime has 10 minutes remaining, the account is deleted in 10 minutes upon guest account expiry. Similarly, if the WLAN session timeout expires before the guest account lifetime, the client experiences a recurring session timeout that requires reauthentication.

Note: You can change a guest user account with a nonzero lifetime to another lifetime value at any time while the account is active. However, to make a guest user account permanent using the controller GUI, you must delete the account and create it again. If desired, you can use the `config netuser lifetime user_name 0` command to make a guest user account permanent without deleting and recreating it.
Step 6  From the WLAN SSID drop-down list, choose the SSID that will be used by the guest user. The only WLANs that are listed are those WLANs for which Layer 3 web authentication has been configured.

**Note**   We recommend that you create a specific guest WLAN to prevent any potential conflicts. If a guest account expires and it has a name conflict with an account on the RADIUS server and both are on the same WLAN, the users associated with both accounts are disassociated before the guest account is deleted.

Step 7  In the Description text box, enter a description of the guest user account. You can enter up to 32 characters.

Step 8  Click **Apply** to commit your changes. The new guest user account appears in the list of guest users on the Guest Users List page.

From this page, you can see all of the guest user accounts, their WLAN SSID, and their lifetime. You can also edit or remove a guest user account. When you remove a guest user account, all of the clients that are using the guest WLAN and are logged in using that account’s username are deleted.

Step 9  Repeat this procedure to create any additional guest user accounts.

---

**Viewing Guest User Accounts**

**Viewing the Guest Accounts (GUI)**

To view guest user accounts using the controller GUI, choose **Security > AAA > Local Net Users**. The Local Net Users page appears.

From this page, you can see all of the local net user accounts (including guest user accounts) and can edit or remove them as desired. When you remove a guest user account, all of the clients that are using the guest WLAN and are logged in using that account’s username are deleted.

**Viewing the Guest Accounts (CLI)**

To see all of the local net user accounts (including guest user accounts) using the controller CLI, enter this command:

```
show netuser summary
```

**Obtaining a Web Authentication Certificate**

**Information About Web Authentication Certificates**

The operating system of the controller automatically generates a fully functional web authentication certificate, so you do not need to do anything in order to use certificates with Layer 3 web authentication. However, if desired, you can prompt the operating system to generate a new web authentication certificate, or you can download an externally generated SSL certificate.

Starting with 7.0.250.0 and 7.3.101.0 releases (but not in 7.2.x release), SHA2 certificates are supported.
The WEB UI home page may not load when `ip http access class` command is enabled. When you encounter this issue, we recommend that you do the following:

1. Run the `show iosd lii` command.
2. Get the internet-address and configure the same ip as `permit` in the access-list.

For WEB UI access using TACACS+ server, custom method-list for authentication and authorization pointing to the TACACS+ server group does not work. You should use the default authorization method-list pointing to the same TACACS+ server group for the WEB UI to work.

**Obtaining Web Authentication Certificates**

**Obtaining a Web Authentication Certificate (GUI)**

**Step 1**  
Choose **Security > Web Auth > Certificate** to open the Web Authentication Certificate page. This page shows the details of the current web authentication certificate.

**Step 2**  
If you want to use a new operating system-generated web authentication certificate, follow these steps:  
a) Click **Regenerate Certificate**. The operating system generates a new web authentication certificate, and a successfully generated web authentication certificate message appears.  
b) Reboot the controller to register the new certificate.

**Step 3**  
If you prefer to use an externally generated web authentication certificate, follow these steps:  
a) Verify that the controller can ping the TFTP server.  
b) Select the **Download SSL Certificate** check box.  
c) In the Server IP Address text box, enter the IP address of the TFTP server.  
The default values of 10 retries and 6 seconds for the Maximum Retries and Timeout text boxes should work correctly without any adjustment. However, you can change these values.  
d) Enter the maximum number of times that each download can be attempted in the Maximum Retries text box and the amount of time (in seconds) allowed for each download in the Timeout text box.  
e) In the Certificate File Path text box, enter the directory path of the certificate.  
f) In the Certificate File Name text box, enter the name of the certificate (**certname.pem**).  
g) In the Certificate Password text box, enter the password for the certificate.  
h) Click **Apply** to commit your changes. The operating system downloads the new certificate from the TFTP server.  
i) Reboot the controller to register the new certificate.
Obtaining a Web Authentication Certificate (CLI)

Step 1  See the current web authentication certificate by entering this command:

```
show certificate summary
```

Information similar to the following appears:

```
Web Administration Certificate................... Locally Generated
Web Authentication Certificate................... Locally Generated
Certificate compatibility mode:............... off
```

Step 2  If you want the operating system to generate a new web authentication certificate, follow these steps:

a) To generate the new certificate, enter this command:

```
config certificate generate webauth
```

b) To reboot the controller to register the new certificate, enter this command:

```
reset system
```

Step 3  If you prefer to use an externally generated web authentication certificate, follow these steps:

Note  We recommend that the Common Name (CN) of the externally generated web authentication certificate be 1.1.1.1 (or the equivalent virtual interface IP address) in order for the client's browser to match the domains of the web authentication URL and the web authentication certificate.

1  Specify the name, path, and type of certificate to be downloaded by entering these commands:

```
transfer download mode tftp
transfer download datatype webauthcert
transfer download serverip server_ip_address
transfer download path server_path_to_file
transfer download filename certname.pem
transfer download certpassword password
transfer download tftpMaxRetries retries
transfer download tftpPktTimeout timeout
```

Note  The default values of 10 retries and a 6-second timeout should work correctly without any adjustment. However, you can change these values. To do so, enter the maximum number of times that each download can be attempted for the `retries` parameter and the amount of time (in seconds) allowed for each download for the `timeout` parameter.

2  Start the download process by entering this command:

```
transfer download start
```

3  Reboot the controller to register the new certificate by entering this command:

```
reset system
```
Web Authentication Process

Web authentication is a Layer 3 security feature that causes the controller to not allow IP traffic (except DHCP-related packets) from a particular client until that client has correctly supplied a valid username and password. When you use web authentication to authenticate clients, you must define a username and password for each client. When the clients attempt to join the wireless LAN, their users must enter the username and password when prompted by a login page.

Note
If a client uses more than 20 DNS resolved addresses, the controller overwrites the 21st address in the first address space in the Mobile Station Control Block (MSCB) table, but the first address is still retained in the client. If the client again tries to use the first address, it will not be reachable because the controller does not have this address in the list of allowed addresses for the client's MSCB table.

Note
One-Time Passwords (OTP) are not supported on web authentication.

When a client is associated with 802.1X + WebAuth Security and when the client roams, the 802.1X username is updated in the client information.

Note
Web Authentication does not work with IPv6 URL when WLAN is LS however IPv4 with LS and IPv6 with CS works. The re-directed web-auth page is not displayed when IPv6 URL is typed in the browser and WLAN is in Local Switching.
Guidelines and Limitations

When web authentication is enabled (under Layer 3 Security), users might receive a web-browser security alert the first time that they attempt to access a URL.

Figure 91: Typical Web-Browser Security Alert

When clients connect to a WebAuth SSID with preauthorization ACL configured to allow VPN users, the clients will get disconnected from the SSID every few minutes. Webauth SSIDs must not connect without authenticating on the web page.

Note

After the user clicks Yes to proceed (or if the client’s browser does not display a security alert), the web authentication system redirects the client to a login page.

To prevent the security alert from appearing, follow these steps:

2. Click Install Certificate.
3. When the Certificate Import Wizard appears, click Next.
4. Choose Place all certificates in the following store and click Browse.
5. At the bottom of the Select Certificate Store page, select the Show Physical Stores check box.
6. Expand the Trusted Root Certification Authorities folder and choose Local Computer.
7. Click OK.
8. Click Next > Finish.
9. When the “The import was successful” message appears, click OK.
Because the issuer text box is blank on the controller self-signed certificate, open Internet Explorer, choose **Tools > Internet Options > Advanced**, unselect the **Warn about Invalid Site Certificates** check box under Security, and click **OK**.

**10** Reboot the PC. On the next web authentication attempt, the login page appears.

The following figure shows the default web authentication login page.

*Figure 92: Default Web Authentication Login Page*

The default login page contains a Cisco logo and Cisco-specific text. You can choose to have the web authentication system display one of the following:

- The default login page
- A modified version of the default login page
- A customized login page that you configure on an external web server
- A customized login page that you download to the controller

The Choosing the Default Web Authentication Login Page section provides instructions for choosing how the web authentication login page appears.
When the user enters a valid username and password on the web authentication login page and clicks **Submit**, the web authentication system displays a successful login page and redirects the authenticated client to the requested URL.

*Figure 93: Successful Login Page*

The default successful login page contains a pointer to a virtual gateway address URL: https://1.1.1.1/logout.html. The IP address that you set for the controller virtual interface serves as the redirect address for the login page.

### Choosing the Default Web Authentication Login Page

#### Information About Default Web Authentication Login Page

If you are using a custom web-auth bundle that is served by the internal controller web server, the page should not contain more than 5 elements (including HTML, CSS, and Images). This is because the internal controller web server implements a DoS protection mechanism that limits each client to open a maximum of 5 (five) concurrent TCP connections depending on the load. Some browsers may try to open more than 5 TCP sessions at the same time (For example Firefox 4) if the page contains more elements and this may result in the page loading slowly depending on how the browser handles the DoS protection.

If you do not want users to connect to a web page using a browser that is configured with SSLv2 only, you can disable SSLv2 for web authentication by entering the `config network secureweb cipher-option sslv2 disable` command. If you enter this command, users must use a browser that is configured to use a more secure protocol such as SSLv3 or later releases. The default value is disabled.
Cisco TAC is not responsible for creating a custom webauth bundle.

If you have a complex custom web authentication module, it is recommended that you use an external web-auth config on the controller, where the full login page is hosted at an external web server.

Guidelines and Limitations

If you do not want users to connect to a web page using a browser that is configured with SSLv2 only, you can disable SSLv2 for web authentication by entering the `config network secureweb cipher-option sslv2 disable` command. If you enter this command, users must use a browser that is configured to use a more secure protocol such as SSLv3 or later releases. The default value is disabled.

Choosing the Default Web Authentication Login Page (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose Security &gt; Web Auth &gt; Web Login Page to open the Web Login page.</td>
</tr>
<tr>
<td>2</td>
<td>From the Web Authentication Type drop-down list, choose Internal (Default).</td>
</tr>
<tr>
<td>3</td>
<td>If you want to use the default web authentication login page as is, go to Step 8. If you want to modify the default login page, go to Step 4.</td>
</tr>
<tr>
<td>4</td>
<td>If you want to hide the Cisco logo that appears in the top right corner of the default page, choose the Cisco Logo Hide option. Otherwise, click the Show option.</td>
</tr>
<tr>
<td>5</td>
<td>If you want the user to be directed to a particular URL (such as the URL for your company) after login, enter the desired URL in the Redirect URL After Login text box. You can enter up to 254 characters.</td>
</tr>
<tr>
<td>6</td>
<td>If you want to create your own headline on the login page, enter the desired text in the Headline text box. You can enter up to 127 characters. The default headline is “Welcome to the Cisco wireless network.”</td>
</tr>
<tr>
<td>7</td>
<td>If you want to create your own message on the login page, enter the desired text in the Message text box. You can enter up to 2047 characters. The default message is “Cisco is pleased to provide the Wireless LAN infrastructure for your network. Please login and put your air space to work.”</td>
</tr>
<tr>
<td>8</td>
<td>Click Apply to commit your changes.</td>
</tr>
<tr>
<td>9</td>
<td>Click Preview to view the web authentication login page.</td>
</tr>
<tr>
<td>10</td>
<td>If you are satisfied with the content and appearance of the login page, click Save Configuration to save your changes. Otherwise, repeat any of the previous steps as necessary to achieve your desired results.</td>
</tr>
</tbody>
</table>

Choosing the Default Web Authentication Login Page (CLI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Command</th>
</tr>
</thead>
</table>
| 1    | Specify the default web authentication type by entering this command: 
`config custom-web webauth_type internal` |
Step 2 If you want to use the default web authentication login page as is, go to Step 7. If you want to modify the default login page, go to Step 3.

Step 3 To show or hide the Cisco logo that appears in the top right corner of the default login page, enter this command:
```
config custom-web weblogo {enable | disable}
```

Step 4 If you want the user to be directed to a particular URL (such as the URL for your company) after login, enter this command:
```
config custom-web redirect-url url
```
You can enter up to 130 characters for the URL. To change the redirect back to the default setting, enter the `clear redirect-url` command.

Step 5 If you want to create your own headline on the login page, enter this command:
```
config custom-web webtitle title
```
You can enter up to 130 characters. The default headline is “Welcome to the Cisco wireless network.” To reset the headline to the default setting, enter the `clear webtitle` command.

Step 6 If you want to create your own message on the login page, enter this command:
```
config custom-web webmessage message
```
You can enter up to 130 characters. The default message is “Cisco is pleased to provide the Wireless LAN infrastructure for your network. Please login and put your air space to work.” To reset the message to the default setting, enter the `clear webmessage` command.

Step 7 To enable or disable the web authentication logout popup window, enter this command:
```
config custom-web logout-popup {enable | disable}
```

Step 8 Enter the `save config` command to save your settings.

Step 9 Import your own logo into the web authentication login page as follows:

1. Make sure that you have a Trivial File Transfer Protocol (TFTP) server available for the file download. Follow these guidelines when setting up a TFTP server:
   - If you are downloading through the service port, the TFTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.
   - If you are downloading through the distribution system network port, the TFTP server can be on the same or a different subnet because the distribution system port is routable.
   - A third-party TFTP server cannot run on the same computer as the Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP server and the third-party TFTP server require the same communication port.

2. Ensure that the controller can contact the TFTP server by entering this command:
   ```
ping ip-address
```

3. Copy the logo file (in .jpg, .gif, or .png format) to the default directory on your TFTP server. The maximum file size is 30 kilobits. For an optimal fit, the logo should be approximately 180 pixels wide and 360 pixels high.

4. Specify the download mode by entering this command:
   ```
   transfer download mode tftp
   ```

5. Specify the type of file to be downloaded by entering this command:
   ```
   transfer download datatype image
   ```
6 Specify the IP address of the TFTP server by entering this command:

```
transfer download serverip tftp-server-ip-address
```

**Note** Some TFTP servers require only a forward slash (/) as the TFTP server IP address, and the TFTP server automatically determines the path to the correct directory.

7 Specify the download path by entering this command:

```
transfer download path absolute-tftp-server-path-to-file
```

8 Specify the file to be downloaded by entering this command:

```
transfer download filename {filename.jpg | filename.gif | filename.png}
```

9 View your updated settings and answer `y` to the prompt to confirm the current download settings and start the download by entering this command:

```
transfer download start
```

10 Save your settings by entering this command:

```
save config
```

**Note** If you ever want to remove this logo from the web authentication login page, enter the `clear webimage` command.

---

**Step 10** Follow the instructions in the Verifying the Web Authentication Login Page Settings (CLI), on page 700 section to verify your settings.

---

**Example: Creating a Customized Web Authentication Login Page**

This section provides information on creating a customized web authentication login page, which can then be accessed from an external web server.

Here is a web authentication login page template. It can be used as a model when creating your own customized page:

```html
<html>
<head>
<meta http-equiv="Pragma" content="no-cache">
<meta HTTP-EQUIV="Content-Type" CONTENT="text/html; charset=iso-8859-1">
<title>Web Authentication</title>
<script>
function submitAction(){
  var link = document.location.href;
  var searchString = "redirect=";
  var equalIndex = link.indexOf(searchString);
  var redirectUrl = "";

  if (document.forms[0].action == ") {
    var url = window.location.href;
    var args = new Object();
    var query = location.search.substring(1);
    var pairs = query.split("&");
    for(var i=0; i<pairs.length; i++){
      var pos = pairs[i].indexOf("=");
      if(pos == -1) continue;
      var argname = pairs[i].substring(0, pos);
      var value = pairs[i].substring(pos+1);
```
args[argname] = unescape(value);
}
document.forms[0].action = args.switch_url;

if(equalIndex >= 0) {
    equalIndex += searchString.length;
    redirectUrl = "";
    redirectUrl += link.substring(equalIndex);
}
if(redirectUrl.length > 255)
    redirectUrl = redirectUrl.substring(0,255);
document.forms[0].redirect_url.value = redirectUrl;
    document.forms[0].buttonClicked.value = 4;
    document.forms[0].submit();
}

function loadAction(){
    var url = window.location.href;
    var args = new Object();
    var query = location.search.substring(1);
    var pairs = query.split("&");
    for(var i=0;i<pairs.length;i++){
        var pos = pairs[i].indexOf("");
        if(pos == -1) continue;
        var argname = pairs[i].substring(0,pos);
        var value = pairs[i].substring(pos+1);
        args[argname] = unescape(value);
    }
    //alert( "AP MAC Address is " + args.ap_mac);
    //alert( "The Switch URL to post user credentials is " + args.switch_url);
    document.forms[0].action = args.switch_url;
    // This is the status code returned from webauth login action
    // Any value of status code from 1 to 5 is error condition and user
    // should be shown error as below or modify the message as it suits
    // the customer
    if(args.statusCode == 1){
        alert("You are already logged in. No further action is required on your part.");
    }
    else if(args.statusCode == 2){
        alert("You are not configured to authenticate against web portal. No further action
is required on your part.");
    }
    else if(args.statusCode == 3){
        alert("The username specified cannot be used at this time. Perhaps the username is
already logged into the system?");
    }
    else if(args.statusCode == 4){
        alert("The User has been excluded. Please contact the administrator.");
    }
    else if(args.statusCode == 5){
        alert("Invalid username and password. Please try again.");
    }
    else if(args.statusCode == 6){
        alert("Invalid email address format. Please try again.");
    }
}
</script>
</head>
<body topmargin="50" marginheight="50" onload="loadAction();">
<form method="post" action="https://209.165.200.225/login.html">
<input TYPE="hidden" NAME="buttonClicked" SIZE="16" MAXLENGTH="15" value="0">
<input TYPE="hidden" NAME="redirect_url" SIZE="255" MAXLENGTH="255" VALUE="">
<input TYPE="hidden" NAME="err_flag" SIZE="16" MAXLENGTH="15" Value="">
<div align="center">
<table border="0" cellspacing="0" cellpadding="0">
<tr> <td>&nbsp;</td></tr>
<tr align="center"> <td colspan="2"><font size="10" color="#336699">Web Authentication</font></td></tr>
</table>
</div>
<tr> <td>&nbsp;</td></tr>
<tr align="center"> <td> <font size="10" color="#336699">Web Authentication</font>
</td></tr>
</form>
These parameters are added to the URL when the user’s Internet browser is redirected to the customized login page:

- **ap_mac**—The MAC address of the access point to which the wireless user is associated.
- **switch_url**—The URL of the controller to which the user credentials should be posted.
- **redirect**—The URL to which the user is redirected after authentication is successful.
- **statusCode**—The status code returned from the controller’s web authentication server.
- **wlan**—The WLAN SSID to which the wireless user is associated.

The available status codes are as follows:

- Status Code 1: “You are already logged in. No further action is required on your part.”
- Status Code 2: “You are not configured to authenticate against web portal. No further action is required on your part.”
- Status Code 3: “The username specified cannot be used at this time. Perhaps the username is already logged into the system?”
- Status Code 4: “You have been excluded.”
- Status Code 5: “The User Name and Password combination you have entered is invalid. Please try again.”

Example: Modified Default Web Authentication Login Page Example

This figure shows an example of a modified default web authentication login page.

Figure 94: Modified Default Web Authentication Login Page Example

These CLI commands were used to create this login page:

- `config custom-web weblogo disable`
- `config custom-web webtitle Welcome to the AcompanyBC Wireless LAN!`
- `config custom-web webmessage Contact the System Administrator for a Username and Password.`
- `transfer download start`
- `config custom-web redirecturl url`

Generating a Certificate Signing Request

Step 1
Install and open the OpenSSL application.

Step 2
Enter the command:

```
OpenSSL> req -new -newkey rsa:1024 -nodes -keyout mykey.pem -out myreq.pem
```

Controllers support a maximum key size of 2048 bits.
You must provide the correct Common Name. Ensure that the host name that is used to create the certificate (Common Name) matches the Domain Name System (DNS) host name entry for the virtual interface IP on the controller. This name should exist in the DNS as well. Also, after you make the change to the VIP interface, you must reboot the system in order for this change to take effect.

After you issue the command, you are prompted to enter information such as country name, state, city, and so on.

Information similar to the following appears:

```
OpenSSL> req -new -newkey rsa:1024 -nodes -keyout mykey.pem -out myreq.pem
Loading 'screen' into random state - done
Generating a 1024 bit RSA private key
...................................................+++++
...................................................+++++
writing new private key to 'mykey.pem'
-----
You are about to be asked to enter information that will be incorporated into your certificate request.
What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.
-----
Country Name (2 letter code) [AU]:US
State or Province Name (Full name) [Some-State]:CA
Locality Name (eg, city) []:San Jose
Organization Name (eg, company) []:Cisco
Organizational Unit Name (eg, section) []:Engineering
Common Name (eg, YOUR name) []:XYZ.ABC
Email Address []:Test@abc.com

Please enter the following 'extra' attributes to be sent with your certificate request
A challenge password []:Test123
An optional company name []:

OpenSSL>
```

After you provide all the required details two files are generated:

- A new private key that includes the name mykey.pem
- A CSR that includes the name myreq.pem

**Step 3**

Copy and paste the Certificate Signing Request (CSR) information into any CA enrollment tool. After you submit the CSR to a third party CA, the third party CA digitally signs the certificate and sends back the signed certificate chain through e-mail. In case of chained certificates, you receive the entire chain of certificates from the CA. If you only have one intermediate certificate similar to the example above, you will receive the following three certificates from the CA:

- Root certificate.pem
- Intermediate certificate.pem
- Device certificate.pem

**Note** Ensure that the certificate is Apache-compatible with SHA1 encryption.

**Step 4**

Once you have all the three certificates, copy and paste into another file the contents of each .pem file in this order:

```
-------BEGIN CERTIFICATE-------
*Device cert*
-------END CERTIFICATE-------
-------BEGIN CERTIFICATE-------
```
Step 5  Save the file as All-certs.pem.

Step 6  Combine the All-certs.pem certificate with the private key that you generated along with the CSR (the private key of the device certificate, which is mykey.pem in this example), and save the file as final.pem.

Step 7  Create the All-certs.pem and final.pem files by entering these commands:

```bash
openssl> pkcs12 -export -in All-certs.pem -inkey mykey.pem
    -out All-certs.p12 -clcerts -passin pass:check123
    -passout pass:check123

openssl> pkcs12 -in All-certs.p12 -out final.pem
    -passin pass:check123 -passout pass:check123
```

`final.pem` is the file that we need to download to the controller.

**Note**  You must enter a password for the parameters `-passin` and `-passout`. The password that is configured for the `-passout` parameter must match the certpassword parameter that is configured on the controller. In the above example, the password that is configured for both the `-passin` and `-passout` parameters is check123.

---

What to Do Next

Download the final.pem file to the controller either using CLI or GUI.

---

### Downloading Third-Party Certificate (GUI)

**Step 1**  Copy the device certificate final.pem to the default directory on your TFTP server.

**Step 2**  Choose Security > Web Auth > Certificate to open the Web Authentication Certificate page.

**Step 3**  Check the Download SSL Certificate check box to view the Download SSL Certificate From Server parameters.

**Step 4**  In the Server IP Address text box, enter the IP address of the TFTP server.

**Step 5**  In the File Path text box, enter the directory path of the certificate.

**Step 6**  In the File Name text box, enter the name of the certificate.

**Step 7**  In the Certificate Password text box, enter the password to protect the certificate.

**Step 8**  Click Apply.

**Step 9**  After the download is complete, choose Commands > Reboot and click Save and Reboot.

**Step 10**  Click OK in order to confirm your decision to reboot the controller.
Downloading Third-Party Certificate (CLI)

**Step 1** Move the `final.pem` file to the default directory on your TFTP server. Change the download settings by entering the following commands:

(Cisco Controller) > `transfer download mode tftp`
(Cisco Controller) > `transfer download datatype webauthcert`
(Cisco Controller) > `transfer download serverip <TFTP server IP address>`
(Cisco Controller) > `transfer download path <absolute TFTP server path to the update file>`
(Cisco Controller) > `transfer download filename final.pem`

**Step 2** Enter the password for the `.pem` file so that the operating system can decrypt the SSL key and certificate.

(Cisco Controller) > `transfer download certpassword password`

**Note** Ensure that the value for `certpassword` is the same as the `-passout` parameter when you generate a CSR.

**Step 3** Start the certificate and key download by entering the this command: `transfer download start`

**Example:**

(Cisco Controller) > `transfer download start`

```
Mode................................. TFTP
Data Type.............................. Site Cert
TFTP Server IP....................... 10.77.244.196
TFTP Packet Timeout.................. 6
TFTP Max Retries..................... 10
TFTP Path............................. /
TFTP Filename........................ final.pem

This may take some time.
Are you sure you want to start? (y/N) y

TFTP EAP Dev cert transfer starting.
Certificate installed.
Reboot the switch to use new certificate.
```

**Step 4** Reboot the controller.
Using a Customized Web Authentication Login Page from an External Web Server

Information About Customized Web Authentication Login Page

You can customize the web authentication login page to redirect to an external web server. When you enable this feature, the user is directed to your customized login page on the external web server.

You must configure a preauthentication access control list (ACL) on the WLAN for the external web server and then choose this ACL as the WLAN preauthentication ACL under Security Policies > Web Policy on the WLANs > Edit page.

Guidelines and Limitations

You must configure a preauthentication access control list (ACL) on the WLAN for the external web server and then choose this ACL as the WLAN preauthentication ACL under Security Policies > Web Policy on the WLANs > Edit page.

Choosing a Customized Web Authentication Login Page from an External Web Server

Choosing a Customized Web Authentication Login Page from an External Web Server (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Security &gt; Web Auth &gt; Web Login Page to open the Web Login page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>From the Web Authentication Type drop-down list, choose External (Redirect to external server).</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Redirect URL after login text box, enter the URL that you want the user to be redirected after a login. For example, you may enter your company's URL here and the users will be directed to that URL after login. The maximum length is 254 characters. By default, the user is redirected to the URL that was entered in the user's browser before the login page was served. of the customized web authentication login page on your web server. You can enter up to 252 characters.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the External Webauth URL text box, enter the URL that is to be used for external web authentication.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Apply.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click Save Configuration.</td>
</tr>
</tbody>
</table>
Choosing a Customized Web Authentication Login Page from an External Web Server (CLI)

Step 1  Specify the web authentication type by entering this command:
        `config custom-web webauth_type external`

Step 2  Specify the URL of the customized web authentication login page on your web server by entering this command:
        `config custom-web ext-webauth-url url`
        You can enter up to 252 characters for the URL.

Step 3  Specify the IP address of your web server by entering this command:
        `config custom-web ext-webserver {add | delete} server_IP_address`

Step 4  Enter the `save config` command to save your settings.

Step 5  Follow the instructions in the Verifying the Web Authentication Login Page Settings (CLI), on page 700 section to verify your settings.

Additional References

See Configuring Security Solutions, on page 197 for more information on ACLs.

Downloading a Customized Web Authentication Login Page

You can compress the page and image files used for displaying a web authentication login page into a .tar file for download to a controller. These files are known as the webauth bundle. The maximum allowed size of the files in their uncompressed state is 1 MB. When the .tar file is downloaded from a local TFTP server, it enters the controller’s file system as an untarred file.

You can download a login page example from Cisco Prime Infrastructure and use it as a starting point for your customized login page. For more information, see the Cisco Prime Infrastructure documentation.

*Note*  If you load a webauth bundle with a .tar compression application that is not GNU compliant, the controller cannot extract the files in the bundle and the following error messages appear: “Extracting error” and “TFTP transfer failed.” Therefore, we recommend that you use an application that complies with GNU standards, such as PicoZip, to compress the .tar file for the webauth bundle.

*Note*  Configuration backups do not include extra files or components, such as the webauth bundle or external licenses, that you download and store on your controller, so you should manually save external backup copies of those files or components.
If the customized webauth bundle has more than 3 separated elements, we advise you to use an external server to prevent page load issues that may be caused because of TCP rate-limiting policy on the controller.

Prerequisites for Downloading a Customized Web Authentication Login Page

- Name the login page `login.html`. The controller prepares the web authentication URL based on this name. If the server does not find this file after the webauth bundle has been untarred, the bundle is discarded, and an error message appears.
- Include input text boxes for both a username and password.
- Retain the redirect URL as a hidden input item after extracting from the original URL.
- Extract and set the action URL in the page from the original URL.
- Include scripts to decode the return status code.
- Make sure that all paths used in the main page (to refer to images, for example).
- Ensure that no filenames within the bundle are greater than 30 characters.

Additional References

You can download a login page example from Cisco Prime Infrastructure and use it as a starting point for your customized login page. For more information, see the Cisco Prime Infrastructure documentation.

Downloading a Customized Web Authentication Login Page (GUI)

**Step 1**
Copy the `.tar` file containing your login page to the default directory on your server.

**Step 2**
Choose **Commands > Download File** to open the Download File to Controller page.

**Step 3**
From the **File Type** drop-down list, choose **Webauth Bundle**.

**Step 4**
From the **Transfer Mode** drop-down list, choose from the following options:

- TFTP
- FTP

**Step 5**
In the **IP Address** text box, enter the IP address of the server.

**Step 6**
If you are using a TFTP server, enter the maximum number of times the controller should attempt to download the `.tar` file in the Maximum Retries text box.
The range is 1 to 254.
The default is 10.
Managing User Accounts

Step 7  If you are using a TFTP server, enter the amount of time in seconds before the controller times out while attempting to download the *.tar file in the Timeout text box. The range is 1 to 254 seconds. The default is 6 seconds.

Step 8  In the File Path text box, enter the path of the .tar file to be downloaded. The default value is "/.

Step 9  In the File Name text box, enter the name of the .tar file to be downloaded.

Step 10  If you are using an FTP server, follow these steps:

  1  In the Server Login Username text box, enter the username to log into the FTP server.

  2  In the Server Login Password text box, enter the password to log into the FTP server.

  3  In the Server Port Number text box, enter the port number on the FTP server through which the download occurs. The default value is 21.

Step 11  Click Download to download the .tar file to the controller.

Step 12  Choose Security > Web Auth > Web Login Page to open the Web Login page.

Step 13  From the Web Authentication Type drop-down list, choose Customized (Downloaded).

Step 14  Click Apply.

Step 15  Click Preview to view your customized web authentication login page.

Step 16  If you are satisfied with the content and appearance of the login page, click Save Configuration.

Downloading a Customized Web Authentication Login Page (CLI)

Step 1  Copy the .tar file containing your login page to the default directory on your server.

Step 2  Specify the download mode by entering this command:

```bash
transfer download mode {tftp | ftp}
```

Step 3  Specify the type of file to be downloaded by entering this command:

```bash
transfer download datatype webauthbundle
```

Step 4  Specify the IP address of the TFTP server by entering this command:

```bash
transfer download serverip tftp-server-ip-address.
```

**Note**  Some TFTP servers require only a forward slash (/) as the TFTP server IP address, and the TFTP server automatically determines the path to the correct directory.

Step 5  Specify the download path by entering this command:

```bash
transfer download path absolute-tftp-server-path-to-file
```

Step 6  Specify the file to be downloaded by entering this command:

```bash
transfer download filename filename.tar
```

Step 7  View your updated settings and answer y to the prompt to confirm the current download settings and start the download by entering this command:
Step 8 Specify the web authentication type by entering this command:
`config custom-web weauth_type customized`

Step 9 Enter the `save config` command to save your settings.

Additional References

See Web Authentication Process.

Example: Customized Web Authentication Login Page

This figure shows an example of a customized web authentication login page.

Figure 95: Customized Web Authentication Login Page Example

Verifying the Web Authentication Login Page Settings (CLI)

Verify your changes to the web authentication login page by entering this command:
`show custom-web`
Assigning Login, Login Failure, and Logout Pages per WLAN

Information About Assigning Login, Login Failure, and Logout Pages per WLAN

You can display different web authentication login, login failure, and logout pages to users per WLAN. This feature enables user-specific web authentication pages to be displayed for a variety of network users, such as guest users or employees within different departments of an organization.

Different login pages are available for all web authentication types (internal, external, and customized). However, different login failure and logout pages can be specified only when you choose customized as the web authentication type.

Assigning Login, Login Failure, and Logout Pages per WLAN (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the WLAN to which you want to assign a web login, login failure, or logout page.
Step 3  Choose Security > Layer 3.
Step 4  Make sure that Web Policy and Authentication are selected.
Step 5  To override the global authentication configuration web authentication pages, select the Override Global Config check box.
Step 6  When the Web Auth Type drop-down list appears, choose one of the following options to define the web authentication pages for wireless guest users:

- **Internal**—Displays the default web login page for the controller. This is the default value.

- **Customized**—Displays custom web login, login failure, and logout pages. If you choose this option, three separate drop-down lists appear for login, login failure, and logout page selection. You do not need to define a customized page for all three options. Choose None from the appropriate drop-down list if you do not want to display a customized page for that option.

  **Note**  These optional login, login failure, and logout pages are downloaded to the controller as webauth.tar files.

- **External**—Redirects users to an external server for authentication. If you choose this option, you must also enter the URL of the external server in the URL text box.

  You can choose specific RADIUS or LDAP servers to provide external authentication on the WLANs > Edit (Security > AAA Servers) page. Additionally, you can define the priority in which the servers provide authentication.

  **Note**  The RADIUS and LDAP external servers must already be configured in order to be selectable options on the WLANs > Edit (Security > AAA Servers) page. You can configure these servers on the RADIUS Authentication Servers page and LDAP Servers page.

Step 7  If you chose External as the web authentication type in Step 6, choose AAA Servers and choose up to three RADIUS and LDAP servers using the drop-down lists.

Step 8  Establish the priority in which the servers are contacted to perform web authentication as follows:
Assigning Login, Login Failure, and Logout Pages per WLAN (CLI)

Step 1 Determine the ID number of the WLAN to which you want to assign a web login, login failure, or logout page by entering this command: `show wlan summary`

Step 2 If you want wireless guest users to log into a customized web login, login failure, or logout page, enter these commands to specify the filename of the web authentication page and the WLAN for which it should display:

- `config wlan custom-web login-page page_name wlan_id`—Defines a customized login page for a given WLAN.
- `config wlan custom-web loginfailure-page page_name wlan_id`—Defines a customized login failure page for a given WLAN.

  **Note**  To use the controller’s default login failure page, enter the `config wlan custom-web loginfailure-page none wlan_id` command.

- `config wlan custom-web logout-page page_name wlan_id`—Defines a customized logout page for a given WLAN.

  **Note**  To use the controller’s default logout page, enter the `config wlan custom-web logout-page none wlan_id` command.

Step 3 Redirect wireless guess users to an external server before accessing the web login page by entering this command to specify the URL of the external server:

`config wlan custom-web ext-webauth-url ext_web_url wlan_id`

Step 4 Define the order in which web authentication servers are contacted by entering this command:

`config wlan security web-auth server-precedence wlan_id {local | ldap | radius} {local | ldap | radius} {local | ldap | radius}`

The default order of server web authentication is local, RADIUS and LDAP.

**Note**  All external servers must be preconfigured on the controller. You can configure them on the RADIUS Authentication Servers page and the LDAP Servers page.
Step 5 Define which web authentication page displays for a wireless guest user by entering this command:
```
cfg wlan custom-web webauth-type \{internal \| customized \| external\} wlan_id
```
where
- **internal** displays the default web login page for the controller. This is the default value.
- **customized** displays the custom web login page that was configured in Step 2.
  
  **Note** You do not need to define the web authentication type in Step 5 for the login failure and logout pages as they are always customized.
- **external** redirects users to the URL that was configured in Step 3.

Step 6 Use a WLAN-specific custom web configuration rather than a global custom web configuration by entering this command:
```
cfg wlan custom-web global disable wlan_id
```
  
  **Note** If you enter the `cfg wlan custom-web global enable wlan_id` command, the custom web authentication configuration at the global level is used.

Step 7 Save your changes by entering this command:
```
save config
```

---

### Configuring Wired Guest Access

#### Information About Wired Guest Access

Wired guest access enables guest users to connect to the guest access network from a wired Ethernet connection designated and configured for guest access. Wired guest access ports might be available in a guest office or through specific ports in a conference room. Like wireless guest user accounts, wired guest access ports are added to the network using the lobby ambassador feature.

Wired guest access can be configured in a standalone configuration or in a dual-controller configuration that uses both an anchor controller and a foreign controller. This latter configuration is used to further isolate wired guest access traffic but is not required for deployment of wired guest access.

Wired guest access ports initially terminate on a Layer 2 access switch or switch port configured with VLAN interfaces for wired guest access traffic. The wired guest traffic is then trunked from the access switch to a controller. This controller is configured with an interface that is mapped to a wired guest access VLAN on the access switch.

**Note** Although wired guest access is managed by anchor and foreign anchors when two controllers are deployed, mobility is not supported for wired guest access clients. In this case, DHCP and web authentication for the client are handled by the anchor controller.
You can specify the amount of bandwidth allocated to a wired guest user in the network by configuring a QoS role and a bandwidth contract.

You can create a basic peer to peer WLAN ACL and apply it to the wired guest WLAN. This will not block peer to peer traffic and the guest users can still communicate with each other.

**Note**

**Prerequisites for Configuring Wired Guest Access**

To configure wired guest access on a wireless network, you must perform the following:

1. Configure a dynamic interface (VLAN) for wired guest user access
2. Create a wired LAN for guest user access
3. Configure the controller
4. Configure the anchor controller (if terminating traffic on another controller)
5. Configure security for the guest LAN
6. Verify the configuration

**Restrictions for Configuring Wired Guest Access**

- Wired guest access interfaces must be tagged.
- Wired guest access ports must be in the same Layer 2 network as the foreign controller.
- Up to five wired guest access LANs can be configured on a controller. Also in a wired guest access LAN, multiple anchors are supported.
- Layer 3 web authentication and web passthrough are supported for wired guest access clients. Layer 2 security is not supported.
- Do not trunk a wired guest VLAN to multiple foreign controllers, as it might produce unpredictable results.
- The controller does not use the callStationIDType parameter configured for the Radius server while authenticating wired clients, instead the controller uses the system MAC address configured for the callStationIDType parameter.
Configuring Wired Guest Access

Configuring Wired Guest Access (GUI)

Step 1 To create a dynamic interface for wired guest user access, choose Controller > Interfaces. The Interfaces page appears.
Step 2 Click New to open the Interfaces > New page.
Step 3 Enter a name and VLAN ID for the new interface.
Step 4 Click Apply to commit your changes.
Step 5 In the Port Number text box, enter a valid port number. You can enter a number between 0 and 25 (inclusive).
Step 6 Select the Guest LAN check box.
Step 7 Click Apply to commit your changes.
Step 8 To create a wired LAN for guest user access, choose WLANs.
Step 9 On the WLANs page, choose Create New from the drop-down list and click Go. The WLANs > New page appears.
Step 10 From the Type drop-down list, choose Guest LAN.
Step 11 In the Profile Name text box, enter a name that identifies the guest LAN. Do not use any spaces.
Step 12 From the WLAN ID drop-down list, choose the ID number for this guest LAN.
Note You can create up to five guest LANs, so the WLAN ID options are 1 through 5 (inclusive).
Step 13 Click Apply to commit your changes.
Step 14 Select the Enabled check box for the Status parameter.
Step 15 Web authentication (Web-Auth) is the default security policy. If you want to change this to web passthrough, choose the Security tab after completing Step 16 and Step 17.
Step 16 From the Ingress Interface drop-down list, choose the VLAN that you created in Step 3. This VLAN provides a path between the wired guest client and the controller by way of the Layer 2 access switch.
Step 17 From the Egress Interface drop-down list, choose the name of the interface. This WLAN provides a path out of the controller for wired guest client traffic.
Step 18 If you want to change the authentication method (for example, from web authentication to web passthrough), choose Security > Layer 3. The WLANs > Edit (Security > Layer 3) page appears.
Step 19 From the Layer 3 Security drop-down list, choose one of the following:

- **None**—Layer 3 security is disabled.
- **Web Authentication**—Causes users to be prompted for a username and password when connecting to the wireless network. This is the default value.
- **Web Passthrough**—Allows users to access the network without entering a username and password.

Note There should not be a Layer 3 gateway on the guest wired VLAN, as this would bypass the web authentication done through the controller.
Step 20 If you choose the Web Passthrough option, an Email Input check box appears. Select this check box if you want users to be prompted for their e-mail address when attempting to connect to the network.

Step 21 To override the global authentication configuration set on the Web Login page, select the Override Global Config check box.

Step 22 When the Web Auth Type drop-down list appears, choose one of the following options to define the web authentication pages for wired guest users:

- **Internal**—Displays the default web login page for the controller. This is the default value.
- **Customized**—Displays custom web login, login failure, and logout pages. If you choose this option, three separate drop-down lists appear for login, login failure, and logout page selection. You do not need to define a customized page for all three options. Choose None from the appropriate drop-down list if you do not want to display a customized page for that option.

  **Note** These optional login, login failure, and logout pages are downloaded to the controller as webauth.tar files.
- **External**—Redirects users to an external server for authentication. If you choose this option, you must also enter the URL of the external server in the URL text box.

  You can choose specific RADIUS or LDAP servers to provide external authentication on the WLANs > Edit (Security > AAA Servers) page. Additionally, you can define the priority in which the servers provide authentication.

Step 23 If you chose External as the web authentication type in Step 22, choose Security > AAA Servers and choose up to three RADIUS and LDAP servers using the drop-down lists.

  **Note** You can configure the Authentication and LDAP Server using both IPv4 and IPv6 addresses.

  **Note** The RADIUS and LDAP external servers must already be configured in order to be selectable options on the WLANs > Edit (Security > AAA Servers) page. You can configure these servers on the RADIUS Authentication Servers page and LDAP Servers page.

Step 24 To establish the priority in which the servers are contacted to perform web authentication as follows:

  **Note** The default order is local, RADIUS, LDAP.

  1. Highlight the server type (local, RADIUS, or LDAP) that you want to be contacted first in the box next to the Up and Down buttons.

  2. Click Up and Down until the desired server type is at the top of the box.

  3. Click the < arrow to move the server type to the priority box on the left.

  4. Repeat these steps to assign priority to the other servers.

Step 25 Click Apply.

Step 26 Click Save Configuration.

Step 27 Repeat this process if a second (anchor) controller is being used in the network.
Configuring Wired Guest Access (CLI)

**Step 1** Create a dynamic interface (VLAN) for wired guest user access by entering this command:

```
config interface create interface_name vlan_id
```

**Step 2** If link aggregation trunk is not configured, enter this command to map a physical port to the interface:

```
config interface port interface_name primary_port secondary_port
```

**Step 3** Enable or disable the guest LAN VLAN by entering this command:

```
config interface guest-lan interface_name {enable | disable}
```

This VLAN is later associated with the ingress interface created in Step 5.

**Step 4** Create a wired LAN for wired client traffic and associate it to an interface by entering this command:

```
config guest-lan create guest_lan_id interface_name
```

The guest LAN ID must be a value between 1 and 5 (inclusive).

**Note** To delete a wired guest LAN, enter the `config guest-lan delete guest_lan_id` command.

**Step 5** Configure the wired guest VLAN’s ingress interface, which provides a path between the wired guest client and the controller by way of the Layer 2 access switch by entering this command:

```
config guest-lan ingress-interface guest_lan_id interface_name
```

**Step 6** Configure an egress interface to transmit wired guest traffic out of the controller by entering this command:

```
config guest-lan egress-interface guest_lan_id interface_name
```

**Note** If the wired guest traffic is terminating on another controller, repeat Step 4 and Step 6 for the terminating (anchor) controller and Step 1 through Step 5 for the originating (foreign) controller. Additionally, configure the `config mobility group anchor add {guest-lan guest_lan_id} wlan wlan_id IP_address` command for both controllers.

**Step 7** Configure the security policy for the wired guest LAN by entering this command:

```
config guest-lan security {web-auth enable guest_lan_id | web-passthrough enable guest_lan_id}
```

**Note** Web authentication is the default setting.

**Step 8** Enable or disable a wired guest LAN by entering this command:

```
config guest-lan {enable | disable} guest_lan_id
```

**Step 9** If you want wired guest users to log into a customized web login, login failure, or logout page, enter these commands to specify the filename of the web authentication page and the guest LAN for which it should display:

- **config guest-lan custom-web login-page page_name guest_lan_id**—Defines a web login page.

- **config guest-lan custom-web loginfailure-page page_name guest_lan_id**—Defines a web login failure page.

  **Note** To use the controller’s default login failure page, enter the `config guest-lan custom-web loginfailure-page none guest_lan_id` command.

- **config guest-lan custom-web logout-page page_name guest_lan_id**—Defines a web logout page.

  **Note** To use the controller’s default logout page, enter the `config guest-lan custom-web logout-page none guest_lan_id` command.
Step 10  If you want wired guest users to be redirected to an external server before accessing the web login page, enter this command to specify the URL of the external server:

```bash
config guest-lan custom-web ext-webauth-url ext_web_url guest_lan_id
```

Step 11  If you want to define the order in which local (controller) or external (RADIUS, LDAP) web authentication servers are contacted, enter this command:

```bash
config wlan security web-auth server-precedence wlan_id {local | ldap | radius} {local | ldap | radius} {local | ldap | radius}
```

The default order of server web authentication is local, RADIUS, LDAP.

**Note**  All external servers must be preconfigured on the controller. You can configure them on the RADIUS Authentication Servers page or the LDAP Servers page.

Step 12  Define the web login page for wired guest users by entering this command:

```bash
config guest-lan custom-web webauth-type {internal | customized | external} guest_lan_id
```

where

- **internal** displays the default web login page for the controller. This is the default value.
- **customized** displays the custom web pages (login, login failure, or logout) that were configured in Step 9.
- **external** redirects users to the URL that was configured in Step 10.

Step 13  Use a guest-LAN specific custom web configuration rather than a global custom web configuration by entering this command:

```bash
config guest-lan custom-web global disable guest_lan_id
```

**Note**  If you enter the `config guest-lan custom-web global enable guest_lan_id` command, the custom web authentication configuration at the global level is used.

Step 14  Save your changes by entering this command:

```bash
save config
```

**Note**  Information on the configured web authentication appears in both the `show run-config` and `show running-config` commands.

Step 15  Display the customized web authentication settings for a specific guest LAN by entering this command:

```bash
show custom-web {all | guest-lan guest_lan_id}
```

**Note**  If internal web authentication is configured, the Web Authentication Type displays as internal rather than external (controller level) or customized (WLAN profile level).

Step 16  Display a summary of the local interfaces by entering this command:

```bash
show interface summary
```

**Note**  The interface name of the wired guest LAN in this example is `wired-guest` and its VLAN ID is 236.

Display detailed interface information by entering this command:

```bash
show interface detailed interface_name
```

Step 17  Display the configuration of a specific wired guest LAN by entering this command:

```bash
show guest-lan guest_lan_id
```

**Note**  Enter the `show guest-lan summary` command to see all wired guest LANs configured on the controller.

Step 18  Display the active wired guest LAN clients by entering this command:

```bash
show client summary guest-lan
```
**Supporting IPv6 Client Guest Access**

The client is in WebAuth Required state until the client is authenticated. The controller intercepts both IPv4 and IPv6 traffic in this state and redirects it to the virtual IP address of the controller. Once authenticated, the user's MAC address is moved to the run state and both IPv4 and IPv6 traffic is allowed to pass.

In order to support the redirection of IPv6-only clients, the controller automatically creates an IPv6 virtual address based on the IPv4 virtual address configured on the controller. The virtual IPv6 address follows the convention of [::ffff:<virtual IPv4 address>]. For example, a virtual IP address of 192.0.2.1 would translate into [::ffff:192.0.2.1]. For an IPv6 captive portal to be displayed, the user must request an IPv6 resolvable DNS entry such as ipv6.google.com which returns a DNSv6 (AAAA) record.
Radio Resource Management

- Information About Radio Resource Management, page 711
- Restrictions for Configuring RRM, page 715
- Configuring RRM, page 716
- Configuring Off-Channel Scanning Defer, page 719
- Configuring RRM Neighbor Discovery Packets, page 731
- Configuring RF Groups, page 732
- Overriding RRM, page 737
- Configuring Rogue Access Point Detection in RF Groups, page 743
- Configuring CCX Radio Management Features, page 744

Information About Radio Resource Management

The Radio Resource Management (RRM) software embedded in the Cisco Wireless LAN Controller acts as a built-in RF engineer to consistently provide real-time RF management of your wireless network. RRM enables Cisco WLCs to continually monitor their associated lightweight access points for the following information:

- Traffic load—The total bandwidth used for transmitting and receiving traffic. It enables wireless LAN managers to track and plan network growth ahead of client demand.
- Interference—The amount of traffic coming from other 802.11 sources.
- Noise—The amount of non-802.11 traffic that is interfering with the currently assigned channel.
- Coverage—The received signal strength (RSSI) and signal-to-noise ratio (SNR) for all connected clients.
- Other—The number of nearby access points.

Using this information, RRM can periodically reconfigure the 802.11 RF network for best efficiency. To do this, RRM performs these functions:

- Radio resource monitoring
• Transmit power control
• Dynamic channel assignment
• Coverage hole detection and correction

Radio Resource Monitoring

RRM automatically detects and configures new Cisco WLCs and lightweight access points as they are added to the network. It then automatically adjusts associated and nearby lightweight access points to optimize coverage and capacity.

Lightweight access points can simultaneously scan all valid 802.11a/b/g channels for the country of operation as well as for channels available in other locations. The access points go "off-channel" for a period not greater than 60 ms to monitor these channels for noise and interference. Packets collected during this time are analyzed to detect rogue access points, rogue clients, ad-hoc clients, and interfering access points.

Note
In the presence of voice traffic (in the last 100 ms), the access points defer off-channel measurements.

Each access point spends only 0.2 percent of its time off-channel. This activity is distributed across all access points so that adjacent access points are not scanning at the same time, which could adversely affect wireless LAN performance.

Note
When there are numerous rogue access points in the network, the chance of detecting rogues on channels 157 or 161 by a FlexConnect or local mode access point is small. In such cases, the monitor mode AP can be used for rogue detection.

Transmit Power Control

The Cisco WLC dynamically controls access point transmit power based on real-time wireless LAN conditions. You can choose between two versions of transmit power control: TPCv1 and TPCv2. With TPCv1, typically, power can be kept low to gain extra capacity and reduce interference. With TPCv2, transmit power is dynamically adjusted with the goal of minimum interference. TPCv2 is suitable for dense networks. In this mode, there could be higher roaming delays and coverage hole incidents.

The Transmit Power Control (TPC) algorithm both increases and decreases an access point's power in response to changes in the RF environment. In most instances, TPC seeks to lower an access point's power to reduce interference, but in the case of a sudden change in the RF coverage—for example, if an access point fails or becomes disabled—TPC can also increase power on surrounding access points. This feature is different from coverage hole detection, which is primarily concerned with clients. TPC provides enough RF power to achieve desired coverage levels while avoiding channel interference between access points.

These documents provide more information on Transmit Power Control values for the following access points:


Overriding the TPC Algorithm with Minimum and Maximum Transmit Power Settings

The TPC algorithm balances RF power in many diverse RF environments. However, it is possible that automatic power control will not be able to resolve some scenarios in which an adequate RF design was not possible to implement due to architectural restrictions or site restrictions—for example, when all access points must be mounted in a central hallway, placing the access points close together, but requiring coverage out to the edge of the building.

In these scenarios, you can configure maximum and minimum transmit power limits to override TPC recommendations. The maximum and minimum TPC power settings apply to all access points through RF profiles in a RF network.

To set the Maximum Power Level Assignment and Minimum Power Level Assignment, enter the maximum and minimum transmit power used by RRM in the text boxes in the Tx Power Control page. The range for these parameters is -10 to 30 dBm. The minimum value cannot be greater than the maximum value; the maximum value cannot be less than the minimum value.

If you configure a maximum transmit power, RRM does not allow any access point attached to the controller to exceed this transmit power level (whether the power is set by RRM TPC or by coverage hole detection). For example, if you configure a maximum transmit power of 11 dBm, then no access point would transmit above 11 dBm, unless the access point is configured manually.

Dynamic Channel Assignment

Two adjacent access points on the same channel can cause either signal contention or signal collision. In a collision, data is not received by the access point. This functionality can become a problem, for example, when someone reading e-mail in a café affects the performance of the access point in a neighboring business. Even though these are completely separate networks, someone sending traffic to the café on channel 1 can disrupt communication in an enterprise using the same channel. Controllers can dynamically allocate access point channel assignments to avoid conflict and to increase capacity and performance. Channels are “reused” to avoid wasting scarce RF resources. In other words, channel 1 is allocated to a different access point far from the café, which is more effective than not using channel 1 altogether.

The controller’s Dynamic Channel Assignment (DCA) capabilities are also useful in minimizing adjacent channel interference between access points. For example, two overlapping channels in the 802.11b/g band, such as 1 and 2, cannot both simultaneously use 11/54 Mbps. By effectively reassigning channels, the controller keeps adjacent channels separated.

We recommend that you use only non-overlapping channels (1, 6, 11, and so on).

The controller examines a variety of real-time RF characteristics to efficiently handle channel assignments as follows:

- Access point received energy—The received signal strength measured between each access point and its nearby neighboring access points. Channels are optimized for the highest network capacity.
• Noise—Noise can limit signal quality at the client and access point. An increase in noise reduces the effective cell size and degrades user experience. By optimizing channels to avoid noise sources, the controller can optimize coverage while maintaining system capacity. If a channel is unusable due to excessive noise, that channel can be avoided.

• 802.11 Interference—Interference is any 802.11 traffic that is not part of your wireless LAN, including rogue access points and neighboring wireless networks. Lightweight access points constantly scan all channels looking for sources of interference. If the amount of 802.11 interference exceeds a predefined configurable threshold (the default is 10 percent), the access point sends an alert to the controller. Using the RRM algorithms, the controller may then dynamically rearrange channel assignments to increase system performance in the presence of the interference. Such an adjustment could result in adjacent lightweight access points being on the same channel, but this setup is preferable to having the access points remain on a channel that is unusable due to an interfering foreign access point.

In addition, if other wireless networks are present, the controller shifts the usage of channels to complement the other networks. For example, if one network is on channel 6, an adjacent wireless LAN is assigned to channel 1 or 11. This arrangement increases the capacity of the network by limiting the sharing of frequencies. If a channel has virtually no capacity remaining, the controller may choose to avoid this channel. In very dense deployments in which all nonoverlapping channels are occupied, the controller does its best, but you must consider RF density when setting expectations.

• Load and utilization—When utilization monitoring is enabled, capacity calculations can consider that some access points are deployed in ways that carry more traffic than other access points (for example, a lobby versus an engineering area). The controller can then assign channels to improve the access point with the worst performance reported. The load is taken into account when changing the channel structure to minimize the impact on clients currently in the wireless LAN. This metric keeps track of every access point’s transmitted and received packet counts to determine how busy the access points are. New clients avoid an overloaded access point and associate to a new access point. This parameter is disabled by default.

The controller combines this RF characteristic information with RRM algorithms to make system-wide decisions. Conflicting demands are resolved using soft-decision metrics that guarantee the best choice for minimizing network interference. The end result is optimal channel configuration in a three-dimensional space, where access points on the floor above and below play a major factor in an overall wireless LAN configuration.

**Note**

Radios using 40-MHz channels in the 2.4-GHz band or or 80MHz channels are not supported by DCA.

The RRM startup mode is invoked in the following conditions:

• In a single-controller environment, the RRM startup mode is invoked after the controller is upgraded and rebooted.

• In a multiple-controller environment, the RRM startup mode is invoked after an RF Group leader is elected.

You can trigger RRM startup mode from CLI.

RRM startup mode runs for 100 minutes (10 iterations at 10-minute intervals). The duration of the RRM startup mode is independent of the DCA interval, sensitivity, and network size. The startup mode consists of 10 DCA runs with high sensitivity (making channel changes easy and sensitive to the environment) to converge to a steady state channel plan. After the startup mode is finished, DCA continues to run at the specified interval and sensitivity.
DCA algorithm interval is set to one hour, but DCA algorithm always runs in default interval of 10min, channel allocation happens for every 10min interval for the first 10 cycles, and channel changes as per DCA algorithm for every 10min. After that it goes back to the configured time interval. This is common for both DCA interval and Anchor time since it follows the steady state.

Note

If DCA/TPC is turned off on the RF-group member, and auto is set on RF-group leader, the channel/TX power on member gets changed as per the algorithm run on the RF-group leader.

Coverage Hole Detection and Correction

The RRM coverage hole detection algorithm can detect areas of radio coverage in a wireless LAN that are below the level needed for robust radio performance. This feature can alert you to the need for an additional (or relocated) lightweight access point.

If clients on a lightweight access point are detected at threshold levels (RSSI, failed client count, percentage of failed packets, and number of failed packets) lower than those specified in the RRM configuration, the access point sends a "coverage hole" alert to the controller. The alert indicates the existence of an area where clients are continually experiencing poor signal coverage, without having a viable access point to which to roam. The controller discriminates between coverage holes that can and cannot be corrected. For coverage holes that can be corrected, the controller mitigates the coverage hole by increasing the transmit power level for that specific access point. The controller does not mitigate coverage holes caused by clients that are unable to increase their transmit power or are statically set to a power level because increasing their downstream transmit power might increase interference in the network.

Benefits of RRM

RRM produces a network with optimal capacity, performance, and reliability. It frees you from having to continually monitor the network for noise and interference problems, which can be transient and difficult to troubleshoot. RRM ensures that clients enjoy a seamless, trouble-free connection throughout the Cisco unified wireless network.

RRM uses separate monitoring and control for each deployed network: 802.11a and 802.11b/g. The RRM algorithms run separately for each radio type (802.11a and 802.11b/g). RRM uses both measurements and algorithms. RRM measurements can be adjusted using monitor intervals, but they cannot be disabled. RRM algorithms are enabled automatically but can be disabled by statically configuring channel and power assignment. The RRM algorithms run at a specified updated interval, which is 600 seconds by default.

Restrictions for Configuring RRM

- The OEAP 600 series access points do not support RRM. The radios for the 600 series OEAP access points are controlled through the local GUI of the 600 series access points and not through the Cisco WLC. Attempting to control the spectrum channel or power, or disabling the radios through the Cisco WLC will fail to have any effect on the 600 series OEAP.
Configuring RRM

The controller’s preconfigured RRM settings are optimized for most deployments. However, you can modify the controller’s RRM configuration parameters at any time through either the GUI or the CLI.

Note You can configure these parameters on controllers that are part of an RF group or on controllers that are not part of an RF group.

Note The RRM parameters should be set to the same values on every controller in an RF group. The RF group leader can change as a result of controller reboots or depending on which radios hear each other. If the RRM parameters are not identical for all RF group members, varying results can occur when the group leader changes.

Using the controller GUI, you can configure the following RRM parameters: RF group mode, transmit power control, dynamic channel assignment, coverage hole detection, profile thresholds, monitoring channels, and monitor intervals.

Configuring the RF Group Mode (GUI)

Step 1 Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > RF Grouping to open the 802.11a (or 802.11b/g) RRM > RF Grouping page.

Step 2 From the Group Mode drop-down list, select the mode you want to configure for this Cisco WLC. You can configure RF grouping in the following modes:

- **auto**—Sets the RF group selection to automatic update mode.
  
  **Note** This mode does not support IPv6 based configuration.

- **leader**—Sets the RF group selection to static mode, and sets this Cisco WLC as the group leader.
  
  **Note** Leader supports static IPv6 address.

  **Note** If a RF group member is configured using IPv4 address, then IPv4 address is used to communicate with the leader. The same is applicable for a RF group member configured using IPv6 too.

- **off**—Sets the RF group selection off. Every Cisco WLC optimizes its own access point parameters.

  **Note** A configured static leader cannot become a member of another Cisco WLC until its mode is set to “auto”.

  **Note** A Cisco WLC with a lower priority cannot assume the role of a group leader if a Cisco WLC with a higher priority is available. Here priority is related to the processing power of the Cisco WLC.

  **Note** We recommend that Cisco WLCs participate in automatic RF grouping. You can override RRM settings without disabling automatic RF group participation.

Step 3 Click **Apply** to save the configuration and click **Restart** to restart RRM RF Grouping algorithm.

Step 4 If you configured RF Grouping mode for this Cisco WLC as a static leader, you can add group members from the RF Group Members section as follows:
1 In the Cisco WLC Name text box, enter the Cisco WLC that you want to add as a member to this group.

2 In the IP Address (IPv4/IPv6) text box, enter the IPv4/IPv6 address of the RF Group Member.

3 Click Add Member to add the member to this group.

Note If the member has not joined the static leader, the reason of the failure is shown in parentheses.

Step 5 Click Apply.
Step 6 Click Save Configuration.

Configuring the RF Group Mode (CLI)

Step 1 Configure the RF Grouping mode by entering this command:
```plaintext
config advanced {802.11a | 802.11b} group-mode {auto | leader | off | restart}
```
- `auto`—Sets the RF group selection to automatic update mode.
- `leader`—Sets the RF group selection to static mode, and sets this Cisco WLC as the group leader.
  
  Note If a group member is configured with IPv4 address, then IPv4 address is used to communicate with a leader and vice versa with IPv6 also.
- `off`—Sets the RF group selection off. Every Cisco WLC optimizes its own access point parameters.
- `restart`—Restarts the RF group selection.

Note A configured static leader cannot become a member of another Cisco WLC until its mode is set to "auto".

Note A Cisco WLC with a lower priority cannot assume the role of a group leader if a Cisco WLC with higher priority is available. Here priority is related to the processing power of the Cisco WLC.

Step 2 Add or remove a Cisco WLC as a static member of the RF group (if the mode is set to "leader") by entering the these commands:
```plaintext
• config advanced {802.11a | 802.11b} group-member add controller_name ipv4/ipv6_address
• config advanced {802.11a | 802.11b} group-member remove controller_name ipv4/ipv6_address
```

Note You can add RF Group Members using either IPv4 or IPv6 address.

Step 3 See RF grouping status by entering this command:
```plaintext
show advanced {802.11a | 802.11b} group
```
Configuring Transmit Power Control (GUI)

**Step 1**
Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > TPC to open the 802.11a/n (or 802.11b/g/n) > RRM > Tx Power Control (TPC) page.

**Step 2**
Choose the Transmit Power Control version from the following options:

- **Interference Optimal Mode (TPCv2)**—For scenarios where voice calls are extensively used. Transmit power is dynamically adjusted with the goal of minimum interference. It is suitable for dense networks. In this mode, there could be higher roaming delays and coverage hole incidents.

  **Note** We recommend that you use TCPv2 only in cases where RF issues cannot be resolved by using TCPv1. Please evaluate and test the use of TCPv2 with the assistance of Cisco Services.

- **Coverage Optimal Mode (TCPv1)**—(Default) Offers strong signal coverage and stability. In this mode, power can be kept low to gain extra capacity and reduce interference.

**Step 3**
Choose one of the following options from the Power Level Assignment Method drop-down list to specify the Cisco WLC’s dynamic power assignment mode:

- **Automatic**—Causes the Cisco WLC to periodically evaluate and, if necessary, update the transmit power for all joined access points. This is the default value.

- **On Demand**—Causes the Cisco WLC to periodically evaluate the transmit power for all joined access points. However, the Cisco WLC updates the power, if necessary, only when you click **Invoke Power Update Now**.

  **Note** The Cisco WLC does not evaluate and update the transmit power immediately after you click **Invoke Power Update Now**. It waits for the next 600-second interval. This value is not configurable.

- **Fixed**—Prevents the Cisco WLC from evaluating and, if necessary, updating the transmit power for joined access points. The power level is set to the fixed value chosen from the drop-down list.

  **Note** The transmit power level is assigned an integer value instead of a value in mW or dBm. The integer corresponds to a power level that varies depending on the regulatory domain, channel, and antennas in which the access points are deployed.

  **Note** For optimal performance, we recommend that you use the Automatic setting.

**Step 4**
Enter the maximum and minimum power level assignment values in the Maximum Power Level Assignment and Minimum Power Level Assignment text boxes.

The range for the Maximum Power Level Assignment is −10 to 30 dBm.

The range for the Minimum Power Level Assignment is −10 to 30 dBm.

**Step 5**
In the Power Threshold text box, enter the cutoff signal level used by RRM when determining whether to reduce an access point’s power. The default value for this parameter is −70 dBm for TCPv1 and −67 dBm for TCPv2, but can be changed when access points are transmitting at higher (or lower) than desired power levels.

The range for this parameter is −80 to −50 dBm. Increasing this value (between −65 and −50 dBm) causes the access points to operate at a higher transmit power. Decreasing the value has the opposite effect.

In applications with a dense population of access points, it may be useful to decrease the threshold to −80 or −75 dBm to reduce the number of BSSIDs (access points) and beacons seen by the wireless clients. Some wireless clients might
have difficulty processing a large number of BSSIDs or a high beacon rate and might exhibit problematic behavior with the default threshold.

This page also shows the following nonconfigurable transmit power level parameter settings:

- **Power Neighbor Count**—The minimum number of neighbors an access point must have for the transmit power control algorithm to run.
- **Power Assignment Leader**—The MAC address of the RF group leader, which is responsible for power level assignment.
- **Last Power Level Assignment**—The last time RRM evaluated the current transmit power level assignments.

**Step 6** Click **Apply**.

**Step 7** Click **Save Configuration**.

---

### Configuring Off-Channel Scanning Defer

#### Information About Off-Channel Scanning Defer

In deployments with certain power-save clients, you sometimes need to defer the Radio Resource Management's (RRM) normal off-channel scanning to avoid missing critical information from low-volume clients (for example, medical devices that use power-save mode and periodically send telemetry information). This feature improves the way that Quality of Service (QoS) interacts with the RRM scan defer feature.

You can use a client's Wi-Fi Multimedia (WMM) UP marking to configure the access point to defer off-channel scanning for a configurable period of time if it receives a packet marked UP.

Off-Channel Scanning Defer is essential to the operation of RRM, which gathers information about alternate channel choices such as noise and interference. Additionally, Off-Channel Scanning Defer is responsible for rogue detection. Devices that need to defer Off-Channel Scanning Defer should use the same WLAN as often as possible. If there are many of these devices (and the possibility exists that Off-Channel Defer scanning could be completely disabled by the use of this feature), you should implement an alternative to local AP Off-Channel Scanning Defer, such as monitoring access points, or other access points in the same location that do not have this WLAN assigned.

You can assign a QoS policy (bronze, silver, gold, and platinum) to a WLAN to affect how packets are marked on the downlink connection from the access point regardless of how they were received on the uplink from the client. UP=1,2 is the lowest priority, and UP=0,3 is the next higher priority. The marking results of each QoS policy are as follows:

- **Bronze** marks all downlink traffic to UP=1.
- **Silver** marks all downlink traffic to UP=0.
- **Gold** marks all downlink traffic to UP=4.
- **Platinum** marks all downlink traffic to UP=6.
Configuring Off-Channel Scanning Defer for WLANs

Configuring Off-Channel Scanning Defer for a WLAN (GUI)

Step 1  Choose WLANs to open the WLANs page.
Step 2  Click the ID number of the WLAN to which you want to configure off-channel scanning Defer.
Step 3  Choose the Advanced tab from the WLANs > Edit page.
Step 4  From the Off Channel Scanning Defer section, set the Scan Defer Priority by clicking on the priority argument.
Step 5  Set the time in milliseconds in the Scan Defer Time text box.
Valid values are 100 through 60000. The default value is 100 milliseconds.
Step 6  Click Apply to save your configuration.

Configuring Off Channel Scanning Defer for a WLAN (CLI)

Step 1  Assign a defer-priority for the channel scan by entering this command:

```
config wlan channel-scan defer-priority priority [enable | disable] WLAN-id
```

The valid range for the priority argument is 0 to 7.
The priority is 0 to 7 (this value should be set to 6 on the client and on the WLAN).
Use this command to configure the amount of time that scanning will be deferred following an UP packet in the queue.

Step 2  Assign the channel scan defer time (in milliseconds) by entering this command:

```
config wlan channel-scan defer-time msec WLAN-id
```

The time value is in milliseconds (ms) and the valid range is 100 (default) to 60000 (60 seconds). This setting should match the requirements of the equipment on your wireless LAN.
You can also configure this feature on the Cisco WLC GUI by selecting WLANs, and either edit an existing WLAN or create a new one.

Configuring Dynamic Channel Assignment (GUI)

You can specify the channels that the dynamic channel assignment (DCA) algorithm considers when selecting the channels to be used for RRM scanning by using the Cisco WLC GUI.
This functionality is helpful when you know that the clients do not support certain channels because they are legacy devices or they have certain regulatory restrictions.

**Step 1** Disable the 802.11a/n or 802.11b/g/n network as follows:

a) Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the Global Parameters page.

b) Unselect the 802.11a (or 802.11b/g) Network Status check box.

c) Click Apply.

**Step 2** Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > DCA to open the Dynamic Channel Assignment (DCA) page.

**Step 3** Choose one of the following options from the Channel Assignment Method drop-down list to specify the Cisco WLC’s DCA mode:

- **Automatic**—Causes the Cisco WLC to periodically evaluate and, if necessary, update the channel assignment for all joined access points. This is the default value.

- **Freeze**—Causes the Cisco WLC to evaluate and update the channel assignment for all joined access points, if necessary, but only when you click Invoke Channel Update Once.

  **Note** The Cisco WLC does not evaluate and update the channel assignment immediately after you click Invoke Channel Update Once. It waits for the next interval to elapse.

- **OFF**—Turns off DCA and sets all access point radios to the first channel of the band, which is the default value. If you choose this option, you must manually assign channels on all radios.

  **Note** For optimal performance, we recommend that you use the Automatic setting. See the Disabling Dynamic Channel and Power Assignment (GUI), on page 742 section for instructions on how to disable the Cisco WLC’s dynamic channel and power settings.

**Step 4** From the Interval drop-down list, choose one of the following options to specify how often the DCA algorithm is allowed to run: **10 minutes, 1 hour, 2 hours, 3 hours, 4 hours, 6 hours, 8 hours, 12 hours, or 24 hours**. The default value is 10 minutes.

  **Note** If your Cisco WLC supports only OfficeExtend access points, we recommend that you set the DCA interval to 6 hours for optimal performance. For deployments with a combination of OfficeExtend access points and local access points, the range of 10 minutes to 24 hours can be used.

**Step 5** From the AnchorTime drop-down list, choose a number to specify the time of day when the DCA algorithm is to start. The options are numbers between 0 and 23 (inclusive) representing the hour of the day from 12:00 a.m. to 11:00 p.m.

**Step 6** Select the **Avoid Foreign AP Interference** check box to cause the Cisco WLC’s RRM algorithms to consider 802.11 traffic from foreign access points (those not included in your wireless network) when assigning channels to lightweight access points, or unselect it to disable this feature. For example, RRM may adjust the channel assignment to have access points avoid channels close to foreign access points. The default value is selected.

**Step 7** Select the **Avoid Cisco AP Load** check box to cause the Cisco WLC’s RRM algorithms to consider 802.11 traffic from Cisco lightweight access points in your wireless network when assigning channels, or unselect it to disable this feature. For example, RRM can assign better reuse patterns to access points that carry a heavier traffic load. The default value is unselected.

**Step 8** Select the **Avoid Non-802.11a (802.11b) Noise** check box to cause the Cisco WLC’s RRM algorithms to consider noise (non-802.11 traffic) in the channel when assigning channels to lightweight access points, or unselect it to disable this.
feature. For example, RRM may have access points avoid channels with significant interference from nonaccess point sources, such as microwave ovens. The default value is selected.

**Step 9**
Select the **Avoid Persistent Non-WiFi Interference** check box to enable the Cisco WLC to ignore persistent non-WiFi interference.

**Step 10**
From the **DCA Channel Sensitivity** drop-down list, choose one of the following options to specify how sensitive the DCA algorithm is to environmental changes such as signal, load, noise, and interference when determining whether to change channels:

- **Low**—The DCA algorithm is not particularly sensitive to environmental changes.
- **Medium**—The DCA algorithm is moderately sensitive to environmental changes.
- **High**—The DCA algorithm is highly sensitive to environmental changes.

The default value is Medium. The DCA sensitivity thresholds vary by radio band, as noted in the table below.

**Table 42: DCA Sensitivity Thresholds**

<table>
<thead>
<tr>
<th>Option</th>
<th>2.4-GHz DCA Sensitivity Threshold</th>
<th>5-GHz DCA Sensitivity Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>5 dB</td>
<td>5 dB</td>
</tr>
<tr>
<td>Medium</td>
<td>10 dB</td>
<td>15 dB</td>
</tr>
<tr>
<td>Low</td>
<td>20 dB</td>
<td>20 dB</td>
</tr>
</tbody>
</table>

**Step 11**
For 802.11a/n networks only, choose one of the following channel width options to specify the channel bandwidth supported for all 802.11n radios in the 5-GHz band:

- **20 MHz**—The 20-MHz channel bandwidth (default)
- **40 MHz**—The 40-MHz channel bandwidth

**Note**
If you choose 40 MHz, be sure to choose at least two adjacent channels from the DCA Channel List in **Step 13** (for example, a primary channel of 36 and an extension channel of 40). If you choose only one channel, that channel is not used for 40-MHz channel width.

**Note**
If you choose 40 MHz, you can also configure the primary and extension channels used by individual access points.

**Note**
To override the globally configured DCA channel width setting, you can statically configure an access point’s radio for 20- or 40-MHz mode on the 802.11a/n Cisco APs > Configure page. If you then change the static RF channel assignment method to WLC Controlled on the access point radio, the global DCA configuration overrides the channel width configuration that the access point was previously using. It can take up to 30 minutes (depending on how often DCA is configured to run) for the change to take effect.

**Note**
If you choose 40 MHz on the A radio, you cannot pair channels 116, 140, and 165 with any other channels.

This page also shows the following nonconfigurable channel parameter settings:

- **Channel Assignment Leader**—The MAC address of the RF group leader, which is responsible for channel assignment.
- **Last Auto Channel Assignment**—The last time RRM evaluated the current channel assignments.
Step 12  Select the Avoid check for non-DFS channel to enable the Cisco WLC to avoid checks for non-DFS channels. DCA configuration requires at least one non-DFS channel in the list. In the EU countries, outdoor deployments do not support non-DFS channels. Customers based in EU or regions with similar regulations must enable this option or at least have one non-DFS channel in the DCA list even if the channel is not supported by the APs.

**Note**  This parameter is applicable only for deployments having outdoor access points such as 1522 and 1524.

**Step 13**  In the DCA Channel List area, the DCA Channels text box shows the channels that are currently selected. To choose a channel, select its check box in the Select column. To exclude a channel, unselect its check box.

The ranges are as follows:

- **802.11a**—36, 40, 44, 48, 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136, 140, 149, 153, 157, 161, 165, 190, 196
- **802.11b/g**—1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11

The defaults are as follows:

- **802.11a**—36, 40, 44, 48, 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136, 140, 149, 153, 157, 161
- **802.11b/g**—1, 6, 11

**Note**  These extended UNII-2 channels in the 802.11a band do not appear in the channel list: 100, 104, 108, 112, 116, 132, 136, and 140. If you have Cisco Aironet 1520 series mesh access points in the -E regulatory domain, you must include these channels in the DCA channel list before you start operation. If you are upgrading from a previous release, verify that these channels are included in the DCA channel list. To include these channels in the channel list, select the **Extended UNII-2 Channels** check box.

**Step 14**  If you are using Cisco Aironet 1520 series mesh access points in your network, you need to set the 4.9-GHz channels in the 802.11a band on which they are to operate. The 4.9-GHz band is for public safety client access traffic only. To choose a 4.9-GHz channel, select its check box in the Select column. To exclude a channel, unselect its check box.

The ranges are as follows:

- **802.11a**—1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26

The defaults are as follows: 802.11a—20, 26

**Step 15**  Click **Apply**.

**Step 16**  Reenable the 802.11 networks as follows:

1. Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the Global Parameters page.
2. Select the 802.11a (or 802.11b/g) Network Status check box.
3. Click **Apply**.

**Step 17**  Click **Save Configuration**.

**Note**  To see why the DCA algorithm changed channels, choose Monitor and then choose View All under Most Recent Traps. The trap provides the MAC address of the radio that changed channels, the previous channel and the new channel, the reason why the change occurred, the energy before and after the change, the noise before and after the change, and the interference before and after the change.

---

**Configuring Coverage Hole Detection (GUI)**

**Step 1**  Disable the 802.11 network as follows:

a) Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the 802.11a (or 802.11b/g) Global Parameters page.
b) Unselect the 802.11a (or 802.11b/g) Network Status check box.
c) Click Apply.

Step 2  Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > Coverage to open the 802.11a (or 802.11b/g/n) > RRM > Coverage page.

Step 3  Select the Enable Coverage Hole Detection check box to enable coverage hole detection, or unselect it to disable this feature. If you enable coverage hole detection, the Cisco WLC automatically determines, based on data received from the access points, if any access points have clients that are potentially located in areas with poor coverage. The default value is selected.

Step 4  In the Data RSSI text box, enter the minimum receive signal strength indication (RSSI) value for data packets received by the access point. The value that you enter is used to identify coverage holes (or areas of poor coverage) within your network. If the access point receives a packet in the data queue with an RSSI value below the value that you enter here, a potential coverage hole has been detected. The valid range is −90 to −60 dBm, and the default value is −80 dBm. The access point takes data RSSI measurements every 5 seconds and reports them to the Cisco WLC in 90-second intervals.

Step 5  In the Voice RSSI text box, enter the minimum receive signal strength indication (RSSI) value for voice packets received by the access point. The value that you enter is used to identify coverage holes within your network. If the access point receives a packet in the voice queue with an RSSI value below the value that you enter here, a potential coverage hole has been detected. The valid range is −90 to −60 dBm, and the default value is −75 dBm. The access point takes voice RSSI measurements every 5 seconds and reports them to the Cisco WLC in 90-second intervals.

Step 6  In the Min Failed Client Count per AP text box, enter the minimum number of clients on an access point with an RSSI value at or below the data or voice RSSI threshold. The valid range is 1 to 75, and the default value is 3.

Step 7  In the Coverage Exception Level per AP text box, enter the percentage of clients on an access point that are experiencing a low signal level but cannot roam to another access point. The valid range is 0 to 100%, and the default value is 25%.

Note  If both the number and percentage of failed packets exceed the values configured for Failed Packet Count and Failed Packet Percentage (configurable through the Cisco WLC CLI) for a 5-second period, the client is considered to be in a pre-alarm condition. The Cisco WLC uses this information to distinguish between real and false coverage holes. False positives are generally due to the poor roaming logic implemented on most clients. A coverage hole is detected if both the number and percentage of failed clients meet or exceed the values entered in the Min Failed Client Count per AP and Coverage Exception Level per AP text boxes over a 90-second period. The Cisco WLC determines if the coverage hole can be corrected and, if appropriate, mitigates the coverage hole by increasing the transmit power level for that specific access point.

Step 8  Click Apply.

Step 9  Reenable the 802.11 network as follows:
   a) Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the 802.11a (or 802.11b/g) Global Parameters page.
   b) Select the 802.11a (or 802.11b/g/n) Network Status check box.
   c) Click Apply.

Step 10  Click Save Configuration.
Configuring RRM Profile Thresholds, Monitoring Channels, and Monitor Intervals (GUI)

Step 1
Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > General to open the 802.11a/n (or 802.11b/g/n) > RRM > General page.

Step 2
Configure profile thresholds used for alarming as follows:

Note
The profile thresholds have no bearing on the functionality of the RRM algorithms. Lightweight access points send an SNMP trap (or an alert) to the Cisco WLC when the values set for these threshold parameters are exceeded.

a) In the Interference text box, enter the percentage of interference (802.11 traffic from sources outside of your wireless network) on a single access point. The valid range is 0 to 100%, and the default value is 10%.

b) In the Clients text box, enter the number of clients on a single access point. The valid range is 1 to 75, and the default value is 12.

c) In the Noise text box, enter the level of noise (non-802.11 traffic) on a single access point. The valid range is $-127$ to $0$ dBm, and the default value is $-70$ dBm.

d) In the Utilization text box, enter the percentage of RF bandwidth being used by a single access point. The valid range is 0 to 100%, and the default value is 80%.

Step 3
From the Channel List drop-down list, choose one of the following options to specify the set of channels that the access point uses for RRM scanning:

- **All Channels**—RRM channel scanning occurs on all channels supported by the selected radio, which includes channels not allowed in the country of operation.

- **Country Channels**—RRM channel scanning occurs only on the data channels in the country of operation. This is the default value.

- **DCA Channels**—RRM channel scanning occurs only on the channel set used by the DCA algorithm, which by default includes all of the non-overlapping channels allowed in the country of operation. However, you can specify the channel set to be used by DCA if desired. To do so, follow instructions in the Dynamic Channel Assignment.

Step 4
Configure monitor intervals as follows:

1. In the Channel Scan Interval text box, enter (in seconds) the sum of the time between scans for each channel within a radio band. The entire scanning process takes 50 ms per channel, per radio and runs at the interval configured here. The time spent listening on each channel is determined by the non-configurable 50-ms scan time and the number of channels to be scanned. For example, in the U.S. all 11 802.11b/g channels are scanned for 50 ms each within the default 180-second interval. So every 16 seconds, 50 ms is spent listening on each scanned channel (180/11 = ~16 seconds). The Channel Scan Interval parameter determines the interval at which the scanning occurs. The valid range is 60 to 3600 seconds, and the default value is 60 seconds for 802.11a radios and 180 seconds for the 802.11b/g radios.

   Note
   If your Cisco WLC supports only OfficeExtend access points, we recommend that you set the channel scan interval to 1800 seconds for optimal performance. For deployments with a combination of OfficeExtend access points and local access points, the range of 60 to 3600 seconds can be used.

2. In the Neighbor Packet Frequency text box, enter (in seconds) how frequently neighbor packets (messages) are sent, which eventually builds the neighbor list. The valid range is 60 to 3600 seconds, and the default value is 60 seconds.
If your Cisco WLC supports only OfficeExtend access points, we recommend that you set the neighbor packet frequency to 600 seconds for optimal performance. For deployments with a combination of OfficeExtend access points and local access points, the range of 60 to 3600 seconds can be used.

**Note** If the access point radio does not receive a neighbor packet from an existing neighbor within 60 minutes, the Cisco WLC deletes that neighbor from the neighbor list.

**Step 5** Click **Apply**.

**Step 6** Click **Save Configuration**.

**Note** Click **Set to Factory Default** if you want to return all of the Cisco WLC’s RRM parameters to their factory-default values.

### Configuring RRM (CLI)

**Step 1** Disable the 802.11 network by entering this command:
```
config {802.11a | 802.11b} disable network
```

**Step 2** Choose the Transmit Power Control version by entering this command:
```
config advanced {802.11a | 802.11b} tpc-version {1 | 2}
```
where:

- **TPCv1**: Coverage-optimal—(Default) Offers strong signal coverage and stability with negligent intercell interferences and sticky client syndrome.
- **TPCv2**: Interference-optimal—For scenarios where voice calls are extensively used. Tx power is dynamically adjusted with the goal of minimum interference. It is suitable for dense networks. In this mode, there can be higher roaming delays and coverage hole incidents.

**Step 3** Perform one of the following to configure transmit power control:

- Have RRM automatically set the transmit power for all 802.11 radios at periodic intervals by entering this command:
```
config {802.11a | 802.11b} txPower global auto
```

- Have RRM automatically reset the transmit power for all 802.11a or 802.11b/g radios one time by entering this command:
```
config {802.11a | 802.11b} txPower global once
```

- Configure the transmit power range that overrides the Transmit Power Control algorithm, use this command to enter the maximum and minimum transmit power used by RRM:
```
config {802.11a | 802.11b} txPower global {max | min} txpower
```
where `txpower` is a value from –10 to 30 dBm. The minimum value cannot be greater than the maximum value; the maximum value cannot be less than the minimum value.

If you configure a maximum transmit power, RRM does not allow any access point to exceed this transmit power (whether the maximum is set at RRM startup, or by coverage hole detection). For example, if you configure a
maximum transmit power of 11 dBm, then no access point would transmit above 11 dBm, unless the access point is configured manually.

- Manually change the default transmit power setting by entering this command:

  ```
  config advanced {802.11a | 802.11b} {tpcv1-thresh | tpcv2-thresh} threshold
  ```

  where `threshold` is a value from –80 to –50 dBm. Increasing this value causes the access points to operate at higher transmit power rates. Decreasing the value has the opposite effect.

  In applications with a dense population of access points, it may be useful to decrease the threshold to –80 or –75 dBm in order to reduce the number of BSSIDs (access points) and beacons seen by the wireless clients. Some wireless clients may have difficulty processing a large number of BSSIDs or a high beacon rate and may exhibit problematic behavior with the default threshold.

- Configure the Transmit Power Control Version 2 on a per-channel basis by entering this command:

  ```
  config advanced {802.11a | 802.11b} tpcv2-per-chan {enable | disable}
  ```

**Step 4** Perform one of the following to configure dynamic channel assignment (DCA):

- Have RRM automatically configure all 802.11 channels based on availability and interference by entering this command:

  ```
  config {802.11a | 802.11b} channel global auto
  ```

- Have RRM automatically reconfigure all 802.11 channels one time based on availability and interference by entering this command:

  ```
  config {802.11a | 802.11b} channel global once
  ```

- Disable RRM and set all channels to their default values by entering this command:

  ```
  config {802.11a | 802.11b} channel global off
  ```

- Restart aggressive DCA cycle by entering this command:

  ```
  config {802.11a | 802.11b} channel global restart
  ```

- To specify the channel set used for DCA by entering this command:

  ```
  config advanced {802.11a | 802.11b} channel {add | delete} channel_number
  ```

  You can enter only one channel number per command. This command is helpful when you know that the clients do not support certain channels because they are legacy devices or they have certain regulatory restrictions.

**Step 5** Configure additional DCA parameters by entering these commands:

- ```
  config advanced {802.11a | 802.11b} channel dca anchor-time value
  ```

  Specifies the time of day when the DCA algorithm is to start. `value` is a number between 0 and 23 (inclusive) representing the hour of the day from 12:00 a.m. to 11:00 p.m.

- ```
  config advanced {802.11a | 802.11b} channel dca interval value
  ```

  Specifies how often the DCA algorithm is allowed to run. `value` is one of the following: 1, 2, 3, 4, 6, 8, 12, or 24 hours or 0, which is the default value of 10 minutes (or 600 seconds).

*Note* If your Cisco WLC supports only OfficeExtend access points, we recommend that you set the DCA interval to 6 hours for optimal performance. For deployments with a combination of OfficeExtend access points and local access points, the range of 10 minutes to 24 hours can be used.
• **config advanced {802.11a | 802.11b} channel dca sensitivity {low | medium | high}**—Specifies how sensitive the DCA algorithm is to environmental changes such as signal, load, noise, and interference when determining whether to change channel.

  * **low** means that the DCA algorithm is not particularly sensitive to environmental changes.
  * **medium** means that the DCA algorithm is moderately sensitive to environmental changes.
  * **high** means that the DCA algorithm is highly sensitive to environmental changes.

The DCA sensitivity thresholds vary by radio band, as noted in following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>2.4-GHz DCA Sensitivity Threshold</th>
<th>5-GHz DCA Sensitivity Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>5 dB</td>
<td>5 dB</td>
</tr>
<tr>
<td>Medium</td>
<td>10 dB</td>
<td>15 dB</td>
</tr>
<tr>
<td>Low</td>
<td>20 dB</td>
<td>20 dB</td>
</tr>
</tbody>
</table>

• **config advanced 802.11a channel dca chan-width-11n {20 | 40}**—Configures the DCA channel width for all 802.11n radios in the 5-GHz band.

  where

  * **20** sets the channel width for 802.11n radios to 20 MHz. This is the default value.
  * **40** sets the channel width for 802.11n radios to 40 MHz.

  **Note** If you choose 40, be sure to set at least two adjacent channels in the **config advanced 802.11a channel {add | delete} channel_number** command in Step 4 (for example, a primary channel of 36 and an extension channel of 40). If you set only one channel, that channel is not used for 40-MHz channel width.

  **Note** If you choose 40, you can also configure the primary and extension channels used by individual access points.

  **Note** To override the globally configured DCA channel width setting, you can statically configure an access point’s radio for 20-MHz or 40-MHz mode using the **config 802.11a chan_width Cisco_AP {20 | 40}** command. If you change the static configuration to global on the access point radio, the global DCA configuration overrides the channel width configuration that the access point was previously using. It can take up to 30 minutes (depending on how often DCA is configured to run) for the change to take effect.

• **config advanced {802.11a | 802.11b} channel outdoor-ap-dca {enable | disable}**—Enables or disables to the Cisco WLC to avoid checks for non-DFS channels.

  **Note** This parameter is applicable only for deployments having outdoor access points such as 1522 and 1524.

• **config advanced {802.11a | 802.11b} channel foreign {enable | disable}**—Enables or disables foreign access point interference avoidance in the channel assignment.
• `config advanced {802.11a | 802.11b} channel load {enable | disable}`—Enables or disables load avoidance in the channel assignment.

• `config advanced {802.11a | 802.11b} channel noise {enable | disable}`—Enables or disables noise avoidance in the channel assignment.

• `config advanced {802.11a | 802.11b} channel update`—Initiates an update of the channel selection for every Cisco access point.

**Step 6** Configure coverage hole detection by entering these commands:

**Note** In Cisco WLC software release 5.2 or later releases, you can disable coverage hole detection on a per-WLAN basis.

• `config advanced {802.11a | 802.11b} coverage {enable | disable}`—Enables or disables coverage hole detection. If you enable coverage hole detection, the Cisco WLC automatically determines, based on data received from the access points, if any access points have clients that are potentially located in areas with poor coverage. The default value is enabled.

• `config advanced {802.11a | 802.11b} coverage {data | voice} rssi-threshold rssi`—Specifies the minimum receive signal strength indication (RSSI) value for packets received by the access point. The value that you enter is used to identify coverage holes (or areas of poor coverage) within your network. If the access point receives a packet in the data or voice queue with an RSSI value below the value you enter here, a potential coverage hole has been detected. The valid range is −90 to −60 dBm, and the default value is −80 dBm for data packets and −75 dBm for voice packets. The access point takes RSSI measurements every 5 seconds and reports them to the Cisco WLC in 90-second intervals.

• `config advanced {802.11a | 802.11b} coverage level global clients`—Specifies the minimum number of clients on an access point with an RSSI value at or below the data or voice RSSI threshold. The valid range is 1 to 75, and the default value is 3.

• `config advanced {802.11a | 802.11b} coverage exception global percent`—Specifies the percentage of clients on an access point that are experiencing a low signal level but cannot roam to another access point. The valid range is 0 to 100%, and the default value is 25%.

• `config advanced {802.11a | 802.11b} coverage {data | voice} packet-count packets`—Specifies the minimum failure count threshold for uplink data or voice packets. The valid range is 1 to 255 packets, and the default value is 10 packets.

• `config advanced {802.11a | 802.11b} coverage {data | voice} fail-rate percent`—Specifies the failure rate threshold for uplink data or voice packets. The valid range is 1 to 100%, and the default value is 20%.

**Note** If both the number and percentage of failed packets exceed the values entered in the `packet-count` and `fail-rate` commands for a 5-second period, the client is considered to be in a pre-alarm condition. The Cisco WLC uses this information to distinguish between real and false coverage holes. False positives are generally due to the poor roaming logic implemented on most clients. A coverage hole is detected if both the number and percentage of failed clients meet or exceed the values entered in the `coverage level global` and `coverage exception global` commands over a 90-second period. The Cisco WLC determines if the coverage hole can be corrected and, if appropriate, mitigates the coverage hole by increasing the transmit power level for that specific access point.

**Step 7** Enable the 80.11a or 80.11b/g network by entering this command:

`config {802.11a | 802.11b} enable network`
To enable the 802.11g network, enter `config 802.11b 11gSupport enable` after the `config 802.11b enable` command.

**Step 8**

Save your settings by entering this command:

`save config`

---

**Viewing RRM Settings (CLI)**

To see 802.11a and 802.11b/g RRM settings, use these commands:

`show advanced {802.11a | 802.11b} ?`

where ? is one of the following:

- `ccx {global | Cisco_AP}`—Shows the CCX RRM configuration.
- `channel`—Shows the channel assignment configuration and statistics.
- `coverage`—Shows the coverage hole detection configuration and statistics.
- `logging`—Shows the RF event and performance logging.
- `monitor`—Shows the Cisco radio monitoring.
- `profile {global | Cisco_AP}`—Shows the access point performance profiles.
- `receiver`—Shows the 802.11a or 802.11b/g receiver configuration and statistics.
- `summary`—Shows the configuration and statistics of the 802.11a or 802.11b/g access points.
- `txpower`—Shows the transmit power assignment configuration and statistics.

---

**Debug RRM Issues (CLI)**

Use these commands to troubleshoot and verify RRM behavior:

`debug airewave-director ?`

where ? is one of the following:

- `all`—Enables debugging for all RRM logs.
- `channel`—Enables debugging for the RRM channel assignment protocol.
- `detail`—Enables debugging for RRM detail logs.
- `error`—Enables debugging for RRM error logs.
- `group`—Enables debugging for the RRM grouping protocol.
- `manager`—Enables debugging for the RRM manager.
- `message`—Enables debugging for RRM messages.
- `packet`—Enables debugging for RRM packets.
• **power**—Enables debugging for the RRM power assignment protocol as well as coverage hole detection.
• **profile**—Enables debugging for RRM profile events.
• **radar**—Enables debugging for the RRM radar detection/avoidance protocol.
• **rf-change**—Enables debugging for RRM RF changes.

## Configuring RRM Neighbor Discovery Packets

The Cisco Neighbor Discovery Packet (NDP) is the fundamental tool for RRM and other wireless applications that provides information about the neighbor radio information. You can configure the controller to encrypt neighbor discovery packets.

This feature enables you to be compliant with the PCI specifications.

## Information About RRM NDP and RF Grouping

The Cisco Neighbor Discovery Packet (NDP) is the fundamental tool for RRM and other wireless applications that provides information about the neighbor radio information. You can configure the Cisco WLC to encrypt neighbor discovery packets.

This feature enables you to be compliant with the PCI specifications.

An RF group can only be formed between Cisco WLCs that have the same encryption mechanism. That is, an access point associated to a Cisco WLC that is encrypted can not be neighbors with an access point associated to a Cisco WLC that is not encrypted. The two Cisco WLCs and their access points will not recognize each other as neighbors and cannot form an RF group. It is possible to assign two Cisco WLCs in a static RF group configuration that has mismatched encryption settings. In this case, the two Cisco WLCs do not function as a single RF group because the access points belonging to the mismatched Cisco WLCs do not recognize one another as neighbors in the group.

## Configuring RRM NDP (CLI)

To configure RRM NDP using the Cisco WLC CLI, enter this command:

```
config advanced 802.11 {a|b} monitor NDP-mode {protected | transparent}
```

This command configures NDP mode. By default, the mode is set to “transparent”. The following options are available:

• Protected—Packets are encrypted.

• Transparent—Packets are sent as is.

Use this command to see the discovery type:

```
show advanced 802.11 {a|b} monitor
```
Configuring RF Groups

Information About RF Groups

An RF group is a logical collection of Cisco WLCs that coordinate to perform RRM in a globally optimized manner to perform network calculations on a per-radio basis. An RF group exists for each 802.11 network type. Clustering Cisco WLCs into a single RF group enable the RRM algorithms to scale beyond the capabilities of a single Cisco WLC.

RF group is created based on following parameters:

- User-configured RF network name.
- Neighbor discovery performed at the radio level.
- Country list configured on MC.

RF grouping runs between MCs.

Lightweight access points periodically send out neighbor messages over the air. Access points using the the same RF group name validate messages from each other.

When access points on different Cisco WLCs hear validated neighbor messages at a signal strength of –80 dBm or stronger, the Cisco WLCs dynamically form an RF neighborhood in auto mode. In static mode, the leader is manually selected and the members are added to the RF Group. To know more about RF Group modes, RF Group Leader.

RF groups and mobility groups are similar in that they both define clusters of Cisco WLCs, but they are different in terms of their use. An RF group facilitates scalable, system-wide dynamic RF management while a mobility group facilitates scalable, system-wide mobility and Cisco WLC redundancy.

RF Group Leader

Starting in the 7.0.116.0 release, the RF Group Leader can be configured in two ways as follows:

- Auto Mode—In this mode, the members of an RF group elect an RF group leader to maintain a “master” power and channel scheme for the group. The RF grouping algorithm dynamically chooses the RF group leader and ensures that an RF group leader is always present. Group leader assignments can and do change (for instance, if the current RF group leader becomes inoperable or if RF group members experience major changes).

- Static Mode—In this mode, the user selects a Cisco WLC as an RF group leader manually. In this mode, the leader and the members are manually configured and are therefore fixed. If the members are unable to join the RF group, the reason is indicated. The leader tries to establish a connection with a member every 1 minute if the member has not joined in the previous attempt.

The RF group leader analyzes real-time radio data collected by the system, calculates the power and channel assignments, and sends them to each of the Cisco WLCs in the RF group. The RRM algorithms ensure...
system-wide stability and restrain channel and power scheme changes to the appropriate local RF neighborhoods.

In Cisco WLC software releases prior to 6.0, the dynamic channel assignment (DCA) search algorithm attempts to find a good channel plan for the radios associated to Cisco WLCs in the RF group, but it does not adopt a new channel plan unless it is considerably better than the current plan. The channel metric of the worst radio in both plans determines which plan is adopted. Using the worst-performing radio as the single criterion for adopting a new channel plan can result in pinning or cascading problems.

Pinning occurs when the algorithm could find a better channel plan for some of the radios in an RF group but is prevented from pursuing such a channel plan change because the worst radio in the network does not have any better channel options. The worst radio in the RF group could potentially prevent other radios in the group from seeking better channel plans. The larger the network, the more likely pinning becomes.

Cascading occurs when one radio’s channel change results in successive channel changes to optimize the remaining radios in the RF neighborhood. Optimizing these radios could lead to their neighbors and their neighbors’ neighbors having a suboptimal channel plan and triggering their channel optimization. This effect could propagate across multiple floors or even multiple buildings, if all the access point radios belong to the same RF group. This change results in considerable client confusion and network instability.

The main cause of both pinning and cascading is the way in which the search for a new channel plan is performed and that any potential channel plan changes are controlled by the RF circumstances of a single radio. In Cisco WLC software release 6.0, the DCA algorithm has been redesigned to prevent both pinning and cascading. The following changes have been implemented:

• Multiple local searches—The DCA search algorithm performs multiple local searches initiated by different radios within the same DCA run rather than performing a single global search driven by a single radio. This change addresses both pinning and cascading while maintaining the desired flexibility and adaptability of DCA and without jeopardizing stability.

• Multiple channel plan change initiators (CPCIs)—Previously, the single worst radio was the sole initiator of a channel plan change. Now each radio within the RF group is evaluated and prioritized as a potential initiator. Intelligent randomization of the resulting list ensures that every radio is eventually evaluated, which eliminates the potential for pinning.

• Limiting the propagation of channel plan changes (Localization)—For each CPCI radio, the DCA algorithm performs a local search for a better channel plan, but only the CPCI radio itself and its one-hop neighboring access points are actually allowed to change their current transmit channels. The impact of an access point triggering a channel plan change is felt only to within two RF hops from that access point, and the actual channel plan changes are confined to within a one-hop RF neighborhood. Because this limitation applies across all CPCI radios, cascading cannot occur.

• Non-RSSI-based cumulative cost metric—A cumulative cost metric measures how well an entire region, neighborhood, or network performs with respect to a given channel plan. The individual cost metrics of all access points in that area are considered in order to provide an overall understanding of the channel plan’s quality. These metrics ensure that the improvement or deterioration of each single radio is factored into any channel plan change. The objective is to prevent channel plan changes in which a single radio improves but at the expense of multiple other radios experiencing a considerable performance decline.

The RRM algorithms run at a specified updated interval, which is 600 seconds by default. Between update intervals, the RF group leader sends keepalive messages to each of the RF group members and collects real-time RF data.
Several monitoring intervals are also available. See the Configuring RRM section for details.

**RF Group Name**

A Cisco WLC is configured with an RF group name, which is sent to all access points joined to the Cisco WLC and used by the access points as the shared secret for generating the hashed MIC in the neighbor messages. To create an RF group, you configure all of the Cisco WLCs to be included in the group with the same RF group name.

If there is any possibility that an access point joined to a Cisco WLC may hear RF transmissions from an access point on a different Cisco WLC, you should configure the Cisco WLCs with the same RF group name. If RF transmissions between access points can be heard, then system-wide RRM is recommended to avoid 802.11 interference and contention as much as possible.

**Controllers and APs in RF Groups**

- Controller software supports up to 20 controllers and 6000 access points in an RF group.
- The RF group members are added based on the following criteria:
  - Maximum number of APs Supported: The maximum limit for the number of access points in an RF group is 6000. The number of access points supported is determined by the number of APs licensed to operate on the controller.
  - Twenty controllers: Only 20 controllers (including the leader) can be part of an RF group if the sum of the access points of all controllers combined is less than or equal to the upper access point limit.

**Table 44: Controller Model Information**

<table>
<thead>
<tr>
<th></th>
<th>8500</th>
<th>7500</th>
<th>5500</th>
<th>WiSM2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum APs per RRM Group</td>
<td>6000</td>
<td>6000</td>
<td>1000</td>
<td>2000</td>
</tr>
<tr>
<td>Maximum AP Groups</td>
<td>6000</td>
<td>6000</td>
<td>500</td>
<td>500</td>
</tr>
</tbody>
</table>

**Configuring RF Groups**

This section describes how to configure RF groups through either the GUI or the CLI.

*Note*
The RF group name is generally set at deployment time through the Startup Wizard. However, you can change it as necessary.
When the multiple-country feature is being used, all Cisco WLCs intended to join the same RF group must be configured with the same set of countries, configured in the same order.

You can also configure RF groups using the Cisco Prime Infrastructure.

**Configuring an RF Group Name (GUI)**

**Step 1** Choose **Controller > General** to open the General page.

**Step 2** Enter a name for the RF group in the RF-Network Name textbox. The name can contain up to 19 ASCII characters.

**Step 3** Click **Apply** to commit your changes.

**Step 4** Click **Save Configuration** to save your changes.

**Step 5** Repeat this procedure for each controller that you want to include in the RF group.

**Configuring an RF Group Name (CLI)**

**Step 1** Create an RF group by entering the `config network rf-network-name name` command:

Enter up to 19 ASCII characters for the group name.

**Step 2** See the RF group by entering the `show network` command.

**Step 3** Save your settings by entering the `save config` command.

**Step 4** Repeat this procedure for each controller that you want to include in the RF group.

**Viewing the RF Group Status**

This section describes how to view the status of the RF group through either the GUI or the CLI.

You can also view the status of RF groups using the Cisco Prime Infrastructure.
Viewing the RF Group Status (GUI)

**Step 1**
Choose Wireless > 802.11a/n > or 802.11b/g/n > RRM > RF Grouping to open the 802.11a/n (or 802.11b/g/n) RRM > RF Grouping page.

This page shows the details of the RF group, displaying the configurable parameter RF Group mode, the RF Group role of this Cisco WLC, the Update Interval and the Cisco WLC name and IP address of the Group Leader to this Cisco WLC.

**Note**  
RF grouping mode can be set using the Group Mode drop-down list.

**Tip**  
Once a Cisco WLC has joined as a static member and you want to change the grouping mode, we recommend that you remove the member from the configured static-leader and also make sure that a member Cisco WLC has not been configured to be a member on multiple static leaders. This is to avoid repeated join attempts from one or more RF static leaders.

**Step 2**  
(Optional) Repeat this procedure for the network type that you did not select (802.11a/n or 802.11b/g/n).

Viewing the RF Group Status (CLI)

**Step 1**  
See which Cisco WLC is the RF group leader for the 802.11a RF network by entering this command:

```
show advanced 802.11a group
```

Information similar to the following appears:

```
Radio RF Grouping
  802.11a Group Mode......................... STATIC
  802.11a Group Update Interval............ 600 seconds
  802.11a Group Leader...................... test (209.165.200.225)
    802.11a Group Member.................... test (209.165.200.225)
  802.11a Last Run.......................... 397 seconds ago
```

This output shows the details of the RF group, specifically the grouping mode for the Cisco WLC, how often the group information is updated (600 seconds by default), the IP address of the RF group leader, the IP address of this Cisco WLC, and the last time the group information was updated.

**Note**  
If the IP addresses of the group leader and the group member are identical, this Cisco WLC is currently the group leader.

**Note**  
A * indicates that the Cisco WLC has not joined as a static member.

**Step 2**  
See which Cisco WLC is the RF group leader for the 802.11b/g RF network by entering this command:

```
show advanced 802.11b group
```
Overriding RRM

Information About Overriding RRM

In some deployments, it is desirable to statically assign channel and transmit power settings to the access points instead of relying on the RRM algorithms provided by Cisco. Typically, this is true in challenging RF environments and non standard deployments but not the more typical carpeted offices.

Note

If you choose to statically assign channels and power levels to your access points and/or to disable dynamic channel and power assignment, you should still use automatic RF grouping to avoid spurious rogue device events.

You can disable dynamic channel and power assignment globally for a Cisco WLC, or you can leave dynamic channel and power assignment enabled and statically configure specific access point radios with a channel and power setting. While you can specify a global default transmit power parameter for each network type that applies to all the access point radios on a Cisco WLC, you must set the channel for each access point radio when you disable dynamic channel assignment. You may also want to set the transmit power for each access point instead of leaving the global transmit power in effect.

Prerequisites for Overriding RRM

We recommend that you assign different nonoverlapping channels to access points that are within close proximity to each other. The nonoverlapping channels in the U.S. are 36, 40, 44, 48, 52, 56, 60, 64, 149, 153, 157, and 161 in an 802.11a network and 1, 6, and 11 in an 802.11b/g network.

Restrictions for Overriding RRM

• Do not assign all access points that are within close proximity to each other to the maximum power level.

Statically Assigning Channel and Transmit Power Settings to Access Point Radios

Statically Assigning Channel and Transmit Power Settings (GUI)

Step 1

Choose Wireless > Access Points > Radios > 802.11a/n or 802.11b/g/n to open the 802.11a/n (or 802.11b/g/n) Radios page.
This page shows all the 802.11a/n or 802.11b/g/n access point radios that are joined to the Cisco WLC and their current settings. The Channel text box shows both the primary and extension channels and uses an asterisk to indicate if they are globally assigned.

**Step 2**
Hover your cursor over the blue drop-down arrow for the access point for which you want to modify the radio configuration and choose **Configure**. The 802.11a/n (or 802.11b/g/n) Cisco APs > Configure page appears.

**Step 3**
Specify the RF Channel Assignment from the following options:
- **Global**—Choose this to specify a global value.
- **Custom**—Choose this and then select a value from the adjacent drop-down list to specify a custom value.

**Step 4**
Configure the antenna parameters for this radio as follows:
1. From the Antenna Type drop-down list, choose **Internal** or **External** to specify the type of antennas used with the access point radio.
2. Select and unselect the check boxes in the Antenna text box to enable and disable the use of specific antennas for this access point, where A, B, and C are specific antenna ports. The D antenna appears for the Cisco 3600 Series Access Points. A is the right antenna port, B is the left antenna port, and C is the center antenna port. For example, to enable transmissions from antenna ports A and B and receptions from antenna port C, you would select the following check boxes: Tx: A and B and Rx: C. In 3600 APs, the valid combinations are A, A+B, A+B+C or A+B+C+D. When you select a dual mode antenna, you can only apply single spatial 802.11n stream rates: MCS 0 to 7 data rates. When you select two dual mode antennae, you can apply only the two spatial 802.11n stream rates: MCS 0 to 15 data rates.
3. In the Antenna Gain text box, enter a number to specify an external antenna's ability to direct or focus radio energy over a region of space. High-gain antennas have a more focused radiation pattern in a specific direction. The antenna gain is measured in 0.5 dBi units, and the default value is 7 times 0.5 dBi, or 3.5 dBi.
   If you have a high-gain antenna, enter a value that is twice the actual dBi value (see *Cisco Aironet Antenna Reference Guide* for antenna dBi values). Otherwise, enter 0. For example, if your antenna has a 4.4-dBi gain, multiply the 4.4 dBi by 2 to get 8.8 and then round down to enter only the whole number (8). The Cisco WLC reduces the actual equivalent isotropic radiated power (EIRP) to make sure that the antenna does not violate your country’s regulations.
4. Choose one of the following options from the Diversity drop-down list:
   - **Enabled**—Enables the antenna connectors on both sides of the access point. This is the default value.
   - **Side A or Right**—Enables the antenna connector on the right side of the access point.
   - **Side B or Left**—Enables the antenna connector on the left side of the access point.

**Step 5**
In the RF Channel Assignment area, choose **Custom** for the Assignment Method under RF Channel Assignment and choose a channel from the drop-down list to assign an RF channel to the access point radio.

**Step 6**
In the Tx Power Level Assignment area, choose the **Custom** assignment method and choose a transmit power level from the drop-down list to assign a transmit power level to the access point radio.
The transmit power level is assigned an integer value instead of a value in mW or dBm. The integer corresponds to a power level that varies depending on the regulatory domain in which the access points are deployed. The number of available power levels varies based on the access point model. However, power level 1 is always the maximum power level allowed per country code setting, with each successive power level representing 50% of the previous power level. For example, 1 = maximum power level in a particular regulatory domain, 2 = 50% power, 3 = 25% power, 4 = 12.5% power, and so on.

**Note**
See the hardware installation guide for your access point for the maximum transmit power levels supported per regulatory domain. Also, see the data sheet for your access point for the number of power levels supported.
If the access point is not operating at full power, the "Due to low PoE, radio is transmitting at degraded power" message appears under the Tx Power Level Assignment section.

**Step 7** Choose **Enable** from the Admin Status drop-down list to enable this configuration for the access point.

**Step 8** Click **Apply**.

**Step 9** Have the Cisco WLC send the access point radio admin state immediately to Cisco Prime Infrastructure as follows:

1. Choose **Wireless > 802.11a/n or 802.11b/g/n > Network** to open the 802.11a (or 802.11b/g) Global Parameters page.
2. Select the **802.11a (or 802.11b/g) Network Status** check box.
3. Click **Apply**.

**Step 10** Click **Save Configuration**.

**Step 11** Repeat this procedure for each access point radio for which you want to assign a static channel and power level.

---

### Statically Assigning Channel and Transmit Power Settings (CLI)

**Step 1** Disable the radio of a particular access point on the 802.11a/n or 802.11b/g/n network by entering this command:

```plaintext
config {802.11a | 802.11b} disable Cisco_AP
```

**Step 2** Configure the channel width for a particular access point by entering this command:

```plaintext
config {802.11a | 802.11b} chan_width Cisco_AP {20 | 40}
```

where

- **20** allows the radio to communicate using only 20-MHz channels. Choose this option for legacy 802.11a radios, 20-MHz 802.11n radios, or 40-MHz 802.11n radios that you want to operate using only 20-MHz channels. This is the default value.

- **40** allows 40-MHz 802.11n radios to communicate using two adjacent 20-MHz channels bonded together. The radio uses the primary channel that you choose as well as its extension channel for faster throughput. Each channel has only one extension channel (36 and 40 are a pair, 44 and 48 are a pair, and so on). For example, if you choose a primary channel of 44, the Cisco WLC would use channel 48 as the extension channel. If you choose a primary channel of 48, the Cisco WLC would use channel 44 as the extension channel.

**Note** This parameter can be configured only if the primary channel is statically assigned.

**Note** Statically configuring an access point's radio for 20-MHz or 40-MHz mode overrides the globally configured DCA channel width setting (configured using the **config advanced 802.11a channel dca chan-width-11n {20 | 40}** command). If you ever change the static configuration back to global on the access point radio, the global DCA configuration overrides the channel width configuration that the access point was previously using. It can take up to 30 minutes (depending on how often DCA is configured to run) for the change to take effect.

**Note** Channels 116, 120, 124, and 128 are not available in the U.S. and Canada for 40-MHz channel bonding.

**Step 3** Enable or disable the use of specific antennas for a particular access point by entering this command:
config \{802.11a \| 802.11b\} 11nsupport antenna \{tx \| rx\} Cisco_AP \{A \| B \| C\} \{enable \| disable\}

where A, B, and C are antenna ports. A is the right antenna port, B is the left antenna port, and C is the center antenna port. For example, to enable transmissions from the antenna in access point AP1’s antenna port C on the 802.11a network, you would enter this command:

```plaintext
config 802.11a 11nsupport antenna tx AP1 C enable
```

**Step 4**

Specify the external antenna gain, which is a measure of an external antenna’s ability to direct or focus radio energy over a region of space entering this command:

```plaintext
config \{802.11a \| 802.11b\} antenna extAntGain antenna_gain Cisco_AP
```

High-gain antennas have a more focused radiation pattern in a specific direction. The antenna gain is measured in 0.5 dBi units, and the default value is 7 times 0.5 dBi, or 3.5 dBi.

If you have a high-gain antenna, enter a value that is twice the actual dBi value (see Cisco Aironet Antenna Reference Guide for antenna dBi values). Otherwise, enter 0. For example, if your antenna has a 4.4-dBi gain, multiply the 4.4 dBi by 2 to get 8.8 and then round down to enter only the whole number (8). The Cisco WLC reduces the actual equivalent isotropic radiated power (EIRP) to make sure that the antenna does not violate your country’s regulations.

**Step 5**

Specify the channel that a particular access point is to use by entering this command:

```plaintext
config \{802.11a \| 802.11b\} channel ap Cisco_AP channel
```

For example, to configure 802.11a channel 36 as the default channel on AP1, enter the `config 802.11a channel ap AP1 36` command.

The channel you choose is the primary channel (for example, channel 36), which is used for communication by legacy 802.11a radios and 802.11n 20-MHz radios. 802.11n 40-MHz radios use this channel as the primary channel but also use an additional bonded extension channel for faster throughput, if you chose 40 for the channel width.

**Note** Changing the operating channel causes the access point radio to reset.

**Step 6**

Specify the transmit power level that a particular access point is to use by entering this command:

```plaintext
config \{802.11a \| 802.11b\} txPower ap Cisco_AP power_level
```

For example, to set the transmit power for 802.11a AP1 to power level 2, enter the `config 802.11a txPower ap AP1 2` command.

The transmit power level is assigned an integer value instead of a value in mW or dBm. The integer corresponds to a power level that varies depending on the regulatory domain in which the access points are deployed. The number of available power levels varies based on the access point model. However, power level 1 is always the maximum power level allowed per country code setting, with each successive power level representing 50% of the previous power level.

For example, 1 = maximum power level in a particular regulatory domain, 2 = 50% power, 3 = 25% power, 4 = 12.5% power, and so on.

In certain cases, Cisco access points support only 7 power levels for certain channels, so that the Cisco Wireless Controller considers the 7th and 8th power levels as the same. If the 8th power level is configured on those channels, the configuration would fail since the controller considers the 7th power level as the lowest acceptable valid power level. These power values are derived based on the regulatory compliance limits and minimum hardware limitation which varies across different Cisco access points. For example, Cisco 3500, 1140, and 1250 series access points allow the configuration of last power levels because those access points report the "per path power" to the controller, whereas all next generation access points such as Cisco 3700, 3600, 2600, and 1600 series access points report "total power value" to the controller, thereby decreasing the allowed power levels for newer generation products. For example, if the last power level in the 3600E access point has a power value of 4dbm (total power), then it actually means the power value is -2dbm (per path).

**Note** See the hardware installation guide for your access point for the maximum transmit power levels supported per regulatory domain. Also, see data sheet for your access point for the number of power levels supported.
### Step 7
Save your settings by entering this command:
```
save config
```

### Step 8
Repeat Step 2 through Step 7 for each access point radio for which you want to assign a static channel and power level.

### Step 9
Reenable the access point radio by entering this command:
```
config {802.11a | 802.11b} enable Cisco_AP
```

### Step 10
Have the Cisco WLC send the access point radio admin state immediately to WCS by entering this command:
```
config {802.11a | 802.11b} enable network
```

### Step 11
Save your changes by entering this command:
```
save config
```

### Step 12
See the configuration of a particular access point by entering this command:
```
show ap config {802.11a | 802.11b} Cisco_AP
```

Information similar to the following appears:

|Cisco AP Identifier|7|
|Cisco AP Name|AP1|

... ⋮

<table>
<thead>
<tr>
<th>Tx Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num Of Supported Power Levels</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tx Power Level</th>
<th>dBm</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>17</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
</tr>
<tr>
<td>4</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>-1</td>
</tr>
</tbody>
</table>

|Tx Power Configuration|CUSTOMIZED|
|Current Tx Power Level|1|

<table>
<thead>
<tr>
<th>Phy OFDM parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
</tr>
<tr>
<td>Current Channel</td>
</tr>
<tr>
<td>Extension Channel</td>
</tr>
<tr>
<td>Channel Width</td>
</tr>
<tr>
<td>Allowed Channel List</td>
</tr>
<tr>
<td>TI Threshold</td>
</tr>
<tr>
<td>Antenna Type</td>
</tr>
<tr>
<td>External Antenna Gain (in .5 dBi units)</td>
</tr>
<tr>
<td>Diversity</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>802.11n Antennas</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rx</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>C</td>
</tr>
</tbody>
</table>
Disabling Dynamic Channel and Power Assignment Globally for a Controller

Disabling Dynamic Channel and Power Assignment (GUI)

Step 1  Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > Auto RF to open the 802.11a/n (or 802.11b/g/n) Global Parameters > Auto RF page.

Step 2  Disable dynamic channel assignment by choosing OFF under RF Channel Assignment.

Step 3  Disable dynamic power assignment by choosing Fixed under Tx Power Level Assignment and choosing a default transmit power level from the drop-down list.

Step 4  Click Apply.

Step 5  Click Save Configuration.

Step 6  If you are overriding the default channel and power settings on a per radio basis, assign static channel and power settings to each of the access point radios that are joined to the Cisco WLC.

Step 7  (Optional) Repeat this procedure for the network type that you did not select (802.11a/n or 802.11b/g/n).

Disabling Dynamic Channel and Power Assignment (CLI)

Step 1  Disable the 802.11a or 802.11b/g network by entering this command:

```
cfg {802.11a | 802.11b} disable network
```

Step 2  Disable RRM for all 802.11a or 802.11b/g radios and set all channels to the default value by entering this command:

```
cfg {802.11a | 802.11b} channel global off
```

Step 3  Enable the 802.11a or 802.11b/g network by entering this command:

```
cfg {802.11a | 802.11b} enable network
```

Note  To enable the 802.11g network, enter the `cfg 802.11b 11gSupport enable` command after the `cfg 802.11b enable network` command.

Step 4  Save your changes by entering this command:

```
save config
```
Configuring Rogue Access Point Detection in RF Groups

Information About Rogue Access Point Detection in RF Groups

After you have created an RF group of Cisco WLCs, you need to configure the access points connected to the Cisco WLCs to detect rogue access points. The access points will then select the beacon/probe-response frames in neighboring access point messages to see if they contain an authentication information element (IE) that matches that of the RF group. If the select is successful, the frames are authenticated. Otherwise, the authorized access point reports the neighboring access point as a rogue, records its BSSID in a rogue table, and sends the table to the Cisco WLC.

Configuring Rogue Access Point Detection in RF Groups

Enabling Rogue Access Point Detection in RF Groups (GUI)

Step 1. Make sure that each Cisco WLC in the RF group has been configured with the same RF group name.

Note: The name is used to verify the authentication IE in all beacon frames. If the Cisco WLCs have different names, false alarms will occur.

Step 2. Choose Wireless to open the All APs page.

Step 3. Click the name of an access point to open the All APs > Details page.

Step 4. Choose either local or monitor from the AP Mode drop-down list and click Apply to commit your changes.

Step 5. Click Save Configuration to save your changes.

Step 6. Repeat Step 2 through Step 5 for every access point connected to the Cisco WLC.


The name of the RF group to which this Cisco WLC belongs appears at the top of the page.

Step 8. Choose AP Authentication from the Protection Type drop-down list to enable rogue access point detection.

Step 9. Enter a number in the Alarm Trigger Threshold edit box to specify when a rogue access point alarm is generated. An alarm occurs when the threshold value (which specifies the number of access point frames with an invalid authentication IE) is met or exceeded within the detection period.

Note: The valid threshold range is from 1 to 255, and the default threshold value is 1. To avoid false alarms, you may want to set the threshold to a higher value.

Step 10. Click Apply to commit your changes.

Step 11. Click Save Configuration to save your changes.

Step 12. Repeat this procedure on every Cisco WLC in the RF group.

Note: If rogue access point detection is not enabled on every Cisco WLC in the RF group, the access points on the Cisco WLCs with this feature disabled are reported as rogues.
Configuring Rogue Access Point Detection in RF Groups (CLI)

Step 1  Make sure that each Cisco WLC in the RF group has been configured with the same RF group name.

Note The name is used to verify the authentication IE in all beacon frames. If the Cisco WLCs have different names, false alarms will occur.

Step 2  Configure a particular access point for local (normal) mode or monitor (listen-only) mode by entering this command:
       config ap mode local Cisco_AP or config ap mode monitor Cisco_AP

Step 3  Save your changes by entering this command:
       save config

Step 4  Repeat Step 2 and Step 3 for every access point connected to the Cisco WLC.

Step 5  Enable rogue access point detection by entering this command:
       config wps ap-authentication

Step 6  Specify when a rogue access point alarm is generated by entering this command. An alarm occurs when the threshold value (which specifies the number of access point frames with an invalid authentication IE) is met or exceeded within the detection period.
       config wps ap-authentication threshold

Note The valid threshold range is from 1 to 255, and the default threshold value is 1. To avoid false alarms, you may want to set the threshold to a higher value.

Step 7  Save your changes by entering this command:
       save config

Step 8  Repeat Step 5 through Step 7 on every Cisco WLC in the RF group.

Note If rogue access point detection is not enabled on every Cisco WLC in the RF group, the access points on the Cisco WLCs with this feature disabled are reported as rogues.

Configuring CCX Radio Management Features

Information About CCX Radio Management Features

You can configure two parameters that affect client location calculations:

- Radio measurement requests
- Location calibration

These parameters are supported in Cisco Client Extensions (CCX) v2 and later releases are designed to enhance location accuracy and timeliness for participating CCX clients.

For the location features to operate properly, the access points must be configured for normal, monitor, or FlexConnect mode. However, for FlexConnect mode, the access point must be connected to the Cisco WLC.
Radio Measurement Requests

When you enable the radio measurement requests feature, lightweight access points issue broadcast radio measurement request messages to clients running CCXv2 or later releases. The access points transmit these messages for every SSID over each enabled radio interface at a configured interval. In the process of performing 802.11 radio measurements, CCX clients send 802.11 broadcast probe requests on all the channels specified in the measurement request. The Cisco Location Appliance uses the uplink measurements based on these requests received at the access points to quickly and accurately calculate the client location. You do not need to specify on which channels the clients are to measure. The Cisco WLC, access point, and client automatically determine which channels to use.

The radio measurement feature enables the Cisco WLC to also obtain information on the radio environment from the client’s perspective (rather than from just that of the access point). In this case, the access points issue unicast radio measurement requests to a particular CCXv4 or v5 client. The client then sends various measurement reports back to the access point and onto the Cisco WLC. These reports include information about the radio environment and data used to interpret the location of the clients. To prevent the access points and Cisco WLC from being overwhelmed by radio measurement requests and reports, only two clients per access point and up to 20 clients per Cisco WLC are supported. You can view the status of radio measurement requests for a particular access point or client as well as radio measurement reports for a particular client from the Cisco WLC CLI.

The Cisco WLC software improves the ability of the mobility services engine to accurately interpret the location of a device through a CCXv4 feature called location-based services. The Cisco WLC issues a path-loss request to a particular CCXv4 or v5 client. If the client chooses to respond, it sends a path-loss measurement report to the Cisco WLC. These reports contain the channel and transmit power of the client.

Note

Non-CCX and CCXv1 clients ignore the CCX measurement requests and do not participate in the radio measurement activity.

Location Calibration

For CCX clients that need to be tracked more closely (for example, when a client calibration is performed), the Cisco WLC can be configured to command the access point to send unicast measurement requests to these clients at a configured interval and whenever a CCX client roams to a new access point. These unicast requests can be sent out more often to these specific CCX clients than the broadcast measurement requests, which are sent to all clients. When location calibration is configured for non-CCX and CCXv1 clients, the clients are forced to disassociate at a specified interval to generate location measurements.
Configuring CCX Radio Management

**Configuring CCX Radio Management (GUI)**

**Step 1**  Choose **Wireless > 802.11a/n or 802.11b/g/n > Network** to open the 802.11a/n (or 802.11b/g/n) Global Parameters page.

**Step 2**  Under CCX Location Measurement, select the **Mode** check box to globally enable CCX radio management. This parameter causes the access points connected to this Cisco WLC to issue broadcast radio measurement requests to clients running CCX v2 or later releases. The default value is disabled (or unselected).

**Step 3**  If you selected the Mode check box in the previous step, enter a value in the Interval text box to specify how often the access points are to issue the broadcast radio measurement requests.
The range is 60 to 32400 seconds.
The default is 60 seconds.

**Step 4**  Click **Apply**.

**Step 5**  Click **Save Configuration**.

**Step 6**  Follow the instructions in Step 2 of the **Configuring CCX Radio Management (CLI)** section below to enable access point customization.

**Note**  To enable CCX radio management for a particular access point, you must enable access point customization, which can be done only through the Cisco WLC CLI.

**Step 7**  If desired, repeat this procedure for the other radio band (802.11a/n or 802.11b/g/n).

**Configuring CCX Radio Management (CLI)**

**Step 1**  Globally enable CCX radio management by entering this command:

```
config advanced {802.11a | 802.11b} ccx location-meas global enable interval_seconds
```

The range for the `interval_seconds` parameter is 60 to 32400 seconds, and the default value is 60 seconds. This command causes all access points connected to this Cisco WLC in the 802.11a or 802.11b/g network to issue broadcast radio measurement requests to clients running CCX v2 or later releases.

**Step 2**  Enable access point customization by entering these commands:

```
• config advanced {802.11a | 802.11b} ccx customize Cisco_AP {on | off}
```

This command enables or disables CCX radio management features for a particular access point in the 802.11a or 802.11b/g network.

```
• config advanced {802.11a | 802.11b} ccx location-meas ap Cisco_AP enable interval_seconds
```

The range for the `interval_seconds` parameter is 60 to 32400 seconds, and the default value is 60 seconds. This command causes a particular access point in the 802.11a or 802.11b/g network to issue broadcast radio measurement requests to clients running CCX v2 or higher.
Step 3
Save your settings by entering this command:
save config

Viewing CCX Radio Management Information (CLI)

- To see the CCX broadcast location measurement request configuration for all access points connected to this Cisco WLC in the 802.11a or 802.11b/g network, enter this command:

  `show advanced {802.11a | 802.11b} ccx global`

- To see the CCX broadcast location measurement request configuration for a particular access point in the 802.11a or 802.11b/g network, enter this command:

  `show advanced {802.11a | 802.11b} ccx ap Cisco_AP`

- To see the status of radio measurement requests for a particular access point, enter this command:

  `show ap ccx rm Cisco_AP status`

  Information similar to the following appears:

  **A Radio**

<table>
<thead>
<tr>
<th>Request</th>
<th>Enabled/Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beacon Request</td>
<td>Enabled</td>
</tr>
<tr>
<td>Channel Load Request</td>
<td>Enabled</td>
</tr>
<tr>
<td>Frame Request</td>
<td>Disabled</td>
</tr>
<tr>
<td>Noise Histogram Request</td>
<td>Disabled</td>
</tr>
<tr>
<td>Path Loss Request</td>
<td>Disabled</td>
</tr>
<tr>
<td>Interval</td>
<td>60</td>
</tr>
<tr>
<td>Iteration</td>
<td>5</td>
</tr>
</tbody>
</table>

  **B Radio**

<table>
<thead>
<tr>
<th>Request</th>
<th>Enabled/Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beacon Request</td>
<td>Disabled</td>
</tr>
<tr>
<td>Channel Load Request</td>
<td>Enabled</td>
</tr>
<tr>
<td>Frame Request</td>
<td>Disabled</td>
</tr>
<tr>
<td>Noise Histogram Request</td>
<td>Enabled</td>
</tr>
<tr>
<td>Path Loss Request</td>
<td>Disabled</td>
</tr>
<tr>
<td>Interval</td>
<td>60</td>
</tr>
<tr>
<td>Iteration</td>
<td>5</td>
</tr>
</tbody>
</table>

- To see the status of radio measurement requests for a particular client, enter this command:

  `show client ccx rm client_mac status`

  Information similar to the following appears:

  **Client Mac Address**: 00:40:96:ae:53:b4
  Beacon Request: Enabled
  Channel Load Request: Disabled
  Frame Request: Disabled
  Noise Histogram Request: Disabled
  Path Loss Request: Disabled
  Interval: 60
  Iteration: 5

- To see radio measurement reports for a particular client, enter these commands:

  `show client ccx rm client_mac report beacon`—Shows the beacon report for the specified client.
show client ccx rm client_mac report chan-load—Shows the channel-load report for the specified client.

show client ccx rm client_mac report noise-hist—Shows the noise-histogram report for the specified client.

show client ccx rm client_mac report frame—Shows the frame report for the specified client.

• To see the clients configured for location calibration, enter this command:
  show client location-calibration summary

• To see the RSSI reported for both antennas on each access point that heard the client, enter this command:
  show client detail client_mac

Debugging CCX Radio Management Issues (CLI)

• Debug CCX broadcast measurement request activity by entering this command:
  debug airewave-director message {enable | disable}

• Debug client location calibration activity by entering this command:
  debug ccxrm [all | error | warning | message | packet | detail {enable | disable}]

• The CCX radio measurement report packets are encapsulated in Internet Access Point Protocol (IAPP) packets. Therefore, if the previous debug ccxrm command does not provide any debugs, enter this command to provide debugs at the IAPP level:
  debug iapp error {enable | disable}

• Debug the output for forwarded probes and their included RSSI for both antennas by entering this command:
  debug dot11 load-balancing
CHAPTER 13

Configuring Cisco CleanAir

This section describes how to configure Cisco CleanAir on a controller and an access point. It contains the following sections:

- Information About CleanAir, page 749
- Guidelines and Limitations, page 752
- Configuring Cisco CleanAir, page 753
- Monitoring the Interference Devices, page 760
- Information About Spectrum Expert Connection, page 767
- Related Documents, page 769
- Feature History of CleanAir, page 770

Information About CleanAir

Cisco CleanAir is a spectrum intelligence solution designed to proactively manage the challenges of a shared wireless spectrum. It allows you to see all of the users of the shared spectrum (both native devices and foreign interferers). It also enables you or your network to act upon this information. For example, you could manually remove the interfering device, or the system could automatically change the channel away from the interference.

CleanAir provides spectrum management and RF visibility.

A Cisco CleanAir system consists of CleanAir-enabled access points, Cisco Wireless LAN Controllers, and Cisco Prime Infrastructure. These access points collect information about all devices that operate in the industrial, scientific, and medical (ISM) bands, identify and evaluate the information as a potential interference source, and forward it to the Cisco WLC. The Cisco WLC controls the access points, collects spectrum data, and forwards information to Cisco Prime Infrastructure or a Cisco mobility services engine (MSE) upon request.

For every device operating in the unlicensed band, Cisco CleanAir tells you what it is, where it is, how it is impacting your wireless network, and what actions you or your network should take. It simplifies RF so that you do not have to be an RF expert.

Wireless LAN systems operate in unlicensed 2.4- and 5-GHz ISM bands. Many devices, such as microwave ovens, cordless phones, and Bluetooth devices also operate in these bands and can negatively affect Wi-Fi operations.
Some of the most advanced WLAN services, such as voice over wireless and IEEE 802.11n radio communications, could be significantly impaired by the interference caused by other legal users of the ISM bands. The integration of Cisco CleanAir functionality into the Cisco Unified Wireless Network addresses this problem of radio frequency (RF) interference.

CleanAir is supported on mesh AP backhaul at a 5-GHz radio of mesh. You can enable CleanAir on backhaul radios and can provide report interference details and air quality.

Role of the Cisco Wireless LAN Controller in a Cisco CleanAir System

The Cisco WLC performs the following tasks in a Cisco CleanAir system:

• Configures Cisco CleanAir capabilities on the access point.
• Provides interfaces (GUI, CLI, and SNMP) for configuring Cisco CleanAir features and retrieving data.
• Displays spectrum data.
• Collects and processes air quality reports from the access point and stores them in the air quality database. The Air Quality Report (AQR) contains information about the total interference from all identified sources represented by the Air Quality Index (AQI) and summary for the most severe interference categories. The CleanAir system can also include unclassified interference information under per interference type reports, which enables you to take action in cases where the interference due to unclassified interfering devices is more.
• Collects and processes interference device reports (IDRs) from the access point and stores them in the interference device database.
• Forwards spectrum data to Prime Infrastructure and the MSE.

Interference Types that Cisco CleanAir Can Detect

Cisco CleanAir can detect interference, report on the location and severity of the interference, and recommend different mitigation strategies. Two such mitigation strategies are persistent device avoidance and spectrum event-driven RRM.

Wi-Fi chip-based RF management systems share these characteristics:

• Any RF energy that cannot be identified as a Wi-Fi signal is reported as noise.
• Noise measurements that are used to assign a channel plan tend to be averaged over a period of time to avoid instability or rapid changes that can be disruptive to certain client devices.
• Averaging measurements reduces the resolution of the measurement. As such, a signal that disrupts clients might not look like it needs to be mitigated after averaging.
• All RF management systems available today are reactive in nature.

Cisco CleanAir is different and can positively identify not only the source of the noise but also its location and potential impact to a WLAN. Having this information allows you to consider the noise within the context of the network and make intelligent and, where possible, proactive decisions. For CleanAir, two types of interference events are common:

• Persistent interference
• Spontaneous interference

Persistent interference events are created by devices that are stationary in nature and have intermittent but largely repeatable patterns of interference. For example, consider the case of a microwave oven located in a break room. Such a device might be active for only 1 or 2 minutes at a time. When operating, however, it can be disruptive to the performance of the wireless network and associated clients. Using Cisco CleanAir, you can positively identify the device as a microwave oven rather than indiscriminate noise. You can also determine exactly which part of the band is affected by the device, and because you can locate it, you can understand which access points are most severely affected. You can then use this information to direct RRM in selecting a channel plan that avoids this source of interference for the access points within its range. Because this interference is not active for a large portion of the day, existing RF management applications might attempt to again change the channels of the affected access points. Persistent device avoidance is unique, however, in that it remains in effect as long as the source of interference is periodically detected to refresh the persistent status. The Cisco CleanAir system knows that the microwave oven exists and includes it in all future planning. If you move either the microwave oven or the surrounding access points, the algorithm updates RRM automatically.

Note
Spectrum event-driven RRM can be triggered only by Cisco CleanAir-enabled access points in local mode.

Spontaneous interference is interference that appears suddenly on a network, perhaps jamming a channel or a range of channels completely. The Cisco CleanAir spectrum event-driven RRM feature allows you to set a threshold for air quality (AQ) that, if exceeded, triggers an immediate channel change for the affected access point. Most RF management systems can avoid interference, but this information takes time to propagate through the system. Cisco CleanAir relies on AQ measurements to continuously evaluate the spectrum and can trigger a move within 30 seconds. For example, if an access point detects interference from a video camera, it can recover by changing channels within 30 seconds of the camera becoming active. Cisco CleanAir also identifies and locates the source of interference so that more permanent mitigation of the device can be performed at a later time.

In the case of Bluetooth devices, Cisco CleanAir-enabled access points can detect and report interferences only if the devices are actively transmitting. Bluetooth devices have extensive power save modes. For example, interference can be detected when data or voice is being streamed between the connected devices.

Persistent Devices

Some interference devices such as outdoor bridges and Microwave Ovens only transmit when needed. These devices can cause significant interference to the local WLAN due to short duration and periodic operation remain largely undetected by normal RF management metrics. With CleanAir the RRM DCA algorithm can detect, measure, register and remember the impact and adjust the DCA algorithm. This minimizes the use of channels affected by the persistent devices in the channel plan local to the interference source. Cisco CleanAir detects and stores the persistent device information in the Cisco WLC and this information is used to mitigate interfering channels.

Persistent Devices Detection

CleanAir-capable Monitor Mode access point collects information about persistent devices on all configured channels and stores the information in the Cisco WLC. Local/Bridge mode AP detects interference devices on the serving channels only.
Persistent Devices Propagation

Persistent device information that is detected by local or monitor mode access points is propagated to the neighboring access points connected to the same Cisco WLC to provide better chance of handling and avoiding persistent devices. Persistent device detected by the CleanAir-enabled access point is propagated to neighboring non-CleanAir access points, thus enhancing channel selection quality.

Guidelines and Limitations

Only Cisco CleanAir-enabled access points using the following access point modes can perform Cisco CleanAir spectrum monitoring:

- **Local**—In this mode, each Cisco CleanAir-enabled access point radio provides air quality and interference detection reports for the current operating channel only.
- **FlexConnect**—When a FlexConnect access point is connected to the controller, its Cisco CleanAir functionality is identical to local mode.
- **Monitor**—When Cisco CleanAir is enabled in monitor mode, the access point provides air quality and interference detection reports for all monitored channels.

The following options are available:

- All—All channels
- DCA—Channel selection governed by the DCA list
- Country—All channel legal within a regulatory domain

---

**Note**

Suppose you have two APs, one in the FlexConnect mode and the other in the monitor mode. Also suppose that you have created a profile enabling EAP attack against 802.1x auth. The Airmagnet (AM) tool, which can generate different types of attacks, fails to generate any attack even if you have provided valid AP MAC and STA MAC addresses. But if the AP MAC and STA MAC addresses in the AM tool are swapped, that is, the AP MAC address is specified in the STA MAC field and the STA MAC address is specified in the AP MAC field, then the tool is able to generate attacks, which the AP in the Monitor mode is also able to detect.

---

**Note**

The access point does not participate in AQ HeatMap in Prime Infrastructure.

---

**Note**

SE-Connect—This mode enables a user to connect a Spectrum Expert application running on an external Microsoft Windows XP or Vista PC to a Cisco CleanAir-enabled access point in order to display and analyze detailed spectrum data. The Spectrum Expert application connects directly to the access point, bypassing the controller. An access point in SE-Connect mode does not provide any Wi-Fi, RF, or spectrum data to the controller. In addition to performing spectrum intelligence, an access point can provide other.
• Access points in monitor mode do not transmit Wi-Fi traffic or 802.11 packets. They are excluded from radio resource management (RRM) planning and are not included in the neighbor access point list. IDR clustering depends on the controller's ability to detect neighboring in-network access points. Correlating interference device detections from multiple access points is limited between monitor-mode access points.

• Spectrum Expert (SE) Connect functionality is supported for local, FlexConnect, bridge, and monitor modes. The access point provides spectrum information to Spectrum Expert only for the current channel(s). For local, FlexConnect, and bridge modes, the spectrum data is available for the current active channel(s) and for the monitor mode, the common monitored channel list is available. The access point continues to send AQ (Air Quality) and IDR (Interference Device Reports) reports to the controller and perform normal activities according to the current mode. Sniffer and rogue detections access point modes are incompatible with all types of CleanAir spectrum monitoring.

• Controllers have limitations on the number of monitor mode AP’s that they can support. This is because, a monitor mode AP saves data for all the channels.

• Do not connect access points in SE connect mode directly to any physical port on Cisco 2500 Series Controllers.

• Spectrum Expert (Windows XP laptop client) and AP should be pingable, otherwise; it will not work.

Configuring Cisco CleanAir

This section describes how to configure Cisco CleanAir on a controller and an access point. It contains the following sections:

Configuring Cisco CleanAir on the Controller

This section contains the following topics:

• Configuring Cisco CleanAir on the Cisco Wireless LAN Controller (GUI), on page 753

• Configuring Cisco CleanAir on the Cisco Wireless LAN Controller (CLI), on page 755

Configuring Cisco CleanAir on the Cisco Wireless LAN Controller (GUI)

Step 1 Choose Wireless > 802.11a/n or 802.11b/g/n > CleanAir to open the 802.11a (or 802.11b) > CleanAir page.

Step 2 Select the CleanAir check box to enable Cisco CleanAir functionality on the 802.11a/n or 802.11b/g/n network, or unselect it to prevent the Cisco WLC from detecting spectrum interference. By default, the value is not selected.

Step 3 Select the Report Interferers check box to enable the Cisco CleanAir system to report any detected sources of interference, or unselect it to prevent the Cisco WLC from reporting interferers. The default value is selected.

Note Device Security alarms, Event Driven RRM, and the Persistence Device Avoidance algorithm do not work if Report Interferers are disabled.

Step 4 Select the Persistent Device Propagation check box to enable propagation of information about persistent devices that can be detected by CleanAir. Persistent device propagation enables you to propagate information about persistent devices
to the neighboring access points connected to the same Cisco WLC. Persistent interferers are present at the location and interfere with the WLAN operations even if they are not detectable at all times.

**Step 5**

Ensure that any sources of interference that need to be detected and reported by the Cisco CleanAir system appear in the Interferences to Detect box and any that do not need to be detected appear in the Interferences to Ignore box. Use the > and < buttons to move interference sources between these two boxes. By default, all interference sources are detected. The possible sources of interference that you can choose are as follows:

- **Bluetooth Paging Inquiry**—A Bluetooth discovery (802.11b/g/n only)
- **Bluetooth Sco Acl**—A Bluetooth link (802.11b/g/n only)
- **Generic DECT**—A digital enhanced cordless communication (DECT)-compatible phone
- **Generic TDD**—A time division duplex (TDD) transmitter
- **Generic Waveform**—A continuous transmitter
- **Jammer**—A jamming device
- **Microwave**—A microwave oven (802.11b/g/n only)
- **Canopy**—A canopy bridge device
- **Spectrum 802.11 FH**—An 802.11 frequency-hopping device (802.11b/g/n only)
- **Spectrum 802.11 inverted**—A device using spectrally inverted Wi-Fi signals
- **Spectrum 802.11 non std channel**—A device using nonstandard Wi-Fi channels
- **Spectrum 802.11 SuperG**—An 802.11 SuperAG device
- **Spectrum 802.15.4**—An 802.15.4 device (802.11b/g/n only)
- **Video Camera**—An analog video camera
- **WiMAX Fixed**—A WiMAX fixed device (802.11a/n only)
- **WiMAX Mobile**—A WiMAX mobile device (802.11a/n only)
- **XBox**—A Microsoft Xbox (802.11b/g/n only)

**Note** Access points that are associated to the Cisco WLC send interference reports only for the interferers that appear in the Interferences to Detect box. This functionality allows you to filter out interferers that you do not want as well as any that may be flooding the network and causing performance problems for the Cisco WLC or Prime Infrastructure. Filtering allows the system to resume normal performance levels.

**Step 6**

Configure Cisco CleanAir alarms as follows:

a) Select the **Enable AQI (Air Quality Index) Trap** check box to enable the triggering of air quality alarms, or unselect the box to disable this feature. The default value is selected.

b) If you selected the **Enable AQI Trap** check box in Step a, enter a value between 1 and 100 (inclusive) in the AQI Alarm Threshold text box to specify the threshold at which you want the air quality alarm to be triggered. When the air quality falls below the threshold level, the alarm is triggered. A value of 1 represents the worst air quality, and 100 represents the best. The default value is 35.

c) Enter the **AQI Alarm Threshold (1 to 100)** that you want to set. An alarm is generated when the air quality reaches a threshold value. The default is 35. Valid range is from 1 and 100.

d) Select the **Enable trap for Unclassified Interferences** check box to enable the AQI alarm to be generated upon detection of unclassified interference beyond the severity threshold specified in the **AQI Alarm Threshold**.
Unclassified interferences are interferences that are detected but do not correspond to any of the identifiable interference types.

e) Enter the **Threshold for Unclassified category trap (1 to 99)**. Enter a value from 1 and 99. The default is 20. This is the severity index threshold for an unclassified interference category.

f) Select the **Enable Interference Type Trap** check box to trigger interferer alarms when the Cisco WLC detects specified device types, or unselect it to disable this feature. The default value is selected.

g) Make sure that any sources of interference that need to trigger interferer alarms appear in the Trap on These Types box and any that do not need to trigger interferer alarms appear in the Do Not Trap on These Types box. Use the > and < buttons to move interference sources between these two boxes. By default, all interference sources trigger interferer alarms.

For example, if you want the Cisco WLC to send an alarm when it detects a jamming device, select the **Enable Interference Type Trap** check box and move the jamming device to the Trap on These Types box.

---

**Configuring Cisco CleanAir on the Cisco Wireless LAN Controller (CLI)**

**Step 1**
Configure Cisco CleanAir functionality on the 802.11 network by entering this command:

```plaintext
config {802.11a | 802.11b} cleanair {enable | disable} all
```

If you disable this feature, the Cisco WLC does not receive any spectrum data. The default value is enable.

**Step 2**
Enable CleanAir on all associated access points in a network:

```plaintext
config {802.11a | 802.11b} cleanair enable network
```

You can enable CleanAir on a 5-GHz radio of mesh access points.
Step 3  Configure interference detection and specify sources of interference that need to be detected by the Cisco CleanAir system by entering this command:

```
config {802.11a | 802.11b} cleanair device {enable | disable} type
```

where you choose the `type` as one of the following:

- **802.11-fh**—An 802.11 frequency-hopping device (802.11b/g/n only)
- **802.11-inv**—A device using spectrally inverted Wi-Fi signals
- **802.11-nonstd**—A device using nonstandard Wi-Fi channels
- **802.15.4**—An 802.15.4 device (802.11b/g/n only)
- **all**—All interference device types (this is the default value)
- **bt-discovery**—A bluetooth discovery (802.11b/g/n only)
- **bt-link**—A bluetooth link (802.11b/g/n only)
- **canopy**—A canopy device
- **cont-tx**—A continuous transmitter
- **dect-like**—A digital enhanced cordless communication (DECT)-compatible phone
- **jammer**—A jamming device
- **mw-oven**—A microwave oven (802.11b/g/n only)
- **superag**—An 802.11 SuperAG device
- **tdd-tx**—A time division duplex (TDD) transmitter
- **video camera**—An analog video camera
- **wimax-fixed**—A WiMAX fixed device
- **wimax-mobile**—A WiMAX mobile device
- **xbox**—A Microsoft Xbox (802.11b/g/n only)

**Note**  Access points that are associated to the Cisco WLC send interference reports only for the interference types specified in this command. This functionality allows you to filter out interferers that may be flooding the network and causing performance problems for the Cisco WLC or Prime Infrastructure. Filtering allows the system to resume normal performance levels.

Step 4  Configure the triggering of air quality alarms by entering this command:

```
config {802.11a | 802.11b} cleanair alarm air-quality {enable | disable}
```

The default value is enabled.

Step 5  Specify the threshold at which you want the air quality alarm to be triggered by entering this command:

```
config {802.11a | 802.11b} cleanair alarm air-quality threshold threshold
```

where `threshold` is a value between 1 and 100 (inclusive). When the air quality falls below the threshold level, the alarm is triggered. A value of 1 represents the worst air quality, and 100 represents the best. The default value is 35.

Step 6  Enable the triggering of interferer alarms by entering this command:

```
config {802.11a | 802.11b} cleanair alarm device {enable | disable}
```

The default value is enable.
Step 7 Specify sources of interference that trigger alarms by entering this command:

```
config {802.11a | 802.11b} cleanair alarm device type {enable | disable}
```

where you choose the type as one of the following:

- **802.11-fh**—An 802.11 frequency-hopping device (802.11b/g/n only)
- **802.11-inv**—A device using spectrally inverted Wi-Fi signals
- **802.11-nondst**—A device using nonstandard Wi-Fi channels
- **802.15.4**—An 802.15.4 device (802.11b/g/n only)
- **all**—All interference device types (this is the default value)
- **bt-discovery**—A Bluetooth discovery (802.11b/g/n only)
- **bt-link**—A Bluetooth link (802.11b/g/n only)
- **canopy**—A canopy device
- **cont-tx**—A continuous transmitter
- **dect-like**—A digital enhanced cordless communication (DECT)-compatible phone
- **jammer**—A jamming device
- **mw-oven**—A microwave oven (802.11b/g/n only)
- **superag**—An 802.11 SuperAG device
- **tdd-tx**—A time division duplex (TDD) transmitter
- **video camera**—An analog video camera
- **wimax-fixed**—A WiMAX fixed device
- **wimax-mobile**—A WiMAX mobile device
- **xbox**—A Microsoft Xbox (802.11b/g/n only)

Step 8 Configure the triggering of air quality alarms for unclassified devices by entering this command:

```
config {802.11a | 802.11b} cleanair alarm unclassified {enable | disable}
```

Step 9 Specify the threshold at which you want the air quality alarm to be triggered for unclassified devices by entering this command:

```
config {802.11a | 802.11b} cleanair alarm unclassified threshold threshold
```

where `threshold` is a value from 1 and 99 (inclusive). When the air quality falls below the threshold level, the alarm is triggered. A value of 1 represents the worst air quality, and 100 represents the best. The default value is 35.

Step 10 Trigger spectrum event-driven radio resource management (RRM) to run when a Cisco CleanAir-enabled access point detects a significant level of interference by entering these commands:

```
config advanced {802.11a | 802.11b} channel cleanair-event {enable | disable}
```

---

**Cisco Wireless LAN Controller Configuration Guide, Release 7.3**
environment while high represents an increased sensitivity. You can also set the sensitivity to a custom level of your choice. The default value is medium.

```
config advanced {802.11a | 802.11b} channel cleanair-event sensitivity threshold thresholdvalue — If you set the threshold sensitivity as custom, you must set a custom threshold value. The default is 35.
```

Step 11
Enable persistent devices propagation by entering this command:
```
config advanced {802.11a | 802.11b} channel pda-prop {enable | disable}
```

Step 12
Save your changes by entering this command:
```
save config
```

Step 13
See the Cisco CleanAir configuration for the 802.11a/n or 802.11b/g/n network by entering this command:
```
show {802.11a | 802.11b} cleanair config
```

Information similar to the following appears:

```
(Cisco Controller) >show 802.11a cleanair config

Clean Air Solution............................... Disabled
Air Quality Settings:
  Air Quality Reporting........................ Enabled
  Air Quality Reporting Period (min)........... 15
  Air Quality Alarms........................... Enabled
  Air Quality Alarm Threshold................ 35
  Unclassified Interference.................. Disabled
  Unclassified Severity Threshold............ 20
Interference Device Settings:
  Interference Device Reporting................ Enabled
  Interference Device Types:
    TDD Transmitter.......................... Enabled
    Jammer................................... Enabled
    Continuous Transmitter................... Enabled
    DECT-like Phone.......................... Enabled
    Video Camera............................. Enabled
    WiFi Inverted........................... Enabled
    WiFi Invalid Channel..................... Enabled
    SuperAG.................................. Enabled
    Canopy................................... Enabled
    WiMax Mobile............................. Enabled
    WiMax Fixed.............................. Enabled
  Interference Device Alarms................... Enabled
  Interference Device Types Triggering Alarms:
    TDD Transmitter.......................... Disabled
    Jammer................................. Enabled
    Continuous Transmitter................... Disabled
    DECT-like Phone......................... Disabled
    Video Camera........................... Disabled
    WiFi Inverted.......................... Enabled
    WiFi Invalid Channel..................... Enabled
    SuperAG................................. Disabled
    Canopy................................... Disabled
    WiMax Mobile............................ Disabled
    WiMax Fixed............................. Disabled
  Additional Clean Air Settings:
    CleanAir ED-RRM State...................... Disabled
    CleanAir ED-RRM Sensitivity............... Medium
    CleanAir ED-RRM Custom Threshold......... 50
    CleanAir Persistent Devices state......... Disabled
    CleanAir Persistent Device Propagation... Enabled
```

Step 14
See the spectrum event-driven RRM configuration for the 802.11a/n or 802.11b/g/n network by entering this command:
```
show advanced {802.11a | 802.11b} channel
```

Information similar to the following appears:
Configuring Cisco CleanAir on an Access Point (GUI)

Step 1  Choose Wireless > Access Points > Radios > 802.11a/n or 802.11b/g/n to open the 802.11a/n (or 802.11b/g/n) Radios page.

Step 2  Hover your cursor over the blue drop-down arrow for the desired access point and click Configure. The 802.11a/n (or 802.11b/g/n) Cisco APs > Configure page appears. The CleanAir Capable field shows whether this access point can support CleanAir functionality. If it can, go to the next step to enable or disable CleanAir for this access point. If the access point cannot support CleanAir functionality, you cannot enable CleanAir for this access point.

Note  By default, the Cisco CleanAir functionality is enabled on the radios.

Step 3  Enable Cisco CleanAir functionality for this access point by choosing Enable from the CleanAir Status drop-down list. To disable CleanAir functionality for this access point, choose Disable. The default value is Enable. This setting overrides the global CleanAir configuration for this access point. The Number of Spectrum Expert Connections text box shows the number of Spectrum Expert applications that are currently connected to the access point radio. Up to three active connections are possible.

Step 4  Click Apply.

Step 5  Click Save Configuration.

Step 6  Click Back to return to the 802.11a/n (or 802.11b/g/n) Radios page.

Step 7  View the Cisco CleanAir status for each access point radio by looking at the CleanAir Status text box on the 802.11a/n (or 802.11b/g/n) Radios page. The Cisco CleanAir status is one of the following:

- **UP**—The spectrum sensor for the access point radio is currently operational (error code 0).

- **DOWN**—The spectrum sensor for the access point radio is currently not operational because an error has occurred. The most likely reason for the error is that the access point radio is disabled (error code 8). To correct this error, enable the radio.

- **ERROR**—The spectrum sensor for the access point radio has crashed (error code 128), making CleanAir monitoring nonoperational for this radio. If this error occurs, reboot the access point. If the error continues to appear, you might want to disable Cisco CleanAir functionality on the radio.

- **N/A**—This access point radio is not capable of supporting Cisco CleanAir functionality.
You can create a filter to make the 802.11a/n Radios page or the 802.11b/g/n Radios page show only access point radios that have a specific Cisco CleanAir status (such as UP, DOWN, ERROR, or N/A). This feature is especially useful if your list of access point radios spans multiple pages, preventing you from viewing them all at once. To create a filter, click **Change Filter** to open the Search AP dialog box, select one or more of the CleanAir Status check boxes, and click **Find**. Only the access point radios that match your search criteria appear on the 802.11a/n Radios page or the 802.11b/g/n Radios page, and the Current Filter parameter at the top of the page specifies the filter used to generate the list (for example, CleanAir Status: UP).

---

**Configuring Cisco CleanAir on an Access Point (CLI)**

**Step 1** Configure Cisco CleanAir functionality for a specific access point by entering this command:
```
config {802.11a | 802.11b} cleanair {enable | disable}Cisco_AP
```

**Step 2** Save your changes by entering this command:
```
save config
```

**Step 3** See the Cisco CleanAir configuration for a specific access point on the 802.11a/n or 802.11b/g/n network by entering this command:
```
show ap config {802.11a | 802.11b} Cisco_AP
```
Information similar to the following appears:

```
Cisco AP Identifier.............................. 0
Cisco AP Name.................................... CISCO_AP3500
...
Spectrum Management Information
  Spectrum Management Capable.............. Yes
  Spectrum Management Admin State......... Enabled
  Spectrum Management Operation State...... Up
  Rapid Update Mode......................... Disabled
  Spectrum Expert connection............... Disabled
  Spectrum Sensor State..................... Configured (Error code = 0)
```

**Note** See step 7 of Configuring Cisco CleanAir on an Access Point (GUI), on page 759 for descriptions of the spectrum management operation states and the possible error codes for the spectrum sensor state.

---

**Monitoring the Interference Devices**

This section describes how to monitor the interference devices of the 802.11a/n and 802.11b/g/n radio bands using the controller GUI or CLI.
Prerequisites for Monitoring the Interference Devices

You can configure Cisco CleanAir only on CleanAir-enabled access points.

Monitoring the Interference Device (GUI)

**Prerequisites for Monitoring the Interference Devices**

You can configure Cisco CleanAir only on CleanAir-enabled access points.

**Monitoring the Interference Device (GUI)**

**Step 1** Choose **Monitor > Cisco CleanAir > 802.11a/n or 802.11b/g/n > Interference Devices** to open the CleanAir > Interference Devices page. This page shows the following information:

- **AP Name** — The name of the access point where the interference device is detected.
- **Radio Slot #** — Slot where the radio is installed.
- **Interferer Type** — Type of the interferer.
- **Affected Channel** — Channel that the device affects.
- **Detected Time** — Time at which the interference was detected.
- **Severity** — Severity index of the interfering device.
- **Duty Cycle (%)** — Proportion of time during which the interfering device was active.
- **RSSI** — Receive signal strength indicator (RSSI) of the access point.
- **DevID** — Device identification number that uniquely identified the interfering device.
- **ClusterID** — Cluster identification number that uniquely identifies the type of the devices.

**Step 2** Click **Change Filter** to display the information about interference devices based on a particular criteria.

**Step 3** Click **Clear Filter** to remove the filter and display the entire access point list.

You can create a filter to display the list of interference devices that are based on the following filtering parameters:

- **Cluster ID** — To filter based on the Cluster ID, select the check box and enter the Cluster ID in the text box next to this field.

- **AP Name** — To filter based on the access point name, select the check box and enter the access point name in the text box next to this field.

- **Interferer Type** — To filter based on the type of the interference device, select the check box and select the interferer device from the options.

Select one of the interferer devices:

- **BT Link**
- **MW Oven**
- **802.11 FH**
- **BT Discovery**
- **TDD Transmit**
Monitoring the Interference Device (CLI)

This section describes the commands that you can use to monitor the interference devices for the 802.11a/n or 802.11b/g/n radio band.

Detecting Interferers by an Access Point

See information for all of the interferers detected by a specific access point on the 802.11a/n or 802.11b/g/n radio band by entering this command:

```
show {802.11a | 802.11b} cleanair device ap Cisco_AP
```

When a CleanAir-enabled access point detects interference devices, detections of the same device from multiple sensors are merged together to create clusters. Each cluster is given a unique ID. Some devices conserve power by limiting the transmit time until actually needed which results in the spectrum sensor to temporarily
stop detecting the device. This device is then correctly marked as down. A down device is correctly removed from the spectrum database. In cases when all the interferer detections for a specific device are reported, the cluster ID is kept alive for an extended period of time to prevent possible device detection bouncing. If the same device is detected again, it is merged with the original cluster ID and the device detection history is preserved.

For example, some Bluetooth headsets operate on battery power. These devices employ methods to reduce power consumption, such as turning off the transmitter when not actually needed. Such devices can appear to come and go from the classification. To manage these devices, CleanAir keeps the cluster IDs longer and they are remerged into a single record upon detection. This process smoothens the user records and accurately represents the device history.

**Detecting Interferers by Device Type**

See information for all of the interferers of a specific device type on the 802.11a/n or 802.11b/g/n radio band by entering this command:

```
show {802.11a | 802.11b} cleanair device type type
```

**Note**

No more than 25 interferers can be detected by a Cisco AP.

**Detecting Persistent Sources of Interference**

See a list of persistent sources of interference for a specific access point on the 802.11a/n or 802.11b/g/n radio band by entering this command:

```
show ap auto-rf {802.11a | 802.11b} Cisco_AP
```

**Monitoring Persistent Devices (GUI)**

To monitor persistent devices on a specific access point using the Cisco WLC GUI:

Choose **Wireless > Access Points > Radios > 802.11a/n or 802.11b/g/n** to open the 802.11a/n (or 802.11b/g/n) Radios page. Hover your cursor over the blue drop-down arrow for the desired access point and click **Detail**. The 802.11a/n (or 802.11b/g/n) AP Interfaces > Detail page appears.

This page displays the details of the access points along with the list of persistent devices detected by this access point. Details of the persistent devices is displayed under the Persistent Devices section.

The following information for each persistent device is available:

- **Class Type**—The class type of the persistent device.
- **Channel**—Channel this device is affecting.
- **DC(%)**—Duty cycle (in percentage) of the persistent device.
- **RSSI(dBm)**—RSSI indicator of the persistent device.
- **Last Seen Time**—Timestamp when the device was last active.
Monitoring Persistent Devices (CLI)

To view the list of persistent devices using the CLI, use the following command:

```
show ap auto-rf {802.11a | 802.11b} ap_name
```

Information similar to the following appears:

- Number Of Slots: 2
- AP Name: AP_1142_MAP
- MAC Address: c4:7d:4f:3a:35:38
- Slot ID: 1
- Radio Type: RADIO_TYPE_80211a
- Sub-band Type: All
- Noise Information
- Power Level: 1
- RTS/CTS Threshold: 2347
- Fragmentation Threshold: 2346
- Antenna Pattern: 0

Persistent Interference Devices

<table>
<thead>
<tr>
<th>Class Type</th>
<th>Channel</th>
<th>DC (%)</th>
<th>RSSI (dBm)</th>
<th>Last Update Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Camera</td>
<td>149</td>
<td>100</td>
<td>-34</td>
<td>Tue Nov 8 10:06:25 2011</td>
</tr>
</tbody>
</table>

The following information for each persistent device is available:

- **Class Type**—The class type of the persistent device.
- **Channel**—The channel this device is affecting.
- **DC(%)**—Duty cycle (in percentage) of the persistent device.
- **RSSI(dBm)**—RSSI indicator of the persistent device.
- **Last Seen Time**—Timestamp when the device was last active.

Monitoring the Air Quality of Radio Bands

This section describes how to monitor the air quality of the 802.11a/n and 802.11b/g/n radio bands using both the Cisco WLC GUI and CLI.

Monitoring the Air Quality of Radio Bands (GUI)

Choose **Monitor > Cisco CleanAir > 802.11a/n or 802.11b/g/n > Air Quality Report** to open the CleanAir > Air Quality Report page.

This page shows the air quality of both the 802.11a/n and 802.11b/g/n radio bands. Specifically, it shows the following information:

- **AP Name**—The name of the access point that reported the worst air quality for the 802.11a/n or 802.11b/g/n radio band.
- **Radio Slot**—The slot number where the radio is installed.
- **Channel**—The radio channel where the air quality is monitored.
• Minimum AQ—The minimum air quality for this radio channel.
• Average AQ—The average air quality for this radio channel.
• Interferer—The number of interferers detected by the radios on the 802.11a/n or 802.11b/g/n radio band.
• DFS—Dynamic Frequency Selection. This indicates if DFS is enabled or not.

**Monitoring the Air Quality of Radio Bands (CLI)**

This section describes the commands that you can use to monitor the air quality of the 802.11a/n or 802.11b/g/n radio band.

**Viewing a Summary of the Air Quality**

See a summary of the air quality for the 802.11a/n or 802.11b/g/n radio band by entering this command:

```
show {802.11a | 802.11b} cleanair air-quality summary
```

**Viewing Air Quality for all Access Points on a Radio Band**

See information for the 802.11a/n or 802.11b/g/n access point with the air quality by entering this command:

```
show {802.11a | 802.11b} cleanair air-quality
```

**Viewing Air Quality for an Access Point on a Radio Band**

See air quality information for a specific access point on the 802.11a/n or 802.11b/g/n radio band by entering this command:

```
show {802.11a | 802.11b} cleanair air-quality Cisco_AP
```

**Monitoring the Worst Air Quality of Radio Bands (GUI)**

**Step 1**

Choose **Monitor > Cisco CleanAir > Worst Air-Quality** to open the **CleanAir > Worst Air Quality Report** page. This page shows the air quality of both the 802.11a/n and 802.11b/g/n radio bands. Specifically, it shows the following information:

• **AP Name**—The name of the access point that reported the worst air quality for the 802.11 radio band.
• **Channel Number**—The radio channel with the worst reported air quality.
• **Minimum Air Quality Index (1 to 100)**—The minimum air quality for this radio channel. An air quality index (AQI) value of 100 is the best, and 1 is the worst.
• **Average Air Quality Index (1 to 100)**—The average air quality for this radio channel. An air quality index (AQI) value of 100 is the best, and 1 is the worst.
• **Interference Device Count**—The number of interferers detected by the radios on the 802.11 radio band.

**Step 2**

See a list of persistent sources of interference for a specific access point radio as follows:
a) **Choose Wireless > Access Points > Radios > 802.11a/n or 802.11b/g/n** to open the 802.11a/n (or 802.11b/g/n) Radios page.

b) Hover your cursor over the blue drop-down arrow for the desired access point radio and click **CleanAir-RRM**. The 802.11a/n (or 802.11b/g/n) Cisco APs > Access Point Name > Persistent Devices page appears. This page lists the device types of persistent sources of interference detected by this access point radio. It also shows the channel on which the interference was detected, the percentage of time that the interferer was active (duty cycle), the received signal strength (RSSI) of the interferer, and the day and time when the interferer was last detected.

---

**Monitoring the Worst Air Quality of Radio Bands (CLI)**

This section describes the commands that you can use to monitor the air quality of the 802.11 radio band.

**Viewing a Summary of the Air Quality (CLI)**

See a summary of the air quality for the 802.11a/n or 802.11b/g/n radio band by entering this command:

```
show {802.11a | 802.11b} cleanair air-quality summary
```

**Viewing the Worst Air Quality Information for all Access Points on a Radio Band (CLI)**

See information for the 802.11a/n or 802.11b/g/n access point with the worst air quality by entering this command:

```
show {802.11a | 802.11b} cleanair air-quality worst
```

**Viewing the Air Quality for an Access Point on a Radio Band (CLI)**

See the air quality information for a specific access point on the 802.11 radio band by entering this command:

```
show {802.11a | 802.11b} cleanair air-quality Cisco_AP
```

**Viewing the Air Quality for an Access Point by Device Type (CLI)**

- See information for all of the interferers detected by a specific access point on the 802.11a/n or 802.11b/g/n radio band by entering this command:
  
  ```
  show {802.11a | 802.11b} cleanair device ap Cisco_AP
  ```

- See information for all of the interferers of a specific device type on the 802.11a/n or 802.11b/g/n radio band by entering this command:
  
  ```
  show {802.11a | 802.11b} cleanair device type type
  ```

  where you choose `type` as one of the following:

  - **802.11-fh**—An 802.11 frequency-hopping device (802.11b/g/n only)
  - **802.11-inv**—A device using spectrally inverted Wi-Fi signals
  - **802.11-nonstd**—A device using nonstandard Wi-Fi channels
Detecting Persistent Sources of Interference (CLI)

See a list of persistent sources of interference for a specific access point on the 802.11a/n or 802.11b/g/n radio band by entering this command:

```
show ap auto-rf {802.11a | 802.11b} Cisco_AP
```

Information About Spectrum Expert Connection

To obtain detailed spectrum data that can be used to generate RF analysis plots similar to those provided by a spectrum analyzer, you can configure a Cisco CleanAir-enabled access point to connect directly to a Microsoft Windows XP or Vista PC running the Spectrum Expert application (referred to as a Spectrum Expert console). You can initiate the Spectrum Expert connection semi-automatically from Prime Infrastructure or by manually launching it from the Cisco WLC. This section provides instructions for the latter.
Configuring Spectrum Expert (GUI)

**Before You Begin**

Prior to establishing a connection between the Spectrum Expert console and the access point, make sure that IP address routing is properly configured and the network spectrum interface (NSI) ports are open in any intervening firewalls.

---

**Step 1**

Ensure that Cisco CleanAir functionality is enabled for the access point that will be connected to the Spectrum Expert console.

**Step 2**

Configure the access point for SE-Connect mode using the Cisco WLC GUI or CLI.

**Note** The SE-Connect mode is set for the entire access point, not just a single radio. However, the Spectrum Expert console connects to a single radio at a time.

If you are using the Cisco WLC GUI, follow these steps:

a) Choose **Wireless > Access Points > All APs** to open the All APs page.
b) Click the name of the desired access point to open the All APs > Details for page.
c) Choose **SE-Connect** from the AP Mode drop-down list. This mode is available only for access points that are capable of supporting Cisco CleanAir functionality. For the SE-Connect mode to appear as an available option, the access point must have at least one spectrum-capable radio in the Enable state.
d) Click **Apply** to commit your changes.
e) Click **OK** when prompted to reboot the access point.

If you are using the CLI, follow these steps:

a) To configure the access point for SE-Connect mode, enter this command:
   `config ap mode se-connect Cisco_AP`
b) When prompted to reboot the access point, enter **Y**.
c) To verify the SE-Connect configuration status for the access point, enter this command:
   `show ap config {802.11a | 802.11b} Cisco_AP`
   Information similar to the following appears:

   ```
   Cisco AP Identifier......................... 0
   Cisco AP Name................................ CISCO_AP3500
   ...
   Spectrum Management Information
   Spectrum Management Capable............... Yes
   Spectrum Management Admin State.......... Enabled
   Spectrum Management Operation State...... Up
   Rapid Update Mode........................ Disabled
   Spectrum Expert connection................. Enabled
   Spectrum Sensor State..................... Configured (Error code = 0)
   ```

**Step 3**

On the Windows PC, access the Cisco Software Center from this URL:

Step 4  Click **Product > Wireless > Cisco Spectrum Intelligence > Cisco Spectrum Expert** > **Cisco Spectrum Expert Wi-Fi**, and then download the Spectrum Expert 4.0 executable (*.exe) file.

Step 5  Run the Spectrum Expert application on the PC.

Step 6  When the Connect to Sensor dialog box appears, enter the IP address of the access point, choose the access point radio, and enter the 16-byte network spectrum interface (NSI) key to authenticate. The Spectrum Expert application opens a TCP/IP connection directly to the access point using the NSI protocol.

**Note**  The access point must be a TCP server listening on ports 37540 for 2.4 GHz and 37550 for 5 GHz frequencies. These ports must be opened for the spectrum expert application to connect to the access point using the NSI protocol.

**Note**  On the Cisco WLC GUI, the NSI key appears in the Network Spectrum Interface Key field (below the Port Number field) on the All APs > Details for page. To view the NSI key from the Cisco WLC CLI, enter the `show ap config {802.11a | 802.11b} Cisco_AP` command.

When an access point in SE-Connect mode joins a Cisco WLC, it sends a Spectrum Capabilities notification message, and the Cisco WLC responds with a Spectrum Configuration Request. The request contains the 16-byte random NSI key generated by the Cisco WLC for use in NSI authentication. The Cisco WLC generates one key per access point, which the access point stores until it is rebooted.

**Note**  You can establish up to three Spectrum Expert console connections per access point radio. The Number of Spectrum Expert Connections text box on the 802.11a/n (or 802.11b/g/n) Cisco APs > Configure page of the Cisco WLC GUI shows the number of Spectrum Expert applications that are currently connected to the access point radio.

Step 7  Verify that the Spectrum Expert console is connected to the access point by selecting the Slave Remote Sensor text box in the bottom right corner of the Spectrum Expert application. If the two devices are connected, the IP address of the access point appears in this text box.

Step 8  Use the Spectrum Expert application to view and analyze spectrum data from the access point.

### Related Documents

<table>
<thead>
<tr>
<th>Related Topic</th>
<th>Document Title</th>
<th>URL:</th>
</tr>
</thead>
</table>
Feature History of CleanAir

This table lists the release history for this feature.

Table 45: Feature History for CleanAir

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Releases</th>
<th>Feature Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster ID</td>
<td>7.0.116.0</td>
<td>Cluster identification number that uniquely identifies the type of the devices.</td>
</tr>
<tr>
<td>CleanAir</td>
<td>7.0.98.0</td>
<td>CleanAir enables you to identify and track non-Wi-Fi sources of interference, adjust your network configuration for optimal performance, identify threats from malicious devices, and allow your WLAN to coexist with other wireless devices.</td>
</tr>
</tbody>
</table>
FlexConnect

- Information About FlexConnect, page 771
- Restrictions on FlexConnect, page 777
- Configuring FlexConnect, page 778
- Configuring FlexConnect ACLs, page 790
- Configuring FlexConnect Groups, page 795

Information About FlexConnect

FlexConnect (previously known as Hybrid Remote Edge Access Point or H-REAP) is a wireless solution for branch office and remote office deployments. It enables customers to configure and control access points (AP) in a branch or remote office from the corporate office through a wide area network (WAN) link without deploying a controller in each office. The FlexConnect access points can switch client data traffic locally and perform client authentication locally when their connection to the controller is lost. When they are connected to the controller, they can also send traffic back to the controller. In the connected mode, the FlexConnect access point can also perform local authentication.
The figure below shows a typical FlexConnect deployment.

*Figure 96: FlexConnect Deployment*

![Diagram of FlexConnect Deployment]

The controller software has a more robust fault tolerance methodology to FlexConnect access points. In previous releases, whenever a FlexConnect access point disassociates from a controller, it moves to the standalone mode. The clients that are centrally switched are disassociated. However, the FlexConnect access point continues to serve locally switched clients. When the FlexConnect access point rejoins the controller (or a standby controller), all clients are disconnected and are authenticated again. This functionality has been enhanced and the connection between the clients and the FlexConnect access points are maintained intact and the clients experience seamless connectivity. When both the access point and the controller have the same configuration, the connection between the clients and APs is maintained.

After the client connection has been established, the controller does not restore the original attributes of the client. The client username, current rate and supported rates, and listen interval values are reset to the default values only after the session timer expires.

There is no deployment restriction on the number of FlexConnect access points per location. Multiple FlexConnect groups can be defined in a single location.

The controller can send multicast packets in the form of unicast or multicast packets to the access point. In FlexConnect mode, the access point can receive multicast packets only in unicast form.

FlexConnect access points support a 1-1 network address translation (NAT) configuration. They also support port address translation (PAT) for all features except true multicast. Multicast is supported across NAT boundaries when configured using the Unicast option. FlexConnect access points also support a many-to-one NAT/PAT boundary, except when you want true multicast to operate for all centrally switched WLANs.

Although NAT and PAT are supported for FlexConnect access points, they are not supported on the corresponding controller. Cisco does not support configurations in which the controller is behind a NAT/PAT boundary.

VPN and PPTP are supported for locally switched traffic if these security types are accessible locally at the access point.

FlexConnect access points support multiple SSIDs.
Workgroup bridges and Universal Workgroup bridges are supported on FlexConnect access points for locally switched clients.

FlexConnect supports IPv6 clients by bridging the traffic to local VLAN, similar to IPv4 operation. FlexConnect supports Client Mobility for a group of up to 100 access points.

In the release 8.0, the access point no longer needs to reboot when moving from local to FlexConnect mode.

For the Cisco Flex 7500 Series Wireless LAN Controller, auto convert mode is available on the CLI. The auto convert mode triggers the change on all the connected APs. The change of the mode from Local to FlexConnect and the reboot works in conjunction with the auto convert mode for the Cisco Flex 7500 Series WLC.

When AP is changed from local to FlexConnect it will not reboot, but when it is changed from FlexConnect to local it reboots and displays the following error message, "Warning: Changing AP Mode will reboot the AP and will rejoin the controller after a few minutes. Are you sure you want to continue?" but CLI remains the same. Changing the AP's mode will also cause the AP to reboot.

**FlexConnect Authentication Process**

When an access point boots up, it looks for a controller. If it finds one, it joins the controller, downloads the latest software image and configuration from the controller, and initializes the radio. It saves the downloaded configuration in nonvolatile memory for use in standalone mode.

Once the access point is rebooted after downloading the latest controller software, it must be converted to the FlexConnect mode. This can done using the GUI or CLI.

A FlexConnect access point can learn the controller IP address in one of these ways:

- If the access point has been assigned an IP address from a DHCP server, it can discover a controller through the regular CAPWAP or LWAPP discovery process.

  **Note** OTAP is no longer supported on the controllers with 6.0.196 code and above.

- If the access point has been assigned a static IP address, it can discover a controller through any of the discovery process methods except DHCP option 43. If the access point cannot discover a controller through Layer 3 broadcast, we recommend DNS resolution. With DNS, any access point with a static IP address that knows of a DNS server can find at least one controller.

- If you want the access point to discover a controller from a remote network where CAPWAP or LWAPP discovery mechanisms are not available, you can use priming. This method enables you to specify (through the access point CLI) the controller to which the access point is to connect.
For more information about how access points find controllers, see the controller deployment guide at:

When a FlexConnect access point can reach the controller (referred to as the connected mode), the controller assists in client authentication. When a FlexConnect access point cannot access the controller, the access point enters the standalone mode and authenticates clients by itself.

The LEDs on the access point change as the device enters different FlexConnect modes. See the hardware installation guide for your access point for information on LED patterns.

When a client associates to a FlexConnect access point, the access point sends all authentication messages to the controller and either switches the client data packets locally (locally switched) or sends them to the controller (centrally switched), depending on the WLAN configuration. With respect to client authentication (open, shared, EAP, web authentication, and NAC) and data packets, the WLAN can be in any one of the following states depending on the configuration and state of controller connectivity:

- **central authentication, central switching**—In this state, the controller handles client authentication, and all client data is tunneled back to the controller. This state is valid only in connected mode.

- **central authentication, local switching**—In this state, the controller handles client authentication, and the FlexConnect access point switches data packets locally. After the client authenticates successfully, the controller sends a configuration command with a new payload to instruct the FlexConnect access point to start switching data packets locally. This message is sent per client. This state is applicable only in connected mode.

For the FlexConnect local switching, central authentication deployments, if there is a passive client with a static IP address, it is recommended to disable the Learn Client IP Address feature under the WLAN > Advanced tab.

- **local authentication, local switching**—In this state, the FlexConnect access point handles client authentication and switches client data packets locally. This state is valid in standalone mode and connected mode.

In connected mode, the access point provides minimal information about the locally authenticated client to the controller. The following information is not available to the controller:

- Policy type
- Access VLAN
- VLAN name
- Supported rates
- Encryption cipher

Local authentication is useful where you cannot maintain a remote office setup of a minimum bandwidth of 128 kbps with the round-trip latency no greater than 100 ms and the maximum transmission unit (MTU) no smaller than 576 bytes. In local authentication, the authentication
capabilities are present in the access point itself. Local authentication reduces the latency 
requirements of the branch office.

Note
Local authentication can only be enabled on the WLAN of a FlexConnect access point 
that is in local switching mode.

Notes about local authentication are as follows:

- Guest authentication cannot be done on a FlexConnect local authentication-enabled WLAN.
- Local RADIUS on the controller is not supported.
- Once the client has been authenticated, roaming is only supported after the controller and the other 
  FlexConnect access points in the group are updated with the client information.
- Local authentication in connected mode requires a WLAN configuration.

Note
When locally switched clients that are connected to a FlexConnect access point renew 
the IP addresses, on joining back, the client continues to stay in the run state. These 
clients are not reauthenticated by the controller.

- authentication down, switch down—In this state, the WLAN disassociates existing clients and stops 
sending beacon and probe requests. This state is valid in both standalone mode and connected mode.
- authentication down, local switching—In this state, the WLAN rejects any new clients trying to 
authenticate, but it continues sending beacon and probe responses to keep existing clients alive. This 
state is valid only in standalone mode.

When a FlexConnect access point enters standalone mode, WLANs that are configured for open, shared, 
WPA-PSK, or WPA2-PSK authentication enter the “local authentication, local switching” state and continue 
new client authentications. In controller software release 4.2 or later releases, this configuration is also correct 
for WLANs that are configured for 802.1X, WPA-802.1X, WPA2-802.1X, or CCKM, but these authentication 
types require that an external RADIUS server be configured. You can also configure a local RADIUS server 
on a FlexConnect access point to support 802.1X in a standalone mode or with local authentication.

Other WLANs enter either the “authentication down, switching down” state (if the WLAN was configured 
for central switching) or the “authentication down, local switching” state (if the WLAN was configured for 
local switching).

When FlexConnect access points are connected to the controller (rather than in standalone mode), the controller 
uses its primary RADIUS servers and accesses them in the order specified on the RADIUS Authentication 
Servers page or in the config radius auth add CLI command (unless the server order is overridden for a 
particular WLAN). However, to support 802.1X EAP authentication, FlexConnect access points in standalone 
mode need to have their own backup RADIUS server to authenticate clients.

Note
A controller does not use a backup RADIUS server. The controller uses the backup RADIUS server in 
local authentication mode.
You can configure a backup RADIUS server for individual FlexConnect access points in standalone mode by using the controller CLI or for groups of FlexConnect access points in standalone mode by using either the GUI or CLI. A backup server configured for an individual access point overrides the backup RADIUS server configuration for a FlexConnect.

When a FlexConnect access point enters standalone mode, it disassociates all clients that are on centrally switched WLANs. For web-authentication WLANs, existing clients are not disassociated, but the FlexConnect access point stops sending beacons when the number of associated clients reaches zero (0). It also sends disassociation messages to new clients associating to web-authentication WLANs. Controller-dependent activities, such as network access control (NAC) and web authentication (guest access), are disabled, and the access point does not send any intrusion detection system (IDS) reports to the controller. Most radio resource management (RRM) features (such as neighbor discovery; noise, interference, load, and coverage measurements; use of the neighbor list; and rogue containment and detection) are disabled. However, a FlexConnect access point supports dynamic frequency selection in standalone mode.

When web-authentication is used on FlexConnect access points at a remote site, the clients get the IP address from the remote local subnet. To resolve the initial URL request, the DNS is accessible through the subnet's default gateway. In order for the controller to intercept and redirect the DNS query return packets, these packets must reach the controller at the data center through a CAPWAP connection. During the web-authentication process, the FlexConnect access points allows only DNS and DHCP messages; the access points forward the DNS reply messages to the controller before web-authentication for the client is complete. After web-authentication for the client is complete, all the traffic is switched locally.

If your controller is configured for NAC, clients can associate only when the access point is in connected mode. When NAC is enabled, you need to create an unhealthy (or quarantined) VLAN so that the data traffic of any client that is assigned to this VLAN passes through the controller, even if the WLAN is configured for local switching. After a client is assigned to a quarantined VLAN, all of its data packets are centrally switched. See the Configuring Dynamic Interfaces section for information about creating quarantined VLANs and the Configuring NAC Out-of-Band section for information about configuring NAC out-of-band support.

When a FlexConnect access point enters into a standalone mode, the following occurs:

- The access point checks whether it is able to reach the default gateway via ARP. If so, it will continue to try and reach the controller.

If the access point fails to establish the ARP, the following occurs:

- The access point attempts to discover for five times and if it still cannot find the controller, it tries to renew the DHCP on the ethernet interface to get a new DHCP IP.
- The access point will retry for five times, and if that fails, the access point will renew the IP address of the interface again, this will happen for three attempts.
- If the three attempts fail, the access point will fall back to the static IP and will reboot (only if the access point is configured with a static IP).
- Reboot is done to remove the possibility of any unknown error the access point configuration.

Once the access point reestablishes a connection with the controller, it disassociates all clients, applies new configuration information from the controller, and allows client connectivity again.
Restrictions on FlexConnect

- You can deploy a FlexConnect access point with either a static IP address or a DHCP address. In the case of DHCP, a DHCP server must be available locally and must be able to provide the IP address for the access point at bootup.

- FlexConnect supports up to four fragmented packets or a minimum 576-byte maximum transmission unit (MTU) WAN link.

- Round-trip latency must not exceed 300 milliseconds (ms) between the access point and the controller, and CAPWAP control packets must be prioritized over all other traffic. In cases where you cannot achieve the 300 milliseconds round-trip latency, you can configure the access point to perform local authentication.

- Client connections are restored only for locally switched clients that are in the RUN state when the access point moves from standalone mode to connected mode. After the access point moves from the standalone mode to the connected mode, the access point’s radio is also reset.

- The configuration on the controller must be the same between the time the access point went into standalone mode and the time the access point came back to connected mode. Similarly, if the access point is falling back to a secondary or backup controller, the configuration between the primary and secondary or backup controller must be the same.

- A newly connected access point cannot be booted in FlexConnect mode.

- To use CCKM fast roaming with FlexConnect access points, you must configure FlexConnect Groups.

- NAC out-of-band integration is supported only on WLANs configured for FlexConnect central switching. It is not supported for use on WLANs configured for FlexConnect local switching.

- The primary and secondary controllers for a FlexConnect access point must have the same configuration. Otherwise, the access point might lose its configuration, and certain features (such as WLAN overrides, VLANs, static channel number, and so on) might not operate correctly. In addition, make sure to duplicate the SSID of the FlexConnect access point and its index number on both controllers.

- Do not connect access points in FlexConnect mode directly to a 2500 Series Controller.

- If you configure a FlexConnect access point with a syslog server configured on the access point, after the access point is reloaded and the native VLAN other than 1, at time of initialization, few syslog packets from the access point are tagged with VLAN ID 1. This is a known issue.

- MAC Filtering is not supported on FlexConnect access points in standalone mode. However, MAC Filtering is supported on FlexConnect access points in connected mode with local switching and central authentication. Also, Open SSID, MAC Filtering, and RADIUS NAC for a locally switched WLAN with FlexConnect access points is a valid configuration where MAC is checked by ISE.

- FlexConnect does not support IPv6 ACLs, neighbor discovery caching, and DHCPv6 snooping of IPv6 NDP packets.

- FlexConnect does not display any IPv6 client addresses within the client detail page.

- FlexConnect Access Points with Locally Switched WLAN cannot perform IP Source Guard and prevent ARP spoofing. For Centrally Switched WLAN, the wireless controller performs the IP Source Guard and ARP Spoofing.
To prevent ARP spoofing attacks in FlexConnect AP with Local Switching, we recommend that you use ARP Inspection.

When you enable local switching on WLAN for the Flexconnect APs, then APs perform local switching. However, for the APs in local mode, central switching is performed.

For Wi-Fi Protected Access version 2 (WPA2) in FlexConnect standalone mode or local-auth in connected mode or CCKM fast-roaming in connected mode, only Advanced Encryption Standard (AES) is supported.

For Wi-Fi Protected Access (WPA) in FlexConnect standalone mode or local-auth in connected mode or CCKM fast-roaming in connected mode, only Temporal Key Integrity Protocol (TKIP) is supported.

WPA2 with TKIP and WPA with AES is not supported in standalone mode, local-auth in connected mode, and CCKM fast-roaming in connected mode.

AVC is not supported on APs in FlexConnect local switched mode.

Local authentication fall back is not supported when user is not available in the external RADIUS server.

For WLAN configured for the FlexConnect AP in the local switching and local authentication, synchronization of dot11 clients information is supported.

It is not possible for the Cisco WLC to detect if an AP has dissociated and with that whether the radio is in operational state or non-operational state.

When a FlexConnect AP dissociates from the Cisco WLC, the AP can still serve the clients with the radios being operational; however, with all other AP modes, the radios go into non-operational state.

When you apply a configuration change to a locally switched WLAN, the access point resets the radio, causing associated client devices to disassociate (including the clients that are not associated with the modified WLAN). However, this behavior does not occur if the modified WLAN is centrally switched. We recommend that you modify the configuration only during a maintenance window. This is also applicable when a centrally switched WLAN is changed to a locally switched WLAN.

### Configuring FlexConnect

**Note**

The configuration tasks must be performed in the order in which they are listed.

### Configuring the Switch at a Remote Site

**Step 1**

Attach the access point that will be enabled for FlexConnect to a trunk or access port on the switch.

**Note**

The sample configuration in this procedure shows the FlexConnect access point connected to a trunk port on the switch.

**Step 2**

See the sample configuration in this procedure to configure the switch to support the FlexConnect access point. In this sample configuration, the FlexConnect access point is connected to trunk interface FastEthernet 1/0/2 with native VLAN 100. The access point needs IP connectivity on the native VLAN. The remote site has local servers/resources on VLAN 101. A DHCP pool is created in the local switch for both VLANs in the switch. The first DHCP pool (NATIVE)
is used by the FlexConnect access point, and the second DHCP pool (LOCAL-SWITCH) is used by the clients when they associate to a WLAN that is locally switched. The bolded text in the sample configuration shows these settings.

A sample local switch configuration is as follows:

```
ip dhcp pool NATIVE
  network 209.165.200.224 255.255.255.224
  default-router 209.165.200.225
  dns-server 192.168.100.167
!
ip dhcp pool LOCAL-SWITCH
  network 209.165.201.224 255.255.255.224
  default-router 209.165.201.225
  dns-server 192.168.100.167
!
interface FastEthernet1/0/1
  description Uplink port
  no switchport
  ip address 209.165.202.225 255.255.255.224
!
interface FastEthernet1/0/2
  description the Access Point port
  switchport trunk encapsulation dot1q
  switchport trunk native vlan 100
  switchport trunk allowed vlan 101
  switchport mode trunk
!
interface Vlan100
  ip address 209.165.200.225 255.255.255.224
!
interface Vlan101
  ip address 209.165.201.225 255.255.255.224
!
end
```

### Configuring the Switch with Multicast enabled directly

In Flex Connect local switching, when Multicast to Unicast (MC2UC) is enabled, traffic will follow the queues as mentioned below:

**Step 1**

To send video or voice traffic into respective queues disabled Unicast Video Redirect and CAC support (ACM) should be on the 802.11a or 802.11b radio on which MC2UC clients join.

**Step 2**

When CAC is enabled or unicast video redirect enabled, MC2UC (video/voice) traffic will be pushed to Best Effort queue.

**Note**

This behavior in flex connect local switching only.

Follow these steps to reproduce
a) Have a 5500 WLC with 2602 Flexconnect AP.
b) Enable Multicast Direct globally.
c) Create a Multicast stream.
d) Enable Multicast direct in the WLAN with Gold QoS.
e) Associate a client to this WLAN.
f) Start sending the multicast traffic from Wired to wireless.
g) Check the queue in the AP.

### Configuring the Controller for FlexConnect

You can configure the controller for FlexConnect in two environments:

- Centrally switched WLAN
- Locally switched WLAN

The controller configuration for FlexConnect consists of creating centrally switched and locally switched WLANs. This table shows three WLAN scenarios.

### Table 46: WLANs Example

<table>
<thead>
<tr>
<th>WLAN</th>
<th>Security</th>
<th>Authentication</th>
<th>Switching</th>
<th>Interface Mapping (VLAN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>employee</td>
<td>WPA1+WPA2</td>
<td>Central</td>
<td>Central</td>
<td>management (centrally switched VLAN)</td>
</tr>
<tr>
<td>employee-local</td>
<td>WPA1+WPA2 (PSK)</td>
<td>Local</td>
<td>Local</td>
<td>101 (locally switched VLAN)</td>
</tr>
<tr>
<td>guest-central</td>
<td>Web authentication</td>
<td>Central</td>
<td>Central</td>
<td>management (centrally switched VLAN)</td>
</tr>
<tr>
<td>employee-local-auth</td>
<td>WPA1+WPA2</td>
<td>Local</td>
<td>Local</td>
<td>101 (locally switched VLAN)</td>
</tr>
</tbody>
</table>
Configuring the Controller for FlexConnect for a Centrally Switched WLAN Used for Guest Access

Before You Begin
You must have created guest user accounts. For more information about creating guest user accounts, see the Cisco Wireless LAN Controller System Management Guide.

---

Step 1
Choose WLANs to open the WLANs page.

Step 2
From the drop-down list, choose Create New and click Go to open the WLANs > New page.

Step 3
From the Type drop-down list, choose WLAN.

Step 4
In the Profile Name text box, enter guest-central.

Step 5
In the WLAN SSID text box, enter guest-central.

Step 6
From the WLAN ID drop-down list, choose an ID for the WLAN.

Step 7
Click Apply. The WLANs > Edit page appears.

Step 8
In the General tab, select the Status check box to enable the WLAN.

Step 9
In the Security > Layer 2 tab, choose None from the Layer 2 Security drop-down list.

Step 10
In the Security > Layer 3 tab:
   a) Choose None from the Layer 3 Security drop-down list.
   b) Choose the Web Policy check box.
   c) Choose Authentication.
   
   Note
   If you are using an external web server, you must configure a preauthentication access control list (ACL) on the WLAN for the server and then choose this ACL as the WLAN preauthentication ACL on the Layer 3 tab.

Step 11
Click Apply.

Step 12
Click Save Configuration.

---

Configuring the Controller for FlexConnect (GUI)

Step 1
Choose WLANs to open the WLANs page.

Step 2
From the drop-down list, choose Create New and click Go to open the WLANs > New page.

Step 3
From the Type drop-down list, choose WLAN.

Step 4
In the Profile Name text box, enter a unique profile name for the WLAN.

Step 5
In the WLAN SSID text box, enter a name for the WLAN.

Step 6
From the WLAN ID drop-down list, choose the ID number for this WLAN.

Step 7
Click Apply.
The WLANs > Edit page is displayed.

**Step 8**

You can configure the controller for FlexConnect in both centrally switched and locally switched WLANs:

To configure the controller for FlexConnect in a centrally switched WLAN:

a) In the General tab, select the Status check box to enable the WLAN.

b) If you have enabled NAC and have created a quarantined VLAN and want to use it for this WLAN, select the interface from the Interface/Interface Group (G) drop-down list in the General tab.

c) In the Security > Layer 2 tab, choose WPA+WPA2 from the Layer 2 Security drop-down list and then set the WPA+WPA2 parameters as required.

To configure the controller for FlexConnect in a locally switched WLAN:

a) In the General tab, select the Status check box to enable the WLAN.

b) If you have enabled NAC and have created a quarantined VLAN and want to use it for this WLAN, select the interface from the Interface/Interface Group (G) drop-down list in the General tab.

c) In the Security > Layer 2 tab, select WPA+WPA2 from the Layer 2 Security drop-down list and then set the WPA+WPA2 parameters as required.

d) In the Advanced tab:

   - Select or unselect the FlexConnect Local Switching check box to enable or disable local switching of client data associated with the APs in FlexConnect mode.

   **Note** The guidelines and limitations for this feature are as follows:

   - When you enable local switching, any FlexConnect access point that advertises this WLAN is able to locally switch data packets (instead of tunneling them to the controller).

   - When you enable FlexConnect local switching, the controller is enabled to learn the client's IP address by default. However, if the client is configured with Fortress Layer 2 encryption, the controller cannot learn the client's IP address, and the controller periodically drops the client. Disable the client IP address learning feature so that the controller maintains the client connection without waiting to learn the client's IP address. The ability to disable this option is supported only with FlexConnect local switching; it is not supported with FlexConnect central switching.

   - For FlexConnect access points, the interface mapping at the controller for WLANs that is configured for FlexConnect Local Switching is inherited at the access point as the default VLAN tagging. This mapping can be changed per SSID and per FlexConnect access point. Non-FlexConnect access points tunnel all traffic back to the controller, and VLAN tagging is determined by each WLAN's interface mapping.

   - Select or unselect the FlexConnect Local Auth check box to enable or disable local authentication for the WLAN.

   - Select or unselect the Learn Client IP Address check box to enable or disable the IP address of the client to be learned.

   - Select or unselect the VLAN based Central Switching check box to enable or disable central switching on a locally switched WLAN based on AAA overridden VLAN.
Note  These are the guidelines and limitations for this feature:

- Multicast on overridden interfaces is not supported.
- This feature is available only on a per-WLAN basis, where the WLAN is locally switched.
- IPv6 ACLs, CAC, NAC, and IPv6 are not supported.
- IPv4 ACLs are supported only with VLAN-based central switching enabled and applicable only to central switching clients on the WLAN.
- This feature is applicable to APs in FlexConnect mode in locally switched WLANs.
- This feature is not applicable to APs in Local mode.
- This feature is not supported on APs in FlexConnect mode in centrally switched WLANs.
- This feature is supported on central authentication only.
- This feature is not supported on web authentication security clients.
- Layer 3 roaming for local switching clients is not supported.

- Select or unselect the **Central DHCP Processing** check box to enable or disable the feature. When you enable this feature, the DHCP packets received from AP are centrally switched to the controller and then forwarded to the corresponding VLAN based on the AP and the SSID.
- Select or unselect the **Override DNS** check box to enable or disable the overriding of the DNS server address on the interface assigned to the locally switched WLAN. When you override DNS in centrally switched WLANs, the clients get their DNS server IP address from the AP, not from the controller.
- Select or unselect the **NAT-PAT** check box to enable or disable Network Address Translation (NAT) and Port Address Translation (PAT) on locally switched WLANs. You must enable Central DHCP Processing to enable NAT and PAT.

**Step 9**  Click **Apply**.

**Step 10**  Click **Save Configuration**.

---

**Configuring the Controller for FlexConnect (CLI)**

- `config wlan flexconnect local-switching wlan_id enable`—Configures the WLAN for local switching.
When you enable FlexConnect local switching, the controller waits to learn the client IP address by default. However, if the client is configured with Fortress Layer 2 encryption, the controller cannot learn the client IP address, and the controller periodically drops the client. Use the `config wlan flexconnect learn-ipaddr wlan_id disable` command to disable the client IP address learning feature so that the controller maintains the client connection without waiting to learn the client’s IP address. The ability to disable this feature is supported only with FlexConnect local switching; it is not supported with FlexConnect central switching. To enable this feature, enter the `config wlan flexconnect learn-ipaddr wlan_id enable` command.

Note

When a WLAN is locally switched (LS), you must use the `config wlan flexconnect learn-ipaddr wlan-id {enable | disable}` command. When the WLAN is centrally switched (CS), you must use the `config wlan learn-ipaddr-cswlan wlan-id {enable | disable}` command.

- `config wlan flexconnect local-switching wlan_id {enable | disable}`—Configures the WLAN for central switching.
- `config wlan flexconnect vlan-central-switching wlan_id {enable | disable}`—Configures central switching on a locally switched WLAN based on an AAA overridden VLAN.

The guidelines and limitations for this feature are as follows:

- Multicast on overridden interfaces is not supported.
- This feature is available only on a per-WLAN basis, where the WLAN is locally switched.
- IPv6 ACLs, CAC, NAC, and IPv6 are not supported.
- IPv4 ACLs are supported only with VLAN-based central switching enabled and applicable only to central switching clients on the WLAN.
- This feature is applicable to APs in FlexConnect mode in locally switched WLANs.
- This feature is not applicable to APs in Local mode.
- This feature is not supported on APs in FlexConnect mode in centrally switched WLANs.
- This feature is supported on central authentication only.
- This features is not supported on web authentication security clients.
- Layer 3 roaming for local switching clients is not supported.

Use these commands to get FlexConnect information:

- `show ap config general Cisco_AP`—Shows VLAN configurations.
- `show wlan wlan_id`—Shows whether the WLAN is locally or centrally switched.
- `show client detail client_mac`—Shows whether the client is locally or centrally switched.

Use these commands to obtain debug information:
• debug flexconnect aaa {event | error} {enable | disable}—Enables or disables debugging of FlexConnect backup RADIUS server events or errors.

• debug flexconnect cckm {enable | disable}—Enables or disables debugging of FlexConnect CCKM.

• debug flexconnect {enable | disable}—Enables or disables debugging of FlexConnect Groups.

• debug pem state {enable | disable}—Enables or disables debugging of the policy manager state machine.

• debug pem events {enable | disable}—Enables or disables debugging of policy manager events.

Configuring an Access Point for FlexConnect

Configuring an Access Point for FlexConnect (GUI)

Before You Begin

Ensure that the access point has been physically added to your network.

Note  The AP will reboot when you change the AP behavior from Flexconnect to Local.

Step 1  Choose Wireless to open the All APs page.

Step 2  Click the name of the desired access point. The All APs > Details page appears.

Step 3  From the AP Mode drop-down list, choose FlexConnect for this access point.

Note  The last parameter in the Inventory tab indicates whether the access point can be configured for FlexConnect.

Step 4  Click Apply to commit your changes and to cause the access point to reboot.

Step 5  Choose the FlexConnect tab to open the All APs > Details for (FlexConnect) page.

If the access point belongs to a FlexConnect group, the name of the group appears in the FlexConnect Name text box.

Step 6  Select the VLAN Support check box and enter the number of the native VLAN on the remote network (such as 100) in the Native VLAN ID text box.

Note  By default, a VLAN is not enabled on the FlexConnect access point. After FlexConnect is enabled, the access point inherits the VLAN ID associated to the WLAN. This configuration is saved in the access point and received after the successful join response. By default, the native VLAN is 1. One native VLAN must be configured per FlexConnect access point in a VLAN-enabled domain. Otherwise, the access point cannot send and receive packets to and from the controller.

Note  If PMIPv6 MAG on FlexConnect AP is configured, VLAN Support can be checked or unchecked on the FlexConnect AP. If you check the VLAN Support check box, enter the number of the native VLAN on the remote network in the Native VLAN ID text box.

Note  To preserve the VLAN mappings in the access point after an upgrade or downgrade, it is necessary that the access point join is restricted to the controller for which it is primed. That is, no other discoverable controller with a different configuration should be available by other means. Similarly, at the time the access point joins, if it moves across controllers that have different VLAN mappings, the VLAN mappings at the access point may get mismatched.

Note  For Cisco 1140 access point, when the native VLAN ID is set, it disconnects and joins back the Cisco 8500 series wireless controller. And after resuming the admin mode for the AP, is disabled.
Step 7  
Click Apply. The access point temporarily loses its connection to the controller while its Ethernet port is reset.

Step 8  
Click the name of the same access point and then click the FlexConnect tab.

Step 9  
Click VLAN Mappings to open the All APs > Access Point Name > VLAN Mappings page.

Step 10  
Enter the number of the VLAN from which the clients will get an IP address when doing local switching (VLAN 101, in this example) in the VLAN ID text box.

Step 11  
To configure Web Authentication ACLs, do the following:
  a) Click the External WebAuthentication ACLs link to open the ACL mappings page. The ACL Mappings page lists details of WLAN ACL mappings and web policy ACLs.
  b) In the WLAN ID box, enter the WLAN ID.
  c) From the WebAuth ACL drop-down list, choose the FlexConnect ACL.
     To create a FlexConnect ACL, choose Wireless > FlexConnect Groups > FlexConnect ACLs, click New, enter the FlexConnect ACL name, and click Apply.
  d) Click Add.
  e) Click Apply.

Step 12  
To configure Local Split ACLs:
  a) Click the Local Split ACLs link to open the ACL Mappings page.
  b) In the WLAN ID box, enter the WLAN ID.
  c) From the Local-Split ACL drop-down list, choose the FlexConnect ACL.
     To create a FlexConnect ACL, choose Wireless > FlexConnect Groups > FlexConnect ACLs, click New, enter the FlexConnect ACL name, and click Apply.
  d) Click Add.

Step 13  
To configure Central DHCP processing:
  a) In the WLAN Id box, enter the WLAN ID with which you want to map Central DHCP.
  b) Select or unselect the Central DHCP check box to enable or disable Central DHCP for the mapping.
  c) Select or unselect the Override DNS check box to enable or disable overriding of DNS for the mapping.
  d) Select or unselect the NAT-PAT check box to enable or disable network address translation and port address translation for the mapping.
  e) Click Add to add the Central DHCP - WLAN mapping.

Step 14  
To map a locally switched WLAN with a WebAuth ACL, follow these steps:
  a) In the WLAN Id box, enter the WLAN ID.
  b) From the WebAuth ACL drop-down list, choose the FlexConnect ACL.
     To create a FlexConnect ACL, choose Wireless > FlexConnect Groups > FlexConnect ACLs, click New, enter the FlexConnect ACL name, and click Apply.
c) Click **Add**.

**Note**  The FlexConnect ACLs that are specific to an AP have the highest priority. The FlexConnect ACLs that are specific to WLANs have the lowest priority.

**Step 15**  From the **WebPolicy ACL** drop-down list, choose a FlexConnect ACL and then click **Add** to configure the FlexConnect ACL as a web policy.

**Note**  You can configure up to 16 Web Policy ACLs that are specific to an access point.

**Step 16**  Click **Apply**.

**Step 17**  Click **Save Configuration**.

**Note**  Repeat this procedure for any additional access points that need to be configured for FlexConnect at the remote site.

---

**Configuring an Access Point for FlexConnect (CLI)**

**Note**  The AP will reboot when you change the AP behavior from Flexconnect to Local.

```
• config ap mode flexconnect **Cisco_AP**—Enables FlexConnect for this access point.

• config ap flexconnect radius auth set \{primary | secondary\} ip_address auth_port secret **Cisco_AP**—Configures a primary or secondary RADIUS server for a specific FlexConnect access point.

**Note**  Only the Session Timeout RADIUS attribute is supported in standalone mode. All other attributes as well as RADIUS accounting are not supported.

**Note**  To delete a RADIUS server that is configured for a FlexConnect access point, enter the `config ap flexconnect radius auth delete \{primary | secondary\} **Cisco_AP**` command.

• config ap flexconnect vlan wlan wlan_id vlan-id **Cisco_AP**—Enables you to assign a VLAN ID to this FlexConnect access point. By default, the access point inherits the VLAN ID associated to the WLAN.

• config ap flexconnect vlan \{enable | disable\} **Cisco_AP**—Enables or disables VLAN tagging for this FlexConnect access point. By default, VLAN tagging is not enabled. After VLAN tagging is enabled on the FlexConnect access point, WLANs that are enabled for local switching inherit the VLAN assigned at the controller.

• config ap flexconnect vlan native vlan-id **Cisco_AP**—Enables you to configure a native VLAN for this FlexConnect access point. By default, no VLAN is set as the native VLAN. One native VLAN must be configured per FlexConnect access point (when VLAN tagging is enabled). Make sure the switch port to which the access point is connected has a corresponding native VLAN configured as well. If the FlexConnect access point’s native VLAN setting and the upstream switch port native VLAN do not match, the access point cannot transmit packets to and from the controller.
```
To save the VLAN mappings in the access point after an upgrade or downgrade, you should restrict the access point to join the controller for which it is primed. No other discoverable controller with a different configuration should be available by other means. Similarly, at the time the access point joins, if it moves across controllers that have different VLAN mappings, the VLAN mappings at the access point might get mismatched.

- Configure the mapping of a Web-Auth or a Web Passthrough ACL to a WLAN for an access point in FlexConnect mode by entering this command:

```
config ap flexconnect web-auth wlan wlan_id cisco_acl_name {enable | disable}
```

**Note** The FlexConnect ACLs that are specific to an AP have the highest priority. The FlexConnect ACLs that are specific to WLANs have the lowest priority.

- Configure a Policy ACL on an AP in FlexConnect mode by entering this command:

```
config ap flexconnect acl {add | delete} acl_name cisco_ap
```

**Note** You can configure up to 16 Policy ACLs that are specific to an access point.

- To configure local split tunneling on a per-AP basis, enter this command:

```
config ap local-split {enable | disable} wlan acl acl-name ap-name
```

- Configure central DHCP on the AP per WLAN by entering this command:

```
config ap flexconnect central-dhcp wlan-id ap-name {enable override dns | disable | delete}
```

**Note** The gratuitous ARP for the gateway is sent by the access point to the client, which obtained an IP address from the central site. This is performed to proxy the gateway by the access point.

Use these commands on the FlexConnect access point to get status information:

- **show capwap reap status**—Shows the status of the FlexConnect access point (connected or standalone).

- **show capwap reap association**—Shows the list of clients associated with this access point and their SSIDs.

Use these commands on the FlexConnect access point to get debug information:

- **debug capwap reap**—Shows general FlexConnect activities.

- **debug capwap reap mgmt**—Shows client authentication and association messages.
- **debug capwap reap load**—Shows payload activities, which are useful when the FlexConnect access point boots up in standalone mode.
- **debug dot11 mgmt interface**—Shows 802.11 management interface events.
- **debug dot11 mgmt msg**—Shows 802.11 management messages.
- **debug dot11 mgmt ssid**—Shows SSID management events.
- **debug dot11 mgmt state-machine**—Shows the 802.11 state machine.
- **debug dot11 mgmt station**—Shows client events.

### Configuring an Access Point for Local Authentication on a WLAN (GUI)

**Step 1** Choose WLANs to open the WLANs page.

**Step 2** Click the ID of the WLAN. The WLANs > Edit page appears.

**Step 3** Clicked the Advanced tab to open the WLANs > Edit (WLAN Name) page.

**Step 4** Select the FlexConnect Local Switching check box to enable FlexConnect local switching.

**Step 5** Select the FlexConnect Local Auth check box to enable FlexConnect local authentication.

**Caution** Do not connect access points in FlexConnect mode directly to 2500 Series Controllers.

**Step 6** Click Apply to commit your changes.

### Configuring an Access Point for Local Authentication on a WLAN (CLI)

**Before You Begin**

Before you begin, you must have enabled local switching on the WLAN where you want to enable local authentication for an access point. For instructions on how to enable local switching on the WLAN, see the Configuring the Controller for FlexConnect (CLI) section.

- **config wlan flexconnect ap-auth wlan_id {enable | disable}**—Configures the access point to enable or disable local authentication on a WLAN.

  **Caution** Do not connect the access points in FlexConnect mode directly to Cisco 2500 Series Controllers.

- **show wlan wlan-id**—Displays the configuration for the WLAN. If local authentication is enabled, the following information appears:

  ```
  ...
  Web Based Authentication...................... Disabled
  Web-Passthrough................................ Disabled
  Conditional Web Redirect..................... Disabled
  Splash-Page Web Redirect..................... Disabled
  Auto Anchor................................... Disabled
  FlexConnect Local Switching.................. Enabled
  FlexConnect Local Authentication............. Enabled
  ```
Connecting Client Devices to WLANs

Follow the instructions for your client device to create profiles to connect to the WLANs you created in the Configuring the Controller for FlexConnect.

In the example scenarios (see Table 46: WLANs Example), there are three profiles on the client:

1. To connect to the "employee" WLAN, create a client profile that uses WPA/WPA2 with PEAP-MSCHAPV2 authentication. After the client becomes authenticated, the client gets an IP address from the management VLAN of the controller.

2. To connect to the "local-employee" WLAN, create a client profile that uses WPA/WPA2 authentication. After the client becomes authenticated, the client gets an IP address from VLAN 101 on the local switch.

3. To connect to the "guest-central" WLAN, create a client profile that uses open authentication. After the client becomes authenticated, the client gets an IP address from VLAN 101 on the network local to the access point. After the client connects, the local user can type any HTTP address in the web browser. The user is automatically directed to the controller to complete the web-authentication process. When the web login page appears, the user enters the username and password.

To determine if a client's data traffic is being locally or centrally switched, choose Monitor > Clients on the controller GUI, click the Detail link for the desired client, and look at the Data Switching parameter under AP Properties.

Configuring FlexConnect ACLs

Information About Access Control Lists

An access control list (ACL) is a set of rules used to limit access to a particular interface (for example, if you want to restrict a wireless client from pinging the management interface of the controller). ACLs enable access control of network traffic. After ACLs are configured on the controller, you can apply them to the management interface, the AP-Manager interface, any of the dynamic interfaces, or a WLAN. ACLs enable you to control data traffic to and from wireless clients or to the controller CPU. You can configure ACLs on FlexConnect access points to enable effective usage and access control of locally switched data traffic on an access point.

The FlexConnect ACLs can be applied to VLAN interfaces on access points in both the Ingress and Egress mode.

Existing interfaces on an access point can be mapped to ACLs. The interfaces can be created by configuring a WLAN-VLAN mapping on a FlexConnect access point.

The FlexConnect ACLs can be applied to an access point's VLAN only if VLAN support is enabled on the FlexConnect access point.
Restrictions for FlexConnect ACLs

- FlexConnect ACLs can be applied only to FlexConnect access points. The configurations applied are per AP and per VLAN.
- FlexConnect ACLs are supported on the native VLAN.
- You can configure up to 512 ACLs on a controller.
- Non-FlexConnect ACLs that are configured on the controller cannot be applied to a FlexConnect AP.
- FlexConnect ACLs do not support direction per rule. Unlike normal ACLs, Flexconnect ACLs cannot be configured with a direction. An ACL as a whole needs to be applied to an interface as ingress or egress.
- You can define up to 512 FlexConnect ACLs, each with up to 64 rules (or filters). Each rule has parameters that affect its action. When a packet matches all the parameters pertaining to a rule, the action set pertaining to that rule is applied to the packet.
- ACLs in your network might have to be modified because Control and Provisioning of Wireless Access Points (CAPWAP) use ports that are different from the ones used by the Lightweight Access Point Protocol (LWAPP).
- All ACLs have an implicit *deny all rule* as the last rule. If a packet does not match any of the rules, it is dropped by the corresponding access point.
- ACLs mapping on the VLANs that are created on an AP using WLAN-VLAN mapping, should be performed on a per-AP basis only. VLANs can be created on a FlexConnect group for AAA override. These VLANs will not have any mapping for a WLAN.
- ACLs for VLANs that are created on a FlexConnect group should be mapped only on the FlexConnect group. If the same VLAN is present on the corresponding AP as well as the FlexConnect group, AP VLAN will take priority. This means that if no ACL is mapped on the AP, the VLAN will not have any ACL, even if the ACL is mapped to the VLAN on the FlexConnect group.
- Ensure the FlexConnect ACL and the regular ACL names are not the same while configuring a WLAN for FlexConnect local switching.

**Note**

A Local Switching WLAN is configured and ACL is mapped to a FlexConnect group with an ACL. The ACL has set of 'deny and permit' rules. When you associate a client to the WLAN, the client needs to have DHCP permit rule added for getting the IP address.

Configuring FlexConnect ACLs

Configuring FlexConnect ACLs (GUI)

**Step 1** Choose **Security > Access Control Lists > FlexConnect Access Control Lists.**
The FlexConnect ACL page is displayed.

This page lists all the FlexConnect ACLs configured on the controller. This page also shows the FlexConnect ACLs created on the corresponding controller. To remove an ACL, hover your mouse over the blue drop-down arrow adjacent to the corresponding ACL name and choose Remove.

**Step 2**
Add a new ACL by clicking **New**.
The Access Control Lists > New page is displayed.

**Step 3**
In the Access Control List Name text box, enter a name for the new ACL. You can enter up to 32 alphanumeric characters.

**Step 4**
Click **Apply**.

**Step 5**
When the Access Control Lists page reappears, click the name of the new ACL.
When the Access Control Lists > Edit page appears, click **Add New Rule**.
The Access Control Lists > Rules > New page is displayed.

**Step 6**
Configure a rule for this ACL as follows:

a) The controller supports up to 64 rules for each ACL. These rules are listed in order from 1 to 64. In the Sequence text box, enter a value (between 1 and 64) to determine the order of this rule in relation to any other rules defined for this ACL.

   **Note** If rules 1 through 4 are already defined and you add rule 29, it is added as rule 5. If you add or change a sequence number of a rule, the sequence numbers of the other rules are automatically adjusted to maintain a continuous sequence. For instance, if you change a rule’s sequence number from 7 to 5, the rules with sequence numbers 5 and 6 are automatically reassigned as 6 and 7, respectively.

b) From the Source drop-down list, choose one of these options to specify the source of the packets to which this ACL is applicable:

   • Any— Any source (This is the default value.)
   • IP Address—A specific source. If you choose this option, enter the IP address and netmask of the source in the corresponding text boxes.

c) From the Destination drop-down list, choose one of these options to specify the destination of the packets to which this ACL applies:

   • Any— Any destination (This is the default value.)
   • IP Address—A specific destination. If you choose this option, enter the IP address and netmask of the destination in the text boxes.

d) From the Protocol drop-down list, choose the protocol ID of the IP packets to be used for this ACL. The protocol options that you can use are the following:

   • Any—Any protocol (This is the default value.)
   • TCP
   • UDP
   • ICMP—Internet Control Message Protocol
   • ESP—IP Encapsulating Security Payload
   • AH—Authentication Header
   • GRE—Generic Routing Encapsulation
• **IP in IP**—Permits or denies IP-in-IP packets  
• **Eth Over IP**—Ethernet-over-Internet Protocol  
• **OSPF**—Open Shortest Path First  
• **Other**—Any other Internet-Assigned Numbers Authority (IANA) protocol

**Note** If you choose Other, enter the number of the desired protocol in the **Protocol** text box. You can find the list of available protocols in the INAI website.

The controller can permit or deny only the IP packets in an ACL. Other types of packets (such as Address Resolution Protocol (ARP) packets) cannot be specified.

If you chose TCP or UDP, two additional parameters, Source Port and Destination Port, are displayed. These parameters enable you to choose a specific source port and destination port or port range. The port options are used by applications that send and receive data to and from the networking stack. Some ports are designated for certain applications, such as Telnet, SSH, HTTP, and so on.

e) From the **DSCP** drop-down list, choose one of these options to specify the differentiated services code point (DSCP) value of this ACL. DSCP is an IP header text box that can be used to define the quality of service across the Internet.

   - **Any**—Any DSCP (This is the default value.)  
   - **Specific**—A specific DSCP from 0 to 63, which you enter in the **DSCP** text box

f) From the **Action** drop-down list, choose **Deny** to cause this ACL to block packets, or **Permit** to cause this ACL to allow packets. The default value is **Deny**.

g) Click **Apply**.

   The **Access Control Lists > Edit** page is displayed on which the rules for this ACL are shown.

h) Repeat this procedure to add additional rules, if any, for this ACL.

**Step 7** Click **Save Configuration**.

---

**Configuring FlexConnect ACLs (CLI)**

Use the following commands on the controller to view information related to FlexConnect ACLs:

- **config flexconnect acl create** `name`

  Creates an ACL on a FlexConnect access point. The name must be an IPv4 ACL name of up to 32 characters.

- **config flexconnect acl delete** `name`

  Deletes a FlexConnect ACL.

- **config flexconnect acl rule action** `acl-name` `rule-index {permit |deny}`

  Permits or denies an ACL.

- **config flexconnect acl rule add** `acl-name` `rule-index`

  Adds an ACL rule.

- **config flexconnect acl rule change index** `acl-name` `old-index` `new-index`—
Changes the index value for an ACL rule.

- **config flexconnect acl rule delete name**
  Deletes an ACL rule.

- **config flexconnect acl rule dscp acl-name rule-index {0-63 | any}**
  Specifies the differentiated services code point (DSCP) value of the rule index. DSCP is an IP header that can be used to define the quality of service across the Internet. Enter a value between 0 and 63 or the value any. The default value is any.

- **config flexconnect acl rule protocol acl-name rule-index {0-255 | any}**
  Assigns the rule index to an ACL rule. Specify a value between 0 and 255 or 'any'. The default is 'any'.

- **config flexconnect acl rule destination address acl-name rule-index ipv4-addr subnet-mask**
  Configures a rule’s destination IP address, netmask and port range.

- **config flexconnect acl rule destination port range acl-name rule-index start-port end-port**
  Configures a rule’s destination port range.

- **config flexconnect acl rule source address acl-name rule-index ipv4-addr subnet-mask**
  Configures a rule's source IP address and netmask.

- **config flexconnect acl apply acl-name**
  Applies an ACL to the FlexConnect access point.

- **config flexconnect acl rule swap acl-name index-1 index-2**
  Swaps the index values of two rules.

- **config ap flexconnect vlan add acl vlan-id ingress-aclname egress-acl-name ap-name**
  Adds a VLAN on a FlexConnect access point.

- **config flexconnect acl rule source port range acl-name rule-index start-port end-port**
  Configures a rule’s source port range.

**Viewing and Debugging FlexConnect ACLs (CLI)**

Use the following commands on the controller to view information related to FlexConnect ACLs:

- **show flexconnect acl summary**—Displays a summary of the ACLs.

- **show client detail mac-address**—Displays the FlexConnect ACL Applied Status and IPv4 ACL Applied Status. The IPv4 ACL name field shows the ACL applied to the client based on local/central switching.

- **show flexconnect acl detailed acl-name**—Displays the detailed information about the ACL.

- **debug flexconnect acl {enable | disable}**—Enables or disables the debugging of FlexConnect ACL.

- **debug capwap reap**—Enables debugging of CAPWAP.
Configuring FlexConnect Groups

Information About FlexConnect Groups

To organize and manage your FlexConnect access points, you can create FlexConnect Groups and assign specific access points to them.

All of the FlexConnect access points in a group share the same backup RADIUS server, CCKM, and local authentication configuration information. This feature is helpful if you have multiple FlexConnect access points in a remote office or on the floor of a building and you want to configure them all at once. For example, you can configure a backup RADIUS server for a FlexConnect rather than having to configure the same server on each access point.

The following figure shows a typical FlexConnect deployment with a backup RADIUS server in the branch office.

Figure 97: FlexConnect Group Deployment

FlexConnect Groups and Backup RADIUS Servers

You can configure the controller to allow a FlexConnect access point in standalone mode to perform full 802.1X authentication to a backup RADIUS server. You can configure a primary backup RADIUS server or both a primary and secondary backup RADIUS server. These servers can be used when the FlexConnect access point is in one of these two modes: standalone or connected.

FlexConnect Groups and CCKM

FlexConnect Groups are required for CCKM fast roaming to work with FlexConnect access points. CCKM fast roaming is achieved by caching a derivative of the master key from a full EAP authentication so that a simple and secure key exchange can occur when a wireless client roams to a different access point. This feature prevents the need to perform a full RADIUS EAP authentication as the client roams from one access point to another. The FlexConnect access points need to obtain the CCKM cache information for all the clients that might associate so they can process it quickly instead of sending it back to the controller. If, for example, you
have a controller with 300 access points and 100 clients that might associate, sending the CCKM cache for all 100 clients is not practical. If you create a FlexConnect that includes a limited number of access points (for example, you create a group for four access points in a remote office), the clients roam only among those four access points, and the CCKM cache is distributed among those four access points only when the clients associate to one of them.

Note  CCKM fast roaming among FlexConnect and non-FlexConnect access points is not supported.

**FlexConnect Groups and Opportunistic Key Caching**

Starting with the Cisco Wireless LAN Controller Release 7.0.116.0, FlexConnect groups accelerate Opportunistic Key Caching (OKC) to enable fast roaming of clients. OKC facilitates fast roaming by using PMK caching in access points that are in the same FlexConnect group.

OKC prevents the need to perform a full authentication as the client roams from one access point to another. FlexConnect groups store the cached key on the APs of the same group, accelerating the process. However, they are not required, as OKC will still happen between access points belonging to different FlexConnect groups and will use the cached key present on the Cisco WLC, provided that Cisco WLC is reachable and APs are in connected mode.

To see the PMK cache entries at the FlexConnect access point, use the `show capwap reap pmk` command. This feature is supported on Cisco FlexConnect access points only. The PMK cache entries cannot be viewed on Non-FlexConnect access points.

Note  The FlexConnect access point must be in connected mode when the PMK is derived during WPA2/802.1x authentication.

When using FlexConnect groups for OKC or CCKM, the PMK-cache is shared only across the access points that are part of the same FlexConnect group and are associated to the same controller. If the access points are in the same FlexConnect group but are associated to different controllers that are part of the same mobility group, the PMK cache is not updated and CCKM roaming will fail but OKC roaming will still work.

Note  Fast roaming works only if the APs are in the same FlexConnect group for APs in FlexConnect mode, 802.11r.

**FlexConnect Groups and Local Authentication**

You can configure the controller to allow a FlexConnect access point in standalone mode to perform LEAP, EAP-FAST authentication for up to 100 statically configured users. The controller sends the static list of usernames and passwords to each FlexConnect access point when it joins the controller. Each access point in the group authenticates only its own associated clients.

This feature is ideal for customers who are migrating from an autonomous access point network to a lightweight FlexConnect access point network and are not interested in maintaining a large user database or adding another hardware device to replace the RADIUS server functionality available in the autonomous access point.
This feature can be used with the FlexConnect backup RADIUS server feature. If a FlexConnect is configured with both a backup RADIUS server and local authentication, the FlexConnect access point always attempts to authenticate clients using the primary backup RADIUS server first, followed by the secondary backup RADIUS server (if the primary is not reachable), and finally the FlexConnect access point itself (if the primary and secondary are not reachable).

For information about the number of FlexConnect groups and access point support for a Cisco WLC model, see the data sheet of the respective Cisco WLC model.

Configuring FlexConnect Groups (GUI)

Step 1 Choose Wireless > FlexConnect Groups to open the FlexConnect Groups page. This page lists any FlexConnect groups that have already been created.

Note If you want to delete an existing group, hover your cursor over the blue drop-down arrow for that group and choose Remove.

Step 2 Click New to create a new FlexConnect Group.

Step 3 On the FlexConnect Groups > New page, enter the name of the new group in the Group Name text box. You can enter up to 32 alphanumeric characters.

Step 4 Click Apply. The new group appears on the FlexConnect Groups page.

Step 5 To edit the properties of a group, click the name of the desired group. The FlexConnect Groups > Edit page appears.

Step 6 If you want to configure a primary RADIUS server for this group (for example, the access points are using 802.1X authentication), choose the desired server from the Primary RADIUS Server drop-down list. Otherwise, leave the text box set to the default value of None.

Note IPv6 RADIUS Server is not configurable. Only IPv4 configuration is supported.

Step 7 If you want to configure a secondary RADIUS server for this group, choose the server from the Secondary RADIUS Server drop-down list. Otherwise, leave the field set to the default value of None.

Step 8 To add an access point to the group, click Add AP. Additional fields appear on the page under Add AP.

Step 9 Perform one of the following tasks:

- To choose an access point that is connected to this controller, select the Select APs from Current Controller check box and choose the name of the access point from the AP Name drop-down list.

  Note If you choose an access point on this controller, the MAC address of the access point is automatically entered in the Ethernet MAC text box to prevent any mismatches from occurring.

- To choose an access point that is connected to a different controller, leave the Select APs from Current Controller check box unselected and enter its MAC address in the Ethernet MAC text box.

  Note If the FlexConnect access points within a group are connected to different controllers, all of the controllers must belong to the same mobility group.

Step 10 Click Add to add the access point to this FlexConnect group. The access point’s MAC address, name, and status appear at the bottom of the page.

Note If you want to delete an access point, hover your cursor over the blue drop-down arrow for that access point and choose Remove.
**Step 11**  
Click **Apply**.

**Step 12**  
Enable local authentication for a FlexConnect Group as follows:

a) Ensure that the Primary RADIUS Server and Secondary RADIUS Server parameters are set to **None**.

b) Select the **Enable AP Local Authentication** check box to enable local authentication for this FlexConnect Group. The default value is unselected.

c) Click **Apply**.

d) Choose the **Local Authentication** tab to open the FlexConnect > Edit (Local Authentication > Local Users) page.

e) To add clients that you want to be able to authenticate using LEAP, EAP-FAST, perform one of the following:

f) Upload a comma-separated values (CSV) file by selecting the **Upload CSV File** check box, clicking the **Browse** button to browse to an CSV file that contains usernames and passwords (each line of the file needs to be in the following format: username, password), and clicking **Add** to upload the CSV file. The clients’ names appear on the left side of the page under the “User Name” heading.

g) Add clients individually by entering the client’s username in the User Name text box and a password for the client in the Password and Confirm Password text boxes, and clicking **Add** to add this client to the list of supported local users. The client name appears on the left side of the page under the “User Name” heading.

**Note**  
You can add up to 100 clients.

h) Click **Apply**.

i) Choose the **Protocols** tab to open the FlexConnect > Edit (Local Authentication > Protocols) page.

j) To allow a FlexConnect access point to authenticate clients using LEAP, select the **Enable LEAP Authentication** check box.

k) To allow a FlexConnect access point to authenticate clients using EAP-FAST, select the **Enable EAP-FAST Authentication** check box. The default value is unselected.

l) Perform one of the following, depending on how you want protected access credentials (PACs) to be provisioned:

- To use manual PAC provisioning, enter the server key used to encrypt and decrypt PACs in the Server Key and Confirm Server Key text boxes. The key must be 32 hexadecimal characters.
- To allow PACs to be sent automatically to clients that do not have one during PAC provisioning, select the **Enable Auto Key Generation** check box

m) In the Authority ID text box, enter the authority identifier of the EAP-FAST server. The identifier must be 32 hexadecimal characters.

n) In the Authority Info text box, enter the authority identifier of the EAP-FAST server in text format. You can enter up to 32 hexadecimal characters.

o) To specify a PAC timeout value, select the **PAC Timeout** check box and enter the number of seconds for the PAC to remain viable in the text box. The default value is unselected, and the valid range is 2 to 4095 seconds when enabled.

p) Click **Apply**.

**Step 13**  
In the WLAN-ACL mapping tab, you can do the following:

a) Under Web Auth ACL Mapping, enter the **WLAN ID**, choose the **WebAuth ACL**, and click **Add** to map the web authentication ACL and the WLAN.

b) Under Local Split ACL Mapping, enter the **WLAN ID**, and choose the **Local Split ACL**, and click **Add** to map the Local Split ACL to the WLAN.

**Note**  
You can configure up to 16 WLAN-ACL combinations for local split tunneling. Local split tunneling does not work for clients with static IP address.

**Step 14**  
In the Central DHCP tab, you can do the following:
a) In the WLAN Id box, enter the WLAN ID with which you want to map Central DHCP.
b) Select or unselect the Central DHCP check box to enable or disable Central DHCP for the mapping.
c) Select or unselect the Override DNS check box to enable or disable overriding of DNS for the mapping.
d) Select or unselect the NAT-PAT check box to enable or disable network address translation and port address translation for the mapping.
e) Click Add to add the Central DHCP - WLAN mapping.

Note When the overridden interface is enabled for the FlexConnect Group DHCP, the DHCP broadcast to unicast is optional for locally switched clients.

Step 15 Click Save Configuration.
Step 16 Repeat this procedure if you want to add more FlexConnects.

Note To see if an individual access point belongs to a FlexConnect Group, you can choose Wireless > Access Points > All APs > the name of the desired access point in the FlexConnect tab. If the access point belongs to a FlexConnect, the name of the group appears in the FlexConnect Name text box.

Configuring FlexConnect Groups (CLI)

Step 1 Add add or delete a FlexConnect Group by entering this command:
```
config flexconnect group group_name {add | delete}
```

Step 2 Configure a primary or secondary RADIUS server for the FlexConnect group by entering this command:
```
config flexconnect group group-name radius server auth {
{add {primary | secondary} ip-addr auth-port secret} |
{delete {primary | secondary}}
}
```

Step 3 Add an access point to the FlexConnect Group by entering this command:
```
config flexconnect group_name ap {add | delete} ap_mac
```

Step 4 Configure local authentication for a FlexConnect as follows:

a) Make sure that a primary and secondary RADIUS server are not configured for the FlexConnect Group.
b) To enable or disable local authentication for this FlexConnect group, enter this command:
```
config flexconnect group group_name radius ap {enable | disable}
```
c) Enter the username and password of a client that you want to be able to authenticate using LEAP, EAP-FAST by entering this command:
```
config flexconnect group group_name radius ap user add username password password
```

Note You can add up to 100 clients.
d) Allow a FlexConnect access point group to authenticate clients using LEAP or to disable this behavior by entering this command:
```
config flexconnect group group_name radius ap leap {enable | disable}
```
e) Allow a FlexConnect access point group to authenticate clients using EAP-FAST or to disable this behavior by entering this command:
```
config flexconnect group group_name radius ap eap-fast {enable | disable}
```
f) To download EAP Root and Device certificate to AP, enter this command:
config flexconnect group group_name radius ap eap-cert  download

g) Allow a FlexConnect access point group to authenticate clients using EAP-TLS or to disable this behavior by entering this command:
   config flexconnect group group_name radius ap eap-tls {enable | disable}

h) Allow a FlexConnect access point group to authenticate clients using PEAP or to disable this behavior by entering this command:
   config flexconnect group group_name radius ap peap {enable | disable}

i) Enter one of the following commands, depending on how you want PACs to be provisioned:
   • config flexconnect group group_name radius ap server-key key — Specifies the server key used to encrypt and decrypt PACs. The key must be 32 hexadecimal characters.
   • config flexconnect group group_name radius ap server-key auto — Allows PACs to be sent automatically to clients that do not have one during PAC provisioning.

j) To specify the authority identifier of the EAP-FAST server, enter this command:
   config flexconnect group group_name radius ap authority id id
   where id is 32 hexadecimal characters.

k) To specify the authority identifier of the EAP-FAST server in text format, enter this command:
   config flexconnect group group_name radius ap authority info info
   where info is up to 32 hexadecimal characters.

l) To specify the number of seconds for the PAC to remain viable, enter this command:
   config flexconnect group group_name radius ap pac-timeout timeout
   where timeout is a value between 2 and 4095 seconds (inclusive) or 0. A value of 0, which is the default value, disables the PAC timeout.

Step 5 Configure a Policy ACL on a FlexConnect group by entering this command:
   config flexconnect group group-name acl {add | delete} acl-name

Step 6 Configure local split tunneling on a per-FlexConnect group basis by entering this command:
   config flexconnect group group_name local-split wlan wlan-id acl acl-name flexconnect-group-name {enable | disable}

Step 7 To set multicast/broadcast across L2 broadcast domain on overridden interface for locally switched clients, enter this command:
   config flexconnect group group_name multicast overridden-interface {enable | disable}

Step 8 Configure central DHCP per WLAN by entering this command:
   config flexconnect group group-name central-dhcp wlan wlan-id {enable override dns | disable | delete}

Step 9 Configure the DHCP overridden interface for FlexConnect group, use the
cfgflexconnectgroupflexgroupdhcppoverridden-interfacenablecommand.

Step 10 Configure policy acl on FlexConnect group by entering this command:
   config flexconnect group group_name policy acl {add | delete} acl-name

Step 11 Configure web-auth acl on flexconnect group by entering this command:
   config flexconnect group group_name web-auth wlan wlan-id acl acl-name {enable | disable}

Step 12 Configure wlan-vlan mapping on flexconnect group by entering this command:
   config flexconnect group group_name wlan-vlan wlan wlan-id{add | delete}vlan vlan-id
Step 13 To set efficient upgrade for group, enter this command:
```
config flexconnect group group_name predownload {enable | disable | master | slave} ap-name retry-count maximum retry count ap-name ap-name
```
Step 14 Save your changes by entering this command:
```
save config
```
Step 15 See the current list of flexconnect groups by entering this command:
```
show flexconnect group summary
```
Step 16 See the details for a specific FlexConnect Groups by entering this command:
```
show flexconnect group detail group_name
```

Configuring VLAN-ACL Mapping on FlexConnect Groups (GUI)

Step 1 Choose Wireless > FlexConnect Groups.
The FlexConnect Groups page appears. This page lists the access points associated with the controller.
Step 2 Click the Group Name link of the FlexConnect Group for which you want to configure VLAN-ACL mapping.
Step 3 Click the VLAN-ACL Mapping tab.
The VLAN-ACL Mapping page for that FlexConnect group appears.
Step 4 Enter the Native VLAN ID in the VLAN ID text box.
Step 5 From the Ingress ACL drop-down list, choose the Ingress ACL.
Step 6 From the Egress ACL drop-down list, choose the Egress ACL.
Step 7 Click Add to add this mapping to the FlexConnect Group.
The VLAN ID is mapped with the required ACLs. To remove the mapping, hover your mouse over the blue drop-down arrow and choose Remove.

Note The Access Points inherit the VLAN-ACL mapping on the FlexConnect groups if the WLAN VLAN mapping is also configured on the groups.

Configuring VLAN-ACL Mapping on FlexConnect Groups (CLI)

- `config flexconnect group group-name vlan add vlan-id acl ingress-acl egress acl`
  Add a VLAN to a FlexConnect group and map the ingress and egress ACLs by entering this command:

Viewing VLAN-ACL Mappings (CLI)

- `show flexconnect group detail group-name`
  View FlexConnect group details.
show ap config general ap-name
View VLAN-ACL mappings on the AP.

Configuring AAA Overrides for FlexConnect

Information About Authentication, Authorization, Accounting Overrides

The Allow Authentication, Authorization, Accounting (AAA) Override option of a WLAN enables you to configure the WLAN for authentication. It enables you to apply VLAN tagging, QoS, and ACLs to individual clients based on the returned RADIUS attributes from the AAA server.

AAA overrides for FlexConnect access points introduce a dynamic VLAN assignment for locally switched clients. AAA overrides for FlexConnect also support fast roaming (Opportunistic Key Caching [OKC]/Cisco Centralized Key management [CCKM]) of overridden clients.

VLAN overrides for FlexConnect are applicable for both centrally and locally authenticated clients. VLANs can be configured on FlexConnect groups.

If a VLAN on the AP is configured using the WLAN-VLAN, the AP configuration of the corresponding ACL is applied. If the VLAN is configured using the FlexConnect group, the corresponding ACL configured on the FlexConnect group is applied. If the same VLAN is configured on the FlexConnect group and also on the AP, the AP configuration, with its ACL takes precedence. If there is no slot for a new VLAN from the WLAN-VLAN mapping, the latest configured FlexConnect group VLAN is replaced.

If the VLAN that was returned from the AAA is not present on the AP, the client falls back to the default VLAN configured for the WLAN.

Before configuring a AAA override, the VLAN must be created on the access points. These VLANs can be created by using the existing WLAN-VLAN mappings on the access points, or by using the FlexConnect group VLAN-ACL mappings.

AAA Override for IPv6 ACLs

In order to support centralized access control through a centralized AAA server such as the Cisco Identity Services Engine (ISE) or ACS, the IPv6 ACL can be provisioned on a per-client basis using AAA Override attributes. In order to use this feature, the IPv6 ACL must be configured on the controller and the WLAN must be configured with the AAA Override feature enabled. The AAA attribute for an IPv6 ACL is Airespace-IPv6-ACL-Name similar to the Airespace-ACL-Name attribute used for provisioning an IPv4-based ACL. The AAA attribute-returned contents should be a string that is equal to the name of the IPv6 ACL as configured on the controller.

Restrictions for AAA Overrides for FlexConnect

- Before configuring a AAA override, VLANs must be created on the access points. These VLANs can be created by using the existing WLAN-VLAN mappings on the access points, or by using the FlexConnect group VLAN-ACL mappings.

- At any given point, an AP has a maximum of 16 VLANs. First, the VLANs are selected as per the AP configuration (WLAN-VLAN), and then the remaining VLANs are pushed from the FlexConnect group in the order that they are configured or displayed in the FlexConnect group. If the VLAN slots are full, an error message is displayed.

- VLAN, ACL, QoS, Rate limiting are supported with local and central switching WLAN.
Dynamic VLAN assignment is not supported for web authentication from a controller with Access Control Server (ACS).

Configuring AAA Overrides for FlexConnect on an Access Point (GUI)

Step 1 Choose Wireless > All > APs.
The All APs page is displayed. This page lists the access points associated with the controller.

Step 2 Click the corresponding AP name.

Step 3 Click the FlexConnect tab.

Step 4 Enter a value for Native VLAN ID.

Step 5 Click the VLAN Mappings button to configure the AP VLANs mappings.
The following parameters are displayed:

- **AP Name**—The access point name.
- **Base Radio MAC**—The base radio of the AP.
- **WLAN-SSID-VLAN ID Mapping**—For each WLAN configured on the controller, the corresponding SSID and VLAN IDs are listed. Change a WLAN-VLAN ID mapping by editing the VLAN ID column for a WLAN.
- **Centrally Switched WLANs**—If centrally switched WLANs are configured, WLAN–VLAN mapping is listed.
- **AP Level VLAN ACL Mapping**—The following parameters are available:
  - VLAN ID—The VLAN ID.
  - Ingress ACL—The Ingress ACL corresponding to the VLAN.
  - Egress ACL—The Egress ACL corresponding to the VLAN.

Change the ingress ACL and egress ACL mappings by selecting the mappings from the drop-down list for each ACL type.

- **Group Level VLAN ACL Mapping**—The following group level VLAN ACL mapping parameters are available:
  - VLAN ID—The VLAN ID.
  - Ingress ACL—The ingress ACL for this VLAN.
  - Egress ACL—The egress ACL for this VLAN.

Step 6 Click Apply.

Configuring VLAN Overrides for FlexConnect on an Access Point (CLI)

To configure VLAN overrides on a FlexConnect access point, use the following command:

```
cfg ap flexconnect vlan add vlan-id acl ingress-acl egress-acl ap_name
```
Configuring FlexConnect AP Upgrades for FlexConnect Access Points

Information About FlexConnect AP Upgrades

Normally, when upgrading the image of an AP, you can use the pre-image download feature to reduce the amount of time the AP is unavailable to serve clients. However, it also increases the downtime because the access point cannot serve clients during an upgrade. The Pre-image download feature can be used to reduce this downtime. However, in the case of a branch office set up, the upgrade images are still downloaded to each access point over the WAN link, which has a higher latency.

A more efficient way is to use the FlexConnect AP Upgrade feature. When this feature is enabled, one access point of each model in the local network first downloads the upgrade image over the WAN link. It works similarly to the master-slave or client-server model. This access point then becomes the master for the remaining access point of the similar model. The remaining access points then download the upgrade image from the master access point using the pre-image download feature over the local network, which reduces the WAN latency.

Restrictions for FlexConnect AP Upgrades for FlexConnect Access Points

• The primary and secondary controllers in the network must have the same set of primary and backup images.

• If you configured a FlexConnect group, all access points in that group must be within the same subnet or must be accessible through NAT.

• A FlexConnect group can have a maximum of 100 APs on Cisco 7510 WLC, and 25 APs on Cisco 5508 WLC.

• A FlexConnect group can have one master AP per AP model. If a master AP is not selected manually, the AP that has the least MAC address value is automatically chosen as the master AP for that model.

• A maximum of 3 slave APs of the same model can download the image from their master AP (a maximum of 3 TFTP connections can serve at a time). The rest of the slave APs use the random back-off timer to retry for the master AP to download the image. The random back-off value is more than 100 seconds. After a slave AP downloads the image, the AP informs the Cisco WLC about the completion of the download. After random back-off, the waiting slave AP can occupy the empty TFTP slot at the master AP.

If a slave AP fails to download the image from its master AP even after the slave retry count that you have configured is exhausted, the slave AP reaches out to the Cisco WLC to fetch the new image.

• This feature works only with CAPWAP APs.

• This feature does not work if a master AP is connected over CAPWAP6.

• If you upgrade from a release that is prior to Release 7.5 directly to Release 7.6.X or a later release, the predownload process on Cisco AP2600 and AP3600 fails. After the Cisco WLC is upgraded to Release 7.6.X or a later release, the new image is loaded on Cisco AP2600 and AP3600. After the upgrade to a Release 7.6.X image, the predownload functionality works as expected. The predownload failure is only a one-time failure.
Configuring FlexConnect AP Upgrades (GUI)

Step 1 Choose Wireless > FlexConnect Groups.
The FlexConnect Groups page appears. This page lists the FlexConnect Groups configured on the controller.

Step 2 Click the Group Name link on which you want to configure the image upgrade.

Step 3 Click the Image Upgrade tab.

Step 4 Check the FlexConnect AP Upgrade check box to enable a FlexConnect AP Upgrade.

Step 5 If you enabled the FlexConnect AP upgrade in the previous step, you must enable the following parameters:

- **Slave Maximum Retry Count**—The number of attempts the slave access point must try to connect to the master access point for downloading the upgrade image. If the image download does not occur for the configured retry attempts, the image is upgraded over the WAN. The default value is 44; the valid range is between 1 and 63.

- **Upgrade Image**—Select the upgrade image. The options are Primary, Backup, and Abort.

Step 6 From the AP Name drop-down list, click Add Master to add the master access point.
You can manually assign master access points in the FlexConnect group by selecting the access points.

Step 7 Click Apply.

Step 8 Click FlexConnect Upgrade to upgrade.

Configuring FlexConnect AP Upgrades (CLI)

```
• config flexconnect group group-name predownload {enable | disable}—Enables or disables the FlexConnect AP upgrade.

• config flexconnect group group-name predownload master ap-name—Sets the AP as the master AP for the model.

• config flexconnect group group-name predownload slave ap-name ap-name—Sets the AP as a slave AP.

• config flexconnect group group-name predownload slave retry-count max-retry-count —Sets the retry count for slave APs.

• config flexconnect group group-name predownload start {abort | primary | backup}—Initiates the image (primary or backup) download on the access points in the FlexConnect group, or aborts an image download process.

• show flexconnect group group-name—Displays the summary of the FlexConnect group configuration.

• show ap image all—Displays the details of the images on the access point.
```
Mobility Groups

- Information About Mobility, page 807
- Information About Mobility Groups, page 811
- Mobility Groups, page 814
- Viewing Mobility Group Statistics, page 819
- Configuring Auto-Anchor Mobility, page 821
- Validating WLAN Mobility Security Values, page 825
- Using Symmetric Mobility Tunneling, page 827
- Verifying Symmetric Mobility Tunneling, page 828
- Running Mobility Ping Tests, page 828
- Configuring Dynamic Anchoring for Clients with Static IP Addresses, page 829
- Configuring Foreign Mappings, page 832
- Configuring Proxy Mobile IPv6, page 832

Information About Mobility

Mobility, or roaming, is a wireless LAN client’s ability to maintain its association seamlessly from one access point to another securely and with as little latency as possible. This section explains how mobility works when controllers are included in a wireless network.

When a wireless client associates and authenticates to an access point, the access point’s controller places an entry for that client in its client database. This entry includes the client’s MAC and IP addresses, security context and associations, quality of service (QoS) contexts, the WLAN, and the associated access point. The controller uses this information to forward frames and manage traffic to and from the wireless client.
This figure shows a wireless client that roams from one access point to another when both access points are joined to the same controller.

*Figure 98: Intracontroller Roaming*

When the wireless client moves its association from one access point to another, the controller simply updates the client database with the newly associated access point. If necessary, new security context and associations are established as well.

The process becomes more complicated, however, when a client roams from an access point joined to one controller to an access point joined to a different controller. It also varies based on whether the controllers are operating on the same subnet.
This figure shows intercontroller roaming, which occurs when the wireless LAN interfaces of the controllers are on the same IP subnet.

*Figure 99: Intercontroller Roaming*

When the client associates to an access point joined to a new controller, the new controller exchanges mobility messages with the original controller, and the client database entry is moved to the new controller. New security context and associations are established if necessary, and the client database entry is updated for the new access point. This process remains transparent to the user.

---

**Note**

All clients configured with 802.1X/Wi-Fi Protected Access (WPA) security complete a full authentication in order to comply with the IEEE standard.
This figure shows intersubnet roaming, which occurs when the wireless LAN interfaces of the controllers are on different IP subnets.

**Figure 100: Intersubnet Roaming**

Inter-subnet roaming is similar to inter-controller roaming in that the controllers exchange mobility messages on the client roam. However, instead of moving the client database entry to the new controller, the original controller marks the client with an "Anchor" entry in its own client database. The database entry is copied to the new controller client database and marked with a "Foreign" entry in the new controller. The roam remains transparent to the wireless client, and the client maintains its original IP address.

In inter-subnet roaming, WLANs on both anchor and foreign controllers need to have the same network access privileges and no source-based routing or source-based firewalls in place. Otherwise, the clients may have network connectivity issues after the handoff.

In a static anchor setup using controllers and ACS, if AAA override is enabled to dynamically assign VLAN and QoS, the foreign controller updates the anchor controller with the right VLAN after a Layer 2 authentication (802.1x). For Layer 3 RADIUS authentication, the RADIUS requests for authentication are sent by the anchor controller.

Mobility is not supported for SSIDs with security type configured for Webauth on MAC filter failure.

If the management VLAN of one Cisco WLC is present as a dynamic VLAN on another Cisco WLC, the mobility feature is not supported.

---

**Note**

If a client roams in web authentication state, the client is considered as a new client on another controller instead of considering it as a mobile client.
New Mobility with WebAuth and MAC filter is not supported. For a client, if L2 authentication fails and it falls back to L3 authentication and then tries to roam to a different Cisco WLC, the roaming will fail. The same behavior is applicable to FlexConnect central switching and local mode as well.

Information About Mobility Groups

A mobility group is a set of controllers, identified by the same mobility group name, that defines the realm of seamless roaming for wireless clients. By creating a mobility group, you can enable multiple controllers in a network to dynamically share information and forward data traffic when inter-controller or inter-subnet roaming occurs. Controllers in the same mobility group can share the context and state of client devices as well as their list of access points so that they do not consider each other’s access points as rogue devices. With this information, the network can support inter-controller wireless LAN roaming and controller redundancy.

Controllers do not have to be of the same model to be a member of a mobility group. Mobility groups can be comprised of any combination of controller platforms.
As shown above, each controller is configured with a list of the other members of the mobility group. Whenever a new client joins a controller, the controller sends out a unicast message (or multicast message if mobility multicast is configured) to all of the controllers in the mobility group. The controller to which the client was previously connected passes on the status of the client.

For example, if a controller supports 6000 access points, a mobility group that consists of 24 such controllers supports up to 144,000 access points (24 * 6000 = 144,000 access points).

Mobility groups enable you to limit roaming between different floors, buildings, or campuses in the same enterprise by assigning different mobility group names to different controllers within the same wireless network.

This figure shows the results of creating distinct mobility group names for two groups of controllers.

*Figure 102: Two Mobility Groups*

The controllers in the ABC mobility group share access point and client information with each other. The controllers in the ABC mobility group do not share the access point or client information with the XYZ controllers, which are in a different mobility group. Likewise, the controllers in the XYZ mobility group do not share access point or client information with the controllers in the ABC mobility group. This feature ensures mobility group isolation across the network.

Every controller maintains information about its peer controllers in a mobility list. Controllers can communicate across mobility groups and clients may roam between access points in different mobility groups if the controllers are included in each other’s mobility lists. In the following example, controller 1 can communicate with either controller 2 or 3, but controller 2 and controller 3 can communicate only with controller 1 and not with each other. Similarly, clients can roam between controller 1 and controller 2 or between controller 1 and controller 3 but not between controller 2 and controller 3.
Table 47: Example

| Controller 1 Mobility group: A Mobility list: Controller 1 (group A) Controller 2 (group A) Controller 3 (group C) | Controller 2 Mobility group: A Mobility list: Controller 1 (group A) Controller 2 (group A) | Controller 3 Mobility group: C Mobility list: Controller 1 (group A) Controller 3 (group C) |

In a mobility list, the following combinations of mobility groups and members are allowed:

- 3 mobility groups with 24 members in each group
- 12 mobility groups with 6 members in each group
- 24 mobility groups with 3 members in each group
- 72 mobility groups with 1 member in each group

The controller supports seamless roaming across multiple mobility groups. During seamless roaming, the client maintains its IP address across all mobility groups; however, Cisco Centralized Key Management (CCKM) and proactive key caching (PKC) are supported only for inter-mobility-group roaming. When a client crosses a mobility group boundary during a roam, the client is fully authenticated, but the IP address is maintained, and mobility tunneling is initiated for Layer 3 roaming.

Note
When a controller is added to a mobility group, some of the APs (which are running in local mode) do not get the complete controllers list updated, those APs are connected to controllers that are in the same mobility group. You can view the controller list in the APs using the command "show capwap client config" AP-NAME command. For example, if the mobility group is for 19 controllers and then you add two more controllers to the mobility group, the AP shows 19 controllers instead of 21 in its list. To address this issue, you can reboot the AP or move it to another controller that is part of the same mobility group to get the controller list updated. This issue is observed in AP1242 connected to different 5508 controllers running code 7.6.120.0.

Note
When client moves to a non anchored SSID from an anchored sSSID on foreign, there is a stale entry on foreign. This happens when multicast mobile announce does not reach from foreign to guest anchor due to whatsoever reason, due to this the service is not impacted and configuration goes unnoticed but silently leaks MSCB on GA. There is no debug or error message shown nor does the GA runs a timer per client to cleanup. A HandoffEnd needs to be sent from foreign to Anchor since there is no timer.

Messaging Among Mobility Groups

The controller provides intersubnet mobility for clients by sending mobility messages to other member controllers.
• The controller sends a Mobile Announce message to members in the mobility list each time that a new client associates to it. The controller sends the message only to those members that are in the same group as the controller (the local group) and then includes all of the other members while sending retries.

• You can configure the controller to use multicast to send the Mobile Announce messages. This behavior allows the controller to send only one copy of the message to the network, which destines it to the multicast group that contains all the mobility members. To derive the maximum benefit from multicast messaging, we recommend that it be enabled on all group members.

Using Mobility Groups with NAT Devices

Mobility message payloads carry IP address information about the source controller. This IP address is validated with the source IP address of the IP header. This behavior is a problem when a NAT device is introduced in the network because it changes the source IP address in the IP header. In the guest WLAN feature, any mobility packet, that is being routed through a NAT device is dropped because of the IP address mismatch.

The mobility group lookup uses the MAC address of the source controller. Because the source IP address is changed due to the mapping in the NAT device, the mobility group database is searched before a reply is sent to get the IP address of the requesting controller. This process is done using the MAC address of the requesting controller.

When configuring the mobility group in a network where NAT is enabled, enter the IP address that is sent to the controller from the NAT device rather than the controller’s management interface IP address. Also, make sure that the following ports are open on the firewall if you are using a firewall such as PIX:

- UDP 16666 for tunnel control traffic
- IP protocol 97 for user data traffic
- UDP 161 and 162 for SNMP

Note

Client mobility among controllers works only if auto-anchor mobility (also called guest tunneling) or symmetric mobility tunneling is enabled. Asymmetric tunneling is not supported when mobility controllers are behind the NAT device. See the Configuring Auto-Anchor Mobility and Using Symmetric Mobility Tunneling sections for details on these mobility options.

Mobility Groups

Prerequisites for Configuring Mobility Groups

Before you add controllers to a mobility group, you must verify that the following requirements have been met for all controllers that are to be included in the group:

- IP connectivity must exist between the management interfaces of all controllers.
You can verify IP connectivity by pinging the controllers.

Mobility control packets can use any interface address as the source, based on routing table. It is recommended that all controllers in the mobility group should have the management interface in the same subnet. A topology where one controller’s management interface and other controller’s dynamic interface are on same subnet not recommended for seamless mobility.

When controllers in the mobility list use different software versions, Layer 2 or Layer 3 clients have limited roaming support. Layer 2 or Layer 3 client roaming is supported only between controllers that use the same version or with controllers that run versions 7.X.X.

If you inadvertently configure a controller with a failover controller that runs a different software release, the access point might take a long time to join the failover controller because the access point starts the discovery process in CAPWAP and then changes to LWAPP discovery.

All controllers must be configured with the same virtual interface IP address.

If necessary, you can change the virtual interface IP address by editing the virtual interface name on the Controller > Interfaces page.

If all the controllers within a mobility group are not using the same virtual interface, inter-controller roaming may appear to work, but the handoff does not complete, and the client loses connectivity for a period of time.

You must have gathered the MAC address and IP address of every controller that is to be included in the mobility group. This information is necessary because you will be configuring all controllers with the MAC address and IP address of all the other mobility group members.

You can find the MAC and IP addresses of the other controllers to be included in the mobility group on the Controller > Mobility Groups page of each controller’s GUI.

When you configure mobility groups using a third-party firewall, for example, Cisco PIX, or Cisco ASA, you must open port 16666, and IP protocol 97.

For intercontroller CAPWAP data and control traffic, you must open the ports 5247 and 5246.

This table lists the protocols and port numbers that must be used for management and operational purposes:
Table 48: Protocol/Service and Port Number

<table>
<thead>
<tr>
<th>Protocol/Service</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSH/Telnet</td>
<td>TCP Port 22 or 29</td>
</tr>
<tr>
<td>TFTP</td>
<td>UDP Port 69</td>
</tr>
<tr>
<td>NTP/SNTP</td>
<td>UDP Port 123</td>
</tr>
<tr>
<td>SNMP</td>
<td>UDP Port 161 for gets and sets and UDP port 162 for traps.</td>
</tr>
<tr>
<td>HTTPS/HTTP</td>
<td>TCP port 443 for HTTPS and port 80 for HTTP</td>
</tr>
<tr>
<td>Syslog</td>
<td>TCP port 514</td>
</tr>
<tr>
<td>Radius Auth/Account</td>
<td>UDP port 1812 and 1813</td>
</tr>
</tbody>
</table>


Note: You cannot perform port address translation (PAT) on the firewall. You must configure one-to-one network address translation (NAT).

**Configuring Mobility Groups (GUI)**

**Step 1**
Choose **Controller > Mobility Management > Mobility Groups** to open the Static Mobility Group Members page. This page shows the mobility group name in the Default Mobility Group text box and lists the MAC address and IPv4/IPv6 address of each controller that is currently a member of the mobility group. The first entry is the local controller, which cannot be deleted.

Note: If you want to delete any of the remote controllers from the mobility group, hover your cursor over the blue drop-down arrow for the desired controller and choose **Remove**.

**Step 2**
Perform one of the following to add controllers to a mobility group:

- If you are adding only one controller or want to individually add multiple controllers, click **New** and go.
  OR
- If you are adding multiple controllers and want to add them in bulk, click **EditAll** and go to.

Note: The EditAll option enables you to enter the MAC and IPv4/IPv6 addresses of all the current mobility group members and then copy and paste all the entries from one controller to the other controllers in the mobility group.
**Step 3**  
Click **New** to open the **Mobility Group Member > New page**.

**Step 4**  
Add a controller to the mobility group as follows:

1. In the **Member IP Address** text box, enter the management interface IPv4/IPv6 address of the controller to be added.  
   **Note**  
   If you are configuring the mobility group in a network where network address translation (NAT) is enabled, enter the IPv4/IPv6 address that is sent to the controller from the NAT device rather than the controller’s management interface IPv4/IPv6 address. Otherwise, mobility will fail among controllers in the mobility group.

2. In the **Member MAC Address** text box, enter the MAC address of the controller to be added.

3. In the **Group Name** text box, enter the name of the mobility group.  
   **Note**  
   The mobility group name is case sensitive.

4. In the **Hash** text box, enter the hash key of the peer mobility controller, which should be a virtual controller in the same domain.  
   **Note**  
   You must configure the hash only if the peer mobility controller is a virtual controller in the same domain.

5. Click **Apply** to commit your changes. The new controller is added to the list of mobility group members on the **Static Mobility Group Members** page.

6. Click **Save Configuration** to save your changes.

7. Repeat **Step a through Step e** to add all of the controllers in the mobility group.

8. Repeat this procedure on every controller to be included in the mobility group. All controllers in the mobility group must be configured with the MAC address and IPv4/IPv6 address of all other mobility group members.

The **Mobility Group Members > Edit All** page lists the MAC address, IPv4/IPv6 address, and mobility group name (optional) of all the controllers currently in the mobility group. The controllers are listed one per line with the local controller at the top of the list.  
**Note**  
If desired, you can edit or delete any of the controllers in the list.

**Step 5**  
Add more controllers to the mobility group as follows:

1. Click inside the edit box to start a new line.

2. Enter the MAC address, the management interface IPv4/IPv6 address, and the name of the mobility group for the controller to be added.  
   **Note**  
   You should enter these values on one line and separate each value with one or two spaces.

   **Note**  
   The mobility group name is case sensitive.

3. Repeat **Step a and Step b** for each additional controller that you want to add to the mobility group.

4. Highlight and copy the complete list of entries in the edit box.

5. Click **Apply** to commit your changes. The new controllers are added to the list of mobility group members on the **Static Mobility Group Members** page.

6. Click **Save Configuration** to save your changes.

7. Paste the list into the text box on the **Mobility Group Members > Edit All** page of all the other controllers in the mobility group and click **Apply** and **Save Configuration**.
Step 6  Choose Mobility Management > Multicast Messaging to open the Mobility Multicast Messaging page. The names of all the currently configured mobility groups appear in the middle of the page.

Step 7  On the Mobility Multicast Messaging page, select the Enable Multicast Messaging check box to enable the controller to use multicast mode to send Mobile Announce messages to the mobility members. If you leave it unselected, the controller uses unicast mode to send the Mobile Announce messages. The default value is unselected.

Step 8  If you enabled multicast messaging in the previous step, enter the multicast group IPv4 address for the local mobility group in the Local Group Multicast IPv4 Address text box. This address is used for multicast mobility messaging.

Note In order to use multicast messaging, you must configure the IPv4 address for the local mobility group.

Note In release 8.0, IPv6 is not supported for mobility multicast.

Step 9  Click Apply to commit your changes.

Step 10  If desired, you can also configure the multicast group IPv4 address for non-local groups within the mobility list. To do so, click the name of a non-local mobility group to open the Mobility Multicast Messaging > Edit page, and enter the multicast group IPv4 address for the non-local mobility group in the Multicast IP Address text box.

Note If you do not configure the multicast IPv4 address for non-local groups, the controller uses unicast mode to send mobility messages to those members.

Step 11  Click Apply to commit your changes.

Step 12  Click Save Configuration to save your changes.

Configuring Mobility Groups (CLI)

Step 1  Check the current mobility settings by entering this command:
show mobility summary

Step 2  Create a mobility group by entering this command:
config mobility group domain domain_name

Note Enter up to 31 case-sensitive ASCII characters for the group name. Spaces are not allowed in mobility group names.

Step 3  Add a group member by entering this command:
config mobility group member add mac_address ip_address

Note If you are configuring the mobility group in a network where network address translation (NAT) is enabled, enter the IP address that is sent to the controller from the NAT device rather than the controller’s management interface IP address. Otherwise, mobility will fail among controllers in the mobility group.

Note Enter the config mobility group member delete mac_address command if you want to delete a group member.

Step 4  To configure the hash key of a peer mobility controller, which is a virtual controller in the same domain, enter this command:
config mobility group member hash peer-ip-address key

Step 5  Enable or disable multicast mobility mode by entering this command:
config mobility multicast-mode {enable | disable} local_group_multicast_address

where local_group_multicast_address is the multicast group IPv4 address for the local mobility group. This address is used for multicast mobility messaging.
In order to use multicast messaging, you must configure the IPv4 address for the local mobility group.

Note In release 8.0, IPv6 is not supported for mobility multicast.

If you enable multicast mobility mode, the controller uses multicast mode to send Mobile Announce messages to the local group. If you disable multicast mobility mode, the controller uses unicast mode to send the Mobile Announce messages to the local group. The default value is disabled.

Step 6 (Optional) You can also configure the multicast group IPv4 address for non-local groups within the mobility list. To do so, enter this command:

```
config mobility group multicast-address group_name IP_address
```

If you do not configure the multicast IPv4 address for non-local groups, the controller uses unicast mode to send mobility messages to those members.

Step 7 Verify the mobility configuration by entering this command:

```
show mobility summary
```

Step 8 To see the hash key of mobility group members in the same domain, enter this command:

```
show mobility group member hash
```

Step 9 Save your changes by entering this command:

```
save config
```

Step 10 Repeat this procedure on every controller to be included in the mobility group. All controllers in the mobility group must be configured with the MAC address and IP address of all other mobility group members.

Step 11 Enable or disable debugging of multicast usage for mobility messages by entering this command:

```
debug mobility multicast {enable | disable}
```

---

**Viewing Mobility Group Statistics**

You can view three types of mobility group statistics from the controller GUI:

- Global statistics—Affect all mobility transactions
- Mobility initiator statistics—Generated by the controller initiating a mobility event
- Mobility responder statistics—Generated by the controller responding to a mobility event

You can view mobility group statistics using the controller GUI or CLI.

**Viewing Mobility Group Statistics (GUI)**

Step 1 Choose Monitor > Statistics > Mobility Statistics to open the Mobility Statistics page. This page contains the following fields:

- Group Mobility Statistics
* Rx Errors—Generic protocol packet receive errors, such as packet too short or format incorrect.

* Tx Errors—Generic protocol packet transmit errors, such as packet transmission fail.

* Responses Retransmitted—Mobility protocol that uses UDP and resends requests several times if it does not receive a response. Because of network or processing delays, the responder may receive one or more retry requests after it initially responds to a request. This text box shows a count of the response resends.

* Handoff Requests Received—Total number of handoff requests received, ignored, or responded to.

* Handoff End Requests Received—Total number of handoff end requests received. These requests are sent by the anchor or foreign controller to notify the other about the close of a client session.

* State Transitions Disallowed—Policy enforcement module (PEM) that has denied a client state transition, usually resulting in the handoff being aborted.

* Resource Unavailable—Necessary resource, such as a buffer, was unavailable, resulting in the handoff being aborted.

• Mobility Initiator Statistics

* Handoff Requests Sent—Number of clients that have associated to the controller and have been announced to the mobility group.

* Handoff Replies Received—Number of handoff replies that have been received in response to the requests sent.

* Handoff as Local Received—Number of handoffs in which the entire client session has been transferred.

* Handoff as Foreign Received—Number of handoffs in which the client session was anchored elsewhere.

* Handoff Denys Received—Number of handoffs that were denied.

* Anchor Request Sent—Number of anchor requests that were sent for a three-party (foreign-to-foreign) handoff. The handoff was received from another foreign controller, and the new controller is requesting the anchor to move the client.

* Anchor Deny Received—Number of anchor requests that were denied by the current anchor.

* Anchor Grant Received—Number of anchor requests that were approved by the current anchor.

* Anchor Transfer Received—Number of anchor requests that closed the session on the current anchor and transferred the anchor back to the requestor.

• Mobility Responder Statistics

* Handoff Requests Ignored—Number of handoff requests or client announcements that were ignored because the controller had no knowledge of that client.

* Ping Pong Handoff Requests Dropped—Number of handoff requests that were denied because the handoff period was too short (3 seconds).

* Handoff Requests Dropped—Number of handoff requests that were dropped due to either an incomplete knowledge of the client or a problem with the packet.

* Handoff Requests Denied—Number of handoff requests that were denied.

* Client Handoff as Local—Number of handoff responses sent while the client is in the local role.
Client Handoff as Foreign—Number of handoff responses sent while the client is in the foreign role.

Anchor Requests Received—Number of anchor requests received.

Anchor Requests Denied—Number of anchor requests denied.

Anchor Requests Granted—Number of anchor requests granted.

Anchor Transferred—Number of anchors transferred because the client has moved from a foreign controller to a controller on the same subnet as the current anchor.

**Step 2** If you want to clear the current mobility statistics, click **Clear Stats**.

### Viewing Mobility Group Statistics (CLI)

- See mobility group statistics by entering the **show mobility statistics** command.
- To clear the current mobility statistics, enter the **clear stats mobility** command.

### Configuring Auto-Anchor Mobility

#### Information About Auto-Anchor Mobility

You can use auto-anchor mobility (also called guest tunneling) to improve load balancing and security for roaming clients on your wireless LANs. Under normal roaming conditions, client devices join a wireless LAN and are anchored to the first controller that they contact. If a client roams to a different subnet, the controller to which the client roamed sets up a foreign session for the client with the anchor controller. However, when you use the auto-anchor mobility feature, you can specify a controller or set of controllers as the anchor points for clients on a wireless LAN.

In auto-anchor mobility mode, a subset of a mobility group is specified as the anchor controllers for a WLAN. You can use this feature to restrict a WLAN to a single subnet, regardless of a client’s entry point into the network. Clients can then access a guest WLAN throughout an enterprise but still be restricted to a specific subnet. Auto-anchor mobility can also provide geographic load balancing because the WLANs can represent a particular section of a building (such as a lobby, a restaurant, and so on), effectively creating a set of home controllers for a WLAN. Instead of being anchored to the first controller that they happen to contact, mobile clients can be anchored to controllers that control access points in a particular vicinity.

When a client first associates to a controller of a mobility group that has been preconfigured as a mobility anchor for a WLAN, the client associates to the controller locally, and a local session is created for the client. Clients can be anchored only to preconfigured anchor controllers of the WLAN. For a given WLAN, you should configure the same set of anchor controllers on all controllers in the mobility group.

When a client first associates to a controller of a mobility group that has not been configured as a mobility anchor for a WLAN, the client associates to the controller locally, a local session is created for the client, and the client is announced to the other controllers in the mobility list. If the announcement is not answered, the controller contacts one of the anchor controllers configured for the WLAN and creates a foreign session for
the client on the local switch. Packets from the client are encapsulated through a mobility tunnel using EtherIP and sent to the anchor controller, where they are decapsulated and delivered to the wired network. Packets to the client are received by the anchor controller and forwarded to the foreign controller through a mobility tunnel using EtherIP. The foreign controller decapsulates the packets and forwards them to the client.

If multiple controllers are added as mobility anchors for a particular WLAN on a foreign controller, the foreign controller internally sorts the controller by their IP address. The controller with the lowest IP address is the first anchor. For example, a typical ordered list would be 172.16.7.25, 172.16.7.28, 192.168.5.15. If the first client associates to the foreign controller's anchored WLAN, the client database entry is sent to the first anchor controller in the list, the second client is sent to the second controller in the list, and so on, until the end of the anchor list is reached. The process is repeated starting with the first anchor controller. If any of the anchor controller is detected to be down, all the clients anchored to the controller are deauthenticated, and the clients then go through the authentication/anchoring process again in a round-robin manner with the remaining controller in the anchor list. This functionality is also extended to regular mobility clients through mobility failover. This feature enables mobility group members to detect failed members and reroute clients.

**Restrictions on Auto-Anchor Mobility**

- Mobility list members can send ping requests to one another to check the data and control paths among them to find failed members and reroute clients. You can configure the number and interval of ping requests that are sent to each anchor controller. This functionality provides guest N+1 redundancy for guest tunneling and mobility failover for regular mobility.
- You must add controllers to the mobility group member list before you can designate them as mobility anchors for a WLAN.
- You can configure multiple controllers as mobility anchors for a WLAN.
- Auto-anchor mobility supports web authentication but does not support other Layer 3 security types.
- You must configure the WLANs on both the foreign controller and the anchor controller with mobility anchors. On the anchor controller, configure the anchor controller itself as a mobility anchor. On the foreign controller, configure the anchor as a mobility anchor.
- It is not possible for clients, WGB, and wired clients to directly connect to a DMZ guest anchor and move to a foreign controller.
- Auto-anchor mobility is not supported for use with DHCP option 82.
- When using the guest N+1 redundancy and mobility failover features with a firewall, make sure that the following ports are open:
  - UDP 16666 for tunnel control traffic
  - IP Protocol 97 for user data traffic
  - UDP 161 and 162 for SNMP
- In case of roaming between anchor controller and foreign mobility, the client addresses learned at the anchor controller is shown at the foreign controller. You must check the foreign controller to view the RA throttle statistics.
- For Layer 3 RADIUS authentication, the RADIUS requests for authentication are sent by the anchor controller.
- The mobility anchor is not supported on virtual wireless LAN controllers.
In a guest anchor Cisco WLC deployment, ensure that the foreign Cisco WLC does not have a WLAN mapped to a VLAN that is associated with the guest anchor Cisco WLC.

Configuring Auto-Anchor Mobility (GUI)

Step 1 Configure the controller to detect failed anchor controllers within a mobility group as follows:
   a) Choose Controller > Mobility Management > Mobility Anchor Config to open the Mobility Anchor Config page.
   b) In the Keep Alive Count text box, enter the number of times a ping request is sent to an anchor controller before the anchor is considered to be unreachable. The valid range is 3 to 20, and the default value is 3.
   c) In the Keep Alive Interval text box, enter the amount of time (in seconds) between each ping request that is sent to an anchor controller. The valid range is 1 to 30 seconds, and the default value is 10 seconds.
   d) In the DSCP Value text box, enter the DSCP value. The default is 0.
   
   **Note** While configuring the Mobility DSCP value, the mobility control socket (i.e. control messages exchanged between mobility peers only and not the data) is also updated. The configured value must reflect in the IPV4 header TOS field. This is a global configuration on the controller that is used to communicate among configured mobility peers only.
   e) Click Apply to commit your changes.

Step 2 Choose WLANs to open the WLANs page.

Step 3 Click the blue drop-down arrow for the desired WLAN or wired guest LAN and choose Mobility Anchors. The Mobility Anchors page appears. This page lists the controllers that have already been configured as mobility anchors and shows the current state of their data and control paths. Controllers within a mobility group communicate among themselves over a well-known UDP port and exchange data traffic through an Ethernet-over-IP (EoIP) tunnel. They send mpings, which test mobility control packet reachability over the management interface over mobility UDP port 16666 and they send epings, which test the mobility data traffic over the management interface over EoIP port 97. The Control Path text box shows whether mpings have passed (up) or failed (down), and the Data Path text box shows whether epings have passed (up) or failed (down). If the Data or Control Path text box shows “down,” the mobility anchor cannot be reached and is considered failed.

Step 4 Select the IPv4/IPv6 address of the controller to be designated a mobility anchor in the Switch IP Address (Anchor) drop-down list.

Step 5 Click Mobility Anchor Create. The selected controller becomes an anchor for this WLAN or wired guest LAN. **Note** To delete a mobility anchor for a WLAN or wired guest LAN, hover your cursor over the blue drop-down arrow for the anchor and choose Remove.

Step 6 Click Save Configuration.

Step 7 Repeat Step 4 and Step 6 to set any other controllers as mobility anchors for this WLAN or wired guest LAN.

Step 8 Configure the same set of mobility anchors on every controller in the mobility group.

Configuring Auto-Anchor Mobility (CLI)

- The controller is programmed to always detect failed mobility list members. To change the parameters for the ping exchange between mobility members, enter these commands:
* `config mobility group keepalive count count`—Specifies the number of times a ping request is sent to a mobility list member before the member is considered to be unreachable. The valid range is 3 to 20, and the default value is 3.

* `config mobility group keepalive interval seconds`—Specifies the amount of time (in seconds) between each ping request sent to a mobility list member. The valid range is 1 to 30 seconds, and the default value is 10 seconds.

- Disable the WLAN or wired guest LAN for which you are configuring mobility anchors by entering this command:

  ```
  config {wlan | guest-lan} disable {wlan_id | guest_lan_id}
  ```

- Create a new mobility anchor for the WLAN or wired guest LAN by entering one of these commands:

  ```
  * `config mobility group anchor add {wlan | guest-lan} {wlan_id | guest_lan_id} anchor_controller_ip_address`
  * `config {wlan | guest-lan} mobility anchor add {wlan_id | guest_lan_id} anchor_controller_ip_address`
  ```

  **Note**  The `wlan_id` or `guest_lan_id` must exist and be disabled, and the `anchor_controller_ip_address` must be a member of the default mobility group.

  **Note**  Auto-anchor mobility is enabled for the WLAN or wired guest LAN when you configure the first mobility anchor.

- Delete a mobility anchor for the WLAN or wired guest LAN by entering one of these commands:

  ```
  * `config mobility group anchor delete {wlan | guest-lan} {wlan_id | guest_lan_id} anchor_controller_ip_address`
  * `config {wlan | guest-lan} mobility anchor delete {wlan_id | guest_lan_id} anchor_controller_ip_address`
  ```

  **Note**  The `wlan_id` or `guest_lan_id` must exist and be disabled.

  **Note**  Deleting the last anchor disables the auto-anchor mobility feature and resumes normal mobility for new associations.

- Save your settings by entering this command:

  ```
  save config
  ```

- See a list and status of controllers configured as mobility anchors for a specific WLAN or wired guest LAN by entering this command:
show mobility anchor \{wlan | guest-lan\} \{wlan_id | guest_lan_id\}

**Note**
The `wlan_id` and `guest_lan_id` parameters are optional and constrain the list to the anchors in a particular WLAN or guest LAN. To see all of the mobility anchors on your system, enter the `show mobility anchor` command.

The Status text box shows one of these values:
- **UP**—The controller is reachable and able to pass data.
- **CNTRL_PATH_DOWN**—The mpings failed. The controller cannot be reached through the control path and is considered failed.
- **DATA_PATH_DOWN**—The epings failed. The controller cannot be reached and is considered failed.
- **CNTRL_DATA_PATH_DOWN**—Both the mpings and epings failed. The controller cannot be reached and is considered failed.

- See the status of all mobility group members by entering this command:
  - `show mobility summary`
- Troubleshoot mobility issues by entering these commands:
  - `debug mobility handoff` \{enable | disable\}—Debugs mobility handoff issues.
  - `debug mobility keep-alive` \{enable | disable\} all—Dumps the keepalive packets for all mobility anchors.
  - `debug mobility keep-alive` \{enable | disable\} `IP_address`—Dumps the keepalive packets for a specific mobility anchor.

---

**Validating WLAN Mobility Security Values**

**Information About WLAN Mobility Security Values**

For any anchoring or mobility event, the WLAN security policy values on each controller must match. These values can be validated in the controller debugs. This table lists the WLAN mobility security values and their corresponding security policy.

<table>
<thead>
<tr>
<th>Security Hexadecimal Value</th>
<th>Security Policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00000000</td>
<td>Security_None</td>
</tr>
<tr>
<td>0x00000001</td>
<td>Security_WEP</td>
</tr>
<tr>
<td>0x00000002</td>
<td>Security_802_1X</td>
</tr>
<tr>
<td>Security Hexadecimal Value</td>
<td>Security Policy</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>0x00000004</td>
<td>Security_IPSec*</td>
</tr>
<tr>
<td>0x00000008</td>
<td>Security_IPSec_Passthrough*</td>
</tr>
<tr>
<td>0x00000010</td>
<td>Security_Web</td>
</tr>
<tr>
<td>0x00000020</td>
<td>Security_PPTP*</td>
</tr>
<tr>
<td>0x00000040</td>
<td>Security_DHCP_Required</td>
</tr>
<tr>
<td>0x00000080</td>
<td>Security_WPA_NotUsed</td>
</tr>
<tr>
<td>0x00000100</td>
<td>Security_Cranite_Passthrough*</td>
</tr>
<tr>
<td>0x00000200</td>
<td>Security_Fortress_Passthrough*</td>
</tr>
<tr>
<td>0x00000400</td>
<td>Security_L2TP_IPSec*</td>
</tr>
<tr>
<td>0x00000800</td>
<td>Security_802_11i_NotUsed</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>    Controllers running software release 6.0 or later do not support this security policy.</td>
</tr>
<tr>
<td>0x00001000</td>
<td>Security_Web_Passthrough</td>
</tr>
</tbody>
</table>
Using Symmetric Mobility Tunneling

Information About Symmetric Mobility Tunneling

When symmetric mobility tunneling is enabled, all client traffic is sent to the anchor controller and can then successfully pass the RPF check.

Symmetric mobility tunneling is also useful in the following situations:

• If a firewall installation in the client packet path drops packets because the source IP address does not match the subnet on which the packets are received.

• If the access-point group VLAN on the anchor controller is different than the WLAN interface VLAN on the foreign controller. In this case, client traffic could be sent on an incorrect VLAN during mobility events.

Guidelines and Limitations

• Symmetric mobility tunneling is enabled by default.
Verifying Symmetric Mobility Tunneling

Verifying Symmetric Mobility Tunneling (GUI)

**Step 1**
Choose Controller > Mobility Management > Mobility Anchor Config to open the Mobility Anchor Config page.

**Step 2**
The Symmetric Mobility Tunneling Mode text box shows Enabled.

Verifying if Symmetric Mobility Tunneling is Enabled (CLI)

Verify that symmetric mobility tunneling is enabled by entering this command:

```
show mobility summary
```

Running Mobility Ping Tests

Information About Mobility Ping Tests

Controllers in a mobility list communicate with each other by controlling information over a well-known UDP port and exchanging data traffic through an Ethernet-over-IP (EoIP) tunnel. Because UDP and EoIP are not reliable transport mechanisms, there is no guarantee that a mobility control packet or data packet will be delivered to a mobility peer. Mobility packets may be lost in transit due to a firewall filtering the UDP port or EoIP packets or due to routing issues.

Guidelines and Limitations

Controller software release 4.0 or later releases enable you to test the mobility communication environment by performing mobility ping tests. These tests may be used to validate connectivity between members of a mobility group (including guest controllers). Two ping tests are available:

- **Mobility ping over UDP**—This test runs over mobility UDP port 16666. It tests whether the mobility control packet can be reached over the management interface.
- **Mobility ping over EoIP**—This test runs over EoIP. It tests the mobility data traffic over the management interface.

Only one mobility ping test per controller can be run at a given time.
These ping tests are not Internet Control Message Protocol (ICMP) based. The term “ping” is used to indicate an echo request and an echo reply message.

Any ICMP packet greater than 1280 bytes will always be responded with a packet that is truncated to 1280 bytes. For example, a ping with a packet that is greater than 1280 bytes from a host to the management interface is always responded with a packet that is truncated to 1280 bytes.

Running Mobility Ping Tests (CLI)

- To test the mobility UDP control packet communication between two controllers, enter this command:
  \[ mping mobility_peer_IP_address \]
  The `mobility_peer_IP_address` parameter must be the IP address of a controller that belongs to the mobility list.

- To test the mobility EoIP data packet communication between two controllers, enter this command:
  \[ eping mobility_peer_IP_address \]
  The `mobility_peer_IP_address` parameter must be the IP address of a controller that belongs to the mobility list.

- To troubleshoot your controller for mobility ping, enter these commands:
  config logging buffered debugging
  show logging
  To troubleshoot your controller for mobility ping over UDP, enter this command to display the mobility control packet:
  \[ debug mobility handoff enable \]
  We recommend using an ethereal trace capture when troubleshooting.

Configuring Dynamic Anchoring for Clients with Static IP Addresses

Information About Dynamic Anchoring for Clients with Static IP

At times you may want to configure static IP addresses for wireless clients. When these wireless clients move about in a network, they could try associating with other controllers. If the clients try to associate with a
controller that does not support the same subnet as the static IP, the clients fail to connect to the network. You can now enable dynamic tunneling of clients with static IP addresses.

Dynamic anchoring of static IP clients with static IP addresses can be associated with other controllers where the client’s subnet is supported by tunneling the traffic to another controller in the same mobility group. This feature enables you to configure your WLAN so that the network is serviced even though the clients use static IP addresses.

How Dynamic Anchoring of Static IP Clients Works

The following sequence of steps occur when a client with a static IP address tries to associate with a controller:

1. When a client associates with a controller, for example, WLC-1, it performs a mobility announcement. If a controller in the mobility group responds (for example WLC-2), the client traffic is tunneled to the controller WLC-2. As a result, the controller WLC-1 becomes the foreign controller and WLC-2 becomes the anchor controller.

2. If none of the controllers responds, the client is treated as a local client and authentication is performed. The IP address for the client is updated either through an orphan packet handling or an ARP request processing. If the IP subnet of the client is not supported in the controller (WLC-1), WLC-1 sends another static IP mobile announce and if a controller (for example WLC-3) that supports the client’s subnet responds to that announcement, the client traffic is tunneled to that controller, that is WLC-3. As a result, the controller WLC-1 becomes the export foreign controller and WLC-3 becomes the export anchor controller.

3. Once the acknowledgment is received, the client traffic is tunneled between the anchor and the controller (WLC-1).

Note

If you configure WLAN with an interface group and any of the interfaces in the interface group supports the static IP client subnet, the client is assigned to that interface. This situation occurs in local or remote (static IP Anchor) controller.

When AAA override is used along with the interface group that is mapped to WLAN, the source interface that is used for DHCP transactions is the Management interface.

If the interface group that you add to a WLAN has RADIUS Server Overwrite interface enabled and a client requests for authentication, the controller selects the first IP address from the interface group as the RADIUS server.

Note

A security level 2 authentication is performed only in the local (static IP foreign) controller, which is also known as the exported foreign controller.

Restrictions on Dynamic Anchoring for Clients With Static IP Addresses

- Do not configure overridden interfaces when you perform AAA for static IP tunneling, this is because traffic can get blocked for the client if the overridden interface does not support the client’s subnet. This can be possible in extreme cases where the overriding interface group supports the client’s subnet.

- The local controller must be configured with the correct AAA server where this client entry is present.
The following restrictions apply when configuring static IP tunneling with other features on the same WLAN:

- Auto anchoring mobility (guest tunneling) cannot be configured for the same WLAN.
- FlexConnect local authentication cannot be configured for the same WLAN.
- The DHCP required option cannot be configured for the same WLAN.
- You cannot configure dynamic anchoring of static IP clients with FlexConnect local switching.
- We recommend that you configure the same NTP/SNTP servers on the Cisco WLCs. If the NTP/SNTP servers are different, ensure that the system time on all Cisco WLCs is the same when NTP/SNTP is enabled. If the system time is not in sync, seamless mobility might fail in some scenarios. Also, a Cisco WLC that has the lagging time with NTP/SNTP enabled drops the mobile announce messages.

**Configuring Dynamic Anchoring of Static IP Clients (GUI)**

**Step 1** Choose WLANs to open the WLANs page.

**Step 2** Click the ID number of the WLAN on which you want to enable dynamic anchoring of IP clients. The WLANs > Edit page is displayed.

**Step 3** Choose the Advanced tab to open the WLANs > Edit (Advanced) page.

**Step 4** Enable dynamic anchoring of static IP clients by selecting the Static IP Tunneling check box.

**Step 5** Click Apply to commit your changes.

**Configuring Dynamic Anchoring of Static IP Clients (CLI)**

```bash
config wlan static-ip tunneling {enable | disable} wlan_id — Enables or disables the dynamic anchoring of static IP clients on a given WLAN.
```

To monitor and troubleshoot your controller for clients with static IP, use the following commands:

- `show wlan wlan_id`—Enables you to see the status of the static IP clients feature.

```
............
Static IP client tunneling............. Enabled
............
```

- `debug client client-mac`
- `debug dot11 mobile enable`
- `debug mobility handoff enable`
Configuring Foreign Mappings

Information About Foreign Mappings

Auto-Anchormobility, also known as Foreign Mapping, allows you to configure users that are on different foreign controllers from different physical location to obtain IP addresses from a subnet or group of subnets based on their physical location.

Configuring Foreign Controller MAC Mapping (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose the WLANs tab. The WLANs page appears listing the available WLANs.</td>
</tr>
<tr>
<td>2</td>
<td>Click the Blue drop down arrow for the desired WLAN and choose <strong>Foreign-Maps</strong>. The foreign mappings page appears. This page also lists the MAC addresses of the foreign controllers that are in the mobility group and interfaces/interface groups.</td>
</tr>
<tr>
<td>3</td>
<td>Choose the desired foreign controller MAC and the interface or interface group to which it must be mapped and click on <strong>Add Mapping</strong>.</td>
</tr>
</tbody>
</table>

Configuring Foreign Controller MAC Mapping (CLI)

- To add foreign controller mapping, enter this command:
  ```
  config wlan mobility foreign-map add wlan-id foreign_ctlr_mac interface/interface_grp name
  ```

Configuring Proxy Mobile IPv6

Information About Proxy Mobile IPv6

Proxy Mobile IPv6 (PMIPv6) is a network-based mobility management protocol that supports a mobile node by acting as the proxy for the mobile node in an IP mobility-related signaling scenario. The mobility entities in the network track the movements of the mobile node, initiate mobility signaling, and set up the required routing state.

The main functional entities are the Local Mobility Anchor (LMA) and Mobile Access Gateway (MAG). The LMA maintains the reachability state of the mobile node and is the topological anchor point for the IP address of the mobile node. The MAG performs mobility management on behalf of a mobile node. The MAG resides on the access link where the mobile node is anchored. The Cisco Wireless LAN Controller (WLC) implements the MAG functionality.
In the Cisco 5500 Series WLC, Cisco Wireless Services Module 2 (WiSM2), and Cisco 8500 Series WLCs, PMIPv6 MAG support for integration with LMA such as Cisco ASR 5000 Series in cellular data networks. For PMIPv6 clients, Cisco WLC supports both central web authentication and local web authentication. PMIPv6 is supported for clients with 802.1X authentication. After the 802.1X authentication is complete, a Cisco AP starts PMIPv6 signaling for the corresponding client.

**Dynamic AAA Attributes**

The dynamic AAA attributes that are supported are listed below:

<table>
<thead>
<tr>
<th>Type</th>
<th>Attribute</th>
<th>Value</th>
<th>Description</th>
<th>Cisco WLC Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>89</td>
<td>Chargeable-User-Identity</td>
<td>String</td>
<td>Chargeable User Identity RFC-4372</td>
<td>If present, the attribute is copied into the MSCB and used in accounting reports; no other usage.</td>
</tr>
<tr>
<td>26/104 15/13</td>
<td>3GPP-Charging-Characteristics</td>
<td>String</td>
<td>Rules for producing charging information</td>
<td>If present, the attribute is copied to the MSCB and passed to the L2 attach triggers to the MAG. The attribute is used to send to the local mobility anchor (LMA) as an option in the proxy binding update (PBU).</td>
</tr>
<tr>
<td>26/9</td>
<td>Cisco-Service-Selection</td>
<td>String</td>
<td>Service Identifier (APN)</td>
<td>If present, the attribute overrides the locally configured APN.</td>
</tr>
<tr>
<td>26/9</td>
<td>Cisco-Mobile-Node-Identifier</td>
<td>String</td>
<td>Mobile Node Identifier</td>
<td>If present, the attribute is used for the network access identifier (NAI).</td>
</tr>
<tr>
<td>26/9</td>
<td>Cisco-MSISDN</td>
<td>String</td>
<td>Mobile Subscriber ISDN Number</td>
<td>If present, the attribute is used to pass to MAG code with a new parameter in the L2 attach trigger.</td>
</tr>
<tr>
<td>26/9</td>
<td>Cisco-MPC-Protocol-Interface</td>
<td>ENUM: &quot;none&quot; &quot;PMIPv6&quot; &quot;GTPv1&quot; &quot;PMIPv4&quot;</td>
<td>Mobile Node Service Type</td>
<td>Only IPv4 and simple IP clients are supported.</td>
</tr>
<tr>
<td>26/9</td>
<td>Cisco-URL-REDIRECT</td>
<td>String</td>
<td>HTTP URL of the Captive Portal</td>
<td>Existing attribute used for web authentication; no changes required.</td>
</tr>
<tr>
<td>26/9</td>
<td>Cisco-URL-REDIRECT-ACL</td>
<td>String</td>
<td>Specific Redirect Rule</td>
<td>Existing attribute used for web authentication; no changes required.</td>
</tr>
<tr>
<td>26/9</td>
<td>Cisco-Home-LMA-IPv4-Address</td>
<td>IP Address</td>
<td>Mobile node's Home LMA IPv4 address</td>
<td>If present, this attribute is used as the LMA for the client. <strong>Note</strong> The GRE tunnel creation is still static.</td>
</tr>
</tbody>
</table>

**PMIPv6 AAA Attributes**

The PMIPv6 AAA attributes that are supported are listed below:
<table>
<thead>
<tr>
<th>Type</th>
<th>Attribute</th>
<th>Value</th>
<th>Description</th>
<th>Cisco WLC Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>89</td>
<td>Chargeable-User-Identity</td>
<td>String</td>
<td>Chargeable User Identity RFC-4372</td>
<td>If present, the attribute is copied into the MSCB and used in accounting reports; no other usage.</td>
</tr>
<tr>
<td>26/104/15/13</td>
<td>3GPP-Charging-Characteristics</td>
<td>String</td>
<td>Rules for producing charging information</td>
<td>If present, the attribute is copied to the MSCB and passed to the L2 attach triggers to the MAG. The attribute is used to send to the local mobility anchor (LMA) as an option in the proxy binding update (PBU).</td>
</tr>
<tr>
<td>26/9/1</td>
<td>mn-network</td>
<td>String</td>
<td>Service Identifier (APN)</td>
<td>If present, the attribute overrides the locally configured APN (Mandatory)</td>
</tr>
<tr>
<td>26/9/1</td>
<td>mn-nai</td>
<td>String</td>
<td>Mobile Node Identifier</td>
<td>If present, the attribute is used for the network access identifier (NAI).</td>
</tr>
<tr>
<td>26/9/1</td>
<td>cisco-msisdn</td>
<td>String</td>
<td>Mobile Subscriber ISDN Number</td>
<td>If present, the attribute is used to pass to MAG code with a new parameter in the L2 attach trigger.</td>
</tr>
<tr>
<td>26/9/1</td>
<td>cisco-mpc-protocol-interface</td>
<td>ENUM: &quot;None&quot; &quot;PMIPv6&quot;</td>
<td>Mobile Node Service Type</td>
<td>Only PMIPv6 clients are supported. (Mandatory)</td>
</tr>
<tr>
<td>26/9/1</td>
<td>home-lma-ipv4-address</td>
<td>IPv4 Address</td>
<td>Mobile node's Home LMA IPv4 address</td>
<td>If present, this attribute is used as the LMA for the client. The LMA should also be configured in WLC (Mandatory). Note The GRE tunnel creation is still static.</td>
</tr>
<tr>
<td>26/9/1</td>
<td>mn-service</td>
<td>ENUM: &quot;IPv4&quot;</td>
<td>Type of client</td>
<td>Only IPv4 is supported.</td>
</tr>
</tbody>
</table>

**Restrictions on Proxy Mobile IPv6**

- IPv6/dual stack clients are not supported. Only IPv4 is supported with PMIPv6.
- You must enable DHCP Proxy before you can connect to a PMIPv6-enabled WLAN.
- PMIPv6 is not supported on local switching WLANs with FlexConnect mode APs.
Configuring Proxy Mobile IPv6 (GUI)

**Step 1**
Choose Controller > PMIPv6 > General. The PMIPv6 General window is displayed.

**Step 2**
Enter the values for the following parameters:

- **Domain Name**—Name of the PMIPv6 domain. The domain name can be up to 127 case-sensitive, alphanumeric characters.
- **MAG Name**—Name of the MAG.
- **Maximum Bindings Allowed**—Maximum number of binding updates that the Cisco WLC can send to the MAG. The valid range is between 0 and 40000.
- **Binding Lifetime**—Lifetime, in seconds, of the binding entries in the Cisco WLC. The valid range is between 10 and 65535. The default value is 3600. The binding lifetime should be a multiple of 4.
- **Binding Refresh Time**—Refresh time, in seconds, of the binding entries in the Cisco WLC. The valid range is between 4 and 65535 seconds. The default value is 300 seconds. The binding refresh time should be a multiple of 4.
- **Binding Initial Retry Timeout**—Initial timeout, in milliseconds, between the Proxy Binding Updates (PBUs) when the Cisco WLC does not receive the Proxy Binding Acknowledgments (PBAs). The valid range is between 100 and 65535. The default value is 1000.
- **Binding Maximum Retry Timeout**—Maximum timeout between the PBUs when the Cisco WLC does not receive the PBAs. The valid range is between 100 and 65535. The default value is 32000.
- **Replay Protection Timestamp**—Maximum amount of time, in milliseconds, difference between the timestamp in the received PBA and the current time of the day. The valid range is between 1 and 255. The default value is 7.
- **Minimum BRI Retransmit Timeout**—Minimum amount of time, in milliseconds, that the Cisco WLC waits for before retransmitting the BRI message. The valid range is between 500 and 65535. The default value is 1000.
- **Maximum BRI Retransmit Timeout**—Maximum amount of time, in milliseconds, that the Cisco WLC waits for before retransmitting the Binding Revocation Indication (BRI) message. The valid range is between 500 and 65535. The default value is 2000.
- **BRI Retries**—Maximum number of times that the Cisco WLC retransmits the BRI message before receiving the Binding Revocation Acknowledgment (BRA) message. The valid range is between 1 to 10. The default value is 1.

**Step 3**
Click **Apply**.

**Note**
To clear your configuration, click **Clear Domain**.

**Step 4**
To create the LMA, follow these steps:
a) Choose Controller > PMIPv6 > LMA and click **New**.
b) Enter the values for the following parameters:

- **Member Name**—Name of the LMA connected to the Cisco WLC.
- **Member IP Address**—IP address of the LMA connected to the Cisco WLC.
c) Click **Apply**.

**Step 5**
To create a PMIPv6 profile, follow these steps:

a) Choose **Controller > PMIPv6 > Profiles** and click **New**.
b) In the **PMIPv6 Profile > New** window, enter the values for the following parameters:
   - **Profile Name**—Name of the profile.
   - **Network Access Identifier**—Name of the Network Access Identifier (NAI) associated with the profile.
   - **LMA Name**—Name of the LMA to which the profile is associated.
   - **Access Point Node**—Name of the access point node; APN identifies a particular routing domain for user traffic.

c) Click **Apply**.

**Step 6**
To configure PMIPv6 parameters for a WLAN, follow these steps:

a) Choose **WLANs > WLAN ID**. The **WLANs > Edit** window is displayed.

b) Click the **Advanced** tab.

(c) Under **PMIP**, from the **PMIP Mobility Type** drop-down list, choose the mobility type from the following options:
   - **None**—Configures the WLAN with simple IP
   - **PMIPv6**—Configures the WLAN with only PMIPv6

d) From the **PMIP Profile** drop-down list, choose the PMIP profile for the WLAN.

e) In the **PMIP Realm** field, enter the default realm for the WLAN.
f) Click **Apply**.

**Step 7**
Click **Save Configuration**.

---

**Configuring Proxy Mobile IPv6 (CLI)**

**Step 1**
Configure a PMIPv6 domain name by entering this command:

```plaintext
config pmipv6 domain domain-name
```

**Note**  
This command also enables the MAG functionality on the Cisco Wireless Controller (WLC).

**Step 2**
Configure MAG by using these commands:

- Configure the maximum binding update entries that are allowed by entering this command:
  ```plaintext
  config pmipv6 mag binding maximum units
  ```
- Configure the binding entry lifetime by entering this command:
  ```plaintext
  config pmipv6 mag lifetime units
  ```
- Configure the binding refresh interval by entering this command:
  ```plaintext
  config pmipv6 mag refresh-time units
  ```
Configure the initial timeout between PBUs if PBA does not arrive by entering this command:

```
config pmipv6 mag init-retx-time units
```

Configure the maximum initial timeout between PBUs if PBA does not arrive by entering this command:

```
config pmipv6 mag max-retx-time units
```

Configure the replay protection mechanism by entering this command:

```
config pmipv6 mag replay-protection {timestamp window units | sequence-no | mobile-node-timestamp}
```

Configure the minimum or maximum amount of time, in seconds, that the MAG should wait for before it retransmits the binding revocation indication (BRI) message by entering this command:

```
config pmipv6 mag bri delay {min | max} units
```

Configure the maximum number of times the MAG should retransmit the BRI message before it receives the binding revocation acknowledgment (BRA) message by entering this command:

```
config pmipv6 mag bri retries units
```

Configure the list of LMAs for the MAG by entering this command:

```
config pmipv6 mag lma lma-name ipv4-address ip-address
```

**Step 3**
Add a profile to a PMIPv6 domain by entering this command:

```
config pmipv6 add profile profile-name nai {user@realm | @realm | *} lma lma-name apn apn-name
```

*Note* nai stands for network access identifier, while apn stands for access point name.

**Step 4**
Delete a PMIPv6 entity by entering this command:

```
config pmipv6 delete {domain domain-name | lma lma-name | profile profile-name nai {user@realm | @realm | *}}
```

**Step 5**
Configure the PMIPv6 parameters for the WLAN by using these commands:

- Configure the default realm for the WLAN by entering this command:
  
  ```
  config wlan pmipv6 default-realm {realm-name | none} wlan-id
  ```

- Configure the mobility type for a WLAN or for all WLANs by entering this command:
  
  ```
  config wlan pmipv6 mobility-type {none | pmipv6} {wlan-id | all}
  ```

- Configure the profile name for a PMIPv6 WLAN by entering this command:
  
  ```
  config pmipv6 mag profile wlan wlan-id
  ```

**Step 6**
Save your changes by entering this command:

```
save config
```

**Step 7**
See the PMIPv6 configuration details by using the following `show` commands:

- See the details of a profile of a PMIPv6 domain by entering this command:
  
  ```
  show pmipv6 domain domain-name profile profile-name
  ```

- See a summary of all the PMIPv6 profiles by entering this command:
  
  ```
  show pmipv6 profile summary
  ```

- See global information about the PMIPv6 for a MAG by entering this command:
  
  ```
  show pmipv6 mag globals
  ```
• See information about MAG bindings for LMA or NAI by entering this command:
  `show pmipv6 mag bindings {lma lma-name | nai nai-name}`
• See statistical information about MAG by entering this command:
  `show pmipv6 mag stats domain domain-name peer peer-name`
• See information about PMIPv6 for all clients by entering this command:
  `show client summary`
• See information about PMIPv6 for a client by entering this command:
  `show client details client-mac-address`
• See information about PMIPv6 for a WLAN by entering this command:
  `show wlan wlan-id`
CHAPTER 16

Configuring Mobile Concierge

- Information About Mobile Concierge, page 839
- Configuring 802.11u Mobility Services Advertisement Protocol, page 841
- Configuring 802.11u HotSpot, page 842

Information About Mobile Concierge

Mobile Concierge is a solution that enables 80.1X capable clients to interwork with external networks. The Mobile Concierge feature provides service availability information to clients and can help them to associate available networks.

The services offered by the network can be broadly classified into two protocols:

- 802.11u MSAP
- 802.11u HotSpot 2.0

Configuring Mobile Concierge (802.11u)

Configuring Mobile Concierge (802.11u) (GUI)

Step 1
Choose WLAN to open the WLANs page.

Step 2
Hover your mouse over the blue drop-down arrow for the desired WLAN on which you want to configure the 802.11u parameters and select 802.11u. The 802.11u page appears.

Step 3
Select the 802.11u Status check box to enable 802.11u on the WLAN.

Step 4
In the 802.11u General Parameters area, do the following:

a) Select the Internet Access check box to enable this WLAN to provide Internet services.

b) From the Network Type drop-down list, choose the network type that best describes the 802.11u you want to configure on this WLAN.
c) From the Network Auth Type drop-down list, choose the authentication type that you want to configure for the 802.11u parameters on this network.

d) In the HESSID box, enter the homogenous extended service set identifier (HESSID) value. The HESSID is a 6-octet MAC address that identifies the homogeneous ESS.

e) If the IP address is in the IPv4 format, then from the IPv4 Type drop-down list, choose the IPv4 address type.

f) From the IPv6 Type drop-down list, choose whether you want to make the IPv6 address type available or not.

**Step 5**

In the OUI List area, do the following:

a) In the OUI text box, enter the Organizationally Unique Identifier, which can be a hexadecimal number represented in 3 or 5 bytes (6 or 10 characters). For example, AABBDF.

b) Select the **Is Beacon** check box to enable the OUI beacon responses.

   **Note** You can have a maximum of 3 OUIs with this field enabled.

c) From the OUI Index drop-down list, choose a value from 1 to 32. The default is 1.

d) Click **Add** to add the OUI entry to the WLAN.

   To remove this entry, hover your mouse pointer over the blue drop-down image and choose **Remove**.

**Step 6**

In the Domain List area, do the following:

a) In the Domain Name box, enter the domain name that is operating in the WLAN.

b) From the Domain Index drop-down list, choose an index for the domain name from 1 to 32. The default is 1.

c) Click **Add** to add the domain entry to the WLAN.

   To remove this entry, hover your mouse pointer over the blue drop-down image and choose **Remove**.

**Step 7**

In the Realm List area, do the following:

a) In the Realm text box, enter the realm name that you can assign to the WLAN.

b) From the Realm Index drop-down list, choose an index for the realm from 1 to 32. The default is 1.

c) Click **Add** to add the domain entry to this WLAN.

   To remove this entry, hover your mouse pointer over the blue drop-down image and choose **Remove**.

**Step 8**

In the Cellular Network Information List area, do the following:

a) In the Country Code text box, enter the 3-character mobile country code.

b) From the CellularIndex drop-down list, choose a value between 1 and 32. The default is 1.

c) In the Network Code text box, enter the character network code. The network code can be 2 or 3 characters.

d) Click **Add** to add the cellular network information to the WLAN.

   To remove this entry, hover your mouse pointer over the blue drop-down image and select **Remove**.

**Step 9**

Click **Apply**.

---

**Configuring Mobile Concierge (802.11u) (CLI)**

- To enable or disable 802.11u on a WLAN, enter this command:

  ```shell
  config wlan hotspot dot11u {enable | disable} wlan-id
  ```

- To add or delete information about a third generation partnership project's cellular network, enter this command:
config wlan hotspot dot11u 3gpp-info {add index mobile-country-code network-code wlan-id | delete index wlan-id}

• To configure the domain name for the entity operating in the 802.11u network, enter this command:
  config wlan hotspot dot11u domain {{ {add | modify} wlan-id domain-index domain-name } | {delete wlan-id domain-index}}

• To configure a homogenous extended service set identifier (HESSID) value for a WLAN, enter this command:
  config wlan hotspot dot11u hessid hessid wlan-id
  The HESSID is a 6-octet MAC address that identifies the homogeneous ESS.

• To configure the IP address availability type for the IPv4 and IPv6 IP addresses on the WLAN, enter this command:
  config wlan hotspot dot11u ipaddr-type ipv4-type ipv6-type wlan-id

• To configure the network authentication type, enter this command:
  config wlan hotspot dot11u auth-type network-auth wlan-id

• To configure the Roaming Consortium OI list, enter this command:
  config wlan hotspot dot11u roam-oi {{ {add | modify} wlan-id oi-index oi is-beacon } | {delete wlan-id oi-index}}

• To configure the 802.11u network type and internet access, enter this command:
  config wlan hotspot dot11u network-type wlan-id network-type internet-access

• To configure the realm for the WLAN, enter this command:
  config wlan hotspot dot11u nai-realm {{ {add | modify} realm-name wlan-id realm-index realm-name } | {delete realm-name wlan-id realm-index}}

• To configure the authentication method for the realm, enter this command:
  config wlan hotspot dot11u nai-realm {add | modify} auth-method wlan-id realm-index eap-index auth-index auth-method auth-parameter

• To delete the authentication method for the realm, enter this command:
  config wlan hotspot dot11u nai-realm delete auth-method wlan-id realm-index eap-index auth-index

• To configure the extensible authentication protocol (EAP) method for the realm, enter this command:
  config wlan hotspot dot11u nai-realm {add | modify} eap-method wlan-id realm-index eap-index eap-method

• To delete the EAP method for the realm, enter this command:
  config wlan hotspot dot11u nai-realm delete eap-method wlan-id realm-index eap-index

### Configuring 802.11u Mobility Services Advertisement Protocol

#### Information About 802.11u MSAP

MSAP (Mobility Services Advertisement Protocol) is designed to be used primarily by mobile devices that are configured with a set of policies for establishing network services. These services are available for devices that offer higher-layer services, or network services that are enabled through service providers.
Service advertisements use MSAP to provide services to mobile devices prior to association to a Wi-Fi access network. This information is conveyed in a service advertisement. A single-mode or dual-mode mobile device queries the network for service advertisements before association. The device's network discovery and the selection function may use the service advertisements in its decision to join the network.

### Configuring 802.11u MSAP (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose WLAN to open the WLANs page.</td>
</tr>
<tr>
<td>2</td>
<td>Hover your mouse over the blue drop-down arrow for the desired WLAN on which you want to configure the MSAP parameters and select Service Advertisements. The Service Advertisement page appears.</td>
</tr>
<tr>
<td>3</td>
<td>Enable the service advertisements.</td>
</tr>
<tr>
<td>4</td>
<td>Enter the server index for this WLAN. The server index field uniquely identifies an MSAP server instance serving a venue that is reachable through the BSSID.</td>
</tr>
<tr>
<td>5</td>
<td>Click Apply.</td>
</tr>
</tbody>
</table>

### Configuring MSAP (CLI)

- To enable or disable MSAP on a WLAN, enter this command:
  
  `config wlan hotspot msap {enable | disable} wlan-id`

- To assign a server ID, enter this command:
  
  `config wlan hotspot msap server-id server-id wlan-id`

### Configuring 802.11u HotSpot

#### Information About 802.11u HotSpot

This feature, which enables IEEE 802.11 devices to interwork with external networks, is typically found in hotspots or other public networks irrespective of whether the service is subscription based or free.

The interworking service aids network discovery and selection, enabling information transfer from external networks. It provides information to the stations about the networks prior to association. Interworking not only helps users within the home, enterprise, and public access, but also assists manufacturers and operators to provide common components and services for IEEE 802.11 customers. These services are configured on a per WLAN basis on the controller.

**Note**

The Downstream Group-Addressed Forwarding (DGAF) bit in the Hotspot 2.0 IE will not be updated automatically until you disable and enable the WLAN.
Configuring 802.11u HotSpot (GUI)

Step 1 Choose WLAN to open the WLANs window.
Step 2 Hover your mouse over the blue drop-down arrow that corresponds to the desired WLAN on which you want to configure the HotSpot parameters and choose HotSpot. The WLAN > HotSpot 2.0 page is displayed.
Step 3 On the WLAN > HotSpot 2.0 window, enable HotSpot 2.
Step 4 To set the WAN link parameters, perform the following tasks:
   a) From the WAN Link Status drop-down list, choose the status. The default is the Not Configured status.
   b) From the WAN Symmetric Link Status drop-down list, choose the status as either Different or Same.
   c) Enter the WAN Downlink and Uplink speeds. The maximum value is 4,294,967,295 kbps.
Step 5 In the Operator Name List area, perform the following tasks:
   a) In the Operator Name text box, enter the name of the 802.11 operator.
   b) From the Operator index drop-down list, choose an index value between 1 and 32 for the operator.
   c) In the Language Code field, enter an ISO-14962-1997-encoded string defining the language. This string is a three-character language code.
   d) Click Add to add the operator details.
      The operator details are displayed in a tabular form. To remove an operator, hover your mouse pointer over the blue drop-down arrow and choose Remove.
Step 6 In the Port Config List area, perform the following tasks:
   a) From the IP Protocol drop-down list, choose the IP protocol that you want to enable.
   b) From the Port No drop-down list, choose the port number that is enabled on the WLAN.
   c) From the Status drop-down list, choose the status of the port.
   d) From the Index drop-down list, choose an index value for the port configuration.
   e) Click Add to add the port configuration parameters.
      To remove a port configuration list, hover your mouse over the blue drop-down arrow and choose Remove.
Step 7 Click Apply.

Configuring HotSpot 2.0 (CLI)

Note The character ‘?’ is not supported in the value part of the commands.

- To enable or disable HotSpot2 on a WLAN, enter this command:
  ```
  config wlan hotspot hs2 {enable | disable}
  ```
- To configure the operator name on a WLAN, enter this command:
  ```
  config wlan hotspot hs2 operator-name {add | modify} wlan-id index operator-name lang-code
  ```
The following options are available:

- **wlan-id**—The WLAN ID on which you want to configure the operator-name.
- **index**—The operator index of the operator. The range is 1 to 32.
- **operator-name**—The name of the 802.11an operator.
- **lang-code**—The language used. An ISO-14962-1997 encoded string defining the language. This string is a three character language code. Enter the first three letters of the language in English (For example: eng for English).

Tip

Press the tab key after entering a keyword or argument to get a list of valid values for the command.

- To delete the operator name, enter this command:
  ```
  config wlan hotspot hs2 operator-name delete wlan-id index
  ```
- To configure the port configuration parameters, enter this command:
  ```
  config wlan hotspot hs2 port-config \{add \| modify\} wlan-id index ip-protocol port-number
  ```
- To delete a port configuration, enter this command:
  ```
  config wlan hotspot hs2 port-config delete wlan-id index
  ```
- To configure the WAN metrics, enter this command:
  ```
  config wlan hotspot hs2 wan-metrics wlan-id link-status symet-link downlink-speed uplink-speed
  ```
  The values are as follows:
  - **link-status**—The link status. The valid range is 1 to 3.
  - **symet-link**—The symmetric link status. For example, you can configure the uplink and downlink to have different speeds or same speeds.
  - **downlink-speed**—The downlink speed. The maximum value is 4,194,304 kbps.
  - **uplink-speed**—The uplink speed. The maximum value is 4,194,304 kbps.
- To clear all HotSpot configurations, enter this command:
  ```
  config wlan hotspot clear-all wlan-id
  ```
- To configure the Access Network Query Protocol (ANQP) 4-way messaging, enter this command:
  ```
  config advanced hotspot anqp-4way \{enable \| disable \| threshold value\}
  ```
- To configure the ANQP comeback delay value in terms of TUs, enter this command:
  ```
  config advanced hotspot cmbk-delay value
  ```
- To configure the gratuitous ARP (GARP) forwarding to wireless networks, enter this command:
  ```
  config advanced hotspot garp \{enable \| disable\}
  ```
- To limit the number of GAS request action frames to be sent to the controller by an AP in a given interval, enter this command:
  ```
  config advanced hotspot gas-limit \{enable num-of-GAS-required interval \| disable\}
  ```
Configuring Access Points for HotSpot2 (GUI)

When HotSpot2 is configured, the access points that are part of the network must be configured to support HotSpot2.

**Step 1**
Click **Wireless > All APs** to open the All APs page.

**Step 2**
Click the **AP Name** link to configure the HotSpot parameters on the desired access point. The AP Details page appears.

**Step 3**
Under the General Tab, configure the following parameters:

- **Venue Group**—The venue category that this access point belongs to. The following options are available:
  - Unspecified
  - Assembly
  - Business
  - Educational
  - Factory and Industrial
  - Institutional
  - Mercantile
  - Residential
  - Storage
  - Utility and Misc
  - Vehicular
  - Outdoor

- **Venue Type**—Depending on the venue category selected above, the venue type drop-down list displays options for the venue type.

- **Venue Name**—Venue name that you can provide to the access point. This name is associated with the BSS. This is used in cases where the SSID does not provide enough information about the venue.

- **Language**—The language used. An ISO-14962-1997 encoded string defining the language. This is a three character language code. Enter the first three letters of the language in English (For example, eng for English).

**Step 4**
Click **Apply**.

---

**Configuring Access Points for HotSpot2 (CLI)**

- `config ap venue add venue-name venue-group venue-type lang-code ap-name`—Adds the venue details to the access point indicating support for HotSpot2.
The values are as follows:

- **venue-name**—Name of the venue where this access point is located.
- **venue-group**—Category of the venue. See the following table.
- **venue-type**—Type of the venue. Depending on the venue-group chosen, select the venue type. See the following table.
- **lang-code**—The language used. An ISO-14962-1997 encoded string defining the language. This is a three character language code. Enter the first three letters of the language in English (For example: eng for English)
- **ap-name**—Access point name.

Press the tab key after entering a keyword or argument to get a list of valid values for the command.

Tip

- **config ap venue delete ap-name**—Deletes the venue related information from the access point.

### Table 50: Venue Group Mapping

<table>
<thead>
<tr>
<th>Venue Group Name</th>
<th>Value</th>
<th>Venue Type for Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNSPECIFIED</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Venue Group Name</td>
<td>Value</td>
<td>Venue Type for Group</td>
</tr>
<tr>
<td>------------------</td>
<td>-------</td>
<td>----------------------</td>
</tr>
</tbody>
</table>
| ASSEMBLY         | 1     | 0—UNSPECIFIED ASSEMBLY  
|                  |       | 1—ARENA               
|                  |       | 2—STADIUM             
|                  |       | 3—PASSENGER TERMINAL (E.G., AIRPORT, BUS, FERRY, TRAIN STATION) 
|                  |       | 4—AMPHITHEATER        
|                  |       | 5—AMUSEMENT PARK      
|                  |       | 6—PLACE OF WORSHIP    
|                  |       | 7—CONVENTION CENTER   
|                  |       | 8—LIBRARY             
|                  |       | 9—MUSEUM              
|                  |       | 10—RESTAURANT         
|                  |       | 11—THEATER            
|                  |       | 12—BAR                
|                  |       | 13—COFFEE SHOP        
|                  |       | 14—ZOO OR AQUARIUM    
|                  |       | 15—EMERGENCY COORDINATION CENTER |
| BUSINESS         | 2     | 0—UNSPECIFIED BUSINESS  
|                  |       | 1—DOCTOR OR DENTIST OFFICE 
|                  |       | 2—BANK                
|                  |       | 3—FIRE STATION        
|                  |       | 4—POLICE STATION      
|                  |       | 6—POST OFFICE         
|                  |       | 7—PROFESSIONAL OFFICE  
|                  |       | 8—RESEARCH AND DEVELOPMENT FACILITY  
<p>|                  |       | 9—ATTORNEY OFFICE     |</p>
<table>
<thead>
<tr>
<th>Venue Group Name</th>
<th>Value</th>
<th>Venue Type for Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDUCATIONAL</td>
<td>3</td>
<td>• 0—UNSPECIFIED EDUCATIONAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—SCHOOL, PRIMARY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2—SCHOOL, SECONDARY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3—UNIVERSITY OR COLLEGE</td>
</tr>
<tr>
<td>FACTORY-INDUSTRIAL</td>
<td>4</td>
<td>• 0—UNSPECIFIED FACTORY AND INDUSTRIAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—FACTORY</td>
</tr>
<tr>
<td>INSTITUTIONAL</td>
<td>5</td>
<td>• 0—UNSPECIFIED INSTITUTIONAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—HOSPITAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2—LONG-TERM CARE FACILITY (E.G., NURSING HOME, HOSPICE, ETC.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3—ALCOHOL AND DRUG RE-HABILITATION CENTER</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 4—GROUP HOME</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 5—PRISON OR JAIL</td>
</tr>
<tr>
<td>MERCANTILE</td>
<td>6</td>
<td>• 0—UNSPECIFIED MERCANTILE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—RETAIL STORE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2—GROCERY MARKET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3—AUTOMOTIVE SERVICE STATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 4—SHOPPING MALL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 5—GAS STATION</td>
</tr>
<tr>
<td>RESIDENTIAL</td>
<td>7</td>
<td>• 0—UNSPECIFIED RESIDENTIAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1—PRIVATE RESIDENCE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2—HOTEL OR MOTEL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3—DORMITORY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 4—BOARDING HOUSE</td>
</tr>
<tr>
<td>STORAGE</td>
<td>8</td>
<td>UNSPECIFIED STORAGE</td>
</tr>
<tr>
<td>UTILITY-MISC</td>
<td>9</td>
<td>0—UNSPECIFIED UTILITY AND MISCELLANEOUS</td>
</tr>
</tbody>
</table>
## Venue Group Name | Value | Venue Type for Group
--- | --- | ---
VEHICULAR | 10 | • 0—UNSPECIFIED VEHICULAR  
• 1—AUTOMOBILE OR TRUCK  
• 2—AIRPLANE  
• 3—BUS  
• 4—FERRY  
• 5—SHIP OR BOAT  
• 6—TRAIN  
• 7—MOTOR BIKE
OUTDOOR | 11 | • 0—UNSPECIFIED OUTDOOR  
• 1—MUNI-MESH NETWORK  
• 2—CITY PARK  
• 3—REST AREA  
• 4—TRAFFIC CONTROL  
• 5—BUS STOP  
• 6—KIOSK

### Downloading the Icon File (CLI)

You can configure unique icons of the service providers to be displayed on the client devices. You can download these icon files to the Cisco WLC for the icon files to be sent through a gas message and displayed on the client devices. This feature enhances the user interface on the client devices wherein users can differentiate between service providers based on the icons displayed.

**Step 1**  
Save the icon file on an TFTP or an FTP server.

**Step 2**  
Download the icon file to the Cisco WLC by entering these commands:

a) `transfer download datatype icon`

b) `transfer download start`
Troubleshooting

- Interpreting LEDs, page 851
- System Messages, page 852
- Viewing System Resources, page 855
- Using the CLI to Troubleshoot Problems, page 857
- Configuring System and Message Logging, page 858
- Viewing Access Point Event Logs, page 865
- Uploading Logs and Crash Files, page 866
- Uploading Core Dumps from the Controller, page 868
- Uploading Packet Capture Files, page 871
- Monitoring Memory Leaks, page 874
- Troubleshooting CCXv5 Client Devices, page 875
- Using the Debug Facility, page 885
- Configuring Wireless Sniffing, page 890
- Troubleshooting Access Points Using Telnet or SSH, page 892
- Debugging the Access Point Monitor Service, page 894
- Troubleshooting OfficeExtend Access Points, page 895

Interpreting LEDs

Information About Interpreting LEDs

This section describes how to interpret controller LEDs and lightweight access point LEDs.
Interpreting Controller LEDs


Interpreting Lightweight Access Point LEDs

See the quick start guide or hardware installation guide for your specific access point for a description of the LED patterns. See the list of access points and the respective documentation at http://www.cisco.com/c/en/us/products/wireless/index.html.

System Messages

Information About System Messages

This table lists some common system messages and their descriptions. For a complete list of system messages, see the Cisco Wireless LAN Controller System Message Guide, Release 7.0.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>apf_utils.c 680: Received a CIF field without the protected bit set from mobile xx:xx:xx:xx:xx:xx</td>
<td>A client is sending an association request on a security-enabled WLAN with the protected bit set to 0 (in the Capability field of the association request). As designed, the controller rejects the association request, and the client sees an association failure.</td>
</tr>
<tr>
<td>dtl_arp.c 480: Got an idle-timeout message from an unknown client xx:xx:xx:xx:xx:xx</td>
<td>The controller’s network processing unit (NPU) sends a timeout message to the central processing unit (CPU) indicating that a particular client has timed out or aged out. This situation typically occurs when the CPU has removed a wireless client from its internal database but has not notified the NPU. Because the client remains in the NPU database, it ages out on the network processor and notifies the CPU. The CPU finds the client that is not present in its database and then sends this message.</td>
</tr>
<tr>
<td>STATION_DISASSOCIATE</td>
<td>The client may have intentionally terminated usage or may have experienced a service disruption.</td>
</tr>
<tr>
<td>STATION_DEAUTHENTICATE</td>
<td>The client may have intentionally terminated usage or this message could indicate an authentication issue.</td>
</tr>
<tr>
<td>STATION_AUTHENTICATION_FAIL</td>
<td>Check disable, key mismatch, or other configuration issues.</td>
</tr>
<tr>
<td>STATION_ASSOCIATE_FAIL</td>
<td>Check load on the Cisco radio or signal quality issues.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>LRAD_ASSOCIATED</td>
<td>The associated lightweight access point is now managed by this controller.</td>
</tr>
<tr>
<td>LRAD_DISASSOCIATED</td>
<td>The lightweight access point may have associated to a different controller or may have become completely unreachable.</td>
</tr>
<tr>
<td>LRAD_UP</td>
<td>The lightweight access point is operational; no action required.</td>
</tr>
<tr>
<td>LRAD_DOWN</td>
<td>The lightweight access point may have a problem or is administratively disabled.</td>
</tr>
<tr>
<td>LRADIF_UP</td>
<td>The Cisco radio is UP.</td>
</tr>
<tr>
<td>LRADIF_DOWN</td>
<td>The Cisco radio may have a problem or is administratively disabled.</td>
</tr>
<tr>
<td>LRADIF_LOAD_PROFILE_FAILED</td>
<td>The client density may have exceeded system capacity.</td>
</tr>
<tr>
<td>LRADIF_NOISE_PROFILE_FAILED</td>
<td>The non-802.11 noise has exceeded the configured threshold.</td>
</tr>
<tr>
<td>LRADIF_INTERFERENCE_PROFILE_FAILED</td>
<td>802.11 interference has exceeded threshold on channel; check channel assignments.</td>
</tr>
<tr>
<td>LRADIF_COVERAGE_PROFILE_FAILED</td>
<td>A possible coverage hole has been detected. Check the lightweight access point history to see if it is a common problem and add lightweight access points if necessary.</td>
</tr>
<tr>
<td>LRADIF_LOAD_PROFILE_PASSED</td>
<td>The load is now within threshold limits.</td>
</tr>
<tr>
<td>LRADIF_NOISE_PROFILE_PASSED</td>
<td>The detected noise is now less than threshold.</td>
</tr>
<tr>
<td>LRADIF_INTERFERENCE_PROFILE_PASSED</td>
<td>The detected interference is now less than threshold.</td>
</tr>
<tr>
<td>LRADIF_COVERAGE_PROFILE_PASSED</td>
<td>The number of clients receiving a poor signal are within threshold.</td>
</tr>
<tr>
<td>LRADIF_CURRENT_TXPOWER_CHANGED</td>
<td>Informational message.</td>
</tr>
<tr>
<td>LRADIF_CURRENT_CHANNEL_CHANGED</td>
<td>Informational message.</td>
</tr>
<tr>
<td>LRADIF_RTS_THRESHOLD_CHANGED</td>
<td>Informational message.</td>
</tr>
<tr>
<td>LRADIF_ED_THRESHOLD_CHANGED</td>
<td>Informational message.</td>
</tr>
<tr>
<td>LRADIF_FRAGMENTATION_THRESHOLD_CHANGED</td>
<td>Informational message.</td>
</tr>
<tr>
<td>RRM_DOT11_A_GROUPING_DONE</td>
<td>Informational message.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RRM_DOT11_B_GROUPING_DONE</td>
<td>Informational message.</td>
</tr>
<tr>
<td>ROGUE_AP_DETECTED</td>
<td>May be a security issue. Use maps and trends to investigate.</td>
</tr>
<tr>
<td>ROGUE_AP_REMOVED</td>
<td>A detected rogue access point has timed out. The unit might have shut down or moved out of the coverage area.</td>
</tr>
<tr>
<td>AP_MAX_ROGUE_COUNT_EXCEEDED</td>
<td>The current number of active rogue access points has exceeded system threshold.</td>
</tr>
<tr>
<td>LINK_UP</td>
<td>Positive confirmation message.</td>
</tr>
<tr>
<td>LINK_DOWN</td>
<td>A port may have a problem or is administratively disabled.</td>
</tr>
<tr>
<td>LINK_FAILURE</td>
<td>A port may have a problem or is administratively disabled.</td>
</tr>
<tr>
<td>AUTHENTICATION_FAILURE</td>
<td>An attempted security breech has occurred. Investigate.</td>
</tr>
<tr>
<td>STP_NEWROOT</td>
<td>Informational message.</td>
</tr>
<tr>
<td>STP_TOPOLOGY_CHANGE</td>
<td>Informational message.</td>
</tr>
<tr>
<td>IPSEC_ESP_AUTH_FAILURE</td>
<td>Check WLAN IPsec configuration.</td>
</tr>
<tr>
<td>IPSEC_ESP_REPLAY_FAILURE</td>
<td>Check for an attempt to spoof an IP address.</td>
</tr>
<tr>
<td>IPSEC_ESP_POLICY_FAILURE</td>
<td>Check for a IPsec configuration mismatch between WLAN and client.</td>
</tr>
<tr>
<td>IPSEC_ESP_INVALID_SPI</td>
<td>Informational message.</td>
</tr>
<tr>
<td>IPSEC_OTHER_POLICY_FAILURE</td>
<td>Check for a IPsec configuration mismatch between WLAN and client.</td>
</tr>
<tr>
<td>IPSEC_IKE_NEG_FAILURE</td>
<td>Check for a IPsec IKE configuration mismatch between WLAN and client.</td>
</tr>
<tr>
<td>IPSEC_SUITE_NEG_FAILURE</td>
<td>Check for a IPsec IKE configuration mismatch between WLAN and client.</td>
</tr>
<tr>
<td>IPSEC_INVALID_COOKIE</td>
<td>Informational message.</td>
</tr>
<tr>
<td>RADIOS_EXCEEDED</td>
<td>The maximum number of supported Cisco radios has been exceeded. Check for a controller failure in the same Layer 2 network or add another controller.</td>
</tr>
<tr>
<td>SENSED_TEMPERATURE_HIGH</td>
<td>Check fan, air conditioning, and/or other cooling arrangements.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SENSED_TEMPERATURE_LOW</td>
<td>Check room temperature and/or other reasons for low temperature.</td>
</tr>
<tr>
<td>TEMPERATURE_SENSOR_FAILURE</td>
<td>Replace temperature sensor as soon as possible.</td>
</tr>
<tr>
<td>TEMPERATURE_SENSOR_CLEAR</td>
<td>The temperature sensor is operational.</td>
</tr>
<tr>
<td>POE_CONTROLLER_FAILURE</td>
<td>Check ports; a possible serious failure has been detected.</td>
</tr>
<tr>
<td>MAX_ROGUE_COUNT_EXCEEDED</td>
<td>The current number of active rogue access points has exceeded system threshold.</td>
</tr>
<tr>
<td>SWITCH_UP</td>
<td>The controller is responding to SNMP polls.</td>
</tr>
<tr>
<td>SWITCH_DOWN</td>
<td>The controller is not responding to SNMP polls; check controller and SNMP settings.</td>
</tr>
<tr>
<td>RADIUS_SERVERS_FAILED</td>
<td>Check network connectivity between RADIUS and the controller.</td>
</tr>
<tr>
<td>CONFIG_SAVED</td>
<td>The running configuration has been saved to flash; it will be active after a reboot.</td>
</tr>
<tr>
<td>MULTIPLE_USERS</td>
<td>Another user with the same username has logged in.</td>
</tr>
<tr>
<td>FAN_FAILURE</td>
<td>Monitor controller temperature to avoid overheating.</td>
</tr>
<tr>
<td>POWER_SUPPLY_CHANGE</td>
<td>Check for a power-supply malfunction.</td>
</tr>
<tr>
<td>COLD_START</td>
<td>The controller may have been rebooted.</td>
</tr>
<tr>
<td>WARM_START</td>
<td>The controller may have been rebooted.</td>
</tr>
</tbody>
</table>

### Viewing System Resources

#### Information About Viewing System Resources

You can determine the amount of system resources being used by the controller. Specifically, you can view the current controller CPU usage, system buffers, and web server buffers.

The Cisco 5500 Series Controllers have multiple CPUs, so you can view individual CPU usage. For each CPU, you can see the percentage of the CPU in use and the percentage of the CPU time spent at the interrupt level (for example, 0%/3%).
Guidelines and Limitations - not used

The Cisco 5500 Series Controllers have multiple CPUs, so you can view individual CPU usage. For each CPU, you can see the percentage of the CPU in use and the percentage of the CPU time spent at the interrupt level (for example, 0%/3%).

Viewing System Resources (GUI)


Viewing System Resources (CLI)

On the controller CLI, enter these commands:

- **show cpu**
  
  Where the first number is the CPU percentage that the controller spent on the user application and the second number is the CPU percentage that the controller spent on the OS services.

- **show tech-support**

- **show system top**
  Provides an ongoing look at processor activity in real time. It displays a list of the most CPU-intensive tasks performed on the system.

- **show system iostat summary**
  Provides CPU statistics, input and output statistics for devices and partitions.

- **show system iostat detail**
Provides CPU statistics, input and output statistics for devices and partitions with extended statistics.

**Using the CLI to Troubleshoot Problems**

If you experience any problems with your controller, you can use the commands in this section to gather information and debug issues.

- **show process cpu**—Shows how various tasks in the system are using the CPU at that instant in time. This command is helpful in understanding if any single task is monopolizing the CPU and preventing other tasks from being performed.
  The Priority field shows two values: 1) the original priority of the task that was created by the actual function call and 2) the priority of the task divided by a range of system priorities.
  The CPU Use field shows the CPU usage of a particular task.
  The Reaper field shows three values: 1) the amount of time for which the task is scheduled in user mode operation, 2) the amount of time for which the task is scheduled in system mode operation, and 3) whether the task is being watched by the reaper task monitor (indicated by a “T”). If the task is being watched by the reaper task monitor, this field also shows the timeout value (in seconds) before which the task needs to alert the task monitor.

  **Note**

  If you want to see the total CPU usage as a percentage, enter the `show cpu` command.

- **show process memory**—Shows the allocation and deallocation of memory from various processes in the system at that instant in time.
  In the example above, the following fields provide information:
  The Name field shows the tasks that the CPU is to perform.
  The Priority field shows two values: 1) the original priority of the task that was created by the actual function call and 2) the priority of the task divided by a range of system priorities.
  The BytesInUse field shows the actual number of bytes used by dynamic memory allocation for a particular task.
  The BlocksInUse field shows the chunks of memory that are assigned to perform a particular task.
  The Reaper field shows three values: 1) the amount of time for which the task is scheduled in user mode operation, 2) the amount of time for which the task is scheduled in system mode operation, and 3) whether the task is being watched by the reaper task monitor (indicated by a “T”). If the task is being watched by the reaper task monitor, this field also shows the timeout value (in seconds) before which the task needs to alert the task monitor.

- **show tech-support**—Shows an array of information related to the state of the system, including the current configuration, last crash file, CPU utilization, and memory utilization.

- **show run-config**—Shows the complete configuration of the controller. To exclude access point configuration settings, use the `show run-config no-ap` command.
If you want to see the passwords in clear text, enter the `config passwd-cleartext enable` command. To execute this command, you must enter an admin password. This command is valid only for this particular session. It is not saved following a reboot.

- `show run-config`—Shows the list of configured commands on the controller. This command shows only values configured by the user. It does not show system-configured default values.

**Configuring System and Message Logging**

**Information About System and Message Logging**

System logging allows controllers to log their system events to up to three remote syslog servers. The controller sends a copy of each syslog message as it is logged to each syslog server configured on the controller. Being able to send the syslog messages to multiple servers ensures that the messages are not lost due to the temporary unavailability of one syslog server. Message logging allows system messages to be logged to the controller buffer or console.

**Configuring System and Message Logging (GUI)**

**Step 1**
Choose *Management > Logs > Config*. The Syslog Configuration page appears.

*Figure 105: Syslog Configuration Page*
Step 2  In the Syslog Server IP Address (IPv4/IPv6) text box, enter the IPv4/IPv6 address of the server to which to send the syslog messages and click Add. You can add up to three syslog servers to the controller. The list of syslog servers that have already been added to the controller appears below this text box.

Note  If you want to remove a syslog server from the controller, click Remove to the right of the desired server.

Step 3  To set the severity level for filtering syslog messages to the syslog servers, choose one of the following options from the Syslog Level drop-down list:

- **Emergencies** = Severity level 0
- **Alerts** = Severity level 1 (default value)
- **Critical** = Severity level 2
- **Errors** = Severity level 3
- **Warnings** = Severity level 4
- **Notifications** = Severity level 5
- **Informational** = Severity level 6
- **Debugging** = Severity level 7

If you set a syslog level, only those messages whose severity is equal to or less than that level are sent to the syslog servers. For example, if you set the syslog level to Warnings (severity level 4), only those messages whose severity is between 0 and 4 are sent to the syslog servers.

Step 4  To set the facility for outgoing syslog messages to the syslog servers, choose one of the following options from the Syslog Facility drop-down list:

- **Kernel** = Facility level 0
- **User Process** = Facility level 1
- **Mail** = Facility level 2
- **System Daemons** = Facility level 3
- **Authorization** = Facility level 4
- **Syslog** = Facility level 5 (default value)
- **Line Printer** = Facility level 6
- **USENET** = Facility level 7
- **Unix-to-Unix Copy** = Facility level 8
- **Cron** = Facility level 9
- **FTP Daemon** = Facility level 11
- **System Use 1** = Facility level 12
- **System Use 2** = Facility level 13
- **System Use 3** = Facility level 14
- **System Use 4** = Facility level 15
Step 5  Click Apply.

Step 6  To set the severity level for logging messages to the controller buffer and console, choose one of the following options from both the **Buffered LogLevel** and **Console LogLevel** drop-down lists:

- **Emergencies** = Severity level 0
- **Alerts** = Severity level 1
- **Critical** = Severity level 2
- **Errors** = Severity level 3 (default value)
- **Warnings** = Severity level 4
- **Notifications** = Severity level 5
- **Informational** = Severity level 6
- **Debugging** = Severity level 7
- **Disable**— This option is available only for Console Log level. Select this option to disable console logging.

If you set a logging level, only those messages whose severity is equal to or less than that level are logged by the controller. For example, if you set the logging level to Warnings (severity level 4), only those messages whose severity is between 0 and 4 are logged.

Step 7  Select the **File Info** check box if you want the message logs to include information about the source file. The default value is enabled.

Step 8  Select the **Trace Info** check box if you want the message logs to include traceback information. The default is disabled.

Step 9  Click Apply.

Step 10  Click Save Configuration.

---

**Viewing Message Logs (GUI)**

To view message logs using the controller GUI, choose **Management > Logs > Message Logs**. The Message Logs page appears.
To clear the current message logs from the controller, click **Clear**.

---

**Configuring System and Message Logging (CLI)**

**Step 1**
Enable system logging and set the IP address of the syslog server to which to send the syslog messages by entering this command:

```
config logging syslog host server_IP_address
```

You can add up to three syslog servers to the controller.

*Note* To remove a syslog server from the controller by entering this command: `config logging syslog host server_IP_address delete`

**Step 2**
Set the severity level for filtering syslog messages to the syslog server by entering this command:

```
config logging syslog level severity_level
```

where `severity_level` is one of the following:

- `emergencies` = Severity level 0
- `alerts` = Severity level 1
- `critical` = Severity level 2
- `errors` = Severity level 3
- `warnings` = Severity level 4
- `notifications` = Severity level 5
- `informational` = Severity level 6
- `debugging` = Severity level 7

*Note* As an alternative, you can enter a number from 0 through 7 for the `severity_level` parameter.

*Note* If you set a syslog level, only those messages whose severity is equal to or less than that level are sent to the syslog server. For example, if you set the syslog level to Warnings (severity level 4), only those messages whose severity is between 0 and 4 are sent to the syslog server.

**Step 3**
Set the severity level for filtering syslog messages for a particular access point or for all access points by entering this command:

```
config ap logging syslog level severity_level {Cisco_AP | all}
```

where `severity_level` is one of the following:

- `emergencies` = Severity level 0
- `alerts` = Severity level 1
- `critical` = Severity level 2
- `errors` = Severity level 3
- `warnings` = Severity level 4
• notifications = Severity level 5
• informational = Severity level 6
• debugging = Severity level 7

**Note** If you set a syslog level, only those messages whose severity is equal to or less than that level are sent to the access point. For example, if you set the syslog level to Warnings (severity level 4), only those messages whose severity is between 0 and 4 are sent to the access point.

**Step 4** Set the facility for outgoing syslog messages to the syslog server by entering this command:
```plaintext
config logging syslog facility facility_code
```
where  *Client*  is one of the following:

• authorization = Authorization system. Facility level = 4.
• auth-private = Authorization system (private). Facility level = 10.
• cron = Cron/at facility. Facility level = 9.
• daemon = System daemons. Facility level = 3.
• ftp = FTP daemon. Facility level = 11.
• kern = Kernel. Facility level = 0.
• local0 = Local use. Facility level = 16.
• local1 = Local use. Facility level = 17.
• local2 = Local use. Facility level = 18.
• local3 = Local use. Facility level = 19.
• local4 = Local use. Facility level = 20.
• local5 = Local use. Facility level = 21.
• local6 = Local use. Facility level = 22.
• local7 = Local use. Facility level = 23.
• lpr = Line printer system. Facility level = 6.
• mail = Mail system. Facility level = 2.
• news = USENET news. Facility level = 7.
• sys12 = System use. Facility level = 12.
• sys13 = System use. Facility level = 13.
• sys14 = System use. Facility level = 14.
• sys15 = System use. Facility level = 15.
• syslog = The syslog itself. Facility level = 5.
• user = User process. Facility level = 1.
Step 5 Configure the syslog facility for AP using the following command:

```
config logging syslog facility AP
```

where `AP` can be:

- associate= Associated syslog for AP
- disassociate= Disassociate syslog for AP

Step 6 Configure the syslog facility for Client using the following command:

```
config logging syslog facility Client
```

where `Client` can be:

- assocfail Dot11= association fail syslog for clients
- associate Dot11= association syslog for clients
- authentication= authentication success syslog for clients
- authfail Dot11= authentication fail syslog for clients
- deauthenticate Dot11= deauthentication syslog for clients
- disassociate Dot11= disassociation syslog for clients
- excluded Excluded= syslog for clients

Step 7 Set the severity level for logging messages to the controller buffer and console, enter these commands:

```
• config logging buffered severity_level
• config logging console severity_level
```

where `severity_level` is one of the following:

- emergencies = Severity level 0
- alerts = Severity level 1
- critical = Severity level 2
- errors = Severity level 3
- warnings = Severity level 4
- notifications = Severity level 5
- informational = Severity level 6
- debugging = Severity level 7

**Note** As an alternative, you can enter a number from 0 through 7 for the `severity_level` parameter.

**Note** If you set a logging level, only those messages whose severity is equal to or less than that level are logged by the controller. For example, if you set the logging level to Warnings (severity level 4), only those messages whose severity is between 0 and 4 are logged.
Step 8  Save debug messages to the controller buffer, the controller console, or a syslog server by entering these commands:

- `config logging debug buffered {enable | disable}`
- `config logging debug console {enable | disable}`
- `config logging debug syslog {enable | disable}`

By default, the console command is enabled, and the buffered and syslog commands are disabled.

Step 9  To cause the controller to include information about the source file in the message logs or to prevent the controller from displaying this information by entering this command:

`config logging fileinfo {enable | disable}`

The default value is enabled.

Step 10 Configure the controller to include process information in the message logs or to prevent the controller from displaying this information by entering this command:

`config logging procinfo {enable | disable}`

The default value is disabled.

Step 11 Configure the controller to include traceback information in the message logs or to prevent the controller from displaying this information by entering this command:

`config logging traceinfo {enable | disable}`

The default value is disabled.

Step 12  Enable or disable timestamps in log messages and debug messages by entering these commands:

- `config service timestamps log {datetime | disable}`
- `config service timestamps debug {datetime | disable}`

  where

- `datetime` = Messages are timestamped with the standard date and time. This is the default value.
- `disable` = Messages are not timestamped.

Step 13  Save your changes by entering this command:

`save config`

Viewing System and Message Logs (CLI)

To see the logging parameters and buffer contents, enter this command:

`show logging`
Viewing Access Point Event Logs

Information About Access Point Event Logs

Access points log all system messages (with a severity level greater than or equal to notifications) to the access point event log. The event log can contain up to 1024 lines of messages, with up to 128 characters per line. When the event log becomes filled, the oldest message is removed to accommodate a new event message. The event log is saved in a file on the access point flash, which ensures that it is saved through a reboot cycle. To minimize the number of writes to the access point flash, the contents of the event log are written to the event log file during normal reload and crash scenarios only.

Viewing Access Point Event Logs (CLI)

Use these CLI commands to view or clear the access point event log from the controller:

- To see the contents of the event log file for an access point that is joined to the controller, enter this command:

  `show ap eventlog Cisco_AP`

  Information similar to the following appears:

  AP event log download has been initiated
  Waiting for download to complete
  AP event log download completed.

  ------------------------ AP Event log Contents ------------------------
  *Sep 22 11:44:00.573: %CAPWAP-5-CHANGED: CAPWAP changed state to IMAGE
  *Sep 22 11:44:01.514: %LINEPROTO-5-UPDOWN: Line protocol on Interface Dot11Radio0, changed state to down
  *Sep 22 11:44:01.519: %LINEPROTO-5-UPDOWN: Line protocol on Interface Dot11Radio1, changed state to down
  *Mar 1 00:00:39.078: %CAPWAP-3-ERRORLOG: Did not get log server settings from DHCP.
  *Mar 1 00:00:39.078: %CAPWAP-3-ERRORLOG: Could not resolve CISCO-CAPWAP-CONTROLLER
  *Mar 1 00:00:42.142: %CDP_PD-4-POWER_OK: Full power - NEGOTIATED inline power source
  *Mar 1 00:00:42.151: %LINK-3-UPDOWN: Interface Dot11Radio1, changed state to up
  *Mar 1 00:00:42.158: %LINK-3-UPDOWN: Interface Dot11Radio0, changed state to up
  *Mar 1 00:00:43.143: %LINEPROTO-5-UPDOWN: Line protocol on Interface Dot11Radio1, changed state to up
  *Mar 1 00:00:43.151: %LINEPROTO-5-UPDOWN: Line protocol on Interface Dot11Radio0, changed state to up
  *Mar 1 00:00:48.078: %CAPWAP-3-ERRORLOG: Could not resolve CISCO-CAPWAP-CONTROLLER
  *Mar 1 00:01:42.144: %CDP_PD-4-POWER_OK: Full power - NEGOTIATED inline power source
  *Mar 1 00:01:48.121: %CAPWAP-3-CLIENTERRORLOG: Set Transport Address: no more AP manager IP addresses remain
  *Mar 1 00:01:48.122: %CAPWAP-5-CHANGED: CAPWAP changed state to JOIN
  *Mar 1 00:01:48.122: %LINK-5-CHANGED: Interface Dot11Radio0, changed state to administratively down
  *Mar 1 00:01:48.122: %LINK-5-CHANGED: Interface Dot11Radio1, changed state to administratively down

- To delete the existing event log and create an empty event log file for a specific access point or for all access points joined to the controller, enter this command:

  `clear ap-eventlog {specific Cisco_AP | all}`
Uploading Logs and Crash Files

Prerequisites to Upload Logs and Crash Files

- Follow the instructions in this section to upload logs and crash files from the controller. However, before you begin, ensure you have a TFTP or FTP server available for the file upload. Follow these guidelines when setting up a TFTP or FTP server:
  - If you are uploading through the service port, the TFTP or FTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.
  - If you are uploading through the distribution system network port, the TFTP or FTP server can be on the same or a different subnet because the distribution system port is routable.
  - A third-party TFTP or FTP server cannot run on the same computer as Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP or FTP server and the third-party TFTP or FTP server require the same communication port.

Uploading Logs and Crash Files (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Command &gt; Upload File. The Upload File from Controller page appears.</td>
</tr>
<tr>
<td>Step 2</td>
<td>From the File Type drop-down list, choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Event Log</td>
</tr>
<tr>
<td></td>
<td>• Message Log</td>
</tr>
<tr>
<td></td>
<td>• Trap Log</td>
</tr>
<tr>
<td></td>
<td>• Crash File</td>
</tr>
<tr>
<td>Step 3</td>
<td>From the Transfer Mode drop-down list, choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>• TFTP</td>
</tr>
<tr>
<td></td>
<td>• FTP</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the IP Address text box, enter the IP address of the server.</td>
</tr>
<tr>
<td>Step 5</td>
<td>In the File Path text box, enter the directory path of the log or crash file.</td>
</tr>
<tr>
<td>Step 6</td>
<td>In the File Name text box, enter the name of the log or crash file.</td>
</tr>
<tr>
<td>Step 7</td>
<td>If you chose FTP as the Transfer Mode, follow these steps:</td>
</tr>
<tr>
<td></td>
<td>1 In the Server Login Username text box, enter the FTP server login name.</td>
</tr>
<tr>
<td></td>
<td>2 In the Server Login Password text box, enter the FTP server login password.</td>
</tr>
</tbody>
</table>
3. In the **Server Port Number** text box, enter the port number of the FTP server. The default value for the server port is 21.

**Step 8** Click **Upload** to upload the log or crash file from the controller. A message appears indicating the status of the upload.

---

### Uploading Logs and Crash Files (CLI)

**Step 1** To transfer the file from the controller to a server, enter this command:
```
transfer upload mode {tftp | ftp}
```

**Step 2** To specify the type of file to be uploaded, enter this command:
```
transfer upload datatype datatype
```
where **datatype** is one of the following options:

- **crashfile**—Uploads the system’s crash file.
- **errorlog**—Uploads the system’s error log.
- **panic-crash-file**—Uploads the kernel panic information if a kernel panic occurs.
- **systemtrace**—Uploads the system’s trace file.
- **traplog**—Uploads the system’s trap log.
- **watchdog-crash-file**—Uploads the console dump resulting from a software-watchdog-initiated reboot of the controller following a crash. The software watchdog module periodically checks the integrity of the internal software and makes sure that the system does not stay in an inconsistent or nonoperational state for a long period of time.

**Step 3** To specify the path to the file, enter these commands:
```
• transfer upload serverip server_ip_address
• transfer upload path server_path_to_file
• transfer upload filename filename
```

**Step 4** If you are using an FTP server, also enter these commands:
```
• transfer upload username username
• transfer upload password password
• transfer upload port port
```

**Note** The default value for the port parameter is 21.

**Step 5** To see the updated settings, enter this command:
```
transfer upload start
```

---
Uploading Core Dumps from the Controller

Information About Uploading Core Dumps from the Controller

To help troubleshoot controller crashes, you can configure the controller to automatically upload its core dump file to an FTP server after experiencing a crash. You cannot upload the core dump file directly to an FTP or TFTP server but you can upload a crash file to an FTP or TFTP server. The controllers save the core dump file to flash memory following a crash.

Configuring the Controller to Automatically Upload Core Dumps to an FTP Server (GUI)

Step 1 Choose Management > Tech Support > Core Dump to open the Core Dump page.

Step 2 To enable the controller to generate a core dump file following a crash, select the Core Dump Transfer check box.

Step 3 To specify the type of server to which the core dump file is uploaded, choose FTP from the Transfer Mode drop-down list.

Step 4 In the IP Address text box, enter the IP address of the FTP server.

Note The controller must be able to reach the FTP server.
Step 5  In the **FileName** text box, enter the name that the controller uses to label the core dump file.

Step 6  In the **UserName** text box, enter the username for FTP login.

Step 7  In the **Password** text box, enter the password for FTP login.

Step 8  Click **Apply** to commit your changes.

Step 9  Click **Save Configuration** to save your changes.

---

### Configuring the Controller to Automatically Upload Core Dumps to an FTP Server (CLI)

**Step 1**  To enable or disable the controller to generate a core dump file following a crash, enter this command:
```
config coredump {enable | disable}
```

**Step 2**  To specify the FTP server to which the core dump file is uploaded, enter this command:
```
config coredump ftp server_ip_address filename
```

where

- `server_ip_address` is the IP address of the FTP server to which the controller sends its core dump file.
  
  **Note** The controller must be able to reach the FTP server.

- `filename` is the name that the controller uses to label the core dump file.

**Step 3**  To specify the username and password for FTP login, enter this command:
```
config coredump username ftp_username password ftp_password
```

**Step 4**  To save your changes, enter this command:
```
save config
```

**Step 5**  To see a summary of the controller’s core dump file, enter this command:
```
show coredump summary
```

**Example:**
Information similar to the following appears:

```
Core Dump is enabled

FTP Server IP.................................... 10.10.10.17
FTP Filename..................................... file1
FTP Username................................. ftpuser
FTP Password.................................. ********
```
Uploading Core Dumps from Controller to a Server (CLI)

Step 1
To see information about the core dump file in flash memory, enter this command:
```
show coredump summary
```
Information similar to the following appears:

```
Core Dump is disabled
Core Dump file is saved on flash
Sw Version.............................. 6.0.83.0
File Size................................. 9081788
File Name Suffix......................... filename.gz
```

Step 2
To transfer the file from the controller to a server, enter these commands:

- `transfer upload mode {tftp | ftp}
- `transfer upload datatype coredump
- `transfer upload serverip <server_ip_address>
- `transfer upload path <server_path_to_file>
- `transfer upload filename <filename>

**Note** After the file is uploaded, it ends with a `.gz` suffix. If desired, you can upload the same core dump file multiple times with different names to different servers.

Step 3
If you are using an FTP server, also enter these commands:

- `transfer upload username <username>
- `transfer upload password <password>
- `transfer upload port <port>

**Note** The default value for the `port` parameter is 21.

Step 4
To view the updated settings, enter this command:
```
transfer upload start
```

Step 5
When prompted to confirm the current settings and start the software upload, answer y.
Uploading Packet Capture Files

Information About Uploading Packet Capture Files

When a Cisco 5500 Series Controller’s data plane crashes, it stores the last 50 packets that the controller received in flash memory. This information can be useful in troubleshooting the crash.

When a crash occurs, the controller generates a new packet capture file (*.pcap) file, and a message similar to the following appears in the controller crash file:

Last 5 packets processed at each core are stored in "last_receivedPkts.pcap" captured file.
- Frame 36,38,43,47,49, processed at core #0.
- Frame 14,27,30,42,45, processed at core #1.
- Frame 15,18,20,32,48, processed at core #2.
- Frame 11,29,34,37,46, processed at core #3.
- Frame 7,8,12,31,35, processed at core #4.
- Frame 21,25,39,41,50, processed at core #5.
- Frame 16,17,19,22,33, processed at core #6.
- Frame 6,10,13,23,26, processed at core #7.
- Frame 9,24,28,40,44, processed at core #8.
- Frame 1,2,3,4,5, processed at core #9.

You can use the controller GUI or CLI to upload the packet capture file from the controller. You can then use Wireshark or another standard packet capture tool to view and analyze the contents of the file.
This figure shows a sample output of the packet capture in Wireshark.

Figure 107: Sample Output of Packet Capture File in Wireshark

Restrictions for Uploading Packet Capture Files

- Only Cisco 5500 Series Controllers generate packet capture files. This feature is not available on other controller platforms.

- Ensure that you have a TFTP or FTP server available for the file upload. Follow these guidelines when setting up a TFTP or FTP server:
  - If you are uploading through the service port, the TFTP or FTP server must be on the same subnet as the service port because the service port is not routable, or you must create static routes on the controller.
  - If you are uploading through the distribution system network port, the TFTP or FTP server can be on the same or a different subnet because the distribution system port is routable.
  - A third-party TFTP or FTP server cannot run on the same computer as Cisco Prime Infrastructure because the Prime Infrastructure built-in TFTP or FTP server and the third-party TFTP or FTP server require the same communication port.
Uploading Packet Capture Files (GUI)

Step 1 Choose **Commands > Upload File** to open the Upload File from Controller page.

Step 2 From the File Type drop-down list, choose **Packet Capture**.

Step 3 From the Transfer Mode drop-down list, choose from the following options:
   - **TFTP**
   - **FTP**

Step 4 In the **IP Address** text box, enter the IP address of the server.

Step 5 In the **File Path** text box, enter the directory path of the packet capture file.

Step 6 In the **File Name** text box, enter the name of the packet capture file. These files have a .pcap extension.

Step 7 If you are using an FTP server, follow these steps:
   a) In the **Server Login Username** text box, enter the username to log into the FTP server.
   b) In the **Server Login Password** text box, enter the password to log into the FTP server.
   c) In the **Server Port Number** text box, enter the port number on the FTP server through which the upload occurs. The default value is 21.

Step 8 Click **Upload** to upload the packet capture file from the controller. A message appears indicating the status of the upload.

Step 9 Use Wireshark or another standard packet capture tool to open the packet capture file and see the last 50 packets that were received by the controller.

Uploading Packet Capture Files (CLI)

Step 1 Log on to the controller CLI.

Step 2 Enter the **transfer upload mode {tftp | ftp}** command.

Step 3 Enter the **transfer upload datatype packet-capture** command.

Step 4 Enter the **transfer upload serverip server-ip-address** command.

Step 5 Enter the **transfer upload path server-path-to-file** command.

Step 6 Enter the **transfer upload filename last_received_pkts.pcap** command.

Step 7 If you are using an FTP server, enter these commands:
   - **transfer upload username username**
   - **transfer upload password password**
   - **transfer upload port port**

   **Note** The default value for the **port** parameter is 21.
Step 8 Enter the `transfer upload start` command to see the updated settings and then answer `y` when prompted to confirm the current settings and start the upload process.

Step 9 Use Wireshark or another standard packet capture tool to open the packet capture file and see the last 50 packets that were received by the controller.

Monitoring Memory Leaks

This section provides instructions for troubleshooting hard-to-solve or hard-to-reproduce memory problems.

⚠️ Caution The commands in this section can be disruptive to your system and should be run only when you are advised to do so by the Cisco Technical Assistance Center (TAC).

Monitoring Memory Leaks (CLI)

Step 1 To enable or disable monitoring for memory errors and leaks, enter this command:
```
config memory monitor errors {enable | disable}
```
The default value is disabled.

⚠️ Note Your changes are not saved across reboots. After the controller reboots, it uses the default setting for this feature.

Step 2 If you suspect that a memory leak has occurred, enter this command to configure the controller to perform an auto-leak analysis between two memory thresholds (in kilobytes):
```
config memory monitor leaks low_thresh high_thresh
```
If the free memory is lower than the `low_thresh` threshold, the system crashes, generating a crash file. The default value for this parameter is 10000 kilobytes, and you cannot set it below this value.

Set the `high_thresh` threshold to the current free memory level or higher so that the system enters auto-leak-analysis mode. After the free memory reaches a level lower than the specified `high_thresh` threshold, the process of tracking and freeing memory allocation begins. As a result, the `debug memory events enable` command shows all allocations and frees, and the `show memory monitor detail` command starts to detect any suspected memory leaks. The default value for this parameter is 30000 kilobytes.

Step 3 To see a summary of any discovered memory issues, enter this command:
```
show memory monitor
```
Information similar to the following appears:

```
Memory Leak Monitor Status:
low_threshold(10000), high_threshold(30000), current status(disabled)
```

-------------------------------------------
Memory Error Monitor Status:
Crash-on-error flag currently set to (disabled)
No memory error detected.

**Step 4**
To see the details of any memory leaks or corruption, enter this command:

```
show memory monitor detail
```

Information similar to the following appears:

Memory error detected. Details:
```
------------------------------------------------
- Corruption detected at pmalloc entry address: (0x179a7ec0)
- Corrupt entry: headerMagic(0xdeadf00d), trailer(0xabcd), poison(0xreadceef), entrysize(128), bytes(100), thread(Unknown task name, task id - (332096592)), file(pmalloc.c), line(1736), time(1027)
------------------------------------------------
```

Previous 1K memory dump from error location.
```
(179a7ac0): 00000000 00000000 00000000 ceeff00d readf00d 00000080 00000000 00000000 00000000
(179a7ae0): 17958b20 00000000 1175608c 00000078 00000000 readceef 179a7af0 00000000
(179a7b00): 00000003 00000006 00000001 00000004 00000001 00000009 00000009 0000002d
(179a7b20): 00000001 00000002 00000002 00000001 00000001 00000004 00000000 00000000 5d7b9aba
(179a7b40): cbddfo0d 192f065e 7791acc8 e5032224 5365788c a1b7cee6 00000000 00000000
(179a7b60): 00000000 00000000 00000000 00000000 00000000 00000000 ceeff00d readf00d 00000080
(179a7b80): 00000000 00000000 17958dc0 00000000 1175608c 00000078 00000000 readceef
(179a7ba0): 179a7baf 00000001 00000003 00000006 00000001 00000004 00000001 00000001 00003763
(179a7bc0): 00000002 00000002 00000010 00000001 00000002 00000000 00000000 0000001e 00000013
(179a7be0): 0000001a 00000089 00000000 00000000 00000008 00000000 00000000 17222194
(179a7c00): 17222c4c 17222c4c 00000000 00000000 00000000 00000000 ceceff00d
(179a7c20): readf00d 00000080 00000000 00000000 179a7b78 00000000 1175608c 00000078
```

**Step 5**
If a memory leak occurs, enter this command to enable debugging of errors or events during memory allocation:

```
debug memory {errors | events} {enable | disable}
```

---

**Troubleshooting CCXv5 Client Devices**

**Information About Troubleshooting CCXv5 Client Devices**

The controller supports three features designed to help troubleshoot communication problems with CCXv5 clients: diagnostic channel, client reporting, and roaming and real-time diagnostics.

**Restrictions for CCXv5 Client Devices**

Diagnostic channel, client reporting, and roaming and real-time diagnostics features are supported only on CCXv5 clients. They are not supported for use with non-CCX clients or with clients running an earlier version of CCX.
Configuring Diagnostic Channel

You can choose a diagnostic channel to troubleshoot why the client is having communication problems with a WLAN. You can test the client and access points to identify the difficulties that the client is experiencing and allow corrective measures to be taken to make the client operational on the network. You can use the controller GUI or CLI to enable the diagnostic channel, and you can use the controller CLI to run the diagnostic tests.

We recommend that you enable the diagnostic channel feature only for nonanchored SSIDs that use the management interface. CCX Diagnostic feature has been tested only with clients having Cisco ADU card.

Configuring the Diagnostic Channel (GUI)

Step 1
Choose WLANs to open the WLANs page.

Step 2
Create a new WLAN or click the ID number of an existing WLAN. We recommend that you create a new WLAN on which to run the diagnostic tests.

Step 3
When the WLANs > Edit page appears, choose the Advanced tab to open the WLANs > Edit (Advanced) page.

Figure 108: WLANs > Edit (Advanced) Page

Step 4
If you want to enable diagnostic channel troubleshooting on this WLAN, select the Diagnostic Channel check box. Otherwise, leave this check box unselected, which is the default value. You can use the CLI to initiate diagnostic tests on the client.

Step 5
Click Apply to commit your changes.

Step 6
Click Save Configuration to save your changes.
Configuring the Diagnostic Channel (CLI)

Step 1  To enable diagnostic channel troubleshooting on a particular WLAN, enter this command:
`config wlan diag-channel {enable | disable} wlan_id`

Step 2  To verify that your change has been made, enter this command:
`show wlan wlan_id`

Information similar to the following appears:

```
WLAN Identifier.......................... 1
Profile Name.............................. employee1
Network Name (SSID)........................ employee
Status...................................... Disabled
MAC Filtering.............................. Disabled
Broadcast SSID............................ Enabled
AAA Policy Override...................... Disabled
Number of Active Clients................ 0
Exclusionlist Timeout.................... 60 seconds
Session Timeout......................... Infinity
Interface.................................. virtual
WLAN ACL................................... unconfigured
DHCP Server................................ Default
DHCP Address Assignment Required....... Disabled
Quality of Service......................... Silver (best effort)
WMM......................................... Disabled
CCX - Aironet Ie Support.................. Enabled
CCX - Gratuitous ProbeResponse (GPR)... Disabled
CCX - Diagnostics Channel Capability... Enabled
```

Step 3  To send a request to the client to perform the DHCP test, enter this command:
`config client ccx dhcp-test client_mac_address`

Note  This test does not require the client to use the diagnostic channel.

Step 4  To send a request to the client to perform the default gateway ping test, enter this command:
`config client ccx default-gw-ping client_mac_address`

Note  This test does not require the client to use the diagnostic channel.

Step 5  To send a request to the client to perform the DNS server IP address ping test, enter this command:
`config client ccx dns-ping client_mac_address`

Note  This test does not require the client to use the diagnostic channel.

Step 6  To send a request to the client to perform the DNS name resolution test to the specified host name, enter this command:
`config client ccx dns-resolve client_mac_address host_name`
Note  This test does not require the client to use the diagnostic channel.

**Step 7**  To send a request to the client to perform the association test, enter this command:

```
config client ccx test-association client_mac_address ssid bssid {802.11a | 802.11b | 802.11g} channel
```

**Step 8**  To send a request to the client to perform the 802.1X test, enter this command:

```
config client ccx test-dot1x client_mac_address profile_id bssid {802.11a | 802.11b | 802.11g} channel
```

**Step 9**  To send a request to the client to perform the profile redirect test, enter this command:

```
config client ccx test-profile client_mac_address profile_id
```

The `profile_id` should be from one of the client profiles for which client reporting is enabled.

Note  Users are redirected back to the parent WLAN, not to any other profile. The only profile shown is the user’s parent profile. Note however that parent WLAN profiles can have one child diagnostic WLAN.

**Step 10**  Use these commands if necessary to abort or clear a test:

- To send a request to the client to abort the current test, enter this command:

  ```
  config client ccx test-abort client_mac_address
  ```

  Only one test can be pending at a time, so this command aborts the current pending test.

- To clear the test results on the controller, enter this command:

  ```
  config client ccx clear-results client_mac_address
  ```

**Step 11**  To send a message to the client, enter this command:

```
config client ccx send-message client_mac_address message_id
```

where `message_id` is one of the following:

- 1 = The SSID is invalid.
- 2 = The network settings are invalid.
- 3 = There is a WLAN credibility mismatch.
- 4 = The user credentials are incorrect.
- 5 = Please call support.
- 6 = The problem is resolved.
- 7 = The problem has not been resolved.
- 8 = Please try again later.
- 9 = Please correct the indicated problem.
- 10 = Troubleshooting is refused by the network.
- 11 = Retrieving client reports.
- 12 = Retrieving client logs.
- 13 = Retrieval complete.
- 14 = Beginning association test.
- 15 = Beginning DHCP test.
• 16 = Beginning network connectivity test.
• 17 = Beginning DNS ping test.
• 18 = Beginning name resolution test.
• 19 = Beginning 802.1X authentication test.
• 20 = Redirecting client to a specific profile.
• 21 = Test complete.
• 22 = Test passed.
• 23 = Test failed.
• 24 = Cancel diagnostic channel operation or select a WLAN profile to resume normal operation.
• 25 = Log retrieval refused by the client.
• 26 = Client report retrieval refused by the client.
• 27 = Test request refused by the client.
• 28 = Invalid network (IP) setting.
• 29 = There is a known outage or problem with the network.
• 30 = Scheduled maintenance period.
• 31 = The WLAN security method is not correct.
• 32 = The WLAN encryption method is not correct.
• 33 = The WLAN authentication method is not correct.

Step 12  To see the status of the last test, enter this command:
\texttt{show client cxx last-test-status client\_mac\_address}
Information similar to the following appears for the default gateway ping test:

\begin{verbatim}
Test Type........................................ Gateway Ping Test
Test Status...................................... Pending/Success/Timeout
Dialog Token..................................... 15
Timeout.......................................... 15000 ms
Request Time................................. 1329 seconds since system boot
\end{verbatim}

Step 13  To see the status of the last test response, enter this command:
\texttt{show client cxx last-response-status client\_mac\_address}
Information similar to the following appears for the 802.1X authentication test:

\begin{verbatim}
Test Status................................. Success
Response Dialog Token....................... 87
Response Status............................. Successful
Response Test Type.......................... 802.1x Authentication Test
Response Time.............................. 3476 seconds since system boot
\end{verbatim}

Step 14  To see the results from the last successful diagnostics test, enter this command:
\texttt{show client cxx results client\_mac\_address}
Information similar to the following appears for the 802.1X authentication test:
To see the relevant data frames captured by the client during the previous test, enter this command:

```
show client ccx frame-data client_mac_address
```

Information similar to the following appears:

```
LOG Frames:
Frame Number: 1
Last Frame Number: 1120
Direction: 1
Timestamp: 0d 00h 50m 39s 863954us
Frame Length: 197
Frame Data:
00000000: 80 00 00 00 ff ff ff ff ff ff ff 00 12 44 bd bd b0 ............D...
00000010: 00 12 44 bd bd b0 f0 af 43 70 00 f2 82 01 00 00 .D...Cp....
00000020: 64 00 11 08 00 01 00 01 08 8c 12 98 24 b0 48 60 d. ..........H
00000030: 00000000: 80 05 04 01 02 00 00 85 1e 00 00 89 00 0f 00 ff l. ..........l
00000040: 03 19 00 41 50 32 33 32 3d 31 30 00 00 00 00 00 00 .AP23=10....
00000050: 00 00 00 00 00 00 2f 96 06 00 40 96 00 ff ff dd ....../...
00000060: 18 00 50 f2 01 01 00 00 50 f2 05 01 00 00 50 f2 .P...P...P.
00000070: 05 01 00 00 40 96 00 28 00 0d 06 00 40 96 01 01 .0...0...
00000080: 00 dd 05 00 40 96 03 04 dd 16 00 40 96 04 00 02 .0...0...
00000090: 07 a4 00 00 23 a4 00 00 42 43 70 a5 f7 78 08 00 00 ...BC..P...
000000a0: dd 06 00 11 08 00 01 00 01 08 8c 12 98 24 b0 48 60 d. ..........H
000000b0: 00 00 00 00 00 00 27 a4 00 00 00 00 00 00 00 00 42 43 5e 00 62 32 2f ....'..BC'.b2/

LOG Frames:
Frame Number: 2
Last Frame Number: 1120
Direction: 1
Timestamp: 0d 00h 50m 39s 878289us
Frame Length: 147
Frame Data:
00000000: 80 00 00 00 ff ff ff ff ff ff ff 00 12 44 bd 80 30 ............D..0
00000010: 00 12 44 bd 80 30 60 f7 46 c0 8b 4b d1 05 00 00 .D..0'.F.K...
00000020: 64 00 11 08 00 01 00 01 08 8c 12 98 24 b0 48 60 d. ..........H
00000030: 00000000: 6c 05 04 01 02 00 00 85 1e 00 00 89 00 0f 00 ff l. ..........l
00000040: 03 19 00 41 50 32 33 32 3d 31 37 00 00 00 00 00 00 .AP23-7....
00000050: 00 00 00 00 00 00 26 96 06 00 40 96 00 ff ff dd ....../...
00000060: 18 00 50 f2 01 01 00 00 50 f2 05 01 00 00 50 f2 .P...P...P.
00000070: 05 01 00 00 40 96 00 28 00 0d 06 00 40 96 01 01 .0...0...
00000080: 00 dd 05 00 40 96 03 04 dd 16 00 40 96 04 00 02 .0...0...
00000090: 07 a4 00 00 23 a4 00 00 42 43 70 a5 f7 78 08 00 00 ...BC..P...
000000a0: dd 06 00 11 08 00 01 00 01 08 8c 12 98 24 b0 48 60 d. ..........H
000000b0: 00 00 00 00 00 00 27 a4 00 00 00 00 00 00 00 00 42 43 5e 00 62 32 2f ....'..BC'.b2/.

LOG Frames:
Frame Number: 3
Last Frame Number: 1120
Direction: 1
Timestamp: 0d 00h 50m 39s 881513us
Frame Length: 189
Frame Data:
00000000: 80 00 00 00 ff ff ff ff ff ff ff 00 12 44 bd 80 30 ............D..0
00000010: 00 12 44 bd 80 30 60 f7 46 c0 8b 4b d1 05 00 00 .D..0'.F.K...
00000020: 64 00 11 08 00 01 00 01 08 8c 12 98 24 b0 48 60 d. ..........H
00000030: 00000000: 6c 05 04 01 02 00 00 85 1e 00 00 89 00 0f 00 ff l. ..........l
00000040: 03 19 00 41 50 32 33 32 3d 31 37 00 00 00 00 00 00 .AP23-7....
00000050: 00 00 00 00 00 00 26 96 06 00 40 96 00 ff ff dd ....../...
00000060: 18 00 50 f2 01 01 00 00 50 f2 05 01 00 00 50 f2 .P...P...P.
00000070: 05 01 00 00 40 96 00 28 00 0d 06 00 40 96 01 01 .0...0...
00000080: 00 dd 05 00 40 96 03 04 dd 16 00 40 96 04 00 02 .0...0...
00000090: 07 a4 00 00 23 a4 00 00 42 43 70 a5 f7 78 08 00 00 ...BC..P...
000000a0: dd 06 00 11 08 00 01 00 01 08 8c 12 98 24 b0 48 60 d. ..........H
000000b0: 00 00 00 00 00 00 27 a4 00 00 00 00 00 00 00 00 42 43 5e 00 62 32 2f ....'..BC'.b2/.
Configuring Client Reporting

The client reporting protocol is used by the client and the access point to exchange client information. Client reports are collected automatically when the client associates. You can use the controller GUI or CLI to send a client report request to any CCXv5 client any time after the client associates. There are four types of client reports:

- **Client profile**—Provides information about the configuration of the client.
- **Operating parameters**—Provides the details of the client’s current operational modes.
- **Manufacturers’ information**—Provides data about the wireless LAN client adapter in use.
- **Client capabilities**—Provides information about the client’s capabilities.

Configuring Client Reporting (GUI)

**Step 1** Choose **Monitor > Clients** to open the Clients page.

**Step 2** Click the MAC address of the desired client. The **Clients > Detail** page appears.

**Step 3** To send a report request to the client, click **Send CCXV5 Req**.

**Note** You must create a Trusted Profile using ACAU for Cisco CB21AG or equivalent software from your CCXv5 vendor.

**Step 4** To view the parameters from the client, click **Display**. The Client Reporting page appears.

**Step 5** Click the link for the desired client profile. The Profile Details page appears displaying the client profile details, including the SSID, power save mode, radio channel, data rates, and 802.11 security settings.

Configuring Client Reporting (CLI)

**Step 1** To send a request to the client to send its profiles, enter this command:

```
config client ccx get-profiles client_mac_address
```

**Step 2** To send a request to the client to send its current operating parameters, enter this command:

```
config client ccx get-operating-parameters client_mac_address
```

**Step 3** To send a request to the client to send the manufacturer’s information, enter this command:
config client ccx get-manufacturer-info client_mac_address

Step 4  To send a request to the client to send its capability information, enter this command:
config client ccx get-client-capability client_mac_address

Step 5  To clear the client reporting information, enter this command:
config client ccx clear-reports client_mac_address

Step 6  To see the client profiles, enter this command:
show client ccx profiles client_mac_address

Step 7  To see the client operating parameters, enter this command:
show client ccx operating-parameters client_mac_address

Step 8  To see the client manufacturer information, enter this command:
show client ccx manufacturer-info client_mac_address

Step 9  To see the client’s capability information, enter this command:
show client ccx client-capability client_mac_address

Note  This command displays the client’s available capabilities, not current settings for the capabilities.

---

### Configuring Roaming and Real-Time Diagnostics

You can use roaming and real-time logs and statistics to solve system problems. The event log enables you to identify and track the behavior of a client device. It is especially useful when attempting to diagnose difficulties that a user may be having on a WLAN. The event log provides a log of events and reports them to the access point. There are three categories of event logs:

- **Roaming log**—This log provides a historical view of the roaming events for a given client. The client maintains a minimum of five previous roaming events including failed attempts and successful roams.

- **Robust Security Network Association (RSNA) log**—This log provides a historical view of the authentication events for a given client. The client maintains a minimum of five previous authentication attempts including failed attempts and successful ones.

- **Syslog**—This log provides internal system information from the client. For example, it may indicate problems with 802.11 operation, system operation, and so on.

The statistics report provides 802.1X and security information for the client. You can use the controller CLI to send the event log and statistics request to any CCXv5 client any time after the client associates.

---

### Configuring Roaming and Real-Time Diagnostics (CLI)

Step 1  To send a log request, enter this command:
config client ccx log-request log_type client_mac_address

where log_type is roam, rsna, or syslog.
Step 2

To view a log response, enter this command:

```
show client ccx log-response log_type client_mac_address
```

where `log_type` is roam, rsna, or syslog.

Information similar to the following appears for a log response with a `log_type` of roam:

```
Tue Jun 26 18:28:48 2007 Roaming Response LogID=133: Status=Successful
  Event Timestamp=0d 00h 00m 13s 322396us
  Source BSSID=00:0b:85:81:06:c2, Target BSSID=00:0b:85:81:06:c2, Transition
  Time=3125(ms)
  Transition Reason: Normal roam, poor link
  Transition Result: Success
```

```
Tue Jun 26 18:28:48 2007 Roaming Response LogID=133: Status=Successful
  Event Timestamp=0d 00h 00m 16s 599006us
  Source BSSID=00:0b:85:81:06:c2, Target BSSID=00:0b:85:81:06:c2, Transition
  Time=3235(ms)
  Transition Reason: Normal roam, poor link
  Transition Result: Success
```

```
Tue Jun 26 18:28:48 2007 Roaming Response LogID=133: Status=Successful
  Event Timestamp=0d 00h 00m 19s 882921us
  Source BSSID=00:0b:85:81:06:c2, Target BSSID=00:0b:85:81:06:c2, Transition
  Time=3234(ms)
  Transition Reason: Normal roam, poor link
  Transition Result: Success
```

```
Tue Jun 26 18:28:48 2007 Roaming Response LogID=133: Status=Successful
  Event Timestamp=0d 00h 00m 08s 815477us
  Source BSSID=00:0b:85:81:06:d2, Target BSSID=00:0b:85:81:06:d2, Transition
  Time=3281(ms)
  Transition Reason: First association to WLAN
  Transition Result: Success
```

Information similar to the following appears for a log response with a `log_type` of rsna:

```
Tue Jun 26 18:24:09 2007 RSNA Response LogID=132: Status=Successful
  Event Timestamp=0d 00h 00m 00s 246578us
  Target BSSID=00:14:1b:58:86:cd
  RSNA Version=1
  Group Cipher Suite=00-0f-ac-02
  Pairwise Cipher Suite Count = 1
    Pairwise Cipher Suite 0 = 00-0f-ac-04
  AKM Suite Count = 1
    AKM Suite 0 = 00-0f-ac-01
  RSN Capability = 0x0
  RSNA Result: Success
```

```
Tue Jun 26 18:24:09 2007 RSNA Response LogID=132: Status=Successful
  Event Timestamp=0d 00h 00m 00s 246625us
  Target BSSID=00:14:1b:58:86:cd
  RSNA Version=1
  Group Cipher Suite=00-0f-ac-02
  Pairwise Cipher Suite Count = 1
    Pairwise Cipher Suite 0 = 00-0f-ac-04
  AKM Suite Count = 1
    AKM Suite 0 = 00-0f-ac-01
  RSN Capability = 0x0
  RSNA Result: Success
```
AKM Suite Count = 1
AKM Suite 0 = 00-0f-ac-01
RSN Capability = 0x0
RSNA Result: Success

Tue Jun 26 18:24:09 2007 RSNA Response LogID=132: Status=Successful
Event Timestamp=0d 00h 00m 01s 624375us
Target BSSID=00:14:1b:58:86:cd
RSNA Version=1
Group Cipher Suite=00-0f-ac-02
Pairwise Cipher Suite Count = 1
Pairwise Cipher Suite 0 = 00-0f-ac-04
AKM Suite Count = 1
AKM Suite 0 = 00-0f-ac-01
RSN Capability = 0x0
RSNA Result: Success

Information similar to the following appears for a log response with a log_type of syslog:

Event Timestamp=0d 00h 19m 42s 278996us
Client SysLog = '<11> Jun 19 11:49:53 uraval3777 Mandatory elements missing in the OID response'

Step 3
To send a request for statistics, enter this command:
```
cfg client ccx stats-request measurement_duration stats_name client_mac_address
```
where stats_name is dot11 or security.

Step 4
To view the statistics response, enter this command:
```
show client ccx stats-report client_mac_address
```
Information similar to the following appears:

Measurement duration = 1

dot11TransmittedFragmentCount = 1
dot11MulticastTransmittedFrameCount = 2
dot11FailedCount = 3
dot11RetryCount = 4
dot11MultipleRetryCount = 5
dot11FrameDuplicateCount = 6
dot11RTSSuccessCount = 7
dot11RTSFailureCount = 8
dot11ACKFailureCount = 9
dot11ReceivedFragmentCount = 10
dot11MulticastReceivedFrameCount = 11
dot11FCSErrorCount = 12
dot11TransmittedFrameCount = 13

Using the Debug Facility

Information About Using the Debug Facility

The debug facility enables you to display all packets going to and from the controller CPU. You can enable it for received packets, transmitted packets, or both. By default, all packets received by the debug facility are displayed. However, you can define access control lists (ACLs) to filter packets before they are displayed. Packets not passing the ACLs are discarded without being displayed.

Each ACL includes an action (permit, deny, or disable) and one or more fields that can be used to match the packet. The debug facility provides ACLs that operate at the following levels and on the following values:

- Driver ACL
  - NPU encapsulation type
  - Port
- Ethernet header ACL
  - Destination address
  - Source address
  - Ethernet type
  - VLAN ID
- IP header ACL
  - Source address
At each level, you can define multiple ACLs. The first ACL that matches the packet is the one that is selected.
Configuring the Debug Facility (CLI)

Step 1  To enable the debug facility, enter this command:

• debug packet logging enable {rx | tx | all} packet_count display_size

where

◦ rx displays all received packets, tx displays all transmitted packets, and all displays both transmitted and received packets.

◦ packet_count is the maximum number of packets to log. You can enter a value between 1 and 65535 packets, and the default value is 25 packets.

◦ display_size is the number of bytes to display when printing a packet. By default, the entire packet is displayed.

Note  To disable the debug facility, enter this command: debug packet logging disable.

• debug packet logging acl driver rule_index action npu_encap port

where

◦ rule_index is a value between 1 and 6 (inclusive).

◦ action is permit, deny, or disable.

◦ npu_encap specifies the NPU encapsulation type, which determines how packets are filtered. The possible values include dhcp, dot11-mgmt, dot11-probe, dot1x, eoip-ping, iapp, ip, lwapp, multicast, orphan-from-sta, orphan-to-sta, rbcp, wired-guest, or any.

◦ port is the physical port for packet transmission or reception.

• Use these commands to configure packet-logging ACLs:

d debug packet logging acl eth rule_index action dst src type vlan

where

◦ rule_index is a value between 1 and 6 (inclusive).

◦ action is permit, deny, or disable.

◦ dst is the destination MAC address.

◦ src is the source MAC address.

◦ type is the two-byte type code (such as 0x800 for IP, 0x806 for ARP). This parameter also accepts a few common string values such as "ip" (for 0x800) or "arp" (for 0x806).

◦ vlan is the two-byte VLAN ID.

• debug packet logging acl ip rule_index action src dst proto src_port dst_port

where
* `proto` is a numeric or any string recognized by `getprotobyname()`. The controller supports the following strings: `ip, icmp, igmp, ggp, ipencap, st, tcp, egp, pwp, udp, hmp, xns-idp, rdp, iso-tp4, xtp, ddp, idpr-ccmp, rsvp, vmp, ospf, ipip, and enccap`.

* `src_port` is the UDP/TCP two-byte source port (for example, telnet, 23) or "any." The controller accepts a numeric or any string recognized by `getservbyname()`. The controller supports the following strings: `tcpmux, echo, discard, systat, daytime, netstat, qotd, msp, chargen, ftp-data, ftp, ftp, ssh, telnet, smtp, time, rlp, nameserver, whois, re-mail-cp, domain, mtp, bootps, bootpc, rftp, gopher, rje, finger, www, link, kerberos, supdup, hostnames, iso-tsap, cnet-ns, 3com-tsmux, rtelnet, pop-2, pop-3, sunrpc, auth, sftp, uucp-path, nntp, ntp, netbios-ns, netbios-dgm, netbios-ssn, imap2, snmp, snmp-trap, cmip-man, cmip-agent, xdmcp, nextstep, bgp, prospero, irc, smux, at-rtmp, at-ntp, at-echo, at-zis, qmtp, z3950, ipx, imap3, ulistserv, https, snpp, saft, nmp-local, nmp-gui, and hmmp-ind`.

* `dst_port` is the UDP/TCP two-byte destination port (for example, telnet, 23) or "any." The controller accepts a numeric or any string recognized by `getservbyname()`. The controller supports the same strings as those for the `src_port`.

- `debug packet logging acl eoip-eth rule_index action dst src type vlan`
- `debug packet logging acl eoip-ip rule_index action src dst proto src_port dst_port`
- `debug packet logging acl lwapp-dot11 rule_index action dst src bssid snap_type`

where

  - `bssid` is the Basic Service Set Identifier.
  - `snap_type` is the Ethernet type.

- `debug packet logging acl lwapp-ip rule_index action src dst proto src_port dst_port`

  **Note** To remove all configured ACLs, enter this command: `debug packet logging acl clear-all`.

**Step 2**

To configure the format of the debug output, enter this command:

```
debug packet logging format {hex2pcap | text2pcap}
```

The debug facility supports two output formats: `hex2pcap` and `text2pcap`. The standard format used by IOS supports the use of `hex2pcap` and can be decoded using an HTML front end. The `text2pcap` option is provided as an alternative so that a sequence of packets can be decoded from the same console log file.
This figure shows an example of hex2pcap output.

**Figure 109: Sample Hex2pcap Output**

```
0000 00 03 01 20 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88 89 90 91 92 93 94 95 96 97 98 99 A0 A1 A2 A3 A4 A5 A6 A7 A8 A9 AA AB AC AD AE AF B0 B1 B2 B3 B4 B5 B6 B7 B8 B9 BA BB BC BD BE BF C0 C1 C2 C3 C4 C5 C6 C7 C8 C9 CA CB CC CD CE CF D0 D1 D2 D3 D4 D5 D6 D7 D8 D9 DA DB DC DD DE DF E0 E1 E2 E3 E4 E5 E6 E7 E8 E9 EA EB EC ED EE EF F0 F1 F2 F3 F4 F5 F6 F7 F8 F9 FA FB FC FD FE FF
```

This figure shows an example of text2pcap output.

**Figure 110: Sample Text2pcap Output**

```
0000 00 03 01 20 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88 89 90 91 92 93 94 95 96 97 98 99 A0 A1 A2 A3 A4 A5 A6 A7 A8 A9 AA AB AC AD AE AF B0 B1 B2 B3 B4 B5 B6 B7 B8 B9 BA BB BC BD BE BF C0 C1 C2 C3 C4 C5 C6 C7 C8 C9 CA CB CC CD CE CF D0 D1 D2 D3 D4 D5 D6 D7 D8 D9 DA DB DC DD DE EE EF F0 F1 F2 F3 F4 F5 F6 F7 F8 F9 FA FB FC FD FE FF
```

**Step 3**

To determine why packets might not be displayed, enter this command:

```
debug packet error {enable | disable}
```

**Step 4**

To display the status of packet debugging, enter this command:

```
show debug packet
```

Information similar to the following appears:

```
Status................................. disabled
Number of packets to display........... 25
Bytes/packet to display................ 0
Packet display format.................. text2pcap
```
Driver ACL:
[1]: disabled
[2]: disabled
[3]: disabled
[4]: disabled
[5]: disabled
[6]: disabled
Ethernet ACL:
[1]: disabled
[2]: disabled
[3]: disabled
[4]: disabled
[5]: disabled
[6]: disabled
IP ACL:
[1]: disabled
[2]: disabled
[3]: disabled
[4]: disabled
[5]: disabled
[6]: disabled
EoIP-Ethernet ACL:
[1]: disabled
[2]: disabled
[3]: disabled
[4]: disabled
[5]: disabled
[6]: disabled
EoIP-IP ACL:
[1]: disabled
[2]: disabled
[3]: disabled
[4]: disabled
[5]: disabled
[6]: disabled
LWAPP-Dot11 ACL:
[1]: disabled
[2]: disabled
[3]: disabled
[4]: disabled
[5]: disabled
[6]: disabled
LWAPP-IP ACL:
[1]: disabled
[2]: disabled
[3]: disabled
[4]: disabled
[5]: disabled
[6]: disabled?

Configuring Wireless Sniffing

Information About Wireless Sniffing

The controller enables you to configure an access point as a network “sniffer,” which captures and forwards all the packets on a particular channel to a remote machine that runs packet analyzer software. These packets contain information on time stamps, signal strength, packet sizes, and so on. Sniffers allow you to monitor and record network activity and to detect problems.
Restrictions for Wireless Sniffing

- Supported third-party network analyzer software applications are as follows:
  - Wildpackets Omnipipek or Airopeek
  - AirMagnet Enterprise Analyzer
  - Wireshark

- The latest version of Wireshark can decode the packets by going to the Analyze mode. Select decode as, and switch UDP5555 to decode as AIROPEEK.

- You must disable IP-MAC address binding in order to use an access point in sniffer mode if the access point is joined to a Cisco 5500 Series Controller. To disable IP-MAC address binding, enter the config network ip-mac-binding disable command in the controller CLI.

- You must enable WLAN 1 in order to use an access point in sniffer mode if the access point is joined to a Cisco 5500 Series Controller. If WLAN 1 is disabled, the access point cannot send packets.

Configuring Sniffing on an Access Point (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Wireless &gt; Access Points &gt; All APs to open the All APs page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the name of the access point that you want to configure as the sniffer. The All APs &gt; Details for page appears.</td>
</tr>
<tr>
<td>Step 3</td>
<td>From the AP Mode drop-down list, choose Sniffer.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click Apply.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click OK when prompted that the access point will be rebooted.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Choose Wireless &gt; Access Points &gt; Radios &gt; 802.11a/n (or 802.11b/g/n) to open the 802.11a/n (or 802.11b/g/n) Radios page.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Hover your cursor over the blue drop-down arrow for the desired access point and choose Configure. The 802.11a/n (or 802.11b/g/n) Cisco APs &gt; Configure page appears.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Select the Sniff check box to enable sniffing on this access point, or leave it unselected to disable sniffing. The default value is unchecked.</td>
</tr>
<tr>
<td>Step 9</td>
<td>If you enabled sniffing in Step 8, follow these steps:</td>
</tr>
<tr>
<td></td>
<td>a) From the Channel drop-down list, choose the channel on which the access point sniffs for packets.</td>
</tr>
<tr>
<td></td>
<td>b) In the Server IP Address text box, enter the IP address of the remote machine running Omnipipek, Airopeek, AirMagnet, or Wireshark.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Click Apply.</td>
</tr>
<tr>
<td>Step 11</td>
<td>Click Save Configuration.</td>
</tr>
</tbody>
</table>
Configuring Sniffing on an Access Point (CLI)

**Step 1** Configure the access point as a sniffer by entering this command:
```plaintext
config ap mode sniffer Cisco_AP
```
where `Cisco_AP` is the access point configured as the sniffer.

**Step 2** When warned that the access point will be rebooted and asked if you want to continue, enter `Y`. The access point reboots in sniffer mode.

**Step 3** Enable sniffing on the access point by entering this command:
```plaintext
config ap sniff {802.11a | 802.11b} enable channel server_IP_address Cisco_AP
```
where
- `channel` is the radio channel on which the access point sniffs for packets. The default values are 36 (802.11a/n) and 1 (802.11b/g/n).
- `server_IP_address` is the IP address of the remote machine running Omnippeek, Airopeek, AirMagnet, or Wireshark.
- `Cisco_AP` is the access point configured as the sniffer.

**Note** To disable sniffing on the access point, enter the `config ap sniff {802.11a | 802.11b} disable Cisco_AP` command.

**Step 4** Save your changes by entering this command:
```plaintext
save config
```

**Step 5** See the sniffer configuration settings for an access point by entering this command:
```plaintext
show ap config {802.11a | 802.11b} Cisco_AP
```

Troubleshooting Access Points Using Telnet or SSH

The controller supports the use of the Telnet and Secure Shell (SSH) protocols to troubleshoot lightweight access points. Using these protocols makes debugging easier, especially when the access point is unable to connect to the controller.

- To avoid potential conflicts and security threats to the network, the following commands are unavailable while a Telnet or SSH session is enabled: `config terminal, telnet, ssh, rsh, ping, traceroute, clear, clock, crypto, delete, fsck, lwapp, mkdir, radius, release, reload, rename, renew, rmdir, save, set, test, upgrade`.

- Commands available during a Telnet or SSH session include `debug, disable, enable, help, led, login, logout, more, no debug, show, systat, undo` and `where`.

**Note** For instructions on configuring Telnet or SSH SSH sessions on the controller, see the Telnet and Secure Shell Sessions section.
Guidelines and Limitations

You can configure Telnet or SSH by using the controller CLI in software release 5.0 or later releases or using the controller GUI in software release 6.0 or later releases.

Troubleshooting Access Points Using Telnet or SSH (GUI)

Step 1  Choose Wireless > Access Points > All APs to open the All APs page.
Step 2  Click the name of the access point for which you want to enable Telnet or SSH.
Step 3  Choose the Advanced tab to open the All APs > Details for (Advanced) page.
Step 4  Select the Telnet check box to enable Telnet connectivity on this access point. The default value is unchecked.
Step 5  Select the SSH check box to enable SSH connectivity on this access point. The default value is unchecked.
Step 6  Click Apply.
Step 7  Click Save Configuration.

Troubleshooting Access Points Using Telnet or SSH (CLI)

Step 1  Enable Telnet or SSH connectivity on an access point by entering this command:
```
cfg ap {telnet | ssh} enable Cisco_AP
```
The default value is disabled.

Note  Disable Telnet or SSH connectivity on an access point by entering this command:
```
cfg ap {telnet | ssh} disable Cisco_AP
```

Step 2  Save your changes by entering this command:
```
save config
```

Step 3  See whether Telnet or SSH is enabled on an access point by entering this command:
```
show ap config general Cisco_AP
```
Information similar to the following appears:

```
Cisco AP Identifier.............................. 5
Cisco AP Name...................................... AF33
Country code...................................... Multiple Countries:US,AE,AR,AT,AU,BH
Reg. Domain allowed by Country............... 802.11bg:-ABCENR 802.11a:-ABCEN
AP Country code...................................... US - United States
AP Regulatory Domain............................ 802.11bg:-A 802.11a:-A
Switch Port Number.............................. 2
MAC Address...................................... 00:19:2f:11:16:7a
IP Address Configuration....................... Static IP assigned
```

Debugging the Access Point Monitor Service

Information About Debugging the Access Point Monitor Service

The controller sends access point status information to the Cisco 3300 Series Mobility Services Engine (MSE) using the access point monitor service.

The MSE sends a service subscription and an access point monitor service request to get the status of all access points currently known to the controller. When any change is made in the status of an access point, a notification is sent to the MSE.

Debugging Access Point Monitor Service Issues (CLI)

If you experience any problems with the access point monitor service, enter this command:

debag service ap-monitor {all | error | event | nmsp | packet} {enable | disable}

where

- **all** configures debugging of all access point status messages.
- **error** configures debugging of access point monitor error events.
- **event** configures debugging of access point monitor events.
- **nmsp** configures debugging of access point monitor NMSP events.
- **packet** configures debugging of access point monitor packets.
- **enable** enables the debug service ap-monitor mode.
- **disable** disables the debug service ap-monitor mode.
Troubleshooting OfficeExtend Access Points

Information About Troubleshooting OfficeExtend Access Points

This section provides troubleshooting information if you experience any problems with your OfficeExtend access points.

Interpreting OfficeExtend LEDs


Positioning OfficeExtend Access Points for Optimal RF Coverage

When positioning your OfficeExtend access point, consider that its RF signals are emitted in a cone shape spreading outward from the LED side of the access point. Ensure to mount the access point so that air can flow behind the metal back plate and prevent the access point from overheating.

Figure 111: OfficeExtend Access Point Radiation Patterns

Troubleshooting Common Problems

Most of the problems experienced with OfficeExtend access points are one of the following:

- The access point cannot join the controller because of network or firewall issues.
  **Resolution:** Follow the instructions in the Viewing Access Point Join Information section to see join statistics for the OfficeExtend access point, or find the access point's public IP address and perform pings of different packet sizes from inside the company.

- The access point joins but keeps dropping off. This behavior usually occurs because of network problems or when the network address translation (NAT) or firewall ports close because of short timeouts.
  **Resolution:** Ask the teleworker for the LED status.

- Clients cannot associate because of NAT issues.
Resolution: Ask the teleworker to perform a speed test and a ping test. Some servers do not return big packet pings.

• Clients keep dropping data. This behavior usually occurs because the home router closes the port because of short timeouts.

Resolution: Perform client troubleshooting in Cisco Prime Infrastructure to determine if the problem is related to the OfficeExtend access point or the client.

• The access point is not broadcasting the enterprise WLAN.

Resolution: Ask the teleworker to check the cables, power supply, and LED status. If you still cannot identify the problem, ask the teleworker to try the following:

  ◦ Connect to the home router directly and see if the PC is able to connect to an Internet website such as http://www.cisco.com/. If the PC cannot connect to the Internet, check the router or modem. If the PC can connect to the Internet, check the home router configuration to see if a firewall or MAC-based filter is enabled that is blocking the access point from reaching the Internet.

  ◦ Log on to the home router and check to see if the access point has obtained an IP address. If it has, the access point’s LED normally blinks orange.

• The access point cannot join the controller, and you cannot identify the problem.

Resolution: A problem could exist with the home router. Ask the teleworker to check the router manual and try the following:

  ◦ Assign the access point a static IP address based on the access point’s MAC address.

  ◦ Put the access point in a demilitarized zone (DMZ), which is a small network inserted as a neutral zone between a company’s private network and the outside public network. It prevents outside users from getting direct access to a server that has company data.

  ◦ If problems still occur, contact your company’s IT department for assistance.

• The teleworker experiences problems while configuring a personal SSID on the access point.

Resolution: Clear the access point configuration and return it to factory default settings by clicking Clear Config on the access point GUI or by entering the `clear ap config Cisco_AP` command and then configuring a personal SSID on an OfficeExtend Access Point. If problems still occur, contact your company’s IT department for assistance.

• The home network needs to be rebooted.

Resolution: Ask the teleworker to follow these steps:

  Leave all devices networked and connected, and then power down all the devices.

  Turn on the cable or DSL modem, and then wait for 2 minutes. (Check the LED status.)

  Turn on the home router, and then wait for 2 minutes. (Check the LED status.)

  Turn on the access point, and then wait for 5 minutes. (Check the LED status.)

  Turn on the client.
INDEX

11n Mode parameter 111
1250 series access points 511, 512, 513
    and PoE Status field 513
    operating modes when using PoE 511
    transmit power settings when using PoE 512
7920 AP CAC parameter 365
7920 Client CAC parameter 365
7920 support mode 364
    configuring 364
    described 364
7921 support mode 364
802.11a (or 802.11b) > Client Roaming page 142
802.11a (or 802.11b) > Voice Parameters page 155, 158, 165
802.11a (or 802.11b/g) > EDCA Parameters page 168
802.11a (or 802.11b/g) Global Parameters page 107, 746
802.11a (or 802.11b/g) Network Status parameter 107, 114
802.11a/n (4.9 GHz) > Configure page 642
802.11a/n (or 802.11b/g/n) Radios page 160, 737
802.11a/n Radios page (from Monitor Menu) 422
802.11g Support parameter 107
802.11h Global Parameters page 114
802.11h, described 114
802.11n 110, 517
    clients 517
    devices 110
802.1Q VLAN trunk port 51
802.1X 339, 346
    dynamic key settings 339
    configuring 339
    described 346
802.1X authentication for access points 426, 428, 429
    configuring 428, 429
    the switch 429
    using the CLI 428, 429
    described 426
802.1x Authentication parameter 427
802.3 bridging 131, 132
    configuring using the CLI 132
    configuring using the GUI 131, 132
802.3 Bridging parameter 132
802.3 frames 132
802.3X flow control, enabling 131

A

Access Control List Name parameter 252
access control lists (ACLs) 251, 252, 256, 257, 791, 885
    applying to the controller CPU 257
    using the CLI 257
    configuring 256
    using the CLI 256
    counters 252, 256
    configuring using the CLI 256
    configuring using the GUI 252
    rules 251, 256, 791
    using with the debug facility 885
Access Control Lists > Edit page 254, 793
Access Control Lists > New page 252
Access Control Lists page 252
Access Mode parameter 122, 124
access point 601
    assisted roaming, described 601
    access point core dumps, uploading 447
    using the GUI 447
    access point count, approved tiers for 5500 series controllers 89
    access point event logs, viewing 865
    access point groups 383, 384, 385
    assigning access points to 384
    using the CLI 384
    using the GUI 384
    creating 384, 385
    using the CLI 384, 385
    removing 383, 384
    using the CLI 384
    using the GUI 383
    viewing 385
access point monitor service, debugging 894
access point radios, searching for 422, 423
access points 140, 415, 416, 429, 432, 434, 437, 443, 452, 516, 852
    assisted roaming 140
    authorization list 437
    authorizing 432, 434
    using LSCs 434
    using MICs 434
    using SSCs 432
access points (continued)
embedded 429
LEDs 516, 852
configuring 516
interpreting 852
priming 415
supporting oversized images 452
verifying that they join the controller 416
viewing join information 443
using the GUI 443
Accounting Server parameters 394
ACL Name parameter 254
ACL. See access control lists (ACLs) 250, 790
Action parameter 254, 733
active exploits 317
Add AAA Client page (on CiscoSecure ACS) 201, 216
Add AP button 797
Add New Rule button 252
Admin Status parameter 70, 71
administrator access 118
Admission Control (ACM) parameter 155
AES-CCMP 346
Aggregated MAC Service Data Unit (A-MSDU) 112
aggregation method, specifying 112
AirMagnet Enterprise Analyzer 891
Aironet IE parameter 379
Airopeek 891
All APs > Access Point Name > Link Details > Neighbor Name page 636
All APs > Access Point Name > Mesh Neighbor Stats page 636
All APs > Access Point Name > Neighbor Info page 634
All APs > Access Point Name > Statistics page 629
All APs > Access Point Name > VLAN Mappings page 786
All APs > Details for (Advanced) page 413, 448, 508
configuring link latency 508
All APs > Details for (Credentials) page 425, 427
All APs > Details for (FlexConnect) page 785
All APs > Details for (General) page 785
All APs > Details for (High Availability) page 478, 489
All APs > Details page 542, 588
All APs page 417, 628, 634, 743
AnchorTime parameter 575, 721
Anonymous Provision parameter 236
Antenna Gain parameter 738
Antenna parameter 738
Antenna Type parameter 738
AP > Clients > Traffic Stream Metrics page 160
AP Authentication Policy page 259
AP Core Dump parameter 448
AP Ethernet MAC Addresses parameter 435
AP Failover Priority parameter 489
AP Group Name parameter 383
AP Groups > Edit (APs) page 384
AP Groups page 383, 397
AP local authentication 789
Using GUI 789
AP Local Authentication on a WLAN 789
Using the CLI 789
AP Mode parameter 464, 743, 785, 891
AP Name parameter 384
AP Primary Discovery Timeout parameter 477, 545
ap-count evaluation licenses, activating 97, 98
using the CLI 97, 98
using the GUI 97
AP-manager interface 58, 68
and dynamic interfaces 68
described 58
AP801 access point 429, 430
described 429
using with a controller 430
Applying ACLs to a WLAN 255
Applying ACLs to the controller CPU 254
Assignment Method parameter 738
authenticated local authentication bind method 228, 230
Authority ID Information parameter 236, 798, 800
Authority ID parameter 236, 798
Authorize LSC APs against auth-list parameter 437
Authorize MIC APs against auth-list or AAA parameter 437
auto-anchor mobility 821, 823
configuring 823
using the GUI 823
overview 821
AutoInstall 33, 34, 35, 36, 37
described 33, 37
example operation 36
obtaining 34
DHCP addresses for interfaces 34
TFTP server information 34
selecting configuration file 35
using 33
Average Data Rate parameter 146, 150, 362
Average Real-Time Rate parameter 146, 150, 362
Avoid Cisco AP Load parameter 575, 721
Avoid Foreign AP Interference parameter 575, 721, 820
Avoid Non-802.11a (802.11b) Noise parameter 575, 721

B
Back-up Primary Controller Name field 477, 545
Back-up Secondary Controller Name parameter 478, 545
Backhaul Client Access parameter 553, 642
backup controllers 476, 544, 546
configuring 546
using the GUI 546
described 476, 544
bandwidth-based CAC  152, 155, 157, 604
  described  152
  enabling  155, 157
    using the CLI  157
    using the GUI  155
  for mesh networks  604
  Beacon Period parameter  107
  Bind Username parameter  228
  browsers supported  24
  Burst Data Rate parameter  146, 150, 362
  Burst Real-Time Rate parameter  146, 150, 362
  C

CA Server URL parameter  435
CAC  158, 159, 160, 364, 603, 612, 614
  configuring for 7920 phones  364
  enabling  158, 159
    using the CLI  159
    using the GUI  158
  in mesh networks  603
  viewing in mesh networks  612, 614
  viewing using the CLI  160
  capacity adder license. See licenses  88
  CCKM  348, 795
    configuring  348
    FlexConnect groups  795
  CCX  378, 379, 505
    configuring Aironet IEs  379
      using the CLI  379
    described  378
    link test  505
    viewing a client’s version  379
      using the GUI  379
  CCX Layer 2 client roaming  140, 141, 143
    configuring  143
      using the CLI  143
    debugging using the CLI  143
    described  140, 141
    obtaining information using the CLI  143
  CCX radio management  744
    features  744
    flexconnect considerations  744
  CCX Version parameter  379
  CCXv5 clients  184
    enabling location presence  184
  CCXv5 Req button  881
  CDP > AP Neighbors > Detail page  175
  CDP > Interface Neighbors > Detail page  174
  CDP > Traffic Metrics page  175
  CDP Advertisement Version parameter  172
  CDP AP Neighbors page  174
  CDP Protocol Status parameter  172
  CDP State parameter  172
  Certificate Authority (CA) certificates  234, 237, 664, 665, 666
    downloading  664, 665, 666
      using the CLI  665, 666
      using the GUI  664
    overview  664
    using with local EAP  234, 237
  Certificate File Name parameter  681
  Certificate File Path parameter  681
  Certificate Issuer parameter  236
  Certificate Password parameter  662, 681
  Certificate Type parameter  437
  Change Rules Priority parameter  282
  Channel Announcement parameter  114
  Channel Assignment Leader parameter  722
  Channel Assignment Method parameter  574, 721
  Channel parameter  738, 891
  Channel Quiet Mode parameter  114
  Channel Scan Duration parameter  725
  Channel Width parameter  576
  Channel Width Parameter  722
  Check Against CA Certificates parameter  236
  Check Certificate Date Validity parameter  236
  chokepoints for RFID tag tracking  179
  CIDS Sensor Add page  294
  CIDS Shun List page  295
  ciphers  347, 348
    configuring  348
    described  347
  Cisco 3200 Series Mobile Access Router (MAR)  640, 642, 643
    described  640
    operating with mesh access points  642, 643
      using the CLI to configure  643
      using the GUI to configure  642
  Cisco 3300 Series Mobility Services Engine (MSE), using with
    wIPS  304
  Cisco 5500 Series Wireless LAN Controllers  50, 51, 79, 81
    multiple AP-manager interfaces  79, 81
    ports  50, 51
  Cisco Adaptive Wireless Path Protocol (AWPP)  530
  Cisco AV-pairs  391, 392
  Cisco Centralized Key Management (CCKM). See CCKM  346
  Cisco Clean Access (CCA)  396
  Cisco Discovery Protocol (CDP)  170, 172, 173, 174, 175, 176
    configuring  172, 173
      using the CLI  173
      using the GUI  172, 173
    described  170
    enabling using the GUI  172, 173
    supported devices  170
    viewing neighbors  174, 175, 176
      using the CLI  176
      using the GUI  174, 175
Cisco Discovery Protocol (CDP) (continued)
viewing traffic information 176
using the CLI 176
Cisco Discovery Protocol parameter 172
Cisco License Manager (CLM) 105
and the controller license agent 105
Cisco Licensing website 101
Cisco Logo parameter 687
Cisco Unified Wireless Network (UWN) Solution 3
described 3
Cisco Wireless Solution 1
described 1
CiscoSecure Access Control Server (ACS) 200
described 200
CleanAir guidelines 753
Clear Filter link 324, 419, 443
Clear Stats button 821
Clear Stats on All APs button 443
CLI 30, 32, 33, 46, 858
enabling wireless connections 46
logging into 30
logging out 32
navigating 33
troubleshooting commands 858
using 30, 33
Client Certificate Required parameter 236
described 236
client location, using Prime Infrastructure 5
client MFP 258
Client Protection parameter 260
described 260
client reporting 881
client roaming, configuring 139, 143
Client Type parameter 473
clients 379, 380, 517, 518, 790
connecting to WLANs 790
viewing 517, 518
using the CLI 518
using the GUI 517, 518
viewing CCX version 379, 380
using the CLI 380
using the GUI 379
Clients > AP > Traffic Stream Metrics page 160
Clients > Detail page 473
viewing client details 473
viewing the status of workgroup bridges 473
Commands > Reset to Factory Defaults page 186
Community Name parameter 122
described 122
conditional web redirect 391
described 391
Conditional Web Redirect parameter 393
Configuration File Encryption parameter 670
configuration files 670, 671, 674
downloading 670, 671
using the GUI 670, 671
editing 674
configuration wizard 8, 21
CLI version 21
described 9
Configuration Wizard - 802.11 Configuration page 19
Configuration Wizard - Miscellaneous Configuration page 15
Configuration Wizard - Set Time page 20
Configuration Wizard - SNMP Summary page 12, 14
Configuration Wizard - System Information page 11
Configuration Wizard - Virtual Interface Configuration page 16
Configuration Wizard Completed page 21
Configuration Wizard-Management Interface Configuration 14
Configuration Wizard-System Information 13
Configure Dynamic Anchoring of Static IP Clients 831
Using the CLI 831
Configure option for RRM override 738
Configure RF Group 717
Using CLI 717
Configure RF Group Mode 716
Using CLI 717
Configuring a Spectrum Expert 767
Configuring ACLs - GUI 252
Configuring Cisco CleanAir 755
Using the CLI 755
Configuring Cisco CleanAir 753
Using the GUI 753
Configuring Client Exclusion Policies (CLI) 262
Configuring Client Exclusion Policies (GUI) 261
configuring ClientLink (CLI) 536
Configuring Controller (GUI) 10
Configuring Country Codes (CLI) 495
Configuring Country Codes (GUI) 494
Configuring Coverage Hole Detection on a WLAN (GUI) 395
Configuring Dynamic Anchoring of Static IP Clients 831
Using the GUI 831
Configuring Ethernet VLAN Tagging (GUI) 588
Configuring FlexConnect APs using the CLI 788
configuring for the debug facility 887
Configuring Sniffing on an Access Point 891
Using the GUI 891
Configuring Web Redirect (GUI) 393
Control and Provisioning of Wireless Access Points protocol (CAPWAP) 410, 411, 414
documenting 414
described 410
restrictions 411
viewing MTU information 414
Controller Time Source Valid parameter 260
controllers 2, 3, 5, 6, 415, 650, 652, 673
configuration 673
saving 673
discovery process 415
multiple-controller deployment 3
overview 5
platforms 6
controllers (continued)
  single-controller deployment 2
  upgrading software 650, 652
    using the CLI 652
    using the GUI 650
core dump files 868, 870
  described 868
  uploading from a 5500 series controller to a TFTP or FTP server 870
Core Dump page 868
Country Code parameter 495
  described 493
  viewing using the CLI 496
Country page 494
Coverage Exception Level per AP parameter 724
coverage hole detection 394, 723, 724, 729
  configuring per controller 723, 724, 729
    using the CLI 729
    using the GUI 723, 724
  disabling on a WLAN 394
    described 394
coverage hole detection and correction 715
Coverage Hole Detection Enabled parameter 395
CPUs, 5500 series controllers 855, 856
  crash files 867
    uploading 867
    using the CLI 867
Creating Multiple AP Manager Interfaces - CLI 79
Creating Multiple AP-Manager Interfaces (GUI) 78
Custom Signatures page 300

D
data encryption 413, 414, 467
  and OfficeExtend access points 467
    configuring 413, 414
      using the CLI 413, 414
    using the GUI 413
Data Encryption parameter 413, 465
Data Path parameter 823
Data Rates parameter 108
date 37
  configuring through NTP server 37
DCA Channel Sensitivity parameter 575, 722
DCA Channels parameter 576, 723
d debug commands, sending 445
d debug facility 885, 886
  described 885, 886
default enable password 423
Default Mobility Group parameter 816
Default Routers parameter 331
Description parameter 224, 540
Destination parameter 252, 792
Destination Port parameter 253, 793
Detect and Report Ad-Hoc Networks parameter 274
device certificates 661, 662
  downloading 661, 662
    using the GUI 661, 662
  overview 661
DHCP Addr. Assignment Required parameter 328
DHCP option 43, in controller discovery process 415
DHCP option 52, in controller discovery process 415
DHCP option 82 248, 249, 250
  configuring 250
    using the GUI 250
    described 248
    example 249
DHCP Option 82 format parameter 249
DHCP Option 82 Remote ID Field Format parameter 249
DHCP Parameters page 116, 117
DHCP proxy 115, 117
  configuring 117
    using the CLI 117
    described 115
DHCP scopes 330
  described 330
DHCP Scopes page 330
DHCP Server IP Addr parameter 328
DHCP servers 326
  internal 326
DHCP Timeout 117
  configuring using GUI 117
diagnostic channel 876
  configuring 876
    using the GUI 876
    described 876
Diagnostic Channel parameter 876
directed roam request 141
Direction parameter 253
disabled clients, configuring a timeout 334
discovery request timer, configuring 479, 547
distribution system ports 50, 51
Diversity parameter 738
DNS Domain Name parameter 331
DNS IP Address parameter 450
DNS Servers parameter 331
Domain Name parameter 450
domain name server (DNS) discovery 415
Download button 662, 665, 699
  downloading a CA certificate 665
    downloading a customized web authentication login page 699
    downloading a device certificate 662
Download File to Controller page 659, 664, 670, 698
  downloading a customized web authentication login page 698
  downloading CA certificates 664
Download File to Controller page (continued)
downloading configuration files 670
downloading login banner file 659
Download SSL Certificate parameter 681
Download Third-Party Certificate 694, 695
   using the CLI 695
   using the GUI 694
DSCP parameter 253, 793
DTIM 335
DTLS 88
DTLS data encryption. See data encryption 411
DTCP Support parameter 108
Dynamic Anchoring for Clients with Static IP Addresses 829
   Configuring 829
dynamic AP management 57, 58, 67
   for dynamic interface 67
   for the management interface 57, 58
Dynamic AP Management parameter 56, 66
   for dynamic interface 66
   for management interface 56
dynamic AP-manager interface 68
dynamic channel assignment (DCA) 575, 713, 722, 723, 727, 729
   40-MHz channelization 722
   configuring 723, 727, 729
   using the CLI 727, 729
   using the GUI 723
described 713
   sensitivity thresholds 575
dynamic frequency selection 500, 501
dynamic interface example 80
dynamic transmit power control, configuring 108
Dynamic WEP Key Index parameter 235
Enable DHCP Proxy parameter 116
Enable Dynamic AP Management parameter 78
Enable EAP-FAST Authentication parameter 798
Enable LEAP Authentication parameter 798
Enable Least Latency Controller Join parameter 465
Enable Link Latency parameter 465, 508
Enable Listener parameter 105
Enable Low Latency MAC parameter 168
Enable LSC on Controller parameter 435
Enable NAT Address parameter 56
Enable Notification parameter 106
Enable OfficeExtend AP parameter 465
Enable Password parameter 425
Enable Server Status parameter 228
Enable Tracking Optimization parameter 502
Encryption Key parameter 352
described
end-user license agreement (EULA) 91, 92
enhanced distributed channel access (EDCA) parameters 169, 170
   configuring using the CLI 169, 170
enhanced neighbor list 140, 141, 601
   request (E2E) 141
described 140, 601
Enter Saved Permission Ticket File Name parameter 102
EoIP port 828
epings 829
error codes, for failed VoIP calls 370
Ethernet connection, using remotely 32
evaluation licenses 89
   installed on 5500 series controllers 89
event reporting for MFP 258
Expedited Bandwidth parameter 155
Expiration Timeout for Rogue AP and Rogue Client Entries parameter 274
Extensible Authentication Protocol (EAP) 237, 238, 240
   setting local timers 237, 238
   timeout and failure counters 240
   per access point 240
   per client 240
Factory default settings 186
   resetting using the GUI 186
failover priority for access points 489, 490
   configuring 489, 490
   using the GUI 489
   described 489
   viewing using the CLI 490
failover protection 7, 8
Fallback Mode parameter 205
fast heartbeat timer 476, 477, 479
    configuring 477, 479
    using the CLI 479
    using the GUI 477
    described 476
fast SSID changing 130
    configuring using the GUI 130
fault tolerance 772
File Compression parameter 448
File Name to Save Credentials parameter 101
file transfers 6
File Type parameter 649, 655, 659, 662, 664, 666, 669, 670, 698, 873
    downloading a CA certificate 664
    downloading a configuration file 670
    downloading a customized web authentication login page 698
    downloading a device certificate 662
    Login Banner 659
    upgrading controller software 649, 655
    uploading a configuration file 669
    uploading packet capture files 873
    uploading PACs 666
filter, using to view clients 517, 518
Fingerprint parameter 294
FlexConnect 773, 774, 776, 784, 788
    authentication process 773, 776
    bandwidth restriction 774
    debugging 784, 788
FlexConnect groups 795, 796
    backup RADIUS server 795
    CCKM 795
    described 795
    local authentication 796
FlexConnect Mode AP Fast Heartbeat Timeout parameter 477
Fragmentation Threshold parameter 108
FTP server guidelines 646
global credentials for access points (continued)
    overriding 425
    using the CLI 425
    using the GUI 425
Group Mode parameter 736, 820
Group Name parameter 797, 817
Guest LAN parameter 705
guest user accounts 680
    viewing 680
    using the CLI 680
    using the GUI 680
Guest User parameter 224
Guest User Role parameter 224
guest WLAN, creating 680
GUI 23, 24
    guidelines 24
    using 23
Guidelines and Limitations for Predownloading 654

H
Headline parameter 687
hex2pcapsampleoutput 889
Holdtime parameter 172
HTTP Access parameter 25
HTTP Configuration page 25
HTTPS Access parameter 25
Hysteresis parameter 142

I
Identity Request Max Retries parameter 234
Identity Request Timeout parameter 234
IDS sensors 293
    described 293
IDS signatures 297, 301, 303
    described 297
    frequency 301
    MAC frequency 301, 303
    measurement interval 301
    pattern 301
    quiet time 301, 303
    tracking method 301
IGMP Snooping 401
IGMP Timeout parameter 136
IKE Diffie Hellman Group parameter 205
IKE Phase 1 parameter 205
Index parameter for IDS 294
indoor access points 637
    converting to mesh access points 637
    described 423

G
General (controller) page 76, 735
    configuring an RF group 735
    enabling link aggregation 76
General (security) page 223
General page 234
Generate Rehost Ticket button 102
generating CSR 692
Global AP Failover Priority parameter 489
Global Configuration page 477, 489, 545
    configuring backup controllers 477, 545
    configuring failover priority for access points 489
global credentials for access points 423, 425
    described 423
infrastructure MFP 258
  components 258
Ingress Interface parameter 705
Injector Switch MAC Address parameter 513
inline power 511
Install License button 91
inter-controller roaming 140, 808
  described 140
  example 808
inter-release mobility 815
inter-subnet mobility 813
inter-subnet roaming 140, 810
  described 140
  illustrated 810
Interface groups 82
Interface Name parameter 383, 397, 540
Interface parameter 328
interfaces 52, 64
  overview 52, 64
Interfaces > Edit page 78
  creating multiple AP-manager interfaces 78
interference 714
Interference threshold parameter 725
Interferences 750
Internet Group Management Protocol (IGMP) 133, 136, 137
  snooping 133
  configuring 136, 137
  using the CLI 137
  using the GUI 136
Interval parameter 575, 721
intra-controller roaming 139, 807
  described 139
  illustrated 807
Inventory page 504
Invoke Channel Update Now button 575, 721
Invoke Power Update Now button 718
IP address-to-MAC address binding 144
  configuring 144
  described 144
IP Mask parameter 122
IPSec parameter 204
IPv6 ACL Name 255

K

Keep Alive Count parameter 823
Keep Alive Interval parameter 823
Key Encryption Key (KEK) parameter 204
Key Index parameter 352
key permutation 351, 352, 353
  configuring 352, 353
  described 351
Key Size parameter 352
Key Wrap Format parameter 204
Key Wrap parameter 204

L

LAG Mode on Next Reboot parameter 76
Last Auto Channel Assignment parameter 722
Layer 2 4
  operation 4
Layer 2 Security parameter 347, 352, 393
Layer 3 4, 199
  operation 4
  security 199
  described 199
Layer 3 Security parameter 355, 357, 359, 393, 705
  for VPN passthrough 355, 359
  for web authentication 357
  for web redirect 393
  for wired guest access 705
LDAP 227, 229
  choosing server priority order 229
  configuring 227, 229
  using the GUI 227, 229
LDAP server 229
  assigning to WLANs 229
LDAP Servers page 228
LDAP Servers parameter 237
Lease Time parameter 331
LEDs 516, 852
  configuring 516
  interpreting 852
license agent 105
  described 105
License Commands page 91
License Detail page 92, 96
licenses 89, 90, 91, 92, 93, 100, 101, 102, 104
  installing 91, 92
  using the CLI 92
  using the GUI 91
  obtaining 89, 91
  rehosting 100, 101, 102
  described 100
  using the GUI 101, 102

J

Japanese country codes 494, 497
Japanese regulations for migrating access points from the -J to
the -U regulatory domain 496
licenses (continued)
   removing 92
      using the CLI 92
      using the GUI 92
   saving 91, 92
      using the CLI 92
      using the GUI 91
SKUs 90
   transferring to a replacement controller after an RMA 104
   viewing 93
      using the CLI 93
Licenses page 92, 96
Lifetime parameter 224, 679
lightweight mode, reverting to autonomous mode 432
link aggregation (LAG) 74, 75
   described 74
   illustrated 75
link latency 467, 507
   and OfficeExtend access points 467
   described 507
Link Status parameter 70
link test 505, 506, 634, 636
   performing 506, 634, 636
      using the CLI 506
      using the GUI 506, 634, 636
   types of packets 505
Link Test 506, 635
   button 506
   option 506, 635
   window 635
Link Trap parameter 70
Listener Message Processing URL parameter 105
load-based CAC 152, 153, 155
   described 152, 153
   enabling 155
      using the GUI 155
Lobby Ambassador Guest Management > Guest Users List page 679
Local Auth Active Timeout parameter 234
Local Authentication on a WLAN 789
   using the GUI 789
local authentication, local switching 774
local EAP 233, 239, 241
   debugging 241
      example 233
      viewing information using the CLI 239
Local EAP Authentication parameter 236
Local Management Users > New page 678
Local Management Users page 678
Local Mode AP Fast Heartbeat Timer parameter 477
Local Net Users > New page 224
local significant certificate (LSC) 434, 435
   configuring 434, 435
      using the GUI 434, 435
local significant certificate (LSC) (continued)
   described 434
Local Significant Certificates (LSC) - AP Provisioning page 435
Local Significant Certificates (LSC) - General page 435
local user database, capacity 678
location 181, 183, 745
   calibration 745
   configuring settings using the CLI 181, 183
   viewing settings using the CLI 183
login banner file 658, 659, 660, 661
   clearing 661
      described 658
   downloading 659, 660
      using the CLI 660
      using the GUI 659, 660
logs 866, 868, 883
RSNA 883
   uploading 866, 868
   using the CLI 868
   using the GUI 866
LWAPP-enabled access points 432, 445, 446, 447, 449
   debug commands 445
   disabling the reset button 449
   retrieving radio core dumps 446
   reverting to autonomous mode 432
   sending crash information to controller 445
   uploading 446, 447
      access point core dumps 447
      radio core dumps 446, 447
M
MAC address of access point 449
   displayed on controller GUI 449
MAC Address parameter 540
MAC filtering 332, 334
   configuring on WLANs 332, 334
MAC Filtering page 540
MAC Filters > New page 540
management frame protection (MFP) 257
   types 257
Management Frame Protection parameter 260
management frame validation 258
management interface 53
   described 53
Management IP Address parameter 464
management over wireless 247
   described 247
Master Controller Configuration page 416
Master Controller Mode parameter 416
Max HTTP Message Size parameter 105
Max RF Bandwidth parameter 155, 158
Max-Login Ignore Identity Response parameter 235
maximum local database entries 222
configuring using the GUI 222
Maximum Local Database Entries parameter 222
Maximum Number of Sessions parameter 105
MCS data rates 111
Member MAC Address parameter 817
memory 7
types 7
memory leaks, monitoring 874
mesh 552, 555, 568, 612, 627, 632, 633
network example 612
parameters 552, 555, 568
configuring using the CLI 568
configuring using the GUI 552, 555
statistics 627, 632, 633
viewing for an access point using the CLI 632, 633
viewing for an access point using the GUI 627, 632
Mesh > LinkTest Results page 635
mesh access points 522, 523, 530, 639, 640
and CAPWAP 530
converting to non-mesh access points 639
models 522
network access 523
roles 523
mesh neighbors, parents, and children 530
mesh routing 530
Message Authentication Code Key (MACK) parameter 204
message logs 858, 860, 861, 864
configuring 858
using the GUI 858
viewing 860, 861, 864
using the CLI 864
using the GUI 860, 861
Message parameter for web authentication 687
Metrics Collection parameter 156
MFP Client Protection parameter 259
MIC 351
migrating access points from the -J to the -U regulatory domain 496, 499
Min Failed Client Count per AP parameter 724
Minimum RSSI parameter 142
mirror mode. See port mirroring, configuring 71
MMH MIC 352, 353
configuring 352, 353
mobility 807
overview 807
Mobility Anchor Create button 823
Mobility Anchors option 823
mobility anchors. See auto-anchor mobility 821
mobility group statistics 819
types 819
mobility groups (continued)
illustrated 811
messaging among 813
mobility ping tests, running 828
mobility services engine 181
synchronizing with controller 181
MODE access point button 181
Mode parameter 142, 746
monitor intervals, configuring using the GUI 725
Monitoring 764
mpings 829
multicast client table, viewing 139
Multicast Groups page 138
multicast mode 133, 134, 135
described 133, 134
guidelines 135
Multicast Optimization 84
Multicast page 136
Multicast VLAN 85
using the GUI 85
multiple country codes 495
configuring 495
using the CLI 495
using the GUI 495
N
NAC out-of-band integration 396
diagram 396
NAC out-of-band support 397, 398
configuring for a specific access point group 397, 398
using the CLI 398
using the GUI 397
NAC State parameter 397
NAT address 55, 58, 66, 67
for dynamic interface 66, 67
for management interface 55, 58
NAT devices in mobility groups 814
Native VLAN ID parameter 785
Neighbor Discovery Packet 731
neighbor information 634, 636
viewing for an access point using the CLI 636
viewing for an access point using the GUI 634
Neighbor Information option 634
Neighbor Packet Frequency parameter 725
neighbor statistics 636
viewing for an access point using the CLI 636
viewing for an access point using the GUI 636
Netbios Name Servers parameter 331
Netmask parameter 331
Network Mobility Services Protocol (NMSP) 179, 184, 185, 186
debugging 185, 186
Network Mobility Services Protocol (NMSP) *(continued)*
modifying the notification interval for clients, RFID tags, and rogues 184
viewing settings 185
Network parameter 331
NTP/SNTP server 37
configuring to obtain time and date 37
Number of Attempts to LSC parameter 435
Number of Hits parameter 254

O

OfficeExtend Access Point Home page 469
OfficeExtend access points 454, 455, 463, 464, 466, 469
and NAT 455
configuring 464, 466, 469
a personal SSID 469
using the GUI 464, 466
described 454
firewall requirements 463
supported access point models 455
typical setup 454
viewing statistics 469
OfficeExtend Access Points 895
LEDs 895
positioning 895
OfficeExtend AP parameter 465
online help, using 24
operating system 3, 4
security 4
software 3
operating with Cisco 3200 Series Mobile Access Routers 640
described 640
Order Used for Authentication parameter 206, 219
Over-ride Global Credentials parameter 425, 427, 428, 465, 466
Override Global Config parameter 701, 706
Override Interface ACL parameter 255
Overview of CleanAir 749

P

P2P Blocking parameter 337
packet capture files 871, 872, 873, 874
described 871
sample output in Wireshark 872
uploading 873, 874
using the CLI 873, 874
Params parameter 435
Passive clients 399
password guidelines 427
Password parameter 224, 424, 427, 666
for access point authentication 427
for access points 424
for local net users 224
for PACs 666
passwords 858
viewing in clear text 858
path loss measurement (S60), CLI command 181
PEAP parameter 235
peer-to-peer blocking 337
described 337
Physical Mode parameter 70
Physical Status parameter 70
ping link test 505
ping tests 829
PMK cache lifetime timer 349
PMKID caching 349
PoE Status parameter 513
Pool End Address parameter 330
Pool Start Address parameter 330
port mirroring, configuring 71, 72
Port Number parameter 70, 204, 219, 228, 705
for controller 70
for LDAP server 228
for RADIUS server 204
for TACACS+ server 219
for wired guest access 705
Port parameter for IDS 294
ports 70
configuring 70
Ports page 70
Power Injector Selection parameter 513
Power Injector State parameter 513
Power Neighbor Count parameter 719
Power over Ethernet (PoE) 6, 513, 514
configuring 513, 514
using the CLI 514
using the GUI 513, 514
described 6
Power Over Ethernet (PoE) parameter 70
Power Threshold parameter 719
preauthentication access control list (ACL) 696, 781
for external web server 696, 781
Preauthentication ACL parameter 255, 393
Predownloading an image 652
Primary Controller parameters 478, 546
Primary RADIUS Server parameter 797
Priority Order > Local-Auth page 234
Priority Order > Management User page 206, 219
Privacy Protocol parameter 124
proactive key caching (PKC), with mobility 813
probe requests, described 503
product authorization key (PAK) 89, 90
obtaining for license upgrade 89
product authorization key (PAK) (continued) registering 90
Profile Name parameter 321, 381, 407, 540, 705
protected access credentials (PACs) 234, 666, 667, 668, 798
overview 666
uploading 666, 667, 668
using the CLI 667, 668
using the GUI 666
using with local EAP 234, 798
Protection Type parameter 259, 743
Protocol parameter 253, 792
Protocol Type parameter 147
PSK 346
described 346
PSK Format parameter 348
Q
QBSS 364
QoS 145, 360
levels 145, 360
QoS profiles 145, 147, 148
configuring 145, 147, 148
using the CLI 145, 147, 148
using the GUI 145, 147
QoS roles 149, 150
configuring 149, 150
using the CLI 150
using the GUI 149, 150
Quality of Service (QoS) parameter 362
Quarantine parameter 66, 397
for dynamic interface 66
NAC out-of-band integration 397
quarantined VLAN 55, 66, 397, 776, 782
configuring 55, 66
using 782
with FlexConnect 776
with NAC out-of-band integration 397
Query Interval parameter 294
radio resource management (RRM) settings 730
viewing using the CLI 730
radio resource monitoring 712
RADIUS 200, 201, 207, 209, 795
KEK parameter 207
MACK parameter 207
configuring on ACS 200, 201
FIPS standard 207
server fallback behavior 209
using FlexConnect 795
RADIUS authentication attributes 210
Range (RootAP to MeshAP) parameter 552
rc4-preference, configuring for web administration 26
Re-sync button 295
Redirect URL After Login parameter 687
Refresh-time Interval parameter 172
Regenerate Certificate button 681
Rehost Ticket File Name parameter 102
rehosting a license. See licenses 100
Remote Authentication Dial-In User Service. See RADIUS 199
Request Max Retries parameter 235
Request Timeout parameter 235
Reserved Roaming Bandwidth parameter 155
Reset Link Latency button 508
Reset Personal SSID parameter 465
resetting the controller 675
RF Channel Assignment parameter 742
RF group leader 732
described 732
RF group name 734
described 734
RF Group support 734
RF groups 732, 733, 734, 735, 736
cascading 733
Spectrum Expert 768
configuring using GUI 768
Splash Page Web Redirect parameter 393
SSH 43, 45, 465, 467, 892
and OfficeExtend access points 465, 467
configuring 43
using the CLI 43
counting access points 45, 892
using the GUI 45, 892
SSH parameter 45, 893
SSID 320, 321, 322
configuring 321, 322
using the CLI 322
using the GUI 321
described 320
SSL certificate 27, 28, 29
loading 27, 28, 29
using the CLI 29
using the GUI 27, 28
SSL Protocol 25
SSLv2 for web authentication, disabling 686, 687
SSLv2, configuring for web administration 26
State parameter 294, 301
stateful DHCPv6 IP addressing 375
static IP address 450
configuring 450
using the CLI 450
using the GUI 450
Static IP address 450
described 450
Static IP parameter 450
Statistics option 629
Status parameter 122, 321, 331, 381, 407, 705
for DHCP scopes 331
for guest LANs 705
for SNMP community 122
for WLANs 321, 381, 407
Summary page 43
Switch IP Address (Anchor) parameter 823
SX/LC/T small form-factor plug-in (SFP) modules 51
symmetric mobility tunneling 827, 828
illustrated 827
overview 827
verifying status 828
using the CLI 828
Symmetric Mobility Tunneling Mode parameter 828
syslog 882, 883, 884
described 882
logs 883, 884
Syslog Configuration page 858
Syslog Facility parameter 859
syslog server 859
removing from controller 859
severity level filtering 859
Syslog Server IP Address parameter 859
system logging 858
configuring 858
using the GUI 858
system logs, viewing using the CLI 864
System Messages 852
System Resource Information page 856
system resources 855, 856
viewing using the CLI 856
viewing using the GUI 855
T
TACACS+ 214, 215, 217, 219
accounting 215
authentication 214
authorization 214
configuring 219
using the CLI 219
described 214
roles 217
TACACS+ (Authentication, Authorization, or Accounting) Servers
> New page 218
TACACS+ (Authentication, Authorization, or Accounting) Servers page 218
TACACS+ Administration .csv page (on CiscoSecure ACS) 221, 222
TCP MSS 510
described 510
Telnet 45, 892, 893
counting access points 45, 892, 893
using the CLI 45, 893
using the GUI 45, 892, 893
Telnet parameter 45, 893
Telnet sessions 42, 43
configuring 42, 43
using the CLI 42, 43
using the GUI 42, 43
Telnet-SSH Configuration page 42
Tertiary Controller parameters 478, 546
txt2pcap sample output 889
Time to Live for the PAC parameter 236, 798
time zone 39, 40
configuring using the CLI 40
configuring using the GUI 39
time-length-values (TLVs), supported for CDP 170, 171
time, configuring 37
using the NTP server 37
timestamps, enabling or disabling in log and debug messages 864
traffic specifications (TSPEC) request 153
examples 153
traffic stream metrics (TSM) 154, 160, 161, 162
described 154
traffic stream metrics (TSM) (continued)
viewing statistics 160, 161, 162
using the CLI 161, 162
using the GUI 160
Transfer Mode parameter 649, 655, 662, 664, 666, 669, 671, 698, 873
downloading a CA certificate 664
downloading a configuration file 671
downloading a customized web authentication login page 698
downloading a device certificate 662
upgrading controller software 649, 655
uploading a configuration file 669
uploading a PAC 666
uploading packet capture files 873
Transition Time parameter 142
transmit power 739
statically assigning using the CLI 739
statically assigning using the GUI 739
transmit power levels 738
transmit power threshold, decreasing 727
trap logs 464
for OfficeExtend access points 464
Trap Logs page 367
troubleshooting 441, 445, 857, 875
access point join process 441, 445
CCXv5 clients 875
problems 857
Troubleshooting OEAPs 895
tunnel attributes and identity networking 267
Tx Power Level Assignment parameter 742
Type parameter 321, 381, 407, 705

U
U-APSD 154, 160, 161
described 154
viewing status 160, 161
using the CLI 161
using the GUI 160
UDP port 828
UDP, use in RADIUS 200
unicast mode 133
unique device identifier (UDI) 504, 505
described 504
retrieving 504, 505
using the CLI 505
using the GUI 504, 505
Upload button 300, 667, 867, 873
Upload CSV File parameter 798
Upload File from Controller page 446, 666, 669, 873
URL to Send the Notifications parameter 106
USB console port, using on a 5500 series controller 73
Use AES Key Wrap parameter 203
User Access Mode parameter 678
User Attribute parameter 229
User Base DN parameter 228
User Credentials parameter 229
User Name parameter 224
User Object Type parameter 229
User parameter 666
User Profile Name parameter 124
Username parameter 424, 427, 428
Using CLI to monitor the Air quality 765
Using GUI to monitor air quality 764
using the GUI 254

V
Validate Rogue Clients Against AAA parameter 274
Validity parameter 666
VCI strings 439
Verify Certificate CN Identity parameter 236
video information, viewing for mesh networks using the CLI 612
virtual interface 61
described 61
VLAN ID parameter 397, 786
VLAN Identifier parameter 59, 66
for AP-manager interface 59
for dynamic interface 66
VLAN Select 81
VLANs 64, 70
described 64
guidelines 70
voice information, viewing for mesh networks using the CLI 612
Voice RSSI parameter 724
voice settings 156
configuring 156
using the GUI 156
voice-over-IP (VoIP) telephone roaming 140
VoIP calls, error codes 370
VoIP snooping 366
described 366
VoIP Snooping and Reporting parameter 367
VPN Gateway Address parameter 355
VPN passthrough 355, 360
configuring using the GUI 360
described 355

W
Web Auth Type parameter 701, 706
web authentication 356, 680, 681, 683, 686
certificate 680, 681
obtaining using the GUI 680, 681
web authentication (continued)
  configuring a WLAN for 356
    using the GUI 356
  described 683
  process 686
  successful login page 686
web authentication login page 685, 687, 689, 692, 696, 699
  choosing the default 687, 689
    using the CLI 687, 689
  customizing from an external web server 696
    using the GUI 696
  default 685
  modified default example 692
  previewing 687, 699
Web Authentication Type parameter 687, 696, 699
Web Login page 696
web mode 25
  described 25
Web Policy parameter 255, 393
Web Session Timeout parameter 25
web-browser security alert 684
webauth bundle 697
webauth.tar files 701
WEP keys, configuring 339
WGB parameter 473
WGB Wired Clients page 473
wired guest access 703, 704
  configuration overview 704
  described 703, 704
wireless intrusion prevention system (wIPS) 304
  described 304
wireless sniffing 891
  configuring 891
    using the GUI 891
  supported software 891
WLAN ID parameter 321, 381, 407
WLAN mobility security values 825
WLAN Profile parameter 224
WLAN SSID parameter 383, 397, 680
  configuring for guest user 680
  mapping an access point group to a WLAN 383, 397
WLANs 321, 322, 323, 339, 353, 381, 407, 790
  checking security settings 339
  connecting clients to 790
    creating 381, 407
      using the GUI 381, 407
    deleting 321, 322
      using the CLI 322
      using the GUI 321
  disabling accounting servers on a WLAN 394
  configuring web redirect 393
WLANs > Edit page 321, 381, 407, 705
WLANs page 320, 321, 325, 380, 407, 823
WMM 152, 364, 365
  configuring 365
  described 364
  with CAC 152
WMM parameter 168, 169
workgroup bridges (WGBs) 455, 465, 469, 470, 473, 474
  configuring 455, 465, 470
    illustrated 455, 465, 470
    sample configuration 473
  viewing status 473, 474
  using the CLI 474
  using the GUI 473, 474
world mode 108, 109
WPA2 Policy parameter 347
wplus license. licenses 88
wplus license. See licenses 88